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Chapitre 1 : Bienvenue dans Pro Tools

Bienvenue dans le logiciel Pro Tools® basé sur la 
technologie Avid®. Les puissantes fonctionnalités 
audionumériques multipistes et de programmation 
MIDI de Pro Tools mettent à votre disposition tous 
les outils dont vous avez besoin pour enregistrer, 
arranger, composer, éditer, mixer et masteriser de 
l'audio et du MIDI de qualité professionnelle pour 
la musique, la vidéo, le cinéma et le multimédia.

Configuration système et 
informations de compatibilité
Avid ne peut garantir une compatibilité des 
produits et fournir une assistance que pour les 
matériels et les logiciels testés et approuvés par 
ses soins.

Pour connaître la configuration requise et consulter 
la liste exhaustive des ordinateurs, systèmes 
d'exploitation, disques durs et périphériques tiers 
pris en charge, rendez-vous sur :

www.avid.com/compatibility

À propos de www.avid.com
Le site Web Avid (www.avid.com) est la meilleure 
source d'informations en ligne pour optimiser 
votre système Pro Tools. Vous trouverez ci-après 
quelques exemples des services et fonctions 
disponibles à cette adresse. 

Enregistrement de produit : enregistrez votre 
nouveau produit en ligne. 

Assistance et téléchargements : contactez le 
service client d'Avid (support technique), 
téléchargez des mises à jour logicielles et les 
dernières versions des manuels en ligne, consultez 
les documents sur la compatibilité, parcourez la 
Base de connaissances en ligne ou rejoignez la 
communauté d'utilisateurs Pro Tools, depuis 
la section User Conference. 

Formation : étudiez directement en ligne ou 
découvrez les méthodes de formation utilisées 
dans les centres de formation certifiés Pro Tools. 

Produits et développeurs : découvrez les produits 
Avid, nos partenaires de développement ainsi 
que leurs plug-ins, applications et matériels, 
et téléchargez des versions démo de logiciels. 

Actualités et événements : accédez aux 
informations de dernière minute publiées par Avid 
et inscrivez-vous pour obtenir une démo de 
Pro Tools.

http://www.avid.com/compatibility
http://www.avid.com
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Conventions utilisées dans la 
documentation Pro Tools
La documentation Pro Tools utilise les 
conventions suivantes pour indiquer les choix de 
menu, les commandes du clavier et de la souris :

Les noms des commandes, options et paramètres 
qui apparaissent à l'écran sont affichés dans une 
autre police.

Les symboles suivants sont utilisés pour mettre en 
évidence des informations importantes :

Convention Action

Fichier > Enregistrer Dans le menu Fichier, 
sélectionnez Enregistrer

Ctrl+N Maintenez la touche Ctrl 
enfoncée et appuyez sur 
la touche N

Ctrl+Clic Maintenez la touche Ctrl 
enfoncée et cliquez 
à l'aide du bouton de 
la souris

Effectuez un clic droit Cliquez à l'aide du 
bouton droit de la souris

Les conseils aux utilisateurs sont des astuces 
qui permettent d'optimiser l'utilisation de 
votre système Pro Tools.

Les avertissements importants identifient des 
opérations susceptibles de modifier les 
données d'une session Pro Tools ou les 
performances de votre système Pro Tools.

Les raccourcis indiquent les commandes 
utiles du clavier et de la souris.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes de ce guide et de la 
documentation Avid.
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Chapitre 2 : Concepts de Pro Tools

Ce chapitre présente certains concepts de 
Pro Tools qu'il est nécessaire de maîtriser avant de 
commencer à utiliser l'application. Ces concepts 
sont à la base des fonctionnalités et opérations de 
Pro Tools.

Enregistrement audio sur 
disque dur
L'enregistrement sur disque dur utilise un support 
non linéaire (ou à accès aléatoire) : vous pouvez 
ainsi accéder instantanément à n'importe quel 
point d'un enregistrement, sans opération de retour 
ou d'avance rapide.

L'enregistrement sur bande exploite un support 
linéaire : autrement dit, il faut faire un retour 
arrière ou une avance rapide pour pouvoir écouter 
un point spécifique d'un enregistrement. Pour 
modifier l'ordre ou répéter des données contenues 
sur un système linéaire, il faut les réenregistrer ou 
les couper, puis les joindre. 

Les systèmes non linéaires présentent plusieurs 
avantages. Vous pouvez facilement modifier la 
disposition des parties d'un enregistrement ou les 
répéter en les faisant lire par le disque dur dans un 
ordre différent ou à plusieurs reprises. De plus, 
cette réorganisation est non destructive, ce qui 
signifie que l'enregistrement d'origine reste intact.

Édition non linéaire
Pro Tools est un système d'édition non linéaire qui 
permet de réorganiser et de mixer des éléments 
enregistrés de façon non destructive. L'expression 
« édition non linéaire » signifie simplement que 
vous pouvez couper, copier, coller, déplacer, 
supprimer, ajuster et réorganiser toute donnée 
audio, MIDI ou vidéo à partir de la fenêtre Edit de 
Pro Tools. 

L'édition non linéaire offre des avantages 
importants par rapport au dubbing 
(réenregistrement) et aux opérations de coupe et 
d'assemblage de la bande magnétique. Cette 
méthode offre une flexibilité maximale pour 
l'édition et la manipulation des données tout en 
étant non destructive et réversible. De plus, avec 
l'édition non linéaire de Pro Tools, il est 
impossible d'altérer la fidélité audio comme sur 
une bande.
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Moteurs audio
Pro Tools peut transmettre de l'audio entre 
l'application et votre matériel audio par le biais du 
moteur Avid Audio Engine (matériel audio Avid 
uniquement), de pilotes Core Audio (Mac 
uniquement avec matériel audio tiers) ou de pilotes 
ASIO (Windows uniquement avec matériel 
audio tiers).

Avid Audio Engine

Le moteur AAE (Avid Audio Engine) de 
Pro Tools, est un système d'exploitation en temps 
réel pour le traitement, la lecture et 
l'enregistrement audio numériques avec du 
matériel audio Avid. Lorsque vous installez 
Pro Tools, le moteur AAE est automatiquement 
installé sur votre système. Le moteur AAE est à la 
base de la plupart des opérations d'enregistrement 
sur disque dur, de traitement des signaux 
numériques et d'automation de mixage réalisées 
dans Pro Tools et d'autres produits Avid ou de ses 
partenaires de développement.

Core Audio

La technologie Core Audio d'Apple fournit une 
connectivité audio entre les applications et le 
matériel audio sous Mac OS X. Le logiciel 
Pro Tools peut utiliser des interfaces audio avec 
des pilotes Core Audio pris en charge pour la 
lecture et l'enregistrement d'un maximum de 
32 canaux d'E/S.

ASIO

La technologie ASIO (Audio Stream Input/Output) 
de Steinberg fournit une connectivité audio entre 
les applications et le matériel audio sous Windows. 
Le logiciel Pro Tools peut utiliser des interfaces 
audio avec des pilotes ASIO pris en charge pour 
la lecture et l'enregistrement d'un maximum 
de 32 canaux d'E/S.

Avid Video Engine
Pro Tools exploite le moteur Avid Video Engine 
(AVE) pour prendre en charge la lecture vidéo. 
Le moteur AVE est installé automatiquement avec 
Pro Tools. Le moteur AVE assure la compatibilité 
et l'interopérabilité de la gamme entière de solutions 
Avid d'édition audio et vidéo, et prend en charge un 
large panel de formats vidéo Avid MXF HD et SD 
sur les pistes vidéo de Pro Tools, sans transcodage 
(y compris Avid DNxHD®). De plus, le moteur 
AVE prend en charge le monitoring des médias 
Avid MXF HD et SD et QuickTime à l'aide d'un 
boîtier Avid Nitris® DX, Mojo® DX ou d'autres 
interfaces vidéo tierces qualifiées par Avid.
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MIDI
Le MIDI (Musical Instrument Digital Interface) 
est un protocole de communication destiné aux 
instruments de musique. Cette norme définie par 
les constructeurs permet de connecter plusieurs 
dispositifs de marques ou de modèles différents. 
Parmi les appareils compatibles MIDI, citons 
les synthétiseurs, les boîtes à rythmes, les patch 
bays MIDI, les processeurs d'effets, les interfaces 
MIDI, les surfaces de contrôle MIDI et les 
séquenceurs MIDI. 

Les périphériques MIDI sont équipés de 
connecteurs DIN à 5 broches, nommés IN, OUT, 
ou THRU. Le port MIDI OUT émet des messages. 
Le port MIDI IN reçoit des messages. Le port 
MIDI THRU transmet les données reçues sur le 
port IN. Les périphériques MIDI se connectent 
à l'aide de câbles MIDI disponibles auprès de la 
plupart des revendeurs d'instruments de musique. 

Les périphériques MIDI compatibles USB et 
FireWire échangent des messages MIDI avec 
l'ordinateur par le biais d'un câble USB ou 
FireWire.

Le protocole MIDI offre 16 canaux MIDI par port. 
Un même câble MIDI peut transmettre un 
ensemble de messages distinct sur chacun des 
16 canaux. Ces 16 canaux peuvent correspondre 
à différents périphériques MIDI ou à plusieurs 
canaux d'un même périphérique (si celui-ci est 
multitimbral). Chaque canal peut contrôler un son 
d'instrument différent. 

Pro Tools est livré avec des outils de 
programmation MIDI puissants. Vous pouvez 
enregistrer, saisir, éditer et lire des données MIDI 
sur des pistes d'instrument et des pistes MIDI dans 
Pro Tools. Ces actions peuvent être effectuées 
dans la fenêtre Edit, dans une fenêtre de l'éditeur 
MIDI ou dans la fenêtre de l'éditeur de partition, 
ainsi que dans la liste des événements MIDI. 

Les données MIDI dans Pro Tools peuvent être 
de tout type, des données de notes MIDI (numéro 
de note, on/off, vélocité) aux messages System 
Exclusive (Sysex). Les données MIDI peuvent être 
enregistrées ou lues à partir de périphériques MIDI 
externes par le biais d'une interface MIDI ou à 
partir d'autres logiciels MIDI (tels que des plug-ins 
d'instrument et des applications clientes ReWire).

Synchronization
Lorsque vous travaillez avec plusieurs systèmes 
basés sur des valeurs temporelles, tels que 
Pro Tools et un dispositif externe, vous devez 
synchroniser les deux systèmes. Pour cela, 
un système doit émettre une source d'horloge 
(telle qu'un timecode ou un MIDI Beat Clock) 
et l'autre doit se synchroniser à, ou suivre, cette 
source d'horloge, afin que les deux systèmes 
fonctionnent ensemble. Il est possible de 
synchroniser Pro Tools avec d'autres 
périphériques (ou de synchroniser d'autres 
périphériques avec Pro Tools) à l'aide d'un 
timecode SMPTE/EBU ou MIDI.
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Son surround
(Pro Tools HD uniquement)

Un son surround signifie simplement qu'un ou 
plusieurs haut-parleurs recevant des signaux 
(canaux) audio distincts sont placés derrière 
l'auditeur, en plus de la paire stéréo classique. 

Il existe plusieurs types de formats surround 
(du format LCR à trois canaux au format 7.1, 
qui comporte 8 canaux).

Le format surround le plus courant est le 5.1, qui 
utilise 5 haut-parleurs et un subwoofer (le « .1 »). 
Le format 5.1 est utilisé dans les salles de cinéma 
et les home cinémas. De plus, la plupart des DVD 
sont au format 5.1. La positionnement standard des 
haut-parleurs pour le monitoring surround au 
format 5.1 est le suivant : un haut-parleur stéréo 
à gauche et à droite, un haut-parleur central 
supplémentaire à l'avant, deux autres haut-parleurs 
stéréo gauche et droite à l'arrière, et un subwoofer 
sur le côté. 

Pro Tools HD prend en charge le mixage aux 
formats surround. Dans Pro Tools, chaque format 
surround est considéré comme étant un format 
multicanal supérieur à stéréo.

Sessions Pro Tools
Lorsque vous démarrez un projet dans Pro Tools, 
vous créez une session.

Fichiers de session
Un fichier de session est le document créé par 
Pro Tools lorsque vous sélectionnez la commande 
File > New Session et configurez une nouvelle 
session. Pro Tools ne peut ouvrir qu'une seule 
session à la fois. Le fichier de session porte 
l'extension .ptx (fichier Pro Tools). Les fichiers de 
session référencent tous les éléments associés à un 
projet, dont ses fichiers audio, les données MIDI, 
ainsi que toutes les informations d'édition et de 
mixage. Rappelez-vous cependant qu'un fichier de 
session Pro Tools ne contient pas de fichier média 
(audio ou vidéo). En revanche, il fait référence aux 
fichiers audio, vidéo, MIDI et aux autres fichiers. 
Vous pouvez apporter des modifications à une 
session et les enregistrer dans un nouveau fichier 
de session. Vous pouvez ainsi créer plusieurs 
versions d'une session ou créer des copies de 
sauvegarde de votre travail d'édition et de mixage. 

Icône de fichier de session
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Pistes
Les pistes de Pro Tools permettent d'enregistrer et 
d'éditer les données audio, MIDI, vidéo et 
d'automation. Elles fournissent également des 
canaux audio pour le routing sur des bus internes, 
ainsi que des entrées et sorties physiques pour les 
données audio et MIDI.

Pro Tools propose plusieurs types de pistes : 
audio, d'entrée auxiliaire, Master Fader, Master 
VCA, MIDI, d'instrument et vidéo.

Les données des pistes audio, MIDI, d'instrument 
et vidéo peuvent être éditées en clips ou répétées 
à des emplacements différents afin de créer des 
boucles, de réarranger des passages ou des 
chansons entières, ou d'assembler des pistes en 
piochant dans différentes prises. 

Les pistes d'entrée auxiliaire permettent de router 
des bus audio internes ou des entrées physiques 
vers des bus internes ou des sorties physiques. 
Les entrées auxiliaires sont généralement utilisées 
pour les bus d'effets audio, la sortie audio 
(monitoring) et les sous-groupes de mixage.

Les pistes Master Fader fournissent des 
commandes pour les canaux de sortie audio 
physiques, y compris des réglages du niveau de 
volume pour le mixage, le panoramique et les 
inserts de plug-in.

Les pistes Master VCA (Pro Tools HD 
uniquement) permettent de contrôler les pistes d'un 
groupe de mixage assignées au Master VCA.

Les pistes vidéo prennent en charge les séquences 
QuickTime (tous les systèmes Pro Tools) et les 
fichiers vidéo VC-1 (Windows uniquement). 
De plus, Pro Tools gère les vidéos Avid par le biais 
du moteur AVE (Avid Video Engine), nativement 
ou via un périphérique vidéo Avid pris en charge. 
Une piste vidéo individuelle peut uniquement lire 
un type de vidéo à la fois.

Les pistes audio, d'entrée auxiliaire, Master Fader 
et d'instrument peuvent être mono, stéréo ou 
multicanal (Pro Tools HD uniquement). Lors de la 
création d'une piste, sélectionnez son format dans 
la liste de formats pris en charge par votre système.

Voix
Dans Pro Tools, les voix correspondent à des flux 
audio uniques et séparés pouvant être routés depuis 
et vers les pistes audio de Pro Tools ou les entrées 
et sorties audio physiques de vos interfaces audio 
Pro Tools. Les chemins audio routés depuis et vers 
le logiciel Pro Tools et envoyés au matériel 
Pro Tools utilisent des voix. Si vous dépassez le 
nombre de voix disponibles dans le système, vous 
dépassez en réalité le nombre de chemins audio 
disponibles. Les voix sont assignées de manière 
dynamique. 

Piste audio dans la fenêtre Edit (piste stéréo) 

Piste MIDI dans la fenêtre Edit

Piste vidéo en vue Frames
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Chaque canal audio de chacune des pistes de votre 
session Pro Tools utilise en général une seule voix. 
Ainsi, une seule voix est utilisée pour une piste 
audio mono, et deux pour une piste stéréo. Lorsque 
vous effectuez un enregistrement en punch-in/out, 
deux voix sont nécessaires pour chaque canal 
audio (une pour la lecture et une pour 
l'enregistrement, aux points d'entrée et de sortie de 
l'opération de punch). Dans certains cas, avec les 
systèmes Pro Tools|HDX, plusieurs voix peuvent 
être nécessaires pour un canal unique (lors de 
l'utilisation d'un traitement hôte sur un bus DSP, 
par exemple).

Sur les systèmes Pro Tools|HDX, le nombre de 
voix disponibles dépend de la capacité de 
traitement DSP dédiée du système (reportez-vous 
à la section « Limites applicables à la lecture, à 
l'enregistrement et aux voix avec Pro Tools HD » 
à la page 44).

Sur tous les autres systèmes Pro Tools, le nombre 
total de voix disponibles pour votre système peut 
être limité par la puissance de traitement de 
l'ordinateur (reportez-vous à la section « Capacités 
de Pro Tools avec différentes configurations 
matérielles » à la page 41).

Fichiers média
Les sessions Pro Tools créent, importent, 
exportent et référencent des fichiers média. 
Les fichiers média peuvent être des fichiers audio, 
MIDI et vidéo. Les fichiers média audio et vidéo 
sont stockés séparément du fichier de session 
Pro Tools. Les données MIDI sont stockées dans le 
fichier de session.

Fichiers audio

Lorsque vous enregistrez de l'audio dans une 
session Pro Tools, des fichiers audio sont créés. 

Les fichiers audio de chaque session sont stockés 
dans un dossier nommé « Audio Files ». 
Les fichiers audio sont répertoriés dans la liste 
des clips de Pro Tools et peuvent être utilisés 
sur une piste audio. Une section de fichier 
audio est appelée un clip. Reportez-vous à la 
section « Clips » à la page 11.

Fichiers MIDI

Lorsque vous enregistrez ou entrez des données 
MIDI dans une session Pro Tools, toutes les 
données MIDI sont stockées dans le fichier de 
session Pro Tools. Vous pouvez importer et 
exporter des fichiers MIDI dans, ou à partir de 
sessions Pro Tools, mais le MIDI enregistré ou 
créé d'une autre manière dans une session 
Pro Tools ne crée pas automatiquement de 
nouveaux fichiers MIDI.

Pour en savoir plus sur l'utilisation des 
voix dans Pro Tools, reportez-vous à la 
section « Priorité des pistes et assignation 
des voix » à la page 239.

Icône de fichier audio

Icône de fichier MIDI



Chapitre 2 : Concepts de Pro Tools 11

Fichiers vidéo

Lorsque vous enregistrez ou importez une vidéo 
dans une session Pro Tools, toutes les données 
vidéo sont stockées au format de fichier vidéo 
correspondant (tel que QuickTime). Les fichiers 
vidéo peuvent être créés (ou copiés) dans le dossier 
Video Files du dossier de la session. Cependant, 
dans la plupart des cas, Pro Tools référence les 
fichiers vidéo qui ont été capturés à l'aide d'une 
autre application, telle qu'Avid Media Composer®.

Clips
Un clip correspond à un segment de données 
audio, MIDI ou vidéo. Un clip peut contenir une 
boucle de batterie, un riff de guitare, un couplet de 
chanson, une prise d'enregistrement, un effet 
sonore, des dialogues ou un fichier audio entier. 
Les clips sont particulièrement utiles pour 
manipuler les données audio et MIDI. Il est 
également possible d'associer des données 
d'automation à un clip. Dans Pro Tools, les clips 
sont créés à partir de fichiers audio ou de données 
MIDI, et peuvent être manipulés sur des playlists 
de pistes audio et MIDI. Les clips peuvent 
également être groupés (un « clip de clips ») et mis 
en boucle (répétés).

Playlists
Une playlist est une séquence de clips positionnés 
sur une piste audio, MIDI ou vidéo. Les pistes 
possèdent des playlists d'édition et des playlists 
d'automation. 

Clip audio

Clip MIDI

Clip vidéo (vue Frames)

Groupe de clips (groupe mixte de clips audio et MIDI 
multipiste)

Menu déroulant du sélecteur de playlist
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Pour les pistes audio, une playlist d'édition indique 
au disque dur quels clips audio lire et dans quel 
ordre. Des clips audio distincts peuvent par 
exemple être utilisés pour l'intro d'une chanson, 
le premier couplet, le premier refrain, etc. Vous 
pouvez ainsi utiliser le même clip audio pour 
accéder à la même portion d'audio à plusieurs 
reprises et à plusieurs emplacements, sans 
consommer d'espace disque supplémentaire. 
Plusieurs versions des mêmes données audio 
peuvent être utilisées à différents endroits et des 
effets variés peuvent leur être appliqués. Dans le 
cas des pistes MIDI et des pistes d'instrument, 
les playlists d'édition permettent de stocker 
plusieurs séquences MIDI (ou performances) 
sur une piste.

Une playlist peut contenir un seul clip ou plusieurs 
clips distincts. Elle peut être constituée d'éléments 
de nature similaire, comme par exemple des clips 
de prises différentes d'un solo, ou variée, comme 
plusieurs effets sonores différents. 

Vous pouvez créer autant de playlists d'édition que 
vous le souhaitez sur une piste. Vous pouvez ainsi 
assembler différentes versions d'interprétations ou 
d'éditions sur une même piste et sélectionner celle 
de votre choix à partir du menu des playlists de 
la piste.

Chaque piste audio, d'entrée auxiliaire, d'instrument, 
Master Fader et VCA dispose également d'un seul 
ensemble de playlists d'automation. Les playlists 
d'automation peuvent contrôler les commandes de 
volume, de panoramique, de mute et d'automation 
pour les assignations d'inserts et de départs de la piste 
correspondante.

Les données de contrôleur MIDI sur les pistes 
d'instrument et MIDI sont toujours incluses dans la 
playlist de la piste.

Canaux
Le terme canal peut avoir plusieurs sens différents, 
selon le composant d'un système Pro Tools auquel 
il se réfère. 

Dans son sens premier, le mot canal désigne une 
entrée ou une sortie physique de votre système 
Pro Tools. Une interface HD I/O, par exemple, 
offre 16 canaux d'entrée et de sortie audio pour un 
système Pro Tools|HDX ou Pro Tools|HD Native, 
alors qu'une interface audio Mbox Pro fournit un 
maximum de huit entrées et huit sorties.

La seconde utilisation du terme canal fait 
référence à une tranche de la fenêtre Mix de 
Pro Tools. Chaque piste d'une session Pro Tools 
est représentée sous la forme d'une tranche dans la 
fenêtre Mix.

Les tranches audio et MIDI présentent des 
commandes semblables, mais elles ont des effets 
légèrement différents. Par exemple, les faders de 
tranches audio, d'entrée auxiliaire et d'instrument 
contrôlent le gain de sortie du canal envoyé sur le 
bus de mixage, alors que les faders de tranches 
MIDI envoient des données de volume MIDI 
(contrôleur MIDI 7) à l'instrument MIDI 
sélectionné. 

Le terme « canal MIDI » s'applique également 
à un aspect distinct du MIDI. Reportez-vous à 
la section « MIDI » à la page 7.
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Routing du signal
Pro Tools met à disposition des commandes 
logicielles de routing des signaux et de mixage pour 
l'audio et le MIDI. Ces commandes sont situées dans 
la fenêtre Mix. Certaines de ces commandes sont 
également accessibles à partir de la fenêtre Edit.

Une tâche courante de routing du signal audio 
consiste à regrouper plusieurs pistes sur une seule 
tranche (une entrée auxiliaire par exemple), afin de 
partager les mêmes traitements et la même commande 
de niveau. Dans l'exemple suivant, deux pistes audio 
sont groupées sur une entrée auxiliaire stéréo.

Tranche de la fenêtre Mix (piste audio)

Sous-groupe de mixage sur une entrée auxiliaire

Entrée 
provenant 
d'un bus 
stéréo

Sorties 
vers un bus 
stéréo

Inserts

Départs

Pistes audio Piste d'entrée auxiliaire
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Options de routing du signal

Les options de routing du signal sont les 
suivantes :

Sélecteurs d'entrée et de sortie (I/O) de piste : le 
routing de signal le plus simple consiste à 
sélectionner l'entrée et la sortie de la piste. Afin 
d'enregistrer de l'audio, un chemin d'entrée doit 
être spécifié sur une piste. Pour pouvoir entendre le 
retour d'une piste enregistrée, un chemin de sortie 
mappé doit également être assigné. Les signaux 
peuvent également être routés vers ou depuis 
d'autres pistes dans Pro Tools (ou entrées et sorties 
matérielles) à l'aide des bus internes.

Pistes d'entrée auxiliaire et Master Fader : les 
entrées auxiliaires peuvent servir de retours, 
de sous-groupes de mixage et de bus masters. 
Les pistes Master Fader servent à contrôler les 
niveaux généraux des bus et des sorties. Les pistes 
d'entrée auxiliaire et Master Fader peuvent 
posséder des inserts plug-in et matériels.

Pistes MIDI : les pistes MIDI sont généralement 
utilisées pour router les données MIDI d'une 
source interne ou externe vers un périphérique 
MIDI externe. Les données MIDI peuvent 
également être routées vers des plug-ins sur des 
pistes d'entrée auxiliaire ou d'instrument.

Pistes d'instrument : les pistes d'instrument sont 
la principale façon de router des données MIDI 
vers un plug-in d'instrument, puis de router le son 
du plug-in vers les sorties, départs, bus ou autres 
inserts. Les pistes d'instrument peuvent être 
également utilisées pour envoyer des données 
MIDI vers des périphériques MIDI externes et 
prendre en charge le monitoring audio de ces 
périphériques.

Départs : les départs envoient les données audio 
des pistes vers des sorties matérielles ou des bus 
internes eux-mêmes routés vers d'autres pistes de 
Pro Tools. Les pistes MIDI, Master Fader et 
Master VCA n'ont pas de départs.

Inserts de plug-in et matériels : le traitement des 
plug-ins s'effectue entièrement dans le système 
Pro Tools. Les inserts matériels doivent être 
connectés à des entrées et sorties d'une interface 
audio, pour former un circuit d'insert classique 
entre des effets externes et d'autres périphériques. 
Les pistes MIDI et Master VCA n'ont pas d'inserts.

Plug-ins d'instrument : les plug-ins d'instrument 
sont différents des plug-ins de traitement dans le 
sens où ils génèrent de l'audio plutôt que de traiter 
le signal audio provenant de l'entrée audio de la 
piste ou du disque dur. Généralement, les sons des 
plug-ins d'instrument sont déclenchés par des 
données MIDI.

Chemins : les chemins correspondent aux choix de 
routing de Pro Tools, dont les entrées, sorties, bus et 
inserts internes ou externes. Pro Tools permet 
d'attribuer un nom à ces chemins. Les noms des 
chemins seront affichés dans les sélecteurs 
d e chemin d'entrée et de sortie audio, ainsi que 
dans d'autres menus. Pour plus d'informations, 
reportez-vous au chapitre Chapitre 7, « I/O Setup ».

Formats de mixage : les sessions peuvent contenir 
des pistes, bus, entrées, sorties et inserts de formats 
mono, stéréo et multicanal (supérieur à stéréo) 
différents. Les formats multicanal supérieurs 
à stéréo sont uniquement pris en charge dans 
Pro Tools HD.

Groupes et pistes VCA : des pistes peuvent être 
groupées pour le mixage. Leurs réglages 
individuels relatifs seront ainsi maintenus lorsque 
vous modifierez une commande d'une piste du 
groupe. Lorsque vous modifiez par exemple le 
volume d'une piste, cela affecte également le 
volume de toutes les autres pistes du groupe. 
Les pistes Master VCA (Pro Tools HD 
uniquement) permettent de contrôler les 
paramètres de mixage de toutes les pistes du 
groupe sélectionné, de manière relative.
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Références temporelles 
basées sur le tempo et les 
échantillons
Dans Pro Tools, vous pouvez définir les bases de 
temps des pistes sur les échantillons ou les 
références de tempo. Vous pouvez également 
choisir le mode d'affichage de la timeline, basée 
sur le tempo ou les échantillons.

Par défaut, les données audio de Pro Tools sont 
basées sur les échantillons. Cela signifie que si un 
clip audio est situé à une position donnée, exprimée 
en échantillons, il ne bougera pas si le tempo de la 
session est modifié, bien que sa position exprimée 
en mesures et en temps soit modifiée.

Les données MIDI de Pro Tools sont basées par 
défaut sur le tempo. Cela signifie que si un clip 
MIDI est situé à une position donnée, exprimée en 
mesures et en temps, il ne bougera pas si le tempo 
de la session est modifié, bien que sa position 
exprimée en échantillons soit modifiée.

Vous pouvez décider si une piste doit être basée 
sur des échantillons ou sur des références de tempo 
lors de sa création, ou choisir de modifier la base 
de temps ultérieurement. 

Audio et MIDI basés sur les 
échantillons
Tous les clips d'une piste audio basée sur les 
échantillons sont définis par un emplacement 
absolu sur la timeline. Les clips ne bougent pas par 
rapport à leur position en échantillons, que le 
tempo et la métrique soient modifiés ou non au 
cours de la session.

Si vous choisissez de baser une piste MIDI sur les 
échantillons, tous ses événements MIDI seront définis 
par un emplacement absolu sur la timeline. Les 
événements MIDI ne bougent pas par rapport à leur 
position en échantillons, que le tempo et la métrique 
soient modifiés ou non au cours de la session.

Audio et MIDI basés sur les 
références de tempo
L'audio basée sur les références de tempo est 
positionné sur un emplacement exprimé en 
mesures et en temps et se déplace relativement 
à la timeline en échantillons lorsque le tempo 
et la métrique sont modifiés. Cependant, 
les événements MIDI et l'audio basés sur le 
tempo se comportent différemment en cas de 
modification du tempo, en termes de durée. 
La durée des événements de note MIDI est 
modifiée en fonction des changements de tempo 
ou de métrique, alors que ce n'est pas le cas des 
clips audio (à moins que le traitement Elastic 
Audio ne soit activé). Lorsque le traitement Elastic 
Audio n'est pas activé sur une piste audio, 
les changements de métrique et de tempo ont un 
impact uniquement sur le point de début (ou point 
de synchro) de chaque clip audio d'une piste basée 
sur le tempo. Si le traitement Elastic Audio est 
activé sur une piste audio, il est appliqué dès qu'un 
changement de tempo survient, ce qui modifie la 
durée du clip audio.

Elastic Audio
Le traitement Elastic Audio applique une 
compression ou extension temporelle (Time 
Compression and Expansion, TCE) à l'audio, 
en temps réel ou non (rendu). Sur les pistes Elastic 
Audio basées sur le tempo, la position en 
échantillons change avec le tempo. L'audio est 
étiré ou compressé afin de s'adapter au tempo. 
Le traitement Elastic Audio peut également être 
utilisé pour appliquer aux clips une modification de 
hauteur (pitch shifting) haute qualité non temps réel.
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Le traitement Elastic Audio de Pro Tools est basé 
sur des algorithmes de détection des transitoires, 
d'analyse rythmique et du tempo et de traitement 
TCE en temps réel ou rendu de haute qualité. 
Le traitement Elastic Audio permet de conformer 
facilement et rapidement l'audio au tempo et à la 
métrique de la règle de tempo de la session. Il offre 
également un degré de contrôle inégalé sur la 
détection des transitoires et le traitement TCE 
événement par événement.

Pour le traitement Elastic Audio, Pro Tools 
analyse l'intégralité des fichiers audio pour 
détecter leurs événements transitoires. 
Un événement peut par exemple être un son de 
batterie, une note chantée ou un accord de guitare. 
Ces événements détectés peuvent servir de points 
de contrôle pour la « déformation » de l'audio. 
Pro Tools peut déformer automatiquement des 
événements audio (TCE), par exemple lors de la 
conformation automatique de l'audio au tempo de 
la session ou lors de la quantification des 
événements audio. La déformation de l'audio peut 
également être effectuée manuellement à l'aide des 
outils d'édition standard, lorsque la piste audio est 
en vue Warp.

Le traitement Elastic Audio est utile pour plusieurs 
workflows courants : manipulation des boucles, 
mise en place de prises, remixage, beatmatching, 
correction de la hauteur, sound design et effets 
spéciaux. 

Ressources système
Le nombre de pistes, le traitement des plug-ins, 
les options de chemin et de routing des signaux 
ainsi que la disponibilité des voix sont finalement 
limités par les ressources de l'ordinateur hôte et de 
votre matériel Pro Tools. 

Pro Tools offre plusieurs manières de gérer et de 
conserver des ressources pour optimiser les 
performances de votre système. Lorsque vous 
commencez à travailler avec des sessions et des 
pistes Pro Tools, les fonctions suivantes vous 
permettront d'augmenter le rendement des 
ressources DSP et des autres ressources 
disponibles :

 Les performances de votre système Pro Tools 
peuvent être ajustées en configurant les paramètres 
système qui affectent ses capacités de traitement, 
de lecture et d'enregistrement. Reportez-vous à la 
section « Configuration des paramètres système de 
Pro Tools » à la page 52.

 Pro Tools permet de désactiver manuellement 
certains éléments de la session (tels que des pistes 
et des inserts), afin de libérer des ressources DSP. 
Les éléments désactivés sont visibles, peuvent 
être édités et sont conservés dans la session. 
Reportez-vous à la section « Éléments activés et 
désactivés » à la page 17.

 Tous les systèmes Pro Tools proposent des 
options de gestion des voix flexibles pour les pistes 
audio, afin d'optimiser l'utilisation des voix 
disponibles dans votre système. Pour plus 
d'informations sur la gestion et les options des 
voix, reportez-vous à la section « Priorité des 
pistes et assignation des voix » à la page 239. 
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Éléments activés et désactivés
Pro Tools permet de désactiver certains éléments, 
tels que des pistes ou inserts, afin de libérer des 
ressources DSP et des connexions du mixeur. 

Les éléments de Pro Tools qui peuvent être 
désactivés sont les suivants :

• pistes audio, d'entrée auxiliaire, d'instrument, 
Master Fader, Master VCA ;

• entrées et sorties de piste ;

• départs ;

• entrées side chain ;

• plug-ins ;

• inserts matériels ;

• chemins (à l'échelle de la session).

En plus d'autoriser l'activation ou la désactivation 
manuelle, Pro Tools désactive automatiquement 
certains éléments lorsque les ressources sont 
insuffisantes ou indisponibles. 

Lorsqu'ils sont activés, les éléments sont 
entièrement opérationnels et fonctionnels.

Lorsqu'ils sont désactivés, les éléments n'émettent 
aucun son et ne sont pas opérationnels, bien que la 
plupart des commandes associées restent 
accessibles. Différents éléments désactivés ont une 
incidence sur les ressources disponibles du système.

Plug-ins : lorsqu'un plug-in est désactivé sur une 
piste, ses DSP est disponible pour d'autres plug-ins 
ou traitements. Les assignations des plug-ins 
peuvent être désactivées soit manuellement, soit 
automatiquement. 

Chemins et assignations : lorsqu'un chemin 
ou l'assignation d'un chemin est désactivé(e), 
les ressources du chemin sont libérées au niveau 
du mixeur pour le routing des signaux de la 
session. La désactivation des chemins et des 
assignations peut s'effectuer soit manuellement, 
soit automatiquement.

Pistes : lorsqu'une piste est désactivée, ses voix 
sont disponibles pour une autre piste. Les pistes 
mono désactivées libèrent une voix, tandis que les 
pistes stéréo et multicanal libèrent une voix par 
canal. De plus, lorsqu'une piste audio, d'entrée 
auxiliaire, d'instrument ou un Master est désactivé, 
ses plug-ins, inserts, départs et assignations d'E/S 
le sont également. Les ressources DSP associées 
sont donc également libérées et peuvent être 
utilisées par un autre élément de la session.

Les pistes MIDI ne peuvent pas être 
désactivées. 

Les entrées side chain peuvent être activées 
ou désactivées directement individuellement, 
mais leur état de commutation ne suit pas 
celui de l'ensemble ou d'une sélection 
d'entrées side chain.
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Affichage des éléments désactivés

Lorsque des éléments sont désactivés, leurs noms 
apparaissent en italique, sur fond gris foncé. 
Lorsqu'une piste est désactivée, la tranche entière 
est grisée.

Navigateurs de l'espace de 
travail
L'espace de travail est un outil de gestion de base 
de données pour Pro Tools. Les outils puissants 
des navigateurs de l'espace de travail étendent les 
capacités de recherche et d'importation de 
Pro Tools. Ils permettent de gérer les données 
internes et externes aux sessions, situées sur tout 
disque connecté au système.

Une base de données sert à organiser des données 
pour en faciliter la recherche, le tri, la gestion et 
l'utilisation. Par exemple, votre carnet de chèques 
peut être considéré comme un fichier de base de 
données. Chaque fois que vous faites un chèque, 
vous saisissez un nouvel enregistrement. Celui-ci 
contient des informations sur le chèque, comme la 
date d'émission, le bénéficiaire et le montant. 
Ces informations sont enregistrées dans des 
colonnes spécifiques, c'est-à-dire des champs. 
Bien que le chèque ne se trouve pas lui-même dans 
ces colonnes, vous disposez de toutes les 
informations nécessaires s'y rapportant 
(les métadonnées du chèque).

Les navigateurs de l'espace de travail permettent 
de gérer ou trier ces bases de données et d'y 
effectuer des recherches, par volume ou catalogue. 
Les navigateurs de l'espace de travail permettent 
d'organiser vos sessions Pro Tools et vos fichiers 
audio, MIDI et vidéo, mais également d'écouter les 
données et de les importer par glisser-déposer.

Pistes, plug-ins et départs activés et désactivés

Plug-in activé Plug-in désactivé 

Piste
désactivée 

Pour plus d'informations, reportez-vous au 
Chapitre 16, « Navigateurs de l'espace 
de travail ».
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AAF, MXF et OMF
Pro Tools permet d'échanger de l'audio, des vidéos 
et des séquences avec d'autres applications 
compatibles AAF, MXF et OMF, telles que les 
systèmes de montage Avid.

Données média (fichiers média)
Les données média correspondent aux données 
audio ou vidéo brutes et sont stockées dans des 
fichiers média individuels. Un fichier média 
contenant des données média est créé dès que vous 
enregistrez des données vidéo ou audio dans une 
application. Les fichiers média audio sont formés 
d'échantillons (44 100 ou 48 000 échantillons par 
seconde d'enregistrement), tandis que les fichiers 
média vidéo sont formés d'images (24, 25 ou 
30 images par seconde d'enregistrement).

La taille de chaque fichier média dépend des 
données audio et vidéo qu'il contient. Un fichier 
contenant dix minutes de vidéo haute résolution, 
par exemple, peut avoir une taille d'environ 2 Go, 
tandis qu'un enregistrement audio de dix minutes 
peut tenir dans un fichier de 100 Mo. Les fichiers 
média sont plutôt volumineux, puisque les signaux 
audio et vidéo contiennent une grande quantité de 
données. En général, les données vidéo requièrent 
bien plus d'espace de stockage que les données 
audio.

Métadonnées
Le terme métadonnées est utilisé pour décrire les 
éléments suivants :

• des informations intégrées dans un fichier 
média, notamment sur les scènes, prises, 
la fréquence d'échantillonnage, la résolution, 
les noms de clips externes, le nom de la bande 
vidéo à partir de laquelle le fichier média a été 
capturé et même des valeurs de timecode ;

• des informations intégrées dans des sessions 
Pro Tools ou autres séquences, notamment le 
nom des fichiers utilisés, leur position dans la 
timeline et l'automation ;

• pour les séquences AAF ou OMF, les métadonnées 
incluent également des informations intégrées dans 
des effets AudioSuite™ non rendus (tels qu'une 
égalisation en temps réel) sur les stations de travail 
Avid. Pro Tools ignore les effets non rendus lors de 
l'importation. Les effets rendus sont des fichiers 
média, qui peuvent être importés dans Pro Tools ;

• des informations sur l'automation (gain des clips 
ou des images clés), dans le cas de séquences 
AAF ou OMF.

Formats d'échange AAF, OMF et 
MXF
Les formats AAF et OMF permettent de stocker et 
de récupérer des fichiers média et des métadonnées 
afin que les projets puissent être échangés 
librement entre différentes applications et 
plateformes. Le format de fichier média MXF peut 
être utilisé avec des fichiers AAF (mais pas OMF).

Les données média et les métadonnées permettent 
à l'application qui reçoit les fichiers de séquence 
AAF et OMF (Pro Tools, par exemple) de 
reconstruire la composition automatiquement et 
rapidement. Pour employer une métaphore simple, 
les fichiers de données média représentent les 
pièces d'un puzzle et les métadonnées les 
instructions permettant de les assembler.

Dans le plus simple des cas, seule la séquence AAF 
ou OMF est échangée. Si elle fait référence à des 
fichiers média existants, la taille du fichier de 
séquence est relativement réduite, et l'exportation 
ou l'importation relativement rapide. 
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Les séquences AAF et OMF peuvent également 
intégrer des données média. Cette opération crée 
un fichier unique plus volumineux, qui ralentit 
l'exportation et l'importation, mais qui est bien plus 
facile à gérer que des milliers de fichiers stockés 
sur différents volumes.

AAF

AAF est un format de fichier de séquence. 
Les séquences AAF sont le moyen le plus pratique 
pour échanger des projets et de conserver des 
métadonnées importantes. Une séquence AAF 
peut se référer à des fichiers média OMF ou MXF 
ou intégrer des fichiers de ce type. Il n'existe pas de 
fichier média AAF audio ou vidéo.

Pro Tools peut importer, lire et exporter une 
séquence AAF liée à des fichiers média ou 
intégrant des fichiers audio.

Lorsque vous importez une séquence AAF 
intégrant des données audio dans Pro Tools, 
les données sont extraites sous forme de pistes 
mono au format de fichier audio de la session 
en cours.

MXF

MXF est un format de fichier média. Il existe des 
fichiers vidéo MXF et des fichiers audio MXF, 
mais pas de séquences MXF. Une séquence AAF 
peut se référer à ou inclure des fichiers média MXF 
mais les séquences OMF ne peuvent pas se référer 
à des fichiers MXF ou intégrer de tels fichiers.

Pro Tools peut importer et lire les fichiers MXF 
audio et vidéo créés dans Media Composer ou 
d'autres applications Avid.

OMF

OMF est à la fois un fichier média et un format de 
séquence. Les fichiers média OMF peuvent 
contenir de l'audio ou de la vidéo et Pro Tools peut 
lire l'audio au format OMF, mais pas la vidéo. 
Pro Tools peut également exporter des fichiers 
audio OMF, mais pas des fichiers vidéo OMF.

Pro Tools peut importer et lire des fichiers OMF 
audio créés dans Media Composer ou d'autres 
applications.

Une séquence OMF ne peut pas se référer à des 
fichiers média MXF ou intégrer ce type de fichier.

Pro Tools peut importer une séquence OMF avec 
audio intégré, mais pas une séquence avec vidéo 
intégrée.

Icône de fichier MXF
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Terminologie de Pro Tools et 
Media Composer
Dans Pro Tools et Avid Media Composer®, 
des termes différents sont utilisés pour désigner le 
même type d'élément. Une session Pro Tools, 
par exemple, est l'équivalent d'une séquence Avid. 
Le tableau suivant dresse la liste des éléments 
courants de Pro Tools et de leurs équivalents Avid.

Pro Tools Avid (AAF ou OMF)

session séquence

clip de fichier entier master clip

clip sous-clip

plug-in effet audio en temps 
réel

gain d'automation de 
volume

volume d'image clé Avid

Les noms des fichiers audio entiers de la liste 
des clips sont affichés en gras. Cependant, 
les noms des fichiers audio de master clips 
importés au format AAF ou OMF dans 
Pro Tools ne sont pas affichés en gras (format 
réservé aux clips) dans la liste des clips de 
Pro Tools, même s'il s'agit de fichiers audio.
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Médias intégrés et médias liés
Les fichiers AAF et OMF peuvent être de deux types : fichiers avec médias intégrés et fichiers avec 
médias liés. 

Médias intégrés
L'exportation au format OMF ou AAF avec médias intégrés génère un fichier OMF ou AAF volumineux 
contenant à la fois les métadonnées et tous les fichiers média associés.

Workflow d'échange AAF/OMF avec médias intégrés

Séquence montée sur une station 
de travail Avid

Fichiers média source originaux

Un fichier AAF/OMF intégré (métadonnées et médias)

Une exportation AAF/OMF avec 
médias intégrés crée...

Fichiers média consolidés 
(avec poignées)

Séquence (métadonnées)

Se réfère à :
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Médias liés
L'exportation au format AAF ou OMF avec médias liés génère un fichier de métadonnées unique 
(.AAF ou .OMF) et tous les médias associés sont stockés dans des fichiers distincts.

Le principal avantage de cette méthode est qu'elle réduit le nombre de fichiers média nécessaires, ce qui 
accélère l'exportation et l'importation. Vous serez donc probablement moins confronté à des limites de 
taille de fichier, puisque les données sont divisées en plusieurs fichiers de petite taille.

Le principal inconvénient de cette méthode est que vous devrez transférer un nombre de fichiers plus 
important entre les systèmes (un fichier AAF ou OMF et des centaines de fichiers média, par exemple).

Workflow d'échange AAF et OMF avec médias liés

Séquence montée sur une station 
de travail Avid

Fichiers média source originaux

Exportation du montage de 
la séquence et des infos de 
fichier sous la forme d'une 

séquence AAF ou OMF

Fichier AAF/OMF (métadonnées uniquement)

Pro Tools importe le 
fichier de session

Fichier de session Pro Tools converti Lié
 à

:

Liée à
:

Lié à :
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Chapitre 3 : Raccourcis clavier et souris

De nombreux raccourcis clavier et contextuels 
sont accessibles dans Pro Tools® pour plus de 
rapidité et de simplicité d'utilisation.

Une liste complète des raccourcis de Pro Tools est 
disponible dans l'aide en ligne, ainsi que dans un 
Guide au format PDF.

Pour accéder à la liste complète des raccourcis de 
Pro Tools de l'aide en ligne :

1 Sélectionnez Help > Pro Tools Help.

2 Cliquez sur Raccourcis Pro Tools dans la table 
des matières (panneau de gauche de la fenêtre 
de l'aide).

Pour accéder à la liste complète des raccourcis de 
Pro Tools du Guide des raccourcis Pro Tools :

 Sélectionnez Help > Shortcuts.

Raccourcis de la souris
Raccourcis de menu contextuel

Pro Tools donne accès à divers menus et 
commandes répartis dans des menus contextuels 
qui s'ouvrent en effectuant un clic droit. 

Fonctions de la molette

Il est possible dans Pro Tools d'augmenter ou de 
diminuer les valeurs de champs numériques en les 
sélectionnant, puis en faisant tourner la molette de 
votre souris vers le haut ou le bas. 

Commandes clavier 
générales
Certains raccourcis clavier s'appliquent à de 
nombreuses fonctions dans Pro Tools.

Fonctions des pistes

Pro Tools propose des raccourcis clavier pour les 
fonctions de piste suivantes :

• Changement de mode d'automation

• Activation des playlists

• Ajout de plug-ins

• Préparation à l'enregistrement, mise en solo et 
mute des pistes

• Protection contre l'enregistrement et de l'état 
solo des pistes

• Assignation des entrées, sorties et départs

• Affichage du volume/niveau crête/délai

• Réinitialisation des indicateurs de niveau

• Modification de la hauteur des pistes

Pour obtenir une liste complète des 
raccourcis contextuels, reportez-vous au 
Guide des raccourcis.

Pour obtenir une liste complète des 
raccourcis clavier, reportez-vous au Guide 
des raccourcis.
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Sélection de paramètres et de listes

Pro Tools propose des raccourcis clavier pour les 
éléments suivants :

• Sélection de pistes dans la liste des pistes

• Activation de groupes dans la liste de groupes

• Paramètres de la fenêtre d'activation de 
l'automation

• Paramètres de définition des emplacements 
mémoire

Commandes et outils d'édition

Pro Tools propose des raccourcis clavier pour agir 
sur les commandes de plug-in, les faders et les 
curseurs, l'outil de scrubbing et les données 
d'automation.

Focus clavier
Le focus clavier de Pro Tools détermine la cible 
des touches alphanumériques. Selon l'élément sur 
lequel le focus clavier est activé, vous pouvez 
utiliser les touches de votre clavier 
alphanumérique pour sélectionner des clips de la 
liste des clips, activer ou désactiver des groupes ou 
exécuter une commande d'édition ou de lecture.

Un seul des trois modes de focus clavier peut être 
activé à la fois. L'activation d'un focus clavier 
désactive le focus activé précédemment.

Pro Tools propose trois types de focus clavier :

Focus clavier sur les commandes : lorsque cette 
option est sélectionnée dans le volet des pistes de 
la fenêtre Edit ou dans le volet Notes d'une fenêtre 
de l'éditeur MIDI, de nombreux raccourcis clavier 
à une touche sont disponibles pour l'édition et la 
lecture. La fenêtre Edit ou de l'éditeur MIDI au 
premier plan reçoit toujours les commandes 
lorsque le focus clavier est activé.

Lorsque le focus clavier sur les commandes est 
désactivé, vous avez toujours accès à n'importe 
lequel de ses raccourcis clavier en maintenant la 
touche Ctrl (Mac) ou Démarrer (Windows) 
enfoncée pendant que vous appuyez sur la touche 
appropriée. Pour obtenir une liste complète des 
raccourcis lorsque le focus clavier est activé sur les 
commandes, reportez-vous au Guide des 
raccourcis.

Commande Windows Mac

Appliquer l'action 
à toutes les 
tranches/pistes

Alt+action Option+
action

Appliquer l'action 
uniquement aux 
tranches/pistes 
sélectionnées

Alt+Maj+
action

Option+
Maj+
action

Commande Windows Mac

Basculer un élément 
ainsi que tous les 
autres sur un 
nouvel état

Alt+clic sur 
l'élément

Option+
clic sur 
l'élément

Basculer un élément 
sur un état et tous 
les autres sur l'état 
inverse

Ctrl+clic 
sur 
l'élément

Commande+
clic sur 
l'élément

Commande Windows Mac

Ajustement 
précis des 
curseurs, 
boutons et points 
d'automation

Ctrl+clic sur 
l'élément

Commande+
clic sur 
l'élément
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Focus clavier sur la liste des clips : lorsque cette 
option est sélectionnée, vous pouvez rechercher 
et sélectionner des clips audio, des clips MIDI et 
des groupes de clips dans la liste des clips en tapant 
les premières lettres de leur nom.

Focus clavier sur la liste des groupes : lorsque 
cette option est sélectionnée, vous pouvez activer 
ou désactiver les groupes d'édition et de mixage en 
tapant leur lettre d'ID (dans la fenêtre Mix ou Edit).

Pour activer le focus clavier, effectuez l'une des 
opérations suivantes :

 Cliquez sur le bouton a-z correspondant au 
focus à activer.

 Maintenez les touches Ctrl+Alt (Windows) 
ou Commande+Option (Mac) enfoncées et 
appuyez sur l'une des touches suivantes : 
1 (commandes), 2 (liste des clips) ou 3 (liste des 
groupes).

Focus sur la barre d'outils
Dans la fenêtre Edit, le volet de l'éditeur MIDI peut 
être affiché avec le volet des pistes (View > Other 

Displays > MIDI Editor). Lorsque le volet de 
l'éditeur MIDI est affiché, deux barres d'outils et 
deux timelines distinctes sont visibles dans la 
fenêtre Edit : une pour le volet des pistes et une 
pour le volet de l'éditeur MIDI. Le focus ne peut 
s'appliquer simultanément qu'à une seule barre 
d'outils et une timeline pour les commandes des 
menus et de la barre d'outils (y compris pour les 
raccourcis clavier correspondants). La barre 
d'outils en focus est encadrée en jaune. 

Si le focus clavier est activé sur la fenêtre Edit, 
il suit le focus de la barre d'outils sélectionné.

Pour activer le focus sur la barre d'outils du volet 
des pistes, effectuez l'une des opérations 
suivantes :

 Cliquez sur la barre d'outils située en haut de la 
fenêtre Edit.

 Appuyez sur les touches Ctrl+Alt+4 (Windows) 
ou Commande+Option+4 (Mac).

Pour activer le focus sur la barre d'outils du volet 
de l'éditeur MIDI, effectuez l'une des opérations 
suivantes :

 Cliquez sur la barre d'outils située juste 
au-dessus du volet de l'éditeur MIDI.

 Appuyez sur les touches Ctrl+Alt+5 (Windows) 
ou Commande+Option+5 (Mac).

Boutons de focus clavier

Bien qu'il soit possible d'activer un focus 
clavier sur plusieurs fenêtres de plug-in, 
la saisie au clavier s'applique uniquement à la 
fenêtre située au premier plan.

Focus clavier
sur la liste des clips

Focus clavier
sur la liste des groupes

Focus clavier sur les 
commandes (fenêtre Edit)



Guide de référence Pro Tools28

Modes du pavé numérique
Les préférences de fonctionnement du mode du 
pavé numérique déterminent son comportement de 
contrôle du transport.

Deux modes de shuttle verrouillé sont disponibles 
(Classic et Transport), plus un mode de shuttle.

Quel que soit le mode sélectionné, vous pouvez 
toujours utiliser le pavé numérique pour sélectionner 
et saisir des valeurs dans les champs de la zone 
d'édition des événements, des indicateurs de 
sélection d'édition, des compteurs principal et 
secondaire et du transport.

Pour définir le mode du pavé numérique :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Dans la section Transport, sélectionnez le mode 
de pavé numérique (Classic, Transport ou 
Shuttle).

3 Cliquez sur OK. 

Modes de shuttle verrouillé
Deux modes de shuttle verrouillé sont 
disponibles : Classic et Transport. Ces deux modes 
permettent d'utiliser le pavé numérique pour les 
opérations de shuttle avant ou arrière à des vitesses 
spécifiques.

• La touche 5 correspond à la vitesse normale.

• Les touches 6 à 9 permettent d'avancer à des 
vitesses progressivement plus rapides.

• Les touches 1 à 4 activent des vitesses de 
recherche arrière de plus en plus rapides 
(4 correspond à la vitesse de recherche arrière la 
plus lente et 1 à la plus rapide).

• Appuyez sur 0 pour interrompre l'opération de 
shuttle, puis sur une touche pour reprendre la 
recherche à la vitesse correspondante.

• Appuyez sur la touche Échap ou sur la barre 
d'espace pour quitter le mode de shuttle 
verrouillé.

Vitesse personnalisée de shuttle verrouillé

(Pro Tools HD uniquement)

Il est possible de personnaliser la vitesse de 
recherche avant la plus rapide (touche 9).

Mode Classic

Ce mode reproduit le mode de fonctionnement des 
versions de Pro Tools antérieures à 5.0. En mode 
de pavé numérique Classic, vous pouvez :

• lire jusqu'à deux pistes audio en mode de shuttle 
verrouillé ; appuyer sur la touche Ctrl (Mac) 
ou Démarrer (Windows), puis sur un chiffre 
de 1 à 9 pour sélectionner différentes vitesses 
de lecture ; 

• appuyer sur la touche Plus ou Moins pour 
inverser la direction ;

• appuyer sur 0 pour interrompre l'opération de 
shuttle, puis sur une touche pour reprendre la 
recherche à la vitesse correspondante ;

• appuyer sur la touche Échap ou sur la barre 
d'espace pour quitter le mode de shuttle 
verrouillé ;

• rappeler des emplacements mémoire en tapant 
leur numéro, suivi d'un point (.).

Pour plus d'informations, reportez-vous à la 
section « Vitesse personnalisée de shuttle 
verrouillé » à la page 571.
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Mode Transport

Ce mode permet d'exécuter un ensemble de 
fonctions d'enregistrement et de lecture et de 
piloter le transport depuis le pavé numérique.

En mode de pavé numérique Transport, vous 
pouvez également :

• lire jusqu'à deux pistes audio en mode de shuttle 
verrouillé ; appuyer sur la touche Ctrl (Mac) 
ou Démarrer (Windows), puis sur un chiffre 
de 1 à 9 pour sélectionner différentes vitesses 
de lecture ; 

• appuyer sur la touche Plus ou Moins pour 
inverser la direction ;

• appuyer sur 0 pour interrompre l'opération de 
shuttle, puis sur une touche pour reprendre la 
recherche à la vitesse correspondante ;

• appuyer sur la touche Échap ou sur la barre 
d'espace pour quitter le mode de shuttle 
verrouillé ;

• rappeler un emplacement mémoire en saisissant 
un point (.), le numéro de l'emplacement 
mémoire, puis un autre point (.).

Mode Shuttle
(Pro Tools HD uniquement)

Pro Tools propose une autre type de navigation par 
shuttle, différent des deux modes de shuttle 
verrouillé. Lorsque le pavé numérique est en mode 
Shuttle, la lecture de la sélection d'édition actuelle 
est déclenchée lorsque vous appuyez sur les 
touches du pavé numérique et se poursuit tant que 
vous les maintenez enfoncées ; la lecture s'arrête 
dès le relâchement des touches. Plusieurs vitesses 
de lecture avant et arrière sont disponibles. Dans ce 
mode, les plages de pré et post-roll sont ignorées.

Lorsque le pavé numérique est en mode Shuttle, 
vous pouvez également rappeler un emplacement 
mémoire en saisissant un point (.), son numéro, 
puis un autre point (.).

Fonction Touche

Activer/désactiver le clic 7

Activer/désactiver le décompte 8

Mode de fusion/remplacement MIDI 9

Activer/désactiver la lecture en boucle 4

Activer/désactiver l'enregistrement en 
boucle

5

Activer/désactiver le mode 
QuickPunch

6

Retour rapide 1

Avance rapide 2

Activation pour l'enregistrement 3

Lecture/Arrêt 0

Vitesses de lecture Touche

Avant 1x 6

Arrière 1x 4

Avant 4x 9

Arrière 4x 7

Avant 1/4x 3

Arrière 1/4x 1

Avant 1/2x 5+6

Arrière 1/2x 5+4

Avant 2x 8+9

Arrière 2x 8+7

Avant 1/16x 2+3

Arrière 1/16x 2+1

Sélection de boucle (1x) 0

Les modes de shuttle verrouillé ne sont pas 
disponibles lorsque le pavé numérique est en 
mode Shuttle.
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Chapitre 4 : Utilisation de l'aide

Le menu Help de Pro Tools fournit un accès rapide 
à la documentation au format PDF installée et 
à l'aide en ligne. Le système d'aide est basé sur 
HTML et s'ouvre dans le navigateur intégré de 
Pro Tools. Il fonctionne également dans la plupart 
des navigateurs Web courants.

Le menu Help de Pro Tools permet également 
d'accéder directement à la base de connaissance 
Pro Tools en ligne, aux forums audio Avid et au 
Centre de support Avid, via le navigateur intégré 
(une connexion Internet est requise).

Accès aux guides de 
Pro Tools
Des versions PDF (Portable Document Format) 
des principaux guides Pro Tools sont accessibles 
depuis le menu Help. Le logiciel Adobe Reader 
est recommandé pour la documentation au 
format PDF.

Pour accéder aux guides depuis Pro Tools :

 Sélectionnez Help, puis le nom d'un guide.

Guides accessibles dans Pro Tools

Les guides suivants sont disponibles depuis le 
menu Help de Pro Tools :

Guide des plug-ins audio : description des 
plug-ins gratuits fournis avec Pro Tools, ainsi 
que d'autres plug-ins vendus séparément.

Guide de référence Pro Tools : description 
détaillée du fonctionnement du logiciel et des 
systèmes Pro Tools. 

Guide des raccourcis Pro Tools : répertorie les 
raccourcis clavier et commandes de menu 
contextuel disponibles dans Pro Tools, y compris 
ceux affichés dans les menus de Pro Tools.

Accès au système d'aide
Vous pouvez accéder au système d'aide de 
différentes manières :

• en ouvrant l'aide sur sa page d'accueil à partir du 
menu Help de Pro Tools ;

• en ouvrant l'aide sur sa page d'accueil à partir du 
navigateur de l'aide de Pro Tools ;

• en ouvrant l'aide sur sa page d'accueil hors 
de Pro Tools ;

• en ouvrant une version ou une langue différente 
de l'aide de Pro Tools.

Le navigateur Web intégré de Pro Tools 
n'est pas disponible lorsque l'application 
n'est pas en cours d'exécution. Pour 
accéder à l'aide dans ce cas, utilisez le 
navigateur Web par défaut de votre système 
d'exploitation.
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Pour ouvrir l'aide depuis Pro Tools, effectuez l'une 
des opérations suivantes :

 Sélectionnez Help > Pro Tools Help.

 Depuis la fenêtre du navigateur Pro Tools 
Online, sélectionnez Help.

Pour ouvrir l'aide hors de Pro Tools (ou 
sélectionner une version ou une langue différente 
de l'aide) :

1 Ouvrez le navigateur Web de votre choix, 
tel que Safari ou Explorer.

2 Rendez-vous sur la page d'accueil de l'aide 
de Pro Tools 
(http://apps.avid.com/ProToolsHelp/).

3 Suivez les instructions à l'écran pour ouvrir une 
version de l'aide.

Pour fermer le système d'aide :

 Cliquez sur le bouton de fermeture de la 
fenêtre d'aide.

Fenêtre de l'aide
Le système d'aide est composé des éléments 
suivants :

Rubriques :  les rubriques d'aide s'ouvrent dans 
le volet droit de la fenêtre d'aide.

Outils de navigation : les onglets Table des 
matières, Index et Rechercher sont affichés dans le 
volet gauche de la fenêtre d'aide.

Liens hiérarchisés : utilisez ces liens pour 
déterminer le niveau de la rubrique actuellement 
affichée dans le chapitre correspondant et revenir à 
des rubriques de niveau supérieur, jusqu'à la 
rubrique principale.

Bouton Afficher dans la table des matières : 

cliquez sur ce bouton pour localiser l'emplacement 
de la rubrique actuelle dans la table des matières.

Boutons Précédent et Suivant :  cliquez sur ces 
boutons pour parcourir les rubriques dans l'ordre 
dans lequel elles apparaissent dans la table des 
matières.

Imprimer : cliquez sur ce bouton pour imprimer 
une ou plusieurs rubriques. 

Utilisation des onglets Table 
des matières et Index
La plupart des outils principaux de navigation de 
l'aide sont affichés dans le volet gauche du 
navigateur de l'aide.

Onglet Table des matières
L'onglet Table des matières affiche la liste 
hiérarchique complète de toutes les rubriques 
d'aide. Vous pouvez ainsi visualiser rapidement 
la structure globale de l'aide. 

Il est possible de développer ou réduire le contenu 
de la table des matières pour afficher les diverses 
rubriques d'aide dans un ordre logique et y accéder 
en cliquant sur le lien correspondant.

Lorsque vous accédez à une nouvelle rubrique, 
la table des matières se développe jusqu'au niveau 
correspondant et la rubrique concernée est mise en 
surbrillance. Cette fonctionnalité, comme les liens 
hiérarchiques situés au-dessus de chaque rubrique, 
permet de visualiser l'emplacement exact de la 
rubrique au sein de l'organisation logique du 
système d'aide.
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Pour afficher une rubrique à partir de la table des 
matières :

 Cliquez sur l'onglet Table des matières, puis sur 
l'une des rubriques proposées. 

Pour développer ou réduire une section de la table 
des matières :

 Cliquez sur l'icône de livre se trouvant à gauche 
d'un lien. 

Onglet Index
L'index dresse la liste alphabétique des entrées et 
est comparable à celui d'un livre. 

Si Java est activé dans votre navigateur, l'index 
s'affiche sous la forme d'un index dynamique dans 
lequel la liste défile à mesure que vous saisissez un 
terme dans la zone de texte. Si Java n'est pas activé 
dans votre navigateur, ou si votre navigateur ne 
prend pas en charge les implémentations Java, 
une version JavaScript de l'index s'affiche pour 
vous permettre de parcourir manuellement 
les entrées.

Pour rechercher des rubriques sur l'onglet Index :

1 Cliquez sur l'onglet Index. 

2 Cliquez sur la première lettre de la rubrique 
dans la liste des chiffres, lettres et symboles.

Pour afficher la rubrique associée à une entrée 
d'index :

 Cliquez sur l'entrée de l'index.

Utilisation de l'onglet 
Rechercher
L'onglet Rechercher permet d'effectuer une 
recherche sur un ou plusieurs mots dans l'ensemble 
du texte du système d'aide et d'afficher les 
rubriques correspondantes. Les rubriques 
considérées les plus pertinentes apparaissent en 
tête de liste.

Lorsque vous lancez une recherche, le texte 
concerné est automatiquement mis en surbrillance 
par défaut. Il est possible de désactiver cette mise 
en surbrillance, mais également de ne plus afficher 
ces surbrillances en cliquant successivement sur 
les boutons de navigation Précédent et Suivant. 
Lorsque vous revenez sur la rubrique recherchée, 
les surbrillances ne seront plus affichées.

Pour obtenir des directives pour une 
utilisationefficace de l'onglet Rechercher, 
reportez-vous à la section « Instructions pour la 
recherche » à la page 34.

Pour lancer une recherche simple :

1 Cliquez sur l'onglet Rechercher. 

2 Dans le menu des sources de recherche (situé 
sous la zone de texte de recherche), sélectionnez 
les guides dans lesquels vous souhaitez 
effectuer la recherche, Tous les livres 
disponibles, ou un livre spécifique tel que celui 
des raccourcis Pro Tools.

3 Dans la zone de texte de la recherche, tapez le 
terme ou l'expression à rechercher. 

4 Cliquez sur Lancer.

La liste des rubriques et leur classement de 
pertinence s'affichent.
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Informations de recherche supplémentaires

La fonction de recherche est à la fois efficace et 
rapide.

• La recherche fonctionne en parcourant une base 
de données de termes valides. Cette base de 
données comprend tous les termes significatifs 
pour l'identification des rubriques et exclut tous 
les autres. Lorsque vous saisissez des mots dans 
la zone de texte, le système ignore tous les mots 
non valides et recherche les mots valides.

• Cette fonction ne recherche pas les mots dans 
un ordre particulier. Si, par exemple, vous 
tapez « importation de graphiques TIFF », 
la recherche affiche toutes les rubriques 
contenant ces trois mots sans tenir compte de 
leur emplacement dans la rubrique. Les résultats 
incluent toutes les rubriques où les trois mots 
apparaissent ensemble en tant qu'expression, 
ainsi que celles où les trois mots sont dispersés 
dans la rubrique.

• La fonction de recherche ne fait pas la 
distinction entre des mots similaires, mais non 
identiques. Si vous tapez, par exemple, « saisir » 
comme entrée de recherche, la recherche affiche 
les rubriques contenant ce mot, mais n'affiche 
pas les rubriques comprenant des mots 
apparentés, tels que « saisie » ou « saisies ». 
Si la recherche d'un mot ne donne pas de 
résultats satisfaisants, la recherche d'un mot 
apparenté peut s'avérer plus efficace.

Instructions pour la 
recherche
Lors de la formulation d'une recherche, prenez en 
considération les points suivants : 

• Il n'est pas nécessaire de respecter la casse lors 
de la formulation de la recherche. 

• La recherche peut porter sur toute association de 
lettres (de a à z) et de chiffres (de 0 à 9). 

• Les symboles de ponctuation (point, deux 
points, point-virgule, virgule et trait d'union) 
sont ignorés pour la recherche, à moins qu'ils 
fassent partie du nom de la rubrique (.WAV par 
exemple). 

• Vous pouvez taper une phrase littérale en 
utilisant des guillemets. La recherche de 
guillemets est impossible. 

Copie du contenu d'une 
rubrique d'aide
Il est possible de copier des informations d'une 
rubrique d'aide pour les utiliser dans un autre 
document tel qu'un fichier texte.

Pour copier les informations d'une rubrique d'aide 
dans un autre document :

1 Ouvrez ou cliquez sur une rubrique pour 
y accéder.

2 Sélectionnez le texte que vous souhaitez copier.

3 Sélectionnez Édition > Copier.

4 Placez le curseur de la souris dans la fenêtre 
d'une autre application, telle qu'un traitement 
de texte.

5 Sélectionnez Édition > Coller pour coller le texte 
copié dans un document. Vous pouvez 
également coller le texte dans la zone de texte 
de recherche.
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Impression des rubriques 
d'aide
Vous pouvez imprimer des rubriques d'aide si vous 
souhaitez pouvoir vous y reporter lors d'une 
procédure compliquée ou pour référence 
ultérieure.

Pour plus d'informations sur les options 
d'impression, consultez la documentation de votre 
navigateur.

Pour imprimer une rubrique d'aide :

1 Dans la fenêtre du navigateur, cliquez sur la 
rubrique que vous souhaitez imprimer.

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Imprimer du volet de la 
rubrique.

• Effectuez un clic droit sur le volet de la rubrique 
et sélectionnez Imprimer.

• Sélectionnez Fichier > Imprimer.

3 Configurez les options d'impression.

4 Cliquez sur Imprimer.

Les options d'impression des rubriques d'aide 
sont limitées, notamment pour la mise en 
forme ou la mise en page. Si vous souhaitez 
imprimer une version haute qualité d'une 
rubrique d'aide, Avid recommande 
d'imprimer tout ou partie de la version PDF 
du guide correspondant.
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Partie II : Configuration du
système
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Chapitre 5 : Systèmes Pro Tools

Il existe trois types de systèmes Pro Tools :

Logiciel Pro Tools avec matériel Avid ou tiers

Ces systèmes sont composés du logiciel Pro Tools 
et d'une interface audio Avid de la famille 003™, 
Eleven® Rack, Mbox® (3e génération) ou Mbox 2. 
Cette catégorie inclut également les systèmes 
composés du logiciel Pro Tools et d'interfaces 
audio tierces fonctionnant avec des pilotes Core 
Audio (Mac, y compris système audio intégré des 
ordinateurs Mac) ou ASIO (Windows) pris en 
charge.

Logiciel Pro Tools HD avec matériel 
Pro Tools|HDX ou Pro Tools|HD Native

Systèmes Pro Tools HD à accélération matérielle 
composés du logiciel Pro Tools HD et de matériel 
Avid HDX ou HD Native (PCIe ou Thunderbolt). 
Les systèmes à accélération matérielle fournissent 
des capacités d'E/S étendues et permettent un 
monitoring à faible latence. Les systèmes 
Pro Tools|HDX intègrent également des DSP 
dédiés pour les plug-ins et les configurations de 
session les plus importantes.

Logiciel Pro Tools HD avec matériel Avid 
ou tiers

Ces systèmes incluent le logiciel Pro Tools HD et 
une ou plusieurs interfaces audio Avid non HD 
Native ou non HDX compatible(s) (telle qu'une 
Mbox Pro), ou Core Audio (Mac) ou ASIO 
(Windows). 

Logiciel Pro Tools
Le logiciel Pro Tools offre les capacités suivantes, 
en fonction de votre configuration matérielle :

• Jusqu'à 32 canaux d'E/S selon le système et le 
matériel audio

• Jusqu'à 96 pistes audio assignées à une voix par 
session (jusqu'à 128 pistes assignables à une 
voix)

• Lecture d'un maximum de 96 pistes, 
ou combinaison d'un maximum de 96 pistes 
mono ou stéréo en lecture et en 
enregistrement, à 44,1 kHz et 48 kHz

• Lecture d'un maximum de 48 pistes, 
ou combinaison d'un maximum de 48 pistes 
mono ou stéréo en lecture et en 
enregistrement, à 88,2 kHz et 96 kHz

• Lecture d'un maximum de 24 pistes, 
ou combinaison d'un maximum de 24 pistes 
mono ou stéréo en lecture et en 
enregistrement, à 176,4 kHz et 192 kHz

• Jusqu'à 128 pistes d'entrée auxiliaire

• Jusqu'à 64 pistes Master Fader

• Jusqu'à 512 pistes MIDI

• Jusqu'à 128 pistes d'instrument

• Une piste vidéo QuickTime

Pour consulter la liste des interfaces audio et 
ordinateurs qualifiés avec l'ensemble des 
systèmes Pro Tools, rendez-vous sur 
www.avid.com/compatibility.
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• Résolution audio 16 bits, 24 bits ou 32 bits 
à virgule flottante à une fréquence 
d'échantillonnage maximale de 192 kHz

• Compensation automatique du délai (jusqu'à 
16 383 échantillons à 48 kHz)

• Édition à accès aléatoire et automation de 
mixage non destructives

• Traitement audio avec jusqu'à 10 plug-ins en 
temps réel par piste, selon la puissance de 
l'ordinateur

• Jusqu'à 10 inserts matériels par piste

• Jusqu'à 10 départs par piste

• Jusqu'à 256 bus internes pour le mixage et le 
routing

Configurations matérielles 
prises en charge pour le logiciel 
Pro Tools
Le logiciel Pro Tools prend en charge les 
configurations matérielles suivantes :

Famille 003

Le logiciel Pro Tools utilisé avec une interface de 
la famille 003 fournit jusqu'à 18 canaux d'entrée et 
sortie audio à une fréquence d'échantillonnage 
maximale de 48 kHz, ou jusqu'à 10 canaux 
d'entrée et sortie audio à une fréquence 
d'échantillonnage maximale de 96 kHz. 
Un système 003 comprend :

• Le logiciel Pro Tools

• L'une des configurations suivantes :

• Interface audio et MIDI 003 (avec surface de 
contrôle)

• Interface audio et MIDI 003 Rack+

• Interface audio et MIDI 003 Rack

Eleven Rack

Le logiciel Pro Tools utilisé avec une interface 
Eleven Rack fournit jusqu'à 8 canaux d'entrée 
audio et 6 canaux de sortie audio à une fréquence 
d'échantillonnage maximale de 88,2 ou 96 kHz. 
Un système Eleven Rack comprend :

• Le logiciel Pro Tools

• L'interface audio et MIDI Eleven Rack, avec 
processeur d'effets de guitare

Famille Mbox

Un système Mbox comprend :

• Le logiciel Pro Tools

• L'une des configurations suivantes :

• Mbox Pro (3e génération) : jusqu'à 8 canaux 
d'entrée et sortie audio à une fréquence 
d'échantillonnage de 44,1 ou 48 kHz, 
ou jusqu'à 6 canaux d'entrée et sortie audio 
à une fréquence d'échantillonnage maximale 
de 176,4 ou 192 kHz

• Mbox (3e génération) : jusqu'à 4 canaux 
d'entrée et sortie audio à une fréquence 
d'échantillonnage de 44,1 ou 48 kHz, 
ou jusqu'à 2 canaux d'entrée et sortie audio 
à une fréquence d'échantillonnage maximale 
de 88,2 ou 96 kHz

• Mbox Mini (3e génération) ou Mbox 2 Mini : 
jusqu'à 2 canaux d'entrée et sortie audio à une 
fréquence d'échantillonnage de 44,1 ou 48 kHz

• Mbox 2 Pro : jusqu'à 6 canaux d'entrée audio 
et 8 canaux de sortie audio à une fréquence 
d'échantillonnage de 44,1 ou 48 kHz, 
ou jusqu'à 4 canaux d'entrée audio et 
6 canaux de sortie audio à une fréquence 
d'échantillonnage de 88,2 ou 96 kHz

• Mbox 2 : jusqu'à 2 canaux d'entrée et sortie 
audio à une fréquence d'échantillonnage de 
44,1 ou 48 kHz

• Mbox 2 Micro : sortie stéréo uniquement à une 
fréquence d'échantillonnage de 44,1 ou 48 kHz

Pour obtenir des informations sur les capacités 
d'E/S de votre interface audio avec Pro Tools, 
veuillez vous reporter à sa documentation.
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Core Audio

Le logiciel Pro Tools utilisé avec une interface 
compatible Core Audio fournit jusqu'à 32 canaux 
d'entrée et sortie audio à une fréquence 
d'échantillonnage maximale de 192 kHz selon 
l'interface. Un système Pro Tools Core Audio 
comprend :

• Le logiciel Pro Tools

• Une interface audio tierce avec des pilotes 
Core Audio pris en charge (y compris le matériel 
audio Mac intégré)

ASIO

Le logiciel Pro Tools utilisé avec une interface 
compatible ASIO fournit jusqu'à 32 canaux 
d'entrée et sortie audio à une fréquence 
d'échantillonnage maximale de 192 kHz selon 
l'interface. Un système Pro Tools ASIO 
comprend :

• Le logiciel Pro Tools

• Une interface audio tierce avec des pilotes ASIO 
pris en charge

Capacité de traitement

La capacité de traitement totale d'un système 
Pro Tools dépend de la puissance du processeur de 
votre ordinateur. Contactez votre revendeur ou 
rendez-vous sur www.avid.com pour obtenir les 
informations de configuration minimale et de 
compatibilité les plus récentes.

Capacités de Pro Tools avec 
différentes configurations matérielles

Pro Tools gère jusqu'à 32 canaux d'entrée et sortie 
audio, mais les capacités d'entrée et sortie 
disponibles dans Pro Tools dépendent de votre 
interface audio. Pour obtenir des informations sur 
les capacités d'entrée et sortie de votre interface 
audio, veuillez consulter sa documentation.

Lorsque vous ouvrez une session créée sur un 
système Pro Tools HD dont le nombre de pistes est 
supérieur à celui pris en charge par votre système 
Pro Tools, les pistes audio dépassant la limite de 
pistes assignables à une voix sont 
automatiquement désactivées.

Pro Tools HD avec matériel 
HDX
Chaque système requiert au moins une interface 
audio Avid HD (vendue séparément). 
Les systèmes HDX peuvent être étendus en 
ajoutant des cartes HDX, pour augmenter le 
nombre de pistes et les capacités de traitement de 
plug-in et du mixeur, ainsi qu'en ajoutant des 
interfaces audio supplémentaires.

Capacités du logiciel Pro Tools 
HD avec du matériel HDX 
Le logiciel Pro Tools HD utilisé avec du matériel 
HDX offre les capacités suivantes :

• Jusqu'à 256 canaux d'E/S selon le système

• Jusqu'à 768 pistes audio assignées à une voix

• Jusqu'à 512 pistes d'entrée auxiliaire

• Jusqu'à 64 pistes Master Fader

• Jusqu'à 128 pistes Master VCA

• Jusqu'à 512 pistes MIDI

• Jusqu'à 256 pistes d'instrument

• Jusqu'à 64 pistes vidéo par session

Pour plus d'informations sur le transfert de 
données de session entre les systèmes 
Pro Tools HD et Pro Tools, reportez-vous 
à la section « Partage de sessions créées 
sur des systèmes Pro Tools différents » à la 
page 401.
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• Résolution audio 16 bits, 24 bits ou 32 bits 
à virgule flottante à une fréquence 
d'échantillonnage maximale de 192 kHz

• Fonctions de mixage surround jusqu'en 7.1

• Compensation automatique du délai (jusqu'à 
16 348 échantillons à 48 kHz)

• Options d'allocation fixe de RAM pour le cache 
disque

• Monitoring sans latence

• Édition à accès aléatoire et automation de 
mixage non destructives

• Traitement audio avec jusqu'à 10 inserts par 
piste (n'importe quelle combinaison de plug-ins 
en temps réel et d'inserts matériels), en fonction 
des capacités de votre ordinateur

• Jusqu'à 10 départs par piste

• Jusqu'à 512 bus internes pour le mixage et le 
routing

Capacités d'enregistrement et de lecture audio

Le nombre de pistes audio pouvant être 
enregistrées ou lues simultanément dépend de 
votre configuration système. Un système 
Pro Tools HD avec une seule carte HDX permet de 
lire et d'enregistrer des fichiers audio 16 ou 24 bits, 
sur les nombres de pistes assignées à une voix 
suivants :

• Jusqu'à 256 pistes à 44,1 kHz ou 48 kHz

• Jusqu'à 128 pistes à 88,2 kHz ou 96 kHz

• Jusqu'à 64 pistes à 176,4 kHz ou 192 kHz

Chaque carte HDX supplémentaire accroît le 
nombre de pistes maximum d'une quantité 
identique. Par exemple, à 44,1 kHz, deux cartes 
HDX gèrent un maximum de 512 pistes audio, 
et trois cartes HDX en gèrent jusqu'à 768.

Logiciel Pro Tools HD avec 
matériel HD Native
Chaque système requiert au moins une interface 
audio Avid HD (vendue séparément). 
Les systèmes HD Native peuvent être étendus en 
ajoutant des interfaces audio HD supplémentaires.

Les systèmes Pro Tools HD avec matériel 
HD Native comprennent les éléments suivants :

• L'une des configurations suivantes :

• Carte PCIe HD Native

• Interface HD Native Thunderbolt

• Logiciel Pro Tools HD

• Clé iLok autorisée pour le logiciel Pro Tools HD

• Une ou plusieurs interfaces audio Avid HD 
(vendues séparément)

• Câble DigiLink Mini pour la connexion du 
matériel HD Native à une interface audio

• Une interface MIDI (en option)

Pour obtenir des informations détaillées sur 
l'installation du matériel HD Native PCIe, 
reportez-vous au Guide d'installation 
HD Native. Pour obtenir des informations sur 
l'installation du matériel HD Native 
Thunderbolt, reportez-vous au Guide 
HD Native Thunderbolt.
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Capacités du logiciel 
Pro Tools HD avec du matériel 
HD Native
Le logiciel Pro Tools HD avec du matériel 
HD Native sur un système Mac ou Windows offre 
les capacités suivantes :

• Jusqu'à 64 canaux d'E/S selon le système, 
le nombre et le type d'interfaces audio installées

• Jusqu'à 256 pistes audio assignées à des voix 
(jusqu'à 768 pistes audio assignables à des voix) :

• Jusqu'à 256 voix à 44,1 kHz ou 48 kHz

• Jusqu'à 128 voix à 88,2 kHz ou 96 kHz

• Jusqu'à 64 voix à 176,4 kHz ou 192 kHz

• Jusqu'à 512 pistes d'entrée auxiliaire

• Jusqu'à 64 pistes Master Fader

• Jusqu'à 128 pistes Master VCA

• Jusqu'à 512 pistes MIDI

• Jusqu'à 256 pistes d'instrument

• Jusqu'à 64 pistes vidéo par session

• Résolution audio 16 bits, 24 bits ou 32 bits 
à virgule flottante à une fréquence 
d'échantillonnage maximale de 192 kHz

• Édition à accès aléatoire et automation de 
mixage non destructives

• Fonctions de mixage surround jusqu'en 7.1

• Compensation automatique du délai (jusqu'à 
16 348 échantillons à 48 kHz)

• Options d'allocation fixe de RAM pour le cache 
disque

• Monitoring à faible latence basé sur le FPGA

• Traitement audio avec jusqu'à 10 inserts par 
piste (n'importe quelle combinaison de plug-ins 
en temps réel et d'inserts matériels), en fonction 
des capacités de votre ordinateur, du nombre et 
du type d'interfaces audio installées

• Jusqu'à 10 départs par piste

• Jusqu'à 256 bus internes pour le mixage et le 
routing

Interfaces audio HD Avid 
prises en charge
Les interfaces audio Avid HD suivantes sont 
compatibles avec le matériel Avid HDX et 
HD Native :

• HD I/O

• HD OMNI

• HD MADI

Configuration d'E/S maximale 
des systèmes HDX
Les systèmes HDX prennent en charge une 
combinaison maximale de 12 interfaces audio 
parmi les suivantes : 

• HD OMNI (une seule interface HD OMNI est 
prise en charge par système)

• HD I/O (jusqu'à 12 interfaces HD I/O peuvent 
être utilisées simultanément avec 3 cartes HDX)

• HD MADI (jusqu'à 3 interfaces HD MADI peuvent 
être utilisées simultanément avec 3 cartes HDX)

Configuration d'E/S maximale 
des systèmes HD Native
Les systèmes HD Native prennent en charge une 
combinaison maximale de 4 interfaces audio 
parmi les suivantes : 

• HD OMNI (une seule interface HD OMNI est 
prise en charge par système HD Native)

• HD I/O (jusqu'à 4 interfaces HD I/O peuvent 
être utilisées simultanément)

• HD MADI (la connectivité complète avec une 
interface HD MADI est possible lorsque les 
deux ports DigiLink de la HD MADI sont 
connectés aux deux ports DigiLink de la carte 
PCIe ou de l'interface Thunderbolt HD Native)

Les systèmes Avid HDX et HD Native 
nécessitent au moins une interface HD I/O, 
HD OMNI ou HD MADI.
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Limites applicables à la lecture, à l'enregistrement et aux 
voix avec Pro Tools HD
Le tableau ci-dessous affiche les limites relatives à la lecture et à l'enregistrement audio, ainsi qu'au nombre 
de pistes assignables à une voix du logiciel Pro Tools HD avec du matériel HDX, HD Native, Core Audio 
et ASIO. Les voix en lecture et en enregistrement se rapportent au nombre de pistes de lecture et 
d'enregistrement simultanées sur votre système. Le nombre total de pistes assignables à des voix 
correspond au nombre maximal de pistes audio pouvant partager les voix disponibles de votre système. 
Une piste mono utilise une seule voix. Les pistes stéréo et multicanal utilisent une voix par canal.

Pour les systèmes avec accélération matérielle HDX, les limites de voix dépendent de la fréquence 
d'échantillonnage de la session et du nombre de puces DSP dédiées au moteur de lecture du système. 
Le logiciel Pro Tools HD peut ouvrir des sessions contenant jusqu'à 768 pistes audio, mais la voix de toute 
piste audio au-delà de la limite du nombre de pistes assignables à une voix du système sera 
automatiquement désactivée.

 

Limites applicables à la lecture, à l'enregistrement et aux voix du logiciel Pro Tools HD

Type de système 
Core

Maximum d'E/S
Fréquence 
d'échantillon-
nage (kHz)

Voix de lecture et 
d'enregistrement 
(pistes mono de 
lecture et 
d'enregistrement 
simultanées)

Nombre 
maximum de 
pistes 
assignables 
à une voix

1 carte HDX 64 canaux 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

2 cartes HDX 128 canaux 44,1/48 512 768

88,2/96 256 768

176,4/192 128 768

3 cartes HDX 192 canaux 44,1/48 1 024 768

88,2/96 512 768

176,4/192 128 768
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Caractéristiques des interfaces audio Avid HD
Le tableau suivant présente les capacités d'entrée et de sortie des différentes interfaces audio Avid HD 
pour les systèmes Avid HDX et HD Native. Chaque carte HDX de votre système prend en charge un 
maximum de 64 canaux d'E/S. Le matériel HD Native prend en charge un maximum de 64 canaux d'E/S. 
Pour enregistrer et lire de l'audio avec le logiciel Pro Tools HD sur l'une de ces configurations matérielles, 
au moins une interface audio Avid HD doit être connectée au premier port de la première carte (ou interface 
Thunderbolt) du système.

HD Native 64 canaux 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

Core Audio et ASIO 
(Pro Tools HD)

32 canaux 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

Limites applicables à la lecture, à l'enregistrement et aux voix du logiciel Pro Tools HD

Type de système 
Core

Maximum d'E/S
Fréquence 
d'échantillon-
nage (kHz)

Voix de lecture et 
d'enregistrement 
(pistes mono de 
lecture et 
d'enregistrement 
simultanées)

Nombre 
maximum de 
pistes 
assignables 
à une voix

Capacités en canaux des interfaces audio Avid HD

Type d'interface
Nombre 
de canaux 
d'E/S

Fréquences 
d'échantillon-
nage (kHz)

Conversion 
A/N

Conversion 
N/A

E/S 
numériques

HD I/O 16 entrées/
16 sorties

44,1 ; 48 ; 
88,2 ; 96 ; 
176,4 ; 192

24 bits 24 bits 24 bits

HD OMNI 8 entrées/
8 sorties

44,1 ; 48 ; 
88,2 ; 96 ; 
176,4 ; 192

24 bits 24 bits 24 bits

HD MADI 64 entrées/
64 sorties

44,1 ; 48 ; 
88,2 ; 96 ; 
176,4 ; 192

Aucune Aucune 24 bits
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Interface audio HD OMNI
La HD OMNI est une interface audio numérique 
professionnelle conçue pour être utilisée avec 
les systèmes Avid HD. La HD OMNI constitue 
une solution compacte de préamplification, 
de monitoring et d'E/S pour les studios 
de production musicale, d'enregistrement et de 
post-production.

Caractéristiques de la HD OMNI

La HD OMNI propose jusqu'à 8 canaux discrets 
d'entrée et de sortie Pro Tools, avec des indicateurs 
de niveau à LED 4 segments pour les entrées ou les 
sorties (sélectionnables). 

E/S analogiques

• Convertisseurs analogique/numérique (A/N) et 
numérique/analogique (N/A) 24 bits, avec prise 
en charge des fréquences d'échantillonnage 
jusqu'en 192 kHz

• 2 préamplis micro/DI (direct) de haute qualité 
(canaux 1 et 2)

• 2 entrées combo XLR et TRS 6,35 mm sur le 
panneau avant pour les entrées au niveau micro 
et instrument

• 2 entrées micro XLR sur le panneau arrière

• 2 départs et 2 retours TRS 6,35 mm sur le 
panneau arrière pour les inserts matériels des 
canaux 1 et 2

• 4 entrées au niveau ligne TRS analogiques sur le 
panneau arrière (canaux 1 à 4)

• Circuits de limitation Soft Clip et Curv offrant 
une protection contre l'écrêtage sur les entrées 
analogiques

• 8 canaux de sortie analogiques sur le panneau 
arrière via un câble éclaté DB-25 (vendu 
séparément) avec gain de sortie variable

• 2 canaux de sortie TRS analogiques sur le 
panneau arrière (miroirs des canaux 1 et 2 ou 
7 et 8 sur le connecteur DB-25)

• Prise casque 6,35 mm stéréo sur le panneau 
avant

E/S numériques

• 8 canaux de sortie AES/EBU (jusqu'en 192 kHz 
Single Wire) via un câble éclaté DB-25 (vendu 
séparément)

• 2 canaux d'entrée XLR AES/EBU (jusqu'en 
192 kHz Single Wire)

• 2 canaux d'entrée et de sortie RCA S/PDIF 
(jusqu'en 192 kHz)

• 8 canaux d'entrée et de sortie ADAT TOSLINK

• Prise en charge du format ADAT S/MUX 
optique pour les fréquences d'échantillonnage de 
88,2 kHz, 96 kHz, 176,4 kHz et 192 kHz

• Prise en charge de deux canaux au format 
S/PDIF optique pour les fréquences 
d'échantillonnage allant jusqu'en 96 kHz

• Conversion de fréquence d'échantillonnage 
(SRC) en temps réel sur les entrées 
numériques 1 et 2 au format AES/EBU, S/PDIF 
ou optique (S/PDIF)

Monitoring

• Chemin de sortie « CUE » stéréo 
supplémentaire dans Pro Tools® pour le 
monitoring casque à partir de la sortie casque du 
panneau avant

• Commande de volume Control Room 
(MAIN/ALT) et casque sur le panneau avant

L'interface HD OMNI offre de nombreux 
connecteurs d'entrée analogiques, mais ne 
peut gérer que quatre canaux d'entrée 
analogiques simultanés pour Pro Tools.

La conversion SRC n'est pas prise en charge 
avec le format ADAT S/MUX.
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• Monitoring flexible avec réduction à partir de 
tous les formats stéréo et surround (jusqu'en 7.1)

• Console de mixage d'entrée pour l'écoute directe 
à faible latence d'une multitude de signaux 
entrants (définie dans la configuration matérielle 
de Pro Tools)

Synchronisation

• Entrée et sortie Loop Sync pour la connexion de 
périphériques HD supplémentaires

• Entrée et sortie External Clock pour la 
synchronisation de la HD OMNI avec des 
périphériques Word Clock externes

Interface audio HD I/O
La HD I/O est une interface audio numérique 
multicanal conçue pour être utilisée avec les 
systèmes Avid HD. La HD I/O intègre des 
convertisseurs analogique/numérique (A/N) 
et numérique/analogique (N/A) 24 bits de très 
haute qualité et prend en charge les fréquences 
d'échantillonnage jusqu'à 192 kHz. 

La HD I/O est disponible en trois configurations 
standard :

• 8 x 8 x 8 (8 entrées analogiques, 8 sorties 
analogiques et 8 entrées et sorties numériques)

• 16 x 16 entrées et sorties analogiques

• 16 x 16 entrées et sorties numériques

Vous pouvez également ajouter ou retirer des 
cartes d'extension analogiques HD I/O (CAN et 
CNA) et des cartes d'extension numériques 
HD I/O pour les configurations personnalisées. 

Caractéristiques de la HD I/O

La HD I/O propose jusqu'à 16 canaux discrets 
d'entrée et de sortie Pro Tools, avec des indicateurs 
de niveau à LED 4 segments pour les entrées et les 
sorties. 

E/S analogiques

• Jusqu'à seize canaux de convertisseurs N/A 
et A/N 24 bits pour des entrées et sorties 
analogiques de qualité supérieure à des 
fréquences d'échantillonnage de 44,1 kHz, 
48 kHz, 88,2 kHz, 96 kHz, 176,4 kHz et 
192 kHz avec les cartes HD I/O Analog In et 
Analog Out

• Circuits de limitation Soft Clip et Curv offrant 
une protection contre l'écrêtage sur les entrées 
analogiques

E/S numériques

• Jusqu'à seize canaux d'E/S numériques 24 bits 
au format AES/EBU, TDIF DB-25 ou optique 
à des fréquences d'échantillonnage de 44,1 kHz, 
48 kHz, 88,2 kHz, 96 kHz, 176,4 kHz et 
192 kHz avec une carte HD I/O Digital

• Conversion en temps réel de la fréquence 
d'échantillonnage des entrées numériques avec 
une carte d'E/S numérique (jusqu'à seize canaux 
AES/EBU, optique ou TDIF)

• Prise en charge du format S/MUX optique pour 
les fréquences d'échantillonnage de 88,2 kHz 
et supérieures

• Prise en charge de 2 canaux au format S/PDIF 
optique (sur châssis) avec les fréquences 
d'échantillonnage allant jusqu'à 96 kHz

• 2 canaux d'E/S AES/EBU (sur châssis) avec 
prise en charge des fréquences d'échantillonnage 
allant jusqu'à 192 kHz

• 2 canaux d'E/S S/PDIF compatibles 24 bits 
(sur châssis) avec prise en charge des fréquences 
d'échantillonnage allant jusqu'à 192 kHz

Pour plus d'informations, reportez-vous au 
Guide HD OMNI.
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Synchronisation

• Entrée et sortie Loop Sync pour la connexion 
d'interfaces audio et périphériques Avid HD 
supplémentaires

• Entrée et sortie External Clock permettant de 
synchroniser la HD I/O avec les périphériques 
Word Clock externes

Capacité d'extension

• Ajout en option de cartes d'E/S pour augmenter 
le nombre d'E/S analogiques ou numériques

• Utilisation simultanée de plusieurs interfaces 
audio Avid HD pour accroître le nombre 
d'entrées et de sorties du système

Interface audio numérique 
HD MADI
La HD MADI est une interface audio numérique 
64 canaux conçue pour être utilisée avec les 
systèmes Avid HD. L'interface HD MADI prend 
en charge le format MADI (Multichannel Audio 
Digital Interface) et les fréquences 
d'échantillonnage jusqu'à 192 kHz. La HD MADI 
assure une connectivité simplifiée entre votre 
système Avid HD et votre matériel audio 
compatible MADI.

Caractéristiques de la HD MADI
• 2 entrées optiques et coaxiales MADI et 

2 sorties optiques et coaxiales MADI pour un 
maximum de 64 canaux discrets d'entrée et de 
sortie numériques (32 canaux par port 
DigiLink Mini)

• Fréquences d'échantillonnage prises en charge : 
44,1, 48, 88,2, 96, 176,4 et 192 kHz

• Résolution 24 ou 16 bits

• Conversion de fréquence d'échantillonnage 
(SRC) en entrée ou en sortie

• Indicateurs de signal d'horloge et de conversion 
SRC sur le panneau avant

• LED de présence de signal en entrée et en sortie 
sur le panneau avant

• E/S BNC Word Clock pour la synchronisation 
de la HD MADI avec un signal Word Clock 1x 
externe

• E/S BNC Loop Sync pour la synchronisation de 
la HD MADI avec d'autres périphériques et 
interfaces audio Avid HD, tels qu'une HD I/O, 
HD OMNI ou SYNC HD

• Entrées dédiées BNC Word Clock et XLR 
AES/EBU (entrée d'horloge uniquement) pour 
la synchronisation MADI externe (lors de 
l'utilisation de la conversion SRC en sortie)

• Prise en charge des signaux d'horloge aux 
formats suivants : Internal, Loop Sync, Word 
Clock, AES/EBU et MADI

• Modes Varispeed (prise en charge des normes 
64 et 56 canaux)

Pour plus d'informations, reportez-vous au 
Guide HD I/O.

Pour plus d'informations, reportez-vous au Guide 
HD MADI.
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Autres options matérielles 
pour Pro Tools
Les systèmes logiciels Pro Tools prennent 
également en charge les options matérielles 
Pro Tools suivantes.

• PRE (préampli micro à huit canaux)

• Eleven Rack (processeur pour guitare)

• Surfaces de contrôle :

• Surfaces de contrôle Avid Artist Series 

• C|24

• Command|8

• Contrôleurs MIDI tiers (tels qu'un M-Audio 
Axiom® Pro ou Mackie HUI)

Autres options matérielles 
pour Pro Tools HD
Pro Tools HD prend également en charge les 
options matérielles Avid HD suivantes :

• Périphériques de synchronisation SYNC HD 
(systèmes Avid HDX HD Native uniquement) :

• PRE (préampli micro à huit canaux)

• Eleven Rack (processeur pour guitare)

• Surfaces de contrôle :

• Surfaces de contrôle Avid Artist Series 

• Surfaces de contrôle Avid Pro Series

• C|24

• Command|8

• D-Command

• D-Control

• Option Surround Panner

• Contrôleurs MIDI tiers (tels qu'un M-Audio 
Axiom® Pro ou Mackie HUI)

Options du logiciel Pro Tools
Avid HDX avec HEAT

L'option logicielle payante HEAT (Harmonically 
Enhanced Algorithm Technology) ajoute une 
« couleur analogique » au son des systèmes Avid 
HDX. Pour plus d'informations, reportez-vous au 
Chapitre 42, « HEAT ».

Systèmes Avid HDX et HD Native avec 
MachineControl

L'option logicielle MachineControl™ pour 
Pro Tools HD est prise en charge par les systèmes 
Avid HDX et HD Native. L'option logicielle 
payante MachineControl pour Pro Tools HD 
permet d'établir une communication série avec les 
synchroniseurs compatibles 9 broches Sony® et des 
appareils audio ou vidéo. Pour plus d'informations, 
reportez-vous au Guide MachineControl.

Pro Tools avec VENUE Link

Le composant VENUE Link assure l'intégration et 
l'interopérabilité entre les systèmes Pro Tools et 
VENUE connectés via Ethernet.
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Recherche de mises à jour 
logicielles
Les mises à jour disponibles pour l'application 
Pro Tools et les plug-ins peuvent être recherchées 
automatiquement ou manuellement. Une connexion 
Internet est requise pour la recherche de mises 
à jour. Environ toutes les deux semaines, Pro Tools 
vérifie les mises à jour disponibles en ligne pour 
l'application et les plug-ins.

Lorsqu'une mise à jour est disponible, Pro Tools 
vous avertit et indique son importance pour votre 
système. Pour rechercher, télécharger et installer 
les mises à jour appropriées pour votre système 
Pro Tools, rendez-vous sur le site Web d'Avid.

Pour rechercher manuellement les mises à jour :

1 Lancez Pro Tools.

2 Sélectionnez Help > Check For Updates.

3 Effectuez l'une des opérations suivantes :

• Si aucune mise à jour n'est disponible, cliquez 
sur OK.

• Si des mises à jour sont disponibles, effectuez 
l'une des opérations suivantes :

• Cliquez sur Details pour lancer votre 
navigateur Web et afficher les mises à jour 
disponibles.

• Cliquez sur Not Now si vous souhaitez 
vérifier ou télécharger les mises à jour 
ultérieurement.

Pour désactiver la recherche automatique des 
mises à jour :

 Dans la boîte de dialogue Software Update, 
sélectionnez l'option Do Not Check For Updates 

Automatically.

Pour activer la recherche automatique des mises 
à jour :

1 Sélectionnez Help > Check For Updates. 

2 Dans la boîte de dialogue Software Update, 
désactivez l'option Do Not Check For Updates 

Automatically.
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Chapitre 6 : Configuration du système

Vous pouvez consulter et mettre à jour les 
paramètres de votre système afin de vous assurer 
de sa bonne configuration.

Démarrage et arrêt de votre 
système
Pour que les différents composants de votre 
système Pro Tools puissent communiquer 
correctement entre eux, vous devez les mettre sous 
tension dans un ordre précis.

Démarrez votre système Pro Tools dans l'ordre 
suivant :

1 Assurez-vous que tous vos appareils (y compris 
votre ordinateur) sont éteints.

2 Baissez le volume de tous les périphériques de 
sortie du système. 

3 Pour les systèmes avec châssis d'extension, 
mettez ce dernier sous tension.

4 Mettez sous tension tous les disques durs 
externes. Patientez environ 10 secondes jusqu'à 
ce qu'ils aient atteint leur vitesse nominale.

5 Mettez sous tension les surfaces de contrôle 
(telles qu'une D-Command ou une Avid Artist 
Control).

6 Mettez sous tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

7 En fonction du type de système Pro Tools, 
effectuez l'une des opérations suivantes :

• Sur les systèmes Avid HDX et HD Native, 
réglez le volume de tous les périphériques de 
sortie au minimum, puis mettez sous tension vos 
interfaces audio (telles qu'une HD OMNI). 
Patientez au moins 15 secondes afin que le 
système de votre interface s'initialise.

• Sur les systèmes Pro Tools comprenant du 
matériel fonctionnant avec une source 
d'alimentation externe (une 003 par exemple), 
réglez le volume de tous les périphériques de 
sortie au minimum, puis mettez le matériel sous 
tension.

8 Mettez l'ordinateur sous tension. 

9 Lancez Pro Tools ou toute autre application 
audio ou MIDI tierce. 

Arrêtez votre système Pro Tools dans l'ordre 
suivant :

1 Quittez Pro Tools et toutes les autres 
applications ouvertes. 

2 Baissez le volume de tous les périphériques de 
sortie du système. 

3 Mettez votre ordinateur hors tension.

Pour quitter Pro Tools, sélectionnez 
File > Exit (Windows) ou Pro Tools > 
Quit (Mac).
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4 En fonction du type de système Pro Tools, 
effectuez l'une des opérations suivantes :

• Sur les systèmes Avid HDX et HD Native, 
mettez hors tension vos interfaces audio 
Pro Tools.

• Sur les systèmes Pro Tools comprenant du 
matériel fonctionnant avec une source 
d'alimentation externe (une 003 par exemple), 
mettez ce matériel hors tension.

5 Pour les systèmes avec châssis d'extension, 
mettez ce dernier sous tension.

6 Mettez hors tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

7 Mettez hors tension les surfaces de travail (telles 
qu'une D-Command) ou les surfaces de contrôle 
(telles qu'une Command|8 par exemple).

8 Mettez hors tension les disques durs externes.

Vérification d'un système 
Pro Tools|HDX ou 
Pro Tools|HD Native avec 
DigiTest
Avant d'utiliser Pro Tools, lancez l'application de 
diagnostic DigiTest pour vous assurer que toutes 
les cartes Avid HDX du système sont reconnues, 
installées dans le bon ordre et que les connexions 
fonctionnent correctement. Vous pouvez 
également utiliser DigiTest pour vérifier 
l'installation de votre carte PCIe ou interface 
Thunderbolt HD Native. Pour plus d'informations, 
reportez-vous au Guide Avid DigiTest.

Configuration des 
paramètres système de 
Pro Tools
Les performances de votre système Pro Tools 
peuvent être ajustées en configurant les 
paramètres système qui affectent ses capacités de 
traitement, de lecture et d'enregistrement. Ces 
paramètres système sont accessibles dans la boîte 
de dialogue Playback Engine (Setup > Playback 

Engine).

Dans la plupart des cas, les paramètres par défaut 
de votre système assurent des performances 
optimales, mais vous pouvez les modifier pour 
travailler sur des sessions Pro Tools plus longues 
ou nécessitant un traitement intensif. 

Boîte de dialogue Playback Engine d'un système 
Pro Tools|HDX

Boîte de dialogue Playback Engine d'un système 
Pro Tools avec une interface Mbox (3e génération)
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Playback Engine
Dans la boîte de dialogue Playback Engine de 
Pro Tools, vous pouvez sélectionner le moteur 
audio à utiliser avec vos interfaces audio. 
Les choix disponibles sont déterminés par les 
interfaces audio connectées pour lesquelles des 
pilotes compatibles sont installés. 

Une modification du paramètre Playback Engine 
peut être utile si plusieurs interfaces audio sont 
connectées à votre ordinateur, afin de sélectionner 
un moteur adapté à différentes configurations de 
routing de votre studio, ou si vous souhaitez 
préparer une session pour un autre système avec 
une interface spécifique (vous pouvez par exemple 
préparer une session créée sur votre système Avid 
HDX pour l'utiliser avec le matériel audio intégré 
de votre ordinateur portable Mac).

Pour sélectionner le moteur audio utilisé par 
Pro Tools :

1 Sélectionnez Setup > Playback Engine.

2 Sélectionnez votre interface audio à l'aide du 
sélecteur Playback Engine :

• Sur les systèmes Avid HDX et HD Native, utilisez 
le paramètre par défaut HDX ou HD Native.

• Pour les interfaces audio Avid prises en charge 
(telles qu'une Mbox Pro), le fait de sélectionner 
le nom de l'interface active le moteur audio de 
Pro Tools. 

• Pour les interfaces audio tierces compatibles 
Core Audio (Mac) ou ASIO (Windows), 
sélectionnez le nom de l'interface audio 
compatible Core Audio (Mac) ou ASIO 
(Windows) correspondante.

• Si vous utilisez le système audio intégré d'un 
système Mac, sélectionnez l'une des options 
disponibles pour la lecture ou sélectionnez 
Pro Tools Aggregate I/O afin de disposer d'E/S 
simultanées avec les options matérielles d'E/S 
intégrées.

3 Cliquez sur OK.

Lorsque vous changez de moteur alors qu'une 
session Pro Tools est ouverte, l'application doit 
fermer puis relancer la session afin de pouvoir 
initialiser le nouveau moteur.

Sur les systèmes Avid HDX, il est nécessaire de 
quitter et de relancer Pro Tools après le 
changement de moteur pour que le nouveau 
paramètre prenne effet.

Pro Tools Aggregate I/O
(Mac uniquement)

Sur les systèmes Mac utilisant des pilotes Core 
Audio, vous pouvez utiliser Pro Tools avec les 
entrées et sorties audio intégrées de votre Mac en 
sélectionnant l'une des entrées et sorties 
disponibles, ou en sélectionnant l'option Pro Tools 

Aggregate I/O pour utiliser simultanément une 
combinaison d'E/S intégrées (pour 
l'enregistrement et le monitoring). 

Les options d'entrée et de sortie de l'agrégat d'E/S 
de Pro Tools peuvent être sélectionnées dans la 
configuration audio du Mac, directement 
accessible à partir de la boîte de dialogue 
Hardware Setup de Pro Tools.

Lorsque vous changez de moteur sur un 
système Pro Tools, il peut être nécessaire 
de réinitialiser les paramètres d'E/S par 
défaut afin qu'ils correspondent à 
l'interface audio sélectionnée.

Sélection de l'option Pro Tools Aggregate I/O dans la 
boîte de dialogue Playback Engine (Mac uniquement)
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Taille de mémoire tampon 
matérielle
La taille de mémoire tampon matérielle (H/W 

Buffer Size) du moteur de lecture contrôle la taille 
de la mémoire utilisée pour gérer les tâches de 
traitement hôte telles que celles des plug-ins basés 
sur hôte, ou « Native ».

• Les tailles de mémoire tampon matérielle faibles 
permettent de réduire la latence pour certaines 
situations d'enregistrement, ou améliorent les 
performances du système :

• Sur tous les systèmes Pro Tools, des tailles 
faibles réduisent la latence de conversion 
MIDI vers audio (par exemple, lorsque vous 
jouez en monitoring direct avec un 
instrument virtuel). Les tailles réduites 
permettent également d'améliorer la réponse 
de l'affichage et la précision des données 
d'automation des plug-ins et de mute.

• Sur les systèmes Pro Tools basés sur hôte, 
des tailles faibles réduisent la latence du 
monitoring entre l'entrée et la sortie des pistes 
activées pour l'enregistrement ou des pistes 
d'entrée auxiliaire utilisées avec des entrées 
live.

• Sur les systèmes Avid HDX, des tailles 
faibles réduisent la latence du monitoring 
lorsqu'un ou plusieurs plug-ins Native sont 
insérés sur des pistes. Les tailles réduites 
peuvent également améliorer la précision de 
la synchronisation des pistes MIDI sur les 
systèmes sans interface MIDI prenant en 
charge le marquage temporel. Elles 
améliorent également la synchronisation des 
pistes MIDI utilisant des instruments virtuels 
MIDI ne prenant pas en charge le marquage 
temporel.

• Les tailles de mémoire tampon matérielle plus 
élevées sont utiles pour les sessions qui utilisent 
un nombre plus important de plug-ins Native en 
lecture. Ces tailles permettent d'effectuer 
davantage de traitement audio. Elles limitent 
également les erreurs survenant sur des 
machines qui requièrent une taille de mémoire 
tampon plus élevée.

Pour modifier la taille de mémoire tampon 
matérielle :

1 Sélectionnez Setup > Playback Engine. 

2 Dans le menu H/W Buffer Size, sélectionnez une 
taille de mémoire tampon audio, exprimée en 
échantillons. 

3 Cliquez sur OK. 

Si vous avez besoin d'une entrée 
(enregistrement) et d'une sortie (lecture et 
monitoring) simultanées dans Pro Tools alors 
que vous utilisez les options audio intégrées du 
Mac, sélectionnez l'option Pro Tools 
Aggregate I/O. Si vous avez uniquement 
besoin de lire de l'audio pour des opérations 
d'édition et de mixage, sélectionnez l'option de 
sortie audio intégrée adéquate.
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Host Engine
Le paramètre Host Engine fournit des options pour 
la suppression des erreurs en cours de lecture et 
d'enregistrement, ainsi que la possibilité d'activer 
le traitement dynamique de plug-in.

Suppression des erreurs en cours de 
lecture/enregistrement

L'option Ignore Errors During Playback/Record 
détermine la façon dont Pro Tools gère les 
messages d'erreur provenant du moteur AAE 
(Avid Audio Engine) en cours de lecture et 
d'enregistrement. Elle peut-être utile lorsque vous 
travaillez avec des plug-ins d'instrument sur la 
composition ou l'arrangement d'un morceau et que 
les clics et pops pouvant survenir dans le signal 
audio sont moins gênants qu'en enregistrement. 
Désactivez cette option dès que vous êtes prêt 
à travailler sur le mix final. Respectez les conseils 
suivants relatifs à l'activation et à la désactivation 
de la suppression des erreurs :

• Il est recommandé d'activer la suppression 
d'erreurs uniquement si les rapports d'erreurs 
interrompent trop souvent votre processus créatif. 
L'activation de cette option peut entraîner une 
dégradation de la qualité audio. Elle constitue 
néanmoins une solution envisageable dans la 
mesure où elle évite les interruptions de lecture et 
d'enregistrement lorsque vous travaillez avec des 
plug-ins d'instrument. 

• Désactivez l'option de suppression d'erreurs 
lorsque vous souhaitez bénéficier d'une qualité 
sonore optimale, par exemple pour un mixage 
final.

Pour activer la suppression des erreurs :

1 Sélectionnez Setup > Playback Engine.

2 Activez l'option Ignore Errors During 

Playback/Record.

3 Cliquez sur OK.

Si l'option Ignore Errors During Playback/Record est 
activée et qu'un nombre trop important de plug-ins 
Native gourmands en ressources CPU sont actifs 
dans la session (tels qu'Eleven Free ou divers plug-ins 
d'instrument virtuel), la qualité audio peut être 
considérablement dégradée. Si vous êtes confronté 
à ce problème, supprimez ou désactivez tout plug-in 
Native inutile. Vous pouvez également enregistrer 
toutes les pistes qui utilisent des instruments virtuels, 
puis les désactiver pour libérer des ressources de 
traitement.

Réduction de la latence d'E/S 
supplémentaire
(Systèmes Pro Tools basés sur hôte uniquement)

Lorsque l'option Minimize Additional I/O Latency 
est activée, toute latence supplémentaire due à la 
suppression des erreurs en cours de lecture et 
d'enregistrement est limitée à 128 échantillons. 
Sur certains systèmes, la suppression d'erreurs 
nécessite au moins 128 échantillons 
supplémentaires de mémoire tampon. Si cette 
option est désactivée, la taille de la mémoire 
tampon est égale à la moitié de la valeur H/W 

Buffer Size ou à 128 échantillons au minimum 
(valeur la plus élevée). Si votre ordinateur est plus 
lent, désactivez cette option pour éviter une baisse 
des performances.

Cette option est disponible uniquement lorsque 
l'option Ignore Errors During Playback/Record est 
activée et que le système Pro Tools nécessite une 
mémoire tampon plus importante pour la suppression 
des erreurs, notamment les systèmes suivants :

• Windows :

• Mbox Pro et Mbox 2 Pro

• Mac :

• Périphériques de la famille 003

• Eleven Rack

• Périphériques de la famille Mbox

• Agrégat d'E/S Pro Tools
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Traitement de plug-in dynamique

Lorsqu'elle est activée, l'option Dynamic Plug-In 

Processing permet de maximiser le nombre de 
plug-ins en réallouant dynamiquement les 
ressources de traitement de l'hôte en fonction des 
besoins. Cela signifie que les plug-ins n'utilisent 
des cycles CPU que lorsqu'ils traitent réellement 
de l'audio.

Pour activer le traitement dynamique de plug-in :

1 Sélectionnez Setup > Playback Engine.

2 Activez l'option Dynamic Plug-In Processing.

3 Cliquez sur OK.

Nombre de voix
(Systèmes Avid HDX uniquement)

Sur les systèmes Avid HDX, le paramètre Number 

of Voices de la boîte de dialogue Playback Engine 
détermine le nombre de voix disponibles et la 
façon dont ces voix sont allouées aux DSP de votre 
système.

La modification du nombre de voix affecte 
l'utilisation des DSP, le nombre total de pistes 
assignables à des voix et les performances globales 
du système. 

Selon la fréquence d'échantillonnage de la session 
et le nombre de cartes Avid HDX de votre système, 
vous disposez de plusieurs choix pour déterminer 
le nombre de voix. Pour connaître le nombre 
maximum de voix sur les différents systèmes Avid 
HDX, reportez-vous à la section « Limites 
applicables à la lecture, à l'enregistrement et aux 
voix avec Pro Tools HD » à la page 44.

Pour modifier le nombre de voix et de DSP 
à allouer à leur gestion :

1 Sélectionnez Setup > Playback Engine.

2 Sélectionnez le nombre de voix et de DSP 
à allouer à leur gestion en sélectionnant une 
valeur dans le menu Number of Voices, selon les 
indications suivantes :

• Sélectionnez les nombres de voix minimum si 
vous utilisez des cartes PCIe à bande passante 
élevée (cartes de capture vidéo, par exemple) 
avec vos cartes Avid HDX. Ces valeurs 
assignent la charge de traitement la moins 
importante à chaque puce DSP allouée, mais 
elles requièrent généralement un nombre de 
puces DSP dédiées à la gestion de voix et au 
mixage plus élevé, ce qui réduit le nombre de 
puces disponibles pour les plug-ins.

• Sélectionnez un nombre de voix intermédiaire 
lorsque vos cartes Avid HDX sont installées 
dans un châssis d'extension ou que d'autres 
cartes PCIe sont installées avec des cartes Avid 
HDX. Ces valeurs offrent généralement un 
équilibre optimal entre le nombre de puces 
nécessaires pour la gestion des voix et la charge 
de traitement allouée à chacune d'elles.

• Sélectionnez un nombre de voix élevé lorsque 
les seules cartes PCIe présentes sur votre 
ordinateur sont des cartes Avid HDX, ou lorsque 
vous utilisez un châssis d'extension pour gérer 
davantage de pistes (par exemple 64 pistes 
à 96 kHz) et que vous souhaitez utiliser 
davantage de voix par DSP (par exemple 
16 voix par DSP à 96 kHz). Ces valeurs utilisent 
moins de puces DSP pour le mixage (laissant 
ainsi plus de puces pour les plug-ins), mais 
assignent la charge de traitement la plus 
importante à chacune d'elles.

3 Cliquez sur OK. 
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Fréquence d'échantillonnage
(Avid HDX uniquement)

Le paramètre Sample Rate de la boîte de dialogue 
Playback Engine indique la fréquence 
d'échantillonnage par défaut des nouvelles 
sessions. Si une session est ouverte, sa fréquence 
d'échantillonnage est affichée, mais ne peut pas 
être modifiée. Dans le cas contraire, vous pouvez 
configurer la fréquence d'échantillonnage par 
défaut des nouvelles sessions.

Moteur vidéo
Activez l'option Video Engine pour importer, éditer 
et lire une vaste gamme de formats vidéo Avid MXF 
HD et SD sur les pistes vidéo de Pro Tools sans 
transcodage (dont les formats Avid DNxHD®), 
ainsi que des vidéos QuickTime. Lorsque le moteur 
vidéo est activé, vous pouvez afficher 
simultanément la lecture d'une vidéo stockée sur 
votre poste de travail, et celle d'une seconde dont le 
monitoring est pris en charge par un périphérique 
vidéo (Avid Nitris® DX, Mojo® DX, ou d'autres 
interfaces vidéo tierces qualifiées).

Pour activer le moteur Avid Video Engine de 
Pro Tools :

1 Sélectionnez Setup > Playback Engine.

2 Activez l'option Video Engine.

3 Cliquez sur OK.

Taille du cache
(Logiciel Pro Tools HD uniquement)

Le paramètre Cache Size de la boîte de dialogue 
Playback Engine détermine la quantité de mémoire 
allouée par le moteur AAE pour transférer 
l'audio dans la mémoire tampon en lecture ou 
en enregistrement. Dans la plupart des cas, 
le paramètre par défaut Normal correspond à une 
taille de cache optimale.

Pro Tools HD peut également charger dans la 
RAM les fichiers audio des sessions afin qu'ils 
soient lus à partir du cache. Pro Tools donne la 
priorité aux fichiers situés le plus près de 
l'emplacement actuel de la tête de lecture. Ainsi, 
lorsque vous lancez la lecture, ces fichiers sont 
déjà chargés dans le cache. Cette fonctionnalité est 
particulièrement efficace lors de l'utilisation d'un 
stockage de médias partagé, tel que les systèmes de 
stockage partagé Avid Unity ISIS. 

Afin de déterminer la quantité maximale de RAM 
disponible pour le cache disque, Pro Tools 
identifie la quantité de RAM installée sur 
l'ordinateur et soustrait 4 Go. 

Par exemple, si votre ordinateur dispose de 12 Go 
de RAM, la quantité totale de RAM disponible 
pour le cache disque sera de 8 Go.

Pour définir la quantité de RAM allouée au cache 
disque :

1 Sélectionnez Setup > Playback Engine.

2 À partir du sélecteur Disk Cache, sélectionnez 
la quantité de RAM que vous souhaitez allouer 
au cache disque.

3 Cliquez sur OK.

Observez la jauge du cache disque et de la 
mémoire de la fenêtre d'utilisation du système 
afin de déterminer la quantité de RAM 
à allouer au cache disque pour la session 
actuelle. Reportez-vous à la section 
« Utilisation du système » à la page 66.
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Configuration du MIDI
Si vous prévoyez d'utiliser des périphériques MIDI 
externes avec Pro Tools (tels que des contrôleurs, 
claviers, synthétiseurs, boîtes à rythmes, 
sampleurs, séquenceurs ou expandeurs), vous 
devez paramétrer votre configuration MIDI via 
l'utilitaire Configuration audio et MIDI (Mac) 
ou MIDI Studio Setup (Windows).

Configuration des 
paramètres matériels de 
Pro Tools
Pro Tools permet de configurer le routing des 
signaux, le format d'E/S numérique, la fréquence 
d'échantillonnage par défaut, la source d'horloge et 
d'autres paramètres matériels pouvant varier selon 
votre système. Ces paramètres système sont 
disponibles dans la boîte de dialogue Hardware 
Setup (Setup > Hardware).

Sélection d'une interface audio 
à configurer
La liste Peripherals de la boîte de dialogue 
Hardware Setup permet de sélectionner une 
interface audio connectée à votre système 
Pro Tools, associée au paramètre Playback Engine 
sélectionné dans la boîte de dialogue Playback 
Engine.

Pour modifier le paramètre Playback Engine afin 
d'utiliser une interface audio spécifique ou le 
moteur AAE (comme une interface HDX, 003, 
une interface Core Audio ou ASIO tierce ou 
l'agrégat d'E/S Pro Tools), reportez-vous à la 
section « Playback Engine » à la page 53.

Pour les interfaces audio Avid HD (comme une 
HD OMNI ou une HD I/O), vous pouvez 
configurer le routing des signaux, le format d'E/S 
numérique, la fréquence d'échantillonnage par 
défaut, la source d'horloge et d'autres paramètres 
matériels pour chaque périphérique HD connecté 
à votre système.

Pour certaines interfaces audio Avid (comme une 
003), vous pouvez configurer le routing des 
signaux, le format d'E/S numérique, la fréquence 
d'échantillonnage par défaut, la source d'horloge et 
d'autres paramètres matériels pouvant varier selon 
votre système. 

Pour plus d'informations, reportez-vous 
au Chapitre 10, « Configuration du 
MIDI ».

Page Main de la boîte de dialogue Hardware Setup 
pour une HD OMNI

Boîte de dialogue Hardware Setup pour une Mbox 
(3e génération)



Chapitre 6 : Configuration du système 59

Pour les interfaces audio de la famille Mbox 3e 
génération et les interfaces audio tierces 
compatibles Core Audio (Mac) et ASIO 
(Windows), cliquez le bouton Launch Control 

Panel pour ouvrir le panneau de configuration de 
votre interface audio.

Ouverture du panneau de 
configuration ou de l'application 
de configuration
(Pro Tools avec interface de la famille Mbox ou 
tierce uniquement)

Vous pouvez utiliser le panneau de configuration 
ou l'application de configuration de votre interface 
audio pour modifier les paramètres suivants, selon 
votre interface audio :

• Paramètres du mixeur

• Paramètres de sortie

• Paramètres matériels (fréquence 
d'échantillonnage, taille de la mémoire tampon 
matérielle et source de synchronisation).

Pour modifier les paramètres du panneau de 
configuration :

1 Dans la boîte de dialogue Hardware Setup, 
cliquez sur le bouton Launch Control Panel ou 
Launch Setup App (selon votre interface audio).

2 Pour modifier les paramètres du panneau de 
configuration ou de l'application de 
configuration, reportez-vous à la 
documentation de votre interface audio.

3 Lorsque vous avez terminé, fermez le panneau 
de configuration ou l'application de 
configuration.

Configuration de l'agrégat d'E/S 
Pro Tools
(Mac uniquement)

Sur les systèmes Mac utilisant un pilote Core Audio, 
vous pouvez sélectionner l'option Pro Tools 

Aggregate I/O en tant que moteur de lecture (Current 

Engine) pour utiliser les entrées et sorties audio 
intégrées de votre ordinateur Mac. Vous pouvez 
configurer l'agrégat d'E/S Pro Tools dans la 
configuration audio Mac, accessible à partir de la 
boîte de dialogue Hardware Setup de Pro Tools.

Pour configurer les paramètres de l'agrégat d'E/S 
Pro Tools :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez 
Pro Tools Aggregate I/O, ou toute autre option 
d'entrée ou de sortie intégrée sélectionnée en 
tant que moteur (Current Engine) dans la boîte 
de dialogue Playback Engine.

3 Cliquez sur le bouton Launch Setup App.

4 Dans la fenêtre Périphériques audio de la 
configuration audio Mac, configurez les 
paramètres de l'agrégat d'E/S Pro Tools.

Vous pouvez définir la fréquence 
d'échantillonnage lors de la création d'une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de dialogue 
New Session.

Boîte de dialogue Hardware Setup avec l'option 
Pro Tools Aggregate I/O (Mac uniquement)

Le périphérique Pro Tools Aggregate I/O 
est destiné à être utilisé uniquement avec 
le circuit audio intégré de votre ordinateur 
Mac. Utilisez les paramètres par défaut 
pour obtenir des performances optimales.
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Configuration de la fréquence 
d'échantillonnage par défaut 
dans Hardware Setup
Le paramètre Sample Rate de la boîte de dialogue 
Hardware Setup détermine la fréquence 
d'échantillonnage par défaut des nouvelles 
sessions. Ce paramètre ne peut être modifié que si 
aucune session n'est ouverte. Si une session est 
ouverte, la fréquence d'échantillonnage est 
affichée, mais ne peut pas être modifiée.

Avec du matériel Avid HDX et HD native, 
ce paramètre est accessible dans les boîtes de 
dialogue Hardware Setup et Playback Engine.

Sur les autres systèmes Pro Tools, vous pouvez 
uniquement modifier la fréquence 
d'échantillonnage par défaut dans la boîte de 
dialogue Hardware Setup ou en utilisant le 
panneau de configuration d'interfaces audio 
tierces.

Pour modifier la fréquence d'échantillonnage par 
défaut dans la boîte de dialogue Hardware Setup :

1 Sélectionnez Setup > Hardware Setup. 

2 Sélectionnez la fréquence d'échantillonnage 
dans le menu Sample Rate.

3 Cliquez sur OK.

Configuration de la source 
d'horloge
La boîte de dialogue Hardware Setup de Pro Tools 
permet de sélectionner une source d'horloge 
(Clock Source) pour le système.

Internal : si vous enregistrez un signal analogique 
directement dans Pro Tools, vous utiliserez 
généralement la source d'horloge interne (Internal). 

External : si vous transférez des données dans 
Pro Tools à partir d'un périphérique numérique 
externe ou si vous utilisez un signal d'horloge 
externe commun, synchronisez Pro Tools sur ce 
périphérique numérique ou ce signal commun. 

Selon le type d'interface audio, les options externes 
peuvent inclure AES/EBU [Encl], S/PDIF, Optical 

[Encl], AES/EBU 1–8, TDIF, ADAT et Word Clock. 
Pour plus d'informations, reportez-vous au guide 
de votre interface audio.

Pour sélectionner la source d'horloge :

1 Sélectionnez Setup > Hardware. 

2 Sélectionnez une source d'horloge dans le menu 
Clock Source.

3 Cliquez sur OK. 

La fréquence d'échantillonnage 
sélectionnée peut affecter le nombre de 
voix disponibles avec du matériel Avid 
HDX ou HD Native.

Vous pouvez définir la fréquence 
d'échantillonnage lors de la création d'une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de dialogue 
New Session.

Les modifications apportées au paramètre 
Clock Source dans la fenêtre Session Setup se 
répercutent dans la fenêtre Hardware Setup.

Votre périphérique d'entrée numérique doit 
être connecté et sous tension afin que la 
synchronisation de Pro Tools avec ce 
périphérique soit établie avec succès. S'il 
n'est pas sous tension, laissez la source 
d'horloge définie sur Internal.



Chapitre 6 : Configuration du système 61

Configuration du format 
numérique et du routing 
matériel
La boîte de dialogue Hardware Setup inclut des 
paramètres supplémentaires pour la configuration 
du format numérique et du routing matériel des 
interfaces audio de votre système.

Pour une description de la configuration d'un système 
Avid HDX ou HD Native avec une ou plusieurs 
interfaces Avid HD, reportez-vous à la section 
« Configuration des paramètres matériels des 
systèmes Avid HDX et HD Native » à la page 61.

Sélection d'une pédale de 
contrôle
(003 uniquement)

Le connecteur de pédale des interfaces de la 
famille 003 permet d'utiliser une pédale pour 
contrôler le lancement et l'arrêt de la lecture ou 
l'enregistrement en punch-in/out. Les fonctions 
d'enregistrement audio en punch-in et punch-out 
QuickPunch et MIDI sont prises en charge. 

Record Punch In/Out : sélectionnez cette option si 
vous souhaitez utiliser une pédale connectée 
à votre interface de la famille 003 pour contrôler 
les opérations de punch-in et punch-out en cours 
d'enregistrement.

Playback Start/Stop : sélectionnez cette option si 
vous souhaitez utiliser une pédale connectée 
à votre interface de la famille 003 pour lancer et 
arrêter la lecture.

Configuration des 
paramètres matériels des 
systèmes Avid HDX et 
HD Native
Vous devez configurer les paramètres matériels de 
chaque interface audio connectée à votre système 
Avid HDX ou HD Native (reportez-vous au 
Chapitre 5, « Systèmes Pro Tools ».).

Des interfaces audio HD I/O, HD OMNI ou 
HD MADI peuvent être connectées aux cartes 
HDX ou à du matériel HD Native d'un système 
Avid HDX ou HD Native. Des interfaces 
supplémentaires peuvent également être 
connectées aux interfaces HD I/O et HD OMNI 
via leur port d'extension.

Identification des interfaces 
audio
Si plusieurs interfaces audio du même type sont 
connectées à votre système, vous devez, avant 
d'effectuer toute connexion audio, confirmer 
l'identité de chacune. Vous pourrez ainsi 
sélectionner la bonne interface dans la liste 
Peripherals pour configurer ses entrées et sorties 
dans la boîte de dialogue Hardware Setup. 

Pour identifier les interfaces audio de votre 
système :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez une 
interface audio connectée à votre système.

3 Assurez-vous que la page Main est bien 
affichée.

Pour configurer des paramètres matériels 
spécifiques pour d'autres interfaces audio 
Pro Tools ou tierces, reportez-vous à la 
documentation de votre interface audio.

Utilisez les touches Flèche haut et bas pour 
naviguer dans la liste des périphériques de la 
boîte de dialogue Hardware Setup.
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4 Activez l'option Identify, située dans le coin 
inférieur gauche de la boîte de dialogue Hardware 
Setup. Toutes les LED du panneau avant de 
l'interface audio sélectionnée s'allument. 

5 Notez l'interface de votre configuration de 
studio correspondant à l'interface sélectionnée. 

6 Répétez les étapes ci-dessus pour toute autre 
interface audio de votre configuration.

Configuration des interfaces 
audio Avid HD
La HD OMNI prend en charge jusqu'à huit canaux 
d'E/S simultanés et plusieurs formats d'E/S (tels 
que les formats analogique, AES/EBU, ADAT 
optique et S/PDIF). 

Les interfaces audio HD I/O prennent en charge 
seize canaux d'E/S simultanés et plusieurs formats 
d'E/S (tels que les formats analogique, AES/EBU, 
ADAT optique, S/PDIF et TDIF). La HD MADI 
prend en charge jusqu’à 64 canaux d’E/S MADI.

La page Main de la boîte de dialogue Hardware 
Setup permet de spécifier les entrées et sorties 
physiques de votre interface audio routées vers des 
entrées et sorties disponibles de Pro Tools. Vous 
pouvez considérer cette fenêtre comme un 
patchbay permettant de router n'importe quelle 
sortie ou entrée de vos interfaces audio vers des 
assignations de canaux du mixeur de Pro Tools.

Des pages supplémentaires sont disponibles afin 
de configurer d'autres paramètres pour chaque 
interface audio (tels que les niveaux de 
fonctionnement).

Pour configurer des interfaces audio Avid HD :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez 
l'interface audio connectée à la première carte 
de votre système. Il s'agit de la première 
interface figurant dans la liste.

3 Cliquez sur l'onglet Main.

4 Dans le menu Clock Source, sélectionnez la 
source d'horloge appropriée pour l'interface.

Vous choisirez la source Internal dans la plupart 
des cas. Les autres choix permettent de 
synchroniser Pro Tools sur des sources d'horloge 
externes. Selon votre interface audio, les choix de 
sources d'horloge peuvent inclure : AES/EBU 

[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, TDIF, 

ADAT et Word Clock (des fréquences de signal 
Word Clock optionnelles sont disponibles aux 
fréquences d'échantillonnage les plus élevées).

5 Si vous souhaitez envoyer un signal d'horloge 
vers d'autres périphériques reliés à l'interface 
audio, sélectionnez la sortie appropriée dans le 
menu Ext. Clock Output. 

Page Main de la boîte de dialogue Hardware Setup 
pour une HD I/O

Appuyez sur Commande+Flèche gauche ou 
droite (Mac) ou Ctrl+Flèche gauche ou 
droite (Windows) pour vous déplacer entre 
les différentes pages de la boîte de dialogue 
Hardware Setup.
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6 Sélectionnez un port d'E/S numérique actif de 
votre interface audio en choisissant l'option 
correspondante sous Digital Format. Selon le 
type d'interface de votre système, vous pouvez 
sélectionner AES/EBU, S/PDIF et Optical 

(S/PDIF). L'option Optical (S/PDIF) réinitialise 
le port d'E/S optique (constitué, par défaut, de 
huit canaux d'E/S ADAT optiques) sur deux 
canaux d'E/S S/PDIF optiques.

7 Pour une compatibilité S/PDIF avec les 
enregistreurs DAT Tascam DA-30, sélectionnez 
Tascam sous S/PDIF Format.

8 Dans les menus Input et Output, sélectionnez les 
ports physiques (tels que Analog 1–2 ou 
Optical 1–2) qui seront routés vers les canaux 
d'entrée et de sortie correspondants de 
Pro Tools (comme Ch 1-2 ou Ch 3-4), affichés 
dans la partie gauche de la page Main.

Pour différencier les entrées et sorties d'un même 
format, celles-ci sont désignées différemment dans 
les menus des canaux d'entrée et de sortie. 
Par exemple, les entrées et sorties AES/EBU du 
châssis de la HD I/O sont nommées AES/EBU 

[Encl], tandis que les entrées et sorties AES/EBU 
de la carte d'E/S numérique d'origine sont 
nommées (par paire) AES/EBU 1–2, AES/EBU 

3–4, AES/EBU 5–6 et AES/EBU 7–8. Pour les 
HD I/O équipées d'une seconde carte d'E/S 
numérique, les ports d'E/S AES/EBU 
supplémentaires de la carte optionnelle sont 
nommés AES/EBU 9–10, AES/EBU 11–12, 

AES/EBU 13–14 et AES/EBU 15–16.

9 Configurez les paramètres spécifiques à votre 
interface audio :

• « Configuration des paramètres d'une 
HD OMNI » à la page 63.

• « Configuration des paramètres d'une HD I/O » 
à la page 64.

• « Configuration des paramètres d'une 
HD MADI » à la page 65.

10 Pour chaque interface audio supplémentaire, 
sélectionnez l'interface dans la liste Peripherals 
et répétez les étapes ci-dessus.

Configuration des paramètres 
d'une HD OMNI

Pour configurer une HD OMNI dans Pro Tools :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez 
l'interface audio HD OMNI.

3 Cliquez sur l'onglet Monitor et configurez les 
options. Lorsque vous utilisez une HD OMNI, 
commencez toujours par configurer la page 
Monitor.

4 Cliquez sur l'onglet Main et configurez les 
options.

Reportez-vous au guide de votre interface 
audio pour obtenir des informations 
supplémentaires sur sa configuration et les 
restrictions.

Pour plus d'informations sur la configuration 
d'une HD OMNI, reportez-vous au Guide 
HD OMNI.

Page Monitor de la boîte de dialogue Hardware Setup 
d'une HD OMNI
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5 Cliquez sur l'onglet Analog In et configurez 
les options.

6 Cliquez sur l'onglet Analog Out et configurez 
les options.

7 Cliquez sur l'onglet Mixer et configurez les 
options.

8 Lorsque vous avez terminé, cliquez sur OK.

Configuration des paramètres 
d'une HD I/O

Pour configurer les paramètres d'une HD I/O :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez 
l'interface audio HD I/O.

3 Cliquez sur l'onglet Main et configurez les 
options.

Page Main de la boîte de dialogue Hardware Setup 
d'une HD OMNI

Page Analog In de la boîte de dialogue Hardware 
Setup d'une HD OMNI

Page Analog Out de la boîte de dialogue Hardware 
Setup d'une HD OMNI

Page Mixer de la boîte de dialogue Hardware Setup 
d'une HD OMNI

Pour plus d'informations sur la configuration 
d'une HD I/O, reportez-vous au Guide 
HD I/O.

Page Main de la boîte de dialogue Hardware Setup 
d'une HD I/O
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4 Si vous utilisez au moins une carte AD HD I/O, 
cliquez sur l'onglet Analog In et configurez les 
options. Si vous utilisez deux cartes AD 
HD I/O, cet onglet s'appelle Analog In 1–8.

5 Si vous utilisez deux cartes AD HD I/O, cliquez 
sur l'onglet Analog In 9–16 et configurez les 
options.

6 Si vous utilisez au moins une carte Digital 
HD I/O, cliquez sur l'onglet Digital et 
configurez les options.

7 Si vous utilisez deux cartes Digital HD I/O, 
cliquez sur le second onglet Digital et configurez 
les options.

8 Lorsque vous avez terminé, cliquez sur OK.

Configuration des paramètres 
d'une HD MADI

Pour configurer les paramètres d'une HD MADI :

1 Sélectionnez Setup > Hardware.

2 Dans la liste Peripherals, sélectionnez 
HD MADI Port 1 ou HD MADI Port 2 et 
configurez les options.

3 Lorsque vous avez terminé, cliquez sur OK.

Page Analog In de la boîte de dialogue Hardware 
Setup d'une HD I/O

Pour plus d'informations sur la configuration 
d'une HD MADI, reportez-vous au Guide 
HD MADI.

Boîte de dialogue Hardware Setup d'une HD MADI

Les paramètres HD MADI Port 1 et 
HD MADI Port 2 sont liés. Les modifications 
sont appliquées globalement, 
indépendamment du port sélectionné dans la 
liste Peripherals.
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Utilisation du système
Les jauges de la fenêtre System Usage indiquent la 
quantité de ressources système utilisées pour le 
traitement audio, ainsi que l'écriture et la lecture 
des données d'automation.

Lorsque ces jauges approchent de leurs limites, 
le traitement hôte et l'enregistrement ou la lecture 
des données d'automation peuvent être affectés. 
Des erreurs système peuvent se produire en raison 
d'une activité intense du processeur ou du bus PCI. 
Si l'activité sur les disques est élevée, Pro Tools 
peut ignorer certaines données d'automation en 
lecture pendant les périodes d'activité 
particulièrement denses, notamment lors de 
l'exécution d'une commande Bounce to Disk. 

Jauges CPU
La jauge Total CPU représente les performances de 
la session pour les traitements Elastic Audio, 
le Gain du clip, les plug-ins Native et le mixeur.

Les jauges CPU individuelles fournissent une 
indication générale de l'utilisation par Pro Tools de 
chaque processeur de votre ordinateur.

Jauges Activity
Les jauges de la section Activity de la fenêtre 
System Usage indiquent l'utilisation du disque et 
de la mémoire.

Jauge Disk

Comme dans les versions précédentes de 
Pro Tools, la jauge Disk indique l'activité du 
disque dur.

Jauge Disk Cache
(logiciel Pro Tools HD uniquement)

Le logiciel Pro Tools HD dispose d'une jauge 
permettant de contrôler l'utilisation du cache 
disque dans la fenêtre System Usage. Cette jauge 
est présente uniquement si une valeur Cache Size 
fixe est sélectionnée dans la boîte de dialogue 
Playback Engine.

La jauge Disk Cache indique la quantité de 
mémoire allouée au cache de l'audio de la timeline 
(dans la limite de la quantité de RAM sélectionnée 
pour le paramètre Disk Cache de la boîte de 
dialogue Playback Engine). Un indicateur 
supplémentaire de type crête mètre est inclus pour 
afficher la quantité de la mémoire RAM allouée 
nécessaire pour mettre en cache la session.

Fenêtre System Usage

Fenêtre System Usage avec jauge Disk Cache



Chapitre 6 : Configuration du système 67

Jauge Memory

La jauge Memory indique la quantité de mémoire 
RAM physique du système actuellement utilisée 
par Pro Tools. Cette jauge prend en compte la 
RAM utilisée par le moteur audio, le moteur vidéo 
(s'il est activé), les plug-ins et le cache disque. Elle 
ne prend pas en compte la RAM utilisée par les 
tâches système ou les applications autres que 
Pro Tools. Si la jauge Memory est proche des 
100 %, installez plus de RAM physique ou 
réduisez la valeur du paramètre Disk Cache de la 
boîte de dialogue Playback Engine.

Jauges d'utilisation des DSP
(Systèmes Avid HDX uniquement)

Les systèmes Avid HDX disposent de jauges 
supplémentaires sous la section Activity. 

Voices

La jauge Voices affiche le nombre total de voix 
pouvant être allouées et le nombre de voix 
actuellement allouées. Elle prend en compte toutes 
les voix, qu'elles soient allouées explicitement ou 
dynamiquement, ainsi que toutes les voix utilisées 
pour le routing des traitements basés sur hôte. 

Time Slots

La jauge Time Slots affiche le nombre total de 
plages de temps DSP disponibles et le nombre de 
plages de temps DSP actuellement utilisées.

DSP

Les jauges DSP affichent le pourcentage actuel 
d'utilisation de chaque puce DSP sur chaque carte 
Avid HDX pour les configurations du mixeur et les 
plug-ins basés sur DSP.

Gestion des ressources 
système

Pour contrôler l'utilisation des ressources lors 
d'une session Pro Tools :

 Sélectionnez Window > System Usage.

Pour réduire la charge de traitement, effectuez 
l'une des actions suivantes :

 Réduisez la densité de l'automation aux endroits 
où l'activité est la plus élevée. Pour plus de 
détails, reportez-vous à la section « Affinage de 
l'automation » à la page 1092. 

 Désactivez les entrées et sorties de pistes inutilisées. 
Pour plus de détails, reportez-vous à la section 
« Désactivation des entrées et sorties de pistes à 
partir de la fenêtre Edit ou Mix » à la page 238.

 Désactivez les pistes inutilisées. Pour plus de 
détails, reportez-vous à la section 
« Désactivation des pistes » à la page 247.

 Désactivez les plug-ins DSP inutilisés. Pour 
plus de détails, reportez-vous à la section 
« Désactivation des inserts » à la page 1037.

Fenêtre System Usage (système Pro Tools|HDX 2)

Voices

Time Slots

Utilisation 
des DSP
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Chapitre 7 : I/O Setup

La boîte de dialogue I/O Setup contient des outils permettant de nommer, de sélectionner un format et d'assigner 
les chemins des signaux audio des entrées, sorties, inserts et bus de Pro Tools pour chaque session et chaque 
système Pro Tools. La boîte de dialogue I/O Setup contient également des commandes pour les chemins de 
signaux du préampli micro PRE et des paramètres de compensation du délai pour les inserts matériels.

La boîte de dialogue I/O Setup affiche une représentation graphique (matrice de points de croisement) 
du routing des signaux des chemins d'entrée et de sortie physiques de chaque interface audio connectée. 
À l'instar d'un patchbay virtuel, les commandes I/O Setup permettent de router les signaux des entrées et 
sorties physiques de l'interface audio vers les canaux d'entrée et de sortie de Pro Tools. Pour les systèmes 
Avid HDX et HD Native, certaines de ces commandes reflètent les commandes de routing de la boîte de 
dialogue Hardware Setup : les modifications apportées au routing physique dans une boîte de dialogue sont 
toujours répercutées dans l'autre. La boîte de dialogue I/O Setup comprend également des commandes de 
création de bus de mixage internes, ainsi que de création et de mappage de bus de sortie.

Boîte de dialogue I/O Setup sur un système Avid HDX avec une HD OMNI et une HD I/O

Grille des canaux

Onglets des types
de chemin

État actif/inactif

Sélecteur de format de chemin

Colonne des noms
de chemin

Outils des chemins

Sélecteurs d'entrée 
et de sortie

Étiquette du nom d'interface

Paramètres
d'importation/exportation

Options
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Ouverture de la boîte de 
dialogue I/O Setup
La boîte de dialogue I/O Setup peut être ouverte 
à partir de la fenêtre de l'application (si aucune 
session n'est ouverte), ou à partir d'une session 
ouverte.

Pour ouvrir la boîte de dialogue I/O Setup :

1 Vérifiez que les interfaces audio sont activées et 
correctement configurées dans la boîte de 
dialogue Hardware Setup. Reportez-vous à la 
section « Configuration des paramètres 
matériels de Pro Tools » à la page 58.

2 Sélectionnez Setup > I/O. 

Fermeture de la boîte de 
dialogue I/O Setup

Pour fermer la boîte de dialogue I/O Setup et 
enregistrer les modifications :

 Cliquez sur OK.

Pro Tools vérifie la validité de plusieurs 
paramètres de routing (afin d'éviter les boucles de 
réinjection). Lorsque certains paramètres entrent 
en conflit ou ne sont pas valides, le système vous 
demande de les corriger (reportez-vous à la section 
« Chemins valides et conditions » à la page 95).

Pour fermer la boîte de dialogue I/O Setup sans 
enregistrer les modifications :

 Cliquez sur Cancel.

Navigation dans la boîte de 
dialogue I/O Setup

Pour faire défiler le contenu de la boîte de dialogue 
I/O Setup vers la gauche ou la droite :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et appuyez sur la touche Page 
haut/bas.

Chemins de signaux de 
Pro Tools
Un chemin de signal correspond à un groupement 
logique de plusieurs entrées, sorties ou bus 
sous un nom et un format (de canal) uniques. 
La boîte de dialogue I/O Setup permet de créer, 
définir et nommer les chemins en fonction de la 
configuration de votre studio et des besoins de 
chaque projet.

Chemins principaux et sous-chemins

Les chemins des pistes de Pro Tools et de la boîte 
de dialogue I/O Setup incluent des chemins 
principaux et des sous-chemins.

Chemins principaux : les chemins principaux sont 
des groupements logiques d'entrées, d'inserts, 
de bus ou de sorties. Par exemple, un chemin de 
sortie stéréo principal inclut à la fois les canaux 
gauche et droit. 

Sous-chemins : un sous-chemin représente un 
chemin de signal inclus dans un chemin principal. 
Par exemple, un chemin de bus de sortie stéréo par 
défaut est constitué de deux sous-chemins mono, 
gauche et droit. Les signaux des pistes et départs 
mono peuvent être routés vers l'un ou l'autre des sous-
chemins mono d'un chemin de bus de sortie stéréo. 

Chemins principaux et sous-chemins dans la boîte de 
dialogue I/O Setup (page Input)
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Chemins dans les sessions
Dans les sessions, les signaux sont routés vers et 
à partir des pistes, départs et inserts à l'aide des 
sélecteurs d'entrée, de sortie, d'insert et de départ 
des pistes.

Lorsque vous cliquez sur le sélecteur d'entrée, 
de sortie, d'insert ou de départ d'une piste, 
les chemins créés et définis dans la boîte de 
dialogue I/O Setup apparaissent dans la liste de 
chemins disponibles (reportez-vous à la section 
« Assignation des entrées et sorties audio des 
pistes » à la page 234).

Configuration des chemins 
et paramètres d'E/S
Chaque système Pro Tools peut posséder une 
configuration de chemins différente, déterminée 
par les conditions suivantes :

• Sur les systèmes Pro Tools, le type d'interface 
audio ou d'autres E/S physiques (y compris 
le matériel intégré). ;

• Sur les systèmes Avid HDX et HD Native, 
le nombre et le type d'interface audio.

Les configurations de chemins dans Pro Tools sont 
enregistrées en tant que paramètres d'E/S.

Les paramètres d'E/S sont enregistrés avec la 
session et sur le système. Vous pouvez choisir 
si les paramètres d'E/S enregistrés avec la session 
doivent remplacer les paramètres d'E/S enregistrés 
sur le système (reportez-vous à la section 
« Sessions Overwrite Current I/O Setup When 
Opened » à la page 81).

Les éléments non disponibles (matériel, chemins 
ou ressources nécessaires) demeurent dans la 
session, mais sont désactivés (reportez-vous à la 
section « Activation ou désactivation de chemins » 
à la page 93).

Lorsque vous créez une nouvelle session, vous 
pouvez spécifier les paramètres d'E/S à utiliser. 
Par exemple, vous pouvez utiliser les paramètres 
d'usine par défaut, les derniers paramètres utilisés 
ou l'un des fichiers de paramètres d'E/S 
personnalisés disponibles.

Paramètres d'E/S par défaut

Pro Tools propose des paramètres d'E/S par défaut 
dans la boîte de dialogue I/O Setup que vous 
pouvez utiliser en tant que points de départ pour 
votre configuration (reportez-vous à la section 
« Paramètres d’E/S d’usine » à la page 100). 
Ouvrez la boîte de dialogue I/O Setup uniquement 
si vous souhaitez personnaliser les chemins d'E/S 
ou modifier votre système (ajouter par exemple 
une carte d'extension à une interface HD I/O ou 
ajouter/supprimer une interface audio). 

Vous pouvez toujours rétablir les paramètres par 
défaut d'une page de paramètres d'E/S en cliquant 
sur le bouton Default. Ces chemins sont 
disponibles à partir des pistes de la session et 
apparaissent dans la boîte de dialogue I/O Setup. 

Vous pouvez personnaliser votre configuration d'E/S 
à tout moment, selon les besoins spécifiques de chaque 
projet (reportez-vous à la section « Personnalisation 
des paramètres d'E/S » à la page 81).

Il est particulièrement utile de configurer et 
nommer des sous-chemins pour les mixages 
les plus complexes, tels qu'un mix 
surround 5.1. 

Pour en savoir plus, reportez-vous aux 
sections « Paramètres d’E/S d’usine » à la 
page 100 et « Fichiers de paramètres 
d'E/S » à la page 101.
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Pages de la boîte de dialogue 
I/O Setup
La boîte de dialogue I/O Setup comporte plusieurs 
onglets de configuration de paramètres d'E/S 
spécifiques.

Ouverture d'une page I/O Setup

Pour ouvrir une page I/O Setup :

 Cliquez sur l'onglet correspondant en haut de la 
boîte de dialogue I/O Setup.

Page Input
La page Input de la boîte de dialogue I/O Setup 
permet de créer et d'assigner des canaux d'entrée 
de Pro Tools pour recevoir de l'audio à partir des 
entrées physiques de votre matériel audio. 

Configurez les noms de chemin, les formats et le 
canal source (analogique ou numérique) du signal 
d'entrée sur la page Input. Les chemins d'entrée 
multicanal (stéréo ou supérieur) peuvent contenir 
autant de sous-chemins que vous le souhaitez. 
Des chemins d'entrée peuvent se chevaucher sur 
un canal d'entrée. Les noms d'entrée, les largeurs 
de canal et le mappage des entrées physiques sont 
enregistrés avec le système et la session et peuvent 
être rappelés à partir de l'un ou l'autre.

Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur la 
touche Flèche gauche ou droite pour faire 
défiler les différentes pages de la boîte de 
dialogue I/O Setup.

Si vous choisissez de personnaliser votre 
configuration d'E/S, nous vous 
recommandons de configurer les options 
spécifiques au système en premier : Input, 
Output, Insert, Mic Preamps et H/W Insert 
Delay. Configurez ensuite la page Bus. 
Une fois votre système configuré, il ne devrait 
plus nécessiter de modification, sauf en cas 
d'ajout ou de suppression de matériel (comme 
des interfaces audio). Reportez-vous à la 
section « Personnalisation des paramètres 
d'E/S » à la page 81.

Page Input de la boîte de dialogue I/O Setup
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Page Output
La page Output de la boîte de dialogue I/O Setup 
permet de créer et d'assigner des canaux de sortie 
de Pro Tools pour envoyer de l'audio aux sorties 
physiques de votre matériel audio. 

Configurez les noms de chemin et les formats des 
signaux de sortie sur la page Output. Des chemins 
de sortie peuvent se chevaucher sur des canaux de 
sortie. Les noms de sortie, les largeurs de canal et 
le mappage des sorties physiques sont enregistrés 
avec le système et la session et peuvent être 
rappelés à partir de l'un ou l'autre.

Page Bus
La page Bus de la boîte de dialogue I/O Setup 
permet de créer et de configurer des bus de mixage 
internes et de sortie. La page Bus permet 
également de mapper des bus de sortie sur des 
chemins de sortie (suivant la configuration de la 
page Output). 

Configurez les noms et formats des chemins de 
bus, puis mappez les chemins de bus principaux 
sur des sorties disponibles dont la largeur est 
identique ou supérieure. Les chemins de bus 
multicanal (stéréo ou supérieur) peuvent contenir 
autant de sous-chemins que vous le souhaitez. 
Les noms et largeurs de canal des bus de sortie et 
bus de mixage internes sont enregistrés et rappelés 
avec la session.

Page Output de la boîte de dialogue I/O Setup

Page Bus de la boîte de dialogue I/O Setup

Pour plus d'informations, reportez-vous à la 
section « Configuration des bus » à la 
page 96.
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Page Insert
La page Insert de la boîte de dialogue I/O Setup 
permet de créer et de configurer des chemins de 
signal d'inserts matériels du mixeur de Pro Tools. 
Les inserts matériels peuvent router de l'audio vers 
un périphérique externe connecté aux entrées et 
sorties parallèles d'une interface audio Pro Tools. 
Vous pouvez ainsi traiter les données audio d'une 
piste en temps réel à l'aide d'un insert matériel. 

Les chemins d'insert nécessitent des entrées et 
sorties de l'interface audio et sont déterminés par la 
configuration de la page Insert de la boîte de 
dialogue I/O Setup de votre système.

Page Mic Preamps
Sur la page Mic Preamps de la boîte de dialogue 
I/O Setup, les chemins de signal d'un ou plusieurs 
préamplis micro multifonctions PRE peuvent être 
mappés sur des interfaces audio. Pour plus 
d'informations, reportez-vous au Guide PRE.

Page Insert de la boîte de dialogue I/O Setup

Pour plus d'informations, reportez-vous 
à la section « Utilisation d'inserts 
matériels » à la page 1061.

Page Mic Preamps
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Page H/W Insert Delay 
(Compensation)
Pour compenser le délai (latence) des 
périphériques matériels externes (tels qu'un 
processeur d'effets) utilisés dans une session, vous 
pouvez définir la valeur de compensation du délai 
des inserts matériels (en millisecondes) pour 
chaque périphérique externe. Les valeurs saisies 
seront utilisées par le moteur de compensation du 
délai pour synchroniser les chemins d'entrées 
lorsque l'insert matériel est en cours d'utilisation et 
que la compensation du délai est activée.

Commandes des chemins de 
signaux dans I/O Setup
Selon la page I/O Setup affichée, les commandes 
suivantes sont disponibles dans la représentation 
graphique pour configurer les chemins de routing 
des signaux.

Sélecteurs d'entrée et de sortie : permettent de 
sélectionner les ports physiques de votre interface 
audio à router vers les entrées et sorties de 
Pro Tools. Les ports sont disponibles sous forme 
de paires de canaux. Les ports disponibles pour 
chaque interface affichée sont basés sur les 
paramètres définis dans la boîte de dialogue 
Hardware Setup. Si, par exemple, les entrées et 
sorties AES/EBU d'une interface sont activées 
dans Hardware Setup, elles sont disponibles pour 
le routing dans I/O Setup. La fonctionnalité des 
sélecteurs d'entrée et de sortie est identique à celle 
disponible sur la page Main de la boîte de dialogue 
Hardware Setup.

Colonne des noms de chemin : indique les 
chemins pouvant être sélectionnés, avec le nom 
spécifié pour chaque chemin défini. Il est possible 
de renommer les chemins.

Champ des délais inhérents aux inserts

Pour plus d'informations, reportez-vous à la 
section « Définition d'un décalage du délai 
pour un insert matériel » à la page 1028.

Commandes des chemins de signaux de la page Input 
de la boîte de dialogue I/O Setup

Colonne des noms 
de chemin

Sélecteur de format de chemin

Sélecteur d'entrée

Triangle 
Développer/réduire

Case d'état 
activé/désactivé

Grille des canaux
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Triangle Développer/réduire : affiche ou masque 
les sous-chemins associés à un chemin principal 
(chemins d'entrée et de bus uniquement).

Case d'état activé/désactivé : indique et permet 
de modifier l'état, activé ou désactivé, de chaque 
chemin.

Sélecteur de format de chemin : affiche et permet 
de sélectionner le type/format (mono, stéréo, Quad 
ou 5.1) de chaque chemin défini (les formats 
multicanal supérieurs à stéréo sont pris en charge 
uniquement sur Pro Tools HD).

Grille des canaux : permet d'assigner des chemins 
à des interfaces et canaux spécifiques. 

Boutons de la boîte de 
dialogue I/O Setup
Selon la page affichée, la boîte de dialogue 
I/O Setup fournit les boutons suivants de 
configuration du routing des signaux.

Bouton New Path : permet de créer un nouveau 
chemin sur les pages Input, Output, Insert, Bus ou 
Mic Preamp.

Bouton New Sub-path : permet de créer un 
nouveau sous-chemin sur les pages Input, Insert 
ou Bus.

Bouton Delete Path : permet de supprimer un 
chemin ou sous-chemin sélectionné sur les pages 
Input, Output, Insert ou Bus.

Bouton Default : réinitialise un type de chemin sur 
sa configuration par défaut, en fonction de l'E/S 
matérielle physique utilisée et de la configuration 
de votre matériel.

Bouton Import Settings : permet d'importer un 
fichier de paramètres d'E/S pour reconfigurer la 
boîte de dialogue I/O Setup. Le bouton Import 

Settings permet d'importer uniquement les 
paramètres liés à la page actuellement affichée 
(page Input par exemple).

Bouton Export Settings : permet d'enregistrer les 
paramètres d'E/S dans un fichier pouvant être 
importé dans les autres sessions ou utilisé sur 
d'autres systèmes Pro Tools. Le bouton Export 

Settings exporte les paramètres de toutes les pages 
de la boîte de dialogue I/O Setup.

Show Last Saved Setup : apparaît dans la boîte de 
dialogue I/O Setup pour certains transferts de 
sessions. Pour plus de détails sur cette fonction, 
reportez-vous à la section « Show Last Saved 
Setup et Show Current Setup » à la page 104.

Bouton Cancel : ferme la boîte de dialogue 
I/O Setup sans enregistrer les modifications.

Bouton OK : ferme la boîte de dialogue I/O Setup 
en enregistrant les modifications.

Boutons de routing des signaux de la page Input 
d'I/O Setup

Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et cliquez sur le 
bouton Default pour rétablir les chemins par 
défaut sur toutes les pages de la boîte de 
dialogue I/O Setup.

Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton 
Import Settings pour importer les paramètres 
sur toutes les pages de la boîte de dialogue 
I/O Setup.
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Options d'I/O Setup
Les systèmes Pro Tools proposent plusieurs 
options de configuration des E/S supplémentaires 
en fonction de la page affichée de la boîte de 
dialogue I/O Setup. Ces options concernent le 
routing des signaux par défaut pour la mesure des 
niveaux et l'écoute, et la disposition des pistes par 
défaut pour les formats de mixage multicanal.

Compensation des délais après 
enregistrement
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native uniquement)

Pro Tools propose deux options de compensation 
de la latence d'entrée et de sortie après 
l'enregistrement, latence inhérente aux 
convertisseurs analogique/numérique et 
numérique/analogique de l'interface audio.

Compensation for Input Delays After 
Record Pass

Lorsqu'elle est activée, cette option compense 
automatiquement le délai inhérent aux entrées 
analogiques ou numériques des interfaces 
Avid HD. Activez cette option pour toutes les 
configurations d'enregistrement. Lorsque vous 
enregistrez une source numérique, les options 
Compensation for Input Delays After Record Pass 
et Compensation for Output Delays After Record 

Pass doivent être activées.

L'option Compensation for Input Delays After 

Record Pass est uniquement disponible sur la page 
Input de la boîte de dialogue I/O Setup.

Compensation for Output Delays After 
Record Pass

Lorsqu'elle est activée, cette option compense 
automatiquement le délai inhérent aux sorties 
analogiques ou numériques des interfaces Avid HD. 
Activez cette option lorsqu'une source d'horloge 
externe est utilisée pour la synchronisation. Lorsque 
vous enregistrez une source numérique, les options 
Compensation for Input Delays After Record Pass et 
Compensation for Output Delays After Record Pass 
doivent être activées.

L'option Compensation for Output Delays After 
Record Pass est uniquement disponible sur la page 
Output de la boîte de dialogue I/O Setup.

Output Meter Path
Le sélecteur Output Meter Path détermine les 
chemins de sortie ou de bus dont les niveaux sont 
affichés sur les indicateurs de la fenêtre de 
transport (reportez-vous à la section « Indicateurs 
de niveau de sortie » à la page 1012).

Le sélecteur Output Meter Path est disponible sur 
la page Output de la boîte de dialogue I/O Setup.

Pour sélectionner les chemins des indicateurs de 
niveau de sortie :

1 Sélectionnez Setup > I/O Setup.

2 Cliquez sur l'onglet Output.

3 Depuis le sélecteur Output Meter Path, 
sélectionnez le chemin de sortie à monitorer sur 
les indicateurs.

Controller Meter Path
Le sélecteur Controller Meter Path détermine 
le chemin affiché sur les indicateurs de 
niveaude sortie des surfaces de contrôle D-Control 
ou D-Command. Pour plus de détails, reportez-vous 
à la documentation de votre surface de contrôle.

Le sélecteur Controller Meter Path est disponible 
sur la page Bus de la boîte de dialogue I/O Setup.

Options de routing des signaux de la page Output 
d'I/O Setup



Guide de référence Pro Tools78

Audition Paths
Vous pouvez spécifier le chemin de sortie sur 
lequel les fichiers et clips sont routés pour l'aperçu 
dans la liste des clips ou dans les navigateurs de 
l'espace de travail, ainsi que pour l'aperçu des 
traitements AudioSuite.

Le sélecteur Audition Paths est disponible sur les 
pages Output et Bus de la boîte de dialogue 
I/O Setup.

Utilisation du chemin d'écoute par 
défaut

Lorsque vous lancez l'aperçu d'un fichier ou d'un 
clip à partir de la liste des clips ou d'un navigateur 
de l'espace de travail, ou lors d'un aperçu d'un 
traitement AudioSuite, Pro Tools route la sortie 
audio vers le chemin d'écoute spécifié. Pro Tools 
assigne un chemin d'écoute par défaut sur le 
premier chemin de sortie principal disponible du 
format correspondant. Vous pouvez également 
sélectionner un chemin d'écoute différent dans la 
boîte de dialogue I/O Setup.

Configuration des chemins d'écoute

Vous pouvez spécifier les sorties de monitoring 
utilisées pour l'écoute d'éléments audio de la liste 
des clips et des navigateurs de l'espace de travail, 
ou pour l'aperçu des traitements AudioSuite, 
à l'aide du menu Audition Paths. 

Menu principal des chemins d'écoute : le menu 
principal est constitué de tous les choix de formats 
de chemin disponibles sur le système actuel (mono 
et stéréo sur tous les systèmes, formats LCR et 
supérieurs sur Pro Tools HD uniquement). 

Sous-menus des chemins d'écoute : chaque 
choix de format de chemin dispose d'un sous-menu 
répertoriant les chemins de sortie pour ce format 
donné. Le sous-menu mono répertorie les chemins 
de sortie de tous les formats.

Pour configurer un chemin d'écoute :

 Sélectionnez un chemin dans le menu ou les 
sous-menus Audition Paths.

Default Output Bus
Vous pouvez définir l'assignation du chemin du 
bus de sortie par défaut pour les nouvelles pistes, 
dans chaque format disponible. 

Le sélecteur Default Output Bus est disponible sur 
les pages Output et Bus de la boîte de dialogue 
I/O Setup.

Pour spécifier une sortie par défaut pour les 
nouvelles pistes dans la boîte de dialogue 
I/O Setup :

 Cliquez sur le menu Default Output Bus, puis 
sélectionnez un format et un chemin de bus de 
sortie.

AFL/PFL Path
(Pro Tools HD avec matériel Avid HDX ou HD 
Native uniquement)

Les pistes en solo en mode Solo AFL (After Fader 
Listen) ou PFL (Pre Fader Listen) sont routées vers 
le chemin AFL/PFL spécifié par le sélecteur 
AFL/PFL Path.

Le sélecteur AFL/PFL Path est disponible sur les 
pages Output et Bus de la boîte de dialogue 
I/O Setup.

Pour plus d'informations sur l'aperçu audio, 
reportez-vous à la section « Aperçu des clips 
dans la liste des clips » à la page 274 ou 
« Aperçu audio dans les navigateurs de 
l'espace de travail » à la page 306.

Le bus de sortie par défaut peut être 
défini pour les chemins de bus de mixage 
internes et les chemins de bus de sortie.
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Pour sélectionner la sortie du chemin AFL/PFL :

 Sélectionnez un chemin dans le menu déroulant 
AFL/PFL Path.

Réglage des niveaux des chemins AFL et PFL

Vous pouvez définir un niveau master de chemin 
AFL/PFL indépendant pour tous les solos AFL et 
tous les solos PFL.

Pour configurer le niveau de chemin AFL/PFL pour 
les solos AFL ou PFL :

1 Sélectionnez Options > Solo Mode et 
sélectionnez un mode Solo :

• Pour définir le niveau des solos AFL, 
sélectionnez AFL.

• Pour définir le niveau des solos PFL, 
sélectionnez PFL.

2 Dans la fenêtre Mix ou Edit, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
et cliquez sur un bouton Solo d'une piste.

3 Ajustez le fader du chemin AFL/PFL.

4 Cliquez sur la nouvelle position du fader 
(ou appuyez sur Échap) pour fermer la fenêtre 
du fader.

AFL/PFL Mutes (chemin de sortie)
(Systèmes sans surface de contrôle D-Control 
ou D-Command)

Si vous n'utilisez pas de console D-Control™ ou 
D-Command®, il est possible de muter le chemin 
de sortie habituel de Pro Tools lorsqu'un signal 
est envoyé sur le chemin AFL/PFL. Le chemin 
qui sera muté peut être sélectionné grâce au 
sélecteur AFL/PFL Mutes (chemin de sortie).

Le sélecteur AFL/PFL Mutes est disponible sur les 
pages Output et Bus de la boîte de dialogue 
I/O Setup.

Pour désigner le chemin de sortie muté lorsque les 
pistes sont mises en solo en mode AFL ou PFL :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Output pour afficher la page 
Output.

3 Sélectionnez un chemin dans le menu déroulant 
AFL/PFL Mutes (chemin de sortie).

4 Cliquez sur OK pour enregistrer vos 
modifications et fermer la boîte de dialogue 
I/O Setup.

Low Latency Monitoring
(Systèmes HD Native uniquement)

Sur les systèmes HD Native, la page Output de la 
boîte de dialogue I/O Setup permet d'activer (ou de 
désactiver) le monitoring à faible latence. Vous 
pouvez également choisir un chemin de sortie pour 
le monitoring à faible latence parmi ceux 
disponibles. Le chemin de sortie du monitoring 
à faible latence peut utiliser n'importe quelle 
largeur de canal (de mono à 7.1). Le monitoring 
à faible latence utilise par défaut les sorties 1 et 2.

Pour plus d'informations sur l'utilisation des 
modes Solo AFL ou PFL, reportez-vous à la 
section « Modes de solo » à la page 244.

L'option None a pour effet de désactiver les 
modes Solo AFL et PFL. Dans ce cas, les modes 
AFL et PFL ne peuvent pas être utilisés.

Il n'est pas nécessaire de mettre les pistes en 
solo pour régler le niveau master de chemin 
AFL/PFL. 

Pour définir le niveau du chemin AFL/PFL sur 
0 dB, maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et cliquez sur un bouton Solo.

Pour plus d'informations sur l'utilisation 
des modes Solo AFL ou PFL, reportez-vous 
à la section « Modes de solo » à la 
page 244.
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Pour configurer le monitoring à faible latence dans 
la boîte de dialogue I/O Setup :

1 Ouvrez la boîte de dialogue I/O Setup 
(Setup > I/O).

2 Cliquez sur l'onglet Output.

3 Activez l'option Low Latency Monitoring.

4 Dans le menu Low Latency Monitoring, 
sélectionnez le chemin de sortie à utiliser pour 
le monitoring à faible latence.

5 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Default Monitor Format
(Pro Tools HD uniquement)

Le menu Default Monitor Format permet de 
sélectionner le format de monitoring par défaut 
(stéréo, 5.1 ou 7.1) des nouveaux chemins de 
sortie. Ce format est également appliqué lorsque 
vous cliquez sur le bouton Default. 

Ce paramètre n'affecte ni les définitions de chemin 
existantes, ni la mesure des niveaux. Il ne fait que 
spécifier le mappage des canaux pour les nouveaux 
chemins au format 5.1. 

Le sélecteur Default Monitor Format est 
uniquement disponible sur la page Output de la 
boîte de dialogue I/O Setup.

Pour choisir un format de monitoring par défaut :

 Sélectionnez un mappage de canaux dans le 
menu Default Monitor Format. 

5.1 Path Order
(Pro Tools HD uniquement)

Le menu déroulant 5.1 Path Order permet de 
spécifier la disposition des pistes par défaut pour 
tous les nouveaux chemins créés au format 5.1. 

Le sélecteur 5.1 Path Order est disponible sur les 
pages Input, Output et Insert de la boîte de 
dialogue I/O Setup.

Pour choisir un nouvel ordre pour les chemins 5.1 
(disposition des pistes) :

1 Sélectionnez Setup > I/O. 

2 Cliquez sur l'onglet Output.

3 Utilisez le paramètre 5.1 Default Path Order pour 
sélectionner la disposition de pistes souhaitée 
(C|24/Film, SMPTE/ITU, DTS/ProControl 
Monitoring ou D-Command/D-Control). 

Embed Eleven Settings From
(Systèmes avec Eleven Rack uniquement)

Lorsqu'une interface Eleven Rack est connectée 
à votre système Pro Tools, vous pouvez intégrer les 
paramètres du rig Eleven Rack actuel dans les clips 
audio pendant leur enregistrement, afin que vous 
puissiez les rappeler ultérieurement. Ceci peut 
également s'avérer utile pour les collaborations ou 
les transferts de sessions ou clips sur un système 
différent à l'aide d'Eleven Rack, car vos paramètres 
accompagnent alors les fichiers.

Le sélecteur Embed Eleven Setting From détermine 
l'entrée audio utilisée pour router l'audio provenant 
d'Eleven Rack via une interface audio séparée. 

Le sélecteur Embed Eleven Setting From est 
disponible sur la page Input de la boîte de dialogue 
I/O Setup.

Pour plus d'informations sur le mixage 
multicanal, reportez-vous au Chapitre 47, 
« Configuration de Pro Tools pour le surround ».
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Pour intégrer des paramètres de rig dans les 
données audio enregistrées :

1 Sélectionnez Setup > I/O Setup.

2 Cliquez sur l'onglet Input. 

3 Définissez le menu Embed Setting From sur 
l'entrée à utiliser pour l'enregistrement, Eleven 
Rig L/R par exemple.

4 Créez une piste audio et définissez son entrée sur 
l'entrée correspondante de votre interface audio.

5 Activez la piste pour l'enregistrement.

6 Enregistrez votre partie.

7 Les paramètres du rig actuellement chargé sont 
intégrés dans chaque clip audio enregistré 
à partir de l'entrée sélectionnée dans le menu 
Embed Setting From. 

Les clips audio avec données de rig intégrées sont 
identifiés par un petit logo Eleven Rack dans la 
fenêtre Edit et la liste des clips de Pro Tools.

Sessions Overwrite Current 
I/O Setup When Opened
Cette option détermine si les paramètres d'E/S des 
pages Input, Output et Insert actuellement 
configurés pour votre système doivent être 
remplacés par les paramètres d'E/S stockés avec 
les sessions lors de leur ouverture. 

 Lorsque l'option Sessions Overwrite Current 

I/O Setup When Opened est désactivée, Pro Tools 
rappelle ces paramètres à partir du système. 
Choisissez cette solution lorsque vous échangez 
des sessions entre différents systèmes utilisant 
Pro Tools version 8.1 ou supérieure (reportez-vous 
à la section « Échange de session » à la page 103).

 Lorsque l'option Sessions Overwrite Current 

I/O Setup When Opened est activée (par défaut), 
Pro Tools rappelle ces paramètres à partir de la 
session et non du système. Choisissez cette 
solution lorsque vous échangez des sessions avec 
des systèmes utilisant des versions de Pro Tools 
8.0.x et inférieures (reportez-vous à la section 
« Échange de session » à la page 103). 

Personnalisation des 
paramètres d'E/S
La section suivante indique comment 
personnaliser vos paramètres d'E/S en fonction de 
la configuration de votre studio. Assurez-vous que 
l'option Sessions Overwrite Current I/O Setup 

When Opened n'est pas activée pour conserver vos 
paramètres personnalisés intacts lors de l'ouverture 
de sessions.

La méthode est la même lorsqu'Eleven Rack est 
utilisé en tant qu'insert d'un système Pro Tools.

Activez l'option Sessions Overwrite Current 
I/O Setup When Opened pour reproduire le 
comportement des anciennes versions de 
Pro Tools (inférieures à 8.1). Cette option est 
activée par défaut.

L'activation ou la désactivation de cette 
option dans l'une des pages de la boîte de 
dialogue I/O Setup est répercutée sur toutes 
les autres pages.

Si vous utilisez une interface HD OMNI, 
configurez tout d'abord la page Monitor de la 
boîte de dialogue Hardware Setup avant de 
configurer les paramètres d'E/S. Pour plus 
d'informations, reportez-vous au Guide 
HD OMNI.
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Pour personnaliser des paramètres d'E/S :

1 Ouvrez la boîte de dialogue I/O Setup (Setup > 

I/O).

2 Importez des paramètres d'E/S à partir d'un 
fichier de paramètres d'E/S (.pio) existant 
(reportez-vous à la section « Importation de 
paramètres d'E/S » à la page 101).

3 Sur les systèmes Avid HDX et HD Native, 
double-cliquez sur l'étiquette située au-dessus 
d'une interface et saisissez un nom.

4 Cliquez sur l'onglet Input et effectuez les 
opérations suivantes :

• Créez des chemins et sous-chemins d'entrée de 
largeur appropriée et des assignations d'entrées 
physiques correspondant à la configuration de 
votre studio (reportez-vous à la section 
« Routing des chemins de signaux des sorties 
audio » à la page 86).

• Renommez les chemins et sous-chemins 
d'entrée en fonction de la configuration de votre 
studio.

5 Cliquez sur l'onglet Output et effectuez les 
opérations suivantes :

• Créez des chemins de sortie de largeur 
appropriée et des assignations de sorties 
physiques correspondant à la configuration de 
votre studio.

• Renommez les chemins de sortie en fonction de 
la configuration de votre studio. 

6 Si vous prévoyez d'utiliser des inserts matériels, 
cliquez sur l'onglet Insert et effectuez les 
opérations suivantes :

• Créez des chemins d'insert de largeur appropriée 
et des assignations d'entrées et de sorties 
physiques correspondant à la configuration de 
votre studio. 

• Nommez les chemins d'insert pour les faire 
correspondre à la configuration de votre studio. 
Utilisez la terminologie standard dans la mesure 
du possible, par exemple Compresseur, Reverb, 
EQ, etc.

• Cliquez sur l'onglet H/W Insert Delay et saisissez 
les valeurs de délai des inserts appropriées (en 
millisecondes) pour chaque paire d'entrée/sortie 
utilisée. Pour plus d'informations, reportez-vous 
à la section « Page H/W Insert Delay 
(Compensation) » à la page 75. 

7 Si vous utilisez un ou plusieurs périphériques 
PRE, cliquez sur l'onglet Mic Preamps et 
configurez-les en conséquence (reportez-vous 
au Guide PRE).

8 Cliquez sur l'onglet Bus.

9 Créez des chemins et sous-chemins de bus de 
mixage interne. Assurez-vous que les bus de 
sortie soient mappés sur les chemins de sortie 
appropriés (reportez-vous à la section « Bus de 
sortie » à la page 96).

10 Assurez-vous que l'option Sessions Overwrite 

Current I/O Setup When Opened est désactivée, 
sur toutes les pages de la boîte de dialogue 
I/O Setup. Vos paramètres d'E/S personnalisés 
resteront ainsi intacts lors de l'ouverture de 
sessions créées sur un autre système.

Vous pouvez ainsi préparer une session pour 
l'utiliser sur un système différent. Tous les 
chemins assignés à du matériel absent sur le 
système actuel apparaîtront comme inactifs.

Avec les systèmes utilisant du matériel Avid 
HDX ou HD Native, la boîte de dialogue 
I/O Setup base les noms par défaut des 
chemins d'entrée et de sortie sur le nom choisi 
pour l'interface.

Les bus de sortie sont automatiquement créés 
et mappés sur les sorties lorsque de nouveaux 
chemins de sortie sont créés.
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11 Exportez vos paramètres d'E/S pour créer une 
copie de sauvegarde de vos paramètres actuels 
(reportez-vous à la section « Exportation de 
paramètres d'E/S » à la page 102).

12 Cliquez sur OK. Vous ne devriez plus avoir à 
ouvrir la boîte de dialogue I/O Setup, sauf pour 
ajouter ou supprimer du matériel, ou pour ouvrir 
une session créée sur un système différent 
(reportez-vous à la section « Échange de 
session » à la page 103).

Configuration matérielle 
dans I/O Setup
(Systèmes Avid HDX et HD Native uniquement)

Sur les systèmes Avid HDX et HD Native, vous 
pouvez choisir les ports physiques de votre 
interface audio routés vers les canaux d'entrée et de 
sortie disponibles dans I/O Setup. Toutes les 
modifications appliquées ici sont également 
répercutées dans la boîte de dialogue Hardware 
Setup, et vice versa (reportez-vous à la section 
« Configuration des paramètres matériels de 
Pro Tools » à la page 58).

Pour configurer le routing des E/S dans I/O Setup :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Input ou Output pour 
afficher le type de chemin correspondant. 

3 Cliquez sur le sélecteur d'entrée ou de sortie de 
la première paire de canaux de l'interface, sous 
l'icône de la première interface audio.

4 Dans le menu, sélectionnez une paire de ports 
physiques (telle que Analog 1-2), pour la router 
vers une paire de canaux de Pro Tools (telle que 
A 1-2) dans la colonne Path Name située 
à gauche.

5 Répétez les étapes précédentes pour les paires 
de canaux suivantes.

6 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

L'interface HD MADI et les systèmes 
Pro Tools tels qu'une Mbox Pro et une 003 
sont câblés en dur et ne peuvent pas être 
modifiés. Pour le matériel tiers et intégré, 
cliquez sur le bouton Launch Setup App dans 
la boîte de dialogue Hardware Setup pour 
afficher les options de configuration 
disponibles.

Menu du sélecteur de canaux d'E/S

Le chemin Monitor d'une HD OMNI est 
fixe et ne peut pas être modifié dans la 
boîte de dialogue I/O Setup. Le chemin 
Monitor d'une HD OMNI peut être 
configuré dans la page Monitor de la 
boîte de dialogue Hardware Setup.
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Routing d'une paire de sorties 
de Pro Tools vers plusieurs 
destinations
Les paires de canaux de Pro Tools peuvent être 
routées vers plusieurs sorties d'une interface audio 
via la boîte de dialogue I/O Setup. Par exemple, 
si vous assignez les deux sorties d'interface 
Analog 1-2 et Analog 3-4 à la paire de sorties de 
Pro Tools 1-2, un signal envoyé sur les sorties de 
Pro Tools 1-2 sera routé simultanément vers les 
deux paires de sorties de l'interface audio.

Vous pouvez de cette manière envoyer le même 
signal (tel qu'une paire stéréo, un mix de stems ou 
un mixage multicanal) vers plusieurs destinations 
(telles que divers périphériques de mastering).

Le nombre de sorties disponibles sur votre système 
définit le nombre de choix possible.

Les paires de sorties de Pro Tools peuvent 
également être routées vers plusieurs sorties d'une 
interface audio via la boîte de dialogue Hardware 
Setup.

Pour router une paire de canaux de sortie de 
Pro Tools vers plusieurs ports de sortie d'une 
interface audio :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Output. 

3 Cliquez sur le sélecteur de sortie d'une paire de 
canaux de l'interface, juste en dessous de l'icône 
de l'interface audio. 

4 Dans le menu, sélectionnez une paire de ports 
physiques (telle que Analog 1-2), pour la router 
vers la paire de canaux de Pro Tools 
correspondante (telle que A 1-2) dans la 
colonne Path Name située à gauche.

5 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le même 
sélecteur de sortie, puis sélectionnez une autre 
paire de sorties dans le même menu.

Le nom de la sortie est alors précédé d'un signe 
plus (+) pour signaler que plusieurs ports de sortie 
sont sélectionnés. Dans le menu, chaque paire de 
ports physiques assignée à cette paire de sorties de 
Pro Tools est indiquée par une coche.

6 Répétez les étapes précédentes pour 
sélectionner des destinations de sortie 
supplémentaires. 

7 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Les assignations de chemins de sortie peuvent 
se chevaucher dans certains cas. Pour plus 
d'informations, reportez-vous à la section 
« Chemins valides et conditions » à la 
page 95.
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Routing des chemins de signaux des entrées audio
L'exemple suivant présente un chemin de signal à partir de l'entrée analogique physique d'une interface 
audio HD OMNI, transitant ensuite via le chemin d'entrée audio de Pro Tools pour atteindre enfin l'entrée 
d'une piste audio du mixeur de Pro Tools :

(1) Entrée physique : pour les interfaces Avid HD 
telles qu'une HD OMNI, les entrées physiques 
disponibles pour Pro Tools sont définies sur la 
page Main de la boîte de dialogue Hardware Setup 
(cette sélection est répercutée sur la page Input de 
la boîte de dialogue I/O Setup). 

Chemin de signal d'entrée depuis une HD OMNI jusqu'au mixeur de Pro Tools, suivant le mappage défini dans 
I/O Setup

3

2

1

Pour les systèmes Pro Tools tels qu'une 
Mbox Pro ou une 003, les entrées physiques 
sont fixes. Pour le matériel tiers et intégré, 
cliquez sur le bouton Launch Setup App de la 
boîte de dialogue Hardware Setup pour afficher 
les options de configuration disponibles.
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(2) Chemin d'entrée : les chemins et sous-chemins 
d'entrée principaux sont routés (patchés) vers les 
entrées physiques à l'aide de la matrice de points de 
croisement de la boîte de dialogue I/O Setup. Dans 
cet exemple, l'entrée audio est routée depuis les 
entrées physiques Analog 1-2 de l'interface 
HD OMNI vers les canaux d'entrée A 1-2 de 
Pro Tools.

(3) Entrée de piste : les chemins et sous-chemins 
d'entrée sont routés vers des entrées de piste du 
mixeur de Pro Tools à l'aide des sélecteurs d'entrée 
de piste permettant de choisir le chemin (ou le 
sous-chemin). Dans cet exemple, le sous-chemin 
d'entrée A1 est routé vers l'entrée de la piste 
« Audio 1 ».

Routing des chemins de signaux des sorties audio
L'exemple suivant présente un chemin de signal à partir de la sortie d'une piste audio. Le signal est envoyé via 
un bus de sortie mappé sur un chemin de sortie routé vers une sortie physique d'une interface audio HD I/O :

Chemin de signal de sortie depuis une piste audio jusqu'à une sortie physique mappée dans la boîte de dialogue 
I/O Setup

3

4

2

1
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(1) Sortie de piste : l'audio est lu à partir du disque 
dur et routé depuis la sortie de piste vers le bus de 
sortie B 1-2.

(2) Chemin du bus de sortie : le bus de sortie est 
configuré sur la page Bus de la boîte de dialogue 
I/O Setup. Sur cette page, le bus de sortie B 1-2 est 
mappé sur la sortie B 1-2, configurée sur la page 
Output de la boîte de dialogue I/O Setup.

(3) Chemin de sortie : sur la page Output de la 
boîte de dialogue I/O Setup, la grille permet de 
router le chemin de sortie (sur lequel le bus de 
sortie est mappé) vers les sorties physiques. 

(4) Sortie physique : pour les interfaces audio 
Avid HD telles qu'une HD OMNI, les sorties 
physiques disponibles pour Pro Tools sont définies 
sur la page Main de la boîte de dialogue Hardware 
Setup (cette sélection est répercutée sur la page 
Output de la boîte de dialogue I/O Setup).

Création de nouveaux 
chemins
La boîte de dialogue I/O Setup permet de créer des 
nouveaux chemins en choisissant leurs noms, 
formats et assignations d'E/S physiques. Les noms 
de chemin personnalisés apparaissent dans les 
sélecteurs d'entrée, de sortie, d'insert et de bus des 
pistes d'une session.

Pour créer un chemin :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Input, Output, Insert ou Bus 
pour afficher le type de chemin correspondant.

3 Cliquez sur New Path. 

4 Dans la boîte de dialogue New Path, spécifiez le 
nombre de chemins que vous souhaitez créer, 
la largeur de canal pour chacun d'entre eux et le 
nom de chaque chemin.

5 Effectuez l'une des opérations suivantes :

• Pour ajouter d'autres chemins, cliquez sur le 
bouton d'ajout de ligne.

• Pour supprimer un chemin, cliquez sur le bouton 
de suppression de ligne.

Pour les systèmes Pro Tools tels qu'une 
Mbox Pro ou une 003, les sorties physiques 
sont fixes. Pour le matériel tiers et intégré, 
cliquez sur le bouton Launch Setup App de la 
boîte de dialogue Hardware Setup pour 
afficher les options de configuration 
disponibles.

Boîte de dialogue New Paths

Vous pouvez ajouter un nouveau chemin en 
appuyant sur Ctrl+N (Windows) ou 
Commande+N (Mac), ou sur Ctrl+Plus (+) 
(Windows) ou Commande+Plus (+) (Mac) 
sur le pavé numérique. 



Guide de référence Pro Tools88

6 Activez (ou désactivez) les options Add 

Default Channel Assignments et Auto-Create 

Sub-paths de la boîte de dialogue New Paths.

7 Cliquez sur Create.

8 Assignez le chemin à une interface audio 
spécifique (pages Input, Output et Insert 
uniquement) dans la colonne de la grille. 
Reportez-vous à la section « Assignation de 
chemins à des E/S matérielles » à la page 94.

9 Configurez tous les types de chemins (d'entrée, 
de sortie, d'insert ou de bus) en répétant les 
étapes précédentes.

10 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup. Si certains chemins portent le même 
nom, vous serez invité à les modifier avant la 
fermeture de la boîte de dialogue I/O Setup. Pour 
plus d'informations, reportez-vous à la section 
« Chemins valides et conditions » à la page 95.

Boîte de dialogue New Paths
La boîte de dialogue New Paths permet de créer 
des nouveaux chemins sur les pages Input, Output, 
Bus et Insert de la boîte de dialogue I/O Setup.

Paramètres des lignes de nouveaux 
chemins

Nombre de nouveaux chemins : saisissez le 
nombre de nouveaux chemins que vous souhaitez 
créer (ou un certain type, comme Bus).

Format du chemin : sélectionnez la largeur de 
canal à l'aide du sélecteur de format de chemin.

Nom du chemin : saisissez le nom du chemin. 
Si vous créez plusieurs chemins, le numéro de 
chaque nouveau chemin créé sera ajouté au nom du 
chemin (par exemple, Bus 1, Bus 2, Bus 3, etc.).

Ajouter/supprimer des lignes : cliquez sur le 
bouton + pour ajouter des lignes de création de 
chemin, ou - pour en supprimer.

Icône de déplacement de ligne : cliquez sur une 
icône de déplacement de ligne et faites-la glisser vers 
le haut ou le bas pour modifier l'ordre des chemins.

Pour supprimer le dernier chemin de la boîte 
de dialogue New Paths, appuyez sur 
Ctrl+Moins (-) (Windows) ou 
Commande+Moins (-) (Mac).

Lorsque vous créez un nouveau chemin de 
sortie, un bus de sortie est automatiquement 
créé sur la page Bus de la boîte de 
dialogue I/O Setup et mappé sur ce chemin. 
Reportez-vous à la section « Bus de sortie » 
à la page 96.

Les chemins et le mixage multicanal sont 
traités dans le Chapitre 47, « Configuration 
de Pro Tools pour le surround ».

Boîte de dialogue New Paths

Icône de déplacement de ligne dans la boîte de 
dialogue New Paths

Nombre de nouveaux chemins

Format du chemin Nom du chemin

Ajouter/supprimer une ligne
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Option Add Default Channel 
Assignments
Activez l'option Add Default Channel Assignments 
si vous souhaitez que Pro Tools assigne 
automatiquement les chemins d'entrée, de sortie et 
d'insert aux entrées et sorties physiques de la grille 
(à partir du premier canal disponible jusqu'au 
nombre maximal de canaux disponibles). Si le 
nombre de nouveaux chemins d'une certaine 
largeur excède le nombre de canaux disponibles, 
Pro Tools poursuit l'assignation en recommençant 
au canal 1. 

Option Auto-Create Sub-Paths
Pour les chemins d'entrée, de sortie et d'insert, 
activez l'option Auto Create Sub-Paths si vous 
souhaitez que Pro Tools crée automatiquement 
l'ensemble de sous-chemins par défaut du format 
de chemin (la largeur de canal), comme suit :

Sous-chemins par défaut

Chemin 
principal

Sous-
chemins

Nom du sous-
chemin

Mono n/d n/d

Stéréo 2 mono <nom de chemin 
principal> suivi par 
la désignation de 
canal .L et .R

LCR 1 stéréo (LR), 
3 mono (un 
pour chaque 
canal)

Stéréo : <nom de 
chemin 
principal>.LR
Mono : <nom de 
chemin 
principal>.L, .C, .R

LCRS 1 stéréo (LR), 
4 mono (un 
pour chaque 
canal)

Stéréo : <nom de 
chemin 
principal>.LR
Mono : <nom de 
chemin principal>
.L, .C, .R, .S

Quad 1 stéréo (LR), 
4 mono (un 
pour chaque 
canal)

Stéréo : <nom de 
chemin 
principal>.LR
Mono : <nom de 
chemin principal>
.L, .R, .Ls, .Rs

5.0, 6.0, 
7.0

1 stéréo (LR), 
5 à 7 mono 
(un pour 
chaque canal)

Stéréo : <nom de 
chemin 
principal>.LR
Mono : <nom de 
chemin 
principal>.L, .C, .R, 
.Ls, .Rs, etc.

5.1, 6.1, 
7.1

1 stéréo (LR), 
6 à 8 mono 
(un pour 
chaque canal)

Stéréo : <nom de 
chemin 
principal>.LR
Mono : <nom de 
chemin 
principal>.L, .C, .R, 
.Ls, .Rs, etc. et LFE

Sous-chemins par défaut

Chemin 
principal

Sous-
chemins

Nom du sous-
chemin
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Création de sous-chemins
Vous pouvez créer des sous-chemins pour les 
chemins principaux sur les pages Input, Bus et 
Insert de la boîte de dialogue I/O Setup.

Pour créer un sous-chemin :

1 Sélectionnez la page de la boîte de dialogue 
I/O Setup sur laquelle vous souhaitez créer des 
sous-chemins (comme la page Input).

2 Sélectionnez le chemin principal pour lequel 
vous souhaitez créer des sous-chemins.

3 Cliquez sur New Sub-Path.

4 Nommez le nouveau sous-chemin.

5 Sélectionnez le format du nouveau sous-chemin 
(tel que Mono).

6 Cliquez dans la grille pour assigner les canaux 
du nouveau sous-chemin aux canaux 
disponibles du chemin principal.

Modification des chemins
Vous pouvez modifier ou personnaliser les 
définitions des chemins de signaux dans la boîte de 
dialogue I/O Setup. 

Les chemins peuvent être :

• réinitialisés sur la configuration par défaut ;

• renommés, pour faciliter leur identification 
après changement ou attribution d'un nouveau 
nom à des interfaces audio ;

• sélectionnés et réorganisés afin de modifier leur 
ordre d'affichage dans les sélecteurs de piste ;

• sélectionnés et supprimés ;

• remappés, en fonction de sources ou 
destinations différentes ;

• désactivés (ou réactivés) pour gérer des 
ressources d'E/S insuffisantes ou inutiles.

De plus, vous pouvez importer et exporter les 
configurations d’E/S en tant que fichier de 
paramètres d’E/S et définir des paramètres de 
chemin par défaut. Reportez-vous à la section 
« Fichiers de paramètres d'E/S » à la page 101.

Le tableau suivant répertorie les attributs 
disponibles pour chaque type de chemin :

Les interfaces peuvent également être renommées.

Vous ne pouvez pas créer de sous-chemins 
pour les sorties sur la page Output de la 
boîte de dialogue I/O Setup. Vous pouvez 
toutefois créer des chemins de sortie qui se 
chevauchent. 

Options modifiables par type de chemin

Type de 
chemin

Options (attributs)

Entrée Noms, formats et canal source 
(entrée physique)

Sortie Noms, formats et canal de 
destination (sortie physique)

Insert Noms, formats et destination 
(entrées et sorties physiques)

Bus Noms, formats et mappage de 
sortie
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Restauration des chemins et 
noms de chemin par défaut
Vous pouvez rétablir les chemins par défaut de la 
boîte de dialogue I/O Setup à tout moment. 
Le rétablissement de leur état par défaut peut être 
utile, par exemple, si vous remplacez une interface 
audio ou en ajoutez une nouvelle à votre système. 

Pour restaurer les chemins et noms de chemin par 
défaut :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Input, Output, Insert ou Bus 
pour afficher le type de chemin correspondant.

3 Cliquez sur Default. Pro Tools effectue l'action 
suivante :

• si une session est ouverte, tous les chemins non 
utilisés sont supprimés ;

• de nouveaux chemins par défaut sont créés 
jusqu'à la limite des E/S physiques et ressources 
disponibles de votre système ; 

• les noms de chemin par défaut sont rétablis 
(reportez-vous à la section « Noms de chemin 
par défaut » à la page 92). Ces noms de chemin 
par défaut s'affichent dans les sélecteurs de 
chemin d'entrée et de sortie des pistes.

4 Cliquez sur OK pour enregistrer les modifications 
et fermer la boîte de dialogue I/O Setup.

Attribution de nouveaux noms 
aux chemins
Les noms des chemins peuvent être personnalisés 
dans la boîte de dialogue I/O.

Pour renommer un chemin dans la boîte de 
dialogue I/O Setup :

1 Double-cliquez sur le nom du chemin.

2 Saisissez un nouveau nom de chemin.

3 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Attribution de nouveaux noms 
aux interfaces 

Les interfaces audio peuvent être renommées dans 
la boîte de dialogue I/O Setup. Lorsque vous 
renommez des interfaces Avid HD, les noms de 
chemin par défaut sont basés sur le nom 
personnalisé attribué à l'interface.

Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et cliquez sur le 
bouton Default pour rétablir les paramètres 
par défaut de toutes les pages de la boîte de 
dialogue I/O Setup.

Chemins de sorties stéréo par défaut

Vous pouvez également renommer les chemins 
d'E/S directement dans la fenêtre Edit ou Mix. 
Pour cela, effectuez un clic droit sur un 
sélecteur d'entrée ou de sortie, puis 
sélectionnez la commande Rename.

Nouveau sous-chemin d'entrée mono du chemin 
principal A 1-2
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Pour renommer une interface audio dans la boîte 
de dialogue I/O Setup :

1 Double-cliquez sur l'étiquette située au-dessus 
du nom d'une interface.

2 Saisissez le nouveau nom de l'interface.

3 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Noms de chemin par défaut

Les noms par défaut des chemins d'entrée, de sortie 
et d'insert sont basés sur le matériel dont vous 
utilisez les E/S physiques. 

Pour les systèmes Avid HDX et HD Native, les 
noms de chemin par défaut sont basés sur les noms 
des interfaces utilisées. Si vous avez renommé 
votre interface, les noms de chemin par défaut sont 
basés sur le nom personnalisé.

Sélection de chemins
La colonne des noms de chemin de la boîte de 
dialogue I/O Setup permet de sélectionner un ou 
plusieurs chemins. Une fois sélectionnés, 
les chemins et sous-chemins peuvent être déplacés 
vers le haut ou le bas pour changer leur ordre 
d'affichage dans les sélecteurs d'entrée, de sortie, 
d'insert et de bus des pistes. Vous pouvez 
également en supprimer. Les sous-chemins suivent 
leurs chemins principaux lorsqu'ils sont déplacés 
dans la boîte de dialogue I/O Setup.

Pour sélectionner un chemin principal ou un sous-
chemin :

 Cliquez sur le nom d'un chemin.

Pour sélectionner des chemins contigus :

1 Cliquez sur le nom d'un chemin.

2 Tout en maintenant la touche Maj enfoncée, 
cliquez sur le nom d'un autre chemin.

Tous les chemins compris entre le premier nom de 
chemin sélectionné et le nom de chemin suivant 
sont également sélectionnés.

Nom d'interface

Sélection de chemins dans I/O Setup
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Pour sélectionner ou désélectionner des chemins 
non contigus, procédez comme suit :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez sur des noms de 
chemin qui ne sont pas en surbrillance pour les 
sélectionner.

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur des 
noms de chemin qui sont en surbrillance pour 
les désélectionner.

Pour sélectionner tous les chemins et sous-
chemins :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur un nom de 
chemin qui n'est pas en surbrillance.

Pour désélectionner tous les chemins et sous-
chemins :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un nom de 
chemin qui est en surbrillance.

Réorganisation des chemins
Une fois sélectionnés, les chemins et sous-chemins 
peuvent être déplacés vers le haut ou le bas dans la 
colonne de nom de chemin pour modifier leur 
ordre d'affichage dans les sélecteurs d'entrée, 
de sortie, d'insert et de bus des pistes.

Pour modifier l'ordre des chemins dans la boîte de 
dialogue I/O Setup et les sélecteurs de piste :

1 Faites glisser un ou plusieurs noms de chemin 
vers le haut ou le bas.

2 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Suppression de chemins
Les définitions de chemins inutiles ou mal 
configurées peuvent être supprimées de la session 
ouverte pour refléter les modifications de votre 
configuration matérielle ou nettoyer les menus des 
sélecteurs de piste. Les assignations de pistes ou de 
départs utilisant un chemin supprimé sont 
réinitialisées sur No Output (aucune sortie).

Pour supprimer un chemin principal ou un sous-
chemin :

1 Sélectionnez le chemin que vous souhaitez 
supprimer dans la boîte de dialogue I/O Setup.

2 Cliquez sur Delete Path. 

3 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Pour supprimer tous les chemins :

1 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un nom de 
chemin.

2 Cliquez sur Delete Path.

3 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Activation ou désactivation de 
chemins
Les chemins de Pro Tools peuvent être activés ou 
désactivés (non disponibles). Vous pouvez activer 
ou désactiver l'ensemble des chemins dans la boîte 
de dialogue I/O Setup. En désactivant un chemin 
de signal, vous le désactivez pour toutes les pistes 
actuellement assignées à ce chemin.
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Les chemins non disponibles sont automatiquement 
désactivés par Pro Tools. Les chemins peuvent être 
non disponibles lorsque du matériel ou d'autres 
ressources du système ne sont pas disponibles, 
par exemple lors de l'ouverture d'une session 
enregistrée sur un système différent.

Les pistes peuvent également être activées 
ou désactivées. Pour plus d’informations, 
reportez-vous à la section « Désactivation des 
entrées et sorties de pistes à partir de la fenêtre Edit 
ou Mix » à la page 238.

Pour activer ou désactiver un chemin 
globalement :

1 Sélectionnez Setup > I/O. 

2 Sélectionnez un type de chemin à l'aide des 
onglets du haut de la fenêtre. 

3 Configurez l'état du chemin, activé ou désactivé. 

Le nom du chemin désactivé sera désormais 
affiché en italique dans les sélecteurs d'E/S des 
pistes assignées sur ce chemin.

4 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup. L'état des chemins est affiché de la 
manière suivante :

En italique : indique que le chemin est désactivé.

Non italique : indique que le chemin est activé.

Assignation de chemins 
à des E/S matérielles
Les chemins sont assignés à des entrées, sorties et 
inserts spécifiques dans la grille. Les chemins 
peuvent être assignés à des E/S physiques dans la 
grille et être réassignés à tout moment.

Pour assigner des canaux :

1 Sélectionnez (ou créez) un chemin principal ou 
un sous-chemin. 

2 Sélectionnez un format de canal (tel que Stereo).

3 Dans la ligne correspondant au chemin 
sélectionné, cliquez sur la colonne de la grille 
sous l'interface audio et le canal désirés. 

Les autres canaux de ce type de chemin sont 
remplis vers la droite, le cas échéant. Par exemple, 
lorsque vous assignez un nouveau chemin stéréo et 
que vous cliquez dans la ligne du chemin sous le 
canal de sortie 1, les zones des canaux 1 et 2 se 
remplissent (gauche sur 1, droit sur 2). 

4 Cliquez sur OK pour enregistrer les modifications 
et fermer la boîte de dialogue I/O Setup.

Si certains paramètres ne sont pas valides, 
le système vous demande de les corriger avant la 
fermeture de la boîte de dialogue I/O Setup. Pour 
plus d'informations, reportez-vous à la section 
« Chemins valides et conditions » à la page 95.

Chemin activé (en haut) et désactivé (en bas)

Lorsque des chemins de sortie avec des 
largeurs de canal différentes se chevauchent, 
si le chemin le plus large est désactivé, aucun 
autre chemin de sortie superposé ne 
transmettra d'audio provenant de Pro Tools.

Assignation de canaux

Pour réassigner les canaux d'un chemin, 
reportez-vous à la section « Réassignation 
de chemins » à la page 95.
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Assignation de chemins avec le mixeur 
surround

(Pro Tools HD uniquement)

Lors de l'assignation de chemins multicanal, 
le canal gauche (L) est assigné en premier sur la 
zone de grille sélectionnée, puis les canaux 
restants remplissent immédiatement les zones de 
droite en respectant l'ordre des chemins par défaut. 

Étant donné que certains formats de mixage 
multicanal utilisent des dispositions de piste 
uniques, Pro Tools permet de définir le format par 
défaut dans la boîte de dialogue I/O Setup 
(reportez-vous à la section « Options d'I/O Setup » 
à la page 77).

Réassignation de chemins
Vous pouvez déplacer des assignations 
individuelles vers d'autres canaux pour réorganiser 
la définition du chemin (en modifiant une 
assignation multicanal sur L-R-C-LFE-Ls-Rs, 
par exemple). 

Pour réassigner les canaux d'un chemin :

 Faites glisser le canal vers un nouvel 
emplacement de la grille. Les autres assignations 
de canaux se décalent en conséquence.

Réorganisation de canaux

Le déplacement d'un signal de droite à gauche 
entraîne une réorganisation des autres signaux se 
retrouvant placés après le nouveau canal de 
destination. Le déplacement d'un signal de gauche 
à droite entraîne une réorganisation de tous les 
signaux à la suite du nouveau canal de destination 
et laisse le canal précédent vide. 

Les sous-chemins suivent les chemins 
principaux

Lorsqu'un chemin principal est réassigné, 
ses sous-chemins (le cas échéant) sont réassignés 
automatiquement pour conserver la cohérence 
des assignations. Par exemple, la réassignation 
d'un chemin stéréo vers d'autres sorties 
matérielles s'accompagne d'un déplacement 
identique de ses sous-chemins. 

Chemins valides et 
conditions
Lors de la configuration de la boîte de dialogue 
I/O Setup, un certain nombre de règles doivent être 
respectées pour définir les chemins et assigner les 
canaux. Tous les chemins doivent être valides 
avant de pouvoir appliquer la configuration définie 
dans la boîte de dialogue I/O Setup. 

Bien qu'il soit possible de définir des assignations 
non valides dans la grille des canaux, Pro Tools 
n'accepte une configuration d'E/S que si tous les 
chemins correspondent aux conditions de 
définition des chemins et d'assignation des canaux 
décrites ci-dessous :

Définitions minimales des chemins : tous les 
chemins doivent posséder un nom, un format 
spécifique et une assignation d'E/S valide. 

Chemins valides : l'assignation des canaux 
respecte certaines règles concernant le 
chevauchement des chemins. 

• Il ne peut y avoir aucun chevauchement partiel 
entre deux chemins de sortie.

Paramètre 5.1 Path Order

Le changement de format d'un chemin 
efface toutes les assignations de canaux 
actuelles. 
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• Un chemin de sortie nouvellement créé doit être 
complètement indépendant des autres 
assignations (il ne doit pas être assigné aux 
autres interfaces/canaux d'E/S disponibles) 
ou être un chemin totalement intégré 
dans un chemin plus grand (par exemple, 
un sous-chemin LCR dans un chemin 5.1).

Configuration des bus
Les bus apparaissent sur la page Bus de la boîte de 
dialogue I/O Setup. Pro Tools fournit deux types 
de bus :

• Bus de sortie

• Bus de mixage internes

Les paramètres des bus de sortie et bus de mixage 
internes sont enregistrés avec la session et rappelés 
à partir de celle-ci. Cette opération présente 
l'avantage de conserver les assignations des pistes 
et départs dans la session lorsque vous la transférez 
d'un système à un autre. Lorsque possible, 
Pro Tools peut automatiquement réassigner les bus 
de sortie de la session aux chemins de sortie du 
système sur lequel la session est ouverte.

Bus de sortie
Les bus de sortie sont mappés (routés) sur les 
chemins de sortie, suivant la configuration de la 
page Output de la boîte de dialogue I/O Setup. 
Les chemins de sortie sont ensuite assignés aux 
sorties audio physiques du système dans la grille 
I/O Setup (reportez-vous à la section « Assignation 
de chemins à des E/S matérielles » à la page 94).

Lorsque vous créez un nouveau chemin de sortie sur 
la page Output de la boîte de dialogue I/O Setup, 
un nouveau bus de sortie de la même largeur est 
automatiquement créé et mappé sur ce chemin de 
sortie. Des bus de sortie sont également créés et 
mappés suivant la configuration par défaut lors de la 
création d'une nouvelle session ou du rétablissement 
des paramètres par défaut (reportez-vous à la 
section « Restauration des chemins et noms de 
chemin par défaut » à la page 91).

Les sorties physiques des chemins de sortie sont 
configurées sur la page Outputs de la boîte de 
dialogue I/O Setup (reportez-vous à la section 
« Assignation de chemins à des E/S matérielles » 
à la page 94).

Chemin de sortie valide (complet)

Chemin de sortie non valide (partiel)

Pour plus d'informations sur l'échange de 
sessions entre systèmes et l'ouverture de 
sessions avec une version antérieure de 
Pro Tools, reportez-vous à la section 
« Échange de session » à la page 103. Les 
bus de sortie n'existent pas dans Pro Tools 
version 8.0.4 ou antérieure. 
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Bus de mixage internes 
Pro Tools fournit jusqu'à 256 bus de mixage 
internes qui permettent de router les signaux audio 
des sorties et départs de piste jusqu'aux entrées des 
autres pistes et aux entrées side-chain des plug-ins. 
Les bus de mixage internes sont couramment 
utilisés pour les départs et retours d'effets (pour 
acheminer le signal des pistes audio vers une piste 
d'entrée auxiliaire afin de le traiter avec un plug-in 
d'effets, par exemple) et l'enregistrement de bus.

Les bus de mixage internes peuvent également être 
mappés sur n'importe quelle sortie (reportez-vous à la 
section « Bus de mixage internes » à la page 97).

Création et assignation de bus 
aux sorties
Tous les bus disponibles peuvent être mappés sur 
des chemins de sortie disponibles de largeur de 
canal identique ou supérieure. Par exemple, un bus 
mono peut être mappé sur un chemin de sortie 
mono, un bus stéréo peut être mappé sur un chemin 
de sortie stéréo et un bus surround 5.1 peut être 
mappé sur un chemin de sortie surround 5.1.

Vous pouvez supprimer le mappage de bus sur des 
sorties à tout moment.

Pour créer un bus et le mapper sur un chemin 
de sortie :

1 Sur la page Bus de la boîte de dialogue 
I/O Setup, cliquez sur New Path.

2 Dans la boîte de dialogue New Paths, spécifiez 
le nombre de nouveaux chemins à créer, 
la largeur de canal de chaque chemin et le nom 
de chemin.

3 Cliquez sur Create pour créer les chemins.

4 Activez l'option Mapping To Output pour le 
chemin de sortie.

5 Sélectionnez un chemin de sortie à l'aide du 
sélecteur Mapping To Output.

Tous les signaux des pistes ou départs utilisant ce 
bus sont désormais envoyés vers les sorties 
matérielles assignées aux chemins de sortie 
correspondants.

Pour mapper tous les bus de sortie de format 
identique sur un chemin de sortie :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur n'importe quel 
sélecteur Mapping To Output, puis sélectionnez 
un chemin de sortie (mono ou stéréo).

Boîte de dialogue New Paths

Bus de sortie MAIN non mappé

Mappage du bus de sortie MAIN sur le chemin de 
sortie A 1-2
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Tous les bus de sortie mappés de même format 
(comme stéréo) sont alors assignés au même 
chemin de sortie. Par exemple, vous pouvez 
assigner tous les bus de sortie stéréo au chemin de 
sortie A 1-2.

Pour mapper tous les bus de sortie de format 
identique sur un seul chemin de sortie :

1 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et cliquez sur 
des bus de sortie contigus pour les sélectionner.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur des 
bus de sortie non contigus pour les sélectionner.

2 Maintenez les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées et cliquez sur 
le sélecteur Mapping To Output de l'un des bus 
de sortie sélectionnés, puis sélectionnez un 
chemin de sortie (mono ou stéréo). 

Seuls les bus de sortie de format identique (comme 
stéréo) sélectionnés sont alors assignés au même 
chemin de sortie. Par exemple, vous pouvez 
assigner uniquement les bus de sortie stéréo 
sélectionnés au chemin de sortie A 1-2.

Pour assigner tous les bus de format identique 
à des chemins de sortie uniques en ordre 
croissant (en cascade) :

 Maintenez les touches Ctrl+Alt (Windows) 
ou Commande+Option (Mac) enfoncées et 
cliquez sur le sélecteur Mapping to Output du 
chemin de sortie le plus haut dans la grille et 
sélectionnez le premier chemin de sortie. 

Tous les bus du même format de canal sont 
automatiquement assignés à un chemin de sortie 
unique par ordre croissant. Par exemple, pour les 
chemins de sortie stéréo, le bus de sortie A 1-2 est 
assigné au chemin de sortie A 1-2, A 3-4 à A 3-4, 
A 5-6 à A 5-6, etc.

Mappage de bus mono sur des chemins 
surround
(Pro Tools HD uniquement)

Il est possible de mapper un bus mono sur 
n'importe quel canal d'un chemin de sortie 
surround. Par exemple, vous pouvez router une 
piste de dialogues vers le canal central d'un chemin 
de sortie 5.1 (cette particularité est valable pour 
toutes les largeurs de canal de sortie, à l'exception 
des sorties stéréo et quad).

Pour mapper un bus mono sur un canal d'un 
chemin de sortie surround :

1 Sur la page Bus de la boîte de dialogue 
I/O Setup, cliquez sur New Path.

2 Dans la boîte de dialogue New Paths, 
sélectionnez une largeur de canal Mono pour le 
chemin du bus, entrez un nom pour le chemin, 
puis cliquez sur Create.

3 Activez l'option Mapping To Output pour le 
chemin de sortie.

4 Sélectionnez un chemin de sortie multicanal 
à l'aide du sélecteur Mapping To Output. 
L'indicateur de bus mono prend la valeur par 
défaut « C » (Center) et un menu déroulant est 
désormais disponible.

5 Pour assigner un autre canal, cliquez sur 
l'indicateur de bus mono et sélectionnez-le 
à partir du menu déroulant.

Sélection d'un chemin de sortie multicanal
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Pour assigner un même canal à tous les bus mono 
mappés sur un chemin de sortie multicanal :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur l'indicateur 
de bus mono, puis sélectionnez le canal à partir 
du menu déroulant. 

Pour assigner un même canal à une sélection de 
bus mono mappés sur un chemin de sortie 
multicanal :

1 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et cliquez sur 
des bus monos contigus de la colonne Name 
pour les sélectionner.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur des 
bus mono non contigus de la colonne Name pour 
les sélectionner.

2 Maintenez les touches Option+Maj (Mac) 
ou Alt+Maj (Windows) enfoncées et cliquez sur 
un indicateur de bus mono, puis sélectionnez le 
canal à partir du menu déroulant. 

Pour assigner des canaux dans un ordre croissant 
(en cascade) à tous les bus mono mappés sur un 
chemin de sortie multicanal :

 Maintenez les touches Commande+Option 
(Mac) ou Ctrl+Alt (Windows) enfoncées et 
cliquez sur l'indicateur du bus mono le plus haut 
dans la grille, puis sélectionnez le premier canal 
du menu déroulant. 

Pour assigner des canaux dans un ordre croissant 
(en cascade) à une sélection de bus mono mappés 
sur un chemin de sortie multicanal :

1 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et cliquez sur 
des bus monos contigus de la colonne Name 
pour les sélectionner.

• Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur 
des bus mono non contigus de la colonne Name 
pour les sélectionner.

2 Maintenez les touches 
Commande+Option+Maj (Mac) 
ou Ctrl+Alt+Maj (Windows) enfoncées et 
cliquez sur l'indicateur du bus mono le plus haut 
dans la grille, puis sélectionnez le premier canal 
du menu déroulant. 

Réinitialisation des bus
Vous pouvez réinitialiser le nombre de bus de 
mixage internes disponibles dans votre session 
afin qu'il corresponde aux capacités de votre 
système en rétablissant la configuration de bus par 
défaut.

Pour rétablir la configuration de bus par défaut sur 
votre système :

1 Ouvrez la boîte de dialogue I/O Setup.

2 Cliquez sur l'onglet Bus dans le coin supérieur 
gauche.

3 Dans le menu déroulant situé à droite du bouton 
Default, sélectionnez l'une des options 
suivantes :

• All Busses (Tous les bus) 

• Output Busses (Bus de sortie) 

• Internal Busses (Bus internes) 

Assignation d'un canal à un bus mono

Pro Tools crée par défaut 128 bus internes 
(sur 256 possibles). 
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4 Cliquez sur Default. 

5 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
I/O Setup.

Bus activés

La page Bus de la boîte de dialogue I/O Setup 
affiche le nombre de bus de mixage internes 
activés. Lorsque le nombre de bus activés dépasse 
le nombre de bus disponibles (256), l'affichage 
devient rouge. Supprimez ou désactivez tous les 
bus activés au-delà du nombre de bus maximum 
afin de pouvoir fermer la boîte de dialogue 
I/O Setup et enregistrer vos paramètres.

Tri des chemins de bus
La page Bus fournit des commandes permettant de 
trier les bus par nom (ordre croissant ou 
décroissant), format (ordre croissant ou 
décroissant) ou état de mappage sur les sorties 
(ordre croissant uniquement).

Pour trier des chemins de bus par nom :

1 Sur la page Bus, cliquez sur l'en-tête de la 
colonne Name. 

2 Cliquez de nouveau sur l'en-tête de la colonne 
Name pour alterner entre les ordres de tri 
croissant et décroissant.

Pour trier des chemins de bus par format :

1 Sur la page Bus, cliquez sur l'en-tête de la 
colonne Format. 

2 Cliquez de nouveau sur l'en-tête de la colonne 
Format pour alterner entre les ordres de tri 
croissant et décroissant.

Pour trier des chemins de bus selon l'état de leur 
mappage de sortie :

 Sur la page Bus, cliquez sur l'en-tête de la 
colonne Mapping To Output. 

Paramètres d’E/S d’usine
Pro Tools fournit des paramètres d'E/S d'usine 
pour les mixages stéréo et surround, 
automatiquement installés avec Pro Tools. 
Ces paramètres permettent d'utiliser un chemin et 
des sous-chemins génériques pour ces deux 
formats de mixage dans vos nouvelles sessions.

Les paramètres d'E/S d'usine sont disponibles dans 
le menu déroulant I/O Settings de la boîte de 
dialogue Quick Start ou New Session.

Paramètres Stereo Mix
Le paramètre Stereo Mix crée le nombre maximal 
de chemins stéréo, déterminé par la configuration 
d'E/S disponibles du système et la configuration 
matérielle.

La réinitialisation des bus sur la 
configuration par défaut renomme tous les 
bus en utilisant leur nom par défaut (Bus 1-2, 
Bus 3-4, etc.).

Tri des chemins de bus dans la boîte de dialogue 
I/O Setup

Cliquez pour trier par nom Cliquez pour trier par état 
de mappage de sortie

Cliquez pour trier par format
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Paramètres Surround Mix 
(Pro Tools HD uniquement)

Le paramètre Surround Mix propose d'autres 
fichiers de paramètres de sortie et de bus 
spécifiques aux formats surround. 

Fichiers de paramètres d'E/S
Les fichiers de paramètres d'E/S (fichiers .pio) 
fournissent des configurations de chemin par 
défaut pour les nouvelles sessions. Les paramètres 
d'E/S peuvent être importés et exportés sous forme 
de fichier pour être utilisés dans les sessions 
partagées entre des systèmes. Les fichiers de 
paramètres d'E/S sont également disponibles dans 
le menu déroulant I/O Settings des boîtes de 
dialogue Quick Start et New Session.

Pour que les fichiers de paramètres d'E/S soient 
disponibles dans les boîtes de dialogue Quick Start 
et New Session, vous devez les enregistrer dans 
le sous-dossier IO Settings du dossier Root 
Settings. Vous pouvez modifier l'emplacement 
du dossier Root Settings dans les préférences de 
fonctionnement (reportez-vous à la section « Section 
User Library » à la page 110).

Paramètres d'E/S dernièrement 
utilisés
Si vous effectuez des modifications dans la boîte 
de dialogue I/O Setup, ces modifications sont 
enregistrées automatiquement dans le fichier de 
paramètres Last Used du dossier IO Settings 
lorsque vous fermez la boîte de dialogue I/O Setup 
(en cliquant sur OK).

Les derniers paramètres utilisés sont disponibles 
dans le menu déroulant IO Settings de la boîte de 
dialogue Quick Start ou New Session, ou lors de 
l'importation des paramètres d'E/S dans I/O Setup.

Paramètres d’E/S personnalisés
Vous pouvez créer des fichiers de paramètres d'E/S 
personnalisés en modifiant les paramètres de la 
boîte de dialogue I/O Setup (reportez-vous à la 
section « Personnalisation des paramètres d'E/S » 
à la page 81), puis en les exportant. Vous pouvez 
ensuite rétablir ces paramètres d'E/S en les 
important dans un système.

Vous pouvez ainsi enregistrer les paramètres de 
différents projets, les importer pour modifier la 
configuration d'E/S, puis gérer les définitions de 
chemins et les paramètres de routing des signaux. 

Importation de paramètres d'E/S
Les paramètres d'E/S peuvent être importés avant 
ou après l'ouverture d'une session. Les paramètres 
d'E/S sont importés uniquement pour la page 
actuelle de la boîte de dialogue I/O Setup. 
Par exemple, si vous ouvrez la page Output et 
importez des paramètres d'E/S, seuls les 
paramètres de cette page seront importés. Vous 
éviterez ainsi d'écraser des paramètres d'E/S 
personnalisés d'autre pages.

L'utilisation d'un fichier de paramètres 
Stereo Mix équivaut à cliquer sur le 
bouton Default de chaque onglet dans la 
boîte de dialogue I/O Settings. Reportez-
vous à la section « Restauration des 
chemins et noms de chemin par défaut » à 
la page 91.

Reportez-vous au Chapitre 47, 
« Configuration de Pro Tools 
pour le surround ».
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Lorsque vous importez des paramètres d'E/S, vous 
pouvez supprimer toutes les définitions de 
chemins inutilisées avant d'importer les nouveaux 
chemins ou laisser les définitions de chemins 
inchangées et ajouter les nouveaux chemins à la 
configuration des paramètres d'E/S actuelle.

Pour importer des paramètres d'E/S :

1 Dans la boîte de dialogue I/O Setup, cliquez sur 
l'onglet de la page pour laquelle vous souhaitez 
importer des paramètres.

2 Cliquez sur Import Settings.

3 Sélectionnez un fichier de paramètres d'E/S 
dans la boîte de dialogue Import Settings et 
cliquez sur Import.

4 Une boîte de dialogue s'affiche pour vous 
demander si vous souhaitez ou non supprimer 
les chemins existants. Effectuez l'une des 
opérations suivantes :

• Cliquez sur Yes pour supprimer les chemins 
inutilisés et ajouter les chemins importés à la 
configuration d'E/S actuelle.

• Cliquez sur No pour ajouter les chemins 
importés à la configuration d'E/S actuelle. 

Si des chemins se chevauchent suite 
à l'importation, les nouveaux chemins apparaissent 
alors désactivés dans la boîte de dialogue 
I/O Setup. Reportez-vous à la section « Activation 
ou désactivation de chemins » à la page 93.

Après avoir importé les paramètres d'E/S, vous 
pouvez réassigner les définitions de routing des 
chemins dans la boîte de dialogue I/O Setup 
en les remappant, renommant ou supprimant. 
Reportez-vous à la section « Chemins de signaux 
de Pro Tools » à la page 70.

Exportation de paramètres d'E/S
Lorsque vous exportez des paramètres d'E/S, 
toutes les pages de la boîte de dialogue I/O Setup 
sont exportées.

Pour exporter et enregistrer les paramètres d'E/S 
sous forme de fichier personnalisé :

1 Configurez les paramètres de la boîte de 
dialogue I/O Setup.

2 Cliquez sur Export Settings. 

3 Attribuez un nom au fichier de paramètres, puis 
enregistrez-le. L'extension .pio du fichier 
permet de l'identifier comme un fichier de 
paramètres d'E/S.

Vous pouvez également importer les 
chemins d'E/S, les noms de chemin et 
d'autres données de session à partir d'une 
session différente en utilisant la commande 
Import Session Data (File > Import > 
Session Data). Pour plus d’informations, 
reportez-vous à la section « Importation de 
données de session » à la page 352.

Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et cliquez sur le 
bouton Import Settings pour importer les 
paramètres sur toutes les pages de la boîte de 
dialogue I/O Setup.

Pour démarrer des sessions avec une boîte de 
dialogue I/O Setup vierge, vous pouvez créer 
et exporter un fichier de paramètres d'E/S 
dans lequel toutes les définitions ont été 
supprimées. 
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Échange de session
Lorsque vous échangez une session entre des 
systèmes Pro Tools, il peut être nécessaire de 
reconfigurer ses paramètres d'E/S. Cela dépend 
de l'ID du système, des noms des chemins, de leur 
format et des versions de Pro Tools de chacun des 
systèmes sur lesquels la session est transférée.

Noms de chemin et remappage 
automatique des bus de sortie
Un ID système est créé et enregistré dans une 
session pour chacun des ordinateurs sur lesquels 
vous l'ouvrez (en utilisant leur adresse MAC). 
Lorsque Pro Tools trouve un ID système 
correspondant lors de l'ouverture d'une session, 
les chemins de sortie sont rétablis et aucune 
reconfiguration n'est nécessaire.

Lorsqu'une session Pro Tools est ouverte pour la 
première fois sur un système, Pro Tools tente de 
remapper automatiquement les bus de sortie.

Si Pro Tools ne trouve pas d'ID système 
correspondant, il tente de remapper les bus de sortie 
en fonction des critères suivants (dans cet ordre) :

Nom et format des chemins : les noms de chemin 
et leur format doivent être identiques.

Format des chemins uniquement : lorsque 
Pro Tools ne trouve pas de noms de chemin 
correspondants, il remappe les chemins sur des 
chemins existants de format (largeur de canal) 
identique.

Les chemins de bus de sortie qui ne peuvent pas 
être remappés automatiquement sont ouverts en 
tant que chemins désactivés. Vous devez remapper 
manuellement ces chemins sur un chemin de sortie 
activé.

Versions de Pro Tools et 
échange de session
Lorsque vous échangez une session entre des 
systèmes avec différentes versions du logiciel 
Pro Tools (par exemple, votre système 
Pro Tools 11.0 et le système Pro Tools 7.x d'un 
collègue), vous pouvez utiliser les options 
suivantes pour conserver les chemins et le routing 
des signaux.

Pro Tools versions 8.1 et supérieures

Lorsque vous échangez des sessions entre des 
systèmes utilisant Pro Tools version 8.1 ou 
supérieure, il est généralement recommandé de 
désactiver l'option Sessions Overwrite Current I/O 

Setup When Opened. Les paramètres d'E/S du 
système sont ainsi conservés lors de l'ouverture 
d'une session provenant d'un autre système 
(reportez-vous à la section « Sessions Overwrite 
Current I/O Setup When Opened » à la page 81).

Pro Tools versions 8.0.x et inférieures

Lorsque vous échangez des sessions avec des 
systèmes utilisant des versions antérieures de 
Pro Tools, il est généralement recommandé 
d'activer l'option Sessions Overwrite Current 

I/O Setup When Opened (reportez-vous à la 
section « Sessions Overwrite Current I/O Setup 
When Opened » à la page 81). Dans ce cas, 
les paramètres personnalisés enregistrés avec la 
session qui ne correspondent pas à votre système 
doivent être reconfigurés manuellement dans la 
boîte de dialogue I/O Setup pour correspondre à la 
configuration de votre studio.

Si vous avez créé une sauvegarde de vos 
paramètres d'E/S, vous pouvez importer des 
paramètres après l'ouverture de la session 
(reportez-vous à la section « Importation de 
paramètres d'E/S » à la page 101).
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Ouverture de sessions antérieures dans 
Pro Tools versions 8.1 et supérieures

Lorsque vous ouvrez des sessions créées dans 
Pro Tools version 8.0.x ou antérieure dans 
Pro Tools version 8.1 ou supérieure, les chemins 
de sortie de la session antérieure sont recréés sous 
forme de bus de sortie. Si l'option Sessions 

Overwrite Current I/O Setup When Opened est 
activée, les bus de sortie sont mappés sur les 
chemins de sortie de la session.

Ordre des chemins et chemins de sortie se 
chevauchant

Lorsque vous échangez des sessions entre des 
systèmes Pro Tools version 8.1 ou supérieure et 
Pro Tools version 8.0.x ou antérieure, les chemins 
et sous-chemins de sortie sont modifiés de la 
manière suivante, selon l'ordre dans lequel ils 
apparaissent sur les onglets de la boîte de dialogue 
I/O Setup.

 Lorsqu'une session créée dans Pro Tools 
version 8.1 ou supérieure contient des chemins 
se chevauchant, avec un chemin plus large créé au-
dessus de chemins plus petits dans I/O Setup, 
ces chemins plus petits sont convertis en sous-
chemins du chemin le plus large lors de l'ouverture de 
la session dans Pro Tools version 8.0.x ou antérieure.

 Lorsqu'une session créée dans Pro Tools 
version 8.1 ou supérieure contient des chemins se 
chevauchant avec un chemin plus petit 
apparaissant au-dessus d'un chemin plus large dans 
la boîte de dialogue I/O Setup, ce chemin plus 
grand est désactivé lors de l'ouverture de la session 
dans Pro Tools version 8.0.x ou antérieure.

Show Last Saved Setup et Show 
Current Setup
Lorsqu'une session ouverte contient des 
définitions de chemins correspondant à des 
interfaces d'E/S non disponibles, la boîte de 
dialogue I/O Setup affiche ces chemins en italique. 

Le bouton Show Last Saved Setup permet 
d'afficher les interfaces audio utilisées dans la 
session d'origine. Cet affichage temporaire permet 
de consulter la dernière configuration d'E/S 
enregistrée comme référence afin de configurer les 
paramètres d'E/S de votre système. 

Lorsqu'une session a été ouverte en conservant des 
E/S non disponibles, vous pouvez réassigner les 
pistes à des chemins d'E/S disponibles. 

Si la configuration matérielle est 
différente, vous devrez reconfigurer 
manuellement les assignations de sortie 
dans la grille de la page Output de la boîte 
de dialogue I/O Setup. Reportez-vous à la 
section « Assignation de chemins à des E/S 
matérielles » à la page 94.
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Chapitre 8 : Préférences

Les paramètres des préférences de Pro Tools 
déterminent la façon dont vous pouvez utiliser les 
fonctionnalités de Pro Tools. La boîte de dialogue 
Preferences contient plusieurs pages d'onglets 
permettant de spécifier vos paramètres préférés.

Pour modifier les préférences de Pro Tools :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet de la page contenant les 
préférences à modifier. 

3 Modifiez les préférences.

4 Cliquez sur OK pour enregistrer les modifications 
et fermer la boîte de dialogue Preferences.

Préférences d'affichage

Section Basics
Track Position Numbers Stay with Hidden 
Tracks : lorsque cette option est activée, les pistes 
masquées conservent leur numéro. Dans le cas 
inverse, des numéros sont assignés uniquement 
aux pistes affichées. Les pistes affichées sont alors 
numérotées de façon séquentielle et les pistes 
masquées ne sont pas numérotées.

Options d'affichage des info-bulles

Function : les info-bulles sont configurées pour 
n'afficher que la fonction de base de l'élément.

Details : les info-bulles sont configurées pour 
afficher l'intégralité d'un nom ou élément abrégé 
(le nom d'une piste, par exemple). La vue Details 
permet également d'afficher la valeur masquée ou 
abrégée des paramètres, ainsi que les assignations 
d'entrées et de sorties. 

Edit Window Default Length

Cette préférence définit la durée par défaut 
couverte par la fenêtre Edit, en heures, minutes, 
secondes et images. (Pro Tools HD uniquement). 
Elle est notamment utile si vous souhaitez créer 
une session d'une durée spécifique ou conserver de 
l'espace pour étendre la zone de travail de la 
fenêtre Edit dans votre session. La durée maximale 
est de 24 heures. Pour une meilleure sensibilité de 
la barre de défilement, définissez une durée 
légèrement supérieure (d'une minute ou plus) 
à la durée totale de la session ou du morceau.
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Options Organize Plug-In Menus By

Ces options permettent de choisir la manière dont 
sont classés les menus de plug-ins dans les 
sélecteurs d'insert ou de plug-in.

Flat List : permet de présenter les plug-ins dans 
une liste simple triée par ordre alphabétique.

Category : affiche les plug-ins par catégorie de 
traitement (par exemple, EQ, Dynamics, Delay), 
chaque plug-in étant répertorié dans les sous-menus 
de catégorie. Les plug-ins qui ne correspondent pas 
à une catégorie standard (par exemple, Signal 
Generator) ou les plug-ins tiers dont la catégorie n'a 
pas été spécifiée par leurs développeurs figurent 
dans la catégorie Other. Certains plug-ins peuvent 
figurer dans plusieurs catégories. 

Manufacturer : les plug-ins sont classés par 
fabricant (tel que Bomb Factory, Focusrite ou 
TL Labs), chaque plug-in étant répertorié dans les 
sous-menus des fabricants. Les plug-ins 
n'appartenant à aucun fabricant en particulier 
s'affichent dans le dossier Other. 

Category and Manufacturer : permet de classer 
les plug-ins selon deux niveaux de menus. 
Les menus de la partie supérieure de la 
fenêtre affichent les plug-ins par catégorie de 
processus (EQ, Dynamics, Delay par exemple), 
chaque plug-in étant répertorié dans les sous-
menus de catégorie. Les menus inférieurs affichent 
les plug-ins par fabricant (tel que Bomb Factory, 
Focusrite ou TL Labs), avec chaque plug-in 
répertorié dans les sous-menus des fabricants.

Options de langue (Windows uniquement)

Vous devez posséder des droits d'administrateur 
pour l'application Pro Tools afin de pouvoir 
configurer ces options.

Language : définit la langue à utiliser dans 
l'application Pro Tools, indépendamment de celle 
utilisée dans Windows.

Default Automatic Naming to English : 
les éléments de session sont automatiquement 
nommés en anglais, même si l'application 
Pro Tools utilise une autre langue.

Auto-Switch Input Language

Lorsque l'option Auto-Switch Input Language est 
activée, la langue de saisie passe automatiquement 
de l'anglais à la langue de saisie actuelle du système 
d'exploitation. Elle revient automatiquement 
à l'anglais lorsque vous utilisez des commandes 
clavier dans Pro Tools. Lorsque l'option est 
désactivée, l'anglais est utilisé lors de la saisie de 
texte, quelle que soit la langue de saisie actuelle du 
système d'exploitation.

Section Warnings and Dialogs
Reset “Don’t Show This Again” Settings : si vous 
activé l'option Don't Show This Again dans l'une 
des boîtes de dialogue de Pro Tools, vous pouvez 
cliquer sur le bouton Reset pour rétablir son état 
d'origine.

Show Quick Start Dialog When Pro Tools Starts : 
lorsque cette option est sélectionnée, Pro Tools 
affiche la boîte de dialogue Session Quick Start au 
démarrage. Désélectionnez cette option si vous 
préférez que Pro Tools n'affiche pas la boîte de 
dialogue Quick Start au démarrage.

Section Color Coding
Always Display Marker Colors : cette option 
permet d'afficher les couleurs de marqueur sur la 
règle des marqueurs, indépendamment de l'option 
Default Clip Color Coding. 
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MIDI Note Color Shows Velocity : lorsque cette 
option est activée, les notes MIDI s'affichent dans 
la fenêtre Edit et dans les fenêtres de l'éditeur 
MIDI dans différentes nuances de la couleur de 
piste définie dans la vue des notes MIDI. Les notes 
de vélocité élevée sont plus sombres et les notes de 
vélocité faible sont plus claires.

Options Default Track Color Coding

Les options suivantes déterminent les codes 
couleur utilisés par défaut pour les pistes des 
fenêtres Edit et Mix. Ces options sont :

None : désactive l'affectation de couleurs pour les 
pistes.

Tracks and MIDI Channels : attribue une couleur 
à chaque piste de la fenêtre Mix ou Edit en 
fonction de son assignation de voix ou canal MIDI.

Tracks and MIDI Devices : attribue une couleur 
à chaque piste de la fenêtre Mix ou Edit en 
fonction de son assignation de voix ou de 
périphérique MIDI.

Groups : attribue une couleur à chaque piste, 
en fonction de son ID de groupe. Si des groupes 
ont été suspendus à l'aide de la commande 
Suspend Groups, les barres de couleur des pistes 
ne sont pas affichées.

Track Type : attribue une couleur à chaque piste 
en fonction de son type (audio, entrée auxiliaire, 
Master Fader, Master VCA, MIDI, d'instrument ou 
vidéo).

Options Default Clip Color Coding

Ces options déterminent le code couleur par défaut 
des pistes, des emplacements de marqueur et des 
clips des playlists de piste ou de la liste des clips. 
Ces options sont :

None : désactive l'assignation de couleurs pour les 
clips. Les clips sont représentés par des formes 
d'ondes ou des notes MIDI noires sur fond gris clair.

Tracks and MIDI Channels : attribue une couleur 
à chaque clip de la fenêtre Edit en fonction de son 
assignation de voix ou de canal MIDI.

Tracks and MIDI Devices : attribue une couleur 
à chaque clip de la fenêtre Edit en fonction de son 
assignation de voix ou de périphérique MIDI.

Groups : attribue une couleur à chaque piste, 
en fonction de son ID de groupe. Si des groupes 
ont été suspendus à l'aide de la commande 
Suspend Groups, des formes d'onde noires ou des 
notes MIDI sont affichées sur fond gris clair pour 
tous les clips.

Track Color : attribue une couleur de clip basée sur 
la couleur assignée à la piste.

Marker Locations : attribue une couleur unique 
à chaque zone de marqueur sur la règle des 
marqueurs, y compris la zone précédant le premier 
marqueur.

Clip List Color : attribue une couleur à chaque clip 
en fonction de sa couleur dans la liste des clips.

Préférences de 
fonctionnement
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Section Transport
Timeline Insertion/Play Start Marker Follows 
Playback : lorsque cette option est sélectionnée, 
le point d'insertion de la timeline et le marqueur de 
début de lecture se déplacent à l'emplacement de la 
timeline sur lequel la lecture a été arrêtée. 
Lorsqu'elle est désélectionnée, le point d'insertion 
de la timeline et le marqueur de début de lecture ne 
suivent pas la lecture et retournent au point de 
départ de la lecture.

Edit Insertion Follows Scrub/Shuttle : lorsque 
cette option est sélectionnée, le curseur d'édition se 
place automatiquement sur le point d'arrêt du 
scrubbing.

Audio During Fast Forward/Rewind : lorsque 
cette option est sélectionnée, le son est audible 
pendant l'avance ou le retour rapide.

Latch Forward/Rewind : lorsque cette option est 
sélectionnée, l'avance et le retour rapides se 
verrouillent et continuent jusqu'à ce que vous 
appuyiez sur Stop, Play, Return To Zero ou Go To 
End dans la fenêtre de transport. Lorsqu'elle est 
désactivée, l'avance et le retour rapides s'arrêtent 
lorsque vous lâchez le bouton de la souris, après 
avoir cliqué sur l'un des boutons de la fenêtre de 
transport (ou lorsque vous cessez d'appuyer sur le 
bouton correspondant sur la surface de contrôle).

Play Start Marker Follows Timeline Selection : 
lorsque cette option est activée, le marqueur de début 
de lecture s'aligne sur le point d'entrée de sélection 
de timeline lorsque vous déplacez ou créez une 
sélection de timeline ou lorsque vous ajustez le point 
de début de la sélection de timeline. Si cette option est 
désactivée, le marqueur de début de lecture n'est pas 
déplacé avec la sélection de timeline.

Reserve Voices for Preview in Context (HDX et HD 
Native uniquement) : lorsque cette option est 
activée, Pro Tools réserve le nombre de voix 
approprié pour l'aperçu en contexte (aperçu des 
fichiers audio depuis les navigateurs de l'espace de 
travail en cours de lecture de la session). 
Le nombre de voix disponibles dépend de la 
largeur de canal des chemins d'écoute sélectionnés 
dans la page Output de la fenêtre I/O Setup. 
Par exemple, si le nombre de voix de lecture est 
défini sur 48 dans le moteur de lecture et si un 
chemin d'écoute stéréo est sélectionné dans la boîte 
de dialogue I/O Setup, seules 46 voix sont 
disponibles pour les pistes. Si le chemin d'écoute 
est de type 5.1, seules 42 voix sont disponibles. 
Lorsque cette option est désactivée, l'aperçu en 
contexte ne sera pas disponible si le nombre de 
voix disponibles est insuffisant. 

Custom Shuttle Lock Speed : définit la vitesse de 
shuttle verrouillé avant la plus élevée (touche 9) 
pour les modes de shuttle Classic ou Transport. 
La plage autorisée est comprise entre 50 et 800 %. 

Custom FF/REW Speed : définit la vitesse 
d'avance et de retour rapide par rapport à la vitesse 
de lecture normale. La plage autorisée est 
comprise entre 100 et 3 200 %. 

Back/Forward Amount (Pro Tools HD 
uniquement) : définit l'intervalle par défaut des 
commandes Back, Back and Play, Forward et 
Forward and Play. La base de temps des 
paramètres Back/Forward Amount est conforme 
à l'échelle temporelle principale par défaut. Vous 
pouvez également désactiver l'option Follow Main 

Time Scale et sélectionner un autre format de base 
de temps : Bars|Beats, Min:Sec, Timecode, 
Feet+Frames ou Samples.

Pour activer ou désactiver l'option Timeline 
Insertion/Play Start Marker Follows 
Playback, appuyez sur Démarrer+N 
(Windows) ou Ctrl+N (Mac).

Pour plus d'informations, reportez-vous à la 
section « Vitesse personnalisée de shuttle 
verrouillé » à la page 571.
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Mode Numeric Keypad

Le mode Numeric Keypad détermine le 
fonctionnement du pavé numérique. Il est toujours 
possible d'utiliser le pavé numérique pour 
sélectionner et saisir des valeurs dans la zone 
d'édition des événements, les indicateurs de 
sélection d'édition, les compteurs principaux et 
secondaires et les champs de la fenêtre de 
transport.

Classic : active un mode de shuttle verrouillé qui 
reproduit le fonctionnement de Pro Tools dans les 
versions inférieures à la version 5.0. Lorsque le 
mode du pavé numérique est défini sur Classic, 
vous pouvez lire jusqu'à deux pistes audio en mode 
de shuttle verrouillé. Appuyez sur la touche 
Démarrer (Windows) ou Ctrl (Mac), puis sur un 
chiffre de 0 à 9 pour sélectionner la vitesse de 
lecture. Appuyez sur la touche Plus (+) ou Moins 
(–) pour inverser le sens. Pour rappeler un 
emplacement mémoire, il suffit de saisir son 
numéro, suivi d'un point (.). 

Transport : active un mode de shuttle verrouillé 
pour lequel vous pouvez configurer un ensemble 
de fonctions d'enregistrement et de lecture, et qui 
permet également de piloter le transport depuis le 
pavé numérique. Lorsque le mode du pavé 
numérique est défini sur Transport, vous pouvez 
lire jusqu'à deux pistes audio en mode de shuttle 
verrouillé. Appuyez sur la touche Démarrer 
(Windows) ou Ctrl (Mac), puis sur un chiffre 
de 0 à 9 pour sélectionner la vitesse de lecture. 
Appuyez sur la touche Plus (+) ou Moins (–) pour 
inverser le sens. Rappelez un emplacement 
mémoire en saisissant un point (.), le numéro de 
l'emplacement mémoire, puis un autre point (.). 

Shuttle (Pro Tools HD uniquement) : active un 
type de shuttle différent du mode de shuttle 
verrouillé. En mode Shuttle, la lecture est 
déclenchée par une pression prolongée sur les 
touches du pavé numérique. Elle s'arrête lorsque 
vous relâchez les touches. Plusieurs vitesses de 
lecture avant et arrière sont disponibles. Vous 
pouvez également rappeler un emplacement 
mémoire en saisissant un point (.), son numéro, 
puis un autre point (.).

Use Separate Play and Stop Keys : 

lorsqu'elle est activée, cette option permet de 
lancer la lecture à l'aide de la touche Entrée et de 
l'arrêter à l'aide de la touche 0 du pavé numérique. 
Cette option s'utilise notamment lors de l'écoute 
des transitions de boucle, pour lancer et arrêter la 
lecture à des points rapprochés. L'option Use 

Separate Play and Stop Keys est disponible 
uniquement lorsque le pavé numérique est en 
mode Transport.

Section Auto Backup
Enable Session File Auto Backup : lorsque cette 
option est sélectionnée, Pro Tools enregistre 
automatiquement des copies de sauvegarde de 
votre fichier de session Pro Tools pendant que 
vous travaillez. Les copies de sauvegarde sont 
stockées dans le sous-dossier Session File Backups 
de votre dossier de session. 

Keep : spécifie le nombre total de copies de 
sauvegarde incrémentielles conservées.

Backup Every : spécifie la fréquence de création 
de copies de sauvegarde de la session.

Pour personnaliser la vitesse de shuttle 
verrouillé avant la plus élevée, reportez-vous 
à la section « Vitesse personnalisée de shuttle 
verrouillé » à la page 571.

Lorsque cette option est sélectionnée, 
la touche Entrée ne permet plus d'ajouter des 
marqueurs d'emplacement mémoire. Pour 
effectuer cette opération, vous devez d'abord 
appuyer sur le point (.), puis sur la touche 
Entrée du pavé numérique.
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Section User Library

Root

Cliquez sur le bouton Change pour définir 
le répertoire racine de tous les fichiers 
utilisateur, dont la documentation, les grooves, 
les paramètres d'E/S, les cartes d'assignation de 
plug-in, les paramètres de plug-in, les modèles de 
session et les patterns de test vidéo.

Section Video

Enable GPU :

Le traitement vidéo dans Pro Tools est pris en 
charge par le GPU (Graphics Processing Unit) afin 
de libérer les ressources du CPU pour l'audio et le 
MIDI. Si votre GPU est plus lent et que la lecture 
vidéo est de mauvaise qualité, désactivez cette 
option pour réassigner le traitement vidéo au CPU.

Prevent Tearing

Lorsque cette option est activée, Pro Tools stocke la 
vidéo dans une mémoire tampon pour empêcher 
l'apparition d'artefacts visuels avec un déplacement 
horizontal, lorsque la synchro vidéo ne correspond 
pas à la fréquence de rafraîchissement de l'écran. 
Cette option n'est pas disponible lorsque l'option 
Activer le GPU est désactivée.

Enable Hardware During Scrub

Lorsque l'option Enable Hardware During Scrub 
est activée, le monitoring vidéo est pris en charge 
lors d'un scrubbing, via une interface vidéo telle 
que Mojo DX ou Nitris DX. Lorsqu'elle est 
désactivée, seul le monitoring dans la fenêtre 
Video de Pro Tools est possible en cours de 
scrubbing. Si vous rencontrez des problèmes de 
performance lors du scrubbing vidéo, alors que 
vous utilisez du matériel vidéo pour le monitoring, 
désactivez cette option.

Play Start Latency

Si vous travaillez sur un ordinateur lent, 
choisissez une valeur plus élevée pour le 
paramètre Play Start Latency. Les valeurs 
disponibles vont de 1-Shortest à 5-Longest.

Section Record
Latch Record Enable Buttons : sélectionnez cette 
option pour activer simultanément plusieurs pistes 
pour l'enregistrement. Si cette option est désactivée, 
cette opération est impossible. L'activation d'une 
piste pour l'enregistrement inverse l'état de toutes 
les pistes audio précédemment activées pour 
l'enregistrement.

Enable Automation in Record : lorsque cette 
option est activée, vous pouvez écrire une 
automation en cours d'enregistrement, comme en 
cours de lecture. Lorsque cette option est 
désactivée, vous ne pouvez écrire une automation 
qu'en cours de lecture.

Notez que lorsque l'option Enable Automation in 

Record est sélectionnée, l'option Link Record and 

Play Faders est automatiquement désactivée et 
n'est pas disponible.

Link Record and Play Faders : lorsque cette 
option est sélectionnée, Pro Tools ne mémorise 
pas les différents niveaux de fader des pistes 
préparées pour l'enregistrement. Vous pouvez 
ainsi conserver le niveau de monitoring de toutes 
les pistes lors de l'enregistrement et la lecture. 

Audio Track RecordLock (Pro Tools HD 
uniquement) : cette option configure Pro Tools 
afin qu'il reproduise le comportement d'un 
enregistreur multipiste numérique, ou l'ancienne 
méthode d'activation pour l'enregistrement des 
pistes. 
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• Lorsque cette option est sélectionnée, 
les pistes audio demeurent préparées pour 
l'enregistrement même en cas d'arrêt de la 
lecture ou de l'enregistrement. 

• Lorsqu'elle n'est pas sélectionnée, les pistes 
audio ne demeurent pas préparées pour 
l'enregistrement lorsque vous arrêtez Pro Tools. 
Cela permet d'éviter que les pistes ne restent 
activées d'une passe à l'autre, émulant le 
comportement d'enregistrement de piste d'un 
enregistreur multipiste numérique. 

Transport RecordLock (Pro Tools HD 
uniquement) : cette option permet de configurer le 
comportement de la commande d'enregistrement 
du transport (le bouton Record des commandes de 
transport) de façon à émuler celui d'un enregistreur 
multipiste numérique ou l'ancienne méthode de la 
commande d'enregistrement principale du 
transport. 

• Si cette option est sélectionnée, le bouton 
Record de la fenêtre de transport reste activé 
même en cas d'arrêt de la lecture ou de 
l'enregistrement. Cela évite d'avoir à préparer le 
transport pour l'enregistrement entre chaque 
prise, ce qui correspond au comportement d'un 
enregistreur multipiste numérique. 

• Si cette option n'est pas sélectionnée, le bouton 
Record de la fenêtre de transport est désactivé 
lorsque Pro Tools est arrêté manuellement ou 
lorsqu'il s'interrompt en raison d'une perte de 
timecode, ce qui reproduit le comportement 
d'enregistrement standard de Pro Tools. 

L'option Transport Record Lock est 
automatiquement désactivée et grisée lorsque le 
mode d'enregistrement destructif est activé.

Disable “Input” When Disarming Track 
(In “Stop”) (Pro Tools HD uniquement) : 
le comportement de la commande de monitoring 
d'entrée de piste peut être personnalisé afin qu'elle 
reste sélectionnée quel que soit l'état d'enregistrement 
d'une piste, ou pour basculer automatiquement en 
mode de monitoring automatique de l'entrée après 
une passe d'enregistrement. Vous pouvez ainsi 
optimiser le monitoring d'un workflow multipiste 
type (pour lequel il est préférable de rester sur le 
monitoring d'entrée uniquement, sauf activation 
explicite du monitoring automatique) ou d'un 
workflow d'enregistrement musical classique (pour 
lequel le monitoring d'entrée doit être désactivé après 
chaque prise pour éviter d'entendre simultanément le 
retour et l'entrée de la piste).

• Lorsque cette option est activée, le fait de sortir 
une piste d'un mode d'activation pour 
l'enregistrement (quel qu'il soit) la fait basculer 
en mode de monitoring de l'entrée uniquement, 
indépendamment du mode de monitoring global. 
Le monitoring passe donc uniquement sur la 
lecture d'audio provenant du disque dur. 

• Lorsqu'elle n'est pas activée, les pistes audio 
restent en mode de monitoring de l'entrée 
uniquement jusqu'à l'activation explicite du 
monitoring automatique de l'entrée. 

Mute Record-Armed Tracks While Stopped 
(Pro Tools HD uniquement) : ce paramètre 
détermine l'état de monitoring des pistes préparées 
pour l'enregistrement. 

• Lorsque cette option est sélectionnée, Pro Tools 
mute les pistes préparées pour l'enregistrement 
lorsque le transport est arrêté. Le monitoring des 
entrées reste possible à l'arrêt à l'aide des 
boutons d'activation du monitoring des entrées 
de piste.

• Lorsqu'elle n'est pas sélectionnée, Pro Tools ne 
mute pas les entrées audio des pistes préparées 
pour l'enregistrement lorsque le transport est 
arrêté.
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PEC/Direct Style Input Monitoring (Pro Tools HD 
uniquement) : cette option modifie la façon dont le 
mode de monitoring de l'entrée de piste est indiqué 
à l'écran (ainsi que sur les surfaces de contrôle 
prises en charge), pour émuler les indications PEC 
(lecture) et Direct (entrée/bus) des consoles grand 
format. 

• Si cette option n'est pas sélectionnée, la 
lettre I s'affiche sur le bouton TrackInput. Ce 
bouton est grisé lorsque le mode Auto Input est 
activé et s'allume en vert pour indiquer le mode 
Input Only.

• Si elle est sélectionnée, le bouton TrackInput est 
grisé et indique la lettre D lorsque le mode Input 
Only est activé (Direct). Il s'allume en vert et 
affiche la lettre P pour indiquer le mode Auto 
Input (Pec ou lecture).

Automatically Create New Playlists When Loop 
Recording : lorsque cette option est sélectionnée, 
les prises successives d'un enregistrement en 
boucle sont copiées vers de nouvelles playlists de 
la piste. Ceci est particulièrement utile pour 
préparer la création de pistes composites en vue 
Playlists après l'enregistrement en boucle de 
plusieurs prises.

Options Online

Record Online at Timecode (or ADAT) Lock : 
lorsque cette option est sélectionnée, l'enregistrement 
en ligne débute dès que Pro Tools reçoit un timecode 
et qu'il se synchronise sur celui-ci.

Record Online at Insertion/Selection : lorsque 
cette option est sélectionnée, l'enregistrement en 
ligne débute à l'emplacement du curseur d'édition. 
Il se poursuit jusqu'à ce que Pro Tools ne reçoive 
plus de timecode. Si vous effectuez une sélection, 
Pro Tools enregistre en ligne pendant la durée de 
la sélection. 

DestructivePunch File Length (Pro Tools HD 
uniquement) :

cette préférence définit la durée des fichiers audio 
consolidés lors de la préparation des pistes pour le 
mode DestructivePunch. La valeur par défaut est 
de 25 minutes. 

Section Misc (Miscellaneous)
Clip Auto Fade In/Out Length (Pro Tools HD 
uniquement) : cette option définit une durée par 
défaut pour les fondus d'entrée et de sortie 
appliqués automatiquement aux extrémités des 
clips. L'utilisation de fondus d'entrée et de sortie 
automatiques évite le montage des clips aux points 
de passage par zéro ou la création d'innombrables 
rendus de fondu afin d'éliminer les clics et autres 
parasites survenant au cours de la lecture. 
Les fondus automatiques ne sont pas enregistrés 
sur le disque. Le paramètre Auto Clip Fade In/Out 

Length peut être défini sur une valeur comprise 
entre 0 et 10 ms. La valeur zéro indique l'absence 
de fondu automatique. La valeur de l'option Auto 
Fade est enregistrée avec la session et appliquée 
automatiquement à toutes les extrémités des clips 
présents sur les pistes, jusqu'à ce que vous la 
modifiiez.

Calibration Reference Level (Systèmes 
Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : définit le niveau de référence 
d'étalonnage par défaut en dB, lorsque Pro Tools 
est en mode Calibration. Pour les interfaces audio 
munies de réglages de trim (telles qu'une HD I/O), 
reportez-vous au guide de l'interface pour obtenir 
des instructions d'étalonnage.
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Delay Compensation Time Mode : lorsque la 
compensation du retard est activée (Options > Delay 

Compensation), cette option permet de déterminer 
l'unité d'affichage des données dans le gestionnaire 
de délai : millisecondes ou échantillons.

Compensate Side Chains (systèmes 
Pro Tools|HDX uniquement) : lorsque la 
compensation du retard est activée (Options > 

Delay Compensation), cette option applique la 
compensation du retard aux signaux side-chain 
des plug-ins. 

Préférences d'édition

Section Clips
Clip List Selection Follows Edit Selection : 
lorsque cette option est sélectionnée, la sélection d'un 
clip sur une piste est reflétée dans la liste des clips. 

Edit Selection Follows Clip List Selection : 
lorsque cette option est sélectionnée, la sélection 
d'un clip dans la liste des clips met en surbrillance 
les occurrences de ce clip sur les pistes.

Auto-Name Separated Clips : lorsque cette option 
est sélectionnée, Pro Tools nomme 
automatiquement les clips qui viennent d'être 
séparés en ajoutant un numéro à leur nom.

“Separate Clip” Operates On All Related Takes : 
lorsque cette option est sélectionnée, l'édition 
d'un clip avec la commande Separate Clip affecte 
également toutes les prises associées (passes 
d'enregistrement) possédant le même marqueur 
temporel utilisateur. Cette option aide à comparer 
différentes sections d'un groupe de prises 
associées.

Si votre système inclut un ou plusieurs 
contrôleurs EUCON, veillez à désactiver 
l'option Auto-bank to selected track dans le 
logiciel EuControl avant d'activer le mode 
Calibration de Pro Tools pour vous assurer 
que le son des faders est bien coupé. Pour cela, 
ouvrez la fenêtre des paramètres EuControl, 
cliquez sur l'onglet General et vérifiez qu'elle 
n'est pas activée. Si nécessaire, cliquez pour 
désactiver l'option Auto-bank to selected 
track. Après être sorti du mode Calibration, 
prenez soin de réactiver l'option Auto-bank to 
selected track (si nécessaire).
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Clip Gain Nudge Value : ce paramètre spécifie la 
valeur (de 0,1 dB à 6 dB) ajoutée ou retirée au gain 
d'un clip lors d'un ajustement par incrémentation.

Section Tracks
New Tracks Default To Tick Timebase : lorsque 
cette option est sélectionnée, toutes les nouvelles 
pistes sont basées par défaut sur les références de 
tempo. Lorsqu'elle n'est pas sélectionnée, les pistes 
audio, d'entrée auxiliaire, Master Fader et Master 
VCA (Pro Tools HD uniquement) sont basées par 
défaut sur les échantillons.

Section Memory Locations
Auto-Name Memory Locations When Playing : 
lorsque cette option est sélectionnée, Pro Tools 
attribue un nom par défaut aux nouveaux 
emplacements mémoire, en fonction de leur 
emplacement temporel dans la session. Les unités 
temporelles sélectionnées dans le menu View 
déterminent les unités utilisées pour ces noms. 

Recall Memory Location at Original Track : 
lorsque cette option est sélectionnée, 
les emplacements mémoire rappelant une sélection 
rappellent également la piste sur laquelle la 
sélection a été effectuée.

Section Fades
Crossfade Preview Pre-Roll : ce paramètre spécifie 
la durée du pré-roll ajoutée lors de l'écoute des fondus 
enchaînés dans la boîte de dialogue Fades.

Crossfade Preview Post-Roll : ce paramètre 
spécifie la durée du post-roll ajoutée lors de 
l'écoute des fondus enchaînés dans la boîte de 
dialogue Fades.

QuickPunch/TrackPunch Crossfade Length : 
cette option spécifie la durée par défaut des 
crossfades créés par l'enregistrement en mode 
QuickPunch ou TrackPunch (Pro Tools HD 
uniquement). Ces fondus enchaînés sont créés 
avant le punch-in et après le punch-out. 

Preserve Fades when Editing : cette option 
permet de conserver les fondus d'entrée et de sortie 
et de convertir les fondus enchaînés séparés en 
fondus d'entrée et de sortie équivalents.

Default Fade Settings

Fade In : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fondus d'entrée créés 
avec l'outil Smart.

Fade Out : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fondus de sortie créés 
avec l'outil Smart.

Crossfade : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fondus enchaînés créés 
avec l'outil Smart.

REX : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fondus et fondus 
enchaînés créés entre les clips (tranches) des 
fichiers REX importés.

Section Zoom Toggle
Vertical Zoom : permet de sélectionner l'option 
Selection ou Last Used pour le paramètre Zoom 

Toggle Vertical Zoom.

Pour appliquer un fondu d'entrée, un fondu 
de sortie ou un fondu enchaîné par défaut 
à une sélection d'édition sans ouvrir la boîte 
de dialogue Fades, appuyez sur les touches 
Ctrl+Démarrer+F (Windows) ou 
Commande+Ctrl+F (Mac).
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Horizontal Zoom : permet de sélectionner l'option 
Selection ou Last Used pour le paramètre Zoom 

Toggle Horizontal Zoom.

Remove Range Selection After Zooming In : 
lorsque cette option est sélectionnée, la sélection 
d'édition actuelle est réduite en un point d'insertion 
lorsque vous effectuez un zoom avant. Le fait 
d'effectuer un zoom arrière rétablit la sélection 
précédente.

Track Height : permet de sélectionner l'option Last 

Used, Medium, Large, Extreme ou Fit To Window 
pour le paramètre Zoom Toggle Track Height.

Track View : permet de sélectionner l'option 
Waveform/Notes, Warp/Notes, Last Used ou No 

Change pour le paramètre Zoom Toggle Track 

View.

Separate Grid Settings When Zoomed In : 
lorsque cette option est sélectionnée, le paramètre 
de grille correspondant au zoom est rappelé 
lorsque vous effectuez un zoom avant. Lorsqu'elle 
est désélectionnée, le paramètre de grille actuel est 
conservé suite à un changement de zoom vers 
l'avant ou l'arrière.

Zoom Toggle Follows Edit Selection : lorsque 
cette option est sélectionnée, le changement 
de zoom suit automatiquement la sélection 
d'édition actuelle. Lorsqu'elle est désélectionnée, 
la modification de la sélection d'édition n'a aucun 
effet sur la piste agrandie (zoom avant) actuelle.

Levels of Undo
Cette préférence définit le nombre maximal 
d'actions qu'il est possible d'annuler avec la 
fonction d'annulation multiple. Des valeurs basses 
sont conseillées pour les ordinateurs les plus lents. 
Pro Tools prend en charge jusqu'à 64 niveaux 
d'annulation.

Préférences de mixage

Section Setup
Sends Default to –INF : lorsque cette option est 
sélectionnée, le niveau de fader initial des 
nouveaux départs est défini sur –∞ (aucun signal 
audible). Lorsqu'elle n'est pas sélectionnée, 
le niveau de fader initial des nouveaux départs est 
défini sur 0 dB.

Send Pans Default to Follow Main Pan : lorsque 
cette option est sélectionnée, l'option Follow Main 

Pan est activée pour les nouveaux départs, afin que 
les réglages de panoramique des départs 
correspondent aux réglages de panoramique de la 
piste. Lorsqu'elle n'est pas sélectionnée, l'option 
Follow Main Pan est désactivée pour les nouveaux 
départs.

Link Mix and Edit Group Enables : lorsqu'elle 
est sélectionnée, cette option lie l'activation et la 
désactivation des groupes Mix et Edit. L'activation 
du groupe A dans la fenêtre Mix active 
automatiquement le groupe correspondant dans la 
fenêtre Edit, par exemple.
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Use Absolute Pan Linking (Pro Tools HD 
uniquement) : cette option affecte le 
comportement des commandes de panoramique 
groupées.

• Lorsqu'elle est sélectionnée, le décalage relatif 
entre les commandes de panoramique groupées 
n'est pas conservé lorsque le réglage de l'une 
d'entre elles est modifié. Toutes les commandes 
de panoramique groupées s'alignent sur la valeur 
absolue de la commande modifiée. 

• Lorsqu'elle n'est pas sélectionnée, le décalage 
relatif entre les commandes groupées est 
conservé lorsque le réglage de l'une d'entre elles 
est modifié.

Default EQ

Cette préférence permet de sélectionner le plug-in 
d'égalisation par défaut parmi les plug-ins 
installés, afin de pouvoir l'assigner rapidement 
à l'écran et sur les surfaces de contrôle ICON 
(Pro Tools HD uniquement). À l'écran, le plug-in 
s'affiche en haut du menu des sélecteurs d'insert. 
Sur les surfaces de contrôle ICON, le plug-in 
s'affiche au début de la liste des choix de menu sur 
les encodeurs rotatifs.

Default Dynamics

Cette préférence permet de sélectionner le plug-in 
de traitement dynamique par défaut parmi les plug-
ins installés, afin de pouvoir l'assigner rapidement 
à l'écran et sur les surfaces de contrôle ICON 
(Pro Tools HD uniquement). À l'écran, le plug-in 
s'affiche en haut du menu des sélecteurs d'insert. 
Sur les surfaces de contrôle ICON, le plug-in 
s'affiche au début de la liste des choix de menu sur 
les encodeurs rotatifs.

Section Controllers
Edit Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge par 
Pro Tools, cette option permet de faire défiler la 
fenêtre Edit pour afficher la banque de pistes 
sélectionnée lorsque vous changez de banque sur 
la surface de contrôle. La banque en cours 
d'utilisation est ainsi toujours visible à l'écran.

Mix Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge par 
Pro Tools, cette option permet de faire défiler la 
fenêtre Mix pour afficher la banque de pistes 
sélectionnée lorsque vous changez de banque sur 
la surface de contrôle. La banque en cours 
d'utilisation est ainsi toujours visible à l'écran.

« Scroll to Track » Banks Controllers : lorsque 
vous utilisez une surface de contrôle (D-Control 
par exemple), vous pouvez sélectionner cette 
option pour assigner les faders de la surface de 
contrôle à une piste numérotée lors de l'utilisation 
de la commande Scroll to Track.

Always Fill Channel Strips When Banking : 
si vous utilisez une surface de contrôle ICON 
(Pro Tools HD uniquement) ou toute autre 
surface prise en charge, vous pouvez sélectionner 
cette option pour augmenter le nombre de 
canaux affichés lors de la création des banques. 
Ce paramètre optimise l'utilisation des 
commandes relatives aux banques et empêche 
qu'un nombre réduit de canaux soit affiché aux 
extrémités de la surface.

Touch Timeout : lors de l'écriture de données 
d'automation en mode Touch, si vous arrêtez de 
déplacer un fader ou un encodeur non tactile, 
Pro Tools poursuit l'écriture pendant la durée 
spécifiée par le paramètre Touch Timeout.
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Lorsque la période Touch Timeout se termine, 
l'écriture de données d'automation s'arrête et ces 
données retrouvent leur valeur d'automation 
précédente, à la vitesse spécifiée par le paramètre 
AutoMatch Time.

Section Automation
Smooth and Thin Data After Pass : lorsque cette 
option est sélectionnée, Pro Tools lisse 
automatiquement les données créées lors d'une 
passe d'automation, puis les affine selon la valeur 
spécifiée. 

Degree of Thinning : cette option spécifie la 
quantité d'affinage des données d'automation 
lorsque vous utilisez la commande Thin 
Automation ou que vous sélectionnez l'option 
Smooth and Thin Data After Pass. 

Plug-In Controls Default to Auto-Enabled : 
lorsque cette option est sélectionnée, toutes les 
commandes applicables des nouveaux plug-ins 
sont activées pour l'automation. Lorsqu'elle ne l'est 
pas, les commandes des nouveaux plug-ins doivent 
être activées manuellement pour l'automation. 

Suppress Automation « Write To » Warnings 
(Pro Tools HD uniquement) : lorsque cette option 
est sélectionnée, Pro Tools supprime les 
avertissements affichés suite à l'appel des 
commandes Write Automation To Start, Selection, 
End ou Punch et à l'arrêt du transport.

Latching Behavior for Switch Controls in 
« Touch » : cette option détermine le 
comportement des commandes à bascule (mute ou 
bypass de plug-in par exemple) lors de l'écriture de 
données d'automation en mode Touch.

• Lorsqu'elle est sélectionnée, les commandes 
sont verrouillées dans leur état actuel en mode 
Touch. Si un point d'automation est atteint, 
l'écriture des données d'automation s'arrête. Si le 
transport est arrêté pendant l'écriture, la 
commande sera définie automatiquement sur la 
valeur sous-jacente.

• Si elle n'est pas sélectionnée, les commandes ne 
sont pas verrouillées en mode Touch. 

Allow Latch Prime in Stop (Pro Tools HD 
uniquement) : lorsque cette option est 
sélectionnée et que des pistes sont en mode Latch, 
vous pouvez modifier les valeurs des commandes 
activées pour l'automation de ces pistes lorsque le 
transport est arrêté en touchant ou déplaçant les 
commandes pour préparer la passe d'automation 
suivante. 

Coalesce when Removing Slaves from VCA 
Group (Pro Tools HD uniquement) : cette option 
détermine le comportement du système lors du 
retrait de pistes esclaves d'un groupe contrôlé 
par VCA.

• Lorsqu'elle est sélectionnée, les données 
d'automation contenues sur la piste Master VCA 
sont automatiquement fusionnées (sans 
confirmation) sur les pistes esclaves lors de leur 
retrait.

• Lorsqu'elle n'est pas sélectionnée, une boîte de 
dialogue vous invite à confirmer la fusion des 
données d'automation de la piste Master VCA 
sur les pistes esclaves.

Standard VCA Logic for Group Attributes 
(Pro Tools HD uniquement) : cette option 
détermine les attributs de groupe de mixage 
pouvant être sélectionnés dans la boîte de dialogue 
Group lorsque le groupe est assigné à un Master 
VCA. 
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• Lorsqu'elle est sélectionnée, les commandes de 
volume principal, mute, solo, Record Enable et 
Input Monitoring des pistes esclaves sont liées 
uniquement au Master VCA ; elles ne peuvent 
pas être liées indépendamment (ce 
comportement émule le comportement des 
Master VCA des consoles analogiques).

• Lorsqu'elle n'est pas sélectionnée, 
les commandes de volume principal, mute, solo, 
Record Enable et Input Monitoring des pistes 
esclaves sont liées au Master VCA. Toutefois, 
elles peuvent également être liées aux groupes 
indépendamment.

Include Sends in Trim Mode (Pro Tools HD 
uniquement) : cette option détermine l'état des 
faders de départ lorsqu'une piste est en mode Trim.

• Lorsqu'elle est sélectionnée, les faders de départ 
passent en mode Trim en même temps que le 
fader de volume principal. 

• Lorsqu'elle ne l'est pas, le fader de volume 
principal passe en mode Trim, mais le fader de 
départ reste dans le mode d'automation standard 
correspondant.

Include Control Changes in Undo Queue : cette 
option indique si certaines modifications 
de commandes de mixage (par exemple, 
le déplacement d'un fader ou d'une commande de 
panoramique) sont ajoutées ou non à la liste 
d'annulations.

• Lorsque cette option est sélectionnée, les 
modifications de commandes de mixage sont 
consignées dans la liste d'annulations et sont 
annulées en cas d'annulation d'une opération 
antérieure.

• Lorsqu'elle est désélectionnée, les modifications 
de commandes de mixage ne sont pas 
consignées dans la liste d'annulations. Vous 
pouvez ainsi annuler d'autres types d'opération 
tout en conservant les réglages actuels du 
mixeur.

Les opérations de réinitialisation des paramètres 
par défaut affectant les commandes du mixeur sont 
consignées dans la liste d'annulations.

AutoMatch Time : lors de l'écriture de données 
d'automation en mode Touch, si vous relâchez un 
fader ou une commande, l'écriture s'arrête et les 
données retrouvent leur valeur précédente. 
La vitesse de retour à la valeur précédente 
correspond au paramètre AutoMatch Time. 

AutoGlide Time (Pro Tools HD uniquement) : 
ce paramètre définit la vitesse à laquelle Pro Tools 
passe (glisse) d'une valeur d'automation à une 
autre, lorsque le mode AutoGlide est activé.

Options After Write Pass, Switch To

Ces options permettent de sélectionner le mode 
d'automation dans lequel les pistes Pro Tools 
basculent automatiquement après une passe 
d'automation en mode Write (ou Write Trim). 
Choisissez l'une des options suivantes :

Touch : active le mode Touch après une passe 
d'automation en mode Write (ou Write Trim).

Latch : active le mode Latch après une passe 
d'automation en mode Write (ou Write Trim).

No Change : reste en mode Write après une passe 
d'automation en mode Write (ou Write Trim). 

Après une passe d'automation en mode Write 
Trim, les pistes basculent automatiquement sur la 
version Trim du paramètre spécifié.

Options Coalesce Trim Automation

(Pro Tools HD uniquement)

Ces options déterminent à quel moment les 
données d'automation de trim sont appliquées à la 
playlist d'automation principale des pistes.
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After Every Pass : les données d'automation de 
trim sont fusionnées lorsque le transport est arrêté, 
à la fin de chaque passe d'automation de trim. 
Aucune playlist composite n'est disponible.

On Exiting Trim Mode : les données d'automation 
de trim sont fusionnées lorsque la piste sort du 
mode Trim. Vous pouvez afficher les playlists 
composites avant de valider les changements de 
trim.

Manually : Les données d'automation de trim sont 
fusionnées uniquement à l'aide de la commande 
Coalesce Trim Automation. Vous pouvez afficher 
les playlists composites avant de valider les 
changements de trim.

Préférences de mesure des 
niveaux

Track and Master Meter Types
La section Track Meters des préférences de 
mixage permet de définir le type d'indicateur et les 
paramètres de mesure et d'affichage des niveaux 
pour les pistes audio, d'entrée auxiliaire et 
d'instrument. La section Master Meters permet de 
configurer ces paramètres indépendamment pour 
les pistes Master Fader.

Track and Master Meter Types Linked

Activez l'option Track and Master Meter Types 
Linked afin que les indicateurs de niveau des pistes 
(audio, d'entrée auxiliaire et d'instrument) et des 
Masters (Master Fader) utilisent toujours le même 
type d'indicateur. Désactivez cette option pour 
utiliser des types d'indicateurs différents sur les 
pistes et les Masters (un indicateur VU pour les 
pistes et un indicateur Crête pour les pistes Master 
par exemple).

Track Meters et Master Meters

Pro Tools permet de choisir parmi plusieurs types 
d'indicateurs de niveau standards de l'industrie 
pour le contrôle visuel des niveaux audio. Vous 
pouvez lier les paramètres des indicateurs des 
pistes (audio, d'entrée auxiliaire et d'instrument) 
et des Masters (Master Fader), ou les configurer 
indépendamment. Les options suivantes sont 
disponibles pour le paramètre Meter Type :

Sample Peak : indicateur de niveau par défaut de 
Pro Tools. Le crête mètre numérique est également 
le type d'indicateur utilisé dans les versions 
non HD de Pro Tools. L'échelle et le temps de 
descente sont calculés en dB/seconde, d'où une 
descente plus lente pour la mesure des niveaux par 
rapport aux versions antérieures de Pro Tools, 
telles que Pro Tools 10. L'option Sample Peak est 
le seul paramètre Meter Type dont le temps 
d'intégration des échantillons est égal à 0. De ce 
fait, il indique précisément la dynamique du signal 
numérique à chaque instant.

Préférences de mesure des niveaux (Pro Tools HD)
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Pro Tools Classic : active des indicateurs de 
niveau et des échelles dont les caractéristiques sont 
identiques à celles des anciennes versions de 
Pro Tools.

Linear (Pro Tools HD uniquement) : le type Linear 
est adapté aux projets de post-production et de 
mixage de musique. Grâce à un temps de descente 
rapide, le type Linear fournit une mesure linéaire 
de toutes les crêtes des échantillons, avec une 
plage de mesure descendant jusqu'à -40 dB. Il offre 
une meilleure résolution de mesure près du 0 dB, 
particulièrement utile pour le mixage et le 
mastering.

Linear (Extended) (Pro Tools HD uniquement) : 
fournit les mêmes caractéristiques de mesure des 
niveaux que le type Linear, mais avec une échelle 
étendue jusqu'à -60 dB.

RMS (Pro Tools HD uniquement) : active des 
indicateurs de mesure qui affichent l'intensité 
moyenne (moyenne quadratique du signal) sur une 
plage de temps. Le type d'indicateur Peak, lui, 
affiche le niveau crête instantané des signaux.

VU (Pro Tools HD uniquement) : très utilisée pour 
le mixage de musique et de dialogues, l'échelle 
VU de Pro Tools est étendue vers le bas, de -23 dB 
à -40 dB, pour convenir à une large gamme de 
contenus, sans nécessiter de ré-étalonnage.

Digital VU (Pro Tools HD uniquement) : fournit 
une mesure des niveaux de type VU-mètre, sur une 
échelle numérique moderne.

PPM Digital (Pro Tools HD uniquement) : très 
utilisé chez les diffuseurs en Europe et en Asie, 
ainsi que sur les consoles cinéma US (telles que les 
consoles Avid System5), le standard PPM Digital 
possède le même temps d'intégration que le type 
Sample Peak, mais une échelle et un temps de 
descente différents.

Le type PPM Digital, tout comme les autres options 
Meter Type, hormis Sample Peak, ne signale pas 
tous les transitoires (par exemple lors d'une série 
de transitoires très rapprochés). Toutefois, même 
si ce type ne retranscrit pas la plage dynamique 
numérique réelle, il est plus fidèle à la perception 
de l'intensité sonore sur le temps par l'oreille 
humaine.

PPM BBC (Pro Tools HD uniquement) : adoptée 
par les diffuseurs au Royaume-Uni, l'échelle BBC 
est basée sur des graduations espacées de 4 dB. 
D'autres organisations dans le monde entier, dont 
l'EBU, CBC et ABC utilisent la même plage 
dynamique, mais avec des échelles légèrement 
différentes.

PPM Nordic (Pro Tools HD uniquement) : 
variante scandinave du format PPM DIN, avec les 
mêmes temps d'intégration et de réponse, mais une 
échelle différente. La graduation « TEST » 
correspond au niveau d'alignement (0 dBu) et 
+9 au niveau maximum autorisé (+9 dBu). Par 
rapport à l'échelle DIN, le type Nordic est basé sur 
une échelle plus logarithmique et couvre une plage 
dynamique légèrement réduite.

PPM EBU (Pro Tools HD uniquement) : variante 
du type PPM britannique, conçue pour le 
contrôle des niveaux dans le cadre d'échanges 
internationaux de programmes (Type PPM IIb 
de la norme IEC 60268-10). Ses caractéristiques 
sont identiques au PPM britannique (BBC), 
à l'exception de l'échelle de mesure. L'échelle de 
mesure est étalonnée en dB relatifs au niveau 
d'alignement, identifié par la mention « TEST ». 
Des graduations sont présentes tous les 2 dB, ainsi 
qu'à +9 dB, le niveau maximum autorisé.
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PPM DIN (Pro Tools HD uniquement) : utilisé par 
les diffuseurs allemands, le signal analogique 
nominal correspondant au niveau maximum 
autorisé a été standardisé par ARD à 1,55 volts 
(+6 dBu), et il s'agit de la sensibilité habituelle 
d'un indicateur de niveau PPM de type DIN 
pour une indication de 0 dB. Le niveau 
d'alignement (-3 dBu) est affiché sur l'indicateur 
par un repère situé à -9 sur l'échelle.

K-12 (Pro Tools HD uniquement) : les échelles 
K sont de type RMS, avec un crête-mètre intégré 
affichant une valeur secondaire. Les échelles 
K sont très employées par les mixeurs musique 
qui recherchent une indication fidèle du niveau 
d'intensité global. Le type K-12 est strictement 
réservé à l'audio broadcast, même si les 
ingénieurs du son de ce secteur peuvent lui 
préférer le type K-14 s'il est plus adapté au contenu 
du programme.

K-14 (Pro Tools HD uniquement) : utilisez le type 
K-14 en mastering lorsque vous travaillez dans un 
environnement de mastering étalonné.

K-20 (Pro Tools HD uniquement) : l'utilisation du 
type K-20 en mixage permet d'obtenir des mix plus 
clairs, plus facilement exploitables par les 
ingénieurs de mastering. Le réalisateur et 
l'ingénieur de mastering doivent au préalable 
décider si le programme doit être converti pour se 
conformer au standard K-14, ou rester en K-20. 
Si vous mixez sur bande analogique, travaillez en 
K-20, vous observerez que les niveaux crête sur la 
bande n'excèdent pas +14.

VENUE Peak : fournit les mêmes caractéristiques 
que le type Sample Peak, mais sur une échelle de 
mesure VENUE étendue jusqu'à +20 dB.

RMS VENUE : fournit les mêmes caractéristiques 
que le type RMS, mais sur une échelle de mesure 
VENUE étendue jusqu'à +20 dB.

Advanced Meter Type Settings
Les paramètres Advanced Meter Type Settings 
permettent d'ajuster l'échelle et la sensibilité de mesure 
des niveaux pour le type Meter Type sélectionné. 
Ces paramètres sont automatiquement mis à jour pour 
correspondre aux caractéristiques du type Meter Type 
sélectionné. Pour certaines configurations système, 
il peut être nécessaire d'ajuster manuellement ces 
paramètres afin de s'assurer que la mesure des niveaux 
dans Pro Tools correspond à celle de votre console 
broadcast (certaines consoles broadcast utilisent des 
variantes des types d'indicateurs standard fournis dans 
Pro Tools). Cependant, dans la plupart des cas, il est 
conseillé de conserver les valeurs par défaut de 
ces paramètres.

Decay

Les paramètres Decay déterminent l'intervalle en 
décibels (dB) duquel l'indicateur de niveau 
retombe, à la vitesse spécifiée en secondes, après 
l'affichage d'un niveau crête. Pour certains types 
d'indicateurs, ces paramètres ne sont pas 
modifiables (VU par exemple).

0 dBFS

Le paramètre 0 dBFS détermine le niveau de 
référence unitaire de l'échelle de mesure, 
en décibels par rapport au 0 dB numérique. 
Dépasser ce niveau (ou le niveau d'écrêtage 
spécifié pour le broadcast) peut engendrer un 
écrêtage des convertisseurs 
numérique/analogique. Pour certains types 
d'indicateurs, ces paramètres ne sont pas 
modifiables (K par exemple).

Les échelles K sont de type RMS, avec un 
crête-mètre intégré affichant une valeur 
secondaire. Pour plus d'informations sur la 
mesure des niveaux avec les échelles de 
type K, consultez l'article « An Integrated 
Approach to Metering, Monitoring, and 
Levelling Practices » par Bob Katz, Digital 
Domain, Inc.



Guide de référence Pro Tools122

Integration Time

Le paramètre Integration Time détermine la durée 
nécessaire, en millisecondes, pour calculer la 
moyenne du niveau crête à afficher sur l'indicateur 
de niveau. Ce paramètre est semblable au temps 
d'attaque nécessaire à l'affichage des niveaux crête 
sur les indicateurs. Pour certains types 
d'indicateurs, ces paramètres ne sont pas 
modifiables (Peak par exemple).

Color Break High

Le paramètre Color Break High détermine le point 
en dB auquel la couleur change dans le haut de 
l'indicateur. Il s'agit habituellement du niveau 
maximal pour le type Meter Type sélectionné. 
Un écrêtage se produit lorsque ce niveau est 
dépassé. Les niveaux compris entre les valeurs 
Color Break High et Color Break Low des 
indicateurs correspondent au « sweet spot », 
la plage d'intensité idéale pour le contenu du 
programme.

Color Break Low

Le paramètre Color Break Low détermine le point 
en dB auquel la couleur change dans le bas de 
l'indicateur. Il s'agit habituellement du niveau 
minimal pour le type Meter Type sélectionné. 
Utilisez ce paramètre pour fournir une indication 
visuelle du niveau le plus faible de la plage 
dynamique du programme, en fonction du format 
de sortie prévu (cinéma, DVD, CD, MP3 ou 
broadcast par exemple).

Reset

Cliquez sur le bouton Reset pour rétablir les 
valeurs par défaut des paramètres avancés du type 
Meter Type sélectionné.

Section Peak/Clip

Options Peak Hold

Ces options permettent de spécifier la durée de 
maintien des témoins d'écrêtage des indicateurs de 
niveau des pistes lorsqu'une crête est détectée. 

3 Seconds : lorsque cette option est sélectionnée, 
les indicateurs des pistes affichent le dernier 
niveau crête pendant trois secondes.

Infinite : lorsque cette option est sélectionnée, 
les indicateurs des pistes affichent le dernier 
niveau crête jusqu'à ce que vous cliquiez dessus 
pour les réinitialiser.

None : lorsque cette option est sélectionnée, 
l'affichage des niveaux crête n'est pas maintenu sur 
les indicateurs des pistes.

Options Clip Indication

Ces options permettent de régler la durée pendant 
laquelle les témoins d'écrêtage des indicateurs de 
niveau de piste, de plug-in et de départ restent 
allumés lorsqu'une crête est détectée.

3 Seconds : lorsque cette option est sélectionnée, 
les indicateurs de niveau affichent un écrêtage 
durant trois secondes.

Infinite : lorsque cette option est sélectionnée, 
les indicateurs de niveau affichent un écrêtage 
jusqu'à ce que vous cliquiez dessus pour les 
réinitialiser.

None : lorsque cette option est sélectionnée, 
les témoins d'écrêtage ne restent pas allumés.

Section Display
La section Display des préférences de mesure des 
niveaux fournit des options de configuration de 
l'affichage des nouveaux indicateurs de réduction 
de gain sur les pistes et les départs.
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Show Send Assignment Level Meter

Activez l'option Show Send Assignment Level 

Meter pour afficher les indicateurs de niveau sur 
les assignations des départs des pistes audio, 
d'entrée auxiliaire et d'instrument de la fenêtre 
Mix. Lorsque cette option est désactivée, 
les indicateurs de niveau ne sont pas affichés sur 
les assignations de départ.

Show Track Gain Reduction Meter 

(Pro Tools HD uniquement)

Activez l'option Show Track Gain Reduction Meter 
pour afficher les indicateurs de réduction de gain 
sur les pistes audio, d'entrée auxiliaire, 
d'instrument et Master Fader de la fenêtre Mix. 
Notez que même si cette option est activée, 
les indicateurs de réduction de gain ne sont 
affichés que sur les pistes sur lesquelles un plug-in 
de traitement dynamique compatible avec cette 
fonctionnalité est inséré. Lorsqu'elle est 
désactivée, les indicateurs de réduction de gain ne 
sont pas affichés sur les pistes.

Show Insert Assignments Gain Reduction 
Meter

(Pro Tools HD uniquement)

Activez l'option Show Insert Assignments Gain 

Reduction Meter pour afficher les indicateurs de 
réduction de gain sur les assignations d'insert des 
pistes audio, d'entrée auxiliaire, d'instrument et 
Master Fader de la fenêtre Mix. Notez que même si 
cette option est activée, les indicateurs de 
réduction de gain ne sont affichés que sur les pistes 
sur lesquelles un plug-in de traitement dynamique 
compatible avec cette fonctionnalité est inséré. 
Lorsqu'elle est désactivée, les indicateurs de 
réduction de gain ne sont pas affichés sur les 
assignations d'insert des pistes.

Gain Reduction Meter Type

(Pro Tools HD uniquement)

Les paramètres Gain Reduction Meter Type 
déterminent les plug-ins de traitement dynamique 
pris en compte par les indicateurs de réduction 
de gain des pistes audio, d'entrée auxiliaire, 
d'instrument et Master Fader de la fenêtre Mix. 
Notez que les indicateurs de réduction de gain ne 
sont affichés que sur les pistes sur lesquelles est 
inséré un plug-in de traitement dynamique du type 
correspondant, compatible avec cette 
fonctionnalité.

Compressor/Limiter : lorsque cette option est 
sélectionnée, les indicateurs affichent uniquement 
la réduction de gain appliquée sur les pistes par les 
plug-ins de type compresseur/limiteur.

Expander/Gate : lorsque cette option est 
sélectionnée, les indicateurs affichent uniquement 
la réduction de gain appliquée sur les pistes par les 
plug-ins de type expanseur/gate.

Priority Compressor/Limiter : lorsque cette option 
est sélectionnée, l'indicateur affiche uniquement la 
réduction de gain appliquée par les plug-ins de ce 
type, lorsqu'un compresseur/limiteur est inséré sur 
la piste. Toutefois, si aucun plug-in de type 
compresseur/limiteur n'est inséré, toute réduction 
de gain appliquée par un plug-in de traitement 
dynamique d'un autre type est affichée sur 
l'indicateur.

Priority Expander/Gate : lorsque cette option est 
sélectionnée, l'indicateur affiche uniquement la 
réduction de gain appliquée par les plug-ins de ce 
type, lorsqu'un expanseur/gate est inséré sur la 
piste. Toutefois, si aucun plug-in de type 
expanseur/gate n'est inséré, toute réduction de gain 
appliquée par un plug-in de traitement dynamique 
d'un autre type est affichée sur l'indicateur.
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All – Summed : lorsque cette option est 
sélectionnée, l'indicateur affiche la somme de toutes 
les réductions de gain appliquées par les plug-ins de 
traitement dynamique insérés sur la piste.

Préférences de traitement

Section AudioSuite

Default Handle Length

Les options Default Handle Length définissent la 
durée par défaut des poignées AudioSuite et de 
gain du clip.

Whole File : lorsque cette option est activée, 
le calcul d'un rendu AudioSuite ou de gain du clip 
prend en compte le fichier entier référencé par la 
sélection ou le clip. 

Length : ce paramètre spécifie la durée par défaut 
(de 0 à 60 secondes) des poignées générées lors 
d'un rendu AudioSuite ou de gain du clip. Lors 
du rendu AudioSuite ou de gain du clip d'une 
sélection, une portion supplémentaire d'audio est 
ajoutée, correspondant à la durée de marge 
spécifiée.

Section Import
Convert Imported “WAV” Files To 
AES31/BroadcastWave : lorsque cette option est 
sélectionnée, tous les nouveaux fichiers .WAV 
importés sont conformes à la norme broadcast 
AES31/EBU.

Automatically Copy Files on Import : lorsque 
cette option est sélectionnée, tous les fichiers audio 
importés par glisser-déposer sont copiés dans le 
dossier Audio Files de la session, qu'ils aient 
besoin ou non d'être convertis vers le type de 
fichier, la résolution ou la fréquence 
d'échantillonnage de la session actuelle. De plus, 
si cette option est sélectionnée, l'option Copy from 

Source Media est automatiquement activée dans la 
boîte de dialogue Import Session Data. 
La préférence Automatically Copy Files on Import 
n'affecte pas la commande Import Audio.

Convert Copied Files to Session Format : 
lorsque cette option est activée, les fichiers dont le 
format est différent de celui spécifié pour la 
session actuelle sont copiés puis convertis lors de 
l'importation au format de fichier de la session. 
Par exemple, si le format de fichier de la session 
est WAV et que vous importer un fichier AIF, il 
sera copié puis converti lors de l'importation au 
format WAV. Lorsque cette option n'est pas 
sélectionnée, les fichiers copiés conservent leur 
format d'origine (sauf si ce format de fichier n'est 
pas compatible avec Pro Tools, dans ce cas ils sont 
convertis).

Do Not Convert Sample Rate on Import : lorsque 
cette option est sélectionnée, les fichiers dont la 
fréquence d'échantillonnage est différente de celle 
de la session ne sont pas automatiquement 
convertis lors de leur importation dans la session. 
Cela signifie que les fichiers dont la fréquence 
d'échantillonnage ne correspond pas seront lus 
à une vitesse et à une hauteur différentes de celles 
de l'enregistrement d'origine.
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Import REX Files as Clip Groups : lorsque cette 
option est sélectionnée, les fichiers REX sont 
importés en tant que groupes de clips et toutes les 
tranches sous-jacentes sont importées en tant que 
clips individuels au sein du groupe de clips. Lorsque 
cette option n'est pas sélectionnée, les fichiers REX 
importés dans une session sont convertis au format 
de fichier audio de la session, les tranches 
individuelles sont consolidées et les informations 
des tranches sont utilisées pour l'analyse Elastic 
Audio. Ces fichiers restent basés sur les références 
de tempo après importation et conversion. 

Automatically Create Fades : lorsque cette option 
est sélectionnée, les fondus enchaînés sont 
appliqués automatiquement aux clips découpés en 
tranches faisant partie d'un groupe de clips et créés 
lors de l'importation des fichiers REX. Si l'option 
Import REX Files as Clip Groups n'est pas 
sélectionnée, l'option Automatically Create Fades 
n'est pas disponible. 

Pour modifier les réglages de fondu par défaut des 
fichiers REX, cliquez sur le bouton REX dans la 
section Default Fade Settings de la page des 
préférences d'édition.

Drag and Drop From Desktop Conforms to 
Session Tempo

Les options Drag and Drop From Desktop 

Conforms to Session Tempo déterminent si les 
fichiers REX, ACID et audio doivent être importés 
en tant que fichiers Elastic Audio basés sur des 
références de tempo et synchronisés avec le tempo 
de la session.

No Files : si cette option est activée, les fichiers 
REX et ACID et tous les autres fichiers audio ne 
sont pas conformés au tempo de la session 
lorsqu'ils sont importés par glisser-déposer à partir 
de l'Explorateur Windows ou du Finder Mac. Ils 
sont importés en tant que fichiers basés sur les 
échantillons et convertis au format de fichier audio 
des sessions.

REX and ACID Files Only : si cette option est 
activée, seuls les fichiers REX et ACID sont 
conformés au tempo de la session lorsqu'ils sont 
importés par glisser-déposer à partir de 
l'Explorateur Windows ou du Finder Mac. Les 
fichiers REX sont importés en tant que fichiers 
Elastic Audio basés sur les références de tempo ou, 
si l'option Import REX Files as Clip Groups est 
activée, en tant que groupes de clips basés sur les 
références de tempo. 

All Files : lorsque cette option est sélectionnée, 
tous les fichiers audio (y compris les fichiers REX 
et ACID) importés par glisser-déposer à partir de 
l'Explorateur Windows ou du Finder Mac sont 
importés en tant que fichiers Elastic Audio basés 
sur des références de tempo et sont conformés au 
tempo de la session.

Sample Rate Conversion Quality

Le menu déroulant Sample Rate Conversion 

Quality permet de sélectionner la qualité par défaut 
de conversion de la fréquence d'échantillonnage 
pour l'importation des fichiers audio par glisser-
déposer à partir d'un navigateur de l'espace de 
travail, de l'Explorateur Windows ou du Finder 
Mac. Plus la qualité de conversion de la fréquence 
d'échantillonnage est élevée, plus le traitement du 
fichier audio dans Pro Tools est lent.

Section TC/E (Time 
Compression/Expansion)
TC/E Plug-In : permet de sélectionner le plug-in 
utilisé pour la compression et l'extension 
temporelle lors de l'édition audio à l'aide de l'outil 
de trim TCE. Cet outil de trim applique une 
compression/expansion temporelle pour faire 
correspondre la durée d'un clip audio à celle d'un 
autre clip, à une grille de tempo, à une scène vidéo 
ou à tout autre point de référence. Le plug-in Time 
Shift est sélectionné par défaut.
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Default Settings : spécifie les paramètres par 
défaut du plug-in TCE sélectionné.

Section Elastic Audio
Ces préférences déterminent l'utilisation et les 
paramètres du traitement Elastic Audio avec les 
nouvelles pistes, ainsi que l'aperçu et l'importation 
des données audio basées sur des références de 
tempo.

Default Plug-In : permet de sélectionner n'importe 
quel plug-in Elastic Audio en temps réel comme 
plug-in par défaut pour l'aperçu et l'importation 
des données Elastic Audio. Le plug-in Elastic 
Audio sélectionné comme plug-in par défaut est 
également utilisé lorsque de nouvelles pistes sont 
créées avec l'option Enable Elastic Audio on New 

Tracks activée. 

Default Input Gain : permet d'atténuer le gain 
d'entrée du signal envoyé aux plug-ins Elastic 
Audio pour l'aperçu et l'importation, de 0 à 6 dB. 
Si le traitement Elastic Audio provoque un 
écrêtage lors d'un aperçu ou à la suite d'une 
importation, vous pouvez ajuster le paramètre 
Default Input Gain de façon à atténuer légèrement 
le gain d'entrée du signal audio traité par Elastic 
Audio. Cette préférence s'appliquera à toute 
donnée audio importée sur une piste Elastic Audio.

La fenêtre Elastic Properties hérite du paramètre 
Default Input Gain. Pour atténuer davantage le gain 
d'entrée d'un clip spécifique pour le traitement 
Elastic Audio, sélectionnez le clip et ajustez le 
paramètre Input Gain dans la fenêtre Elastic 
Properties (reportez-vous à la section « Fenêtre 
Elastic Properties » à la page 930).

Enable Elastic Audio on New Tracks : lorsque 
cette option est sélectionnée, le traitement Elastic 
Audio est activé sur les nouvelles pistes créées. 
Le plug-in Elastic Audio sélectionné comme plug-
in par défaut est utilisé.

Section DSP Management
(Systèmes Pro Tools|HDX uniquement)

Ces préférences déterminent comment sont gérées 
les ressources DSP pour la conversion des plug-ins 
DSP au format Native et l'utilisation de l'option 
logicielle HEAT.

Open Unresourced DSP Plug-Ins as Native : 
lorsque cette option est activée, tous les plug-ins 
DSP qui ne disposent pas de suffisamment de 
ressources de traitement DSP sont convertis au 
format Native dès que possible. Lorsque cette 
option est désactivée, les plug-ins DSP qui 
dépassent la limite de traitement DSP disponible 
sont désactivés. 

Enable HEAT in New Sessions (Systèmes 
Pro Tools|HDX uniquement) : lorsque cette option 
est activée, les nouvelles sessions sont créées avec 
l'option HEAT activée sur toutes les pistes audio. 
Lorsqu'elle est désactivée, l'option HEAT est 
désactivée par défaut dans les nouvelles sessions. 
Cette option est disponible uniquement lorsque 
l'option logicielle HEAT est installée. Pour plus 
d'informations, reportez-vous au Guide de l'option 
logicielle HEAT.

Si l'option Enable Elastic Audio on New 
Tracks est sélectionnée, il peut être conseillé 
de sélectionner l'option New Tracks Default 
to Tick Timebase de la page des préférences 
d'édition.
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Préférences MIDI

Section Basics
Remove Range Selection After Opening the 
MIDI/Score Editor : lorsque cette option est 
sélectionnée, la sélection d'édition est perdue 
lorsque l'éditeur MIDI ou l'éditeur de partition 
s'ouvre. Lorsqu'elle est désactivée, la sélection 
d'édition actuelle est conservée.

Use MIDI to Tap Tempo : lorsque cette option est 
sélectionnée, vous pouvez battre le tempo sur un 
contrôleur MIDI afin de saisir une nouvelle valeur 
de tempo dans le champ du tempo.

Display Events as Modified by Real-Time 
Properties : lorsque cette option est activée, 
Pro Tools affiche les effets des propriétés en temps 
réel dans les fenêtres Edit, de l'éditeur MIDI et de 
l'éditeur de partition, ainsi que dans la liste des 
événements MIDI.

Use F11 Key for Wait for Note : lorsque cette 
option est sélectionnée, la touche de fonction F11 
permet d'activer le mode Wait for Note pour 
l'enregistrement MIDI. 

Automatically Create Click Track in New 
Sessions : lorsque cette option est activée, 
Pro Tools crée automatiquement une piste de clic 
dans les nouvelles sessions.

Default Thru Instrument

Cette option permet de définir l'instrument MIDI 
Thru par défaut. Vous pouvez sélectionner un 
périphérique prédéfini à partir des instruments 
MIDI disponibles ou choisir First Selected MIDI 

Track pour utiliser la sortie MIDI assignée de la 
première piste MIDI ou d'instrument sélectionnée. 
En cas de sélection de plusieurs pistes MIDI ou 
d'instrument, c'est l'instrument de la piste 
sélectionnée qui est la plus proche du haut de la 
fenêtre Edit (ou du bord gauche de la fenêtre Mix) 
qui est utilisé. Sélectionnez None pour assigner 
uniquement les pistes MIDI et d'instrument sur 
lesquelles l'enregistrement MIDI Thru est activé.

Pencil Tool Resolution When Drawing 
Controller Data

Cette option définit la résolution par défaut des 
données de contrôleur MIDI créées avec le 
Crayon. Le choix d'une valeur de résolution 
modérée évite la création de données de contrôleur 
inutilement denses. Ce paramètre est réglable entre 
1 et 100 millisecondes.

Global MIDI Playback Offset

Cette option permet de définir un décalage en 
échantillons pour compenser la latence MIDI. 
La saisie d'une valeur dans cette zone donne le 
même résultat que la configuration d'un décalage 
avec la commande MIDI Track Offsets. Les valeurs 
de décalage peuvent être positives (pour appliquer 
un retard) ou négatives (pour avancer). 

Double-Clicking a MIDI Clip Opens

Cette option permet de spécifier l'action à effectuer 
lorsque vous double-cliquez sur des clips MIDI 
à l'aide de la Main. 
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MIDI Editor : ouvre le clip MIDI dans une fenêtre 
de l'éditeur MIDI.

Score Editor : ouvre le clip MIDI dans une fenêtre 
de l'éditeur de partition.

MIDI Event List : ouvre le clip MIDI dans la liste 
des événements MIDI.

Name Dialog : ouvre la boîte de dialogue Name 
pour le clip MIDI.

Options Note Display
Ces options définissent la référence du do central 
sur la note C3, C4 ou la note MIDI numéro 60.

Options Delay Compensation for 
External Devices
Ces options s'appliquent uniquement lorsqu'un 
moteur de compensation du délai (Delay 

Compensation Engine) est sélectionné dans le 
moteur de lecture et que l'option Delay 

Compensation est activée dans Pro Tools. Elles 
agissent indépendamment des décalages 
disponibles pour les inserts matériels dans la boîte 
de dialogue I/O Setup.

MIDI Timecode : lorsque cette option est 
sélectionnée, Pro Tools applique la compensation 
du délai au timecode MIDI (MTC) généré par 
Pro Tools. Activez cette option pour synchroniser 
la vidéo avec Pro Tools à l'aide d'un timecode 
MIDI (MTC).

MIDI Beat Clock : lorsque cette option est 
sélectionnée, Pro Tools applique la compensation 
du délai au MIDI Beat Clock généré par Pro Tools.

MIDI Notes and Controllers : lorsque cette option 
est sélectionnée, Pro Tools applique la 
compensation du délai aux notes MIDI et aux 
données de contrôleur MIDI. Elle est utile pour le 
monitoring en lecture ou lors de l'enregistrement 
à partir de périphériques MIDI externes.

MIDI/Score Editor Display

Additional Empty Bars in the Score Editor

Ce paramètre permet de spécifier le nombre par 
défaut de mesures vides qui apparaissent dans la 
fenêtre de l'éditeur de partition à la suite du dernier 
clip MIDI de la session.

Préférences de 
synchronisation

Section Machine Control
Machine Chases Memory Location : lorsque cette 
option est sélectionnée, la navigation vers un 
emplacement spécifique d'une session à l'aide d'un 
emplacement mémoire entraîne un transport 
connecté à se caler sur cet emplacement.

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, la recherche d'un 
emplacement spécifique dans une session par 
déplacement du point de sélection ou scrubbing sur 
une piste fait suivre un transport connecté, qui se 
cale aussi sur cet emplacement.
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Lorsque le périphérique connecté est de type 
linéaire (tel qu'un magnétophone), sélectionnez 
Linear Devices (jog) afin que Pro Tools envoie des 
commandes jog.

Lorsque le périphérique connecté est de type non 
linéaire (tel qu'un enregistreur vidéo à accès 
aléatoire ou un autre système Pro Tools), 
sélectionnez Non-Linear Devices (cue) afin que 
Pro Tools envoie des commandes de calage.

Machine Cues Intelligently (Systèmes 
Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : lorsque cette option est sélectionnée, 
si vous accédez à un point situé à plus de 
10 secondes de la position actuelle, Pro Tools 
ordonne au transport connecté d'accéder au nouvel 
emplacement en avance rapide jusqu'à 10 secondes 
avant le point demandé. L'avance rapide ralentit 
alors et la lecture se poursuit en vitesse normale 
jusqu'au point sélectionné. Ce processus accélère 
considérablement l'avance rapide sur les bandes 
avec certains transports vidéo.

Stop at Shuttle Speed Zero (Systèmes 
Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : provoque l'envoi d'une commande 
Stop par Pro Tools chaque fois que vous arrêtez 
une opération de shuttle. Cette fonction est utile si 
le périphérique requiert une commande Stop 
explicite pour se caler correctement. 

Non-Linear Transport Error Suppression 
(Systèmes Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : lorsque Transport = Pro Tools, 
cette option empêche Pro Tools d'envoyer une 
commande Stop lorsqu'il passe offline. Cela 
empêche également Pro Tools d'arrêter les autres 
périphériques 9 broches connectés au système.

Section Synchronization
Minimum Sync Delay : définit la durée initiale 
(en images) nécessaire à la synchronisation des 
différents périphériques composant votre système. 
Cette durée est différente pour chaque 
périphérique. Pour régler le délai de 
synchronisation dans Pro Tools, saisissez une 
valeur dans le champ Minimum Sync Delay de la 
page Synchronization, dans la boîte de dialogue 
Preferences. La valeur minimale disponible est de 
15 images. Déterminez la valeur minimale de délai 
de synchronisation pour votre système, puis 
saisissez cette valeur dans la zone Minimum Sync 

Delay. Sur les systèmes avec option 
MachineControl, l'activation de l'option Use Serial 

Time Code accélère considérablement 
l'établissement de la synchronisation des 
périphériques. Le timecode série requiert à la fois 
un périphérique de synchronisation qualifié et des 
périphériques externes synchronisés sur une 
référence vidéo commune.

Delay Before Locking to Longitudinal Timecode 
(Systèmes Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : définit le délai (en images) requis 
par Pro Tools pour établir la synchronisation avec 
un timecode LTC entrant. Utilisez cette option 
lorsque la synchronisation de Pro Tools est établie 
sur une source de timecode stable (telle qu'un 
périphérique à bande non linéaire ou un générateur 
de LTC) plutôt que sur un périphérique à bande 
linéaire.

Delay Before Locking to Serial Timecode 
(Systèmes Pro Tools|HDX et Pro Tools|HD Native 
uniquement) : définit le délai (en images) pendant 
lequel Pro Tools doit patienter avant de tenter de se 
synchroniser sur des périphériques envoyant des 
messages de servoverrouillage. Ce paramètre 
permet aux servomécanismes d'atteindre un 
verrouillage stable.
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Section Remote Mode
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native uniquement)

Ignore Track Arming : configure Pro Tools pour 
qu'il ignore les commandes d'armement de piste 
(activation pour l'enregistrement) entrantes. Cette 
fonction est utile si vous souhaitez utiliser un 
contrôleur principal pour armer des pistes sur 
d'autres périphériques, sans armer les pistes dans 
Pro Tools.

Set Servo Lock Bit at Play : activez cette option 
lorsque vous utilisez un synchroniseur pour 
contrôler Pro Tools en mode Remote afin de 
minimiser les temps de verrouillage lors de 
l'enregistrement.

Allow 9-Pin Track Arm Commands in Local 
Mode : permet à Pro Tools de répondre aux 
commandes d'armement de piste (activation pour 
l'enregistrement) entrantes même lorsque le 
système n'est pas en mode Remote. Cette option 
est utile si vous utilisez un périphérique de 
commande pour contrôler l'armement des pistes et 
l'activation de l'enregistrement en punch-in/out 
dans Pro Tools. 

Allow 9-Pin Transport Commands in Local 
Mode : permet à Pro Tools de répondre aux 
commandes de transport entrantes même lorsque 
le système n'est pas en mode Remote. Cette option 
est utile lors de l'utilisation conjointe de Satellite 
Link et d'un contrôleur 9 broches. Les commandes 
de transport peuvent être reçues à partir du 
contrôleur 9 broches, sans le lag associé aux 
périphériques 9 broches.

Punch In Frame Offset : cette option définit un 
décalage (exprimé en images) visant à compenser 
l'avance ou le retard des opérations de punch-in.

Punch Out Frame Offset : cette option définit un 
décalage (exprimé en images) visant à compenser 
l'avance ou le retard des opérations de punch-out.

Delay After Play Command : définit le délai 
(en images) pendant lequel Pro Tools doit 
patienter entre la réception d'une commande de 
lecture et le démarrage du moteur audio. Cette 
option permet d'éviter les démarrages non 
souhaités lors du verrouillage sur des 
synchroniseurs dont la prise en charge n'est pas 
entièrement assurée par Pro Tools.

Section Satellites
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native uniquement)

Satellite Link permet de relier jusqu'à 12 systèmes 
Pro Tools HD, ou 11 systèmes Pro Tools HD et un 
système Avid Video Satellite (Media Composer ou 
Avid Symphony Nitris DX®) ou un système Video 
Satellite Pro Tools, via un réseau Ethernet afin de 
contrôler les commandes de transport (lecture, 
arrêt et calage), de créer des sélections de lecture et 
de placer des pistes en solo sur tous les systèmes, 
à partir de n'importe quelle station de travail 
connectée.

Transmit Solos : configure un système Pro Tools 
relié pour qu'il envoie l'état solo de ses pistes à tous 
les autres systèmes Pro Tools reliés. Sur les autres 
systèmes reliés configurés pour recevoir l'état des 
solos, les pistes suivent le comportement de lecture 
en solo comme si les solos étaient activés sur le 
système local. 

Receive Solos : configure un système Pro Tools 
relié pour qu'il reçoive l'état des solos de tous les 
autres systèmes Pro Tools reliés et configurés pour 
transmettre l'état solo de leurs pistes. Les pistes du 
système de destination suivent le comportement de 
lecture en solo, comme si les solos étaient activés 
sur le système local. 
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Solo Independent of Linked State : configure un 
système Pro Tools pour qu'il envoie l'état solo de 
ses pistes aux autres systèmes satellites, même s'ils 
ne sont pas reliés. Cette fonction permet de 
consulter l'état des commandes solo des systèmes 
même si le contrôle du transport n'est pas activé. 

AAE Errors Stop All Linked Systems : permet 
d'arrêter le transport sur tous les systèmes reliés 
lorsqu'une erreur AAE se produit sur l'un des 
systèmes Pro Tools reliés. Lorsque cette option 
n'est pas sélectionnée, les systèmes reliés ne 
s'arrêtent pas lorsqu'une erreur AAE se produit sur 
l'un des systèmes. 

Transmit Play Selections : configure un système 
Pro Tools relié pour qu'il communique la sélection 
de la fenêtre Edit à tous les autres systèmes 
Pro Tools reliés. Sur les autres systèmes reliés 
paramétrés pour recevoir des sélections de lecture, 
la sélection est reflétée dans la fenêtre Edit.

Receive Play Selections : configure un système 
Pro Tools relié pour qu'il reçoive les sélections de 
la fenêtre Edit de tous les autres systèmes 
Pro Tools reliés configurés pour communiquer les 
sélections de lecture.

Préférences globales et 
locales
Les préférences de Pro Tools peuvent être globales 
(elles s'appliquent à l'ensemble du système) ou 
locales (elles s'appliquent uniquement à la session 
actuelle). 

Préférences globales (s'appliquent au système 
complet) : les préférences globales s'appliquent 
à toutes les sessions. Elles deviennent les 
préférences par défaut pour toutes les sessions 
existantes que vous ouvrez par la suite ou pour 
toute nouvelle session.

Préférences locales (s'appliquent à la session 
ouverte) : les préférences locales s'appliquent à la 
session actuellement ouverte (le cas échéant). Elles 
ne s'appliquent pas aux sessions ouvertes par la 
suite.

Préférences et nouvelles sessions

Les nouvelles sessions utilisent les préférences 
globales, ainsi que les préférences locales les plus 
récentes. Les paramètres locaux les plus récents 
sont ceux utilisés pour la dernière session ouverte 
(à moins que des modifications n'aient été 
effectuées ultérieurement dans la boîte de dialogue 
Preferences à partir de la fenêtre de l'application).

Préférences locales 
(s'appliquent uniquement à la 
session)
Toutes les préférences sont globales et s'appliquent 
au système, à l'exception des préférences locales 
suivantes :

• Préférences d'affichage

• Edit Window Default Length

• Always Display Marker Colors

• Options Default Track Color Coding

• Options Default Clip Color Coding
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• Préférences de fonctionnement

• Custom Shuttle Lock Speed

• Back/Forward Amount (Pro Tools HD 
uniquement)

• PEC/Direct Style Input Monitoring 
(Pro Tools HD uniquement)

• DestructivePunch File Length (Pro Tools HD 
uniquement)

• Clip Auto Fade In/Out Length (Pro Tools HD 
uniquement)

• Delay Comp Time Mode

• Compensate Side Chains (systèmes 
Pro Tools|HDX uniquement)

• Préférences d'édition

• Aucune

• Préférences de mixage

• Coalesce when Removing Slaves from VCA 
Group (Pro Tools HD uniquement)

• Préférences de mesure des niveaux

• Aucune

• Préférences de traitement

• Convert Imported « WAV » Files To 
AES31/BroadcastWave

• Préférences MIDI

• Display Events as Modified by Real-Time 
Properties

• Automatically Create Click Track in New 
Sessions

• Default Thru Instrument

• Pencil Tool Resolution When Drawing 
Controller Data

• Options Delay for External Devices

• Préférences de synchronisation

• Aucune
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Chapitre 9 : Périphériques

Les paramètres de la boîte de dialogue Peripherals 
définissent la manière dont Pro Tools 
fonctionne avec différents périphériques audio, 
de synchronisation et contrôleurs, ainsi qu'avec les 
systèmes VENUE.

Pour configurer les paramètres des périphériques 
de Pro Tools :

1 Sélectionnez Setup > Peripherals.

2 Cliquez sur l'onglet correspondant au type de 
périphérique à configurer. 

3 Configurez les paramètres.

4 Cliquez sur OK pour enregistrer les 
modifications et fermer la boîte de dialogue 
Peripherals.

Synchronisation
La page Synchronization permet de configurer 
Pro Tools pour l'utilisation d'un timecode MIDI et 
d'un périphérique de synchronisation.

MTC Reader et MTC Generator
Les paramètres de timecode MIDI (MTC) 
permettent de sélectionner les ports d'entrée et de 
sortie MIDI pour le MTC.

MTC Reader Port : le paramètre MTC Reader Port 
permet de sélectionner le port d'entrée MIDI 
auquel le périphérique esclave MTC est connecté 
(la source des informations MTC provenant du 
périphérique esclave). 

MTC Generator Port : le paramètre MTC 

Generator Port permet de sélectionner le port de 
sortie MIDI auquel le périphérique maître est 
connecté (la destination des informations MTC 
provenant de Pro Tools).

Pour plus d'informations sur les 
périphériques de synchronisation, 
reportez-vous au Guide SYNC HD.
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Synchronization Device
(Systèmes Avid HDX et HD Native uniquement)

Les paramètres Synchronization Device 
permettent de configurer un périphérique de 
synchronisation, tel qu'une SYNC HD.

Enable SYNC Peripheral

Lorsque cette option est sélectionnée, tous les 
périphériques de synchronisation connectés sont 
activés pour être utilisés avec Pro Tools.

Current Firmware Version

Cette option affiche la version du firmware du 
périphérique de synchronisation connecté, 
tel qu'une SYNC HD.

VITC Insertion Enabled

Lorsque cette option est sélectionnée, le VITC est 
inséré dans le signal vidéo sortant, en supposant 
qu'un signal vidéo est présent sur l'entrée vidéo 
d'un périphérique de synchronisation et que son 
mode autorise l'insertion de VITC. 

Pitch Memory Enabled

Lorsque cette option est sélectionnée, 
le périphérique de synchronisation reste fixé sur 
une hauteur (fréquence d'échantillonnage) qui 
correspond à la dernière vitesse connue du timecode 
entrant. Si elle est désactivée, le périphérique 
de synchronisation revient à la fréquence 
d'échantillonnage sélectionnée. Si l'option Pitch 
Memory est désactivée et si l'horloge de référence 
externe sélectionnée n'est pas disponible, 
le périphérique de synchronisation revient au 
réglage de la fréquence d'échantillonnage nominale 
interne sélectionnée.

Idle MTC Enabled

Lorsque cette option est sélectionnée, le timecode 
MIDI est émis de façon continue. Lorsque cette 
option est désactivée, la sortie MTC est mutée 
lorsque la lecture est à l'arrêt.

LTC Output Level

Ce paramètre permet d'ajuster le niveau audio 
analogique de la sortie LTC, de -24 dBu à +9 dBu.

VITC Read Lines

Ce paramètre détermine la paire de lignes du signal 
vidéo entrant utilisée comme source du VITC. 
Lorsque la valeur Auto est affichée, 
le périphérique de synchronisation recherche 
automatiquement la première paire de lignes 
valide. Cette valeur peut également correspondre 
à des paires de lignes spécifiques du VITC.

VITC Generate Lines

Ce paramètre détermine la paire de lignes du signal 
vidéo sortant sur laquelle le périphérique de 
synchronisation insère le VITC. Le réglage par 
défaut (et conseillé) de 14/16 doit normalement 
être conservé. 

Bi-Phase/Tach Wiring

Ce paramètre permet de choisir les options 
suivantes de câblage Bi-Phase ou Tach :

• Biphase : FWD = A leads B

• Biphase : FWD = B leads A

• Tach : FWD = B is Low

• Tach : FWD = B is High
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Bi-Phase/Tach Pulses/Frame (2-254)

Il existe différentes normes pour le nombre 
d'impulsions par image émises par les appareils 
utilisant un signal biphasé ou tachymétrique. Vous 
pouvez configurer le périphérique de 
synchronisation dans Pro Tools pour qu'il 
fonctionne avec 2 à 254 impulsions par image. 
Ce paramètre doit correspondre au nombre 
d'impulsions par image de l'encodeur Bi-
Phase/Tach du périphérique externe.

Reset Bi-Phase

Ce bouton permet de définir l'image de début Bi-
Phase/Tach à partir de Pro Tools. Cliquez sur le 
bouton pour actualiser l'affichage du timecode sur 
le périphérique de synchronisation afin qu'il 
corresponde à la valeur de timecode de la session.

Enable Dub Window

Cette option permet d'insérer une fenêtre de 
timecode dans un signal vidéo avec les paramètres 
d'incrustation suivants : 

Vertical Position : définit la position verticale de 
la fenêtre d'incrustation par rapport au bas de 
l'image vidéo. Les valeurs possibles vont de 10 % 
From Bottom (à partir du bas) à 50 % From 
Bottom, par incrément de 10 %.

Horizontal Position : définit la position 
horizontale relative de la fenêtre d'incrustation 
dans l'image vidéo. Les options sont Extreme Left, 
Left, Center, Right et Extreme Right.

Size : définit la taille relative de la fenêtre 
d'incrustation. Les options sont Small et Large.

Color : définit la couleur des chiffres de timecode 
et de l'arrière-plan de la fenêtre d'incrustation. 
Les options sont : White on Black Bkgnd (blanc 
sur fond noir), Black on White Bkgnd (noir sur 
fond blanc), White on Video Bkgnd (blanc sur 
fond vidéo) et Black on Video Bkgnd (noir sur 
fond vidéo). Fond vidéo signifie que l'arrière-plan 
de la fenêtre d'incrustation est transparent, les 
chiffres du timecode sont directement affichés sur 
l'image vidéo, sans contraste avec l'arrière-plan. 
Le réglage par défaut est White on Black Bkgnd.

Machine Control
La page Machine Control permet de configurer 
Pro Tools pour le contrôle de périphériques MIDI 
ou 9 broches.

La position verticale 10 % From Bottom se 
trouve en dehors de la zone standard 
d'image. La fenêtre peut donc ne pas être 
visible sur certains moniteurs vidéo.

Les positions horizontales Extreme Left et 
Extreme Right se trouvent en dehors de la 
zone standard d'affichage. La fenêtre peut 
donc ne pas être visible sur certains 
moniteurs vidéo.

Pour plus d'informations sur l'option 
logicielle MachineControl pour Pro Tools, 
reportez-vous au Guide MachineControl.
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MIDI Machine Control (Master)
Pro Tools propose les options suivantes de 
configuration du contrôle de périphériques MIDI 
(maître).

Enable

Lorsque l'option Enable est sélectionnée, 
Pro Tools est utilisé comme maître. Il envoie alors 
des commandes MMC au périphérique esclave et 
reçoit des informations MTC de ce périphérique.

MIDI Out Port

Le menu déroulant MIDI Out Port permet de 
sélectionner le port de sortie MIDI auquel le 
périphérique esclave est connecté.

MMC ID

Le paramètre MMC ID permet de spécifier le 
numéro d'identification MMC pour lequel des 
informations MMC sont envoyées. 
Les commandes MMC contiennent le numéro 
d'identification du périphérique qui doit répondre 
à ces commandes. Il existe 128 numéros 
d'identification MMC, de 0 à 127. Le numéro 
d'identification par défaut 127 est un paramètre 
spécial permettant de transmettre les données à la 
totalité des 128 identifiants MMC. Lorsque vous 
désignez le numéro 127, Pro Tools transmet les 
commandes MMC à tous les identifiants MMC. 

Preroll

Le paramètre Preroll permet de spécifier une durée 
de pré-roll en images pour le périphérique esclave 
MMC. Le pré-roll permet au périphérique de 
disposer de suffisamment de temps pour se 
synchroniser au timecode transmis par Pro Tools. 
Cette durée est variable selon le périphérique 
externe. Si la durée de pré-roll est insuffisante, 
le périphérique n'aura peut-être pas le temps de se 
synchroniser avant que la position de timecode 
souhaitée ne soit atteinte.

MIDI Machine Control (Slave)
Pro Tools propose les options suivantes de 
configuration du contrôle de périphériques MIDI 
(esclaves).

Enable

Lorsque l'option Enable est sélectionnée, 
Pro Tools est utilisé comme esclave. Il reçoit alors 
des commandes MMC du périphérique maître et 
renvoie des informations MTC au périphérique 
esclave.

MMC ID

Le paramètre MMC ID permet de spécifier le 
numéro d'identification MMC pour lequel des 
informations MMC sont reçues.

9-Pin Machine Control (Deck 
Control)
(Systèmes Pro Tools|HDX et 
Pro Tools|HD Native avec MachineControl 
uniquement)

Les paramètres 9-Pin Machine Control (Deck 

Control) permettent de configurer un périphérique 
de contrôle en mode Serial Deck Control avec 
Pro Tools. Le mode Serial Deck Control est 
disponible lorsque le périphérique de contrôle 
est connecté à l'aide du câble Serial Deck Control. 
Lorsqu'il est connecté en mode Serial Deck 
Control, le périphérique de contrôle active 
toutes les fonctions d'armement de piste, 
de synchronisation et de transport de Pro Tools, 
en fonction de leur disponibilité sur le système. 
Le mode Serial Deck Control prend également en 
charge le timecode série 9 broches.

Enable

Lorsque l'option Enable est sélectionnée, 
Pro Tools est en mode Serial Deck Control.



Chapitre 9 : Périphériques 137

Port

Le paramètre Port permet de sélectionner le port du 
périphérique de contrôle 9 broches. Les choix 
disponibles dépendent de la plateforme et de la 
configuration.

Machine Type

Une fois le port sélectionné, Pro Tools interroge 
automatiquement le port pour détecter le type de 
périphérique connecté. Si le périphérique est 
reconnu, Pro Tools charge le modèle Machine Type 
correspondant. Ce modèle inclut la disposition des 
pistes correspondante et fait apparaître 
automatiquement le nom de cette machine dans la 
fenêtre Machine Track Arming. Cependant, si le 
périphérique n'est pas reconnu, le modèle 
« Generic 1 » est automatiquement chargé. 

Preroll

Le paramètre Preroll permet de spécifier une durée 
de pré-roll variable qui équivaut au temps 
nécessaire au périphérique pour établir le 
servoverrouillage. Les valeurs de pré-roll basses 
sont généralement recommandées pour les 
périphériques non linéaires. Les valeurs de pré-roll 
élevées sont généralement recommandées pour les 
transports à bande plus anciens. La valeur de pré-
roll du périphérique est ajoutée à tout pré-roll 
défini dans la fenêtre de transport.

9-Pin Remote (Deck Emulation)
(Systèmes Pro Tools|HDX et Pro Tools|HD Native 
avec MachineControl uniquement)

Les paramètres 9-Pin Remote (Deck Emulation) 
permettent de configurer Pro Tools pour le mode 
9-Pin Remote (Deck Emulation). Ce mode 
permet à Pro Tools de fonctionner comme un 
magnétophone virtuel, prenant en charge la plupart 
des commandes 9 broches Sony P2 standard. Par 
défaut, Pro Tools émule le magnétoscope Sony 
BVW-75. Vous pouvez également configurer 
Pro Tools pour qu'il émule d'autres périphériques.

Enable

Lorsque l'option Enable est sélectionnée, Pro Tools 
est en mode 9-Pin Remote (Deck Emulation).

Port

Le paramètre Port permet de sélectionner le port du 
périphérique de contrôle 9 broches. Les choix 
disponibles dépendent de la plateforme et de la 
configuration.

Machine Type

Le paramètre Machine Type permet de 
sélectionner la description de périphérique pour 
des contrôleurs spécifiques (tels que Soundmaster 
ATOM). Par défaut, Pro Tools émule un 
magnétoscope Sony BVW-75. 

Chase LTC

Lorsque l'option Chase LTC est activée, Pro Tools 
continue de répondre aux commandes d'armement 
de piste et d'enregistrement. Cependant, Pro Tools 
suit le timecode longitudinal (LTC) entrant au lieu 
de se comporter comme maître ou esclave du 
périphérique. Asservir Pro Tools à la source de 
LTC au lieu d'asservir le périphérique au timecode 
de Pro Tools permet d'éviter l'attente (et l'usure de 
la bande) se produisant lorsque la machine doit 
localiser un repère sélectionné et positionner la 
bande à cet endroit en avance rapide. 
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MIDI Controllers
La page MIDI Controllers permet de configurer 
jusqu'à 4 contrôleurs MIDI différents pour Pro Tools.

Numéros et couleurs

Le numéro de la ligne indique l'ordre des 
contrôleurs sélectionnés. La couleur correspond au 
focus du contrôleur affiché autour des commandes 
de piste et de plug-in de Pro Tools.

Type

Le paramètre Type permet de sélectionner le 
contrôleur MIDI connecté à votre ordinateur. 
Sélectionnez l'un des types de contrôleurs MIDI 
suivants :

• Command|8

• HUI

• Surround Panner

• M-Audio Keyboard

Receive From

Le paramètre Receive From permet de sélectionner 
le port d'entrée MIDI auquel le contrôleur MIDI 
est connecté.

Send To

Le paramètre Send To permet de sélectionner le 
port de sortie MIDI auquel le contrôleur MIDI est 
connecté.

Nombre de canaux

Le nombre de canaux (# Ch's) affiche le nombre de 
canaux de contrôle pris en charge par le type de 
contrôleur MIDI sélectionné.

Ethernet Controllers
La page Ethernet Controllers permet de configurer 
jusqu'à 7 contrôleurs Ethernet différents pour 
Pro Tools.

Enable

Lorsque cette option est sélectionnée, le contrôle 
de Pro Tools par un ou plusieurs contrôleurs 
Ethernet (tels qu'une D-Command ou une C|24) est 
activé.

Ethernet Port

Le paramètre Ethernet Port spécifie le port 
Ethernet de l'ordinateur auquel le contrôleur est 
connecté.
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Numéros et couleurs

Le numéro de la ligne indique l'ordre des contrôleurs 
sélectionnés. La couleur correspond à la bordure 
colorée du contrôleur sélectionné au niveau de la 
piste Pro Tools et des commandes de plug-in.

Contrôleur Ethernet

Dans le menu déroulant, sélectionnez le contrôleur 
Ethernet à utiliser.

Name

Cliquez sur le bouton Name pour attribuer un nom 
au contrôleur Ethernet sélectionné.

Enable EUCON (contrôle utilisateur étendu)

Lorsque cette option est sélectionnée, le contrôle 
de Pro Tools par un ou plusieurs contrôleurs 
compatibles EUCON est activé. EUCON est un 
protocole Ethernet haut débit novateur développé 
par Avid pour permettre à une surface de contrôle 
matérielle de communiquer directement avec une 
application logicielle. 

Mic Preamps
La page Mic Preamps permet de configurer jusqu'à 
9 préamplis micro (PRE) différents pour 
Pro Tools.

Type

Le paramètre Type permet de sélectionner l'option 
none ou PRE. Sélectionnez l'option PRE pour 
déclarer un préampli PRE connecté.

Receive From

Le paramètre Receive From permet de spécifier le 
port d'entrée MIDI auquel le préampli PRE est 
connecté.

Send To

Le paramètre Send To permet de spécifier le port 
de sortie MIDI auquel le préampli PRE est 
connecté.

Defaults

Cliquez sur le bouton Reset pour réinitialiser le 
préampli PRE correspondant.

Pour plus d'informations sur l'utilisation de 
Pro Tools avec EUCON, reportez-vous à la 
documentation fournie avec votre contrôleur.

Pour plus d'informations sur le préampli 
PRE, reportez-vous au Guide PRE.
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Retain Current Settings

Sélectionnez l'option Retain Current Settings pour 
conserver les paramètres du canal PRE lorsque 
vous chargez une session avec des paramètres 
différents. Les nouvelles sessions adopteront alors 
automatiquement les paramètres actuellement 
définis.

Option Remote Lock-Out Mode

Lorsque l'option Remote Lock-Out Mode est 
activée, les commandes des panneaux avant des 
préamplis PRE connectés sont désactivées.

Satellites
La page Satellites permet de configurer les options 
de synchronisation entre plusieurs systèmes 
Pro Tools (dont un système Avid Video Satellite) 
à l'aide de Satellite  Link. 

Satellite Link permet de relier jusqu'à 12 systèmes 
Avid HDX ou HD Native (ou toute combinaison 
de 11 systèmes Avid HDX ou HD Native et un 
système Avid Video Satellite ou un système 
Pro Tools Video Satellite) via un réseau Ethernet 
afin de pouvoir caler le transport, lancer et 
interrompre la lecture, créer des sélections de 
lecture et mettre des pistes en solo sur l'ensemble 
des systèmes, à partir de n'importe quelle station de 
travail reliée. 

Media Composer Video Satellite permet de lier un 
système Avid HDX ou HD Native et un système 
Media Composer pour le monitoring de vidéos 
Avid. Pro Tools Video Satellite permet de lier un 
système Avid HDX ou HD Native et un système 
Pro Tools basé sur hôte pour le monitoring de 
vidéos Avid ou QuickTime.

System Name

Saisissez le nom du système local. Ce nom 
apparaît dans la liste des satellites disponibles sur 
les autres systèmes connectés disposant de l'option 
Satellite Link.

Mode

Le paramètre Mode configure le comportement du 
système local satellite. 

Administrator : lorsqu'elle est sélectionnée, 
l'option Administrator désigne le système local 
comme système administrateur de tous les 
systèmes satellites du réseau. Les systèmes 
satellites peuvent être déclarés à partir du système 
administrateur. 

Satellite : lorsqu'elle est sélectionnée, l'option 
Satellite désigne le système local comme système 
satellite du réseau. Lorsqu'un système est en mode 
Satellite, il peut être déclaré comme satellite depuis 
n'importe quel système administrateur du réseau. 

Pour plus d'informations, reportez-
vous au Chapitre 53, « Satellite Link ».
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Administrator

Lorsque le système local est en mode 
Administrator, les paramètres Administrator 
permettent de déclarer des satellites à partir de ce 
système. 

System 1-12 : ces menus déroulants permettent de 
déclarer jusqu'à 11 systèmes satellites (en plus du 
système administrateur) à partir d'un système 
administrateur. Le numéro du système indique 
l'ordre des satellites déclarés dans la fenêtre de 
transport.

VENUE
La page VENUE permet de configurer Pro Tools 
afin de l'utiliser avec un système VENUE via 
Ethernet, à l'aide de VENUE Link. 

Le composant VENUE Link de Pro Tools permet 
d'importer des paramètres VENUE dans 
Pro Tools, de créer des marqueurs Pro Tools 
à partir de snapshots VENUE et de les utiliser pour 
la navigation.

System Name

Le champ System Name permet de saisir un nom 
pour votre système Pro Tools.

VENUE System

Le sélecteur VENUE System permet de 
sélectionner un système VENUE distant pour 
l'enregistrement sur (ou la lecture depuis) votre 
système Pro Tools. Vous pouvez également saisir 
manuellement les adresses IP du système VENUE.

Advanced Network Settings

Les paramètres de réseau avancés Advanced 

Network Settings permettent de spécifier une 
adresse IP et un port pour la communication du 
composant VENUE Link. 

Interface : pour les systèmes disposant de 
plusieurs connexions réseau Ethernet, le paramètre 
Interface permet de sélectionner la connexion 
à utiliser pour la communication VENUE Link. 

TCP/UDP Port : pour les systèmes disposant de 
plusieurs connexions réseau Ethernet, vous pouvez 
indiquer le numéro de port TCP/UDP à utiliser 
pour la communication VENUE Link.
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Chapitre 10 : Configuration du MIDI

Si vous utilisez des périphériques MIDI externes 
avec Pro Tools (tels que des claviers ou 
expandeurs), vous pouvez personnaliser votre 
configuration de studio MIDI pour afficher les 
noms des périphériques MIDI dans Pro Tools.

Configuration de MIDI Studio 
(Mac)
Pro Tools identifie les ports de l'interface MIDI 
comme des ports génériques. Sous Mac OS X, 
l'utilitaire Configuration audio et MIDI d'Apple 
permet d'identifier les périphériques MIDI 
externes connectés à votre interface MIDI et de 
configurer votre studio MIDI pour Pro Tools.

Pour configurer votre studio MIDI dans l'utilitaire 
de configuration :

1 Effectuez l'une des opérations suivantes :

• Lancez l'utilitaire Configuration audio et MIDI 
(dossier Applications\Utilitaires).

• Dans Pro Tools, sélectionnez Setup > MIDI > 

MIDI Studio.

2 Si la fenêtre MIDI Studio ne s'affiche pas, 
sélectionnez Window > MIDI Studio. 

L'utilitaire analyse votre système à la recherche 
d'interfaces MIDI connectées. Si votre interface 
MIDI est correctement connectée, elle s'affiche 
avec chacun de ses ports numérotés.

3 Pour créer un périphérique MIDI personnalisé 
pour l'ensemble des périphériques MIDI 
externes connectés à votre interface MIDI, 
cliquez sur Add Device. Une nouvelle icône de 
périphérique externe s'affiche avec l'image de 
clavier MIDI par défaut.

4 Faites glisser l'icône du nouveau périphérique 
vers l'emplacement de votre choix dans la 
fenêtre.

Pour des performances optimales, ne 
modifiez pas la configuration audio et MIDI 
lorsque la lecture dans Pro Tools est activée. 
Arrêtez le transport de Pro Tools avant de 
lancer l'utilitaire de configuration. 

Configuration audio et MIDI (onglet MIDI Devices)
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5 Connectez le périphérique MIDI à l'interface 
MIDI en cliquant sur la flèche correspondant au 
port de sortie du périphérique approprié et en 
faisant glisser la connexion (câble) vers la 
flèche d'entrée du port correspondant de 
l'interface MIDI.

6 Cliquez sur la flèche du port d'entrée approprié 
du périphérique, puis faites glisser un câble sur 
la flèche de sortie du port correspondant de 
l'interface MIDI. 

7 Répétez les étapes 3 à 6 pour chaque 
périphérique MIDI de votre configuration MIDI.

Pour personnaliser un périphérique MIDI externe 
dans l'utilitaire de configuration :

1 Sélectionnez l'icône du périphérique externe et 
cliquez sur Afficher Infos (ou double-cliquez sur 
l'icône du nouveau périphérique). 

2 Sélectionnez le fabricant et le modèle du 
nouveau périphérique dans les menus 
déroulants correspondants. Si le fabricant et le 
modèle de votre périphérique ne figurent pas 
dans les menus déroulants, saisissez vous-
même son nom.

3 Cliquez sur la flèche Plus d'informations pour 
développer la boîte de dialogue, puis activez les 
canaux MIDI appropriés (1 à 16) pour la 
transmission et la réception. Cette opération 
détermine les canaux qui seront utilisés par le 
périphérique pour envoyer et recevoir des 
données MIDI. 

Connexion des entrées et sorties MIDI

Pour supprimer une connexion, sélectionnez 
le câble et appuyez sur la touche Suppr.

Icône de périphérique externe

Attribution d'un nom à un nouveau périphérique MIDI

 Les noms de fabricant et de modèle sont 
quant à eux contenus dans un ou plusieurs 
fichiers .middev qui se trouvent dans le 
répertoire Root/Library/Audio/MIDI 
Devices. Pro Tools installe un fichier 
contenant des informations sur de nombreux 
périphériques MIDI disponibles dans le 
commerce, nommé « Digidesign Device 
List.middev ». Si les noms du fabricant ou du 
modèle de l'un de vos périphériques MIDI 
n'apparaissent pas dans les menus Fabricant 
et Modèle de l'utilitaire de configuration, 
vous pouvez les ajouter en modifiant le fichier 
.middev dans un éditeur de texte (tel que 
TextEdit). 

Pour plus d'informations, reportez-vous à la 
section « Noms de patch MIDI » à la page 716.
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4 Cliquez sur l'image du périphérique. 
La fenêtre s'agrandit pour afficher des images 
correspondant aux divers périphériques MIDI 
(tels que des claviers, expandeurs, interfaces et 
consoles de mixage). Sélectionnez une icône 
pour votre périphérique. 

5 Sélectionnez une image de périphérique et 
cliquez sur Appliquer. 

6 Fermez la fenêtre de l'utilitaire de configuration 
audio et MIDI. 

Les noms de périphériques saisis peuvent ensuite 
être sélectionnés comme entrée ou sortie MIDI 
dans Pro Tools.

Configuration de MIDI Studio 
(Windows)
MIDI Studio Setup (MSS) permet de configurer 
les contrôleurs et expandeurs MIDI connectés 
à votre système, et de contrôler le routing des 
données MIDI entre vos équipements MIDI et 
Pro Tools.

MSS détecte automatiquement les interfaces MIDI 
et permet de personnaliser les noms de chaque port 
MIDI dans le document MIDI Studio Setup. 

MSS prend également en charge les noms de 
fichier patch au format XML dans le cadre du 
stockage et de l'importation des noms de patch de 
vos périphériques MIDI externes. 

Vous pouvez importer et exporter l'ensemble des 
configurations MIDI Studio Setup créées dans MSS. 

Activation de canaux MIDI

Sélection d'une icône de périphérique

Pour utiliser vos icônes personnalisées, 
vous pouvez placer des fichiers image TIFF 
dans le répertoire /Library/Audio/MIDI 
Devices/Generic/Images. Vous pouvez ensuite 
les sélectionner dans la fenêtre du 
périphérique AMS.
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Pour configurer votre studio MIDI avec MSS :

1 Dans Pro Tools, sélectionnez Setup > MIDI > 

MIDI Studio.

2 Configurez les fenêtres MIDI Studio Setup.

3 Lorsque vous avez terminé de configurer les 
paramètres de la fenêtre MIDI Studio Setup, 
fermez-la.

Fenêtre MIDI Studio Setup
La fenêtre MIDI Studio Setup est organisée en 
trois sections. Les commandes d'interface se 
trouvent dans la partie supérieure de la fenêtre. 
À gauche, une liste répertorie le nom de tous les 
instruments que vous avez définis. À droite, 
la section Properties affiche les détails des 
paramètres MIDI.

Commandes d'interface

Create : ajoute le nom d'un nouvel instrument à la 
liste.

Delete : supprime le nom des instruments 
sélectionnés dans la liste.

Import : importe un fichier MIDI Studio Setup 
existant.

Export : exporte le fichier MIDI Studio Setup 
actuel.

Show Duplicate Emulated Outputs : lorsque cette 
option est sélectionnée avec une interface MIDI 
prenant en charge le marquage temporel, la fenêtre 
MIDI Studio Setup affiche à la fois les ports de 
sortie DirectMusic avec marquage temporel et les 
ports de sortie émulés sans marquage temporel. 

Liste des instruments

La liste des instruments répertorie tous les 
instruments que vous avez définis. Sélectionnez un 
instrument pour afficher ses propriétés dans la 
section Properties de la fenêtre.

Section Properties

Dans cette section, vous pouvez modifier les 
informations relatives aux nouveaux instruments 
ou aux instruments sélectionnés dans la liste des 
instruments.

L'affichage de la section Properties se modifie et 
indique les propriétés de l'instrument sélectionné 
dans la liste des instruments, si celui-ci a été défini 
précédemment.

Pour définir un instrument avec MIDI Studio 
Setup :

1 Sélectionnez Setup > MIDI > MIDI Studio.

2 Cliquez sur Create.

3 Dans le champ Instrument Name, saisissez le 
nom de l'instrument, puis appuyez sur Entrée.

Fenêtre MIDI Studio Setup

Dans certains cas, vous devez quitter et 
relancer Pro Tools pour que les interfaces 
MIDI puissent charger ou décharger 
correctement leurs pilotes. Pour plus 
d'informations, reportez-vous à la 
documentation de votre interface MIDI.

Si vous n'entrez pas le nom de l'instrument, 
le champ hérite automatiquement des 
informations contenues dans les menus 
déroulants Manufacturer et Model. 
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4 Indiquez le fabricant et le modèle du nouveau 
périphérique dans les menus déroulants 
correspondants. Si le fabricant et le modèle de 
votre périphérique n'y figurent pas, sélectionnez 
None.

5 Dans le menu déroulant Input, sélectionnez le 
port d'entrée de l'interface MIDI connecté au 
port de sortie MIDI de l'instrument.

6 Dans le menu déroulant Output, sélectionnez le 
port de sortie de l'interface MIDI connecté au 
port d'entrée MIDI de l'instrument.

7 Activez les canaux MIDI requis (1 à 16) pour 
les options Send Channel et Receive Channel, 
qui déterminent respectivement les canaux 
d'envoi et de réception MIDI.

Instrument Name

Dans ce champ, vous pouvez indiquer le nom de 
l'instrument sélectionné.

Manufacturer

Ce menu déroulant contient la liste des fabricants 
de matériel MIDI, issue des fichiers de 
périphériques MIDI au format XML. 

Model

Ce menu déroulant contient la liste des 
périphériques MIDI regroupés par fabricant. Cette 
liste est issue des fichiers de périphériques MIDI 
au format XML installés avec Pro Tools.

Input Port

Le menu déroulant Input Port contient la liste 
des ports d'entrée disponibles de l'interface MIDI. 
Ce menu permet de définir et d'afficher le port de 
l'interface MIDI par lequel les données MIDI sont 
envoyées, du périphérique MIDI externe spécifié 
dans le champ Instrument Name vers l'interface 
MIDI.

Output Port

Le menu déroulant Output Port contient la liste des 
ports de sortie disponibles de l'interface MIDI. 
Ce menu permet de définir et d'afficher le port par 
lequel les données MIDI sont envoyées, de 
l'interface MIDI vers le périphérique MIDI 
spécifié dans le champ Instrument Name.

Send Channels

La grille Send Channels définit les canaux 
d'émission du périphérique MIDI spécifié dans le 
champ Instrument Name. 

Receive Channels

La grille Receive Channels définit les canaux de 
réception du périphérique MIDI spécifié dans le 
champ Instrument Name.

Pour plus d'informations, reportez-vous à la 
section « Noms de patch MIDI » à la page 716.

Pour plus d'informations, reportez-vous à la 
section « Noms de patch MIDI » à la page 716.

Si vous choisissez la valeur None pour le port 
d'entrée, l'instrument défini n'apparaîtra pas 
dans le sélecteur d'entrée MIDI. 

Si vous choisissez la valeur None pour le port 
de sortie, l'instrument défini n'apparaîtra pas 
dans le sélecteur de sortie MIDI. 
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Partie III : Sessions et pistes
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Chapitre 11 : Sessions

Lorsque vous démarrez un projet dans Pro Tools, 
vous devez créer une session. Les sessions sont 
représentées par des fichiers de session que vous 
pouvez sauvegarder, copier et utiliser comme 
modèles.

Boîte de dialogue Quick Start
Pro Tools affiche une boîte de dialogue Quick 
Start au démarrage pour vous permettre de 
créer facilement et rapidement une session ou 
d'ouvrir une session existante. Vous pouvez 
choisir d'afficher ou de masquer la boîte de 
dialogue Quick Start au démarrage dans les 
préférences de fonctionnement de Pro Tools.

Au premier démarrage de Pro Tools, la boîte de 
dialogue Quick Start vous invite à effectuer l'une 
des opérations suivantes :

• créer une session à partir d'un modèle ;

• créer une session vide ;

• ouvrir l'une des dix dernières sessions utilisées ;

• ouvrir une autre session de votre système.

Création d'une session à partir 
d'un modèle

Pour créer une session à partir d'un modèle :

1 Sélectionnez Create Session from Template.

2 Dans le menu Session Template, sélectionnez la 
catégorie de modèles de session souhaitée.

3 Sélectionnez dans la liste le modèle de session 
à utiliser (sur la droite).

Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur la 
touche Flèche haut/bas pour sélectionner 
les différentes options de démarrage. Vous 
pouvez également utiliser les flèches haut ou 
bas pour sélectionner différents éléments de 
la liste des sessions récentes et des modèles 
de session.

Menu Session Template de la boîte de dialogue Quick 
Start

Vous pouvez créer vos propres catégories 
personnalisées. Pour plus d'informations, 
reportez-vous à la section « Modèles de 
session » à la page 168. 
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4 Pour modifier un paramètre de session, cliquez 
sur le bouton Session Parameters pour afficher 
les paramètres de session et effectuez l'une des 
opérations suivantes :

• Sélectionnez le type de fichier audio (Audio File 
Type) de la session.

• Sélectionnez la résolution (Bit Depth) : 16 bit, 
24 bit ou 32 bit float.

• Pour créer des fichiers audio multicanal entrelacés 
dans la session, sélectionnez Interleaved. 

• Sélectionnez une fréquence d'échantillonnage 
(Sample Rate).

5 Cliquez sur OK.

6 Dans la boîte de dialogue d'enregistrement, 
donnez un nom à la session, sélectionnez 
l'emplacement où vous voulez l'enregistrer, 
puis cliquez sur Save.

Création d'une session vide

Pour créer une session vide :

1 Sélectionnez Create Blank Session.

2 Pour modifier un paramètre de session, cliquez 
sur le bouton d'affichage des paramètres de 
session et effectuez l'une des opérations 
suivantes :

• Sélectionnez le type de fichier audio (Audio File 
Type) de la session.

• Sélectionnez la résolution (Bit Depth) : 16 bit, 
24 bit ou 32 bit float.

• Pour créer des fichiers audio multicanal entrelacés 
dans la session, sélectionnez Interleaved.

• Sélectionnez une fréquence d'échantillonnage 
(Sample Rate).

• Sélectionnez les paramètres d'E/S (I/O Settings) 
à utiliser pour la session. Votre système est livré 
avec plusieurs presets de configuration d'E/S, 
mais vous pouvez sélectionner une configuration 
personnalisée. Pour plus d'informations, reportez-
vous au Chapitre 7, « I/O Setup ». 

Section Session Parameters affichée dans la boîte de 
dialogue Quick Start

Pour une compatibilité maximale entre 
Windows et Mac, sélectionnez le type de 
fichier BWF (.WAV). 

Boîte de dialogue Quick Start, création d'une 
session vide
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3 Cliquez sur OK.

4 Dans la boîte de dialogue d'enregistrement, 
donnez un nom à la session, sélectionnez 
l'emplacement où vous voulez l'enregistrer, 
puis cliquez sur Save.

Ouverture d'une session récente

Pour ouvrir une session récente :

1 Sélectionnez Open Recent Session.

2 Sélectionnez une session parmi les dix dernières 
sessions les plus récentes dans la liste (sur la 
droite).

3 Cliquez sur OK.

Ouverture d'une session

Pour ouvrir une session :

1 Sélectionnez Open Session.

2 Cliquez sur OK.

3 Dans la boîte de dialogue Choose a Session, 
naviguez jusqu'à l'emplacement du fichier de 
session et sélectionnez-le.

4 Cliquez sur Open.

Affichage ou masquage de la 
boîte de dialogue Quick Start 
au démarrage

Pour empêcher l'affichage de la boîte de dialogue 
Quick Start au démarrage de Pro Tools :

 Désélectionnez l'option Show Quick Start 

Dialog when Pro Tools Starts dans la boîte de 
dialogue Quick Start ou dans les préférences de 
fonctionnement de Pro Tools (Setup > 

Preferences).

Pour afficher la boîte de dialogue Quick Start 
au démarrage de Pro Tools :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l’onglet Display.

3 Dans la section Warnings & Dialogs des 
préférences d'affichage, sélectionnez l'option 
Show Quick Start Dialog when Pro Tools Starts.

4 Cliquez sur OK.

L'option Open Recent Session n'est pas 
disponible au premier démarrage de Pro Tools 
(ou si vous avez effacé le contenu de la liste des 
sessions récentes en sélectionnant File > Open 
Recent > Clear).

Boîte de dialogue Quick Start, ouverture d'une session 
récente

Option Show Quick Start Dialog when Pro Tools Starts
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Création d'une session
La boîte de dialogue New Session permet de créer 
une session à partir d'un modèle ou de créer une 
session vide (sans piste ni média).

Création d'une session à partir 
d'un modèle

Pour créer une session à partir d'un modèle :

1 Sélectionnez File > New.

2 Dans la boîte de dialogue New Session, 
sélectionnez Create Session from Template.

3 Dans le menu Session Template, sélectionnez la 
catégorie de modèles de session souhaitée.

4 Sélectionnez le modèle de session à utiliser.

5 Sélectionnez le type de fichier audio (Audio File 

Type) de la session.

6 Sélectionnez la résolution (Bit Depth) : 16 bit, 
24 bit ou 32 bit float.

7 Pour créer des fichiers audio multicanal entrelacés 
dans la session, sélectionnez Interleaved. 

8 Sélectionnez une fréquence d'échantillonnage 
(Sample Rate).

9 Cliquez sur OK.

10 Dans la boîte de dialogue d'enregistrement, 
nommez la session, accédez à l'emplacement où 
vous voulez enregistrer la nouvelle session, puis 
cliquez sur Save.

Création d'une session vide

Pour créer une session vide :

1 Sélectionnez File > New.

2 Dans la boîte de dialogue New Session, 
sélectionnez Create Blank Session.

3 Sélectionnez le type de fichier audio (Audio File 

Type) de la session.

4 Sélectionnez la résolution (Bit Depth) : 16 bit, 
24 bit ou 32 bit float.

5 Pour créer des fichiers audio multicanal 
entrelacés dans la session, sélectionnez 
Interleaved.

6 Sélectionnez une fréquence d'échantillonnage 
(Sample Rate).

Boîte de dialogue New Session, création d'une 
session à partir d'un modèle

Pour une compatibilité optimale, 
sélectionnez le type de fichier BWF (.WAV). 

Boîte de dialogue New Session, création d'une 
session vide
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7 Sélectionnez les paramètres d'E/S (I/O Settings) 
à utiliser pour la session. Votre système est livré 
avec plusieurs presets de configuration d'E/S, 
mais vous pouvez sélectionner une configuration 
personnalisée. Pour plus d'informations, 
reportez-vous au Chapitre 7, « I/O Setup ». 

8 Cliquez sur OK.

9 Dans la boîte de dialogue d'enregistrement, 
nommez la session, accédez à l'emplacement où 
vous voulez enregistrer la nouvelle session, puis 
cliquez sur Save.

Résolutions et fréquences 
d'échantillonnage
Lorsque vous sélectionnez une résolution ou 
une fréquence d'échantillonnage pour votre 
session, prenez en compte les critères de fidélité, 
de compatibilité avec les autres systèmes et 
d'espace de stockage. 

La résolution et la fréquence d'échantillonnage 
affectent également la puissance de traitement 
disponible pour une session. Le nombre de canaux 
disponibles est réduit pour les sessions en 24 bits et 
32 bits virgule flottante ou avec des fréquences 
d'échantillonnage plus élevées.

Résolutions
16 bits : sélectionnez la résolution 16 bits si vous 
souhaitez limiter la taille des fichiers audio. 
La résolution 16 bits est surtout utilisée pour des 
sessions comportant peu de pistes et peu de 
traitement de plug-in et d'automation de mixage. 
Les CD (disques compacts) ont une résolution 
de 16 bits.

24 bits : sélectionnez la résolution 24 bits pour vos 
sessions de production et post-production si vous 
utilisez un grand nombre de pistes audio et 
appliquez divers mixages et traitements par plug-
in. Les fichiers 24 bits occupent jusqu'à un tiers 
d'espace en plus que les fichiers 16 bits.

32 bits virgule flottante : sélectionnez la 
résolution 32 bits virgule flottante pour les 
fichiers audio des sessions Pro Tools afin d'éviter 
l'écrêtage et un dithering inutile lors des rendus 
AudioSuite. Cette résolution empêche également 
les erreurs d'arrondi dans le traitement de signal 
(qui peuvent se produire pendant la conversion 
de résolution pour la lecture des fichiers et le 
traitement d'insert de plug-in en temps réel). 
Toutefois, les fichiers 32 bits prennent jusqu'à 
un tiers d'espace disque et de bande passante de 
streaming audio en plus, ce qui peut constituer un 
problème pour les nombres de pistes élevés avec 
des disques durs plus lents.

Vous pouvez modifier la résolution de tous les 
fichiers qui viennent d'être enregistrés ou importés 
(et convertis) dans la session en sélectionnant une 
résolution (Bit Depth) différente dans la fenêtre 
Session Setup.

Pour modifier la résolution de la session 
Pro Tools :

1 Sélectionnez Setup > Session.

2 Dans la fenêtre Session Setup, sélectionnez 
la résolution souhaitée à l'aide du sélecteur 
Bit Depth. 

Fenêtre Session Setup, sélection de la résolution 
32 bits virgule flottante
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Fréquences d'échantillonnage
44,1 kHz : fréquence d'échantillonnage des CD, 
couramment utilisée dans les environnements de 
production musicale.

48 kHz : fréquence d'échantillonnage des projets 
vidéo et film, couramment utilisée dans les 
environnements de post-production. Il s'agit de la 
fréquence d'échantillonnage utilisée pour les DVD.

88,2 kHz et 96 kHz : ces deux fréquences 
d'échantillonnage sont respectivement deux fois 
plus élevées que celles des CD et DVD audio. 
Les fichiers audio enregistrés à des fréquences 
d'échantillonnage supérieures occupent plus de place 
sur le disque, mais fournissent une meilleure 
résolution pour les traitements de plug-in basés sur 
des références temporelles (ce qui produit moins 
d'aliasing). Ces options sont disponibles uniquement 
lorsque Pro Tools est utilisé avec du matériel audio 
prenant en charge ces fréquences d'échantillonnage.

176,4 kHz et 192 kHz : ces deux fréquences 
d'échantillonnage sont respectivement quatre fois 
plus élevées que celles des CD et DVD audio. 
Les fichiers audio enregistrés à des fréquences 
d'échantillonnage supérieures occupent plus de 
place sur le disque, mais fournissent une meilleure 
résolution pour les traitements de plug-in basés sur 
des références temporelles (ce qui produit moins 
d'aliasing). Ces options sont disponibles 
uniquement lorsque Pro Tools est utilisé avec du 
matériel audio prenant en charge ces fréquences 
d'échantillonnage.

Formats de fichiers audio 
mixtes
Pro Tools permet de mélanger plusieurs formats 
de fichiers audio (WAV et AIF, par exemple) 
dans une même session. Lors de l'importation de 
fichiers audio dans une session Pro Tools, vous 
pouvez choisir de les ajouter (Add) plutôt que de 
les convertir (Convert), indépendamment du 
format de fichier audio.

Vous pouvez modifier le format de tous les fichiers 
audio qui viennent d'être enregistrés ou importés 
(et convertis) dans la session en sélectionnant une 
valeur différente pour Audio Format dans la fenêtre 
Session Setup.

Pour modifier le format audio de la session 
Pro Tools :

1 Sélectionnez Setup > Session.

2 Dans la fenêtre Session Setup, sélectionnez le 
format de fichier audio souhaité (AIF ou WAV) 
à l'aide du sélecteur Audio Format. 
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Fichiers audio multi-mono et 
multicanal entrelacés
Pour l'audio multicanal stéréo et au format 
supérieur à stéréo, Pro Tools prend en charge les 
fichiers audio multicanal entrelacés et les fichiers 
audio multi-mono.

Un fichier audio entrelacé contient toutes les 
informations sur les canaux combinées en un seul 
« flux » audio distinct, dans lequel les bits de 
données consécutifs sont distribués et entrelacés. 
Cela permet d'éviter les erreurs consécutives 
lorsque les données sont lues.

Les fichiers audio multi-mono ou mono divisés 
sont des fichiers audio mono multicanal considérés 
comme un groupe de fichiers audio multicanal. 
Chaque canal (fichier) peut être traité 
individuellement. Avec des fichiers stéréo par 
exemple, deux fichiers distincts sont créés, l'un 
contient le canal gauche, et l'autre le canal droit. 
Ces fichiers sont identifiés par les suffixes « .L » 
et « .R ». Ils sont ensuite liés et édités en tant que 
paire sur les pistes stéréo de Pro Tools. Toutefois, 
si vous le souhaitez, vous pouvez les dissocier et 
les diviser en deux pistes audio mono distinctes 
dans Pro Tools afin de les éditer, traiter et mixer 
séparément. 

Vous pouvez modifier le paramètre Interleaved 
pour la session actuelle dans la fenêtre Session 
Setup. Lorsque cette option est activée, tous les 
fichiers multicanal stéréo ou dans un format 
supérieur à stéréo qui viennent d'être enregistrés ou 
importés (et convertis) dans la session deviennent 
des fichiers audio entrelacés.

Pour activer (ou désactiver) les formats audio 
entrelacés dans la session Pro Tools :

1 Sélectionnez Setup > Session.

2 Dans la fenêtre Session Setup, sélectionnez 
(ou désélectionnez) l'option Interleaved.

Fichiers et dossiers de 
session
Lorsque vous créez une session, Pro Tools génère 
automatiquement un dossier portant le nom de 
votre session. Ce dossier contient le fichier de 
session, un fichier WaveCache.wfm et plusieurs 
sous-dossiers, notamment ceux nommés Audio 
Files et Clip Groups.

Fichier de session
Le fichier de session est le document créé par 
Pro Tools lorsque vous démarrez un nouveau 
projet. Pro Tools ne peut ouvrir qu'une seule 
session à la fois. Un fichier de session est identifié 
par l'extension .ptx.

Contenu type d'un dossier de session (sous Mac 
OS X)
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Dossier Audio Files
Le dossier Audio Files contient toutes les données 
audio enregistrées ou converties au cours de la 
session. 

Lorsque vous enregistrez une nouvelle piste audio, 
celle-ci est enregistrée dans un nouveau fichier 
audio dans le dossier Audio Files. Vous pouvez 
également importer d’autres fichiers audio dans la 
session et travailler avec eux. 

Dossier Fade Files
Le dossier Fade Files peut être présent dans les 
sessions créées sur des versions antérieures de 
Pro Tools. Jusqu'à Pro Tools 10.0, les fondus et 
fondus enchaînés rendus sont enregistrés dans le 
dossier Fade Files de la session.

Dossier Rendered Files
Le dossier Rendered Files contient tous les fichiers 
temporaires créés par traitement Elastic Audio dans 
la session. Il peut également contenir des fichiers 
d'analyse temporaires (.aan) obtenus suite à des 
modifications apportées à l'analyse Elastic Audio.

Dossier Clip Groups
Le dossier Clip Groups est le répertoire par défaut 
réservé aux groupes de clips que vous exportez 
à partir de votre session Pro Tools.

Fichier WaveCache
Le fichier WaveCache.wfm stocke toutes les 
données d'affichage des formes d'onde de la session. 
Si vous supprimez le fichier WaveCache.wfm, 
Pro Tools en génère un nouveau lors de l'ouverture 
suivante de la session.

Les sessions s'ouvrent plus rapidement lorsque 
vous stockez vos données de forme d'onde dans le 
fichier WaveCache. Ce fichier de session peut être 
inclus à chaque transfert de session vers un autre 
système Pro Tools (version 7.x ou supérieure). 

Pro Tools enregistre également un fichier 
WaveCache distinct dans le dossier Databases 
afin de conserver les données de forme d'onde 
pour tous les fichiers utilisés sur le système.

La suppression d'un fichier WaveCache 
n'endommage ni la session, ni votre système. 
La session prend toutefois plus de temps pour 
s'ouvrir car elle doit recalculer les données de 
forme d'onde pour tous les fichiers audio associés, 
puis stocker ces données dans un nouveau fichier 
WaveCache. 

Dossier Session File Backups
Le dossier Session File Backups contient les 
sauvegardes générées automatiquement de vos 
sessions Pro Tools. Ces fichiers sont créés 
à condition de travailler dans une session et 
d'activer l'option Enable Session File Auto Backup 
des préférences de fonctionnement. Reportez-vous 
à la section « Enable Session File Auto Backup : » 
à la page 109.

Pour plus d'informations sur l'allocation de 
pistes audio à différents emplacements du 
disque, y compris les volumes de médias 
partagés, reportez-vous à la section 
« Enregistrement avec plusieurs disques 
durs » à la page 450.
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Dossier Renamed Audio Files
Ce dossier contient les noms des fichiers renommés 
lors de l'ouverture d'une session faisant référence 
à des noms de fichiers audio avec des caractères 
incompatibles ou, dans certaines situations, lors de 
l'enregistrement de la copie d'une session d'une 
version Pro Tools qui ne prend pas en charge les 
noms de fichier longs.

Ouverture d'une session
Lorsque vous ouvrez une session, Pro Tools 
recherche dans le dossier correspondant les 
fichiers audio et de fondu associés.

Pour ouvrir une session existante :

1 Sélectionnez File > Open Session.

2 Recherchez la session que vous souhaitez 
ouvrir, puis cliquez sur Open.

Ouverture d'une session 
contenant des fichiers de fondu
Lors de l'ouverture d'une session créée dans une 
version antérieure à Pro Tools 10.0, Pro Tools 
calcule et lit tous les fondus en temps réel. Le dossier 
Fade Files du dossier de session n'est ni effacé, 
ni utilisé. Tous les fondus rendus créés dans les 
sessions de version antérieure sont calculés et lus en 
temps réel. Tous les nouveaux fondus créés dans la 
session ne génèrent aucun nouveau fichier rendu 
dans le dossier Fade Files préexistant.

Ouverture d'une session 
contenant des fichiers non 
disponibles
Pro Tools vous informe si certains fichiers trouvés 
résident sur un volume de transfert ou si certains 
fichiers sont manquants. Pour plus d'informations, 
reportez-vous à la section « Recherche de fichiers 
audio » à la page 394.

Ouverture d'une session à partir 
d'un volume de transfert
Lorsque vous ouvrez une session à partir d'un 
volume de transfert (tel qu'un CD ou un DVD), 
Pro Tools vous demande d'enregistrer la session 
sur un volume de votre système, puis de copier et 
de convertir les fichiers média référencés. Pour 
plus d'informations, reportez-vous à la section 
« Recherche de fichiers audio » à la page 394.

Ouverture d'une session 
contenant des ressources 
non disponibles
Un message vous avertit si la session que vous ouvrez 
comporte des voix, des chemins d'E/S, des ressources 
DSP ou des plug-ins non disponibles. Cela se produit 
fréquemment lors du transfert de sessions d'un 
système à un autre système constitué de matériel 
Pro Tools différent.

Pour plus d'informations, reportez-vous 
à a section « Fichiers audio renommés » à la 
page 395.

Pour plus d'informations sur l'ouverture de 
sessions créées sur des plateformes, systèmes 
Pro Tools ou versions logicielles de Pro Tools 
différentes, reportez-vous au Chapitre 18, 
« Gestion et compatibilité des fichiers et 
sessions ».

Vous pouvez également ouvrir une session 
à partir d'un navigateur de l'espace de travail 
en double-cliquant dessus.

Les fichiers SD II importés dans Pro Tools 
doivent être convertis dans un format de 
fichier audio pris en charge (.WAV ou .AIF).
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La boîte de dialogue Unavailable Resources permet 
d'obtenir un premier rapport sur les composants 
manquants de la session. Pour enregistrer un fichier 
texte (.txt) contenant des notes plus détaillées, ainsi 
que l'action résultante, cliquez sur Yes. Le nom de la 
session est attribué au fichier, suivi de Notes.txt. 
Vous pouvez choisir de sauvegarder ce fichier dans 
votre dossier de session ou à un autre emplacement.

La section suivante décrit ce qui se produit lors de 
l'ouverture d'une session avec des éléments non 
disponibles.

Sur tous les systèmes Pro Tools :

 Les inserts assignés à des plug-ins non 
disponibles sont désactivés.

 Les entrées, sorties et départs assignés à des 
chemins non disponibles sont désactivés.

Sur les systèmes Pro Tools|HDX uniquement :

 Les pistes dont le numéro est supérieur au 
maximum de voix disponibles sur le système 
actuel sont désactivées. 

Sur les systèmes Pro Tools basés sur hôte 
uniquement :

 Les pistes dont le numéro est supérieur au 
maximum de voix disponibles sur le système 
actuel n'ont plus de voix assignée (Voice Off).

Ouverture d'une session avec des 
noms de fichier audio contenant 
des caractères interdits
Pro Tools ne prend pas en charge les noms de 
fichiers audio contenant les caractères ASCII 
suivants :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

" (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (barre verticale)

Tout caractère ASCII créé avec une 
combinaison de touches

Lorsque les noms des fichiers audio utilisés dans 
les sessions ouvertes contiennent de tels caractères, 
Pro Tools crée automatiquement une copie 
renommée de chaque fichier concerné (en remplaçant 
les caractères interdits par un trait de soulignement 
« _ »). Les fichiers renommés sont placés dans le 
dossier Renamed Audio Files. Les fichiers originaux 
restent inchangés dans le dossier Audio Files.

Avant l'ouverture de la session, vous êtes invité 
à enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichier texte de notes. Suivez les instructions 
à l'écran. Par défaut, le fichier de notes est 
sauvegardé dans le dossier de la session.

Ouverture d'une session 
enregistrée avec un gain de 
fader de +6 dB
Toutes les sessions Pro Tools version 7.x ou 
supérieure ont un niveau de gain de fader de 
+12 dB. Toutefois, si vous enregistrez une session 
Pro Tools 7.x ou supérieure dans un format 
Pro Tools inférieur preDnant en charge les gains 
de fader +6 et +12 dB, vous pouvez alors choisir 
entre ces deux gains maximum.

Lors de l'enregistrement d'une session à +12 dB ou 
+6 dB, Pro Tools vous informe que tout paramètre 
d'automation supérieur à +6 dB est maintenu 
à +6 dB. Reportez-vous à la section « Enregistrement 
d'une copie de session » à la page 163.

Dans Pro Tools version 7.x ou supérieure, si vous 
ouvrez une session enregistrée avec un niveau de 
gain maximal de +6 dB, la session sera mise à jour 
avec une plage de +12 dB.
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Ouverture d'une session 
récente
Dans le menu File, vous pouvez utiliser la commande 
Open Recent pour ouvrir l'une des dix dernières 
sessions ouvertes dans Pro Tools.

Pour ouvrir une session récente :

 Sélectionnez File > Open Recent et sélectionnez 
la session à ouvrir.

Si une session est déjà ouverte, Pro Tools vous 
invite à enregistrer la session en cours avant 
d'ouvrir la session récente sélectionnée.

Pour ouvrir la session la plus récente :

 Appuyez sur Ctrl+Maj+O (Windows) ou 
Commande+Maj+O (Mac).

Pour effacer le sous-menu des sessions récentes :

 Sélectionnez File > Open Recent, puis 
sélectionnez Clear.

Ouverture d'une session avec 
les plug-ins désactivés
Pro Tools permet d'ouvrir des sessions en 
désactivant tous les plug-ins. Étant donné que le 
délai de chargement des sessions contenant de 
nombreux plug-ins peut être très long, cela vous 
permet d'ouvrir rapidement une session pour un 
examen visuel et une lecture audio immédiats 
(sans plug-in). S'il s'agit de la session sur laquelle 
vous voulez travailler, vous pouvez alors la rouvrir 
facilement en activant les plug-ins.

Pour ouvrir une session Pro Tools avec tous les 
plug-ins désactivés :

1 Dans Pro Tools, sélectionnez File > Open 

Session.

2 Dans la boîte de dialogue Open Session, localisez 
et sélectionnez la session de votre choix.

3 Cliquez sur Open en maintenant la touche Maj 
enfoncée.

Pour rouvrir la même session avec tous les plug-ins 
activés, effectuez l'une des opérations suivantes :

 Sélectionnez File > Revert To Saved.

 Sélectionnez File > Open Recent et 
sélectionnez la session la plus récente dans le 
sous-menu.

Pour ouvrir la session la plus récente, 
appuyez sur Ctrl+Maj+O (Windows) ou 
Commande+Maj+O (Mac).

Au lieu de retourner à la version enregistrée de la 
session pour ouvrir la session avec tous les plug-
ins activés, vous pouvez simplement activer un 
plug-in individuel en cliquant sur celui-ci tout 
en maintenant les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées. Pour activer une rangée complète 
de plug-ins, cliquez sur l'un des plug-ins dans 
la rangée des inserts tout en maintenant les 
touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées.
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Enregistrement d'une session
Il est recommandé d'enregistrer régulièrement 
votre travail au cours d'une session, afin de le 
conserver sur votre disque dur.

Enregistrement du fichier de 
session
La commande Save enregistre les changements 
effectués au cours de la session par rapport à la 
version précédente du fichier. La commande Save 
ne peut pas être annulée.

Pour enregistrer une session :

 Sélectionnez File > Save.

Retour à un fichier de session 
précédemment enregistré
Si vous avez effectué des changements dans une 
session depuis la dernière sauvegarde, vous 
pouvez les annuler et revenir à l'état précédent.

Pour restaurer la dernière version enregistrée 
d'une session :

 Sélectionnez File > Revert to Saved.

Enregistrement du fichier de 
session sous un nouveau nom
La commande Save As permet d'enregistrer une 
copie de la session actuelle sous un nom différent ou 
à un autre emplacement du disque. La commande 
Save As ferme la session actuelle et vous permet de 
continuer à travailler sur la copie renommée. De ce 
fait, elle est utile pour faire des essais et enregistrer 
des versions successives de la session.

Vous pouvez ainsi revenir rapidement en arrière si 
vous souhaitez retrouver une version précédente de 
votre session. La commande Save As vous permet 
d'enregistrer une nouvelle version du fichier de 
session uniquement, sans dupliquer les versions des 
fichiers audio ou de fondu.

Pour enregistrer une session sous un 
nouveau nom :

1 Sélectionnez File > Save As. 

2 Attribuez un nouveau nom à la session.

3 Cliquez sur Save.

Le fichier de session renommé est enregistré dans 
le dossier de la session avec la session d'origine 
(à moins que vous ayez spécifié une autre 
destination). Tout nouveau fichier audio que vous 
enregistrez dans votre session renommée sera 
placé dans le dossier Audio Files créé avec votre 
session d'origine. 

Vous pouvez également ouvrir une copie de 
sauvegarde de votre session si vous avez 
activé l'option Auto Backup des préférences de 
fonctionnement. Cette fonction permet de 
spécifier le nombre total de sauvegardes 
incrémentielles conservées et la fréquence 
d'enregistrement de la session. Reportez-vous 
à la section « Section Auto Backup » à la 
page 109.

Le retour à un fichier de session précédemment 
enregistré permet également d'ouvrir une 
session avec tous ses plug-ins activés, 
après l'avoir ouverte avec tous ses plug-ins 
désactivés. Reportez-vous à la section 
« Ouverture d'une session avec les plug-ins 
désactivés » à la page 161.
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Enregistrement d'une copie 
de session
La commande Save Copy In permet d'enregistrer 
une copie de la session actuelle avec ou sans ses 
fichiers audio et de fondu. En outre, vous pouvez 
préciser le format du fichier de session, le format 
du fichier audio, la résolution et la fréquence 
d'échantillonnage pour la copie de la session.

Pour enregistrer une copie de la session à un 
nouvel emplacement :

1 Sélectionnez File > Save Copy In.

2 Dans la boîte de dialogue Save Session Copy, 
sélectionnez une destination et saisissez le nom 
du fichier de la nouvelle session.

3 Sélectionnez un format de fichier de session 
(Save As Type) pour la session copiée.

4 Définissez le type de fichier audio (Audio File 
Type) pour la session copiée. Sélectionnez AIFF 
ou BWF (.WAV) pour la compatibilité des fichiers 
audio avec les systèmes Mac ou Windows.

5 Définissez la fréquence d'échantillonnage 
(Sample Rate) et la résolution (Bit Depth) 
de la session copiée.

6 Si applicable, sélectionnez un niveau de gain de 
fader (Fader Gain) pour la session copiée.

7 Si applicable, sélectionnez l'option Enforce 
Mac/PC Compatibility pour créer une session et 
des fichiers audio compatibles avec les systèmes 
Pro Tools installés sous Windows et Mac 
(reportez-vous à la section « Enregistrement de 
copies de sessions Mac compatibles avec 
Windows » à la page 399).

8 Sélectionnez les éléments à copier (Items to 
Copy) associés à la session copiée.

9 Cliquez sur Save. 

Fonctionnement de la 
commande Save Copy In
Contrairement à la commande Save As, 
la commande Save Copy In ne referme pas la 
session d'origine. Les nouvelles modifications sont 
ainsi effectuées sur la session d'origine. Les copies 
de sessions servent à archiver des sessions 
importantes, à contrôler les versions ou à préparer 
des sessions pour le transfert vers d'autres 
systèmes Pro Tools.

La commande Save Copy In n'enregistre que 
les données audio utilisées dans la session. 
Les données audio enregistrées ou importées, 
puis supprimées de la session, mais pas du disque, 
ne seront pas incluses dans la nouvelle copie de 
la session.

Pour plus d'informations sur le partage de 
sessions entre des plateformes, systèmes 
Pro Tools ou versions logicielles de Pro Tools 
différentes, reportez-vous au Chapitre 18, 
« Gestion et compatibilité des fichiers et 
sessions ».

Boîte de dialogue Save Session Copy

Pour inclure toutes les données audio 
utilisées dans la session, sélectionnez l'option 
All Audio Files.
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L'utilisation de la commande Save Copy In 
est le seul moyen de modifier la fréquence 
d'échantillonnage d'une session. La fréquence 
d'échantillonnage de chaque fichier audio copié 
de la session est remplacée par la fréquence 
d'échantillonnage sélectionnée. Lorsque vous 
enregistrez une copie de session avec une 
fréquence d'échantillonnage différente, Pro Tools 
se base sur l'option Sample Rate Conversion 

Quality sélectionnée dans la zone Import des 
préférences de traitement (Setup > Preferences).

Lorsque vous enregistrez une copie de la session 
dans une résolution inférieure, un dithering (avec 
mise en forme du bruit) est appliqué. Consultez le 
tableau suivant :

Le plug-in Dither est utilisé pour toutes les 
conversions, avec le paramètre Noise Shaping 
activé.

Options d'enregistrement de 
copie de session
Lorsque vous enregistrez une copie d'une session, 
la commande Save Copy In propose plusieurs 
options.

Session Format

Lorsque vous enregistrez une copie d'une session 
avec la commande Save Copy In, vous pouvez 
enregistrer la copie de session dans les formats 
suivants, selon votre plateforme :

Mac :

• Latest ; prise en charge des sessions Pro Tools 
10.0. et supérieures (.ptx)

• Pro Tools 7.x -> 9.x Session (.ptf)

• Pro Tools 5.1 -> 6.9 Session 

Pour inclure toutes les données audio 
utilisées dans la session, sélectionnez l'option 
All Audio Files.

Dithering et mise en forme du bruit pour une copie 
de session

Résolution Dithering
Mise en 
forme 
du bruit

32 bits virgule 
flottante vers 32 bits 
virgule flottante

Oui Oui

32 bits virgule 
flottante vers 24 bits

Oui Oui

32 bits virgule 
flottante vers 16 bits

Oui Oui

32 bits virgule 
flottante vers 8 bits

Oui Non

24 bits vers 32 bits 
virgule flottante

Non Non

24 bits vers 24 bits Non Non

24 bits vers 16 bits Oui Oui

24 bits vers 8 bits Oui Non

16 bits vers 32 bits 
virgule flottante

Non Non

16 bits vers 24 bits Non Non

16 bits vers 16 bits Non Non

16 bits vers 8 bits Oui Non

Pour en savoir plus sur le dithering, 
reportez-vous à la section « Dithering » à la 
page 1029.

Dithering et mise en forme du bruit pour une copie 
de session

Résolution Dithering
Mise en 
forme 
du bruit
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• Pro Tools 5.0 Session 

• Pro Tools 4 24 bits Session 

• Pro Tools 4 16 bits Session 

• Pro Tools 3.2 Session 

Windows :

• Latest ; prise en charge des sessions Pro Tools 
10.0. et supérieures (.ptx)

• Pro Tools 7.x -> 9.x Session (.ptf)

• Pro Tools 5.1 -> 6.9 Session 

• Pro Tools 5.0 Session 

Session Parameters

Lorsque vous enregistrez une copie d'une session 
avec la commande Save Copy In, les paramètres de 
session suivants sont disponibles :

Audio File Type

Vous pouvez enregistrer la session afin qu'elle se 
réfère à des fichiers audio BWF (.WAV) ou AIFF.

Utilisation de types de fichiers mixtes

Une même session peut utiliser des fichiers 
audio de types différents. Si votre session 
d’origine comporte des fichiers de types différents, 
ces derniers ne seront pas convertis au type de 
fichier sélectionné, à moins que vous ne spécifiiez 
qu'ils le soient en sélectionnant l'option Convert 

to Specified Format dans la zone Items To 
Copy (reportez-vous à la section « Items to Copy » 
à la page 166). 

Bit Depth

Vous pouvez enregistrer la session avec une 
résolution de 16 bits, 24 bits ou 32 bits virgule 

flottante.

Les sessions Pro Tools des versions 10.0 et 
supérieures peuvent utiliser des fichiers audio 
avec différentes résolutions. Si votre session 
d’origine comporte des résolutions différentes, 
ces dernières ne seront pas converties à la 
résolution sélectionnée, à moins que vous ne 
spécifiiez qu'elles le soient en sélectionnant 
l'option Convert to Specified Format dans la zone 
Items To Copy (reportez-vous à la section « Items 
to Copy » à la page 166).

Lorsque vous enregistrez la session au format 
10.0 ou inférieur, et si sa résolution est différente, 
ses fichiers audio sont convertis à la nouvelle 
résolution de la session et copiés à l'emplacement 
spécifié. De plus, la résolution 32 bits virgule 
flottante n'est pas disponible pour les formats de 
session inférieurs à 10.0.

Sample Rate

Vous pouvez enregistrer la session à diverses 
fréquences d'échantillonnage en fonction de votre 
système. Reportez-vous à la section 
« Configurations matérielles prises en charge pour 
le logiciel Pro Tools » à la page 40. 

Si la fréquence d'échantillonnage de votre session 
est différente, les fichiers audio y sont convertis 
avant d'être copiés vers l'emplacement spécifié.

Lorsque vous enregistrez des sessions dans 
une version inférieure à Pro Tools 5.1, 
les pistes comportant plusieurs canaux 
(y compris les pistes stéréo) et les plug-ins 
multi-mono sont perdus. Pour éviter cette 
perte de données, enregistrez séparément les 
pistes et les plug-ins en mono.

Pour plus d'informations sur les opérations 
de bounce sur disque et le dithering, 
reportez-vous à la section « Utilisation du 
dithering » à la page 1130.
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Fader Gain

Une session Pro Tools version 7.x ou supérieure 
peut être enregistrée avec un gain de fader 
maximal de +6 dB ou +12 dB dans une version 
inférieure de Pro Tools autorisant un gain de fader 
de +12 dB. Lors de l'enregistrement d'une session 
à +12 dB en tant que session à +6 dB, 
les paramètres d'automation supérieurs à +6 dB 
sont maintenus à +6 dB.

Enforce Mac/PC Compatibility

Lorsque vous enregistrez une session Pro Tools 
version 7.x ou supérieure dans une version 
inférieure, activez l'option Enforce Mac/PC 

Compatibility pour forcer les versions Mac ou 
Windows de Pro Tools à créer des sessions et des 
fichiers audio utilisables sur les deux plateformes. 

Limit Character Set

Lors de l'enregistrement d'une copie d'une session 
au format de session actuel, vous pouvez décider de 
limiter l'ensemble de caractères à une langue unique 
en sélectionnant l'option Limit Character Set.

Lors de l'enregistrement d'une copie d'une session 
dans un format de session inférieur, l'option Limit 

Character Set est sélectionnée automatiquement. 
Sélectionnez une langue dans le menu contextuel 
Limit Character Set.

Pour sélectionner le codage linguistique lors de 
l'enregistrement d'une copie d'une session : 

1 Sélectionnez File > Save Copy In. 

2 Sélectionnez l'option Limit Character Set. 

3 Sélectionnez la langue à utiliser dans le menu 
contextuel Limit Character Set. 

Items to Copy

Lorsque vous enregistrez une copie d'une 
session avec la commande Save Copy In, vous 
pouvez sélectionner les éléments à copier, décrits 
ci-dessous :

Audio Files

Lorsque cette option est sélectionnée, tous les 
fichiers audio sont copiés vers le nouvel 
emplacement. Ce paramètre est automatiquement 
sélectionné si vous sélectionnez un format de 
session inférieur à la version 10.0.

Convert To Specified Format

Lorsque l'option Convert To Specified Format est 
sélectionnée, tous les fichiers audio copiés sont 
convertis au format de fichier audio indiqué dans la 
section Session Parameters. Si cette option n'est 
pas sélectionnée, tous les fichiers audio copiés 
conservent leurs paramètres de format de fichier 
audio d'origine (y compris la fréquence 
d'échantillonnage et la résolution) et sont copiés 
à l'identique, au bit près.

Cette option est sélectionnée automatiquement 
dans l'un des cas suivants :

• Vous enregistrez dans un format de session 
inférieur à la version 10.0.

• Vous sélectionnez Enforce Mac/PC Compatibility.

Don’t Copy Elastic Audio Rendered Files

Lorsque cette option est sélectionnée, les fichiers 
de rendu Elastic Audio ne sont pas copiés dans le 
dossier Rendered Files de la nouvelle session. 

Lors de l'ouverture de la nouvelle session, 
Pro Tools ouvre la session en accédant à tous les 
médias disponibles. Tout fichier de rendu 
manquant est recréé automatiquement.

Pour plus d'informations, reportez-vous 
à la section « Enregistrement de copies de 
sessions Mac compatibles avec Windows » 
à la page 399.

Veuillez noter que la copie de formats au bit 
près est beaucoup plus rapide que la conversion 
des fichiers.
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Main Playlist Only

Lorsque cette option est sélectionnée, seules les 
playlists principales sont incluses dans la copie de 
session. Aucune playlist alternative n'est donc 
ajoutée à la copie de session.

Lorsque cette option n'est pas sélectionnée, toutes 
les playlists sont incluses dans la copie de session.

Selected Tracks Only

Lorsque cette option est sélectionnée, seules les 
pistes sélectionnées dans la session source sont 
enregistrées dans la copie de session. Cette option est 
activée automatiquement lorsque vous sélectionnez 
la commande File > Export > Selected Tracks As 

New Session.

Si cette option n'est pas sélectionnée, toutes les 
pistes de la session source sont enregistrées dans 
la copie de session. Elle est automatiquement 
désactivée lorsque vous sélectionnez la commande 
File > Save Session Copy.

Session Plug-In Settings Folder

Lorsque cette option est sélectionnée, le dossier de 
paramètres de plug-in de la session (Plug-In Settings) 
est copié au nouvel emplacement. Les références 
à ces paramètres de plug-in dans la session sont 
redirigées vers les fichiers de paramètres copiés.

Root Plug-In Settings Folder

Lorsque cette option est sélectionnée, le contenu 
du dossier de référence des paramètres de plug-in 
est copié dans un dossier nommé Place in Root 
Settings Folder, indiquant que ces fichiers devront 
être déplacés vers le dossier de référence des 
paramètres de plug-in sur le système de destination 
avant que vous ne les utilisiez. Les références à ces 
fichiers de paramètres de la session ne sont pas 
redirigées pour pointer vers les fichiers copiés.

Movie/Video Files

Lorsque cette option est sélectionnée, les fichiers 
vidéo (QuickTime ou Avid) de la session sont 
copiés dans le nouvel emplacement et les références 
de la session sont mises à jour pour pointer vers les 
fichiers vidéo copiés.

Preserve Folder Hierarchy

Lorsque cette option est sélectionnée, l'organisation 
relative des fichiers audio de la session répartis 
sur différents lecteurs et dossiers est conservée. 
Le dossier principal de la session copiée inclut des 
sous-dossiers correspondant aux sous-dossiers des 
disques ou dossiers de la session d'origine.

Lorsque l'option est désactivée, la commande 
Save Copy In copie dans un seul dossier de 
destination tous les fichiers de même type, quel 
que soit leur emplacement. 
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Modèles de session
En plus des modèles de session figurant dans la 
liste des modèles de la boîte de dialogue Quick 
Start, Pro Tools permet de créer et partager 
vos propres modèles de session personnalisés. 
Les fichiers de modèle de session Pro Tools 
portent l'extension .ptxt pour les différencier des 
fichiers de session Pro Tools ordinaires (.ptx).

Création et enregistrement de 
modèles personnalisés

Pour créer un modèle de session Pro Tools 
personnalisé :

1 Créez une session Pro Tools et configurez-la en 
fonction du modèle de session que vous 
souhaitez obtenir. 

2 Sélectionnez File > Save As Template.

3 Configurez les paramètres de la boîte de dialogue 
Save Session Template (reportez-vous à la 
section « Boîte de dialogue Save Session 
Template » à la page 169).

4 Sélectionnez l'option Include Media si vous 
souhaitez inclure des médias audio, MIDI ou 
vidéo dans le modèle. 

5 Cliquez sur OK.

Si vous avez sélectionné l'option Install Template 

In System, votre modèle de session sera disponible 
dans la boîte de dialogue Quick Start de la session 
Pro Tools. 

Si vous avez sélectionné l'option Select Location 

For Template, la boîte de dialogue Save As 
Template vous demande d'enregistrer le fichier 
à un autre emplacement de votre système.

Par exemple, si vous composez des chansons, 
vous aurez peut-être simplement besoin d'une 
session composée d'une piste d'instrument et 
d'un plug-in d'instrument (tel que Xpand ! 2 
avec un preset de piano), une piste audio 
mono (pour la voix), une piste d'entrée 
auxiliaire stéréo (comme bus d'effets) et une 
piste stéréo Master Fader. Vous pouvez 
ensuite utiliser ce modèle chaque fois que 
vous composez une nouvelle chanson.

Boîte de dialogue Save Session Template

Lorsque l'option Include Media est activée, 
tous les médias de la session sont inclus dans 
le modèle. Si vous souhaitez inclure des 
médias dans votre modèle de session, vérifiez 
que votre session contient uniquement les 
médias souhaités.

Lorsque vous êtes prêt à utiliser un modèle 
pour créer une session, reportez-vous à la 
section « Création d'une session à partir d'un 
modèle » à la page 154.
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Boîte de dialogue Save Session 
Template
La boîte de dialogue Save Template fournit les 
options suivantes :

Install Template In System

Sélectionnez cette option pour enregistrer le fichier 
de modèle dans le dossier système auquel la boîte 
de dialogue Quick Start de la session Pro Tools fait 
référence (modèles Session Templates dans le 
dossier d'application de Pro Tools).

Category

Le menu Category est disponible uniquement 
lorsque l'option Install Template In System est 
activée. Le menu Category vous permet de 
sélectionner le sous-répertoire d'enregistrement du 
fichier de modèle. Il fournit également des options 
d'ajout de catégorie et d'affichage du dossier 
Session Templates dans l'Explorateur Windows ou 
le Finder Mac.

Add Category : sélectionnez cette option 
dans le menu Category pour créer un nouveau 
sous-répertoire dans le dossier Session Templates.

Name

Le paramètre Name est disponible uniquement 
lorsque l'option Install Template In System est 
activée. Il permet de saisir un nouveau nom pour le 
fichier de modèle. À partir du menu déroulant 
Name (à droite du champ Name), vous pouvez 
effectuer une sélection dans la liste de tous les 
modèles disponibles de la catégorie sélectionnée. 
Lorsque vous sélectionnez une catégorie, son nom 
s'affiche dans le champ Name et vous permet de 
remplacer ou de créer une version incrémentielle 
du modèle existant.

Select Location For Template

Sélectionnez cette option pour enregistrer le fichier 
de modèle dans un répertoire de votre système. 
Notez que le modèle de session enregistré ne 
s'affiche pas dans la boîte de dialogue Quick Start 
de la session Pro Tools, sauf s'il a été placé dans un 
sous-répertoire (Category) dans le dossier Session 
Templates du dossier Root Settings de Pro Tools. 
Vous pouvez modifier l'emplacement du 
dossier Root Settings dans les préférences de 
fonctionnement (reportez-vous à la section 
« Section User Library » à la page 110).

Include Media

Sélectionnez cette option pour inclure des médias 
audio, MIDI ou vidéo de la session dans le modèle.

Création de sessions à partir de 
modèles
Vous pouvez créer une session à partir de modèles 
en ouvrant un modèle. Vous pouvez ouvrir tout 
fichier de modèle de session Pro Tools (.ptt) 
pour commencer une nouvelle session basée sur 
ce modèle.

Pour plus d'informations sur la création de 
sessions à partir de modèles à l'aide de la 
boîte de dialogue Quick Start, reportez-vous 
à la section « Création d'une session à partir 
d'un modèle » à la page 151.
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Fermeture d'une session
Pro Tools ne peut ouvrir qu'une seule session à la 
fois. La commande Close Session ferme votre 
session Pro Tools actuelle, sans quitter l'application. 
Pro Tools vous invite à enregistrer la session lors de 
sa fermeture, mais il est recommandé d'utiliser 
auparavant la commande Save ou Save As.

Pour fermer une session :

 Sélectionnez File > Close Session.

Fermeture de Pro Tools
Lors de la fermeture de l'application sous 
Windows ou Mac, Pro Tools vous invite 
à enregistrer la session ouverte.

Pour quitter Pro Tools sous Windows :

 Sélectionnez File > Exit.

Pour quitter Pro Tools sous Mac :

 Sélectionnez Pro Tools > Quit Pro Tools.
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Chapitre 12 : 21Fenêtres principales de 
Pro Tools

Pro Tools offre deux façons complémentaires 
de visualiser les pistes d'une session : 

Fenêtre Mix : affiche les pistes sous forme de 
tranches, comme sur une console de mixage 
(reportez-vous à la section « Fenêtre Mix » à la 
page 172).

Fenêtre Edit : affiche les pistes et leur contenu sur 
la timeline (reportez-vous à la section « Fenêtre 
Edit » à la page 174). 

Pour basculer de la fenêtre Edit à la fenêtre 
Mix, et inversement, appuyez sur Ctrl+Égal (=) 
(Windows) ou Commande+Égal (=) (Mac).

Fenêtres de Pro Tools

Fenêtre Edit

Fenêtre Mix

Fenêtre de transport

Fenêtre de plug-in

Navigateur de l'espace de travail
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Pro Tools propose plusieurs autres types de fenêtres :

Fenêtre de transport : contrôle le transport et les 
fonctions associées (reportez-vous à la section 
« Fenêtre de transport » à la page 180).

Fenêtres de plug-in : contrôlent les paramètres 
de plug-in, comme la fréquence centrale et la 
valeur Q pour un égaliseur (reportez-vous à la 
section « Fenêtres de plug-in » à la page 1041). 

Fenêtres de l'éditeur MIDI : permettent d'éditer les 
données MIDI (reportez-vous au Chapitre 32, 
« Éditeurs MIDI »).

Fenêtre de l'éditeur de partition : permet d'éditer 
les données MIDI sous forme de notation musicale 
(reportez-vous au Chapitre 33, « Éditeur de 
partition »).

Navigateurs de l'espace de travail : permettent 
de gérer, écouter et importer des médias pour des 
sessions Pro Tools (reportez-vous à la section 
« Navigateurs de l'espace de travail » à la 
page 279).

Navigateurs Web intégrés : permettent d'accéder 
au Marketplace Avid et à Pro Tools Online 
(reportez-vous à la section « Navigateur Web 
intégré » à la page 186).

Fenêtre Mix
Dans la fenêtre Mix, les pistes sont affichées sous 
la forme de tranches (comme sur une console de 
mixage), avec des commandes contrôlant les 
éléments suivants :

• Inserts

• Départs

• Assignations d'entrée et de sortie

• Volume

• Panoramique

• Activation pour l'enregistrement

• Monitoring de l'entrée de piste

• Mode d'automation

• Solo et Mute

• Commandes d'instrument

• Commandes HEAT (Pro Tools HD uniquement)

• Préamplis micro

Pour afficher la fenêtre Mix :

 Sélectionnez Window > Mix.

Pour afficher tous les composants de la fenêtre 
Mix :

 Sélectionnez View > Mix Window > All.

Pour plus d'informations sur la sélection 
d'options d'affichage individuelles, reportez-
vous à la section « Vues dans les fenêtres Mix 
et Edit » à la page 992.
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Fenêtre Mix de Pro Tools

Vue Inserts 
(page 994)

Liste des 
pistes 

(page 230)

Fader de volume 
(page 209)

Bouton de 
panoramique 
(page 209)

Indicateur de 
niveau (page 210)

Entrée 
auxiliaire 

(page 202)

Vue de la
compensation du
délai (page 995)

Master 
Fader 

(page 202)

Indicateur
AutoMatch

(page 1078)

Sélecteurs de 
chemin de piste 
(page 234 et 
page 241)

Piste audio 
mono 

(page 200)

Piste
MIDI 

(page 203)

Vue Sends 
(page 994)

Sélecteur de mode 
d'automation 
(page 1068)

Vue des 
commentaires 
de piste 
(page 994)

Sélecteur de voix
(page 240)

Nom de la piste 
(page 219)

Liste des groupes
de mixage
(page 253)

Indicateur d'ID
de groupe

(page 256)

Piste 
d'instrument 
(page 204)

Vue Instrument 
(page 994)

Sélecteur de vues 
de la fenêtre Mix

(page 992)

Afficher/Masquer la
liste des

pistes/groupes
(page 230)

Tranches 
(page 201)

Solo/Mute
(page 244)

Monitoring
d'entrée /

Activation pour
l'enregistrement

Piste audio 
stéréo 

(page 200)



Guide de référence Pro Tools174

Fenêtre Edit
La fenêtre Edit présente une timeline affichant 
l'audio, la vidéo et les notes MIDI, ainsi que 
d'autres données MIDI et d'automation du mixeur 
pour l'enregistrement, l'édition et l'arrangement 

des pistes. Tout comme dans la fenêtre Mix, 
chaque piste possède ses commandes 
de préparation à l'enregistrement, solo, 
mute et d'automation.

Fenêtre Edit de Pro Tools

Règles de base 
de temps et de 
chef d'orchestre 

(page 789)

Liste des 
clips 
(page 267)

Liste des 
pistes 

(page 230)

Boutons des 
modes 

d'édition 
(page 543)

Outils d'édition 
(page 547)

Boutons de zoom (page 548)

Compteurs et 
indicateurs

de sélection d'édition
(page 590)

Valeurs de grille et 
d'incrément 
(page 176)

Volet de l'éditeur 
MIDI (vue Notation) 

(page 184)

Lignes de contrôleur MIDI 
(page 751)

Clip sélectionné 
(page 578)

Liste des 
groupes 
d'édition 

(page 796)

Commandes de 
transport (page 180)

Menu et barre 
d'outils de la 
fenêtre Edit 
(page 175)

Pistes 
(page 199)

Vue de piste 
Playlists 

(page 651)

Vue de piste 
Elastic Audio 
(page 903)

Automation 
(page 1065)

Vue Universe 
(page 593)

Boutons de zoom 
de la fenêtre Edit 

(page 178)



Chapitre 12 : 21Fenêtres principales de Pro Tools 175

Pour afficher la fenêtre Edit :

 Sélectionnez Window > Edit.

Pour afficher tous les composants de la fenêtre 
Edit :

 Sélectionnez View > Edit Window > All. 

Les options d'affichage de la fenêtre Edit 
peuvent être sélectionnées individuellement. 
Reportez-vous à la section « Vues dans les fenêtres 
Mix et Edit » à la page 992.

Barre d'outils de la fenêtre Edit
La barre d'outils et les menus se situent en haut de la 
fenêtre Edit. Cette barre d'outils permet d'accéder 
aux modes d'édition, outils, options, indicateurs et 
fenêtres de Pro Tools. Vous pouvez personnaliser la 
barre d'outils des fenêtres Edit, de l'éditeur MIDI ou 
de partition en réorganisant, affichant ou masquant 
les fenêtres et commandes disponibles.

Commandes et zones d'informations de 
la barre d'outils de la fenêtre Edit

Les commandes et zones d'informations suivantes 
de la barre d'outils de la fenêtre Edit sont affichés 
en permanence.

Modes d'édition

Le mode d'édition a une incidence sur le 
déplacement et le positionnement des clips audio 
et MIDI (et des notes MIDI), sur le fonctionnement 
de commandes telles que Copy et Paste, ainsi que 
sur celui des différents outils d'édition (outil de 
trim, Sélecteur, Main et Crayon). Pour plus 
d'informations, reportez-vous à la section « Modes 
d'édition » à la page 543.

Outils d'édition

Les outils d'édition permettent d'éditer des données 
audio, MIDI et d'automation dans Pro Tools. Pour 
plus d'informations, reportez-vous à la section 
« Outils d'édition » à la page 547.

Compteurs et indicateurs de sélection d'édition

Les compteurs et les indicateurs de sélection 
d'édition donnent des informations sur 
l'emplacement des sélections dans la timeline. 

Compteur principal : affiche l'emplacement 
d'insertion d'édition actuel sur la règle de base de 
temps principale.

Compteur secondaire : affiche l'emplacement 
d'insertion d'édition actuel sur la règle de base de 
temps secondaire.

Emplacement du curseur : affiche la position 
actuelle du curseur sur la règle de base de temps 
principale.

Boutons des modes d'édition

Outils d'édition

Indicateurs de la fenêtre Edit

Compteurs principal et
secondaire

Sélection 
d'édition

Sélection MIDI

Emplacement du curseur Indicateur de 
piste mutée

Indicateur de 
piste en solo

Valeur du curseur

État en ligne des données
de la timeline

État en ligne des données de la session

Compensation automatique du délai
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Valeur du curseur : affiche la valeur du curseur 
actuel en amplitude de crête (audio), hauteur 
(MIDI) ou en fonction de l'automation actuelle ou 
du type de données de contrôleur. 

Indicateurs de sélection d'édition : affichent le 
début, la fin et la durée de la sélection d'édition 
actuelle.

Indicateurs et commandes de sélection MIDI : 
affichent la sélection d'édition MIDI actuelle 
(numéro de note MIDI et vélocités d'attaque et de 
release) et fournissent des commandes pour 
l'édition MIDI.

Indicateur d'état en ligne des données de la 
timeline : l'indicateur est vert lorsque tous les 
fichiers utilisés dans les playlists des pistes sont 
disponibles pour la lecture. Si les fichiers sont hors 
ligne, en cours de traitement ou non disponibles 
pour la lecture, l'indicateur est rouge.

Indicateur d'état en ligne des données de la 
session : l'indicateur est vert lorsque tous les 
fichiers audio et fichiers de fondu référencés par la 
session en cours sont disponibles pour la lecture. 
Si les fichiers sont hors ligne, en cours de 
traitement ou non disponibles pour la lecture, 
l'indicateur est rouge.

Indicateur d'état de la compensation du délai : 
s'affiche lorsque l'option Delay Compensation est 
activée (Options > Delay Compensation). Lorsque 
l'option Delay Compensation est désactivée, 
cet indicateur n'est pas affiché.

Indicateur de piste en solo : s'allume en jaune 
lorsqu'une ou plusieurs pistes de la session sont en 
solo. Lorsqu'aucune piste de la session n'est en 
solo, l'indicateur de piste en solo apparaît en vert 
estompé. Pour les systèmes avec option Satellite 
Link, l'indicateur de piste en solo s'allume en jaune 
estompé lorsqu'une piste est en solo sur n'importe 
quel système satellite.

Lorsque l'indicateur de piste en solo s'allume, vous 
pouvez cliquer dessus pour désactiver l'état solo de 
toutes les pistes de la session.

Indicateur de piste mutée : s'allume en orange 
lorsqu'une ou plusieurs pistes de la session sont 
mutées. Lorsqu'aucune piste de la session n'est 
mutée, l'indicateur de piste mutée apparaît en vert 
estompé. Veuillez noter qu'étant donné que la 
fonction de mute est automatisable, l'indicateur de 
piste mutée ne désactive pas l'état de mute de 
toutes les pistes lorsque vous cliquez dessus.

Sélecteurs Grid et Nudge

Les sélecteurs Grid et Nudge permettent de définir 
les valeurs de grille (Grid) et d'incrément (Nudge) 
pour l'édition dans Pro Tools. Pour plus 
d'informations sur le sélecteur Grid, reportez-vous 
à la section « Configuration de la grille » à la 
page 546. Pour plus d'informations sur le sélecteur 
Nudge, reportez-vous à la section « Définition de 
la valeur d'incrément » à la page 607.

Affichage et masquage des 
commandes supplémentaires 
de la fenêtre Edit

Pour afficher ou masquer des commandes sur la 
barre d'outils de la fenêtre Edit :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la barre d'outils de la 
fenêtre Edit (dans l'angle supérieur droit de la 
fenêtre) ;

• Cliquez sur la barre d'outils avec le bouton droit 
de la souris.

Sélecteurs des valeurs de grille et d'incrément

Sélecteur de valeur de grille
Sélecteur de valeur 
d'incrément
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2 Dans le menu, sélectionnez ou désélectionnez 
une ou plusieurs options parmi les suivantes, 
selon la fenêtre à configurer :

Zoom Controls : lorsque cette option est 
sélectionnée, les commandes de zoom sont 
affichées sur la barre d'outils de la fenêtre Edit.

Transport : lorsque cette option est sélectionnée, 
les commandes de transport sont affichées sur la 
barre d'outils de la fenêtre Edit.

MIDI Controls : lorsque cette option est 
sélectionnée, les commandes MIDI sont affichées 
sur la barre d'outils de la fenêtre Edit.

Synchronization : lorsque cette option est 
sélectionnée, les commandes et indicateurs de 
synchronisation sont affichés sur la barre d'outils 
de la fenêtre Edit.

Output Meters : lorsque cette option est 
sélectionnée, les indicateurs de niveau de sortie 
sont affichés sur la barre d'outils de la fenêtre Edit.

Eleven Rack (Eleven Rack uniquement) : cette 
option est disponible uniquement lorsqu'un 
périphérique Eleven Rack est connecté à votre 
système Pro Tools. Lorsqu'elle est sélectionnées, 
les commandes Eleven Rack sont affichées sur la 
barre d'outils de la fenêtre Edit. Pour plus 
d'informations, reportez-vous au Guide de 
l'utilisateur Eleven Rack.

Minimal : lorsque cette option est sélectionnée, 
l'affichage des commandes de zoom, de transport, 
MIDI et de synchronisation est désactivé sur la 
barre d'outils de la fenêtre Edit.

All : lorsque cette option est sélectionnée, 
l'affichage des commandes de zoom, de transport, 
MIDI et de synchronisation est activé sur la barre 
d'outils de la fenêtre Edit.

Menu de la barre d'outils de la fenêtre Edit
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Expanded Transport : lorsque cette option est 
sélectionnée, les commandes de transport étendu 
sont affichées sur la barre d'outils de la fenêtre 
Edit, si l'option Transport est également activée.

Track List : lorsque cette option est sélectionnée, 
la liste des pistes est affichée sur la gauche de la 
fenêtre Edit.

Clip List : lorsque cette option est sélectionnée, 
la liste des clips est affichée sur la droite de la 
fenêtre Edit.

Universe : lorsque cette option est sélectionnée, 
la vue Universe est affichée à proximité du haut de 
la fenêtre Edit.

MIDI Editor : lorsque cette option est sélectionnée, 
la vue de l'éditeur MIDI est affichée en bas de la 
fenêtre Edit.

Réorganisation des commandes 
et affichages

Pour réorganiser les commandes et affichages de 
la barre d'outils de la fenêtre Edit, ou des fenêtres 
de l'éditeur MIDI ou de partition :

 Cliquez sur la commande ou l'affichage que 
vous souhaitez déplacer tout en maintenant 
la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée, puis faites-le/la glisser vers le nouvel 
emplacement dans la barre d'outils.

Par exemple, si vous souhaitez disposer les 
indicateurs des compteurs et de la sélection 
d'édition à droite des commandes de transport sur 
la barre d'outils, cliquez dessus tout en maintenant 
la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée, puis déplacez-les à droite des 
commandes de transport.

Boutons de zoom de la fenêtre 
Edit
La fenêtre Edit fournit également des boutons de 
zoom dans les angles inférieur droit et supérieur 
droit du volet des pistes.

Boutons de zoom avant/arrière horizontal 
et vertical

Outre les commandes de zoom de la barre d'outils, 
Pro Tools comprend des boutons de zoom vertical 
et horizontal dans le coin inférieur droit de la 
fenêtre Edit. 

Déplacement des indicateurs des compteurs et de la 
sélection d'édition

Boutons de zoom vertical (fenêtre Edit)

Boutons de zoom horizontal (fenêtre Edit)
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Boutons de zoom vertical : appliquent un zoom 
proportionnel sur les hauteurs de pistes dans la 
fenêtre Edit.

Boutons de zoom horizontal : appliquent un 
zoom sur la timeline identique à celui des 
commandes de zoom horizontal de la barre d'outils 
de la fenêtre Edit.

Boutons de zoom avant et arrière audio et MIDI

Pro Tools fournit également des boutons de zoom 
avant et arrière audio et MIDI dans le coin 
supérieur droit de la fenêtre Edit. Ces commandes 
fonctionnent exactement comme les commandes 
de zoom audio et MIDI de la barre d'outils, 
et permettent d'effectuer un zoom avant ou arrière 
verticalement sur des formes d'onde audio et des 
notes MIDI respectivement.

Durée par défaut de la 
fenêtre Edit
Pro Tools permet de définir une durée par défaut 
pour la fenêtre Edit, en heures, minutes, secondes et 
images. Elle est notamment utile si vous souhaitez 
créer une session d'une durée spécifique ou 
conserver de l'espace pour étendre la zone de travail 
de la fenêtre Edit dans votre session. La durée 
maximale est de 12 heures et 25 minutes en 48 kHz 
(elle diminue de façon proportionnelle pour des 
fréquences d'échantillonnage plus élevées). Pour 
une meilleure sensibilité de la barre de défilement, 
définissez une durée légèrement supérieure (d'une 
minute ou plus) à la durée totale de la session ou 
du morceau.

Pour définir la durée par défaut de la fenêtre Edit :

1 Sélectionnez Setup > Preferences.

2 Sur la page Display, saisissez la valeur en 
heures, minutes, secondes et images du 
paramètre Edit Window Default Length.

3 Cliquez sur OK.

Dans la fenêtre Edit, le zoom vertical MIDI 
affecte uniquement les pistes dans les vues 
autres que la vue Clips.

Bouton de zoom audio (fenêtre Edit)

Bouton de zoom MIDI (fenêtre Edit)
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Fenêtre de transport
La fenêtre de Transport peut être configurée pour 
faire apparaître les commandes de transport, 
compteurs et commandes MIDI de base, ainsi que 
des fonctions étendues. Les compteurs de la 
fenêtre de transport reflètent les commandes et 
compteurs du haut de la fenêtre Edit.

Pour afficher la fenêtre de transport :

 Sélectionnez Window > Transport.

Commandes et compteurs de 
transport de base

Online : passe Pro Tools en mode en ligne afin que 
la lecture et l'enregistrement soient déclenchés par 
une source de timecode externe.

Retour à zéro : permet de revenir au début de la 
session.

Retour rapide : permet d'effectuer un retour en 
arrière rapide par rapport à l'emplacement de 
lecture actuel. Vous pouvez également cliquer 
plusieurs fois de suite, afin d'effectuer un retour 
arrière par incrément (d'une valeur basée sur 
l'échelle temporelle principale).

Avance rapide : permet d'effectuer une avance 
rapide par rapport au point d'insertion de la 
timeline. Vous pouvez également cliquer plusieurs 
fois de suite, afin d'effectuer une avance rapide par 
incrément (d'une valeur basée sur l'échelle 
temporelle principale).

Aller à la fin : permet d'aller directement à la fin de 
la session.

Fenêtre de transport avec les compteurs et 
commandes de transport de base (sans les compteurs 
principaux et secondaires, ni commandes MIDI)

Appuyez sur la touche Entrée (Windows) 
ou Retour (Mac) pour revenir au début de 
la session.

Indicateurs de début, fin
et durée de la sélection d'édition

Online

Retour rapide

Avance rapide

Arrêt

Lecture

Enregistrement

Retour à zéro

Aller à la fin

Pré-roll

Post-roll

Indicateur d'activation pour l'enregistrement de piste

Indicateur de monitoring 
TrackInput

Menu de la fenêtre de transport

Effectuez un clic droit sur le bouton Return 
to Zero pour accéder aux commandes 
d'automation Write to Start et Write to All.

Lorsque le pavé numérique est en mode 
Transport, le retour rapide est activé par 
la touche 1.

Incréments de retour et d'avance rapides

Format d'échelle 
temporelle principale

Valeur 
d'incrément

Min:Sec 1 seconde

Timecode 1 image

Bars|Beats 1 mesure

Feet+Frames 1 pied

Sample 1 seconde

Lorsque le pavé numérique est en mode 
Transport, le retour rapide est activé par la 
touche 2.
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Arrêt : arrête la lecture ou l'enregistrement.

Lecture : lance la lecture ou, si vous avez 
préalablement cliqué sur le bouton Record, 
l'enregistrement à partir du point d'insertion de 
la timeline ou de l'emplacement du marqueur de 
début de lecture si le mode de transport dynamique 
est activé.

Effectuez un clic droit sur le bouton Play pour 
sélectionner un mode de lecture dans le menu 
contextuel :

• Half-Speed (mi-vitesse)

• Prime for Playback (préparer pour la lecture)

• Loop (en boucle)

• Dynamic Transport (transport dynamique)

Lorsque le transport est arrêté, maintenez la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée et 
cliquez sur le bouton Play pour passer en mode de 
lecture en boucle. Lorsque l'option est activée, 
un symbole de boucle s'affiche sur le bouton Play 
et Pro Tools effectue un cycle de lecture entre le 
début et la fin de la sélection.

Enregistrement : prépare Pro Tools pour 
l'enregistrement (le bouton clignote). Cliquez 
ensuite sur Lecture pour lancer l'enregistrement 
sur les pistes activées pour l'enregistrement 
uniquement.

Effectuez un clic droit sur le bouton Record pour 
sélectionner un mode d'enregistrement dans le 
menu contextuel :

• Normal

• Loop (en boucle)

• Destructive (destructif)

• QuickPunch

• TrackPunch (Pro Tools HD uniquement)

• Destructive Punch (Pro Tools HD uniquement)

Lorsque le transport est arrêté, vous pouvez 
également passer d'un mode d'enregistrement 
à l'autre en cliquant sur le bouton Record tout en 
maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée.

Vous pouvez aussi appuyer sur Ctrl+Entrée 
(Windows) ou Option+Retour (Mac) sur le 
clavier alphanumérique pour aller à la fin de 
la session.

Effectuez un clic droit sur le bouton Aller à la 
fin pour accéder aux commandes d'automation 
Write to End et Write to All.

Vous pouvez aussi interrompre le transport 
en appuyant sur la barre d'espace ou en 
appuyant sur la touche 0 (zéro) du pavé 
numérique en mode Transport.

Vous pouvez également lancer la lecture 
en appuyant sur la barre d'espace ou en 
appuyant sur la touche 0 (zéro) du pavé 
numérique en mode Transport.

Pour lancer la lecture à mi-vitesse, vous 
pouvez également appuyer sur Maj+barre 
d'espace (Windows ou Mac) ou cliquer sur 
le bouton Play tout en maintenant la touche 
Maj enfoncée (Mac).

Pour plus d'informations sur la lecture en 
boucle et le mode de transport dynamique, 
reportez-vous à la section « Mode de lecture 
en boucle » à la page 426.

Vous pouvez aussi lancer immédiatement 
l'enregistrement en appuyant sur la touche 
F12, puis sur Ctrl+barre d'espace (Windows) 
ou Commande+barre d'espace (Mac), 
ou encore en appuyant sur la touche 3 du pavé 
numérique en mode Transport.
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Le bouton Record indique le mode actuellement 
sélectionné : vide pour non destructif, « D » 
pour destructif, un symbole de boucle pour 
l'enregistrement en boucle, « P » pour 
QuickPunch, « T » pour TrackPunch et « DP » 
pour DestructivePunch.

Indicateur d'activation pour l'enregistrement : 
allumé en rouge, il indique qu'au moins une piste 
audio est actuellement activée pour l'enregistrement. 
Lorsqu'il est éteint (gris), aucune piste audio n'est 
activée pour l'enregistrement. 

Indicateur de monitoring TrackInput : allumé en 
vert, il indique qu'au moins une piste audio est 
actuellement en mode de monitoring d'entrée 
(quel que soit son statut d'activation pour 
l'enregistrement). Lorsqu'il est éteint (gris), toutes 
les pistes sont en mode de monitoring 
automatique.

Menu de la fenêtre de transport : permet de 
sélectionner les options à afficher dans la fenêtre 
de transport : Counters, MIDI Controls, 
Synchronization, Minimal, All et Expanded 

Transport.

Pré-roll : lors de la lecture ou de l'enregistrement, 
spécifie la quantité d'audio lu avant la position 
actuelle du curseur de lecture (timeline) ou 
l'emplacement du marqueur de début de lecture, 
ou encore avant le début de la sélection de la 
timeline. Le pré-roll est particulièrement utile pour 
un enregistrement en punch-in/out, car il permet de 
« rentrer dans le rythme » avant d'atteindre le point 
de punch-in. Pour définir une durée de pré-roll, 
saisissez une nouvelle valeur dans ce champ ou 
faites glisser le drapeau de pré-roll sur la règle de 
base de temps principale.

Post-roll : lors de la lecture ou de l'enregistrement, 
spécifie la durée lue après la fin de la sélection de la 
timeline. Le post-roll est utile pour l'enregistrement 
en punch-in/out, car la lecture se poursuit après le 
point de sortie de l'enregistrement, ce qui permet 
de vérifier que la transition avec les sons déjà 
enregistrés s'effectue en douceur. Pour définir 
une durée de post-roll, saisissez une nouvelle 
valeur dans ce champ ou faites glisser le drapeau de 
post-roll sur la règle de base de temps principale.

Start : spécifie le début de la plage de lecture ou 
d'enregistrement. Vous pouvez définir le point de 
départ en entrant un emplacement dans ce champ 
ou en faisant glisser le marqueur de sélection 
de timeline correspondant ou le marqueur de 
début de lecture sur la règle de base de temps 
principale. Pour plus d'informations, reportez-
vous à la section « Marqueurs de sélection 
de timeline » à la page 464.

End : spécifie la fin de la plage de lecture ou 
d'enregistrement. Vous pouvez définir le point 
de fin en entrant un emplacement dans ce 
champ ou en faisant glisser le marqueur de 
sélection de timeline sur la règle de base de temps 
principale. Pour plus d'informations, reportez-
vous à la section « Marqueurs de sélection 
de timeline » à la page 464.

Length : spécifie la durée de la plage de lecture ou 
d'enregistrement. Vous pouvez définir une durée 
en entrant un emplacement dans ce champ ou en 
sélectionnant une plage sur la règle de base de 
temps principale.

Pour démarrer un enregistrement à mi-vitesse, 
appuyez sur Ctrl+Maj+barre d'espace 
(Windows) ou Commande+Maj+barre 
d'espace (Mac).

Lorsque les sélections d'édition et de timeline 
sont liées, vous pouvez effectuer une sélection 
d'édition sur une playlist de piste pour définir 
la plage de lecture et d'enregistrement. 
Reportez-vous à la section « Liaison ou 
dissociation des sélections d'édition et de 
timeline » à la page 575.



Chapitre 12 : 21Fenêtres principales de Pro Tools 183

Commandes MIDI

Pour afficher les commandes MIDI de la fenêtre de 
transport, procédez comme suit :

 Sélectionnez View > Transport > MIDI Controls.

 Pour afficher les commandes MIDI, maintenez 
la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et cliquez sur le bouton 
Développer/Réduire (+) de la fenêtre de 
transport.

Wait for Note : lorsque ce bouton est sélectionné, 
l'enregistrement ne commence que lorsqu'un 
événement MIDI est reçu. Cela garantit que 
l'enregistrement ne commence que lorsque vous 
êtes prêt à jouer, et que la première note, ou toute 
autre donnée MIDI, est enregistrée précisément au 
début de la plage d'enregistrement.

Clic du métronome : lorsque ce bouton est 
sélectionné, Pro Tools produit des battements de 
métronome. Ces battements peuvent utiliser des 
sons intégrés ou des instruments MIDI en lecture 
et en enregistrement.

Le métronome de Pro Tools se configure dans 
la boîte de dialogue Click/Countoff Options. 
Double-cliquez sur le bouton Metronome Click 
pour ouvrir la boîte de dialogue Click/Countoff 
Options.

Décompte : lorsque cet indicateur est activé, 
Pro Tools utilise un décompte du nombre de 
mesures spécifié (indiqué par cet indicateur) avant 
de lancer la lecture ou l'enregistrement.

Double-cliquez sur le bouton Count Off pour 
ouvrir la boîte de dialogue Click/Count Off 
Options.

Commandes MIDI de la fenêtre de transport

Bouton Développer/Réduire de la fenêtre de transport 
et commandes MIDI

Activation de la 
règle de tempo

Wait for Note

Décompte Métrique

Métronome

Fusion MIDI

Tempo

Menu de résolution du tempo (valeur de note)

Appuyez sur la touche F11 pour activer le 
mode Wait for Note. Il n'est pas disponible 
lorsque l'option Disable F11 for Wait for Note 
est sélectionnée dans les préférences MIDI.

Sur Mac, le raccourci clavier du bureau 
utilise la même touche que Pro Tools pour le 
mode Wait For Note (F11). Pour utiliser le 
raccourci Pro Tools, désactivez le raccourci 
clavier du bureau dans les préférences 
système Apple.

Lorsque le pavé numérique est en mode 
Transport, appuyez sur la touche 7 pour 
activer le métronome.

Lorsque le pavé numérique est en mode 
Transport, appuyez sur la touche 8 pour 
activer le décompte.
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Fusion MIDI : lorsque le bouton MIDI Merge est 
activé (mode Merge), les données MIDI 
enregistrées sont fusionnées avec celles déjà 
présentes sur les pistes. S'il n'est pas activé 
(mode Replace), les données MIDI enregistrées 
remplacent les données précédentes.

Activation de la règle de tempo (chef 
d'orchestre) : lorsque ce bouton est sélectionné, 
Pro Tools utilise la table de tempos définie sur la 
règle de tempo. Lorsqu'il est désactivé, Pro Tools 
passe en mode de tempo manuel et ignore la règle 
de tempo.

En mode de tempo manuel, vous pouvez saisir 
une valeur en BPM dans le champ du tempo ou 
appuyer en rythme sur la touche T de votre clavier 
alphanumérique.

Métrique actuelle : indique la métrique actuelle de 
la session à l'emplacement de la tête de lecture. 
Double-cliquez sur l'indicateur Meter pour ouvrir 
la fenêtre Change Meter.

Tempo actuel : affiche le tempo actuel de la 
session à l'emplacement de la tête de lecture. 
En mode de tempo manuel, vous pouvez saisir une 
valeur en BPM dans ce champ ou battre le tempo 
sur un clavier d'ordinateur ou un clavier MIDI 
externe.

Indicateurs de niveau de sortie
Pro Tools fournit des indicateurs de niveau de 
sortie dans la fenêtre de transport. Ils affichent les 
niveaux de monitoring des signaux routés depuis 
votre session vers les sorties physiques de vos 
interfaces audio, ou vers des bus internes de la 
session. La LED rouge du haut signale un écrêtage 
des convertisseurs de votre interface audio (CNA) 
sur les canaux correspondants ou les bus internes. 

Fenêtres de l'éditeur MIDI
Les fenêtres de l'éditeur MIDI permettent d'afficher 
et d'éditer des notes et des données de contrôleur 
MIDI. Vous pouvez ouvrir plusieurs fenêtres de 
l'éditeur MIDI pour travailler séparément sur 
différentes parties de vos arrangements MIDI. 
Les fenêtres de l'éditeur MIDI présentent des 
données de pistes d'instrument et MIDI superposées 
en vue Notes ou sur différentes pistes en vue 
Notation. Elles permettent d'afficher et d'éditer des 
données de contrôleur MIDI (par exemple la 
vélocité, le pitch bend et la molette de modulation) 
sur les lignes des contrôleurs sous le volet Notes.

Lorsque le pavé numérique est en mode 
Transport, appuyez sur la touche 9 pour 
activer le mode MIDI Merge.

Indicateurs de niveau de sortie dans la fenêtre de 
transport

Pour plus d'informations, reportez-vous à la 
section « Indicateurs de niveau de sortie » à la 
page 1012.

Pour plus d'informations, reportez-vous 
au Chapitre 32, « Éditeurs MIDI ».
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Affichage de l'éditeur MIDI dans 
la fenêtre Edit
Vous pouvez choisir d'afficher (ou de masquer) un 
volet de l'éditeur MIDI dans le bas de la fenêtre 
Edit (sous le volet des pistes). 

Pour afficher (ou masquer) la vue de l'éditeur MIDI 
dans la fenêtre Edit, effectuez l'une des opérations 
suivantes :

 Sélectionnez (ou désélectionnez) View > Other 

Displays > MIDI Editor.

 Cliquez sur l'icône permettant 
d'afficher/masquer l'éditeur MIDI qui se trouve 
dans l'angle inférieur gauche du volet des pistes, 
dans la fenêtre Edit.

 Double-cliquez sur le séparateur situé sous le 
volet des pistes de la fenêtre Edit.

 Dans le menu de la fenêtre Edit, sélectionnez 
(ou désélectionnez) MIDI Editor.

Fenêtre de l'éditeur de 
partition
La fenêtre de l'éditeur de partition permet d'afficher 
et d'éditer des pistes MIDI et d'instrument sous 
forme de notation musicale. Elle transcrit 
automatiquement les performances MIDI en temps 
réel. Vous pouvez imprimer une partition de votre 
session ou simplement des parties de pistes 
individuelles.

Navigateurs de l'espace 
de travail
Les sessions, fichiers média et répertoires 
Pro Tools peuvent être affichés sous forme de base 
de données dans les navigateurs de l'espace de 
travail. Ces navigateurs fournissent une interface 
intuitive qui permet d'accéder rapidement depuis 
Pro Tools aux fichiers média et sessions en ligne et 
hors ligne.

Les navigateurs dans Pro Tools sont similaires aux 
fenêtres du système d'exploitation d'un ordinateur 
(comme l'Explorateur Windows ou le Finder Mac), 
mais ils sont conçus spécifiquement pour 
fonctionner dans Pro Tools. Vous pouvez afficher 
simultanément plusieurs navigateurs et 
personnaliser l'affichage de chacun.

Les navigateurs permettent de trier des sessions et 
fichiers audio et vidéo et d'y effectuer des recherches. 
Vous pouvez déplacer directement les fichiers 
affichés dans ces navigateurs (par glisser-déposer) 
dans la session Pro Tools en cours.

Lorsque vous avez besoin d'utiliser des éléments 
hors ligne, Pro Tools permet de trouver les fichiers 
correspondants, puis de relier les éléments aux 
médias en ligne. 

Pour plus d'informations, reportez-vous au 
Chapitre 33, « Éditeur de partition ».

Pour ouvrir un navigateur de l'espace de 
travail, appuyez sur Option+Point-virgule (;) 
(Mac) ou Alt+Point virgule (;) (Windows) 

Pour afficher tous les navigateurs au premier 
plan, appuyez sur Option+J (Mac) ou Alt+J 
(Windows).

Pour placer tous les navigateurs en arrière-
plan, appuyez sur Option+Maj+J (Mac) ou 
Alt+Maj+J (Windows).
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Les principaux éléments d'un navigateur de 
l'espace de travail (voir l'illustration ci-dessous) 
sont les suivants : 

Presets d'affichage : permettent de mémoriser 
jusqu'à cinq affichages différents du navigateur. 

Commandes d'aperçu : fournissent des outils 
d'écoute des fichiers audio depuis le navigateur. 

Outils de recherche : permettent d'effectuer des 
recherches de fichiers et dossiers sur votre 
système, à l'aide de critères de recherche simples 
ou avancés. 

Menu du navigateur : fournit des commandes de 
gestion des fichiers. 

En-têtes de colonnes : affichent le type de 
métadonnées qui figurent dans la liste des 
éléments. Les en-têtes de colonnes peuvent être :

• Redimensionnés en faisant glisser le bord 
d'une colonne ou réorganisés en faisant glisser 
un en-tête ;

• Déplacés par glisser-déposer à l'intérieur de l'un 
des deux volets du navigateur, le volet fixe et le 
volet de défilement.

Volet Locations : fournit une liste des volumes 
(ainsi que des dossiers et fichiers), des catalogues 
et de la session actuellement ouverte sur votre 
système. 

Volet de navigation : affiche les éléments de votre 
système contenus dans le volume (ou dossier), 
le catalogue ou la session ouverte, sélectionné(e) 
dans le volet Locations. Le volet de navigation 
peut également afficher les résultats d'une 
recherche.

Fenêtre du gestionnaire 
de tâches
La fenêtre du gestionnaire de tâches est un 
utilitaire conçu pour visualiser et gérer toutes 
les tâches d'arrière-plan initiées par Pro Tools. 
Elle permet de surveiller, d'interrompre 
momentanément et d'annuler les tâches d'arrière-
plan (comme la copie de fichiers, les recherches, 
l'indexation et la création de fondus).

Navigateur Web intégré
Pro Tools fournit un accès rapide à la boutique 
Avid en ligne, ainsi qu'à l'Aide de Pro Tools sur 
Internet, la base de connaissances et d'autres 
ressources en ligne, grâce à deux navigateurs Web 
intégrés. 

Marketplace Avid : permet une connexion 
sécurisée aux pages Web Avid de commerce en 
ligne lié à Pro Tools.

Pro Tools Online : facilite l'accès à l'aide en ligne 
de Pro Tools, à la base de connaissances et aux 
forums de la communauté audio Avid.

Pour lancer le navigateur Web intégré de Pro Tools 
pour accéder à la boutique en ligne, sélectionnez 
l'une des options du menu Marketplace :

• Your Account (mon compte)

• Plug-ins

• Support Center (centre de support)

• Upgrades (mises à niveau)
Pour obtenir plus de détails sur les 
navigateurs de l'espace de travail, reportez-
vous au Chapitre 16, « Navigateurs de 
l'espace de travail ».

Pour en savoir plus sur la fenêtre des tâches, 
reportez-vous à la section « Fenêtre du 
gestionnaire de tâches » à la page 324.
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Pour lancer le navigateur Web intégré de Pro Tools 
pour accéder à des ressources en ligne, 
sélectionnez l'une des options du menu Help :

• Pro Tools Help (aide de Pro Tools) 

• Pro Tools Knowledge Base (base de 

connaissances) 

• Avid Audio Forums (forums Avid Audio) 

• Avid Support Center (centre de support Avid)

Commandes du navigateur Web 
intégré de Pro Tools
Le navigateur Web intégré de Pro Tools dispose 
d'une barre d'outils contenant quelques 
commandes de navigation très simples.

Page précédente : cliquez sur ce bouton pour 
revenir à la page précédente.

Page suivante : cliquez sur ce bouton pour passer 
à la page suivante.

Accueil : cliquez sur ce bouton pour revenir à la 
page d'accueil du site actuellement affiché.

Actualiser : cliquez sur ce bouton pour recharger 
la page actuellement affichée.

Emplacements : cliquez sur un bouton 
d'emplacement pour accéder à la page d'accueil 
correspondante du site Web d'Avid. Le Marketplace 
Avid et les navigateurs Pro Tools Online proposent 
différents choix d'emplacements.

Ouverture dans un navigateur 
Web externe

Vous pouvez ouvrir la page actuellement affichée 
dans le navigateur Web par défaut de votre 
système d'exploitation :

Pour ouvrir la page actuellement affichée dans un 
navigateur externe :

 Dans la fenêtre Marketplace Avid ou Pro Tools 
Online, cliquez sur l'icône d'ouverture dans un 
navigateur Web externe.

Marketplace Avid
Le menu Marketplace de Pro Tools permet 
d'accéder à votre compte Avid et à la boutique 
Avid en ligne (pour acheter des plug-ins, des mises 
à niveau ou des offres de support Avid). 

Pour vous connecter à votre compte Avid 
en ligne :

 Sélectionnez Marketplace > Your Account.

Navigateur Web de Pro Tools

Page précédente
Page suivante

Accueil

Actualiser
Emplacements

Icône d'ouverture dans un navigateur Web externe
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Pour accéder à la section de la boutique Avid en 
ligne dédiée aux plug-ins :

 Sélectionnez Marketplace > Plug-Ins.

Pour accéder à la section de la boutique Avid en 
ligne dédiée au support et à la formation, effectuez 
l'une des opérations suivantes :

 Sélectionnez Marketplace > Support and 

Training.

 Sélectionnez Help > Avid Support and Training.

Pour accéder à la section de la boutique Avid en 
ligne dédiée aux mises à niveau logicielles :

 Sélectionnez Marketplace > Upgrades.

Pro Tools Online
Le menu Help permet d'accéder aux ressources 
locales installées avec Pro Tools, mais également 
au navigateur Pro Tools Online.

Pour accéder aux ressources de Pro Tools en 
ligne à partir du menu Help :

 Cliquez sur Help et sélectionnez l'une des 
options suivantes :

• Pro Tools Help (aide de Pro Tools) 

• Pro Tools Knowledge Base (base de 

connaissances) 

• Avid Audio Forums (forums Avid Audio) 

Pro Tools Help

La commande Pro Tools Help permet d'accéder 
à l'aide de Pro Tools en ligne à partir du navigateur 
Web de Pro Tools. Vous pourrez ainsi toujours 
accéder aux fichiers d'aide les plus récents, 
dès qu'ils seront disponibles. Vous pourrez 
également accéder aux versions traduites des 
fichiers d'aide de Pro Tools, dès qu'ils seront 
disponibles.

Si vous n'êtes pas connecté à Internet, Pro Tools 
ouvrira les fichiers d'aide en anglais installés en 
local avec Pro Tools.

Pro Tools Knowledge Base

La commande Pro Tools Knowledge Base permet 
d'accéder à la base de connaissances Avid en ligne 
via le navigateur Web intégré de Pro Tools. 
La base de connaissances Avid fournit des 
informations complètes pour vous aider à résoudre 
les problèmes que vous pouvez rencontrer avec 
Pro Tools (y compris les informations de 
compatibilité et les mises à jour logicielles).

Avid Audio Forums

La commande Avid Audio Forums offre un accès 
aux forums Avid Audio en ligne à l'aide du 
navigateur Web intégré de Pro Tools. Les forums 
Avid Audio sont basés sur une importante 
communauté d'utilisateurs et permettent 
d'échanger des informations avec d'autres 
utilisateurs de Pro Tools.

Vous pouvez également accéder à la boutique 
Avid en ligne à partir du menu AudioSuite et 
des sélecteurs d'insert des pistes en 
sélectionnant l'option Avid Marketplace.

Vous pouvez également accéder à l'aide de 
Pro Tools en ligne à l'aide des navigateurs 
Safari ou Explorer. Cela peut s'avérer utile si 
Pro Tools n'est pas en cours d'exécution, ou si 
vous souhaitez changer la version ou la langue 
de l'aide. Pour plus d'informations, rendez-
vous sur http://apps.avid.com/ProToolsHelp.
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Avid Support Center

La commande Avid Support Center permet 
d'accéder au centre de support Avid en ligne via le 
navigateur Web intégré de Pro Tools. Le centre de 
support Avid fournit des instructions d'assistance 
pour vos produits Avid.

Check for Updates

Pour récupérer les dernières mises à niveau pour 
Pro Tools, les pilotes matériels et les plug-ins :

 Sélectionnez Help > Check For Updates.

Gestion des fenêtres

Configurations de fenêtres
Pro Tools dispose d'un outil puissant de gestion de 
la configuration des fenêtres dans votre session, 
ainsi que la configuration interne des fenêtres Edit, 
Mix, de l'éditeur MIDI, de l'éditeur de partition 
et de la fenêtre de transport. Utilisez la liste des 
configurations de fenêtres pour créer, supprimer 
et gérer vos configurations de fenêtres 
mémorisées. Pro Tools permet de stocker jusqu'à 
99 configurations de fenêtres. Les configurations 
de fenêtres sont enregistrées avec la session.

Création de configurations 
de fenêtres

Pour créer une configuration de fenêtres :

1 Ouvrez les fenêtres à inclure dans la 
configuration de fenêtres et positionnez-les 
à l'emplacement souhaité sur l'écran.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Window > Configurations > New 

Configuration. 

• Si la liste des configurations de fenêtres est 
ouverte, sélectionnez New Configuration dans le 
menu Window Configuration List.

3 Dans la boîte de dialogue New Window 
Configuration, effectuez l'une des opérations 
suivantes :

• Sélectionnez Window Layout et précisez si vous 
souhaitez inclure ou non les paramètres 
d'affichage des fenêtres Edit, Mix, de l'éditeur 
MIDI ciblé, de l'éditeur de partition et de la 
fenêtre de transport.

• Sélectionnez l'un des paramètres d'affichage 
dans le menu déroulant (Edit Window, Mix 

Window, MIDI Editor (Targeted), Score Editor 

Window ou Transport Window).

4 Donnez un nom à la configuration de fenêtres.

Créez un modèle de session avec votre 
configuration de fenêtres favorite. Vous 
pourrez ensuite utiliser ce modèle lorsque 
vous créerez une nouvelle session, ou utiliser 
l'option Import Session Data pour importer 
des configurations de fenêtres dans votre 
session actuelle.

Boîte de dialogue New Window Configuration
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5 Vous pouvez saisir un numéro différent pour la 
nouvelle configuration de fenêtres. Si le numéro 
que vous saisissez est déjà utilisé par une autre 
configuration de fenêtres, vous êtes invité à le 
remplacer ou à annuler l'opération en cliquant 
sur Cancel. Par défaut, Pro Tools utilise le 
premier numéro disponible (de 1 à 99) pour la 
configuration de fenêtres. 

6 Tapez un commentaire pour la nouvelle 
configuration de fenêtres.

7 Cliquez sur OK pour stocker la nouvelle 
configuration de fenêtres ou annulez 
l'opération (Cancel).

La nouvelle configuration de fenêtres est ajoutée 
à la liste des configurations de fenêtres.

Pour créer une configuration de fenêtres dans un 
emplacement portant un numéro précis :

 Pour ajouter une nouvelle configuration de 
fenêtres à cet emplacement de numéro, saisissez 
un point (.), un numéro (de 1 à 99), puis appuyez 
sur la touche Plus (+) du pavé numérique. 

Rappel de configurations 
de fenêtres
Vous pouvez utiliser la liste des configurations de 
fenêtres pour rappeler des configurations stockées. 
Vous pouvez également utiliser le pavé numérique 
de votre clavier pour rappeler une configuration de 
fenêtres spécifique.

Pour rappeler une configuration de fenêtres, 
effectuez l'une des opérations suivantes :

 Sélectionnez la configuration de fenêtres dans 
Window > Configurations.

 Cliquez sur la configuration de fenêtres 
souhaitée dans la liste des configurations de 
fenêtres pour la rappeler.

 Sur le pavé numérique, saisissez un point (.), 
le numéro de la configuration (de 1 à 99) puis 
appuyez sur la touche astérisque (*).

La disposition d'écran de la session Pro Tools est 
mise à jour avec la configuration de fenêtres 
stockée.

Annulation des configurations 
de fenêtres
Pro Tools permet uniquement de revenir à la toute 
dernière configuration de fenêtres. Cela peut être le 
cas si vous rappelez une configuration de fenêtres, 
puis décidiez de revenir à la configuration 
précédente.

Pour revenir à la configuration de fenêtres 
précédente :

 Sur le pavé numérique, saisissez un point (.), 
le chiffre 0, puis appuyez sur la touche 
astérisque (*). 

Pour rétablir une configuration de fenêtre :

 Sur le pavé numérique, saisissez un point (.), 
le chiffre 0, puis appuyez sur la touche 
astérisque (*).

Si l'option Auto-Update Active Configuration est 
activée, l'annulation de la configuration de fenêtres 
rétablit la configuration stockée précédemment 
sans sauvegarder les modifications (reportez-vous 
à la section « Mise à jour des configurations de 
fenêtres » à la page 191).

Si une configuration de fenêtres existe déjà 
à cet emplacement numéroté, la nouvelle 
configuration la remplace.
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Modification des configurations 
de fenêtres
Outre les propriétés stockées avec les 
configurations de fenêtres, vous pouvez modifier 
le numéro, le nom et les commentaires associés 
à une configuration de fenêtres. 

Pour modifier une configuration de fenêtres :

1 Sélectionnez la configuration à modifier dans la 
liste des configurations de fenêtres.

2 Dans le menu Window Configuration List, 
sélectionnez Edit <Nom>. 

3 Modifiez la configuration dans la boîte de 
dialogue Edit Window Configuration, puis 
cliquez sur OK.

Mise à jour des configurations 
de fenêtres
Après avoir rappelé une configuration de fenêtres 
stockée, vous pouvez apporter des modifications 
à la disposition et aux paramètres des fenêtres, puis 
mettre à jour la configuration stockée. Vous 
pouvez effectuer cette opération manuellement ou 
configurer Pro Tools de manière à ce que la mise 
à jour s'effectue automatiquement.

Pour une mise à jour manuelle d'une configuration 
de fenêtres, effectuez l'une des opérations 
suivantes :

 Sélectionnez Window > Configurations > 

Update Active Configuration. La configuration 
de fenêtres active est mise à jour avec les 
modifications apportées à ses propriétés 
(disposition et paramètres d'affichage des 
fenêtres).

 Dans le menu Window Configuration List, 
sélectionnez Update <Nom>. La configuration 
sélectionnée est mise à jour avec les 
modifications apportées à ses propriétés.

Pour une mise à jour automatique de la 
configuration de fenêtres active, effectuez l'une 
des opérations suivantes :

 Sélectionnez Window > Configurations > 

Auto-Update Active Configuration.

 Dans le menu Window Configuration List, 
sélectionnez Auto-Update Active Configuration.

Lorsque l'option Auto-Update Active Configuration 
est sélectionnée, la configuration de fenêtres active 
est mise à jour avec toutes les modifications 
apportées à la disposition et aux paramètres 
d'affichage des fenêtres.

Seules les configurations de fenêtres incluant la 
disposition des fenêtres peuvent être actives. Elles 
sont, par conséquent, les seules à pouvoir être mises 
à jour automatiquement. Pour mettre à jour une 
configuration de fenêtres avec les modifications 
apportées aux paramètres d'affichage de fenêtres 
(comme par exemple, la largeur de la liste des clips 
dans la fenêtre Edit), utilisez la commande Update 
de la liste des configurations de fenêtres.

Effacement d'une configuration 
de fenêtres
L'effacement d'une configuration de fenêtres la 
supprime ainsi que son numéro d'emplacement 
associé, sans modifier les numéros d'emplacement 
des autres configurations de fenêtres. La commande 
Clear est utile si vous souhaitez insérer une autre 
configuration au même emplacement. 

Pour effacer une configuration de fenêtres :

1 Sélectionnez la configuration à effacer dans la 
liste des configurations de fenêtres.

2 Dans le menu Window Configuration List, 
sélectionnez Clear <Nom>. 



Guide de référence Pro Tools192

Suppression d'une configuration 
de fenêtres
La suppression d'une configuration de fenêtres la 
supprime, ainsi que son numéro d'emplacement, 
et entraîne une renumérotation de toutes les 
configurations suivantes.

Pour supprimer une configuration de fenêtres :

1 Sélectionnez la configuration à supprimer dans 
la liste des configurations de fenêtres.

2 Dans le menu Window Configuration List, 
sélectionnez Delete <Nom>. 

Pour supprimer toutes les configurations 
de fenêtres :

 Dans le menu Window Configuration List, 
sélectionnez Delete All.

Importation de configurations 
de fenêtres
Vous pouvez importer des configurations de 
fenêtres à partir d'une autre session grâce à la 
commande Import Session Data. 

Pour importer des configurations de fenêtres :

1 Sélectionnez File > Import > Session Data.

2 Sélectionnez l'option Window Configurations.

3 Si vous souhaitez importer uniquement des 
configurations de fenêtres, cliquez sur le menu 
Session Data to Import et sélectionnez None.

4 Cliquez sur OK.

Organisation des fenêtres
Pro Tools fournit des commandes permettant de 
disposer en mosaïque ou en cascade la totalité des 
fenêtres ouvertes. Ces commandes n'affectent pas 
les fenêtres flottantes (telles que les fenêtres de 
plug-in), ni la fenêtre de transport.

Pour réorganiser les fenêtres :

 Sélectionnez Window > Arrange, puis l'une des 
options suivantes :

Tile : dispose toutes les fenêtres ouvertes sous 
forme de mosaïque à l'écran.

Tile Horizontal : dispose toutes les fenêtres 
ouvertes sous forme de mosaïque horizontale 
à l'écran. Cette option n'est pas disponible si un 
nombre trop important de fenêtres est ouvert.

Tile Vertical : dispose toutes les fenêtres ouvertes 
côte à côte sous forme de mosaïque verticale 
à l'écran. Cette option n'est pas disponible si un 
nombre trop important de fenêtres est ouvert.

Cascade : dispose toutes les fenêtres ouvertes en 
cascade à l'écran.

Masquage des fenêtres 
flottantes
La commande Hide All Floating Windows masque 
ou affiche toutes les fenêtres flottantes. Cette 
commande est utile pour masquer rapidement 
toutes les fenêtres flottantes de l'écran et travailler 
dans la fenêtre Edit ou Mix. 

Pour masquer ou afficher toutes les fenêtres 
flottantes :

 Sélectionnez ou désélectionnez Window > Hide 

All Floating Windows.

Appuyez sur Ctrl+Alt+J (Windows) ou 
Commande+Option+J (Mac) pour afficher 
ou masquer toutes les fenêtres flottantes.
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Fermeture des fenêtres

Pour fermer une fenêtre : 

1 Assurez-vous que la fenêtre que vous souhaitez 
fermer se trouve au premier plan.

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton de fermeture de la fenêtre. 

• Sélectionnez Window > Close Window.

Fonctionnement des 
configurations de fenêtres
Une configuration de fenêtres peut stocker 
l'emplacement et la taille de toutes les fenêtres 
ouvertes parmi les suivantes :

• Fenêtre Edit

• Fenêtre Mix

• Fenêtre de l'éditeur MIDI ciblée

• Fenêtre de l'éditeur de partition

• Navigateurs de l'espace de travail

• Fenêtre Session Setup

• Fenêtres Time, Tempo et Event Operations

• Liste des événements MIDI

• Fenêtre de propriétés MIDI en temps réel

• Fenêtre Beat Detective

• Fenêtres de plug-in

• Fenêtres de panoramique

• Fenêtres de préampli micro

• Toutes les fenêtres flottantes listées dans le 
menu Window :

• Fenêtre Task Manager

• Fenêtre de transport

• Fenêtre du grand compteur

• Fenêtre Automation

• Fenêtre Memory Locations

• Fenêtre Machine Track Arming

• Fenêtre Video Universe

• Fenêtre Video

• Fenêtre de la palette de couleurs

• Fenêtre Undo History

• Fenêtre Disk Space

• Fenêtre System Usage

Une configuration de fenêtres peut également 
stocker les paramètres d'affichage des fenêtres 
Edit, Mix, de l'éditeur MIDI ciblé, de l'éditeur de 
partition et de la fenêtre de transport.

Liste des configurations 
de fenêtres
La liste des configurations de fenêtres permet de 
rappeler et gérer les configurations de fenêtres 
stockées ainsi que d'en créer de nouvelles.

Appuyez sur Ctrl+W (Windows) ou 
Commande+W (Mac), pour fermer la fenêtre 
actuellement au premier plan.

L'emplacement et la taille de la liste de 
configurations de fenêtres ne sont pas stockés 
avec les configurations de fenêtres.

Liste des configurations de fenêtres
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Pour ouvrir la liste des configurations 
de fenêtres :

 Sélectionnez Window > Configurations > 
Window Configuration List.

Propriétés des configurations 
de fenêtres
Vous pouvez stocker et rappeler l'organisation des 
fenêtres de votre session Pro Tools grâce aux 
configurations de fenêtres, mais également l'état 
des fenêtres Edit, Mix et de transport. Pour chaque 
configuration de fenêtres, vous pouvez déterminer 
les propriétés à enregistrer dans la boîte de 
dialogue New Window Configuration ou Edit 
Window Configuration.

Number : numéro de l'emplacement dans lequel 
la configuration de fenêtres sera enregistrée 
(de 1à 99). Vous pouvez saisir un point (.), 
le numéro de la configuration de fenêtres, puis 
un astérisque (*) sur le pavé numérique de votre 
clavier pour rappeler la configuration de fenêtres 
stockée à cet emplacement.

Name : nom de la configuration de fenêtres 
enregistrée.

Window Layout : permet de stocker la taille et 
l'emplacement de toutes les fenêtres ouvertes.

Include Edit, Mix, Targeted MIDI Editor, Score 
Editor, and Transport Display Settings : lorsque 
cette option est activée, tous les paramètres 
d'affichage des fenêtres Edit, Mix, de l'éditeur 
MIDI ciblé, de l'éditeur de partition et de la fenêtre 
de transport sont stockés dans la configuration de 
fenêtres. Cela permet par exemple d'afficher ou 
non la liste des clips dans la fenêtre Edit. Cette 
option est disponible uniquement lorsque l'option 
Window Layout est activée.

Sélection d'une fenêtre spécifique : stocke 
uniquement les paramètres d'affichage de la fenêtre 
sélectionnée (Edit, Mix, de l'éditeur MIDI ciblé, 
de l'éditeur de partition ou de la fenêtre de 
transport) :

• Paramètres d'affichage de la fenêtre Edit

• Largeur des listes des pistes et des groupes

• Hauteur de la liste des pistes

• Largeur de la liste des clips

• Règles affichées (la règle principale 
l'est toujours) 

• Colonnes de pistes affichées (par exemple 
Inserts, Sends ou Comments)

• Affichage de l'éditeur de tempo

• Affichage ou non des commandes de 
transport dans la fenêtre Edit

• Organisation de la barre d'outils de la 
fenêtre Edit

• Paramètres d'affichage de la Fenêtre Mix

• Largeur des listes des pistes et des groupes

• Hauteur de la liste des pistes

• Zones de pistes affichées (par exemple 
Inserts, Sends ou Comments)

• Vue réduite/agrandie des tranches du mixeur

• Éditeur de partition

• Éditeur MIDI (ciblé)

• Éditeur MIDI (non ciblé)

Appuyez sur Commande+Option+J (Mac) 
ou Ctrl+Alt+J (Windows) pour afficher 
ou masquer la liste des configurations de 
fenêtres.

Boîte de dialogue Edit Window Configuration
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• Paramètres d'affichage de la fenêtre de transport

• Affichage des compteurs

• Affichage des commandes MIDI

• Vue étendue

Comments : permet d'ajouter des commentaires 
sur les configurations de fenêtres.

Commandes et options de la 
fenêtre Window Configurations
Il existe trois types principaux de commandes et 
d'options dans la fenêtre Window Configurations :

• Icônes de filtrage

• Éléments du menu de la liste des configurations 
de fenêtres

• Options de configuration de la fenêtre active

Icônes des filtres d'affichage
Les icônes de filtrage permettent d'afficher ou de 
masquer des configurations de fenêtres selon leur 
type : avec ou sans paramètres de disposition des 
fenêtres ou des fenêtres Edit, Mix, de l'éditeur de 
partition, de l'éditeur MIDI ou de la fenêtre de 
transport.

Pour afficher ou masquer des configurations 
de fenêtres dans la liste des configurations 
de fenêtres, effectuez l'une des opérations 
suivantes :

 Cliquez sur l'icône de filtrage correspondant aux 
propriétés à afficher ou masquer (disposition des 
fenêtres, paramètres de la fenêtre Edit, de la 
fenêtre Mix, de la fenêtre de l'éditeur de partition, 
de la fenêtre de l'éditeur MIDI ou de la fenêtre de 
transport). 

 Sélectionnez ou désélectionnez un élément 
à filtrer dans le menu de la liste des 
configurations de fenêtres.

Menu de la liste des 
configurations de fenêtres
Vous pouvez sélectionner des options d'affichage 
et de tri, ainsi que des commandes de création et de 
suppression de configurations de fenêtres, à partir 
du menu de la liste des configurations de fenêtres.

View Filter : affiche ou masque les icônes de 
filtrage des configurations de fenêtres dans la liste, 
ainsi que les configurations de fenêtres avec 
disposition des fenêtres, paramètres de la fenêtre 
Edit, de la fenêtre Mix, de la fenêtre de l'éditeur de 
partition, de la fenêtre de l'éditeur MIDI ou de la 
fenêtre de transport. 

Show Comments : affiche ou masque les 
commentaires dans la liste des configurations 
de fenêtres.

Icônes de filtrage de la liste des configurations de 
fenêtres

Paramètres de la fenêtre de l'éditeur MIDI (ciblée)

Paramètres de la fenêtre de transport

Paramètres de la fenêtre de l'éditeur de partition

Paramètres de la fenêtre Mix

Paramètres de la fenêtre Edit

Disposition des fenêtres

Menu de la liste des configurations de fenêtres
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New Configuration : permet de créer une 
configuration de fenêtres. Cette commande est 
également disponible à partir de Window > 

Configurations.

Update <Nom> : met à jour la configuration de 
fenêtres sélectionnée et applique les modifications 
apportées à la disposition et aux paramètres 
des fenêtres en fonction des propriétés de la 
configuration de fenêtres. Cette commande est 
également disponible à partir de Window > 

Configurations.

Edit <Nom> : ouvre la boîte de dialogue Edit 
Window Configuration qui permet de modifier 
les propriétés des configurations de fenêtres 
sélectionnées.

Clear <Nom> : efface la configuration de fenêtres 
sélectionnée sans supprimer l'emplacement 
(numéro).

Delete All : supprime toutes les configurations 
de fenêtres.

Insert Slot Before <Nom> : insère un nouvel 
emplacement avant la configuration de fenêtres 
sélectionnée et, si nécessaire, incrémente le 
numéro de chacun des emplacements suivants.

Delete <Nom> Slot : supprime la configuration de 
fenêtres sélectionnée et son emplacement (numéro), 
et renumérote les emplacements suivants.

Auto-Update Active Configuration : met à jour 
automatiquement la configuration de fenêtres 
active après modification de la disposition et des 
paramètres des fenêtres. Si l'option Auto-Update 

Active Configuration est activée, le numéro de la 
configuration active s'affiche également dans le 
menu Window. Cette commande est également 
disponible à partir de Window > Configurations.

Configuration de fenêtres active
La configuration de fenêtres active est indiquée par 
un losange situé à gauche de son numéro dans la 
liste des configurations de fenêtres et dans le sous-
menu Configurations (Window > Configuration). 
Si l'option Auto-Update Active Configuration est 
activée, le numéro de la configuration active 
s'affiche également dans le menu Window. Seules 
les configurations de fenêtres incluant une 
disposition de fenêtres peuvent être actives. 

Liste des configurations de fenêtres et configuration 
active
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Menus
Les menus de Pro Tools proposent différentes 
commandes de configuration et d'utilisation de 
l'application, des sessions et de leur contenu.

Menus principaux de Pro Tools
Pro Tools inclut les menus principaux suivants :

File : commandes de création et de gestion des 
sessions Pro Tools.

Edit : commandes d'édition et de manipulation de 
la sélection actuelle, agissant également sur les 
données de la timeline ou du presse-papiers.

View : options et commandes de personnalisation 
des diverses fenêtres. 

Track : commandes de création, gestion et édition 
des pistes.

Clip : commandes de gestion et d'édition des clips.

Event : commandes d'édition des événements 
audio et MIDI.

AudioSuite : accès à un ensemble de plug-ins 
AudioSuite. 

Options : commandes de sélection de diverses 
options d'édition, d'enregistrement; de monitoring, 
de lecture et d'affichage.

Setup : commandes d'ouverture de boîtes de 
dialogue et fenêtres ou de configuration des 
différents paramètres matériels et logiciels de 
Pro Tools.

Window : commandes de navigation entre les 
différentes fenêtres de Pro Tools.

Marketplace : permet d'accéder à votre compte 
Avid en ligne, à l'outil en ligne de recherche de 
plug-ins, au centre de support Avid en ligne et aux 
mises à niveau disponibles pour votre version de 
Pro Tools.

Help : permet d'accéder aux ressources d'aide 
(Pro Tools Help), à la base de connaissance en 
ligne (Pro Tools Knowledge Base), ainsi qu'aux 
forums audio Avid (Avid Audio Forums). Le menu 
Help propose également un accès rapide à la 
documentation PDF (installée avec Pro Tools). 

Le menu Help permet enfin d'accéder au centre 
de support Avid (Avid Support Center) et à la 
commande Check For Updates pour télécharger 
les dernières mises à niveau disponibles.

Menus des listes des pistes, 
des clips et des groupes
Les listes des pistes, des clips et des groupes 
contiennent des menus déroulants permettant de 
gérer leur contenu.

Menu de la liste des pistes : commandes 
d'affichage des pistes dans les fenêtres Mix, Edit, 
de l'éditeur MIDI et de l'éditeur de partition. 
Le menu déroulant de la liste des pistes sert 
également à trier le contenu de la liste des pistes. 

Menu de la liste des groupes (d'édition et de 
mixage) : commandes de création, d'affichage, 
de suspension et de suppression des groupes 
d'édition et de mixage.

Menu de la liste des clips (fenêtre Edit 
uniquement) : commandes de recherche, sélection, 
tri, effacement, attribution de nom, marquage 
temporel, compactage, exportation et recalcul des 
aperçus des formes d'onde des éléments de la liste 
des clips. Ce menu déroulant sert également 
à définir l'ordre dans lequel les clips que vous faites 
glisser à partir de la liste des clips sont déposés dans 
la timeline. 

Pour plus d'informations, reportez-vous à la 
section « Liste des pistes » à la page 230.

Pour plus d'informations, reportez-vous à la 
section « La liste des groupes » à la 
page 255.
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Menus contextuels des noms de 
pistes et de clips
En effectuant un clic droit sur des noms de pistes et 
de clips, vous accéder à des menus contextuels de 
commandes de gestion et de manipulation de ces 
pistes et clips :

Menu contextuel des noms de pistes : s'ouvre 
avec un clic droit sur un nom de piste, dans la 
fenêtre Edit, Mix ou la liste des pistes, et fournit 
diverses commandes associées aux pistes 
(afficher/masquer, activer/désactiver, renommer, 
dupliquer ou supprimer, etc.). 

Menu contextuel des noms de clips (fenêtre Edit 
uniquement) : s'ouvre avec un clic droit sur un nom 
de clip dans la liste des clips et fournit diverses 
commandes pour l'effacement, l'attribution de nom, 
le marquage temporel ou le remplacement de clips. 
Ce menu contextuel permet également d'exporter 
des définitions de clips ou des clips sélectionnés en 
tant que fichiers, de recalculer les aperçus de formes 
d'onde, de sélectionner le fichier parent des clips 
sélectionnés dans un navigateur de l'espace de 
travail ou de sélectionner un clip en tant qu'objet 
dans la fenêtre Edit.

Menus contextuels des ID de 
groupes de pistes et noms de 
groupes
Lorsque vous maintenez le bouton de la souris 
enfoncé sur un nom de groupe dans la liste des 
groupes ou cliquez sur un ID de groupe, un menu 
contextuel s'affiche et donne accès à des commandes 
relatives aux groupes (sélection de pistes d'un 
groupe, par exemple).

Info-bulles
Pro Tools affiche des info-bulles dans toutes les 
fenêtres principales. Il suffit de placer le pointeur 
de la souris quelques secondes sur un nom abrégé, 
une icône ou un outil sans nom pour connaître la 
fonction ou les détails de l'élément (en fonction des 
préférences sélectionnées pour les info-bulles).

Pour configurer les info-bulles de Pro Tools :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Display.

2 Dans la section Basics, sélectionnez le contenu 
des info-bulles à afficher. 

Function : affiche le nom fonctionnel des 
différents éléments de Pro Tools (boutons, 
indicateurs, modes, sélecteurs et outils d'édition, 
par exemple).

Details : affiche les noms ou valeurs abrégés ou 
masqués dans Pro Tools pour différents éléments 
(noms d'insert, niveaux de gain, paramètres et 
assignations de routing, par exemple).

3 Cliquez sur OK. 

Pour plus d'informations, reportez-vous au 
Chapitre 15, « La liste des clips ».

Pour plus d'informations, reportez-vous à la 
section « Menu contextuel des noms de 
piste » à la page 233.

Pour plus d'informations, reportez-vous au 
Chapitre 15, « La liste des clips ».

Pour plus d'informations, reportez-vous à la 
section « Menus des ID de groupe de pistes et 
noms de groupes » à la page 256.

Pour désactiver les info-bulles, laissez les 
deux options désélectionnées.
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Chapitre 13 : Pistes

Différents types de pistes sont disponibles pour 
l'utilisation de données audio, MIDI et vidéo dans 
les sessions Pro Tools. 

Types de pistes
Une session Pro Tools peut contenir différents 
types de pistes. Il peut s'agir de pistes audio, 
d'entrée auxiliaire, Master Fader, Master VCA 
(Pro Tools HD uniquement), MIDI, d'instrument 
et vidéo.

Pistes audio, d'entrée auxiliaire, Master Fader 
et Master VCA

Les pistes audio, d'entrée auxiliaire, Master Fader 
et Master VCA de Pro Tools peuvent être aux 
formats mono, stéréo et multicanal.

Pistes audio : les pistes audio permettent 
l'enregistrement et la lecture de fichiers audio 
enregistrés sur disque ou importés.

Pistes d'entrée auxiliaire : les pistes d'entrée 
auxiliaire peuvent être utilisées comme départs 
d'effets, destinations pour des sous-groupes de 
mixage, destination de bounce ou entrées pour le 
monitoring ou le traitement audio (tel que l'audio 
des instruments MIDI externes) et d'autres tâches 
de routing audio.

Pistes Master Fader : les pistes Master Fader 
contrôlent le niveau global des chemins audio 
routés sur les chemins de sortie physiques. Vous 
pouvez par exemple utiliser 24 pistes dans une 
session et router les canaux 1 à 8 vers la sortie 
analogique 1–2, les canaux 9 à 16 vers la sortie 
analogique 3–4 et les canaux 17 à 24 vers la sortie 
analogique 5–6. Vous pouvez alors créer trois 
Master Faders pour contrôler chacune de ces paires 
de sorties.

Les pistes Master Fader permettent de réaliser 
encore davantage d'opérations (telles que le 
contrôle des niveaux de sous-groupes). Pour plus 
d'informations, reportez-vous à la section « Pistes 
Master Fader et flux de signal », à la page 984.

Pistes Master VCA (Pro Tools HD uniquement) : 
les pistes Master VCA ont pour but d'émuler 
le fonctionnement des canaux d'amplification 
commandés par tension des consoles analogiques. 
Un fader de canal VCA permet dans ce cas de 
contrôler, grouper ou appliquer un offset aux 
niveaux des signaux d'autres canaux de la console.

Les pistes Master VCA ne transmettent pas de 
données audio. Elles n'ont par conséquent pas 
d'entrées, de sorties, d'inserts ou de départs. 
Les pistes Master VCA sont associées à un groupe 
de mixage, qui apparaît dans le sélecteur 
d'assignation de la piste VCA.

Les commandes des pistes de ce groupe (appelées 
pistes esclaves) sont modifiées par celles de la 
piste Master VCA. Pour plus d'informations, 
reportez-vous à la section « Pistes Master VCA », 
à la page 987.

Les caractéristiques des pistes vidéo sont 
décrites au Chapitre 52, « Utilisation de la 
vidéo dans Pro Tools ».
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Pistes MIDI

Les pistes MIDI enregistrent, stockent et lisent des 
données MIDI. Il est impossible de sélectionner un 
format de piste lorsque vous créez une piste MIDI, 
car elle ne transmet aucun signal audio.

Pistes d'instrument

Les pistes d'instrument sont un type de piste 
particulier qui associe les fonctionnalités MIDI 
et audio dans une seule tranche. Les pistes 
d'instrument simplifient l'enregistrement et le 
monitoring des instruments MIDI logiciels.

Pistes vidéo

les pistes vidéo permettent d'ajouter ou d'importer 
de la vidéo QuickTime (Windows et Mac) ou 
Windows Media (Windows Vista uniquement).

Lorsque vous utilisez Pro Tools avec un 
périphérique vidéo Avid, vous pouvez ajouter ou 
importer des vidéos Avid dans la timeline de 
Pro Tools (reportez-vous au chapitre Chapitre 52, 
« Utilisation de la vidéo dans Pro Tools »).

Les pistes vidéo apparaissent uniquement dans la 
fenêtre Edit et leur contenu peut être visualisé dans 
la fenêtre Video.

Formats de piste

Pistes mono

Une piste audio, d'entrée auxiliaire, Master Fader 
ou d'instrument mono contrôle le volume et, dans 
certains cas, le panoramique d'un canal audio 
unique. Une piste mono audio utilise une seule 
voix. Les pistes mono peuvent également être 
routées vers une sortie multicanal.

Pistes stéréo

Une piste audio, d'entrée auxiliaire, Master Fader ou 
d'instrument stéréo correspond à une tranche unique 
réunissant deux canaux audio sous forme de paire 
stéréo. Les pistes audio stéréo utilisent deux voix. 

Pistes multicanal 

(Pro Tools HD uniquement)

Une piste multicanal correspond à une tranche 
unique, prenant en charge plusieurs canaux d'audio 
(3 à 8 canaux simultanés). Pro Tools peut ainsi 
prendre en charge les formats de mixage 
multicanal, tels que LCRS, 5.1, 6.1, etc. Les pistes 
audio, d'entrée auxiliaire, Master Fader ou 
d'instrument sont compatibles avec tout format 
multicanal pris en charge.

Pour plus d'informations sur le mixage surround 
dans Pro Tools, reportez-vous aux chapitres 
suivants :

• Chapitre 47, « Configuration de Pro Tools pour 
le surround »

• Chapitre 48, « Pistes multicanal et routing des 
signaux »

• Chapitre 49, « Mixage et panoramique 
surround »
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Tranches de piste de la 
fenêtre Mix

Tranche de piste audio
Chaque piste audio possède son propre jeu de 
commandes de tranches de console pour le volume, 
le panoramique, la préparation à l'enregistrement, 
le monitoring des signaux d'entrée (Pro Tools HD 
uniquement), le mode d'automation, la mise en solo, 
le mute et l'assignation de voix.

Tranche de piste audio mono 

Inserts (A à E)

Départs (A à E)

Chemins d'entrée/sortie audio

Boutons Solo/Mute

Sélecteur de mode d'automation

Bouton du nom de piste

Bouton de panoramique

Indicateur de niveau

Fader de volume

ID de groupe

Bouton de la fenêtre Output

Commentaires de la piste

Indicateur du type de piste

Sélecteur de voix

Bouton d'activation pour 
l'enregistrement de la piste

Indicateurs crête/délai et de 
réserve de gain

Indicateur de panoramique

Vue de la compensation du délai

Bouton de monitoring TrackInput

Code couleur de la piste

Code couleur de la piste

Commandes HEAT de la piste 
(Pro Tools HD avec option HEAT 
uniquement)
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Tranche de piste d'entrée 
auxiliaire
Chaque piste d'entrée auxiliaire dispose de son 
propre ensemble de commandes sur la tranche 
associée pour contrôler le volume, le panoramique, 
le mode d'automation, la mise en solo et la 
commande mute.

Tranche de piste Master Fader
Chaque piste Master Fader dispose de son propre 
ensemble de commandes sur la tranche associée 
pour contrôler le volume et le mode d'automation. 

Tranche de piste d'entrée auxiliaire stéréo 

Inserts (A à E)

Départs (A à E)

Sélecteurs de chemin d'entrée/sortie 
audio

Boutons Solo/Mute

Sélecteur de mode d'automation

Bouton du nom de piste

Boutons de panoramique

Indicateurs de niveau

Fader de volume

ID de groupe

Commentaires de la piste

Indicateur du type de piste

Indicateurs crête/délai et de réserve 
de gain

Indicateurs de panoramique

Vue de la compensation du délai

Code couleur de la piste

Bouton de la fenêtre Output

Tranche de piste Master Fader stéréo 

Inserts (A à E)

Sélecteurs de chemin de sortie 
audio

Sélecteur de mode d'automation

Bouton du nom de piste

Indicateurs de niveau

Fader de volume

ID de groupe

Commentaires de la piste

Indicateur du type de piste

Indicateurs crête/délai et de réserve de 
gain

Vue de la compensation du délai

Code couleur de la piste

Bouton de la fenêtre Output
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Tranche de pistes Master VCA
(Pro Tools HD uniquement)

Chaque piste Master VCA dispose de son propre 
ensemble de commandes sur la tranche associée 
pour contrôler le volume, l'activation pour 
l'enregistrement, le monitoring d'entrée, le mode 
d'automation, la mise en solo et la commande mute. 

Tranche de piste MIDI
Chaque piste MIDI dispose de son propre 
ensemble de commandes sur la tranche associée 
pour contrôler le volume MIDI, le panoramique, 
l'activation pour l'enregistrement, le mode 
d'automation, la mise en solo, la commande mute, 
l'assignation de patch et l'assignation de canal. 

Pour plus d'informations, reportez-vous à la 
section « Pistes Master VCA », à la page 987.

Piste Master VCA

Sélecteur de mode 
d'automation

Mute

Bouton de 
monitoring 
TrackInput

Solo

Activation pour 
l'enregistrement

Indicateur du type de 
piste

Commentaires de la piste

Code couleur de la piste

Indicateur de volume

ID de groupe

Fader de 
volume

Indicateur de niveau

Tranche MIDI 

Sélecteur d'entrée MIDI

Fader de volume MIDI

Bouton de panoramique MIDI

Bouton du nom de piste

Indicateur de vélocité MIDI

Sélecteur de mode d'automation

Sélecteur de sortie MIDI

Activation pour l'enregistrement

Sélection de patch

Indicateur de panoramique MIDI

Indicateur de volume MIDI
Indicateur du type de piste

ID de groupe

Commentaires de la piste

Boutons Solo/Mute

Code couleur de la piste



Guide de référence Pro Tools204

Tranche de piste d'instrument
Chaque piste d'instrument dispose de son propre 
ensemble de commandes sur la tranche associée 
pour contrôler le volume audio (comme sur une 
piste d'entrée auxiliaire), le panoramique, le mode 
d'automation, la mise en solo, la commande mute 
et l'activation pour l'enregistrement MIDI 
(comme sur une piste MIDI). Les pistes 
d'instrument offrent une vue supplémentaire qui 
contient les commandes MIDI d'entrée et de sortie, 
de mute, de volume et de panoramique (comme sur 
une piste MIDI).

Tranche de piste d'instrument stéréo, en vue 
Instruments

Inserts (A à E)

Départs (A à E)

Sélecteurs de chemin d'entrée/sortie audio

Boutons Solo/Mute

Sélecteur de mode d'automation

Nom de la piste

Indicateurs de niveau

Fader de volume

ID de groupe

Bouton de la fenêtre Output

Commentaires de la piste

Indicateur du type de piste

Indicateurs crête/délai et de 
réserve de gain

Boutons de panoramique

Vue de la compensation du délai

Activation pour l'enregistrement

Sélection de patch

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI

Indicateur MIDI (vélocité)

Volume MIDI

Bouton Mute MIDI

Code couleur de la piste

Panoramique MIDI

Indicateurs de panoramique
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Commandes et indicateurs 
des pistes dans la 
fenêtre Edit

Commandes de piste audio
Chaque piste audio possède son propre jeu de 
commandes de pistes, notamment pour le 
nom des pistes, les playlists, la préparation 
à l'enregistrement, le monitoring des signaux 
d'entrée (Pro Tools HD uniquement), la mise en 
solo, le mute, la vue de piste, la hauteur de piste, 
la base de temps, les options Elastic Audio, 
l'assignation des voix et le mode d'automation. 

Commandes de piste d'entrée 
auxiliaire
Chaque piste d'entrée auxiliaire dispose de son 
propre ensemble de commandes de piste 
contrôlant son nom, la mise en solo, la commande 
mute, la vue et la hauteur de la piste, la base de 
temps et le mode d'automation. 

Commandes de piste Master Fader
Chaque piste Master Fader dispose de son propre 
ensemble de commandes de piste contrôlant son 
nom, la vue et la hauteur de la piste, la base de 
temps et le mode d'automation. 

Commandes d'une piste audio mono dans la fenêtre 
Edit (hauteur de piste moyenne)

Sélecteur de mode d'automation

Bouton Mute

Sélecteur de voix

Sélecteur de hauteur de piste

Sélecteur de 
playlist

Nom de la piste

Bouton Solo
Bouton de monitoring TrackInput

Sélecteur de base de temps

Sélecteur de plug-in Elastic Audio

Bouton d'activation pour l'enregistrement

Afficher/masquer les lignes d'automation

Sélecteur de vue 
de piste

Commandes d'une piste d'entrée auxiliaire stéréo 
dans la fenêtre Edit (hauteur de piste moyenne)

Commandes d'une piste Master Fader stéréo dans la 
fenêtre Edit (hauteur de piste moyenne)

Bouton Mute

Sélecteur de hauteur de piste
Nom de la piste

Sélecteur de base de temps

Sélecteur de vue de 
piste

Bouton Solo

Sélecteur de mode
d'automation

Afficher/masquer les lignes d'automation

Sélecteur
de hauteur de piste

Nom de la piste

Sélecteur 
de vue de piste

Sélecteur de mode 
d'automation

Afficher/masquer les lignes 
d'automation

Sélecteur de base de temps
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Commandes de piste 
Master VCA
(Pro Tools HD uniquement)

Chaque piste Master VCA dispose de son propre 
ensemble de commandes de piste contrôlant son 
nom, les playlists, l'activation pour l'enregistrement, 
le monitoring d'entrée, la mise en solo, 
la commande mute, la vue et la hauteur de la piste, 
la base de temps et le mode d'automation. 

Commandes de piste MIDI
Chaque piste MIDI dispose de son propre ensemble 
de commandes de piste contrôlant son nom, 
les playlists, l'activation pour l'enregistrement, 
la mise en solo, la commande mute, la vue et la 
hauteur de la piste, le patch, la base de temps et le 
mode d'automation. 

Commandes d'une piste Master VCA dans la fenêtre 
Edit (hauteur de piste moyenne)

Bouton Mute

Sélecteur de hauteur de piste

Nom de la piste

Bouton Solo
Bouton de monitoring TrackInput

Bouton d'activation pour l'enregistrement

Sélecteur de mode 
d'automation

Sélecteur de base 
de temps

Afficher/masquer les lignes d'automation
Commandes d'une piste MIDI dans la fenêtre Edit 
(hauteur de piste moyenne)

Bouton Mute

Sélecteur de hauteur de piste

Sélecteur de playlist

Nom de la piste
Bouton Solo

Bouton d'activation pour l'enregistrement

Sélecteur de mode d'automation
Sélecteur de patch

Sélecteur de base de temps

Sélecteur de vue 
de piste

Afficher/Masquer les lignes de contrôleur
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Commandes de piste 
d'instrument
Chaque piste d'instrument dispose de son propre 
ensemble de commandes de piste contrôlant son 
nom, les playlists, l'activation pour l'enregistrement, 
la mise en solo, la commande mute, la vue et la 
hauteur de la piste, le patch, la base de temps et le 
mode d'automation.

Commandes de piste vidéo
Chaque piste vidéo dispose de son propre 
ensemble de commandes de piste contrôlant son 
nom, les playlists, l'état en ligne, la vue et la 
hauteur de la piste. 

Vues de la fenêtre Edit
En plus des commandes de piste et des playlists 
(des clips d'événements sur la timeline), la fenêtre 
Edit propose les vues suivantes correspondant aux 
commandes des tranches de la fenêtre Mix :

• Comments 

• Mic Preamps 

• Instruments 

• Inserts (A–E et F–J)

• Sends (A–E et F–J)

• I/O 

• RealTime Properties 

• Track Color 

• All 

• Minimal 

Commandes d'une piste d'instrument stéréo dans la 
fenêtre Edit (hauteur de piste moyenne)

Bouton Mute

Sélecteur de hauteur de piste

Sélecteur 
de playlist

Nom de la piste

Bouton Solo

Bouton d'activation pour l'enregistrement

Sélecteur de 
vue de piste

Sélecteur de mode d'automation

Sélecteur de patch

Sélecteur de base de temps

Afficher/masquer les lignes d'automation et de contrôleur

Commandes d'une piste vidéo dans la fenêtre Edit 
(hauteur de piste moyenne)

Reportez-vous également à la section « Vues 
dans les fenêtres Mix et Edit », à la page 992.

Bouton d'état Online

Sélecteur de hauteur de piste
Sélecteur de playlistNom de la piste

Sélecteur de vue 
de piste

Indicateur de la 
cadence d'images
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Vue Comments
La vue Comments permet de saisir et de consulter 
les commentaires spécifiques à une piste.

Vue Mic Preamps
La vue Mic Preamps affiche des commandes pour 
les pistes dont les entrées audio physiques sont 
routées via un préampli PRE. 

Vue Instruments
La vue Instruments affiche les commandes MIDI 
des pistes d'instrument : sélecteurs d'entrée et de 
sortie MIDI, volume, panoramique et mute MIDI.

Vue Inserts (A-E et F-J)
La vue Inserts affiche jusqu'à dix inserts (plug-ins 
logiciels et inserts matériels de génération ou 
traitement audio) sur chaque piste audio, d'entrée 
auxiliaire, Master Fader et d'instrument. 

Vue Sends (A–E et F–J)
La vue Sends affiche les assignations de départ de 
chaque piste audio, d'entrée auxiliaire et d'instrument. 

Vue I/O
Dans la fenêtre Edit, la vue I/O affiche les sélecteurs 
d'entrée et sortie des pistes audio, d'entrée auxiliaire, 
Master Fader (sortie uniquement), MIDI et 
d'instrument (correspondant aux commandes du 
même nom de la fenêtre Mix).

Pour afficher la vue I/O dans la fenêtre Edit :

 Sélectionnez View > Edit Window > I/O.

Indicateur de volume/crête/délai de canal

L'indicateur de volume d'une piste audio propose 
trois modes d'affichage : Volume, Peak (crête) et 
Channel Delay (délai du canal).

Pour plus d'informations sur la vue 
Comments, reportez-vous à la section « Ajout 
de commentaires aux pistes », à la page 220.

Pour plus d'informations, reportez-vous au 
Guide PRE.

Pour plus d'informations, reportez-vous à la 
section « Assignation d'une entrée et d'une 
sortie MIDI sur des pistes d'instrument », à la 
page 243.

Pour plus d'informations sur les inserts, 
reportez-vous au Chapitre 44, « Inserts de 
plug-in et matériels »

Pour plus d'informations, reportez-vous à la 
section « Configuration de la vue Sends dans 
les fenêtres Mix et Edit », à la page 1002.

Vue I/O de la fenêtre Edit (piste audio)

Les sélecteurs d'entrée et de sortie sont 
toujours affichés sur les tranches de la fenêtre 
Mix, de la même manière que les valeurs de 
volume et de panoramique ; la vue I/O n'est 
donc pas disponible dans cette fenêtre.

Pour plus d'informations sur les sélecteurs 
d'entrée et de sortie, reportez-vous à la section 
« Assignation des entrées et sorties audio des 
pistes », à la page 234.

Sélecteur de chemin d'entrée

Sélecteur de chemin de sortie

Indicateur de volume
Indicateur de panoramique

Bouton de la fenêtre Output



Chapitre 13 : Pistes 209

Pour changer le mode d'affichage de l'indicateur 
de volume :

 Pour basculer d'un mode à l'autre, maintenez la 
touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez sur l'indicateur.

Indicateur de volume (et fenêtre pop-up de 
fader) : affiche le volume actuel, ou le niveau 
d'entrée d'une piste, défini par son fader de 
volume. En vue I/O (fenêtre Edit), cliquez sur 
l'indicateur de volume pour afficher la fenêtre 
pop-up du fader et ajuster le volume.

Indicateur de crête : fonctionne comme un 
indicateur de réserve de gain, basé sur le dernier 
niveau crête lu. Pour réinitialiser l'indicateur de 
crête, cliquez dessus. Les valeurs sont comprises 
entre –∞ (aucun signal) et 0 dB. 

Indicateur de panoramique

L'indicateur de panoramique affiche le réglage 
actuel du panoramique d'une piste. Les valeurs 
de panoramique s'étendent de <100 (entièrement 
à gauche) à 100> (entièrement à droite). 
Les commandes de panoramique ne sont 
disponibles que sur les pistes stéréo ou les pistes 
mono routées vers une sortie stéréo.

En vue I/O (fenêtre Edit), cliquez sur l'indicateur 
de panoramique pour afficher la fenêtre pop-up du 
curseur d'ajustement du panoramique.

Curseur de panoramique

Le curseur de panoramique contrôle la balance 
d'une piste entre la paire de sorties qui lui est 
assignée. Il n'apparaît que sur les pistes stéréo ou 
mono routées vers une sortie stéréo.

Le curseur de panoramique d'une piste MIDI ne 
fonctionne que si vous contrôlez un instrument 
virtuel ou expandeur prenant en charge le 
panoramique MIDI.

Fader de volume

Le fader de volume contrôle le niveau de lecture 
d'une piste, ou de monitoring lorsqu'elle est en 
enregistrement. Vous pouvez lier les niveaux 
d'enregistrement et de monitoring en activant 
l'option Link Record and Play Faders des 
préférences de fonctionnement.

Le niveau de gain maximum appliqué par un fader 
de volume est de +12 dB.

Fenêtre pop-up de fader de volume d'une piste audio 
en vue I/O (fenêtre Edit)

Fenêtre pop-up du curseur de panoramique d'une 
piste audio en vue I/O (fenêtre Edit)

Aucun indicateur de panoramique n'est 
disponible en vue I/O pour les pistes 
multicanal de format supérieur à stéréo. Vous 
pouvez afficher et ajuster le panoramique 
multicanal à partir de la fenêtre Output de la 
piste ou de la fenêtre Mix.

Vous pouvez lier la commandes de 
panoramique d'un départ à celle du 
panoramique principal en activant le bouton 
Follow Main Pan de la fenêtre du départ.
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Fader de volume MIDI

Si votre instrument virtuel ou expandeur MIDI 
prend en charge le volume, le fader de volume 
d'une piste MIDI ou d'instrument peut envoyer au 
contrôleur de volume MIDI une valeur comprise 
entre 0 et 127.

RealTime Properties
Dans la fenêtre Edit, la vue RealTime Properties 
permet d'accéder aux commandes des propriétés 
en temps réel (Quantize ou Transpose par 
exemple) des pistes MIDI et d'instrument. Pour 
plus d'informations, reportez-vous à la section 
« Propriétés MIDI en temps réel », à la page 725.

Track Color
Dans la fenêtre Edit, la vue Track Color affiche les 
bandes de couleur des pistes à gauche de leurs 
commandes.

Indicateurs de niveau de piste
Sur les pistes audio, les indicateurs de niveau 
affichent le niveau du signal en cours 
d'enregistrement ou de lecture sur ou à partir 
du disque dur. Lorsqu'une piste audio est activée 
pour l'enregistrement ou en mode de monitoring 
d'entrée, ses indicateurs de niveau affichent le 
niveau d'enregistrement ou de monitoring, 
respectivement.

Sur les pistes d'entrée auxiliaire, Master Fader et 
d'instrument, les indicateurs de niveau affichent le 
niveau du signal actuellement en sortie du canal. 

Sur les pistes MIDI et en vue Instruments pour les 
pistes d'instrument, l'indicateur de niveau indique 
la vélocité MIDI de l'événement MIDI le plus 
récent.

Piste audio stéréo avec indicateurs de niveau du 
signal et de réduction de gain dans la fenêtre Mix 
(Pro Tools HD)

Échelle du
type

d'indicateur

Échelle de
gain du

fader

Témoin 
d'écrêtage

Indicateur 
de réduction 
de gain 
(Pro Tools HD 
uniquement)

Indicateurs 
de niveau de 
la piste
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Échelle de gain du fader

L'échelle de gain du fader indique la quantité 
d'augmentation ou d'atténuation du gain appliquée 
au signal par le fader. 

Échelle du type d'indicateur : affiche l'échelle 
de mesure du niveau pour le type d'indicateur 
sélectionné (reportez-vous à la section « Mesure 
des niveaux avancée », à la page 214).

Indicateur de réduction de gain (Pro Tools HD 
uniquement) : Pro Tools HD permet d'afficher un 
indicateur de réduction de gain, à droite des 
indicateurs de niveau des pistes audio, d'entrée 
auxiliaire, d'instrument et Master Fader, lorsque 
des plug-ins de traitement dynamique pris en 
charge sont insérés (tels que les plug-ins Avid 
Pro Compressor ou Pro Expander). Pour plus 
d'informations, reportez-vous à la section 
« Configuration des indicateurs de réduction de 
gain », à la page 216.

Indicateurs de niveau de la piste : pour les pistes 
audio, d'entrée auxiliaire, d'instrument, VCA 
(Pro Tools HD uniquement) et Master Fader, 
les indicateurs de niveau affichent un repère de 
couleur verte qui indique l'emplacement du 0 dB 
numérique sur l'échelle sélectionnée. Si le 0 dB 
numérique se trouve au-delà de l'échelle de mesure 
affichée, le repère apparaît en haut de l'indicateur, 
en orange.

Indicateur d'écrêtage : s'affiche en rouge 
lorsqu'un écrêtage se produit sur les convertisseurs 
d'entrée ou de sortie de l'interface audio, ou lors de 
l'écriture d'un fichier audio 16 ou 24 bits. 
L'indicateur d'écrêtage s'affiche en jaune lorsque le 
niveau dépasse 0 dBFS dans le mixeur interne. 
Pour plus d'informations, reportez-vous à la 
section « Indication de l'écrêtage », à la page 212.

Mesure des niveaux pré et 
post-fader
Vous pouvez configurer globalement les indicateurs 
de niveau des pistes audio pour qu'ils affichent 
les niveaux pré ou post-fader. Lorsque l'option Pre-
Fader Metering est sélectionnée, les indicateurs de 
niveau affichent les niveaux avant fader, sans tenir 
compte de la position du fader. Avec l’option Post-
Fader Metering, les indicateurs de niveau tiennent 
compte des mouvements des faders.

Pour basculer entre les modes pré et post-fader 
des indicateurs de niveau :

 Sélectionnez Options > Pre-Fader Metering.

Maintien des niveaux crêtes
Les indicateurs de niveau de Pro Tools disposent 
de trois options pour le maintien du niveau crête : 
3 Second, Infinite ou None.

Pour sélectionner une option de maintien de 
l'affichage des niveaux crête :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Metering.

2 Sélectionnez une option Peak Hold.

3 Cliquez sur OK.

Pour réinitialiser un indicateur de niveau :

 Cliquez n'importe où sur l'indicateur de niveau. 

Pour réinitialiser tous les indicateurs de niveau, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur un 
indicateur de niveau.

 Sélectionnez Track > Clear All Clip Indicators.

 Appuyez sur Alt+C (Windows) ou 
Option+C (Mac).
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Indication de l'écrêtage
Les calculs dans Pro Tools sont effectués sur 
64 bits en virgule flottante. De ce fait, aucun 
écrêtage interne ne peut se produire dans le 
mixeur. Cependant, des écrêtages peuvent survenir 
au niveau des convertisseurs de votre interface 
audio. Cela peut également être le cas lors de 
l'écriture de fichiers audio en virgule fixe sur le 
disque (fichiers 16 ou 24 bits uniquement, 
les fichiers 32 bits en virgule flottante ne subiront 
pas d'écrêtage).

Les indicateurs de niveau de Pro Tools proposent 
trois options de maintien de l'affichage des 
écrêtages : 3 Second, Infinite ou None. Si un 
écrêtage survient, la LED la plus en haut de 
l'indicateur reste allumée.

Pour sélectionner une option de maintien de 
l'affichage des écrêtages :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Metering.

2 Sélectionnez une option Clip Indication.

3 Cliquez sur OK.

Pour réinitialiser un indicateur d'écrêtage :

 Cliquez n'importe où sur l'indicateur de niveau. 

Pour réinitialiser tous les indicateurs d'écrêtage, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur un 
indicateur de niveau.

 Sélectionnez Track > Clear All Clip Indicators.

 Appuyez sur Alt+C (Windows) ou Option+C 
(Mac).

Indicateurs d'écrêtage des pistes 
Master Fader

Les indicateurs d'écrêtage des pistes Master Fader 
s'allument en rouge lorsque le signal audio dépasse 
0 dBFS et provoque un écrêtage au niveau des 
convertisseurs de sortie de votre interface audio. 
Les indicateurs de niveau de sortie de la fenêtre de 
transport se comportent de manière identique.

Indicateurs d'écrêtage des pistes audio

Les indicateurs d'écrêtage des pistes audio 
s'allument en rouge dans les cas suivants (en jaune 
dans les autres cas) :

• Lorsqu'une piste audio est activée pour 
l'enregistrement ou configurée pour le 
monitoring de l'entrée et qu'un signal d'entrée 
dépassant 0 dBFS lui est envoyé, provoquant un 
écrêtage sur les convertisseurs.

• Lorsqu'une piste audio est en cours 
d'enregistrement dans une résolution en virgule 
fixe (16 ou 24 bits) et que l'audio écrit sur le 
disque dépasse 0 dBFS, provoquant un écrêtage 
dans le fichier.

Des indicateurs d'écrêtage sont présents dans 
les fenêtres des plug-ins, des départs et des 
pistes.

Pistes audio, d'entrée auxiliaire, d'instrument et 
Master Fader indiquant un écrêtage
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Indicateurs d'écrêtage des pistes 
d'entrée auxiliaire et d'instrument et 
des départs

Les indicateurs d'écrêtage des pistes d'entrée 
auxiliaire, d'instrument et des départs s'allument 
en jaune lorsque le signal dépasse 0 dBFS, 
même si aucun écrêtage interne ne se produit. 
Cet avertissement vous informe que ces flux audio 
peuvent provoquer un écrêtage au niveau des 
convertisseurs de sortie ou lors de l'écriture d'un 
fichier en virgule fixe sur le disque.

Vue large des indicateurs de 
niveau
La vue large des indicateurs de niveau permet de 
consulter plus facilement les niveaux affichés sur 
les indicateurs des fenêtres Mix et Edit. Cette vue 
est également disponible en vue réduite de la 
fenêtre Mix.

Pour activer ou désactiver la vue large des 
indicateurs de niveau :

 Maintenez les touches Ctrl+Alt+Démarrer 
(Windows) ou Commande+Option+Ctrl (Mac) 
enfoncées et cliquez sur un indicateur de niveau 
de piste dans la fenêtre Mix ou Edit.

Affichage ou masquage des 
indicateurs de niveau et des 
faders
Pro Tools permet d'afficher ou de masquer les 
indicateurs de niveau et les faders dans la fenêtre 
Mix. Vous pouvez ainsi économiser de l'espace 
à l'écran, en particulier si vous travaillez avec une 
surface de contrôle.

Pour afficher (ou masquer) les indicateurs de 
niveau et les faders dans la fenêtre Mix, effectuez 
l'une des opérations suivantes :

 Sélectionnez (ou désélectionnez) View > Mix 

Window Views > Meters and Faders.

 Depuis le sélecteur de vues de la fenêtre Mix, 
sélectionnez (ou désélectionnez) Meters and 

Faders.

Vue large des indicateurs de niveau dans les fenêtres 
Mix et Edit

Sélecteur de vue de la fenêtre Mix
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Mesure des niveaux avancée
Pro Tools permet de sélectionner le type 
d'indicateur et l'échelle de mesure des niveaux les 
plus adaptés à vos besoins pour le monitoring 
visuel des niveaux audio. Pour la plupart des 
utilisateurs, les paramètres par défaut de chaque 
type d'indicateur conviendront. Cependant, 
d'autres options permettront aux sociétés de 
broadcast, de post-production, de mixage ou de 
mastering, d'aligner la mesure des niveaux dans 
Pro Tools sur celle de diverses consoles ou autres 
périphériques externes. 

Échelles du fader et de mesure

Dans la fenêtre Mix, Pro Tools affiche une échelle 
d'augmentation et d'atténuation du gain, mesurée en 
dB, à gauche du fader de volume des pistes, graduée 
de +12 dB à -INF dB. Cette échelle indique dans 
quelle proportion les mouvements du fader affectent 
le niveau audio de chaque piste. Dans certains cas, 
par exemple lorsque les indicateurs sont affichés en 
vue large ou pour un format de canal supérieur 
à stéréo, l'échelle du fader peut ne pas apparaître.

Les valeurs affichées entre le fader et les 
indicateurs de niveau dépendent du paramètre 
Meter Type sélectionné. Par exemple, pour le type 
Peak, l'échelle de mesure s'étend de 0 dB à -60 dB, 
alors que pour le type VU, elle couvre une plage de 
+3 dB à -20 dB.

Position de l'indicateur de réduction de 
gain selon l'échelle
(Pro Tools HD uniquement)

La position de l'indicateur de réduction de gain, 
lorsqu'il est affiché, dépend de l'échelle du type 
d'indicateur de niveau sélectionné. Le haut de 
l'indicateur de réduction de gain est toujours aligné 
sur le niveau de référence du type d'indicateur 
sélectionné. De la même manière, la position du 
bas de l'indicateur de réduction de gain s'adapte 
à la plage de l'indicateur correspondant au 
paramètre Meter Type sélectionné.

Sélection d'un type d'indicateur de 
niveau

Vous pouvez définir le type d'indicateur de niveau 
dans les préférences Metering de Pro Tools, ou via 
le menu contextuel Meter. Selon la configuration 
du paramètre Track and Master Meter Types 
Linked, vous pouvez définir des types d'indicateurs 
de pistes (audio, d'entrée auxiliaire et d'instrument) 
ou de Masters (Master Fader) indépendants.

Échelles de différents types d'indicateurs

Échelle du
type

d'indicateur

Peak VU

Différents emplacements de l'indicateur de réduction 
de gain selon le type d'indicateur

Reportez-vous à la section « Track and 
Master Meter Types », à la page 119 pour 
plus d'informations sur les types 
d'indicateurs disponibles.

Peak VU K-20
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Pour définir le type d'indicateur de niveau des 
pistes et des Masters dans les préférences de 
Pro Tools :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Metering.

3 Activez ou désactivez l'option Track and Master 

Meter Types Linked.

4 Effectuez l'une des opérations suivantes :

• Si l'option Track and Master Meter Types Linked 
est activée, sélectionnez le type d'indicateur 
souhaité dans le menu déroulant Track Meters 
ou Master Meters.

• Si l'option Track and Master Meter Types Linked 
est désactivée, sélectionnez le type d'indicateur 
souhaité pour les pistes dans le menu Track 

Meters et un autre pour les pistes Master dans le 
menu Master Meters.

5 Cliquez sur OK.

Pour définir le type d'indicateur de niveau des 
pistes dans la fenêtre Mix ou Edit :

1 Effectuez un clic droit sur l'indicateur de niveau 
d'une piste.

2 Dans le menu Meter Type, sélectionnez le type 
d'indicateur souhaité.

Pour définir le type d'indicateur de niveau des 
pistes Master dans la fenêtre Mix ou Edit :

1 Effectuez un clic droit sur l'indicateur de niveau 
d'une piste Master.

2 Dans le menu Meter Type, sélectionnez le type 
d'indicateur souhaité.

Les raccourcis Option+Clic droit (Mac) ou 
Alt+Clic droit (Windows) sur un indicateur 
de piste permettent de sélectionner le même 
type d'indicateur pour tous les types de 
pistes, quelle que soit la configuration de 
l'option Types d'indicateurs de niveau master 
et pistes liés.

Si l'option Track and Master Meter Types 
Linked est activée dans les préférences 
Metering de Pro Tools, le type sélectionné est 
également appliqué aux indicateurs des 
pistes Master.

Si l'option Track and Master Meter Types 
Linked est activée dans les préférences 
Metering de Pro Tools, le type sélectionné est 
appliqué aux indicateurs de toutes les pistes.

Sélection d'un type d'indicateur de niveau dans la 
fenêtre Mix (Pro Tools HD)
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Configuration des indicateurs de 
réduction de gain
(Pro Tools HD uniquement)

Vous pouvez configurer les indicateurs de réduction 
de gain dans les préférences Metering de Pro Tools, 
ou via le menu contextuel Meter. Le type 
d'indicateur de réduction de gain sélectionné 
s'applique à la fois aux indicateurs des pistes et des 
Masters, quelle que soit la configuration de l'option 
Track and Master Meter Types Linked.

Pour configurer le type d'indicateur de réduction 
de gain, effectuez l'une des opérations suivantes :

 Sélectionnez Setup > Preference > Metering et 
choisissez un type à l'aide du paramètre Gain 

Reduction Meter Type.

 Effectuez un clic droit sur l'indicateur de niveau 
d'une piste et sélectionnez une option dans le 
sous-menu Gain Reduction du menu Gain 

Reduction Meter Type.

Ajustement de la largeur 
des pistes
(Fenêtre Mix)

La commande Narrow Mix permet d'afficher 
l'ensemble des pistes ou des canaux de la fenêtre 
Mix en largeur réduite afin de conserver de 
l'espace à l'écran pour les sessions de grande taille. 
Pour plus d'informations sur l'ajustement de la 
hauteur des pistes dans la fenêtre Edit, reportez-
vous à la section « Hauteur de piste », à la 
page 228.

Pour réduire la largeur des pistes dans la 
fenêtre Mix :

 Sélectionnez View > Narrow Mix.

Pour afficher les pistes à leur largeur normale :

 Désactivez l'option View > Narrow Mix.

Activation des indicateurs de réduction de gain dans la 
fenêtre Mix

Vous pouvez basculer entre les largeurs de 
piste normale et réduite en appuyant sur les 
touches Commande+Option+M (Mac) ou 
Ctrl+Alt+M (Windows).
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Création de pistes
Vous pouvez créer des pistes mono et stéréo sur 
tous les systèmes Pro Tools. Dans Pro Tools HD, 
vous pouvez également créer des pistes multicanal 
(de LCR à 7.1).

Lorsque de nouvelles pistes sont créées, un nom 
par défaut leur est attribué, mais reste modifiable 
à tout moment.

 Pour insérer de nouvelles pistes à côté d'une 
piste spécifique d'une session, sélectionnez cette 
piste en cliquant sur son nom dans la fenêtre Mix 
ou Edit avant d'ouvrir la boîte de dialogue New 
Tracks. Les nouvelles pistes viennent s'ajouter 
immédiatement après la piste sélectionnée. 

 Pour insérer de nouvelles pistes après la 
dernière piste d'une session, assurez-vous qu'aucun 
nom de piste ne soit sélectionné à l'écran avant 
d'ouvrir la boîte de dialogue New Tracks

Pour créer des pistes :

1 Effectuez l'une des opérations suivantes pour 
ouvrir la boîte de dialogue New Tracks :

• Sélectionnez Track > New.

• Effectuez un clic droit sur le nom d'une piste 
dans la fenêtre Mix ou Edit, ou dans la liste des 
pistes, puis sélectionnez New.

2 Sélectionnez à partir du menu Track Type le 
type de piste que vous souhaitez créer. 

3 Sélectionnez le format de piste (mono, stéréo ou 
l'un des formats surround multicanal) à partir du 
menu Track Format. Les formats surround sont 
uniquement disponibles dans Pro Tools HD.

4 Sélectionnez la base de temps (échantillons ou 
références de tempo) à partir du menu Track 

Timebase.

5 Entrez le nombre de nouvelles pistes.

Vous pouvez également ajouter des pistes 
à votre session en les important à partir de 
sessions existantes. Reportez-vous à la section 
« Importation de données de session », à la 
page 352.

Pour ouvrir la boîte de dialogue New Tracks, 
appuyez sur Commande+Maj+N (Mac) ou 
Ctrl+Maj+N (Windows).

Boîte de dialogue New Tracks

Pour parcourir les options du menu Track 
Type de la boîte de dialogue New Tracks, 
maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée, puis utilisez les 
touches Flèche haut et bas.

Pour parcourir les options du menu Track 
Format, maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée, puis utilisez 
les touches Flèche gauche et droite.

Pour parcourir les options du menu Track 
Timebase, maintenez les touches Ctrl+Alt 
(Windows) ou Commande+Option (Mac) 
enfoncées, puis utilisez les touches Flèche 
haut et bas.

Si vous créez plusieurs nouvelles pistes de 
types différents, vous pouvez naviguer entre 
les champs du nombre de pistes de chaque 
rangée en appuyant sur les touches Tab ou 
Maj+Tab.

Nombre de nouvelles pistes

Format de piste
Type de piste Base de 

temps de la piste

Ajouter/supprimer une rangée
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6 Effectuez l'une des opérations suivantes :

• Pour ajouter d'autres pistes, cliquez sur le bouton 
d'ajout de rangée.

• Pour supprimer une piste, cliquez sur le bouton 
de suppression de rangée.

7 Pour modifier l'ordre des pistes, faites glisser 
une icône de déplacement de rangée vers le haut 
ou le bas.

8 Cliquez sur Create.

Création de pistes par un 
double-clic dans la fenêtre Edit 
ou Mix
Pro Tools permet d'ajouter de nouvelles pistes en 
double-cliquant sur un espace vierge en dessous 
des pistes dans la fenêtre Edit, ou en dessous ou 
à droite des pistes dans la fenêtre Mix.

Pour ajouter une nouvelle piste du même type et 
du même format de canal que la dernière piste 
créée, effectuez l'une des opérations suivantes :

 Double-cliquez sur la zone vierge de la fenêtre 
Mix, en dessous ou à droite des pistes actuelles.

 Double-cliquez sur la zone vierge de la fenêtre 
Edit, en dessous des pistes actuelles.

 Double-cliquez sur la zone vierge en dessous 
des pistes actuelles de la liste des pistes.

Si la session ne comporte aucune piste, une piste 
stéréo est créée par défaut.

Pour ajouter une nouvelle piste audio du même 
format de canal que la dernière piste créée, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et double-cliquez sur la 
zone vierge de la fenêtre Mix, en dessous ou 
à droite des pistes actuelles.

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et double-cliquez sur la 
zone vierge de la fenêtre Edit, en dessous des 
pistes actuelles.

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et double-cliquez sur la 
zone vierge en dessous des pistes actuelles de la 
liste des pistes.

Si la session ne comporte aucune piste, une piste 
stéréo est créée par défaut.

Vous pouvez ajouter une nouvelle rangée en 
appuyant sur les touches Commande+N 
(Mac) ou Ctrl+N (Windows), ou 
Commande+Plus (+) (Mac) ou Ctrl+Plus 
(+) (Windows) sur le pavé numérique. 

Pour supprimer la dernière rangée de la 
boîte de dialogue New Tracks, appuyez sur 
Ctrl+Moins (-) (Windows) ou 
Commande+Moins (-) (Mac).

Icône de déplacement de rangée dans la boîte de 
dialogue New Tracks
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Pour ajouter une nouvelle piste d'entrée auxiliaire 
du même format de canal que la dernière piste 
créée, effectuez l'une des opérations suivantes :

 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et double-cliquez sur la 
zone vierge de la fenêtre Mix, en dessous ou 
à droite des pistes actuelles.

 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et double-cliquez sur la 
zone vierge de la fenêtre Edit, en dessous des 
pistes actuelles.

 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et double-cliquez sur la 
zone vierge en dessous des pistes actuelles de la 
liste des pistes.

Si la session ne comporte aucune piste, une piste 
d'entrée auxiliaire stéréo est créée par défaut.

Pour ajouter une nouvelle piste Master Fader du 
même format de canal que la dernière piste créée, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Maj enfoncée et double-
cliquez sur la zone vierge de la fenêtre Mix, 
en dessous ou à droite des pistes actuelles.

 Maintenez la touche Maj enfoncée et double-
cliquez sur la zone vierge de la fenêtre Edit, 
en dessous des pistes actuelles.

 Maintenez la touche Maj (Mac) enfoncée et 
double-cliquez sur la zone vierge en dessous des 
pistes actuelles de la liste des pistes.

Si la session ne comporte aucune piste, une piste 
Master Fader stéréo est créée par défaut.

Noms de piste par défaut
Lorsque vous créez des pistes audio, d'entrée 
auxiliaire, Master Fader, Master VCA, MIDI et 
d'instrument, Pro Tools les nomme « Audio », 
« Aux », « Master », « VCA », « MIDI » ou 
« Inst » et les numérote de façon séquentielle. 
Par exemple, lorsque vous créez les deux 
premières pistes audio d'une nouvelle session, 
les noms par défaut sont « Audio 1 » et 
« Audio 2 ». Vous pouvez renommer les pistes et 
saisir des commentaires pour chacune d'elles.

Attribution de noms aux pistes
Les noms des pistes servent aussi à nommer 
automatiquement les clips et fichiers audio 
enregistrés.

Pour renommer une piste :

1 Effectuez l'une des opérations suivantes :

• Dans les fenêtres Mix ou Edit, double-cliquez 
sur le bouton du nom de la piste à renommer.

• Dans la liste des pistes ou dans la fenêtre Mix ou 
Edit, effectuez un clic droit sur le nom de la piste 
à modifier.

2 Dans la boîte de dialogue Track Name/Comments, 
saisissez un nouveau nom de piste.

Boîte de dialogue d'attribution de nom et de saisie de 
commentaires d'une piste



Guide de référence Pro Tools220

3 Cliquez sur Previous ou Next pour renommer 
d'autres pistes de la session.

4 Cliquez sur OK.

Ajout de commentaires aux 
pistes

Pour ajouter des commentaires à une piste, 
effectuez l'une des opérations suivantes :

 Sur une tranche de piste, cliquez directement 
sur la zone Comments, entrez le commentaire 
et appuyez sur Entrée (Windows) ou Retour 
(Mac). 

 Dans la fenêtre Edit ou Mix, double-cliquez sur 
le bouton du nom d'une piste. Cliquez ensuite 
directement dans la zone Comments, entrez le 
commentaire sur la piste et appuyez sur Entrée 
(Windows) ou Retour (Mac). 

Numérotation des pistes
En vue Track Number, chaque piste se voit 
assigner un numéro correspondant à sa position 
dans les fenêtres Mix et Edit. Lorsque l'ordre des 
pistes est modifié, elles sont renumérotées pour 
maintenir leur position séquentielle.

Pour activer la vue Track Number :

 Sélectionnez View > Track Number.

Pour accéder directement au numéro de piste de 
votre choix :

1 Sélectionnez Track > Scroll to Track.

2 Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de la piste à laquelle vous 
souhaitez accéder.

3 Cliquez sur OK.

Pour passer à la piste précédente ou suivante 
dans la boîte de dialogue d'attribution de 
nom et de saisie de commentaires, maintenez 
la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et appuyez sur les touches 
Flèche haut et bas ou gauche et droite.

Pour insérer un retour chariot dans la zone 
Comments, appuyez sur les touches 
Maj+Entrée (Windows) ou Maj+Retour 
(Mac) du clavier alphanumérique.

Appuyez sur Ctrl+Alt+F (Windows) ou 
Commande+Option+F (Mac) pour ouvrir 
la boîte de dialogue Scroll to Track.

Boîte de dialogue Scroll To Track
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Sélection de pistes
Des pistes doivent au préalable être sélectionnées 
pour des opérations telles que la duplication ou 
l'ajout de pistes à un groupe. Il est possible de 
sélectionner une ou plusieurs pistes à la fois.

Pour sélectionner une piste :

 Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance sur sa tranche.

Pour sélectionner une plage de pistes :

1 Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance sur sa tranche.

2 Cliquez sur un autre bouton tout en maintenant 
la touche Maj enfoncée.

Toutes les pistes comprises entre ces deux pistes 
sont également sélectionnées.

Pour sélectionner ou désélectionner des pistes 
non contiguës, effectuez l'une des opérations 
suivantes :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur des 
boutons de nom de piste qui ne sont pas en 
surbrillance pour les sélectionner.

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur des 
boutons de nom de piste qui sont en surbrillance 
pour les désélectionner.

Pour sélectionner toutes les pistes :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un bouton de nom 
de piste qui n'est pas en surbrillance.

Pour désélectionner toutes les pistes :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un bouton de nom 
de piste qui est en surbrillance.

Sélection de pistes lors de la création d'une 
sélection d'édition

Les sélections d'édition et de pistes peuvent être 
liées dans Pro Tools. Lorsque les sélections 
d'édition et de piste sont liées, vous pouvez créer 
une sélection sur une ou plusieurs pistes pour les 
éditer ; chaque piste est sélectionnée (les noms des 
pistes sont automatiquement mis en surbrillance). 

Pour lier les sélections d'édition et de piste :

 Sélectionnez Options > Link Track and Edit 

Selection.

Pistes sélectionnée et non sélectionnée

piste non sélectionnée
piste sélectionnée
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Défilement de la fenêtre jusqu'à 
une piste

Pour faire défiler l'affichage jusqu'à une piste 
spécifique :

 Dans la liste des pistes ou la fenêtre Mix ou 
Edit, effectuez un clic droit sur le nom d'une 
piste et sélectionnez Scroll into View.

Suppression de pistes
Lorsque vous supprimez des pistes, les données de 
vos clips audio ou MIDI restent dans la liste des 
clips, mais la disposition des clips de la piste 
supprimée (autrement dit, la playlist de la piste) 
est perdue. 

Si la piste contient des playlists qui ne sont 
assignées à aucune piste, vous êtes invité à les 
supprimer ou à les conserver.

Pour supprimer une piste :

1 Cliquez sur le nom de la piste souhaitée sur sa 
tranche pour la sélectionner. 

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Delete.

• Dans la liste des pistes ou la fenêtre Mix ou Edit, 
effectuez un clic droit sur le nom de la piste et 
sélectionnez Delete.

3 Cliquez sur OK pour supprimer les pistes 
sélectionnées de la session.

Duplication de pistes
La commande Duplicate Track permet de 
dupliquer une ou plusieurs pistes, y compris leurs 
données audio ou MIDI, les playlists, l'automation 
et d'autres attributs.

Pour dupliquer une ou plusieurs pistes :

1 Sélectionnez les pistes à dupliquer.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Duplicate. 

• Appuyez sur Alt+Maj+D (Windows) ou 
Option+Maj+D (Mac).

• Dans la liste des pistes ou la fenêtre Mix ou Edit, 
effectuez un clic droit sur le nom de la piste et 
sélectionnez Duplicate.

3 Dans la boîte de dialogue Duplicate Tracks, 
configurez les options suivantes :

• Entrez le nombre de copies à créer dans le 
champ Number of Duplicates. 

• Pour copier la playlist d'édition active (visible) 
sur la piste source, sélectionnez Active Playlist. 

La commande Delete Track ne peut être annulée.

Pour sélectionner plusieurs pistes, maintenez 
la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et cliquez sur les noms de 
pistes supplémentaires.

Pour sélectionner une plage de pistes, 
maintenez la touche Maj enfoncée et cliquez 
sur les noms d'autres pistes.

Pour plus d’informations, reportez-vous à la 
section « Sélection de pistes », à la page 221.

Boîte de dialogue Duplicate Tracks
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• Pour copier toutes les playlists d'édition de la 
piste source, sélectionnez Alternate Playlists.

• Pour copier toute l'automation de la piste source, 
sélectionnez Automation. 

• Pour copier toutes les assignations de plug-in et 
d'insert, sélectionnez Inserts. 

• Pour copier l'ensemble des départs et 
assignations des départs, sélectionnez Sends.

• Pour conserver toutes les assignations des 
groupes de mixage et d'édition, sélectionnez 
Group Assignments. 

4 Pour dupliquer plusieurs pistes, procédez 
comme suit :

• Si vous souhaitez que toutes les pistes dupliquées 
apparaissent à la suite de la dernière piste source 
sélectionnée (à l'extrême droite de la fenêtre Mix 
et au bas de la fenêtre Edit), sélectionnez l'option 
Insert after Last Selected Track.

• Si vous souhaitez que chaque piste dupliquée 
soit insérée directement après sa piste source, 
désactivez l'option Insert after Last Selected 

Track.

5 Cliquez sur OK pour dupliquer les pistes 
conformément aux paramètres de la boîte de 
dialogue Duplicate Tracks. Cliquez sur Cancel 
pour fermer la boîte de dialogue sans dupliquer 
les pistes. 

Duplication de pistes 
esclaves VCA
(Pro Tools HD uniquement)

Le fait de dupliquer une piste esclave VCA sans 
dupliquer ses assignations de groupe a pour effet 
de fusionner l'automation sur la piste dupliquée, 
le cas échéant. La piste dupliquée fondue est lue 
comme si elle appartenait au groupe VCA. Pour 
plus d'informations, reportez-vous à la section 
« Pistes Master VCA », à la page 987.

Vues de piste
La vue de piste détermine quelles données sont 
affichées et éditées dans la zone de la playlist de 
la piste. Les données des pistes peuvent être 
affichées en vue Playlists, Blocks, Analysis, Warp, 
Waveform, Volume, Volume Trim, Mute, Pan ou 
Send. La vue d'un paramètre automatisé ou d'un 
contrôleur continu peut également être activée, 
selon le type de piste et votre système Pro Tools.

Pistes audio : ces pistes peuvent être affichées en 
vue Blocks, Playlists, Analysis, Warp, Waveform, 
Volume, Volume Trim, Mute, Pan, ou représenter 
des commandes de départ ou toute commande de 
plug-in dont l'automation est activée. Les pistes 
audio sont affichées par défaut en vue Waveform 
et leurs données sont donc représentées 
graphiquement par des formes d'onde d'amplitude 
(représentation temporelle du son). Cette vue de 
piste est suffisamment détaillée pour les opérations 
d'édition de clips importantes.

Pistes d'entrée auxiliaire : ces pistes peuvent être 
affichées en vue Volume, Volume Trim, Mute, Pan, 
ou représenter des commandes de départ ou toute 
commande de plug-in dont l'automation est activée. 

Pistes Master Fader : ces pistes peuvent être 
affichées en vue Volume, Volume Trim, 
ou représenter toute commande de plug-in dont 
l'automation est activée.

Pistes Master VCA (Pro Tools HD uniquement) : 
ces pistes peuvent être affichées en vue Volume, 
Volume Trim ou Mute.



Guide de référence Pro Tools224

Pistes MIDI : ces pistes peuvent être affichées en 
vue Blocks, Clips, Notes, Velocity, Volume, Mute, 
Pan, Pitch Bend, Mono After Touch, Program 

Change, Sysex, ou représenter tout type de 
contrôleur continu. Les pistes MIDI sont en général 
affichées en vue Notes ou Clips, dans lesquelles les 
notes apparaissent sous la forme d'une bande 
perforée pour piano mécanique. Utilisez la vue 
Clips pour éditer et organiser les clips MIDI. 
Utilisez la vue Notes pour insérer et éditer des notes 
MIDI. D'autres vues de piste MIDI s'avèrent 
particulièrement utiles pour l'édition de la vélocité, 
des données de contrôleur, des changements de 
programme et des événements Sysex.

Pistes d'instrument : ces pistes peuvent être 
affichées en vue Blocks, Clips, Notes, Velocity, 
Volume, Mute, Pan, Pitch Bend, Mono After Touch, 
Program Change, Sysex, ou représenter tout type 
de contrôleur continu pour le MIDI ; ainsi 
qu'en vue Volume, Volume Trim, Mute, Pan, 
ou représenter des commandes de départ ou toute 
commande de plug-in dont l'automation est 
activée. Les pistes d'instrument sont en général 
affichées en vue Notes ou Clips, dans lesquelles les 
notes apparaissent sous la forme d'une bande 
perforée pour piano mécanique. Utilisez la vue 
Notes pour insérer, modifier, copier et coller des 
notes MIDI. Utilisez la vue Clips pour organiser, 
capturer ou consolider des clips. D'autres vues de 
piste d'instrument s'avèrent particulièrement utiles 
pour l'édition de l'automation, des données de 
contrôleur, des changements de programme et des 
événements Sysex.

Pistes vidéo : pour plus d'informations sur les 
vues de piste vidéo, reportez-vous à la section 
« Vue de piste vidéo », à la page 1249.

Vue de piste Blocks
En vue de piste Blocks, les clips audio et MIDI sont 
affichés sous la forme de blocs vides portant le 
nom du clip. Cette vue de piste est particulièrement 
utile lorsque, après avoir capturé et édité des clips 
au niveau de la forme d'onde ou des événements 
MIDI, vous désirez les déplacer et les réorganiser. 
Les rafraîchissements d'écran sont plus rapides 
avec ce format d'affichage.

Vue de piste Playlists
(Pistes audio uniquement)

En vue de piste Playlists, les playlists alternatives 
des pistes audio sont affichées sur des lignes de la 
playlist, sous la playlist principale. Cette vue est 
utile pour créer des pistes composites, car vous 
pouvez sélectionner les meilleures parties des 
playlists alternatives des pistes, afin de les copier 
dans la playlist principale.

Vues de piste Analysis et Warp
(Pistes audio uniquement)

En vue de piste Analysis ou Warp, vous pouvez 
éditer l'analyse Elastic Audio et les marqueurs de 
déformation des pistes Elastic Audio.

Vue Waveform
(Audio uniquement)

En vue de piste Waveform, vous pouvez éditer 
et organiser les clips audio sur les pistes audio. 
Les formes d'onde sont des représentations 
temporelles et peuvent être standard ou rectifiées, 
et calculées en mode Peak ou Power.

Piste audio en vue Waveform
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Vue Clips
(MIDI uniquement)

En vue de piste Clips, vous pouvez éditer et 
organiser les clips MIDI sur les pistes MIDI et 
d'instrument.

Vue Notes
(MIDI uniquement)

Lorsque la vue de piste active est Notes, vous 
pouvez insérer et éditer des notes MIDI sur les 
pistes MIDI et d'instrument.

Vues d'automation et de 
contrôleur
Lorsqu'une piste audio ou d'instrument est affichée 
en vue Volume, Pan, ou présente l'automation 
d'une autre commande, ou lorsqu'une piste MIDI 
ou d'instrument affiche l'un des types de contrôleur 
continu (Volume ou Pitch Bend par exemple), 
les données de cette piste apparaissent sous la 
forme d'un graphique linéaire comprenant une 
série de points d'automation éditables. Pour 
modifier l'automation, déplacez ces points 
d'automation ou ajoutez-en à l'aide du Crayon 
ou de la Main. Une vue Velocity est également 
disponible pour l'édition des vélocités MIDI des 
notes des pistes MIDI et d'instrument.

Sur les pistes audio, la forme d'onde est 
également visible en vue Playlists, Analysis, 
Warp et Automation.

Piste MIDI en vue Clips

Piste audio en vue Pan

Pour plus d'informations sur l'insertion et 
l'édition des données de contrôleur des pistes 
MIDI, reportez-vous à la section 
« Événements de contrôleur continu », à la 
page 712.

Vous pouvez également éditer des données 
d'automation et de contrôleur sur les lignes 
apparaissant sous la vue de la playlist 
principale d'une piste. Pour plus 
d'informations sur l'édition des données 
d'automation des pistes audio, reportez-vous 
au chapitre Chapitre 45, « Automation »
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Sélection de vues de piste 
dans la fenêtre Edit
Pour sélectionner une vue de piste :

 Cliquez sur le sélecteur de vue de piste et 
sélectionnez une vue dans le menu déroulant.

La piste s'affiche dans la nouvelle vue. Si elle fait 
partie d'un groupe d'édition actif, toutes les autres 
pistes du groupe passent également sur cette 
nouvelle vue.

Sélecteur de vue de piste audio

Sélecteur de vue de piste auxiliaire

Sélecteur de vue de piste Master Fader

Sélecteur de vue de piste Master VCA (Pro Tools HD 
uniquement)

Sélecteur de vue de piste MIDI

Sélecteur de vue de piste d'instrument
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Changement de vue de piste
Avec les pistes audio, MIDI, d'entrée auxiliaire et 
d'instrument, vous pouvez passer d'une vue à la 
suivante ou à la précédente, ou basculer entre 
plusieurs vues courantes prédéfinies.

Passer à la vue précédente ou suivante

Lorsque vous passez à la vue suivante ou que vous 
revenez à la vue précédente, l'ordre de la liste du 
sélecteur des vues de piste est respecté.

Pour passer à la vue suivante ou précédente :

1 Cliquez sur la piste dont vous souhaitez 
modifier la vue. Pour changer la vue de 
plusieurs pistes, maintenez la touche Maj 
enfoncée et cliquez sur les pistes souhaitées ou 
faites glisser le Sélecteur, ou bien sélectionnez 
un groupe.

2 Effectuez l'une des opérations suivantes :

• Pour passer à la vue précédente ou suivante sur 
toutes les pistes sélectionnées, maintenez les 
touches Ctrl+Démarrer (Windows) ou 
Ctrl+Commande (Mac) enfoncées et appuyez 
sur la touche Flèche gauche ou droite.

• Pour passer à la vue précédente ou suivante sur 
toutes les pistes, maintenez les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées et 
appuyez sur la touche Flèche gauche ou droite.

Basculement d'une vue de piste courante 
à une autre

Les vues de piste les plus couramment utilisées 
pour l'édition de pistes audio sont les vues 
Waveform et Volume. Pour l'édition de pistes 
MIDI et d'instrument, il s'agit des vues Notes et 
Clips. Pro Tools offre la possibilité de basculer 
simplement d'une vue à l'autre.

Pour modifier les vues des pistes sur les pistes 
contenant le curseur d'édition (ou une sélection 
d'édition) :

1 Cliquez sur la piste pour laquelle vous souhaitez 
modifier la vue. Pour changer la vue de 
plusieurs pistes, maintenez la touche Maj 
enfoncée et faites glisser avec le Sélecteur pour 
sélectionner les pistes supplémentaires.

2 Effectuez l'une des opérations suivantes :

• Appuyez sur Démarrer+Moins (-) (Windows) ou 
Ctrl+Moins (-) (Mac) (clavier alphanumérique).

• Après avoir activé le focus clavier sur les 
commandes (reportez-vous à la section « Focus 
clavier », à la page 26), appuyez sur la touche 
Moins (-) du clavier alphanumérique.

Les pistes audio passent de la vue Waveform à la 
vue Volume et inversement. Les pistes MIDI et les 
pistes d'instrument passent de la vue Notes à la vue 
Clips, et inversement.

Il est impossible de revenir à la vue 
précédente à partir d'une vue située en tête de 
liste (vue Blocks pour les pistes audio ou 
MIDI par exemple). De même, vous ne 
pouvez pas passer à la vue suivante à partir 
d'une vue située en fin de liste (une vue de 
contrôleur MIDI par exemple).

Pour basculer la vue de toutes les pistes, 
appuyez sur Option+Ctrl+Moins (-) (Mac) 
ou Alt+Démarrer+Moins (-) (Windows) 
(clavier alphanumérique).

Pour basculer la vue de toutes les pistes avec 
le focus clavier activé sur les commandes, 
appuyez sur Option+Moins (-) (Mac) ou 
Alt+Moins (-) (Windows) (clavier 
alphanumérique).
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Vues principales des pistes
Une vue « principale » est définie pour les pistes 
audio, MIDI et d'instrument. Lorsqu'une piste est 
affichée dans sa vue principale, toute opération 
d'édition s'applique à l'ensemble des données de la 
piste. Par exemple, lorsqu'une piste audio est en vue 
Waveform, l'opération copier/coller ne concerne 
pas uniquement les informations de la forme d'onde, 
mais également toutes les données d'automation 
associées. 

La vue principale dépend du type de piste :

• Pistes audio : Blocks et Waveform

• Pistes MIDI et d'instrument : Clips, Blocks et 
Notes (lors de l'utilisation du Sélecteur)

Hauteur de piste
Les pistes peuvent être affichées dans la fenêtre 
Edit avec l'une des huit hauteurs suivantes : Micro, 
Mini, Small, Medium, Large, Jumbo, Extreme et Fit 

To Window. Les hauteurs de piste les plus grandes 
sont utiles pour les opérations d'édition précises, 
particulièrement pour le MIDI. Les hauteurs de 
piste plus petites sont utiles pour gagner de 
l'espace à l'écran dans une session de grande taille.

Vous pouvez régler la hauteur des pistes 
individuellement ou en choisir une commune 
à toutes les pistes. La hauteur des pistes est 
modifiable en cours de lecture.

Pour définir la hauteur des pistes, effectuez l'une 
des opérations suivantes :

 Cliquez sur la petite flèche située à gauche du 
nom d'une piste pour faire apparaître le menu 
Track Height.

 Effectuez un clic droit sur l'échelle de zoom 
vertical à droite des commandes d'une piste et 
sélectionnez une hauteur dans le menu.

La piste est redimensionnée à la nouvelle hauteur. 
Si la piste fait partie d'un groupe d'édition, toutes 
les pistes de ce groupe adoptent la nouvelle 
hauteur.

Pour redimensionner proportionnellement toutes 
les pistes :

 Cliquez sur le bouton zoom arrière ou avant 
vertical de la fenêtre Edit.

Menu déroulant des hauteurs de piste 

Pour augmenter/réduire la hauteur d'une 
piste contenant une sélection ou sur laquelle 
le curseur d'édition se trouve actuellement, 
maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et appuyez sur la touche 
Flèche haut/bas.

Boutons de zoom avant et arrière vertical dans la 
fenêtre Edit
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Modification continue des 
hauteurs de piste
Dans la fenêtre Edit, il est possible de modifier de 
manière continue les hauteurs de piste en faisant 
glisser leur bordure inférieure dans la colonne des 
commandes de piste. 

Pour redimensionner la hauteur d'une piste dans 
la fenêtre Edit :

 Faites glisser vers le haut ou le bas la bordure 
inférieure d'une piste dans la colonne des 
commandes de piste. Le curseur change de 
forme pour signaler que la piste peut être 
redimensionnée.

La hauteur de la piste est modifiée de manière 
incrémentielle.

Commandes de piste et hauteur 
de piste
La hauteur d'une piste influe sur la façon dont 
ses commandes sont affichées dans la fenêtre 
Edit. Pour une hauteur de piste Small, 
par exemple, la plupart des boutons sont 
affichés en taille réduite.

Pour les hauteurs Mini et Micro, seules les 
commandes Record, Mute et Solo sont affichées et 
les menus Playlist, Track Timebase (base de temps 
de la piste), Track Height (hauteur de piste) et 
Track View (vue de piste) sont accessibles à partir 
du même sélecteur.

Pour les hauteurs Medium, Large, Jumbo ou 
Extreme, toutes les commandes de piste sont 
affichées à leur taille maximale.Ajustement de la hauteur d'une piste audio

Maintenez la touche Commande (Mac) ou 
Ctrl (Windows) enfoncée tout en ajustant la 
hauteur d'une piste pour la modifier de 
manière continue et non incrémentielle.

Pour redimensionner toutes les pistes de 
façon continue, maintenez la touche Alt 
(Windows) ou Option (Mac) enfoncée et 
faites glisser une bordure inférieure.

Pour redimensionner toutes les pistes 
sélectionnées de façon continue, maintenez les 
touches Alt+Maj (Windows) ou Option+Maj 
(Mac) enfoncées et faites glisser la bordure 
inférieure de l'une des pistes sélectionnées.

Affichage d'une piste en hauteur Small

Affichage d'une piste en hauteur Mini

Affichage d'une piste en hauteur Large
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Liste des pistes
La liste des pistes, dans la partie gauche des 
fenêtres Mix et Edit, présente toutes les pistes de la 
session. Elle permet d'afficher ou de masquer une 
piste dans les fenêtres Mix, Edit et les fenêtres des 
éditeurs MIDI et de partition. Même si une piste est 
masquée, son contenu continue à être lu avec le 
reste de la session. Les pistes désactivées 
apparaissent en italique dans la liste des pistes.

Affichage et masquage de la 
liste des pistes et de la liste des 
groupes

Pour afficher (ou masquer) la liste des pistes (et la 
liste des groupes), procédez de l'une des manières 
suivantes :

 Dans le menu de la fenêtre Edit, sélectionnez 
(ou désélectionnez) Track List.

 Cliquez sur le bouton Show/Hide Track 

List/Group List View dans la fenêtre Mix ou Edit.

Menu de la liste des pistes
Le menu déroulant situé en haut de la liste des 
pistes contient des commandes permettant 
d'afficher ou de masquer toutes les pistes, les pistes 
actuellement sélectionnées à l'écran ou des types 
de piste particuliers (audio, entrée auxiliaire, 
Master Fader, MIDI, instrument, Master VCA ou 
pistes désactivées). 

La liste des pistes peut également servir 
à créer des pistes lors de l'importation de 
médias par glisser-déposer depuis un 
navigateur de l'espace de travail. Reportez-
vous à la section « Importation de fichiers 
par glisser-déposer », à la page 333. 

Liste des pistes

Nom de la piste

Icône du type de piste

Code couleur de la piste

Afficher/Masquer la piste

Menu de la liste des pistes
Bouton Show/Hide Track List/Group List de la fenêtre 
Edit

Sélection d'un type de piste à afficher
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La commande de tri des pistes (Sort Tracks By) 
permet de classer les pistes en fonction de leur 
nom (Name), type (Type), groupe d'édition 
(Edit Group), groupe de mixage (Mix Group) ou 
voix (Voice). L'ordre de tri choisi est répercuté 
dans la liste des pistes de la fenêtre Mix, Edit et des 
fenêtres des éditeurs MIDI et de partition. 

Lorsqu'une piste appartenant à un groupe actif est 
masquée, elle n'est pas affectée par les opérations 
d'édition effectuées sur les autres membres du 
groupe dans la fenêtre Edit. Dans la fenêtre Mix, 
en revanche, une piste masquée appartenant à un 
groupe actif est concernée par toutes les opérations 
autres que l'activation pour l'enregistrement.

Les options du menu de la liste des pistes de la 
fenêtre de l'éditeur de partition sont différentes de 
celles des fenêtres Mix, Edit et de l'éditeur MIDI. 
Pour plus d'informations, reportez-vous à la 
section « Track List », à la page 760.

Affichage et masquage des 
pistes
Les fenêtres Mix et Edit sont liées en termes 
d'affichage ou de masquage des pistes. Toutefois, 
les fenêtres de l'éditeur de partition et de l'éditeur 
MIDI sont toutes uniques en termes d'affichage ou 
de masquage des pistes. Par exemple, si vous 
masquez une piste précise dans la fenêtre Edit, elle 
est également masquée dans la fenêtre Mix, mais 
pas dans la fenêtre de l'éditeur de partition ou de 
l'éditeur MIDI. 

De même, si vous masquez une piste précise dans 
une fenêtre de l'éditeur MIDI, elle n'est masquée 
que dans cette fenêtre de l'éditeur MIDI.

Pour masquer une piste, effectuez l'une des 
opérations suivantes :

 Cliquez sur l'icône permettant d'afficher ou de 
masquer la piste dans la liste des pistes.

 Dans la liste des pistes (ou sur la tranche de la 
piste), effectuez un clic droit sur le nom de la 
piste et sélectionnez Hide (ou Hide and Make 

Inactive si la piste est active et si vous souhaitez 
également la désactiver).

Pour afficher une piste actuellement masquée, 
effectuez l'une des opérations suivantes :

 Cliquez sur l'icône permettant d'afficher ou de 
masquer la piste dans la liste des pistes.

 Dans la liste des pistes (ou sur la tranche de la 
piste), effectuez un clic droit sur le nom de la 
piste et sélectionnez Show (ou Show and Make 

Active si la piste est désactivée et si vous 
souhaitez également l'activer).

Sélection d'une option de tri des pistes

Icône de piste affichée dans la liste des pistes

Icône de piste masquée dans la liste des pistes



Guide de référence Pro Tools232

Pour afficher toutes les pistes :

 Cliquez sur le menu de la liste des pistes et 
sélectionnez Show All Tracks.

Pour masquer toutes les pistes :

 Cliquez sur le menu de la liste des pistes et 
sélectionnez Hide All Tracks.

Pour afficher une plage de pistes :

1 Sélectionnez une plage de pistes masquées dans 
la liste des pistes.

2 Cliquez sur l'icône Afficher/Masquer de la 
première piste masquée de la plage.

3 Maintenez la touche Maj enfoncée, puis cliquez 
sur l'icône Afficher/Masquer de la dernière piste 
de la plage.

Toutes les pistes comprises entre la première piste 
sélectionnée et la dernière seront également 
sélectionnées.

Pour afficher ou masquer une plage de pistes 
dans la liste des pistes à l'aide du rectangle de 
sélection :

1 Déplacez le curseur à gauche du nom d'une piste 
jusqu'à ce que le rectangle de sélection avec le 
symbole + s'affiche.

2 Cliquez sur une piste dans la liste et faites 
glisser vers le haut ou le bas sur les icônes 
Afficher/Masquer (pour masquer ou afficher 
la piste et les pistes placées immédiatement 
au-dessus ou au-dessous d'elle).

Pour afficher ou masquer des pistes non 
contiguës :

 Cliquez sur l'icône Afficher/Masquer des pistes 
que vous voulez afficher ou masquer.

Pour restaurer les pistes précédemment affichées 
après avoir utilisé les commandes Show All 
Tracks, Show Only Selected Tracks ou Show Only 
Tracks by <Track Type> :

 Dans le menu de la liste des pistes, sélectionnez 
l'option Restore Previously Shown Tracks.

Groupes d'édition/mixage et 
pistes masquées
Dans la fenêtre Mix, lorsqu'une piste masquée 
appartient à un groupe activé, toutes les opérations 
de la fenêtre Mix effectuées sur les autres membres 
du groupe affectent également la piste masquée, 
à l'exception de l'activation pour l'enregistrement 
audio ou MIDI. Si vous utilisez les commandes 
solo, mute ou d'activation pour l'écriture 
d'automation d'une piste groupée, tous les 
membres masqués du groupe seront également 
concernés par ces commandes. 

Dans la fenêtre Edit, cependant, les opérations 
d'édition effectuées sur les membres d'un groupe 
activé n'affectent pas les pistes masquées de ce 
groupe. 

Vous pouvez également afficher toutes les 
pistes en maintenant la touche Option (Mac) 
ou Alt (Windows) enfoncée, puis en cliquant 
sur l'icône Afficher/Masquer d'une piste 
masquée.

Vous pouvez également masquer toutes les 
pistes en maintenant la touche Alt (Windows) 
ou Option (Mac) enfoncée, puis en cliquant 
sur l'icône Afficher/Masquer d'une piste 
affichée.

Pour modifier l'ordre des pistes à l'écran, 
faites glisser les noms des pistes vers leurs 
nouvelles positions dans la liste des pistes ou 
dans la fenêtre Mix ou Edit.
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Numérotation des pistes et 
pistes masquées
Dans les fenêtres Mix et Edit, la séquence des 
numéros des pistes peut prendre en compte les 
pistes masquées, ou au contraire les ignorer :

• Lorsque l'option Track Position Numbers Stay 

with Hidden Tracks n'est pas sélectionnée sur la 
page des préférences d'affichage, des numéros 
sont assignés uniquement aux pistes affichées. 
Dans ce cas, les pistes actives sont numérotées 
dans l'ordre croissant. Aucun numéro n'est 
attribué aux pistes masquées.

• Lorsque l'option Track Position Numbers Stay 

With Hidden Tracks est sélectionnée sur la page 
des préférences d'affichage, les pistes 
conservent leurs numéros de position, même si 
elles sont masquées.

Menu contextuel des noms 
de piste
(Fenêtres Mix, Edit, d'éditeur MIDI ou liste 
des pistes)

Lorsque vous effectuez un clic droit sur le nom 
d'une piste dans la fenêtre Mix, Edit, de l'éditeur 
MIDI ou dans la liste des pistes, un menu 
contextuel permet d'accéder aux commandes 
suivantes :

Hide/Show : masque (ou affiche) la piste (ou les 
pistes sélectionnées le cas échéant).

Hide and Make Inactive : masque la piste (ou les 
pistes sélectionnées le cas échéant) et la désactive.

Make Active/Inactive : active ou désactive la piste 
(ou de toutes les pistes sélectionnées dans la 
fenêtre Mix ou Edit uniquement).

Scroll Into View : fait défiler l'affichage pour 
placer la piste en haut de la fenêtre Edit ou 
à gauche de la fenêtre Mix.

Export MIDI (pistes MIDI et d'instrument 
uniquement) : exporte les données MIDI d'une ou 
plusieurs pistes MIDI ou d'instrument dans un 
fichier MIDI standard. Pour plus d'informations, 
reportez-vous à la section « Exportation de fichiers 
MIDI », à la page 349.

Coalesce VCA Master Automation (pistes Master 
VCA avec Pro Tools HD uniquement) : fusionne 
l'automation VCA des pistes esclaves du VCA.

Coalesce Trim Automation (Pro Tools HD 
uniquement) : fusionne l'automation de trim de la 
piste (ou des pistes sélectionnées le cas échéant).

Clear Trim Automation (Pro Tools HD 
uniquement) : efface l'automation de trim de la 
piste (ou des pistes sélectionnées le cas échéant).

Locked (piste vidéo uniquement) : verrouille ou 
déverrouille la piste vidéo (ou les pistes vidéo 
sélectionnées le cas échéant).

New : ouvre la boîte de dialogue New Track.

Rename : ouvre la boîte de dialogue Track Name.

Duplicate : duplique la piste (ou les pistes 
sélectionnées le cas échéant).

Split Into Mono (pistes multicanal uniquement) : 
divise une piste multicanal (ou des pistes 
multicanal sélectionnées le cas échéant) en 
plusieurs pistes mono.

Delete : supprime la piste (ou les pistes 
sélectionnées le cas échéant).

Field Recorder Guide Track (pistes audio avec 
Pro Tools HD uniquement) : désigne la piste 
sélectionnée comme piste témoin pour les 
workflows avec enregistreur portable.

MIDI RealTime Properties (pistes MIDI et 
d'instrument uniquement) : ouvre la fenêtre 
RealTime Properties de la piste. 



Guide de référence Pro Tools234

Open in New MIDI Editor (pistes MIDI et 
d'instrument uniquement) : ouvre la piste dans 
une nouvelle fenêtre de l'éditeur MIDI. 

Open in Score Editor (pistes MIDI et d'instrument 
uniquement) : ouvre la piste dans la fenêtre de 
l'éditeur de partition.

Open in MIDI Event List (pistes MIDI et 
d'instrument uniquement) : ouvre la piste dans la 
liste des événements MIDI.

Notation Display Track Settings (pistes MIDI et 
d'instrument uniquement) : ouvre la fenêtre 
Notation Display Track Settings de la piste. 
La notation musicale peut être affichée uniquement 
dans la fenêtre de l'éditeur de partition ou de 
l'éditeur MIDI en vue Notation.

Expand Channels to New Tracks : développe les 
fichiers audio multicanal importés à partir d'un 
enregistreur portable sur de nouvelles pistes, 
chaque canal apparaissant alors sur sa propre piste 
audio. L'ensemble des points d'édition de la piste 
guide (à partir de laquelle les canaux sont 
développées) sont automatiquement répercutés sur 
les pistes développées. Vous pouvez développer 
des fichiers multicanal sur de nouvelles pistes 
triées selon leur nom de canal, numéro de canal, 
nom et numéro de canal ou selon leur timecode 
uniquement.

Assignation des entrées et 
sorties audio des pistes
Les entrées des pistes audio, d'entrée auxiliaire et 
d'instrument peuvent être assignées à des canaux 
de l'interface audio ou à des bus. Il en est de même 
pour les sorties des pistes audio, d'entrée auxiliaire, 
Master Fader et d'instrument.

Pour les pistes stéréo et surround multicanal, les 
entrées et sorties apparaissent par paires stéréo 
et groupes multicanal. Les entrées, sorties et bus 
disponibles sont définis comme des chemins dans 
la boîte de dialogue I/O Setup (reportez-vous au 
Chapitre 7, « I/O Setup »). 

Assignation automatique des 
entrées et sorties
Lorsque vous ajoutez des pistes à une nouvelle 
session, les entrées sont automatiquement 
assignées dans l'ordre croissant. Si vous possédez, 
par exemple, une interface audio dotée de huit 
entrées, la création de quatre pistes audio mono 
ajoute automatiquement quatre pistes audio avec 
des entrées assignées aux quatre premiers chemins 
définis dans la boîte de dialogue I/O Setup. Lors de 
la création de pistes stéréo, les entrées sont 
automatiquement assignées aux paires d'entrées 
suivantes.

Les sorties assignées automatiquement aux 
nouvelles pistes sont déterminées par le paramètre 
New Track Default Output Bus spécifié dans la 
boîte de dialogue I/O Setup.

Assignation des entrées et sorties de trois pistes audio 
mono

Entrée de 
piste 

configurée sur 
Audio 2

Entrée de 
piste 

configurée 
sur Bus 2

Piste sans 
entrée 
définie
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Assignation des entrées audio
(Pistes audio, d'entrée auxiliaire et 
d'instrument)

Pour assigner une entrée audio d'une piste audio, 
d'entrée auxiliaire ou d'instrument :

1 Pour assigner des entrées de pistes audio dans 
la fenêtre Edit, sélectionnez View > Edit 

Window > I/O.

2 Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin d'entrée de la piste et 
sélectionnez parmi les canaux de l'interface 
audio et les bus disponibles. Pour les pistes 
stéréo et surround multicanal, les entrées 
apparaissent par paires et groupes multicanal.

Le sélecteur de chemin d'entrée permet de router 
n'importe quelle entrée audio ou n'importe quel 
bus interne de Pro Tools vers une piste audio, 
d'entrée auxiliaire ou d'instrument. Les choix 
disponibles dans ce menu déroulant sont 
déterminés par la configuration du chemin d'entrée 
de la boîte de dialogue I/O Setup. Les entrées déjà 
utilisées par une autre piste sont affichées en gras 
dans le menu du sélecteur de chemin d'entrée.

Pour assigner automatiquement toutes les 
entrées de piste (de type et largeur de canal 
identiques) à des chemins d'entrée uniques par 
ordre croissant (en cascade) :

 Maintenez les touches Ctrl+Alt (Windows) 
ou Commande+Option (Mac) enfoncées, puis 
cliquez sur le sélecteur de chemin d'entrée de la 
piste la plus à gauche et sélectionnez le premier 
chemin d'entrée (mono ou stéréo, selon les 
pistes). 

Toutes les pistes visibles ayant la même largeur de 
canal (mono ou stéréo) se voient automatiquement 
attribuer des assignations de chemin d'entrée 
uniques, par ordre croissant. Par exemple, 
la piste 1 est assignée à l'entrée A1, la piste 2 
à l'entrée A2, la piste 3 à l'entrée A3, etc.

Pour supprimer une assignation d'entrée :

 Sélectionnez l'option No Input dans le sélecteur 
des chemins d'entrée.

Assignation des sorties audio
(Pistes audio, d'entrée auxiliaire, Master Fader 
et d'instrument)

Pour assigner la sortie audio d'une piste audio, 
d'entrée auxiliaire, Master Fader ou d'instrument :

1 Pour assigner des sorties de pistes audio dans 
la fenêtre Edit, sélectionnez View > Edit 

Window > I/O.

2 Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin de sortie de la piste et 
sélectionnez parmi les canaux de l'interface 
audio et les bus disponibles. Pour les pistes 
stéréo et surround multicanal, les sorties sont 
affichées par paires et chemins multicanal.

Les pistes d'instrument assignent 
automatiquement la sortie audio du plug-in 
d'instrument inséré sur la piste à l'entrée 
audio de la piste.

 

Sélecteur de chemin d'entrée
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Le sélecteur des chemins de sortie permet de router 
une piste vers n'importe quelle sortie audio ou 
n'importe quel bus interne configuré(e). Les choix 
disponibles sont déterminés par la configuration 
des chemins de bus de sortie dans la boîte de 
dialogue I/O Setup. Les sorties déjà utilisés par une 
autre piste sont affichées en gras dans le menu du 
sélecteur des chemins de sortie.

Pour supprimer une assignation de sortie :

 Sélectionnez l'option No Output dans le 
sélecteur des chemins de sortie. L'affichage des 
playlists des pistes sans assignation de sortie est 
estompé.

Création et assignation d'une nouvelle 
piste à partir de la sortie d'une piste

Pro Tools permet de créer une nouvelle piste 
d'entrée auxiliaire, audio ou d'instrument à partir 
du sélecteur de sortie, puis d'assigner 
automatiquement la sortie de la piste d'origine 
à l'entrée de la nouvelle piste via un bus de mixage 
interne disponible.

Pour créer une nouvelle piste à partir de la sortie 
d'une piste :

1 Sur une piste existante, cliquez sur son sélecteur 
de sortie et sélectionnez New Track.

2 Dans la boîte de dialogue New Track, 
sélectionnez les options Width, Type et Time 

Base pour la nouvelle piste.

3 Saisissez le nom de la nouvelle piste.

4 Sélectionnez (ou désélectionnez) l'option 
permettant de créer la nouvelle piste à côté de la 
piste actuelle.

5 Cliquez sur OK.

Pro Tools crée une nouvelle piste et route 
automatiquement la sortie de la piste d'origine vers 
l'entrée de la nouvelle piste, via un bus de mixage 
interne disponible. 

Si un nouveau bus de mixage interne est créé, 
il prendra le nom spécifié pour la nouvelle piste. 
Par exemple, si vous avez saisi le nom « Drum 
Sub », Pro Tools crée une nouvelle piste d'entrée 
auxiliaire nommée « Drum Sub », ainsi qu'un bus 
de mixage interne nommé « Drum Sub ».

Sélecteur de chemin de sortie

Maintenez les touches Ctrl+Alt (Windows) 
ou Commande+Option (Mac) enfoncées, 
puis cliquez sur le sélecteur des chemins de 
sortie de la piste la plus à gauche et 
sélectionnez le premier chemin de sortie 
(mono ou stéréo). Toutes les pistes visibles se 
voient automatiquement attribuer des 
assignations de chemin de bus de sortie 
uniques, par ordre croissant. Par exemple, 
la piste 1 est assignée à la sortie A1-2, la 
piste 2 à la sortie A3-4, la piste 3 à la sortie 
A5-6, etc.

Lorsque vous assignez une piste audio, 
d'entrée auxiliaire, Master Fader ou 
d'instrument sur No Output, son automation 
de panoramique et de commandes de plug-in 
est perdue. 

Boîte de dialogue New Track



Chapitre 13 : Pistes 237

Assignation d'une piste existante à partir de la 
sortie d'une piste

Pro Tools permet d'assigner la sortie d'une piste 
à l'entrée d'une piste existante via un bus de 
mixage interne disponible. Notez que la piste de 
destination doit être définie sur un bus de mixage 
interne ou sur l'option No Input afin d'être 
disponible pour l'assignation.

Pour assigner la sortie d'une piste à une entrée 
disponible sur une piste existante :

1 Sur une piste existante, cliquez sur son sélecteur 
de sortie et sélectionnez Track.

2 Dans le sous-menu Track, sélectionnez la piste 
de destination souhaitée.

Pro Tools route automatiquement la piste ou le 
départ vers l'entrée de la piste sélectionnée via un 
bus de mixage interne disponible.

Modification du nom des entrées 
et des sorties de pistes à partir 
de la fenêtre Edit ou Mix
Il est possible de changer le nom des chemins d'E/S 
depuis les fenêtres Edit ou Mix ou dans la boîte de 
dialogue I/O Setup.

Pour renommer un chemin d'E/S à partir de la 
fenêtre Edit ou Mix :

1 Dans la fenêtre Edit ou Mix, effectuez un clic 
droit sur le sélecteur d'entrée ou de sortie d'une 
piste et sélectionnez Rename dans le menu 
contextuel.

Nouvelle piste d'entrée auxiliaire avec sortie de piste 
audio assignée automatiquement au Bus 1–2

Assignation de la sortie d'une piste à une piste 
d'entrée auxiliaire existante
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2 Dans la boîte de dialogue Rename I/O, donnez 
un nom au chemin d'E/S et cliquez sur OK.

Désactivation des entrées et 
sorties de pistes à partir de la 
fenêtre Edit ou Mix
Les assignations d'entrée et sortie, ou de bus d'une 
piste peuvent être désactivées via le sélecteur 
correspondant. La désactivation d'une entrée ou 
sortie de piste coupe le son sur cette entrée ou sortie, 
tout en conservant l'ensemble des données 
d'automation et de playlist. Sur les systèmes Avid 
HDX, les entrées et sorties désactivées n'utilisent 
pas de ressources DSP pour le routing du mixeur, 
mais les plug-ins actifs assignés à la piste continuent 
d'exploiter les ressources DSP nécessaires. Sur les 
systèmes Pro Tools basés sur hôte, les entrées et 
sorties désactivées n'utilisent aucune ressource de 
traitement hôte. Les plug-ins basés sur hôte, ou 
Native, exploitent les ressources du CPU, alors que 
les plug-ins basés sur DSP utilisent les DSP 
disponibles sur les cartes Avid HDX. 

Vous pouvez désactiver (ou activer) des entrées et 
des sorties de piste directement depuis la fenêtre 
Edit ou Mix. Les chemins d'E/S désactivés sont 
grisés.

Pour désactiver (ou activer) le chemin d'entrée ou 
de sortie d'une piste, effectuez l'une des 
opérations suivantes :

 Dans la fenêtre Edit ou Mix, effectuez un clic 
droit sur le sélecteur d'entrée ou de sortie d'une 
piste et sélectionnez Make Inactive (ou Make 

Active) dans le menu contextuel.

 Maintenez les touches Ctrl+Démarrer (Windows) 
ou Commande+Ctrl (Mac) enfoncées et cliquez 
sur le sélecteur d'entrée ou de sortie dans la fenêtre 
Mix ou Edit.

Pour désactiver (ou activer) toutes les entrées ou 
sorties de piste assignées à un même chemin, 
effectuez l'une des opérations suivantes :

 Dans la fenêtre Edit ou Mix, maintenez les 
touches Option+Maj (Mac) ou Alt+Maj 
(Windows) enfoncées et effectuez un clic droit 
sur le sélecteur d'entrée ou de sortie d'une piste, 
puis sélectionnez Make Inactive (ou Make 

Active) dans le menu contextuel.

 Maintenez les touches Ctrl+Alt+Démarrer 
(Windows) ou Commande+Option+Ctrl (Mac) 
enfoncées et cliquez sur le sélecteur d'entrée ou 
de sortie dans la fenêtre Mix ou Edit.

Pour désactiver (ou activer) toutes les entrées ou 
sorties de pistes sélectionnées assignées à un 
même chemin, effectuez l'une des opérations 
suivantes :

 Dans la fenêtre Edit ou Mix, maintenez les 
touches Option+Maj (Mac) ou Alt+Maj 
(Windows) enfoncées et effectuez un clic droit 
sur le sélecteur d'entrée ou de sortie d'une piste, 
puis sélectionnez Make Inactive (ou Make 

Active) dans le menu contextuel.

 Maintenez les touches 
Commande+Option+Ctrl+Maj (Mac) ou 
Ctrl+Alt+Démarrer+Maj (Windows) enfoncées 
et cliquez sur le sélecteur d'entrée ou de sortie 
dans la fenêtre Mix ou Edit.

 

Boîte de dialogue Rename I/O

Vous pouvez activer ou désactiver 
globalement un chemin dans la boîte de 
dialogue I/O Setup. Reportez-vous à la 
section « Activation ou désactivation de 
chemins », à la page 93.
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Basculement de l'état de plusieurs chemins

Si une piste ne possède qu'une assignation de sortie 
principale, maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) enfoncées 
et cliquez sur son sélecteur de chemin de sortie 
pour désactiver la sortie principale. Si plusieurs 
assignations sont actives, le sélecteur de la piste 
s'affiche pour vous permettre de choisir le chemin 
d'entrée, de sortie, d'insert, ou de bus. 

Priorité des pistes et 
assignation des voix
La priorité des pistes et l'assignation des voix 
dépendent de votre configuration Pro Tools 
matérielle et logicielle.

Le nombre de voix (canaux simultanés de lecture et 
d'enregistrement audio) des systèmes Avid HDX 
varie en fonction du nombre de cartes du système. 
Pour plus d'informations sur les capacités des 
systèmes Pro Tools, reportez-vous à la section 
« Limites applicables à la lecture, à l'enregistrement 
et aux voix avec Pro Tools HD », à la page 44.

Les systèmes Pro Tools permettent de lire ou 
d'enregistrer jusqu'à 96 pistes stéréo ou mono en 
simultané. Pour plus d'informations sur les 
capacités des systèmes, reportez-vous à la section 
« Capacités de Pro Tools avec différentes 
configurations matérielles », à la page 41.

Priorité des pistes
Bien que votre matériel Pro Tools autorise un 
nombre fixe de voix, le logiciel Pro Tools permet 
de travailler avec un nombre de pistes audio 
supérieur à ce nombre de voix. Toutes ces pistes 
peuvent être enregistrées ou importées, arrangées 
et activées pour la lecture, mais elles ne peuvent 
pas toutes être lues simultanément. 

Lorsque les pistes de la session sont plus 
nombreuses que les voix disponibles, celles ayant 
la plus faible priorité peuvent ne pas être audibles. 
Dans de telles situations, Pro Tools assigne des 
priorités aux pistes qui recherchent des voix 
disponibles. Comme les pistes peuvent être plus 
nombreuses que les voix disponibles, Pro Tools 
permet de définir la priorité de lecture des pistes 
audio de plusieurs façons. Reportez-vous aux 
sections « Modification de la priorité de lecture 
d'une piste », à la page 239 et « Libération de voix 
sur les pistes », à la page 240.

Modification de la priorité de lecture 
d'une piste

La position des pistes représente leur niveau de 
priorité : priorité décroissante du haut vers le bas 
dans la fenêtre Edit, et de la gauche vers la droite 
dans la fenêtre Mix. 

Pour attribuer une priorité plus élevée à une piste, 
vous pouvez au choix :

 Dans la fenêtre Mix, faire glisser le bouton de 
nom de piste à gauche d'autres pistes de la 
session. Les pistes situées à gauche de la fenêtre 
Mix possèdent une priorité plus élevée que 
celles situées à droite.

 Dans la fenêtre Edit, faire glisser le bouton de 
nom de piste au-dessus d'autres pistes de la 
session. Les pistes situées en haut de la fenêtre 
Edit ont une priorité plus élevée que celles 
situées au-dessous.

Lorsqu'un départ (A-J) possède plusieurs 
assignations de chemin de sortie et que l'une 
d'elles est activée ou désactivée, toutes les 
assignations de chemin de sortie de ce départ 
(A-J) sont activées ou désactivées.



Guide de référence Pro Tools240

 Dans la liste des pistes, faire glisser le bouton de 
nom de piste vers une position plus élevée. 
Les pistes situées en haut de cette liste 
possèdent une priorité plus élevée que celles 
situées vers le bas.

Libération de voix sur les pistes

Vous pouvez également modifier la priorité 
relative des pistes en libérant les voix de pistes 
spécifiques et ainsi les rendre disponible pour 
d'autres pistes de la session. 

Pour libérer la voix d'une piste, procédez 
comme suit :

 Cliquez sur le sélecteur de voix de la piste et 
sélectionnez le paramètre Off. Reportez-vous 
à la section « Définition des assignations de 
voix », à la page 240.

 Désactivez la piste en appuyant sur 
Ctrl+Démarrer (Windows) ou Commande+Ctrl 
(Mac), puis en cliquant sur l'icône du type de 
piste dans la fenêtre Mix.

 Assurez-vous que la piste ne comporte pas 
d'assignation de chemin de sortie ou de départ. 

Définition des assignations de 
voix
L'assignation de voix d'une piste peut être 
désactivée ou allouée dynamiquement. L'option 
d'assignation dynamique des voix gère l'allocation 
automatiquement en arrière-plan, chaque voix non 
assignée pouvant être attribuée aux autres pistes.

Pour assigner une voix à une piste :

 Cliquez sur le sélecteur de voix et sélectionnez 
Dyn, Off ou un numéro de voix.

Priorité des pistes et allocation 
dynamique des voix

Les pistes audio activées dont les numéros sont les 
moins élevés (priorité la plus haute) et dont 
l'assignation de voix est configurée sur DYN 
(allocation dynamique) sont celles qui sont lues. 
Le nombre total des pistes qui sont lues dépend du 
nombre maximum de pistes audio assignées à une 
voix autorisé sur votre système.

Dans Pro Tools HD, les modes QuickPunch, 
TrackPunch et DestructivePunch requièrent 
des voix supplémentaires. Pour plus 
d'informations, reportez-vous au Chapitre 23, 
« Modes d'enregistrement en punch-in/out »

Sur les systèmes Pro Tools|HDX, le premier 
insert d'un plug-in Native (basé sur hôte) 
utilise des voix supplémentaires dans certains 
cas. Reportez-vous à la section « Utilisation 
des voix et latence totale pour les plug-ins 
Native (basés sur hôte) », à la page 1035.

Sélecteur de voix d'une piste audio stéréo
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Les pistes dont les numéros sont plus élevés 
(priorité plus basse) que ceux des pistes prioritaires 
ne sont pas lues et il est impossible d'enregistrer 
dessus. Leur bouton d'allocation dynamique des 
voix devient bleu pour indiquer qu'elles ne sont pas 
disponibles pour la lecture ou l'enregistrement.

Lorsque vous travaillez avec plus de pistes audio 
assignées à une voix que votre système ne le 
permet, vous ne pouvez lire l'audio des pistes de 
numéro élevé (priorité basse) qu'en modifiant leur 
priorité de l'une des manières suivantes :

• Désactivez une piste de numéro moins élevé 
(cliquez sur le nom de la piste et sélectionnez 
Track > Make Inactive).

• Définissez l'assignation de voix d'une piste de 
numéro moins élevé sur Off (cliquez sur le 
sélecteur de voix et sélectionnez Off).

• Faites glisser le bouton du nom de la piste de 
numéro le plus élevé vers la gauche (fenêtre 
Mix) ou le haut (fenêtre Edit ou liste des pistes), 
jusqu'à ce qu'elle se trouve dans la plage du 
nombre maximum de pistes audio assignées 
à une voix autorisé par votre système. La piste 
qui était précédemment la dernière piste audio 
assignée à une voix est placée en dehors de la 
plage et son assignation de voix passe sur Off.

Lorsque la priorité de la piste avec le numéro le 
plus élevé est modifiée, son assignation de voix 
passe automatiquement de Off à DYN.

Assignation des entrées et 
sorties MIDI des pistes
L'enregistrement et la lecture MIDI sont possibles 
sur les pistes MIDI et les pistes d'instrument.

Les ports MIDI de votre système peuvent être 
nommés et configurés dans Pro Tools (pour 
Windows, reportez-vous à la section 
« Configuration de MIDI Studio Setup » et pour 
Mac, « Configuration AMS »). 

Assignation d'une entrée de 
piste MIDI
Pro Tools permet d'assigner des ports et canaux 
MIDI spécifiques à une entrée de piste MIDI. 
Le paramètre par défaut All envoie sur tous les 
canaux l'ensemble des données MIDI provenant de 
tous les ports. Utilisez le sélecteur d'entrée MIDI 
pour spécifier un port et un canal MIDI d'entrée.

Pour assigner une entrée de piste MIDI :

 Cliquez sur le sélecteur d'entrée MIDI de la 
piste et assignez un port et un canal à l'entrée 
MIDI. Les canaux déjà assignés à une autre 
piste sont affichés en caractères gras.

Il est impossible de lire des pistes lorsqu'elles 
sont désactivées ou lorsque leur assignation 
de voix est configurée sur Off.

Pour plus d'informations sur l'assignation de 
l'entrée MIDI sur les pistes d'instrument, 
reportez-vous à la section « Assignation 
d'une entrée et d'une sortie MIDI sur des 
pistes d'instrument », à la page 243.

Dans la fenêtre Edit, sélectionnez View > 
Edit Window > I/O pour accéder au sélecteur 
d'entrée de n'importe quelle piste.
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Assignation d'une sortie de 
piste MIDI
Pro Tools permet d'assigner des ports et canaux 
MIDI spécifiques à une sortie de piste MIDI. 
Le paramètre par défaut none n'envoie les données 
MIDI vers aucun port ni aucun canal. Utilisez le 
sélecteur de sortie MIDI pour spécifier un port et 
un canal MIDI de sortie.

Pour assigner une piste MIDI (et tous ses clips) 
à un canal de périphérique MIDI spécifique :

 Cliquez sur le sélecteur de sortie MIDI de la 
piste et assignez un port et un canal de sortie 
MIDI. Les canaux déjà assignés à une autre 
piste sont affichés en caractères gras.

Pour assigner plusieurs destinations à une piste 
MIDI unique :

 Maintenez la touche Ctrl enfoncée (Mac) puis 
cliquez, ou effectuez un clic droit (Mac ou 
Windows) sur le sélecteur de sortie MIDI, puis 
sélectionnez des canaux de périphérique 
supplémentaires.

Sélecteur d'entrée MIDI (piste MIDI)

Les pistes MIDI de Pro Tools ne peuvent pas 
contenir plusieurs canaux de données MIDI.

Pour plus d'informations sur l'assignation de 
sorties MIDI sur les pistes d'instrument, 
reportez-vous à la section « Assignation 
d'une entrée et d'une sortie MIDI sur des 
pistes d'instrument », à la page 243.

Dans la fenêtre Edit, sélectionnez View > 
Edit Window > I/O pour accéder au sélecteur 
de sortie de n'importe quelle piste.

Sélecteur de sortie MIDI (piste MIDI)

Pour plus d'informations sur 
l'enregistrement et l'importation de 
données MIDI, reportez-vous au 
Chapitre 22, « Enregistrement MIDI »
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Assignation d'une entrée et 
d'une sortie MIDI sur des pistes 
d'instrument
Les pistes d'instrument bénéficient d'une vue 
spécifique pour les commandes MIDI, notamment 
les sélecteurs d'entrée et de sortie MIDI.

Pour afficher les commandes MIDI de piste 
d'instrument, effectuez l'une des opérations 
suivantes :

 Sélectionnez View > Mix Window > Instruments.

 Sélectionnez View > Edit Window > 

Instruments.

Entrée MIDI de piste d'instrument

Pro Tools permet d'assigner des ports et des 
canaux MIDI spécifiques à l'entrée MIDI d'une 
piste d'instrument. Le paramètre par défaut All 
envoie sur tous les canaux l'ensemble des données 
MIDI provenant de tous les ports. Utilisez le 
sélecteur d'entrée MIDI pour spécifier un port et un 
canal MIDI d'entrée.

Les canaux déjà utilisés par une autre entrée 
de piste sont affichés en gras dans le menu des 
entrées MIDI.

Pour assigner l'entrée MIDI d'une piste 
d'instrument :

 Cliquez sur le sélecteur d'entrée MIDI de la 
piste et assignez un port et un canal à l'entrée 
MIDI. Les canaux déjà assignés à une autre 
piste sont affichés en caractères gras.

Sortie MIDI de piste d'instrument

Pro Tools permet d'assigner des ports et canaux 
MIDI spécifiques à la sortie MIDI d'une piste 
d'instrument. Le paramètre par défaut none n'envoie 
les données MIDI vers aucun périphérique, port ou 
nœud, ni aucun canal. Utilisez le sélecteur de sortie 
MIDI pour spécifier un port et un canal MIDI de 
sortie.

Les canaux déjà utilisés par une autre entrée de 
piste sont affichés en gras dans le menu des 
entrées MIDI.

Pour assigner la sortie MIDI d'une piste 
d'instrument :

 Cliquez sur le sélecteur de sortie MIDI de la 
piste et assignez un port et un canal de sortie 
MIDI. Les canaux déjà assignés à une autre 
piste sont affichés en caractères gras.

Outre l'affectation de l'entrée et de la sortie 
MIDI pour l'enregistrement et la lecture des 
données MIDI, les pistes d'instrument 
assurent également le monitoring audio de 
vos instruments MIDI matériels et plug-ins 
d'instrument. Reportez-vous à la section 
« Routing du signal pour le monitoring et les 
sous-groupes de mixage », à la page 1013.

Vue Instruments dans la fenêtre Mix

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI
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Commandes solo et mute des 
pistes
Les boutons Solo et Mute peuvent être activés 
à tout moment en cours de lecture. Ils affectent 
aussi bien les pistes MIDI que les pistes audio. 
Plusieurs pistes peuvent être simultanément 
mutées ou en solo dans une session.

Le groupement de pistes a également une influence 
sur les commandes solo et mute. Lorsque vous 
mutez ou mettez en solo une piste membre d'un 
groupe de mixage actif, toutes les autres pistes du 
groupe sont également mutées ou mises en solo.

Mise en solo des pistes

Pour mettre des pistes en solo :

1 Cliquez sur le bouton Solo d'une piste. Le bouton 
est mis en surbrillance et toutes les autres pistes 
sont mutées.

2 Cliquez sur le bouton Solo d'une autre piste. 
Les boutons de ces deux pistes apparaissent 
en surbrillance et toutes les autres pistes sont 
mutées.

Pour désactiver le solo de pistes :

 Cliquez sur le bouton Solo des pistes 
actuellement en solo.

Bouton Solo
Le bouton Solo agit en mutant toutes les autres 
pistes, de façon à ce que seule la piste sélectionnée 
soit audible.

Dans Pro Tools HD, ce comportement correspond 
au mode « Solo In Place ». D'autres modes de solo 
sont disponibles pour modifier l'effet des boutons 
Solo. Reportez-vous à la section « Modes de solo », 
à la page 244.

Modes de solo
(Pro Tools HD uniquement)

Dans Pro Tools HD, le bouton Solo permet de :

• muter d'autres pistes afin que seule la piste 
sélectionnée soit audible ;

• router une piste sélectionnée vers une sortie 
distincte.

Le comportement du bouton Solo est défini par le 
mode de solo de la manière suivante :

SIP (Solo In Place) : le bouton Solo mute les 
autres pistes. Lorsque ce mode est activé, des 
pistes peuvent être protégées contre la mise en solo 
(reportez-vous à la section « Mode de protection 
de la mise en solo », à la page 247).

AFL (After Fader Listen) (Pro Tools HD avec 
matériel Avid HDX ou HD Native uniquement) : 
le bouton Solo route le signal post-fader/post-
panoramique de la piste vers la sortie du chemin 
AFL/PFL. La configuration du chemin AFL/PFL 
s'effectue sur la page Output de la boîte de 
dialogue I/O Setup (reportez-vous à la section 
« AFL/PFL Path », à la page 78). 

En mode AFL, le niveau que vous entendez 
dépend du niveau du fader de la piste. De plus, 
un paramètre distinct détermine le niveau général 
AFL et influe sur la sortie des pistes solo en mode 
AFL (reportez-vous à la section « AFL/PFL 
Path », à la page 78). Ce paramètre de niveau est 
indépendant du paramètre de niveau PFL.

Les pistes d'instruments possèdent des 
groupes de boutons Solo et Mute distincts 
pour le monitoring MIDI et audio.

Pour plus d'informations sur la création et la 
modification de groupes pour leur mise en 
solo ou mute, reportez-vous à la section 
« Groupement de pistes », à la page 253.
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PFL (Pre Fader Listen) (Pro Tools HD avec 
matériel Avid HDX ou HD Native uniquement) : 
le bouton Solo route le signal pré-fader/pré-
panoramique de la piste vers la sortie du chemin 
AFL/PFL. La configuration du chemin AFL/PFL 
s'effectue sur la page Output de la boîte de 
dialogue I/O Setup (reportez-vous à la section 
« AFL/PFL Path », à la page 78). 

En mode PFL, le niveau du fader et le panoramique 
sont ignorés ; le niveau que vous entendez dépend 
du niveau d'enregistrement du signal. De plus, 
un paramètre distinct détermine le niveau général 
PFL et influe sur la sortie des pistes solo en mode 
PFL (reportez-vous à la section « AFL/PFL Path », 
à la page 78). Ce paramètre de niveau est 
indépendant du paramètre de niveau AFL.

Pour sélectionner un mode de solo :

1 Sélectionnez Options > Solo Mode.

2 Sélectionnez SIP, AFL ou PFL.

Utilisation des DSP en mode AFL ou PFL

Pour les modes AFL et PFL, Pro Tools crée un 
mixeur « en arrière-plan » pour router le signal 
vers le chemin AFL/PFL choisi. Selon la taille de 
votre mixeur principal, Pro Tools alloue une partie 
importante de ses ressources DSP disponibles pour 
le mode AFL/PFL.

L'annulation de la déclaration du chemin AFL/PFL 
libère toutes les ressources DSP précédemment 
utilisées en mode AFL/PFL.

Modes AFL/PFL sur des systèmes Pro Tools 
avec D-Control ou D-Command

Le mode AFL/PFL est optimisé pour les 
systèmes Pro Tools avec une surface de contrôle 
D-Command ou D-Control, sur lesquelles le 
module XMON bascule automatiquement la 
source de monitoring entre la sortie principale et la 
sortie AFL/PFL de Pro Tools.

Les modes de solo AFL et PFL requièrent le 
plug-in Surround Mixer. 

Les paramètres de profondeur de 
panoramique personnalisée ne sont pas 
disponibles lorsque le mode de solo AFL ou 
PFL est activé.

Si l'option Mutes Frees Assigned Voice est 
activée, toutes les pistes mutées ne seront pas 
audibles en mode PFL.

Le mode de solo de toutes les pistes solo peut 
être modifié pour passer de l'un des trois 
modes au mode SIP ou AFL. Les pistes 
précédemment en solo adopteront alors le 
comportement du nouveau mode.

Le fait de basculer des pistes en solo en mode 
PFL a pour effet d'annuler tous les solos 
avant d'activer le mode PFL. Cette opération 
permet d'éviter un accroissement 
considérable des niveaux.

Pour plus d'informations sur l'utilisation du 
module XMON et des modes AFL/PFL, 
reportez-vous au guide de votre surface de 
contrôle.
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Modes AFL/PFL sur des systèmes Pro Tools 
sans D-Control ou D-Command

Si vous n'utilisez pas de surface de contrôle 
D-Control ou D-Command, votre chemin de sortie 
Pro Tools normal n'est pas nécessairement muté 
lorsqu'un signal est envoyé sur le chemin 
AFL/PFL. Si vous souhaitez que le signal principal 
soit automatiquement muté lorsqu'un signal 
AFL/PFL est activé, effectuez les opérations 
suivantes : 

1 Configurez le chemin de sortie des pistes en 
solo en mode AFL ou PFL.

2 Sélectionnez le chemin de sortie principal qui 
sera muté dès qu'une piste sera mise en solo en 
mode AFL ou PFL (reportez-vous à la section 
« AFL/PFL Mutes (chemin de sortie) », à la 
page 79).

3 Configurez votre matériel afin qu'il prenne en 
charge simultanément le monitoring du chemin 
principal et des chemins AFL/PFL.

Lorsque le mode de solo AFL ou PFL est 
sélectionné Solo et qu'une piste est mise en solo, 
le chemin de sortie principal est muté et le signal 
AFL/PFL est envoyé sur le chemin de monitoring 
AFL/PFL.

Options de verrouillage de l'état 
solo
L'état solo des pistes peut suivre divers 
comportements : il peut être verrouillé (les pistes 
successivement mises en solo s'ajoutent les unes 
aux autres dans le mix solo), déverrouillé ou 
temporairement verrouillé (Pro Tools HD 
uniquement).

Pour sélectionner un mode de verrouillage de 
l'état solo :

 Sélectionnez Options > Solo Mode et 
sélectionnez l'une des options suivantes :

Latch : lorsque cette option est sélectionnée, 
les boutons Solo sur lesquels vous appuyez 
successivement ajoutent les pistes correspondantes 
au mix solo.

X-OR (annulation des solos précédents) : lorsque 
cette option est sélectionnée, le fait d'appuyer sur un 
bouton Solo annule les solos précédents.

Momentary (Pro Tools HD uniquement) : lorsque 
cette option est sélectionnée, les boutons Solo ne 
restent pas enclenchés. Une piste reste en solo tant 
que son bouton Solo est maintenu enfoncé.

Avec une surface de contrôle qualifiée, il est 
possible de mettre d'autres pistes en solo en 
appuyant sur leurs touches SOLO (à condition de 
maintenir au moins un bouton Solo enfoncé). 
Toutes les pistes sortiront du mode solo dès 
qu'aucune touche SOLO ne sera plus maintenue 
enfoncée.

Verrouillage temporaire de solos en mode de 
solo Momentary

(Pro Tools HD uniquement)

Pour verrouiller temporairement des pistes en 
solo :

1 Sélectionnez Options > Solo Mode > 
Momentary.

2 Appuyez sur le bouton Solo de la première piste 
à mettre en solo.

3 Tout en maintenant ce bouton enfoncé, appuyez 
sur d'autres boutons Solo. Les boutons Solo 
restent activés tant que vous maintenez un 
bouton Solo enfoncé.

Pour passer outre le mode X-OR et mettre en 
solo plus d'une piste à la fois, maintenez le 
bouton Solo de la première piste enfoncé. 
Les boutons Solo sur lesquels vous appuierez 
par la suite seront activés en mode verrouillé.

Tant qu'au moins un bouton Solo est enfoncé, 
tous les solos restent verrouillés.
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Mode de protection de la mise 
en solo
Pro Tools permet de protéger une piste contre la 
mise en solo. La piste ne pourra être mutée, même 
si d'autres pistes sont mises en solo. Cette fonction 
est utile pour les pistes, telles que les entrées 
auxiliaires utilisées en tant que sous-groupes de 
mixage de pistes audio ou retours d'effets, car elle 
permet à la piste d'effets ou audio de rester dans le 
mix, même lorsque d'autres pistes sont mises en 
solo. Il est également utile de protéger des pistes 
MIDI contre la mise en solo afin que leur lecture ne 
soit pas affectée lorsque vous placez des pistes 
audio en solo.

Pour protéger une piste contre la mise en solo :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée, puis cliquez sur le 
bouton Solo de la piste. La piste ne pourra être 
mutée, même si d'autres pistes sont mises en 
solo. Le bouton Solo devient transparent en 
mode de protection contre la mise en solo.

Pour annuler l'état de protection d'une piste contre 
la mise en solo :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée, puis cliquez une 
nouvelle fois sur le bouton Solo de la piste.

Bouton Mute
Le bouton Mute coupe le son de la piste 
correspondante. Plus d'une piste peuvent être 
mutées simultanément.

Pour muter une piste :

 Cliquez sur le bouton Mute de la piste.

Pour démuter une piste :

 Cliquez une nouvelle fois sur le bouton Mute.

Mute MIDI

Le bouton Mute d'une piste MIDI suspend la 
lecture des données MIDI, non de l'audio. Si vous 
mutez une piste MIDI, aucune donnée MIDI 
n'est transmise à la sortie MIDI. Sur les pistes 
d'instrument, le bouton Mute de la piste coupe la 
lecture du signal audio et le bouton Mute MIDI 
n'est disponible qu'en vue Instruments.

Désactivation des pistes
Les pistes audio, d'entrée auxiliaire, Master Fader, 
Master VCA (Pro Tools HD) et d'instrument 
peuvent être désactivées. Les pistes désactivées 
n'utilisent ni DSP, ni voix. Les plug-ins, départs, 
voix et l'automation des pistes désactivées sont 
également désactivés. Par ailleurs, des pistes 
peuvent être automatiquement désactivées si une 
session est ouverte sur un système dont la puissance 
DSP est inférieure que sur le système d'origine.

Pour activer ou désactiver une piste :

 Maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et cliquez sur l'indicateur du type de 
piste dans la fenêtre Mix.

Les playlists des pistes désactivées sont estompées 
et les commandes des pistes sont grisées.

Les pistes en mode de solo AFL ou PFL 
(Pro Tools HD uniquement) ne peuvent pas 
être protégées contre la mise en solo. Bouton de mute MIDI en vue Instruments dans la 

fenêtre Mix

Les pistes MIDI ne peuvent être désactivées.
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Pour désactiver ou activer une ou plusieurs 
pistes, effectuez l'une des opérations suivantes :

 Sélectionnez la piste, puis Track > Make 

Inactive/Active. 

 Dans la liste des pistes ou la fenêtre Edit ou 
Mix, effectuez un clic droit sur le nom de la 
piste, puis sélectionnez Make Inactive/Active.

Code couleur des pistes, 
clips, marqueurs et groupes
Des couleurs différentes peuvent être affectées à des 
clips, des pistes, des marqueurs et des groupes audio 
et MIDI. Les clips affichés en vue Waveform ou 
Block de la fenêtre Edit apparaissent en couleur. 
Les pistes présentes dans la liste des pistes, la liste 
de groupes et les fenêtres Mix et Edit sont associées 
à des barres de couleurs.

Barres de couleur

Le code couleur appliqué aux pistes apparaît de la 
manière suivante :

Fenêtre Mix : les couleurs des pistes sont affichées 
sous forme de barres de couleur horizontales 
figurant au-dessus de chaque tranche, en dessous 
du nom de la piste. 

Fenêtre Edit : les couleurs des pistes sont affichées 
sous forme de barres de couleur verticales à gauche 
de chaque piste.

Liste des pistes : les couleurs des pistes sont 
affichées sous forme de barres de couleur 
verticales à gauche de chaque nom de piste.

Liste des groupes : les couleurs des pistes sont 
affichées sous forme de barres de couleur 
verticales à gauche de chaque nom de groupe.

Les couleurs par défaut sont automatiquement 
affectées aux pistes, mais il est possible de les 
remplacer en sélectionnant d'autres teintes parmi 
les 96 couleurs de la palette. Pour plus 
d'informations, reportez-vous à la section « Palette 
de couleurs », à la page 250.

Préférences d'affichage 
relatives au code couleur
Les options de codage couleur déterminent 
la manière dont les couleurs sont affectées 
à l'affichage des pistes et clips.

Pour modifier les options de codage couleur :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l’onglet Display.

3 Activez ou désactivez l'option Always Display 

Marker Colors.

4 Sélectionnez l'option MIDI Note Color Shows 

Velocity.

5 Activez ou désactivez l'option Apply Color 

Coding to Track Channel Strip.

6 Sélectionnez une option dans la section Default 

Track Color Coding.

7 Sélectionnez une option dans la section Default 

Clip Color Coding.

8 Cliquez sur OK.

Pour sélectionner plusieurs pistes, maintenez 
la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et cliquez sur les noms de 
pistes supplémentaires.

Pour sélectionner une plage de pistes, 
maintenez la touche Maj enfoncée et cliquez 
sur les noms des pistes à chaque extrémité de 
la plage de pistes à sélectionner.
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Always Display Marker Colors

Cette option permet d'afficher les couleurs des 
marqueurs sur la règle des marqueurs, quelle que 
soit l'option Default Clip Color Coding 
sélectionnée. 

MIDI Note Color Shows Velocity

Lorsque cette option est activée, les notes MIDI 
sont affichées dans la fenêtre Edit et dans les 
fenêtres de l'éditeur MIDI dans différentes nuances 
de la couleur de piste définie dans la vue des notes 
MIDI. Les notes de vélocité élevée sont plus 
sombres et les notes de vélocité faible sont plus 
claires.

Default Track Color Coding

Les options Default Track Color Coding 
déterminent la façon dont les couleurs sont 
assignées à l'affichage des pistes. 

None : désactive l'affectation de couleurs par 
défaut aux pistes.

Tracks and MIDI Channels : affecte une couleur 
à chaque piste de la fenêtre Mix ou Edit en 
fonction de son assignation de voix ou de 
canal MIDI.

Tracks and MIDI Devices : affecte une couleur 
à chaque piste de la fenêtre Mix ou Edit en 
fonction de son assignation de voix ou de 
périphérique MIDI.

Groups : assigne une couleur à chaque piste en 
fonction de son ID de groupe de mixage ou 
d'édition. Si des groupes ont été suspendus à l'aide 
de la commande Suspend Groups, les barres de 
couleur des pistes ne sont pas affichées.

Track Type : affecte une couleur à chaque piste 
en fonction de son type (audio, entrée auxiliaire, 
Master Fader, Master VCA, MIDI, instrument 
ou vidéo).

Default Clip Color Coding

Les options Default Region Color Coding 
déterminent la façon dont les couleurs sont 
assignées à l'affichage des pistes, des clips des 
playlists et de la liste des clips, ainsi qu'aux 
emplacements de marqueur. 

None : désactive l'affectation de couleurs par 
défaut aux clips. Les clips sont représentés par des 
formes d'onde ou notes MIDI noires sur un arrière-
plan gris clair.

Tracks and MIDI Channels : affecte une couleur 
à chaque clip de la fenêtre Edit en fonction de son 
assignation de voix ou de canal MIDI.

Tracks and MIDI Devices : affecte une couleur 
à chaque clip de la fenêtre Edit en fonction de son 
assignation de voix ou de périphérique MIDI.

Groups : affecte une couleur à chaque clip, 
conformément à l'ID de groupe de sa piste. Si des 
groupes sont suspendus à l'aide de la commande 
Suspend Groups, tous les clips sont représentés 
par des formes d'onde ou notes MIDI noires sur un 
arrière-plan gris clair.

Track Color : affecte une couleur de clip basée sur 
la couleur attribuée à la piste (Reportez-vous à la 
section « Palette de couleurs » à la page 250.).

Marker Locations : affecte une couleur unique 
à chaque zone de marqueur sur la règle des 
marqueurs, y compris la zone précédant le premier 
marqueur.

Clip List Color : affecte une couleur à chaque clip 
en fonction de sa couleur dans la liste des clips. 
Lorsque cette option Default Region Color Coding 
est activée, la couleur de clip assignée est 
conservée même si le clip est placé dans un 
ensemble de pistes d'un code couleur différent. 
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Palette de couleurs
La palette de couleurs permet de sélectionner des 
couleurs pour les pistes, les clips, les groupes et les 
marqueurs. 

La palette de couleurs permet d'attribuer aux clips 
des codes couleur différents dans la liste des clips 
et sur les pistes.

Pour appliquer une couleur à partie de la palette de 
couleurs :

1 Sélectionnez Window > Color Palette.

2 Effectuez l'une des opérations suivantes :

• Dans le menu de sélection de cible, sélectionnez 
la destination du code couleur : Tracks, Marker, 
Group, Clips in Tracks ou Clips in Clip List.

• Sélectionnez une piste, un marqueur, un groupe, 
un clip de piste ou un clip de la liste des clips dans 
la fenêtre appropriée de Pro Tools. Le menu de 
sélection de cible affiche le type d'élément que 
vous avez sélectionné.

3 Sélectionnez une couleur de la palette, ou l'une 
des options suivantes :

Default : supprime toute couleur personnalisée 
et rétablit la couleur par défaut. Pour plus 
d'informations, reportez-vous à la section 
« Préférences d'affichage relatives au code 
couleur », à la page 248.

None : désactive l'affectation de couleurs. 
Les clips affectés sont représentés par des formes 
d'onde ou des notes MIDI noires sur fond gris clair. 
Les barres de couleur des pistes et des groupes 
concernés ne sont plus affichées.

Utilisation du bouton Hold 
La palette de couleurs comprend un bouton Hold 
qui permet d'affecter plus simplement des couleurs 
identiques à plusieurs éléments (tels que des pistes 
et clips).

Par défaut, le bouton Hold est désactivé. Dans ce 
cas, la palette de couleurs met automatiquement en 
surbrillance la couleur affectée (le cas échéant) aux 
éléments au fur et à mesure que vous les 
sélectionnez. 

Lorsque le bouton Hold est activé, la couleur 
assignée sélectionnée dans la palette de couleurs 
reste inchangée lorsqu'une piste ou un clip 
différent(e) est sélectionné(e). 

L'activation d'une option de la liste Default 
Region Color Coding autre que l'option Clip 
List Color annule la couleur de la liste des 
clips correspondante et réaffecte la couleur 
de la piste parente aux copies du clip placées 
sur les pistes. Les copies du clip dans la liste 
des clips conservent leur couleur unique.

Fenêtre de la palette de couleurs

Sélection de cible
Appliquer aux tranches

Saturation
Brightness

Default
None

Dernière couleur affectée Hold

Si l'option Marker n'apparaît pas dans le menu 
de sélection de cible après avoir sélectionné 
un marqueur, alors l'option Always Display 
Marker Colors des préférences d'affichage est 
activée. Pour plus d'informations, reportez-
vous à la section « Always Display Marker 
Colors », à la page 249.
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Pour utiliser le bouton Hold afin d'affecter une 
même couleur à plusieurs éléments : 

1 Cliquez sur le bouton Hold pour l'activer. 
Le bouton Hold devient blanc et la couleur 
actuellement sélectionnée est mise en 
surbrillance (elle est entourée d'un cadre blanc). 

2 Sélectionnez des pistes ou des clips 
supplémentaires auxquels vous voulez affecter 
la couleur choisie. Étant donné que le bouton 
Hold est activé, la palette de couleurs n'est pas 
affectée par la sélection de l'élément ; elle 
conserve (ou « bloque ») la dernière couleur 
actuellement assignée. 

3 Cliquez à nouveau sur la couleur affectée pour 
l'appliquer à la nouvelle sélection de pistes ou 
de clips. Utilisez le menu de sélection de cible 
pour déterminer les éléments sélectionnés 
concernés. 

4 Pour désactiver le bouton Hold et rétablir le 
mode par défaut de la palette de couleurs, 
cliquez sur le bouton Hold pour le désactiver. 

Application du code couleur des 
pistes aux tranches
La palette de couleurs permet d'appliquer le code 
couleur des pistes aux tranches des fenêtres Mix et 
Edit.

Pour appliquer le code couleur des pistes aux 
tranches :

1 Activez le bouton d'application du code aux 
tranches.

2 Si nécessaire, ajustez le curseur Saturation pour 
modifier la saturation des couleurs. 

3 Si nécessaire, ajustez le curseur Brightness. 

Code couleur appliqué aux tranches de la fenêtre Mix
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Chapitre 14 : Groupement de pistes

La fonction de groupement de Pro Tools permet de 
lier des pistes et leurs commandes pour les 
manipuler simultanément. 

Groupement de pistes
Les groupes sont pratiques pour appliquer des 
opérations d'édition identiques à plusieurs pistes 
ou pour mixer plusieurs pistes (une paire de pistes 
stéréo ou un sous-groupe par exemple), tout en 
conservant leurs niveaux de volume relatifs. 

Pro Tools offre les caractéristiques de groupement 
suivantes :

• Jusqu'à 104 groupes disponibles, répartis en 
4 banques de 26 ID de groupe. ;

• Imbrication de groupes (sous-groupes 
à l'intérieur de groupes). ;

• Ajustement relatif des faders ou contrôleurs 
groupés les uns par rapport aux autres. ;

• Groupes assignables à une piste Master VCA 
disponible (Pro Tools HD uniquement).

Groupes de mixage, groupes 
d'édition et groupes de 
mixage/édition
Les groupes de mixage ont une incidence 
uniquement sur les fonctions de mixage alors que 
les groupes d'édition concernent les fonctions 
d'édition. Les groupes de mixage/édition associent 
les fonctions des groupes de mixage et d'édition.

Groupes d'édition

Les éléments suivants des fenêtres Edit et de 
l'éditeur MIDI sont affectés par les groupes 
d'édition :

• Vue des pistes

• Hauteur des pistes

• Base de temps des pistes

• Fonctions d'édition audio et MIDI

• Fonctions d'édition de l'automation

Groupes de mixage dans Pro Tools HD

Les groupes de mixage dans Pro Tools HD 
peuvent être configurés pour affecter les éléments 
suivants :

• Commande mute principale

• Solo

• Niveau des départs 

• Mute des départs

• Volume principal

• Panoramique principal

• Niveau LFE principal

• Activation pour l'enregistrement

• Monitoring d'entrée

• Mode d'automation

• Panoramique des départs

• Niveau LFE des départs

• Commandes des plug-ins

• Bypass des plug-ins
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Groupes de mixage dans Pro Tools

Les éléments suivants de Pro Tools sont toujours 
affectés par les groupes de mixage :

• Volume principal

• Mode d'automation

Les groupes de mixage dans Pro Tools peuvent 
également agir sur les éléments suivants :

• Commande mute principale

• Solo

• Niveau des départs 

• Mute des départs

Limitations des groupes

Les paramètres suivants ne sont pas affectés par les 
groupes :

• Assignation des voix

• Assignation des sorties

• Insertion de plug-ins

• Plug-ins Elastic Audio

Attributs de groupe 
sélectionnables
Vous pouvez choisir quels paramètres ou attributs 
des groupes sont liés à l'aide de l'une des méthodes 
suivantes. :

• En créant un groupe d'édition, de mixage 
ou une combinaison des deux (groupe de 
mixage/édition). ;

• En choisissant parmi la liste des attributs du 
groupe (groupes de mixage et de 
mixage/édition). ;

• En choisissant si les attributs sélectionnés 
s'appliquent globalement à tous les groupes ou 
à des groupes individuels (groupes de mixage 
dans Pro Tools HD).

Liaison des groupes de mixage et 
d'édition

L'option Link Mix and Edit Group Enables lie 
l'activation des groupes entre les fenêtres Mix et 
Edit. Pro Tools permet de créer des groupes qui 
sont à la fois des groupes de mixage et d'édition, 
mais il peut être utile dans certains cas qu'ils ne 
soient pas toujours activés en même temps. Si vous 
utilisez par exemple la fenêtre Mix pour le mixage 
d'une session, il peut être préférable d'utiliser 
des groupes de taille importante et imbriqués. 
En revanche, dans la fenêtre Edit ou une fenêtre de 
l'éditeur MIDI, vous préférerez sans doute réaliser 
les tâches d'édition à l'intérieur d'un groupe plus 
petit. Désactivez l'option Link Mix and Edit Group 

Enables pour utiliser des groupes différents dans 
les deux fenêtres.

Pour désactiver la liaison entre les groupes de 
mixage et d'édition :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing. 

2 Désactivez l'option Link Mix and Edit Group 

Enables. 

3 Cliquez sur OK.

Dans Pro Tools HD, lorsque l'attribut de 
panoramique principal est activé pour les 
groupes, le comportement de groupe s'applique 
aux commandes de liaison et d'inversion des 
canaux avant, arrière et avant/arrière dans les 
fenêtres de panoramique multicanal et stéréo.
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Groupes de mixage et 
Masters VCA
(Pro Tools HD uniquement)

Il est possible d'assigner un groupe de mixage 
existant à une piste Master VCA ou un nouveau 
groupe de mixage à une piste Master VCA lors de 
sa création. Vous ne pouvez assigner qu'un groupe 
à la fois à une piste Master VCA. Une piste Master 
VCA ne peut pas contrôler un groupe qui s'inclut 
lui-même.

Commandes des groupes
Les menus et commandes de création et de 
modification des groupes sont accessibles à partir 
des éléments suivants :

• Liste des groupes

• Nom des groupes dans la liste de groupes

• Indicateurs d'ID de groupe des pistes

• Menu Track > Group

La liste des groupes
Les fonctions de groupement de pistes de 
Pro Tools se trouvent à gauche des fenêtres Mix, 
Edit et de l'éditeur MIDI dans la liste des groupes. 
Cette fenêtre défilante contient les noms de tous 
les groupes de votre session, ainsi qu'un menu 
d'accès aux commandes de groupement. Vous 
pouvez sélectionner et activer des groupes à partir 
de ce menu.

Par défaut, chaque session possède un groupe 
nommé All, qui inclut toutes les pistes de la 
session. Vous ne pouvez ni modifier, ni supprimer 
le groupe All.

Bouton d'affichage/masquage de la 
liste des pistes/groupes

Pour afficher la liste des groupes (et la liste 
des pistes) :

 Cliquez sur le bouton d'affichage/masquage de 
la liste des pistes/groupes dans la fenêtre Mix, 
Edit ou de l'éditeur MIDI.

ID de groupe

À gauche de chaque nom dans la liste des groupes 
figure une lettre correspondant à son ID de groupe 
(de « a » à « z »).

Pour plus d'informations sur l'assignation 
des groupes aux pistes Master VCA, 
reportez-vous à la section « Assignation de 
groupes à des Masters VCA » à la page 990.

Liste des groupes

Menu de la liste des groupes

Cliquez pour 
sélectionner 
un groupe en 
tapant sa 
lettre

Cliquez 
pour activer 
un groupe 

Cliquez 
pour 
sélectionner 
les 
membres 
du groupe

Afficher/masquer la 
liste des groupes

ID de 
groupe

Couleurs
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Symboles de groupe

À gauche de chaque ID de groupe (« a » à « z ») 
se trouve un symbole indiquant si ce groupe est 
sélectionné dans la fenêtre actuelle (Edit ou Mix). 
Il existe trois types de symboles de groupe, 
représentés sur la figure suivante :

Les significations de ces symboles de groupe sont 
les suivantes :

Cercle plein : indique que tous les membres du 
groupe sont actuellement sélectionnés, et qu'aucun 
membre extérieur au groupe n'est sélectionné.

Cercle vide : indique que seuls certains membres 
du groupe sont actuellement sélectionnés.

Cercle avec point : indique que tous les membres 
du groupe sont actuellement sélectionnés, ainsi 
que des membres extérieurs au groupe.

Menu de la liste des groupes

Le menu apparaissant en haut de la liste des 
groupes contient les commandes suivantes :

New Group : Exécute la commande Track > Group.

Display : permet d'accéder à des commandes 
d'affichage des groupes d'édition, de mixage ou de 
tous les groupes (édition, mixage et 
mixage/édition).

Suspend All Groups : suspend le comportement de 
groupe de tous les groupes de mixage et d'édition.

Modify Groups : ouvre la boîte de dialogue Group 
pour modifier uniquement les groupes existants.

Delete Active Groups : supprime uniquement les 
groupes actuellement actifs.

Menus des ID de groupe de 
pistes et noms de groupes
Lorsque vous effectuez un clic droit sur un nom de 
groupe dans la liste des groupes, ou lorsque vous 
cliquez sur un indicateur d'ID de groupe, un menu 
s'affiche avec les commandes suivantes :

Tracks : affiche les pistes appartenant au groupe.

Attributes : affiche les attributs du groupe.

Modify : ouvre la boîte de dialogue Group pour 
modifier uniquement les groupes existants.

Duplicate : ouvre la boîte de dialogue Group pour 
le groupe dupliqué.

Delete : supprime un groupe unique.

Select Tracks in Group : sélectionne les pistes 
du groupe.

Show/Hide Tracks in Group : affiche ou masque 
les pistes du groupe actuel.

Show Only Tracks in Group : affiche uniquement 
les pistes du groupe et masque toutes les autres.

Show All Tracks : affiche toutes les pistes de 
la session.

Symboles de groupe

Cercle vide

Cercle plein

Cercle avec point Menu de la liste des groupes
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Boîte de dialogue Group 
Quelle que soit la tâche à effectuer (création ou 
modification de groupes via la liste des groupes, 
l'indicateur d'ID de groupe d'une piste ou la 
commande Track > Group), vous utiliserez la boîte 
de dialogue Groups.

La boîte de dialogue Groups permet de créer des 
groupes et de leur assigner des attributs.

Boîte de dialogue Group dans 
Pro Tools HD

Dans Pro Tools HD, la boîte de dialogue Group est 
composée de trois pages :

Tracks : permet d'ajouter et de retirer des pistes 
dans le groupe actuel.

Attributes : permet de sélectionner les paramètres 
liés du groupe de mixage ou de mixage/édition 
actuel.

Globals : permet de sélectionner des paramètres 
à appliquer en tant que modèle à des groupes 
individuels à l'aide de l'option Follow Globals.

Menu contextuel des noms de groupe

Menu contextuel des indicateurs d'ID de groupe

Boîte de dialogue Group (Pro Tools HD)
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Boîte de dialogue Group dans Pro Tools

Dans Pro Tools, la boîte de dialogue Group est 
constituée d'une seule page.

Utilisation des groupes

Création de groupes
Vous pouvez sélectionner les pistes que vous 
souhaitez ajouter à un groupe avant de le créer, 
ou ajouter et retirer des pistes d'un groupe après sa 
création.

Création de groupes dans Pro Tools HD

Pour créer un groupe dans Pro Tools HD :

1 Sélectionnez les pistes à inclure dans le groupe. 
Si aucune piste n'est sélectionnée à cette étape, 
vous pourrez en ajouter ultérieurement.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Group.

• Sélectionnez New Group dans le menu de la liste 
des groupes.

3 Saisissez le nom du groupe.

4 Sélectionnez le type de groupe à créer : Edit, 
Mix ou Mix/Edit.

5 Sélectionnez un ID de groupe dans le menu ID. 
Quatre banques de 26 ID sont disponibles : a–z, 

2a–z, 3a–z, 4a–z. Si vous ne sélectionnez pas 
d'ID de groupe, Pro Tools attribue 
automatiquement le prochain ID disponible au 
nouveau groupe. 

6 Sélectionnez des pistes et effectuez l'une des 
opérations suivantes :

• Pour ajouter au groupe les pistes actuellement 
sélectionnées dans la session, cliquez sur le 
bouton Add en bas de la boîte de dialogue 
Group.

• Pour ajouter des pistes au groupe, sélectionnez 
les noms des pistes dans la liste Available, puis 
cliquez sur Add ou appuyez sur la touche A du 
clavier de votre ordinateur.

• Pour retirer des pistes du groupe, sélectionnez 
les noms des pistes dans la liste Currently In 
Group, puis cliquez sur Remove ou appuyez sur 
la touche R du clavier de votre ordinateur.

• Double-cliquez sur des noms de pistes dans l'une 
ou l'autre des listes pour les transférer dans la 
colonne opposée.

• Pour remplacer toutes les pistes du groupe par 
les pistes actuellement sélectionnées dans la 
session, cliquez sur le bouton Replace en bas de 
la boîte de dialogue Group.

Boîte de dialogue Group (Pro Tools)

Dans l'une ou l'autre des listes, cliquez sur 
les noms des pistes tout en maintenant la 
touche Maj enfoncée pour sélectionner une 
plage de noms de piste. Maintenez la touche 
Ctrl (Windows) ou Commande (Mac) 
enfoncée, puis cliquez pour sélectionner des 
noms de pistes non contigus.
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7 Si le groupe est un groupe de mixage ou un 
groupe de mixage/édition, effectuez l'une des 
opérations suivantes :

• Configurez les attributs du groupe (reportez-
vous à la section « Configuration des attributs 
des groupes » à la page 262).

• Si vous souhaitez assigner le groupe à un VCA 
disponible, sélectionnez le Master VCA à partir 
du menu VCA.

8 Cliquez sur OK.

Création de groupes dans Pro Tools

Pour créer un groupe dans Pro Tools :

1 Sélectionnez les pistes à inclure dans le groupe. 
Si aucune piste n'est sélectionnée à cette étape, 
vous pourrez en ajouter ultérieurement.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Group.

• Sélectionnez New Group dans le menu de la liste 
des groupes.

3 Saisissez le nom du groupe.

4 Sélectionnez le type de groupe à créer : Edit, 

Mix ou Mix/Edit.

5 Sélectionnez un ID de groupe dans le menu ID. 
Quatre banques de 26 ID sont disponibles : a–z, 

2a–z, 3a–z, 4a–z. Si vous ne sélectionnez pas 
d'ID de groupe, Pro Tools attribue 
automatiquement le prochain ID disponible au 
nouveau groupe. 

6 Effectuez l'une des opérations suivantes :

• Pour ajouter au groupe les pistes actuellement 
sélectionnées dans la session, cliquez sur le 
bouton Add en bas de la boîte de dialogue Group.

• Pour ajouter des pistes au groupe, sélectionnez 
les noms des pistes dans la liste Available, puis 
cliquez sur Add ou appuyez sur la touche A du 
clavier de votre ordinateur.

• Pour retirer des pistes du groupe, sélectionnez 
les noms des pistes dans la liste Currently In 
Group, puis cliquez sur Remove ou appuyez sur 
la touche R du clavier de votre ordinateur.

• Double-cliquez sur des noms de pistes dans l'une 
ou l'autre des listes pour les transférer dans la 
colonne opposée.

• Pour remplacer toutes les pistes du groupe par 
les pistes actuellement sélectionnées dans la 
session, cliquez sur le bouton Replace en bas de 
la boîte de dialogue Group.

7 Sélectionnez les éléments des groupes à lier 
dans la zone Linked Within Groups : Mutes, 
Solos, Send Mute, Send Levels.

8 Cliquez sur OK.

Modification d'un groupe

Pour modifier un groupe :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Modify Groups dans le menu de la 
liste des groupes. 

• Dans la fenêtre Mix, cliquez sur l'indicateur d'ID 
de groupe d'une piste et sélectionnez Modify 
dans le menu déroulant. 

• Effectuez un clic droit sur le nom du groupe dans 
la liste des groupes et sélectionnez Modify dans 
le menu contextuel.

2 Dans la boîte de dialogue Groups, sélectionnez 
le groupe que vous souhaitez modifier à partir 
du menu ID.

Dans l'une ou l'autre des listes, cliquez sur 
les noms des pistes tout en maintenant la 
touche Maj enfoncée pour sélectionner une 
plage de noms de piste. Maintenez la touche 
Ctrl (Windows) ou Commande (Mac) 
enfoncée, puis cliquez pour sélectionner des 
noms de pistes non contigus.
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3 Changez les éléments de votre choix pour le 
groupe actuel :

• Nom du groupe

• Type de groupe (Edit, Mix ou Mix/Edit)

• État VCA (Pro Tools HD uniquement)

• État de l'option Follows Global (Pro Tools HD 
uniquement)

• Pistes appartenant au groupe

• Attributs (Pro Tools HD uniquement)

• Éléments liés du groupe (Linked Within Group) 
(Pro Tools HD uniquement)

4 Cliquez sur OK.

Pour modifier les paramètres du groupe « All » 
dans Pro Tools HD :

1 Effectuez un clic droit sur le nom du groupe 
« All » dans la liste des groupes et sélectionnez 
Modify dans le menu contextuel.

2 Dans la boîte de dialogue Group, sélectionnez 
Edit, Mix ou Mix/Edit pour modifier les 
paramètres du groupe « All ». Si vous 
sélectionnez Edit ou Mix uniquement, le groupe 
« All » s'applique uniquement à ce type de 
groupe. 

3 Pour les groupes de mixage ou de 
mixage/édition, vous avez la possibilité de 
modifier les paramètres suivants :

• État de l'option Follows Globals

• Attributs

4 Cliquez sur OK. 

Pour modifier les paramètres du groupe « All » 
dans Pro Tools :

1 Effectuez un clic droit sur le nom du groupe 
« All » dans la liste des groupes et sélectionnez 
Modify dans le menu contextuel.

2 Dans la boîte de dialogue Group, sélectionnez 
Edit, Mix ou Mix/Edit pour modifier les 
paramètres du groupe « All ». Si vous 
sélectionnez Edit ou Mix uniquement, le groupe 
« All » s'applique uniquement à ce type de 
groupe. 

Boîte de dialogue Modify ALL Group (Pro Tools HD)
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3 Pour les groupes de mixage ou de 
mixage/d'édition, vous avez la possibilité de 
modifier les options suivantes de liaison des 
éléments des groupes (Linked Within Groups) :

• Mutes 

• Solos 

• Send Mutes 

• Send Levels 

4 Cliquez sur OK. 

Suppression de groupes
Il est possible de supprimer un groupe ou tous les 
groupes à la fois.

Pour supprimer un groupe unique, effectuez l'une 
des opérations suivantes :

 Dans la fenêtre Mix, cliquez sur l'indicateur 
d'ID de groupe d'une piste et sélectionnez 
Delete dans le menu déroulant. 

 Effectuez un clic droit sur le nom du groupe 
dans la liste des groupes et sélectionnez Delete 
dans le menu contextuel.

Pour supprimer tous les groupes actuellement 
actifs :

 Sélectionnez Delete Active Groups dans le 
menu de la liste des groupes. 

Duplication de groupes
Vous pouvez dupliquer un groupe et modifier ses 
paramètres pour préparer rapidement un mixage. 

Pour dupliquer un groupe :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur l'indicateur d'ID de groupe d'une 
piste et sélectionnez Duplicate dans le menu 
déroulant. 

• Effectuez un clic droit sur le nom du groupe dans 
la liste des groupes et sélectionnez Duplicate 
dans le menu contextuel.

2 Changez les éléments de votre choix pour le 
groupe actuel :

• Nom du groupe

• Type de groupe (Edit, Mix ou Mix/Edit)

• État VCA (Pro Tools HD uniquement)

• État de l'option Follows Globals (Pro Tools HD 
uniquement)

• Pistes appartenant au groupe

• Attributs (Pro Tools HD uniquement)

• Éléments liés du groupe (Linked Within Group) 
(Pro Tools uniquement)

3 Cliquez sur OK. 

Boîte de dialogue Modify ALL Group (Pro Tools)

La suppression d'un groupe est irréversible.

Il est impossible de supprimer le groupe 
« All ».
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Configuration des attributs 
des groupes
(Pro Tools HD uniquement)

Lorsque vous créez un groupe de mixage ou un 
groupe de mixage/édition, vous avez la possibilité 
de sélectionner les paramètres de la fenêtre Mix 
qui seront liés. Ces paramètres liés sont les 
attributs du groupe.

Vous pouvez sélectionner des attributs sur la page 
Globals et configurer des groupes individuels afin 
qu'ils se conforment aux paramètres globaux, 
ou encore appliquer des attributs à des groupes de 
façon indépendante. 

Sélection des attributs sur la 
page Globals

Pour sélectionner des attributs sur la page 
Globals :

1 Lors de la création ou de la modification d'un 
groupe, cliquez sur Globals dans la boîte de 
dialogue Group.

2 Sélectionnez le jeu de base d'attributs des 
groupes de votre session. 

3 Cliquez sur OK pour enregistrer le groupe et les 
nouveaux paramètres globaux.

Page Globals de la boîte de dialogue Group

Pour plus d'informations sur la sélection des 
attributs, reportez-vous à la section 
« Sélection des attributs de groupe » à la 
page 263.
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Pour sélectionner des attributs pour un groupe 
indépendant :

1 Lors de la création ou de la modification d'un 
groupe de mixage ou d'un groupe de 
mixage/édition, effectuez l'une des opérations 
suivantes :

• Cliquez sur Attributes dans la boîte de dialogue 
Group et sélectionnez les attributs à associer au 
groupe. 

• Activez l'option Follow Globals pour respecter 
l'ensemble d'attributs de base. La page 
Attributes s'estompe pour signaler que le groupe 
est conforme aux sélections de la page Globals.

2 Cliquez sur OK pour enregistrer les paramètres.

Sélection des attributs de 
groupe
Les attributs suivants peuvent être sélectionnés en 
tant que paramètres globaux ou pour des groupes 
individuels.

Commandes des pistes :

• Volume principal

• Commande mute principale

• Panoramique principal

• Niveau LFE principal

Commandes d'insert (A à J) :

• Commandes des plug-ins

• Bypass d'insert

Commandes de départ (A à J) :

• Niveau des départs

• Mute des départs

• Panoramique des départs

• Niveau LFE des départs

Attributs de la fenêtre Mix :

• Activation pour l'enregistrement

• Monitoring d'entrée

• Solos

• Mode d'automation

• État pré/post de HEAT (Pro Tools|HDX 
uniquement)

• Bypass de HEAT (Pro Tools|HDX uniquement)

Pour sélectionner les attributs d'un groupe, 
effectuez l'une des opérations suivantes :

 Sélectionnez des attributs individuels.

 Pour sélectionner ou désélectionner tous les 
attributs, maintenez les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées, 
puis cliquez sur un attribut.

Pour plus d'informations sur la sélection des 
attributs, reportez-vous à la section 
« Sélection des attributs de groupe » à la 
page 263.

Page Attributes de la boîte de dialogue Group
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 Pour sélectionner ou désélectionner tous les 
attributs d'un départ ou insert unique (rangée 
entière), maintenez la touche Démarrer 
(Windows) ou Commande (Mac) enfoncée et 
cliquez sur un attribut de cette rangée. 

 Pour sélectionner ou désélectionner les attributs 
d'une commande unique pour tous les départs, 
tous les inserts ou pour les quatre commandes 
de piste (colonne entière), maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée et 
cliquez sur un attribut de cette colonne. 

Enregistrement de presets 
d'attributs de groupe
Il est possible de configurer six presets d'attributs 
de groupe que vous pouvez rappeler à partir de la 
page Attributes ou Globals chaque fois que vous 
créez ou modifiez un groupe de mixage ou de 
mixage/édition. 

Pour enregistrer les paramètres d'attributs actuels 
en tant que preset :

1 Dans la boîte de dialogue Group, cliquez sur 
Save. Pour enregistrer des paramètres à partir 
de la page Attributes, assurez-vous que l'option 
Follow Globals est désélectionnée.

2 Dans la boîte de dialogue Save Group Settings, 
sélectionnez l'un des six emplacements de 
preset à partir du menu Location, puis cliquez 
sur Save.

Pour rappeler un preset de groupe :

 Cliquez sur le bouton de preset correspondant 
(1 à 6) dans la boîte de dialogue Groups. Pour 
rappeler des paramètres à partir de la page 
Attributes, assurez-vous que l'option Follow 
Globals est désélectionnée.

Activation des groupes
Les opérations d'édition ne s'appliquent pas aux 
membres d'un groupe masqués dans la liste des 
pistes. Les opérations de mixage (à l'exception de 
l'activation pour l'enregistrement des pistes) 
s'appliquent aux pistes masquées.

Pro Tools permet de créer des groupes distincts 
pour l'édition et le mixage. Cette option est définie 
lorsque vous utilisez la commande New Group. 
Les groupes concernés à la fois par l'édition et le 
mixage peuvent être découplés.

Pour activer un groupe :

 Dans la liste des groupes, sélectionnez le 
nom du groupe à activer. Le nom est affiché 
en surbrillance pour indiquer que le groupe 
est activé.

Pour activer d'autres groupes, cliquez sur leurs 
noms dans la liste des groupes. 

Enregistrement d'un preset de groupe

Sélection d'un emplacement pour les paramètres du 
groupe 

Pour enregistrer les paramètres d'attributs 
actuels directement dans un emplacement 
de preset, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée 
et cliquez sur le bouton de preset.

Rappel d'un preset de groupe
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Le déplacement du fader d'un membre du groupe 
entraîne un déplacement proportionnel des faders 
des autres membres du groupe. Si un fader 
appartient à plusieurs groupes et qu'ils entrent en 
conflit lorsque les faders sont déplacés, il suivra le 
groupe de plus haut niveau, ou « parent », auquel il 
appartient.

Pour désactiver un groupe :

 Dans la liste des groupes, sélectionnez le nom 
du groupe à désactiver. Le nom n'est plus 
affiché en surbrillance pour indiquer que le 
groupe est désactivé.

Sélection de groupes au clavier
Le focus clavier sur la liste des groupes permet de 
basculer l'état d'activation d'un groupe en tapant 
directement une lettre d'ID de groupe.

 Dans la fenêtre Mix, le focus clavier sur la liste 
des groupes est toujours actif. 

 Dans la fenêtre Edit, vous devez activer le focus 
pour pouvoir l'utiliser.

Pour activer le focus clavier sur la liste des 
groupes, effectuez l'une des opérations 
suivantes :

 Cliquez sur le bouton du focus clavier en haut 
à droite de la liste des groupes.

 Appuyez sur Ctrl+Alt+3 (Windows) ou 
Commande+Option+3 (Mac).

Pour activer ou désactiver des groupes avec le 
focus clavier sur la liste des groupes des fenêtres 
Edit et Mix :

 Lorsque le focus est activé, tapez la lettre de l'ID 
du groupe (a à z) pour activer ou désactiver 
automatiquement le groupe en question.

Isolation temporaire d'une 
commande d'un élément dans le 
cadre d'une opération de groupe
Il est possible d'isoler temporairement la 
commande d'un élément d'un groupe lors d'une 
opération de groupe en effectuant un clic droit sur 
l'élément.

Il est possible d'isoler les éléments suivants lors 
d'une opération de groupe :

• Curseur de panoramique (Pro Tools HD 
uniquement)

• Activation pour l'enregistrement des canaux 
(Pro Tools HD uniquement)

• Bouton TrackInput des canaux (Pro Tools HD 
uniquement)

• Curseur de panoramique des départs 

• Fader de volume des canaux

• Curseur de panoramique des canaux

• Bouton Mute des canaux

• Bouton Solo des canaux

• Bouton d'activation pour l'enregistrement des 
canaux

• Bouton TrackInput des canaux

• Fader des départs

• Curseur de panoramique des départs
Focus clavier activé sur la liste des groupes

Vous pouvez également suspendre 
temporairement le comportement de groupe 
d'une piste en maintenant la touche Ctrl (Mac) 
ou Démarrer (Windows) enfoncée pendant 
que vous cliquez sur une fonction de groupe.
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Décalages pour les 
commandes groupées
Lorsque les commandes suivantes sont groupées 
et que leur valeur varie d'une piste à l'autre, si vous 
les déplacez vers leurs positions extrêmes, 
les décalages relatifs sont préservés lorsque vous 
changez à nouveau leur position :

• Volume principal

• Panoramique principal (Pro Tools HD 
uniquement)

• Niveau des départs

• Panoramique des départs

Si un fader de volume groupé est déplacé, 
par exemple, jusqu'à sa valeur maximale, tout 
autre fader de ce groupe possédant une valeur 
supérieure mémorisera leur décalage relatif dès 
que vous rebaisserez le premier fader.

Dans les vues d'automation, ce phénomène est 
matérialisé dans la playlist d'automation par des 
points d'automation bleus aux niveaux extrêmes de 
la playlist d'automation.

Définition de commandes de 
panoramique groupées afin 
d'ignorer les décalages
Par défaut, les décalages sont préservés pour les 
commandes de panoramique groupées. Pour 
certains workflows, il est préférable de faire 
correspondre les commandes de panoramique 
groupées à des valeurs absolues plutôt que de 
maintenir les décalages.

Pour définir des commandes de panoramique 
groupées afin d'ignorer les décalages :

1 Sélectionnez Setup > Preferences et cliquez 
sur Mixing.

2 Sélectionnez l'option Use Absolute Pan Linking.

Lorsque cette option est activée, les commandes de 
panoramique groupées s'alignent par rapport à la 
valeur absolue de la commande panoramique en 
cours d'ajustement.
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Chapitre 15 : La liste des clips

La fenêtre Edit affiche dans une liste des clips 
complète la totalité des clips audio et MIDI, ainsi 
que les groupes de clips. 

Tous les clips enregistrés, importés ou créés lors 
de l'édition apparaissent dans la liste des clips. 
Les éléments peuvent être déplacés d'une liste vers 
des pistes et disposés dans un ordre quelconque. 
Vous pouvez également obtenir un aperçu des 
clips audio et MIDI et des groupes de clips dans 
la liste des clips.

Les informations des clips pouvant être longues, 
vous pouvez faire défiler ou redimensionner 
la liste des clips si nécessaire. 

Menu de la liste des clips
Le menu de la liste des clips propose des outils 
permettant de rechercher, sélectionner, trier, 
exporter, supprimer et gérer les différents éléments 
de la liste.

Pour accéder au menu déroulant de la liste 
des clips :

 Dans la fenêtre Edit, cliquez sur le menu de 
la liste des clips.

Liste des clips

Cliquez sur le bouton Show/Hide Clip List 
pour masquer la liste des clips

Faites glisser pour modifier 
la largeur 

de la liste des clips Menu de la liste des clips

Focus clavier Utilisez la liste des clips comme un chutier 
permettant de stocker vos boucles audio et clips 
MIDI favoris. Si vous enregistrez une session en 
tant que modèle, les clips seront disponibles 
pour les sessions futures (reportez-vous à la 
section « Modèles de session » à la page 168).

Menu de la liste des clips
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Affichage des clips dans la 
liste des clips
La liste des clips peut afficher tous les types 
de clips (audio, MIDI, vidéo, groupes, créés 
automatiquement), ou uniquement certains types 
de clips. Vous pouvez ainsi isoler un type de clips 
spécifique pour réaliser des opérations d'édition 
et d'arrangement. Par exemple, lorsque vous 
arrangez des groupes de clips, vous pouvez faire en 
sorte que la liste des clips n'affiche que les groupes 
de clips.

Pour afficher ou masquer certains types de clips 
dans la liste des clips :

 Cliquez sur le menu de la liste des clips (en haut 
de la liste), puis sélectionnez Show. Dans le 
sous-menu, sélectionnez ou désélectionnez le 
type de clip à afficher ou masquer. 

Audio : affiche ou masque les clips audio dans la 
liste des clips.

MIDI : affiche ou masque les clips MIDI dans la 
liste des clips.

Video : affiche ou masque les clips vidéo dans la 
liste des clips.

Groups : affiche ou masque les groupes de clips 
dans la liste des clips.

Auto-Created : affiche ou masque les clips créés 
automatiquement (de tous types) dans la liste 
des clips. Ces clips ont pu être créés par les 
commandes couper, coller ou par la séparation 
d'autres clips. Puisque le nombre de ces clips créés 
automatiquement peut devenir important, le fait de 
les masquer (en désélectionnant l'option) évite 
d'avoir à faire défiler la totalité d'une liste des clips 
trop longue pour rechercher un clip spécifique. 

Dans la liste des clips, les clips audio de fichier 
entier apparaissent en gras et les clips audio stéréo 
et multicanal peuvent être développés pour 
afficher leurs canaux individuels.

Si l'option Clip List Selection Follows Edit 

Selection est activée dans les préférences d'édition, 
le fait de cliquer sur un clip ou un groupe de clips 
dans la liste des clips permet de les sélectionner 
sur la piste à laquelle ils appartiennent (dans les 
playlists assignées). De même, la sélection d'un 
clip ou d'un groupe de clips sur une piste est 
reflétée dans la liste des clips.

Affichage d'informations sur les 
fichiers de clips audio
En plus des noms de clip, la liste des clips peut 
également afficher des informations concernant 
le code couleur, le type (audio, MIDI et groupe de 
clips), la base de temps, le traitement Elastic Audio 
et le fichier audio parent du clip :

Timebase : affiche la base de temps (basée sur les 
références de tempo ou les échantillons) pour les 
clips audio et MIDI, ainsi que pour les groupes 
de clips.

Color : affiche le code couleur des pistes tel qu'il est 
assigné avec l'option Default Clip Color Coding sur 
la page des préférences d'affichage, ou tel qu'il est 
assigné dans la palette des couleurs.

Processing State : affiche l'icône de l'indicateur 
de déformation si un traitement Elastic Audio est 
appliqué au clip.

Masquer les clips créés automatiquement 
peut être utile lors de l'importation de 
groupes de clips (ou de fichiers REX en tant 
que groupes de clips). En effet, comme ces 
types de fichiers contiennent parfois un 
grand nombre de clips distincts, la liste des 
clips risque d'être difficile à consulter.
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Guitar Settings (Eleven Rack uniquement) : 
affiche l'icône Eleven Rack lorsque des paramètres 
de guitare sont intégrés au clip.

File Type : affiche l'icône du type de fichier pour 
les clips audio et MIDI et les groupes de clips.

File Name : affiche le nom du fichier parent.

Disk Name : affiche le nom du disque dur sur 
lequel sont situés les fichiers référencés.

Full Path : affiche le chemin d'accès complet du 
répertoire du fichier parent du clip.

Channel Name : affiche le nom du canal des 
fichiers audio importés à partir d'enregistreurs 
portables.

Scene and Take : affiche la scène et la prise des 
fichiers audio importés à partir d'enregistreurs 
portables.

Par défaut, Pro Tools affiche uniquement les noms 
des clips dans la liste des clips. 

Tri et recherche dans la liste 
des clips
La plupart des sessions contiennent de nombreux 
clips, ce qui peut rendre difficile la recherche d'un 
clip particulier dans la liste des clips. Pro Tools 
permet de trier et rechercher les clips dans la liste 
des clips afin de localiser rapidement les clips 
souhaités.

Tri des clips

Pour trier les clips de la liste des clips :

1 Cliquez sur le menu de la liste des clips (en haut 
de la liste), puis sélectionnez Sort By. 

2 Sélectionnez un critère de tri dans le sous-menu. 
Différentes options sont disponibles pour les 
clips audio et MIDI. Reportez-vous à la section 
« Options de tri » à la page 269.

3 Pour indiquer si les clips doivent être classés par 
ordre croissant ou décroissant, cliquez sur le 
menu de la liste des clips, sélectionnez Sort By, 
puis Ascending ou Descending.

Options de tri
Les options Sort By permettent de trier les clips 
lorsque leur nombre devient important.

Les options de tri des clips audio sont les 
suivantes :

• Clip Type

• Name

• Length

• Original Time Stamp

• User Time Stamp

• Timebase

• Start in Parent

• End in Parent

Clips et informations sur les fichiers affichés dans la 
liste des clips

Lorsque vous effectuez des opérations d'édition, 
la liste des clips peut être surchargée avec les 
clips créés automatiquement. Vous pouvez 
masquer les clips créés automatiquement en 
choisissant l'option Show dans le menu de la 
liste des clips, puis en désélectionnant l'option 
Auto-Created.
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• File Name

• File Length

• File Creation Date

• File Modification Date

• Disk Name (audio et groupes de clips 
uniquement)

• Track Format/Width

• By Channel Name

• By Scene and Take

• Guitar Settings

Les options de tri des clips MIDI sont les 
suivantes :

• Name

• Length

• Original Time Stamp

• User Time Stamp

• Timebase

• Start in Parent

• End in Parent

Les clips peuvent également être triés selon leur 
type (Clip Type, audio et MIDI), ou dans l'ordre 
croissant (Ascending) ou décroissant (Descending).

Recherche de clips
Utilisez la commande Find pour afficher dans une 
liste tous les clips dont les noms contiennent un 
mot ou une phrase spécifique.

Pour rechercher et afficher des clips dans la liste 
des clips :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la liste des clips et 
sélectionnez Find. 

• Appuyez sur les touches Commande+Maj+F 
(Mac) ou Ctrl+Maj+F (Windows).

2 Dans la boîte de dialogue Find Clips, effectuez 
l'une des opérations suivantes : 

• Sélectionnez By Name, puis tapez le nom ou une 
partie du nom des clips que vous recherchez. 
La chaîne de recherche s'affiche en haut de la 
liste des clips.

• Sélectionnez Include Subsequently Added Clips 
pour limiter l'affichage aux clips récemment 
ajoutés. Un signe plus (+) s'affiche en haut de la 
liste des clips pour indiquer que cette option est 
sélectionnée.

• Sélectionnez les deux options pour lancer la 
recherche sur les noms de clips spécifiés et 
autoriser l'affichage des clips ajoutés.

Tous les types de clips dont les noms correspondent 
au mot ou à l'expression que vous recherchez 
s'affichent dans la liste des clips. La chaîne de 
recherche s'affiche entre parenthèses en haut de la 
liste des clips. 

3 Cliquez sur OK.

Boîte de dialogue Find Clips

Résultat de recherche dans la liste des clips

Le texte saisi dans la boîte de dialogue Find 
est enregistré dans un historique, ce qui 
vous permet de trouver rapidement des 
expressions déjà recherchées, sans avoir 
à en taper de nouveau la totalité.
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Pour relancer une recherche précédente :

1 Cliquez sur le menu de la liste des clips et 
sélectionnez Find.

2 Cliquez sur la petite flèche à droite du champ 
de texte de la boîte de dialogue Find, puis 
sélectionnez une chaîne de texte dans le menu 
de l'historique de recherche. 

L'historique est enregistré avec la session. 

L'historique permet non seulement d'enregistrer 
les chaînes de texte recherchées préalablement, 
mais également d'insérer manuellement plusieurs 
entrées dans l'historique de recherche (sans qu'il 
soit nécessaire d'effectuer chaque recherche pour 
stocker des mots ou des expressions). 

Pour compiler un historique de recherche sans 
lancer chaque recherche :

1 Cliquez sur le menu de la liste des clips et 
sélectionnez Find. 

2 Cliquez sur la petite flèche à droite du champ 
de texte de la boîte de dialogue Find et 
maintenez-la enfoncée, puis sélectionnez 
l'élément de l'historique avant lequel vous 
souhaitez insérer la nouvelle entrée.

3 Tapez le nom ou une partie du nom des clips 
à rechercher.

4 Cliquez sur la petite double à droite du champ 
de texte de la boîte de dialogue Find, puis 
sélectionnez Insert Entry dans le menu. 

5 Si vous le souhaitez, saisissez une autre entrée, 
puis sélectionnez de nouveau Insert Entry pour 
ajouter des chaînes de recherche supplémentaires 
à l'historique. 

Pour supprimer une entrée de l'historique :

1 Sélectionnez-la dans le menu d'historique afin 
qu'elle s'affiche dans le champ de texte.

2 Sélectionnez Remove Entry dans le menu 

d'historique. 

Pour effacer le contenu de l'historique de 
recherche :

 Sélectionnez Remove All Entries dans le menu 

d'historique. 

Exemple d'historique de recherche

Recherche dans la liste des clips
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Sélection de clips dans la 
liste des clips
Dans la liste des clips, vous pouvez sélectionner 
plusieurs clips pour les faire glisser vers des pistes, 
les traiter avec des plug-ins AudioSuite ou les 
exporter.

Pour sélectionner ou désélectionner un clip 
dans la liste des clips, effectuez les opérations 
suivantes :

 Cliquez sur un nom de clip qui n'est pas en 
surbrillance pour le sélectionner.

 Cliquez sur un nom de clip en surbrillance pour 
le désélectionner.

Pour sélectionner une plage de clips dans la liste 
des clips, effectuez l'une des opérations 
suivantes :

 Placez le curseur sur la gauche des noms des 
clips pour faire apparaître le rectangle de 
sélection et entourez-en les clips que vous 
voulez sélectionner.

 Cliquez sur le nom d'un clip dans la liste des 
clips, puis cliquez en maintenant la touche Maj 
enfoncée sur un autre nom de clip.

Tous les clips compris entre le premier clip 
sélectionné et le second sont automatiquement 
sélectionnés.

Pour sélectionner ou désélectionner une plage de 
clips à l'aide du rectangle de sélection :

1 Placez le curseur à gauche d'un nom de clip 
jusqu'à ce que l'icône du rectangle de sélection 
et un petit symbole + apparaissent :

• Pour sélectionner des clips, le rectangle de 
sélection doit être placé à gauche d'un nom de 
clip qui n'est pas en surbrillance.

• Pour désélectionner des clips, le rectangle de 
sélection doit être placé à gauche d'un nom de 
clip qui est en surbrillance.

2 Cliquez sur le nom d'un clip, puis faites-le glisser 
vers le haut ou le bas (pour sélectionner ou 
désélectionner les clips situés immédiatement 
au-dessus ou au-dessous du nom de clip).

Pour sélectionner ou désélectionner des clips 
non contigus, effectuez l'une des opérations 
suivantes :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez sur les noms de 
clips qui ne sont pas en surbrillance pour les 
sélectionner.

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez sur les noms 
de clips qui sont en surbrillance pour les 
désélectionner.

Clips sélectionnés avec le rectangle de sélection

Pour sélectionner plusieurs clips non consécutifs 
dans la liste des clips, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
et effectuez les sélections.
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Sélection de clips au clavier
Si le focus clavier est activé sur la liste des clips, 
vous pouvez taper les premières lettres du nom 
d'un clip pour que Pro Tools le recherche et le 
sélectionne automatiquement dans la liste des clips.

Pour activer et utiliser le focus clavier sur la liste 
des clips :

1 Cliquez sur le bouton de focus clavier 
(Keyboard Focus) dans le coin supérieur droit 
de la liste des clips.

2 Tapez les premières lettres du clip pour 
que Pro Tools le recherche et le sélectionne 
automatiquement. Lorsqu'un clip a été trouvé 
et sélectionné, vous pouvez le faire glisser sur 
une piste.

La sélection au clavier de clips audio recherche les 
clips d'après leur nom et non d'après celui de leurs 
fichiers parents ou des volumes sur lesquels ils 
résident.

Options Select
Dans la liste des clips, vous pouvez sélectionner 
des clips spécifiques pour les faire glisser vers des 
pistes, les traiter avec des plug-ins AudioSuite ou 
les exporter.

Pour sélectionner des clips spécifiques dans la 
liste des clips :

 Dans le menu de la liste des clips, sélectionnez 
Select, puis l'une des options Select :

All : sélectionne tous les clips de la liste des clips.

Unused : sélectionne les clips qui ne figurent pas 
sur une piste de la session actuelle. Les clips 
offline apparaissent estompés et en italique dans la 
liste des clips.

Unused Except Whole Files : sélectionne les clips 
qui ne figurent pas sur une piste de la session 
actuelle, sans inclure les clips de fichier entier. 
Les clips de fichier entier sont créés lors de 
l'enregistrement ou de l'importation d'audio, de la 
consolidation de clips existants et d'un traitement 
non destructif avec un plug-in AudioSuite. 
Les clips audio de fichier entier référencent un 
fichier audio entier stocké sur votre disque dur. Ils 
sont affichés en gras dans la liste des clips. 

Offline : sélectionne les clips dont les fichiers 
parents sont introuvables ou non disponibles 
à l'ouverture d'une session ou lors de l'importation 
d'une piste. Les clips offline sont estompés et en 
italique dans la liste des clips ; ils apparaissent 
en bleu clair avec un nom en italique dans les 
playlists.

Focus clavier activé sur la liste des clips
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Aperçu des clips dans la liste 
des clips
Vous pouvez obtenir un aperçu des clips audio et 
MIDI et des groupes de clips dans la liste des clips. 
La fonction d'aperçu utilise le chemin d'écoute 
principal sélectionné sur la page Output de la boîte 
de dialogue I/O Setup. Le niveau de base pour 
l'aperçu est défini par le niveau du Master Fader 
(ou de l'entrée auxiliaire) assigné au chemin 
d'écoute.

Pour obtenir un aperçu d'un clip de la liste 
des clips :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le nom 
du clip. 

Les clips audio et les groupes de clips sont lus en 
utilisant le chemin d'écoute spécifié (reportez-vous 
à la section « Audition Paths » à la page 78).

Les clips basés sur les échantillons sont lus à leur 
tempo d'origine. Les clips MIDI et Elastic Audio 
basés sur les références de tempo sont lus au tempo 
de la session (selon la position du curseur de 
lecture). Vous pouvez également obtenir un aperçu 
des clips de la liste des clips en cours de lecture de 
la session.

Les clips MIDI sont lus en utilisant l'option 
Default Thru Instrument sélectionnée dans la page 
des préférences MIDI (reportez-vous à la section 
« Instrument Thru par défaut » à la page 483).

Écoute de signaux discrets 
d'éléments multicanal
Dans la liste des clips, les clips multicanal sont 
écoutés via le chemin d'écoute indiqué dans la 
boîte de dialogue I/O Setup. Les signaux peuvent 
être écoutés tels quels ou via toutes les sorties, 
comme décrit ci-dessous. 

Écoute en contexte

Lorsque vous écoutez un composant mono d'un 
clip mono, ce clip mono peut être lu depuis le 
canal correspondant de son clip mono parent 
correspondant. Cette méthode de lecture se nomme 
écoute en contexte.

Pour écouter en contexte :

1 Dans la liste des clips, vérifiez que le clip stéréo 
ou multicanal se trouve en vue développée 
(il affiche .L, .R et les autres canaux le 
composant). 

2 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le clip du 
canal que vous souhaitez écouter. 

Écoute sur toutes les sorties

Lorsque vous écoutez un canal mono d'un clip 
mono, ce clip peut être routé vers toutes les sorties 
du chemin d'écoute du clip parent correspondant.

Pour écouter sur tous les canaux du chemin 
d'écoute principal :

 Maintenez les touches Maj+Option (Mac) ou 
Maj+Alt (Windows) enfoncées et cliquez sur le 
signal dans la liste des clips. 

La commande de volume de pré-écoute de 
la boîte de dialogue Import Audio détermine 
également le volume de pré-écoute des clips 
dans la liste des clips.
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Clips stéréo et multicanal 
dans la liste des clips
Les clips stéréo et multicanal, qu'ils soient 
importés ou enregistrés dans Pro Tools, s'affichent 
sous forme d'éléments uniques dans la liste des 
clips. Par exemple, deux clips source mono 
nommés « Main Piano.L » et « Main Piano.R » 
sont répertoriés sous le nom « Main Piano 
(Stereo) ». Un triangle Développer/Réduire 
permet d'identifier les clips stéréo et multicanal. 

Les clips stéréo et multicanal apparaissent par 
défaut dans la liste des clips en vue réduite. Vous 
pouvez afficher leurs clips individuels en cliquant 
sur la flèche située à gauche du clip pour la 
développer.

Pour agrandir ou réduire tous les clips stéréo et 
multicanal :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le triangle 
Développer/Réduire.

Chaque élément individuel d'un clip stéréo et 
multicanal en vue développée peut être sélectionné 
indépendamment des autres clips associés dans la 
liste des clips.

Règles pour les clips stéréo et 
multicanal
Pour afficher les clips stéréo et multicanal sous 
forme de clips collectifs, les clips composants 
doivent être de même durée. Si un clip stéréo ou 
multicanal existant a été déplacé sur plusieurs pistes 
mono, puis édité de sorte qu'un ou plusieurs 
composants ne sont plus de la même longueur, 
l'affichage stéréo disparaît et les clips apparaissent 
sous forme de clips individuels dans la liste des clips.

Attribution de noms et 
affichage des clips dans la 
liste des clips
Dans une session classique, des dizaines de pistes 
et des centaines de clips peuvent rapidement 
s'accumuler. Pour parvenir à gérer les clips d'une 
session et à en assurer le suivi, vous pouvez 
effectuer les opérations suivantes :

• Renommer les clips existants ;

• Spécifier la méthode d'attribution de noms aux 
clips créés automatiquement ;

• Masquer les clips créés automatiquement ;

• Supprimer les clips inutilisés.

Modification des noms de clip
Au cours d'une session, vous pouvez renommer des 
clips pour leur donner des noms plus descriptifs, 
les raccourcir ou les simplifier. Lorsque vous 
renommez un clip créé automatiquement lors d'une 
opération d'édition, il devient un clip défini par 
l'utilisateur et apparaît dans la liste des clips, même 
si les clips créés automatiquement sont masqués.

Si un clip se trouve sur une piste, vous pouvez 
facilement le renommer en double-cliquant dessus 
avec l'un des outils de saisie. Toutefois, si le clip ne 
réside pas sur une piste ou si vous souhaitez 
renommer plusieurs clips, utilisez la commande 
Rename dans la liste des clips.

Clips stéréo développés (en haut) et réduits (en bas)
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Vous pouvez également renommer un clip sur une 
piste à l'aide de la commande Rename du menu de 
la liste des clips ou du menu contextuel.

Pour renommer un ou plusieurs clips dans la liste 
des clips :

1 Si vous souhaitez renommer un clip créé 
automatiquement, sélectionnez Show > Auto-
Created dans le menu de la liste des clips.

2 Sélectionnez un ou plusieurs clips à renommer 
dans la liste des clips.

3 Effectuez l'une des opérations suivantes :

• Dans le menu de la liste des clips, sélectionnez 
Rename.

• Effectuez un clic droit sur un clip sélectionné, puis 
sélectionnez Rename dans le menu contextuel.

4 Dans la boîte de dialogue Name, saisissez le 
nouveau nom du clip. Si le clip audio sélectionné 
correspond à un fichier entier, précisez si vous 
souhaitez renommer uniquement le clip ou le clip 
et le fichier sur le disque.

5 Cliquez sur OK pour renommer le clip. Si vous 
renommez plusieurs clips, vous êtes invité à les 
renommer l'un après l'autre.

Options d'attribution 
automatique des noms
Vous pouvez indiquer les paramètres d'attribution 
automatique des noms lorsque des clips sont créés 
automatiquement à partir d'un clip parent. 

L'attribution automatique d'un nom à un clip n'a 
pas d'incidence sur les noms des fichiers audio 
parents. En revanche, elle mémorise des pointeurs 
vers les clips au sein du fichier source parent.

Pour définir les options d'attribution automatique 
des noms aux clips :

1 Sélectionnez un clip dans la liste des clips.

2 Sélectionnez Auto Rename dans le menu de la 
liste des clips.

3 Dans la boîte de dialogue Rename Selected Clips, 
entrez le texte qui sera utilisé pour nommer les 
clips créés à partir du clip sélectionné.

Name : détermine le nom racine des clips créés 
automatiquement.

Starting Number : définit le chiffre de départ de la 
numérotation automatique séquentielle.

Number of Places : spécifie le nombre de chiffres 
apparaissant avant le numéro attribué 
automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

4 Cliquez sur OK.

Si l'option Clip List Selection Follows Edit 
Selection est activée dans les préférences 
d'édition, vous pouvez sélectionner un clip 
dans la liste des clips en le sélectionnant 
directement sur une piste.

Boîte de dialogue Name

Boîte de dialogue Rename Selected Clips
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Gestion des clips dans la 
liste des clips
Au fil des éditions d'une session, la liste des clips 
peut accumuler rapidement de nombreux clips : 
ceux que vous avez créés intentionnellement et 
ceux qui ont été créés automatiquement en 
coupant, collant et séparant d'autres clips ou en 
important des fichiers de groupes de clips (ou des 
fichiers REX comme groupes de clips). Pro Tools 
vous permet de masquer ou supprimer des clips de 
votre session pour vous éviter de faire défiler un 
grand nombre d'entrées dans la liste des clips.

Masquage des clips créés 
automatiquement
Vous pouvez masquer les clips créés 
automatiquement en cours d'édition.

Pour masquer les clips créés automatiquement :

 Dans le menu de la liste des clips, 
désélectionnez Show > Auto-Created. Lorsque 
cette option n'est pas sélectionnée, seuls les 
clips définis par l'utilisateur apparaissent dans 
la liste des clips.

Les clips définis par l'utilisateur incluent :

• les clips de fichier entier ;

• les clips créés pendant l'enregistrement ;

• les clips importés ;

• les clips renommés ;

• les clips créés à la suite d'un traitement 
AudioSuite ;

• Les clips créés avec la commande Clip > Capture 
ou Edit > Separate Clip ;

• les clips créés suite au trimming d'un clip audio 
de fichier entier.

Lorsque les clips créés automatiquement sont 
masqués, Pro Tools vous avertit dès que leur 
nombre excède un certain seuil pour vous offrir la 
possibilité de les supprimer. Si vous sélectionnez 
de les supprimer, tous les clips créés 
automatiquement sont supprimés en même temps. 

Pour que les clips créés automatiquement soient 
conservés, veillez à les renommer. Lorsque vous 
nommez un clip, il passe de clip créé 
automatiquement à clip défini par l'utilisateur 
(reportez-vous à la section « Modification des 
noms de clip » à la page 275).

Suppression des clips inutilisés
Dans la liste des clips, vous pouvez sélectionner des 
clips inutilisés et les supprimer de la session avec la 
commande Clear. Les clips de fichier entier peuvent 
également être supprimés de façon permanente du 
disque dur sur lequel ils sont stockés.

Pour rechercher et supprimer les clips inutilisés 
d'une session :

1 Effectuez l'une des opérations suivantes :

• Pour les clips MIDI, sélectionnez Select > 
Unused dans le menu de la liste des clips.

• Pour les clips audio, sélectionnez Select, puis 
Unused, Unused Except Whole Files ou Offline 
dans le menu de la liste des clips.

2 Après avoir sélectionné toutes les clips 
inutilisés, sélectionnez Clear dans le menu de 
la liste des clips. La boîte de dialogue Clear 
Selected s'affiche.

3 Dans la boîte de dialogue Clear Selected, 
sélectionnez l'option Automatically select all 

unused clips pour sélectionner tous les clips 
inutilisés, y compris ceux de fichier entier et les 
supprimer. Toutes les sélections effectuées 
précédemment dans la liste des clips sont 
ignorées.

La commande Clear ne peut pas être annulée.
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4 Effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour supprimer les clips 
inutilisés de la session.

• Si vous supprimez un clip audio de fichier entier 
et souhaitez supprimer définitivement le fichier 
audio de votre disque dur, cliquez sur Delete.

Lorsque vous supprimez des fichiers audio pour 
plusieurs clips, Pro Tools ouvre une boîte de 
dialogue d'avertissement pour chaque fichier audio. 

Pour ne plus afficher ces boîtes de dialogue 
d'avertissement :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le bouton 
Delete de la boîte de dialogue Clear. Cette 
opération supprime définitivement chaque 
fichier audio de votre disque dur (pour chacune 
des clips inutiles), sans avertissement préalable. 

Commandes contextuelles 
des noms de clips
Lorsque vous effectuez un clic droit sur un nom 
dans la liste des clips, un menu contextuel permet 
d'accéder aux commandes suivantes :

Clear : supprime les clips sélectionnés de la 
session.

Rename : renomme les clips sélectionnés.

Time Stamp : redéfinit le marqueur temporel des 
clips sélectionnés.

Replace Clip (Pro Tools HD uniquement) : 
remplace plusieurs instances d'un clip par un autre 
clip.

Compact : compacte les clips sélectionnés.

Export Clip Definitions : exporte les définitions 
des clips sélectionnés.

Export Clips as Files : exporte les clips 
sélectionnés sous forme de fichiers.

Recalculate Waveform Overviews : retrace les 
formes d'onde des clips sélectionnés.

Select Parent in Workspace : met en surbrillance 
le fichier parent du clip sélectionné dans un 
navigateur de l'espace de travail.

Reveal in Finder/Reveal in Explorer :  permet 
d'afficher le fichier parent d'un clip dans le Finder 
(Mac) ou l'Explorateur Windows.

Object Select in Edit Window : sélectionne un clip 
sous forme d'objet dans la fenêtre Edit.

Utilisez ce mode de suppression puissant 
avec précaution. La suppression des fichiers 
ne peut pas être annulée.
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Chapitre 16 : Navigateurs de l'espace 
de travail

L'espace de travail de Pro Tools associe une 
interface intuitive de style navigateur à un moteur 
d'exploitation de bases de données intégré, optimisé 
pour la gestion des médias et métadonnées.

Les navigateurs de l'espace de travail proposent 
une palette complète d'outils de base de données 
pour les opérations de recherche, de tri, d'écoute et 
d'importation de fichiers audio, MIDI et vidéo, 
et de fichiers de paramètres de plug-in (.txf), de rig 
de guitare (Eleven Rack uniquement) et de session. 
Il est possible d'afficher et d'organiser plusieurs 
navigateurs en appliquant des paramètres 
d'affichage personnalisé, ceci afin d'optimiser 
votre environnement de travail. 

Navigateurs de l'espace de 
travail
Les navigateurs de l'espace de travail fournissent 
une interface utilisateur intuitive et de nombreuses 
fonctions de gestion des fichiers (recherche et tri 
par exemple).

Les navigateurs de l'espace de travail de Pro Tools 
sont semblables aux fenêtres de votre système 
d'exploitation et sont conçus spécifiquement pour 
les workflows de Pro Tools. Vous pouvez afficher 
simultanément plusieurs navigateurs et 
personnaliser l'affichage de chacun.

Les navigateurs de l'espace de travail permettent 
de trier des sessions et fichiers audio et vidéo et 
d'effectuer des recherches. Vous pouvez déposer 
les fichiers audio, vidéo et de session affichés dans 
les navigateurs directement dans la session 
Pro Tools actuelle.

Lorsque vous avez besoin d'utiliser des éléments 
hors ligne, Pro Tools permet de trouver les fichiers 
correspondants, puis de relier les éléments aux 
médias en ligne. 

Le navigateur de l'espace de travail fournit un 
accès à tous les volumes montés ainsi qu'aux 
dossiers et fichiers qu'ils contiennent. 

Le navigateur de l'espace de travail permet 
d'effectuer les opérations suivantes :

• Accès à tous les volumes montés

• Accès à tous les catalogues

Pour plus d'informations sur les opérations 
de glisser-déposer des fichiers à partir de 
navigateurs de l'espace de travail dans votre 
session Pro Tools, reportez-vous à la section 
« Importation de fichiers par glisser-
déposer » à la page 333.
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• Recherche simultanée dans plusieurs volumes et 
catalogues

• Sélection de volumes pour l'enregistrement et la 
lecture, la lecture seule ou le transfert

• Affichage, gestion, écoute et importation 
d'éléments individuels de tout catalogue ou 
volume monté

• Mise à jour des bases de données de volumes 
entiers

Volumes

Les navigateurs de l'espace de travail permettent 
de gérer les volumes locaux et réseau. Les volumes 
sont des partitions formatées d'un disque physique 
(disque dur). Tout changement effectué dans 
l'espace de travail (tel que la copie ou le 
déplacement de fichiers et de dossiers) se répercute 
directement sur les volumes eux-mêmes. 
Les volumes comprennent les disques durs 
montés, les volumes d'archivage réseau et les 
supports amovibles (comme les CD-ROM).

Lorsque le focus est mis sur les volumes dans le 
volet Locations, vous pouvez :

• Afficher, gérer, écouter et importer des éléments 
individuels d'un volume.

• Mettre à jour une base de données des contenus 
d'un volume.

Session

Les navigateurs de l'espace de travail fournissent 
des outils de recherche et de gestion des fichiers 
référencés dans votre session actuelle, quel que 
soit leur emplacement de stockage. 

Lorsque le focus est mis sur la session actuellement 
ouverte dans le volet Locations, vous pouvez :

• Afficher tous les fichiers médias associés à la 
session actuelle, y compris tous les fichiers 
manquants.

• Afficher, gérer, écouter et placer des éléments 
individuels.

Catalogues 

Les catalogues constituent le niveau le plus élevé 
de gestion des fichiers de Pro Tools. Ils permettent 
d'organiser facilement des fichiers provenant de 
sources diverses dans des bibliothèques contenant 
vos fichiers préférés. Vous pouvez trier les 
catalogues et y effectuer des recherches, même 
lorsque les fichiers auxquels ils font référence sont 
hors ligne. 

Les catalogues permettent d'effectuer les 
opérations suivantes :

• Collecter et organiser des fichiers stockés sur 
n'importe quelle combinaison de volumes.

• Créer des catalogues de volumes complets pour 
la visualisation et la recherche de leurs contenus, 
qu'ils soient en ligne ou non.

• Afficher, gérer, écouter et importer des éléments 
individuels dans le catalogue.

• Mettre à jour une base de données des contenus 
du catalogue.

Fenêtre Task Manager
La fenêtre Task Manager est un utilitaire 
conçu pour visualiser et gérer toutes les tâches 
d'arrière-plan initiées par Pro Tools. Elle permet 
de surveiller, d'interrompre momentanément et 
d'annuler les tâches d'arrière-plan (comme la copie 
de fichiers, les recherches et l'indexation).

Pour plus d'informations, reportez-vous à la 
section « Catalogues » à la page 320.

Pour plus d'informations, reportez-vous à la 
section « Fenêtre du gestionnaire de tâches » 
à la page 324.
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Fenêtre Relink
La fenêtre Relink propose des outils et des fonctions 
conçus pour rétablir les liens des sessions et des 
catalogues pointant vers les fichiers média. 
Les outils de relinking permettent de rechercher et 
de récupérer des fichiers manquants dans la session 
actuelle. 

Volumes de performance et 
de transfert
Les navigateurs de l'espace de travail permettent 
de visualiser, de gérer et d'importer des sessions et 
médias à partir des volumes de performance et de 
transfert.

Volumes de performance : il s'agit de volumes de 
stockage (disques durs) adaptés à la lecture et 
sélectionnés à partir du navigateur de l'espace de 
travail pour l'enregistrement et la lecture (R) ou la 
lecture seule (P) de fichiers média dans une session 
Pro Tools.

Volumes de transfert : il s'agit de volumes non 
pris en charge pour la lecture de médias dans 
Pro Tools (tels que des volumes réseau partagés ou 
des CD-ROM) ou de volumes de stockage (disques 
durs) sélectionnés à partir du navigateur de 
l'espace de travail comme volumes de transfert (T). 
Les volumes de transfert ne peuvent pas être 
utilisés pour enregistrer ou lire des fichiers média 
dans une session Pro Tools. Les volumes de 
transfert (T) peuvent être utiles pour transférer une 
session et des fichiers média entre différents 
systèmes Pro Tools.

Bases de données
Les informations affichées dans les navigateurs de 
l'espace de travail sont stockées dans une base de 
données Pro Tools qui couvre le système entier. 
Pro Tools crée automatiquement une base de 
données centralisée sur votre disque système pour 
tous les volumes montés, y compris les volumes de 
transfert. Pro Tools utilise un fichier de base de 
données unique qui maintient à jour un index de 
tous les volumes (disques durs, lecteurs réseau et 
médias amovibles) et catalogues. 

Sur Mac, le fichier de base de données est stocké 
à l'emplacement /Utilisateurs/Partagé/Pro Tools.

Sous Windows, le fichier de base de données est 
stocké à l'emplacement 
<DisqueSystème>/Utilisateurs/Public/Pro Tools.

Le cache des formes d'onde des fichiers audio 
indexés par la base de données est stocké dans 
le fichier de base de données. Il comprend des 
miniatures des formes d'onde pour l'aperçu 
(les fichiers de cache des formes d'onde des 
sessions sont toujours stockés dans les dossiers 
de session).

Un fichier global de cache des formes d'onde 
stocke également les métadonnées des fichiers 
audio lorsqu'aucune session n'est ouverte, ou celles 
des fichiers stockés sur des volumes en lecture 
seule. Comme dans les versions précédentes de 
Pro Tools, il s'agit d'un fichier séparé, stocké à côté 
du fichier de base de données.

Pour plus d'informations, reportez-vous à la 
section « Fenêtre Relink » à la page 316.

Pour plus d'informations, reportez-vous à la 
section « Permissions des volumes » à la 
page 286.
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Les bases de données Pro Tools utilisent deux 
types de fichiers :

Workspace.wksp : stocke les métadonnées des 
fichiers média et de session d'un volume ou 
catalogue particulier.

Wavecache.wfm : stocke les aperçus de forme 
d'onde des fichiers audio référencés par chaque 
session.

Dans Pro Tools 11, le fichier de base de 
données est associé à cette version et n'est 
pas compatible avec les versions antérieures 
de Pro Tools. Lorsque vous utilisez un 
système sur lequel Pro Tools 11 et 
Pro Tools 10 sont co-installés, des fichiers 
de base de données séparés seront présents 
pour chaque version. Notez également que 
les fichiers de base de données d'une même 
version sont compatibles sur toutes les 
plateformes (Mac et Windows).

La suppression du fichier de base de données 
entraîne la perte de toutes les informations 
de base de données existantes. Pour recréer 
une base de données supprimée, vous devez 
réindexer les volumes (reportez-vous à la 
section « Indexation des bases de données de 
l'espace de travail » à la page 288).
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Disposition et outils des navigateurs de l'espace de travail
Les navigateurs de l'espace de travail affichent tous les fichiers contenus dans leur base de données, 
y compris les fichiers Pro Tools et non Pro Tools. Ils peuvent aussi afficher les types de fichiers inconnus 
ainsi que les alias et les dossiers du bureau. 

Afin d'optimiser la vitesse de traitement et de 
protéger les composants essentiels, les navigateurs 
de l'espace de travail n'affichent pas l'intégralité 
des dossiers. Sous Windows par exemple, 
les navigateurs de l'espace de travail n'affichent 
pas les dossiers WU Temp et System Volume 
Information. Sous Mac OS X, ils n'affichent pas le 
dossier System. Par conséquent, ces dossiers ne 
sont pas concernés par les opérations d'indexation, 
de recherche, de tri et ne sont pas affectés par toute 
autre tâche liée à l'espace de travail. Ne stockez 
aucun fichier média ou de session Pro Tools dans 
l'un de ces dossiers.

Les principaux éléments d'un navigateur de 
l'espace de travail sont les suivants : 

Barre d'outils : contient le menu du navigateur, 
l'icône de recherche, les presets d'affichage 
(numérotés de 1 à 5), les outils de navigation dans 
l'espace de travail et des outils d'aperçu. 

Liste des éléments : affiche le contenu d'une base 
de données de volume, de dossier, de session ou de 
catalogue. 

Outils, volets et colonnes d'un navigateur de l'espace de travail basique

Barre d'outils

Liste des
éléments

Volet Locations Volet de navigation

En-têtes de
colonnes

Colonnes Presets d'affichage

Menu du navigateur

Commandes d'aperçu

Bouton Dossier parent

Outils de recherche

Afficher/Masquer

Séparation des volets

Barre de titre
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Colonnes : identifient le type de métadonnées 
affichées pour les volumes, dossiers et fichiers de 
la liste d'éléments (nom et format de fichier par 
exemple). Pour redimensionner une colonne, faites 
glisser sa bordure. Pour modifier son emplacement, 
faites glisser son en-tête.

Chaque ligne de données d'un navigateur de 
l'espace de travail représente un élément, tel qu'un 
fichier ou un dossier. Les données disponibles 
pour chaque élément sont affichées dans les 
colonnes. 

Volet Locations : permet de naviguer entre les 
volumes (lecteurs locaux et réseau) de votre 
système, la session actuellement ouverte, 
les catalogues de médias indexés et le répertoire 
Utilisateur du système.

Volet de navigation : affiche le contenu des 
éléments sélectionnés dans le volet Locations ou 
les résultats de recherche.

Ouverture d'un navigateur de 
l'espace de travail
Vous disposez de plusieurs méthodes pour ouvrir, 
fermer et naviguer au sein d'un ou plusieurs 
navigateurs de l'espace de travail.

Pour ouvrir le navigateur de l'espace de travail 
lorsqu'aucun autre n'est ouvert, effectuez l'une 
des opérations suivantes :

 Sélectionnez Window > Workspace.

 Appuyez sur Option+Point-virgule (;) (Mac) ou 
Alt+Point-virgule (;) (Windows) pour ouvrir et 
fermer une fenêtre de l'espace de travail. 
Si plusieurs navigateurs de l'espace de travail 
sont ouverts, ces commandes clavier activent 
successivement chacun d'eux au premier plan. 

Pour ouvrir un nouveau navigateur de l'espace de 
travail dédié aux volumes :

 Appuyez sur Option+I (Mac) ou Alt+I 
(Windows). 

Pour ouvrir un nouveau navigateur de l'espace de 
travail dédié au projet :

 Appuyez sur Option+O (Mac) ou Alt+O 
(Windows). 

Afin d'ouvrir un nouveau navigateur de l'espace de 
travail depuis un volume, catalogue ou dossier 
sélectionné, effectuez l'une des opérations 
suivantes :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et double-cliquez sur un 
volume, catalogue ou dossier dans le navigateur 
de l'espace de travail actuellement ouvert.

 Appuyez sur Option+Flèche bas (Mac) ou 
Alt+Flèche bas (Windows) pour ouvrir le 
volume, catalogue ou dossier actuellement 
sélectionné dans un nouveau navigateur de 
l'espace de travail.

Ces commandes clavier ferment également le 
navigateur de l'espace de travail si le dossier 
racine des volumes est sélectionné dans le 
volet Locations. Si un autre élément est 
sélectionné dans le volet Locations, 
ces commandes clavier ouvrent un nouveau 
navigateur dédié à cet élément.
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Affichage du contenu d'un 
volume, dossier ou catalogue

Pour développer ou réduire le dossier sélectionné, 
effectuez l'une des opérations suivantes :

 Cliquez sur l'icône Développer/Réduire située 
en regard du volume, dossier, session ou 
catalogue dans le volet de navigation ou 
Locations.

 Sélectionnez un volume, un dossier ou un 
catalogue et appuyez sur la touche Flèche droite 
pour développer l'arborescence ou sur la touche 
Flèche gauche pour la réduire.

Pour vous déplacer d'un niveau vers le haut dans 
un navigateur : 

 Cliquez sur la flèche de retour de la barre 
d'outils. 

Déplacement des navigateurs 
de l'espace de travail au premier 
plan ou en arrière-plan

Pour placer tous les navigateurs de l'espace de 
travail ouverts au premier plan :

 Sélectionnez Window > Browsers > Bring to 

Front. 

Pour faire passer tous les navigateurs de l'espace 
de travail en arrière-plan :

 Sélectionnez Window > Browsers > 

Send to Back. 

Tous les navigateurs de l'espace de travail ouverts 
passent en arrière-plan, les autres fenêtres passent 
au premier plan. Tous les navigateurs de l'espace 
de travail restent néanmoins actifs et accessibles. 

Pour ramener un navigateur de l'espace de travail 
ouvert au premier plan :

 Sélectionnez Window > Browsers et 
sélectionnez un navigateur de l'espace de travail 
ouvert dans le sous-menu.

Pour passer au navigateur de l'espace de travail 
suivant ou précédent :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur la 
touche Flèche gauche ou Flèche droite.

Fermeture des navigateurs de 
l'espace de travail

Pour fermer tous les navigateurs de l'espace de 
travail :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le bouton de 
fermeture de l'un des navigateurs de l'espace de 
travail. 

Pour remonter d'un niveau dans un 
navigateur de l'espace de travail, appuyez sur 
Commande+Flèche haut (Mac) ou Ctrl+Flèche 
haut (Windows).

Pour placer tous les navigateurs de l'espace de 
travail au premier plan, appuyez sur Option+J 
(Mac) ou Alt+J (Windows).

Pour placer tous les navigateurs de l'espace 
de travail en arrière-plan, appuyez sur 
Option+Maj+J (Mac) ou Alt+Maj+J 
(Windows).

La fenêtre des tâches étant un utilitaire et non 
un navigateur, elle reste ouverte.
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Permissions des volumes
L'espace de travail inclut une colonne permissions 
(Perm.) pour les volumes. Cette colonne affiche 
et permet de désigner les permissions de chaque 
volume : enregistrement (R), lecture (P) ou 
transfert (T) de fichiers média.

R (Enregistrement et lecture) : permet de lire des 
fichiers audio et vidéo résidant déjà sur ce volume 
et d'en enregistrer de nouveaux. 

P (Lecture uniquement) : permet de lire des 
fichiers audio et vidéo résidant sur ce volume mais 
ne permet pas d'en enregistrer de nouveaux. 

T (Transfert) : peut uniquement être utilisé pour la 
sauvegarde, le transfert ou l'écoute de fichiers et 
n'est donc pas disponible pour l'enregistrement ou 
la lecture. 

Pour redéfinir les permissions d'un volume :

1 Ouvrez un navigateur de l'espace de travail.

2 Dans le volet Locations, sélectionnez Volumes.

3 Dans le volet de navigation, cliquez sur la 
colonne de permissions d'un volume et 
sélectionnez les permissions appropriées. 

Démontage de volumes
Utilisez le Finder Mac ou l'Explorateur Windows 
pour monter et démonter des volumes lorsque 
Pro Tools est en cours d'exécution. 

Utilisation des éléments des 
navigateurs de l'espace de 
travail

Ouverture de sessions

Pour ouvrir une session Pro Tools répertoriée 
dans un navigateur de l'espace de travail :

 Fermez toute session Pro Tools éventuellement 
ouverte et double-cliquez sur un fichier de 
session Pro Tools dans un navigateur de 
l'espace de travail. 

Ouverture de séquences AAF 
et OMF
Les séquences AAF et OMF peuvent être ouvertes 
à partir des navigateurs de l'espace de travail.

Vous pouvez également faire glisser des séquences 
AAF et OMF depuis les navigateurs de l'espace de 
travail pour les déposer dans la session actuelle.

Pour ouvrir une séquence AAF ou OMF depuis un 
navigateur de l'espace de travail :

1 Effectuez l'une des opérations suivantes :

• Fermez toute session Pro Tools éventuellement 
ouverte et double-cliquez sur la séquence AAF ou 
OMF dans un navigateur de l'espace de travail.

• Faites glisser la séquence AAF ou OMF depuis 
le navigateur de l'espace de travail vers la 
timeline d'une session ouverte.

2 Configurez la boîte de dialogue Import Session 
Data.

3 Cliquez sur OK.

Si votre système Pro Tools comporte plusieurs 
disques et que vous souhaitez enregistrer 
différentes pistes simultanément, vous pouvez 
désigner le disque système comme disque 
dédié uniquement à la lecture ou au transfert 
afin d'optimiser les performances.

Sélection des permissions d'un volume de l'espace 
de travail
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Création et ouverture de 
dossiers dans les navigateurs 
de l'espace de travail
Les navigateurs de l'espace de travail permettent de 
créer et de manipuler des dossiers (sous-répertoires 
du système de fichiers). Tous les dossiers 
comportent une icône Développer/Réduire destinée 
à afficher leur contenu. Lorsque vous faites glisser 
des éléments vers l'icône d'un dossier, cela revient 
à les faire glisser vers un navigateur de l'espace de 
travail ouvert. 

Pour créer un dossier dans un volume, un dossier 
ou un catalogue :

1 Sélectionnez le volume, dossier ou catalogue 
dans lequel vous souhaitez créer un dossier.

2 Sélectionnez New Folder dans le menu du 
navigateur. 

3 Saisissez un nom pour le dossier, puis cliquez 
sur OK  

4 Pour les volumes et dossiers, le dossier est créé 
sur le disque. En ce qui concerne les catalogues, 
le dossier est créé uniquement dans la base de 
données du catalogue. La liste d'éléments est 
mise à jour quand vous ajoutez de nouveaux 
éléments. 

Pour ouvrir un dossier dans le navigateur de 
l'espace de travail actuel :

 Double-cliquez sur le dossier ou cliquez sur 
l'icône Développer/Réduire correspondant 
à l'élément souhaité. 

Pour créer et ouvrir un dossier dans son propre 
navigateur de l'espace de travail :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et double-cliquez 
sur le dossier. La fenêtre du navigateur de 
l'espace de travail précédent (parent) reste 
ouverte. 

Défilement et déplacement de 
sélections

Pour faire défiler le volet actif vers le haut ou 
le bas :

 Appuyez sur la touche Page préc. ou Page suiv.

Pour atteindre le haut ou le bas du volet actif :

 Appuyez sur la touche Origine (pour aller en 
haut) ou Fin (pour aller en bas).

Pour déplacer des éléments vers le haut ou le bas 
dans le navigateur de l'espace de travail actuel :

1 Sélectionnez les éléments souhaités dans le 
navigateur de l'espace de travail, et assurez-
vous que sa fenêtre est au premier plan. 

2 Appuyez sur la touche Flèche haut ou Flèche bas.

Après avoir activé un navigateur de l'espace 
de travail au premier plan et sélectionné le 
dossier, appuyez sur Commande+Flèche 
bas (Mac) ou Ctrl+Flèche bas (Windows) 
pour ouvrir un dossier dans le navigateur de 
l'espace de travail actuel.

Après avoir activé un navigateur de l'espace de 
travail au premier plan et sélectionné le dossier, 
appuyez sur Commande+Option+Flèche bas 
(Mac) ou Ctrl+Alt+Flèche bas (Windows) pour 
ouvrir un dossier dans son propre navigateur de 
l'espace de travail.
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Saisie de texte dans les 
navigateurs de l'espace de 
travail
Vous pouvez éditer de nombreuses zones de texte 
pour remplacer ou mettre à jour les données d'un 
élément. 

Pour éditer une zone de texte et en sortir en 
restaurant le statut d'affichage précédent :

 Appuyez sur la touche Entrée.

Pour annuler une édition de texte et restaurer le 
texte précédent :

 Appuyez sur la touche Échap.

Indexation des bases de 
données de l'espace de 
travail
L'indexation désigne le procédé qui consiste à lire 
les fichiers média, à extraire les métadonnées de 
chaque fichier et à sauvegarder ces données dans 
une base de données associée, afin d'afficher ces 
données dans les colonnes d'un navigateur de 
l'espace de travail. L'indexation complète d'un 
volume ou d'un dossier vous permet d'y effectuer 
des recherches rapides, car toutes les métadonnées 
sont déjà triées et organisées.

Un volume ou un dossier non indexé le sera 
automatiquement lors de sa première ouverture 
dans un navigateur de l'espace de travail. Pour les 
volumes ou dossiers comprenant une quantité 
importante de fichiers média, l'indexation peut 
prendre un certain temps. Vous pouvez par 
conséquent souhaiter indexer manuellement des 
volumes ou des fichiers spécifiques avant de 
démarrer un projet afin d'accélérer le processus.

Indexation pendant la 
navigation
La première fois que vous ouvrez un navigateur 
pour un volume ou un dossier qui n'a jamais été 
indexé, Pro Tools remplit automatiquement la base 
de données pour le niveau en question du volume. 
Le navigateur affiche des fichiers et des dossiers 
dans la liste d'éléments, ainsi que des métadonnées 
dans les colonnes de chaque élément. L'indexation 
se poursuit jusqu'à ce que vous refermiez le 
navigateur ou que le dossier soit entièrement 
indexé.

La prochaine fois que vous ouvrirez le navigateur 
en question, il affichera immédiatement les 
métadonnées des éléments déjà indexés. Si vous 
avez fermé le navigateur ou le dossier avant la fin de 
l'indexation ou que le contenu du dossier a changé 
depuis votre dernière navigation, Pro Tools effectue 
automatiquement la mise à jour de la base de 
données lors de la prochaine ouverture. La base de 
données est donc toujours parfaitement à jour pour 
le dossier que vous parcourez. Affichez le 
Gestionnaire des tâches pour vérifier l'activité 
en cours.

L'indexation pendant la navigation permet de 
gagner du temps, car elle complète seulement la 
base de données pour les éléments du volume 
actuellement parcouru. Par exemple, si vous 
naviguez dans la racine du volume, l'indexation 
porte seulement sur les dossiers et fichiers au 
niveau de la racine. Si vous ouvrez un dossier, 
Pro Tools indexe uniquement les éléments dans ce 
dossier. Une base de données est donc uniquement 
indexée pour les parties du volume dans lesquelles 
vous avez navigué. Cependant, les recherches sont 
plus rapides et complètes si un volume a déjà été 
entièrement indexé. 

Pour plus de détails sur l'édition des 
colonnes, reportez-vous à la section 
« Données des colonnes » à la page 293.
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Indexation manuelle
L'indexation manuelle fournit toutes les données 
manquantes et met à jour les données modifiées 
pour les dossiers sélectionnés et tous leurs sous-
dossiers. 

Pour mettre à jour l'index d'un dossier et de tous 
ses sous-dossiers :

1 Sélectionnez l'élément souhaité dans la liste 
d'éléments d'un navigateur de l'espace de travail. 

2 Sélectionnez Update Index for Selected Items 

dans le menu de navigation. 

Pour mettre à jour l'index d'un volume entier :

1 Sélectionnez le volume à mettre à jour dans le 
navigateur de l'espace de travail. 

2 Sélectionnez Update Index for Selected Items 

dans le menu de navigation. 

Affichage de la date de dernière indexation

La colonne Date Indexed indique la date à laquelle 
l'index du dossier et de tous ses sous-dossiers a été 
mis à jour. Notez qu'il est possible que certains 
sous-dossiers aient été mis à jour plus récemment.

Mise à jour automatique des actions de 
Pro Tools

Dès que Pro Tools ajoute, efface ou modifie un 
fichier d'un volume ou d'une session, la base de 
données appropriée est immédiatement mise à jour 
pour refléter le changement opéré. 

Menu des navigateurs de 
l'espace de travail 
Tous les fenêtres navigateurs de l'espace de travail 
disposent d'un menu de navigateur dans le coin 
supérieur droit de leur barre d'outils. Les menus 
des navigateurs de l'espace de travail contiennent 
des commandes spécifiques au type d'éléments 
sélectionnés dans le volet Locations ou de 
navigation, comme décrit ci-dessous. 

Vous pouvez également effectuer un clic droit sur 
des éléments du volet Locations ou de navigation 
pour accéder aux commandes du menu agissant sur 
les éléments de ce type.

New Folder : crée un dossier dans le volume, 
dossier ou catalogue actuellement sélectionné. Pour 
les volumes et dossiers, le dossier est créé sur le 
disque. Pour plus d'informations, reportez-vous à la 
section « Création et ouverture de dossiers dans les 
navigateurs de l'espace de travail » à la page 287.

Create Catalog from Selection : crée un catalogue 
entièrement indexé de tous les éléments sélectionnés 
dans le volet Locations ou de navigation.

Calculate Waveform : calcule les affichages des 
formes d'onde des fichiers audio sélectionnés, 
ou de tous les fichiers audio des volumes, dossiers 
ou catalogues sélectionnés.

Les changements effectués avec l'Explorateur 
Windows ou le Finder Mac (par exemple la 
copie ou le déplacement de fichiers) ne sont 
pas pris en compte par Pro Tools et ne sont 
indexés que si vous parcourez le dossier 
correspondant ou que vous effectuez une 
indexation manuelle.

Icône du menu des navigateurs de l'espace de travail

Pour plus d'informations, reportez-vous à la 
section « Formes d'onde » à la page 303.
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Update Index for Selected Items : met à jour 
l'indexation des volumes ou dossiers actuellement 
sélectionnés.

Delete Index for Selected Items : supprime 
l'indexation des fichiers dans la base de données, 
pour les éléments du volume ou dossier sélectionné.

Delete Index for All Offline Volumes : supprime 
l'indexation dans la base de données de tous les 
volumes hors ligne.

Calculate Elastic Analysis : calcule les données 
d'analyse Elastic Audio pour tous les fichiers audio 
sélectionnés. les fichiers analysés sont identifiées 
par une horloge bleue pour les fichiers basés sur les 
échantillons, et par un métronome vert pour 
les fichiers basés sur des références de tempo. 
Les fichiers analysés pour lesquels un tempo 
a été détecté sont également mis à jour en tant que 
fichiers basés sur des références de tempo. Leur 
durée est affichée en mesures et temps et leur 
tempo d'origine apparaît dans la colonne Tempo. 
Vous pouvez visualiser la progression de l'analyse 
Elastic Audio dans la fenêtre des tâches.

Clear Elastic Analysis : efface les données 
d'analyse Elastic Audio pour tous les fichiers audio 
sélectionnés. Les fichiers dans lesquels les données 
d'analyse Elastic Audio sont effacées retrouvent une 
base de temps basée sur les échantillons. Leur durée 
est affichée en minutes et secondes et aucun tempo 
n'est détecté.

Load Guitar Rig Settings (Eleven Rack 
uniquement) : charge les paramètres de rig de 
guitare pour les fichiers audio sélectionnés qui 
intègrent des paramètres de rig de guitare 
provenant d'une interface Eleven Rack.

Select Offline Files : sélectionne tous les fichiers 
actuellement hors ligne.

Select Online Files : sélectionne tous les fichiers 
actuellement en ligne. 

Select Transfer Files : sélectionne tous les fichiers 
identifiés comme des fichiers de transfert (résidant 
sur des supports ne permettant pas la lecture). 

Invert Selection : inverse la sélection actuelle.

Reveal in Finder/Explorer : ouvre la fenêtre 
parente correspondant au fichier sélectionné dans 
le Finder Mac ou l'Explorateur Windows. 

Open in New Workspace : ouvre l'élément 
sélectionné dans un nouveau navigateur. L'élément 
sélectionné est mis en surbrillance dans le nouveau 
navigateur.

Relink Offline : ouvre la fenêtre Relink pour les 
éléments sélectionnés dans la session actuelle.

Relink Selected Items : ouvre la fenêtre Relink 
avec tous les fichiers sélectionnés dans le 
navigateur actuel et dont les liens doivent être 
rétablis. Cette commande est uniquement 
disponible pour les catalogues et les sessions.

Copy and Relink : copie les éléments sélectionnés 
dans le navigateur de la session actuelle vers un 
emplacement donné et rétablit les liens de la 
session vers les copies plutôt que les fichiers 
originaux. Utilisez cette commande pour déplacer 
facilement des fichiers d'un volume de transfert 
vers un volume de performance. Cette commande 
est également disponible dans certains catalogues 
pour vous permettre de copier des éléments et de 
relier le catalogue actuel aux copies. 

Duplicate Selected Items : crée une copie des 
éléments sélectionnés au même emplacement. 

Rename Selected Item : renomme l'élément 
sélectionné. 

Pour plus d'informations, reportez-vous 
à la section « Fichiers Elastic Audio dans 
l'espace de travail » à la page 304.
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Lock Selected Items : verrouille tous les éléments 
sélectionnés. Tous les fichiers déjà verrouillés 
le restent. En verrouillant un dossier, vous 
verrouillez tous ses fichiers et sous-dossiers. 

Unlock Selected  Items : déverrouille les éléments 
sélectionnés. 

Move To Trash/Move To Recycle Bin : déplace les 
éléments sélectionnés du volet de navigation dans 
la corbeille. Les éléments restent dans la Corbeille 
jusqu'à ce que vous la vidiez à l'aide de la 
commande appropriée de votre système 
d'exploitation. Cette commande est uniquement 
disponible pour les éléments de session ou de 
catalogue.

Auto-Preview : active ou désactive l'aperçu 
automatique des fichiers. La sélection d'un fichier 
dans le navigateur lance l'aperçu lorsque cette 
option est activée. Le bouton d'aperçu est mis 
à jour pour indiquer que l'option Auto-Preview est 
activée.

Loop Preview : offre un aperçu du fichier 
sélectionné en le lisant en boucle. Si plusieurs 
fichiers sont sélectionnés, seul l'aperçu du premier 
est lu en boucle. Lorsque le mode d'aperçu en 
boucle est activé, le bouton d'aperçu est mis à jour 
et affiche une icône correspondant à ce mode.

Spacebar Toggles File Preview : active ou 
désactive la barre d'espace pour lancer et 
interrompre l'aperçu d'un fichier. Lorsque cette 
option est désactivée, utilisez le bouton Preview 
pour lancer ou arrêter l'aperçu. Dans ce mode, 
la barre d'espace permet de lancer et d'arrêter la 
lecture d'une session. Vous pouvez ainsi lire la 
session et, lorsque l'option Audio Files Conform to 

Session Tempo est activée, obtenir un aperçu du 
fichier audio sélectionné en synchronisation avec 
la session.

Audio Files Conform to Session Tempo : 
conforme tous les fichiers audio basés sur des 
références de tempo avec analyse Elastic Audio, 
ainsi que les fichiers REX et ACID, au tempo de la 
session. Cette option vous permet de lire la session 
et d'obtenir un aperçu simultané des fichiers 
sélectionnés en synchronisation avec la session. 
Cette option est disponible uniquement lorsqu'une 
session est ouverte. Pour plus d'informations, 
reportez-vous à la section « Conformation de 
l'aperçu au tempo de la session » à la page 310. 

Lorsque l'option Audio Files Conform to Session 

Tempo est activée, Pro Tools analyse les fichiers 
non analysés lors de leur aperçu ou importation. 
Les fichiers audio analysés comme étant basés sur 
des références de tempo peuvent ensuite être 
prévisualisés au tempo de la session et se 
conformer au tempo de la session à l'importation.

Lorsque l'option Audio Files Conform to Session 

Tempo est désactivée, l'aperçu et l'importation des 
fichiers audio basés sur des références de tempo 
avec analyse Elastic Audio, ainsi que les fichiers 
REX et ACID, respectent le tempo d'origine. 

Show Offline Volumes : sélectionnez 
(ou désélectionnez) la commande Show Offline 

Volumes pour afficher (ou masquer) tous les 
volumes hors ligne indexés de la base de données 
dans le volet Locations.

Pour lancer ou arrêter l'aperçu d'un fichier 
lorsqu'un navigateur est situé au premier 
plan, appuyez sur Ctrl+P (Windows) ou 
Commande+P (Mac). La touche Échap 
permet également d'interrompre l'aperçu.
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Commandes supplémentaires 
pour les catalogues
Les catalogues proposent les fonctions 
complémentaires suivantes pour la gestion des 
commentaires dans les éléments sélectionnés. 

Copy Database Comments to Clip Names : copie 
les commentaires d'un élément de la base de 
données sur son nom de clip. 

Copy File Comments to Clip Names (Mac 
uniquement) : copie les commentaires de fichier 
d'un élément sur son nom de clip. 

Volets et options d'affichage 
des navigateurs de l'espace 
de travail
Les navigateurs de l'espace de travail affichent une 
liste d'éléments divisée en plusieurs colonnes 
(telles que nom, taille, date de création et fréquence 
d'échantillonnage du fichier). 

Affichage ou masquage du volet 
Locations
Le volet Locations peut être masqué.

Pour afficher ou masquer le volet Locations :

 Cliquez sur l'icône Afficher/Masquer dans le 
coin inférieur droit du volet gauche. 

Déplacement des colonnes

Pour déplacer une colonne :

 Faites glisser la colonne vers un nouvel 
emplacement de l'espace de travail. 

Redimensionnement des 
colonnes

Pour redimensionner une colonne :

 Faites glisser la limite droite de la colonne pour 
définir sa largeur. 

Affichage et masquage des 
colonnes
Vous pouvez masquer ou afficher les colonnes des 
navigateurs de l'espace de travail pour les adapter 
à votre workflow. L'affichage par défaut des 
colonnes inclut les éléments utilisés dans la plupart 
des sessions.

Pour afficher ou masquer une colonne :

 Cliquez sur l'étiquette de la colonne en 
maintenant la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée ou effectuez un clic droit sur 
l'étiquette puis sélectionnez ou désélectionnez le 
nom de la colonne dans le menu contextuel. 

Pour plus d'informations, reportez-vous à la 
section « Zones de commentaires » à la page 296.

Icône Afficher/Masquer du volet Locations

Affichage et masquage de colonnes
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Pour afficher ou masquer toutes les colonnes :

 Cliquez sur l'en-tête d'une colonne en maintenant 
la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée ou effectuez un clic droit sur l'en-tête, 
puis sélectionnez ALL ou NONE dans le menu 
contextuel. Lorsque vous sélectionnez NONE, 
seules les colonnes Name et Clip Name 
s'affichent.

Pour afficher l'ensemble de colonnes par défaut :

 Cliquez sur l'en-tête d'une colonne en maintenant 
la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée ou effectuez un clic droit sur l'en-tête, 
puis sélectionnez DEFAULT dans le menu 
contextuel. 

Presets d'affichage
Pro Tools permet de sauvegarder jusqu'à 5 presets 
d'affichage pour les navigateurs de l'espace de 
travail et la fenêtre Relink. Vous pouvez charger 
ces presets en cliquant sur les boutons 
correspondants. 

Pour sauvegarder un preset d'affichage :

1 Ouvrez un navigateur de l'espace de travail ou la 
fenêtre Relink. 

2 Organisez les colonnes et les affichages. 

3 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez sur l'un des 
boutons de preset (de 1 à 5).

Pour charger un preset sauvegardé :

 Cliquez sur le bouton de preset d'affichage 
approprié.

Tri des colonnes
Vous pouvez trier les colonnes par ordre croissant 
ou décroissant. Vous disposez également d'options 
de tri multiples (jusqu'à quatre niveaux).

Pour trier une colonne :

 Cliquez sur l'en-tête de la colonne. 

Pour passer du tri par ordre croissant au tri par 
ordre décroissant :

 Cliquez une seconde fois sur l'en-tête de la 
colonne.

Pour effectuer un tri sur plusieurs colonnes :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur chaque en-
tête de colonne.

Données des colonnes
Dans les navigateurs de l'espace de travail, chaque 
ligne de données représente un élément d'une base 
de données (par exemple, un fichier, une session 
ou un volume). Chaque colonne affiche des 
données spécifiques aux éléments.

Name : affiche le nom du fichier, du dossier, 
du volume, du catalogue ou de la session. 
Les noms des éléments hors ligne sont affichés 
en italique.

Perm. : affiche les permissions désignées de 
chaque volume pour l'enregistrement, la lecture ou 
le transfert uniquement.

Boutons de preset d'affichage du navigateur
Pour plus d'informations, reportez-vous à la 
section « Permissions des volumes » à la 
page 286.
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Kind : spécifie s'il s'agit d'un volume, d'un dossier, 
d'un catalogue ou d'un fichier. Pour les fichiers, 
cette colonne affiche le type de fichier : fichier de 
session, fichier audio, fichier vidéo ou autre. Cette 
zone ne peut pas être éditée. En ce qui concerne les 
fichiers audio, cette colonne indique également si 
le fichier est basé sur les échantillons ou sur les 
références de tempo.

Size : affiche la taille d'un fichier. Cette zone ne 
peut pas être éditée.

Waveform : affiche une représentation graphique 
du fichier audio. Pour plus d'informations, reportez-
vous à la section « Formes d'onde » à la page 303.

Duration : affiche la durée d'un fichier en temps 
absolu (minutes et secondes), quel que soit le 
format de timecode. Pour les groupes de clips, 
fichiers MIDI, fichiers Elastic Audio basés sur des 
références de tempo, fichiers REX et ACID, 
la durée est affichée en temps et mesures. Cette 
zone ne peut pas être éditée.

Date Indexed : affiche la date de la dernière 
indexation de l'élément. Cette zone ne peut pas être 
éditée.

Capacity : affiche la capacité totale d'un volume. 
Cette zone ne peut pas être éditée. 

Free : affiche l'espace disponible sur les volumes. 
Cette zone ne peut pas être éditée. 

File Comment : affiche tout commentaire associé 
au fichier. Les commentaires sur un fichier sont pris 
en charge avec les fichiers BWF et SD II, mais ne le 
sont pas avec les fichiers AIFF. Les commentaires 
restent associés à leurs fichiers quand vous les 
copiez, les convertissez ou les transférez. Pour plus 
d'informations, reportez-vous à la section « Zones 
de commentaires » à la page 296.

Database Comment : affiche des commentaires de 
l'utilisateur sauvegardés dans la base de données, 
avec prise en charge des commentaires du Finder. 
Pour plus d'informations, reportez-vous à la 
« Zones de commentaires » à la page 296.

Date Modified : affiche la date de la dernière 
modification de l'élément. Cette zone ne peut pas 
être éditée.

Date Created : affiche la date de création d'un 
élément. Cette zone ne peut pas être éditée. 

Number of Channels : affiche le nombre de 
canaux d'un fichier audio : mono, stéréo ou 
de 3 à 8 (selon les caractéristiques des fichiers 
multicanal pris en charge). Ce champ ne peut pas 
être édité.

Format : affiche le format des fichiers audio, 
WAV, WAV (ACID) pour les fichiers ACID, 
WAV (BWF), AIFF, MP3 ou ReCycle pour les 
fichiers REX. Ce champ ne peut pas être édité. 

Sample Rate : affiche la fréquence 
d'échantillonnage des fichiers audio. Ce champ 
peut être édité dans les navigateurs de l'espace de 
travail pour les fichiers WAV et SD II uniquement. 
Il est utile lorsque vous travaillez avec de l'audio 
auquel un facteur de pull up ou pull down a été 
appliqué, ou pour forcer la conversion de 
fréquence d'échantillonnage avant l'importation 
d'un fichier qui à l'origine ne nécessitait aucune 
conversion.

Bit Depth : affiche la résolution des fichiers audio. 
Ce champ ne peut pas être édité.

Tempo : affiche le tempo associé aux fichiers 
MIDI, Elastic Audio basés sur des références de 
tempo, REX, ACID, de groupe de clips et de 
session. Ce champ ne peut pas être édité.

Video Compression : affiche le taux de 
compression des fichiers vidéo.

Les fichiers SD II importés dans Pro Tools 
doivent être convertis dans un format de 
fichier audio pris en charge (.WAV ou .AIF).
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Frame Rate : affiche la cadence d'images des 
fichiers vidéo.

Original Time Stamp : affiche le marqueur 
temporel d'origine (emplacement de timecode) des 
fichiers audio ou vidéo.

User Time Stamp : affiche, le cas échéant, 
le marqueur temporel utilisateur des fichiers audio 
uniquement.

Path : affiche le chemin d'accès aux éléments. 

Unique ID : affiche l'ID unique des fichiers 
Pro Tools. 

Clip Name : affiche le nom du fichier ou du clip 
Avid si l'élément est un fichier AAF ou OMF. 
Lorsque vous importez un fichier dans une session, 
le nom du clip apparaît sur la timeline et dans la 
liste des clips. Cette zone peut uniquement être 
éditée dans les catalogues. Vous pouvez la générer 
avec n'importe quelle commande du type Copy 
Comments to Clip Name du menu de navigateur 
(reportez-vous à la section « Commandes 
supplémentaires pour les catalogues » à la 
page 292). 

Tape : cette colonne affiche le nom d'origine de la 
bande Avid si l'élément est un fichier OMF (audio 
ou vidéo). Si le fichier audio a été enregistré dans 
une session Pro Tools, cette zone affiche le nom de 
la session d'origine. 

TC Rate : cette colonne affiche la cadence 
d'images de l'élément si ce dernier est une 
séquence AAF ou une séquence/un fichier OMF : 
24, 25, 29.97, 30, drop ou non-drop. Pour les 
séquences, la cadence d'images du début de la 
séquence est affichée.

Channel Names : affiche les informations de nom 
et de numéro de canal intégrées dans les fichiers 
audio multicanal. Vous pouvez modifier le nom 
de canal des fichiers BWF mono uniquement. 
Lorsque vous modifiez le nom du canal, tout ce qui 
est saisi entre parenthèses est ignoré. Le numéro du 
canal est cependant toujours conservé.

Scene : affiche les informations de numéro de 
scène intégrées dans les fichiers audio. 

Take : affiche les informations de numéro de prise 
intégrées dans les fichiers audio.

Shoot Date : affiche les informations de date et 
d'heure de production insérées dans les fichiers 
audio. Cependant, de nombreux enregistreurs 
portables ne renseignent pas automatiquement le 
champ Shoot Date ; la date de création du fichier est 
alors utilisée pour indiquer la date de production. 
Lorsque Pro Tools importe un fichier issu d'un 
appareil d'enregistrement portable, il vérifie que le 
champ Shoot Date est bien renseigné. Si ce champ 
est vide, Pro Tools copie la date de création du 
fichier source d'origine dans le champ Shoot Date 
des nouveaux fichiers importés. Ce champ ne peut 
pas être édité.

Sound Roll : affiche les informations de numéro 
de bande son (ces informations correspondent en 
général aux données Tape dans les fichiers BWF, 
mais sont distinctes de la date affichée dans la 
colonne Tape de l'espace de travail). Ce champ ne 
peut pas être édité.

Sound Roll TC : affiche le timecode de début des 
fichiers audio. Ce champ ne peut pas être édité.

Sound Roll TC Rate : affiche les informations de 
cadence d'images intégrées dans les fichiers 
audio : 24, 25, 29.97, 30, drop ou non-drop. 
Ce champ ne peut pas être édité.
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User Bits : affiche les informations de texte 
intégrées dans les fichiers audio. Vous pouvez 
utiliser ce champ pour les commentaires utilisateur 
ou les informations auto-générées avec certains 
appareils d'enregistrement portables.

Tape ID : affiche les informations d'identifiant de 
bande intégrées dans les fichiers audio. Ce champ 
ne peut pas être édité.

Project : affiche les informations de nom de projet 
intégrées dans les fichiers audio.

Circled : indique si une prise est « cerclée » (No ou 
Yes) dans les fichiers audio. Cette option sert en 
général à indiquer la prise à utiliser.

Plug-In Name : affiche le nom du plug-in pour les 
fichiers de paramètres de plug-in (.txf).

Plug-In Manufacturer Name : affiche le nom de 
fabricant du plug-in pour les fichiers de paramètres 
de plug-in (.txf).

Link Path : affiche le chemin d'accès au fichier 
utilisé pour rétablir le lien. Commande uniquement 
disponible dans la fenêtre Relink.

Zones de commentaires
Les commentaires liés aux fichiers individuels 
peuvent être sauvegardés dans la base de données 
et intégrés à l'ensemble des métadonnées du 
fichier. Il existe deux types de zones de 
commentaires : les commentaires de fichier et les 
commentaires de base de données.

Commentaires de fichier

Les commentaires de fichier sont sauvegardés 
avec les métadonnées du fichier lui-même. Tous 
les types de fichiers ne proposent pas ces 
commentaires. L'indexation sauvegarde les 
commentaires de fichier dans la base de données, 
ce qui permet de rechercher et de visualiser les 
commentaires même si le fichier en question est 
hors ligne. Les commentaires de fichier peuvent 
être édités dans les navigateurs de l'espace de 
travail, à condition que les fichiers ou que leurs 
médias parents ne soient pas en lecture seule. 

Vous pouvez également ajouter et éditer des 
commentaires de fichier pour les fichiers de 
session Pro Tools. Les catalogues ne permettent 
pas d'éditer les commentaires de fichier.

Commentaires de base de données

(Sessions et catalogues uniquement)

Les commentaires de base de données peuvent 
contenir jusqu'à 256 caractères, peuvent être inclus 
dans une recherche, s'appliquent à toutes les 
plateformes et peuvent être édités. Pour plus 
d'informations, reportez-vous à la section « Zones 
de commentaires » à la page 296. 

Ajout et modification de 
commentaires

Pour ajouter, visualiser ou éditer un commentaire :

1 Cliquez sur le champ Comments. Si nécessaire, 
cette zone s'agrandit pour afficher le commentaire 
entier. 

2 Saisissez ou éditez un commentaire. 

3 Appuyez sur Entrée ou cliquez en dehors de la 
zone de texte pour la refermer. 
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Sélection d'éléments
Pour sélectionner un élément unique dans le volet 
Locations :

 Cliquez sur l'icône d'un élément. Lorsqu'un 
élément est sélectionné, il est mis en surbrillance. 
Le contenu de l'élément sélectionné (volume, 
dossier, session ou catalogue) est affiché dans le 
volet de navigation.

Pour sélectionner plusieurs éléments dans le volet 
de navigation :

 Cliquez et faites glisser votre souris pour 
sélectionner un groupe d'éléments, 
ou maintenez la touche Maj enfoncée et cliquez 
sur les éléments à ajouter à la sélection. Pour 
sélectionner plusieurs éléments non contigus, 
maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez dessus. 

Pour sélectionner tous les éléments affichés :

 Appuyez sur Ctrl+A (Windows) ou 
Commande+A (Mac).

Pour sélectionner tous les fichiers de transfert 
dans la fenêtre active :

 Sélectionnez Select Transfer Files dans le menu 
du navigateur.

Pour sélectionner tous les fichiers hors ligne :

 Sélectionnez Select Offline Files dans le menu 
du navigateur.

Pour sélectionner tous les fichiers en ligne :

 Sélectionnez Select Online Files dans le menu 
du navigateur.

Pour inverser la sélection actuelle :

 Sélectionnez Invert Selected dans le menu du 
navigateur. 

Déplacement, copie, 
duplication et suppression 
d'éléments
Le déplacement, la copie, la duplication et la 
suppression d'éléments dans les navigateurs de 
l'espace de travail fonctionnent comme dans votre 
système d'exploitation. Par exemple, 
le déplacement d'un fichier dans un autre volume 
crée une copie de ce fichier ; Pro Tools vous avertit 
lorsqu'un élément risque d'être remplacé ou écrasé 
suite à l'opération effectuée. Lorsque vous faites 
glisser un élément d'un catalogue vers un dossier 
d'un volume, une copie de cet élément est créée. 

Déplacement d'éléments

Pour déplacer des éléments :

 Sélectionnez un ou plusieurs éléments et faites-
les glisser. Si l'emplacement de destination se 
trouve sur le même volume, l'élément est 
déplacé ; en revanche, si vous le déplacez vers 
un autre volume, l'élément est copié. 

Copie d'éléments

Pour copier et déplacer des éléments :

 Sélectionnez un ou plusieurs éléments, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et faites-les glisser vers un 
nouvel emplacement. 

Si un ou plusieurs éléments sont déjà 
sélectionnés dans le volet Locations ou de 
navigation, vous pouvez également saisir les 
premières lettres de l'élément à sélectionner.

Vous pouvez faire glisser directement des 
éléments vers la timeline ou la liste des 
clips de la session en cours. Reportez-
vous à la section « Importation de fichiers 
par glisser-déposer » à la page 333.
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Duplication d'éléments

Pour dupliquer un ou plusieurs éléments :

1 Sélectionnez un ou plusieurs éléments. 

2 Sélectionnez Duplicate Selected dans le menu 
du navigateur.

Suppression d'éléments de 
session
Les navigateurs de l'espace de travail permettent 
d'enlever ou de supprimer des fichiers de la session 
actuellement ouverte. Si un élément sélectionné 
réside sur un volume en lecture seule, il peut être 
retiré de la session, mais ne peut pas être supprimé 
définitivement. 

Pour supprimer définitivement un ou plusieurs 
éléments de la session :

1 Sélectionnez la session actuelle dans le volet 
Locations. 

2 Sélectionnez un ou plusieurs éléments dans le 
volet de navigation.

3 Sélectionnez la commande Move to Trash 
(Mac) ou Move to Recycle Bin (Windows) dans 
le menu du navigateur. 

4 Effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour retirer l'élément de la 
session.

• Cliquez sur Delete pour supprimer 
définitivement l'élément de votre système.

• Cliquez sur Cancel pour annuler l'opération sur 
les éléments sélectionnés. 

Recherche d'éléments
Pro Tools permet d'effectuer une recherche sur 
votre système ou des volumes, répertoires ou 
catalogues spécifiques. Les navigateurs de l'espace 
de travail disposent d'un groupe d'outils de 
recherche simples permettant de trouver facilement 
des fichiers en ligne ou hors ligne sur votre système.

Les recherches filtrent la liste des éléments du 
volet de navigation pour n'afficher que ceux qui 
correspondent aux critères de recherche. 

La fenêtre Relink propose des fonctions de 
recherche spécialement conçues pour localiser les 
fichiers manquants et rétablir leurs liens. Pour plus 
d'informations, reportez-vous à la section 
« Création et rétablissement de liens vers des 
fichiers » à la page 312.

Outils de recherche
Un groupe d'outils de recherche est présent dans la 
partie supérieure de chaque navigateur de l'espace 
de travail pour trouver des fichiers sur votre 
système, rapidement et simplement.

Champ de recherche du navigateur

Saisissez les noms des fichiers, dates, durées, 
etc. dans le champ de recherche du navigateur. 
Dès que vous commencez à taper, Pro Tools 
démarre simultanément la recherche en fonction 
de votre texte. Les résultats sont affichés dans le 
volet de navigation. 

Pour dupliquer les éléments sélectionnés dans 
le navigateur de l'espace de travail, appuyez 
sur Commande+D (Mac) ou Ctrl+D 
(Windows).

Nouveaux outils de recherche

Bouton de recherche avancée

Bouton de recherche simple

Champ de recherche du 
navigateur
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Bouton de recherche simple

Cliquez sur le bouton Rechercher pour lancer une 
recherche simple avant de taper votre texte dans le 
champ de recherche du navigateur. Le bouton de 
recherche simple change d'une icône de loupe à un 
« X » et lance immédiatement une recherche. 
Cliquez à nouveau sur ce bouton pour terminer la 
recherche (ou appuyez sur la touche Échap). 

Bouton de recherche avancée

Cliquez sur le bouton de recherche avancée pour 
ouvrir la barre d'outils de recherche avancée 
(reportez-vous à la section « Recherche avancée » 
à la page 300).

Recherche simple
Pro Tools permet d'effectuer des recherches de 
texte simples via le champ de recherche du 
navigateur. Vous pouvez ainsi rapidement 
rechercher des éléments par nom de fichier ou tout 
autre champ de texte disponible dans le navigateur 
de l'espace de travail (tel que File Comment, 
Database Comment, Scene, Take, Plug-In 

Name, etc.).

Pour effectuer une recherche simple :

1 Dans le volet Locations, sélectionnez le 
volume, le catalogue, la session ou le dossier 
dans lequel lancer la recherche. Si vous ne 
sélectionnez aucun emplacement, la recherche 
sera effectuée sur l'ensemble de votre système 
(y compris sur les volumes hors ligne affichés).

2 Appuyez sur Commande+F (Mac) ou Ctrl+F 
(Windows).

3 Saisissez le texte à rechercher dans le champ de 
recherche du navigateur.

4 Cliquez dans le champ de recherche du 
navigateur et tapez le texte à rechercher.

Les résultats de la recherche apparaissent dans le 
volet de navigation.

Le lancement d'une recherche sans critères 
renvoie tous les éléments du système.
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Recherche avancée
Pro Tools fournit des outils avancés pour la recherche de fichiers et de volumes par catégories spécifiques. 
Vous pouvez affiner votre recherche en ajoutant plusieurs restrictions à vos paramètres de recherche. Vous 
pouvez également passer aisément d'une recherche avancée à une recherche simple.

Pour lancer une recherche sur un élément 
sélectionné dans le volet Locations :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton de recherche avancée.

• Appuyez sur Commande+Maj+F (Mac) ou 
Ctrl+Maj+F (Windows).

2 Si l'option de recherche dans les éléments 
cochés est activée, à gauche de l'en-tête du volet 
Locations, cliquez dessus pour la désactiver.

3 Dans le volet Locations, sélectionnez le 
volume, le catalogue, la session ou le dossier 
dans lequel lancer la recherche.

4 Sélectionnez le type de colonne.

5 Sélectionnez les critères de recherche.

6 Cliquez sur le champ Rechercher et tapez le 
texte de votre recherche.

7 Appuyez sur Retour (Mac) ou Entrée 
(Windows).

Les résultats de la recherche apparaissent dans le 
volet de navigation.

Si vous souhaitez affiner votre recherche, cliquez 
sur le bouton d'ajout de ligne pour ajouter des 
restrictions supplémentaires à votre recherche. 
Répétez les étapes 4 à 6 pour chaque ligne ajoutée.

Résultats d'une recherche avancée dans le volume sélectionné.

Volume sélectionné pour 
la recherche

Paramètres de recherche 
avancée

Recherche avancée activée

Option de recherche dans les 
éléments cochés (désactivée)

Résultats de la recherche
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Pour lancer une recherche avancée sur les éléments cochés dans le volet Locations :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton de recherche avancée.

• Appuyez sur Commande+Maj+F (Mac) ou Ctrl+Maj+F (Windows).

2 Si l'option de recherche dans les éléments cochés est désactivée, à gauche de l'en-tête du volet 
Locations, cliquez dessus pour l'activer.

3 Dans le volet Locations, cochez tous les volumes, catalogues, sessions ou dossiers dans lesquels vous 
souhaitez effectuer une recherche.

4 Sélectionnez le type de colonne.

5 Sélectionnez les critères de recherche.

6 Cliquez sur le champ Rechercher et tapez le 
texte de votre recherche.

7 Appuyez sur Retour (Mac) ou Entrée 
(Windows).

Les résultats de la recherche sont affichés dans le 
volet de l'espace de travail.

Si vous souhaitez affiner votre recherche, cliquez 
sur le bouton d'ajout de ligne pour ajouter des 
restrictions supplémentaires à votre recherche. 
Répétez les étapes 4 à 6 pour chaque ligne ajoutée.

Résultats d'une recherche avancée dans les volumes cochés

 

Volumes cochés pour 
la recherche Paramètres de recherche avancée Recherche avancée activée

Option de recherche dans les 
éléments cochés (activée)

Résultats de la 
recherche
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Pour passer d'une recherche avancée à une 
recherche simple, effectuez l'une des opérations 
suivantes :

 Cliquez sur le bouton de recherche avancée afin 
de le mettre en surbrillance.

 Appuyez sur Commande+Maj+F (Mac) ou 
Ctrl+Maj+F (Windows).

Pour passer d'une recherche simple à une 
recherche avancée, effectuez l'une des opérations 
suivantes :

 Cliquez sur le bouton de recherche avancée afin 
de le désactiver.

 Appuyez sur Commande+F (Mac) ou Ctrl+F 
(Windows).

Pour annuler entièrement une recherche :

 Cliquez sur le bouton de recherche simple 
(« X »).

Fonctions de recherche 
avancée
Une fois que vous avez lancé une recherche 
avancée, le navigateur de l'espace de travail 
propose des fonctions de recherche 
supplémentaires.

Sélecteur de colonne pour la recherche

Vous pouvez rechercher du texte dans toutes 
les colonnes ou seulement dans des colonnes 
spécifiques du navigateur.

Sélecteur de critères de recherche 

Vous pouvez rechercher des éléments dans la 
colonne sélectionnée qui répondent aux critères de 
recherche suivants : 

Contains : sélectionnez cette option pour 
rechercher des éléments qui contiennent le texte 
que vous tapez dans le champ de recherche.

Does Not Contain : sélectionnez cette option 
pour exclure de la recherche les éléments qui 
contiennent le texte que vous tapez dans le 
champ de recherche.

Starts With : sélectionnez cette option pour 
rechercher les éléments qui commencent par le 
texte que vous tapez dans le champ de recherche.

Contains Exactly : sélectionnez cette option pour 
rechercher les éléments qui contiennent exactement 
le texte que vous tapez dans le champ de recherche.

Champ de texte de recherche

Utilisez le champ de texte de recherche pour 
effectuer une recherche dans le type de colonne 
sélectionné, en fonction des critères de recherche.

Boutons d'ajout/suppression de ligne

Pro Tools vous permet d'affiner votre recherche 
avec jusqu'à 8 lignes de critères de recherche.

Bouton d'ajout de ligne : cliquez sur le bouton + 
pour afficher une autre ligne et affiner la recherche 
avancée.

Outils de recherche avancée

Bouton d'ajout de ligne

Champ de texte de recherche

Sélecteur de colonne 
pour la recherche

Sélecteur de critères de recherche

Bouton de suppression de ligne
Appuyez sur Maj+Plus (+) pour ajouter une 
nouvelle ligne.
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Bouton de suppression de ligne : cliquez sur le 
bouton – d'une ligne pour la supprimer.

Sauvegarde des résultats de la 
recherche sous forme de 
catalogue

Pour sauvegarder les résultats de votre recherche 
sous forme de catalogue :

1 Pour sélectionner toute la liste des éléments, 
sélectionnez Edit > Select All ou appuyez sur 
Ctrl+A (Windows) ou Commande+A (Mac).

2 Dans le menu du navigateur, sélectionnez 
Create Catalog.

Formes d'onde
La colonne Waveform affiche les formes d'onde 
des fichiers audio. L'affichage des formes d'onde 
dépend des facteurs suivants :

• Les formes d'onde s'affichent si elles ont déjà été 
calculées et sauvegardées avec les métadonnées 
du fichier ou dans le cache global des formes 
d'onde.

• Lorsque vous importez un fichier dans une 
session, une forme d'onde est automatiquement 
calculée. 

Les aperçus de forme d'onde sont sauvegardés dans 
le fichier ou le dossier Databases de Pro Tools sur 
votre disque dur. Pour plus d'informations, reportez-
vous à la section « WaveCache » à la page 304.

Formes d'onde sommées de fichiers multicanal

Pour les fichiers stéréo et multicanal, les formes 
d'onde sont sommées. 

Calcul des formes d'onde pour 
l'affichage
Si un élément d'un fichier audio ne possède pas de 
forme d'onde, celle-ci doit être calculée pour être 
affichée dans la colonne Waveform du navigateur 
de l'espace de travail. 

Pour calculer les formes d'onde dans un 
navigateur de l'espace de travail :

1 Dans un navigateur de l'espace de travail, 
sélectionnez des fichiers audio en ligne ou des 
dossiers contenant des fichiers audio.

2 Sélectionnez Calculate Waveform dans le menu 
du navigateur. 

Appuyez sur Maj+Moins (-) pour supprimer 
la dernière ligne.

Pour plus d'informations, reportez-vous 
à la section « Catalogues » à la page 320.

Affichage de formes d'onde dans un navigateur de 
l'espace de travail
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WaveCache
Un fichier WaveCache global stocke les formes 
d'onde qui ne peuvent pas être sauvegardées dans 
le fichier audio, notamment pour les fichiers en 
lecture seule, fichiers réseau ou enregistrés sur 
d'autres volumes en lecture en seule, ainsi que pour 
les fichiers entrelacés.

Sur Mac, le fichier WaveCache est stocké 
à l'emplacement /Utilisateurs/Partagé/Pro Tools.

Sous Windows, le fichier WaveCache est stocké 
à l'emplacement 
<DisqueSystème>/Utilisateurs/Public/Pro Tools.

Fichiers Elastic Audio dans 
l'espace de travail
Vous pouvez calculer et effacer l'analyse Elastic 
Audio des fichiers audio sélectionnés dans les 
navigateurs de l'espace de travail. Seuls les fichiers 
AIFF et WAV sont pris en charge pour l'analyse et 
le traitement Elastic Audio. Tous les autres 
formats de fichiers (comme MP3) doivent être 
convertis au format AIFF ou WAV pour permettre 
l'analyse et le traitement Elastic Audio.

Pour calculer l'analyse Elastic Audio :

1 Dans un navigateur de l'espace de travail, 
sélectionnez les fichiers à analyser.

2 Effectuez l'une des opérations suivantes :

• Dans le menu du navigateur, sélectionnez 
Calculate Elastic Analysis.

• Effectuez un clic droit sur l'un des fichiers 
sélectionnés, puis sélectionnez Calculate Elastic 

Analysis dans le menu contextuel.

• Lancez l'aperçu du fichier en activant l'option 
Audio Files Conform to Session Tempo.

Les fichiers analysés dans lesquels un tempo 
régulier a été détecté sont mis à jour comme étant 
basés sur des références de tempo. Leur durée est 
affichée en mesures et temps (Bars|Beats) et leur 
tempo d'origine apparaît dans la colonne Tempo. 

Les fichiers analysés dans lesquels aucun tempo 
n'a été détecté demeurent basés sur des 
échantillons. Ces fichiers comportent 
généralement un seul transitoire (par exemple un 
battement de caisse claire). Il peut également s'agir 
de fichiers plus longs sans tempo régulier 
facilement identifiable (comme des chansons 
entières).

Même si les fichiers au format MP3 ne sont 
pas directement pris en charge par le 
traitement Elastic Audio, vous pouvez les 
importer dans une session basée sur le format 
WAV ou AIFF, puis utiliser les fichiers 
convertis sur des pistes Elastic Audio. 
Les fichiers dont le format ne correspond pas 
à la session sont automatiquement convertis 
à l'importation.

Pour plus d'informations, reportez-vous au 
Chapitre 40, « Elastic Audio ».

Sur Mac, si l'icône d'analyse Elastic Audio 
n'apparaît pas ou si la durée n'est pas affichée 
comme basée sur les références de tempo lors 
de l'aperçu, vérifiez les autorisations du 
dossier dans le Finder Mac. Vous devez 
disposer de droits d'écriture sur le répertoire 
pour utiliser cette fonctionnalité.
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Pour effacer l'analyse Elastic Audio :

1 Dans un navigateur de l'espace de travail, 
sélectionnez les fichiers avec analyse Elastic 
Audio que vous voulez effacer.

2 Effectuez l'une des opérations suivantes :

• Dans le menu du navigateur, sélectionnez Clear 

Elastic Analysis.

• Effectuez un clic droit sur l'un des fichiers 
sélectionnés, puis sélectionnez Clear Elastic 

Analysis dans le menu contextuel.

Les fichiers dans lesquels les données d'analyse 
Elastic Audio sont effacées retrouvent une base de 
temps basée sur les échantillons. Leur durée est 
affichée en minutes et secondes et aucun tempo 
n'est détecté.

Icônes de base de temps et 
d'analyse Elastic Audio d'un 
fichier
Les navigateurs de l'espace de travail affichent 
deux icônes différentes pour les fichiers basés sur 
des données temporelles ou sur des références de 
tempo. Pour les fichiers basés sur des données 
temporelles, l'icône utilise un code couleur pour 
indiquer si le fichier inclut une analyse Elastic 
Audio ou non.

Icônes Elastic Audio et de base de temps dans un 
navigateur de l'espace de travail

Icône de fichier 
Elastic Audio basé sur 

les échantillons

Icône de fichier 
basé sur des 
références de 
tempo

Icône de fichier basé 
sur les échantillons, 
non Elastic Audio
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Icône de fichier basé sur les échantillons : 
indique que le fichier est basé sur les échantillons. 
L'icône utilise un code couleur pour indiquer si le 
fichier inclut des données d'analyse Elastic Audio 
ou non. L'icône des fichiers WAV et AIF basés sur 
les échantillons, sans données d'analyse Elastic 
Audio, représente une horloge grise. L'icône des 
fichiers WAV et AIF basés sur les échantillons, 
avec données d'analyse Elastic Audio, représente 
une horloge bleue. La durée du fichier est affichée 
en minutes et secondes. 

Icône de fichier basé sur des références de 
tempo : indique que le fichier est basé sur des 
références de tempo. La durée du fichier est affichée 
en mesures et temps et son tempo d'origine apparaît 
dans la colonne Tempo. Les fichiers MIDI, REX et 
ACID sont basés sur des références de tempo et 
contiennent leur propre tempo et métadonnées en 
mesures et temps. L'icône des fichiers WAV et 
AIF basés sur des références de tempo, avec 
données d'analyse Elastic Audio, représente un 
métronome vert.

Aperçu audio dans les 
navigateurs de l'espace de 
travail
Il est possible d'écouter un aperçu des fichiers 
audio dans les navigateurs de l'espace de travail. 
La fonction d'aperçu utilise le chemin d'écoute 
principal sélectionné dans le volet Output de la 
boîte de dialogue I/O Setup (reportez-vous à la 
section « Audition Paths » à la page 78). Le niveau 
de base pour l'aperçu est défini par le niveau du 
Master Fader (ou de l'entrée auxiliaire) assigné au 
chemin d'écoute. Vous pouvez également ajuster le 
volume d'aperçu dans le navigateur de l'espace de 
travail.

Pour écouter l'aperçu d'un fichier audio dans un 
navigateur de l'espace de travail :

1 Sélectionnez un fichier audio dans la liste 
d'éléments d'un navigateur. Assurez-vous que la 
fenêtre du navigateur de l'espace de travail est 
au premier plan (active). 

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton d'aperçu de la forme 
d'onde (icône en forme de haut-parleur située 
à gauche de l'affichage de forme d'onde). 
Cliquez de nouveau pour mettre fin à l'écoute.

• Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, appuyez 
sur la barre d'espace. Appuyez à nouveau sur la 
barre d'espace pour interrompre l'écoute.

• Appuyez sur Commande+P (Mac) ou Ctrl+P 
(Windows) pour lancer et arrêter l'aperçu. 

• Appuyez sur la touche Échap pour interrompre 
l'aperçu. 

Si l'option Auto-Preview est activée, l'aperçu 
démarre dès la sélection du fichier dans un 
navigateur de l'espace de travail.
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Pour écouter un fichier audio à partir d'un point 
spécifique du fichier :

 Cliquez sur l'emplacement souhaité de 
l'affichage de la forme d'onde. 

Fichiers entrelacés

Lors d'un aperçu dans un navigateur de l'espace de 
travail, les fichiers audio entrelacés comportant plus 
de deux canaux sont sommés en fichiers mono. 

Fichiers multi-mono

Pour l'aperçu de fichiers multi-mono, chaque 
fichier doit être traité à la fois. 

Aperçu groupé des fichiers stéréo divisés

Lorsque vous sélectionnez un des deux fichiers 
stéréo divisés, comme Drums.L et Drums.R, 
les deux fichiers sont prévisualisés ensemble. Pour 
obtenir uniquement l'aperçu du canal sélectionné 
d'une paire stéréo divisée, appuyez sur la touche 
Maj et lancez l'aperçu.

Commandes et indicateurs 
d'aperçu
Chaque navigateur de l'espace de travail dispose 
des commandes d'aperçu suivantes dans la barre 
d'outils : bouton d'aperçu, volume, indicateurs de 
niveau, bouton de conformation des fichiers audio 
au tempo de la session et sélecteur de plug-in 
Elastic Audio.

Bouton d'aperçu

Le bouton d'aperçu lance et interrompt l'aperçu des 
fichiers audio sélectionnés dans les navigateurs de 
l'espace de travail. Vous pouvez également 
effectuer un clic droit pour changer le mode 
d'aperçu et indiquer si la barre d'espace permet ou 
non de changer le mode d'aperçu des fichiers. 

Écoute d'un fichier audio

Certaines opérations effectuées dans Pro Tools 
peuvent interrompre provisoirement l'écoute 
dans les navigateurs de l'espace de travail. 

L'aperçu des fichiers MIDI est possible 
à partir de la liste des clips de la session, mais 
pas à partir des navigateurs de l'espace de 
travail. Reportez-vous à la section « Aperçu 
des clips dans la liste des clips » à la page 274.

Commandes d'aperçu des navigateurs de l'espace de 
travail

Menu contextuel du bouton d'aperçu d'un navigateur 
de l'espace de travail

Bouton de conformation des fichiers 
audio au tempo de la session

Bouton 
d'aperçu

Volume

Indicateurs de niveau
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Volume

La commande de volume des navigateurs de 
l'espace de travail permet d'augmenter ou de réduire 
le gain de l'aperçu des fichiers sélectionnés. 

Pour modifier le volume d'aperçu dans les 
navigateurs de l'espace de travail :

1 Cliquez sur le champ Volume pour afficher le 
fader de volume.

2 Ajustez le fader de volume (de -INF à +12 dB).

Indicateurs de niveau

Les indicateurs de niveau affichent le niveau audio 
et disposent également de témoins d'écrêtage. 
Le niveau d'un fichier mono est affiché sur les deux 
indicateurs. Pour les fichiers stéréo, les indicateurs 
gauche et droit affichent respectivement les canaux 
gauche et droit. Les fichiers multicanal de format 
supérieur à stéréo s'affichent sous la forme de 
fichiers mono sommés sur les deux indicateurs 
de niveau.

Bouton de conformation des fichiers audio au 
tempo de la session

Le bouton de conformation des fichiers audio au 
tempo de la session reflète l'option de menu du 
navigateur correspondante. Lorsqu'il est activé, 
tous les fichiers audio basés sur des références de 
tempo avec analyse Elastic Audio, ainsi que les 
fichiers REX et ACID, sont conformés au tempo 
de la session. Cela vous permet de lire la session, 
puis d'obtenir un aperçu simultané des fichiers 
sélectionnés en synchronisation avec la session. 
Le bouton de conformation des fichiers audio au 
tempo de la session est disponible uniquement 
lorsqu'une session est ouverte. Dans le cas 
contraire, il est désactivé et grisé.

Lorsque le bouton de conformation des fichiers 
audio au tempo de la session est activé, Pro Tools 
analyse les fichiers non analysés lors de l'aperçu ou 
de l'importation. Les fichiers audio basés sur des 
références de tempo sont conformés au tempo 
de la session lors de l'aperçu et de l'importation. 
La vitesse et la durée d'origine des fichiers basés 
sur les échantillons pour lesquels aucun tempo n'a 
été détecté sont toujours respectées lors de l'aperçu 
et de l'importation.

Lorsque le bouton de conformation des fichiers 
audio au tempo de la session est désactivé, l'aperçu 
des fichiers audio basés sur des références de 
tempo avec analyse Elastic Audio, ainsi que des 
fichiers REX et ACID, est effectué au tempo 
d'origine. 

Fader du volume d'aperçu d'un navigateur de l'espace 
de travail

Pour plus d'informations, reportez-vous à la 
section « Conformation de l'aperçu au tempo 
de la session » à la page 310.
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Sélecteur de plug-in Elastic Audio

Le sélecteur de plug-in Elastic Audio permet de 
sélectionner n'importe quel plug-in Elastic Audio 
en temps réel en tant que plug-in par défaut pour 
l'aperçu et l'importation de fichiers Elastic Audio. 
La modification du plug-in dans un navigateur de 
l'espace de travail affecte également l'option 
Elastic Audio Default Plug-In des préférences de 
traitement.

Pour sélectionner le plug-in Elastic Audio utilisé 
pour l'aperçu en contexte :

1 Effectuez un clic-droit sur le bouton de 
conformation des fichiers audio au tempo de 
la session.

2 Sélectionnez le plug-in Elastic Audio de votre 
choix.

Modes d'aperçu
Les navigateurs de l'espace de travail proposent 
trois modes d'aperçu : normal, en boucle et 
automatique.

Aperçu normal
En mode d'aperçu normal, le fichier audio 
sélectionné est lu jusqu'à la fin. Désactivez les 
modes d'aperçu en boucle et automatique pour 
activer le mode normal.

Aperçu en boucle
En mode d'aperçu en boucle, le fichier sélectionné 
est lu en boucle. Si plusieurs fichiers sont 
sélectionnés, seul le premier est lu en boucle. 
Lorsque le mode d'aperçu en boucle est activé, 
le bouton d'aperçu est mis à jour et affiche une 
icône correspondant à ce mode.

Pour activer l'aperçu en boucle d'un fichier dans 
un navigateur de l'espace de travail :

1 Effectuez l'une des opérations suivantes :

• Dans le menu du navigateur, sélectionnez Loop 

Preview. Le bouton d'aperçu du navigateur est 
mis à jour et affiche l'icône d'aperçu en boucle.

• Effectuez un clic droit sur le bouton d'aperçu et 
sélectionnez Loop Preview.

Sélection du plug-in Elastic Audio utilisé pour l'aperçu 
des fichiers Elastic Audio dans un navigateur de 
l'espace de travail

Pour plus d'informations, reportez-vous à la 
section « Plug-ins Elastic Audio » à la page 916.

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et cliquez sur le bouton 
d'aperçu pour activer ou désactiver le mode 
d'aperçu en boucle.

Bouton du mode d'aperçu en boucle de l'espace 
de travail
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2 Sélectionnez un fichier audio dans la liste 
d'éléments d'un navigateur de l'espace de travail. 
Assurez-vous que la fenêtre du navigateur de 
l'espace de travail est au premier plan (active). 

3 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton d'aperçu du navigateur.

• Cliquez sur le bouton d'aperçu de la forme 
d'onde.

• Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, 
appuyez sur la barre d'espace.

• Appuyez sur Ctrl+P (Windows) ou 
Commande+P (Mac). 

Pour arrêter l'écoute en boucle :

 Effectuez l'une des opérations suivantes :

• Cliquez de nouveau sur le bouton d'aperçu du 
navigateur.

• Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, 
appuyez à nouveau sur la barre d'espace.

• Appuyez sur Ctrl+P (Windows) ou 
Commande+P (Mac). 

• Appuyez sur la touche Échap. 

Aperçu automatique
En mode d'aperçu automatique, les fichiers audio 
sont lus dès qu'ils sont sélectionnés. Le bouton 
d'aperçu est également mis à jour et affiche l'icône 
d'aperçu automatique.

Pour activer l'aperçu automatique des fichiers lors 
de leur sélection :

 Effectuez l'une des opérations suivantes :

• Dans le menu du navigateur, sélectionnez Auto-

Preview. Le bouton d'aperçu est mis à jour pour 
indiquer que l'option Auto-Preview est activée.

• Effectuez un clic droit sur le bouton d'aperçu et 
sélectionnez Auto-Preview.

Conformation de l'aperçu au 
tempo de la session
Pro Tools vous permet d'obtenir un aperçu des 
fichiers analysés Elastic Audio au tempo de la 
session. Le plug-in Elastic Audio par défaut 
sélectionné est utilisé pour prévisualiser les 
fichiers audio Elastic Audio analysés au tempo de 
la session. De plus, l'aperçu d'autres fichiers basés 
sur les références de tempo, comme les fichiers 
REX et ACID, peut également être conformé au 
tempo de la session et donc être synchronisé avec 
la lecture. 

Pour activer un aperçu des fichiers au tempo de la 
session :

1 Dans la session, placez le point d'insertion 
à l'endroit où vous souhaitez que l'aperçu du 
fichier commence dans l'espace de travail.

2 Dans un navigateur de l'espace de travail, 
sélectionnez le fichier dont vous souhaitez 
écouter l'aperçu.

Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur le 
bouton d'aperçu pour activer ou désactiver le 
mode d'aperçu automatique.

Bouton du mode d'aperçu automatique de l'espace de 
travail
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3 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton de conformation des 
fichiers audio au tempo de la session. Le bouton 
est allumé lorsqu'il est activé.

• Dans le menu du navigateur, sélectionnez Audio 

Files Conform to Session Tempo.

• Effectuez un clic droit sur le fichier dont vous 
souhaitez activer l'aperçu et sélectionnez Audio 

Files Conform to Session Tempo dans le menu 
contextuel.

4 Cliquez sur le bouton d'aperçu du navigateur 
pour lire le fichier au tempo de la session.

Aperçu en contexte
Pro Tools permet d'écouter un aperçu des fichiers 
audio dans les navigateurs de l'espace de travail 
pendant la lecture d'une session Pro Tools. 
Les fichiers audio basés sur les références de 
tempo (ceux dont l'analyse Elastic Audio a détecté 
le tempo, ainsi que les fichiers REX et ACID) 
peuvent être lus au tempo, et à des emplacements 
correspondants exprimés en mesures et en temps, 
avec la session. L'écoute de fichiers audio basés 
sur des références de tempo s'effectue au tempo de 
la session lorsque l'option Audio Files Conform to 

Session Tempo est activée. 

Réservation de voix pour l'aperçu en 
contexte
(Pro Tools HD uniquement)

L'aperçu en contexte (aperçu des fichiers audio 
dans l'espace de travail pendant la lecture de la 
session) utilise des voix pour la lecture. Le nombre 
de voix nécessaires dépend de la largeur du canal 
des chemins d'écoute sélectionnés sur la page 
Output de la fenêtre I/O Setup. Par exemple, 
un chemin d'écoute stéréo sélectionné dans la 
fenêtre I/O Setup requiert 2 voix pour l'aperçu en 
contexte, tandis qu'un chemin d'écoute de type 5.1 
nécessite 6 voix. Si une ou plusieurs voix ne sont 
pas disponibles pour l'aperçu en contexte car elles 
sont utilisées par les pistes du disque (ou pour le 
routing d'un traitement Native sur les systèmes 
Pro Tools|HDX), le bouton d'aperçu des 
navigateurs de l'espace de travail est désactivé 
pendant la lecture de la session. 

Pro Tools propose une option permettant de 
réserver des voix pour l'aperçu en contexte. 
Le nombre de voix réservées dépend de la largeur 
du canal des chemins d'écoute sélectionnés dans la 
fenêtre I/O Setup. Les voix réservées pour l'aperçu 
en contexte ne sont pas disponibles pour les pistes 
enregistrées sur les disques.

Pour réserver des voix pour l'aperçu en contexte : 

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Operation.

3 Activez l'option Reserve Voices For Preview In 

Context.

4 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

Désélectionnez l'option Spacebar Toggles File 
Preview dans le menu du navigateur afin de 
pouvoir lancer et interrompre la lecture de la 
session avec la barre d'espace, sans avoir 
à démarrer et arrêter l'aperçu depuis le 
navigateur de l'espace de travail. Appuyez sur 
Ctrl+P (Windows) ou Commande+P (Mac) 
pour démarrer et interrompre l'aperçu dans le 
navigateur de l'espace de travail situé au 
premier plan lors de la lecture de la session. 
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Création et rétablissement 
de liens vers des fichiers
Une session Pro Tools contient des références 
(ou liens) pointant vers les fichiers audio et autres 
médias d'une session. Seuls les fichiers audio et 
vidéo se trouvant sur des volumes de performance 
et comprenant des liens valides peuvent être lus 
dans la session.

Les types de fichiers suivants ne peuvent pas 
être lus :

Fichiers de transfert : fichiers résidant sur des 
volumes ne convenant pas pour la lecture, tels 
qu'un CD-ROM et des volumes réseau.

Fichiers manquants : fichiers ne se trouvant pas 
à l'endroit où la session les cherche parce qu'ils ont 
été déplacés ou qu'ils se trouvent sur un volume 
inaccessible (hors ligne).

Le processus de réacquisition des fichiers 
manquants se nomme rétablissement des liens. 
Dans certains cas, cette opération de 
rétablissement des liens peut nécessiter plusieurs 
sous-tâches annexes.

• Les fichiers de transfert doivent d'abord être 
copiés vers un volume de performance 
approprié. Dans ce cas, la session rétablit un lien 
avec ces copies des volumes de performance 
plutôt qu'avec les fichiers de transfert originaux.

• Il existe des fonctions permettant de rechercher 
des fichiers manquants dans les volumes. 
Lorsque les fichiers sont retrouvés, Pro Tools 
établit un nouveau lien entre la session et ces 
derniers.

• Les liens des fichiers se trouvant sur des 
volumes inaccessibles ne pourront être rétablis 
qu'après le remontage (retour à l'état en ligne) 
des volumes en question.

Quand faut-il rétablir les liens ?
À l'ouverture d'une session ou ultérieurement, 
Pro Tools vous invite à rétablir le lien avec les 
fichiers introuvables.

 Le rétablissement des liens à l'ouverture d'une 
session garantit que tous les médias de cette 
session seront disponibles. Le rétablissement des 
liens peut être effectué manuellement ou 
automatiquement. Reportez-vous à la section 
« Ouverture d'une session contenant des fichiers 
manquants » à la page 314. 

 Le rétablissement des liens ultérieurement 
(après l'ouverture d'une session) constitue la façon 
la plus rapide d'ouvrir une session. Dans ce cas, les 
éléments manquants restent hors ligne et ne 
peuvent pas être lus. Reportez-vous à la section 
« Fenêtre Relink » à la page 316.

Rétablissement de lien forcé

Si vous ne parvenez pas à rétablir le lien vers le 
fichier d'origine, vous pouvez forcer un 
rétablissement de lien vers un autre fichier. 
Reportez-vous à la section « Rétablissement forcé 
des liens des fichiers » à la page 319. 

Les catalogues proposent des caractéristiques 
de liaison uniques. Reportez-vous à la section 
« Rétablissement de liens et alias dans les 
catalogues » à la page 320. 
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Fichiers de transfert
Contrairement aux fichiers manquants, les fichiers 
de transfert sont des fichiers qui ont été localisés, 
mais qui résident sur des volumes ne pouvant être 
lus (CD-ROM ou lecteurs réseau). Ce genre de 
volume apparaît comme volume de transfert dans 
le navigateur de l'espace de travail. 

Ouverture d'une session avec 
fichiers de transfert
Si une session trouve des fichiers résidant sur des 
volumes qui ne peuvent pas être lus, une boîte de 
dialogue apparaît, vous invitant à copier ces 
fichiers vers un volume adapté. 

Pour copier les fichiers de transfert trouvés 
à l'ouverture d'une session, effectuez l'une des 
opérations suivantes : 

 Cliquez sur Yes pour ouvrir la boîte de dialogue 
Copy and Relink.

 Cliquez sur No pour ouvrir la session en 
conservant les fichiers de transfert hors ligne. 
Une fois la session ouverte, le navigateur de 
l'espace de travail signale les fichiers de 
transfert par un T dans la colonne Status.

Fichiers de transfert dans une session 
ouverte

Pour que les fichiers de transfert puissent être lus 
dans la session en cours :

1 Sélectionnez la session actuelle dans le volet 
Locations.

2 Double-cliquez sur le dossier Audio Files pour 
afficher tous les fichiers audio.

3 Sélectionnez Select Transfer Files dans le menu 
du navigateur. 

4 Sélectionnez Copy and Relink dans le menu du 
navigateur. 

5 Spécifiez une destination pour les fichiers 
copiés sur un volume de performance valide et 
cliquez sur OK. 

6 Le cas échéant, répétez cette procédure pour les 
fichiers vidéo. 

Copy and Relink 
La commande Copy and Relink est une option de 
gestion de fichiers disponible pour la session et les 
catalogues dans les navigateurs de l'espace de 
travail. 

Cette commande permet de copier facilement des 
fichiers et d'établir un lien entre une session ou un 
catalogue et les copies plutôt qu'avec les originaux. 

Pour copier des fichiers dans un nouvel 
emplacement et rétablir un lien avec les copies :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Window > New Workspace, puis 
sélectionnez la session actuelle dans le volet 
Locations.

• Pour ouvrir un catalogue :

2 Sélectionnez les éléments à copier et relier. 
Vous pouvez choisir n'importe quel type de 
fichier média (en ligne, hors ligne et fichiers 
de transfert). 

3 Sélectionnez l'option Copy and Relink Selected 
dans le menu du navigateur. 

4 Si l'emplacement par défaut choisi pour les 
copies (le dossier Audio Files de la session) ne 
convient pas, spécifiez un autre emplacement et 
cliquez sur Choose. 

5 Les fichiers sont copiés à l'emplacement choisi 
et les liens entre la session ou le catalogue et les 
copies sont établis en arrière-plan. 
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Fichiers manquants
Si un fichier ne se trouve plus à l'endroit où il 
résidait lors du dernier enregistrement de la 
session, ce fichier est considéré comme manquant. 
Cela se produit lorsque vous déplacez des fichiers 
ou le dossier de la session, ou encore si les fichiers 
se trouvent sur un volume non disponible. 

Ouverture d'une session 
contenant des fichiers 
manquants

Pour ouvrir une session Pro Tools avec des 
fichiers manquants :

1 Lors de l'ouverture d'une session, Pro Tools tente 
d'accéder à tous les médias requis. Il affiche 
ensuite une liste des fichiers manquants (le cas 
échéant) et vous demande l'opération à effectuer. 
Si certains fichiers ne peuvent pas être lus, 
reportez-vous à la section « Fichiers de 
transfert » à la page 313.

2 Sélectionnez l'une des commandes suivantes :

• Skip All, ou appuyez sur Ctrl+S (Windows) 
ou Commande+S (Mac).

• Manually Find Relink, ou appuyez sur Ctrl+M 
(Windows) ou Commande+M (Mac).

• Automatically Find Relink, ou appuyez sur 
Ctrl+A (Windows) ou Commande+A (Mac).

3 Sélectionnez Regenerate Missing Rendered 

Files Without Searching pour exclure les 
fichiers Elastic Audio rendus du processus de 
rétablissement des liens et en générer de 
nouveaux.

4 Cliquez sur OK.

Skip All

L'option Skip All permet d'ignorer tous les fichiers 
manquants. Il s'agit de la méthode la plus rapide 
pour ouvrir une session en utilisant tous les médias 
disponibles. Les fichiers manquants sont hors ligne 
dans la session et s'affichent en italique dans la 
liste des clips et le navigateur de l'espace de travail. 

Manually Find and Relink

Cette option ouvre la fenêtre Relink. Utilisez la 
fenêtre Relink pour rechercher, comparer, vérifier 
et relier des fichiers manquants. Les fichiers 
peuvent être liés un à un ou par lot. Pour plus 
d'informations, reportez-vous à la section 
« Fenêtre Relink » à la page 316. 

Automatically Find and Relink

L'option Automatically Find and Relink représente 
la méthode la plus simple pour rétablir les liens 
entre une session et les fichiers requis, mais elle ne 
permet pas de comparer les fichiers, ni de vérifier 
les liens. Cette option ne peut pas être annulée. 
L'option Automatically Find and Relink fonctionne 
de la manière suivante : 

• Elle cherche les fichiers manquants (par nom, 
ID, format et taille) sur tous les volumes de 
performance disponibles.

• Elle établit un lien avec les premiers fichiers 
correspondant aux critères de la recherche.

• Elle confirme les liens avec tous les fichiers 
trouvés en arrière-plan.

Les liens, une fois validés, ne pourront être 
rompus une fois la session sauvegardée. 
La seule manière de rétablir les liens 
précédents consiste à fermer la session sans 
la sauvegarder. 
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Si certains fichiers n'ont pu être liés, la fenêtre de 
tâches apparaît et affiche un message d'échec dans 
le volet Paused Tasks (tâches suspendues). 
Double-cliquez sur l'icône de tâche pour ouvrir la 
fenêtre Relink, puis trouvez les fichiers et 
rétablissez les liens manuellement.

Regenerate Missing Rendered Files Without 
Searching

Activez cette option si vous souhaitez exclure les 
fichiers Elastic Audio rendus du processus de 
rétablissement des liens (les fichiers rendus sont 
alors recalculés). Cette option est disponible 
lorsque vous activez l'option Automatically Find 

and Relink ou Manually Find and Relink. 

Le message d'échec reste dans la fenêtre de 
tâches, même après avoir retrouvé et rétabli 
les liens des fichiers manquants. Comme tous 
les messages d'échec, celui-ci doit être 
supprimé manuellement. Reportez-vous à la 
section « À propos des tâches échouées » à la 
page 326. 
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Fenêtre Relink
La fenêtre Relink propose des outils permettant d'effectuer toutes les tâches de rétablissement de liens. 

Menu et barre d'outils : vous y trouverez le menu 
Relink, les presets d'affichage et les boutons 
permettant de rétablir les liens. L'état est affiché 
à l'extrémité droite.

Zones de recherche : permet de sélectionner les 
volumes sur lesquels porte la recherche des 
éléments manquants. 

Fichiers à relier : affiche les fichiers manquants.

Fichiers candidats : Répertorie les fichiers 
correspondant aux « critères de rétablissement de 
lien » définis pour un fichier manquant donné. 
Vous pouvez activer/désactiver l'icône de lien en 
regard du fichier candidat pour rétablir (ou 
supprimer) le lien du candidat proposé au fichier 
manquant sélectionné. 

La fenêtre Relink permet de contrôler chaque 
phase du processus de rétablissement de lien. 

Ouverture de la fenêtre Relink
Lorsque vous ouvrez une session comportant des 
fichiers manquants, utilisez l'option Manually Find 

and Relink pour ouvrir la fenêtre Relink. 

Vous pouvez également afficher la fenêtre Relink 
après l'ouverture de la session. 

Pour ouvrir la fenêtre Relink dans une session 
ouverte :

1 Dans le navigateur de l'espace de travail, 
sélectionnez l'élément à relier. 

2 Sélectionnez Relink Offline dans le menu du 
navigateur. 

Principaux éléments de la fenêtre Relink

Fichiers à relier

Fichiers candidats

Zones de recherche

Menu et barre d'outils
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Sélection des zones de recherche
Le volet des zones de recherche permet de 
sélectionner les volumes et dossiers dans lesquels 
vous souhaitez effectuer la recherche des fichiers 
manquants. Cela permet d'accélérer la procédure de 
rétablissement de lien en limitant le nombre de 
volumes ou de dossiers à rechercher. De plus, le fait 
d'exclure des dossiers d'une recherche permet 
également de rediriger une session ou un catalogue 
vers une copie plus appropriée d'un élément.

Pour sélectionner des volumes ou des dossiers 
à inclure ou exclure d'une recherche :

1 Configurez le volet des zones de recherche de 
sorte à afficher le volume, catalogue ou dossier 
adéquat. 

2 Cochez la case de chaque élément pour l'inclure 
ou l'exclure de la recherche. Lorsqu'un élément 
est coché, il est inclus dans la recherche. Tous 
les sous-dossiers de l'élément sont également 
cochés.

Rétablissement de liens entre 
un ou plusieurs fichiers
La fenêtre Relink permet de rétablir les liens de 
fichiers manquants individuellement ou de façon 
groupée. 

Rétablissement des liens de fichiers 
manquants individuels

Il est parfois préférable de rétablir les liens de 
fichiers individuels un par un afin de relier la 
session au fichier adéquat. C'est notamment le cas 
si plusieurs copies d'un fichier média sont en ligne 
ou lorsque vous voulez garder un contrôle 
maximal sur le processus de rétablissement de lien. 

Pour rétablir le lien d'un fichier manquant :

1 Configurez le volet des zones de recherche. 

2 Sélectionnez un fichier dans la liste Files to 
Relink. 

3 Cliquez sur Find All Candidates. 
Volumes sélectionnés à inclure dans la recherche

Commande Find All Candidates pour le 
rétablissement du lien d'un fichier manquant 
sélectionné
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Pro Tools parcourt les volumes sélectionnés et 
affiche tous les fichiers correspondant au nom de 
fichier ou à l'ID unique dans la liste des candidats. 
Des icônes de lien indiquent si un candidat est 
déjà lié.

4 Cliquez sur l'icône du lien à côté du candidat 
que vous souhaitez relier. Une icône de lien en 
regard d'un élément indique qu'il sera relié 
à l'élément actuellement sélectionné dans la 
liste Files to Relink.

5 Cliquez sur l'icône de lien en regard des autres 
candidats si vous souhaitez relier des fichiers 
manquants supplémentaires.

6 Cliquez sur le bouton Commit Links.

Rétablissement simultané des liens de 
plusieurs fichiers manquants 

Le bouton Find Links vous permet de relier 
plusieurs fichiers en une seule opération. 

Pour relier plusieurs fichiers manquants :

1 Configurez le volet des zones de recherche. 
Pour plus d'informations, reportez-vous à la 
section « Sélection des zones de recherche » à 
la page 317.

2 Sélectionnez un ou plusieurs éléments dans la 
liste Files to Relink. Le bouton Find Links 
devient disponible. 

3 Cliquez sur Find Links. 

4 Si nécessaire, configurez les critères de 
rétablissement de liens dans la boîte de dialogue 
Linking Options.

• L'option Find by Name and ID est activée par 
défaut.

• Pour ajouter des critères de recherche 
supplémentaires, sélectionnez une option dans la 
boîte de dialogue Linking Options (l'option 
Modification Date n'est disponible que pour les 
catalogues).

• Lorsque l'option Match Duration est activée, 
Pro Tools sélectionne uniquement les fichiers de 
durée équivalente ou supérieure. 

Les clips vidéo OMF peuvent uniquement 
être reliés à une session s'ils disposent d'ID 
uniques correspondants.

Les clips vidéo QuickTime peuvent 
uniquement être reliés à une session par nom 
et format de fichier (QuickTime).

Pour contrôler les critères de correspondance 
et de lien lorsque vous rétablissez le lien d'un 
fichier manquant individuel, utilisez le bouton 
Find Links. Le bouton Find Links est décrit 
dans la section « Rétablissement simultané des 
liens de plusieurs fichiers manquants » à la 
page 318.

Icône de lien indiquant l'état de fichier lié

Options de liaison
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5 Cliquez sur OK pour continuer (ou sur Cancel 
pour revenir à la fenêtre Relink). 

Pro Tools recherche un candidat acceptable pour le 
premier fichier manquant (le premier élément 
sélectionné dans la liste Files to Relink). Une icône 
de lien apparaît à côté de chaque fichier lorsque 
Pro Tools trouve et relie le premier candidat 
acceptable au fichier manquant. La colonne Link 
Path affiche l'emplacement du candidat sélectionné. 
Pro Tools continue à faire des recherches, établir 
des correspondances et créer des liens pour chaque 
fichier manquant de la liste Files to Relink. 

6 Pour afficher un candidat d'un fichier manquant, 
mettez en surbrillance le fichier manquant. Le 
candidat pour ce fichier apparaît dans le volet 
Candidates, où s'affichent les informations et la 
forme d'onde.

7 Si les candidats proposés pour un fichier 
manquant particulier ne vous conviennent pas, 
vous pouvez cliquer sur Find All Candidates 
pour le fichier sélectionné (reportez-vous à la 
section « Rétablissement des liens de fichiers 
manquants individuels » à la page 317). 

Rétablissement forcé des liens 
des fichiers
Si vous souhaitez établir un lien vers un fichier de 
substitution (contenant par exemple les mêmes 
données audio ou vidéo, mais n'ayant pas le même 
nom ou ID unique), vous pouvez forcer un 
rétablissement de lien.

 Pour forcer le rétablissement de lien d'un fichier 
audio, son format (WAV, AIFF ou MXF), 
sa fréquence d'échantillonnage et sa résolution 
doivent correspondre à ceux du fichier d'origine.

 Pour forcer un rétablissement de lien à un 
fichier vidéo, son format (QuickTime, Avid, MXF 
ou OMF) et sa cadence d'images doivent 
correspondre à ceux du fichier d'origine.

Pour forcer un rétablissement de lien :

1 Sélectionnez les fichiers à relier. 

2 Sélectionnez Relink Offline dans le menu du 
navigateur. 

3 Dans la fenêtre Relink, sélectionnez un élément 
dans la liste Files to Relink. 

4 Naviguez dans le volet des zones de recherche 
pour localiser le fichier à relier.

5 Faites glisser le fichier dans le volet Candidates 
de la fenêtre Relink.

6 Cliquez sur l'icône Link à côté du fichier que 
vous avez déposé dans le volet Candidates. 

7 Cliquez sur le bouton Commit Links.

Validation des liens
Il est impossible d'annuler la validation d'un lien. 
Une fois que vous avez relié un fichier et 
sauvegardé la session, celle-ci conserve le nouveau 
lien en mémoire (le lien d'origine est ignoré). C'est 
pourquoi vous devez confirmer le lien avec 
l'option Commit Links. 

L'option Automatically Find and Relink est le 
seul processus de liaison qui ne vous demande 
pas de vérifier les liens avant de les 
enregistrer. Si vous utilisez cette option mais 
que le résultat ne vous satisfait pas, refermez 
la session sans la sauvegarder pour annuler 
les nouveaux liens. 
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Pour valider des liens :

1 Établissez des liens entre les fichiers en utilisant 
la fenêtre Relink, comme décrit dans la section 
« Rétablissement de liens entre un ou plusieurs 
fichiers » à la page 317. 

2 Cliquez sur Commit. Une demande de 
confirmation apparaît. 

3 Effectuez l'une des opérations suivantes :

• Cliquez sur Yes pour valider les liens. 

• Cliquez sur No pour annuler l'opération sans 
modifier les fichiers. 

Rétablissement de liens et alias 
dans les catalogues
Les catalogues correspondent à des compilations 
d'alias ou de raccourcis vers des fichiers réels. Si 
vous déplacez les fichiers, un élément d'un 
catalogue peut perdre son lien avec son fichier de 
référence. 

Pour rétablir les liens d'un catalogue :

1 Ouvrez le catalogue. 

2 Sélectionnez des éléments à relier. 

3 Sélectionnez Relink Selected dans le menu du 
navigateur de cette fenêtre de catalogue.

Catalogues
Les catalogues sont similaires à un dossier de 
fichiers favoris. Ils permettent de rassembler et 
d'organiser des éléments fréquemment utilisés, 
quel que soit leur emplacement. Un catalogue n'est 
autre qu'un dossier ne contenant que des alias 
(renvois) ou des raccourcis. Lorsque vous placez 
un fichier dans un catalogue, vous n'effectuez pas 
de copie ni ne modifiez l'emplacement de stockage 
de ce fichier. Il s'agit plutôt d'un renvoi (alias) à ce 
fichier vous permettant de manipuler ce dernier 
sans avoir besoin de connaître son emplacement 
physique. 

Création de catalogues
Vous pouvez ajouter de nouveaux catalogues vides 
à l'espace de travail ou sélectionner des fichiers au 
préalable et créer un catalogue basé sur votre 
sélection. 

Pour créer un catalogue vide :

1 Ouvrez un navigateur de l'espace de travail. 

2 Sélectionnez New Catalog dans le menu du 
navigateur. 

3 Saisissez un nom unique et cliquez sur OK. 

Pour créer un catalogue à partir de plusieurs 
fichiers : 

1 Ouvrez un navigateur de l'espace de travail. 

2 Sélectionnez les éléments que vous souhaitez 
inclure dans le nouveau catalogue. 

3 Sélectionnez Create Catalog from Selection 
dans le menu du navigateur. 

Une nouvelle base de données de catalogue déjà 
indexée est créée à partir des éléments 
sélectionnés. 
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Création de catalogues de dossiers

Pour créer un catalogue à partir du contenu d'un 
dossier : 

1 Ouvrez le navigateur de l'espace de travail s'il 
n'est pas ouvert. 

2 Faites glisser un dossier sur l'icône de catalogue 
dans le navigateur de l'espace de travail. 

Pro Tools indexe le dossier et crée ensuite un 
catalogue indexé qui prend le nom de ce dossier.

Attribution d'un nouveau nom 
à un catalogue
Vous pouvez renommer un catalogue à n'importe 
quel moment. 

Pour renommer un catalogue :

1 Cliquez sur l'icône du catalogue dans l'espace 
de travail jusqu'à ce que son nom apparaisse en 
surbrillance. 

2 Saisissez le nouveau nom du catalogue. 

Modification des catalogues

Pour ajouter des éléments à un catalogue, 
effectuez l'une des opérations suivantes :

 Ouvrez le catalogue et faites glisser les fichiers 
souhaités à partir d'un autre navigateur de 
l'espace de travail. 

 Cliquez sur l'icône principale Catalogs dans 
l'espace de travail pour pouvoir visionner tous 
les catalogues disponibles, puis faites glisser les 
fichiers voulus. 

Pour ajouter un dossier à un catalogue :

1 Ouvrez le catalogue.

2 Sélectionnez New Folder dans le menu du 
navigateur. 

Suppression d'éléments de 
catalogue
Lorsque vous supprimez un dossier ou un élément 
d'un catalogue, Pro Tools permet de spécifier si la 
suppression porte uniquement sur les alias du 
catalogue ou également sur les fichiers d'origine 
du disque. 

Pour supprimer un élément d'un catalogue : 

1 Sélectionnez un catalogue dans le volet 
Locations.

2 Dans le volet de navigation, sélectionnez un ou 
plusieurs éléments à supprimer du catalogue.

3 Sélectionnez Remove Selected Items dans le 
menu du navigateur.

4 Lorsque le système vous y invite, effectuez 
l'une des opérations suivantes : 

• Pour supprimer les alias des éléments 
sélectionnés du catalogue, cliquez sur Remove. 

• Pour supprimer les éléments sélectionnés du 
disque (ainsi que leurs alias du catalogue), 
cliquez sur Move To Trash (Mac) ou Move To 

Recycle Bin (Windows).

Consolidation de fichiers avec 
les catalogues
Les catalogues sont d'excellents outils pour 
consolider des fichiers provenant de plusieurs 
sources. 

Par exemple, créez un catalogue intitulé Bruits et 
placez-y des fichiers provenant de trois volumes 
différents. Faites ensuite glisser le catalogue du 
navigateur de l'espace de travail vers un autre 
volume pour créer un dossier Bruits sur ce volume. 
Tous les fichiers référencés par le catalogue sont 
automatiquement copiés dans le volume. Les 
dossiers et sous-dossiers (le cas échéant) ainsi que 
leur contenu sont également copiés. 
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Mise à jour de catalogues
Comme une base de données de catalogue n'est 
liée à aucun volume spécifique, la commande 
Update Index est soumise à certaines limitations. 
Lorsque vous sélectionnez la commande Update 

Index for Selected dans le menu du navigateur d'un 
catalogue, Pro Tools cherche les éléments 
représentés par des alias dans le catalogue et met 
à jour les informations suivantes :

Métadonnées : les métadonnées de tous les 
fichiers trouvés en ligne, y compris les 
commentaires de fichier, sont mis à jour.

Commentaires de base de données : les 
commentaires de base de données ne sont pas mis 
à jour puisqu'ils ne s'appliquent qu'au catalogue en 
question et ne font donc pas partie des 
métadonnées du fichier.

Rétablissement des liens des 
éléments d'un catalogue
Si des fichiers apparaissent comme manquants dans 
un catalogue, utilisez la fenêtre Relink pour les 
retrouver, copier et relier. Pour plus d'informations, 
reportez-vous à la section « Création et 
rétablissement de liens vers des fichiers » à la 
page 312. 

Suppression de catalogues

Pour supprimer un catalogue :

1 Sélectionnez un catalogue dans le volet 
Locations.

2 Sélectionnez le catalogue dans le volet de 
navigation.

3 Sélectionnez Remove Selected Items dans le 
menu du navigateur. Une boîte de dialogue 
d'avertissement s'affiche.

4 Dans la boîte de dialogue d'avertissement, 
effectuez l'une des opérations suivantes :

• Cliquez sur Cancel pour annuler l'opération de 
suppression.

• Cliquez sur Move to Trash (Mac) ou Move to 

Recycle Bin (Windows) pour supprimer les alias 
et les fichiers associés du disque.

• Cliquez sur Remove pour supprimer uniquement 
les alias et conserver les fichiers associés.

Une fois effectuée, cette suppression ne peut être 
annulée. 

Importation d'éléments de 
catalogue
Il est possible d'importer des éléments en ligne ou 
hors ligne d'un catalogue dans la session actuelle. 

Importation d'éléments en ligne à partir 
d'un catalogue

Le glisser-déposer de fichiers audio dans la liste 
des clips et la timeline de Pro Tools s'effectue de la 
même manière qu'à partir des navigateurs de 
l'espace de travail. 

Importation d'éléments hors ligne 
à partir d'un catalogue

Les catalogues permettent également de chercher et 
d'importer des fichiers hors ligne. Si, par exemple, 
vous disposez d'un extrait musical stocké sur un 
CD-ROM ou sur un volume non monté, vous 
pouvez faire glisser le fichier en question du 
catalogue vers la timeline d'une session. Le fichier 
est automatiquement importé dans la session lors 
du montage du volume. 

La première étape consiste à ajouter des fichiers 
à un catalogue (les fichiers doivent être en ligne). 
Une fois l'ajout à un catalogue effectué, les éléments 
sont affichés en italique s'ils passent hors ligne. 

Pour plus d'informations, reportez-vous à la 
section « Importation de fichiers par glisser-
déposer » à la page 333. 
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Les fichiers hors ligne peuvent être déposés depuis 
un catalogue sur la timeline d'une session comme 
des fichiers en ligne. Une boîte de dialogue 
s'affiche, vous demandant si vous souhaitez ou non 
rétablir un lien avec le fichier. Cliquez sur Skip All 
pour charger tous les éléments en tant que fichiers 
hors ligne (les clips correspondants apparaissent 
en bleu clair dans la timeline). 

Chaque fois que vous montez un volume contenant 
des fichiers hors ligne, Pro Tools importe 
automatiquement les fichiers en arrière-plan. Ceci 
se produit même si vous avez enregistré la session, 
quitté ou relancé Pro Tools. 

Dès que les éléments ont été importés, 
ils apparaissent comme éléments en ligne dans 
la timeline, la liste des clips et le navigateur de 
l'espace de travail. 

Si les éléments hors ligne utilisent la même 
fréquence d'échantillonnage, la même résolution et 
le même format de fichier que la session, aucune 
conversion n'est nécessaire. Tant que le volume est 
adapté pour la lecture, les éléments peuvent être 
lus dans la session dès que le volume est monté. 

Si le volume n'est pas adapté pour la lecture, vous 
êtes invité à copier les fichiers requis vers des 
volumes appropriés. 

Pour plus d'informations sur le transfert de 
fichiers, les fichiers manquants et le 
rétablissement de liens, reportez-vous à la 
section « Fenêtre Relink » à la page 316.
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Fenêtre du gestionnaire de tâches
Pour accroître la flexibilité et la performance des opérations de gestion des fichiers, Pro Tools propose une 
fenêtre du gestionnaire des tâches. La gestion de fichiers dans Pro Tools implique la création, la copie, 
la conversion, le traitement, la recherche et l'indexation de fichiers de façon quasi permanente. Ces tâches 
sont exécutées en arrière-plan et ne retardent pas les processus d'enregistrement, de montage et de mixage 
en cours. 

La fenêtre de tâches permet de contrôler, d'interrompre ou d'annuler les tâches en cours (telles que la copie 
de fichiers, la régénération de fondus et l'indexation). 

Ouverture de la fenêtre de 
tâches

Pour ouvrir la fenêtre de tâches :

 Dans Pro Tools, sélectionnez Window > Task 

Manager.

Messages de la fenêtre de 
tâches
Lorsqu'une tâche ne peut pas être exécutée en 
arrière-plan, la fenêtre de tâches passe au premier 
plan et vous informe de l'erreur. La tâche 
incomplète apparaît alors dans le volet des tâches 
suspendues de la fenêtre de tâches. 

La fenêtre de tâches étant une fenêtre flottante, elle 
n'entravera en aucun cas l'opération en cours. Vous 
pouvez donc poursuivre l'enregistrement et 
l'édition, et repousser la gestion des fichiers à un 
moment plus approprié.

Fenêtre Tasks en affichage maximum

Tâches
suspendues

Tâches
actives

Basculement de l'affichage (maximum/minimum)

État

Appuyez sur Alt+' (Windows) ou Option+' 
(Mac) pour ouvrir le navigateur de l'espace 
de travail.



Chapitre 16 : Navigateurs de l'espace de travail 325

Affichages de la fenêtre de 
tâches
La fenêtre de tâches propose un affichage 
maximum et minimum.

Pour alterner entre les deux types d'affichage :

 Cliquez sur l'icône de basculement de vue, 
située en haut de la fenêtre de tâches. 

Outils, colonnes et volets de la 
fenêtre de tâches
Le menu de la fenêtre de tâches fournit des 
commandes pour les opérations disponibles dans 
cette fenêtre.

Les données suivantes sont toujours visibles dans 
la fenêtre de tâches (pour les deux affichages) :

Name : indique l'élément concerné, qu'il s'agisse 
d'un fichier, d'une base de données ou de tout autre 
élément pris en charge.

Status : correspond à l'action en cours (copie, 
traitement, indexation, etc.).

Progress : spécifie l'état d'avancement de la tâche 
ou de ses tâches secondaires, ce qui inclut l'analyse 
de la taille des fichiers et la durée approximative 
requise pour compléter la tâche. 

Indicateur de progression : indique que le 
traitement est en cours. 

Quantification : indique, en pourcentage, l'état 
d'avancement de la tâche en cours.

Volet des tâches actives

La partie supérieure de la fenêtre de tâches affiche 
les tâches en cours et celles en attente de traitement. 
La tâche en cours d'exécution se trouve tout en haut 
de la liste. Toutes les tâches apparaissant dans ce 
volet seront exécutées. 

Les tâches exécutées disparaissent de la file d'attente.

Les tâches ne pouvant pas être exécutées sont 
transférées dans le volet des tâches suspendues 
(voir ci-dessous). La colonne Status contient une 
description de l'erreur.

Volet des tâches suspendues

Le volet des tâches suspendues se trouve sous le volet 
des tâches actives, sous une barre de séparation 
mobile. Les tâches répertoriées dans ce volet ne 
seront exécutées qu'une fois déplacées dans le volet 
des tâches actives. 

Suspension et annulation de 
tâches
La fenêtre de tâches permet de suspendre, 
de reprendre et d'annuler des tâches. 

Pour suspendre une tâche :

 Faites glisser la tâche du volet des tâches actives 
dans le volet des tâches suspendues. 

Pour suspendre toutes les tâches :

 Sélectionnez Pause All dans le menu de la 
fenêtre de tâches.

Pour reprendre une tâche :

 Faites glisser la tâche depuis le volet des tâches 
suspendues dans le volet des tâches actives. 
La tâche retrouve alors sa place originale dans 
la liste d'attente. 

Fenêtre Tasks en affichage minimum
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Pour reprendre toutes les tâches :

 Sélectionnez Resume All dans le menu de la 
fenêtre de tâches. Toutes les tâches du volet des 
tâches suspendues (sauf les tâches échouées) 
sont déplacées dans le volet des tâches actives. 

Pour annuler une tâche :

1 Sélectionnez la tâche dans l'un des deux volets 
de la fenêtre de tâches.

2 Appuyez sur la touche Suppr pour la supprimer 
de la fenêtre de tâches. 

Pour annuler toutes les tâches :

1 Sélectionnez n'importe quelle tâche dans l'un 
des deux volets de la fenêtre. 

2 Appuyez sur Ctrl+A (Windows) ou 
Commande+A (Mac) pour sélectionner toutes 
les tâches dans ce volet.

3 Appuyez sur la touche Suppr.

Cette commande ne peut pas être annulée.

À propos de l'annulation des tâches

Certaines tâches se composent de plusieurs sous-
tâches. Lorsque vous supprimez une tâche, les 
sous-tâches déjà exécutées ne sont pas annulées. 
Par exemple, si l'importation et la conversion de 
plusieurs fichiers apparaissent comme une tâche 
unique, la suppression de cette tâche avant qu'elle 
ne soit complétée interrompt le processus 
d'importation et de conversion. Les fichiers déjà 
convertis et importés restent cependant sur le 
disque dur. Si vous souhaitez annuler une tâche 
comprenant plusieurs sous-tâches, il est préférable 
d'attendre la fin de l'opération et d'utiliser Undo 
pour annuler toutes les sous-tâches, si possible. 

Fermeture de sessions avec des 
tâches en attente
Si vous fermez une session ou quittez Pro Tools 
alors qu'il reste encore des tâches à exécuter 
(dans le volet des tâches actives ou des tâches 
suspendues de la fenêtre de tâches), Pro Tools 
vous demande si vous souhaitez annuler les tâches 
restantes ou les exécuter. Vous pouvez alors 
ouvrir la fenêtre de tâches et attendre la fin des 
opérations, annuler les tâches en attente ou quitter 
la fenêtre. Si vous fermez la session, certaines 
tâches sont annulées. Les tâches comportant la 
copie de fichiers sont cependant mémorisées et 
relancées au prochain lancement de Pro Tools. 

À propos des tâches échouées

Le volet des tâches suspendues contient une liste 
de toutes les tâches qui n'ont pas pu être exécutées. 
La raison de cet échec apparaît dans la colonne 
Status. 

Une tâche ayant échoué ne peut pas être reprise 
et doit être supprimée manuellement du volet des 
tâches suspendues. 

Lorsque la commande Automatically Find and 

Relink ne parvient pas à trouver tous les fichiers 
d'une session, une tâche échouée apparaît dans le 
volet des tâches suspendues de la fenêtre de tâches. 
Elle reste dans ce volet jusqu'à ce que vous la 
supprimiez (même si vous êtes parvenu à retrouver 
les fichiers ultérieurement au cours d'une nouvelle 
opération de recherche et de liaison). 

Priorité des tâches
Une tâche en cours peut être interrompue par une 
autre tâche ayant priorité sur la première. Dans ce 
cas, la tâche interrompue est exécutée plus tard et 
une barre de progression dans le volet des tâches 
actives indique à quel moment la tâche a été 
interrompue. Une fois la tâche prioritaire terminée, 
la première tâche inachevée est reprise.
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Suspension de tâches en cours 
de lecture 
Le menu du navigateur de la fenêtre de tâches 
propose la préférence globale Pause During 

Playback. Lorsque cette option est activée, 
les tâches actives sont suspendues pendant la 
lecture (ou l'enregistrement) de Pro Tools. 
Ce paramètre est surtout conseillé pour des 
processeurs plutôt lents ou pour éviter qu'une 
surcharge du système ne ralentisse les opérations 
d'enregistrement ou de lecture. Ce paramètre 
reste dans cet état jusqu'à ce qu'il soit modifié. 

Tâches sauvegardées
Une tâche qui importe des fichiers dans une 
session est sauvegardée avec la session lors de sa 
fermeture. Elle reprend dès que vous ouvrez 
à nouveau cette session. Par exemple, si vous 
importez des données de la session (boîte de 
dialogue Import Session Data) en sélectionnant 
l'option Copy From Source Media, puis que vous 
enregistrez (Save) et fermez (Close) la session 
avant la fin de la copie, les tâches de copie 
reprendront lors de la prochaine ouverture de la 
session. 

Tâches groupées
Certaines tâches englobent plusieurs tâches 
auxiliaires. Ainsi, la commande Copy and Relink 
peut nécessiter la copie de plusieurs centaines de 
fichiers. Afin de faciliter la gestion de ce type de 
tâches, celles-ci sont regroupées selon l'action 
qu'elles effectuent. Dans le cas d'une commande 
Copy and Relink, une seule tâche de copie apparaît 
avec une icône Développer/réduire dans la fenêtre 
de tâches. En cliquant sur cette icône, vous 
affichez la liste des sous-tâches impliquées.

Si la liste contient plusieurs tâches groupées, 
les sous-tâches du deuxième groupe ne sont 
traitées qu'une fois toutes les sous-tâches du 
groupe précédent exécutées.

Si vous enregistrez et fermez une session dont 
plusieurs tâches groupées se trouvent dans la file 
d'attente, et s'il s'agit de tâches pouvant être 
interrompues et enregistrées à la fermeture de la 
session, elles sont affichées comme membres du 
même groupe à la prochaine ouverture de session. 
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Chapitre 17 : Importation et exportation de 
données de session

Pro Tools permet d'importer et exporter différents 
types de données de session, notamment des 
fichiers audio et MIDI, des groupes de clips, 
des fichiers vidéo, des playlists de piste, des 
configurations d'E/S et de routing des signaux.

Vous pouvez importer individuellement des 
fichiers audio et MIDI dans une session ou 
importer intégralement des pistes audio ou MIDI 
issues d'une autre session, ainsi que leurs attributs. 
En outre, avec Pro Tools HD, vous pouvez choisir 
précisément les attributs de piste à importer à partir 
d'une autre session : playlists audio ou MIDI, 
routing des signaux, plug-ins, attributs 
d'automation, etc. (reportez-vous à la section 
« Importation de données de session » à la 
page 352). 

Lorsque vous travaillez avec de la vidéo, vous 
pouvez importer et exporter des fichiers vidéo 
à partir d'une session (reportez-vous au 
Chapitre 52, « Utilisation de la vidéo dans 
Pro Tools »). 

Importation et exportation 
de données de session
Importation

Pro Tools permet d'importer des données audio, 
vidéo ou MIDI, des groupes de clips ou des fichiers 
de session dans la session Pro Tools actuelle 
à l'aide de différentes méthodes :

• Glisser-déposer à partir : 

• d'un navigateur de l'espace de travail ;

• du Finder Mac ou de l'Explorateur Windows.

• Utilisation des commandes d'importation du 
menu File :

• Session Data

• Audio

• MIDI

• Video

• Clip Groups

• VENUE Channel Names as Track Names

Les données de session, les fichiers audio et les clips 
peuvent être importés sur des pistes existantes, 
sur de nouvelles pistes, dans la liste des pistes ou 
dans la liste des clips d'une session Pro Tools.
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Exportation

Pro Tools permet d'exporter des données audio, 
vidéo ou MIDI, ainsi que des groupes de clips et 
des données de session à l'aide de différentes 
méthodes :

• Commande Export to Sibelius ou Send to 

Sibelius (MIDI uniquement)

• Commandes d'exportation du menu File :

• Selected Tracks as New AAF/OMF 

• Selected Tracks as New Session

• MIDI 

• Sibelius 

• Session Info As Text 

• Menu contextuel des pistes :

• Commande Send To Sibelius (éditeur de 
partition uniquement)

• Commande Export MIDI

• Menu de la liste des clips :

• Commande Export Clip Definitions

• Commande Export Clips as Files

• Commande Export Clip Groups

Conversion audio lors de 
l'importation
En fonction des propriétés des fichiers audio que 
vous importez, vous pouvez les ajouter, les copier 
ou les convertir :

 Lorsque vous ajoutez des fichiers à une session 
Pro Tools, ils demeurent à leur emplacement 
d'origine sur le disque dur et ne sont ni déplacés, 
ni copiés. La session référence les fichiers d'origine, 
quel que soit leur emplacement sur le système. 
De plus, les fichiers référencés par la session 
conservent leur format, fréquence d'échantillonnage 
et résolution d'origine.

 Lorsque vous copiez des fichiers dans la session, 
les fichiers d'origine demeurent à leur emplacement 
sur le système, mais ils sont également copiés dans 
le dossier Audio Files de la session avant d'être 
ajoutés à la session. Dans ce cas, la session référence 
les fichiers copiés et non les fichiers d'origine. 
De plus, les fichiers copiés référencés par la session 
conservent leur format, fréquence d'échantillonnage 
et résolution d'origine.

 Lorsque vous convertissez des fichiers dans la 
session, les fichiers d'origine demeurent à leur 
emplacement sur le système, mais ils sont 
également copiés dans le dossier Audio Files de la 
session et convertis au format, à la fréquence 
d'échantillonnage et à la résolution de la session. 
Dans ce cas, la session référence les fichiers 
convertis et non les fichiers d'origine. 
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Fichiers pouvant être ajoutés à une session 
sans conversion

Vous pouvez ajouter n'importe quel type de fichier 
audio à une session sans conversion, tant que son 
format (WAV et AIFF) et sa résolution (16, 24, 
et 32 bits virgule flottante) sont pris en charge. 
Vous pouvez ajouter sans les convertir des fichiers 
audio avec une fréquence d'échantillonnage 
différente de celle de la session, mais ces fichiers 
seront lus à une hauteur et à une vitesse différentes 
de celles des fichiers ayant la même fréquence 
d'échantillonnage que la session.

Fichiers devant être convertis lors de 
l'importation

Tout autre format de fichier audio que WAV et 
AIFF doit être converti lors d'une importation. 
Pro Tools convertit automatiquement ces fichiers 
au format de fichier actuel de la session pendant 
l'importation. Si la session n'est pas compatible 
avec les fichiers entrelacés, Pro Tools divise les 
fichiers audio entrelacés en plusieurs fichiers 
mono pendant l'importation.

Si des définitions de clips sont présentes dans un 
fichier audio, vous pouvez convertir et importer les 
données audio d'un clip sans importer l'ensemble 
du fichier audio parent en utilisant la commande 
Import Audio.

Formats de fichiers audio pris 
en charge
Vous pouvez importer sans conversion les fichiers 
audio des types suivants dans les sessions Pro Tools :

• AIFF

• WAV ou BWF (.WAV) (prise en charge des 
formats WAV Extensible et RF64 comprise)

Les fichiers audio des types suivants peuvent être 
importés dans les sessions Pro Tools, mais ils 
seront convertis au format de fichier de session 
actuel pendant l'importation :

• Audio AAC (y compris audio avec extension de 
fichier AAC, Mp4 ou M4a)

• Fichiers ACID

• MP3

• Audio MXF

• QuickTime (Mac uniquement)

• Fichiers ReCycle (REX 1 et 2)

• SD II

• SD I

• Sound Resource (AIFL - Mac uniquement)

Vous pouvez activer l'option Automatically 
Copy Files on Import dans la page des 
préférences de traitement afin que les fichiers 
soient systématiquement copiés dans le dossier 
Audio Files de la session lorsque vous importez 
des données audio par glisser-déposer.

Pro Tools version 7.x ou supérieure ne prend 
pas en charge les noms de fichier audio 
contenant certains caractères ASCII 
(reportez-vous à la section « Ouverture d'une 
session contenant des noms de fichier audio 
avec des caractères interdits » à la page 395).

Pro Tools n'est pas en mesure d'importer des 
fichiers AAC ou MP4 protégés avec l'extension 
.M4p. Ces fichiers sont protégés par des droits 
en matière de propriété numérique.
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Sample Rate Conversion Quality
Le paramètre Sample Rate Conversion Quality 
détermine la qualité de la conversion de fréquence 
d'échantillonnage utilisée pour la conversion et 
l'importation d'audio dans une session. 
Ce paramètre est également pris en compte lors de 
l'exportation de fichiers à une autre fréquence 
d'échantillonnage et lors du bounce de données 
audio sur le disque. Cinq qualités de conversion sont 
disponibles, classées par ordre croissant de Low 
(conversion rapide, mais qualité faible) à Tweak 
Head (qualité très élevée, mais conversion lente). 
Plus la qualité de la conversion de la fréquence 
d'échantillonnage choisie est élevée, plus le 
traitement du fichier audio dans Pro Tools est long.

L'option Sample Rate Conversion Quality est 
disponible dans les boîtes de dialogue Import 
Audio, Import Session Data, Export Clips as Files 
et Bounce to Disk. Les paramètres Sample Rate 
Conversion Quality de ces différentes boîtes de 
dialogue sont indépendants les uns des autres. 
La préférence Sample Rate Conversion Quality 
s'applique uniquement aux conversions réalisées 
lors d'une importation par glisser-déposer.

Pour définir la qualité de la conversion de 
fréquence d'échantillonnage utilisée lors de 
l'importation de données audio par glisser-
déposer :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Dans le menu déroulant Sample Rate 
Conversion Quality, sélectionnez la qualité. 
Pour la plupart des applications, les qualités 
Good (bonne) ou Better (meilleure) donneront 
de très bons résultats.

3 Cliquez sur OK.

Conversion de la résolution et 
dithering
Si la préférence Convert Copied Files on Import est 
activée (Setup > Preferences > Processing), 
les événements suivants se produisent lorsque vous 
importez des fichiers audio avec une résolution 
différente de celle de la session actuelle :

• Lors de l'importation de données audio dont la 
résolution est inférieure à celle de la session, Pro 
Tools convertit le fichier en y ajoutant des bits 
vides afin que sa résolution corresponde à celle 
de la session. Par exemple, lors de l'importation 
d'un fichier 16 bits dans une session 24 bits, Pro 
Tools convertit le fichier en 24 bits.

• Lors de l'importation de données audio dont la 
résolution est supérieure à celle de la session, 
Pro Tools applique automatiquement un preset 
de dithering avec mise en forme du bruit et 
convertit le fichier à la résolution de la session. 
Par exemple, lors de l'importation d'un fichier 
24 bits dans une session 16 bits, un dithering est 
automatiquement appliqué aux données audio et 
le fichier est converti en 16 bits.

Importation de fichiers 
entrelacés
Lorsque vous utilisez la commande Import Audio, 
les fichiers stéréo entrelacés sont automatiquement 
importés sur des pistes stéréo. Dans Pro Tools HD, 
les fichiers audio multicanal de format supérieur 
à stéréo sont automatiquement importés sur des 
pistes du même format multicanal. 

Si l'option Interleaved est activée pour la session 
ou pendant l'importation, les fichiers entrelacés 
sont importés dans la session et conservent leur 
format entrelacé. Si cette option n'est pas activée, 
les fichiers entrelacés sont divisés en plusieurs 
fichiers mono.

Les boîtes de dialogue Import Audio, Import 
Session Data et Bounce To Disk disposent de 
leur propre réglage de qualité de conversion.
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Inversement, les fichiers audio stéréo scindés (double 
mono) peuvent être importés automatiquement sur 
des pistes stéréo. Les fichiers de ce type doivent 
inclure dans leurs noms les identificateurs de canal 
« .L » et « .R » (par exemple, nomfichier.L et 
nomfichier.R) et les fichiers doivent être de 
même longueur. Sous Windows ou en mode de 
compatibilité Mac/PC, ces fichiers portent une 
extension de trois lettres ajoutée après l'identificateur 
de canal « .L » ou « .R ».

Importation de fichiers par 
glisser-déposer
Pro Tools permet d'importer des fichiers audio, 
MIDI, vidéo et de session en faisant glisser les 
fichiers à partir d'un navigateur de l'espace de 
travail, de l'Explorateur Windows ou du Finder 
Mac et en les déposant sur l'icône de l'application 
Pro Tools, sur la timeline de la session, sur une 
piste, dans la liste des pistes ou dans la liste des 
clips. 

L'illustration suivante présente certaines des 
options disponibles pour l'importation de fichiers 
par glisser-déposer à partir de navigateurs de 
l'espace de travail.

Pour importer des fichiers dans la liste des clips :

1 Sélectionnez des fichiers audio, vidéo, MIDI, 
REX, ACID ou des fichiers de groupe de clips 
dans un navigateur de l'espace de travail, 
l'Explorateur Windows ou le Finder Mac. 

2 Faites glisser les fichiers sélectionnés vers la 
liste des clips. 

Pour importer des fichiers sur une piste existante :

1 Sélectionnez les fichiers à importer dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

2 Faites glisser le fichier vers l'emplacement 
souhaité d'une piste existante compatible avec 
le format du fichier. Le fichier est importé et 
placé à l'endroit où il a été déposé. 

Pour importer des fichiers en créant de nouvelles 
pistes :

1 Sélectionnez les fichiers à importer dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et faites 
glisser le fichier vers la fenêtre Edit. 

• Déposez le fichier dans la liste des pistes.

• Déposez le fichier dans un espace vide de la 
fenêtre Edit, au-dessous ou entre des pistes. 

L'importation ne convertit ou ne copie pas 
toujours les fichiers audio. Reportez-vous à la 
section « Conversion audio lors de 
l'importation » à la page 330.

L'importation par glisser-déposer ne place 
pas nécessairement la fenêtre Edit au premier 
plan. Par exemple, lorsque vous faites glisser 
un fichier depuis un navigateur vers une piste, 
le navigateur source reste au premier plan 
(mais pas la fenêtre Edit). Vérifiez toujours 
quelle est la fenêtre active ou le navigateur 
actif au premier plan avant de continuer.
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Importation par glisser-déposer depuis l'espace de travail 

Espace de travail

Déposez les fichiers 
médias ou de session sur 
des pistes existantes ou 
sur la liste des pistes pour 
créer de nouvelles pistes Déposez les fichiers 

sur la liste des clips 
pour les importer 
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Pour importer des fichiers et les positionner sur 
une piste :

1 Activez le mode Spot. 

2 Sélectionnez les fichiers à importer dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

3 Faites glisser les fichiers vers une piste compatible 
existante. La boîte de dialogue Spot s'ouvre.

4 Saisissez l'emplacement de timecode souhaité 
(auquel vous souhaitez placer le fichier importé).

5 Cliquez sur OK.

Pour importer et placer un fichier audio en 
fonction de sa forme d'onde à partir d'un 
navigateur de l'espace de travail : 

1 Dans un navigateur de l'espace de travail, 
maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur la 
forme d'onde du fichier au point de référence 
approximatif sur lequel vous souhaitez placer le 
fichier dans une piste. 

2 Tout en maintenant la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée, faites glisser la 
forme d'onde vers une piste audio existante 
(le fichier audio source et la piste audio de 
destination doivent posséder le même nombre 
de canaux).

Alignement sur le début et la fin
Vous pouvez glisser-déposer des fichiers vers des 
pistes et faire en sorte qu'ils se calent sur le début 
ou la fin de la sélection d'édition ou sur un point 
d'insertion. Si vous sélectionnez un calage sur 
le début, le début du fichier importé sera 
automatiquement calé sur le début de la sélection 
d'édition. Si vous sélectionnez un calage sur la fin, 
la fin du fichier importé sera automatiquement 
calée sur le début de la sélection d'édition.

Pour une importation et un alignement sur le début 
d'un fichier :

 Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et faites glisser un fichier 
sur une piste. 

Pour caler le début du fichier et le copier dans le 
dossier Audio Files de la session :

 Maintenez les touches Alt+Démarrer (Windows) 
ou Option+Ctrl (Mac) enfoncées et faites glisser 
un fichier sur une piste. 

Pour un alignement sur la fin d'un fichier :

 Tout en maintenant les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées, faites glisser un fichier sur une piste. 

Pour caler la fin du fichier et le copier dans le 
dossier Audio files de la session : 

 Tout en maintenant les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées, 
faites glisser un fichier sur une piste. 
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Traitement Elastic Audio lors de 
l'importation
Lorsque vous importez un fichier audio par glisser-
déposer sur une piste Elastic Audio, le fichier est 
importé et analysé (s'il n'a pas encore été analysé). 
Si le fichier audio importé est basé sur les références 
de tempo, il est conformé au tempo à l'aide du plug-
in Elastic Audio de la piste. S'il s'agit d'un fichier 
audio basé sur les échantillons, tel qu'un son de 
batterie ou un effet sonore court, il conserve sa 
durée d'origine. Les fichiers audio de longue durée 
dont le tempo est difficile à déterminer restent basés 
sur les échantillons.

Vous pouvez également importer de l'audio par 
glisser-déposer pour créer des pistes Elastic Audio 
basées sur les références de tempo.

Lorsque vous importez de l'audio basé sur les 
références de tempo par glisser-déposer à partir 
d'un navigateur de l'espace de travail vers la liste 
des pistes ou un emplacement vide de la fenêtre 
Edit, Pro Tools crée une piste Elastic Audio basée 
sur les références de tempo et utilisant le plug-in 
Elastic Audio par défaut sélectionné dans les 
préférences de traitement (reportez-vous à la 
section « Options Elastic Audio » à la page 343).

Lorsque vous importez un fichier audio par glisser-
déposer à partir de l'Explorateur Windows ou du 
Finder Mac vers la liste des pistes ou un emplacement 
vide de la fenêtre Edit, les fichiers sont importés 
en tant que fichiers Elastic Audio basés sur les 
références de tempo ou les échantillons, selon la 
préférence Drag and Drop from Desktop Conforms 

to Session Tempo (reportez-vous à la section « Drag 
and Drop From Desktop Conforms to Session 
Tempo » à la page 343).

Importation Elastic Audio 
depuis l'espace de travail dans 
la liste des clips
Lorsque l'option Audio Files Conform to Session 

Tempo est activée, le fait de glisser-déposer de 
l'audio basé sur les références de tempo dans la 
liste des clips (ou la liste des pistes) à partir de 
navigateurs de l'espace de travail crée deux clips 
distincts dans la liste des clips. Le premier est un 
clip de fichier entier basé sur les échantillons, 
le second est une copie du même clip, basée sur les 
références de tempo.

Importation du tempo à partir 
d'audio basé sur les références 
de tempo
Si vous importez un fichier audio basé sur les 
références de tempo dans la liste des clips, la liste 
des pistes ou une zone vide de la fenêtre Edit d'une 
session qui ne contient aucune piste, un message 
vous demande si vous souhaitez importer le tempo 
du fichier ou conserver le tempo par défaut de la 
session. Pour conserver le tempo par défaut de la 
session et conformer la boucle au tempo de la 
session, cliquez sur Don't Import. 

Si la session contient au moins une piste (quel que 
soit le type de piste), aucun message ne s'affiche 
pour vous demander si vous souhaitez importer le 
tempo du fichier. Le fichier est automatiquement 
conformé au tempo de la session.
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Importation de fichiers et de 
clips audio à l'aide de la 
commande Import Audio
La commande Import Audio permet d'importer des 
fichiers et clips audio dans votre session Pro Tools.

Pour importer des fichiers ou des clips audio dans 
une session à l'aide de la commande Import 
Audio :

1 Sélectionnez File > Import > Audio. 

2 Dans la boîte de dialogue Import Audio, 
localisez et sélectionnez un fichier audio afin 
d'afficher ses propriétés et les clips associés.

Vous pouvez choisir de n'afficher qu'un seul type 
de fichier (WAV, par exemple) en le sélectionnant 
dans le menu déroulant Show. Pour afficher tous 
les types de fichiers pris en charge, sélectionnez All 

Documents dans le menu déroulant Show.

Dans la liste d'importation, les fichiers audio se 
distinguent des clips par leurs icônes.

3 Pour écouter un aperçu d'un fichier ou d'un clip 
avant de l'importer, sélectionnez le fichier ou le 
clip et cliquez sur les boutons de lecture et 
d'arrêt dans la boîte de dialogue Import Audio.

Pour ajuster le volume de l'aperçu, déplacez le 
curseur vertical. Pour accéder à un endroit 
particulier du fichier, déplacez le curseur horizontal 
qui se trouve juste au-dessous des boutons de lecture 
et d'arrêt. 

Le chemin de sortie pour l'écoute est défini par 
défaut sur les canaux 1 et 2. Sur les systèmes 
Pro Tools offrant plus de deux canaux de sortie, 
il est possible de modifier le chemin d'écoute dans 
la boîte de dialogue I/O Setup (reportez-vous à la 
section « Audition Paths » à la page 78).

4 Effectuez l'une des opérations suivantes :

• Pour ajouter un fichier ou un clip à la liste 
d'importation, sélectionnez le fichier puis 
cliquez sur Add ou Convert. 

• Pour importer tous les fichiers et clips présents 
dans le répertoire actuel, cliquez sur Add All ou 
Convert All. 

Pour importer des pistes entières depuis 
d'autres sessions, reportez-vous à la section 
« Importation de données de session » à la 
page 352.

Boîte de dialogue Import Audio

Icônes des fichiers et des clips dans la boîte de 
dialogue Import Audio

Sur Mac, les fichiers Sound Resource doivent 
porter l'extension .SFIL pour que Pro Tools 
puisse les importer. 

La commande de volume d'aperçu de la boîte de 
dialogue Import Audio détermine également le 
volume d'aperçu des clips dans la liste des clips.

Icône de fichier audio

Icône de clip audio
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• Pour supprimer un fichier ou un clip de la liste 
d'importation, sélectionnez cet élément et 
cliquez sur Remove. 

• Pour supprimer l'ensemble des fichiers et clips, 
cliquez sur Remove All.

5 Lorsque vous avez ajouté tous les fichiers et 
clips audio à la liste d'importation, vous pouvez 
convertir les fréquences d'échantillonnage en 
effectuant les opérations suivantes :

• Activez l'option Apply SRC.

• Spécifiez la fréquence d'échantillonnage source 
(Source Sample Rate) en saisissant sa valeur ou 
en sélectionnant une fréquence dans le menu 
déroulant.

• Sélectionnez la qualité de conversion de la 
fréquence d'échantillonnage dans le menu 
déroulant Quality. Ce paramètre prévaut sur le 
paramètre Sample Rate Conversion Quality des 
préférences de traitement.

6 Cliquez sur Done.

7 Si vous copiez ou convertissez des fichiers, 
sélectionnez un emplacement pour les 
nouveaux fichiers. Sélectionnez un dossier dans 
un lecteur audio valide, tel que le dossier Audio 
Files pour la session en cours. 

8 Dans la boîte de dialogue Audio Import Options, 
indiquez à quel emplacement de la session les 
fichiers importés doivent être placés :

New Track : chaque fichier audio est importé sur 
une piste individuelle et dans la liste des clips. 

Lorsque vous importez de l'audio sur une piste, vous 
pouvez également sélectionner l'emplacement de la 
piste où le fichier audio doit démarrer (en début de 
session, par exemple).

Clip List : les fichiers audio sont importés dans la 
liste des clips et aucune piste n'est créée. Les 
fichiers audio importés apparaissent dans la liste 
des clips et vous pouvez les faire glisser vers des 
pistes audio.

9 Si vous créez une piste, sélectionnez 
l'emplacement pour le fichier importé dans 
la piste :

Session Start : les fichiers ou clips sont placés au 
début de la session. 

Song Start : aligne le début du fichier ou du clip 
avec le début du morceau. 

Selection : le début des fichiers ou clips est aligné 
sur le curseur d'édition ou le début d'une sélection 
de timeline.

Spot : affiche la boîte de dialogue Spot qui permet 
de placer le fichier ou le clip à un emplacement 
spécifique basé sur l'une des échelles temporelles.

10 Cliquez sur OK.

Pro Tools permet d'ajouter à une session des 
fichiers dont la fréquence d'échantillonnage 
est différente de celle de votre session. Dans 
le champ des commentaires de la boîte de 
dialogue Import Audio, un avertissement 
indique que ces fichiers ne seront pas lus à la 
bonne vitesse et à la bonne hauteur s'ils ne 
sont pas convertis.

Appuyez sur Commande+W (Mac) ou Alt+E 
(Windows) pour valider l'opération. Appuyez 
sur Commande+Point (.) (Mac) ou Échap 
pour annuler.

Boîte de dialogue Audio Import Options
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Importation audio à partir de 
CD audio
Pro Tools permet d'importer des pistes depuis des 
CD audio en utilisant les mêmes méthodes que 
pour l'importation des fichiers audio :

• en faisant glisser les pistes audio du CD à partir 
du dossier du CD ;

• en faisant glisser les fichiers depuis un 
navigateur de l'espace de travail ;

• en utilisant la commande Import Audio.

Avant d'importer des pistes audio d'un CD, 
assurez-vous que l'espace libre sur le disque dur est 
suffisant pour stocker les fichiers audio convertis.

Le transfert étant entièrement numérique, le signal 
ne subit aucune dégradation.

La fréquence d'échantillonnage des CD audio est de 
44,1 kHz. Par conséquent, si la fréquence 
d'échantillonnage de la session est de 48 kHz ou 
plus, Pro Tools convertit celle des données audio 
importées. Avant d'importer les données audio d'un 
CD, configurez le paramètre Sample Rate 

Conversion Quality en conséquence. Pour plus 
d'informations, reportez-vous à la section « Sample 
Rate Conversion Quality » à la page 332.

Importation de fichiers ACID 
et REX
Les fichiers ACID et REX 1 et 2 sont convertis au 
format de fichier audio de la session. En fonction 
des préférences définies, les fichiers ACID et REX 
peuvent être importés sous forme de clips basés sur 
les échantillons ou de clips Elastic Audio basés sur 
les références de tempo. Dans le cas des fichiers 
REX, Pro Tools utilise les données de découpage 
des fichiers pour créer des marqueurs d'événement 
aux emplacements exacts. Comme pour les 
fichiers WAV, l'analyse des fichiers ACID 
consiste à rechercher des événements Elastic 
Audio et par conséquent, la détection des 
événements est plus ou moins précise.

Les fichiers REX peuvent également être importés 
en tant que groupes de clips basés sur les 
références de tempo. 

Pour importer des fichiers ACID ou REX en tant 
que clips basés sur les échantillons :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Désactivez l'option Import REX Files as Clip 

Groups.

3 Sélectionnez No Files pour le paramètre Drag 

and Drop from Desktop Conforms to Session 

Tempo.

4 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

L'importation de pistes d'un CD par glisser-
déposer n'interrompt pas la session au premier 
plan (dans la fenêtre Mix ou Edit, par 
exemple). Le Gestionnaire de tâches (Window 
> Task Manager) se charge d'importer et de 
convertir l'audio en arrière-plan. Pour plus 
d'informations sur le Gestionnaire de tâches, 
reportez-vous à la section « Fenêtre du 
gestionnaire de tâches » à la page 324.

Pour plus d'informations sur le traitement 
Elastic Audio, reportez-vous au Chapitre 40, 
« Elastic Audio ».

Pour plus d'informations sur les groupes de 
clips, reportez-vous à la section « Groupes de 
clips » à la page 877.
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5 Lorsque vous importez des données par glisser-
déposer à partir de navigateurs de l'espace de 
travail, assurez-vous que l'option Audio Files 

Conform to Session Tempo est désactivée.

6 Importez les fichiers ACID et REX de votre 
choix par glisser-déposer à partir d'un 
navigateur de l'espace de travail ou du poste de 
travail, ou encore à l'aide de la commande 
Import Audio (reportez-vous à la section 
« Importation de fichiers et de clips audio à 
l'aide de la commande Import Audio » à la 
page 337).

Pour importer des fichiers ACID ou REX en tant 
que clips Elastic Audio basés sur les références 
de tempo :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Désactivez l'option Import REX Files as Clip 

Groups.

3 Sélectionnez REX and ACID Files Only ou All 

Files pour le paramètre Drag and Drop from 

Desktop Conforms to Session Tempo.

4 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

5 Effectuez l'une des opérations suivantes :

• Importez les fichiers REX souhaités par glisser-
déposer à partir d'un navigateur de l'espace de 
travail.

• Importez les fichiers REX souhaités par glisser-
déposer à partir du poste de travail.

• Utilisez la commande Import Audio (reportez-
vous à la section « Importation de fichiers et de 
clips audio à l'aide de la commande Import 
Audio » à la page 337).

Pour importer des fichiers REX en tant que 
groupes de clips basés sur les références de 
tempo :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Sélectionnez l'option Import REX Files as Clip 

Groups.

3 Pour appliquer des fondus enchaînés en temps 
réel aux fichiers, activez l'option Automatically 

Create Fades (reportez-vous à la section 
« Fondus automatiques pour les fichiers REX 
importés » à la page 340).

4 Sélectionnez REX and ACID Files Only ou All 

Files pour le paramètre Drag and Drop from 

Desktop Conforms to Session Tempo.

5 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

6 Effectuez l'une des opérations suivantes :

• Importez les fichiers REX souhaités par glisser-
déposer à partir d'un navigateur de l'espace de 
travail. 

• Importez les fichiers REX souhaités par glisser-
déposer à partir du poste de travail.

• Utilisez la commande Import Audio (reportez-
vous à la section « Importation de fichiers et de 
clips audio à l'aide de la commande Import 
Audio » à la page 337).

Fondus automatiques pour les fichiers REX 
importés

Si l'option Import REX Files as Clip Groups est 
activée dans les préférences de traitement, 
Pro Tools peut appliquer automatiquement des 
fondus enchaînés en temps réel aux clips (également 
appelés « tranches ») des fichiers REX importés. 
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Pour appliquer des fondus enchaînés en temps 
réel à des fichiers REX :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Activez l'option Import REX Files as Clip 

Groups.

3 Activez l'option Automatically Create Fades.

4 Dans la boîte de dialogue Preferences, cliquez 
sur l'onglet Editing. 

5 Sous Default Fade Settings, cliquez sur REX.

6 Dans la boîte de dialogue REX Auto-
Crossfades, sélectionnez les formes à utiliser 
pour les fondus enchaînés, puis cliquez sur OK. 

7 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

Importation de fichiers audio 
multicanal d'enregistreur 
portable
Pro Tools vous permet d'utiliser les méthodes 
de votre choix pour importer des fichiers audio 
monophoniques et polyphoniques enregistrés par 
un enregistreur portable. Lorsque vous importez 
ces types de fichiers, vous devez les convertir dans 
un format audio compatible avec Pro Tools.

Importation de fichiers audio 
monophoniques
Un fichier audio monophonique contient un canal 
mono et les métadonnées associées provenant d'un 
enregistrement multicanal unique. 

Lorsque vous importez des fichiers audio 
monophoniques enregistrés simultanément, 
ils sont convertis en clips multicanal et affichés 
ensemble dans la liste des clips. Les métadonnées 
correspondantes sont également importées avec les 
fichiers.

Importation de fichiers audio 
polyphoniques
Un fichier audio polyphonique contient plusieurs 
canaux mono et les métadonnées associées 
enregistrées simultanément en multicanal.

Lors de son importation dans Pro Tools, un fichier 
audio polyphonique est divisé en fichiers audio 
monophoniques enregistrés sur le disque 
(un fichier par canal). Les clips de chaque canal 
apparaissent dans la playlist, et un clip multicanal 
apparaît dans la liste des clips avec ses canaux en 
dessous. Les métadonnées correspondantes sont 
également importées avec les fichiers. 

En fonction des modifications réalisées ou 
des changements de tempo appliqués après 
l'importation des fichiers REX, il se peut que 
les fondus soient supprimés, auquel cas vous 
devez les recréer manuellement.

Pour plus d'informations sur l'importation de 
fichiers depuis un enregistreur portable, 
reportez-vous au Chapitre 51, « Utilisation 
d'enregistreurs portables avec Pro Tools ».
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Options et préférences 
d'importation
Pro Tools propose plusieurs options et préférences 
pour l'importation des données audio. Configurez 
Pro Tools en fonction de vos workflows les plus 
courants. Si vous utilisez par exemple fréquemment 
des boucles dans vos compositions et importez des 
fichiers REX, configurez Pro Tools afin qu'il 
importe systématiquement les fichiers REX au 
tempo correct sur de nouvelles pistes Elastic Audio 
basées sur les références de tempo.

Convert Imported "WAV" Files To 
AES31/BroadcastWave : lorsque cette option est 
sélectionnée, tous les nouveaux fichiers WAV 
importés sont conformés à la norme broadcast 
AES31/EBU.

Automatically Copy Files on Import : lorsque 
cette option est sélectionnée, tous les fichiers audio 
importés par glisser-déposer sont copiés dans le 
dossier Audio Files de la session, qu'ils doivent ou 
non être convertis au type de fichier, à la résolution 
ou à la fréquence d'échantillonnage de la session 
actuelle. Par ailleurs, lorsque cette option est 
sélectionnée, le paramètre de la boîte de dialogue 
Import Session Data prend la valeur par défaut 
Copy from Source Media. La préférence 
Automatically Copy Files on Import n'affecte pas 
la commande Import Audio.

Convert Copied Files to Session Format : 
lorsque cette option est sélectionnée, les fichiers 
dont le format est différent de celui de la session 
actuelle sont copiés et convertis pendant 
l'importation en fichiers audio de format, résolution 
et fréquence d'échantillonnage identiques à ceux de 
la session actuelle. Par exemple, si le fichier de la 
session est au format WAV, 24 bits, 48 kHz et que 
vous importez un fichier au format AIF, 16 bits, 
44,1 kHz, ce fichier est copié et converti au format 
WAV, 24 bits, 48 kHz pendant l'importation. 
Lorsque cette option n'est pas sélectionnée, 
les fichiers copiés conservent leur format d'origine 
(sauf si ce format de fichier n'est pas compatible 
avec Pro Tools, dans ce cas ils sont convertis).

Do Not Convert Sample Rate on Import : lorsque 
cette option est sélectionnée, les fichiers dont la 
fréquence d'échantillonnage est différente de celle 
de la session ne sont pas automatiquement 
convertis lors de leur importation dans la session. 
Ils ne sont donc pas lus à la même vitesse et la 
hauteur est différente de celle de l'enregistrement 
(ou de la conversion) d'origine.

Import REX Files as Clip Groups : lorsque cette 
option est sélectionnée, les fichiers REX sont 
importés en tant que groupes de clips et toutes les 
tranches sous-jacentes sont importées en tant que 
clips individuels au sein du groupe de clips. 
Lorsque cette option n'est pas sélectionnée, 
les fichiers REX importés dans une session sont 
convertis au format de fichier audio de la session, 
les tranches individuelles sont consolidées et les 
informations des tranches sont utilisées pour 
l'analyse Elastic Audio. Ces fichiers restent basés 
sur les références de tempo après importation et 
conversion. 

Automatically Create Fades : lorsque cette option 
est sélectionnée, les fondus enchaînés sont 
appliqués automatiquement aux clips découpés en 
tranches faisant partie d'un groupe de clips et créés 
lors de l'importation des fichiers REX. Si l'option 
Import REX Files as Clip Groups n'est pas 
sélectionnée, l'option Automatically Create Fades 
ne s'applique pas. 

Pour modifier les réglages de fondu par défaut 
pour les fichiers REX, cliquez sur le bouton REX 
dans la section Default Fade Settings des 
préférences d'édition (reportez-vous à la section 
« Préférence d'édition des fondus » à la page 344).
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Drag and Drop From Desktop Conforms to 
Session Tempo

Les options de la section Drag and Drop From 
Desktop Conforms to Session Tempo déterminent 
si les fichiers REX et ACID, ainsi que tous les autres 
fichiers audio que vous faites glisser à partir de 
l'Explorateur Windows ou du Finder Mac doivent 
être importés en tant que données Elastic Audio 
basées sur les références de tempo et conformés au 
tempo de la session.

None : si cette option est activée, les fichiers 
audio, y compris les fichiers REX et ACID, ne sont 
pas conformés au tempo de la session lorsqu'ils 
sont importés par glisser-déposer à partir de 
l'Explorateur Windows ou du Finder Mac. Ils sont 
importés en tant que fichiers basés sur les 
échantillons et convertis au format de fichier audio 
des sessions.

REX and ACID Files Only : si cette option est 
activée, seuls les fichiers REX et ACID sont 
conformés au tempo de la session lorsqu'ils 
sont importés par glisser-déposer à partir de 
l'Explorateur Windows ou du Finder Mac. 
Les fichiers REX sont importés en tant que fichiers 
Elastic Audio basés sur les références de tempo ou, 
si l'option Import REX Files as Clip Groups est 
activée, en tant que groupes de clips basés sur les 
références de tempo. 

All Files : lorsque cette option est activée, tous les 
fichiers audio sont importés en tant que fichiers 
Elastic Audio basés sur les références de tempo et 
sont conformés au tempo de la session.

Sample Rate Conversion Quality

La préférence Sample Rate Conversion Quality 
détermine la qualité de la conversion de fréquence 
d'échantillonnage utilisée pour convertir et importer 
des données audio dans une session par glisser-
déposer. La conversion de la fréquence 
d'échantillonnage est utilisée dans un certain 
nombre de traitements dans Pro Tools, notamment 
lors de la conversion et l'importation de fichiers 
audio de différents formats dans une session, ainsi 
que pour le bounce et l'enregistrement des pistes 
dans une fréquence d'échantillonnage ou une 
résolution différente. Plus la qualité de la 
conversion de la fréquence d'échantillonnage 
choisie est élevée, plus le traitement du fichier 
audio dans Pro Tools est long.

Options Elastic Audio

Les préférences Elastic Audio permettent de 
définir le plug-in Elastic Audio à utiliser pour 
l'aperçu et l'importation et de déterminer si les 
nouvelles pistes doivent être créées en mode 
Elastic Audio à l'aide du plug-in par défaut 
sélectionné.

Default Plug-In : permet de sélectionner n'importe 
quel plug-in Elastic Audio en temps réel en tant que 
plug-in par défaut pour l'aperçu et l'importation 
Elastic Audio. Le plug-in Elastic Audio sélectionné 
par défaut est également utilisé pour la création de 
nouvelles pistes Elastic Audio. Le sélecteur du plug-
in Elastic Audio dans les navigateurs de l'espace de 
travail hérite du plug-in sélectionné par défaut. 
De même, une modification du plug-in sélectionné 
dans les navigateurs de l'espace de travail met à jour 
la préférence de traitement Default Plug-In.
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Default Input Gain : permet d'atténuer le gain 
d'entrée du signal envoyé aux plug-ins Elastic 
Audio pour l'aperçu et l'importation, de 0 à -6 dB. 
Si le traitement Elastic Audio provoque un écrêtage 
lors d'un aperçu ou à la suite d'une importation, 
il peut être utile de régler le paramètre Default Input 

Gain de façon à réduire légèrement le niveau 
d'entrée du signal audio. Cette préférence 
s'appliquera à toute donnée audio importée sur une 
piste Elastic Audio.

Si vous validez (en désactivant le mode Elastic 
Audio de la piste) des clips qui ont été importés 
alors que le paramètre Default Input Gain était 
activé, le paramètre Input Gain de ces clips est 
remis à zéro.

La fenêtre Elastic Properties hérite de la valeur du 
paramètre Default Input Gain. Pour appliquer un 
gain d'entrée supplémentaire pour le traitement 
Elastic Audio d'un clip, sélectionnez le clip et 
ajustez la valeur du paramètre Input Gain de la 
fenêtre Elastic Properties (reportez-vous à la 
section « Fenêtre Elastic Properties » à la 
page 930).

Enable Elastic Audio on New Tracks : lorsque 
cette option est sélectionnée, le traitement Elastic 
Audio est activé sur les nouvelles pistes créées. 
Le plug-in Elastic Audio sélectionné comme plug-
in par défaut est utilisé. Si cette option est activée, 
lorsque vous importez des données audio sur de 
nouvelles pistes, le traitement Elastic Audio est 
automatiquement activé pour ces nouvelles pistes.

Préférence des pistes

Lorsque l'option New Tracks Default To Tick 

Timebase est activée, toutes les nouvelles pistes 
sont basées sur les références de tempo. Cela 
concerne également l'importation d'audio sur de 
nouvelles pistes. Lorsqu'elle n'est pas sélectionnée, 
les pistes audio, d'entrée auxiliaire, Master Fader et 
Master VCA (Pro Tools HD uniquement) sont 
basées par défaut sur les échantillons. Par défaut, 
les pistes MIDI et les pistes d'instrument sont 
basées sur les références de tempo.

Préférence d'édition des fondus

Les préférences d'édition Default Fade Settings 
des fichiers REX permettent de sélectionner la 
forme d'enveloppe par défaut des fondus et fondus 
enchaînés créés entre les clips (tranches) des 
fichiers REX importés. Les fondus sont appliqués 
aux fichiers REX importés uniquement si les 
options Import REX Files as Clip Groups et 
Automatically Create Fades sont toutes les deux 
activées dans les préférences de traitement.

Si l'option Enable Elastic Audio on New 
Tracks est sélectionnée, il est conseillé 
d'activer également l'option New Tracks 
Default to Tick Timebase des préférences 
d'édition.

Boîte de dialogue REX Auto-Crossfades
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Exportation audio
Pro Tools prend en charge l'exportation des clips 
sous forme de fichiers audio, l'exportation des 
données audio des canaux droit et gauche sous 
forme de fichiers stéréo entrelacés et l'exportation 
des informations des clips.

Vous pouvez également exporter des données 
audio à partir de Pro Tools via un bounce ou 
une consolidation de pistes audio. Pour plus 
d'informations, reportez-vous aux sections 
« Bounce to Disk » à la page 1133 et 
« Consolidation des clips » à la page 621.

Exportation d'un clip en tant que 
nouveau fichier audio
La commande Export Clips As Files permet 
d'exporter des clips sous forme de fichiers audio. 
Cette commande est utile si vous envisagez 
d'utiliser un clip dans d'autres sessions (ou dans 
d'autres applications audio) sans utiliser son fichier 
source parent. 

Cette commande permet également de convertir 
des clips dans un format audio, une fréquence 
d'échantillonnage ou une résolution différents.

Pour exporter des clips sous forme de nouveaux 
fichiers audio :

1 Dans la liste des clips, sélectionnez les clips 
à exporter.

2 Dans le menu de la liste des clips, sélectionnez 
Export Clips as Files. 

3 Dans la boîte de dialogue Export Selected, 
configurez les paramètres File Type, Format, 
Bit Depth et Sample Rate. Spécifiez également 
la qualité de conversion (Conversion Quality) 
et le répertoire de destination (Destination 

Directory).

Lorsque vous exportez des clips dans une résolution 
inférieure, un dithering avec ou sans mise en forme 
du bruit (Noise Shaping) est appliqué de la façon 
indiquée dans le tableau suivant.

Les clips avec déformation (traitement Elastic 
Audio) seront exportés sans tenir compte des 
déformations, avec leur durée d'origine.

Boîte de dialogue Export Selected

Dithering et mise en forme du bruit avec la boîte de 
dialogue Export Selected

Résolution Dithering
Mise en 
forme du 
bruit

32 bits virgule 
flottante vers 32 bits 
virgule flottante

Oui Oui

32 bits virgule 
flottante vers 24 bits

Oui Oui
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L'outil de dithering utilisé pour les conversions est 
le plug-in Avid Dither (avec ou sans mise en forme 
du bruit).

4 Pour un partage sur Gobbler, sélectionnez 
l'option Share with Gobbler (reportez-vous à la 
section « Share With Gobbler » à la page 1143).

5 Pour un partage sur SoundCloud, sélectionnez 
l'option Share with SoundCloud (reportez-vous 
à la section « Share With SoundCloud » à la 
page 1141).

6 Sélectionnez une option pour indiquer 
à Pro Tools la procédure à suivre en cas de 
duplication des noms de fichiers. 

Prompting for Each Duplicate : cette option vous 
invite à entrer un nom pour tout fichier portant le 
même nom qu'un fichier de votre répertoire de 
destination. 

Auto Renaming : cette option modifie 
automatiquement le nom de tout fichier dupliqué 
en lui ajoutant un nombre (tel que fichier_01). 

Replacing with New Files : les fichiers ayant le 
même nom sont remplacés par les nouveaux 
fichiers.

7 Cliquez sur Export pour exporter les nouveaux 
fichiers audio.

Exportation de fichiers stéréo 
ou multicanal entrelacés
La commande Export Clips as Files permet 
d'exporter des clips audio en tant que fichiers stéréo 
ou multicanal entrelacés utilisables dans d'autres 
applications. Pro Tools n'utilise pas directement les 
fichiers entrelacés dans la timeline. Ces fichiers 
doivent être convertis en plusieurs fichiers mono. 
Par exemple, pour utiliser cette commande avec un 
fichier stéréo, les clips sélectionnés doivent porter 
des noms identiques, avec les suffixes « .L » et 
« .R » (tels que voix_01.L et voix_01.R). Ces clips 
apparaissent en tant que clip stéréo dans la liste des 
clips.

Pro Tools HD permet également de bouncer des 
fichiers multicanal entrelacés de n'importe quel 
format pris en charge. 

32 bits virgule 
flottante vers 16 bits

Oui Oui

32 bits virgule 
flottante vers 8 bits

Oui Non

24 bits vers 32 bits 
virgule flottante

Non Non

24 bits vers 24 bits Non Non

24 bits vers 16 bits Oui Oui

24 bits vers 8 bits Oui Non

16 bits vers 32 bits 
virgule flottante

Non Non

16 bits vers 24 bits Non Non

16 bits vers 16 bits Non Non

16 bits vers 8 bits Oui Non

Pour en savoir plus sur le dithering, reportez-
vous à la section « Dithering » à la page 1029.

Dithering et mise en forme du bruit avec la boîte de 
dialogue Export Selected

Résolution Dithering
Mise en 
forme du 
bruit
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Pour exporter des clips sous forme de fichier 
stéréo ou multicanal entrelacé :

1 Sélectionnez le clip audio stéréo ou multicanal 
dans la liste des clips ou dans la playlist de la 
piste. Si les clips apparaissent sur des pistes 
mono de la session, sélectionnez les deux clips 
mono.

2 Dans le menu de la liste des clips, sélectionnez 
Export Clips as Files.

3 Dans la boîte de dialogue Export Selected, 
sélectionnez Stereo Interleaved dans le menu 
déroulant Format. Dans le cas de clips 
multicanal, l'option Stereo Interleaved produit 
un fichier multicanal entrelacé.

4 Configurez les autres options d'exportation, 
puis cliquez sur Export pour exporter le 
nouveau fichier stéréo entrelacé.

Exportation des définitions 
de clips
Pro Tools enregistre les définitions de clip des 
fichiers audio au sein de chaque session. Si vous 
souhaitez utiliser les clips d'un fichier audio dans 
une autre session, ou avec une autre application qui 
les prend en charge, vous pouvez exporter les 
informations des clips. 

La commande Export Clip Definitions n'exporte pas 
les clips sous forme de fichiers audio 
(contrairement à la commande Export Clip as 

Files). En revanche, elle mémorise des pointeurs 
vers les clips au sein du fichier source parent.

Pour exporter les définitions des clips d'un fichier 
audio :

1 Dans la liste des clips, sélectionnez les clips ou 
les groupes de clips pour lesquels vous voulez 
exporter les définitions. Il n'est pas nécessaire 
de sélectionner le clip audio du fichier parent.

2 Sélectionnez Export Clip Definitions dans le 
menu de la liste des clips.

3 Cliquez sur Export.

Importation de fichiers MIDI
Vous pouvez importer des fichiers MIDI standard 
(SMF) dans vos sessions Pro Tools.

Pro Tools propose plusieurs méthodes d'importation 
des fichiers MIDI dans une session ouverte.

• « Importation de fichiers MIDI à l'aide des 
commandes de menu de Pro Tools » à la 
page 348.

• « Importation de fichiers MIDI par glisser-
déposer » à la page 349.

Pro Tools n'importe pas les fichiers de séquence 
propriétaires. Pour utiliser des séquences provenant 
d'autres applications MIDI dans une session 
Pro Tools, vous devez d'abord les enregistrer sous 
forme de fichiers MIDI standard (SMF). Consultez 
la documentation du logiciel pour obtenir plus de 
détails sur l'enregistrement de fichiers MIDI 
standard.

Il existe deux types de fichiers MIDI standard, tous 
deux pris en charge par Pro Tools :

• Les fichiers MIDI de type 0 enregistrent les 
données de tous les canaux MIDI sur une seule 
piste. Lors de l'importation de ces fichiers, 
Pro Tools sépare les données par canal et place 
les données de chaque piste dans des clips et 
pistes distincts.

Si vous prévoyez de transférer des données 
de session Pro Tools vers une autre session, 
il est conseillé d'exporter les définitions de 
clip des sessions contenant des prises 
multiples enregistrées en boucle.
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• Les fichiers MIDI de type 1, parfois nommés 
fichiers MIDI multipistes, comportent plusieurs 
pistes de données MIDI. Lorsque vous importez 
ces fichiers, les données de chaque piste sont 
placées dans leur propre piste MIDI de la session 
Pro Tools.

Importation de fichiers MIDI 
à l'aide des commandes de 
menu de Pro Tools
Pro Tools offre plusieurs commandes 
d'importation des fichiers MIDI.

Pour importer des fichiers MIDI standard dans une 
session à l'aide du menu File de Pro Tools :

1 Sélectionnez File > Import > MIDI et 
sélectionnez le fichier à importer.

2 Dans la boîte de dialogue MIDI Import Options, 
sélectionnez la destination du fichier importé :

New Track : crée une piste de destination pour le 
fichier importé.

Clip List : importe le fichier dans la liste des clips, 
à partir de laquelle il devient accessible pour être 
placé sur une piste.

3 Si vous créez une piste, sélectionnez 
l'emplacement de la piste auquel le fichier sera 
importé :

Session Start : les fichiers ou clips sont placés au 
début de la session. 

Song Start : aligne le début du fichier avec le début 
du morceau. 

Selection : aligne le début du fichier avec le curseur 
d'édition ou le début d'une sélection dans la 
timeline.

Spot : affiche la boîte de dialogue Spot qui permet 
de placer le fichier à un emplacement spécifique 
basé sur l'une des échelles temporelles.

4 Sélectionnez l'une des options d'importation 
suivantes :

Import Tempo Map From MIDI File : remplace 
toute table de tempos et de métriques existante par 
les informations de tempo et de métrique 
provenant du fichier MIDI. 

Import Key Signature From MIDI File : remplace 
toutes les armures existantes par les informations 
d'armure provenant du fichier MIDI. 

Remove Existing Instrument Tracks : supprime 
toute piste d'instrument existante. La sélection de 
cette option n'a aucun effet sur les pistes MIDI 
actuelles. Tous les clips MIDI existants seront 
conservés dans la liste des clips.

Remove Existing MIDI Tracks : supprime toute 
piste MIDI existante. La sélection de cette option 
n'a aucun effet sur les pistes d'instrument actuelles. 
Tous les clips MIDI existants seront conservés 
dans la liste des clips.

Remove Existing MIDI Clips : supprime les clips 
MIDI existants (c'est-à-dire toutes les données 
figurant sur l'ensemble des pistes MIDI et 
d'instrument), mais laisse les pistes MIDI et 
d'instrument en place. 

Boîte de dialogue MIDI Import Options
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5 Cliquez sur OK.

Le fichier MIDI sera importé conformément aux 
paramètres choisis dans la boîte de dialogue 
Import MIDI Settings.

6 Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie MIDI pour chaque nouvelle piste et 
affectez un instrument MIDI et un canal.

Importation de fichiers MIDI par 
glisser-déposer
Vous pouvez faire glisser des fichiers MIDI 
à partir d'un navigateur de l'espace de travail, 
de l'Explorateur Windows ou du Finder Mac et les 
déposer dans la timeline, une piste, la liste des 
pistes ou la liste des clips.

Pour importer des données MIDI dans la liste 
des clips :

1 Sélectionnez des fichiers MIDI dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

2 Déposez les fichiers dans la liste des clips de la 
session actuelle. 

Pour importer des données MIDI sur une piste 
existante :

1 Sélectionnez des fichiers MIDI dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

2 Déposez les fichiers sur une piste existante de la 
fenêtre Edit de la session actuelle. 

Pour importer des données MIDI sur de nouvelles 
pistes :

1 Sélectionnez des fichiers MIDI dans un 
navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac. 

2 Effectuez l'une des opérations suivantes :

• Dans le navigateur de l'espace de travail, 
maintenez la touche Maj enfoncée et faites glisser 
les fichiers vers n'importe quel emplacement de la 
fenêtre Edit de la session actuelle.

• Faites glisser les fichiers vers la timeline de la 
session actuelle.

• Déposez les fichiers dans la liste des pistes.

Exportation de fichiers MIDI
Pour exporter les pistes MIDI d'une session afin de 
les utiliser dans une autre application MIDI ou de 
les lire avec un séquenceur MIDI externe (matériel), 
vous pouvez exporter les pistes MIDI et 
d'instrument de Pro Tools sous forme de fichier 
MIDI standard. 

Les données MIDI peuvent être exportées depuis 
Pro Tools sous forme d'une piste unique multicanal 
fusionnée (Type 0) ou de plusieurs pistes (Type 1).

Si votre session Pro Tools utilise des armures et 
des métriques, elles sont exportées avec le fichier 
MIDI.

Si le fichier MIDI standard contient des 
marqueurs, ceux-ci ne sont importés que si la 
session en cours ne contient aucun marqueur.

Pour plus d'informations, reportez-vous au 
Chapitre 16, « Navigateurs de l'espace 
de travail ».
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Pour exporter toutes les pistes MIDI et d'instrument 
de la session en cours :

1 Veillez à démuter les pistes MIDI de la session 
à inclure dans le fichier MIDI exporté (ou mutez 
les pistes MIDI que vous ne souhaitez pas inclure 
dans le fichier MIDI exporté). Pour les pistes 
d'instrument, activez ou désactivez le bouton de 
mute MIDI (vue Instruments).

2 Sélectionnez File > Export > MIDI. La boîte de 
dialogue Export MIDI Settings s'affiche.

3 Dans le menu déroulant MIDI File Format, 
sélectionnez 1 (multitrack) ou 0 (single track).

4 Si le timecode de début du morceau est différent 
de celui de la session, sélectionnez Session 
Start ou Song Start dans le menu déroulant 
Location Reference.

5 Activez ou désactivez l'option Apply Real-Time 
Properties.

6 Cliquez sur OK.

7 Sélectionnez la destination du fichier MIDI et 
donnez-lui un nom.

8 Cliquez sur Save. 

Pro Tools exporte toutes les pistes MIDI et 
d'instrument de la session actuelle qui ne sont pas 
mutées dans un fichier MIDI standard sur votre 
disque dur. Les informations MIDI exportées 
incluent les notes, les événements de contrôleur, 
les changements du programme, les données 
System Exclusive, ainsi que les événements 
concernant le tempo, la métrique et les marqueurs.

Le timecode de début SMPTE de la session ou du 
morceau (selon la sélection réalisée dans le menu 
déroulant Location Reference) est également 
exporté. Ainsi, lors de la lecture à partir d'une autre 
application MIDI, les pistes exportées démarrent au 
timecode SMPTE approprié et sont synchronisées 
correctement avec les magnétophones et 
magnétoscopes externes, ou encore avec Pro Tools.

Reportez-vous à la documentation de votre 
séquenceur MIDI tiers pour savoir s'il prend en 
charge l'importation des timecodes de début 
SMPTE à partir des fichiers MIDI.

Éléments non exportés avec les fichiers MIDI

L'automation de mute et les clips mutés n'ont pas 
d'incidence sur les données MIDI exportées. Tant 
qu'une piste MIDI ou d'instrument n'est pas mutée, 
toutes ses données MIDI sont exportées.

Les symboles et diagrammes d'accord ne sont pas 
exportés avec les fichiers MIDI.

Lors de l'exportation de fichiers MIDI à partir de 
Pro Tools, les assignations de périphérique aux 
pistes ne sont pas conservées (même si les 
assignations de canal le sont). Par conséquent, 
si vous exportez des pistes MIDI ou d'instrument 
à partir de Pro Tools et que vous les réimportez 
plus tard, vous devrez réassigner les pistes aux 
périphériques de votre studio.

Toutes les informations de playlist des pistes MIDI 
et d'instrument sont perdues lors de l'exportation. 
Par exemple, les pistes qui contenaient 
préalablement des dizaines de clips MIDI seront 
mises à plat et ne contiendront plus qu'un seul clip 
après exportation et réimportation.

Boîte de dialogue Export MIDI Settings

Pro Tools ajoute automatiquement l'extension 
.mid lors de l'exportation de fichiers MIDI.
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Exportation de pistes MIDI et 
d'instrument individuelles
Vous pouvez également exporter individuellement 
des pistes MIDI et d'instrument sous forme de 
fichiers MIDI. Cela peut s'avérer utile pour 
sauvegarder des bibliothèques contenant les 
séquences MIDI ou données Sysex que vous 
utilisez souvent (pour le transfert d'un ou plusieurs 
patchs vers vos appareils MIDI externes, par 
exemple) ou pour importer des données MIDI dans 
des applications de notation musicale autres que 
Sibelius.

Pour exporter une piste MIDI ou d'instrument sous 
forme de fichier MIDI :

1 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le nom d'une piste 
non sélectionnée dans la fenêtre Edit ou Mix, 
ou dans la liste des pistes.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et effectuez un clic 
droit sur le nom d'une piste dans liste des pistes 
ou dans la fenêtre Edit ou Mix. 

2 Sélectionnez Export MIDI dans le menu 
contextuel.

3 Définissez les paramètres d'exportation MIDI 
dans la boîte de dialogue Export MIDI Settings.

4 Cliquez sur OK.

5 Dans la boîte de dialogue Save, saisissez le nom 
du fichier MIDI, spécifiez l'emplacement où 
vous souhaitez l'enregistrer et cliquez sur Save.

Pour exporter toutes les pistes d'instrument ou 
MIDI de Pro Tools sous forme de fichier MIDI :

1 Sélectionnez les pistes à exporter sous forme de 
fichier MIDI.

2 Effectuez un clic droit sur le nom des pistes 
sélectionnées dans la fenêtre Edit ou Mix, 
ou dans la liste des pistes.

3 Sélectionnez Export MIDI dans le menu 
contextuel.

4 Configurez les paramètres d'exportation MIDI.

5 Cliquez sur OK. 

6 Dans la boîte de dialogue Save, saisissez le nom 
du fichier MIDI, spécifiez l'emplacement où 
vous souhaitez l'enregistrer et cliquez sur Save.

Exportation de fichiers 
Sibelius
Pro Tools peut exporter la partition de votre 
session sous forme de fichier Sibelius (.sib). Vous 
pouvez choisir d'exporter la partition sous forme 
de fichier Sibelius pour l'utiliser ultérieurement ou 
de transférer la partition, ou encore d'ouvrir la 
partition directement dans Sibelius, si cette 
application est installée sur votre ordinateur. 
Sibelius utilise la transcription des données MIDI 
de votre session, telle qu'elle apparaît dans la 
fenêtre de l'éditeur de partition de Pro Tools 
(pour plus d'informations, reportez-vous à la 
section « Exportation de partitions » à la 
page 774). 

Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et effectuez un clic 
droit pour exporter toutes les pistes dans un 
fichier MIDI unique.

Maintenez les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées et effectuez 
un clic droit pour exporter toutes les pistes 
dans un fichier MIDI unique.

Sibelius version 5.x ou supérieure est requis 
pour ouvrir les fichiers .sib exportés depuis 
Pro Tools.
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Importation de données de 
session
Vous pouvez importer dans la session Pro Tools 
actuelle des pistes complètes provenant d'autres 
sessions Pro Tools, soit par glisser-déposer, soit 
à l'aide de la commande Import Session Data. 

Dans Pro Tools, vous pouvez importer des pistes 
ou des données de session spécifiques, telles que 
l'automation et le routing. Vous pouvez aussi 
importer les options principales de playlist, soit en 
remplaçant les options existantes, soit en écrasant 
des éléments sur les pistes existantes.

Pour importer des pistes ou des attributs :

1 Ouvrez ou créez une session.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez File > Import > Session Data, 
sélectionnez la session dont vous souhaitez 
importer les données, puis cliquez sur Open. 

• Faites glisser le fichier de session dont vous 
souhaitez importer les pistes ou les attributs 
à partir d'un navigateur de l'espace de travail, 
de l'Explorateur Windows ou du Finder Mac et 
déposez-le sur une zone vierge de la fenêtre Edit 
ou dans la liste des pistes.

3 Si le paramètre Fader Gain de la session est 
différent, un message vous demande si vous 
souhaitez conserver ou modifier le paramètre 
Fader Gain avant l'ouverture de la boîte de 
dialogue Session Data.

4 Dans la section Source, sélectionnez les pistes 
à importer en cliquant sur le menu déroulant 
à droite de chaque nom de piste et en 
sélectionnant New Track. 

5 Pour chaque piste que vous sélectionnez, vous 
pouvez choisir d'effectuer l'importation sous 
forme de nouvelle piste, ou choisir une piste 
de destination dans le menu déroulant 
correspondant. Cliquez sur Match Tracks pour 
faire correspondre automatiquement les pistes 
source et de destination portant des noms 
identiques. 

6 Sélectionnez toutes les données de piste 
supplémentaires que vous souhaitez importer 
dans le menu déroulant Track Data to Import. 

7 Sélectionnez l'une des options Main Playlist 

Options pour choisir le mode d'importation des 
pistes source. 

8 Le cas échéant, sélectionnez les options 
d'importation des fichiers médias dans les 
menus Audio Media Options et Video Media 

Options. 

9 Sélectionnez les options Timecode Mapping 

Options pour les données importées. 

10 Si les fréquences d'échantillonnage des sessions 
sont différentes, sélectionnez celle de la session 
source à partir du menu déroulant Source 

Sample Rate. 

11 Pour importer les tables de tempo et de métrique 
à partir de la session source, sélectionnez 
l'option Import Tempo/Meter Map.

12 Pour importer des armures à partir de la session 
source, sélectionnez l'option Import Key 

Signature Map.

13 Pour importer des marqueurs et des 
emplacements mémoire à partir de la session 
source, sélectionnez l'option Import 

Marker/Memory Locations.

Pour sélectionner plusieurs pistes, cliquez sur le 
menu déroulant d'une piste tout en maintenant 
la touche Alt (Windows) ou Option (Mac) 
enfoncée et sélectionnez Import As New Track.

Si le système Pro Tools de destination ne 
prend pas en charge le mixage surround, les 
pistes surround n'apparaissent pas dans la 
liste des pistes source.
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14 Pour importer des configurations de fenêtres, 
sélectionnez l'option Import Window 

Configurations.

15 Dans Pro Tools HD, sélectionnez l'option 
Import Mic Pre Settings pour importer tous les 
paramètres de préamplificateur micro à partir de 
la session source.

16 Lorsque vous avez terminé, cliquez sur OK.

17 Si vous sélectionnez de copier ou de consolider 
un média, sélectionnez un emplacement pour 
placer les fichiers média.

Importation de playlists groupées 
à partir d'autres sessions
Vous pouvez importer des pistes qui utilisent 
des playlists groupées depuis une autre session 
Pro Tools ; la fonction de regroupement de playlist 
demeure inchangée pour ces pistes importées. 
L'importation à partir de sessions antérieures 
à Pro Tools 6.1 est cependant soumise à une 
restriction : après l'importation d'un ensemble 
partiel de playlists groupées (par exemple, les 
pistes 1 à 7 d'un groupe de 10 pistes), vous ne 
pouvez pas importer ultérieurement les pistes 8 à 10 
dans le groupe de playlists constitué des pistes 1 à 7.

Importation de sessions et de 
pistes par glisser-déposer
Vous pouvez faire glisser des fichiers de session 
dans la session en cours pour importer 
(et positionner) des données audio, vidéo et MIDI, 
des groupes de clips, des fichiers REX et ACID, 
des pistes et des données de session. 

• Lorsque vous déposez une session dans la liste 
des clips, tous les clips de cette session sont 
importés (mais pas les pistes). 

• Lorsque vous déposez une session dans une piste 
de Pro Tools, vous pouvez importer des pistes.

• Lorsque vous déposez une session dans une 
playlist de Pro Tools, la boîte de dialogue Import 
Session Data s'ouvre pour vous permettre de 
sélectionner les pistes et les attributs à importer. 
Les données de la session importée commencent 
à l'endroit où vous avez déposé la session dans la 
timeline.

Pour importer des pistes et autres données de 
session par une opération de glisser-déposer :

1 Ouvrez un navigateur de l'espace de travail.

2 Faites glisser un fichier de session Pro Tools ou 
une séquence AAF ou OMF dans la session en 
cours, en procédant de la façon suivante : 

• Faites glisser le fichier et déposez-le sur une piste 
pour recouvrir et écraser les données sur les pistes 
cible. Maintenez la touche Maj enfoncée tout en 
effectuant une opération de glisser-déposer si 
vous souhaitez remplacer les playlists de pistes en 
cours par celles en cours d'importation (la touche 
Maj préconfigure les paramètres de la boîte de 
dialogue Import Session Data).

• Faites glisser le fichier ou la séquence vers la 
fenêtre Edit pour créer de nouvelles pistes et 
y importer les données de session. 

• Configurez les options Import Session Data 
(reportez-vous à la section « Boîte de dialogue 
Import Session Data » à la page 354). 

Les pistes importées sont désactivées si leur 
média source n'est pas disponible ou si la 
session en cours ne contient pas de chemin de 
sortie équivalent.
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Copie en cours d'importation
Si aucune conversion n'est nécessaire et que les 
fichiers se trouvent sur un volume de performance 
approprié, Pro Tools référence la version originale 
du média. Vous pouvez également copier des 
médias lors de l'importation en utilisant des 
touches de raccourci ou en activant la préférence 
Automatically Copy Files on Import. Les copies sont 
créées dans le dossier Audio Files de la session. 

Pour copier manuellement des fichiers lors de 
l'importation :

 Faites glisser les fichiers en maintenant la touche 
Alt (Windows) ou Option (Mac) enfoncée. 
Une copie des fichiers est créée dans le dossier 
Audio Files de la session. 

Lors de l'importation de sessions ou de pistes, vous 
devez spécifier dans la boîte de dialogue Import 
Session Data si vous souhaitez référencer ou 
copier le média source.

Pour copier automatiquement des fichiers lors de 
l'importation :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Sélectionnez Automatically Copy Files on 

Import. 

3 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

Utilisation de la commande 
Undo après l'importation 
Si vous utilisez la commande Undo après avoir 
importé des fichiers dans la timeline, ces fichiers sont 
supprimés de la timeline. Cependant, les fichiers 
restent dans la session (dans la liste des clips et le 
navigateur de l'espace de travail), et sont hors ligne. 
Si vous ne supprimez pas manuellement les fichiers 
de la session, Pro Tools les considérera comme 
manquants à la prochaine ouverture de la session. 

Boîte de dialogue Import 
Session Data
La boîte de dialogue Import Session Data permet 
d'afficher les propriétés de la session source, 
de sélectionner les pistes à importer et, dans 
Pro Tools HD, de choisir les attributs de ces pistes 
à importer dans la session actuelle.

Propriétés de la session source
La boîte de dialogue Import Session Data affiche les 
propriétés de la session source. Ces propriétés 
comprennent le nom de la session source, le type de 
session, l'heure de début de la session, la résolution 
audio et la fréquence d'échantillonnage. Pour les 
sessions Pro Tools version 5.1 ou supérieure, 
le programme utilisé pour créer la session et le type 
de fichier audio s'affichent également.

Boîte de dialogue Import Session Data (Pro Tools HD)
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Encodage du texte

Pro Tools prend en charge la saisie et l'affichage 
des caractères Unicode dans toutes les fonctions de 
Pro Tools. Vous pouvez ainsi utiliser plusieurs 
langues dans les noms de sessions, de chemins, 
de fichiers et de clips. 

Toutefois, Pro Tools 7.3.x et les versions 
antérieures ne prennent pas en charge les caractères 
Unicode. Lorsque vous importez des données 
à partir de sessions ou de séquences OMF créées ou 
enregistrées dans des versions plus anciennes de 
Pro Tools, il peut être utile de connaître l'encodage 
linguistique des éléments importés. 

Pour choisir l'encodage linguistique lors de 
l'importation de données à partir d'une session 
créée dans une ancienne version de Pro Tools :

1 Sélectionnez File > Import > Session Data.

2 Sélectionnez la langue utilisée dans la session 
d'origine depuis le menu déroulant Text 

Encoding.

Options des médias audio
Les options de médias audio suivantes sont 
disponibles dans la boîte de dialogue Import 
Session Data :

Link to Source Media (Where Possible) : cette 
option permet d'éviter de dupliquer les fichiers 
audio, en se référant aux fichiers d'origine quand 
cela est possible. Si les fichiers source ne résident 
pas sur un support directement pris en charge 
(tel qu'un CD ou un DVD) ou s'ils nécessitent une 
conversion de résolution ou de fréquence 
d'échantillonnage, ils sont copiés. Cette option 
permet à la session en cours de se référer aux 
fichiers qui ne correspondent pas à son format de 
fichier audio. 

Copy from Source Media : cette option permet de 
copier tous les fichiers audio liés aux pistes 
importées depuis le support source vers un nouvel 
emplacement spécifique et de convertir les fichiers 
au format, à la résolution et à la fréquence 
d'échantillonnage des fichiers audio de la session 
en cours si nécessaire. Elle est pratique si vous 
importez des pistes à partir d'une source telle qu'un 
CD ou un DVD ou d'un stockage partagé et que 
vous souhaitez placer les fichiers audio sur un 
disque dur différent.

Consolidate from Source Media : cette option 
permet de consolider l'audio lors de sa copie. Elle 
est pratique si vous souhaitez ne copier que les 
clips des fichiers audio utilisés dans les pistes 
source, sans copier l'audio non utilisé. Cette option 
permet de copier et de convertir l'audio consolidé 
au format, à la résolution et à la fréquence 
d'échantillonnage des fichiers audio de la session 
en cours si nécessaire. 

Lorsque vous sélectionnez cette option, vous pouvez 
également choisir la valeur (en millisecondes) de la 
taille des poignées (Handle Size) appliquées aux 
fichiers audio consolidés. La poignée désigne la 
partie du fichier audio d'origine conservée avant et 
après chaque clip, dans le cas où vous souhaiteriez 
éditer les nouveaux clips (par exemple pour 
appliquer des fondus ou une opération de trimming).

Force to Target Session Format : cette option 
permet de copier et de convertir tout fichier 
dont le format, la résolution et la fréquence 
d'échantillonnage ne correspondent pas à ceux de 
la session en cours. En revanche, les fichiers 
dont le type, la résolution et la fréquence 
d'échantillonnage correspondent à ceux de la 
session en cours sont directement référencés et ne 
sont pas copiés.

L'option Consolidate From Source Media 
n'est pas disponible lorsque vous importez 
des pistes Elastic Audio.
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Options des médias vidéo

Dans la boîte de dialogue Import Session Data, 
vous pouvez choisir de laisser les fichiers média 
vidéo dans leur emplacement d'origine ou de les 
copier dans un nouvel emplacement. Cette option 
est utile si vous importez des pistes à partir d'une 
source telle qu'un CD, un DVD ou un stockage 
partagé et que vous souhaitez placer les fichiers 
vidéo sur un disque différent.

Link to Source Media

Sélectionnez cette option pour éviter de dupliquer 
les fichiers vidéo en vous référant aux fichiers 
d'origine. 

Copy from Source Media

Sélectionnez ce paramètre pour copier tous les 
fichiers vidéo liés aux pistes importées depuis le 
support source vers un nouvel emplacement 
spécifié. 

Import as Offline Satellite Media

(Pro Tools HD uniquement)

Sélectionnez cette option pour importer une piste 
vidéo avec des média hors ligne. Vous avez la 
possibilité d'afficher les noms des séquences et des 
clips, mais les médias vidéo demeurent hors ligne. 
Vous pouvez visionner les médias vidéo sur un 
système Video Satellite connecté. Cette option est 
disponible uniquement lorsque l'option New 
Satellite Track est sélectionnée pour la piste vidéo.

Options de mappage du timecode
Dans la boîte de dialogue Import Session Data, vous 
pouvez spécifier à quel endroit vous souhaitez placer 
les pistes importées dans la session en cours. Les 
valeurs temporelles sont exprimées en timecode.

Les options Timecode Mapping Options suivantes 
sont disponibles :

Maintain Absolute Timecode Values : cette option 
place les pistes aux emplacements qu'elles occupaient 
dans la session source. Ainsi, si la session en cours 
démarre à 00:01:00:00 et que la session à partir de 
laquelle vous importez démarre à 10:00:00:00, 
les premières pistes importées démarreront 9 heures 
et 59 minutes après le début de votre session.

Maintain Relative Timecode Values : cette option 
place les pistes en préservant leur décalage par 
rapport au début de la session dans la session 
source. Par exemple, si la session source démarre 
à 01:00:00:00 et contient une piste qui démarre 
à 01:01:00:00 et que la session en cours démarre 
à 02:00:00:00, la piste est placée à 02:01:00:00 
dans la session en cours. 

Map Start Timecode To : cette option « force » les 
pistes à démarrer à un timecode précis, tout en 
respectant leurs positions d'origine. Les valeurs 
temporelles sont exprimées au format hh:mm:ss:ii. 
Par exemple, si votre session démarre à 00:01:00:00 
et que la session à partir de laquelle vous importez 
les données démarre à 10:00:00:00, vous pouvez 
redéfinir le timecode de début sur 00:01:00:00 pour 
éviter de placer les fichiers 9 heures et 59 minutes 
après le début de la session.

Adjust Session Start Time to Match Source 
Start Time

Lorsqu'elle est sélectionnée, l'option Adjust 
Session Start Time to Match Source Start Time 
permet de définir automatiquement l'heure de 
début de la session Pro Tools actuelle pour la faire 
correspondre à l'heure de début de la session ou de 
la séquence AAF ou OMF que vous importez. 
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Options de décalage des pistes
Dans la boîte de dialogue Import Session Data, 
vous pouvez spécifier un décalage de piste en plus 
du décalage lié aux options Timecode Mapping 

Options. Les données audio importées sont 
décalées de la valeur spécifiée dans la timeline de 
la session actuelle. Les valeurs peuvent être saisies 
au format Minutes : Seconds, Bars|Beats, 
Feet.Frames, en échantillons ou en timecode. 

Options de conversion de la 
fréquence d'échantillonnage
Dans la boîte de dialogue Import Session Data, 
vous pouvez définir les options qui contrôlent la 
conversion de la fréquence d'échantillonnage 
appliquée aux fichiers audio importés. Si la session 
source et la session en cours ont la même fréquence 
d'échantillonnage, cette partie de la boîte de 
dialogue est désactivée.

Les options de conversion de la fréquence 
d'échantillonnage (Sample Rate Conversion 

(SRC)) disponibles sont les suivantes :

Source Sample Rate : pour les fichiers audio 
créés dans n'importe quelle session, quelle que soit 
sa fréquence d'échantillonnage, le processus de 
conversion de la fréquence d'échantillonnage peut 
traiter les fichiers de différentes manières pour 
compenser un facteur de pull-up ou de pull-down, 
ainsi que les cadences d'images NTSC ou PAL. 
Ce paramètre permet également de choisir la 
fréquence d'échantillonnage à partir de laquelle 
lancer la procédure de conversion. 

Destination Sample Rate : la valeur de la 
fréquence d'échantillonnage de destination 
correspond toujours à celle de la session actuelle.

Conversion Quality : cette option permet de définir 
la qualité de conversion de la fréquence 
d'échantillonnage (reportez-vous à la section 
« Sample Rate Conversion Quality » à la page 332).

Pistes source
Cette zone de la boîte de dialogue Import Session 
Data répertorie les pistes de la session source qui 
peuvent être importées, chacune disposant d'un 
menu déroulant correspondant. 

Menus Operation/Destination 
des pistes
Dans la boîte de dialogue Import Session Data, 
chaque piste source possède un menu déroulant 
correspondant qui affiche les options d'importation 
ainsi que les pistes de destination possibles dans la 
session en cours. Les menus déroulants affichent 
les éléments suivants :

Do Not Import : ni la piste source ni ses attributs ne 
sont importés. 

Import as New Track : La piste source et tous les 
attributs sélectionnés dans le menu déroulant Track 

Data to Import sont importés sur une nouvelle piste 
dans la session actuelle. 

Destination Track Names : les noms des pistes de 
destination possibles dans la session actuelle sont 
répertoriés dans la partie inférieure du menu 
déroulant. Les playlists importées et tous les 
attributs sélectionnés dans le menu déroulant Track 

Data to Import sont placés sur la piste de 
destination sélectionnée. 

Seules les pistes de destination qui correspondent 
au type de piste (audio, instrument, MIDI, entrée 
auxiliaire ou Master Fader) et au format de canal 
(mono, stéréo ou tout format multicanal pris en 
charge) de la piste source s'affichent dans le menu 
déroulant. 
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Mise en correspondance des 
pistes
Dans la boîte de dialogue Import Session Data, 
vous pouvez vous assurer de faire correspondre les 
noms de piste lors de l'importation de playlists 
à partir de pistes source portant un nom identique 
à celui des pistes de destination dans la session en 
cours (comme une nouvelle séquence d'une scène). 
Cliquez sur Match Tracks pour faire correspondre 
automatiquement les noms de piste. Les pistes 
doivent avoir le même nom, le même format de 
canal et être du même type pour pouvoir être 
automatiquement mises en correspondance.

Données des pistes à importer
Dans la boîte de dialogue Import Session Data, 
le menu déroulant Track Data to Import permet de 
sélectionner les attributs des pistes sélectionnées 
à importer dans la session actuelle. 

Les attributs sélectionnés sont appliqués à toutes 
les pistes que vous avez choisies d'importer dans la 
session actuelle.

Remplacement des attributs des pistes

Lorsque vous importez un attribut de la piste source 
sur une piste existante de la session actuelle, celui-ci 
écrase l'attribut correspondant sur la piste de 
destination. Si vous choisissez de ne pas importer un 
attribut de la piste source, l'attribut correspondant 
sur la piste de destination est conservé. 

Remplacement des noms des chemins des pistes

Lorsque vous importez une entrée, une sortie, 
une sortie de départ ou des assignations d'inserts 
matériels d'une piste, les noms de chemin et 
configurations d'E/S personnalisés de la session 
source ne sont pas importés. Vous pouvez importer 
des noms de chemin et des configurations d'E/S en 
important les paramètres I/O Setup. Pour plus 
d'informations, reportez-vous à la section 
« Paramètres d’E/S d’usine » à la page 100. 

Sélection des données de piste à importer

Vous pouvez sélectionner toutes les données des 
pistes répertoriées (All), aucune de ces données 
(None) ou les sélectionner une à une. Les choix 
disponibles pour l'importation sont les suivants :

All : importe toutes les playlists de la piste source, 
en fonction du paramètre Main Playlist Option, 
ainsi que tous les attributs de la liste Track Data to 

Import.

None : importe uniquement la playlist principale 
de la piste source, en fonction du paramètre Main 

Playlist Option. Aucun autre attribut n'est importé. 

Alternate Playlists : importe toutes les playlists 
alternatives de la piste source. Les playlists 
alternatives sont affichées dans le menu déroulant 
des playlists de la piste de destination. 

Clips and Media : importe tous les fichiers et les 
clips audio de la piste source et les place dans la 
liste des clips. 

Clips Gain : importe les réglages de gain du clip 
pour tous les clips audio importés. 

Volume Automation and Setting : importe le 
niveau du fader de volume de la piste source et 
toute donnée d'automation dans la playlist 
d'automation de volume de la piste. Le niveau du 
fader de volume et toutes les données d'automation 
de volume de la piste de destination sont 
remplacés. 

Pan Automation and Setting : importe la position 
du curseur de panoramique de la piste source et 
toute donnée d'automation dans la playlist 
d'automation du panoramique de la piste. 
La position du curseur de panoramique et toutes 
les données d'automation du panoramique de la 
piste de destination sont remplacées.
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Mute Automation and Setting : importe l'état de la 
commande mute de la piste source et toute donnée 
d'automation dans la playlist d'automation de mute 
de la piste. L'état de la commande mute et toutes 
les données d'automation de mute de la piste de 
destination sont remplacés.

Main Output Assignments : importe les 
assignations de sortie de canal de la piste source, 
y compris les assignations de sortie multiples, 
qui viennent remplacer les assignations de sortie 
de canal de la piste de destination.

Send Output Assignments : importe les 
assignations de sortie des départs de la piste source, 
qui viennent remplacer les assignations de sortie des 
départs de la piste de destination.

Plug-In Assignments : importe les assignations de 
plug-ins de la piste source. Tout plug-in de la piste 
de destination est supprimé et les paramètres qui 
y sont associés ainsi que l'automation sont perdus. 

Si la piste source utilise un plug-in qui n'est pas 
disponible dans le système de destination, 
il apparaît sur la piste de destination et est désactivé. 

Plug-In Settings and Automation : lorsque les 
assignations de plug-ins de la piste source sont 
importées, cette option importe les paramètres de 
plug-in de la piste et toute donnée d'automation 
associée aux plug-ins. Si aucune assignation de 
plug-in n'est importée, cette option n'a aucun effet.

Elastic Audio Track State : importe l'état de piste 
Elastic Audio de la piste source. Tous les 
paramètres Elastic Audio dans la session de 
destination sont remplacés.

HW Insert Assignments : importe les assignations 
des inserts matériels de la piste source, qui viennent 
remplacer les assignations d'inserts de la piste de 
destination.

Voice Assignments : importe les assignations de 
voix de la piste source depuis la session source, 
qui remplacent les assignations de voix de la piste 
de destination. 

Input Assignments : importe les assignations 
d'entrée de canal de la piste source, qui remplacent 
les assignations d'entrée de la piste de destination. 

Side-Chain Assignments : lorsque les 
assignations de plug-ins de la piste source sont 
importées, cette option importe toutes les 
assignations de side-chain associées aux plug-ins. 
Si aucune assignation de plug-in n'est importée, 
cette option n'a aucun effet.

Track Active State : importe l'état activé/désactivé 
de la piste source depuis la session source. 

Track Comments : importe les commentaires sur la 
piste associés à la piste source. Ces commentaires 
viennent remplacer ceux de la piste de destination. 

Track Colors : importe la couleur de piste associée 
à la piste source. La couleur de la piste de 
destination est alors modifiée. 

Record Safe/Solo Safe Settings : importe les 
paramètres de protection contre l'enregistrement et 
la mise en solo de la piste source depuis la session 
source, qui remplacent ces mêmes paramètres dans 
la piste de destination. 

Track View Settings : importe la hauteur de piste 
et la vue de playlist de la piste source depuis la 
session source. 

Mix/Edit Groups : importe les groupes de pistes de 
la session source.

ICON Custom Fader Groups (Pro Tools HD 
uniquement) : importe les groupes de Custom 
Faders ICON de la session source.

ICON Automation Snapshots (Pro Tools HD 
uniquement) : importe les snapshots d'automation 
ICON de la session source.
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HEAT Switch Settings (systèmes Pro Tools|HDX 
avec option logicielle HEAT uniquement) : 
importe tous les paramètres enregistrés 
d'activation du module HEAT de la session source.

Options d'importation
Les options d'importation suivantes sont 
disponibles dans la boîte de dialogue Import 
Session Data :

Import Tempo/Meter Map : importe les tables de 
métriques et de tempos, telles qu'elles apparaissent 
sur les règles de tempo et de métrique de la session 
source. Tous les événements de métrique ou de 
tempo de la session de destination sont remplacés. 

Import Key Signature/Chord Map : importe toutes 
les armures (le cas échéant) et tous les marqueurs 
d'accord dans Pro Tools lors de l'importation des 
données de session. Ces armures et marqueurs 
d'accord viennent remplacer ceux de la session de 
destination.

Import Marker/Memory Locations : importe les 
marqueurs et les emplacements mémoire tels qu'ils 
apparaissent sur la règle des marqueurs, à partir de 
la session source. Ceux qui figurent dans la session 
de destination sont conservés. Les numéros 
disponibles suivants sont attribués aux marqueurs 
et aux emplacements mémoire importés.

Import Window Configurations : importe les 
configurations de fenêtres à partir de la session 
source.

Import Mic Pre Settings : importe tous les 
paramètres de préamplificateur micro (Mic Pre) 
de Pro Tools à partir de la session source. 
Ces paramètres remplacent ceux de la session de 
destination. 

Import HEAT Master Settings (Pro Tools|HDX 
avec HEAT uniquement) : importe tous les 
paramètres HEAT prinicpaux à partir de la session 
source, dont les paramètres Bypass, Drive et Tone. 
Tous les paramètres HEAT principaux de la 
session de destination sont remplacés.

Options de playlist principale
Dans la boîte de dialogue Import Session Data, 
les options suivantes vous permettent de déterminer 
la façon dont la playlist principale de chaque piste 
source est importée sur la piste de destination dans 
la session actuelle. 

Import – Replace Existing Playlists : importe la 
playlist principale depuis la piste source. Lorsque 
vous importez la playlist sur une piste existante, 
la playlist principale de la piste de destination est 
supprimée et remplacée par la playlist importée. 

 Si vous sélectionnez cette option et importez 
tous les attributs de la piste source, cela revient 
à importer l'intégralité de la piste. 

 Si vous sélectionnez cette option et que vous 
n'importez aucun attribut de la piste source, 
les playlists audio sont remplacées, mais les 
paramètres de mixage actuels sont conservés.

Import – Overlay New On Existing Playlists : 
importe la playlist principale depuis la piste 
source. Lorsque vous importez la playlist sur une 
piste existante, un trimming est appliqué à toutes 
les données existantes de playlist qui chevauchent 
les données importées de la piste source, 
qui viennent les remplacer. Toutes les données de 
la playlist sur la piste de destination qui ne sont pas 
recouvertes sont conservées sur la piste de 
destination. 

Do Not Import : la playlist principale de la piste 
source n'est pas importée. Aucune donnée audio 
n'est importée. Seuls les attributs sélectionnés dans 
la liste Track Data to Import sont importés sur les 
pistes sélectionnées. Lorsque cette option est 
sélectionnée, l'importation de tous les attributs 
d'entrée, de sortie, de départ, d'insert et de plug-in 
de la piste source équivaut à importer tous les 
paramètres d'une tranche de console.
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Importation de séquences 
AAF et OMF
Pro Tools vous permet d'ouvrir des séquences 
AAF et OMF sous forme de nouvelles sessions 
Pro Tools ou d'importer des séquences AAF 
et OMF dans des sessions Pro Tools existantes. 
Pro Tools peut importer des séquences AAF 
et OMF exportées à partir d'autres sessions 
Pro Tools, d'Avid Media Composer ou 
d'applications tierces (telles que Final Cut Pro, 
Logic Audio, Adobe Premiere Pro et Nuendo).

Lors de l'importation de séquences AAF créées 
dans une application de montage vidéo Avid, 
Pro Tools peut importer des pistes audio aux 
formats mono, stéréo et surround 5.1 et 7.1. Les 
pistes mono avec panoramique surround 5.1 ou 7.1 
peuvent également être importées, sans que les 
informations de panoramique ne soient affectées 
(les formats multicanal supérieurs à stéréo sont 
uniquement pris en charge dans Pro Tools HD).

Lors de l'ouverture ou de l'importation d'une 
séquence AAF ou OMF, la boîte de dialogue New 
Session s'affiche et vous invite à nommer et 
à enregistrer la séquence en tant que nouvelle 
session. Une fois ces opérations effectuées, la boîte 
de dialogue Import Session Data s'ouvre. Pour plus 
d'informations, reportez-vous à la section 
« Paramètres de conversion des pistes source 
AAF/OMF » à la page 370.

Pro Tools peut importer les types de fichiers 
suivants depuis des logiciels de montage Avid :

• Séquences AAF ou OMF (y compris avec 
données audio intégrées)

• Fichiers vidéo Avid individuels au format MXF 
ou OMF

• Fichiers audio OMF et MXF

Pour importer des séquences AAF ou OMF dans 
Pro Tools, effectuez l'une des opérations 
suivantes :

 Utilisez la commande File > Import > Session 

Data.

 Utilisez la commande File > Open Session.

 Faites glisser les séquences à partir d'un 
navigateur de l'espace de travail ou du poste de 
travail.

Pour importer des fichiers vidéo Avid MXF ou OMF 
individuels dans Pro Tools, effectuez l'une des 
opérations suivantes :

 Utilisez la commande File > Import > Video.

 Faites glisser les séquences à partir d'un 
navigateur de l'espace de travail ou du poste de 
travail.

Pour importer des fichiers audio OMF ou MXF 
individuels dans Pro Tools, effectuez l'une des 
opérations suivantes :

 Utilisez la commande File > Import > Audio.

 Faites glisser les séquences à partir d'un 
navigateur de l'espace de travail ou du poste de 
travail.

L'importation et l'exportation de fichiers 
multicanal n'est possible qu'avec des séquences 
AAF.

Un boîtier Avid Mojo SDI ou Avid Mojo est 
requis pour l'importation de vidéos MXF et OMF.

Pour plus d'informations, reportez-vous à la 
section « Importation d'une séquence AAF ou 
OMF dans une session existante » à la page 363.
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Importation d'une séquence 
AAF ou OMF sous forme de 
session Pro Tools
Le moyen le plus simple d'utiliser Pro Tools pour 
éditer une séquence exportée à partir d'une 
application Avid (telle que Media Composer) est 
de l'ouvrir en tant que nouvelle session.

Pour ouvrir et importer une séquence AAF ou OMF 
dans Pro Tools :

1 Lancez Pro Tools.

2 Sélectionnez File > Open Session.

3 Dans la boîte de dialogue Open Session, 
accédez à la séquence AAF ou OMF à importer.

4 Cliquez sur Open.

5 Sélectionnez les paramètres Audio File Type, 
Sample Rate et Bit Depth de la session.

6 Pour créer des fichiers audio multicanal 
entrelacés dans la session, sélectionnez 
Interleaved.

7 Cliquez sur OK.

8 Nommez votre session dans le champ Save As.

9 Cliquez sur Save. La boîte de dialogue Import 
Session Data s'ouvre.

10 Sélectionnez une option d'importation pour 
l'audio à l'aide du menu Audio Media Options 
(reportez-vous à la section « Options des 
médias audio » à la page 366).

11 Sélectionnez une option d'importation pour 
la vidéo à l'aide du menu Audio Media Options 
(reportez-vous à la section « Options des 
médias vidéo » à la page 367).

12 Configurez les autres paramètres et options 
(reportez-vous à la section « Options 
d'importation des séquences AAF ou OMF » à 
la page 366). 

13 Cliquez sur OK.

Pro Tools crée un fichier de session à l'emplacement 
spécifié, avec les nouveaux éléments suivants :

• Dossier Audio Files

• Dossier Clip Groups

• Dossier Session File Backups 

Pro Tools ne peut pas lire les fichiers vidéo 
intégrés à une séquence AAF ou OMF.

Vous pouvez ouvrir et importer des séquences 
OMF ou AAF faisant référence à des fichiers 
audio avec diverses fréquences 
d'échantillonnage ou résolutions.

Boîte de dialogue Import Session Data
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• Dossier Video Files

• Fichier cache.wfm

Le type de fichier audio, la fréquence 
d'échantillonnage et la résolution de cette session 
sont les mêmes que pour l'audio de la séquence 
OMF ou AAF sélectionnée. Pro Tools n'importe 
pas les données vidéo incorporées à une séquence. 

Si un système Video Satellite est disponible, 
Pro Tools peut importer les métadonnées vidéo 
d'une séquence sur une piste satellite. Dans ce cas, 
la vidéo elle-même est lue sur le système Video 
Satellite, synchronisée avec Pro Tools.

Fichiers de résolution multicaméra

Sur un système Avid, les fichiers de résolution 
multicaméra affichent les angles de plusieurs 
caméras individuelles pour une même scène. Lors 
d'une exportation AAF ou OMF, l'opérateur Avid 
choisit les fichiers multicaméra (et par conséquent 
les angles de caméra) qui seront dominants. Lorsque 
vous importez une séquence AAF ou OMF dans une 
session Pro Tools, seul le clip de l'angle de caméra 
dominant s'affiche.

Importation d'une séquence 
AAF ou OMF dans une session 
existante
Vous pouvez importer une séquence AAF ou OMF 
contenant des médias audio et vidéo dans une 
session Pro Tools existante. 

Pour ouvrir et importer des pistes audio et/ou 
vidéo à partir d'une séquence OMF ou AAF :

1 Lancez Pro Tools, puis ouvrez une session 
Pro Tools existante.

2 Sélectionnez File > Import > Session Data et 
sélectionnez la séquence AAF ou OMF 
à importer.

Pour plus d'informations, reportez-vous au 
Chapitre 55, « Avid Video Satellite ».

Si une erreur se produit lors de l'importation, 
troncation d'un nom de clip ou autre (rendus 
d'effets manquants par exemple), une boîte de 
dialogue s'affiche pour vous demander si vous 
souhaitez obtenir un rapport détaillé des 
modifications. Cliquez sur Yes et sélectionnez 
l'emplacement dans lequel le fichier de log doit 
être enregistré. Le fichier de log est un fichier 
texte que vous pouvez ouvrir dans une 
application de traitement de texte.

Tous les fichiers AAF et OMF possèdent un nom 
de fichier et un identificateur unique stockés 
dans les métadonnées AAF et OMF, ainsi qu'un 
nom affiché sur le poste de travail. La troncation 
d'un nom de clip lors de la conversion ne modifie 
ni le nom, ni l'identificateur unique des fichiers 
AAF et OMF.

Vous pouvez également ouvrir une séquence 
AAF ou OMF en la faisant glisser à partir d'un 
emplacement de votre ordinateur ou d'un 
navigateur de l'espace de travail vers la timeline 
de Pro Tools.
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3 Dans la boîte de dialogue Import Session Data, 
désélectionnez toutes les pistes source que vous 
ne souhaitez pas importer. Si vous importez des 
données de session depuis des séquences AAF 
ou OMF, toutes les pistes sont sélectionnées par 
défaut. Si vous importez des pistes depuis une 
session Pro Tools, aucune piste n'est sélectionnée 
par défaut.

4 Sélectionnez les paramètres de conversion 
AAF/OMF (reportez-vous à la section 
« Paramètres de conversion des pistes source 
AAF/OMF » à la page 370).

5 Configurez les options Audio Media Options 
(reportez-vous à la section « Options des 
médias audio » à la page 366).

6 Configurez les options Video Media Options 
(reportez-vous à la section « Options des 
médias vidéo » à la page 367).

7 Configurez les options Timecode Mapping 

Options (reportez-vous à la section « Options de 
mappage du timecode » à la page 368).

8 Configurez les options Track Offset Options 
(reportez-vous à la section « Options de 
décalage des pistes » à la page 368).

9 Configurez les options Sample Rate Convert 

Options (reportez-vous à la section « Options de 
conversion de la fréquence d'échantillonnage » 
à la page 369).

10 Modifiez les autres paramètres et options, 
si nécessaire (pour plus d'informations sur la 
boîte de dialogue Import Session Data, reportez-
vous à la section « Boîte de dialogue Import 
Session Data » à la page 354). 

11 Cliquez sur OK.

12 Si les médias audio ou vidéo source sont stockés 
sur un volume inapproprié pour la lecture 
(affiché comme volume de transfert dans le 
navigateur de l'espace de travail), Pro Tools 
affiche une boîte de dialogue qui vous indique 
comment copier les médias sur un volume 
désigné pour la lecture ou l'enregistrement. 
Cliquez sur Yes.

Pro Tools importe les médias audio et vidéo dans 
la timeline. Les pistes audio avec des fréquences 
d'échantillonnage mixtes sont automatiquement 
converties à la fréquence d'échantillonnage de 
la session.

Pistes source

En présence d'erreur ou de troncation d'un nom 
de clip, une boîte de dialogue s'affiche pour 
vous demander si vous souhaitez obtenir un 
rapport détaillé des modifications. Cliquez sur 
Yes et sélectionnez l'emplacement dans lequel 
le fichier de log doit être enregistré.
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Importation de séquences audio 
AAF/OMF avec fréquences 
d'échantillonnage ou 
résolutions mixtes
Vous pouvez ouvrir et importer des séquences AAF 
ou OMF avec diverses fréquences d'échantillonnage 
et/ou résolutions dans Pro Tools.

Les fichiers audio ayant une fréquence 
d'échantillonnage différente de celle de la session 
doivent être convertis avant leur utilisation. 
Lorsqu'un fichier audio est converti, un nouveau 
fichier avec le type et la fréquence d'échantillonnage 
corrects est créé et placé dans le dossier de votre 
choix. Les fichiers audio avec des résolutions 
mixtes (et des fréquences d'échantillonnage 
correspondantes) peuvent être importés sans 
conversion.

Importation audio à partir de 
séquences AAF avec formats 
vidéo non pris en charge
Pro Tools permet d'importer de l'audio provenant 
de séquences AAF contenant des formats vidéo 
non pris en charge, notamment des fichiers vidéo 
Avid haute définition avec une cadence d'images 
supérieure à 30 images par seconde.

Les règles suivantes s'appliquent lors de 
l'importation de séquences AAF de ce type :

• Les données audio prises en charge dans ces 
séquences sont lues, mais pas les données vidéo 
non prises en charge.

• Les données vidéo non prises en charge 
s'affichent dans la timeline sous forme de blocs 
de couleur orange.

Importation de séquences 
AAF/OMF avec médias mis à plat
Pro Tools avec un périphérique vidéo Avid permet 
d'importer des séquences AAF et OMF exportées 
depuis des applications de montage Avid en 
sélectionnant File > Import > Session Data, 
ou en les faisant glisser à partir du bureau ou d'un 
navigateur de l'espace de travail vers Pro Tools. 
Pour plus d'informations, reportez-vous à la section 
« Importation de données de session » à la 
page 352. 

Lorsque la séquence contient un mixdown vidéo, 
ce mixdown et les métadonnées correspondantes 
sont affichés sur deux pistes vidéo distinctes de la 
timeline.

Lorsque la séquence contient un mixdown audio, 
ce mixdown et les métadonnées correspondantes 
sont affichés sur deux pistes vidéo distinctes de la 
timeline.

Les éventuels facteurs de pull up ou pull down 
appliqués à l'audio avant l'importation peuvent 
être compensés à l'aide du paramètre Source 
Sample Rate. Dans une séquence contenant des 
fichiers de fréquences d'échantillonnage 
mixtes, définissez la fréquence 
d'échantillonnage source par rapport à la 
fréquence d'échantillonnage cible de la 
session. Ainsi, les facteurs de pull up et pull 
down seront compensés de manière adéquate 
dans tous les fichiers, proportionnellement à 
leurs fréquences d'échantillonnage initiales.
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Options d'importation des 
séquences AAF ou OMF
Lors de l'importation de séquences AAF ou OMF, 
Pro Tools propose les options d'importation 
suivantes dans la boîte de dialogue Import Session 
Data :

• Options des médias audio

• Options des médias vidéo

• Options de mappage du timecode

• Options de décalage des pistes

• Options de conversion de la fréquence 
d'échantillonnage

• Paramètres de conversion de pistes source 
AAF/OMF

• Options de playlist principale

Options des médias audio
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, utilisez le menu déroulant Audio Media 

Options pour choisir s'il convient de copier, 
de consolider ou de lier l'audio aux médias audio 
source.

Link to Source Audio Media (Where Possible)

Sélectionnez cette option pour convertir le fichier 
AAF ou OMF en une session Pro Tools faisant 
référence à autant de fichiers média d'origine que 
possible. La session Pro Tools pointe alors vers les 
fichiers BWF (WAV) ou AIF du projet source. 

Lors de l'importation de données audio intégrées 
à une séquence AAF, Pro Tools copie ces données 
audio vers un nouveau disque ou dossier même si 
ce paramètre est sélectionné.

Copy from Source Media

Cette option permet de copier les données audio 
référencées sur un disque ou dans un dossier 
différent. 

Vous pouvez convertir la fréquence 
d'échantillonnage des données audio pendant 
l'opération.

Médias audio OMFI et mode Copy from Source 
Media

Lors de l'importation d'une séquence AAF ou 
OMF avec l'option Copy from Source Media 
activée, Pro Tools peut copier les formats OMFI 
de fichiers audio .WAV et .AIF directement dans 
la session. Cependant, Pro Tools traite les fichiers 
audio OMFI comme des fichiers en lecture seule. 

Aucun processus ou édition en mode destructif 
(comme le Crayon) ne peut être appliqué à ces 
fichiers audio, à moins de les convertir dans un 
format standard.

Pour convertir des fichiers audio OMFI pendant 
l'importation :

 Choisissez le mode Force to Target Format, 
plutôt que le mode Copy from Source Media 
dans les options d'importation. Pour plus 
d'informations, reportez-vous à la section 
« Force to Target Session Format » à la 
page 367. 

Pour convertir un fichier audio OMFI existant dans 
la session actuelle :

1 Sélectionnez l'audio à convertir.

2 Appliquez la commande Consolidate pour 
convertir l'audio sélectionné (Edit > Consolidate 

Clip).

3 Éditez et traitez les fichiers convertis 
normalement.
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Consolidate from Source Media

Cette option permet de copier les données audio du 
projet source dans la session Pro Tools, tout en 
supprimant toutes les sections inutilisées des 
fichiers copiés. Dans un projet, vous pouvez par 
exemple choisir de n'utiliser qu'un passage de dix 
secondes d'un fichier audio de dix minutes. 
La consolidation de ces données audio permet 
d'économiser une quantité d'espace importante sur 
le disque, car elle ne conserve que les données 
audio utilisées, plus la durée des poignées que vous 
avez définie, le reste étant supprimé.

Vous pouvez convertir la fréquence 
d'échantillonnage de l'audio pendant l'opération.

Force to Target Session Format

Cette option permet de convertir les médias source 
au format de fichier audio de la session, si leur 
format est différent.

Handle Size (millisecondes)

Lorsque vous sélectionnez Consolidate from 

Source Media, vous pouvez spécifier un nombre 
de millisecondes à conserver pour chaque fichier 
audio d'origine, avant et après les limites de clip 
définies dans le projet source. Vous pouvez ainsi 
étendre les limites du clip à votre guise, y compris 
après la consolidation.

Il est recommandé de sélectionner une durée d'au 
moins 1 000 millisecondes pour les poignées afin 
de pouvoir récupérer des données audio, si un 
point d'édition doit être retouché.

Options des médias vidéo
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, utilisez le menu déroulant Video Media 
Options pour choisir s'il convient de copier ou de 
lier la vidéo aux médias vidéo source.

Link to Source Media

Sélectionnez cette option pour éviter de dupliquer 
les fichiers vidéo en vous référant aux fichiers 
d'origine. 

Copy from Source Media

Sélectionnez ce paramètre pour copier tous les 
fichiers vidéo liés aux pistes importées depuis le 
support source vers un nouvel emplacement 
spécifié. 

Import as Offline Satellite Media

(Pro Tools HD uniquement)

Sélectionnez cette option pour importer une piste 
vidéo avec des médias hors ligne. Vous avez la 
possibilité d'afficher les noms des séquences et des 
clips, mais les médias vidéo restent hors ligne. 
Vous pouvez visionner les médias vidéo sur le 
système Video Satellite connecté. Cette option est 
disponible uniquement lorsque l'option New 

Satellite Track est sélectionnée pour la piste vidéo.
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Options de mappage du 
timecode
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, vous pouvez spécifier à quel endroit 
vous souhaitez placer les pistes importées dans la 
session actuelle. Les valeurs temporelles sont 
exprimées en timecode.

Maintain Absolute Timecode Values

Cette option place les pistes aux emplacements 
qu'elles occupaient dans la session source. Ainsi, 
si la session actuelle démarre à 00:01:00:00 et 
que la session source démarre à 10:00:00:00, 
les premières pistes importées démarreront 
9 heures et 59 minutes après le début de votre 
session.

Maintain Relative Timecode Values

Cette option place les pistes dans la session 
actuelle en préservant leur décalage par rapport au 
début de la session source. Par exemple, si la 
session source démarre à 01:00:00:00 et contient 
une piste qui débute à 01:01:00:00 et si la session 
actuelle démarre à 02:00:00:00, la piste est placée 
à 02:01:00:00 dans la session actuelle. 

Map Start Timecode to hh:mm:ss:ff

Cette option place les pistes de manière relative à leur 
heure de début dans la session d'origine. Par exemple, 
si la session actuelle démarre à 00:01:00:00 et que la 
session source démarre à 10:00:00:00, vous pouvez 
redéfinir le timecode de début sur 00:01:00:00 pour 
éviter de placer les fichiers 9 heures et 59 minutes 
après le début de la session.

Adjust Session Start Time to Match Source 
Start Time

Cette option fait correspondre l'heure de début de 
la session actuelle avec celle de la séquence AAF 
ou OMF en cours d'importation. Lorsqu'elle est 
activée, l'option Map Start Timecode to 

hh:mm:ss:ff (et la zone de saisie de timecode 
correspondante) sont désactivées.

Options de décalage des pistes
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, vous pouvez spécifier un décalage de 
piste en plus du décalage lié aux options de 
mappage du timecode. Les données audio 
importées sont décalées de la valeur spécifiée sur 
la timeline de la session actuelle. Les valeurs 
peuvent être spécifiées au format Bars|Beats, 
Min:Sec, Timecode, Feet.Frames ou Samples. 

Si l'heure de début de la séquence est 
ultérieure à celle de la session actuelle, 
l'option Maintain Absolute Timecode Values 
est désactivée.

Lorsque des clips de la session actuelle sont 
situés près des limites temporelles de la 
session, l'activation des options Adjust 
Session Start Time et Maintain Relative 
Timecode Values risque de déplacer ces clips 
hors des limites temporelles. Si c'est le cas, 
un avertissement s'affiche et Pro Tools ne 
modifie pas l'heure de début.
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Options de conversion de la 
fréquence d'échantillonnage
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, ces paramètres permettent de convertir la 
fréquence d'échantillonnage des fichiers audio de la 
session. Par exemple, vous pouvez effectuer une 
conversion de 48 kHz à 44,1 kHz, ou de 44,1 kHz 
à 48 kHz. Les systèmes Avid HDX et HD Native 
prennent en charge les fréquences d'échantillonnage 
supérieures à 48 kHz (88,2 kHz, 96 kHz, 176,4 kHz 
et 192 kHz). Ces options permettent également de 
compenser la modification de cadence de 0,1 % 
(pull-up ou pull-down) entre un film en 24 i/s et une 
vidéo NTSC en 29.97 i/s, ou la modification de 
cadence de 4 % (pull-up ou pull-down) entre un film 
en 24 i/s et une vidéo PAL en 25 i/s.

Source Sample Rate

Cette option permet de spécifier la fréquence 
d'échantillonnage des données audio que vous 
utilisez dans Pro Tools, indépendamment des 
paramètres de fréquence d'échantillonnage du projet.

Par exemple, vous pouvez recevoir un projet créé 
dans Media Composer en 44,1 kHz. Si vous 
souhaitez utiliser une fréquence de 48 kHz dans 
Pro Tools, définissez la fréquence d'échantillonnage 
source sur 44 100 et celle de destination sur 48 000.

Ces options permettent également de corriger les 
problèmes de pull-up ou pull-down. Un compositeur 
peut par exemple vous envoyer un transfert AAF ou 
OMF contenant des médias audio en 48 kHz et 
correspondant à une « cadence film ». Vous avez 
alors la possibilité de convertir l'ensemble des fichiers 
audio et points d'édition afin qu'ils soient lus à une 
cadence vidéo NTSC en 48 kHz. 

Pour cela, définissez la fréquence d'échantillonnage 
source sur 47 952 et celle de destination sur 48 000. 
Vous indiquez ainsi à Pro Tools que 47 952 
échantillons prélevés à partir de la cadence film 
originale doivent s'étendre sur 48 000 échantillons 
de la nouvelle cadence vidéo. Ces paramètres 
permettent de basculer la fréquence 
d'échantillonnage des données sur la cadence 
de lecture des vidéos NTSC. 

Vous pouvez définir la fréquence d'échantillonnage 
de l'audio source en sélectionnant l'un des presets du 
menu déroulant ou en saisissant une valeur dans la 
zone de texte.

Destination Sample Rate

Cette option détermine la fréquence 
d'échantillonnage audio de la session de destination, 
indiquée dans la fenêtre Session Setup, ainsi que la 
fréquence d'échantillonnage de tous les fichiers 
audio de la session de destination. Les paramètres 
disponibles comprennent les fréquences 
d'échantillonnage standard de Pro Tools (44,1 kHz 
et 48 kHz). Les systèmes Avid HDX et HD Native 
prennent en charge les fréquences d'échantillonnage 
supérieures à 48 kHz (88,2 kHz, 96 kHz, 176,4 kHz 
et 192 kHz).

Lorsque ce paramètre est différent du paramètre 
Source Sample Rate, la fréquence d'échantillonnage 
audio est convertie numériquement à la fréquence 
d'échantillonnage de destination (Destination 
Sample Rate).

Menu déroulant Conversion Quality

Ce menu déroulant permet de sélectionner les 
paramètres correspondant aux paramètres de 
conversion de la fréquence d'échantillonnage de 
Pro Tools. L'option Tweak Head (la plus lente) 
offre les meilleurs résultats.

Pour plus d'informations sur la conversion des 
différentes cadences et fréquences 
d'échantillonnage, reportez-vous à la section 
« Correction des cadences film, vidéo NTSC et 
vidéo PAL » à la page 1219.
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Paramètres de conversion des 
pistes source AAF/OMF
Pro Tools propose des options spécifiques pour la 
conversion des clips audio lors de l'importation de 
séquences AAF ou de fichiers et séquences OMF.

Import Rendered Audio Effects

L'option Import Rendered Audio Effects permet 
d'importer les clips en tant que clips audio, avec 
rendu des effets (tels qu'un EQ) appliqués aux 
clips. Désactivez cette option si vous souhaitez 
utiliser des effets et traitements audio de Pro Tools 
exclusivement pour votre travail de post-
production audio. Lorsqu'elle est désactivée, vous 
obtiendrez l'audio source non traité.

Import Clip Gain

Le paramètre Import Clip Gain permet d'importer 
entièrement les réglages de gain du clip de chaque 
clip individuel. Media Composer et d'autres 
produits Avid offrent une fonction de gain du clip, 
qui permet d'ajuster le volume d'un clip audio 
spécifique. 

Le gain du clip diffère de l'ajustement du volume 
standard d'une piste entière ou de l'automation de 
volume dans Pro Tools. Activez cette option pour 
importer les données de gain basées sur les clips de 
la séquence originale.

Import Volume Automation

Le paramètre Import Volume Automation permet 
d'importer l'automation de volume ou de l'ignorer. 
Media Composer et d'autres produits Avid gèrent 
l'automation du volume, qui permet de faire varier 
le volume en continu tout au long d'une séquence.

Pan Odd Tracks Left/Even Tracks Right

Le paramètre Pan Odd Tracks Left/Even Tracks 

Right permet de régler le panoramique de base de 
façon à ce que les pistes de numéro impair soient 
converties à l'extrême gauche, et les pistes de 
numéro pair, à l'extrême droite. Ce paramètre 
s'avère utile si vous souhaitez régler le panoramique 
d'un média audio au panoramique non défini pour le 
placer à l'extrême gauche ou l'extrême droite.

Markers To Import

Les séquences Avid Media Composer peuvent 
contenir des points de métadonnées (marqueurs) 
dont la fonction est similaire à celle des marqueurs 
de Pro Tools, qui fournissent des informations 
contextuelles sur la timeline avec un code couleur. 
Bien que ces marqueurs soient associés à des pistes 
spécifiques dans Media Composer, vous pouvez 
les importer dans Pro Tools sans importer ces 
pistes.

Lors de l'exportation d'une séquence AAF depuis 
Media Composer, les informations de marqueur 
sont incluses et peuvent être importées dans 
Pro Tools, permettant ainsi de conserver ces 
données.

Le paramètre Pan Odd Tracks Left/Even 
Tracks Right n'est pas pris en charge lors de 
l'importation de pistes audio multicanal 
à partir d'une séquence AAF. Lors de 
l'importation de pistes multicanal, 
le paramètre apparaît en grisé et les canaux 
stéréo importés sont placés à l'extrême gauche 
et l'extrême droite.

Les marqueurs peuvent être importés 
uniquement à partir de séquences AAF. 
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Pour importer tous les marqueurs : 

 Cliquez sur le menu Markers to Import et 
sélectionnez All.

Pour ne pas importer de marqueur :

 Cliquez sur le menu Markers to Import et 
sélectionnez None.

Pour importer des marqueurs en fonction de leur 
couleur :

1 Cliquez sur le menu Markers to Import.

2 Sélectionnez les couleurs des marqueurs 
à importer. Des coches s'affichent près des 
couleurs sélectionnées.

Une fois importés, les nouveaux marqueurs 
peuvent être modifiés normalement. 

Menu déroulant Track Data to Import

Le menu déroulant Track Data to Import permet de 
sélectionner les attributs des pistes sélectionnées 
à importer dans la session actuelle. Les attributs 
sélectionnés sont appliqués à toutes les pistes 
que vous avez choisi d'importer dans la session 
actuelle. Pour plus d'informations sur les options 
Track Data To Import, reportez-vous à la section 
« Données des pistes à importer » à la page 358.

Lors de l'importation d'une séquence AAF dans 
Pro Tools, utilisez le menu Track Data to Import 
pour spécifier si vous souhaitez ou non importer 
les plug-ins et paramètres de plug-in.

Pour importer les paramètres de plug-in lors de 
l'importation de pistes ou séquences AAF :

1 Ouvrez le menu Track Data to Import.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez All.

• Sélectionnez Some et assurez-vous que l'option 
Plug-in Assignments est cochée.

Pour ne pas importer les paramètres de plug-in 
lors de l'importation de pistes ou séquences AAF :

1 Ouvrez le menu Track Data to Import.

2 Sélectionnez Some et assurez-vous que l'option 
Plug-in Assignments est décochée.

Options de playlist principale
Lors de l'importation de pistes AAF ou OMF dans 
Pro Tools, vous pouvez déterminer la façon dont la 
playlist principale de chaque piste source est 
importée sur la piste de destination dans la session 
actuelle. Reportez-vous à la section « Options de 
playlist principale » à la page 360.

Contrairement aux marqueurs de Pro Tools, 
qui repèrent uniquement des positions 
temporelles spécifiques d'une session, les 
marqueurs de Media Composer renvoient 
spécifiquement à des pistes audio ou vidéo 
individuelles. Les informations permettant 
d'identifier la piste à laquelle chaque 
marqueur est associé peuvent être consultées 
dans la zone Comments de la fenêtre Memory 
Locations dans Pro Tools.

Lorsque les marqueurs sont importés dans 
Pro Tools, le texte de commentaire associé est 
ajouté au nom du marqueur dans Pro Tools 
(jusqu'à 31 caractères). Les commentaires 
comprenant plus de 31 caractères peuvent être 
affichés en totalité dans la fenêtre Memory 
Locations de Pro Tools.
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Options d'exportation de 
Media Composer pour les 
mixdowns audio et vidéo
Vous pouvez demander les options d'exportation 
suivantes pour les séquences AAF que vous 
recevez depuis une application Avid :

• Pour exporter un mixdown vidéo et ses 
métadonnées de montage correspondantes, 
le monteur vidéo Avid doit sélectionner Video 
Mixdown dans le menu déroulant Export 
Method, puis sélectionner Mixdown with Video 
Edits dans la boîte de dialogue Export Settings.

• Pour exporter un mixdown audio et ses 
métadonnées de montage correspondantes, 
le monteur vidéo Avid doit sélectionner Add 
Audio Mixdown Track(s) dans la boîte de 
dialogue Export Settings.

Problèmes d'incompatibilité 
des formats de fichier audio

Format de fichier audio AIFC
Avid Media Composer et les autres systèmes de 
montage Avid prennent en charge les fichiers 
audio au format AIFC. Il s'agit d'une version du 
format AIFF (Audio Interchange File Format) 
prenant en charge les médias compressés. 
Pro Tools peut importer et utiliser ce format, mais 
pas compresser les données audio dans ce format.

Format de fichier audio Sound 
Designer II

Prise en charge des séquences AAF 
référençant des fichiers audio SD II

Pro Tools permet d'importer des séquences AAF 
référençant des fichiers audio Sound Designer II 
(SD II). Cependant, tous les fichiers Sound 
Designer II référencés doivent être convertis au 
format de fichier de la session (WAV ou AIF).

Fichiers de notes de conversion
En présence d'erreur, de troncation d'un nom de 
clip ou d'autres notes (signalant des rendus d'effets 
manquants, par exemple) au cours de l'importation 
d'un fichier ou d'une séquence AAF ou OMF, 
une boîte de dialogue s'affiche pour vous 
demander si vous souhaitez obtenir un rapport 
détaillé des modifications. Cliquez sur Yes et 
sélectionnez l'emplacement dans lequel le fichier 
de notes de conversion doit être enregistré.

Vous pouvez ouvrir le fichier de notes de 
conversion depuis la plupart des applications de 
traitement de texte lisant les fichiers texte.

Format des notes de conversion

Les notes de conversion se présentent sous la 
forme suivante :

Nom de piste <Timecode de début – Timecode de 
fin> « nom de clip (si disponible) »;message

Notes de conversion et catégories

Le fichier de notes de conversion est divisé en 
plusieurs catégories. Voici, pour chaque catégorie, 
quelques exemples de messages, les explications 
concernant l'origine des problèmes et les solutions 
éventuelles :

Erreurs d'analyse

Exemple

A1<01:00:00:00–01:00:04:20>error 
readingcomponent « Assertion in 
OMF_Objects2x.cpp », line 2871;substituting fill.

Cette erreur indique un problème probablement 
causé par Pro Tools ou par l'application ayant créé 
le fichier AAF ou OMF. Un silence ou un noir 
vidéo apparaît au niveau de l'intervalle spécifié 
dans la composition convertie.
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Rendus manquants

Exemple 1

A1<01:00:02:00–01:00:07:01> no rendering 
foreffect:EFF_AUDIO_EQMB;using bypass clip.

Cette erreur indique la présence d'un effet pour 
lequel il n'existe aucun rendu. Le clip « bypass » 
correspond au matériel source (non traité) de l'effet. 

Exemple 2

V1<01:00:48:25–01:00:49:26>no rendering 
foreffect: omfi:effect: 
VideoRepeat;substitutingsilence/video black.

La durée de sortie de certains effets n'est pas 
identique à celle d'entrée. Dans ce cas, la substitution 
par un clip bypass est inutile lorsqu'un rendu est 
manquant, car la synchronisation serait incorrecte. 
Pro Tools insérera donc un silence ou du noir vidéo.

Effets ignorés

A1<01:00:02:00–01:00:07:01>ignoring 
rendering for effect: EFF_AUDIO_EQMB;using 
bypass clip.

Cette erreur indique que l'utilisateur a sélectionné 
l'option Ignore Rendered Audio Effects dans 
Pro Tools. Cette note permet à l'utilisateur de 
déterminer, lorsque la séquence convertie présente 
des caractéristiques inhabituelles, si un effet qui 
a été ignoré est en réalité nécessaire.

Rendu incomplet

A1<00:00:28:29-00:00:31:17> 
incompleterendering for effect Audio MultiBand 
EQ;usingbypass clip.

Ce message indique qu'un effet a été rendu de 
manière incomplète au niveau d'une limite de fondu 
dans un système Avid. Lors de l'importation, 
Pro Tools a ignoré le rendu incomplet et importé les 
données audio sans l'effet. Si vous avez besoin de 
l'effet et du fondu, ceux-ci doivent faire l'objet d'un 
nouveau rendu sur le système Avid, puis être de 
nouveau exportés. Erreurs diverses (Misc Errors)

Exemple

A1<01:00:00:00–01:00:16:06>“Jag film to 
Whirl.01.Sub.06.new.01”; insufficient 
sourcematerial for clip;shortening clip by 1 
sample.

Cette note de conversion à caractère essentiellement 
informatif vous indique que Pro Tools n'a pas pu 
convertir correctement la séquence AAF ou OMF et 
qu'il a effectué un ajustement pour que le système 
puisse la comprendre.

Cette erreur est due au fait que les applications ne 
calculent pas toujours de la même manière le 
nombre d'échantillons contenus dans une image. 
Dans certains cas, il peut arriver que la prise en 
charge d'un clip spécifique soit impossible en 
raison de l'absence d'un échantillon de média au 
niveau de Pro Tools. Dans une telle situation, un 
« clic » audio peut se faire entendre. 

Exportation de pistes de 
Pro Tools en tant que 
séquences AAF ou OMF
Pro Tools permet d'exporter des pistes 
individuelles au format AAF ou OMF. Utilisez la 
commande Export Selected Tracks as AAF/OMF.

Les séquences AAF et OMF exportées depuis 
Pro Tools ne prennent pas en charge les fichiers 
vidéo. Elles ne conservent pas non plus les 
informations relatives aux assignations de plug-in, 
paramètres, marqueurs, options de routing ou 
groupements. Il est recommandé d'effectuer le 
rendu de tous les effets avant de procéder à une 
exportation.
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Pour exporter les pistes audio sélectionnées sous 
forme de séquence AAF ou OMF :

1 Dans Pro Tools, sélectionnez les pistes 
à exporter. Sélectionnez des fichiers mixtes 
ou non mixtes.

2 Sélectionnez File > Export > Selected Tracks as 

OMF/AAF.

3 Dans le menu déroulant Export As, sélectionnez 
AAF ou OMF.

4 Si vous souhaitez forcer la compatibilité avec 
Avid, sélectionnez Enforce Avid Compatibility.

5 Assurez-vous de sélectionner l'option Target 

Project Timecode Format appropriée pour le 
projet, en vérifiant si le format correspond 
à celui du projet dans l'application cible (Avid 
Media Composer, par exemple).

6 Configurez les options Sample Rate 

Conversion Options.

7 Configurez les options des médias audio en 
effectuant les opérations suivantes :

• Assurez-vous que le format (Format) et la 
résolution (Bit Depth) correspondent aux 
paramètres de votre projet cible (définis pour 
le projet dans votre application vidéo).

Pro Tools peut exporter des séquences AAF ou 
OMF liées à des fichiers audio RF64 (fichiers 
WAV dont la taille dépasse la taille standard 
de 2 Go). Cependant, les applications de 
montage vidéo Avid ne peuvent pas ouvrir de 
fichiers WAV supérieurs à 2 Go. Souvenez-
vous en lorsque vous exportez des séquences 
AAF/OMF pour des utilisateurs d'applications 
de montage vidéo Avid.

Boîte de dialogue Export to OMF/AAF

Pour sélectionner plusieurs pistes, maintenez la 
touche Maj enfoncée et cliquez sur les pistes de 
votre choix. Pour sélectionner toutes les pistes, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez.

L'option Enforce Avid Compatibility limite la 
fréquence d'échantillonnage à 44,1 ou 48 kHz 
et permet d'exporter les données de gain du 
clip. Un dithering sans mise en forme du bruit 
est appliqué aux fichiers 24 bits exportés en 
16 bits.
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• Sélectionnez une option de copie (Copy Option : 
Link to Source Media, Copy from Source Media 
ou Consolidate from Source Media).

8 Si vous exportez une séquence qui contient des 
pistes stéréo, 5.1 ou 7.1 dont vous ne souhaitez 
pas modifier la disposition des canaux lors de 
l'exportation, activez l'option Export Stereo, 

5.1 and 7.1 Tracks as Multi-Channel.

9 Configurez les autres options d'exportation.

10 Cliquez sur OK.

11 Dans la boîte de dialogue Publishing Options, 
remplissez les champs Comments et Sequence 
Name.

12 Cliquez sur OK. 

13 Dans la boîte de dialogue Save, accédez à un 
dossier dans lequel vous pourrez facilement 
rechercher la séquence AAF ou OMF au moment 
de la distribuer à un autre système de montage ou 
de l'importer dans Media Composer.

14 Cliquez sur Save.

15 Dans la boîte de dialogue Please Choose 
a Folder for Converted Audio Files, accédez 
à un dossier dans lequel vous pouvez facilement 
rechercher les fichiers média (comme le dossier 
servant à stocker la séquence AAF ou OMF).

16 Cliquez sur Choose (Mac) ou Use Current 

Folder (Windows).

Pro Tools exporte la composition et les fichiers 
média associés dans les dossiers appropriés.

Exportation de pistes audio 
multicanal
Lorsque vous exportez des séquences AAF, 
les pistes stéréo, 5.1 et 7.1 peuvent être exportées 
en tant que pistes multicanal ou pistes mono 
divisées. Lorsque vous exportez des séquences au 
format OMF, les pistes multicanal sont toujours 
exportées en tant que fichiers multi mono.

Exportation du gain du clip
Lorsque vous exportez au format AAF avec l'option 
Enforce Avid Compatibility activée, Pro Tools crée 
pour chaque piste des données de gain du clip 
similaires à celles de Media Composer. 

Pendant l'exportation, le gain du clip des clips 
Pro Tools avec un volume statique compris en-
trinf dB et +12 dB est converti en gain basé sur les 
clips. Le gain de clip dynamique et les valeurs 
supérieures à 12 dB seront rendus pour chaque clip 
afin d'optimiser la compatibilité avec les 
applications de montage vidéo Avid.

Pour plus d'informations, reportez-vous à la 
section « Options d'exportation des séquences 
AAF ou OMF » à la page 379.

Boîte de dialogue Publishing Options (avec option 
Export Selected Tracks as OMF/AAF)

Certains systèmes de montage vidéo (tels que 
Avid Media Composer) nécessitent que tous les 
fichiers média soient stockés dans des dossiers 
spécifiques pour rétablir les liens correctement.

Vous ne pouvez pas exporter de pistes vidéo au 
format AAF ou OMF à partir de Pro Tools.

Vous devez activer l'option Enforce Avid 
Compatibility pour exporter ces données de 
gain basé sur les clips.

Le gain basé sur les clips n'est pas exporté au 
format OMF.
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Exportation de l'automation de volume au 
format OMF

Pro Tools exporte l'automation de volume au 
format OMF à la seule condition que l'option 
Enforce Avid Compatibility soit désactivée.

Exportation de fondus
Pro Tools prend en charge la création de fondus 
audio en temps réel et rend sur disque tous les 
fondus de la session lors de l'exportation au format 
AAF ou OMF afin d'optimiser la compatibilité 
avec les application de montage vidéo Avid.

Groupes de clips
Pro Tools ne peut pas exporter de pistes avec des 
groupes de clips lors de l'exportation au format 
AAF ou OMF. Avant d'exporter les pistes d'une 
séquence au format AAF ou OMF, veillez à ne pas 
sélectionner des pistes qui contiennent des groupes 
de clips.

Exportation de pistes 
Pro Tools sous forme de 
fichiers audio MXF
Vous pouvez exporter des fichiers audio MXF en 
utilisant les commandes suivantes :

• Export Selected Tracks as OMF/AAF

• Bounce to Disk

• Export Selected Clips as Files

Exportation de séquences AAF 
contenant des données audio 
MXF
Utilisez l'option Export Selected Tracks as 

OMF/AAF pour exporter des pistes individuelles 
ou une session Pro Tools complète sous forme 
de séquence AAF référençant des fichiers 
audio MXF.

Pour exporter les pistes audio sélectionnées 
à partir de Pro Tools sous forme de séquence AAF 
référençant des fichiers audio MXF :

1 Dans Pro Tools, sélectionnez les pistes à 
exporter.

2 Sélectionnez File > Export > Selected Tracks as 

OMF/AAF.

3 Sous OMF/AAF Options, sélectionnez AAF dans 
le menu déroulant Export As.

Les fondus sont rendus et exportés, que 
l'option Link to Source Media soit activée ou 
non pendant la création d'une séquence 
AAF/OMF.

Les pistes sont exportées dans leur intégralité 
et les sélections temporelles sont ignorées.

L'automation de volume et de panoramique 
n'est pas exportée si l'option Quantize Edits 
to Frame Boundaries est activée ou si le mode 
Avid Compatibility est sélectionné.
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4 Sélectionnez Enforce Avid Compatibility.

5 Assurez-vous que le format de timecode du 
projet cible (Target Project Timecode Format) 
est approprié pour le projet de l'application Avid 
vers lequel vous souhaitez exporter la séquence 
AAF. 

6 Sous la section Audio Media Options, 
sélectionnez MXF dans le menu déroulant 
Audio Format.

7 Assurez-vous que le paramètre de résolution 
audio (Audio Bit-Depth) convient au destinataire 
de l'exportation. 

8 Si vous exportez une séquence qui contient des 
pistes stéréo, 5.1 ou 7.1 et souhaitez que ces 
pistes soient exportées en tant que fichiers audio 
multicanal, activez l'option Export Stereo, 

5.1 and 7.1 Tracks as Multi-Channel.

9 Cliquez sur OK. 

10 Dans la boîte de dialogue Publishing Options, 
remplissez les champs Comments et Sequence 
Name. 

Pro Tools crée une séquence portant le nom que 
vous avez spécifié. Le commentaire apparaît dans 
la colonne Pro Tools Comment du chutier de 
l'application Avid.

11 Cliquez sur OK.

12 Dans la boîte de dialogue Name the AAF File to 

Export, accédez à un dossier dans lequel vous 
pourrez facilement rechercher la séquence AAF 
au moment de la distribuer à un autre monteur 
ou de l'importer dans Media Composer.

13 Cliquez sur Save.

14 Dans la boîte de dialogue Please Choose 

a Folder for Converted Audio Files, naviguez 
jusqu'à un dossier dans lequel vous pourrez 
facilement rechercher les fichiers médias 
(comme le dossier servant à stocker la séquence 
AAF ou OMF).

15 Cliquez sur Choose (Mac) ou Use Current 

Folder (Windows).

Pro Tools exporte la séquence AAF dans le dossier 
sélectionné, et les médias associés dans le dossier 
OMFI MediaFiles (fichiers OMF) ou Avid 
MediaFiles (fichiers MXF).

16 Avant d'importer les fichiers dans l'application 
Avid, quittez Pro Tools.

Une séquence OMF ne peut pas référencer des 
fichiers média MXF. Si vous utilisez la boîte de 
dialogue Export Selected Tracks as OMF/AAF, 
sélectionnez AAF dans le menu déroulant 
Export As afin d'activer MXF dans le menu 
Audio Format.

L'option Enforce Avid Compatibility crée des 
montages d'une précision à l'image près, exporte 
les fichiers au format OMFI (sauf si vous 
spécifiez MXF) et limite les options de fréquence 
d'échantillonnage à 44,1 ou 48 kHz. 
Un dithering sans mise en forme du bruit est 
appliqué aux fichiers 24 bits exportés en 16 bits.

Certains systèmes de montage vidéo (tels que 
Avid Media Composer) nécessitent que tous les 
fichiers média soient stockés dans des dossiers 
spécifiques pour rétablir les liens correctement.

Pour plus d'informations sur l'utilisation des 
applications Avid, reportez-vous au guide de 
votre application Avid.
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Exportation de fichiers audio 
MXF à l'aide la commande 
Bounce to Disk
Vous pouvez utiliser la commande Bounce to Disk 
pour créer des fichiers audio MXF bouncés de la 
session Pro Tools actuelle. Les fichiers individuels 
de la timeline ne sont pas tous exportés, mais cette 
commande vous garantit que le mixage que vous 
écoutez dans une autre application sera identique 
à celui que vous écoutez dans Pro Tools, 
notamment au niveau du panoramique, 
de l'automation et des effets.

Pour exporter au format MXF à l'aide de la 
commande Bounce to Disk :

1 Une fois l'enregistrement et le mixage d'une 
session Pro Tools terminés, sélectionnez la 
durée de la session sur la règle de la timeline 
(ou sur une piste), ainsi qu'une plage temporelle 
supplémentaire afin d'éviter que les éventuelles 
queues de réverbération soient coupées.

2 Sélectionnez File > Bounce To > Disk.

3 Dans la boîte de dialogue Bounce, sélectionnez 
l'option Bounce Source. 

4 Sélectionnez Enforce Avid Compatibility.

5 Sélectionnez MXF comme type de fichier 
(File Type).

6 Sélectionnez une fréquence d'échantillonnage 
(Sample Rate) et une résolution (Bit Depth). 

7 Cliquez sur Bounce.

8 Dans la boîte de dialogue Publishing Options, 
procédez comme suit : 

• Remplissez les champs Comment et Clip Name.

• Sélectionnez un format de timecode pour le 
projet cible (Target Project Timecode Format) 
correspondant au projet de l'application Avid 
vers lequel vous exportez le fichier audio MXF. 

L'option Enforce Avid Compatibility crée des 
montages d'une précision à l'image près, 
exporte les fichiers au format OMFI (sauf si 
vous spécifiez MXF) et limite les options de 
fréquence d'échantillonnage à 44,1 ou 48 kHz. 
Un dithering sans mise en forme du bruit est 
appliqué aux fichiers 24 bits exportés en 
16 bits.

Boîte de dialogue Bounce de Pro Tools (type de fichier 
MXF)

Boîte de dialogue Publishing Options
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Toute donnée audio audible dans la sélection est 
exportée vers deux fichiers audio multi-mono.

9 Dans la boîte de dialogue Save Bounce As, 
sélectionnez le disque sur lequel vous souhaitez 
enregistrer les fichiers.

10 Cliquez sur Save.

Pro Tools lance le bounce sur disque. Les bounces 
Pro Tools s'effectuent en temps réel, ce qui permet 
d'écouter la lecture audio du mixage pendant 
l'opération (sans pouvoir le modifier).

Exportation d'un clip sous forme 
de fichier MXF
La commande Export Selected As Files permet 
d'exporter des clips sous forme de fichiers audio 
MXF. Cette commande est utile si vous envisagez 
d'utiliser un clip dans d'autres sessions (ou dans 
d'autres applications audio) sans utiliser son fichier 
source parent. 

Cette commande permet également de convertir 
des clips dans une fréquence d'échantillonnage ou 
résolution différente.

Pour exporter des clips en tant que nouveaux 
fichiers MXF :

1 Dans la liste des clips, sélectionnez les clips 
à exporter.

2 Dans le menu déroulant Audio Clips List, 
sélectionnez Export Selected As Files.

3 Dans la boîte de dialogue Export Selected, 
sélectionnez l'option Enforce Avid Compatibility.

4 Sélectionnez MXF dans le menu déroulant 
Audio Format.

5 Spécifiez la résolution et la fréquence 
d'échantillonnage. Indiquez également la 
qualité de la conversion et le répertoire de 
destination.

6 Cliquez sur OK.

Options d'exportation des 
séquences AAF ou OMF
Pro Tools offre plusieurs options de conversion 
lors de l'exportation des pistes au format 
OMF/AAF, dont les options OMF/AAF, 
les options de conversion de la fréquence 
d'échantillonnage et les options des médias audio.

Options OMF/AAF
Lors de l'exportation des pistes au format AAF ou 
OMF, Pro Tools propose les options OMF/AAF 
suivantes :

Enforce Avid Compatibility

Lorsque l'option Enforce Avid Compatibility est 
activée, les fichiers et séquences AAF et OMF 
répondent aux exigences spécifiques des stations 
de travail vidéo Avid. Les seules fréquences 
d'échantillonnage disponibles sont 44,1 kHz et 
48 kHz. Des marges sont ajoutées aux clips exportés 
en s'alignant sur les limites d'image les plus proches 
(Quantize Edits to Frame Boundaries). Grâce à ces 
marges, le placement d'un fichier dans la timeline 
sera le même sur des systèmes offrant une précision 
à l'échantillon près et sur des systèmes offrant une 
précision à l'image près. 

L'option Enforce Avid Compatibility crée des 
montages d'une précision à l'image près, 
exporte les fichiers au format OMFI (sauf si 
vous spécifiez MXF) et limite les options de 
fréquence d'échantillonnage à 44,1 ou 48 kHz. 
Un dithering sans mise en forme du bruit est 
appliqué aux fichiers 24 bits exportés en 16 bits.

Pour exporter une séquence avec des pistes 
audio multicanal, l'option Enforce Avid 
Compatibility doit être activée.
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Target Project Timecode Format

Sélectionnez le format du timecode du projet dans 
lequel sera importé(e) ce fichier ou cette séquence 
(il peut ne pas correspondre à celui de la session 
actuelle). Ce paramètre permet de placer 
correctement les clips dans les sessions dont le 
timecode possède un format différent et de calculer 
le nombre d'échantillons à ajouter aux clips alignés 
sur les limites de l'image.

Quantize Edits to Frame Boundaries

Pro Tools offre une précision à l'échantillon 
près pour le positionnement des clips. En effet, 
Pro Tools vous permet de placer un clip de 
n'importe quelle longueur à l'endroit de votre 
choix, sans devoir l'aligner sur les limites de 
l'image.

En général, les programmes de montage vidéo tels 
que Media Composer, ne prennent en charge que le 
montage précis à l'image près et, en conséquence, 
ne permettent de modifier que les sons des limites 
des images entières, ce qui réduit quelque peu la 
précision.

La sélection de l'option Enforce Avid Compatibility 
sélectionne automatiquement l'option Quantize 

Edits to Frame Boundaries.

L'option Quantize Edits to Frame Boundaries 
permet à Pro Tools d'exporter vos montages 
Pro Tools à l'échantillon près dans un fichier AAF 
ou OMF afin qu'ils apparaissent avec une précision 
à l'image près.

Lorsque vous quantifiez des montages sur les 
limites d'image, vous devez saisir une taille de 
marge (longueur) dans les options des médias 
audio. Reportez-vous à la section « Consolidate 
Handle Size (millisecondes) : » à la page 383.

Un master clip formé du clip et de la taille 
(longueur) des marges avant et arrière est alors 
exporté. La séquence exportée crée un sous-clip 
équivalent au clip d'origine, mais étendu aux limites 
d'image les plus éloignées. Par exemple, si le clip 
commence à la position 1:15 et 500 échantillons, 
le sous-clip démarre à la position 1:15 ; s'il finit à la 
position 4:00 et 500 échantillons, le sous-clip finit 
à la position 4:01.

Vous devez sélectionner le paramètre 
Quantize Edits to Frame Boundaries lors de la 
conversion d'une session Pro Tools devant 
être utilisée sur une station de montage offrant 
une précision à l'image près. C'est pour cette 
raison qu'il est sélectionné automatiquement 
lorsque vous exportez des pistes et que l'option 
Enforce Avid Compatibility est activée.

Clip d'origine

Clip exporté avec marges

Sous-clip : clip étiré vers les limites d'image les plus 
éloignées

Sous-clip avec fichiers OFF (à image unique) 
superposés sur les images de fin
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Comme la quantification des points d'édition sur 
les limites d'image étend les clips, vous risquez 
d'entendre des sons supplémentaires indésirables. 
Pour empêcher la lecture de ces sons, des fichiers 
audio spéciaux d'une seule image sont rendus pour 
dupliquer les limites d'origine du clip. Dans la 
séquence exportée, ces fichiers à image unique 
sont placés sur les images de début et de fin du clip 
étendu pour que vous ne puissiez pas entendre 
l'extension.

Les fichiers à image unique (OFF) sont importés 
dans les stations de travail Avid en tant qu'élément 
de la séquence AAF ou OMF, comme n'importe 
quel autre fichier audio. Dans la timeline Avid, 
ils apparaissent sous forme de montages à image 
unique sur l'un des côtés d'un sous-clip.

Si vous choisissez d'étendre le sous-clip à un point, 
annulez le fichier OFF et effectuez les retouches 
nécessaires sur le sous-clip.

Export Stereo, 5.1, and 7.1 Tracks as Multi-
Channel

Sélectionnez cette option pour que Pro Tools 
exporte l'audio des pistes multicanal sous forme de 
fichiers audio multicanal au lieu de les exporter en 
tant que plusieurs fichiers mono.

Options de conversion de la 
fréquence d'échantillonnage
Ces options permettent de convertir la fréquence 
d'échantillonnage de la session Pro Tools lors de 
l'exportation au format AAF ou OMF en 
convertissant la fréquence d'échantillonnage de 
chaque fichier audio et en ajustant les montages 
dans le fichier AAF ou OMF créé pour compenser 
cette modification.

Il peut être utile de modifier la fréquence 
d'échantillonnage d'une session lorsque 
l'exportation vers un système ou l'étape du 
processus requiert une fréquence d'échantillonnage 
différente.

Votre session peut par exemple contenir des 
médias audio en 29.97 i/s (vidéo NTSC) et 48 kHz, 
et le compositeur auquel vous envoyez la session 
exportée peut demander des médias audio en 24 i/s 
(cadence film) et 48 kHz. Pour convertir tous les 
fichiers audio et points d'édition pour une lecture 
en 24 i/s (vitesse film) et 48 kHz, configurez le 
paramètre Source Audio Sample Rate sur 48 048 
(pull up de 0,1 %) et le paramètre Destination 
Audio Sample Rate sur 48 000. Vous indiquez 
ainsi à Pro Tools que 48 048 échantillons prélevés 
à partir de la cadence vidéo originale doivent tenir 
dans 48 000 échantillons de la nouvelle cadence 
film. Ces paramètres vous permettent de convertir 
la fréquence d'échantillonnage des données vidéo 
à la cadence de lecture cinématographique.

Cette solution est disponible uniquement 
lorsque vous exportez une séquence, et 
non pas lorsque vous exportez des fichiers 
un à un. 

Si vous sélectionnez l'option Quantize Edits 
to Frame Boundaries, l'automation de 
volume Pro Tools ne sera pas exportée.

Pour plus d'informations sur la conversion 
des différentes cadences et fréquences 
d'échantillonnage, reportez-vous à la section 
« Correction des cadences film, vidéo NTSC et 
vidéo PAL » à la page 1219.

Vérifiez les options de pull up/pull down audio 
et vidéo avant d'appliquer une conversion de la 
fréquence d'échantillonnage à la session 
entière.
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Source Audio Sample Rate

Ce paramètre permet de spécifier la fréquence 
d'échantillonnage des données que vous utilisez 
dans Pro Tools, indépendamment des paramètres 
de fréquence d'échantillonnage de la session.

Destination Audio Sample Rate

Ce paramètre permet de spécifier la fréquence 
d'échantillonnage des fichiers audio après une 
conversion au format AAF ou OMF. 

Lorsque ce paramètre est différent du paramètre 
Source Sample Rate, l'audio est converti 
numériquement à la fréquence d'échantillonnage 
de destination Destination Audio Sample Rate.

Sample Rate Conversion Quality

Ces paramètres correspondent aux paramètres de 
conversion de la fréquence d'échantillonnage de 
Pro Tools. Il est déconseillé d'utiliser le paramètre 
Low (le plus rapide). Le paramètre Tweak Head 
(le plus lent) offre la meilleure qualité de 
conversion de la fréquence d'échantillonnage.

Options des médias audio
Lors de l'exportation de pistes au format AAF ou 
OMF, Pro Tools propose les options relatives aux 
médias audio suivantes :

Audio Format

Spécifiez si le fichier AAF ou OMF créé doit faire 
référence aux fichiers BWF (.WAV), AIFF, SD II 
(Mac et OMF uniquement), MXF (AAF 
uniquement) ou aux fichiers intégrés. Les fichiers 
audio sont convertis en conséquence.

Bit Depth

Sélectionnez la résolution cible des médias 
exportés (16 ou 24 bits). Lorsque la résolution 
est réduite de 24 à 16 bits, Pro Tools applique 
automatiquement un dithering sans mise en forme 
du bruit.

Source Media

Lors de l'exportation de pistes de Pro Tools au 
format AAF ou OMF, Pro Tools peut traiter les 
médias audio source de trois façons (proposées 
dans la fenêtre Audio Media Options de la boîte de 
dialogue Export to OMF/AAF).

Link To Source Media : crée un fichier AAF ou 
OMF qui référence autant de fichiers média 
d'origine que possible. Dans ce cas, le fichier AAF 
ou OMF pointe vers les fichiers BWF (.WAV), 
MXF, AIFC ou Sound Designer II depuis le projet 
source.

Copy From Source Media : copie l'audio sur un 
autre disque ou dans un dossier différent. Au cours 
de cette conversion, vous pouvez modifier la 
fréquence d'échantillonnage audio.

Si vous créez des fichiers audio AIFF ou BWF 
(.WAV), des données OMF supplémentaires 
leur sont associées. Bien que ces fichiers audio 
soient lus par la plupart des applications, 
ils peuvent ne pas être compatibles avec toutes 
les applications.

L'option MXF est disponible uniquement 
lorsque vous sélectionnez l'option Enforce Avid 
Compatibility.
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Consolidate From Source Media : copie 
uniquement les parties des fichiers réellement 
utilisées dans la session. Dans un projet, vous 
pouvez par exemple choisir de n'utiliser qu'un 
passage de dix secondes d'un fichier audio de dix 
minutes. La consolidation de l'audio permet 
d'économiser une quantité d'espace importante sur 
le disque : vous ne copiez en effet que l'audio 
utilisé et supprimez le reste. 

Consolidate Handle Size (millisecondes) : 
indique le nombre de millisecondes du fichier audio 
original qui doivent être conservées au début et à la 
fin de chaque clip audio créé. Cette option permet 
d'étendre les limites du clip de la quantité de votre 
choix, même après la consolidation. Il est 
recommandé de sélectionner une durée d'au moins 
1 000 millisecondes (une seconde) pour les 
poignées afin de pouvoir récupérer des données 
audio, si un point d'édition doit être retouché. 
Le paramètre Consolidate Handle Size est 
disponible uniquement lorsque l'option Consolidate 

From Source Media est sélectionnée.

Export Stereo, 5.1, and 7.1 Tracks as Multi-
Channel

Activez cette option si vous souhaitez conserver 
la disposition des canaux lors de l'exportation 
d'une séquence avec des pistes multicanal (stéréo, 
5.1 ou 7.1).

Options de publication
Lors de l'exportation de fichiers AAF ou OMF 
depuis Pro Tools, la boîte de dialogue Publishing 
Options vous donne accès aux options de 
publication spécifiques qui fournissent des 
informations sur la séquence ou les médias. 
Ces options varient en fonction de la méthode 
d'exportation des fichiers utilisée.

Options OMF

Pro Tools Comment : identifie la source du 
fichier. Le nom de la session actuelle est attribué 
par défaut. Ce champ ne s'affiche pas si vous 
utilisez la commande Export Selected as Tracks, 
car les données audio d'une piste peuvent provenir 
de plusieurs sources différentes.

Sequence Name : correspond au nom qui s'affiche 
lors de l'importation du fichier dans un autre 
programme prenant en charge le format AAF ou 
OMF. Le nom de la séquence est différent du nom 
du fichier qui s'affiche dans le navigateur. Par 
défaut, ce champ adopte le nom du clip Pro Tools. 
Lors de l'exportation de plusieurs clips, tous les 
clips adoptent automatiquement ce nom.

Target Project Timecode Format : correspond au 
format de timecode du projet dans lequel sera 
importé ce fichier ou cette séquence (il peut ne pas 
correspondre à celui de la session actuelle). 
Ce paramètre permet de placer correctement les 
clips dans les sessions dont le timecode possède un 
format différent et de calculer le nombre 
d'échantillons à ajouter aux clips alignés sur les 
limites de l'image.

Marquage temporel

Lors de l'exportation au format AAF ou OMF, 
un marqueur temporel est inséré dans tous les 
médias exportés. Ce marqueur temporel représente 
un emplacement de timecode spécifique enregistré 
à l'intérieur d'un fichier média individuel.

Lorsque vous sélectionnez l'option Quantize 
Edits to Frame Boundaries, l'option Consolidate 
Source Audio Media est la seule disponible lors 
d'une conversion depuis Pro Tools au format 
AAF ou OMF. Reportez-vous à la section 
« Quantize Edits to Frame Boundaries » à la 
page 380.
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Le marqueur temporel peut indiquer :

• l'emplacement de timecode sur la bande source ;

• l'emplacement d'origine du fichier dans la 
timeline de Pro Tools ;

• l'emplacement d'un clip dans une timeline 
d'Avid ou de Pro Tools ;

• des timecodes saisis par un utilisateur.

Vous pouvez stocker les marqueurs temporels 
à trois endroits différents dans un fichier média :

• dans une définition de clip ;

• dans les métadonnées de format du fichier 
(encapsulations de fichier .WAV par exemple) ;

• dans l'encapsulation AAF ou OMF.

Exportation d'un clip

Lorsque vous exportez un clip, le marqueur 
temporel est placé sur le point de début du clip, 
par rapport au point où le fichier a commencé 
l'enregistrement. Par exemple, si vous enregistrez 
un fichier de la position 1:00 à la position 1:30 et 
que vous effectuez un trim pour qu'il commence 
à la position 1:15, le marqueur temporel du clip 
exporté est placé à la position 1:15. Ceci s'applique 
même lorsque le clip est déplacé par glissement 
à un autre emplacement dans la timeline.

Exportation d'un clip en tant que partie 
d'une séquence

Lorsque vous exportez un clip en tant que partie 
d'une séquence, le marqueur temporel d'origine du 
clip reflète la position de ce dernier dans la 
timeline de la séquence.

Exportation d'un fichier

Enregistré dans Pro Tools : si le fichier a été 
enregistré dans Pro Tools, le marqueur temporel 
correspond à l'emplacement du début de 
l'enregistrement dans la timeline. Par exemple, 
si vous enregistrez le fichier de la position 1:00 à la 
position 2:00, le marqueur temporel est placé à la 
position 1:00.

AudioSuite : ce marqueur temporel représente un 
emplacement de timecode spécifique enregistré 
à l'intérieur d'un fichier média individuel. En mode 
Create Individual Files, le marqueur temporel 
correspond au marqueur temporel d'origine du 
fichier source. En mode Create Continuous File, 
le marqueur temporel correspond à la position du 
fichier source sur la timeline.

Marqueur temporel existant : si vous importez un 
fichier possédant déjà un marqueur temporel, 
ce dernier est utilisé pour le fichier exporté. Si le 
fichier d'origine contient un marqueur temporel 
dans l'encapsulation de format, il est copié dans 
l'encapsulation OMF lors de l'exportation.

Exportation d'un fichier sans marqueur 
temporel

Lorsque vous importez un fichier ne contenant pas 
de marqueur temporel (tel qu'un effet sonore 
provenant d'un CD), le marqueur temporel 
correspond à 0 lors de l'exportation du fichier.

Importation de fichiers à partir d'une 
séquence Avid AAF ou OMF

Lorsque vous importez un fichier depuis une 
séquence Avid AAF ou OMF, le marqueur temporel 
de la bande source du fichier média devient le 
marqueur temporel d'origine du nouveau fichier 
Pro Tools. Le marqueur temporel utilisateur 
conserve le marqueur temporel d'origine.

L'espace de travail comprend des colonnes 
pour certaines métadonnées de séquences Avid 
OMF, dont : Clip Name, Tape, FPS, Original 
Timestamp et User Timestamp.
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Exportation d'une sélection 
de pistes en tant que 
nouvelle session
Pro Tools permet d'exporter n'importe quelle 
sélection de pistes d'une session en tant que 
nouvelle session. Cette commande remplace 
l'option Export Session Data disponible dans les 
versions antérieures de Pro Tools. Cette fonction 
est particulièrement utile pour les projets 
collaboratifs. 

Supposons que vous travailliez sur une importante 
session de post-production et souhaitiez que votre 
collaborateur travaille uniquement sur certains 
dialogues, pendant que vous continuez à travailler 
sur le reste de la session. Vous pouvez désormais 
sélectionner les pistes de dialogue et les exporter 
en tant que nouvelle session. Votre collaborateur 
peut ainsi ouvrir cette nouvelle session et éditer les 
dialogues. Une fois son travail terminé, vous 
n'aurez qu'à importer les données de session des 
dialogues édités puis mettre à jour les pistes de 
dialogue de la session d'origine.

Pour exporter des pistes sélectionnées en tant que 
nouvelle session :

1 Sélectionnez les pistes à exporter en tant que 
nouvelle session.

2 Sélectionnez File > Export > Selected Tracks As 

New Session. La boîte de dialogue Save 
Session Copy s'ouvre. Vous pouvez également 
ouvrir cette boîte de dialogue en sélectionnant 
File > Save Copy In.

3 Dans la boîte de dialogue Save Session Copy, 
assurez-vous que l'option Selected Tracks Only 
est activée.

4 Définissez le format de la session, puis 
configurez les paramètres et options de la 
section Session Parameters.

5 Configurez les paramètres et options de la 
section Items to Copy.

6 Vous pouvez également activer l'option Main 

Playlist Only si vous ne souhaitez pas inclure les 
autres playlists associées aux pistes 
sélectionnées dans la nouvelle session.

7 Cliquez sur OK. La boîte de dialogue Save 
s'ouvre.

8 Dans la boîte de dialogue Save, donnez un nom 
à la session.

9 Accédez à l'emplacement où vous souhaitez 
enregistrer la session.

10 Cliquez sur Save.

Une copie de la session comprenant uniquement 
les pistes sélectionnées de la session source est 
enregistrée à l'emplacement indiqué.

Boîte de dialogue Save Session Copy
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Exportation des informations 
de la session sous forme de 
texte
La commande Export Session Info as Text permet 
de créer un fichier texte contenant des 
informations complètes sur votre session. 

Ce fichier texte contient la liste des fichiers audio, 
des clips audio, la liste EDL (Edit Decision List) de 
la piste audio, des informations détaillées de 
marquage temporel et des informations concernant 
les fondus enchaînés.

Les listes EDL des pistes sont exportées sous 
forme de texte délimité par des tabulations, c'est-à-
dire contenant une tabulation entre chaque en-tête 
de colonne et chaque paramètre d'événement. 
Vous pouvez utiliser ces données dans un 
programme permettant de lire des listes EDL ou 
formater ces données EDL sous forme de tableaux 
en utilisant une application de traitement de texte 
ou un tableur.

Pour exporter les informations d'une session sous 
forme de texte :

1 Sélectionnez File > Export > Session Info as 

Text.

2 Choisissez d'inclure ou non la liste des fichiers, 
la liste des clips et les listes EDL de la piste.

3 Si vous sélectionnez d'inclure les listes EDL de 
la piste, sélectionnez si vous voulez faire 
apparaître les subframes et inclure des 
marqueurs temporels utilisateur. Sélectionnez 
également une option de gestion des fondus 
enchaînés.

4 Si vous choisissez d'inclure les listes EDL de la 
piste, sélectionnez le format temporel du texte 
de la session exportée dans le menu déroulant 
Time Format.

5 Sélectionnez dans le menu déroulant le format 
de fichier du texte exporté.

6 Après avoir défini ces options, cliquez sur OK. 

7 Sélectionnez un emplacement et saisissez un 
nom de fichier pour le fichier texte exporté. 
Sous Windows, Pro Tools ajoute la bonne 
extension de 3 lettres, tandis que sous Mac, 
l'extension .txt est ajoutée.

Fichiers texte d'une session 
exportée

Informations sur la session

Le fichier texte de la session débute avec des 
informations de base relatives à la session. 
Ces informations incluent le nom de la session, 
la fréquence d'échantillonnage, la résolution, 
le format de timecode, le nombre de pistes audio, 
de clips audio et de fichiers audio de la session, 
comme dans l'exemple ci-dessous.

Liste des fichiers et liste des clips

Ensuite, si vous sélectionnez de les inclure, 
apparaissent les listes des fichiers et clips audio.

Pour plus d'informations sur les paramètres 
et options de la boîte de dialogue Save 
Session Copy, reportez-vous à la section 
« Options d'enregistrement de copie de 
session » à la page 164.

Exemple d'informations d'une session

SESSION NAME : Ripleys II-092700

SAMPLE RATE : 48 000,000000

BIT DEPTH : 24-bit

TIMECODE FORMAT : 30 Frame

# OF AUDIO TRACKS : 19

# OF AUDIO CLIPS : 203 

# OF AUDIO FILES : 54
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Listes EDL de la piste

L'élément final, s'il est exporté, correspond aux 
listes EDL de la piste. Une liste EDL indique le 
nom de la piste et tous les points d'édition, avec le 
numéro de l'événement, le nom du clip, les heures 
de début et de fin du clip, ainsi que la durée du clip. 
Le marquage temporel du clip est également 
exporté, si vous sélectionnez cette option. 
Les subframes sont affichées dans chaque champ 
temporel si vous sélectionnez cette option.

Options de la boîte de 
dialogue Export Session Text

Include File List

Sélectionnez cette option pour exporter une liste de 
fichiers audio de la session. La liste des fichiers 
répertorie tous les fichiers audio de la session, ainsi 
que leur emplacement sur le disque dur.

Include Clip List

Sélectionnez cette option pour exporter une liste 
des clips audio de la session. La liste des clips 
répertorie tous les fichiers audio de la session, ainsi 
que le fichier audio source pour chaque clip.

Include Markers

Sélectionnez cette option pour exporter une liste de 
tous les marqueurs inclus dans la session.

Include Plug-In List

Sélectionnez cette option pour exporter une liste de 
tous les plug-ins de la session.

Include Track EDLs (Playlists)

Cette option permet d'exporter les listes EDL 
des pistes (playlists). Ces listes peuvent servir 
à vérifier avec précision le placement des clips 
et des points d'édition ou être utilisées par un 
programme de conformation pour des applications 
de post-production. Dans des circonstances 
extrêmes, l'EDL peut permettre de recréer une 
session entière.

Lors de l'exportation des listes EDL des pistes, 
les options suivantes sont disponibles :

Show Subframes : cette option permet d'exporter 
des informations temporelles relatives aux 
subframes (subdivisions d'images) avec les listes 
EDL des pistes, si elles sont utilisées dans votre 
session.

Include User Timestamps : vous pouvez inclure 
des marqueurs temporels utilisateur avec les listes 
EDL des pistes. Ces marqueurs temporels 
indiquent un emplacement de session défini par 
l'utilisateur pour le clip ou l'emplacement d'origine 
du clip lors de son enregistrement.

Boîte de dialogue Export Session Text

Les listes EDL des pistes MIDI ne sont pas 
exportées.



Guide de référence Pro Tools388

Fade Handling

Pour les listes EDL des pistes, vous pouvez choisir 
d'afficher les fondus enchaînés, de ne pas les 
afficher ou de combiner les clips avec fondu 
enchaîné. Lorsque des clips sont combinés, leurs 
durée et emplacement sont répertoriés jusqu'au 
centre du fondu enchaîné (pour le premier clip) et 
à partir du centre du enchaîné (pour le second clip).

Time Format

Vous pouvez sélectionner le format temporel 
approprié sur lequel sont basées les informations 
des listes EDL. Vous pouvez par exemple choisir 
un timecode SMPTE pour la post-production ou le 
format Bars : Beats pour la création musicale 
basée sur une grille. 

File Format

Sur Mac, vous pouvez exporter aux formats de 
texte TextEdit, UTF-8, MS Excel, MS Word, 
Write Now, Word Perfect et AppleWorks. Sous 
Windows, vous pouvez exporter au format 
TextEdit ou UTF-8.

Importation et exportation 
de fichiers de groupe de clips
Pro Tools peut exporter et importer les fichiers de 
groupe de clips au format .rgrp. Cela vous permet 
d'effectuer les opérations suivantes :

• Séparer les métadonnées des groupes de clips 
des fichiers audio pour éviter les opérations de 
copie de fichiers inutiles lors de l'exportation de 
groupes de clips audio composés de plusieurs 
fichiers source.

• Exporter des données MIDI dans un groupe de 
clips.

• Créer des boucles multipistes.

Les fichiers de groupe de clips contiennent les 
métadonnées suivantes :

• références à tous les fichiers audio au sein du 
groupe de clips ;

• noms des clips et emplacements relatifs dans 
les pistes ;

• fondus et fondus enchaînés intégrés ;

• noms et format (monopiste ou multipiste) des 
groupes de clips ;

• toutes les données MIDI présentes dans le 
groupe de clips (notes, contrôleurs et Sysex, 
par exemple) ;

• nom des pistes ;

• marqueurs de déformation Elastic Audio et 
facteur TCE ;

• base de temps du clip (références de tempo ou 
échantillons) ;

• points de synchronisation ;

• boucles ;

• table de tempos.

Les fichiers de groupe de clips ne contiennent pas 
les données suivantes :

• audio ;

• automation ; 

• plug-ins ;

• routing des pistes ;

• table de métriques ; 

• informations de la liste des clips.

Pro Tools propose plusieurs méthodes pour 
importer des groupes de clips dans une session 
ouverte :

• « Importation de groupes de clips à l'aide des 
commandes de menu de Pro Tools » à la 
page 389

• « Importation de groupes de clips par glisser-
déposer » à la page 389
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Importation de groupes de clips 
à l'aide des commandes de 
menu de Pro Tools

Pour importer un groupe de clips à l'aide des 
commandes de menu de Pro Tools :

1 Sélectionnez File > Import > clip groups et 
sélectionnez le groupe de clips à importer.

2 Dans la boîte de dialogue Clip Group Import 
Options, sélectionnez la destination du groupe 
de clips.

New Track : crée une piste de destination pour le 
groupe de clips importé.

Clip List : importe le groupe de clips dans la liste 
des clips, à partir de laquelle il devient accessible 
pour être placé sur une piste. 

3 Si vous créez une piste, sélectionnez un 
emplacement pour le groupe importé sur la 
piste :

Session Start : place le groupe au début de la 
session. 

Song Start : aligne le début du groupe avec le 
début du morceau. 

Selection : aligne le début du groupe avec le 
curseur d'édition ou le début d'une sélection dans la 
timeline.

Spot : affiche la boîte de dialogue Spot qui permet 
de placer le groupe à un emplacement spécifique 
basé sur l'une des échelles temporelles.

4 Sélectionnez l'une des options d'importation 
suivantes :

Import Tempo Map from Clip Group File : 
remplace la table de tempos de la session par celle 
du groupe de clips. Cette option n'est disponible 
que pour l'importation du groupe de clips au début 
de la session.

5 Cliquez sur OK. 

Importation de groupes de clips 
par glisser-déposer
Vous pouvez faire glisser des groupes de clips 
à partir d'un navigateur de l'espace de travail, 
de l'Explorateur Windows ou du Finder Mac pour 
les déposer sur la timeline, une piste, la liste des 
pistes ou la liste des clips.

Pour importer des groupes de clips dans la liste 
des clips :

1 Sélectionnez un ou plusieurs groupes de clips 
dans un navigateur de l'espace de travail, 
l'Explorateur Windows ou le Finder Mac. 

2 Déposez les fichiers dans la liste des clips de la 
session actuelle. 

Pour importer des groupes de clips sur une piste 
existante :

1 Sélectionnez un ou plusieurs groupes de clips 
dans un navigateur de l'espace de travail, 
l'Explorateur Windows ou le Finder Mac. 

2 Déposez les fichiers sur une piste existante de la 
fenêtre Edit de la session actuelle. 

Boîte de dialogue Clip Group Import Options



Guide de référence Pro Tools390

Pour importer des groupes de clips sur de 
nouvelles pistes :

1 Sélectionnez un ou plusieurs groupes de clips 
dans un navigateur de l'espace de travail, 
l'Explorateur Windows ou le Finder Mac. 

2 Effectuez l'une des opérations suivantes :

• À partir du navigateur de l'espace de travail, 
maintenez la touche Maj enfoncée et faites glisser 
les fichiers vers n'importe quel emplacement de la 
fenêtre Edit de la session actuelle.

• Déposez les fichiers sur un emplacement vide de 
la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans la liste des pistes.

Exportation de groupes de clips

Pour exporter un groupe de clips :

1 Sélectionnez un ou plusieurs groupes de clips 
dans la liste des clips.

2 Dans le menu de la liste des clips, sélectionnez 
Export Clip Groups. 

3 Dans la boîte de dialogue Export Clip Groups, le 
répertoire de destination par défaut est le dossier 
Clip Groups créé automatiquement dans le dossier 
de la session. Vous pouvez modifier le répertoire 
de destination en cliquant sur le bouton Choose, 
en accédant à l'emplacement souhaité, puis en 
cliquant sur Choose. Cliquez sur Reset pour 
rétablir le répertoire de destination par défaut.

4 Activez l'une des options suivantes pour 
résoudre les problèmes de noms de fichiers de 
groupe de clips en double :

• Prompting for Each Duplicate (option par défaut)

• Auto Renaming 

• Replacing with New Files 

5 Cliquez sur Export. 

Exportation de groupes de clips sur un autre 
disque dur

En règle générale, si vous exportez des groupes de 
clips sur un autre disque dur, il est recommandé de 
copier tous les fichiers audio référencés. Vous 
pourrez ainsi transférer des groupes de clips non 
seulement d'une session à une autre, mais 
également d'un système à un autre.

Pour exporter un groupe de clips sur un autre 
disque dur en incluant ses fichiers audio :

1 Exportez un ou plusieurs groupes de clips sur le 
nouveau disque dur.

2 Créez une session sur le nouveau disque.

3 Sélectionnez Setup > Preferences.

4 Dans la boîte de dialogue Preferences, cliquez 
sur l'onglet Processing et sélectionnez 
Automatically Copy Files on Import.

5 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

6 Importez tous les groupes de clips 
précédemment exportés en les déposant dans la 
session. 

Le dossier des fichiers audio de la nouvelle session 
contient à présent tous les fichiers référencés par 
les groupes de clips.

Boîte de dialogue Export Clip Groups



Chapitre 17 : Importation et exportation de données de session 391

Transfert de sessions sur 
Gobbler
Gobbler est outil basé cloud de sauvegarde, 
de transfert et de collaboration pour la gestion de 
projets audio et de leurs assets média. Pro Tools 
s'intègre avec Gobbler afin de pouvoir envoyer des 
sessions Pro Tools et des fichiers audio à des 
collaborateurs via Internet. Lorsqu'elle est installée, 
l'application Gobbler peut être configurée pour 
analyser votre système afin de localiser et de 
sauvegarder automatiquement vos sessions 
Pro Tools et les fichiers média associés. Si vous ne 
possédez pas de compte, vous pouvez en créer un 
gratuitement.

Afin de transférer vos sessions Pro Tools et les 
médias associés sur Gobbler, utilisez la commande 
Send To Gobbler. 

Pour envoyer une session Pro Tools via Gobbler :

1 Sélectionnez File > Send To > Gobbler.

2 Si vous n'êtes pas connecté à votre compte 
Gobbler, vous êtes invité à vous identifier 
(reportez-vous à la section « Connexion à 
Gobbler » à la page 1144).

3 Dans la boîte de dialogue Send Files de 
l'application Gobbler, saisissez les adresses e-
mail des personnes auxquelles vous souhaitez 
envoyer le fichier audio.

4 Cliquez sur Send.

Pour plus d'informations sur Gobbler, 
rendez-vous sur www.gobbler.com.

Pour obtenir des informations sur le partage de 
fichiers audio individuels de votre session 
Pro Tools avec Gobbler lors de l'utilisation des 
commandes Bounce et Export Selected, reportez-
vous à la section « Share With Gobbler » à la 
page 1143.
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Chapitre 18 : Gestion et compatibilité des 
fichiers et sessions

Lors de l'utilisation de Pro Tools, vous pourrez 
rencontrer plusieurs types de fichiers informatiques. 
Pour fonctionner correctement, les systèmes 
Pro Tools requièrent de conserver certains fichiers 
dans des emplacements spécifiques du disque dur :

• Les fichiers du logiciel Pro Tools (comme les 
fichiers d'application et de plug-ins) doivent être 
stockés sur votre disque de démarrage (celui qui 
contient le système d'exploitation et les autres 
fichiers système).

• Les fichiers de données (comme les fichiers 
audio, de session et vidéo) peuvent être stockés 
sur n'importe quel disque compatible connecté 
aux bus internes ou externes SAS, SATA, 
IDE/ATA, FireWire ou Thunderbolt de votre 
ordinateur.

Vous pouvez spécifier l'emplacement des nouveaux 
fichiers de session lors de la création de sessions 
(reportez-vous à la section « Création d'une 
session » à la page 154).

Dans les sessions Pro Tools, utilisez la commande 
Disk Allocation pour spécifier l'emplacement de 
stockage des fichiers audio nouvellement enregistrés 
(reportez-vous à la section « Utilisation de disques 
durs pour l'enregistrement » à la page 449).

Bien que Pro Tools permette d'enregistrer sur 
votre disque système, cela est généralement 
déconseillé. Vous ne devez enregistrer sur des 
disques système qu'en cas de stricte nécessité, 
par exemple si votre ordinateur ne comporte 
qu'un seul disque dur ou si les autres disques 
sont déjà pleins.

Si votre système comprend plusieurs disques, 
vous pouvez désigner le disque système comme 
disque dédié uniquement à la lecture ou au 
transfert pour optimiser les performances 
(reportez-vous à la section « Permissions des 
volumes » à la page 286).
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Gestion des fichiers audio

Identifiants uniques de fichiers
Pro Tools attribue un identifiant unique à chaque 
fichier audio d'une session, ce qui permet de 
retrouver les fichiers dont le nom ou l'emplacement 
a été modifié.

Recherche de fichiers audio
Dans Pro Tools, vous gérez les liens pointant vers 
les fichiers audio et média à l'aide de la fenêtre 
Relink. 

Pro Tools classe les volumes de stockage selon 
leur qualité de disque de performance (pour 
l'enregistrement ou la lecture) ou de transfert 
(pour le stockage ou la copie). Les fichiers audio 
doivent être stockés sur des volumes de 
performance appropriés et comprendre des liens 
valides pour être lus dans une session Pro Tools.

Lors de l'ouverture d'une session, si Pro Tools 
signale que les fichiers audio ne sont pas stockés 
sur un volume de performance, ou si le système ne 
parvient pas à localiser les fichiers audio contenus 
dans la session, vous pouvez localiser et copier 
les fichiers afin de pouvoir lire la session. 
Ce processus est appelé relinking. 

Fichiers de transfert

Les fichiers de transfert résident sur des volumes 
non destinés à la lecture comme les CD-ROM, 
les DVD et les lecteurs réseau.

Pour ouvrir une session comprenant des fichiers 
de transfert :

 Ouvrez la session Pro Tools. Si des fichiers se 
trouvent sur un volume non destiné à la lecture, 
Pro Tools vous invite à effectuer l'une des 
opérations suivantes :

• Cliquez sur Yes pour ouvrir la fenêtre Copy and 
Relink.

• Cliquez sur No pour ouvrir la session en 
conservant les fichiers de transfert hors ligne. 

Pour que les fichiers de transfert puissent être lus 
dans la session actuelle :

1 Sélectionnez la session dans le volet Locations.

2 Double-cliquez sur le dossier Audio Files pour 
afficher tous les fichiers audio.

3 Sélectionnez Select Transfer Files dans le menu 
du navigateur. 

4 Sélectionnez Copy and Relink dans le menu du 
navigateur. 

5 Sélectionnez une destination sur un volume de 
performance valide où copier les fichiers.

6 Cliquez sur OK. 
Pour plus d'informations sur la classification 
des volumes de stockage, reportez-vous à la 
section « Volumes de performance et de 
transfert » à la page 281.

Pour plus d'informations, reportez-vous à la 
section « Création et rétablissement de liens 
vers des fichiers » à la page 312.
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Fichiers manquants

Si un fichier ne se trouve plus à l'endroit où il 
résidait lors du dernier enregistrement de la 
session, ce fichier est considéré comme manquant. 

Pour ouvrir une session Pro Tools avec des 
fichiers manquants :

1 Ouvrez la session Pro Tools. Si des fichiers sont 
manquants, Pro Tools affiche un avertissement 
(Missing Files).

2 Sélectionnez l'une des options suivantes :

Skip All : ignore tous les fichiers manquants. 
Les fichiers manquants de la session sont 
hors ligne.

Manually Find and Relink : ouvre la fenêtre 
Relink, dans laquelle vous pouvez rechercher, 
comparer, vérifier et rétablir les liens des fichiers 
manquants.

Automatically Find and Relink : lance une 
recherche sur tous les volumes de performance 
pour localiser tous les fichiers dont le nom, l'ID de 
fichier unique, le format et la durée correspondent 
aux fichiers manquants et rétablit les liens vers les 
fichiers manquants si possible. 

3 Pour exclure les fichiers de rendu Elastic Audio 
du relinking afin de les recréer, sélectionnez 
Regenerate Missing Rendered Files Without 

Searching.

4 Cliquez sur OK. 

Fichiers audio renommés
Les fichiers audio renommés se trouvent dans 
le dossier Renamed Audio Files créé 
automatiquement dans le dossier de la session 
Pro Tools. Vous pouvez renommer des fichiers 
lorsque vous ouvrez une session faisant référence 
à des fichiers audio dont le nom contient des 
caractères incompatibles. Vous pouvez également 
renommer des fichiers dans certaines situations, 
notamment lors de l'enregistrement de la copie 
d'une session dans une version Pro Tools ne prenant 
pas en charge les noms de fichier longs.

Ouverture d'une session contenant des noms 
de fichier audio avec des caractères interdits

Pro Tools version 7.x ou supérieure ne prend pas 
en charge les noms de fichier audio contenant les 
caractères ASCII suivants :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

" (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (barre verticale)

Tout caractère ASCII créé avec une 
combinaison de touches

Avertissement concernant des fichiers manquants 
à l'ouverture d'une session

Pour plus d'informations, reportez-vous à la 
section « Création et rétablissement de liens 
vers des fichiers » à la page 312.
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Lors de l'ouverture de sessions contenant des 
fichiers audio dont les noms comprennent des 
caractères non autorisés, Pro Tools crée 
automatiquement une copie renommée de chacun 
de ces fichiers (en remplaçant les caractères 
interdits par un trait de soulignement « _ »). 
Les fichiers renommés sont placés dans le dossier 
Renamed Audio Files. Les fichiers originaux 
restent inchangés dans le dossier Audio Files.

Avant l'ouverture de la session, vous êtes invité 
à enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichier texte de notes. Par défaut, le fichier de notes 
est sauvegardé dans le dossier de la session.

Enregistrement de la copie d'une session 
contenant des noms de fichier audio longs

Lors de l'enregistrement de fichiers dans 
Pro Tools 6.9.x ou une version inférieure (à l'aide 
de la commande Save Copy In), les fichiers audio 
dont le nom dépasse la limite du format de 
destination sont tronqués et placés dans le dossier 
de la session, suivant les règles suivantes :

• Si la nouvelle session est enregistrée dans 
le même répertoire que la session d'origine, 
un dossier Renamed Audio Files est créé dans 
le dossier d'origine de la session pour les fichiers 
audio renommés.

• Si la nouvelle session est enregistrée dans un 
répertoire différent de celui de la session 
d'origine et que l'option All Audio Files n'est pas 
sélectionnée, un nouveau dossier de session 
(comprenant des sous-dossiers Audio Files et 
Renamed Audio Files) est créé. Les fichiers 
audio renommés sont alors placés dans le 
dossier Audio Files.

• Si la nouvelle session est enregistrée dans un 
répertoire différent de celui de la session 
d'origine et que l'option All Audio Files est 
sélectionnée, un nouveau dossier de session 
(comprenant un sous-dossier Audio Files) est 
créé. Les fichiers audio renommés sont alors 
placés dans le dossier Audio Files.

Compatibilité des fichiers 
WAV
Conversion de fichiers WAV importés au 
format AES31/BroadcastWave

Pro Tools crée toujours des fichiers BWF (.wav) 
compatibles AES31/Broadcast lorsque le fichier 
provient de Pro Tools. Les fichiers WAV non 
BWF peuvent être ajoutés sans conversion à des 
sessions Pro Tools au format BWF (WAV). Cette 
option garantit l'importation de tous les fichiers 
WAV et, si nécessaire, leur conversion au format 
BWF (WAV), conforme à la norme AES31/EBU 
Broadcast.

AES31/Broadcast Wave est une variante du type 
de fichier audio standard WAV. Le format AES31 
contient des marquages temporels SMPTE et 
d'autres informations complémentaires aux 
données PCM audio brutes. 

Cette variante est conforme aux normes définies 
par l'AES (Audio Engineering Society) et l'EBU 
(European Broadcasters Union). Sélectionnez 
cette option pour garantir la compatibilité avec 
d'autres stations de travail reconnaissant ce type 
de fichier. 

Il est possible de travailler dans une session 
Pro Tools version 7.x ou supérieure contenant 
des fichiers audio dont les noms comprennent 
des caractères non autorisés. Si vous enregistrez 
une copie de la session dans Pro Tools 
version 6.9.x ou inférieure en activant l'option 
Enforce Mac/PC Compatibility, les pistes sont 
renommées avec des caractères autorisés. 
Si l'option Enforce Mac/PC Compatibility est 
désactivée, les caractères restent les mêmes.
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Pour que vos fichiers WAV importés soient 
conformes à la norme AES31/EBU Broadcast :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Sélectionnez l'option Convert Imported “.wav” 

Files to AES31/BroadcastWave.

3 Cliquez sur OK.

Format de fichier audio WAVE Extensible 

Pro Tools 10 prend en charge le format de fichier 
audio WAVE Extensible. Ce format de fichier 
spécifie les données de plusieurs canaux audio 
(son surround) avec les positions de haut-parleurs, 
stockées dans l'en-tête du fichier audio. 
Ces fichiers audio sont identifiés dans les 
navigateurs de l'espace de travail par la mention 
« WAV (BWF EXT) » dans le champ Attributes. 

Si vous travaillez avec des pistes au format 
multicanal supérieur à stéréo dans vos sessions 
Pro Tools, il est conseillé d'utiliser le format de 
fichier WAV.

RF64

Pro Tools 10 prend en charge le format de fichier 
audio RF64. RF64 est une extension du format de 
fichier audio WAV qui permet de contourner la 
limitation de taille de 4 Go des autres formats de 
fichier audio WAV. Ces fichiers audio sont 
identifiés par la mention « MBWF » dans le champ 
Attributes des navigateurs de l'espace de travail.

Partage de sessions créées 
sur des plateformes 
différentes

Utilisation de disques HFS+ 
basés Mac sur des ordinateurs 
Windows
Pour monter des disques HFS+ sur un système 
NTFS afin de les utiliser avec Pro Tools, vous 
pouvez utiliser l'utilitaire MacDrive de Mediafour. 

Déplacement de sessions d'un 
système Windows vers des 
disques HFS+ Mac
(À partir de disques NTFS Windows 
uniquement)

Plusieurs étapes sont nécessaires pour transférer 
des fichiers de session à partir de disques NTFS 
Windows vers des disques HFS+ Mac.

Pour transférer des sessions Pro Tools Windows 
depuis des disques NTFS vers des disques HFS+ :

1 Définissez les options de MacDrive pour une 
opération du type Backup/File Transfert.

2 Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
NTFS vers le disque HFS+.

• Ouvrez la session Windows sur le disque NTFS, 
sélectionnez Save Copy In, puis enregistrez une 
copie de la session sur le disque HFS+.

Lorsque vous utilisez le format de fichier WAV 
pour des sessions Pro Tools 10, l'ordre des 
canaux correspondant pour chaque canal de 
fichier multicanal entrelacé de format supérieur 
à stéréo est affiché dans la liste des clips.

Les versions antérieures de Pro Tools ne 
peuvent pas lire les fichiers RF64. Sur ces 
versions, vous devez éditer et consolider les 
fichiers RF64 manuellement pour que leur 
taille ne dépasse pas 4 Go.
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Déplacement de sessions Mac 
sur des disques HFS+ vers un 
système Windows
(Vers des disques NTFS Windows uniquement)

Plusieurs étapes sont nécessaires pour transférer 
des fichiers à partir de disques HFS+ Mac vers des 
disques NTFS Windows.

Pour transférer des sessions Pro Tools Mac 
depuis des disques HFS+ vers des disques NTFS :

1 Définissez les options de MacDrive pour une 
opération du type Normal Use.

2 Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
HFS+ vers le disque NTFS.

• Ouvrez la session Mac sur le disque HFS+ et, 
lorsque vous y êtes invité, sélectionnez Save 

Copy In et enregistrez une copie de la session sur 
le disque NTFS. 

Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format de 
fichier audio.

Enregistrement et lecture 
à partir de disques HFS+ sur 
Windows
Windows prend en charge l'enregistrement et la 
lecture de sessions directement à partir de disques 
formatés Mac (HFS+) à l'aide de l'application 
MacDrive.

Lors de l'utilisation de MacDrive pour 
l'enregistrement et la lecture sur un système 
Windows, le fichier de session et tous les fichiers 
audio doivent être stockés sur des disques formatés 
Mac (HFS+). L'enregistrement et la lecture d'une 
session à partir d'un mélange de disques formatés 
Mac et Windows ne sont pas pris en charge.

Pour enregistrer ou lire à partir de disques HFS+ 
avec Windows à l'aide de MacDrive :

1 Sous Windows, accédez au panneau de 
configuration de MacDrive.

2 Sélectionnez Options > File Names et 
sélectionnez l'option International Use.

3 Supprimez toutes les options répertoriées sous 
File Name Maps.

4 Dans Pro Tools, sélectionnez Window > 

Workspace et vérifiez que tous les volumes 
formatés Mac sont paramétrés sur R 
(enregistrement) ou P (lecture) dans les 
colonnes A (audio) et V (vidéo). 

Pour enregistrer (ou créer) des sessions Mac 
destinées à être utilisées sur des systèmes 
Windows, reportez-vous à la section 
« Enregistrement de copies de sessions Mac 
compatibles avec Windows » à la page 399.

Lors du transfert de sessions Pro Tools depuis 
des disques HFS+ vers des disques NTFS, les 
sessions Pro Tools sont incapables de rétablir 
les liens vers les fichiers audio dont les noms sont 
composés de caractères Mac non pris en charge 
dans Windows. Ces caractères sont 
automatiquement convertis en traits de 
soulignement (_). Les fichiers en question sont 
placés dans le dossier Renamed Audio Files. 
Il vous faut alors rétablir manuellement les liens 
de chaque fichier par ID de fichier. Reportez-
vous à la section « Fichiers manquants » à la 
page 395.

Dans les anciennes versions de Pro Tools, 
les disques formatés Mac HFS+ pouvaient 
uniquement être utilisés en tant que volumes 
de transfert lorsqu'ils étaient connectés aux 
systèmes Windows par le biais de MacDrive.
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Enregistrement de copies de 
sessions Mac compatibles avec 
Windows
(Commande Save Copy In dans Pro Tools 
version 6.9.x ou inférieure uniquement)

Les sessions créées et enregistrées dans Pro Tools 
version 7.x ou supérieure sont toutes compatibles 
avec les systèmes Windows et Mac.

Si vous créez une session Pro Tools version 6.9.x ou 
inférieure sur un système Mac, cette session est 
compatible uniquement avec les systèmes Windows 
si l'option Enforce Mac/PC Compatibility est 
sélectionnée lors de l'utilisation de la commande 
Save Copy In. En matière de compatibilité entre les 
différentes plateformes, il existe un certain nombre 
de limitations à prendre en compte lorsque vous 
utilisez la commande Save Copy In.

Limites des sessions multiplateformes

Lorsque vous enregistrez (ou créez) une copie 
d'une session Pro Tools compatible Mac et 
Windows, tenez compte des restrictions suivantes 
et des méthodes d'utilisation dans Pro Tools :

Types de fichiers audio

Le format de fichier recommandé pour une parfaite 
interopérabilité entre les plateformes est le format 
BWF (.WAV). Pour favoriser les échanges de 
sessions, Pro Tools adopte par défaut le format 
BWF pour les nouvelles sessions.

Pro Tools vous permet d'enregistrer, de bouncer et 
d'exporter un grand nombre de formats de fichier 
audio, dont WAV, AIFF, MP3 et QuickTime. 

Extensions des noms de fichiers

Pour assurer la compatibilité multiplateformes, 
tous les fichiers d'une session doivent se terminer 
par une extension de trois lettres. Les fichiers de 
session Pro Tools 5.1 à 6.9.x possèdent une 
extension .pts, et les sessions Pro Tools 5, 
une extension .pt5. Les fichiers Wave possèdent 
une extension de fichier .wav, et les fichiers AIFF, 
une extension de fichier .aif.

Caractères ASCII incompatibles

Les noms des clips, des pistes et des fichiers, ainsi 
que les paramètres de plug-in, ne peuvent pas 
contenir de caractères ASCII incompatibles avec 
l'un ou l'autre des systèmes. 

Lorsque vous importez des fichiers dans une 
session, les caractères incompatibles sont 
convertis en traits de soulignement (_) et les 
fichiers renommés sont placés dans le dossier 
Renamed Files.

Les caractères suivants ne peuvent pas être utilisés 
dans les sessions Windows :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

" (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (barre verticale)

Tout caractère ASCII créé avec une 
combinaison de touches
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Enregistrement de sessions 
multiplateformes

Pour sauvegarder une session existante dans 
Pro Tools 6.9.x ou une version inférieure et 
garantir la compatibilité avec Mac et Windows :

1 Sélectionnez File > Save Copy In.

2 Dans la boîte de dialogue Save Session Copy, 
sélectionnez une destination et saisissez le nom 
du fichier de la nouvelle session.

3 Définissez l'option Audio File Type sur AIFF ou 
BWF (.WAV). Ces formats de fichier sont 
compatibles avec les deux plateformes.

4 Définissez la fréquence d'échantillonnage 
(Sample Rate) et la résolution (Bit Depth) 
de la session.

5 Sélectionnez Enforce Mac/PC Compatibility. 
Cette option doit être sélectionnée pour que 
votre session soit compatible sur les deux 
plateformes.

6 Sélectionnez les éléments à copier (Items to 

Copy) pour la nouvelle session.

7 Cliquez sur Save. 

Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format de 
fichier audio.

Pro Tools permet de convertir en fichier 
compatible Windows un fichier créé sur Mac 
et enregistré sans l'option Enforce Mac/PC 
compatibility. Pour plus d'informations, 
reportez-vous à la section « Partage de sessions 
créées sur des plateformes différentes » à la 
page 397.
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Partage de sessions créées sur des systèmes Pro Tools 
différents
Pro Tools permet de partager simplement des sessions entre des systèmes Pro Tools HD et Pro Tools. 
Il existe des différences importantes pouvant avoir une incidence sur le transfert des données d'une session.

Pour plus d'informations sur le transfert de sessions entre Windows et Mac, reportez-vous à la section 
« Partage de sessions créées sur des plateformes différentes » à la page 397.

Différences entre les systèmes Pro Tools

Caractéristique Systèmes Avid HDX Systèmes HD Native Pro Tools

Nombre maximum de 
pistes audio

jusqu'à 768 
(768 assignables 
à une voix)

jusqu'à 768 
(256 assignables 
à une voix)

jusqu'à 128 
(96 assignables 
à une voix)

Nombre maximum de 
pistes d'entrée 
auxiliaire

512 pistes d'entrée 
auxiliaire

512 pistes d'entrée 
auxiliaire

128 pistes d'entrée 
auxiliaire

Nombre maximum de 
pistes d'instrument

256 pistes 
d'instrument

256 pistes 
d'instrument

128 pistes 
d'instrument

Nombre maximum de 
bus de mixage 
internes

256 bus de mixage 
internes

256 bus de mixage 
internes

256 bus de mixage 
internes

Inserts par piste jusqu'à 10 jusqu'à 10 jusqu'à 10

Départs par piste jusqu'à 10 jusqu'à 10 jusqu'à 10



Guide de référence Pro Tools402

Ouverture de sessions 
Pro Tools HD dans Pro Tools
Vous pouvez ouvrir une session Pro Tools HD 
avec Pro Tools, mais certains éléments de la 
session risquent d'être chargés incorrectement ou 
absents.

Lors de l'ouverture d'une session 
Pro Tools HD 11.x dans Pro Tools 11.x, 
les événements suivants se produisent :

Pistes

• Les pistes au-delà de la piste 128 sont 
désactivées.

• Les pistes d'instrument au-delà de la piste 128 
sont désactivées.

• Les pistes d'entrée auxiliaire au-delà de la 
piste 128 sont désactivées.

• Les plug-ins DSP ayant des équivalents Native 
sont convertis ; les autres sont désactivés.

• Les pistes multicanal surround sont supprimées 
de la session.

• Les chemins d'entrée et de sortie non disponibles 
sont désactivés.

• L'option HEAT (si présente) est supprimée.

Groupes

• Les groupes de mixage ne conservent que les 
informations de volume principal.

• Les groupes de mixage/édition ne conservent 
que les informations de volume principal et de 
mode d'automation.

• Les informations du processus d'automation 
pour les commandes groupées sont conservées.

• Les comportements de groupe des commandes 
Solo, Mute, de niveau de départ et de mute de 
départ sont conservés.

• Les paramètres de mode de solo et de 
verrouillage solo sont abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des séquences QuickTime 
dans la liste des clips mais pas de piste vidéo, 
la session s'ouvre avec une nouvelle piste 
QuickTime contenant la première séquence 
QuickTime de la liste des clips.

• La timeline affiche et lit uniquement la dernière 
playlist vidéo active. Aucune autre playlist 
vidéo n'est disponible.

Partage de sessions créées 
avec des versions différentes 
de Pro Tools
Pro Tools facilite le partage de sessions entre les 
différentes versions logicielles d'un système 
Pro Tools spécifique. 

Il est impossible d'ouvrir des sessions Pro Tools 
11.x et 10.x avec des versions antérieures de 
Pro Tools. Pour enregistrer une session 
Pro Tools 11.x ou 10.x afin qu'elle soit compatible 
avec une version antérieure de Pro Tools, utilisez 
la commande File > Save Copy In pour 
sélectionner le format de session approprié.

Partage de sessions entre 
Pro Tools 11.x et Pro Tools 10.x
Les sessions Pro Tools 11.x et Pro Tools 10.x sont 
compatibles. Toutefois, les plug-ins 64 bits AAX 
qui n'ont pas d'équivalent 32 bits seront désactivés 
lors de l'ouverture des sessions dans Pro Tools 
10.x. De même, les plug-ins 32 bits AAX, RTAS 
et TDM qui n'ont pas d'équivalent 64 bits AAX 
seront désactivés lors de l'ouverture des sessions 
dans Pro Tools 10.x.
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De plus, toutes les pistes d'instrument dont le 
numéro est supérieur à 128 dans une session 
créée ou modifiée dans Pro Tools 11.x sera 
désactivée lors de l'ouverture de la session dans 
Pro Tools 10.x.

Il est impossible d'ouvrir une session créée dans 
Pro Tools 11.x qui utilise plus de 4 Go de RAM 
(du fait des plug-ins) dans Pro Tools 10.x.

Partage de sessions avec de la vidéo

Lors de l'ouverture dans Pro Tools 11.x d'une 
session créée dans une version antérieure de 
Pro Tools contenant de la vidéo SD, le format 
d'image doit être réinitialisé.

Lors de l'ouverture dans une version antérieure de 
Pro Tools d'une session créée dans Pro Tools 11.x 
contenant une vidéo Avid, la piste sera désactivée, 
à moins que la vidéo Avid ne soit au format SD et 
qu'un boîtier Mojo ou Mojo SDI ne soit connecté.

Sauvegarde de sessions 
Pro Tools 11.x-10.x au format 
Pro Tools 7 –> 9
Pour enregistrer une session Pro Tools 11.x ou 
10.x afin qu'elle soit compatible avec Pro Tools 
versions 7.x à 9.x, utilisez la commande File > Save 

Copy In pour choisir le format Pro Tools 7 –> 9 

Session.

Lorsque vous enregistrez une session 
Pro Tools 11.x ou 10.x au format Pro Tools 7 –> 
9, les événements suivants se produisent :

• Les pistes audio au-delà de la piste 256 sont 
désactivées.

• Les paramètres de gain du clip sont abandonnés. 
Si vous souhaitez appliquer les paramètres de 
gain du clip avant d'enregistrer la copie de 
session, vous devez générer leur rendu 
manuellement.

• Les fondus doivent être rendus avant d'ouvrir 
une session dans une version antérieure de 
Pro Tools.

• Les fichiers des sessions avec des formats de 
fichier et résolutions mixtes doivent tous être 
convertis au même format et à la même 
résolution.

• Les fichiers des sessions avec une résolution 
32 bits virgule flottante doivent être convertis en 
16 ou 24 bits.

• Les fichiers des sessions dont la taille est 
supérieure à 4 Go ne pourront être ouverts dans 
les versions antérieures de Pro Tools. Vous 
devez éditer et consolider manuellement ces 
fichiers pour que les données audio soient 
disponibles dans les versions antérieures de 
Pro Tools.

Ouverture de sessions 
Pro Tools 9.0 dans 
Pro Tools 8.1. et 8.5
Vous pouvez ouvrir une session Pro Tools 9.0 
dans Pro Tools 8.1 et 8.5, mais certains éléments 
risquent d'être chargés incorrectement ou absents.

Lorsque vous ouvrez une session Pro Tools 9.0 
dans Pro Tools 8.1 ou 8.5, les événements 
suivants se produisent : 

• Les pistes audio au-delà de la piste 256 sont 
désactivées.

• Les bus de mixage internes au-delà du bus 128 
sont désactivés.

• Le paramètre Stereo Pan Depth est défini 
sur -2,5 dB.

Lorsque vous ouvrez une session 
Pro Tools 9.0 dans Pro Tools 8.1 ou 8.5, 
un message vous prévient que vous ouvrez 
une session créée dans une version plus 
récente de Pro Tools et que les éléments de la 
session ne seront pas tous disponibles.
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Ouverture de sessions 
Pro Tools 9.0 dans Pro Tools 8.0
Vous pouvez ouvrir une session Pro Tools 9.0 
dans Pro Tools 8.0, mais certains éléments 
risquent d'être chargés incorrectement ou absents.

Lorsque vous ouvrez une session Pro Tools 9.0 
dans Pro Tools 8.0, les événements suivants se 
produisent : 

• Tous les événements qui se produisent lorsque 
vous ouvrez une session Pro Tools 9.0 dans 
Pro Tools 8.1.

• Les assignations de bus de sortie sont 
supprimées.

• L'option HEAT (si présente) est supprimée.

Ouverture de sessions 
Pro Tools 9.0 dans 
Pro Tools 7.4.x
Vous pouvez ouvrir une session Pro Tools 9.0 
dans Pro Tools 7.4.x, mais certains éléments de la 
session risquent d'être chargés incorrectement ou 
absents.

Lorsque vous ouvrez une session Pro Tools 9.0 
dans Pro Tools 7.4.x, les événements suivants 
se produisent : 

• Tous les événements qui se produisent lorsque 
vous ouvrez une session Pro Tools 9.0 dans 
Pro Tools 8.0.

• Les inserts F à J et toutes les données 
d'automation associées sont supprimés.

• Les clips issus de fichiers audio de plus de 2 Go 
apparaissent hors ligne.

• Les transpositions de hauteur des clips Elastic 
Audio sont supprimées.

• Les marqueurs d'accord sont supprimés.

Ouverture de sessions 
Pro Tools 7.4 ou supérieur dans 
Pro Tools 7.3.x ou 7.2
Vous pouvez ouvrir une session Pro Tools 7.4 
à 9.x dans Pro Tools 7.3.x ou 7.2, mais certains 
éléments risquent d'être chargés incorrectement ou 
absents.

Lorsque vous ouvrez une session Pro Tools 7.4.x 
ou supérieur dans Pro Tools 7.3.x ou 7.2, les 
événements suivants se produisent : 

• Tous les événements qui se produisent lorsque 
vous ouvrez une session Pro Tools8.x ou 
supérieur dans Pro Tools 7.4.x.

• Les données Elastic Audio sont absentes des 
pistes Elastic Audio et les durées des clips sont 
conformes au timing du fichier source d'origine.

• Les sessions contenant des caractères Unicode 
mixtes risquent de ne pas s'ouvrir ou de 
provoquer l'affichage de caractères illisibles 
dans Pro Tools.

Lorsque vous ouvrez une session Pro Tools 9.0 
dans Pro Tools 8.0, un message vous prévient 
que vous ouvrez une session créée dans une 
version plus récente de Pro Tools et que les 
éléments de la session ne seront pas tous 
disponibles.

Lorsque vous ouvrez une session 
Pro Tools 9.0 dans Pro Tools 7.4.x, 
un message vous prévient que vous ouvrez une 
session créée dans une version plus récente de 
Pro Tools et que les éléments de la session ne 
seront pas tous disponibles.

Lorsque vous ouvrez une session Pro Tools 7.4 
à 9.x dans Pro Tools 7.3.x, un message vous 
prévient que vous ouvrez une session créée 
dans une version plus récente de Pro Tools et 
que les éléments de la session ne seront pas tous 
disponibles.
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Ouverture de sessions 
Pro Tools 7.2 ou supérieur dans 
Pro Tools 7.1 ou 7.0
Vous pouvez ouvrir une session Pro Tools 7.2 
à 9.x sans pistes vidéo ou Master VCA dans 
Pro Tools 7.1 ou 7.0, mais certains éléments de la 
session risquent d'être chargés incorrectement ou 
absents.

Lorsque vous ouvrez une session Pro Tools 7.4 
à 9.x dans Pro Tools 7.1 ou 7.0, les événements 
suivants se produisent : 

• Tous les événements qui se produisent lorsque 
vous ouvrez une session Pro Tools 7.4 ou 
supérieur dans Pro Tools 7.3.x ou 7.2.

Pistes

• Les pistes Master VCA sont supprimées et toute 
automation VCA non fusionnée est abandonnée.

• Toute automation de trim non fusionnée est 
abandonnée.

Groupes

• Tous les groupes au-delà des 26 premiers 
(banque 1, groupes a à z) sont abandonnés.

• Les groupes de mixage ne conservent que les 
informations de volume principal.

• Les groupes de mixage/édition ne conservent 
que les informations de volume principal et de 
mode d'automation.

• Les informations du processus d'automation 
pour les commandes groupées ne sont pas 
conservées.

• Les comportements de groupe des commandes 
Solo, Mute, de niveau de départ et de mute de 
départ ne sont pas conservés.

• Les paramètres de mode de solo et de 
verrouillage solo sont abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des séquences QuickTime 
dans la liste des clips mais pas de piste vidéo, 
la session s'ouvre avec une nouvelle piste 
QuickTime contenant la première séquence 
QuickTime de la liste des clips.

• La timeline affiche et lit uniquement la dernière 
playlist vidéo active. Aucune autre playlist 
vidéo n'est disponible.

• Les clips vidéo et les groupes de clips vidéo ne 
sont ni affichés ni enregistrés.

Ouverture de sessions créées 
dans Pro Tools HD 7.2 à 9.x 
dans Pro Tools LE 8.0
Vous pouvez ouvrir une session créée dans 
Pro Tools HD 7.2 à 9.x sans pistes vidéo ou 
Master VCA dans Pro Tools LE 8.0, mais certains 
éléments de la session risquent d'être chargés 
incorrectement ou absents.

Lorsque vous ouvrez une session Pro Tools 7.4 
à 9.x dans Pro Tools 7.2, 7.1 ou 7.0, aucun 
message ne s'affiche pour vous prévenir que 
certains éléments de la session risquent de ne 
pas être disponibles.

Les sessions créées dans Pro Tools 7.2 à 9.x 
contenant des pistes vidéo ou Master VCA ne 
peuvent être ouvertes que dans 
Pro Tools HD 7.1cs3 ou supérieur.

Les sessions créées dans Pro Tools HD 7.2 
ou supérieur contenant des pistes vidéo ou 
Master VCA ne peuvent être ouvertes que 
dans Pro Tools LE 7.0cs3 ou supérieur.
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Lors de l'ouverture d'une session Pro Tools HD 
version 7.x à 9.x dans Pro Tools LE 8.0, 
les événements suivants se produisent :

Pistes

• Aucune voix (voice off) n'est assignée aux pistes 
au-delà des 48 premières, ainsi qu'aux pistes 
désactivées.

• Toute assignation à des bus au-delà du bus 32 est 
désactivée.

• Les pistes d'instrument au-delà de la piste 32 
sont désactivées.

• Les plug-ins TDM ayant des équivalents RTAS 
sont convertis ; les autres sont désactivés.

• Les pistes multicanal surround sont supprimées 
de la session.

• Les chemins d'entrée et de sortie non disponibles 
sont désactivés.

• Tout paramètre de compensation du délai est 
supprimé.

• Les pistes Master VCA sont supprimées et toute 
automation VCA non fusionnée est abandonnée.

• L'option HEAT (si présente) est supprimée 
(sessions Pro Tools HD 8.1 ou supérieur avec 
option HEAT uniquement).

• Les assignations de bus de sortie sont 
supprimées (sessions Pro Tools HD 8.1 ou 
supérieur uniquement).

Groupes

• Dans Pro Tools LE version 7.1 ou inférieure 
uniquement, tous les groupes au-delà des 
26 premiers (banque 1, groupes a à z) sont 
abandonnés.

• Les groupes de mixage ne conservent que les 
informations de volume principal.

• Les groupes de mixage/édition ne conservent 
que les informations de volume principal et de 
mode d'automation.

• Les informations du processus d'automation 
pour les commandes groupées sont conservées.

• Les comportements de groupe des commandes 
Solo, Mute, de niveau de départ et de mute de 
départ sont conservés.

• Les paramètres de mode de solo et de 
verrouillage solo sont abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des séquences QuickTime 
dans la liste des clips mais pas de piste vidéo, 
la session s'ouvre avec une nouvelle piste 
QuickTime contenant la première séquence 
QuickTime de la liste des clips.

• La timeline affiche et lit uniquement la dernière 
playlist vidéo active. Aucune autre playlist 
vidéo n'est disponible.

• Dans Pro Tools LE version 7.1 ou inférieure, 
les clips vidéo et les groupes de clips vidéo ne 
sont ni affichés ni sauvegardés.

Sauvegarde de sessions 
Pro Tools 11.x - 10.x au format 
Pro Tools 5.1 -> 6.9
Vous ne pouvez pas ouvrir une session Pro Tools 
version 7.x ou supérieure avec Pro Tools 
versions 5.1 à 6.9.x. 

Pour enregistrer une session Pro Tools 11.x ou 
10.x afin qu'elle soit compatible avec Pro Tools 
versions 5.1.x à 6.9.x, utilisez la commande File > 

Save Copy In pour choisir le format Pro Tools 5.1 

-> 6.9 Session.
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Lorsque vous enregistrez une session 
Pro Tools 11.x ou 10.x au format Pro Tools 5.1 -> 
6.9, les événements suivants se produisent :

• Tous les événements qui se produisent lorsque 
vous enregistrez une session Pro Tools 11.x ou 
10.x au format Pro Tools 7–>9.

Pistes

• Les pistes audio au-delà de la piste 256 sont 
supprimées.

• Les bus de mixage internes au-delà du bus 128 
sont supprimés.

• Les assignations de bus de sortie sont 
supprimées.

• L'option HEAT (si présente) est supprimée.

• Les paramètres de transposition et de 
déformation des pistes Elastic Audio ne sont pas 
pris en compte, et les durées des clips sont 
conformes au timing du fichier source d'origine.

• Les pistes d'instrument sont divisées en pistes 
d'entrée auxiliaire et pistes MIDI distinctes.

• Les pistes Master VCA sont supprimées et 
l'automation VCA est fusionnée dans les pistes 
esclaves correspondantes.

• Les playlists d'automation de trim sont 
fusionnées dans leurs playlists d'automation 
respectives.

• Les niveaux de gain de fader et les points 
d'automation supérieurs à +6 dB passent à la 
valeur +6 dB.

• Les noms longs sont abrégés à 31 caractères.

• Les attributs suivants sont abandonnés :

• Groupes de clips

• Boucles de clips

• Clips MIDI basés sur les échantillons

• Pistes MIDI basées sur les échantillons

• Inserts F à J et toutes les données 
d'automation associées

• Départs F à J et toutes les données 
d'automation associées

• Emplacements mémoire/de marqueur 
201 à 999

Groupes

• Tous les groupes au-delà des 26 premiers 
(banque 1, groupes a à z) sont abandonnés.

• Les groupes de mixage ne conservent que les 
informations de volume principal.

• Les groupes de mixage/édition ne conservent 
que les informations de volume principal et de 
mode d'automation.

• Les informations du processus d'automation 
pour les commandes groupées ne sont pas 
conservées.

• Les comportements de groupe des commandes 
Solo, Mute, de niveau de départ et de mute de 
départ ne sont pas conservés.

• Les paramètres de mode de solo et de 
verrouillage solo sont abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

Pro Tools 8.x et supérieur prend en charge les 
tailles de fichiers jusqu'à 3,4 Go, et Pro Tools 
10 et supérieur des tailles de fichier pouvant 
dépasser 4 Go. Pro Tools 5.1 à 6.9 sur Mac 
prend uniquement en charge les tailles de 
fichier jusqu'à 2 GB. Si votre session contient 
des fichiers audio de plus de 2 Go, éditez et 
consolidez les clips de sorte qu'aucun des 
fichiers auxquels la session fait référence ne 
dépasse 2 Go.
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• Si la session contient des séquences QuickTime 
dans la liste des clips mais pas de piste vidéo, 
la session s'ouvre avec une nouvelle piste 
QuickTime contenant la première séquence 
QuickTime de la liste des clips.

• La timeline affiche et lit uniquement la dernière 
playlist vidéo active. Aucune autre playlist 
vidéo n'est disponible.

• Les clips vidéo et les groupes de clips vidéo ne 
sont ni affichés ni enregistrés.

Compatibilité linguistique

• L'option Limit Character Set doit être activée et 
vous devez sélectionner une langue et un jeu de 
caractères uniques.

Sauvegarde de sessions 
Pro Tools 11.x - 10.x au format 
Pro Tools 5.0
Vous ne pouvez pas ouvrir une session 
Pro Tools 5.1 ou supérieur dans Pro Tools 5.0.

Pour enregistrer une session Pro Tools 11.x ou 
10.x afin qu'elle soit compatible avec 
Pro Tools 5.0, utilisez la commande File > Save 

Copy In pour choisir le format Pro Tools 5.0 

Session.

Lorsque vous enregistrez une session 
Pro Tools 11.x ou 10.x au format Pro Tools 5.0, 
les événements suivants se produisent :

• Tous les événements qui se produisent lorsque 
vous enregistrez une session Pro Tools 11.x ou 
10.x au format Pro Tools 5.0.

• Les pistes multicanal surround sont supprimées 
de la session.

• Les pistes désactivées sont supprimées de la 
session.

• Les pistes sur lesquelles aucune sortie n'est 
assignée (No Output) sont routées sur les 
bus 31 et 32.

• Les pistes ou départs assignés aux bus 33 à 64 
sont routés sur les bus 31 et 32.

• Les pistes assignées à des chemins multicanal ou 
des sous-chemins de chemins multicanal sont 
routées sur les bus 31 et 32.

• Les départs assignés à des chemins multicanal 
ou des sous-chemins de chemins multicanal sont 
abandonnés.

• Les pistes ou départs assignés aux chemins 
stéréo faisant référence à des canaux 
pairs/impairs (2-3, par exemple) sont routés sur 
les bus 31 et 32.

• Les instances de plug-in multi-mono sont 
abandonnées.

Compatibilité linguistique

Prise en charge Unicode pour 
différentes langues
Pro Tools prend en charge la saisie et l'affichage 
des caractères Unicode dans toutes les fonctions de 
Pro Tools. Vous pouvez ainsi :

• Utiliser plusieurs langues dans les noms 
de sessions, et dans les noms de chemins, 
de fichiers et de clips au sein d'une même 
session.

• Rechercher des termes dans plusieurs langues 
dans les navigateurs de l'espace de travail. 

Langue utilisée pour 
l'attribution automatique de 
noms dans Pro Tools
Lorsque vous travaillez dans une autre langue que 
l'anglais, vous pouvez configurer Pro Tools afin 
que les noms attribués automatiquement aux 
éléments de la session soient en anglais (clips, 
pistes, chemins d'E/S, etc.). Cette fonction est utile 
si vous partagez des sessions avec d'autres 
utilisateurs travaillant en anglais. 
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Pour faire en sorte que la langue utilisée pour 
l'attribution automatique de noms corresponde 
à la langue sélectionnée pour l'application 
Pro Tools, procédez comme suit :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Display.

2 Dans le menu Language, sélectionnez la langue 
à utiliser dans Pro Tools.

3 Désélectionnez l'option Default Automatic 

Naming to English.

Langue utilisée dans 
l'application Pro Tools
(Windows uniquement)

Vous pouvez choisir la langue à utiliser dans 
l'application Pro Tools, indépendamment de la 
langue utilisée dans votre version de Windows.

Pour sélectionner la langue de Pro Tools :

1 Sélectionnez Setup > Preferences, puis cliquez 
sur l'onglet Display.

2 Dans le menu Language, sélectionnez la langue 
à utiliser dans Pro Tools.

Prise en charge des applications 
multilingues pour les systèmes 
Pro Tools
(Systèmes d'exploitation Mac localisés 
uniquement)

Les versions localisées de Pro Tools peuvent 
être ouvertes sur les systèmes Mac qualifiés, 
à condition que ces derniers prennent en charge 
l'anglais et la version localisée. Pour les versions 
localisées de Pro Tools, vous pouvez également 
sélectionner une autre langue (y compris l'anglais) 
dans les préférences système d'Apple.

Pour changer de version localisée de Pro Tools :

1 Fermez d'abord Pro Tools.

2 Lancez les préférences système d'Apple.

3 Cliquez sur International (icône représentant 
un drapeau).

4 Cliquez sur l'onglet Langue.

5 Dans la colonne des langues, faites glisser la 
langue souhaitée en haut de la liste.

6 Fermez la fenêtre International.

7 Effectuez l'une des opérations suivantes :

• Si vous passez d'une version localisée à la 
version anglaise, lancez Pro Tools.

• Si vous passez d'une version localisée à une 
autre (ou de l'anglais à une version localisée), 
fermez puis ouvrez la session à partir du menu 
Pomme, puis lancez Pro Tools.

Si vous souhaitez à nouveau afficher la langue 
précédemment sélectionnée au démarrage de 
l'ordinateur (après avoir travaillé dans une 
autre version localisée), suivez les étapes ci-
dessus et rétablissez la langue précédente 
comme préférence internationale.
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Chapitre 19 : Lecture du contenu des pistes

Après avoir enregistré ou importé de l'audio ou du 
MIDI sur des pistes, vous devez lancer la lecture 
de ces données avant de procéder aux opérations 
d'édition et de mixage.

Lancement et arrêt de la lecture

Pour lancer la lecture, effectuez l'une des 
opérations suivantes :

• Cliquez sur le bouton Play de la fenêtre 
de transport. 

• Appuyez sur la barre d'espace.

• Lorsque le pavé numérique est en mode Transport 
ou Shuttle, appuyez sur la touche 0 du pavé 
numérique.

• Si le pavé numérique est en mode Transport et si 
l'option Use Separate Play and Stop Keys est 
activée, appuyez sur la touche Entrée du pavé 
numérique.

• Si vous disposez d'une surface de travail 
ou d'une surface de contrôle MIDI connectée 
et configurée, appuyez sur la touche Play.

• Si Pro Tools est en ligne et asservi à un autre 
transport, appuyez sur la touche Play du 
transport maître (reportez-vous à la section 
« Activation du mode Online de Pro Tools » 
à la page 1205).

Pour arrêter la lecture, effectuez l'une des 
opérations suivantes :

• Cliquez sur le bouton Stop de la fenêtre 
de transport. 

• Appuyez sur la barre d'espace.

• Lorsque le pavé numérique est en mode Transport 
ou Shuttle, appuyez sur la touche 0 du pavé 
numérique.

• Si vous disposez d'une surface de contrôle 
connectée et configurée, appuyez sur 
la touche Stop.

• Si Pro Tools est en ligne et asservi à un autre 
transport, appuyez sur la touche Stop du 
transport maître (reportez-vous à la section 
« Activation du mode Online de Pro Tools » 
à la page 1205).

Lecture de l'audio

Pour lire de l'audio :

1 Importez ou enregistrez de l'audio sur une piste.

2 Assignez le sélecteur de sortie de la piste 
au chemin de monitoring principal.

3 Dans la fenêtre de transport, cliquez sur le bouton 
de retour à zéro pour vous assurer que la lecture 
commence au début de la session.

4 Lancez la lecture.

5 L'audio est lu via le chemin de sortie 
sélectionné. Ajustez, si nécessaire, les faders de 
volume et de panoramique de la piste.

6 Lorsque vous avez terminé, arrêtez la lecture.

Pour plus d'informations sur les modes du 
pavé numérique, reportez-vous à la section 
« Modes du pavé numérique » à la page 28.
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Lecture de données MIDI

Pour lire du MIDI (avec monitoring audio) : 

1 Importez, enregistrez ou entrez des données 
MIDI sur une piste d'instrument ou MIDI.

2 Pour une piste d'instrument, effectuez les 
opérations suivantes :

• Définissez le sélecteur de sortie audio de la piste 
d'instrument sur le chemin de monitoring principal.

• Si vous utilisez un plug-in d'instrument, insérez-le 
sur la piste. Le sélecteur de sortie MIDI de la piste 
(dans la vue Instrument) devrait être affecté 
automatiquement au plug-in.

• Si vous utilisez un périphérique MIDI externe 
(et non un plug-in d'instrument), définissez le 
sélecteur de sortie MIDI dans la vue Instrument 
sur le périphérique (port) et le canal qui prendra 
en charge la lecture.

• Si vous utilisez un périphérique MIDI externe 
(et non un plug-in d'instrument), définissez 
le sélecteur d'entrée audio de la piste d'instrument 
sur le chemin d'entrée auquel les sorties audio 
de votre périphérique MIDI sont connectées.

3 Pour une piste MIDI, effectuez les opérations 
suivantes :

• Si vous utilisez un plug-in d'instrument, créez 
une entrée auxiliaire ou une piste d'instrument 
pour insérer le plug-in d'instrument sur la piste.

• Si vous utilisez un périphérique MIDI externe 
(et non un plug-in d'instrument), créez une 
entrée auxiliaire ou une piste d'instrument pour 
le monitoring audio à partir d'un périphérique 
MIDI externe ou d'un plug-in d'instrument.

• Si vous utilisez un périphérique MIDI externe 
(et non un plug-in d'instrument), définissez 
l'entrée auxiliaire ou le sélecteur d'entrée audio 
de la piste d'instrument sur le chemin d'entrée 
auquel les sorties audio de votre périphérique 
MIDI sont connectées.

• Définissez l'entrée auxiliaire ou le sélecteur 
de sortie audio de la piste d'instrument sur 
le chemin de monitoring principal.

• Définissez le sélecteur de sortie de la piste MIDI 
sur le plug-in d'instrument ou le périphérique 
(port) MIDI, et le canal que vous souhaitez lire.

4 Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
la lecture commence au début de la session.

5 Lancez la lecture.

6 Les données MIDI sont lues à partir du 
périphérique MIDI sélectionné et le monitoring 
de l'audio provenant du périphérique MIDI est 
assuré via chemin de sortie sélectionné au 
niveau de l'entrée auxiliaire ou de la piste 
d'instrument. Réglez si nécessaire les faders de 
volume et de panoramique des pistes MIDI, 
d'entrée auxiliaire ou Instrument.

7 Lorsque vous avez terminé, arrêtez la lecture.

Pour plus d'informations sur la synchronisation 
des périphériques MIDI externes avec 
Pro Tools pour la lecture et l'enregistrement 
à l'aide du MIDI Beat Clock, reportez-vous à la 
section « MIDI Beat Clock » à la page 430. 
Pour plus d'informations sur l'utilisation 
du timecode MIDI, reportez-vous à la section 
« Génération de timecode » à la page 1206.
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Position de lecture
La position de lecture est l'emplacement dans 
la timeline de Pro Tools à partir duquel vous 
commencez la lecture des données audio ou MIDI 
de la session.

La position de lecture est indiquée par des 
compteurs et des indicateurs dans les fenêtres Edit, 
de transport et du grand compteur. La position 
de lecture (ou la sélection d'édition) est également 
indiquée par un curseur de lecture ou d'édition dans 
la timeline ou la playlist de la fenêtre Edit.

Pro Tools offre également une commande de 
pré-roll permettant de paramétrer la lecture afin 
qu'elle commence avant la position de lecture. 
Reportez-vous à la section « Commandes et 
compteurs de transport de base » à la page 180.

Compteurs et indicateurs 
affichant la position de lecture
Compteurs principal et secondaire et indicateurs 
de sélection d'édition

En haut de la fenêtre Edit, la position de lecture est 
affichée dans les compteurs principal et secondaire, 
ainsi que dans l'indicateur de début de la sélection 
d'édition. Si aucune sélection n'est effectuée, 
la position de lecture est également affichée dans 
l'indicateur de fin de la sélection d'édition.

Les compteurs et les indicateurs de sélection 
d'édition peuvent également être affichés dans 
la fenêtre de transport.

Pour afficher le compteur principal dans la fenêtre 
de transport :

 Sélectionnez View > Transport > Counters. 

Pour afficher le compteur secondaire dans 
la fenêtre de transport :

1 Sélectionnez View > Transport > Counters.

2 Sélectionnez View > Transport > Expanded.

Pour afficher les indicateurs de sélection d'édition 
dans la fenêtre de transport :

 Sélectionnez View > Transport > Expanded.

Le grand compteur

La position de lecture actuelle peut également être 
affichée dans la fenêtre du grand compteur.

Pour afficher la fenêtre du grand compteur :

 Sélectionnez Window > Big Counter.

Compteurs principal et secondaire, indicateurs de 
sélection d'édition

Fenêtre de transport avec compteurs

 Pour afficher ou masquer les compteurs, 
maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le bouton 
Développer/Réduire de la fenêtre de transport.

Pour afficher ou masquer les compteurs et les 
commandes MIDI, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez sur le bouton Développer/Réduire 
de la fenêtre de transport.

Fenêtre du grand compteur
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Curseurs indiquant la position 
de lecture (ou d'édition)
Dans la fenêtre Edit de Pro Tools, deux types 
de curseur indiquent la position de lecture actuelle 
ou la sélection d'édition :

Curseur de lecture

Le curseur de lecture est une ligne continue qui 
se déplace dans la fenêtre Edit pour indiquer 
la position de lecture actuelle.

L'option de défilement sélectionnée détermine 
le comportement de la fenêtre Edit en lecture et celui 
du curseur de lecture. Reportez-vous à la section 
« Options de défilement » à la page 420.

Curseur d'édition

Le curseur d'édition est une ligne clignotante qui 
apparaît lorsque vous cliquez avec le Sélecteur 
dans la playlist d'une piste. Le curseur d'édition 
clignotant indique le point de début de n'importe 
quelle tâche d'édition effectuée. Si vous effectuez 
une sélection et réalisez une opération d'édition, 
la sélection entière est la cible de l'opération.

Localisation du curseur de lecture 
lorsqu'il se trouve en dehors de l'écran

Utilisez le repère de curseur de lecture pour 
localiser le curseur de lecture lorsqu'il n'apparaît 
pas à l'écran.

Si le curseur de lecture se trouve en aval de la 
partie visible de la fenêtre Edit, le repère de curseur 
de lecture apparaît à droite sur la règle de base 
de temps principale. Si le curseur de lecture 
se trouve en amont de la partie visible de la fenêtre 
Edit, le repère de curseur de lecture apparaît 
à gauche sur la règle de base de temps principale.

Par exemple, si l'option de défilement est définie 
sur None, le curseur de lecture se déplace hors 
de l'écran une fois que la zone visible dans la fenêtre 
Edit a été lue. Le repère de curseur de lecture 
apparaît à droite sur la règle de base de temps 
principale une fois que le curseur de lecture s'est 
déplacé au-delà de la zone visible de la fenêtre Edit.

Le repère de curseur de lecture est rouge 
lorsqu'une piste est activée pour l'enregistrement 
et bleu lorsqu'aucune piste n'est activée pour 
l'enregistrement.

Pour localiser le curseur de lecture lorsqu'il 
se trouve en dehors de l'écran :

 Cliquez sur le repère de curseur de lecture sur 
la règle de base de temps principale.

L'affichage est mis à jour afin que le curseur 
de lecture soit centré dans la fenêtre Edit.

Repère de curseur de lecture, état d'activation pour 
l'enregistrement (curseur de lecture situé après 
l'audio affiché)



Chapitre 19 : Lecture du contenu des pistes 417

Définition de la position 
de lecture
Pro Tools fournit des commandes permettant 
de définir et de déplacer la position de lecture dans 
une session de plusieurs façons. Cela inclut la 
recherche d'un passage particulier dans 
un morceau, le déplacement vers une autre section 
de l'arrangement ou la comparaison de plusieurs 
sections.

Définition de la position 
de lecture à l'aide du Sélecteur
Pour définir le début de la lecture, cliquez sur un 
emplacement d'une piste avec le Sélecteur (si les 
sélections d'édition et de timeline sont liées). 
Reportez-vous à la section « Liaison ou 
dissociation des sélections d'édition et de 
timeline » à la page 575.

Pour lancer la lecture depuis un point spécifique 
d'une piste :

1 Assurez-vous que l'option Options > Link 

Timeline and Edit Selection est activée.

2 À l'aide du Sélecteur, cliquez sur une piste 
à l'endroit où vous souhaitez que la lecture 
commence.

3 Lancez la lecture.

4 Arrêtez la lecture.

Pour positionner le curseur à un autre 
emplacement et lancer la lecture à partir de ce 
point, effectuez l'une des opérations suivantes :

 Après l'arrêt de la lecture, cliquez avec 
le Sélecteur sur le point à partir duquel vous 
souhaitez lancer la lecture, puis cliquez sur 
le bouton Play de la fenêtre de transport.

 En cours de lecture, cliquez sur la nouvelle 
position sur l'une des règles de base de temps.

Lorsque les sélections d'édition et de timeline sont 
liées, vous pouvez cliquer sur un clip ou une note 
MIDI à l'aide de l'outil de saisie du temps pour 
automatiquement mettre à jour la position du début 
de la sélection de timeline, ce qui permet de lancer la 
lecture à partir ce point.

Définition de la position de 
lecture à l'aide des commandes 
de base de la fenêtre de transport
Pour déplacer la position de lecture, vous pouvez 
utiliser les commandes de transport situées dans 
la fenêtre de transport et en haut de la fenêtre Edit. 
Elles incluent les commandes de retour rapide 
(Rewind), d'avance rapide (Fast Forward) et de 
retour à zéro (Return to Zero) (pour déplacer 
la position de lecture vers le début de la session). 
Pour plus d'informations, reportez-vous à la section 
« Commandes et compteurs de transport de base » 
à la page 180.

Définition d'un point de lecture avec le Sélecteur
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Définition de la position 
de lecture à l'aide du compteur 
principal ou de l'indicateur 
de début de la sélection d'édition

Pour définir la position de lecture à l'aide 
du compteur principal (ou de l'indicateur de début 
de la sélection d'édition) :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur l'un des compteurs.

• Appuyez sur la touche astérisque (*) du pavé 
numérique pour mettre en surbrillance le 
compteur principal de la fenêtre Edit (ou celui de 
la fenêtre de transport ou la fenêtre du grand 
compteur, si l'une ou l'autre est à l'écran).

2 Entrez la nouvelle position. Appuyez sur la touche 
Point (.) pour passer d'un champ à l'autre.

3 Appuyez sur Entrée pour accepter la nouvelle 
valeur et vous y rendre automatiquement.

Définition de la position 
de lecture à l'aide des 
commandes Fast Forward/Rewind
Les boutons Fast Forward et Rewind de la fenêtre de 
transport permettent de déplacer la position de 
lecture. Si l'option Audio During Fast 

Forward/Rewind des préférences de 
fonctionnement est sélectionnée, l'audio continue à 
être lu lors de l'utilisation du bouton Fast Forward 
ou Rewind (comme sur un lecteur CD).

Vous pouvez également effectuer une avance 
rapide ou un retour rapide par incréments 
en cliquant plusieurs fois sur le bouton 
correspondant. La taille de ces incréments est 
déterminée par l'échelle temporelle principale :

Bars|Beats : déplace la position de lecture 
au début de la mesure précédente ou suivante.

Min:Sec : déplace la position de lecture en arrière ou 
en avant par pas d'une seconde.

Timecode : déplace la position de lecture 
en arrière ou en avant par pas d'une seconde 
(avec ajustement au format SMPTE actuel).

Feet+Frames : déplace la position de lecture 
en arrière ou en avant par pas d'un pied.

Samples : déplace la position de lecture en arrière ou 
en avant par pas d'une seconde.

Définition de la position 
de lecture à l'aide des 
commandes Back et Forward
(Pro Tools HD uniquement)

Pro Tools dispose de quatre commandes 
Back/Forward (appelées parfois « rollback ») pour 
déplacer la position de lecture dans la fenêtre Edit. 

Vous pouvez également déplacer la position 
de lecture par plusieurs incréments en appuyant de 
manière répétée sur la commande (reportez-vous à 
la section « Utilisation répétée des commandes 
Back/Forward » à la page 419).

Back : déplace la position de lecture vers l'arrière de 
la valeur définie par l'option Back/Forward Amount 
(Valeur de déplacement arrière/avant).

Back and Play : déplace la position de lecture vers 
l'arrière de la valeur définie par l'option 
Back/Forward Amount et lance automatiquement la 
lecture.

Forward : déplace la position de lecture vers 
l'avant de la valeur définie par l'option 
Back/Forward Amount.

Les commandes Back/Forward fonctionnent 
également lorsque vous contrôlez un 
périphérique 9 broches. Pour plus 
d'informations, reportez-vous au Guide 
MachineControl.
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Forward and Play : déplace la position de lecture 
vers l'avant de la valeur définie par l'option 
Back/Forward Amount et lance automatiquement 
la lecture.

Définition de la valeur de l'option Back/Forward 
Amount

L'intervalle du déplacement avant ou arrière est 
déterminé par le paramètre Back/Forward 
Amount des préférences de fonctionnement 
(Setup > Preferences).

Pour configurer le paramètre Back/Forward Amount :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

La base de temps des paramètres Back/Forward 
Amount est conforme à l'échelle temporelle 
principale par défaut. Vous pouvez désélectionner 
l'option Follow Main Time et choisir une autre base 
de temps :

• Bars|Beats

• Min:Sec

• Timecode

• Feet+Frames

• Samples

2 Effectuez l'une des opérations suivantes :

• Sélectionnez une valeur prédéfinie dans le menu 
déroulant Back/Forward Amount.

• Dans le champ Back/Forward Amount, saisissez 
un intervalle personnalisé.

Utilisation des commandes Back ou Forward

Pour déplacer la position de la lecture vers l'arrière 
de la valeur Back/Forward Amount :

 Maintenez la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et cliquez sur le bouton Rewind 
de la fenêtre de transport.

Pour déplacer la position de la lecture vers l'avant 
de la valeur Back/Forward Amount :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur le 
bouton Fast Forward de la fenêtre de transport.

Pour déplacer la position de la lecture vers l'arrière 
de la valeur Back/Forward Amount et lancer 
automatiquement la lecture :

 Maintenez les touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac) enfoncées et cliquez 
sur le bouton Rewind de la fenêtre de transport.

Pour déplacer la position de la lecture vers l'avant 
de la valeur Back/Forward Amount et lancer 
automatiquement la lecture :

 Maintenez les touches Ctrl+Alt (Windows) 
ou Commande+Option (Mac) enfoncées 
et cliquez sur le bouton Fast Forward de la 
fenêtre de transport.

Utilisation répétée des commandes Back/Forward

Toutes les commandes Back/Forward peuvent être 
utilisées de manière répétée afin d'augmenter 
l'amplitude du déplacement avant ou arrière.

Pour appliquer des commandes Back/Forward 
répétées :

1 Maintenez la touche Commande (Mac) ou 
Ctrl (Windows) enfoncée.

2 Cliquez sur les boutons Rewind ou Fast 
Forward autant de fois que nécessaire pour 
déplacer la position de lecture en arrière ou en 
avant. La valeur Back/Forward Amount définit 
l'intervalle du déplacement.
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Extension des sélections avec les commandes 
Back ou Back and Play

Les commandes Back ou Back and Play peuvent 
étendre une sélection en amont, de la valeur 
spécifiée par le paramètre Back/Forward Amount. 

Pour étendre une sélection avec les commandes 
Back ou Back and Play :

1 Définissez la valeur du paramètre Back/Forward 
Amount. Reportez-vous à la section « Définition 
de la valeur de l'option Back/Forward Amount » 
à la page 419.

2 Faites glisser le sélecteur sur la piste pour créer 
une sélection.

3 Effectuez l'une des opérations suivantes :

• Pour étendre la sélection en amont de la valeur 
Back/Forward Amount, maintenez les touches 
Maj+Ctrl (Windows) ou Maj+Commande (Mac) 
enfoncées et cliquez sur le bouton Rewind de la 
fenêtre de transport.

• Pour étendre la sélection en amont de la valeur 
Back/Forward Amount et lancer la lecture, 
maintenez les touches Maj+Ctrl+Alt (Windows) 
ou Maj+Commande+Option (Mac) enfoncées 
et cliquez sur le bouton Rewind de la fenêtre 
de transport.

Méthodes alternatives 
de déplacement de la position 
de lecture
Vous pouvez également déplacer la position 
de lecture à l'aide des opérations suivantes :

Modes de shuttle verrouillé : en mode de shuttle 
verrouillé Classic ou Transport, vous pouvez 
utiliser le pavé numérique pour effectuer un shuttle 
avant ou arrière à la vitesse souhaitée. Pour plus 
d'informations, reportez-vous à la section « Modes 
de shuttle verrouillé » à la page 28.

Emplacements mémoire : les emplacements 
mémoire peuvent être utilisés pour déplacer 
la position de lecture (ou la sélection d'édition). 
Lorsqu'un emplacement mémoire est rappelé, 
la position de lecture (ou la sélection d'édition) est 
mise à jour. Vous pouvez rappeler des 
emplacements mémoire à partir de la fenêtre 
Memory Locations et à partir du pavé numérique. 
De plus, vous pouvez rappeler des sélections 
de marqueurs en cliquant dessus sur la règle des 
marqueurs. Pour plus d'informations, reportez-vous 
à la section « Rappel d'emplacements mémoire » 
à la page 843.

Tabulation vers les transitoires : lorsque le 
bouton Tab to Transients est activé, vous pouvez 
passer automatiquement d'un transitoire à un autre 
dans les formes d'onde audio, en plaçant le curseur 
juste avant la crête transitoire détectée. Pour plus 
d'informations, reportez-vous à la section 
« Tabulation vers les transitoires » à la page 587.

Options de défilement
Il est possible de configurer le défilement 
du contenu de la fenêtre Edit en cours de lecture 
et d'enregistrement. 

Pour configurer les options de défilement :

 Sélectionnez Options > Scrolling, puis l'une des 
options suivantes :

None : la fenêtre Edit ne défile ni pendant ni après 
la lecture. Le curseur de lecture se déplace dans 
la fenêtre Edit, indiquant la position de lecture.

After Playback : le curseur de lecture se déplace 
dans la fenêtre Edit, indiquant la position 
de lecture. La fenêtre Edit défile jusqu'à la position 
de lecture finale après l'arrêt de la lecture.

Bien que vous ne puissiez pas étendre une 
sélection à l'aide des commandes Forward 
ou Forward and Play, vous pouvez utiliser 
les procédures suivantes avec Forward 
ou Forward and Play pour déplacer le point 
de début de la sélection actuelle.
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Page : le curseur de lecture se déplace dans 
la fenêtre Edit, indiquant la position de lecture. 
Lorsque le bord droit de la fenêtre Edit est atteint, 
son contenu tout entier défile et le curseur 
de lecture reprend son déplacement depuis le bord 
gauche de la fenêtre. Pour plus d'informations, 
reportez-vous à la section « Défilement par page 
pendant la lecture » à la page 421.

Continuous (Pro Tools HD uniquement) : 
reportez-vous à la section « Défilement continu 
pendant la lecture » à la page 421.

Center Playhead (Pro Tools HD uniquement) : 
reportez-vous à la section « Défilement centré sur 
la tête de lecture » à la page 422.

Défilement par page pendant 
la lecture
Vous pouvez configurer Pro Tools afin que 
l'affichage des pistes défile en cours de lecture, et 
que le curseur d'édition apparaisse 
à l'emplacement d'arrêt de la lecture.

Si vous souhaitez que l'affichage des pistes et le 
curseur d'édition suivent la lecture :

 Activez le bouton Timeline Insertion/Play Start 
Marker Follows Playback dans la fenêtre Edit.

Défilement continu pendant 
la lecture
(Pro Tools HD uniquement)

L'option Continuous Scrolling During Playback 
provoque le défilement continu du contenu 
de la fenêtre Edit en aval du curseur de lecture, 
qui reste au centre de la fenêtre. Avec cette option, 
la lecture repose toujours sur la sélection de timeline 
(contrairement à ce qui se produit avec l'option Center 

Playhead Scrolling). 

L'option Continuous Scrolling During Playback fait 
appel aux capacités de traitement de l'hôte et ne 
doit par conséquent être utilisée qu'en cas 
d'absolue nécessité sur les systèmes Pro Tools 
basés sur hôte.

Si vous créez une sélection dans la timeline ou 
dans une playlist, ou si vous faites défiler la 
timeline manuellement en mode de défilement 
par page ou continu, le défilement est suspendu. 
Pour reprendre le défilement des pages et 
passer à l'emplacement actuel de la tête de 
lecture, cliquez sur le repère du curseur de 
lecture sur la règle de base de temps principale 
(reportez-vous à la section « Localisation du 
curseur de lecture lorsqu'il se trouve en dehors 
de l'écran » à la page 416).

Bouton Timeline Insertion/Play Start Marker Follows 
Playback activé

Vous pouvez activer ou désactiver l'option 
Timeline Insertion/Play Start Marker Follows 
Playback des préférences de fonctionnement.

Pour activer ou désactiver l'option Timeline 
Insertion/Play Start Marker Follows Playback, 
appuyez sur Démarrer+N (Windows) 
ou Ctrl+N (Mac).
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Défilement centré sur la tête 
de lecture
(Pro Tools HD uniquement)

L'option Center Playhead Scrolling entraîne 
le défilement continu du contenu de la fenêtre Edit 
en aval de la tête de lecture, matérialisée par une 
ligne bleue au centre de la fenêtre (ou une ligne 
rouge pendant l'enregistrement).

La tête de lecture indique le point de début 
de lecture lorsque vous cliquez sur le bouton Play 
de la fenêtre de transport.

Pour déplacer la tête de lecture à un emplacement 
déterminé, vous pouvez faire défiler la règle 
(reportez-vous à la section « Défilement sur une 
règle de base de temps » à la page 590), utiliser la 
barre de défilement horizontale de la fenêtre Edit 
ou saisir l'emplacement désiré dans l'un des 
indicateurs de sélection d'édition ou dans l'un des 
compteurs.

Le déplacement de la tête de lecture par ces 
méthodes ne met pas à jour la sélection de timeline. 
En revanche, la mise à jour de la sélection de 
timeline déplace automatiquement la tête de 
lecture vers le point d'insertion de la timeline.

Lorsque la tête de lecture est activée, vous pouvez 
atteindre la sélection d'édition ou de timeline et 
passer en lecture. Pour plus d'informations, 
reportez-vous à la section « Lecture des sélections 
d'édition et de timeline avec la tête de lecture » 
à la page 424.

Demi-page de la fenêtre Edit
Lorsque le défilement est en mode continu 
ou centré sur la tête de lecture, une demi-page 
apparaît à l'extrémité gauche de la fenêtre Edit 
(avant le début de la session) lorsque la tête 
de lecture est au début de la session.

Option Center Playhead Scrolling

Les modes de défilement centré sur la tête de 
lecture et de transport dynamique ne peuvent 
pas être utilisés en même temps. Si vous passez 
en mode de défilement centré sur la tête de 
lecture, le mode de transport dynamique est 
désactivé (s'il était activé au préalable). De la 
même façon, lorsque le mode de défilement 
centré sur la tête de lecture est activé, 
la sélection du mode de transport dynamique 
entraîne la désactivation du défilement.

Demi-page en mode de défilement centré sur la tête 
de lecture



Chapitre 19 : Lecture du contenu des pistes 423

Lecture de sélections
Après avoir créé une sélection d'édition, vous 
pouvez l'écouter en cliquant sur le bouton Play 
de la fenêtre de transport. S'ils sont activés, 
les pré-rolls et post-rolls sont lus également.

Pour lire une sélection :

1 Sélectionnez Options > Link Timeline and Edit 

Selection.

2 À l'aide du Sélecteur ou de l'outil de saisie 
du temps, effectuez une sélection de piste.

3 Si vous souhaitez utiliser le pré-roll ou le 
post-roll, activez-les et configurez leur durée. 
Pour plus d'informations, reportez-vous à la 
section « Configuration des durées de pré-roll 
et post-roll » à la page 466.

4 Cliquez sur le bouton Play de la fenêtre 
de transport ou appuyez sur la barre d'espace.

Toutes les pistes sont lues sur la durée de la sélection, 
avec les pré-roll et post-roll le cas échéant.

Pour lire une sélection d'édition avec l'option Link 
Timeline and Edit Selection désactivée :

 Sélectionnez Edit > Selection > Play Edit.

Pour lire une sélection de timeline lorsque l'option 
Link Timeline and Edit Selection est désactivée :

 Sélectionnez Edit > Selection > Play Timeline.

Écoute du pré-roll et du post-roll
Il est possible d'écouter et de lire uniquement les 
plages de pré-roll ou post-roll d'une sélection.

Pour lire à partir du point de pré-roll jusqu'au 
début de la sélection ou jusqu'à l'emplacement 
actuel du curseur :

 Appuyez sur Alt+Flèche gauche (Windows) 
ou Option+Flèche gauche (Mac).

Pour lire jusqu'au point de post-roll à partir de la 
fin de la sélection ou depuis l'emplacement actuel 
du curseur :

 Appuyez sur Ctrl+Flèche droite (Windows) 
ou Commande+Flèche droite (Mac).

Écoute des points de début 
et de fin des sélections
Il peut être utile dans certains cas d'écouter 
le début ou la fin d'une sélection audio sans pour 
autant écouter la sélection complète. Vous pouvez 
ainsi vérifier, par exemple, la présence de clics ou 
pops parasites.

Pour écouter le point de début d'une sélection :

 Appuyez sur Ctrl+Flèche gauche (Windows) 
ou Commande+Flèche gauche (Mac).

Lors de l'écoute du début d'une sélection, la lecture 
part du point de début et continue sur la durée 
du post-roll.

Pour écouter le point de début d'une sélection 
avec le pré-roll :

 Appuyez sur Ctrl+Alt+Flèche gauche (Windows) 
ou Commande+Option+Flèche gauche (Mac).

Plages de lecture pour l'écoute des points de début 
et de fin

lit le début
(sur la durée de post-roll)

lecture du pré-roll + début

lit la fin
(sur la durée de pré-roll)

lecture de la fin + post-roll
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Pour écouter le point de fin d'une sélection :

 Appuyez sur Alt+Flèche droite (Windows) 
ou Option+Flèche droite (Mac).

Lorsque vous écoutez la fin d'une sélection, 
la lecture continue jusqu'au point de fin, 
sur la durée du pré-roll.

Pour écouter le point de fin d'une sélection avec 
le post-roll :

 Appuyez sur Ctrl+Alt+Flèche droite (Windows) 
ou Commande+Option+Flèche droite (Mac).

Fondu d'entrée du transport
Pro Tools fournit une option Fade-in qui s'applique 
au transport. Lorsque cette option est activée, 
un fondu d'entrée linéaire est appliqué à toutes les 
sources audio, du silence jusqu'à leur niveau actuel, 
à l'emplacement auquel le transport est lancé. 
La durée du fondu d'entrée peut être configurée 
de 0.000 à 4.000 secondes. Cette option permet 
d'éviter les pops et les clics ou les augmentations 
soudaines de volume lors du repositionnement de la 
tête de lecture en cours de lecture. 

Utilisez des durées de fondu d'entrée plus courtes 
(250 ms) en production musicale. Pour certains 
projets de post-production synchronisés sur des 
magnétoscopes externes, utilisez une durée de 
fondu d'entrée plus longue, équivalente à la durée 
nécessaire pour que les périphériques synchronisés 
se verrouillent sur le timecode (jusqu'à 
2 secondes).

Pour activer (ou désactiver) l'option Fade-in 
du transport :

1 Ouvrez la fenêtre de transport étendue.

2 Cliquez sur Fade-in pour mettre l'option 
en surbrillance (ou la désactiver). 

Pour configurer la durée du fondu d'entrée 
du transport :

1 Ouvrez la fenêtre de transport étendue.

2 Cliquez sur le champ numérique situé à droite 
du bouton d'activation du fondu d'entrée. 

3 Entrez la durée souhaitée.

4 Appuyez sur Retour (Mac) ou Entrée (Windows).

Lecture des sélections 
d'édition et de timeline avec 
la tête de lecture
(Pro Tools HD uniquement)

Lorsque le défilement est centré sur la tête de 
lecture, les sélections de timeline ne déterminent 
pas l'emplacement de début de lecture. La tête 
de lecture elle-même symbolise le point auquel 
la lecture débute. 

Les sélections de timeline et d'édition peuvent 
toujours être lues lorsque la tête de lecture 
est activée.

Pour lire une sélection d'édition avec la tête 
de lecture activée :

1 Désélectionnez Options > Link Timeline and 

Edit Selection.

2 Sélectionnez Options > Scrolling > Center 

Playhead.

Fondu d'entrée activé dans la fenêtre de transport 
(2 secondes)

Durée du fondu d'entrée

Fondu d'entrée activé

En enregistrement, assurez-vous que l'option 
Fade-in du transport est désactivée. Si elle 
est activée, un fondu d'entrée de la même 
durée sera appliqué à l'audio enregistré.
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3 À l'aide du Sélecteur ou de l'outil de saisie 
du temps, créez une sélection de piste.

4 Sélectionnez Edit > Selection > Play Edit.

Pour lire une sélection de timeline avec la tête de 
lecture activée :

1 Désélectionnez Options > Link Timeline and 

Edit Selection.

2 Sélectionnez Options > Scrolling > Center 

Playhead.

3 Faites glisser le Sélecteur sur n'importe quelle 
règle de base de temps pour définir la plage de 
lecture.

4 Sélectionnez Edit > Selection > Play Timeline.

Déplacement de la tête 
de lecture
Lorsque le défilement est centré sur la tête 
de lecture, la tête de lecture peut être déplacée 
en avant ou en arrière, vers la limite de clip 
suivante sur la piste sélectionnée.

Pour déplacer la tête de lecture vers les limites 
d'un clip d'une piste :

1 Vérifiez que le bouton Tab to Transients n'est pas 
activé (reportez-vous à la section « Tabulation 
vers les transitoires » à la page 587).

2 Cliquez avec le Sélecteur sur la piste.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche de tabulation pour 
déplacer la tête de lecture en aval vers la limite 
de clip suivante.

• Pour déplacer la tête de lecture en amont sur 
la limite de clip précédente, appuyez sur 
Option+Tab (Mac) ou Ctrl+Tab (Windows).

Modes de lecture
Pro Tools propose plusieurs modes de lecture : 

• Mode de lecture normale

• Mode de lecture à mi-vitesse

• Mode d'amorce pour lecture

• Mode de lecture en boucle

• Mode de transport dynamique

Mode de lecture normale
Le mode de lecture normale correspond 
simplement au mode de lecture utilisé 
lorsqu'aucun des autres modes n'est appliqué. 
En mode de lecture normale, Pro Tools suit 
la fréquence d'échantillonnage de la session.

Mode de lecture à mi-vitesse
Utilisez le mode de lecture à mi-vitesse pour 
répéter ou transcrire des passages difficiles 
de pistes enregistrées.

Pour activer la lecture à mi-vitesse :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Play de la fenêtre 
de transport tout en maintenant la touche 
Maj enfoncée.

• Effectuez un clic droit sur le bouton Play de la 
fenêtre de transport et sélectionnez Half-Speed. 
Cliquez ensuite sur le bouton Play pour lancer la 
lecture à mi-vitesse.

2 Pour interrompre la lecture, cliquez sur 
le bouton Stop de la fenêtre de transport.

Vous pouvez également lire à mi-vitesse 
en utilisant la combinaison de touches 
Maj+barre d'espace.
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Mode d'amorce pour lecture
Lorsque le nombre de pistes est élevé, 
le déclenchement de la lecture de Pro Tools peut être 
retardé. Afin d'éviter ce retard, activez le mode 
d'amorce pour lecture avant de lancer la lecture.

Pour activer le mode d'amorce pour lecture 
et lancer la lecture :

1 Effectuez l'une des opérations suivantes :

• Pour placer Pro Tools en mode d'amorce pour 
lecture, maintenez la touche Alt (Windows) 
ou Option (Mac) enfoncée et cliquez sur 
le bouton Play de la fenêtre de transport. 

• Effectuez un clic droit sur le bouton Play 
et sélectionnez Prime for Playback.

Le bouton Stop s'allume et le bouton Play clignote.

2 Pour lancer la lecture instantanément, cliquez 
sur le bouton Play. 

3 Cliquez sur le bouton Stop pour stopper la lecture.

Mode de lecture en boucle
Lorsque le mode de lecture en boucle est activé, 
la plage sélectionnée est lue en boucle. Si aucune 
sélection n'a été créée, la lecture se déroule 
normalement à partir de l'emplacement actuel 
du curseur. 

La lecture en boucle permet notamment de vérifier la 
continuité rythmique d'une sélection de données 
musicales. La lecture en boucle de sélections d'une 
mesure peut permettre de vérifier si le bouclage est 
perceptible ou non. Si la mise en boucle est audible, 
ajustez la longueur de la sélection jusqu'à ce que la 
boucle s'enchaîne parfaitement et colle avec le contenu 
des autres pistes.

Pour lire une sélection en boucle :

1 Sélectionnez Options > Link Timeline and 
Edit Selection.

2 À l'aide du Sélecteur, sélectionnez la plage de la 
piste à lire en boucle.

3 Activez la lecture en boucle en effectuant l'une 
des opérations suivantes :

• Sélectionnez Options > Loop Playback. 

• Effectuez un clic droit sur le bouton Play de la 
fenêtre de transport, puis sélectionnez Loop dans 
le menu contextuel.

• Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le bouton 
Play de la fenêtre de transport. 

• Appuyez sur Ctrl+Maj+L (Windows) 
ou Commande+Maj+L (Mac).

• Lorsque le pavé numérique est en mode Transport, 
appuyez sur la touche 4 du pavé numérique.

Dès que la lecture en boucle est activée, 
un symbole de boucle apparaît sur le bouton Play 
de la fenêtre de transport.

4 Cliquez sur le bouton Play de la fenêtre 
de transport.

La lecture commence à partir du point de pré-roll 
(si le pré-roll est activé) et continue jusqu'au point 
de fin de la sélection, puis revient au point de départ.

5 Pour interrompre la lecture, cliquez sur le 
bouton Stop de la fenêtre de transport.

Lecture en boucle et enregistrement audio

La lecture en boucle n'active pas l'enregistrement 
en boucle. Pour enregistrer en boucle, passez 
en mode Loop Record (reportez-vous à la section 
« Enregistrement audio en boucle » à la page 472).

Lors d'une synchronisation sur un timecode, 
utilisez le mode Prime for Playback pour lire un 
grand nombre de pistes. Le verrouillage sur le 
timecode sera ainsi plus rapide.

Une sélection doit durer au moins 500 ms 
pour pouvoir être lue en boucle.

Lecture en boucle activée
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Mode de transport dynamique
Le mode de transport dynamique permet 
de dissocier la position de lecture de la sélection 
de timeline. Cela signifie que vous pouvez lancer 
la lecture à partir de n'importe quel emplacement 
de la timeline sans perdre les sélections de timeline 
ou d'édition. Vous pouvez par exemple utiliser 
le mode de transport dynamique conjointement 
avec la lecture en boucle pour écouter rapidement 
des transitions entre des boucles.

Lorsque le mode de transport dynamique est activé, 
la hauteur de la règle de base de temps principale 
double afin d'afficher le marqueur de début 
de lecture. Ce marqueur détermine l'emplacement 
du début de la lecture lors de l'activation 
du transport. L'emplacement choisi est entièrement 
indépendant de la sélection de timeline. Vous 
pouvez le modifier pendant la lecture ; la lecture 
se poursuit alors à partir du nouvel emplacement.

Pour activer ou désactiver le mode de transport 
dynamique, effectuez l'une des opérations 
suivantes :

 Sélectionnez ou désélectionnez Options > 

Dynamic Transport.

 Effectuez un clic droit sur le bouton Play de la 
fenêtre de transport, puis sélectionnez Dynamic 

Transport dans le menu contextuel.

 Appuyez sur Ctrl+Démarrer+P (Windows) ou 
Commande+Ctrl+P (Mac) pour activer ou 
désactiver le mode de transport dynamique.

Pour repositionner le marqueur de début de 
lecture, effectuez l'une des opérations suivantes :

 Sélectionnez un outil d'édition, puis cliquez sur 
la ligne du marqueur de début de lecture sur la 
règle de base de temps principale.

 Sélectionnez un outil d'édition et faites glisser 
le marqueur de début de lecture à 
l'emplacement souhaité.

L'activation du mode de transport dynamique 
désactive automatiquement l'option Link 
Timeline and Edit Selection et active 
automatiquement la lecture en boucle.

Les modes de défilement centré sur la tête 
de lecture (Pro Tools HD uniquement) et 
de transport dynamique ne peuvent pas être 
utilisés en même temps. Si vous passez 
en mode de défilement centré sur la tête de 
lecture, le mode de transport dynamique est 
désactivé (s'il était activé au préalable). De 
la même façon, lorsque le mode de défilement 
centré sur la tête de lecture est activé, 
la sélection du mode de transport dynamique 
entraîne la désactivation du défilement.

Mode de transport dynamique avec marqueur 
de début de lecture sur la règle de base de temps 
principale étendue

Bande du marqueur de début de lecture

Sélection de timeline
Marqueur de début de lecture
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 Cliquez sur le bouton Fast Forward ou Rewind de 
la fenêtre de transport pour déplacer le marqueur 
de début de lecture de la valeur d'incrément 
standard définie pour ces commandes.

Pour modifier les marqueurs de début ou de fin 
d'une sélection de timeline :

1 Définissez une sélection de timeline en cliquant et 
en faisant glisser le Sélecteur sur la règle de base 
de temps principale. Si l'option Link Timeline and 

Edit Selection est activée, vous pouvez créer une 
sélection d'édition avec le Sélecteur ou l'un des 
outils de saisie.

2 Sélectionnez un outil d'édition puis faites glisser le 
marqueur de début ou de fin de la sélection de 
timeline vers la gauche ou la droite afin d'étendre 
ou de réduire la sélection.

Pour déplacer la sélection de timeline :

 Sélectionnez un outil d'édition puis faites 
glisser la sélection sur la règle de base de temps 
principale à l'emplacement souhaité.

Play Start Marker Follows Timeline Selection

Lorsque cette option est activée, le marqueur 
de début de lecture s'aligne sur le point d'entrée de 
sélection de timeline lorsque vous déplacez 
ou créez une sélection de timeline ou lorsque vous 
ajustez le point de début de la sélection de timeline. 
Si cette option est désactivée, le marqueur de début 
de lecture n'est pas déplacé avec la sélection de 
timeline.

Pour aligner en permanence le marqueur de début 
de lecture sur le point d'entrée de sélection de 
timeline :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Operation.

3 Sélectionnez l'option Play Start Marker Follows 
Timeline Selection.

4 Cliquez sur OK.

Timeline Insertion/Play Start Marker Follows 
Playback

Lorsque cette option est activée, le marqueur 
de début de lecture se déplace jusqu'au point de la 
timeline auquel la lecture a été interrompue. Si cette 
option est désactivée, le marqueur de début de lecture 
ne suit pas la lecture. 

Lorsque le mode de transport dynamique n'est pas 
sélectionné, le point d'insertion sur la timeline suit 
la lecture.

Pour que le point d'insertion sur la timeline et le 
marqueur de début de lecture suivent la lecture, 
procédez comme suit :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Operation.

Double-cliquez sur une zone de la bande du 
marqueur de début de lecture de la règle de base de 
temps principale pour déplacer le marqueur à cet 
emplacement et lancer la lecture.

Si vous modifiez la sélection de timeline 
en cours de lecture, celle-ci s'interrompt 
momentanément. Pour minimiser la durée de 
cette interruption, réduisez la taille de la 
mémoire tampon de lecture AAE dans la 
boîte de dialogue Playback Engine.

Déplacement d'une sélection d'édition en mode de 
transport dynamique

Lorsque l'option Link Timeline and Edit 
Selection est désactivée, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et faites glisser la sélection de timeline afin de 
l'aligner sur la sélection d'édition et ainsi 
déplacer les deux sélections simultanément.
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3 Sélectionnez Timeline Insertion/Play Start 

Marker Follows Playback.

4 Cliquez sur OK.

Utilisation du mode de transport 
dynamique et de la lecture en 
boucle
Utilisez le mode de transport dynamique 
conjointement à la lecture en boucle afin de définir 
les points de début et de fin de la boucle sur la 
sélection de timeline, tout en utilisant le marqueur 
de début de lecture pour spécifier l'emplacement 
de début de la lecture. La combinaison de ces 
fonctionnalités permet notamment d'écouter les 
transitions de boucles. La sélection du mode de 
transport dynamique active automatiquement la 
lecture en boucle.

Pour écouter une transition de boucle :

1 Activez le mode de transport dynamique.

2 Assurez-vous que la lecture en boucle est activée.

3 Créez la sélection de timeline à lire en boucle.

4 Positionnez le marqueur de début de lecture 
devant le point de sortie de la sélection 
de timeline.

5 Lancez la lecture.

La lecture commence avant le point de fin de 
boucle et continue en revenant au point de début de 
la boucle. Vous pouvez modifier l'emplacement 
des marqueurs de début et de fin de la sélection de 
timeline en les déplaçant vers la gauche ou la 
droite, même en cours de lecture. 

Utilisation de touches 
différentes pour le lancement 
et l'arrêt de la lecture
Lorsqu'elle est activée, l'option Use Separate Play 

and Stop Keys permet de lancer la lecture à l'aide 
de la touche Entrée et de l'arrêter à l'aide de la 
touche 0 du pavé numérique. Cette option s'utilise 
notamment lors de l'écoute des transitions de 
boucle, pour lancer et arrêter la lecture à des points 
rapprochés.

Pour utiliser des touches du pavé numérique 
différentes pour le démarrage et l'arrêt de la 
lecture :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Operation.

3 Sélectionnez Transport pour Numeric Keypad.

4 Sélectionnez Use Separate Play and Stop Keys.

5 Cliquez sur OK.

La touche Entrée permet de lancer la lecture. 
La touche zéro permet d'arrêter la lecture. Si vous 
appuyez deux fois sur la touche zéro, le marqueur de 
début de lecture se positionne au début de la sélection 
de timeline.

Pour activer ou désactiver l'option Timeline 
Insertion/Play Start Marker Follows Playback, 
appuyez sur Démarrer+N (Windows) 
ou Ctrl+N (Mac).

Écoute d'une transition de boucle en mode de 
transport dynamique

Lorsque cette option est sélectionnée, la touche 
Entrée ne permet plus d'ajouter des marqueurs 
d'emplacement mémoire. Pour ajouter 
un marqueur d'emplacement mémoire, vous 
devez d'abord appuyer sur le point (.), puis sur la 
touche Entrée du pavé numérique.
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Raccourcis clavier 
de déplacement du marqueur 
de début de lecture
En mode de transport dynamique, vous pouvez 
utiliser des raccourcis clavier pour déplacer 
le marqueur de début de lecture en cours de lecture 
ou lorsque le transport est arrêté. 

Pour déplacer le marqueur de début de lecture au 
début de la sélection de timeline :

 Appuyez sur la touche Point (.) du pavé 
numérique, puis sur la touche Flèche gauche.

Pour déplacer le marqueur de début de lecture à la 
fin de la sélection de timeline :

 Appuyez sur la touche Point (.) du pavé 
numérique, puis sur la touche Flèche droite.

Pour déplacer le marqueur de début de lecture au 
début de la sélection d'édition :

 Appuyez sur la touche Point (.) du pavé 
numérique, puis sur la touche Flèche bas.

Pour déplacer le marqueur de début de lecture au 
niveau de la tête de lecture :

 Appuyez sur la touche Point (.) du pavé 
numérique, puis sur la touche Flèche haut.

Pour déplacer le marqueur de début de lecture en 
amont (retour rapide) :

 Appuyez sur la touche 1 du pavé numérique.

Pour déplacer le marqueur de début de lecture en 
aval (avance rapide) :

 Appuyez sur la touche 2 du pavé numérique.

Pour déplacer le marqueur de début de lecture sur 
une mesure spécifique :

 Sélectionnez Bars|Beats comme règle de base 
de temps principale, puis effectuez les 
opérations suivantes sur le pavé numérique :

• Appuyez sur la touche astérisque (*).

• Saisissez le numéro de la mesure.

• Appuyez sur la touche Entrée.

Enregistrement en mode 
de transport dynamique
L'enregistrement en mode de transport dynamique 
permet de lancer la lecture indépendamment de la 
sélection de timeline. Utilisez le marqueur de 
début de lecture comme un pré-roll manuel avant 
la sélection de timeline. Les points de punch-in 
et out de l'enregistrement correspondent à la 
sélection de timeline. 

MIDI Beat Clock
Pro Tools peut transmettre un MIDI Beat Clock 
pour synchroniser des périphériques MIDI externes 
compatibles (boîtes à rythmes, séquenceurs 
matériels ou arpégiateurs, par exemple) au tempo 
de la session Pro Tools pour la lecture ou 
l'enregistrement. Certains plug-ins d'instrument 
prennent également en charge le MIDI Beat Clock 
pour la synchronisation au tempo de Pro Tools.

Transmission du MIDI Beat Clock

Pour transmettre un MIDI Beat Clock :

1 Sélectionnez Setup > MIDI > MIDI Beat Clock.

2 Dans la boîte de dialogue MIDI Beat Clock, 
sélectionnez l'option Enable MIDI Beat Clock.

3 Sélectionnez les périphériques qui recevront 
le MIDI Beat Clock. Si votre interface MIDI 
ne prend pas en charge la transmission du MIDI 
Beat Clock sur des ports distincts, seule 
l'interface apparaît en tant que destination.

Pour plus d'informations sur la synchronisation 
de périphériques MIDI externes avec Pro Tools 
en lecture et en enregistrement à l'aide 
du timecode MIDI, reportez-vous à la section 
« Génération de timecode » à la page 1206.
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4 Saisissez les valeurs de décalage négatif 
appropriées (« -200 » échantillons, par exemple) 
pour chaque port de transmission du MIDI 
Beat Clock activé (reportez-vous à la section 
« Mesure de la latence du MIDI Beat Clock » 
à la page 431).

5 Cliquez sur OK.

Envoi du MIDI Beat Clock via IAC
(Mac uniquement)

Vous pouvez synchroniser d'autres applications MIDI 
utilisant le pilote Apple Inter-Application 
Communication (IAC) avec Pro Tools en transmettant 
le MIDI Beat Clock sur le bus IAC.

Pour transmettre le MIDI Beat Clock sur le bus IAC :

1 Sélectionnez Setup > MIDI > MIDI Studio.

2 Dans la fenêtre MIDI Devices de Audio MIDI 
Setup, double-cliquez sur l'icône du pilote IAC. 

3 Configurez les ports du pilote IAC 
et assurez-vous qu'il est en ligne.

4 Sélectionnez Setup > MIDI > MIDI Beat Clock.

5 Dans la boîte de dialogue MIDI Beat Clock, 
sélectionnez l'option Enable MIDI Beat Clock.

6 Sélectionnez les ports du pilote IAC à activer 
pour envoyer le MIDI Beat Clock.

7 Cliquez sur OK.

Décalages du MIDI Beat Clock
Vous pouvez définir un décalage pour le MIDI Beat 
Clock sur chaque port avec votre interface MIDI 
et vos périphériques MIDI externes. Vous pouvez 
ainsi ajuster le timing de chaque périphérique 
lorsque certains sont désynchronisés d'un délai de 
latence fixe. Lorsque cela est nécessaire, saisissez 
des valeurs de décalage négatives en échantillons 
pour chaque port afin de synchroniser correctement 
les signaux audio provenant des périphériques 
MIDI externes avec la lecture de Pro Tools. 

Mesure de la latence du MIDI 
Beat Clock

Pour déterminer le décalage approprié du MIDI 
Beat Clock pour un périphérique MIDI externe :

1 Assurez-vous que l'ordinateur et le périphérique 
MIDI externe sont correctement reliés et 
configurés pour le MIDI, et que la sortie audio 
est connectée aux entrées audio de votre 
interface audio Pro Tools.

2 Assurez-vous que le périphérique MIDI externe 
est configuré pour recevoir le MIDI Beat Clock 
et pour lire un pattern rythmique simple au bon 
tempo.

3 Créez une session Pro Tools.

4 Dans la boîte de dialogue MIDI Beat Clock, 
assurez-vous que MIDI Beat Clock est activé et 
que le périphérique est sélectionné.

5 Définissez l'échelle temporelle principale sur 
Bars|Beats.

6 Créez une piste audio et sélectionnez les canaux 
d'entrée audio pour votre périphérique MIDI 
externe.

7 Activez la piste audio pour l'enregistrement et 
lancez l'enregistrement. Le MIDI Beat Clock 
est envoyé au périphérique MIDI externe, 
qui déclenche la lecture du pattern.

Boîte de dialogue MIDI Beat Clock
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8 Arrêtez l'enregistrement après quelques mesures.

9 Activez les options Snap to Grid et Show Grid.

10 À l'aide du Sélecteur, positionnez le curseur 
d'édition sur la grille rythmique, avant 
un transitoire prononcé de la forme d'onde qui 
est « en place ». 

11 Activez l'option Tab to Transients, puis appuyez 
sur Maj+Tab pour déplacer le curseur jusqu'au 
transitoire précédent. La durée de cette 
sélection correspond à la latence approximative 
de votre périphérique MIDI externe.

12 Définissez l'échelle temporelle principale sur 
Samples. La durée du clip sélectionné 
en échantillons correspond à la latence du MIDI 
Beat Clock pour ce périphérique.

13 Dans la boîte de dialogue MIDI Beat Clock, 
saisissez une valeur négative dans la colonne 
des décalages en échantillons.

Mesure du décalage en échantillons du MIDI Beat Clock

Décalage en échantillons du MIDI Beat Clock

Étant donné que le MIDI n'est pas précis à l'échantillon près, vous pouvez effectuer plusieurs mesures à 
différents emplacements de la grille et calculer leur moyenne afin de déterminer la meilleure valeur de 
décalage du MIDI Beat Clock.

Une fois que vous avez calculé la latence pour les périphériques compatibles MIDI Beat Clock, 
conservez ces valeurs pour les reporter lors de sessions ultérieures.
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Chapitre 20 : Configuration de l'enregistrement

Avant de commencer à enregistrer dans Pro Tools, 
vous devez configurer votre système Pro Tools, 
une session, ainsi qu'une ou plusieurs pistes pour 
l'enregistrement. Vous devez également 
configurer le monitoring des entrées de Pro Tools. 

Certaines informations de ce chapitre portent sur 
l'enregistrement des données MIDI. Vous 
trouverez toutefois des informations de 
configuration plus spécifiques au Chapitre 22, 
« Enregistrement MIDI ».

Pour plus d'informations sur l'enregistrement 
audio, reportez-vous au Chapitre 21, 
« Enregistrement audio ».

Vue d'ensemble de la 
configuration de 
l'enregistrement
La configuration de l'enregistrement inclut les 
éléments suivants :

Configuration du matériel pour l'enregistrement

• « Configuration des E/S matérielles de 
Pro Tools pour l'enregistrement » à la page 434

• « Connexion d'une source sonore » à la page 436

Configuration de la session pour l'enregistrement

• Configuration pour l'enregistrement d'une 
session nouvelle ou existante :

• « Utilisation de disques durs pour 
l'enregistrement » à la page 449

• « Enregistrement avec un clic » à la page 436

• « Configuration de la métrique et du tempo 
de la session » à la page 439

• Définition d'un mode d'enregistrement. 
Reportez-vous à la section « Modes 
d'enregistrement » à la page 441.

Configuration des pistes pour l'enregistrement

• Configuration d'une ou plusieurs pistes pour 
l'enregistrement :

• « Configuration des noms par défaut des 
fichiers et clips audio » à la page 445

• « Assignation d'E/S matérielles sur une piste » 
à la page 446

• « Activation des pistes pour l'enregistrement » 
à la page 447

• « Enregistrement avec plusieurs disques durs » 
à la page 450

Configuration du monitoring pour l'enregistrement

• « Sélection d'un mode de monitoring d'entrée 
pour l'enregistrement » à la page 452

• « Configuration des niveaux de monitoring pour 
l'enregistrement et la lecture » à la page 455

• « Réduction de la latence du monitoring » 
à la page 455

• « Enregistrement avec compensation du délai » 
à la page 456

Pour plus d'informations sur la numérisation 
(l'enregistrement) vidéo dans Pro Tools, 
reportez-vous au Chapitre 52, « Utilisation de 
la vidéo dans Pro Tools » ou au Guide des 
périphériques vidéo Avid.
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Configuration des E/S 
matérielles de Pro Tools pour 
l'enregistrement
Avant d'enregistrer, vérifiez que le matériel de votre 
système Pro Tools est correctement connecté et 
configuré. Pour plus de détails sur la connexion de 
Pro Tools à votre studio et la configuration de votre 
matériel dans la boîte de dialogue Hardware Setup, 
reportez-vous au Guide de l'utilisateur fourni avec 
votre système. Pour plus d'informations sur le 
routing des signaux audio dans Pro Tools, 
reportez-vous au Chapitre 7, « I/O Setup ».

Connexions d'entrée et niveaux 
audio
Les interfaces audio Avid HD fonctionnent au 
niveau ligne et n'assurent pas la préamplification 
des signaux. Les sources de faible niveau (micros, 
guitares électriques) doivent être préamplifiées. 
Pour ce faire, il vous faut une console de mixage 
haut de gamme ou un préampli dédié, tel qu'un 
préampli PRE.

La 003 Rack+ dispose de huit entrées 
préamplifiées, sur lesquelles vous pouvez 
connecter des signaux de faible niveau.

Les 003 et 003 Rack possèdent quatre entrées avec 
préamplis, sur lesquelles vous pouvez connecter 
des signaux de faible niveau, et quatre entrées 
supplémentaires au niveau ligne, avec gain 
commutable.

Eleven Rack fournit une entrée micro avec 
préamplificateur et une entrée guitare au niveau 
instrument avec un circuit spécial à impédance 
variable appelé True-Z. Pour plus d'informations, 
reportez-vous au Guide de l'utilisateur Eleven Rack.

Les Mbox (3e génération), Mbox 2, Mbox Pro, 
Mbox 2 Pro, Mbox Mini et Mbox 2 Mini sont 
dotées de deux entrées préamplifiées sur lesquelles 
vous pouvez connecter des signaux de faible niveau.

Quel que soit le système, les commandes de volume 
et de panoramique des pistes dans Pro Tools 
modifient uniquement les niveaux de monitoring, 
sans affecter le gain d'entrée pour l'enregistrement. 
Les indicateurs de niveau à LED des interfaces 
audio HD telles qu'une HD I/O ou une HD OMNI 
indiquent les niveaux pleine échelle (niveau le plus 
élevé avant écrêtage), ainsi que l'écrêtage réel des 
signaux de sortie de Pro Tools. Les indicateurs de 
niveau de Pro Tools indiquent l'écrêtage réel sur les 
entrées audio et lors d'un enregistrement sur disque. 
Avec Pro Tools, il est possible d'écrêter les 
convertisseurs d'entrée et de sortie de votre interface 
audio, ainsi que lors d'un enregistrement dans une 
résolution en virgule fixe (16 ou 24 bits 
uniquement, aucun écrêtage ne se produira pour une 
résolution de 32 bits en virgule flottante).

Écrêtage numérique

Un écrêtage se produit lorsqu'un enregistreur ou un 
mixeur reçoit un signal de niveau supérieur au 
niveau maximum accepté par le périphérique. 
Sur de nombreux magnétophones analogiques, 
un léger écrêtage ajoute une chaleur perceptible 
au son, du fait de la compression appliquée par la 
bande magnétique. Dans le cas d'un enregistrement 
numérique, en revanche, l'écrêtage provoque une 
distorsion numérique indésirable qui doit être 
impérativement évitée. 

 Le préampli PRE est contrôlable à distance à 
partir des sessions Pro Tools.
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Réglage des niveaux d'entrée

Lorsque vous envoyez un signal vers un système 
d'enregistrement audio, notamment Pro Tools, 
vérifiez le niveau d'entrée afin d'optimiser la plage 
dynamique et le rapport signal-bruit du fichier 
enregistré. Si le niveau d'entrée est trop faible, 
vous ne bénéficierez pas pleinement de la plage 
dynamique de votre système Pro Tools. Si le niveau 
d'entrée est trop élevé, la forme d'onde peut subir 
des écrêtages et déformer l'enregistrement. Réglez 
les niveaux d'entrée suffisamment haut tout 
en évitant l'écrêtage.

En règle générale, essayez de régler les niveaux 
pour que les crêtes soient comprises entre -3 dB 
et -12 dB sur l'indicateur de niveau d'entrée, 
sans déclencher l'indicateur d'écrêtage de votre 
interface audio. Selon le type de signal enregistré, 
sa plage dynamique et les crêtes qu'il contient, 
vous pouvez décider d'enregistrer à des niveaux 
supérieurs ou inférieurs.

Vous pouvez afficher les niveaux d'entrée d'une 
piste sur son indicateur de volume audio. En règle 
générale, cet indicateur est configuré pour agir en 
tant qu'indicateur de volume crête. Vous pouvez 
également utiliser l'indicateur de réserve de gain 
pour comparer le niveau crête du signal d'entrée 
par rapport à la réserve de gain disponible.

Pour afficher le niveau crête d'une piste :

 Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur 
l'indicateur de volume d'une piste pour 
parcourir les différents modes (volume ou délai 
du canal), jusqu'à ce que l'indicateur affiche 
le niveau crête (pk).

Indicateur de réserve de gain

Pro Tools indique numériquement (en dB) la réserve 
de gain disponible sur les pistes, en se basant sur 
le dernier niveau crête enregistré, par rapport 
au niveau de référence du type d'indicateur de niveau 
sélectionné. L'indicateur de réserve de gain se situe 
à droite de l'indicateur de volume audio, en dessous 
des faders et indicateurs de niveau de la fenêtre Mix. 
Cliquez sur l'indicateur de réserve de gain pour 
réinitialiser la valeur affichée.

L'indicateur de réserve de gain est affiché 
en bleu s'il mesure une valeur en dB inférieure 
au repère le plus bas de l'échelle du type 
d'indicateur sélectionné.

Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur une indicateur 
de réserve de gain pour réinitialiser tous ceux de 
la session. Maintenez les touches Maj+Option 
(Mac) ou Maj+Alt (Windows) enfoncées et 
cliquez sur une indicateur de réserve de gain pour 
réinitialiser ceux des pistes sélectionnées.

Indicateurs de volume audio et de réserve de gain

Indicateur de réserve de gain

Indicateur de volume audio
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Mode Calibration
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native uniquement)

Le mode Calibration de Pro Tools permet d'ajuster 
les niveaux d'entrée et de sortie de vos interfaces 
audio afin qu'ils correspondent à ceux de votre 
console de mixage et des autres périphériques 
audio de votre studio.

L'interface HD I/O est équipée d'une série 
de potentiomètres de trim pour ses entrées. 
De plus, le niveau de référence des entrées peut 
être réglé sur +4 dBu ou -10 dBV. Pour plus 
d'informations sur l'étalonnage d'une HD I/O, 
reportez-vous au Guide HD I/O.

Aucune commande de trim d'entrée ou sortie n'est 
disponible sur les interfaces audio suivantes : 
HD OMNI, HD MADI. Certaines interfaces audio 
Pro Tools dépourvues de commandes de trim 
de sortie (telles que la HD OMNI) disposent 
de commandes logicielles de réglage des niveaux 
d'entrée, ajustables à partir de la page Setup > 
Hardware (reportez-vous au guide de votre 
interface audio).

Connexion d'une source 
sonore
En fonction de vos interfaces audio Pro Tools, 
vous pouvez connecter différents types de sources 
sonores (tels que des instruments de musique, 
des micros et des sorties de table de mixage). 
Reportez-vous au Guide de l'utilisateur de votre 
système Pro Tools. Pour plus d'informations, 
reportez-vous à la documentation fournie avec 
votre source sonore.

Si vous connectez une source sonore à une entrée 
de Pro Tools qui n'a pas été configurée au préalable 
pour recevoir une entrée, vous devrez reconfigurer 
votre matériel dans la boîte de dialogue Hardware 
Setup (reportez-vous au Guide de l'utilisateur). 
Vous devrez éventuellement réinitialiser les 
chemins des signaux d'E/S dans I/O Setup 
(reportez-vous au Chapitre 7, « I/O Setup ».).

Enregistrement avec un clic
Pour travailler avec des pistes MIDI ou d'instrument 
dans une session, ou si l'audio est basé sur un tempo 
précis, vous pouvez enregistrer vos pistes en 
utilisant un clic. Ce clic sera une référence qui 
garantira l'alignement des signaux MIDI et audio 
sur les temps et mesures de la session.

Lorsque les contenus sont enregistrés au tempo de la 
session, vous pouvez alors exploiter les fonctions 
d'édition extrêmement efficaces de Pro Tools, telles 
que la quantification des événements ou clips 
MIDI et audio, la quantification de notes MIDI 
individuelles, ou encore le copier-coller de mesures 
ou de passages entiers d'un morceau en mode Grid.

Création d'une piste de clic
Pro Tools permet de créer une piste de clic sur 
laquelle le plug-in Click est inséré. Vous pouvez 
également utiliser le plug-in TL Metro (fourni 
avec Pro Tools) ou un instrument MIDI avec 
ce type de piste.

Les contenus enregistrés sans aucune 
référence de tempo peuvent néanmoins être 
alignés sur une grille en mesures et temps 
dans Pro Tools à l'aide de Beat Detective 
(reportez-vous au Chapitre 30, « Beat 
Detective »), ou en utilisant la commande 
Identify Beat pour déterminer leur tempo 
(reportez-vous à la section « Commande 
Identify Beat » à la page 817).

Pour plus d'informations sur le plug-in Click 
ou TL Metro, reportez-vous au Guide des 
plug-ins audio.
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Pour créer une piste de clic avec le plug-in Click :

 Sélectionnez Track > Create Click Track.

Pro Tools crée une nouvelle piste d'entrée 
auxiliaire nommée Click sur laquelle le plug-in 
Click est déjà inséré. Dans la fenêtre Edit, 
la hauteur de la piste de clic est réglée sur Mini. 
Vous pouvez créer plusieurs pistes de clic. Chaque 
piste successive est nommée de façon séquentielle 
(Click 1, Click 2 et Click 3, par exemple).

Pour entendre le clic en lecture et en enregistrement, 
configurez les options du clic (reportez-vous 
à la section « Options du clic » à la page 438) 
et assurez-vous qu'il est bien activé (reportez-vous 
à la section « Activation du clic » à la page 437).

Pour créer une piste de clic en utilisant 
un périphérique MIDI :

1 Créez une piste d'entrée auxiliaire ou une piste 
d'instrument mono.

2 Effectuez l'une des opérations suivantes :

• Dans le sélecteur d'entrée de la piste, 
sélectionnez le chemin auquel le périphérique 
MIDI est connecté.

• Insérez un plug-in d'instrument sur la piste 
(TL Metro ou Xpand2, par exemple).

3 Configurez les options de la boîte de dialogue 
Click/Countoff et veillez à sélectionner le port 
du périphérique MIDI ou du plug-in d'instrument 
dans le menu Output (reportez-vous à la section 
« Options du clic » à la page 438).

4 Activez le clic (reportez-vous à la section 
« Activation du clic » à la page 437).

Activation du clic
Les pistes de clic doivent être activées pour être 
audibles en lecture ou en enregistrement.

Pour activer le clic à partir du menu MIDI :

 Sélectionnez Options > Click.

Pour activer le clic dans la fenêtre de transport :

1 Affichez les commandes MIDI de la fenêtre 
de transport en effectuant l'une des opérations 
suivantes :

• Sélectionnez View > Transport > MIDI Controls.

• Dans le menu de la fenêtre de transport, 
sélectionnez MIDI Controls.

• Pour afficher les commandes MIDI, maintenez 
la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez sur le bouton Développer/ 
Réduire (+) de la fenêtre de transport.

• Pour afficher les commandes MIDI et les 
compteurs, maintenez la touche Alt (Windows) 
ou Option (Mac) enfoncée et cliquez sur 
le bouton Développer/Réduire (+) de la fenêtre 
de transport.

Sélection des commandes MIDI dans le menu de la 
fenêtre de transport

Bouton Développer/Réduire (+) de la fenêtre 
de transport et commandes MIDI
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2 Dans la fenêtre de transport, cliquez sur 
le bouton du métronome pour le mettre 
en surbrillance.

3 Pour entendre le décompte du clic 
en enregistrement ou en lecture, cliquez sur le 
bouton Count Off de la fenêtre de transport pour 
le mettre en surbrillance.

En se basant sur ce décompte lors d'un 
enregistrement, les musiciens peuvent commencer 
à jouer au bon moment et au bon tempo. La zone 
Count Off de la fenêtre de transport indique le 
nombre de mesures décomptées avant que le 
transport ne soit lancé.

Options du clic
Pro Tools propose des options et commandes 
de configuration du clic. Les étapes suivantes 
décrivent les procédures de configuration 
et d'activation d'un clic avec le plug-in Click 
ou un périphérique MIDI.

Pour configurer les options du clic :

1 Accédez à la boîte de dialogue Click/Countoff 
Options en effectuant l'une des opérations 
suivantes :

• Sélectionnez Setup > Click/Countoff.

• Double-cliquez sur le bouton du métronome de 
la fenêtre de transport.

2 Dans la boîte de dialogue Click/Countoff 
Options, effectuez l'une des opérations 
suivantes :

• Si vous utilisez le plug-in TL Metro ou Click, 
sélectionnez None dans le menu déroulant 
Output.

• Si le clic est produit avec du MIDI, sélectionnez 
dans le menu Output le numéro du port 
(périphérique) et le canal appropriés. 

Bouton du métronome activé

Bouton de décompte activé

Le décompte est ignoré lorsque Pro Tools est en 
ligne et synchronisé sur un timecode SMPTE.

Boîte de dialogue Click/Countoff Options
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3 Spécifiez la note, la vélocité et la durée des 
notes accentuées et non accentuées. 

Lorsque vous écoutez le clic dans vos sessions 
Pro Tools, la note accentuée correspond 
au premier temps de chaque mesure ; les autres 
temps correspondent aux notes non accentuées.

4 Indiquez si le clic doit être entendu en lecture 
et en enregistrement (During Play and Record), 
seulement en enregistrement (Only During 

Record) ou seulement pendant le décompte 
(Only During Countoff).

5 Si vous utilisez un décompte, indiquez 
le nombre de mesures devant être décomptées. 
Si vous souhaitez entendre le décompte 
seulement en enregistrement, activez l'option 
Only during record.

6 Cliquez sur OK.

Configuration de la métrique 
et du tempo de la session 
(Facultatif)

Configuration de la métrique 
de la session
Lorsque vous ouvrez une session dans Pro Tools, 
la métrique par défaut est 4/4. Pour enregistrer 
avec un clic basé sur une métrique différente, il est 
impératif de configurer cette métrique.

Si la métrique d'une session ne correspond pas à 
celle de la musique que vous enregistrez, les notes 
accentuées du clic ne tomberont pas sur les 
premiers temps de votre morceau. Par conséquent, 
les pistes enregistrées risquent de ne pas être 
alignées sur les mesures et temps de la fenêtre Edit.

Les événements de métrique, qui peuvent 
se produire à tout moment dans une session 
Pro Tools, apparaissent sur la règle de métrique. 
Pour plus d'informations sur l'insertion et l'édition 
d'événements de métrique, reportez-vous à la 
section « Événements de métrique » à la page 821.

Pour définir la métrique d'une session :

1 Double-cliquez sur la métrique actuelle affichée 
dans la zone Meter de la fenêtre de transport.

2 Saisissez la métrique de la session dans la zone 
Meter, à partir de l'emplacement 1|1|000 (champ 
Location), afin que l'événement de métrique 
inséré remplace la métrique par défaut.

3 Dans le menu déroulant Click, sélectionnez une 
valeur de note pour les battements. Pour une 
mesure en 6/8 par exemple, sélectionnez une 
noire pointée.

4 Cliquez sur OK pour insérer le nouvel 
événement de métrique.

Vous pouvez jouer les notes directement 
sur un clavier MIDI connecté pour saisir 
automatiquement les nouvelles valeurs.

Zone Meter

Fenêtre Meter Change
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Configuration du tempo de la 
session
Lorsque vous ouvrez une nouvelle session dans 
Pro Tools, le tempo par défaut est de 120 BPM 
(battements par minute). Pour enregistrer avec un 
clic basé sur un tempo différent de 120 BPM, 
configurez le tempo en conséquence.

Pour modifier le tempo de la session :

1 Double-cliquez sur le marqueur de début 
du morceau dans la fenêtre Edit (reportez-vous 
à la section « Marqueur de début de morceau » 
à la page 797).

2 Entrez la valeur du tempo de la session en BPM. 

3 Définissez l'emplacement (Location) sur 
1|1|000, afin que l'événement de tempo inséré 
remplace le tempo par défaut.

4 Dans le menu déroulant Resolution, 
sélectionnez une valeur de note pour les temps. 
Pour une mesure en 6/8 par exemple, 
sélectionnez une noire pointée.

5 Cliquez sur OK.

Utilisation du mode de tempo 
manuel
En mode de tempo manuel, Pro Tools ignore les 
événements de tempo de la règle de tempo et suit 
un tempo manuel à la place. Vous pouvez définir le 
tempo avec le curseur de tempo ou, si vous n'êtes 
pas certain de la valeur, en battant le tempo.

Vous pouvez ajuster le tempo manuel en cours 
de lecture, mais celle-ci sera alors 
momentanément interrompue.

Pour ajuster le tempo manuel à l'aide du curseur 
de tempo :

1 Pour afficher les commandes MIDI dans 
la fenêtre de transport, sélectionnez View > 

Transport > MIDI Controls.

2 Dans la fenêtre de transport, cliquez sur le 
bouton d'activation de la règle de tempo 
(chef d'orchestre) afin qu'il ne soit plus en 
surbrillance. Pro Tools passe en mode de tempo 
manuel. Dans ce mode, tous les événements 
de tempo de la règle de tempo sont ignorés.

3 Pour baser le tempo en BPM sur une autre 
valeur de note, cliquez sur le sélecteur 
de résolution du tempo et sélectionnez une autre 
valeur Pour une mesure en 6/8 par exemple, 
sélectionnez une noire pointée.

4 Pour entrer un nouveau tempo, effectuez l'une 
des opérations suivantes :

• Cliquez sur le champ de tempo et faites glisser 
votre souris vers le haut ou le bas. Pour un 
ajustement plus précis, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée tout 
en faisant glisser votre souris.

• Cliquez sur la valeur du tempo, tapez une 
nouvelle valeur et appuyez sur Entrée.

Les événements de tempo, qui peuvent être 
insérés n'importe où dans une session 
Pro Tools, apparaissent sur la règle de tempo. 
Pour plus d'informations sur l'insertion et 
l'édition d'événements de tempo, reportez-vous 
à la section « Tempo » à la page 797.

Vous pouvez saisir un tempo spécifique ou 
utiliser la touche T pour battre la mesure.

Fenêtre Tempo Change

Mode de tempo manuel

Valeur du tempo en BPM

Bouton d'activation de la règle 
de tempo

Sélecteur de résolution du tempo
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Pour quitter le mode de tempo manuel et activer 
la règle de tempo :

 Dans la fenêtre de transport, cliquez sur 
le bouton d'activation de la règle de tempo 
(chef d'orchestre), afin qu'il soit en surbrillance.

Pour définir le tempo manuellement en battant 
la mesure :

1 Assurez-vous que les commandes MIDI de la 
fenêtre de transport sont affichées (sélectionnez 
View > Transport Window > MIDI Controls).

2 Dans la fenêtre de transport, cliquez sur le 
bouton d'activation de la règle de tempo 
(chef d'orchestre) pour qu'il ne soit plus en 
surbrillance. Pro Tools passe en mode de tempo 
manuel. Dans ce mode, tous les événements 
de tempo de la règle de tempo sont ignorés.

3 Effectuez l'une des opérations suivantes :

• Cliquez dans le champ du tempo pour le mettre 
en surbrillance et appuyez sur la touche T de 
votre clavier de façon répétée au rythme 
du nouveau tempo.

• Si l'option Use MIDI to Tap Tempo est activée 
dans les préférences MIDI, cliquez sur le champ 
de tempo afin de le mettre en surbrillance 
et battez le tempo sur votre contrôleur MIDI 
en jouant une note de façon répétée, à la cadence 
du nouveau tempo.

Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou moins). 
La valeur en BPM calculée apparaît dans le champ 
Tempo de la fenêtre de transport.

Pour verrouiller le nouveau tempo :

 Désactivez le mode de tempo manuel de 
Pro Tools en cliquant sur le bouton d'activation 
de la règle de tempo (chef d'orchestre), puis 
entrez le nouveau tempo en tant que tempo par 
défaut du marqueur de début de morceau.

Modes d'enregistrement
Pro Tools propose les modes d'enregistrement 
audio suivants :

• Normal (non destructif)

• Destructif

• En boucle

• QuickPunch

• TrackPunch (Pro Tools HD uniquement)

• DestructivePunch (Pro Tools HD uniquement)

Pour sélectionner un mode d'enregistrement, 
effectuez l'une des opérations suivantes :

 Sélectionnez le mode d'enregistrement dans le 
menu Options. Lorsqu'aucun mode 
d'enregistrement n'est sélectionné, Pro Tools est 
en mode d'enregistrement normal 
(non destructif).

 Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport, puis sélectionnez un mode 
d'enregistrement dans le menu contextuel.

L'aspect du bouton Record change alors pour 
indiquer le mode d'enregistrement actif : 

• bouton vide pour le mode normal 
(non destructif) ; 

• lettre D pour le mode destructif ;

• symbole représentant une boucle pour 
l'enregistrement en boucle ;

• lettre P pour le mode QuickPunch ;

Lorsque le transport est arrêté, vous pouvez 
également passer d'un mode d'enregistrement à 
l'autre en cliquant sur le bouton Record tout en 
maintenant la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée.
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• lettre T pour le mode TrackPunch (Pro Tools HD 
uniquement) ;

• lettres DP pour le mode DestructivePunch 
(Pro Tools HD uniquement).

Mode d'enregistrement normal 
(non destructif)
En mode d'enregistrement normal non destructif, 
Pro Tools effectue un enregistrement audio non 
destructif, ce qui signifie que si vous enregistrez 
sur des clips existants d'une piste, les données 
ne sont pas effacées de votre disque dur. 
Les anciens fichiers audio sont conservés avec les 
nouveaux sur votre disque dur et sont disponibles 
sous forme de clips dans la liste des clips.

En mode d'enregistrement normal, la plage 
d'enregistrement est définie en sélectionnant une 
plage sur la règle ou dans la playlist d'une piste, 
ou en indiquant ses points de début et de fin dans 
la fenêtre de transport. En l'absence de sélection, 
l'enregistrement débute à l'emplacement du curseur 
et se poursuit jusqu'à ce que vous cliquiez sur le 
bouton Stop de la fenêtre de transport.

Les plages de pré-roll et post-roll permettent 
d'entendre le contenu des pistes situé avant et après 
les points de début et de fin d'enregistrement, ce qui 
est utile pour un punch-in/out (reportez-vous à la 
section « Enregistrement audio en punch-in/out sur 
une plage spécifiée » à la page 468).

Mode d'enregistrement destructif
En mode d'enregistrement destructif, les données 
enregistrées sur des clips existants les remplacent 
définitivement, ce qui permet d'économiser 
de l'espace sur le disque dur. Toutefois, si vous 
disposez d'un espace disque suffisant, il est 
généralement conseillé d'utiliser le mode 
d'enregistrement non destructif de Pro Tools 
pour éviter d'effacer les prises précédentes.

La configuration de la plage d'enregistrement et des 
durées de pré et post-roll s'effectue de la même 
manière qu'en mode normal (non destructif).

Contrairement aux autres modes d'enregistrement, 
il est impossible d'annuler des prises en mode 
d'enregistrement destructif (reportez-vous à la 
section « Annulation d'une prise d'enregistrement » 
à la page 461).

Mode d'enregistrement destructif activé

Pendant l'enregistrement, vous pouvez 
économiser de l'espace disque en supprimant les 
prises inutiles (reportez-vous à la section 
« Suppression des clips inutilisés » 
à la page 277) et en compactant les fichiers 
audio (reportez-vous à la section « Compactage 
d'un fichier audio » à la page 621).

Pour définir une plage d'enregistrement en la 
sélectionnant dans la playlist d'une piste, 
les sélections de timeline et d'édition doivent 
être liées. Reportez-vous à la section 
« Liaison ou dissociation des sélections 
d'édition et de timeline » à la page 575.

En mode d'enregistrement destructif, l'aperçu 
de la forme d'onde est mis à jour uniquement 
après avoir arrêté l'enregistrement.

L'enregistrement en mode destructif n'est pas 
pris en charge pour les clips AudioSuite 
rendus avec poignées. Consolidez ces clips 
si vous avez besoin d'utiliser le mode 
d'enregistrement destructif.



Chapitre 20 : Configuration de l'enregistrement 443

Mode d'enregistrement en boucle
En mode d'enregistrement en boucle, un passage 
audio est répété afin de pouvoir enchaîner les 
prises en les enregistrant de manière non 
destructive. Cette technique est pratique pour 
enregistrer rapidement plusieurs prises d'une partie 
sans perdre en spontanéité.

La plage temporelle lue en boucle et enregistrée 
(qui doit durer au minimum une seconde) est 
sélectionnée sur une règle ou dans la playlist d'une 
piste, ou en indiquant ses points de début et de fin 
dans la fenêtre de transport. Le pré-roll, s'il est 
activé, est utilisé lors de la première passe 
d'enregistrement. Pour les passes d'enregistrement 
suivantes, les plage de pré et post-roll sont ignorées.

En mode d'enregistrement en boucle, chaque prise 
successive apparaît sous la forme d'un clip dans 
la liste des clips, numéroté de façon séquentielle. 
Les différentes prises, dont la durée et l'heure 
de début sont identiques, peuvent facilement être 
écoutées et placées sur la piste à l'emplacement 
correct, à l'aide du menu Matches (reportez-vous 
à la section « Sélection de prises alternatives » 
à la page 474).

QuickPunch
En mode QuickPunch, vous pouvez contrôler 
manuellement et instantanément les opérations 
de punch-in (début d'enregistrement) et punch out 
(fin d'enregistrement) sur les pistes audio activées 
pour l'enregistrement en cours de lecture, en cliquant 
sur le bouton Record de la fenêtre de transport. 
L'enregistrement QuickPunch est non destructif.

En mode QuickPunch, Pro Tools commence 
l'enregistrement d'un nouveau fichier dès le 
lancement de la lecture et crée automatiquement 
des clips au sein de ce fichier à chaque point de 
punch-in et de punch-out. Ces clips apparaissent 
dans la playlist de la piste. Le fichier audio complet 
apparaît dans la liste des clips avec les clips créés 
en mode QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 opérations de 
punch-in et de punch-out.

Bien qu'il soit possible d'enregistrer en punch-in 
dans les autres modes d'enregistrement en 
spécifiant manuellement la plage d'enregistrement, 
seul le mode QuickPunch assure une commutation 
instantanée du monitoring suite à un punch-out.

Pour définir une plage d'enregistrement par 
sélection dans la playlist d'une piste, activez 
l'option Link Timeline and Edit Selection. 
Reportez-vous à la section « Liaison ou 
dissociation des sélections d'édition et de 
timeline » à la page 575.

En mode d'enregistrement en boucle, 
l'affichage de la forme d'onde est mis à jour 
uniquement après avoir arrêté l'enregistrement.

Pour plus d'informations sur le mode 
QuickPunch, reportez-vous à la section 
« Enregistrement audio en mode 
QuickPunch » à la page 505.
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TrackPunch 
(Pro Tools HD uniquement)

Le mode TrackPunch permet d'effectuer des 
opérations de punch-in et de punch-out out sur 
des pistes individuelles et de les désactiver pour 
l'enregistrement, sans interrompre l'enregistrement 
et la lecture en ligne. 

Le mode d'enregistrement TrackPunch est non 
destructif. Lorsqu'une piste est en mode TrackPunch, 
Pro Tools commence l'enregistrement d'un 
nouveau fichier au démarrage de la lecture. 
En cours de lecture, vous pouvez activer 
ou désactiver pour l'enregistrement n'importe 
quelle piste ou combinaison de pistes en mode 
TrackPunch, ou y effectuer des opérations 
de punch-in et de punch-out. 

En mode TrackPunch, des clips sont créés à chaque 
point de punch-in et de punch-out. Ces clips 
apparaissent dans la playlist de la piste. Le fichier 
audio complet apparaît dans la liste des clips avec 
les clips créés en mode TrackPunch. Vous pouvez 
ainsi, dans une même passe, effectuer jusqu'à 
200 opérations de punch-in et de punch-out. 

DestructivePunch
(Pro Tools HD uniquement)

Le mode d'enregistrement DestructivePunch est un 
mode destructif qui permet de déclencher en cours 
de lecture un punch-in (début d'enregistrement) et un 
punch-out (fin d'enregistrement) instantanément sur 
des pistes audio individuelles, en créant un fichier 
audio contigu pour chaque piste enregistrée, 
comprenant les données enregistrées en punch-in/out. 

Modes d'enregistrement et MIDI
En plus des divers modes d'enregistrement, la fenêtre 
de transport comporte un bouton de fusion MIDI qui 
détermine la façon dont le MIDI est enregistré. 
Lorsque le bouton (mode de fusion MIDI) est activé, 
les nouvelles données MIDI enregistrées sur des 
clips MIDI existants sont fusionnées avec les 
anciennes. Lorsqu'il est désactivé (mode de 
remplacement MIDI), les nouvelles données MIDI 
remplacent les anciennes.

L'enregistrement MIDI fonctionne de la même 
manière, que vous utilisiez un mode non destructif 
ou destructif. De plus, il n'est pas nécessaire 
d'activer le mode QuickPunch ou TrackPunch pour 
les opérations de punch MIDI à la volée, qui sont 
possibles dans les modes d'enregistrement non 
destructifs et destructifs.

Contrairement au mode d'enregistrement 
en boucle, l'activation ou la désactivation du mode 
de fusion MIDI détermine si les données existantes 
sont remplacées ou fusionnées.

Si le mode de fusion MIDI est désactivé, 
l'enregistrement MIDI est destructif (bien qu'il soit 
possible d'annuler une passe d'enregistrement 
MIDI), soit par remplacement, soit par ajout d'un 
clip. Il existe une exception à cette règle : lorsque 
l'enregistrement en boucle est activé en mode 
fusion, les clips existants de la piste sont remplacés 
par de nouveaux lorsque vous enregistrez de 
nouvelles données. Les anciens clips demeurent 
intacts et disponibles dans la liste des clips, 
ainsi que dans le menu Matches. En mode 
d'enregistrement en boucle, la fusion MIDI 
n'a aucun effet. Le bouton est donc grisé.

Pour plus d'informations sur le mode 
TrackPunch, reportez-vous à la section 
« Enregistrement audio en mode 
TrackPunch » à la page 506.

Pour plus d'informations sur le mode 
DestructivePunch, reportez-vous à la section 
« Enregistrement audio en mode 
DestructivePunch » à la page 511.

Bouton de fusion MIDI activé
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Configuration des noms par 
défaut des fichiers et clips 
audio 
(Facultatif)

Le nom des pistes détermine celui des nouveaux 
fichiers et clips créés lors d'un enregistrement 
(reportez-vous à la section « Attribution de noms 
aux pistes » à la page 219).

Lorsque vous enregistrez sur une piste audio, 
les noms de fichiers et de clips résultants sont 
basés sur le nom de la piste. Si vous enregistrez par 
exemple une première prise sur une piste nommée 
« Guit élec », un fichier audio est créé avec le nom 
« Guit élec_01 ». De plus, un clip apparaît dans 
la liste des clips, avec le nom « Guit élec_01 ». 
Ce clip est un clip de fichier entier.

Les prises suivantes sur la même piste portent 
le même nom, mais le numéro de la prise est 
incrémenté pour indiquer le numéro de la prise 
(« Guit élec_02 », par exemple). Une seconde 
série de chiffres (« Guit élec_01-01 », etc.) indique 
qu'un clip a été créé automatiquement suite à une 
opération d'édition. 

Lorsque vous enregistrez des pistes MIDI, 
un principe de dénomination similaire est utilisé, 
à la seule différence qu'il ne comporte qu'une série 
de chiffres. Après avoir enregistré sur une piste 
nommée « Synth 1 » par exemple, le clip créé s'appelle 
« Synth 1-01 ». Les clips suivants de cette piste, 
créés soit à partir de prises ultérieures, soit à partir 
d'opérations d'édition sur les clips, sont numérotés 
de façon séquentielle (« Synth 1-02 », par exemple).

Pour renommer une piste :

1 Effectuez l'une des opérations suivantes :

• Dans les fenêtres Mix ou Edit, double-cliquez 
sur le bouton du nom de la piste à renommer.

• Dans la liste des pistes de la fenêtre Mix, Edit, 
de l'éditeur MIDI ou de partition, effectuez un 
clic droit sur le nom de la piste à renommer.

2 Dans la boîte de dialogue Track Name/Comments, 
saisissez un nouveau nom de piste.

3 Cliquez sur OK.

Noms des pistes audio stéréo
Lors de l'enregistrement sur des pistes audio 
stéréo, les noms des clips et des fichiers audio des 
canaux gauche et droit sont respectivement 
accompagnés des suffixes « .L » et « .R ».

Noms des pistes multicanal 
(Pro Tools HD uniquement)

Lors de l'enregistrement sur des pistes surround 
multicanal, les noms des clips et des fichiers audio 
de chaque canal possèdent respectivement les 
suffixes suivants :

Les modes TrackPunch, QuickPunch et 
DestructivePunch utilisent une méthode 
de numérotation des clips différente. Pour plus 
d'informations, reportez-vous à la section 
« Enregistrement audio en mode 
TrackPunch » à la page 506.

Format 
multicanal

Suffixes des fichiers et clips

LCR L, C, R

Quad L, R, Ls, Rs

LCRS L, C, R, S

5.0 L, C, R, Ls, Rs

5.1 L, C, R, Ls, Rs, LFE

6.0 L, C, R, Ls, Cs, Rs, LFE

6.1 L, C, R, Ls, Cs, Rs

7.0 L, C, R, Lss, Rss, Lsr, Rsr

7.1 L, C, R, Lss, Rss, Lsr, Rsr, LFE

7.0 SDDS L, Lc, C, R, Rc, Ls, Rs

7.1 SDDS L, Lc, C, R, Rc, Ls, Rs, LFE
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Assignation d'E/S matérielles 
sur une piste
Avant d'enregistrer sur une piste, vous devez 
spécifier les chemins d'entrée et de sortie 
empruntés par les signaux. Pour cela, assignez une 
entrée matérielle (source d'enregistrement) et un 
bus de sortie (pour le monitoring de 
l'enregistrement) à la piste.

Pour assigner les E/S d'une piste :

1 Assignez une entrée matérielle (source 
d'enregistrement) en effectuant l'une des 
opérations suivantes :

• Dans la fenêtre Mix, sélectionnez l'entrée 
matérielle correspondant à votre source à partir 
du sélecteur de chemin d'entrée de la piste.

• Dans la fenêtre Edit, activez la vue I/O et 
sélectionnez l'entrée matérielle correspondant 
à votre source à partir du sélecteur de chemin 
d'entrée de la piste.

2 Assignez un bus de sortie (pour le monitoring 
de l'enregistrement) en effectuant l'une des 
opérations suivantes :

• Dans la fenêtre Mix, sélectionnez le bus de 
sortie utilisé pour le monitoring (« A 1-2 », 
par exemple) à partir du sélecteur de chemin 
de sortie de la piste.

Sélecteur de chemin d'entrée dans la fenêtre Mix

Sélecteur de chemin d'entrée dans la fenêtre Edit

Sélecteur de chemin de sortie dans la fenêtre Mix
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• Dans la fenêtre Edit, activez la vue I/O et 
sélectionnez le bus de sortie utilisé pour le 
monitoring (« A 1-2 », par exemple) à partir 
du sélecteur de chemin de sortie de la piste.

Activation des pistes pour 
l'enregistrement
Pour enregistrer de l'audio ou du MIDI sur une 
piste, vous devez d'abord enclencher son bouton 
d'activation pour l'enregistrement. Pour enregistrer 
plusieurs pistes simultanément (audio, 
d'instrument ou MIDI), enclenchez leur bouton 
d'activation pour l'enregistrement. 

Lorsqu'une ou plusieurs pistes sont activées pour 
l'enregistrement, cliquez sur le bouton Record de la 
fenêtre de transport pour préparer l'enregistrement, 
puis sur le bouton Play pour le lancer.

Pour activer une piste audio, MIDI ou d'instrument 
pour l'enregistrement :

 Depuis la fenêtre Mix ou Edit, cliquez sur le 
bouton d'activation pour l'enregistrement de la 
piste. Le bouton clignote en rouge, le fader est 
allumé en rouge et l'indicateur d'activation pour 
l'enregistrement de la fenêtre de transport passe 
au rouge (signalant qu'au moins une piste est 
activée pour l'enregistrement).

Sélecteur de chemin de sortie dans la fenêtre Edit

Les pistes MIDI et d'instrument peuvent être 
activées pour l'enregistrement en cours de 
lecture ou d'enregistrement. Afin d'activer les 
pistes audio pour l'enregistrement, vous devez 
arrêter le transport ou sélectionner le mode 
QuickPunch, TrackPunch ou DestructivePunch. 
Pour plus d'informations sur les modes 
QuickPunch, TrackPunch et DestructivePunch, 
reportez-vous à la section « Modes 
d'enregistrement » à la page 441.

Piste audio activée pour l'enregistrement dans les 
fenêtres Mix et Edit

Appuyez sur Maj+R afin d'activer pour 
l'enregistrement toute piste contenant 
le curseur d'édition sur une sélection d'édition.

Fenêtre Edit

Fenêtre Mix



Guide de référence Pro Tools448

Pour activer plusieurs pistes audio pour 
l'enregistrement :

 Depuis la fenêtre Mix ou Edit, cliquez sur 
le bouton d'activation pour l'enregistrement 
de chaque piste.

Pour activer plusieurs pistes MIDI ou d'instrument 
pour l'enregistrement :

 Depuis la fenêtre Mix ou Edit, maintenez la 
touche Maj enfoncée et cliquez sur le bouton 
d'activation pour l'enregistrement de chaque 
piste pour basculer leur état.

Pour activer des pistes MIDI ou d'instrument pour 
l'enregistrement à l'aide des touches Flèche haut 
et bas :

 Maintenez la touche Commande (Mac) 
ou Ctrl (Windows) enfoncée, puis appuyez sur 
la touche Flèche haut ou bas afin d'activer pour 
l'enregistrement la piste MIDI ou d'instrument 
précédente ou suivante. La piste d'origine n'est 
alors plus activée pour l'enregistrement.

Pour activer pour l'enregistrement toutes les pistes 
audio ou toutes les pistes MIDI et d'instrument :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le bouton 
d'activation pour l'enregistrement d'une piste 
audio, d'instrument ou MIDI pour basculer l'état 
de l'ensemble des pistes du même type. 

Pro Tools ne fait pas de distinction entre les pistes 
MIDI et d'instrument en ce qui concerne 
l'activation pour l'enregistrement. Par conséquent, 
le fait de maintenir la touche Alt (Windows) 
ou Option (Mac) enfoncée et de cliquer sur 
le bouton d'activation pour l'enregistrement d'une 
piste MIDI ou d'instrument bascule l'état de toutes 
les pistes MIDI et d'instrument de la session.

Pour activer pour l'enregistrement toutes les 
pistes audio ou pistes MIDI et d'instrument 
sélectionnées :

 Maintenez les touches Option+Maj (Mac) 
ou Alt+Maj (Windows) enfoncées et cliquez sur 
le bouton d'activation pour l'enregistrement 
d'une piste audio, ou MIDI ou d'instrument 
sélectionnée. L'état des autres pistes audio, 
ou MIDI et d'instrument sélectionnées bascule 
également.

Préférence de verrouillage des 
boutons d'activation pour 
l'enregistrement
Lorsque l'option Latch Record Enable Buttons est 
sélectionnée dans les préférences de fonctionnement, 
vous pouvez activer pour l'enregistrement une 
série de pistes audio en cliquant sur leur bouton 
d'activation pour l'enregistrement. Les pistes déjà 
activées pour l'enregistrement restent dans cet état. 
L'option Latch Record Enable Buttons n'affecte 
que les pistes audio.

Si le mode Latch n'est pas activé, maintenez 
la touche Maj enfoncée et cliquez sur le bouton 
d'activation de chaque piste pour basculer leur 
état. Reportez-vous à la section « Préférence 
de verrouillage des boutons d'activation pour 
l'enregistrement » à la page 448.

Afin que la piste d'origine reste activée 
pour l'enregistrement, appuyez sur 
Commande+Maj+Flèche haut/bas (Mac) 
ou Ctrl+Maj+Flèche haut/bas (Windows).

L'activation pour l'enregistrement d'une piste 
appartenant à un groupe de mixage n'affecte 
pas l'état des autres pistes du groupe. 
Afin d'activer pour l'enregistrement toutes les 
pistes d'un groupe, cliquez directement 
à gauche du nom du groupe dans la liste des 
groupes pour sélectionner toute ses pistes, 
puis maintenez les touches Option+Maj (Mac) 
ou Alt+Maj (Windows) enfoncées et cliquez 
sur le bouton d'activation pour 
l'enregistrement de l'une des pistes.
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Lorsque l'option Latch Record Enable Buttons est 
désélectionnée, l'activation pour l'enregistrement 
d'une piste audio désactive celle de la piste audio 
précédente.

Pour activer la préférence Latch Record Enable 
Buttons :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Sélectionnez l'option Latch Record Enable 

Buttons.

Mode de protection contre 
l'enregistrement
Le mode de protection contre l'enregistrement de 
Pro Tools permet d'éviter qu'une piste ne soit 
activée pour l'enregistrement par inadvertance. 
Utilisez ce mode pour empêcher l'écrasement de 
données audio ou MIDI importantes sur une piste.

Pour protéger une piste audio, MIDI ou 
d'instrument contre l'enregistrement :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur le 
bouton d'activation pour l'enregistrement de 
la piste. Le bouton est alors grisé.

Pour désactiver le mode de protection contre 
l'enregistrement de la piste, cliquez à nouveau sur 
le bouton tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée.

Pour protéger toutes les pistes audio, MIDI ou 
d'instrument contre l'enregistrement :

 Maintenez les touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac) enfoncées et cliquez 
sur le bouton d'activation pour l'enregistrement 
de n'importe quelle piste.

Pour désactiver le mode de protection contre 
l'enregistrement de toutes les pistes, cliquez 
à nouveau sur le bouton tout en maintenant les 
touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac) enfoncées.

Pour protéger toutes les pistes actuellement 
sélectionnées contre l'enregistrement :

 Maintenez les touches Commande+Option+Maj 
(Mac) ou Ctrl+Alt+Maj (Windows) enfoncées 
et cliquez sur le bouton d'activation pour 
l'enregistrement de l'une des pistes sélectionnées 
pour basculer l'état de protection contre 
l'enregistrement de toutes les pistes sélectionnées.

Utilisation de disques durs 
pour l'enregistrement

Monitoring de l'espace disponible
Pro Tools permet de vérifier l'espace disque 
disponible. La fenêtre Disk Usage indique l'espace 
disque disponible pour chaque lecteur connecté 
à votre système sous forme de texte et de jauge.

Pour contrôler l'espace disponible sur un disque 
dur durant une session Pro Tools :

 Sélectionnez Window > Disk Space.

Pour afficher l'espace disque disponible sous 
forme de texte uniquement :

 Dans le menu Disk Usage, sélectionnez Text Only.

Disk Usage, fenêtre

Sélection de l'affichage texte uniquement dans la 
fenêtre Disk Usage
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Enregistrement avec plusieurs 
disques durs
(Facultatif)

Par défaut, Pro Tools enregistre les fichiers audio 
dans le dossier Audio Files qui se trouve dans le 
dossier de la session. Si vous disposez de plusieurs 
disques durs pour l'enregistrement, vous pouvez 
utiliser la fenêtre Disk Allocation pour spécifier 
des emplacements sur d'autres disques durs afin 
d'enregistrer les fichiers audio de chaque piste.

Les disques durs pleins n'apparaissent pas dans 
la fenêtre Disk Allocation.

Pour accroître les performances du système, 
Pro Tools peut enregistrer et lire chaque piste 
à partir d'un disque dur différent. Vous pouvez 
également distribuer automatiquement les pistes 
nouvellement créées entre plusieurs disques audio 
grâce à l'option Round Robin Allocation.

Navigation dans la fenêtre Disk Allocation

Pour redimensionner la fenêtre Disk Allocation :

 Faites glisser le coin inférieur droit de la fenêtre.

Pour faire défiler la fenêtre Disk Allocation vers le 
haut ou le bas :

 Appuyez sur la touche Page haut ou Page bas.

Allocation de disques audio 
de votre système

Pour allouer les disques audio de votre système :

1 Sélectionnez Setup > Disk Allocation.

2 Dans la fenêtre Disk Allocation, assignez un 
disque dur à chaque piste en cliquant dans la 
colonne Root Media Folder, puis en sélectionnant 
un volume dans le menu d'allocation des disques.

Seuls les disques de type R (lecture et 
enregistrement) peuvent être sélectionnés dans 
la fenêtre Disk Allocation. Pour plus d'informations, 
reportez-vous à la section « Volumes de 
performance et de transfert » à la page 281.

Un dossier portant le nom de la session est créé sur 
chaque disque dur ; il contient des sous-dossiers 
pour les fichiers audio et les fichiers de fondu.

• Pour assigner une piste à un autre disque dur, 
cliquez sur la piste et sélectionnez le nom 
d'un disque.

Fenêtre Disk Allocation

Menu d'allocation des disques
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• Pour assigner toutes les pistes à un même disque 
dur, maintenez la touche Alt (Windows) 
ou Option (Mac) enfoncée et sélectionnez 
le nom d'un disque.

• Pour effectuer une sélection continue, maintenez 
la touche Maj enfoncée et cliquez sur le nom 
d'une piste (dans la colonne Track). La sélection 
englobe les pistes déjà sélectionnées et toutes les 
pistes intermédiaires.

• Pour sélectionner plusieurs éléments non 
contigus, maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur 
le nom d'une piste dans la colonne Track. 
La sélection englobe les pistes déjà sélectionnées, 
sans inclure les pistes intermédiaires.

3 Pour sauvegarder les fichiers audio enregistrés 
dans un dossier existant (sans créer d'autre 
dossier pour la session), sélectionnez Customize 

Allocation Options, puis cliquez sur Change 
et sélectionnez un dossier. Pour créer des 
sous-dossiers dans ce dossier, sélectionnez 
l'option Create Subfolders for Audio, Video, 

and Fade Files.

4 Pour distribuer automatiquement toutes les pistes 
nouvellement créées entre les différents disques 
connectés à votre système, sélectionnez l'option 
Use Round Robin Allocation for New Tracks.

Si vous utilisez l'allocation Round Robin 
et souhaitez que de l'audio soit enregistré sur 
le disque de démarrage de votre système, 
procédez comme suit :

• Ouvrez le navigateur de l'espace de travail 
(Window > Workspace) et définissez l'indicateur 
de votre volume système sur R (enregistrement 
et lecture). Reportez-vous à la section 
« Désignation des volumes de l'espace de travail » 
à la page 452.

5 Lorsque vous avez terminé, cliquez sur OK.

Sauvegarde des paramètres 
d'allocation des disques
Pour sauvegarder les paramètres d'allocation des 
disques et les utiliser dans de futures sessions, 
enregistrez la session en tant que modèle. Pour 
plus d'informations, reportez-vous à la section 
« Modèles de session » à la page 168.

Allocation des disques 
et sessions multi-plateformes
Pour assurer une portabilité maximale entre les 
plateformes, les sessions Pro Tools Mac et les 
fichiers audio associés doivent se trouver sur des 
disques formatés Mac (HFS ou HFS+). Les sessions 
Pro Tools Windows et les fichiers audio associés 
doivent se trouver sur des lecteurs NTFS Windows. 

L'allocation Round Robin n'est pas prise en 
charge avec des disques durs partitionnés.

Si vous souhaitez exclure des volumes montés 
et valides spécifiques des passes d'allocation 
Round Robin, ouvrez le navigateur de 
l'espace de travail et protégez le volume 
en sélectionnant P (lecture seulement) 
ou T (transfert). Pour plus d'informations, 
reportez-vous à la section « Permissions des 
volumes » à la page 286.

Reportez-vous aux sections « Enregistrement 
de copies de sessions Mac compatibles avec 
Windows » à la page 399 et « Partage de 
sessions créées sur des plateformes 
différentes » à la page 397.
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Réallocation de pistes
Lorsque vous ouvrez une session pour laquelle 
certains disques durs préalablement utilisés 
ne sont plus disponibles (ou ne sont pas pris 
en charge par la plateforme de la session actuelle), 
Pro Tools réassigne automatiquement les pistes au 
volume sur lequel le fichier de session est stocké. 
Le cas échéant, utilisez la fenêtre Disk Allocation 
pour allouer des pistes à d'autres disques.

Désignation des volumes 
de l'espace de travail
La désignation des volumes de l'espace de travail 
peut affecter la disponibilité des disques, et donc 
se répercuter dans la fenêtre Disk Allocation. 
Un volume peut être désigné en tant que volume 
d'enregistrement, de lecture ou de transfert à partir 
du navigateur de l'espace de travail. Si vous modifiez 
la désignation d'un disque et le définissez en tant que 
support en lecture seule (lecture ou transfert), 
consultez la fenêtre Disk Allocation pour vérifier 
si des pistes lui étaient précédemment allouées. 
Pour plus d'informations, reportez-vous à la section 
« Permissions des volumes » à la page 286.

Enregistrement sur le volume 
système
Bien que Pro Tools permette d'enregistrer sur votre 
volume système, cela est généralement déconseillé. 
Les performances d'enregistrement et de lecture 
audio sur les disques système ne sont pas aussi 
élevées que sur les autres disques.

Enregistrez sur le disque système uniquement 
en cas de nécessité absolue, par exemple si votre 
système ne compte qu'un seul disque dur ou si les 
autres disques sont pleins.

Par défaut, le volume système est ignoré pas 
l'allocation Round Robin (quelle que soit 
sa désignation dans le navigateur de l'espace 
de travail). Pour inclure le volume système dans les 
allocations Round Robin, reportez-vous à la section 
« Allocation de disques audio de votre système » 
à la page 450.

Sélection d'un mode 
de monitoring d'entrée pour 
l'enregistrement
Pro Tools propose deux modes de monitoring des 
entrées : Auto Input (monitoring d'entrée 
automatique) et Input Only (monitoring d'entrée 
uniquement). Ces modes déterminent la manière 
dont le monitoring fonctionne en cours de lecture, 
d'enregistrement ou lorsque le transport est arrêté.

Mode de monitoring automatique
En mode de monitoring automatique, dès que 
la lecture de la session est arrêtée, le monitoring de 
Pro Tools bascule sur les entrées. Lorsque la lecture 
est lancée pour effectuer un punch-in, Pro Tools lit le 
contenu des pistes déjà enregistré jusqu'au point de 
punch. Le monitoring bascule ensuite sur les entrées. 
Après le point de punch-out, le monitoring rebascule 
sur le contenu des pistes. Ce mode de fonctionnement 
est semblable à celui des magnétophones multipistes 
numériques ou analogiques.

La réallocation de pistes n'a aucune 
conséquence sur l'audio précédemment 
enregistré. Elle n'affecte que l'emplacement 
de stockage de l'audio qui sera enregistré 
par la suite.

Si votre système Pro Tools comporte plusieurs 
disques et si vous souhaitez enregistrer 
différentes pistes simultanément, vous pouvez 
désigner le disque système comme disque 
dédié uniquement à la lecture ou au transfert 
afin d'optimiser les performances.

En mode de monitoring automatique, le retour 
au monitoring du contenu des pistes suite à un 
punch-out n'est pas instantané
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Monitoring d'entrée uniquement
En mode de monitoring d'entrée uniquement, 
lorsqu'une piste est activée pour l'enregistrement, 
le monitoring de Pro Tools bascule sur son entrée, 
qu'une sélection de punch-in/out ait été créée 
ou non, ou quel que soit l'état de la piste.

Dans Pro Tools, l'indicateur d'état d'activation du 
monitoring d'entrée (dans la fenêtre de transport) 
est allumé en vert lorsque le mode de monitoring 
d'entrée uniquement est activé.

Dans Pro Tools HD, l'indicateur s'allume en vert 
lorsque la commande de monitoring d'entrée d'une 
ou plusieurs pistes est activée (reportez-vous à la 
section « Sélection des modes de monitoring pour 
l'enregistrement avec la commande de monitoring 
d'entrée de piste » à la page 453).

Sélection d'un mode de 
monitoring pour l'enregistrement

Pour placer les pistes activées pour l'enregistrement 
en mode de monitoring d'entrée automatique :

 Sélectionnez Track > Auto Input Monitoring.

Pour placer les pistes activées pour l'enregistrement 
en mode de monitoring d'entrée uniquement :

 Sélectionnez Track > Input Only Monitoring.

Sélection des modes de 
monitoring pour l'enregistrement 
avec la commande de monitoring 
d'entrée de piste
(Pro Tools HD uniquement)

La commande de monitoring d'entrée de piste 
(TrackInput) permet à tout moment de passer 
du mode de monitoring d'entrée automatique 
au mode de monitoring d'entrée uniquement 
et inversement, pour chaque piste audio, que ce 
soit en cours de lecture, d'enregistrement 
ou à l'arrêt et ce, même si une piste n'est pas 
activée pour l'enregistrement. La commande 
de monitoring d'entrée de piste offre la flexibilité 
de monitoring nécessaire pour le réenregistrement 
et le mixage, et est similaire à la commutation 
d'entrée des enregistreurs multipistes analogiques 
et des appareils de même type.

Lorsque le bouton TrackInput d'une piste est 
activé (vert), la piste est en mode de monitoring 
d'entrée uniquement. 

Dans Pro Tools HD, les pistes sont en mode 
de monitoring automatique par défaut et une 
commande de monitoring (bouton TrackInput) 
est disponible sur chacune d'entre elles. 
Reportez-vous à la section « Sélection des 
modes de monitoring pour l'enregistrement 
avec la commande de monitoring d'entrée de 
piste » à la page 453.

Indicateur d'état d'activation du monitoring d'entrée 
de la fenêtre de transport

Pour passer d'un mode de monitoring à l'autre, 
appuyez sur les touches Alt+K (Windows) 
ou Option+K (Mac).

Bouton de monitoring TrackInput activé (entrée 
uniquement) dans la fenêtre Edit
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Lorsque le bouton TrackInput d'une piste est 
désactivé, la piste est en mode de monitoring 
d'entrée automatique.

Pour basculer le mode de monitoring des pistes 
audio, effectuez l'une des opérations suivantes :

 Pour basculer l'état d'une seule piste, cliquez sur 
son bouton de monitoring TrackInput.

 Pour basculer l'état de toutes les pistes de la 
session, maintenez la touche Option (Mac) 
ou Alt (Windows) enfoncée et cliquez sur 
un bouton de monitoring TrackInput.

 Pour basculer l'état de toutes les pistes 
sélectionnées de la session, maintenez les touches 
Option+Maj (Mac) ou Alt+Maj (Windows) 
enfoncées et cliquez sur le bouton de monitoring 
TrackInput de l'une des pistes sélectionnées.

Pour basculer l'état des boutons TrackInput 
de toutes les pistes activées pour l'enregistrement, 
effectuez l'une des opérations suivantes :

 Pour placer toutes les pistes activées pour 
l'enregistrement en mode de monitoring 
d'entrée automatique, sélectionnez Track > 

Set Record Tracks to Auto Input.

 Pour placer toutes les pistes activées pour 
l'enregistrement en mode de monitoring 
d'entrée uniquement, sélectionnez Track > 

Set Record Tracks to Input Only.

Désactivation du monitoring d'entrée de 
piste lors du désarmement d'une piste

Si l'option Disable “Input” When Disarming Track 

(in “Stop”) est activée dans les préférences 
de fonctionnement, le monitoring d'entrée de piste 
est désactivé dès qu'une piste sort de l'état 
d'activation pour l'enregistrement. Cela est 
particulièrement utile pour certains workflows, 
notamment lorsque vous enregistrez une série 
de pistes, l'une après l'autre.

Si cette option n'est pas activée, la commande 
TrackInput reste activée lorsque le bouton 
d'activation pour l'enregistrement d'une piste 
est désenclenché.

Bouton de monitoring TrackInput désactivé (entrée 
audio) dans la fenêtre Edit

Appuyez sur Maj+I pour activer le bouton 
de monitoring TrackInput de toute piste 
contenant le curseur d'édition sur une 
sélection d'édition.

Pour basculer l'état des pistes activées pour 
l'enregistrement entre les modes 
de monitoring d'entrée automatique 
et d'entrée uniquement, appuyez sur 
Alt+K (Windows) ou Option+K (Mac).
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Configuration des niveaux 
de monitoring pour 
l'enregistrement et la lecture
Pro Tools mémorise deux niveaux de fader 
différents pour le monitoring de chaque piste 
audio : un premier lorsque la piste est activée pour 
l'enregistrement, un second lorsqu'elle ne l'est pas. 

Pro Tools mémorise automatiquement ces deux 
valeurs de niveau de fader. Si vous déplacez 
un fader alors qu'une piste est activée pour 
l'enregistrement, puis basculez son état 
d'activation pour l'enregistrement, le fader 
retrouve son niveau pour la lecture.

Lorsqu'une piste audio est activée pour 
l'enregistrement, son fader de volume devient 
rouge dans la fenêtre Mix, indiquant que le niveau 
de monitoring d'enregistrement est actif.

Liaison des faders 
d'enregistrement et de lecture
Lorsque l'option Link Record and Play Faders est 
sélectionnée dans les préférences de 
fonctionnement, Pro Tools ne mémorise pas les 
différents niveaux d'enregistrement et de lecture 
pour les pistes audio. Dans ce cas, l'activation 
d'une piste audio pour l'enregistrement n'a aucun 
effet sur le niveau du fader de la piste. Vous 
pouvez ainsi conserver un mixage cohérent, que ce 
soit pendant l'enregistrement ou la lecture.

Réduction de la latence 
du monitoring
Les circuits de monitoring induisent inévitablement 
un certain délai audio, également appelé latence 
(même s'il s'agit uniquement de quelques 
échantillons) en raison du processus de conversion 
d'un signal analogique en signal numérique 
(en entrée) et inversement (en sortie). Une latence 
supplémentaire peut provenir de différentes 
configurations du mixeur et des traitements 
appliqués.

Les systèmes Avid HDX présentent une latence 
supplémentaire lors de l'utilisation de plug-ins 
Native, car ces derniers utilisent également 
le processeur hôte de votre ordinateur.

Les systèmes Pro Tools basés sur hôte utilisent 
le processeur hôte de votre ordinateur pour 
le traitement, la lecture et l'enregistrement audio, 
si bien que le système subit toujours une légère 
latence. Un délai audible peut par exemple se 
manifester entre l'entrée d'un signal et sa sortie sur 
le chemin de monitoring d'enregistrement de 
Pro Tools. 

Dans Pro Tools, la latence peut se manifester de la 
manière suivante :

• Tous les systèmes Pro Tools peuvent subir une 
latence liée à la conversion du MIDI en audio 
pour les plug-ins d'instrument virtuel (lorsque 
vous jouez d'un instrument virtuel en live et 
écoutez la sortie de l'instrument par exemple).

• Une latence de monitoring entre l'entrée et la 
sortie est présente sur les systèmes Pro Tools sur 
toute piste ou entrée auxiliaire activée pour 
l'enregistrement avec une entrée live.

• Les systèmes Pro Tools|HDX présentent une 
latence de monitoring sur les pistes utilisant un 
ou plusieurs plug-ins basés sur hôte. 
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La quantité de latence est liée à la taille de la 
mémoire tampon matérielle (H/W Buffer Size) : 
plus sa taille est élevée, plus la latence est 
importante. Réduisez la valeur du paramètre H/W 

Buffer Size pour limiter la latence du monitoring. 
Il est toutefois impossible d'éliminer complètement 
la latence, même avec la taille de mémoire tampon 
la plus faible. 

De plus, le fait de réduire la taille de la mémoire 
tampon limite le nombre de pistes audio que 
vous pouvez enregistrer simultanément sans 
risque d'erreur.

Dans certaines circonstances, une taille de 
mémoire tampon importante peut s'avérer 
nécessaire, par exemple lorsque vous utilisez de 
nombreuses pistes et plug-ins. Cependant, il est 
généralement conseillé d'utiliser la plus petite taille 
possible lorsque la latence est trop importante pour 
l'enregistrement et le monitoring.

Si vous utilisez une console de mixage externe 
pour le monitoring d'une source enregistrée 
avant qu'elle ne soit routée vers Pro Tools, 
vous n'entendrez aucune latence.

Pour définir la taille de la mémoire tampon matérielle :

1 Sélectionnez Setup > Playback Engine.

2 Dans le menu déroulant H/W Buffer Size, 
sélectionnez un nombre d'échantillons.

3 Cliquez sur OK.

Enregistrement avec 
compensation du délai
Dans la plupart des cas, il est recommandé 
d'enregistrer en activant la compensation du délai 
pour maintenir un alignement temporel et une 
cohérence de phase entre des pistes présentant des 
délais DSP différents. Toutefois, il est 
généralement déconseillé d'utiliser des inserts sur 
les pistes enregistrées ou celles contrôlant les 
niveaux de mixages casque. Pour plus 
d'informations, reportez-vous à la section 
« Compensation du délai » à la page 1021.

Monitoring sans latence
(Mbox, Mbox 2, Mbox Mini et Mbox 2 
Mini uniquement)

Les Mbox (3e génération), Mbox 2, Mbox Mini 
et Mbox 2 Mini permettent d'obtenir un 
monitoring sans aucune latence des signaux 
d'entrée analogiques lors de l'enregistrement. 
Ce monitoring analogique à latence zéro est 
contrôlé par le bouton Mix du panneau avant 
de l'interface, que vous pouvez utiliser pour mixer 
et ajuster la balance entre l'entrée analogique et le 
retour de Pro Tools. Pour plus d'informations, 
reportez-vous à votre Guide de l'utilisateur.

Monitoring à faible latence
(Pro Tools|HD Native, 003, 003 Rack, 003 Rack+, 
Mbox Pro, Mbox Pro 2 et interfaces Core Audio 
et ASIO avec mixeurs intégrés uniquement)

Les systèmes Pro Tools|HD Native, 003, 003 
Rack, 003 Rack+, Mbox Pro et Mbox Pro 2 
peuvent utiliser l'option Low Latency Monitoring 
pour enregistrer avec une latence de monitoring 
extrêmement faible, sur autant de pistes que peut 
en gérer chaque système.

De même, certaines interfaces audio Core Audio 
et ASIO qui possèdent un mixeur intégré 
(telles que la RME Fireface ou la MOTU 828) 
peuvent utiliser l'option Low Latency Monitoring.

Pour plus d'informations sur le paramètre 
H/W Buffer Size, reportez-vous à la section 
« Taille de mémoire tampon matérielle » 
à la page 54.

Les ordinateurs dotés de processeurs plus 
lents ne pourront peut-être pas utiliser une 
taille de mémoire tampon matérielle 
inférieure à 512 échantillons sans que cela 
n'entraîne des erreurs de fonctionnement.
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Seules les pistes dont les entrées sont assignées à une 
sortie physique (et non à un bus de mixage interne) 
peuvent utiliser le monitoring à faible latence.

Pour activer le monitoring à faible latence :

1 Effectuez l'une des opérations suivantes :

• Pour les systèmes HD Native, assignez chaque 
piste au chemin de monitoring à faible latence 
sélectionné, tel que spécifié sur l'onglet Output 
de la boîte de dialogue I/O Setup (reportez-vous 
à la section « Low Latency Monitoring » 
à la page 79). Seules les pistes assignées à ces 
sorties utilisent le monitoring à faible latence.

• Pour tous les autres systèmes, assignez chaque 
sortie de piste au chemin Output 1 ou Output 
2 (mono), ou aux deux (stéréo). Seules les pistes 
assignées à ces sorties utilisent le monitoring 
à faible latence.

2 Activez les pistes audio pour l'enregistrement 
en cliquant sur leur bouton d'activation 
pour l'enregistrement.

3 Sélectionnez Options > Low Latency Monitoring. 

Lorsque l'option Low Latency Monitoring est 
activée, les plug-ins et départs assignés aux pistes 
activées pour l'enregistrement (routées sur le 
chemin de monitoring à faible latence sélectionné 
pour les systèmes HD Native, ou sur les sorties 1 
et 2 pour tous les autres systèmes) sont 
automatiquement bypassés et doivent le rester. 
De plus, les niveaux de ces pistes ne sont pas pris 
en compte par les indicateurs de niveau des 
Master Faders.

Monitoring à faible latence et bounce 
sur disque

Lorsque l'option Low Latency Monitoring est activée, 
seules les pistes audio sont prises en compte par 
la commande Bounce To Disk. Les pistes d'entrée 
auxiliaire et d'instrument sont ignorées. Pour inclure 
les pistes d'entrée auxiliaire et d'instrument, 
désactivez l'option Low Latency Monitoring avant 
d'utiliser la commande Bounce to Disk. 

Si votre matériel Core Audio ou ASIO ne 
dispose pas de mixeur intégré, le monitoring 
à faible latence ne fonctionnera pas. Si vous 
activez l'option Low Latency Monitoring avec 
ce type de matériel, le monitoring des pistes 
de Pro Tools activées pour l'enregistrement 
sera impossible.

Il est impossible d'enregistrer une entrée 
externe lors d'un bounce sur disque. Pour 
inclure une entrée externe lors d'un bounce, 
elle doit au préalable être enregistrée sur de 
nouvelles pistes audio (reportez-vous à la 
section « Bounce to Disk » à la page 1133).
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Chapitre 21 : Enregistrement audio

Pro Tools permet d'enregistrer des données audio 
sur des pistes audio. Ces pistes peuvent être mono, 
stéréo ou multicanal selon les caractéristiques de la 
source d'enregistrement. 

Pour enregistrer une source mono, utilisez une 
seule piste audio mono de Pro Tools. Un seul 
fichier audio mono est enregistré sur le disque ; il 
apparaît en tant que clip dans la playlist de la piste 
et dans la liste des clips.

Pour enregistrer une source stéréo, utilisez une 
seule piste audio stéréo de Pro Tools. Un seul 
fichier audio mono est enregistré sur le disque pour 
chaque canal d'une piste stéréo (un pour le gauche 
et un pour le droit). Ces fichiers apparaissent sous 
la forme d'un clip stéréo dans la playlist de la piste 
et dans la liste des clips.

L'enregistrement d'une source multicanal sur une 
piste de même type (Pro Tools HD uniquement) est 
similaire à l'enregistrement de pistes audio stéréo. 
Un seul fichier audio mono est enregistré pour 
chaque canal de la piste ; il apparaît en tant que clip 
multicanal dans la playlist de la piste et dans la liste 
des clips (reportez-vous à la section « Pistes audio 
multicanal » à la page 1161).

Avant d'enregistrer
Avant de commencer à enregistrer dans Pro Tools, 
vous devez configurer votre système Pro Tools, une 
session, ainsi qu'une ou plusieurs pistes pour 
l'enregistrement. Vous devez également configurer le 
monitoring des entrées de Pro Tools. Pour plus 
d'informations, reportez-vous au Chapitre 20, 
« Configuration de l'enregistrement ».

Procédure d'enregistrement 
de base

Pour enregistrer une piste audio :

1 Dans le sélecteur de chemin d'entrée de la piste, 
sélectionnez le chemin d'entrée audio 
à enregistrer (reportez-vous à la section 
« Assignation d'E/S matérielles sur une piste » 
à la page 446).

2 Dans le sélecteur de chemin de sortie de la piste, 
sélectionnez le chemin de monitoring principal.

3 Cliquez sur le bouton d'activation pour 
l'enregistrement de la piste audio. Il s'allume en 
rouge.

Activation d'une piste pour l'enregistrement dans 
la fenêtre Mix
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4 Réglez le niveau de sortie de votre source sonore 
(instrument, table de mixage ou préamplificateur). 
Surveillez les indicateurs de niveau de la piste 
dans Pro Tools afin que les crêtes se situent dans la 
plage comprise entre -6 dB et -12 dB sur 
l'indicateur de niveau d'entrée sans déclencher 
l'indicateur d'écrêtage de l'interface audio.

5 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Mix, réglez les faders de volume 
et de panoramique de la piste comme souhaité. 
Ces paramètres affectent uniquement 
le monitoring et non les données effectivement 
enregistrées.

• Dans la fenêtre de sortie de la piste, réglez le fader 
de volume et les curseurs de panoramique de la 
piste. Ces paramètres affectent uniquement le 
monitoring et non les données effectivement 
enregistrées. Reportez-vous à la section « Fenêtres 
Output pour les pistes et les départs » 
à la page 1008.

6 Pour afficher la fenêtre de transport, sélectionnez 
Window > Transport. Pour retourner au début de la 
session, cliquez sur le bouton de retour à zéro. 

7 Dans la fenêtre de transport, cliquez sur 
le bouton Record pour activer Pro Tools pour 
l'enregistrement. Ce bouton clignote en rouge 
pour indiquer que Pro Tools est prêt 
à enregistrer.

8 Veillez à ce que le mode d'enregistrement normal 
soit sélectionné (reportez-vous à la section « Modes 
d'enregistrement » à la page 441).

9 Dès que vous êtes prêt à commencer 
l'enregistrement, cliquez sur le bouton Play ou 
appuyez sur la barre d'espace.

Si le décompte est activé, Pro Tools décompte le 
nombre de mesures spécifié avant de commencer 
l'enregistrement. Reportez-vous à la section 
« Enregistrement avec un clic » à la page 436.

10 Enregistrez votre performance.

11 À la fin de l'enregistrement, cliquez sur 
le bouton Stop de la fenêtre de transport 
ou appuyez sur la barre d'espace.

L'audio enregistré est écrit sur le disque et apparaît 
sous la forme d'un clip audio dans la playlist de la 
piste et la liste des clips.

Pour lire la piste audio :

1 Cliquez sur le bouton d'activation pour 
l'enregistrement pour sortir la piste de ce mode. 
Le fader de volume de la piste fonctionne 
désormais comme commande de niveau de 
lecture.

2 Dans la fenêtre de transport, cliquez sur le bouton 
de retour à zéro pour vous assurer que la lecture 
commencera au début de la session.

3 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport ou appuyez sur la barre 
d'espace.

Fenêtre de transport

Retour à zéro Avance rapide
Aller à la fin

En ligne Arrêt
Lecture

Enregistrer

Retour rapide

Si une piste préparée pour l'enregistrement est 
en mode de monitoring d'entrée automatique, 
vous entendrez l'entrée après avoir appuyé sur 
le bouton Stop de la fenêtre de transport. La 
piste passe automatiquement en mode de lecture 
lorsque vous appuyez sur Play, puis retourne en 
mode de monitoring d'entrée lorsque vous 
arrêtez la lecture ou déclenchez un 
enregistrement en punch-in. Pour plus 
d'informations, reportez-vous à la section 
« Mode de monitoring automatique » 
à la page 452.
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Annulation d'un enregistrement 
audio
Après avoir enregistré une piste audio et appuyé 
sur le bouton Stop de la fenêtre de transport, vous 
pouvez annuler la prise d'enregistrement.

Pour annuler un enregistrement audio :

 Après avoir arrêté l'enregistrement, 
sélectionnez Edit > Undo Record Audio. 

La playlist de la piste est restaurée à son état 
précédent et les données sont supprimées comme 
suit :

• En mode d'enregistrement normal, seule la prise 
la plus récente est annulée.

• En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont 
annulées.

• En mode QuickPunch, TrackPunch 
ou DestructivePunch, tous les enregistrements en 
punch-in/out de la dernière passe 
d'enregistrement sont annulés.

Si aucune action ne peut être annulée, le menu 
affiche Can't Undo en grisé.

Annulation d'une prise 
d'enregistrement
Il est possible d'annuler la prise en cours 
d'enregistrement. Les données audio enregistrées 
jusqu'à ce point sur votre disque dur sont 
alors supprimées, de même que les clips 
correspondants dans la playlist de la piste et la liste 
des clips. En mode d'enregistrement en boucle, 
toutes les prises enregistrées passe après passe sont 
annulées. Il est impossible d'annuler 
un enregistrement en mode destructif. 

Pour annuler une prise en cours d'enregistrement :

 Appuyez sur Commande+Point (.) (Mac) 
ou Ctrl+Point (.) (Windows) avant d'arrêter 
le transport.

Enregistrement de plusieurs 
pistes audio
Pro Tools peut enregistrer simultanément 
plusieurs pistes audio, dans la limite du nombre de 
pistes de votre système. Pour enregistrer sur 
plusieurs pistes, configurez chacune des pistes, 
activez-les pour l'enregistrement, puis lancez 
l'enregistrement. Suivez la procédure indiquée 
dans la section « Procédure d'enregistrement 
de base » à la page 459.

Pour chaque piste activée pour l'enregistrement, un 
nouveau fichier audio est enregistré sur le disque 
et un nouveau clip est créé. Celui-ci apparaît dans 
la playlist de la piste et la liste des clips.

Si vous annulez une passe d'enregistrement 
en cours d'enregistrement, Pro Tools supprime 
de la session toutes les passes d'enregistrement 
annulées précédemment et vous permet 
de supprimer la passe d'enregistrement 
précédente de votre disque dur.

Si votre système Pro Tools comporte 
plusieurs disques et si vous voulez enregistrer 
plusieurs pistes simultanément, vous pouvez 
désigner le disque système comme disque de 
transfert uniquement afin d'optimiser les 
performances.
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Raccourcis pour 
l'enregistrement
Pour activer Pro Tools pour l'enregistrement, vous 
pouvez cliquer sur le bouton Record de la fenêtre 
de transport ou de la fenêtre Edit ou lancer 
l'enregistrement avec les raccourcis clavier 
suivants :

• Appuyez sur F12 pour lancer immédiatement 
l'enregistrement.

• Appuyez sur Ctrl+Barre d'espace (Windows) 
ou Commande+Barre d'espace (Mac) pour 
lancer l'enregistrement.

• Appuyez sur la touche 3 du pavé numérique 
(lorsque le pavé numérique est en mode 
Transport) pour lancer l'enregistrement.

Mode de préparation 
à l'enregistrement
Lorsque vous enregistrez un grand nombre 
de pistes ou de canaux, ou lorsqu'un nombre 
important de pistes doit être lu en cours 
d'enregistrement, Pro Tools peut prendre plus de 
temps à commencer effectivement 
l'enregistrement. Pour éviter ce retard, 
placez Pro Tools en mode de préparation 
à l'enregistrement avant de commencer 
à enregistrer.

Pour activer le mode de préparation 
à l'enregistrement et commencer l'enregistrement :

1 Cliquez sur le bouton Record de la fenêtre 
de transport. Le bouton Record clignote.

2 Effectuez l'une des opérations suivantes :

• Pour placer Pro Tools en mode de préparation à 
l'enregistrement, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez sur le bouton Play de la fenêtre 
de transport.

• Effectuez un clic droit sur le bouton Play 
et sélectionnez Prime for Record.

Le bouton Stop s'allume et les boutons Play 
et Record clignotent.

3 Pour lancer l'enregistrement instantanément, 
cliquez sur Play. 

4 Cliquez sur Stop pour arrêter l'enregistrement.

Sur Mac, la touche F12 ne permet 
l'enregistrement que si le raccourci 
du Dashboard est désactivé ou réassigné. 
Pour plus d'informations, reportez-vous 
au Guide de l'utilisateur.

Sur Mac, la combinaison de touches 
Commande+Barre d'espace ne permet 
l'enregistrement que si la fonction Spotlight est 
désactivée ou réaffectée. Pour plus 
d'informations, reportez-vous au Guide 
de l'utilisateur.

Pour lancer un enregistrement à mi-vitesse, 
appuyez sur Ctrl+Maj+Barre d'espace 
(Windows) ou Commande+Maj+Barre 
d'espace (Mac). Reportez-vous à la section 
« Enregistrement à mi-vitesse » à la page 480.

Lors de la synchronisation avec un timecode, 
utilisez le mode de préparation 
à l'enregistrement pour enregistrer ou lire un 
grand nombre de pistes. Le verrouillage sur 
le timecode sera ainsi plus rapide.



Chapitre 21 : Enregistrement audio 463

Configuration des points 
de punch et de boucle
Les points de début et de fin d'une plage 
d'enregistrement en punch-in/out et en 
boucle peuvent être définis à l'aide des méthodes 
suivantes :

• Sélectionnez une plage dans la playlist d'une 
piste (avec l'option Options > Link Timeline and 

Edit Selection activée).

• Sélectionnez une plage sur une règle de base de 
temps.

• Faites glisser les marqueurs de sélection 
de timeline sur la règle.

• Saisissez les heures de début et de fin dans 
la fenêtre de transport.

• Rappelez un emplacement mémoire incluant 
une sélection d'édition (avec l'option Options > 

Link Timeline et Edit Selection activée).

Pour définir la plage d'enregistrement dans 
la playlist d'une piste :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Sélectionnez Options > Link Timeline and Edit 

Selection.

3 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur, sélectionnez la plage 
d'enregistrement dans la playlist de la piste.

• Si la plage d'enregistrement est définie par les 
points de début et de fin d'un clip, sélectionnez la 
totalité du clip.

Pour définir la plage d'enregistrement sur une 
règle de base de temps :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Sélectionnez la plage d'enregistrement sur 
la règle de base de temps de votre choix.

Sélection de playlist

Vous pouvez également entrer des points 
de début et de fin en cours de lecture. Appuyez 
sur la touche flèche bas pour définir un point 
de début et sur la touche flèche haut pour 
définir un point de fin. Si vous utilisez cette 
méthode en mode Grid, l'alignement sur la 
grille n'est pas respecté.

Sélection de timeline

Si le Sélecteur est désactivé, vous n'avez pas 
besoin de le sélectionner manuellement. 
D'autres outils d'édition (tels que l'outil 
de saisie du temps) se transforment 
automatiquement en Sélecteur sur les règles 
de base de temps.
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Marqueurs de sélection 
de timeline
Lorsque des pistes sont activées pour 
l'enregistrement, des marqueurs de sélection de 
timeline correspondant aux heures de début et de 
fin apparaissent sous la forme de flèches rouges 
orientées vers le haut et le bas sur la règle de base 
de temps principale. Si aucune piste n'est activée 
pour l'enregistrement, les marqueurs de sélection 
de timeline sont bleus.

Vous pouvez faire glisser les marqueurs de sélection 
de timeline, séparément ou simultanément, pour 
définir les plages de lecture et d'enregistrement.

Pour définir la plage d'enregistrement en déplaçant 
les marqueurs de sélection de timeline :

1 Si vous souhaitez que les marqueurs de sélection 
de timeline s'alignent sur la valeur de grille 
actuelle, passez en mode d'édition Grid. 

2 Faites glisser le premier marqueur de sélection de 
timeline (flèche orientée vers le bas) sur le point 
de début de la plage.

3 Faites glisser le second marqueur de sélection 
de timeline (flèche orientée vers le haut) sur le 
point de fin de la plage.

Champs de début, de fin 
et de durée
En vue étendue, la fenêtre de transport peut afficher 
les heures de début, de fin et la durée, ainsi que les 
paramètres de pré-roll et post-roll. Lorsque vous 
définissez une plage d'enregistrement ou de lecture, 
les valeurs correspondantes sont affichées dans ces 
champs.

Vous pouvez saisir des valeurs dans les champs de 
début et de fin pour définir la plage de lecture ou 
d'enregistrement. La position des marqueurs de 
sélection de timeline est mise à jour en conséquence 
sur la règle de base de temps principale.

Pour définir la plage d'enregistrement en saisissant les 
heures de début et de fin dans la fenêtre de transport :

1 Pour voir les heures de début, de fin ainsi que la 
durée, effectuez l'une des opérations suivantes :

• Sélectionnez View > Transport > Expanded.

• Dans la fenêtre de transport, maintenez la touche 
Maj enfoncée et cliquez sur le bouton 
Développer/Réduire (icône +).

Marqueurs de sélection de timeline sur la règle 
de base de temps principale

Déplacement d'un marqueur de sélection de timeline 
(heure de début) sur la règle de base de temps principale

Si la plage d'enregistrement actuelle est déjà de 
la bonne durée et s'il suffit de la déplacer, faites 
glisser l'un des marqueurs de sélection de 
timeline en maintenant la touche 
Alt (Windows) ou Option (Mac) enfoncée 
pour déplacer l'ensemble vers un nouvel 
emplacement (tout en conservant 
la même durée).

Fenêtre de transport avec champs de début, fin et durée
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2 Effectuez l'une des opérations suivantes :

• Dans la fenêtre de transport, cliquez sur 
le champ Start.

• Appuyez sur Alt+barre oblique (/) (Windows) 
ou Option+barre oblique (/) (Mac) sur le pavé 
numérique pour sélectionner le champ Start de la 
fenêtre de transport.

3 Saisissez l'emplacement de début, puis appuyez 
sur Alt+barre oblique (/) (Windows) ou 
Option+barre oblique (/) (Mac) sur le pavé 
numérique pour valider la valeur et passer 
automatiquement au champ de End.

4 Saisissez l'emplacement de fin, puis appuyez 
sur Entrée pour valider la valeur.

Emplacements mémoire
Vous pouvez mémoriser des sélections d'édition 
sous forme d'emplacements mémoire, qui peuvent 
inclure les valeurs actuelles de pré-roll et post-roll.

Pour enregistrer une sélection d'édition à l'aide 
d'un emplacement mémoire :

1 Assurez-vous que Options > Link Timeline and 

Edit Selection est sélectionné.

2 Définissez la plage d'enregistrement en créant 
une sélection d'édition ou de timeline, ou en 
entrant les heures de début et de fin dans la 
fenêtre de transport.

3 Pour enregistrer les valeurs de pré-roll 
et post-roll, activez et définissez les durées de 
pré-roll et post-roll en les saisissant dans la 
fenêtre de transport ou en faisant glisser les 
drapeaux correspondants sur la règle 
représentant l'échelle temporelle principale 
(reportez-vous à la section « Configuration des 
durées de pré-roll et post-roll » à la page 466).

4 Appuyez sur la touche Entrée du pavé 
numérique ou cliquez sur le bouton Add 
Marker/Memory Location dans la fenêtre Edit.

5 Dans la boîte de dialogue New Memory 
Location, activez l'option Selection dans 
la zone Time Properties et, si vous souhaitez 
enregistrer les valeurs de pré et post-roll, cochez 
l'option Pre/Post Roll Times dans la zone 
General Properties.

Utilisez la touche Point (.) ou les touches 
flèche gauche et droite pour vous déplacer 
dans les champs Start et End. Utilisez les 
flèches haut et bas pour augmenter 
ou diminuer les valeurs numériques.

Pour plus d'informations sur les 
emplacements mémoire, reportez-vous 
au Chapitre 36, « Emplacements mémoire ».

Boîte de dialogue New Memory Location,
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6 Saisissez un nom pour le nouvel emplacement 
mémoire.

7 Cliquez sur OK.

Pour rappeler une sélection d'édition à l'aide d'un 
emplacement mémoire :

1 Sélectionnez Options > Link Timeline and Edit 

Selection.

2 Sélectionnez Windows > Memory Locations.

3 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez sur 
le nom ou le numéro de l'emplacement mémoire.

• Rappelez l'emplacement mémoire en saisissant 
un point (.), le numéro de l'emplacement 
mémoire et un autre point (.) sur le pavé 
numérique (reportez-vous à la section « Modes 
du pavé numérique » à la page 28).

Les heures de début et de fin, ainsi que les valeurs 
de pré-roll et post-roll stockées dans 
l'emplacement mémoire sont rappelées.

Configuration des durées 
de pré-roll et post-roll
Les durées de pré-roll et post-roll apparaissent sous 
forme de drapeaux sur la règle qui représente l'échelle 
temporelle principale. Lorsque le pré et le post-roll 
sont activés, les drapeaux sont de couleur verte, et de 
couleur grise dans le cas inverse.

Vous pouvez saisir les durées de pré-roll et de post-
roll dans la fenêtre de transport, les définir à partir 
de la playlist d'une piste ou d'une règle de base de 
temps, ou en rappelant un emplacement mémoire.

Configuration des durées de pré 
et post-roll dans la fenêtre de 
transport
Vous pouvez activer et configurer les durées 
de pré-roll et de post-roll dans la fenêtre 
de transport.

Pour configurer et activer les durées de pré-roll 
et de post-roll dans la fenêtre de transport :

1 Sélectionnez View > Transport > Expanded.

2 Dans la fenêtre de transport, cliquez sur 
le champ Pre-roll.

3 Saisissez la durée de pré-roll souhaitée, 
puis appuyez sur la barre oblique (/) du pavé 
numérique pour valider la valeur et passer 
automatiquement au champ Post-roll.

4 Saisissez la durée de post-roll souhaitée 
et appuyez sur Entrée pour valider la nouvelle 
valeur.

Fenêtre Memory Locations

Drapeaux de pré/post-roll verts (activés) sur la règle 
de base de temps principale

Pré-roll activé sur 2 temps ; post-roll désactivé
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5 Pour activer le pré-roll ou le post-roll, cliquez 
sur le bouton correspondant pour le mettre en 
surbrillance.

Configuration des durées de pré 
et de post-roll dans une playlist
Le Sélecteur permet d'activer et de désactiver 
le pré-roll et le post-roll en cliquant dans la playlist 
d'une piste.

Pour configurer et activer le pré-roll et le post-roll 
en cliquant dans une playlist :

1 Sélectionnez Options > Link Timeline and Edit 

Selection.

2 À l'aide du Sélecteur, sélectionnez la plage 
d'enregistrement dans la playlist de la piste.

3 À l'aide du Sélecteur, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez avant la sélection dans la playlist de 
la piste pour activer le pré-roll à cet 
emplacement.

4 À l'aide du Sélecteur, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez après la sélection dans la playlist de la 
piste pour activer le post-roll à cet 
emplacement.

Pour désactiver les durées de pré-roll et de 
post-roll en cliquant dans une playlist :

1 À l'aide du Sélecteur, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez près du début dans la sélection 
d'édition pour désactiver le pré-roll.

2 À l'aide du Sélecteur, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée 
et cliquez près de la fin dans la sélection 
d'édition pour désactiver le post-roll.

3 Faites glisser le drapeau de pré-roll sur le 
marqueur de début de la sélection de timeline.

4 Faites glisser le drapeau de post-roll sur le point 
de fin de la sélection de timeline.

Activation du pré-roll et du post-
roll à partir du menu Options
Vous pouvez activer et désactiver le pré-roll et le post-
roll (simultanément) à partir du menu Options.

Pour activer à la fois le pré-roll et le post-roll 
à partir du menu Options :

 Sélectionnez Options > Pre/Post-Roll.

Utilisez les touches Point (.) ou Flèche droite 
et Flèche gauche pour vous déplacer dans les 
champs Pre-roll et Post-roll. Utilisez les 
touches Flèche haut et bas pour augmenter ou 
diminuer les valeurs numériques.

Dans la timeline, vous pouvez remettre à zéro le 
pré-roll et le post-roll. Tout d'abord, faites 
glisser le drapeau de pré-roll sur le point de 
début de sélection de timeline, puis faites 
glisser le drapeau de post-roll sur le point de 
fin de sélection de timeline.
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Déplacement des drapeaux 
de pré et post-roll sur la règle de 
base de temps
Vous pouvez faire glisser (séparément 
ou ensemble) les drapeaux de pré-roll et de post-
roll sur la règle de base de temps principale pour 
définir leur emplacement.

Pour configurer les durées de pré-roll et de 
post-roll par glisser sur la règle de base 
de temps principale :

1 Si vous souhaitez que les drapeaux de pré-roll et 
post-roll s'alignent sur la valeur de grille 
actuelle, passez en mode d'édition Grid.

2 Faites glisser le drapeau de pré-roll vers 
un nouvel emplacement de la règle.

3 Faites glisser le drapeau de post-roll vers 
un nouvel emplacement de la règle.

Enregistrement audio 
en punch-in/out sur une 
plage spécifiée
Vous pouvez configurer Pro Tools pour un 
enregistrement en punch-in/out automatique sur 
une plage spécifique d'une piste audio 
(pour remplacer une portion de piste enregistrée, 
par exemple). Vous devez spécifier les points de 
début (punch-in) et de fin (punch-out) de la plage 
avant l'enregistrement.

Bien qu'il existe plusieurs manières de définir les 
plages d'enregistrement et de lecture (reportez-
vous à la section « Configuration des points 
de punch et de boucle » à la page 463), la plus 
simple est peut-être de sélectionner au sein de la 
playlist de la piste la plage à enregistrer.

Lors de l'enregistrement, la lecture commence dès 
le début de la plage de pré-roll (s'il est activé) et se 
poursuit jusqu'au point de début de la sélection 
(point de punch-in), auquel l'enregistrement 
démarre effectivement. Lorsque le point de fin de 
la sélection est atteint (point de punch-out), 
Pro Tools sort automatiquement du mode 
d'enregistrement et poursuit la lecture sur la plage 
de post-roll. Cette fonction de punch-in/out 
automatique est puissante et précise et permet 
d'enregistrer ou de réenregistrer sur une piste.

Déplacement d'un drapeau de pré-roll sur la règle 
de base de temps

Pour configurer des durées de pré-roll et de 
post-roll identiques, faites glisser le drapeau 
de pré-roll ou celui de post-roll sur la règle 
tout en maintenant la touche Alt (Windows) ou 
Option (Mac) enfoncée. La position du 
drapeau non sélectionné sera mise à jour pour 
définir une durée équivalente à celle de l'autre 
plage.

Pour enregistrer en punch-in/out manuel sur 
des pistes audio activées pour 
l'enregistrement en cours de lecture, reportez-
vous au Chapitre 23, « Modes 
d'enregistrement en punch-in/out ».

Pour définir une plage d'enregistrement 
ou de lecture par sélection dans une playlist, 
les sélections d'édition et de timeline doivent 
être liées (sélectionnez Options > Link 
Timeline and Edit Selection).
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Pour effectuer un enregistrement en punch-in/out 
sur une piste audio :

1 Effectuez l'une des opérations suivantes :

• Pour un enregistrement non destructif, assurez-
vous que l'option Options > Destructive Record 
n'est pas activée.

• Si vous avez décidé d'écraser définitivement les 
données de la plage spécifiée, activez l'option 
Options > Destructive Record.

2 Activez la piste pour l'enregistrement.

3 Sélectionnez Options > Link Timeline and Edit 

Selection.

4 Faites glisser le Sélecteur dans la playlist de la 
piste ou sur l'une des règles de base de temps 
jusqu'à ce que la sélection englobe la plage 
d'enregistrement en punch-in/out (reportez-vous 
à la section « Configuration des points de punch 
et de boucle » à la page 463).

5 Pour entendre ce qui se trouve déjà sur une piste 
jusqu'au point de punch-in, ou après le point de 
punch-out, activez le pré-roll et le post-roll et 
configurez leur durée (reportez-vous à la 
section « Configuration des durées de pré-roll 
et post-roll » à la page 466).

6 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

7 Cliquez sur Play pour lancer l'enregistrement.

Pro Tools commence l'enregistrement à partir du 
point de punch-in Si un pré-roll est activé, 
l'enregistrement commence lorsque le point de 
punch-in (début) est atteint. L'enregistrement se 
poursuit jusqu'au point de punch-out (fin), à moins 
que vous n'interrompiez manuellement 
l'enregistrement. Si le post-roll est activé, la lecture 
se poursuit pendant la durée spécifiée.

Si vous travaillez en mode non destructif, 
un nouveau fichier audio est enregistré sur 
le disque dur et un nouveau clip apparaît sur 
la piste et dans la liste des clips.

Si vous travaillez en mode destructif, les nouvelles 
données audio remplacent les précédentes dans 
le fichier audio et le clip existants.

Monitoring pour l'enregistrement en punch-in/out

Pro Tools dispose de deux modes de monitoring pour 
l'enregistrement : monitoring d'entrée automatique 
ou de l'entrée uniquement (reportez-vous à la section 
« Sélection d'un mode de monitoring d'entrée pour 
l'enregistrement » à la page 452).

Sélection de timeline pour un enregistrement 
en punch-in/out avec pré-roll et post-roll

Si vous enregistrez dans un mode autre que le 
mode destructif, les enregistrements en punch-
in/out ne remplacent pas définitivement les 
données précédemment enregistrées. Si vous 
avez décidé d'écraser définitivement les 
données de la plage spécifiée (et de ne 
conserver que la prise la plus récente), 
sélectionnez Options > Destructive Record.

Drapeau de pré-roll

Punch-in Punch-out 

Drapeau de post-roll

Pré-roll
activé

Post-roll activé
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Enregistrement de prises 
supplémentaires
Après avoir enregistré sur une piste audio, 
vous pouvez enregistrer d'autres prises sur cette 
même piste. Toutes les prises supplémentaires 
éventuelles peuvent être utilisées dans la playlist 
principale. Pour plus d'informations sur l'accès aux 
prises alternatives, reportez-vous à la section 
« Prises alternatives » à la page 474.

L'enregistrement de prises supplémentaires en mode 
destructif remplace la prise précédente. Pour conserver 
les données audio des prises précédentes, enregistrez 
en mode normal (non destructif).

Pour enregistrer de façon non destructive une 
nouvelle prise sur la même piste :

1 Assurez-vous que le mode d'enregistrement normal 
est sélectionné (reportez-vous à la section « Modes 
d'enregistrement » à la page 441).

2 Activez la piste pour l'enregistrement.

3 Effectuez l'une des opérations suivantes :

• Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commence au début de la 
session.

• Si Options > Link Timeline and Edit Selection 
est sélectionné, cliquez n'importe où dans 
la playlist de la piste pour enregistrer à partir de 
cet endroit.

4 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

5 Cliquez sur Play pour lancer l'enregistrement.

6 Cliquez sur Stop pour arrêter l'enregistrement.

Un fichier audio correspondant à la nouvelle prise 
est enregistré sur le disque ; il apparaît sous la 
forme d'un clip audio dans la playlist de la piste et 
dans la liste des clips.

L'ancienne prise est conservée sur votre disque dur 
et est toujours disponible sous forme de clip dans 
la liste des clips.

Pour enregistrer de façon destructive sur une 
prise précédente :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Options > Destructive Record.   

• Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport et sélectionnez Destructive.

Le bouton Record affiche un D majuscule.

2 Activez la piste pour l'enregistrement.

3 Effectuez l'une des opérations suivantes :

• Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commence au début de la 
session.

• Si Options > Link Timeline and Edit Selection est 
sélectionné, cliquez n'importe où dans la playlist 
de la piste pour enregistrer à partir de cet endroit.

Pour plus d'informations sur les noms 
attribués aux fichiers audio et aux clips lors de 
l'enregistrement de nouvelles prises, reportez-
vous à la section « Configuration des noms 
par défaut des fichiers et clips audio » 
à la page 445.

Pour enregistrer sur une plage spécifique de la 
piste, avec des points de début et de fin précis, 
reportez-vous à la section « Enregistrement audio 
en punch-in/out sur une plage spécifiée » 
à la page 468.

Mode d'enregistrement destructif activé

Pour enregistrer une plage spécifique de la piste, 
avec des points de début et de fin précis, reportez-
vous à la section « Enregistrement audio 
en punch-in/out sur une plage spécifiée » 
à la page 468.
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4 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

5 Cliquez sur Play pour lancer l'enregistrement.

6 Une fois terminé, cliquez sur le bouton Stop 
pour arrêter l'enregistrement.

L'audio de la nouvelle prise est enregistré sur 
le disque et remplace de façon définitive l'audio 
d'origine. Les nouvelles données viennent 
remplacer les données d'origine dans le clip 
existant. Le clip n'est pas renommé.

Ajout de nouvelles données 
à la fin d'une piste
Vous pouvez également ajouter de nouvelles 
données à la fin d'une piste. 

Pour ajouter des éléments à la fin d'une piste :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Go to End de la fenêtre de 
transport pour aller à la fin de la piste (cela 
permet de localiser la fin de la session).

• Placez le curseur à la fin du dernier clip de la 
piste à l'aide de la touche de tabulation.

2 Lancez l'enregistrement à partir de cet 
emplacement. 

Pro Tools ajoute les nouveaux éléments à la fin de 
la piste. Si vous travaillez en mode 
d'enregistrement destructif, les nouvelles données 
audio sont ajoutées au fichier audio et au clip à 
partir de la première prise. Si vous travaillez en 
mode d'enregistrement non destructif, un nouveau 
fichier et un nouveau clip sont créés.

Enregistrement sur une nouvelle 
playlist
Plutôt que d'écraser des clips audio existants, 
il existe une autre manière d'enregistrer 
de nouvelles prises sur la même piste de façon non 
destructive. Pour cela, il suffit de créer une playlist 
pour la piste, puis d'effectuer l'enregistrement 
comme précédemment.

Les pistes peuvent posséder plusieurs playlists 
d'édition, chacune mémorisant une liste des clips et 
l'ordre dans lequel les lire. Comme les playlists 
suivent les groupes, le fait de dupliquer ou de 
sélectionner des playlists alternatives pour une 
piste du groupe activé affectera toutes les pistes du 
groupe.

Pour enregistrer sur une nouvelle playlist de piste :

1 Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez New.

2 Saisissez le nom de la nouvelle playlist. 

3 Cliquez sur OK.

Lorsqu'une playlist est créée, son nom remplace 
celui de la piste. Les noms des nouveaux fichiers 
audio et des nouveaux clips sont basés sur le nom 
de la piste.

4 Activez la piste pour l'enregistrement.

Sélecteur de playlist
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5 Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

6 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

7 Cliquez sur Play pour lancer l'enregistrement.

8 Cliquez sur Stop pour arrêter l'enregistrement.

Un fichier audio correspondant à la nouvelle prise 
est enregistré sur le disque ; il apparaît sous la forme 
d'un clip audio dans la nouvelle playlist de la piste et 
dans la liste des clips.

La sélection d'une playlist précédente à partir du 
sélecteur de playlist de la piste rappelle ses clips tels 
qu'ils apparaissaient auparavant dans la piste. À tout 
moment, touts les clips de toutes les playlists sont 
disponibles dans la liste des clips et peuvent être 
mélangés/combinés entre playlists et pistes.

Enregistrement audio 
en boucle
Pro Tools dispose d'un mode d'enregistrement en 
boucle qui permet d'enregistrer prise après prise 
tandis que la même section d'audio se répète. Cette 
technique est pratique pour enregistrer rapidement 
plusieurs prises d'une partie sans perdre en 
spontanéité.

Pour enregistrer en boucle, commencez par indiquer 
les points de début et de fin de la boucle. Bien qu'il 
existe plusieurs façons de définir les plages 
d'enregistrement et de lecture (reportez-vous à la 
section « Configuration des points de punch et de 
boucle » à la page 463), la plus simple consiste à 
sélectionner la plage à répéter en boucle sur la 
playlist de la piste (veillez à activer l'option Options 

> Link Timeline and Edit Selection).

Le pré-roll, s'il est activé, est pris en compte lors de la 
première passe d'enregistrement uniquement. Les 
plages de pré-roll et post-roll sont ignorées lors de 
chaque boucle successive. Pour compenser cela, 
vous pouvez rallonger la boucle, quitte à rétablir par 
la suite la durée appropriée grâce à l'outil de trim 
(reportez-vous à la section « Utilisation des outils de 
trim » à la page 558).

Lorsque vous enregistrez de l'audio en boucle, 
Pro Tools crée un seul fichier audio regroupant 
toutes les prises. Les prises apparaissent sous forme 
de clips distincts dans la liste des clips et sont 
numérotées de façon séquentielle. Après avoir 
arrêté l'enregistrement, vous pouvez écouter 
n'importe quelle prise enregistrée.

Pour enregistrer en boucle sur une piste audio :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Options > Loop Record. Lorsque le 
mode d'enregistrement en boucle est activé, un 
symbole de boucle apparaît sur le bouton 
Record.

• Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport et sélectionnez Loop.

Pour plus d'informations sur les playlists et 
leur édition, reportez-vous à la section 
« Playlists » à la page 645.

Pour utiliser des prises alternatives créées en 
mode d'enregistrement en boucle dans 
d'autres sessions (en utilisant, par exemple, la 
boîte de dialogue Import Session Data), 
exportez les définitions des clips 
(reportez-vous à la section « Exportation des 
définitions de clips » à la page 347). Si les 
définitions des clips ne sont pas exportées, les 
prises alternatives enregistrées en boucle ne 
sont pas accessibles lorsqu'elles sont 
importées dans une autre session. 

Mode d'enregistrement en boucle activé
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2 Activez la piste audio pour l'enregistrement en 
cliquant sur son bouton d'activation 
pour l'enregistrement.

3 Sélectionnez Options > Link Timeline and Edit 

Selection.

4 À l'aide du Sélecteur, sélectionnez la plage de la 
boucle sur la piste. Pour connaître d'autres 
méthodes de définition de la plage 
d'enregistrement, reportez-vous à la section 
« Configuration des points de punch et de 
boucle » à la page 463.

5 Pour entendre le contenu de la piste jusqu'au 
point d'entrée de la boucle, activez le pré-roll et 
configurez sa durée (reportez-vous à la section 
« Configuration des durées de pré-roll et post-
roll » à la page 466).

6 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

7 Cliquez sur Play pour lancer l'enregistrement.

Le bouton Record clignote pendant le pré-roll. 
Lorsque le point de début est atteint, Pro Tools 
commence l'enregistrement. Une fois le point 
de fin atteint, Pro Tools retourne au point de début 
et poursuit l'enregistrement.

8 Pour annuler toutes les prises enregistrées 
en boucle, appuyez sur Commande+Point 
(.) (Mac) ou Ctrl+Point (.) (Windows).

9 Une fois terminé, cliquez sur le bouton Stop 
pour arrêter l'enregistrement.

Si vous arrêtez l'enregistrement avant d'avoir atteint 
le milieu de la boucle, Pro Tools annule la dernière 
prise. Si vous enregistrez sur plus de la moitié de la 
boucle, Pro Tools laisse la prise sur la piste lorsque 
vous arrêtez l'enregistrement.

Les prises enregistrées apparaissent sous forme de 
clips dans la liste des clips et sont numérotées de 
façon séquentielle. La dernière prise enregistrée 
apparaît dans la playlist active sur la piste. 

Pour plus de détails sur l'écoute de plusieurs prises, 
reportez-vous à la section « Sélection de prises 
alternatives » à la page 474.

Lecture en boucle et enregistrement 
audio

Pro Tools ignore les boucles de lecture lors 
de l'enregistrement. La seule manière de définir 
une boucle pendant l'enregistrement est d'activer le 
mode d'enregistrement en boucle.

Création automatique 
de nouvelles playlists lors 
de l'enregistrement en boucle
Lors d'un enregistrement en boucle, Pro Tools crée 
un fichier unique contenant toutes les passes 
d'enregistrement (chaque passe correspond à un clip 
dans le fichier). Sur la piste, seule la dernière passe 
d'enregistrement apparaît en tant que clip sur la 
playlist principale. Tous les autres clips (c'est-à-
dire les autres passes d'enregistrement) sont 
masqués, et peuvent uniquement être sélectionnés 
comme clips (prises) alternatifs correspondants. 
Lorsque l'option Automatically Create New 

Playlists When Loop Recording est activée dans la 
page des préférences de fonctionnement, chaque 
clip (prise) est copié automatiquement dans une 
nouvelle playlist de la piste. Cela facilite 
l'utilisation de la vue Playlists pour l'écoute et la 
sélection de prises alternatives.

Pour créer automatiquement des playlists lors 
d'un enregistrement en boucle :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Dans la section Recording, activez l'option 
Automatically Create New Playlists When Loop 

Recording.
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Prises alternatives
Lors d'un enregistrement en punch-in/out ou en 
boucle, Pro Tools crée des prises alternatives 
correspondantes (clips). Pro Tools permet de 
remplacer des clips de la playlist principale d'une 
piste par des clips alternatifs correspondants, qui 
proviennent d'autres playlists associées à la même 
piste, d'autres pistes ou de la liste des clips. Les 
clips alternatifs correspondants sont des clips 
répondant à certains critères. Il s'agit par exemple 
des clips dont le marqueur temporel utilisateur est 
identique (reportez-vous à la section 
« Correspondance des clips alternatifs » 
à la page 657).

Sélection de prises alternatives
Après avoir enregistré plusieurs prises, en boucle ou 
en punch-in/out, vous pouvez remplacer la prise 
actuelle de la playlist piste active par l'une des prises 
précédentes. Toutes les prises sont numérotées de 
façon séquentielle. 

Sélection de pistes alternatives dans 
la liste des clips

Pour sélectionner une prise dans la liste des clips :

1 Dans la fenêtre Edit, sélectionnez le clip (prise) 
en cours à l'aide de l'outil de saisie du temps.

2 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez dans la liste des 
clips sur différents clips à écouter.

3 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et faites glisser le clip de 
votre choix de la liste des clips vers la playlist.

Le clip remplace la prise précédente et se 
positionne précisément à l'endroit correct.

Sélection de prises alternatives sur 
une piste

Chaque clip résultant d'une passe d'enregistrement en 
punch-in/out ou en boucle est caractérisé par une 
heure de début identique (le marqueur temporel 
utilisateur). Vous pouvez sélectionner et écouter 
des prises alternatives à partir du sous-menu des 
prises correspondantes ou du menu des prises 
alternatives, et ce même en cours de lecture. 

Pour sélectionner une prise alternative :

1 Assurez-vous que l'option Track ID (ou Track 
Name) est sélectionnée, ainsi que l'option Clip 
Start dans la fenêtre Matching Criteria 
(reportez-vous à la section « Fenêtre Matching 
Criteria » à la page 476).

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip avec 
le Sélecteur ou la Main, puis sélectionnez 
une prise correspondant aux critères dans 
le sous-menu des prises correspondantes.

Sous-menu contextuel des prises correspondantes
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• Si la prise se trouvant sur la piste est 
sélectionnée, maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez 
n'importe où sur la prise avec le Sélecteur. 
Sélectionnez ensuite une prise différente dans le 
menu des prises alternatives.

• Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez avec 
le Sélecteur sur le début de la plage 
d'enregistrement en boucle ou en punch-in/ out. 
Sélectionnez ensuite une prise différente dans le 
menu des prises alternatives.

Le clip (prise) alternatif correspondant sélectionné 
remplace le clip dans la playlist principale et se 
positionne précisément au bon emplacement.

Pour vous assurer que les prises suivantes utilisent 
le même marqueur temporel utilisateur (et sont 
donc disponibles en tant que clips alternatifs 
correspondants), mémorisez les sélections 
d'enregistrement en boucle ou en punch-in/out 
avec des emplacements mémoire. Si vous devez 
enregistrer d'autres prises par la suite, il vous suffit 
de rappeler l'emplacement mémoire 
correspondant. 

Pour changer le marqueur temporel utilisateur 
d'autres clips afin qu'ils soient disponibles en tant 
que clips alternatifs correspondants pour un 
emplacement précis, utilisez la commande Time 

Stamp du menu de la liste des clips. 

Correspondances et pistes 
multiples
Si vous avez effectué des enregistrements 
en boucle sur plusieurs pistes et si chacune 
contient plusieurs prises avec des marqueurs 
temporels utilisateur identiques, vous pouvez 
modifier toutes les prises simultanément.

Pour modifier les prises de plusieurs pistes :

1 Configurez la fenêtre Matching Criteria 
(reportez-vous à la section « Fenêtre Matching 
Criteria » à la page 476) afin que les options 
suivantes soient sélectionnées :

• Track Name 

• Selection Range

2 À l'aide du Sélecteur, sélectionnez la plage de la 
prise de chaque piste à remplacer.

3 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur la sélection d'édition 
et sélectionnez une prise alternative 
correspondante différente à partir du sous-menu 
des prises correspondantes.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur 
la sélection d'édition, puis sélectionnez une prise 
différente à partir du menu des 
prises alternatives.

La prise sélectionnée remplace la prise précédente 
et se positionne à l'emplacement correct sur chaque 
piste.

Menu des prises alternatives
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Fenêtre Matching Criteria
La fenêtre Matching Criteria permet de 
sélectionner les critères des clips alternatifs 
correspondants. Ces critères permettent d'affiner la 
liste des clips correspondants disponibles dans les 
menus des prises alternatives et des prises 
correspondantes.

Options de la section Alternates Match

Vous pouvez sélectionner les options Alternates 
Match suivantes (toutes les combinaisons 
sont possibles) :

Track ID : tous les clips enregistrés sur la même 
piste sont considérés comme des clips 
correspondants. Utilisez cette option pour 
sélectionner des prises alternatives créées suite à 
un enregistrement en boucle ou en punch-in/out.

Track Name : tous les clips partageant le même 
nom racine avec la piste ou la playlist sont 
considérés comme des clips correspondants. 
Par exemple, les pistes correspondantes pour une 
piste nommée Gtr.L indiquent les clips Gtr.L_01 et 
Gtr.L_02-01, mais pas Guit.L_01. 

Clip Rating : tous les clips ayant le même 
classement sont considérés comme des clips 
correspondants. Activez cette option si vous avez 
attribué un classement aux clips (reportez-vous à la 
section « Notation des clips » à la page 623). 

Options de la section In Addition To

Les options In Addition To suivantes sont 
mutuellement exclusives.

All : tout clip qui inclut l'emplacement temporel du 
curseur d'édition, ou tout clip situé partiellement 
ou entièrement dans la plage temporelle actuelle de 
la sélection d'édition.

Clip Start : tout clip dont l'heure de début 
correspond à l'emplacement temporel du curseur 
d'édition ou de la sélection d'édition.

Clip Start and End : tout clip ayant les mêmes 
heures de début et de fin que la sélection d'édition.

Within Selection : tout clip entièrement inclus 
dans la sélection d'édition.

None : aucun autre critère de filtre des clips 
alternatifs correspondants n'est utilisé en plus des 
options Alternates Match sélectionnées.

Développement de prises 
alternatives sur de nouvelles 
playlists ou pistes
Pro Tools permet de copier des prises alternatives 
sur de nouvelles playlists ou pistes. Cela est 
particulièrement utile pour l'écoute, l'édition et le 
mixage de plusieurs prises ou canaux alternatifs. 
Les prises alternatives sont créées suite à un 
enregistrement en punch-in/out ou en boucle.

Fenêtre Matching Criteria

Les critères de correspondance s'appliquent 
aux clips MIDI et audio.
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Développement de prises alternatives 
sur de nouvelles playlists

Le développement de prises alternatives sur de 
nouvelles playlists facilite la création de pistes 
composites. Une fois que vous avez développé les 
prises alternatives sur de nouvelles playlists de 
piste, vous pouvez les écouter et les éditer en vue 
Playlists afin d'assembler les meilleures prises 
dans la playlist principale.

Pour développer des prises alternatives sur 
de nouvelles playlists :

1 Identifiez le clip de la playlist principale 
contenant des clips (prises) alternatifs 
correspondants. 

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip et sélectionnez 
Matches > Expand Alternates To New Playlists.

• Si le clip est sélectionné, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
et cliquez avec le Sélecteur sur le clip 
sélectionné, puis choisissez Matches > Expand 

Alternates To New Playlists.

• Si le clip n'est pas sélectionné, maintenez la 
touche Commande (Mac) ou Ctrl (Windows) 
enfoncée et cliquez avec le Sélecteur sur le début 
exact de la plage d'enregistrement en boucle ou 
en punch-in/out, puis sélectionnez Matches > 

Expand Alternates To New Playlists.

Tous les clips alternatifs correspondants sont 
développés sur de nouvelles playlists de piste. 
Pour afficher toutes les playlists de la piste, 
sélectionnez la vue Playlists. Quelle que soit la vue de 
piste sélectionnée, vous pouvez également 
sélectionner n'importe quelle playlist alternative 
disponible et la définir comme playlist principale à 
partir du sélecteur de playlist. Pour plus 
d'informations, reportez-vous à la section « Vue 
Playlists » à la page 651.

Développement de prises alternatives 
sur de nouvelles pistes

Le développement de prises alternatives sur de 
nouvelles pistes facilite l'écoute, l'édition et le 
mixage des prises alternatives de chaque piste.

Pour développer des prises alternatives sur 
de nouvelles pistes :

1 Identifiez le clip de la playlist principale 
contenant des clips (prises) alternatifs 
correspondants. 

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip et sélectionnez 
Matches > Expand Alternates To New Tracks.

• Si le clip est sélectionné, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
et cliquez avec le Sélecteur sur le clip 
sélectionné, puis choisissez Matches > Expand 

Alternates To New Tracks.

• Si le clip n'est pas sélectionné, maintenez la 
touche Commande (Mac) ou Ctrl (Windows) 
enfoncée et cliquez avec le Sélecteur sur le début 
exact de la plage d'enregistrement en boucle ou 
en punch-in/out, puis sélectionnez Matches > 

Expand Alternates To New Tracks.

3 Sélectionnez l'une des options suivantes dans le 
sous-menu Expand Alternates To New Tracks :

By Track Name : nomme toutes les nouvelles 
pistes en fonction du nom de la piste source.

By Clip Name : nomme toutes les nouvelles pistes 
en fonction du nom du clip d'origine 
correspondant, tel qu'il apparaît dans la liste des 
correspondances.

By Track and Clip Name : nomme toutes les 
nouvelles pistes en fonction du nom de la piste 
source. Le nom de la région d'origine 
correspondante apparaît entre parenthèses.

Tous les clips alternatifs correspondants sont 
copiés sur de nouvelles pistes.
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Enregistrement à partir d'une 
source numérique
Si vous envisagez d'utiliser la sortie numérique 
d'un lecteur DAT, d'un enregistreur de CD 
ou de tout autre appareil numérique avec votre 
système Pro Tools, assurez-vous qu'il prend 
en charge le format numérique adapté. Par 
exemple, les entrées et sorties AES/EBU de votre 
interface audio Pro Tools doivent uniquement être 
connectées à un périphérique AES/EBU.

Formats numériques des 
interfaces audio Avid HD
Les interfaces HD I/O et HD OMNI prennent 
en charge les formats numériques AES/EBU, 
S/PDIF et ADAT. De plus, les interfaces HD I/O 
avec une carte d'extension numérique incluent des 
connecteurs d'E/S numériques TDIF.

L'interface HD MADI comporte des E/S MADI 
optiques et coaxiales (pour plus d'informations, 
reportez-vous au Guide HD MADI). 

Avec les interfaces HD I/O et HD OMNI, 
Pro Tools peut recevoir de l'audio numérique à 
partir des E/S optiques (ADAT) d'origine (si elles 
ne sont pas en mode S/PDIF). Cependant, 
Pro Tools peut recevoir de l'audio numérique 
uniquement depuis l'une des sources numériques 
[Encl] sur châssis (AES/EBU, Optical (S/PDIF) ou 
S/PDIF).

Les sources numériques sur châssis sont installées 
d'origine sur les interfaces audio Avid HD et sont 
identifiées à l'écran par la mention [Encl], afin de 
pouvoir les différencier des entrées et sorties 
numériques de la carte numérique installée dans 
une HD I/O. C'est le cas, par exemple, des entrées 
et sorties AES/EBU incluses dans toutes les 
interfaces HD I/O (identifiées AES/EBU [Encl]).

Les ports numériques supplémentaires de la 
HD I/O sont les suivants : TDIF, AES/EBU et 
ADAT. Pro Tools ne peut recevoir des données 
audionumériques qu'à partir de l'un de ces ports à 
la fois.

Les entrées du châssis et de la carte numérique de 
la HD I/O peuvent être utilisées simultanément. Sur 
une HD I/O par exemple, il est possible d'envoyer 
une source à partir de l'une des entrées sur châssis 
et d'utiliser une autre entrée numérique provenant 
des ports numériques pour appliquer une 
conversion de la fréquence d'échantillonnage, 
et ainsi de disposer de deux sources numériques.

Formats numériques des 
interfaces audio Pro Tools
Les 003, 003 Rack et 003 Rack+ incluent des E/S 
numériques S/PDIF et ADAT. 

Eleven Rack dispose d'E/S numériques S/PDIF 
et AES/EBU.

Les Mbox (3e génération), Mbox 2, Mbox Pro 
et Mbox Pro 2 ne gèrent que le format numérique 
S/PDIF.

Toutes les sorties numériques sont actives 
en permanence. Vous pouvez ainsi envoyer 
simultanément des données audionumériques vers 
plusieurs périphériques numériques. 

Pour plus d'informations sur la configuration 
de votre système Pro Tools pour 
l'enregistrement à partir d'une source 
numérique, reportez-vous à votre Guide 
de l'utilisateur.
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Enregistrement à partir 
de sources numériques

Pour enregistrer à partir d'une source numérique 
dans Pro Tools :

1 Connectez la sortie numérique de votre source 
d'enregistrement à l'entrée appropriée de votre 
matériel audio.

2 Si vous souhaitez créer une nouvelle session 
avec une fréquence d'échantillonnage 
différente, procédez comme suit :

• Sélectionnez File > New Session.

• Sélectionnez la fréquence d'échantillonnage.

• Configurez les autres options de la boîte 
de dialogue New Session en conséquence.

• Cliquez sur Save.

3 Spécifiez le format (numérique) des entrées de 
l'interface audio à laquelle la source 
d'enregistrement numérique est connectée : 

• Sélectionnez Setup > Hardware.

• Sélectionnez l'interface audio.

• Sélectionnez le format numérique pour la paire 
de canaux appropriée (AES/EBU ou S/PDIF, par 
exemple). 

4 Pour Pro Tools|HD, sélectionnez l'option Clock 

Source appropriée dans la fenêtre Session Setup 
ou dans la boîte de dialogue Hardware Setup.

5 Créez une piste audio stéréo.

6 Assignez les sélecteurs de chemin d'entrée de la 
piste à l'entrée appropriée. Puisqu'il s'agit d'un 
transfert numérique, vous n'avez pas à vous 
soucier des niveaux d'entrée.

7 Assignez le sélecteur de chemin de sortie de la 
piste à la sortie appropriée pour le monitoring 
(A 1-2, par exemple). 

8 Dans le menu Options, assurez-vous que les 
options suivantes sont désélectionnées : 
Destructive Record, Loop Record, QuickPunch, 
TrackPunch et DestructivePunch.

9 Dans la fenêtre de transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commence au début de la 
session.

10 Activez la nouvelle piste audio pour 
l'enregistrement.

11 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

12 Cliquez sur Play pour lancer l'enregistrement.

13 Lancez la lecture sur la source d'enregistrement.

14 Lorsque la lecture de l'audio source est 
terminée, cliquez sur Stop dans la fenêtre 
de transport.

15 Arrêtez la lecture sur la source 
d'enregistrement.

Certaines interfaces audio Pro Tools 
ne disposent que de deux canaux pouvant être 
configurés en mode analogique ou numérique. 
La Mbox (3e génération) par exemple dispose 
d'entrées numériques S/PDIF L–R (stéréo) et 
d'entrées analogiques In 1-2. La Mbox 
(3e génération) peut enregistrer 
simultanément à partir des entrées 
analogiques et numériques. 
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Après un transfert numérique
(Systèmes Avid HDX et HD Native uniquement)

Après avoir terminé un enregistrement numérique, 
cliquez sur le menu Clock Source de la fenêtre 
Session Setup et rétablissez l'option Internal. Cette 
action permet à Pro Tools de revenir à son horloge 
interne pour pouvoir enregistrer et lire 
correctement les données audio. Le non 
rétablissement de la synchronisation interne 
entraîne en général des problèmes de hauteur 
(lecture trop rapide ou trop lente), des clics et 
autres parasites ou des erreurs AAE, car un 
enregistreur DAT ou de CD inactif peut revenir 
à une fréquence d'échantillonnage par défaut 
différente ou cesser d'envoyer un signal d'horloge.

Enregistrement à mi-vitesse
Pro Tools permet de lire et d'enregistrer à 
mi-vitesse. Cette fonction, similaire à celle d'un 
magnétophone, permet d'enregistrer des éléments 
à mi-vitesse puis de les lire à vitesse normale (plus 
vite et une octave plus haut) ou d'enregistrer à 
vitesse normale puis de lire à mi-vitesse 
(plus lentement et une octave plus bas) 
pour réaliser des effets spéciaux.

Utilisez l'enregistrement à mi-vitesse pour 
enregistrer des pistes MIDI difficiles à jouer, 
ou des mouvements d'automation complexes. 

Pour enregistrer à mi-vitesse :

1 Activez pour l'enregistrement les pistes 
sur lesquelles vous souhaitez enregistrer à mi-
vitesse.

2 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

3 Appuyez sur Ctrl+Maj+Barre d'espace 
(Windows) ou Commande+Maj+Barre d'espace 
(Mac). L'enregistrement commence et la lecture 
de toutes les données existantes s'effectue à mi-
vitesse.

4 À la fin de l'enregistrement, cliquez sur 
le bouton Stop.

Pour plus d'informations sur la lecture à mi-
vitesse, reportez-vous à la section « Mode de 
lecture à mi-vitesse » à la page 425.
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Chapitre 22 : Enregistrement MIDI

Bien que l'enregistrement MIDI dans Pro Tools 
soit similaire à l'enregistrement audio, il existe 
quelques différences importantes :

 Contrairement à l'enregistrement audio, 
l'enregistrement MIDI est presque toujours 
destructif. Reportez-vous à la section « Modes 
d'enregistrement et MIDI » à la page 444 pour 
plus de détails.

 Contrairement aux pistes audio, les pistes MIDI 
et d'instrument peuvent être activées 
pour l'enregistrement en cours de lecture 
ou d'enregistrement.

 Un sélecteur d'entrée est présent sur les pistes 
MIDI et d'instrument afin de déterminer quel port de 
votre interface MIDI (périphérique) et quel canal 
MIDI sont routés et enregistrés sur la piste. Si le 
sélecteur d'entrée MIDI est réglé sur All, tous les 
canaux de tous les périphériques sont routés sur la 
piste. 

 À l'instar des pistes d'entrée auxiliaire, les pistes 
d'instrument possèdent des sélecteurs d'entrée et 
sortie audio. Ces sélecteurs sont différents des 
sélecteurs d'entrée et sortie MIDI des pistes 
d'instrument et sont principalement utilisés pour le 
monitoring audio des instruments ou plug-ins 
d'instrument MIDI. 

 Il n'est pas nécessaire d'activer le mode 
QuickPunch, TrackPunch ou DestructivePunch 
pour enregistrer en punch-in/out sur des pistes MIDI 
ou d'instrument. Cette possibilité existe dans le 
mode d'enregistrement normal non destructif et 
dans le mode d'enregistrement destructif.

Enregistrement à partir de 
périphériques MIDI
Les entrées MIDI des pistes MIDI et d'instrument 
activées pour l'enregistrement déterminent les 
données MIDI qui seront enregistrées dans 
Pro Tools. Les entrées MIDI peuvent être définies 
sur un périphérique (port) ou un canal donné, ou sur 
All pour que les données provenant de tous les 
périphériques soient fusionnées sur la piste.

Les pistes MIDI et d'instrument de Pro Tools 
ne peuvent contenir plusieurs canaux et sont 
toujours lues via le périphérique et le canal de sortie 
MIDI assignés à la piste. Il est possible d'enregistrer 
simultanément plusieurs périphériques et canaux 
MIDI sur plusieurs pistes.

Les options suivantes de Pro Tools déterminent les 
modalités d'enregistrement à partir d'un contrôleur 
MIDI (clavier ou pad de batterie MIDI par 
exemple) :

 Les périphériques définis en tant que 
contrôleurs MIDI dans la boîte de dialogue 
Peripherals (Setup > Peripherals) sont ignorés lors 
de l'enregistrement de pistes MIDI. Cela évite 
l'enregistrement de données provenant de surfaces 
de contrôle MIDI telles qu'une Command|8.

 Pour enregistrer et lire des pistes MIDI, 
le périphérique doit être activé dans la boîte 
de dialogue MIDI Input Enable. Pour plus 
d'informations, reportez-vous à la section 
« Activation de périphériques d'entrée » 
à la page 482.
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En outre, les options suivantes ont une incidence sur 
la façon dont les données MIDI sont enregistrées 
dans Pro Tools :

 Le filtre d'entrée MIDI peut filtrer les messages 
MIDI que vous ne souhaitez pas enregistrer, tels 
que des données d'aftertouch polyphonique ou 
System Exclusive. Pour plus d'informations, 
reportez-vous à la section « Filtre d'entrée MIDI » 
à la page 484.

 Lorsqu'elle est activée, la quantification 
en entrée corrige automatiquement la position 
temporelles des notes MIDI enregistrées. 
Pour plus d'informations, reportez-vous 
à la section « Quantification en entrée » 
à la page 484.

Activation de périphériques 
d'entrée
Pour enregistrer à partir d'un périphérique MIDI 
(un clavier MIDI, par exemple) dans Pro Tools, 
le périphérique doit être activé dans la boîte 
de dialogue MIDI Input Enable. Cette boîte 
de dialogue permet de s'assurer que les notes 
indésirables provenant de certains périphériques, 
tels que les boîtes à rythmes ou les arpégiateurs, ne 
sont pas enregistrées.

Surfaces de contrôle MIDI : pour utiliser une 
surface de contrôle MIDI (telle qu'une Command|8), 
elle doit être activée dans la boîte de dialogue 
MIDI Input Enable.

MMC : pour synchroniser Pro Tools avec le MMC 
(MIDI Machine Control), la source MMC doit être 
activée dans la boîte de dialogue MIDI Input 
Enable. Pour plus d'informations sur l'utilisation 
du MMC avec Pro Tools, reportez-vous à la 
section « Utilisation du MIDI Machine Control » 
à la page 1207.

Pour activer des périphériques d'entrée :

1 Sélectionnez Setup > MIDI > Input Devices.

2 Sélectionnez les périphériques MIDI 
à enregistrer. Sélectionnez également les 
périphériques à utiliser en tant que surface de 
contrôle.

3 Désélectionnez tous les périphériques d'entrée 
que vous souhaitez ignorer pendant 
l'enregistrement MIDI.

4 Cliquez sur OK.

Boîte de dialogue MIDI Input Enable

Il n'est pas nécessaire de sélectionner les 
périphériques pour que ceux-ci reçoivent des 
données MIDI de Pro Tools. Il est par 
exemple inutile de sélectionner dans la boîte 
de dialogue MIDI Input Enable 
un périphérique utilisé exclusivement comme 
expandeur.
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MIDI Thru
Afin d'assurer le monitoring des pistes MIDI 
en cours d'enregistrement, activez le MIDI Thru. 
Lorsqu'il est activé, Pro Tools route les données 
MIDI provenant des contrôleurs vers le 
périphérique et les canaux assignés à la piste MIDI 
actuellement activée pour l'enregistrement.

Pour activer le MIDI Thru :

 Sélectionnez Options > MIDI Thru.

Instrument Thru par défaut
En plus des pistes MIDI activées pour 
l'enregistrement, vous pouvez également router 
des données MIDI vers l'instrument Thru par 
défaut. Cela vous évite de créer une piste MIDI 
et de l'activer pour l'enregistrement afin d'entendre 
un périphérique et un canal MIDI spécifiques.

Contrairement aux pistes MIDI, qui ne reçoivent 
que les données MIDI du périphérique et du canal 
assignés à leur sélecteur d'entrée MIDI, toutes les 
données MIDI entrantes sont routées vers 
l'instrument Thru par défaut.

Si l'instrument Thru par défaut est assigné à une 
piste MIDI activée pour l'enregistrement, 
Pro Tools route uniquement les données MIDI 
entrantes vers cette piste.

Pour configurer un instrument Thru par défaut :

1 Sélectionnez Setup > Preferences. 

2 Cliquez sur l'onglet MIDI. 

3 Effectuez l'une des opérations suivantes :

• Sélectionnez un périphérique spécifique dans le 
menu Default Thru Instrument pour lire les 
données MIDI sur ce périphérique par défaut. 

• Sélectionnez Follows First Selected MIDI Track 
pour que l'assignation d'aperçu MIDI suive 
la sélection de piste MIDI. Lorsque plusieurs 
pistes MIDI sont sélectionnées, l'aperçu utilise 
la piste MIDI la plus haute dans la fenêtre Edit 
ou la piste MIDI la plus à gauche dans la fenêtre 
Mix. 

• Pour désactiver l'instrument Thru par défaut, 
sélectionnez None.

L'option Global MIDI Playback Offset des 
préférences MIDI et les offsets individuels des 
pistes MIDI n'affectent pas les données MIDI 
routées via MIDI Thru.

Lorsque le MIDI Thru est activé, les événements 
System Exclusive (Sysex) sont renvoyés vers le 
périphérique MIDI assigné à la piste activée 
pour l'enregistrement (si leur taille est 
inférieure à 256 octets).

Lorsque vous utilisez le MIDI Thru, il est 
préférable de désactiver le contrôle local sur 
vos périphériques, le cas échéant. S'il reste 
activé, votre périphérique MIDI risque 
de recevoir des notes MIDI en double, ce qui 
peut causer divers problèmes. Si vous ne savez 
pas comment désactiver le contrôle local de 
votre instrument, consultez la documentation 
de son fabricant.

L'option Default Thru Follows First Selected 
MIDI Track Selection permet également 
d'entendre un instrument sans avoir à créer 
ou activer pour l'enregistrement une piste 
MIDI ou d'instrument.
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Filtre d'entrée MIDI
Le filtre d'entrée MIDI permet d'exclure certains 
types de messages MIDI de vos enregistrements. 
Le filtre d'entrée MIDI peut être configuré pour 
enregistrer tous les messages (All), seulement les 
messages spécifiés (Only) ou tous les messages 
sauf ceux spécifiés (All except).

Par exemple, pour exclure les messages 
de changement de programme :

1 Sélectionnez Setup > MIDI > Input Filter.

2 Dans la boîte de dialogue MIDI Input Filter, 
sélectionnez l'option All Except.

3 Sélectionnez l'option Program Changes. 
Ne cochez pas les autres cases d'option.

4 Cliquez sur OK.

Lorsque vous utilisez l'option All Except, les types 
de messages MIDI sélectionnés ne sont pas 
enregistrés. Inversement, lorsque vous utilisez 
l'option Only, seuls les messages MIDI 
sélectionnés sont enregistrés.

Quantification en entrée
Lorsque l'option Input Quantize est activée dans la 
boîte de dialogue Input Quantize Event Operations 
(Event > Event Operations > Input Quantize), 
toutes les notes MIDI enregistrées sont 
automatiquement quantifiées. La quantification en 
entrée du MIDI aide à la mise en place des données 
MIDI enregistrées. Désactivez cette option si vous 
souhaitez préserver le feeling original de vos pistes 
MIDI (un phrasé rubato, par exemple).

Wait for Note
Le bouton Wait for Note de la fenêtre de transport 
détermine de quelle manière Pro Tools commence 
l'enregistrement. Lorsque ce mode est activé, 
Pro Tools ne démarre l'enregistrement qu'à 
la réception d'un événement MIDI. Cela permet 
de s'assurer que l'enregistrement ne commence 
qu'à la première note de l'instrument et que les 
données correspondantes, MIDI ou non, 
sont enregistrées précisément au début de la plage 
d'enregistrement définie (heure de début).

Le mode Wait for Note peut être utilisé pour 
l'enregistrement normal, à la volée ou en boucle. Si 
un pré-roll est activé, il intervient après réception de 
l'événement MIDI et avant le début 
de l'enregistrement.Boîte de dialogue MIDI Input Filter

Pour plus d'informations sur la quantification 
en entrée, reportez-vous à la section 
« Commande Input Quantize » à la page 963. 

Les boutons Wait for Note et Countoff 
s'excluent mutuellement et ne peuvent être 
activés simultanément. Par exemple, si vous 
activez le décompte et cliquez sur le bouton 
Wait for Note, le décompte est désactivé. 
En outre, le bouton Wait for Note permet de 
démarrer immédiatement l'enregistrement, en 
ignorant tout pré-roll spécifié.
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Pour activer le mode Wait for Note :

1 Pour afficher les commandes MIDI dans 
la fenêtre de transport, sélectionnez View > 

Transport > MIDI Controls.

2 Dans la fenêtre de transport, cliquez sur 
le bouton Wait for Note pour le mettre 
en surbrillance.

Fusion/remplacement MIDI
Le bouton MIDI Merge de la fenêtre de transport 
détermine le mode d'enregistrement MIDI en 
overdub ou en punch-in. Lorsque le bouton MIDI 
Merge est activé (mode fusion), les données MIDI 
enregistrées sont fusionnées avec les données déjà 
présentes sur la piste. Lorsque le bouton MIDI 
Merge est désactivé (mode remplacement), les 
données qui se trouvaient dans le clip enregistré 
sont remplacées par les nouvelles.

Le bouton MIDI Merge peut être activé et désactivé 
en cours de lecture ou d'enregistrement. En mode 
d'enregistrement en boucle, le bouton MIDI Merge 
n'a aucun effet et est estompé.

Pour activer le mode de fusion MIDI :

1 Pour afficher les commandes MIDI dans 
la fenêtre de transport, sélectionnez View > 

Transport > MIDI Controls.

2 Dans la fenêtre de transport, cliquez sur 
le bouton MIDI Merge pour le mettre 
en surbrillance.

Fenêtre de transport avec commandes MIDI

Bouton Wait for Note activé

Lorsque l'option Use F11 for Wait for Note des 
préférences de fonctionnement est 
sélectionnée, vous pouvez appuyer sur 
la touche F11 pour activer le mode Wait for 
Note (sur les systèmes Mac, le raccourci 
clavier d'accès au bureau doit être désactivé 
ou réassigné).

Pour activer le mode de fusion MIDI par 
un raccourci clavier, passez en mode de pavé 
numérique Transport et appuyez sur 
la touche 9 du pavé numérique. 

Vous pouvez également coller et fusionner des 
notes MIDI à l'aide de la fonction de collage 
spécial. Reportez-vous à la section « Fonction 
Special Paste pour les données d'automation » 
à la page 1102.

Bouton de fusion MIDI activé



Guide de référence Pro Tools486

Configuration des pistes 
MIDI ou d'instrument pour 
l'enregistrement
Pour configurer une ou plusieurs pistes MIDI 
ou d'instrument pour l'enregistrement :

1 Utilisez une piste MIDI ou d'instrument 
existante ou créez-en une.

2 Pour les pistes d'instrument, sélectionnez View 

> Mix Window > Instruments ou View > Edit 

Window > Instruments.

3 À partir du sélecteur d'entrée MIDI de la piste, 
sélectionnez le périphérique et le canal 
à enregistrer (pour les pistes d'instrument, 
le sélecteur d'entrée MIDI est disponible dans la 
vue Instruments).

4 À partir du sélecteur de sortie MIDI, sélectionnez 
le périphérique et le canal de lecture MIDI.

5 Pour assigner plusieurs destinations à une 
même piste MIDI ou d'instrument, cliquez sur 
le sélecteur de sortie MIDI tout en maintenant 
la touche Ctrl (Mac) ou Démarrer (Windows) 
enfoncée, puis sélectionnez des canaux 
supplémentaires de n'importe quel 
périphérique. Lorsque plusieurs destinations 
sont sélectionnées pour une seule piste MIDI, 
un signe plus (+) est affiché à côté du nom de la 
première destination sur son sélecteur de sortie 
MIDI.

Sélecteur d'entrée d'une piste MIDI

Sélecteur d'entrée MIDI d'une piste d'instrument

Sélecteur de sortie d'une piste MIDI

Sélecteur d'entrée MIDI d'une piste d'instrument
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6 Pour assigner à la piste un changement 
de programme par défaut, effectuez l'une 
des opérations suivantes :

• Cliquez sur le bouton de sélection des patchs.

• Effectuez vos sélections de programme 
et de banque.

• Cliquez sur Done.

7 Si vous enregistrez sur plusieurs pistes 
MIDI ou d'instrument, répétez les étapes 
précédentes pour chaque piste, puis passez 
à l'étape suivante.

8 Si vous souhaitez utiliser un clic, activez et 
configurez-le, puis définissez le tempo et la 
métrique par défaut de la session (reportez-vous 
à la section « Enregistrement avec un clic » 
à la page 436).

9 Activez au choix le mode Wait for Note ou le 
décompte à partir de la fenêtre de transport. 

10 Pour remplacer les données existantes de la 
piste, désactivez le mode de fusion MIDI dans 
la fenêtre de transport (reportez-vous 
à la section « Fusion/remplacement MIDI » 
à la page 485).

11 Pour activer la quantification automatique des 
données enregistrées, sélectionnez l'option Input 
Quantize (Event > Event Operations > Input 
Quantize). Reportez-vous à la section 
« Quantification en entrée » à la page 484.

12 Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commence à partir du début de 
la session.

13 Activez la piste MIDI ou d'instrument pour 
l'enregistrement en cliquant sur son bouton 
d'activation pour l'enregistrement.

14 Assurez-vous que l'option Options > MIDI Thru 
est activée, puis commencez à jouer sur votre 
contrôleur MIDI. Le périphérique ou le plug-in 
d'instrument MIDI assigné à la sortie MIDI de 
la piste doit émettre du son et les indicateurs de 
niveau de la piste doivent témoigner d'une 
activité MIDI (vélocité des notes).

Vous êtes maintenant prêt à enregistrer des 
données MIDI sur les pistes MIDI ou d'instrument 
activées pour l'enregistrement.

Les messages de changement de programme 
par défaut sont transmis à chaque lecture de la 
piste. Pour plus d'informations, reportez-vous 
à la section « Sélection de patch (changements 
de programme et de banque) » à la page 715.

Pour activer des pistes supplémentaires pour 
l'enregistrement, maintenez la touche Maj 
enfoncée et cliquez sur leur bouton 
d'activation pour l'enregistrement.

Pour le monitoring audio d'un instrument 
MIDI externe, sélectionnez le chemin d'entrée 
audio correspondant à votre instrument MIDI 
sur la piste d'instrument (ou utilisez une piste 
d'entrée auxiliaire). Reportez-vous à la section 
« Routing du signal pour le monitoring et les 
sous-groupes de mixage » à la page 1013.
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Enregistrement de pistes 
MIDI et d'instrument
Dans Pro Tools, vous pouvez enregistrer sur une 
ou plusieurs pistes MIDI ou d'instrument. 
L'enregistrement simultané sur plusieurs 
pistes permet :

• d'enregistrer simultanément plusieurs musiciens à 
partir de plusieurs périphériques MIDI ;

• d'enregistrer un même périphérique (un clavier 
avec split, par exemple) sur plusieurs canaux ;

• de transférer des pistes MIDI provenant d'un 
séquenceur MIDI externe.

Pour enregistrer sur une ou plusieurs pistes MIDI 
ou d'instrument :

1 Configurez une piste MIDI ou d'instrument pour 
l'enregistrement (reportez-vous à la section 
« Configuration des pistes MIDI ou d'instrument 
pour l'enregistrement » à la page 486).

2 Assurez-vous que la piste sur laquelle 
vous voulez enregistrer est activée 
pour l'enregistrement.

3 Assurez-vous que le mode d'enregistrement 
normal est sélectionné (reportez-vous 
à la section « Modes d'enregistrement » 
à la page 441).

4 Dans la fenêtre de transport, cliquez sur 
le bouton Record pour préparer Pro Tools 
à l'enregistrement. L'indicateur d'état 
d'activation pour l'enregistrement de la piste 
s'allume en rouge.

5 Effectuez l'une des opérations suivantes :

• Cliquez sur Play pour lancer l'enregistrement. Si 
le décompte est activé, Pro Tools décompte le 
nombre de mesures spécifié avant 
de commencer l'enregistrement. 

• Si le mode Wait for Note est activé, ne cliquez pas 
sur le bouton Play ; l'enregistrement commencera 
automatiquement dès la première note (à la 
réception d'un événement MIDI).

6 Jouez sur votre contrôleur MIDI.

7 Lorsque vous avez fini de jouer, cliquez sur 
le bouton Stop de la fenêtre de transport.

Un nouveau clip MIDI est créé et apparaît dans la 
playlist et la liste des clips pour chaque piste 
activée pour l'enregistrement.

Pour tirer pleinement parti des fonctions 
d'édition MIDI de Pro Tools, enregistrez avec 
un clic les pistes MIDI basées sur les 
références de tempo. Les données enregistrées 
seront ainsi alignées sur les mesures et temps de 
la session. Vous pouvez également enregistrer 
sans clic sur des pistes MIDI basées sur les 
échantillons et déterminer le tempo et la 
métrique à partir des notes.

Pour enregistrer de l'audio à partir d'un 
instrument ou d'un plug-in d'instrument MIDI, 
routez la sortie audio de la piste d'instrument, ou 
de la piste d'entrée auxiliaire utilisée pour le 
monitoring de l'instrument, vers une piste 
audio. Activez la piste audio pour 
l'enregistrement et lancez l'enregistrement. 
Reportez-vous à la section « Enregistrement 
audio à partir d'un instrument MIDI » 
à la page 497.

Pour activer des pistes supplémentaires pour 
l'enregistrement, maintenez la touche Maj 
enfoncée et cliquez sur leur bouton 
d'activation pour l'enregistrement.

Bouton Record en mode de préparation pour 
l'enregistrement
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Clips MIDI créés sur les barres 
de mesure
Lors de l'enregistrement ou de la saisie de notes 
MIDI, les limites de début et de fin des clips MIDI 
sont alignées sur les barres de mesure. Les clips 
MIDI peuvent ainsi être réorganisés mesure par 
mesure, en respectant le tempo et la métrique de la 
session.

Le début d'un clip MIDI enregistré commence 
toujours sur la barre de mesure qui précède 
immédiatement la première note MIDI (Note On) 
du clip. De même, le clip MIDI se termine sur 
la barre de mesure qui suit immédiatement 
la dernière note (Note Off) du clip. 

Enregistrement sur des clips 
MIDI existants
Contrairement aux clips audio, les clips MIDI 
existants ne sont jamais écrasés, même si leurs 
données MIDI peuvent l'être. Si le mode de fusion 
MIDI est désactivé lors de l'enregistrement 
de données MIDI sur une piste qui contient déjà 
des clips, les données MIDI enregistrées remplacent 
celles des clips existants. Les limites des clips 
demeurent cependant inchangées. D'autres clips 
MIDI peuvent être créés pour combler les espaces 
vides compris dans les limites d'un clip MIDI 
existant. Comme d'habitude, les nouveaux clips 
MIDI sont toujours alignés sur les barres 
de mesure. Cependant, si des limites de clips 
existants ne sont pas alignées sur des barres 
de mesure, les clips créés seront délimités par les 
clips existants.

Lecture de données MIDI 
enregistrées

Pour lire une piste MIDI ou d'instrument enregistrée :

1 Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

2 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

Les données MIDI enregistrées sont lues via 
chaque canal et périphérique de sortie (port) 
assignés à la piste.

Appuyez sur F12 pour lancer immédiatement 
l'enregistrement. Vous pouvez également 
utiliser la combinaison de touches Ctrl+barre 
d'espace (Windows) ou Commande+barre 
d'espace (Mac). Pour plus d'informations, 
reportez-vous à la section « Raccourcis pour 
l'enregistrement » à la page 462.

La première note peut appartenir à un clip 
MIDI et la dernière note au clip MIDI suivant. 
Il est également possible que la fin du clip 
se trouve avant la fin d'une note, auquel cas la 
fin de la note s'étendra au-delà de la limite du 
clip. Toutefois, la première note ne peut 
jamais précéder le début d'un clip. 

Pour le monitoring audio d'un instrument 
MIDI externe, sélectionnez le chemin d'entrée 
audio correspondant à votre instrument MIDI 
sur la piste d'instrument (ou utilisez une piste 
d'entrée auxiliaire). Reportez-vous à la section 
« Routing du signal pour le monitoring et les 
sous-groupes de mixage » à la page 1013.
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Annulation d'un enregistrement 
MIDI
Vous pouvez annuler des prises MIDI 
précédemment enregistrées.

Pour annuler un enregistrement MIDI :

 Après avoir arrêté l'enregistrement, 
sélectionnez Edit > Undo MIDI Recording. 

La playlist de la piste revient à son état antérieur. 
Toutefois, les conditions suivantes s'appliquent :

• Si vous avez effectué plusieurs punch-ins et outs 
avant d'arrêter le transport, seul le dernier punch 
est annulé.

• En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont 
annulées.

Annulation d'une prise 
d'enregistrement
Il est également possible d'annuler la prise 
en cours avant l'arrêt de l'enregistrement.

Pour annuler une prise en cours d'enregistrement :

 Appuyez sur Commande+Point (.) (Mac) 
ou Ctrl+Point (.) (Windows) avant l'arrêt 
du transport.

En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont annulées.

Enregistrement MIDI 
en punch-in/out sur une plage 
spécifiée
Vous pouvez configurer Pro Tools pour effectuer 
automatiquement un enregistrement en 
punch-in/out sur une plage spécifique d'une piste 
MIDI ou d'instrument. Vous devez spécifier les 
points d'entrée (punch-in) et de sortie (punch-out) 
de la plage avant l'enregistrement.

Pour effectuer un punch-in sur une piste MIDI 
ou d'instrument :

1 Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (reportez-vous 
à la section « Configuration des pistes MIDI ou 
d'instrument pour l'enregistrement » 
à la page 486).

2 Assurez-vous que le mode d'enregistrement 
normal est sélectionné (reportez-vous 
à la section « Modes d'enregistrement » 
à la page 441).

3 Dans la fenêtre de transport, désactivez le mode 
Wait for Note et le décompte.

4 Sélectionnez Options > Link Timeline and Edit 

Selection.

5 À l'aide du Sélecteur, sélectionnez la plage 
de punch-in/out sur la playlist de la piste.

6 Pour entendre le contenu de la piste jusqu'au 
point d'entrée, ou après le point de sortie, 
activez le pré-roll et le post-roll et spécifiez 
leurs durées (reportez-vous à la section 
« Configuration des durées de pré-roll et post-
roll » à la page 466).

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, reportez-
vous à la section « Configuration des points 
de punch et de boucle » à la page 463.
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7 Activez pour l'enregistrement la piste contenant la 
prise précédente.

8 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement. 
Le bouton Record clignote.

9 Cliquez sur Play pour lancer l'enregistrement.

Si le pré-roll est activé, les données se trouvant sur 
la piste sont lues jusqu'au point de punch-in. Vous 
pouvez commencer à jouer pendant le pré-roll 
pour vous « mettre dans le tempo ». 
L'enregistrement MIDI ne commence qu'à partir 
du point d'entrée de l'enregistrement.

Lorsque le point d'entrée est atteint, Pro Tools 
commence l'enregistrement. L'enregistrement 
se poursuit jusqu'au point de sortie. Si le post-roll 
est activé, la lecture se poursuit pendant la durée 
spécifiée.

10 Pour interrompre l'enregistrement, cliquez sur 
le bouton Stop de la fenêtre de transport. Les 
données MIDI enregistrées apparaissent sur la 
piste.

Enregistrement MIDI en 
punch-in/out en cours de lecture
Il n'est pas obligatoire de définir au préalable une 
plage d'enregistrement pour effectuer un punch-in 
sur une piste MIDI ou d'instrument. En réalité, il est 
possible de lancer l'enregistrement et d'en sortir 
à tout moment en cours de lecture. Contrairement 
aux pistes audio, il n'est pas nécessaire d'activer 
le mode d'enregistrement QuickPunch pour 
réaliser un enregistrement en punch-in/out en 
temps réel.

Pour effectuer un punch-in MIDI :

1 Configurez une piste MIDI ou d'instrument pour 
l'enregistrement (reportez-vous à la section 
« Configuration des pistes MIDI ou d'instrument 
pour l'enregistrement » à la page 486).

2 Assurez-vous que le mode d'enregistrement 
normal est sélectionné (reportez-vous 
à la section « Modes d'enregistrement » 
à la page 441).

3 Dans la fenêtre de transport, désactivez le mode 
Wait for Note et le décompte.

4 Activez pour l'enregistrement la piste contenant 
la prise précédente.

5 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport. 

6 Une fois le point de punch-in atteint, effectuez 
l'une des opérations suivantes :

• Cliquez sur le bouton Record de la fenêtre 
de transport.

• Pour les systèmes Pro Tools sur lesquels une 
pédale est connectée, appuyez sur la pédale au 
point de punch-in.

Les pédales sont prises en charge par les 
interfaces de la famille 003, la Mbox Pro et la 
Mbox 2 Pro, ainsi que par tout système 
Pro Tools avec une surface de contrôle prise 
en charge (telle qu'une C|24 ou Command|8).
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Lors de l'enregistrement, le bouton Record de 
la fenêtre de transport et le bouton d'activation 
pour l'enregistrement de la piste cessent 
de clignoter et restent allumés.

7 Pour arrêter l'enregistrement, cliquez 
de nouveau sur le bouton Record (ou appuyez 
sur la pédale).

Pro Tools quitte alors le mode d'enregistrement 
et continue la lecture. Vous pouvez effectuer 
d'autres punch-ins/outs au cours de la même passe.

Clips MIDI et enregistrement 
en punch-in
Selon la plage d'enregistrement, de nouveaux clips 
peuvent être créés à l'issue d'un enregistrement en 
punch-in/out. 

Si le mode de fusion MIDI est désactivé par 
exemple, l'enregistrement remplace toutes les 
données MIDI contenues dans la plage 
d'enregistrement. Lorsque le début et la fin 
d'enregistrement se situent entre deux clips, 
les notes sont enregistrées dans chacune d'eux ainsi 
que dans un nouveau clip créé pour combler l'espace 
entre les deux clips.

Lorsque vous sélectionnez un clip entier ou une 
partie de clip avant l'enregistrement en 
punch-in/out, aucun clip n'est créé. Dans ce cas, 
seules les données se trouvant dans les limites du 
clip existant sont modifiées. Aucune nouvelle 
donnée n'est enregistrée en dehors du clip.

Dans ce cas de figure, contrairement 
à l'enregistrement audio, l'enregistrement MIDI 
est destructif. Les données MIDI nouvellement 
enregistrées remplacent les données MIDI 
existantes du clip, sans modifier ses limites.

Si les données MIDI d'un clip sont modifiées suite 
à une prise d'enregistrement, les données d'origine 
sont soit perdues (sauf si vous sélectionnez Edit > 
Undo MIDI Recording), soit associées aux 
nouvelles données (si le mode de fusion MIDI était 
activé pendant l'enregistrement). Si vous souhaitez 
conserver les données du clip, vous pouvez utiliser 
la commande Duplicate pour copier le clip 
(« Duplication des clips » à la page 871) 
ou la playlist de la piste, ou encore sauvegarder les 
données à conserver dans une nouvelle playlist 
(reportez-vous à la section « Utilisation des 
playlists » à la page 645).

Clip ajouté après un enregistrement en punch-in/out

nouveau clipdonnées nouvellement
enregistrées

Avant l'enregistrement en punch-in/out

Après l'enregistrement en punch-in/out
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Enregistrement MIDI en 
boucle
Il existe deux méthodes d'enregistrement MIDI en 
boucle : 

• En mode normal non destructif, activez les 
modes de lecture en boucle et de fusion MIDI 
pour enregistrer en boucle comme sur une boîte 
à rythmes.

• Utilisez le mode d'enregistrement en boucle 
pour enregistrer plusieurs prises successives à 
chaque passe d'enregistrement. Cette méthode 
est semblable à l'enregistrement audio en 
boucle.

Enregistrement en boucle 
en mode de fusion MIDI
Pour enregistrer du MIDI en boucle, utilisez le 
mode normal non destructif en activant les modes 
de lecture en boucle et de fusion MIDI. Cette 
méthode permet d'enregistrer et de fusionner les 
données MIDI sur un même clip passe après passe 
d'enregistrement. De cette façon, vous pouvez par 
exemple enregistrer un charley lors de la première 
passe, la grosse caisse et la caisse claire lors de la 
deuxième, etc.

Assurez-vous que le mode de fusion MIDI est 
activé dans la fenêtre de transport. Dans le cas 
contraire (mode remplacement), chaque prise 
remplacera la précédente de façon destructive.

Pour enregistrer en boucle en mode de fusion MIDI :

1 Configurez une piste MIDI ou d'instrument pour 
l'enregistrement (reportez-vous à la section 
« Configuration des pistes MIDI ou d'instrument 
pour l'enregistrement » à la page 486).

2 Assurez-vous que le mode d'enregistrement 
normal est sélectionné (reportez-vous 
à la section « Modes d'enregistrement » 
à la page 441).

3 Sélectionnez Options > Loop Playback. Lorsque 
la lecture en boucle est activée, un symbole 
de boucle est affiché sur le bouton Play.

4 Activez la piste MIDI ou d'instrument pour 
l'enregistrement. Vérifiez qu'aucune piste audio 
ne soit activée pour l'enregistrement.

5 Dans la fenêtre de transport, cliquez sur 
le bouton MIDI Merge pour le mettre 
en surbrillance.

6 Désactivez le mode Wait for Note et le décompte à 
partir de la fenêtre de transport.

7 Sélectionnez Options > Link Timeline and 

Edit Selection.

8 À l'aide du Sélecteur, sélectionnez la plage 
d'enregistrement en boucle sur la playlist de la 
piste.

Pour enregistrer comme sur une boîte 
à rythmes, utilisez la saisie pas à pas 
(reportez-vous à la section « Commande Step 
Input » à la page 964).

Vous pouvez activer autre piste MIDI ou 
d'instrument pour l'enregistrement pendant un 
enregistrement en boucle. Maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée et 
appuyez sur les touches Flèche haut et bas afin 
d'activer pour l'enregistrement la piste MIDI 
ou d'instrument précédente ou suivante.

Lecture en boucle activée



Guide de référence Pro Tools494

9 Pour entendre le contenu de la piste jusqu'au 
point d'entrée de la boucle, activez le pré-roll et 
configurez sa durée (reportez-vous à la section 
« Configuration des durées de pré-roll et post-
roll » à la page 466).

10 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement. 
Le bouton Record clignote.

11 Cliquez sur Play pour lancer l'enregistrement.

Le bouton Recors clignote pendant la durée 
du pré-roll. Lorsque le point d'entrée est atteint, 
Pro Tools commence l'enregistrement. Lorsque le 
point de sortie est atteint, Pro Tools retourne au 
point d'entrée et continue la lecture et 
l'enregistrement.

12 Jouez sur votre contrôleur MIDI. Les nouvelles 
données MIDI enregistrées apparaissent dans 
un clip sur la piste d'enregistrement. À chaque 
prise successive, le contenu enregistré apparaît à 
l'intérieur du clip, sans remplacer le contenu des 
prises précédentes.

13 Pour passer à une nouvelle piste, appuyez sur la 
touche Ctrl (Windows) ou Commande (Mac), 
puis sur les touches Flèche haut et bas afin 
d'activer pour l'enregistrement la piste MIDI ou 
d'instrument suivante ou précédente.

14 Pour interrompre l'enregistrement, cliquez sur 
le bouton Stop de la fenêtre de transport.

Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'un clip MIDI dans 
la playlist de la piste et dans la liste des clips.

Enregistrement en boucle 
de plusieurs prises
Lorsque vous enregistrez du MIDI en boucle, 
des clips sont créés chaque fois que de nouvelles 
données sont reçues au cours d'une passe 
d'enregistrement. Cette méthode est différente 
de l'enregistrement audio en boucle, pour lequel 
Pro Tools crée un fichier audio unique comprenant 
toutes les prises. Ces prises apparaissent en tant 
que clips individuels dans la liste des clips.

Cette méthode d'enregistrement MIDI en boucle 
permet d'enregistrer des prises successives sans 
interrompre l'enregistrement, afin de préserver la 
spontanéité du moment. Mais elle présente 
un autre avantage : étant donné son caractère non 
destructif, les clips existants et les clips créés 
demeurent intacts (et sont disponibles dans la liste 
des clips).

Pour enregistrer du MIDI en mode d'enregistrement 
en boucle :

1 Configurez une piste MIDI ou d'instrument pour 
l'enregistrement (reportez-vous à la section 
« Configuration des pistes MIDI ou d'instrument 
pour l'enregistrement » à la page 486).

2 Sélectionnez Options > Loop Record. Lorsque 
le mode d'enregistrement en boucle est activé, 
un symbole de boucle apparaît sur le bouton 
Record.

3 Si vous ne l'avez pas déjà fait, activez la piste 
MIDI ou d'instrument pour l'enregistrement 
en cliquant sur son bouton d'activation pour 
l'enregistrement. Assurez-vous qu'aucune piste 
audio ne soit activée pour l'enregistrement.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, reportez-
vous à la section « Configuration des points 
de punch et de boucle » à la page 463.

Mode d'enregistrement en boucle activé
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4 Désactivez le mode Wait for Note et le décompte à 
partir de la fenêtre de transport.

5 Sélectionnez Options > Link Timeline and Edit 

Selection.

6 À l'aide du Sélecteur, sélectionnez la plage 
d'enregistrement en boucle sur la playlist de la 
piste.

7 Pour entendre le contenu de la piste jusqu'au 
point d'entrée de la boucle, activez le pré-roll et 
configurez sa durée (reportez-vous à la section 
« Configuration des durées de pré-roll et post-
roll » à la page 466).

8 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement. 
Le bouton Record clignote.

9 Cliquez sur Play pour lancer l'enregistrement.

Le bouton Record clignote pendant le pré-roll. 
Lorsque le point d'entrée est atteint, Pro Tools 
commence l'enregistrement. Lorsque le point de 
sortie est atteint, Pro Tools retourne au point 
d'entrée et continue la lecture et l'enregistrement.

10 Jouez sur votre contrôleur MIDI. Un clip MIDI 
contenant les nouvelles données enregistrées est 
créé automatiquement et apparaît sur la playlist 
de la piste, remplaçant le clip précédent.

Les clips sont remplacés (de façon non destructive) 
passe après passe d'enregistrement lorsque 
de nouvelles données MIDI sont reçues.

11 Pour interrompre l'enregistrement, cliquez sur 
le bouton Stop de la fenêtre de transport.

Les prises enregistrées apparaissent sous forme 
de clips dans la liste des clips et sont numérotées 
de façon séquentielle. Vous pouvez ainsi 
sélectionner les prises, de même durée 
et facilement interchangeables, à partir du menu 
contextuel des prises correspondantes, même 
lorsque la session est en cours de lecture ou en 
boucle.

Pour sélectionner les différentes prises 
d'enregistrement :

1 Assurez-vous que la fenêtre Matching Criteria 
est correctement configurée (reportez-vous à la 
section « Fenêtre Matching Criteria » 
à la page 476).

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip à l'aide de l'un 
des outils de sélection ou de saisie 
et sélectionnez une prise dans le sous-menu 
Matches du menu contextuel. 

• Maintenez la touche Commande (Mac) ou 
Ctrl (Windows) enfoncée et cliquez avec le 
Sélecteur sur le point d'entrée exact de la plage 
d'enregistrement en boucle ou de punch-in/ out. 
Sélectionnez ensuite une prise différente dans le 
menu contextuel des prises alternatives.

• Si la prise se trouvant sur la piste est 
sélectionnée, maintenez la touche Commande 
(Mac) ou Ctrl (Windows) enfoncée et cliquez 
n'importe où dans la prise avec le Sélecteur. 
Sélectionnez ensuite une prise différente dans le 
menu contextuel des prises alternatives.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, reportez-
vous à la section « Configuration des points 
de punch et de boucle » à la page 463.

Sélection d'une prise MIDI alternative
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La prise (clip) sélectionnée remplace la prise 
précédente et se positionne précisément à l'endroit 
approprié.

Saisie MIDI pas à pas
La saisie pas à pas permet d'utiliser un clavier MIDI 
(ou tout autre contrôleur capable d'émettre des 
données de notes MIDI) pour entrer des notes 
individuellement, l'une après l'autre. Vous pouvez 
ainsi contrôler précisément la position, la durée et la 
vélocité des notes. La saisie MIDI pas à pas donne 
également la possibilité de créer des passages 
musicaux difficiles à interpréter fidèlement ou joués 
à un tempo plus rapide. 

Enregistrement de données 
System Exclusive
Pro Tools permet d'enregistrer et de lire des 
données System Exclusive (Sysex) sur des pistes 
MIDI. Vous pouvez ainsi utiliser des pistes MIDI 
dans Pro Tools pour stocker des données de patchs 
et de configuration pour vos périphériques MIDI, 
ou d'enregistrer en temps réel des changements de 
valeurs Sysex correspondant à un paramètre 
particulier d'un périphérique MIDI qui ne peut être 
contrôlé par un contrôleur MIDI standard.

Pour enregistrer un « dump » (transfert de données) 
Sysex au début d'une piste MIDI :

1 Assurez-vous que le port de sortie MIDI 
du périphérique émettant les données Sysex soit 
connecté au port d'entrée MIDI de votre 
interface MIDI.

2 Dans la boîte de dialogue MIDI Input Filter, 
activez les options Only et System Exclusive.

3 Configurez une piste MIDI pour l'enregistrement 
(reportez-vous à la section « Configuration des 
pistes MIDI ou d'instrument pour 
l'enregistrement » à la page 486).

4 Assurez-vous que le mode d'enregistrement 
normal est sélectionné (reportez-vous 
à la section « Modes d'enregistrement » 
à la page 441).

5 Activez une piste MIDI pour l'enregistrement.

6 Activez le mode Wait for Note à partir de la 
fenêtre de transport.

7 Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commence à partir du début de 
la session.

8 Lorsque vous êtes prêt à enregistrer, cliquez sur le 
bouton Record de la fenêtre de transport. 

Les boutons Record, Play et Wait for Note 
clignotent pour indiquer que Pro Tools attend des 
données MIDI.

9 Lancez le transfert des données Sysex à partir 
du périphérique MIDI en suivant les 
instructions du fabricant. Pro Tools démarre 
automatiquement l'enregistrement à la 
réception des données Sysex.

10 Après le transfert des données Sysex, cliquez 
sur le bouton Stop de la fenêtre de transport.

Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'un clip MIDI dans 
la playlist de la piste et dans la liste des clips. 
Les clips MIDI contenant des données System 
Exclusive apparaissent vides en vue de piste Clips.

Pour plus d'informations sur l'écoute et la 
gestion des prises, reportez-vous à la section 
« Sélection de prises alternatives » 
à la page 474.

Pour plus d'informations sur la saisie pas 
à pas, reportez-vous à la section 
« Commande Step Input » à la page 964.
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Pour que les blocs d'événements Sysex indiquant 
l'emplacement des données soient affichés, utilisez 
la vue de piste Sysex (reportez-vous à la section 
« Vue Clips pour les pistes MIDI et d'instrument » 
à la page 529). 

Pour envoyer des données Sysex d'un système 
Pro Tools vers un périphérique MIDI externe :

1 Assurez-vous que le port d'entrée MIDI du 
périphérique recevant les données System 
Exclusive soit connecté au port de sortie MIDI 
de votre interface MIDI. Vérifiez également 
que le périphérique soit configuré pour recevoir 
des données Sysex. Sur certains périphériques, 
la protection de la mémoire doit être désactivée. 
Pour plus d'informations, reportez-vous aux 
instructions du fabricant.

2 Vérifiez que la piste MIDI contenant les 
données Sysex ne soit pas activée pour 
l'enregistrement.

3 Cliquez sur le sélecteur de sortie MIDI de la 
piste et assignez le périphérique à partir 
du menu déroulant.

4 Configurez le périphérique MIDI externe pour 
la réception des données Sysex en suivant les 
instructions du fabricant.

5 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport. Pro Tools commence 
à lire et à transmettre les données Sysex 
précédemment enregistrées au périphérique 
MIDI assigné.

Enregistrement audio à 
partir d'un instrument MIDI
En règle générale, vous utiliserez des pistes 
d'entrée auxiliaire et d'instrument pour le 
monitoring audio des instruments MIDI (matériels 
ou plug-ins). Pour un mixdown final, l'audio des 
pistes d'entrée auxiliaire et d'instrument peut être 
mis à plat lors d'une opération de bounce sur 
disque, ou routé sur un bus pour être enregistré sur 
une nouvelle piste. 

Enregistrement audio à partir 
d'un plug-in d'instrument

Pour enregistrer de l'audio à partir d'un plug-in 
d'instrument :

1 Créez une piste d'instrument.

2 Insérez un plug-in d'instrument sur la 
piste créée.

3 Effectuez l'une des opérations suivantes :

• Enregistrez une prise MIDI sur la piste 
d'instrument.

• Saisissez manuellement les données MIDI sur la 
piste d'instrument.

4 Créez une piste audio composée du même 
nombre de canaux que la piste d'instrument 
(stéréo, par exemple).

5 Définissez le sélecteur de chemin de sortie audio 
de la piste d'instrument sur un bus (bus 1-2, 
par exemple).

6 Définissez le sélecteur de chemin d'entrée audio 
de la piste audio sur le même bus.

Pour plus d'informations sur le déplacement 
et la copie de données Sysex, reportez-vous à 
la section « Événements System Exclusive » 
à la page 720.

Avec les plug-ins d'instrument, vous pouvez 
enregistrer l'audio d'un instrument MIDI sur 
une nouvelle piste avant le mixage afin 
de libérer des ressources DSP.

Vous pouvez également enregistrer 
simultanément le MIDI et l'audio de la prise.
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7 Définissez le sélecteur de chemin de sortie 
audio de la piste audio sur le chemin 
de monitoring principal.

8 Activez la piste audio pour l'enregistrement.

9 Effectuez l'une des opérations suivantes :

• Dans la fenêtre de transport, cliquez sur 
le bouton de retour à zéro pour vous assurer que 
l'enregistrement commence à partir du début de 
la session.

• Sélectionnez la plage d'enregistrement dans 
la timeline.

10 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

11 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

12 Lorsque la lecture de la prise MIDI enregistrée 
précédemment est terminée, cliquez sur 
le bouton Stop de la fenêtre de transport pour 
arrêter l'enregistrement.

Enregistrement audio à partir 
d'un instrument MIDI externe
Vous pouvez enregistrer de l'audio provenant d'un 
instrument MIDI externe de deux façons :

• en routant sur un bus l'audio provenant de la 
sortie de la piste d'instrument (ou d'entrée 
auxiliaire) utilisée pour le monitoring de 
l'instrument MIDI, afin de l'enregistrer sur une 
piste audio ; 

• en définissant le sélecteur de chemin d'entrée 
audio de la piste audio sur le même chemin 
d'entrée audio que la piste d'instrument 
(ou d'entrée auxiliaire) utilisée pour 
le monitoring de l'instrument MIDI externe. 

Cette seconde méthode limite l'effet de latence 
inhérent au routing sur un bus. Cependant, pensez à 
muter la piste d'instrument (ou d'entrée auxiliaire) 
utilisée pour le monitoring lors de l'enregistrement du 
même chemin audio sur la piste audio.

Enregistrement audio d'un bus provenant d'un plug-in 
d'instrument
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Chapitre 23 : Modes d'enregistrement 
en punch-in/out

L'enregistrement en punch-in/out est utilisé dans 
de nombreux domaines de la production audio 
pour les films, la vidéo et la musique.

Introduction aux modes 
d'enregistrement en punch-in/out
Après avoir enregistré une prise sur une piste, il est 
souvent nécessaire de réenregistrer certains passages 
d'audio. L'enregistrement en punch-in/ out permet 
d'enclencher ou désenclencher manuellement 
l'enregistrement sur une ou plusieurs pistes sans 
arrêter le transport. 

Modes d'enregistrement 
en punch-in/out de Pro Tools
Pro Tools propose trois modes d'enregistrement 
manuel en punch-in/out : 

QuickPunch : mode d'enregistrement non 
destructif permettant d'effectuer des punch-ins et 
outs en cours de lecture sur des pistes activées pour 
l'enregistrement en cliquant sur le bouton Record de 
la fenêtre de transport. Le mode QuickPunch est 
disponible sur tous les systèmes. 

TrackPunch (Pro Tools HD uniquement) : 
mode d'enregistrement non destructif permettant 
d'effectuer des punch-ins et outs sur des pistes 
individuelles et de les désactiver pour 
l'enregistrement sans interrompre l'enregistrement 
et la lecture online.

DestructivePunch (Pro Tools HD uniquement) : 
mode d'enregistrement destructif dans lequel 
un fichier audio continu unique est utilisé pour les 
opérations de punch sur les pistes, et permettant 
d'effectuer des punch-ins et outs sur des pistes 
individuelles et de les désactiver pour 
l'enregistrement sans interrompre l'enregistrement 
et la lecture online.

Il n'est pas nécessaire d'activer le mode 
QuickPunch ni aucun autre mode 
d'enregistrement audio en punch-in/out pour 
pouvoir effectuer un punch-in/out sur une 
piste MIDI. Ces opérations sont possibles avec 
les pistes MIDI en mode d'enregistrement 
normal (non destructif) et en mode 
d'enregistrement destructif.

Pour effectuer un punch-in/out automatique sur 
des pistes audio activées pour l'enregistrement 
et sur une plage spécifique, reportez-vous à la 
section « Enregistrement audio en punch-
in/out sur une plage spécifiée » à la page 468.
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Directives pour l'enregistrement 
en punch-in/out
Cette section répertorie les paramètres 
et instructions de base permettant d'enregistrer en 
punch-in/out dans Pro Tools : 

• « Nombre de voix nécessaires pour 
l'enregistrement en punch-in/out » 
à la page 500. 

• « Compensation du délai et mode 
DestructivePunch » à la page 501.

• « Fichiers, clips et prises audio » à la page 502.

• « Préférences d'enregistrement en punch-in/out » 
à la page 502 (pour les fondus enchaînés, 
ainsi que les paramètres de configuration 
du transport et du monitoring).

Nombre de voix nécessaires 
pour l'enregistrement 
en punch-in/out
Le nombre maximal de pistes pouvant faire l'objet 
d'un enregistrement en punch-in/out dépend 
du type de système que vous utilisez, ainsi que 
du nombre de voix disponibles. Les rubriques 
suivantes fournissent des instructions d'utilisation 
des voix pour l'enregistrement en punch-in/out qui 
peuvent être utiles pour la gestion des ressources 
en cours de session. 

Pro Tools

(mode QuickPunch uniquement)

Les capacités du mode QuickPunch de Pro Tools 
dépendent du nombre total de voix disponibles. Ce 
nombre varie en fonction du nombre de pistes et de 
plug-ins utilisés dans la session en cours (lequel 
affecte le nombre de voix disponibles). 

Pour augmenter le nombre de voix disponibles 
pour l'enregistrement en punch-in/out :

1 Identifiez les pistes qui ne sont pas activées 
pour l'enregistrement et qui n'ont pas besoin 
d'être audibles pendant l'enregistrement.

2 Désactivez ces pistes. 

Pro Tools HD

(Modes QuickPunch, TrackPunch 
et DestructivePunch)

Lorsque l'un des modes d'enregistrement en 
punch-in/out de Pro Tools HD est activé, deux 
voix sont nécessaires pour chaque piste mono 
préparée pour l'enregistrement. Vous pouvez ainsi 
enregistrer en punch-in/out jusqu'à la moitié du 
nombre total de voix disponibles sur votre 
système.

Si le nombre de voix nécessaires pour les pistes 
activées pour l'enregistrement n'est pas disponible 
lorsque vous passez en mode QuickPunch, 
TrackPunch ou DestructivePunch, vous êtes invité 
à libérer les voix nécessaires.

Pour augmenter le nombre de voix disponibles 
pour l'enregistrement en punch-in/out :

 Identifiez les pistes qui ne sont pas activées pour 
l'enregistrement et qui n'ont pas besoin d'être 
audibles pendant l'enregistrement, puis effectuez 
l'une des opérations suivantes :

• Définissez l'assignation des voix des pistes sur Off.

• Désactivez des pistes.

• Groupez tous les plug-ins Native avant les plug-
ins DSP.

En fonction des besoins, les voix utilisées par 
d'autres pistes mais qui ne sont pas activées pour 
l'enregistrement peuvent être « empruntées » 
pendant un enregistrement en punch-in/out. 

Le mode QuickPunch utilise la puissance 
du processeur, ce qui risque de réduire 
le nombre de pistes et de plug-ins que 
vous pouvez utiliser.

Pour plus d'informations sur les capacités de 
gestion des voix, reportez-vous à la section 
« Capacités de Pro Tools avec différentes 
configurations matérielles » à la page 41.
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Si un mode d'enregistrement en punch-in/out est 
activé, la priorité de lecture des voix est la suivante 
(de la priorité de lecture la plus haute à la plus 
basse) :

• Les pistes dont les voix sont assignées, mais non 
activées pour l'enregistrement.

• Les pistes dont les voix sont assignées qui sont 
activées pour l'enregistrement.

• Les pistes avec allocation dynamique des voix qui 
ne sont pas activées pour l'enregistrement.

• Les pistes avec allocation dynamique des voix 
qui sont activées pour l'enregistrement.

Si de nombreuses voix sont disponibles dans une 
session, vous ne devriez pas rencontrer 
de problème pour effectuer un enregistrement en 
punch-in/out sur des pistes en utilisant l'allocation 
dynamique des voix. Toutefois, si vous manquez de 
voix et souhaitez être sûr qu'une piste sera audible 
pendant un enregistrement en punch-in/out, 
assurez-vous de définir l'assignation de voix Off 
sur les pistes non concernées par le punch-in/out.

Compensation du délai et mode 
DestructivePunch
Afin d'effectuer un enregistrement en punch-in/ out 
sur un enregistrement existant en mode 
DestructivePunch, assurez-vous que les 
paramètres de compensation du délai soient 
identiques à ceux utilisés pour l'enregistrement du 
fichier d'origine. S'ils sont différents, l'audio 
enregistré en punch-in ne sera pas aligné sur 
l'enregistrement d'origine.

 Si la compensation du délai était désactivée lors 
de l'enregistrement du fichier d'origine, elle doit 
être désactivée pour le mode DestructivePunch.

 Si la compensation du délai était activée lors de 
l'enregistrement du fichier d'origine, elle doit 
rester activée pour le mode DestructivePunch. 

Afin que le chemin de compensation du délai soit 
le même sur toutes les pistes activées pour 
l'enregistrement en mode DestructivePunch, 
Pro Tools ne doit pas pouvoir utiliser le chemin 
de monitoring à faible latence lorsque les pistes 
enregistrées passent en mode de monitoring d'entrée.

Pour appliquer la compensation du délai à une 
piste sur laquelle elle a été suspendue, effectuez 
l'une des opérations suivantes :

 Effectuez un clic droit sur l'indicateur de 
compensation de la piste et sélectionnez Auto 

Low Latency Off.

 Maintenez les touches Démarrer+Ctrl 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et cliquez sur l'indicateur de 
compensation de la piste.

Pour appliquer la compensation du délai à toutes 
les pistes sélectionnées sur lesquelles elle a été 
suspendue, effectuez l'une des opérations 
suivantes :

 Maintenez la touche Maj enfoncée et effectuez 
un clic droit sur l'indicateur de compensation 
d'une piste, puis sélectionnez Auto Low Latency 

Off.

 Maintenez les touches Démarrer+Ctrl+Maj 
(Windows) ou Commande+Ctrl+Maj (Mac) 
enfoncées et cliquez sur l'indicateur de 
compensation d'une piste.

Pour plus d'informations, reportez-vous à 
la section « Compensation du délai » 
à la page 1021.
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Fichiers, clips et prises audio

Modes QuickPunch et TrackPunch

Les modes d'enregistrement QuickPunch 
et TrackPunch sont non destructifs. Au lieu 
de remplacer l'audio lors d'un enregistrement 
en punch-in/out, de nouveaux fichiers audio sont créés 
pour chaque passe en mode QuickPunch 
ou TrackPunch (une passe correspond à un cycle 
compris entre le lancement et l'arrêt du transport).

Pro Tools commence l'enregistrement d'un nouveau 
fichier audio au début de la lecture et crée 
automatiquement des clips dans ce fichier à chaque 
point de punch-in et de punch-out. Vous pouvez 
ainsi, dans une même passe, effectuer jusqu'à 
200 opérations de punch-in et out. En mode 
QuickPunch ou TrackPunch, le monitoring peut 
basculer instantanément sur les retour des pistes après 
un punch-out. 

Après un enregistrement en mode QuickPunch ou 
TrackPunch, les nouveaux clips audio apparaissent 
dans la liste des clips. Il s'agit aussi bien du clip audio 
de fichier entier qui englobe toutes les opérations de 
punch d'une passe d'enregistrement que des clips 
créés à chaque punch.

Les noms des clips créés lors d'un enregistrement 
en punch-in/out sont numérotées séquentiellement 
à partir du suffixe « 01 ». Par exemple, si vous 
effectuez deux punch-ins en mode QuickPunch sur 
une piste nommée « Lead Gtr », un clip 
correspondant au fichier audio parent apparaît, 
nommé « Lead Gtr_01 », ainsi que deux clips 
correspondant aux opérations de punch, intitulés 
« Lead Gtr_01-01 » et « Lead Gtr_01-02 ». 

Si vous arrêtez la lecture puis effectuez d'autres 
enregistrements en mode QuickPunch 
(ou TrackPunch), un nouveau clip de fichier entier 
est créé (car un clip est créé pour chaque passe) et 
les clips suivants sont nommés de manière 
incrémentielle, en augmentant à chaque fois d'une 
unité les deux premiers chiffres de leur nom. Par 
exemple, lors de la seconde passe, les clips créés 
suite aux punch-ins sont nommés « Lead Gtr_02-
01 », « Lead Gtr_02-02 » et ainsi de suite. 

Mode DestructivePunch

Le mode d'enregistrement DestructivePunch est 
destructif. L'ensemble du contenu déjà présent sur 
une piste est remplacé de façon définitive par l'audio 
enregistré lors de l'opération de punch. Pro Tools 
enregistre jusqu'à la sortie de l'enregistrement 
(punch-out) et insère de nouveaux contenus pour 
remplacer l'audio des playlists des pistes. 

Préférences d'enregistrement 
en punch-in/out
(Fondus enchaînés, transport et enregistrement)

Plusieurs préférences associées à l'enregistrement en 
punch-in/out sont disponibles dans Pro Tools afin 
de spécifier la manière dont les fondus enchaînés, 
le monitoring et le transport doivent fonctionner 
pendant et après les passes d'enregistrement. Ces 
paramètres optimisent la création des fondus, le 
transport et le comportement des pistes de 
Pro Tools pour différents types de tâches, dont le 
doublage, le mixage et le réenregistrement. 

Création de fondus enchaînés en cours 
d'enregistrement en punch-in/out

Pro Tools crée des fondus enchaînés à chaque 
point d'entrée et de sortie pour lisser les transitions 
entre les clips enregistrés en punch-in/out. Vous 
pouvez spécifier la durée des fondus enchaînés 
ajoutés en mode QuickPunch et TrackPunch (le 
mode DestructivePunch utilise une durée de fondu 
enchaîné fixe qui ne peut être modifiée). Une fois 
l'enregistrement en punch-in/out terminé, tous les 
fondus enchaînés peuvent être modifiés de la 
même manière que des fondus enchaînés standard 
(reportez-vous au Chapitre 28, « Fondus et fondus 
enchaînés »). 
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Durée de fondu enchaîné en mode 
QuickPunch/TrackPunch

Pro Tools peut créer automatiquement un fondu 
enchaîné à chaque point de punch-in/out en mode 
QuickPunch ou TrackPunch. La durée de ces 
fondus enchaînés est définie par l'option 
QuickPunch/TrackPunch Crossfade Length des 
préférences d'édition.

Pour définir la durée des fondus enchaînés 
en mode QuickPunch/TrackPunch :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Editing.

2 Entrez une durée de fondu enchaîné (en ms) pour 
le paramètre QuickPunch/TrackPunch Crossfade 

Length. Une durée de fondu enchaîné de 10 ms 
est adaptée à la plupart des cas. Si vous définissez 
cette préférence sur zéro, Pro Tools ne crée 
aucun fondu enchaîné aux points de punch-
in/out.

3 Cliquez sur OK.

Si vous avez spécifié une valeur non nulle pour le 
paramètre QuickPunch/TrackPunch Crossfade 

Length, Pro Tools insère un pré-fondu enchaîné au 
point de punch-in (le fondu commence avant ce 
point et s'étend jusqu'à celui-ci) et un post-fondu 
enchaîné au point de punch-out (qui s'étend après 
le clip enregistré).

Quelle que soit la durée de fondu enchaîné en 
mode QuickPunch/TrackPunch définie, Pro Tools 
applique toujours un fondu enchaîné pour 
le monitoring (qui ne sera pas enregistré sur 
le disque) de 4 millisecondes pour éviter les clics 
ou bruits parasites qui risquent de se produire 
lorsque vous entrez et sortez du 
mode d'enregistrement.

Mode DestructivePunch et fondus enchaînés

En mode DestructivePunch, un fondu enchaîné 
linéaire fixe de 10 ms est ajouté à chaque point 
d'entrée et de sortie. Une fois l'enregistrement 
en punch-in/out terminé, les fondus enchaînés 
peuvent être modifiés de la même manière que des 
fondus enchaînés standard (reportez-vous au 
Chapitre 28, « Fondus et fondus enchaînés »). 

Paramètres de transport et d'enregistrement

Les préférences de transport et d'enregistrement 
pour l'enregistrement en punch-in/out apparaissent 
sur la page des préférences de fonctionnement. 
Ces préférences spécifient la manière dont les 
pistes et le transport se comportent pendant, entre 
et après les opérations de punch et passes 
d'enregistrement.

Transport Record Lock

Ce paramètre permet de configurer le bouton 
Record de la fenêtre de transport afin de reproduire 
le comportement d'un enregistreur multipiste 
numérique ou celui des anciennes commandes 
globales d'enregistrement. 

Préférences du mode TrackPunch
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 Si cette option n'est pas activée, le bouton 
Record de la fenêtre de transport est désactivé 
lorsque Pro Tools est arrêté manuellement ou suite 
à une perte de timecode. Ce mode reproduit le 
comportement d'enregistrement des anciennes 
versions de Pro Tools. 

 Si cette option est sélectionnée, le bouton 
Record de la fenêtre de transport reste activé après 
l'arrêt de la lecture ou de l'enregistrement. Cela 
évite d'avoir à préparer le transport pour 
l'enregistrement entre chaque prise, ce qui 
correspond au comportement d'un enregistreur 
multipiste numérique. 

Enregistrement destructif et option Transport 
Record Lock

Afin d'empêcher tout enregistrement accidentel 
sur des données précédemment enregistrées, 
l'option Transport Record Lock est 
automatiquement désactivée et grisée lorsque 
le mode d'enregistrement destructif est activé. 

Audio Track Record Lock

Ce paramètre permet aux pistes de Pro Tools 
d'émuler le comportement d'un enregistreur 
multipiste numérique ou de conserver l'ancien 
comportement pour l'état d'enregistrement 
des pistes. 

 Lorsque l'option Audio Track Record Lock est 
activée, les pistes audio activées pour 
l'enregistrement restent dans cet état même en cas 
d'arrêt de la lecture ou de l'enregistrement. 

 Lorsque l'option Audio Track Record Lock n'est 
pas activée, les pistes audio quittent le mode 
d'activation pour l'enregistrement en cas d'arrêt de 
Pro Tools. Cela permet d'éviter que les pistes 
ne restent activées d'une passe à l'autre, émulant le 
comportement d'enregistrement de piste d'un 
enregistreur multipiste numérique.

Options de synchronisation 
et d'activation des pistes pour 
l'enregistrement en punch-in/out
(SYNC HD uniquement)

Les paramètres de synchronisation pour 
l'enregistrement en punch-in/out online varient 
selon le type et les fonctionnalités de votre 
système Pro Tools et des autres périphériques de 
votre studio. 

L'option MachineControl™ pour Pro Tools HD 
permet d'activer à distance des pistes pour 
l'enregistrement sur des magnétoscopes 9 broches 
pris en charge (ou V-LAN pour le transport 
uniquement). 

Si vous sortez de l'enregistrement en cliquant 
sur le bouton Record de la fenêtre de 
transport, vous désactivez également le mode 
de préparation pour l'enregistrement du 
transport.

Pour consulter des exemples d'application de 
ces paramètres, reportez-vous à la section 
« Exemples de workflows en modes 
TrackPunch et DestructivePunch » 
à la page 516.

Pour obtenir des informations de base sur le 
timecode et la synchronisation avec 
Pro Tools, reportez-vous au Chapitre 50, 
« Utilisation de la synchronisation ».

Sélectionnez Setup > Machine Track Arming 
Profiles pour configurer votre système, 
puis Window > Machine Track Arming pour 
afficher la fenêtre Machine Track Arming. 

Pour plus d'informations sur l'armement 
de pistes à distance avec MachineControl, 
reportez-vous au Guide MachineControl. 
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Enregistrement audio 
en mode QuickPunch
Le mode QuickPunch est disponible sur tous les 
systèmes et permet d'effectuer un punch-in/out 
instantané sur toutes les pistes audio activées pour 
l'enregistrement en cours de lecture en cliquant sur le 
bouton Record de la fenêtre de transport. 

Enregistrement en mode 
QuickPunch

Pour enregistrer en punch-in/out en mode 
QuickPunch :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Options > QuickPunch. 

• Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport et sélectionnez QuickPunch.

Lorsque le mode QuickPunch est activé, la lettre P 
est affichée sur le bouton Record. 

2 Vérifiez ou reconfigurez le paramètre de fondu 
enchaîné pour l'enregistrement en punch-in/out 
(reportez-vous à la section « Durée de fondu 
enchaîné en mode QuickPunch/TrackPunch » 
à la page 503).

3 Cliquez sur le bouton d'activation pour 
l'enregistrement des pistes sur lesquelles vous 
souhaitez enregistrer en punch-in/out. 

4 Préparez-vous à enregistrer en calant Pro Tools 
à l'endroit désiré. Si vous le souhaitez, activez 
la plage de pré-roll à partir de la fenêtre de 
transport.

5 Lancez la lecture en cliquant sur le bouton Play 
de la fenêtre de transport.

6 Effectuez l'une des opérations suivantes :

• Lorsque vous atteignez le point de punch-in, 
cliquez sur le bouton Record de la fenêtre 
de transport.

• Pour les systèmes Pro Tools sur lesquels une 
pédale est connectée, appuyez sur la pédale au 
point de punch-in.

Le bouton Record cesse de clignoter et reste 
allumé pendant l'enregistrement.

7 Pour sortir de l'enregistrement, cliquez 
de nouveau sur le bouton Record (ou appuyez 
sur la pédale).

La lecture se poursuit dans Pro Tools et vous 
pouvez effectuer d'autres opérations de punch 
(200 au maximum). Lorsque plusieurs passages 
sont enregistrés en punch-in/out durant une même 
passe, un fichier audio unique est créé, à partir 
duquel Pro Tools génère les clips appropriés.

De nombreux systèmes Pro Tools permettent 
également d'utiliser une pédale pour 
déclencher les punch-ins et outs. Reportez-vous 
au guide fourni avec votre interface audio ou 
surface de contrôle Pro Tools.

Mode QuickPunch activé

Si vous ne pouvez pas activez des pistes pour 
l'enregistrement en raison d'un nombre de 
voix insuffisant, reportez-vous à la section 
« Nombre de voix nécessaires pour 
l'enregistrement en punch-in/out » 
à la page 500.
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Après une passe d'enregistrement en mode 
QuickPunch, la playlist de la piste concernée dans 
la fenêtre Edit affiche les clips créés suite aux 
opérations de punch. Vous pouvez utiliser l'un des 
outils de trim après un enregistrement en punch-
in/out pour rallonger la durée des clips enregistrés 
en mode QuickPunch, ou à l'inverse les raccourcir 
pour retrouver une partie du fichier audio 
précédemment enregistré. Vous pouvez ainsi 
récupérer toute opération de punch manquée ou 
tardive. 

Pour plus d'informations sur l'attribution des noms 
des fichiers et clips, reportez-vous à la section 
« Fichiers, clips et prises audio » à la page 502. 

Enregistrement QuickPunch avec une 
sélection d'édition

Si une sélection d'édition est active lors d'un 
enregistrement en mode QuickPunch, les règles 
suivantes s'appliquent :

• Si le transport n'est pas en ligne, l'enregistrement 
commence et s'arrête chaque fois que vous 
cliquez sur le bouton Record de la fenêtre de 
transport, quels que soient les points de début et 
de fin de la sélection. 

• Si le transport est en ligne, l'enregistrement en 
punch-in/out est contrôlé par le paramètre Online 
Options des préférences de fonctionnement. 

• Si vous sélectionnez Record Online at 

Insertion/Selection, les points de punch-in 
et out en mode QuickPunch ne peuvent être 
déclenchés qu'entre les points de début et de 
fin de la sélection (ou seulement après le point 
d'insertion, le cas échéant). 

• Si vous sélectionnez Record Online at Time 

Code Lock, vous pouvez déclencher un punch-
in ou un punch-out à l'emplacement de votre 
choix en mode QuickPunch, sans tenir compte 
de la sélection (après que Pro Tools soit 
verrouillé sur le timecode).

Enregistrement audio 
en mode TrackPunch
(Pro Tools HD uniquement)

En mode TrackPunch, vous pouvez effectuer des 
opérations de punch sur des pistes individuelles 
(l'une après l'autre), ou sur plusieurs pistes 
simultanément. Le mode d'enregistrement 
TrackPunch est non destructif et conserve 
les données précédentes sur le disque 
(pour remplacer de façon destructive l'audio 
enregistré sur le disque, reportez-vous à la section 
« Enregistrement audio en mode 
DestructivePunch » à la page 511). 

Configuration du mode 
TrackPunch
Avant d'utiliser le mode TrackPunch lors d'une 
passe d'enregistrement, vous devez configurer les 
paramètres de Pro Tools, de la session 
et des pistes.

Configuration de Pro Tools

Pour configurer Pro Tools : 

1 Configurez les pistes, l'allocation des voix et les 
autres paramètres du mode TrackPunch selon 
vos besoins (reportez-vous à la section 
« Directives pour l'enregistrement 
en punch-in/out » à la page 500). 

2 Assurez-vous que Pro Tools n'est pas en cours 
d'enregistrement ou de lecture (transport à 
l'arrêt). 

Pour plus d'informations sur la lecture 
en ligne dans Pro Tools, reportez-vous 
au Guide de l'utilisateur fourni avec votre 
système. Pour plus d'informations sur 
la synchronisation avec les modes 
d'enregistrement TrackPunch 
et DestructivePunch, reportez-vous 
à la section « Options de synchronisation 
et d'activation des pistes pour l'enregistrement 
en punch-in/out » à la page 504. 
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Activation du mode TrackPunch
Pour activer le mode TrackPunch :

 Effectuez l'une des opérations suivantes : 

• Sélectionnez Options > TrackPunch.

• Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport, puis sélectionnez la commande 
TrackPunch dans le menu contextuel.

• Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez sur 
le bouton Record de la fenêtre de transport pour 
parcourir les modes d'enregistrement 
disponibles et sélectionner le mode TrackPunch 
(indiqué par un T majuscule). 

• Appuyez sur Ctrl+Maj+T (Windows) 
ou Commande+Maj+T (Mac).

Affichage de l'état du mode TrackPunch 
dans la fenêtre de transport

Le bouton Record de la fenêtre de transport 
indique le statut du mode TrackPunch et 
de l'enregistrement comme suit :

Lorsque le mode TrackPunch est activé :

 Un T majuscule est affiché sur le bouton Record 
de la fenêtre de transport. 

 Si au moins une piste est en mode TrackPunch, le 
bouton Record reste allumé en bleu. 

Lorsque le mode TrackPunch est activé et que 
le transport est préparé à l'enregistrement :

 Si aucune piste n'est en mode TrackPunch, 
le bouton Record de la fenêtre de transport 
clignote en gris et rouge. 

 Si au moins une piste est en mode TrackPunch, le 
bouton Record clignote en bleu et rouge.

 Si au moins une piste en mode TrackPunch est 
activée pour l'enregistrement, le bouton Record 
clignote en rouge et bleu et la LED 
d'enregistrement s'allume.

 Dès qu'une piste audio est en cours 
d'enregistrement, le bouton Record de la fenêtre de 
transport reste allumé en rouge. 

Activation du mode TrackPunch 
sur les pistes
Avant chaque passe, vous devez activer le mode 
TrackPunch sur toutes les pistes sur lesquelles 
vous avez l'intention d'effectuer un enregistrement 
en punch-in/out (des pistes peuvent se trouver en 
mode TrackPunch sans être activées pour 
l'enregistrement). 

Pour activer le mode TrackPunch sur une piste : 

 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le bouton 
d'activation pour l'enregistrement de la piste. 

Pour activer ou désactiver le mode TrackPunch 
sur toutes les pistes audio :

 Maintenez les touches Alt+Démarrer (Windows) 
ou Option+Ctrl (Mac) enfoncées et cliquez sur le 
bouton d'activation pour l'enregistrement d'une 
piste. 

Pour activer ou désactiver le mode TrackPunch 
sur toutes les pistes audio sélectionnées : 

 Maintenez les touches Alt+Démarrer+Maj 
(Windows) ou Option+Ctrl+Maj (Mac) 
enfoncées et cliquez sur le bouton d'activation 
pour l'enregistrement d'une piste sélectionnée. 

Indicateurs d'état des modes TrackPunch et 
TrackInput dans la fenêtre de transport

Mode TrackPunch avec au moins une piste en mode 
TrackPunch

Mode TrackPunch 
activé

Indicateur d'activation 
pour l'enregistrement

Indicateur d'état d'entrée
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Lorsque le mode TrackPunch est activé sur 
des pistes, leur bouton d'activation pour 
l'enregistrement reste allumé en bleu.

Affichage de l'état d'enregistrement des pistes

Le bouton d'activation pour l'enregistrement 
de chaque piste indique son état d'activation pour 
l'enregistrement et le mode TrackPunch comme 
suit :

• Si le mode TrackPunch est activé sur une piste 
non activée pour l'enregistrement, son bouton 
reste allumé en bleu. 

• Si une piste est à la fois en mode TrackPunch et 
activée pour l'enregistrement, son bouton 
d'activation pour l'enregistrement clignote 
en bleu et rouge. 

• Si une piste est uniquement activée pour 
l'enregistrement, son bouton d'activation pour 
l'enregistrement clignote en rouge. 

• Si une piste est en cours d'enregistrement (quel 
que soit le mode), son bouton d'activation pour 
l'enregistrement reste allumé en rouge.

Monitoring et niveaux

Pour terminer la configuration du mode TrackPunch : 

1 Configurez le monitoring des pistes activées 
pour l'enregistrement en sélectionnant un mode 
dans leur menu ou en utilisant le bouton 
TrackInput. Vous avez le choix entre les options 
suivantes :

• Set Record Tracks to Auto Input 

• Set Record Tracks to Input Only 

Le choix d'un mode de monitoring affecte 
uniquement les pistes activées pour 
l'enregistrement. 

2 Lancez la lecture et comparez les niveaux de la 
source d'entrée avec celui des pistes audio 
enregistrées. Cliquez sur le bouton TrackInput 
pour basculer la source de la piste. Lorsqu'il est 
allumé (en vert), le monitoring de l'entrée est 
activé. Lorsqu'il est éteint (gris), le monitoring du 
contenu de la piste est activé (reportez-vous à la 
section « Sélection des modes de monitoring pour 
l'enregistrement avec la commande de monitoring 
d'entrée de piste » à la page 453). 

3 Dès que les niveaux sont convenablement réglés, 
vous êtes prêt à commencer l'enregistrement 
en punch-in/out. 

Créez des groupes de pistes pour chaque stem 
ou ensemble de pistes sur lequel vous 
prévoyez d'effectuer un enregistrement 
en punch-in/out, puis utilisez la liste des 
groupes pour sélectionner rapidement toutes 
les pistes du groupe. 

Bouton d'activation pour l'enregistrement activé

Un bouton rouge (non clignotant) signale un 
enregistrement en cours (tous les modes)
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Utilisation du mode 
TrackPunch
Une fois que vous avez configuré Pro Tools, 
les pistes et les niveaux, vous pouvez enregistrer en 
mode TrackPunch de plusieurs façons. 

Punch-in sur des pistes 
individuelles
Pour effectuer un punch-in sur des pistes 
individuelles :

1 Assurez-vous que Pro Tools est en mode 
TrackPunch.

2 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, puis cliquez sur 
le bouton d'activation pour l'enregistrement de 
chaque piste concernée afin d'y activer le mode 
TrackPunch. Le bouton d'activation pour 
l'enregistrement des pistes doit rester allumé en 
bleu. 

3 Cliquez sur le bouton Record de la fenêtre 
de transport pour préparer l'enregistrement en 
mode TrackPunch. Le bouton Record clignote 
en bleu et rouge.

4 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

5 Pendant la lecture, vous pouvez effectuer 
un punch-in ou un punch-out sur des pistes 
individuelles activées pour l'enregistrement en 
mode TrackPunch en cliquant sur leur bouton 
d'activation pour l'enregistrement. 

6 En cours de lecture locale ou à distance, 
effectuez l'une des opérations suivantes :

• Enregistrez en punch-in sur d'autres pistes 
individuelles activées pour l'enregistrement en 
mode TrackPunch.

• Après un punch-out, sortez la piste de son état 
d'activation pour l'enregistrement, puis activez 
une autres piste pour l'enregistrement 
TrackPunch. 

• Répétez ces étapes pour les opérations de punch 
sur d'autres stems, pistes ou prises. 

7 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes et 
du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres de 
préférence Audio Track Record Lock et 
Transport Record Lock. 

Après une passe d'enregistrement en mode 
TrackPunch, la playlist de la piste concernée dans 
la fenêtre Edit affiche les clips créés suite aux 
enregistrements en punch-in/out. Vous pouvez 
utiliser l'un des outils de trim après 
un enregistrement en punch-in/out pour rallonger 
la durée des clips enregistrés en mode TrackPunch, 
ou à l'inverse les raccourcir pour retrouver une 
partie du fichier audio précédemment enregistré. 
Vous pouvez ainsi récupérer toute opération 
de punch manquée ou tardive. 

Pour plus d'informations sur l'attribution des noms 
des fichiers et clips, reportez-vous à la section 
« Fichiers, clips et prises audio » à la page 502. 
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Punch-in simultané sur 
plusieurs pistes

Pour effectuer un punch-in sur plusieurs pistes 
simultanément :

1 Activez le mode TrackPunch. 

2 Cliquez sur le bouton d'activation pour 
l'enregistrement de chaque piste sur laquelle 
vous souhaitez effectuer un punch-in, afin de les 
activer à la fois pour l'enregistrement et le mode 
TrackPunch. Ce bouton clignote alors en bleu 
et rouge.

3 Effectuez l'une des opérations suivantes : 

• Pendant la lecture, cliquez sur le bouton Record 
de la fenêtre de transport pour activer ou 
désactiver simultanément l'enregistrement sur 
les pistes en mode TrackPunch. 

• Cliquez sur le bouton Record de la fenêtre de 
transport, puis maintenez les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées 
tout en cliquant sur le bouton d'activation pour 
l'enregistrement d'une piste afin d'effectuer des 
enregistrements en punch-in/out simultanément 
sur toutes les pistes en mode TrackPunch 
actuellement sélectionnées.

4 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes et 
du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres de 
préférence Audio Track Record Lock et 
Transport Record Lock. 

Lancement de l'enregistrement 
sur toutes les pistes
Vous pouvez choisir de lancer une passe 
d'enregistrement, puis d'effectuer autant de punch-
outs et punch-ins que nécessaire. 

Pour effectuer un punch-in sur toutes les pistes :

1 Activez le mode TrackPunch (reportez-vous 
à la section « Affichage de l'état du mode 
TrackPunch dans la fenêtre de transport » 
à la page 507).

2 Cliquez sur le bouton d'activation pour 
l'enregistrement de chaque piste sur laquelle 
vous souhaitez effectuer un punch-in, afin 
de les activer à la fois pour l'enregistrement et le 
mode TrackPunch. Ce bouton clignote alors en 
bleu et rouge. 

3 Cliquez sur le bouton Record de la fenêtre 
de transport pour préparer l'enregistrement en 
mode TrackPunch. Le bouton Record clignote 
en bleu et rouge.

4 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

5 Pendant la lecture, effectuez des punch-outs et 
ins successifs sur des pistes individuelles 
activées pour le mode TrackPunch en cliquant 
sur leurs boutons d'activation pour 
l'enregistrement respectifs.

6 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes et 
du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres de 
préférence Audio Track Record Lock et 
Transport Record Lock. 
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Enregistrement audio 
en mode DestructivePunch
(Pro Tools HD uniquement)

Le mode d'enregistrement DestructivePunch est 
destructif et permet d'effectuer un punch-in 
ou punch-out en cours de lecture, tout en 
conservant un fichier audio continu pour chaque 
piste enregistrée. Comme le mode TrackPunch, le 
mode DestructivePunch permet d'effectuer 
un punch-in ou punch-out sur des pistes 
individuelles (l'une après l'autre), ou sur plusieurs 
pistes simultanément. 

Contrairement aux modes QuickPunch et 
TrackPunch, le mode DestructivePunch remplace 
l'audio au sein du fichier parent cible. Le mode 
DestructivePunch est en réalité une version 
destructive du mode TrackPunch. À la différence 
du mode TrackPunch, qui enregistre toujours 
l'audio dans un nouveau fichier en arrière-plan, le 
mode DestructivePunch l'enregistre directement 
dans le fichier d'origine de façon destructive, en 
appliquant un fondu enchaîné linéaire de 10 ms. 
Ce mode d'enregistrement ne crée aucun clip 
supplémentaire. Vous pouvez ainsi, dans une 
même passe en mode DestructivePunch, effectuer 
jusqu'à 200 opérations de punch-in/out.

Configuration du mode 
DestructivePunch
(Pro Tools HD uniquement)

Avant d'utiliser le mode DestructivePunch pour une 
passe d'enregistrement, vous devez configurer les 
paramètres de Pro Tools, de la session et des pistes. 

Configuration de Pro Tools pour le 
mode DestructivePunch

Pour configurer Pro Tools : 

1 Configurez les pistes, l'assignation des voix 
et les autres paramètres selon vos besoins 
(reportez-vous à la section « Directives pour 
l'enregistrement en punch-in/out » 
à la page 500). 

2 Assurez-vous que Pro Tools n'est pas en cours 
d'enregistrement ou de lecture (transport à 
l'arrêt). 

Activation du mode 
DestructivePunch

Pour activer le mode DestructivePunch :

 Effectuez l'une des opérations suivantes :

• Sélectionnez Options > DestructivePunch.

• Effectuez un clic droit sur le bouton Record de la 
fenêtre de transport et sélectionnez 
DestructivePunch.

• Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le bouton 
Record de la fenêtre de transport pour parcourir 
les modes d'enregistrement disponibles jusqu'à 
ce que les lettres « DP » apparaissent sur le 
bouton Record de la fenêtre de transport. 

L'enregistrement en mode Destructive Punch 
n'est pas pris en charge pour les clips 
AudioSuite rendus avec des poignées. Vous 
pouvez consolider ce type de clip si vous avez 
besoin d'utiliser le mode DestructivePunch.

La vue Power des formes d'onde n'est pas 
disponible en mode DestructivePunch.
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Affichage de l'état du mode 
DestructivePunch dans la fenêtre 
de transport

Lorsque le mode DestructivePunch est activé :

 Les lettres « DP » apparaissent sur le bouton 
Record de la fenêtre de transport. 

 Si au moins une piste est en mode 
DestructivePunch, le bouton Record reste allumé 
en bleu.

Lorsque le mode DestructivePunch est activé et 
que le transport est préparé à l'enregistrement :

 Si aucune piste n'est en mode DestructivePunch, le 
bouton Record de la fenêtre de transport clignote en 
gris et rouge. 

 Si au moins une piste est en mode 
DestructivePunch, le bouton Record clignote 
en bleu et rouge.

 Si au moins une piste est en mode 
DestructivePunch et est activée pour 
l'enregistrement, le bouton Record clignote en rouge 
et bleu et la LED d'enregistrement s'allume.

 Dès qu'au moins une piste est en enregistrement, le 
bouton Record reste allumé en rouge.

Préparation des pistes pour un 
enregistrement en mode 
DestructivePunch
Pour être préparée à l'enregistrement en mode 
DestructivePunch, une piste doit contenir 
un fichier audio contigu remplissant les conditions 
suivantes :

• Le fichier démarre au début de la session 
(échantillon 0). 

• La durée du fichier est supérieure ou égale 
à celle du fichier DestructivePunch 
(reportez-vous à la section « Durée de fichier 
DestructivePunch » à la page 512). 

Si la piste ne contient pas de fichier remplissant ces 
conditions, vous pouvez effectuer l'une des 
opérations suivantes :

• Déplacez le fichier actuel dans la timeline de la 
piste pour le faire démarrer au début de la session.

• Utilisez la commande Consolidate pour créer un 
fichier continu de la durée requise.

• Modifiez le paramètre DestructivePunch File 
Length afin que la durée du fichier actuel soit 
supérieure ou égale à la durée requise.

• Utilisez la commande Prepare DPE Tracks pour 
consolider l'audio sur toutes les pistes en mode 
DestructivePunch. Reportez-vous à la section 
« Utilisation de la commande Prepare DPE 
Tracks » à la page 513.

Durée de fichier DestructivePunch

Pour enregistrer sur une piste audio en mode 
DestructivePunch, elle doit contenir un fichier 
audio contigu dont la durée minimale doit être 
spécifiée dans la page des préférences de 
fonctionnement de Pro Tools.

Pour définir la durée du fichier DestructivePunch :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2 Entrez une valeur dans le champ 
DestructivePunch File Length. 

3 Cliquez sur OK.

Bouton Record de la fenêtre de transport en mode 
DestructivePunch
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Utilisation de la commande Prepare 
DPE Tracks

Pour préparer une piste à l'enregistrement 
en mode DestructivePunch :

1 Activez le mode DestructivePunch 
(reportez-vous à la section « Activation du 
mode DestructivePunch » à la page 511). 

2 Assurez-vous que les pistes concernées sont 
en mode DestructivePunch (reportez-vous à la 
section « Activation du mode DestructivePunch 
sans activer les pistes pour l'enregistrement » 
à la page 513).

3 Cliquez sur Options > Prepare DPE Tracks. 

Pro Tools consolide l'audio sur toutes les pistes 
en mode DestructivePunch, du début de la session 
jusqu'à la valeur spécifiée dans la préférence 
DestructivePunch File Length. 

Activation des pistes pour 
l'enregistrement en mode 
DestructivePunch
Vous pouvez activer les pistes en mode 
DestructivePunch sans avoir à les préparer pour 
l'enregistrement. Cela vous permet, après 
le lancement de la lecture, d'effectuer un punch-in 
sur des pistes spécifiques en cliquant sur leur bouton 
d'activation pour l'enregistrement. 

Vous pouvez également activer simultanément le 
mode de préparation pour l'enregistrement et le 
mode DestructivePunch pour les pistes audio. Vous 
pouvez ainsi lancer l'enregistrement dès l'activation 
du bouton Record de la fenêtre de transport et le 
début de la lecture. Reportez-vous à la section 
« Activation simultanée du mode DestructivePunch 
et du mode de préparation pour l'enregistrement des 
pistes » à la page 514.

Activation du mode DestructivePunch 
sans activer les pistes pour 
l'enregistrement

Cette méthode permet d'utiliser la commande 
Prepare DPE Tracks pour consolider les fichiers 
pour l'enregistrement en mode DestructivePunch. 

Pour activer le mode DestructivePunch sur une 
piste audio :

 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le bouton 
d'activation pour l'enregistrement de la piste ; il 
s'allume en bleu.

Pour activer le mode DestructivePunch sur toutes 
les pistes audio : 

 Maintenez les touches Alt+ Démarrer (Windows) 
ou Option+Ctrl (Mac) enfoncées et cliquez sur 
le bouton d'activation pour l'enregistrement 
d'une piste ; ils s'allument tous en bleu.

Pour activer le mode DestructivePunch sur toutes 
les pistes audio sélectionnées :

 Maintenez les touches Démarrer+Alt+Maj 
(Windows) ou Option+Ctrl+Maj (Mac) 
enfoncées et cliquez sur le bouton d'activation 
pour l'enregistrement de l'une des pistes 
sélectionnées ; leurs boutons s'allument en bleu.

Pour les clips dont les réglages de gain du clip 
sont différents de 0 dB, la commande Prepare 
DPE Tracks calcule automatiquement le rendu 
de tout les gains du clip, puis les réinitialise à 
0 dB sur les clips obtenus.

Vous pouvez créer un groupe VCA pour chaque 
stem ou ensemble de pistes à enregistrer en 
punch-in/out et utiliser le bouton VCA Record 
Enable pour préparer toutes les pistes du 
groupe à l'enregistrement en mode 
DestructivePunch. Pour plus d'informations, 
reportez-vous à la section « Pistes Master 
VCA » à la page 987.
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Activation simultanée du mode 
DestructivePunch et du mode 
de préparation pour l'enregistrement 
des pistes
Cette méthode peut être utilisée lorsque les pistes 
satisfont déjà les conditions requises pour 
l'enregistrement en mode DestructivePunch.

Pour activer simultanément les modes 
DestructivePunch et de préparation pour 
l'enregistrement sur une piste audio :

 Cliquez sur le bouton d'activation pour 
l'enregistrement de la piste. Ce bouton clignote 
alors en bleu et rouge. 

Pour activer simultanément les modes 
DestructivePunch et de préparation pour 
l'enregistrement sur toutes les pistes audio :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton 
d'activation pour l'enregistrement de la piste. Le 
bouton d'activation pour l'enregistrement de 
toutes les pistes clignote en bleu et rouge.

Pour activer simultanément les modes 
DestructivePunch et de préparation pour 
l'enregistrement sur toutes les pistes audio 
sélectionnées :

 Maintenez les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées et cliquez sur 
le bouton d'activation pour l'enregistrement de 
l'une des pistes sélectionnées. Le bouton 
d'activation pour l'enregistrement des pistes 
sélectionnées clignote en bleu et rouge.

Affichage de l'état d'enregistrement 
des pistes
Lorsque Pro Tools est en mode DestructivePunch, 
l'état du mode d'activation pour l'enregistrement et 
du mode DestructivePunch des pistes est indiqué de 
la manière suivante :

• Si les deux modes sont activés sur une piste, 
son bouton d'activation pour l'enregistrement 
clignote en bleu et rouge. 

• Si le mode DestructivePunch est activé pour une 
piste mais qu'elle n'est pas activée pour 
l'enregistrement, son bouton d'activation pour 
l'enregistrement reste allumé en bleu. 

• Si une piste est uniquement activée pour 
l'enregistrement, son bouton d'activation pour 
l'enregistrement clignote en rouge.

• Si une piste est en cours d'enregistrement 
(quel que soit le mode), son bouton d'activation 
pour l'enregistrement reste allumé en rouge.

Monitoring et niveaux

Pour terminer la configuration du mode 
DestructivePunch : 

1 Configurez le monitoring des pistes activées 
pour l'enregistrement en sélectionnant un mode 
dans leur menu. Vous avez le choix entre les 
options suivantes :

• Set Record Tracks to Auto Input 

• Set Record Tracks to Input Only 

Le choix d'un mode de monitoring affecte 
uniquement les pistes activées pour 
l'enregistrement. 

2 Lancez la lecture. 

3 Pour comparer le niveau de la source d'entrée 
avec celui de l'audio déjà enregistré sur la piste, 
cliquez sur le bouton TrackInput. Lorsqu'il est 
allumé (en vert), le monitoring de l'entrée est 
activé. Lorsqu'il est éteint (gris), le monitoring 
du contenu de la piste est activé (reportez-vous 
à la section « Sélection des modes de monitoring 
pour l'enregistrement avec la commande de 
monitoring d'entrée de piste » à la page 453). 

Dès que les niveaux sont convenablement réglés, 
vous êtes prêt à commencer l'enregistrement en 
punch-in/out. 
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Utilisation du mode 
DestructivePunch 
Une fois que vous avez configuré Pro Tools, 
les pistes et les niveaux, vous pouvez utiliser 
le mode DestructivePunch pour enregistrer 
de plusieurs façons.

Punch-in sur des pistes 
individuelles

Pour effectuer un punch-in sur une piste individuelle :

1 Activez le mode DestructivePunch 
(reportez-vous à la section « Activation du 
mode DestructivePunch » à la page 511). 

2 Maintenez la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, puis cliquez sur le bouton 
d'activation pour l'enregistrement de chaque piste 
concernée afin de n'activer que le mode 
DestructivePunch. Le bouton d'activation pour 
l'enregistrement de la piste reste allumé en bleu. 

3 Cliquez sur le bouton Record de la fenêtre 
de transport pour préparer l'enregistrement en 
mode DestructivePunch. Le bouton Record 
clignote en bleu et rouge.

4 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

5 Pendant la lecture, vous pouvez effectuer 
un punch-in ou un punch-out sur des pistes 
individuelles activées pour l'enregistrement 
en mode DestructivePunch en cliquant sur leur 
bouton d'activation pour l'enregistrement.

6 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes et 
du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres de 
préférence Audio Track Record Lock et 
Transport Record Lock. 

Punch-in sur plusieurs pistes

Pour effectuer un punch-in sur plusieurs pistes 
simultanément :

1 Activez le mode DestructivePunch 
(reportez-vous à la section « Activation du 
mode DestructivePunch » à la page 511). 

2 Cliquez sur le bouton d'activation pour 
l'enregistrement de chaque piste concernée afin 
qu'elles passent en mode DestructivePunch 
et soient activées pour l'enregistrement. 
Le bouton d'activation pour l'enregistrement 
de chaque piste clignote en bleu et rouge. 

3 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

4 Pendant la lecture, cliquez sur le bouton Record 
de la fenêtre de transport pour activer ou 
désactiver simultanément l'enregistrement sur les 
pistes en mode DestructivePunch. 

5 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes 
et du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres 
de préférence Audio Track Record Lock 
et Transport Record Lock.

Lancement immédiat 
de l'enregistrement sur 
plusieurs pistes

Pour effectuer un punch-in sur plusieurs pistes :

1 Activez le mode DestructivePunch 
(reportez-vous à la section « Activation du 
mode DestructivePunch » à la page 511). 

2 Cliquez sur le bouton d'activation pour 
l'enregistrement de chaque piste concernée afin 
qu'elles passent en mode DestructivePunch 
et soient activées pour l'enregistrement. Le bouton 
d'activation pour l'enregistrement de chaque piste 
clignote en bleu et rouge. 
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3 Cliquez sur le bouton Record de la fenêtre 
de transport pour préparer l'enregistrement en 
mode DestructivePunch. Le bouton Record 
clignote en bleu et rouge.

4 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport.

5 Pendant la lecture, vous pouvez effectuer 
un punch-in ou un punch-out sur des pistes 
individuelles activées pour l'enregistrement 
en mode DestructivePunch en cliquant sur leur 
bouton d'activation pour l'enregistrement.

6 Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, l'état du bouton 
d'activation pour l'enregistrement des pistes et 
du bouton Record de la fenêtre de transport 
dépend de la configuration des paramètres de 
préférence Audio Track Record Lock et 
Transport Record Lock. 

Exemples de workflows 
en modes TrackPunch et 
DestructivePunch
Les modes TrackPunch et DestructivePunch 
permettent d'effectuer des enregistrements en punch-
in/out de plusieurs façons différentes. Le mode 
DestructivePunch par exemple permet d'utiliser 
Pro Tools à la manière d'un enregistreur multipiste 
numérique pour le réenregistrement de films et le 
mixage (reportez-vous à la section « Doublage et 
mixage de films » à la page 517). 

Des raccourcis clavier et des paramètres par défaut 
pour l'enregistrement et le monitoring d'entrée 
offrent un niveau de flexibilité qui rend les modes 
TrackPunch ou DestructivePunch tout aussi utiles 
pour les workflows suivants, couramment utilisés 
en production film, vidéo et musique :

• Chargement de rushes (reportez-vous 
à la section « Chargement de rushes avec 
verrouillage de l'enregistrement » à la page 518)

• Enregistrement de bruitages (reportez-vous à la 
section « Enregistrement de bruitages » 
à la page 518)

• Enregistrement et overdub en production musicale 
ou tout autre environnement d'enregistrement 
(reportez-vous à la section « Enregistrement et 
overdub en musique » à la page 519)

Pro Tools pouvant être utilisé en réseau, 
les fichiers audio TrackPunch (et tous les autres), 
ainsi que des sessions entières peuvent être 
transférés de façon sécurisée vers d'autres 
systèmes pour leur vérification, modification 
et archivage. 

Si vous ne maîtrisez pas encore le routing, la 
sélection et le groupement de pistes dans 
Pro Tools, reportez-vous au Chapitre 13, 
« Pistes » et au Chapitre 43, « Principes de 
base du mixage ».

Dans l'ensemble de ces exemples, les références 
au mode TrackPunch peuvent également 
s'appliquer au mode DestructivePunch 
(souvenez-vous simplement que le mode 
TrackPunch est non destructif, alors que 
le mode DestructivePunch permet d'enregistrer 
en punch-in/out de manière destructive). 
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Doublage et mixage de films 
Les fonctionnalités de doublage et de mixage de 
films des modes TrackPunch et DestructivePunch 
offrent les possibilités suivantes :

• Activation et enregistrement en punch-in/out de 
pistes audio Pro Tools à distance et à tout 
moment, à partir d'un synchroniseur maître tel 
que le SoundMaster via des commandes P2, sans 
interruption de la lecture et tout en maintenant la 
synchronisation avec le timecode (option 
MachineControl requise).

• Basculement des pistes audio Pro Tools entre 
le monitoring d'entrée et le retour des fichiers 
sur disque. 

• Utilisation de Pro Tools en tant que périphérique 
maître de timecode (génération) ou en mode 
asservi. 

• Enregistrement en punch-in/out non destructif 
en mode TrackPunch ou destructif en mode 
DestructivePunch. 

La préparation d'une session standard inclut les 
étapes suivantes :

1 Configurez la synchronisation entre Pro Tools 
et les autres périphériques. 

2 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

3 Sélectionnez (activez) l'option Transport 

Record Lock. Le bouton Record des 
commandes de transport restera ainsi activé 
après l'arrêt du transport.

4 Désactivez l'option Audio Track Record Lock. 
La piste audio enregistrée sortira alors du mode 
de préparation à l'enregistrement à l'arrêt 
du transport.

5 Effectuez l'une des opérations suivantes : 

• Sélectionnez Options > TrackPunch pour activer 
le mode TrackPunch et effectuer 
un enregistrement en punch-in/out 
non destructif. 

• Sélectionnez Options > DestructivePunch pour 
activer l'enregistrement en mode 
DestructivePunch. 

6 Créez 32 pistes.

7 Assignez les entrées des pistes.

8 Groupez les pistes par huit. 

9 Cliquez sur les boutons d'activation pour 
l'enregistrement des huit premières pistes pour 
les faire passer en mode TrackPunch (le groupe 
pour le premier pré-doublage).

10 Assignez les commandes de la télécommande 
de la console au premier groupe de huit pistes 
de la session. 

11 Commencez la passe de pré-doublage. Utilisez 
la télécommande de la console pour armer 
Pro Tools et effectuer des punch-ins et outs sur 
le premier groupe. 

En mode distant, l'option Transport Record 
Lock n'a aucun effet. Le synchroniseur 
détermine le comportement du système.

En mode distant, la fonction Audio Track 
Record Lock n'a aucun effet. Le synchroniseur 
détermine le comportement du système.

Utilisez la liste de groupes pour sélectionner 
rapidement toutes les pistes du groupe, puis 
cliquez en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées 
pour activer pour l'enregistrement toutes les 
pistes du groupe.
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12 Lorsque le premier pré-doublage est terminé 
et qu'un punch-out a été effectué sur toutes les 
pistes, désactivez le mode TrackPunch 
ou DestructivePunch sur toutes les pistes.

13 Sélectionnez le groupe de pistes suivant 
et activez le mode TrackPunch ou 
DestructivePunch.

14 Enregistrez en punch-in/out sur le deuxième 
groupe de pistes. 

15 Répétez les étapes précédentes autant de fois 
que nécessaire.

Chargement de rushes avec 
verrouillage de l'enregistrement
Les rushes et types de transferts similaires sont 
composés de plusieurs prises ou scènes, chacune 
étant enregistrée tout en étant synchronisée sur un 
timecode horaire unique. Entre chaque prise, le 
timecode ne continue pas ; il est totalement 
interrompu. C'est pourquoi le timecode des rushes 
et des données source similaires est dit 
« discontinu » (ou interrompu). 

Par défaut, Pro Tools sort de l'enregistrement 
lorsqu'il passe hors ligne suite à une interruption de 
timecode. Cependant, il est possible de modifier ce 
comportement afin que Pro Tools reste préparé 
pour l'enregistrement et soit prêt à relancer 
l'enregistrement dès que le verrouillage sur 
le timecode de la pris suivante est rétabli. 

Pour configurer le verrouillage de l'enregistrement 
pour le chargement de rushes :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2 Activez l'option Transport Record Lock. 

3 Activez l'option Audio Track Record Lock. 

4 Configurez la synchronisation et les autres 
paramètres. 

5 Mettez Pro Tools en ligne et lancez le lecteur 
source externe. 

6 Chaque fois que le timecode est interrompu 
ou s'arrête, Pro Tools reste online et attend 
de recevoir un nouveau timecode. Le transport et 
les pistes activées pour l'enregistrement restent 
dans cet état. Lorsque le timecode reprend, 
Pro Tools lance l'enregistrement dans un 
nouveau fichier audio (avec un marquage 
temporel correct basé sur le code entrant). 

Enregistrement de bruitages 
L'enregistrement de bruitages est l'un des types 
d'enregistrement les plus spécialisés de la production 
de films, avec des conditions de monitoring bien 
particulières. Entre deux opérations de punch ou 
prises successives, les entrées doivent être mutées 
afin que les bruiteurs puissent se déplacer et s'équiper 
pour le bruitage suivant. 

La fonction de monitoring TrackInput peut être 
configurée pour s'adapter à l'enregistrement 
de bruitages en mode TrackPunch avec la préférence 
Mute Record-Armed Tracks While Stopped.

Pour configurer Pro Tools pour le monitoring 
d'enregistrement de bruitages en punch-in/out : 

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Activez l'option Mute Record-Armed Tracks 

While Stopped.

Pro Tools disposant d'une limite de timeline de 
24 heures, vous devez utiliser plusieurs 
sessions pour charger les rushes, si leur 
timecode s'étend sur plus de 24 heures.
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3 Configurez la synchronisation et d'autres 
paramètres pour Pro Tools et vos autres 
périphériques. 

4 Activez le mode TrackPunch ou 
DestructivePunch et procédez à 
l'enregistrement en punch-in/out. 

Si l'option Mute Record-Armed Tracks While 
Stopped est activée lors d'un enregistrement 
online, les pistes activées pour l'enregistrement 
sont mutées dès que le transport est arrêté. 
Le monitoring des entrées reste possible, à tout 
moment, en cliquent sur les boutons TrackInput. 

Enregistrement et overdub 
en musique 
L'enregistrement multipiste moderne requiert la 
possibilité de « capturer l'instant » en effectuant un 
punch-in/out à la volée, comme le permet le mode 
TrackPunch. Le mode TrackPunch disposes des 
avantages suivants pour toutes les situations 
d'enregistrement, d'overdub et de punch-in/out :

• Possibilité d'activer des pistes pour 
l'enregistrement alors que le transport est actif. 

• Possibilité d'effectuer un punch-in/out à l'aide 
des boutons d'activation pour l'enregistrement, à 
distance à partir d'un synchroniseur, à partir 
d'une surface de contrôle ou à l'aide d'une 
pédale. 

• Possibilité de comparer et uniformiser les 
niveaux à l'aide du bouton TrackInput. 
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Chapitre 24 : Opérations d'édition de base

Utilisez la fenêtre Edit de Pro Tools pour éditer et 
arranger les contenus audio, vidéo et MIDI. 
Le contenu des pistes peut être édité de façon non 
destructive et en temps réel pendant la lecture. 

La fenêtre Edit permet également d'éditer 
graphiquement d'autres données, comme expliqué 
dans les chapitres suivants :

Édition de clips et sélections : reportez-vous au 
Chapitre 27, « Édition des clips et sélections ». 
et au Chapitre 37, « Organisation des clips ».

Édition de fondus et fondus enchaînés : 
reportez-vous au Chapitre 28, « Fondus et fondus 
enchaînés ».

Édition Elastic Audio : reportez-vous au 
Chapitre 40, « Elastic Audio ».

Édition MIDI : reportez-vous au Chapitre 31, 
« Édition MIDI ».

Édition de l'automation : reportez-vous au 
Chapitre 45, « Automation ».

Édition vidéo : reportez-vous au Chapitre 52, 
« Utilisation de la vidéo dans Pro Tools ».

Édition non destructive
La grande majorité des opérations d'édition audio 
dans Pro Tools sont non destructives. Qu'il s'agisse 
de couper, coller, effectuer une opération de trim, 
séparer ou supprimer des clips, vous n'agissez que 
sur des références pointant vers les médias eux-
mêmes (des fichiers audio par exemple). Les fichiers 
source demeurent intacts. Cependant, certains 
processus ou outils indiqués dans ce guide 
fonctionnent de façon destructive (ils modifient 
définitivement les fichiers audio de votre disque dur).

Si l'édition de pistes MIDI peut être destructive 
dans certains cas, le respect de quelques 
précautions vous permettra de préserver vos 
pistes et vos clips MIDI importants lorsque 
vous effectuerez des opérations d'édition 
(reportez-vous à la section « Édition MIDI non 
destructive » à la page 532).

Édition en cours de lecture
Pro Tools permet d'effectuer de nombreuses tâches 
d'édition pendant la lecture de la session. Cette 
particularité permet de modifier et d'éditer une 
session de façon interactive, puisque vous entendez 
immédiatement les modifications apportées. 

Pour l'écoute et l'édition de boucles en cours 
de lecture, utilisez les modes de lecture en 
boucle et de transport dynamique. Reportez-
vous à la section « Modes de lecture » à la 
page 425.
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Les opérations suivantes sont des exemples de 
tâches d'édition et d'organisation pouvant être 
effectuées lors de la lecture d'une session 
Pro Tools :

• Capture, séparation, coupe, copie, collage et 
trim de clips

• Placement, positionnement ou réorganisation de 
clips

• Ajout de fondus ou fondus enchaînés à des clips 
audio

• Quantification de notes MIDI et d'événements 
audio

• Transposition ou autre modification de 
pistes MIDI

• Déplacement par incrément de clips audio 
ou MIDI

• Écoute de différentes playlists

• Ajustement ou déplacement de données 
d'automation ou de contrôleur continu MIDI

• Insertion de plug-ins en temps réel

• Application d'un traitement Elastic Audio en 
temps réel (et rendu)

• Traitement de données audio avec un plug-in 
AudioSuite

• Édition de l'automation

Lorsque Pro Tools est en lecture, certains aspects 
ne peuvent être modifiés. Ce guide s'y rapporte au 
fur et à mesure de la présentation des fonctions.

Contenu des pistes
Chaque fois que vous enregistrez ou importez de 
l'audio, de la vidéo et du MIDI, Pro Tools crée des 
clips pour les nouvelles données de la piste, 
qui indiquent leurs points de début et de fin, 
et offrent également un aperçu de leurs 
caractéristiques et de leur contenu. Lorsque vous 
enregistrez des prises supplémentaires, 
ou effectuez un punch-in à un emplacement donné 
d'une piste, Pro Tools crée des clips.

Des clips sont également créés lors d'opérations de 
coupe et de collage, de redimensionnement, de 
séparation et de recapture des clips existants. Les 
clips d'une session sont affichés dans la liste des 
clips, à partir de laquelle vous pouvez les faire 
glisser sur des pistes existantes. Une piste peut 
contenir un nombre indifférent de clips, dans 
n'importe quelle disposition. La playlist d'une piste 
définit l'ordre de lecture et l'emplacement des clips 
d'une piste. 

En plus des clips audio et MIDI, les pistes offrent 
des playlists d'automation pour toutes les données 
d'automation (notamment de volume et de 
panoramique). L'automation peut être enregistrée 
et éditée dans les fenêtres Edit et Mix, ou dans 
l'éditeur MIDI (reportez-vous au Chapitre 45, 
« Automation »). 

Types de clips
Il existe différents types de clips audio et MIDI, 
basés sur la façon dont ils ont été créés :

Pour plus d'informations sur les clips vidéo, 
reportez-vous au Chapitre 52, « Utilisation de 
la vidéo dans Pro Tools ».
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Clips audio de fichier entier : ces clips audio sont 
créés lors de l'enregistrement ou de l'importation 
d'audio, de la consolidation de clips existants et 
d'un traitement non destructif avec un plug-in 
AudioSuite. Les clips audio de fichier entier 
référencent un fichier audio entier stocké sur votre 
disque dur. Ces clips sont affichés en gras dans la 
liste des clips (reportez-vous au Chapitre 15, « La 
liste des clips »). Les clips normaux ne font 
souvent référence qu'à une partie de leur fichier 
audio parent et sont créées pendant l'édition et, 
dans certains cas, lors d'un enregistrement en 
punch-in/out ou en boucle. 

Clips définis par l'utilisateur : ces clips sont 
définis de façon explicite par l'utilisateur, 
par exemple lors de l'enregistrement ou de 
l'importation de données audio ou MIDI, de la 
capture, séparation ou consolidation d'une 
sélection, d'une opération de trim sur un clip audio 
de fichier entier ou encore de la modification du 
nom d'un clip existant.

Clips créés automatiquement : ces clips sont 
créés automatiquement lors de l'édition et, 
dans certains cas, lors d'un enregistrement en 
punch-in/out sur des clips existants. Dans la 
mesure où ces clips peuvent rapidement 
s'accumuler dans une session, vous pouvez les 
masquer dans la liste des clips. Les clips créés 
automatiquement peuvent être transformés en clips 
définis par l'utilisateur en les renommant.

Clips hors ligne : les clips sont hors ligne lorsque 
leurs fichiers parents sont introuvables ou non 
disponibles à l'ouverture d'une session ou à 
l'importation d'une piste. Les clips hors ligne sont 
estompés et en italique dans la liste des clips et 
apparaissent en bleu clair avec un nom en italique 

dans les playlists. Les clips hors ligne peuvent être 
édités au même titre que les autres clips, mais ne 
peuvent pas être traités avec des plug-ins 
AudioSuite. 

Clips multicanal : ces clips, affichés sous la forme 
d'un clip unique dans la liste des clips, font 
référence à plusieurs clips et fichiers audio pour les 
pistes stéréo et surround. Les clips multicanal 
peuvent être développés (en cliquant sur le triangle 
qui se trouve à côté de leur nom) pour faire 
apparaître leurs différents canaux, que vous 
pouvez alors faire glisser sur les pistes 
indépendamment les uns des autres.

Groupes de clips : un groupe de clips est 
une combinaison de clips audio et MIDI qui 
se présente et agit comme un clip unique. 
Les groupes de clips servent essentiellement 
de conteneur pour un ou plusieurs clips. 
Les groupes de clips peuvent être créés sur une 
seule piste ou sur plusieurs pistes adjacentes audio, 
MIDI et d'instrument. Ils permettent d'imbriquer 
plusieurs clips dans un macro-clip et facilitent ainsi 
la manipulation du groove et du tempo, l'édition et 
l'arrangement (reportez-vous à la section 
« Groupes de clips » à la page 877). 

Clips déformés : des déformations peuvent être 
appliquées aux clips situés sur des pistes Elastic 
Audio en temps réel. Les clips ainsi déformés sont 
identifiables par l'indicateur de déformation 
apparaissant dans leur coin supérieur droit, 
et à gauche des noms dans la liste des clips. 
Les clips déformés sont le résultat d'un traitement 
Elastic Audio. Le traitement Elastic Audio peut être 
appliqué manuellement en vue Warp ou à l'aide de 
l'outil de trim TCE en vue Waveform, ou 
automatiquement suite à une opération de 
conformation au tempo, de quantification ou de 
transposition (reportez-vous à la section « Clips 
déformés » à la page 925). 

Pour plus d'informations, reportez-vous à la 
section « Attribution de noms et affichage des 
clips dans la liste des clips » à la page 275. 
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Clips audio et formes d'onde
Lorsque les pistes audio sont affichées en vue 
Waveform, Pro Tools représente les données audio 
sous forme d'un diagramme appelé forme d'onde 
audio. Les formes d'onde audio donnent de 
nombreuses informations sur les sons enregistrés.

Dans l'image ci-dessus, les « crêtes » représentent 
les emplacements de l'enregistrement où l'attaque 
du son entraîne une augmentation momentanée du 
volume. Elles sont suivies de « creux » où le 
volume diminue.

À chaque type de son correspond un type de forme 
d'onde différent. La batterie, par exemple, produit 
en général des formes d'onde avec des transitoires 
marqués (des crêtes de courte durée), clairement 
visibles. Un son de grosse caisse ou de caisse claire 
est caractérisé par une attaque puissante et franche 
suivie d'une décroissance rapide du son.

D'autres sons, tels que les voix ou les pads de 
synthétiseur avec sustain, produisent des formes 
d'ondes très différentes. Ces sons ont des crêtes et 
des creux moins prononcés, leurs attaques étant 
plus douces et leurs décroissances plus longues.

Vues des formes d'onde
Pro Tools propose plusieurs options d'affichage pour 
les formes d'onde. En fonction de la tâche d'édition, 
vous avez le choix entre différentes vues.

Calcul des aperçus des formes 
d'onde
Les aperçus des formes d'onde peuvent être calculés en 
mode Peak (crêtes) ou Power (puissance). 

Pour définir le mode de calcul des formes d'onde :

 Sélectionnez View > Waveforms, puis Peak 
ou Power. 

Peak : dans ce mode, les formes d'onde sont 
calculées en se basant sur le niveau crête échantillon 
par échantillon. La vue Peak est la méthode de 
calcul standard de l'aperçu des formes d'onde dans 
Pro Tools. Cette vue peut être utilisée pour les vues 
normales ou redressées. La vue Peak affiche 
clairement les écrêtages sur la forme d'onde.

Power : dans ce mode, les formes d'onde sont 
calculées en se basant sur le niveau RMS (niveau 
moyen). La vue Power peut être utilisée pour les vues 
normales ou redressées. La vue Power permet de 
mieux visualiser les caractéristiques des données 
audio dans la forme d'onde, lorsque vous effectuez un 
zoom arrière et passez à un niveau d'affichage 
supérieur à celui de l'échantillon. Pour les applications 
de mastering en particulier, cette vue permet de mieux 
rendre compte des caractéristiques sonores de l'audio 
que la vue Peak.

Forme d'onde audio d'une piste de batterie

Vue de forme d'onde normale Peak avec contours

En cas de zoom au niveau de l'échantillon, 
Pro Tools affiche toujours la vue Peak.

Vue de forme d'onde normale Power avec contours
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Formes d'onde redressées
Les excursions positives et négatives des formes 
d'onde redressées (c'est-à-dire les parties situées au-
dessus et en dessous de l'axe central) sont sommées 
et présentées sous la forme d'un signal uniquement 
positif. Cette vue permet d'afficher des formes 
d'onde plus détaillées, que la hauteur de piste soit 
normale ou réduite. Elle est particulièrement utile 
lors de l'édition de données d'automation de volume, 
puisque le niveau des formes d'onde est représenté à 
partir du bas de la piste. La vue redressée est 
disponible à la fois en mode Peak et Power.

Pour afficher les formes d'onde redressées 
(ou normales) :

 Sélectionnez (ou désélectionnez) View > 
Waveforms > Rectified.

Formes d'onde avec contours
Les formes d'onde avec contours offrent une 
définition plus visuelle, en particulier si celles-ci 
sont visualisées à une certaine distance. Vous 
pouvez désactiver les contours lorsque vous devez 
effectuer une opération d'édition précise et 
détaillée en vue de forme d'onde Peak. 
Les contours ne sont pas affichés lorsque vous 
effectuez un zoom au niveau de l'échantillon.

Pour afficher (ou masquer) les contours des 
formes d'onde :

 Sélectionnez (ou désélectionnez) View > 
Waveforms > Outlines.

Lors d'un enregistrement, la vue Peak est 
toujours affichée. La vue Power est calculée 
et affichée uniquement après l'arrêt 
de l'enregistrement.

La vue Power n'est pas disponible en mode 
Destructive Punch ou en cas de zoom au 
niveau de l'échantillon.

Vue de forme d'onde Peak redressée avec contours

Vue de forme d'onde Power redressée avec contours

En cas de zoom au niveau de l'échantillon, 
Pro Tools affiche toujours les formes d'onde 
en vue Peak normale.

Vue de forme d'onde Peak normale sans contours

Vue de forme d'onde Power normale sans contours

Vue de forme d'onde Peak redressée sans contours

Vue de forme d'onde Power redressée sans contours
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Directives pour l'édition des 
formes d'onde
À l'aide du Sélecteur dans la fenêtre Edit, 
vous pouvez sélectionner des parties de formes 
d'onde audio et les diviser en segments appelés 
clips, afin de pouvoir les réorganiser et les 
manipuler sur les pistes.

Lors de l'édition de contenus musicaux, essayez de 
créer des clips qui permettent de maintenir un 
tempo constant. Si vos clips contiennent toujours 
un nombre entier de temps, vous pourrez les 
enchaîner et conserver un rythme régulier et 
continu.

Il est parfois utile d'avoir une forme d'onde de 
référence régulière et bien définie, une piste de 
batterie ou de métronome par exemple, qui peut 
servir de témoin lorsque vous sélectionnez et créez 
d'autres clips. Si vous jouez en rythme, il devrait 
être plus facile de créer des clips rythmiquement 
précis en vous basant sur la forme d'onde de 
référence.

Lorsque vous éditez des clips, respectez les règles 
suivantes :

 Dans la mesure du possible, le point de début 
d'un clip doit se trouver immédiatement avant une 
crête de volume, et son point de fin immédiatement 
avant une autre.

 Dans la mesure du possible, les points de début 
et de fin d'un clip doivent se trouver exactement 
sur le même emplacement rythmique d'une 
mesure.

 Utilisez les fonctionnalités de Pro Tools 
suivantes pour créer des clips exploitables en 
éditant des contenus rythmiques ou de l'audio 
comprenant des transitoires marqués :

• Tabulation vers transitoires (reportez-vous à la 
section « Tabulation vers les transitoires » à la 
page 587)

• Édition sur une grille (reportez-vous à la section 
« Mode Grid » à la page 545)

• Beat Detective (reportez-vous au Chapitre 30, 
« Beat Detective »)

Éviter les clics et les pops
Si un clip édité débute ou se termine sur un point 
d'amplitude élevée, vous risquez d'entendre un clic 
lors de la transition d'un clip à l'autre. Afin d'éviter 
les clics et les pops, effectuez l'une des opérations 
suivantes :

 Assurez-vous que les points de début et de fin 
de votre sélection se trouvent aussi près que 
possible du point où l'amplitude de la forme d'onde 
diminue et coupe la ligne de passage par zéro 
(l'axe horizontal central dans l'affichage de la 
forme d'onde de la piste). Si nécessaire, utilisez les 
outils de zoom de la fenêtre Edit (reportez-vous à 
la section « Méthodes de zoom » à la page 548) 
pour afficher les formes d'onde avec davantage de 
détails.

 Appliquez un fondu enchaîné entre des clips où 
se produit un clic. Reportez-vous à la section 
« Création d'un fondu enchaîné » à la page 635 
pour plus de détails.

 Sur Pro Tools HD, utilisez la fonction AutoFade 
afin d'appliquer des fondus d'entrée et de sortie en 
temps réel à toutes les limites des clips qui ne 
touchent, ni ne chevauchent d'autres clips. Pour 
plus d'informations, reportez-vous à la section 
« Utilisation des fondus automatiques » à la page 
637.

Sélection débutant et se terminant sur un point de 
passage par zéro
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Édition audio non destructive
Lorsque vous éditez la playlist d'une piste audio 
dans Pro Tools, vous ne coupez ni ne déplacez 
réellement d'extraits sonores, comme vous le feriez 
avec une bande analogique. Pro Tools crée des 
références au fichier audio stocké sur votre disque 
dur, qui décrivent l'ordre dans lequel les 
différentes portions de la piste doivent être lues.

Lorsque vous effectuez un trim sur des clips audio 
à l'aide de l'un des outils de trim ou lorsque vous 
modifiez le placement ou l'ordre des clips sur une 
piste, vous pouvez utiliser plusieurs playlists, afin 
de pouvoir retrouver facilement l'état précédent 
d'une piste. Pour plus d'informations, reportez-
vous à la section « Playlists » à la page 645.

Clips audio et données 
d'automation
Les données d'automation audio résident sur 
les pistes et non dans la liste des clips. Ainsi, 
lorsque vous déplacez un clip audio de la liste des 
clips vers une nouvelle piste, aucune donnée 
d'automation n'est placée sur la piste. En revanche, 
si vous déplacez un clip audio d'une piste existante 
(contenant des données d'automation) vers une 
autre piste, les données d'automation de la piste 
source sont placées sur la piste de destination.

Vous pouvez éditer des données d'automation en 
activant une autre vue de piste ou en affichant les 
lignes d'automation en-dessous de la piste.

Clips MIDI et données MIDI
Les deux vues de piste les plus couramment 
utilisées pour les pistes MIDI et d'instrument sont 
les vues Notes et Clips.

 Utilisez la vue Clips pour organiser les clips.

 Utilisez la vue Notes pour insérer et éditer des 
notes MIDI individuelles ou travailler sur des 
groupes de notes et les modifier.

Vue Clips pour les pistes MIDI et 
d'instrument
Les pistes MIDI et d'instrument peuvent également 
être affichées en vue Clips. Cette vue est très 
similaire à la vue Waveform pour les pistes audio. 
Bien que les notes d'une piste soient visibles dans la 
vue Clips, l'édition de notes individuelles n'est pas 
possible dans cette vue. En revanche, toutes les 
opérations d'édition affectent une plage de temps 
englobant toutes les données de la piste, 
en particulier les événements de contrôleur continu, 
de changement de programme et de type System 
Exclusive.

Utilisez la vue Clips pour éditer des clips qui 
représentent des sections et des clips d'un morceau 
ou pour réorganiser ou regrouper des éléments 
d'une piste.

En vue Clips, l'échelle de zoom vertical est définie 
automatiquement de manière à afficher toute la 
plage de hauteurs des notes MIDI de la piste.

Pour plus d'informations sur l'automation, 
reportez-vous au Chapitre 45, « Automation ».

Pour plus d'informations sur l'activation des 
vues de piste, reportez-vous à la section 
« Vues de piste » à la page 223.

Pour passer de la vue de piste Notes à la vue de 
piste Clips, cliquez sur la piste de votre choix 
et appuyez sur Démarrer+Moins (-) 
(Windows) ou Ctrl+Moins (-) (Mac) sur le 
clavier alphanumérique.
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Toutefois, vous devez respecter un certain nombre 
de principes lorsque vous sélectionnez, coupez, 
copiez et effectuez une opération de trim sur des 
clips MIDI :

 Lorsque vous coupez ou supprimez une sélection 
de clip ou de groupe de clips incluant le début d'une 
note, toute la note est supprimée. C'est le cas même 
si vous n'avez sélectionné qu'une partie de la note 
(du moment qu'elle inclut son point de début).

 Lorsque vous coupez ou supprimez une 
sélection de clip ou de groupe de clips contenant la 
fin d'une note (mais pas son point de début), la note 
est conservée et déborde du clip.

 Des règles similaires s'appliquent également 
lorsque vous effectuez une opération de trim avec 
l'un des outils de trim sur des clips MIDI ou des 
groupes de clips contenant des clips MIDI. Si le 
point de début du clip MIDI est déplacé au-delà du 
point de début de la note, cette dernière est 
supprimée. Si vous effectuez un trim sur le point de 
fin du clip et que le point de début de la note se 
trouve dans le clip mais que son point de fin ne s'y 
trouve pas, la note est conservée et dépasse du bord 
du clip.

Lorsque vous déplacez et positionnez des clips 
MIDI comportant des notes qui dépassent, les notes 
se déplacent toujours avec les clips. Lorsque vous 
positionnez des clips MIDI comportant des notes 
qui dépassent à côté ou près d'un autre clip, les notes 
superposées viennent se positionner à l'intérieur du 
clip suivant de la piste.

Création de clips MIDI sur des barres 
de mesure

Lorsque vous enregistrez des données MIDI ou 
entrez manuellement des notes MIDI, le début et la 
fin des clips MIDI sont alignés sur des limites de 
mesure. Les clips MIDI peuvent ainsi être arrangés 
en fonction de la métrique et du tempo, par 
mesures entières.

Le début d'un clip MIDI enregistré commence 
toujours sur la barre de mesure qui précède 
immédiatement la première note MIDI (Note On) 
du clip. De même, le clip MIDI se termine sur la 
barre de mesure qui suit immédiatement la 
dernière note (Note Off) du clip. 

Pour ouvrir un clip MIDI dans l'éditeur 
MIDI, double-cliquez sur le clip. Reportez-
vous au Chapitre 32, « Éditeurs MIDI ».

Coupe d'un clip MIDI avec un chevauchement de note

Pour séparer des notes MIDI plutôt que de les 
laisser en suspens lorsque vous séparez, 
coupez ou copiez des clips, effectuez la 
sélection d'édition souhaitée, basculez en vue 
Notes et utilisez la commande Separate At 
Selection, puis basculez à nouveau en vue 
Clips et effectuez la modification (séparation, 
coupe ou copie).
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Clips MIDI et événements de contrôleur 
continu

Les événements de contrôleur résident dans les 
clips MIDI et non sur les pistes. Ainsi, lorsque 
vous déplacez un clip contenant des données de 
contrôleur depuis une piste ou la liste des clips, ces 
données sont écrites sur la piste de destination.

Vous pouvez éditer les événements de contrôleur 
continu en activant une autre vue de piste ou en 
affichant les lignes de contrôleur sous la piste.

Automation de mute MIDI

Contrairement aux événements de contrôleur 
continu, qui représentent des nuances au sein d'une 
performance MIDI, le mute dans Pro Tools est 
géré par une playlist d'automation qui mute en 
réalité le moteur MIDI. L'automation de mute ne 
correspond pas à des événements MIDI réels et 
n'est donc pas exportée lors de la sauvegarde sous 
la forme d'un fichier MIDI standard.

Vue Notes pour les pistes MIDI 
et d'instrument
Lorsque la vue d'une piste MIDI ou d'instrument 
est définie sur Notes, les notes MIDI sont affichées 
sous la forme d'une bande perforée pour piano 
mécanique. Chaque note est représentée par un 
petit rectangle, sa position verticale indiquant sa 
hauteur et sa position horizontale son 
emplacement temporel (et sa durée).

À gauche de la playlist de la piste MIDI ou 
d'instrument se trouve, pour référence de hauteur, 
un mini-clavier vertical, avec un numéro d'octave. 
Vous pouvez cliquer sur le mini-clavier pour jouer 
des notes via la sortie MIDI sélectionnée pour la 
piste. Les flèches situées au-dessus et au-dessous 
du mini-clavier (non visibles avec les plus petites 
hauteurs de piste) permettent de faire défiler 
l'affichage des notes vers le haut ou le bas.

En vue Notes, la plage de hauteurs de notes MIDI 
affichable dépend de la hauteur de la piste et de la 
valeur du zoom. Une ligne d'un pixel apparaît en 
haut ou en bas de la plage de notes affichée si une 
note se situe hors de cette plage.

Pour en savoir plus sur l'édition des données 
de contrôleur MIDI, reportez-vous au 
Chapitre 31, « Édition MIDI ». Notes affichées sur une piste MIDI

Si vous cliquez sur le mini-clavier, 
la sélection d'édition actuelle est effacée. 
Pour plus d'informations, reportez-vous 
à la section « Sélection de notes MIDI » à 
la page 700.

Flèche vers le haut

Flèche vers 
le bas

Note MIDI au-dessus de la 
plage affichée

Clavier de référence Note MIDI
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Pour faire défiler l'affichage des notes d'une piste 
MIDI ou d'instrument vers le haut ou le bas, 
effectuez l'une des opérations suivantes :

 Cliquez sur la flèche vers le haut ou vers le bas 
du mini-clavier.

 Sélectionnez l'un des outils de la fenêtre 
Edit (l'outil de saisie du temps par exemple), 
appuyez sur Commande+Option+Ctrl (Mac) 
ou Ctrl+Alt+Démarrer (Windows), puis cliquez 
et faites glisser votre souris vers le haut ou le 
bas sur le mini-clavier.

 Si votre souris dispose d'une molette de 
défilement, placez le pointeur sur la piste 
et appuyez sur Commande+Option+Ctrl (Mac) 
ou Ctrl+Alt+Démarrer (Windows), puis cliquez 
et faites glisser l'affichage des notes vers le haut 
ou le bas.

À l'aide des outils de la fenêtre Edit, vous pouvez 
insérer, supprimer, transposer, effectuer une 
opération de trim et déplacer des notes. Pour plus 
d'informations, reportez-vous à la section « Édition 
manuelle des notes MIDI » à la page 700.

Édition MIDI non destructive
Si l'édition de clips audio est en général non 
destructive, ce n'est habituellement pas le cas des 
clips MIDI. Par exemple, si un clip MIDI se trouve 
à un seul endroit sur une seule piste, l'édition de ce 
clip est destructive. Cela signifie que la 
modification de la hauteur, de la durée ou du 
positionnement des notes en vue Notes modifie 
définitivement le clip.

Cependant, si l'option Mirror MIDI Editing est 
désactivée, lorsque vous éditez un clip MIDI dont 
une copie est présente ailleurs dans la session (sur 
la même piste mais à un autre emplacement ou dans 
une playlist différente, ou sur une autre piste), 
l'édition est non destructive et un clip créé 
automatiquement est ajouté. Pour rétablir les 
données précédentes, faites glisser le clip d'origine 
depuis la liste des clips ou rappelez une playlist 
préalablement sauvegardée.

Défilement de notes avec la flèche vers le haut du 
mini-clavier

Défilement de l'affichage des notes par glissement

Les playlists permettent de restaurer en 
toute sécurité l'état précédent d'une piste. 
Avant d'éditer des notes ou bien de faire un 
trim ou de réorganiser des clips, faites une 
copie de la playlist de la piste, puis éditez 
cette copie (reportez-vous à la section 
« Playlists » à la page 645).

Pour appliquer des modifications à toutes 
les instances d'un clip MIDI, activez le 
mode d'édition MIDI en miroir (reportez-
vous à la section « Édition MIDI en miroir » 
à la page 695).
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Attribution de noms aux clips
Vous pouvez renommer les clips afin de rendre leur 
nom plus explicite ou plus simple. Lorsque vous 
renommez un clip créé automatiquement lors d'une 
opération d'édition, il devient un clip défini par 
l'utilisateur et apparaît dans la liste des clips, même si 
les clips créés automatiquement sont masqués.

Pour renommer un clip sur une piste :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez le clip à renommer et cliquez sur 
Clip > Rename.

• À l'aide de l'un des outils d'édition, effectuez un 
clic droit sur le clip à renommer et sélectionnez 
Rename dans le menu contextuel.

• Appuyez sur Ctrl+Maj+R (Windows) ou 
Commande+Maj+R (Mac).

• Avec la Main, double-cliquez sur le clip 
à renommer. Pour les clips MIDI, l'option Name 
Dialog doit être sélectionnée pour le paramètre 
Double-Clicking a MIDI Clip Opens des 
préférences MIDI.

2 Dans la boîte de dialogue Name, saisissez le 
nouveau nom du clip. Si le clip audio 
sélectionné est un clip de fichier entier, précisez 
si vous souhaitez renommer uniquement le clip 
ou le clip et le fichier sur le disque.

3 Cliquez sur OK pour renommer le clip. 

Affichage des noms, 
informations temporelles et 
autres données des clips
Les noms et informations temporelles des clips 
gênent parfois l'édition des formes d'onde audio ou 
des données MIDI. Lorsque cela est le cas, vous 
pouvez désactiver leur affichage. Dans d'autres 
cas, par exemple pour organiser ou positionner des 
effets sonores, il peut s'avérer utile d'afficher les 
noms et informations temporelles des clips.

Pour activer ou désactiver l'affichage des noms 
des clips dans les playlists :

 Sélectionnez ou désélectionnez View > 
Clip > Name.

Pour afficher les informations temporelles des 
clips :

 Dans le sous-menu View > Clip, sélectionnez 
l'une des options suivantes :

No Time : désactive l'affichage des informations 
temporelles des clips.

Current Time : affiche les heures de début et de fin 
des clips.

Original Time Stamp : affiche le marqueur temporel 
d'origine de chaque clip. Le marqueur temporel 
d'origine est le timecode d'origine du clip, lors de son 
premier enregistrement ou de sa création.

User Time Stamp : affiche le marqueur temporel 
utilisateur de chaque clip. Le marqueur temporel 
utilisateur, par défaut identique au marqueur 
temporel d'origine, peut être redéfini grâce à la 
commande Time Stamp.

Pour plus d'informations, reportez-vous à la 
section « Modification des noms de clip » à la 
page 275.

Affichage activé des noms et positions temporelles 
des clips et des chevauchements
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Affichage des données des clips sur tous 
les canaux

Pour les pistes multicanal au format stéréo ou 
supérieur, les données des clips peuvent être 
affichées sur tous les canaux.

Pour activer ou désactiver l'affichage des noms 
des clips sur tous les canaux :

 Sélectionnez ou désélectionnez View > Clip > 

Display on All Channels.

Affichage des autres informations des clips

Vous pouvez également afficher les informations 
suivantes sur les clips :

Points de synchronisation : peuvent être affichés 
sur les clips des playlists. Leur positionnement par 
rapport au timecode et l'arrangement en mode Grid 
sont ainsi simplifiés. Pour plus d'informations, 
reportez-vous à la section « Points de 
synchronisation » à la page 863.

État du traitement : pour les clips traités avec 
Elastic Audio, permet d'afficher un indicateur 
de déformation dans les playlists et la liste de clips. 
Reportez-vous à la section « Clips déformés » à la 
page 925.

Noms des canaux, scènes et prises : ces 
informations peuvent être affichées sur les clips 
d'une playlist et dans la liste des clips. Cela peut être 
utile pour travailler avec des enregistrements 
multicanal et des métadonnées provenant d'un 
enregistreur portable. Pour plus d'informations sur 
les workflows avec des enregistreurs portables, 
reportez-vous au Chapitre 51, « Utilisation 
d'enregistreurs portables avec Pro Tools ».

Classement : peuvent être affichés sur les 
clips des playlists. Ces informations sont utiles en 
arrangement pour la manipulation de playlists 
multiples et de prises alternatives. Reportez-vous 
à la section « Notation des clips » à la page 623.

Chevauchements de clips : peuvent être affichés 
sur les clips des playlists. Ces informations sont 
utiles en arrangement pour la manipulation de 
pistes audio basées sur les références de tempo. 
Reportez-vous à la section « Chevauchement de 
clips avec recouvrement ou superposition » à la 
page 603.

Courbe de gain du clip : affiche la courbe de gain 
du clip sur tous les clips de la fenêtre Edit. 
La courbe de gain du clip permet de modifier les 
réglages de gain de n'importe quel clip en éditant 
des points d'automation, de manière très semblable 
à l'automation de volume des pistes. Reportez-
vous à la section « Courbe de gain du clip » à la 
page 612.

Infos sur le gain du clip : affiche l'icône de fader 
de gain du clip au début du clip dans l'angle 
inférieur gauche. Si le gain du clip est statique, 
la valeur correspondante (-144 dB à +36 dB) est 
affichée à droite de l'icône de fader. Si le gain du 
clip est dynamique (basé sur des points 
d'automation), la valeur de gain du clip n'est pas 
affichée. Pour plus d'informations, reportez-vous 
à la section « Affichage des informations de gain 
du clip » à la page 611.



Chapitre 24 : Opérations d'édition de base 535

Niveaux d'annulation 
multiples
Pro Tools peut mémoriser les 32 dernières 
opérations pouvant être annulées et permet ainsi de 
revenir à un état d'édition précédent. 

Les opérations effectuées dans Pro Tools sont 
stockées dans une file d'annulation et dans l'ordre 
dans lequel elles ont été appelées. Lorsque vous 
sélectionnez Edit > Undo, c'est l'opération la plus 
récente qui est annulée. Si vous sélectionnez Undo 
de nouveau, l'opération suivante de la file sera 
annulée. Vous pouvez également choisir Edit > 

Redo pour rétablir une opération annulée, ce qui 
permet de remonter une opération après l'autre dans 
la file d'annulation.

Lorsque le nombre d'opérations de la liste 
d'annulations atteint le nombre maximal 
d'annulations possibles (tel que défini dans la page 
des préférences d'édition), toute autre opération 
susceptible d'être annulée remplacera l'opération la 
plus ancienne dans la liste d'annulations.

Pour annuler la dernière opération, effectuez l'une 
des opérations suivantes :

 Sélectionnez Edit > Undo.

 Appuyez sur Ctrl+Z (Windows) ou 
Commande+Z (Mac).

Pour rétablir la dernière opération annulée, 
effectuez l'une des opérations suivantes :

 Sélectionnez Edit > Redo.

 Appuyez sur Maj+Ctrl+Z (Windows) 
ou Maj+Commande+Z (Mac).

Fenêtre Undo History
La fenêtre Undo History permet de voir 
l'historique des opérations qu'il est possible 
d'annuler ou de rétablir, afin de revenir à une étape 
précédente. Cet historique affiche l'heure de 
chaque modification, ce qui vous permet de 
revenir à l'état dans lequel se trouvait la session 
à une heure précise. 

Pour afficher ou masquer la fenêtre Undo History :

 Sélectionnez Window > Undo History.

Pour annuler des opérations dans la fenêtre Undo 
History :

 Cliquez sur l'opération de la liste (en gras) 
à annuler. 

Toutes les opérations de la file d'attente qui ont été 
réalisées après l'opération que vous sélectionnez 
sont également annulées. Dans la fenêtre Undo 
History, les opérations qu'il est possible d'annuler 
sont affichées en gras et celles que vous pouvez 
rétablir (celles ayant déjà été annulées) sont 
affichées en italique.

Pour rétablir des opérations dans la fenêtre Undo 
History :

 Cliquez sur l'opération (en italique) de la liste 
à répéter.

L'opération que vous avez choisie est rétablie, 
ainsi que toutes les opérations antérieures 
à celle-ci dans la liste.

Si aucune action ne peut être annulée, le texte 
Can't Undo (impossible d'annuler) est affiché 
dans le menu.

Si aucune action ne peut être rétablie, le texte 
Can't Redo (impossible de rétablir) est 
affiché dans le menu.

Fenêtre Undo History

Opérations
pouvant
être annulées

Opérations
pouvant 
être rétablies

Heures de création

Sélecteur d'options
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Pour activer ou désactiver l'affichage des heures 
de création dans la fenêtre Undo History :

 Cliquez sur le menu Options et sélectionnez 
Show Creation Times. 

Pour annuler toutes les opérations de la fenêtre 
Undo History :

 Cliquez sur le menu Options et sélectionnez 
Undo All.

Pour rétablir toutes les opérations de la file 
d'attente :

 Cliquez sur le menu Options et sélectionnez 
Redo All.

Effacement de la liste 
d'annulations

Pour effacer manuellement le contenu de la liste 
d'annulations :

 Cliquez sur le menu Options et sélectionnez 
Clear Undo Queue.

D'autres opérations permettent également d'effacer 
la liste d'annulations :

• Suppression d'une piste ou d'un clip dans la liste 
des clips

• La sélection de l'option Select > Unused ou 
Select > Unused Audio Except Whole Files dans 
le menu de la liste des clips

Lorsque le nombre d'opérations de la fenêtre Undo 
History atteint la limite maximale autorisée, toute 
autre opération susceptible d'être annulée 
remplace l'opération la plus ancienne en haut de la 
file d'attente d'annulations. Lorsque l'opération la 
plus ancienne arrive en avant-dernière position et 
qu'elle est sur le point de disparaître de la file 
d'attente, elle s'affiche en rouge.

Niveaux d'annulation et RAM
Pro Tools devant mémoriser les playlists de toutes 
les pistes éditées, l'utilisation de plusieurs niveaux 
d'annulation risque de solliciter la mémoire de façon 
intensive. Vous pouvez baisser la valeur du 
paramètre Levels of Undo des préférences d'édition 
pour réduire la quantité de RAM utilisée par la liste 
d'annulations. Si vous avez alloué une grande 
quantité de RAM à Pro Tools, vous pouvez utiliser 
un plus grand nombre de niveaux d'annulation.

Pour définir le nombre de niveaux d'annulation 
dans Pro Tools :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Editing.

2 Cliquez dans le champ Levels of Undo et entrez 
une valeur comprise entre 1 et 64.

3 Cliquez sur OK.

La fenêtre Undo History vous permet d'afficher 
la liste des opérations pouvant être annulées et 
de revenir à un état précédent.

Préférence Levels of Undo
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Commandes d'édition de base
Pro Tools fournit de nombreuses commandes 
d'édition standard (Cut, Copy et Paste par 
exemple). Pro Tools dispose également de 
commandes d'édition spécialisées, optimisées pour 
la production audio et MIDI (commande Repeat 
Paste to Fill par exemple).

Couper, copier, coller et effacer
Les commandes couper (Cut), copier (Copy), coller 
(Paste) et effacer (Clear) permettent de réorganiser 
et d'éditer le contenu des pistes. Les opérations 
d'édition peuvent s'appliquer à des clips entiers 
sélectionnés avec l'outil de saisie du temps ou à des 
plages d'une piste définies avec le Sélecteur. Les 
opérations d'édition peuvent également s'appliquer 
à plusieurs pistes (reportez-vous à la section 
« Édition simultanée de plusieurs pistes » à la page 
541).

Vue de piste et édition des 
contenus
Lorsque vous coupez ou copiez les données d'une 
piste, la vue de piste détermine le type de données 
placées dans le presse-papiers. Lorsque vous 
effectuez une édition dans la vue principale de la 
piste (vue Waveform pour les pistes audio et vue 
Clips pour les pistes MIDI et d'instrument), 
les sélections peuvent inclure toutes les données 
d'automation et de contrôleur sous-jacentes 
(« Option Automation Follows Edit » à la page 
1074). Ainsi, lorsque vous coupez un clip audio, les 
données d'automation de volume, de panoramique, 
de mute, de départ, de contrôleur continu ou 
d'automation de plug-in de la piste sont également 
coupées. Ceci vous évite d'avoir à les couper 
individuellement dans chaque playlist d'automation 
de la piste.

Lorsque vous sélectionnez des groupes de notes 
MIDI en vue Notes avec l'un des outils de saisie 
(en traçant un rectangle de sélection), seules les 
données des notes sont placées dans le presse-
papiers. Lorsque vous sélectionnez une plage 
temporelle de notes MIDI (en vue Notes) avec le 
Sélecteur, toutes les données de contrôleur 
contenues sur la piste sont sélectionnées (comme 
pour la sélection de pistes audio avec le Sélecteur 
en vue Waveform).

Lorsqu'une piste affiche des données d'automation 
ou de contrôleur, seules ces données sont placées 
dans le presse-papiers. De plus, chaque fois que 
vous coupez ou copiez des données d'automation, 
des points d'automation sont créés à chaque 
extrémité de la zone sélectionnée, afin de 
conserver la pente de l'automation à la fois 
à l'intérieur et hors de la sélection.

Vous pouvez couper, copier et coller des clips 
non contigus à l'aide de l'outil de saisie 
d'objet.

Données d'une forme d'onde audio

Données d'automation avec un clip audio coupé 
et collé

Appuyez sur Ctrl+Démarrer+V (Windows) 
ou Commande+Ctrl+V (Mac) pour réaliser 
un collage spécial de données d'automation 
sur un autre type d'automation. Vous pouvez, 
par exemple, copier des données 
d'automation de panoramique sur une 
playlist d'automation de volume.
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Si des pistes sont groupées, une opération 
de copier-coller sur l'une des pistes du groupe a 
une incidence sur les autres pistes du groupe. Les 
pistes masquées, même si elles appartiennent à un 
groupe en cours d'édition, ne sont pas affectées par 
l'opération d'édition.

Le mode Shuffle a une incidence sur la copie et le 
collage du contenu des pistes :

• En mode Shuffle, la commande Cut ne laisse pas 
d'espace vide, car les clips situés à droite du clip 
coupé se décalent pour combler l'intervalle. 
Dans les autres modes, la commande Cut laisse 
un espace vide correspondant aux données 
supprimées de la piste. 

• Lorsque le mode Shuffle est activé, tous les clips 
se décalent de la distance nécessaire pour laisser 
une place suffisante aux données collées. Dans 
les autres modes, les données collées se 
superposent aux clips adjacents.

De nouveaux clips sont souvent créés 
automatiquement lors des opérations d'édition. 
Lorsque vous effacez, par exemple, une sélection 
d'un clip, de nouveaux clips sont créés 
automatiquement à partir des données résidant 
hors de la sélection.

Commandes Cut et Copy
La commande Cut permet de supprimer une 
sélection d'une piste et de la placer dans le presse-
papiers.

La commande Copy place une copie de la sélection 
dans le presse-papiers pour pouvoir la coller sur 
une autre piste ou sur la même piste à un 
emplacement différent, sans que la sélection 
d'origine ne soit modifiée ou déplacée.

Pour couper ou copier une sélection ou un clip :

1 Pour restreindre la sélection aux limites de 
la grille actuelle, activez la fonction Snap 
to Grid. 

2 Sélectionnez une vue en fonction du type de 
piste à éditer.

Lorsque les formes d'onde sont affichées sur les 
pistes audio, ou les notes ou les clips pour les pistes 
MIDI, les sélections incluent les données sous-
jacentes d'automation et de contrôleur. Lorsque 
des données d'automation sont affichées, seules 
ces données sont affectées par les opérations 
d'édition.

3 Créez une sélection d'édition des données 
à couper (Cut) ou à copier (Copy).

4 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Cut pour supprimer la 
sélection et la placer dans le presse-papiers.

• Sélectionnez Edit > Copy pour placer la sélection 
dans le presse-papiers sans la supprimer.

Si une partie d'un clip a été coupée ou copiée, les 
données du presse-papiers apparaissent dans la 
liste des clips, sous la forme d'un nouveau clip. Si 
une partie d'un clip a été coupée, de nouveaux clips 
sont créés automatiquement à partir des données se 
trouvant hors de la sélection. 

En mode Shuffle, les clips suivants sont déplacés 
afin de combler l'espace vide.

Pour plus d'informations sur le mode Shuffle, 
reportez-vous à la section « Mode Shuffle » à 
la page 543.

Pour plus d'informations sur la création 
de sélections d'édition, reportez-vous 
à la section « Sélection du contenu des 
pistes » à la page 577.
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Suppression des données sous-jacentes des 
clips

Lorsque vous supprimez des clips ou une 
sélection, vous pouvez également supprimer ou 
conserver les données sous-jacentes des clips.

Pour supprimer un clip ou une sélection et les 
données sous-jacentes :

 Sélectionnez Edit > Cut.

Pour supprimer un clip ou une sélection sans 
supprimer les données sous-jacentes :

 Sélectionnez Edit > Clear.

Commande Paste
La commande Paste place le contenu du presse-
papiers au point d'insertion d'édition, en 
remplaçant les données déjà présentes.

Pour coller une sélection ou un clip :

1 Pour restreindre le point d'insertion ou la 
sélection aux limites de la grille actuelle, 
activez la fonction Snap to Grid. 

2 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur, cliquez sur la piste, 
à l'endroit où vous souhaitez coller les données.

• À l'aide du Sélecteur ou de l'outil de saisie du 
temps, créez une sélection à l'endroit où les 
données seront placées.

3 Sélectionnez Edit > Paste.

Si vous effectuez le collage à un point d'insertion 
en mode Shuffle, les données situées à droite du 
point d'insertion se décalent vers la droite. Dans les 
autres modes, les données situées sur la zone du 
collage sont remplacées.

Si vous effectuez le collage sur une sélection en 
mode Shuffle, la sélection est remplacée par le 
contenu du presse-papiers et les données 
adjacentes se décalent de la durée nécessaire, 
à gauche ou à droite. Dans les autres modes, 
la sélection est remplacée mais les données 
adjacentes demeurent inchangées.

Commande Clear
La commande Clear permet d'effacer une sélection 
d'une piste sans la placer dans le presse-papiers.

Pour effacer une sélection ou un clip :

1 Pour restreindre la sélection aux limites de la 
grille actuelle, activez la fonction Snap to Grid. 

2 Sélectionnez une vue en fonction du type de 
piste à éditer.

Lorsque les formes d'onde sont affichées sur les 
pistes audio, ou les notes ou les clips pour les pistes 
MIDI, les sélections incluent les données sous-
jacentes d'automation et de contrôleur. Lorsque 
des données d'automation sont affichées, seules 
ces données sont affectées par les opérations 
d'édition.

3 Créez une sélection d'édition.

4 Sélectionnez Edit > Clear pour effacer la 
sélection.

Si une partie d'un clip a été coupée, de nouveaux 
clips sont créés automatiquement à partir des 
données se trouvant hors de la sélection. En mode 
Shuffle, les clips suivants sont déplacés afin de 
combler l'espace vide.

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et cliquez avec la Main 
sur un clip pour le conformer à la sélection 
actuelle.

Lorsque vous travaillez avec des données 
MIDI, vous pouvez fusionner le contenu du 
presse-papiers avec les données de la piste de 
destination grâce à la commande Edit > 
Paste Special > Merge. Pour plus 
d'informations, reportez-vous à la section 
« Paste Special » à la page 1102.
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Commandes spéciales couper, 
copier, coller et effacer
Les commandes « spéciales » du menu Edit 
(Cut Special, Copy Special, Paste Special et Clear 

Special) permettent de couper, copier, coller et 
effacer des données d'automation (volume, 
panoramique, mute et automation de plug-ins) de 
pistes audio, Master VCA, d'entrée auxiliaire, 
d'instrument et Master Fader. Vous pouvez 
également utiliser ces commandes pour les 
données de contrôleur MIDI des pistes MIDI et 
d'instrument. Des commandes Cut Special, Copy 

Special et Clear Special sont également 
disponibles pour couper, copier et effacer des 
paramètres de gain de clip (reportez-vous à la 
section « Gain du clip » à la page 611).

Repeat to Fill Selection
La commande Repeat to Fill Selection permet de 
remplir automatiquement une sélection avec des 
clips ou des données audio ou MIDI sans avoir 
à les dupliquer manuellement. Pour utiliser cette 

fonctionnalité, coupez ou copiez un clip, créez une 
sélection, puis sélectionnez la commande pour 
remplir la sélection. Lorsque vous collez des clips 
audio, vous êtes invité à paramétrer le fondu 
enchaîné à utiliser. 

Si vous remplissez une zone dont la taille est un 
multiple exact de celle du clip copié (si vous 
remplissez 16 mesures avec un clip de 4 mesures par 
exemple), la sélection copiée est collée autant de fois 
que nécessaire pour remplir la sélection. Si vous 
remplissez une zone qui n'est pas un multiple exact de 
la taille du clip copié (si vous remplissez 15 secondes 
avec un clip de 2 secondes de bruit de fond par 
exemple), la zone de sélection restante est remplie par 
une version sur laquelle un trim automatique de la 
sélection d'origine a été appliqué.

Pour remplir une sélection à l'aide de la 
commande Repeat to Fill Selection :

1 Sélectionnez le clip à copier.

2 Sélectionnez Edit > Copy.

3 Sélectionnez la zone à remplir à l'aide du 
Sélecteur, puis sélectionnez Edit > Paste 

Special > Repeat to Fill Selection.

4 Effectuez l'une des opérations suivantes :

• Si vous collez des clips audio sur des zones plus 
grandes, la boîte de dialogue Batch Fades 
s'ouvre. Configurez la boîte de dialogue pour 
créer des fondus enchaînés entre chaque clip 
collé, puis cliquez sur OK.

• Si vous ne souhaitez pas de fondus enchaînés 
entre les données audio collées, cliquez sur 
Cancel dans la boîte de dialogue Batch Fades.

Il est impossible coller des données de 
contrôleur MIDI sur des données 
d'automation, et inversement.

Pour plus d'informations, reportez-vous 
à la section « Coupe, copie et collage 
d'automation » à la page 1099.
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Édition simultanée de 
plusieurs pistes
Lorsque vous travaillez avec des données de 
plusieurs pistes, vous devez prendre en 
considération un certain nombre de points 
importants. Par exemple, si des pistes sélectionnées 
utilisent leur vue principale (reportez-vous à la 
section « Vues principales des pistes » à la page 
228), les opérations d'édition concernent non 
seulement les données MIDI et audio des pistes 
sélectionnées, mais également toutes les données 
d'automation et de contrôleur.

Si des données d'automation sont affichées sur 
toutes les pistes sélectionnées, les modifications ne 
concernent que le type de données d'automation 
affiché sur chaque piste. De plus, si la piste 1 affiche 
une automation de panoramique, la piste 2 une 
automation de volume et la piste 3 une automation 
de mute, la commande Cut ne coupe que les 
données de panoramique de la piste 1, les données 
de volume de la piste 2 et les données de mute de la 
piste 3.

Pour copier tous les types d'automation sur toutes 
les pistes sélectionnées lors de la copie de 
données d'automation ou de contrôleur :

 Sélectionnez Edit > Copy Special > 

All Automation.

Pour coller sur plusieurs pistes :

1 Effectuez l'une des opérations suivantes :

• Positionnez le point d'insertion sur chaque piste 
de destination en maintenant la touche Maj 
enfoncée, puis en cliquant sur chacune d'elles.

• Créez une sélection sur l'une des règles de base 
de temps.

2 Sélectionnez Edit > Paste.

Lorsque vous collez plusieurs types de données, 
toute donnée copiée est collée sur le type de 
playlist qui lui correspond. Les données 
d'automation sont collées sur la playlist 
d'automation correspondante. Les données audio 
ou MIDI sont collées sur la playlist audio ou MIDI. 
Il n'est pas nécessaire de définir les pistes de 
destination en fonction du type de données 
à coller.

Si des données d'automation sont affichées sur 
toutes les pistes de destination d'un collage 
multipiste, le collage remplace les données 
précédentes des pistes cibles, sans déplacer aucune 
des données, que le mode Shuffle soit activé ou 
non.Pour plus d'informations sur la sélection de 

données sur plusieurs pistes, reportez-vous à 
la section « Sélection sur plusieurs pistes » à 
la page 584.
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Chapitre 25 : Modes et outils d'édition

Pro Tools fournit quatre modes d'édition et divers 
outils d'édition pour vous permettre d'éditer le 
contenu des pistes.

Modes d'édition
Pro Tools propose quatre modes d'édition : Shuffle, 
Spot, Slip et Grid. Le mode Grid offre également 
deux modes de fonctionnement : absolu et relatif. 
Pour sélectionner un mode d'édition, cliquez sur le 
bouton correspondant dans la partie supérieure 
gauche de la fenêtre Edit.

Le mode d'édition a une incidence sur le 
déplacement et le positionnement des clips audio 
et MIDI (et des notes MIDI), sur le fonctionnement 
des commandes Copy et Paste, ainsi que celui des 
différents outils d'édition (outil de trim, Sélecteur, 
Main et Crayon).

Mode Shuffle
Le mode Shuffle permet de déplacer, effectuer des 
opérations de trimming, supprimer, couper ou coller 
librement les clips sur une piste ou vers d'autres 
pistes, mais leur mouvement est restreint par les 
autres clips. Autrement dit, si vous placez plusieurs 
clips sur une piste, ils s'alignent automatiquement les 
uns à la suite des autres. Vous pouvez ensuite 
modifier l'ordre dans lequel elles se succèdent, mais 
vous ne pouvez pas les séparer, ni les superposer 
comme en mode Slip. Cependant, si un silence est 
présent entre des clips existants et que ces clips sont 
intervertis, le silence est maintenu et n'est pas 
supprimé.

En mode Shuffle, l'ajout d'un autre clip au début 
d'une piste décale les clips suivants vers la droite 
(plus tard dans le temps), de la durée du clip ajouté. 

Lorsque vous utilisez l'un des outils de trim en 
mode Shuffle, le fait d'ajuster la position du point 
de début ou de fin d'un clip décale 
automatiquement les clips suivants en 
conséquence. Le mode Shuffle n'a pas d'incidence 
sur le placement et l'insertion de notes MIDI.

Boutons des modes d'édition

Utilisez la touche d'accent ( ` ) pour 
parcourir les modes d'édition.

Appuyez sur F1 pour activer le mode Shuffle. 
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Verrouillage du mode Shuffle
Il est important d'exclure le mode Shuffle de 
certains workflows afin de s'assurer que les 
clips restent synchronisés pendant l'édition. 
Le verrouillage du mode Shuffle entraîne la 
désactivation de toutes les touches de raccourci et 
de surface de contrôle liées à ce mode. Le mode 
Shuffle ne peut plus être sélectionné, même par 
inadvertance. Le verrouillage du mode Shuffle ne 
peut être effectué lorsque le mode Shuffle est actif. 

Pour verrouiller le mode Shuffle :

 En mode d'édition quelconque excepté le mode 
Shuffle, cliquez sur le bouton Shuffle de l'écran 
tout en maintenant la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée. Une icône 
représentant un cadenas apparaît sur le bouton 
Shuffle. 

Pour déverrouiller le mode Shuffle :

 Cliquez sur le cadenas du bouton Shuffle tout en 
maintenant la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée.

Mode Slip
En mode Slip, vous pouvez déplacer les clips 
librement sur une piste ou vers d'autres pistes. 
Dans ce mode, il est possible de placer un clip sur 
une piste en laissant un espace entre lui et les autres 
clips. Lors de la lecture de la piste, aucun son ne 
sera émis lors de ce passage de silence. Vous 
pouvez également déplacer un clip pour qu'il 
recouvre partiellement ou complètement un autre 
clip.

Utilisez le mode Slip lorsque vous voulez que 
l'outil de trim, le Sélecteur, la Main et le Crayon 
fonctionnent sans aucune restriction de placement 
temporel.

Mode Spot
Utilisez le mode Spot pour positionner des clips à 
des endroits précis. Ce mode permet de spécifier 
un point précis (exprimé en timecode SMPTE ou 
tout autre format temporel), capturer une adresse 
de timecode entrant ou utiliser les marqueurs 
temporels d'un clip comme points de référence de 
positionnement. Ce mode peut 
être particulièrement utile pour des tâches de post-
production basées sur des emplacements d'image 
SMPTE. 

Lorsque le mode Spot est activé, Pro Tools vous 
demande d'indiquer un emplacement de 
destination lorsqu'un clip est déplacé à partir de la 
liste des clips, d'un navigateur de l'espace de 
travail, de l'Explorateur Windows ou du Finder 
Mac.

Verrouillage du mode Shuffle activé

Appuyez sur F2 pour activer le mode Slip. 

Appuyez sur F3 pour activer le mode Spot. 
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Mode Grid
En mode Grid, les clips et notes MIDI déplacés, 
insérés ou sur lesquels des opérations de trimming 
sont effectuées s'alignent sur les limites de grille 
ou sur les incréments précis d'une grille temporelle 
définie par l'utilisateur. 

Affichage des lignes de la grille

Pour afficher (ou masquer) les lignes de la grille 
dans la fenêtre Edit ou une fenêtre de l'éditeur 
MIDI, effectuez l'une des opérations suivantes :

 Sélectionnez (ou désélectionnez) le bouton Grid.

 Cliquez sur le nom de la règle de base de temps 
actuellement sélectionnée.

Modes Grid absolu et relatif
Le mode Grid fonctionne de manière absolue ou 
relative : 

 En mode Grid absolu, le déplacement d'un clip 
entraîne l'alignement de son début sur une limite 
de la grille. Si le point de départ d'un clip se trouve 
entre deux temps et que la grille est définie sur des 
noires, le déplacement du clip déplace son heure 
de début sur la noire la plus proche (la valeur 
actuelle de grille absolue). 

 En mode Grid relatif, les clips peuvent être 
déplacés par unités de grille (ou incrément). 
Si le point de départ d'un clip se trouve entre deux 
temps et que la grille est définie sur une noire 
(en supposant que la noire tombe sur le temps), 
le déplacement du clip est contraint à des intervalles 
d'une noire et conserve la position relative du clip par 
rapport au temps le plus proche. Pour plus 
d'informations sur le mode Grid relatif, reportez-vous 
à la section « Glissement de clips en mode Grid » à la 
page 859. 

Pour sélectionner le mode Grid absolu ou relatif :

 Cliquez sur le sélecteur de mode Grid, 
puis sélectionnez Absolute ou Relative. 

Appuyez sur F4 pour activer le mode Grid. 

Bouton Grid sélectionné dans la fenêtre Edit

Activation des lignes de la grille à partir de la règle de 
base de temps

Pour suspendre temporairement le mode Grid 
et basculer en mode Slip lors du déplacement 
d'un clip, maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée.
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Alignement sur la grille
Pro Tools permet d'activer l'alignement sur la 
grille lorsque vous êtes en mode Shuffle, Slip ou 
Spot. Lorsque l'alignement sur la grille est activé 
dans l'un de ces modes, le placement du curseur 
d'édition et les sélections d'édition sont restreints 
aux limites de la grille, mais toute opération 
d'édition sur les clips dépend également du mode 
d'édition sélectionné. 

Par exemple, lorsque l'alignement sur la grille est 
activé en mode Shuffle, vous pouvez créer une 
sélection sur un clip en vous basant sur la grille, 
puis couper la sélection. Les clips situés à droite de 
la sélection se déplacent alors vers la gauche.

Pour activer l'alignement sur la grille depuis un 
autre mode d'édition :

 Maintenez la touche Maj enfoncée et cliquez 
sur le bouton du mode Grid.

Pour activer le mode Shuffle, Slip ou Spot lorsque 
vous êtes en mode Grid :

 Maintenez la touche Maj enfoncée et cliquez 
sur le bouton Shuffle, Slip ou Spot.

Configuration de la grille
La taille actuelle de la grille, définie par le 
sélecteur de valeur de grille, peut être basée sur une 
valeur temporelle exprimée dans l'échelle 
temporelle principale. Si l'option Follow Main Time 

Scale n'est pas sélectionnée, vous pouvez utiliser 
un autre format temporel pour les pas de la grille. 

L'indicateur de valeur de grille et le sélecteur sont 
situés dans la fenêtre Edit. Les fenêtres de l'éditeur 
de partition et de l'éditeur MIDI incluent un 
indicateur et un sélecteur de valeur de grille 
indépendants.

Mode Shuffle avec alignement sur la grille activé

Pour activer l'alignement sur la grille depuis un 
autre mode d'édition, appuyez sur Maj+F4.

Pour activer le mode Shuffle et l'alignement 
sur la grille, appuyez sur F1+F4. Pour activer 
le mode Slip et l'alignement sur la grille, 
appuyez sur F2+F4. Pour activer le mode 
Spot et l'alignement sur la grille, appuyez sur 
F3+F4.

Indicateur et menu déroulant de valeur de grille

La valeur de grille actuelle est également 
utilisée pour la commande de quantification 
sur la grille (reportez-vous à la section 
« Quantification des clips sur la grille » à la 
page 609) et celle de séparation des clips 
sur la grille (reportez-vous à la section 
« Commandes de séparation » à la page 600).
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L'option Clips/Markers du menu des valeurs de grille 
permet de placer librement des événements (comme 
en mode Slip), mais ils s'alignent sur les 
emplacements des clips (points de début, de fin et de 
synchronisation), les marqueurs et les sélections 
d'édition lorsque vous les placez à proximité.

Verrouillage du mode Grid
Afin de ne pas changer par inadvertance de mode 
Grid lorsque vous utilisez les raccourcis clavier 
des modes d'édition, vous pouvez le verrouiller en 
sélectionnant l'option Edit/Tool Mode Keyboard 
Lock.

Pour verrouiller (ou déverrouiller) le mode Grid 
sélectionné :

1 Cliquez sur le sélecteur de mode Grid, puis 
sélectionnez Absolute ou Relative.

2 Sélectionnez (ou désélectionnez) Options > 
Edit/Tool Mode Keyboard Lock.

Outils d'édition
Pro Tools inclut les outils d'édition suivants : outil 
de zoom, outil de trim, Sélecteur, Main, outil de 
scrubbing et Crayon, ainsi que l'outil Smart 
multifonction. 

Pour sélectionner un outil d'édition :

 Sur la barre d'outils, cliquez sur l'icône de l'outil 
que vous souhaitez utiliser. 

L'outil de zoom ainsi que les outils de trim, la Main 
et le Crayon comportent des modes différents, qui 
peuvent être sélectionnés depuis un menu 
contextuel lorsque vous cliquez sur l'outil.

Boutons de zoom : utilisez les boutons de zoom 
pour effectuer des zooms vers l'avant ou l'arrière, 
verticalement ou horizontalement sur le contenu 
des pistes MIDI et audio. Il est également possible 
d'enregistrer et de rappeler cinq presets de zoom.

Outil de zoom : permet de sélectionner une vue de 
zoom sur une piste.

Changement de zoom : permet de passer de la 
valeur de zoom actuelle à un facteur de zoom 
défini, et inversement.

Outils de trim : permettent d'effectuer des 
opérations de trimming sur les clips et groupes de 
clips.

Sélecteur : permet de créer des sélections sur les 
pistes.

Outils de saisie : permettent de sélectionner, 
séparer ou déplacer des clips sur des pistes.

Les notes MIDI insérées avec le Crayon 
ignorent l'option Clips/Markers et s'alignent 
sur la valeur temporelle sélectionnée dans le 
sélecteur de valeur de grille.

Boutons de zoom et outils d'édition

Boutons de zoom Outil Smart

Outil de 
scrubbing

Crayon

Changement de zoom

Outil de trim

Sélecteur
Main

Zoom

Vous pouvez utiliser les touches F5 (outil de 
zoom), F6 (outil de trim), F7 (Sélecteur), F8 
(Main), F9 (outil de scrubbing) et F10 
(Crayon) pour sélectionner l'outil d'édition 
correspondant et parcourir ses modes. 

Appuyez sur la touche Échap pour parcourir 
les différents outils d'édition.
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Outil Smart : permet d'effectuer une opération de 
trimming, de sélectionner ou de saisir des clips sur 
les pistes.

Outil de scrubbing : permet d'effectuer un 
scrubbing sur le contenu des pistes.

Crayon : permet de dessiner des données 
d'automation et MIDI.

Méthodes de zoom
Plusieurs méthodes de zoom sont disponibles dans 
Pro Tools : boutons de zoom, outil de zoom, 
boutons de preset de zoom et commande de 
changement de zoom.

Boutons de zoom
Pro Tools propose différents boutons permettant 
d'effectuer un zoom avant et arrière sur les données 
des pistes.

Les boutons de zoom sont également disponibles 
dans la fenêtre Edit, les fenêtres de l'éditeur MIDI 
et de l'éditeur de partition, au-dessus et en-dessous 
de la barre de défilement vertical (reportez-vous 
aux sections « Boutons de zoom de la fenêtre 
Edit » à la page 178, « Commandes de zoom de 
l'éditeur MIDI » à la page 740 et « Commandes de 
zoom de l'éditeur de partition » à la page 763).

Boutons de zoom avant/arrière 
horizontal
Les boutons de zoom avant/arrière horizontal 
permettent de zoomer horizontalement sur les 
données d'une piste.

Pour effectuer un zoom avant horizontal sur 
l'ensemble des pistes, effectuez l'une des 
opérations suivantes :

 Cliquez sur la commande de zoom avant 
horizontal.

 Cliquez et faites glisser votre souris sur le 
bouton de zoom avant horizontal pour effectuer 
un zoom avant continu.

 Appuyez sur les touches Ctrl+] (Windows) 
ou Commande+] (Mac).

Pour effectuer un zoom arrière horizontal sur 
l'ensemble des pistes, effectuez l'une des 
opérations suivantes :

 Cliquez sur la commande de zoom arrière 
horizontal.

 Cliquez et faites glisser votre souris sur le 
bouton de zoom arrière horizontal pour 
effectuer un zoom arrière continu.

 Appuyez sur les touches Ctrl+[ (Windows) 
ou Commande+[ (Mac).

Pour plus d'informations sur l'utilisation des 
outils d'édition en vue Notes sur les pistes 
MIDI et d'instrument, reportez-vous au 
Chapitre 31, « Édition MIDI ».

Pour plus d'informations sur l'utilisation des outils 
d'édition en vue Warp et Analysis sur les pistes 
Elastic Audio, reportez-vous aux sections 
« Édition en vue Warp » à la page 920 et « Édition 
en vue Analysis » à la page 927.

Boutons de zoom avant/arrière horizontal 
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Boutons de zoom avant et 
arrière audio et MIDI
Les boutons de zoom audio et MIDI permettent 
respectivement d'effectuer un zoom avant ou 
arrière vertical sur les données audio et MIDI.

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes audio, effectuez l'une des 
opérations suivantes :

 Cliquez sur la commande de zoom avant audio. 

 Cliquez et faites glisser votre souris sur le 
bouton de zoom avant audio pour effectuer un 
zoom continu.

 Appuyez sur Ctrl+Alt+] (Windows) ou 
Commande+Option+] (Mac).

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes audio, effectuez l'une des 
opérations suivantes :

 Cliquez sur le bouton de zoom arrière audio. 

 Cliquez sur les boutons de zoom vertical audio.

 Appuyez sur Ctrl+Alt+[ ou Ctrl+Alt+] 
(Windows) ou Commande+Option+[ ou 
Commande+Option+] (Mac). 

Pour effectuer un zoom vertical audio afin 
d'afficher la hauteur par défaut des formes 
d'onde :

 Appuyez sur Ctrl+Alt+Démarrer+[ (Windows) 
ou Commande+Option+Ctrl+[ (Mac).

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes d'instrument et MIDI, 
effectuez l'une des opérations suivantes :

 Cliquez sur la commande de zoom avant MIDI.

 Appuyez sur Ctrl+Maj+] (Windows) ou 
Commande+Maj+] (Mac).

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes d'instrument et MIDI, 
effectuez l'une des opérations suivantes :

 Cliquez sur la commande de zoom arrière 
MIDI.

 Appuyez sur Ctrl+Maj+[ (Windows) ou 
Commande+Maj+[ (Mac).

Pour effectuer un zoom vertical MIDI afin d'afficher 
toutes les notes (de la plus basse à la plus haute) 
sur les pistes MIDI et les pistes d'instrument :

 Appuyez sur les touches Ctrl+Démarrer+Maj+ 
[ (Windows) ou Commande+Ctrl+Maj+[ (Mac).

Bouton de zoom vertical audio

Bouton de zoom vertical MIDI

Le zoom vertical MIDI affecte uniquement les 
pistes qui ne sont pas en vue Clips.
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Pour effectuer un zoom vertical avant ou arrière 
sur une piste d'instrument ou MIDI :

1 Assurez-vous que la piste n'est pas affichée en 
vue Clips.

2 Sélectionnez l'outil de zoom. 

3 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, puis faites glisser la 
souris vers le haut pour effectuer un zoom avant 
ou vers le bas pour effectuer un zoom arrière.

Autres commandes de zoom

Pour revenir au niveau de zoom précédent, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur l'un des boutons 
de zoom horizontal audio ou MIDI.

 Appuyez sur Ctrl+Alt+E (Windows) ou 
Commande+Option+E (Mac).

Pour effectuer un zoom avant horizontal sur la 
sélection d'édition sans affecter le niveau de zoom 
vertical :

 Appuyez sur Alt+F (Windows) ou Option+F 
(Mac).

Si la sélection contient des notes MIDI, celles-ci 
défilent verticalement sur les pistes.

Pour effectuer un zoom avant horizontal sur une 
sélection sans affecter le niveau de zoom vertical 
ou le défilement, effectuez l'une des opérations 
suivantes :

 Appuyez sur Alt+Démarrer+E (Windows) ou 
Option+Ctrl+F (Mac).

 Appuyez sur Ctrl+Démarrer+] (Windows) ou 
Commande+Ctrl+] (Mac).

Pour zoomer horizontalement afin d'afficher la 
totalité de la session, effectuez l'une des 
opérations suivantes :

 Double-cliquez sur l'outil de zoom de la barre 
d'outils.

 Appuyez sur Alt+A (Windows) ou Option+A 
(Mac).

Les formes d'onde audio repassent au niveau de 
zoom vertical par défaut. Sur les pistes en vue 
Notes, un zoom vertical est effectué sur les notes 
MIDI afin d'afficher toutes les notes de la piste 
(comme pour un zoom vertical en vue Clips). Un 
zoom vertical est appliqué dans l'éditeur de tempo 
pour afficher tous les événements de tempo.

Pour effectuer un zoom horizontal afin d'afficher 
la session entière sans affecter le zoom vertical ou le 
défilement, effectuez l'une des opérations suivantes :

 Appuyez sur Alt+Démarrer+A (Windows) ou 
Option+Ctrl+A (Mac).

 Appuyez sur Ctrl+Démarrer+[ (Windows) ou 
Commande+Ctrl+[ (Mac).

Pour définir le zoom horizontal sur l'échelle 
d'aperçu (256 échantillons par pixel) :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur l'outil 
de zoom.
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Outil de zoom
L'outil de zoom permet d'effectuer un zoom avant et 
arrière sur une zone particulière d'une piste. 

Il propose deux modes : 

Zoom normal : l'outil de zoom reste sélectionné 
même après avoir zoomé. 

Zoom unique : l'outil d'édition précédemment 
sélectionné est automatiquement resélectionné une 
fois le zoom effectué.

Outil de zoom normal

Pour zoomer sur un point spécifique d'une piste :

1 Effectuez l'une des opérations suivantes :

• Cliquez dans le menu déroulant du zoom et 
sélectionnez le mode de zoom normal.

• Effectuez un clic droit sur une piste et 
sélectionnez Tools > Zoomer Tools > 

Normal Zoom.

2 Cliquez une fois avec l'outil de zoom sur un 
point de la piste. Toutes les pistes sont agrandies 
d'un niveau et la fenêtre Edit est centrée autour 
du point ciblé.

3 Pour revenir au niveau de zoom précédent, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le zoom.

Pour effectuer un zoom avant sur une zone 
particulière d'une piste :

1 Effectuez l'une des opérations suivantes :

• Cliquez dans le menu déroulant du zoom et 
sélectionnez le mode de zoom normal.

• Effectuez un clic droit sur une piste et 
sélectionnez Tools > Zoomer Tools > 

Normal Zoom.

2 Effectuez l'une des opérations suivantes :

• Pour effectuer un zoom horizontal uniquement, 
cliquez et faites glisser l'outil de zoom sur la 
playlist de la piste.

• Pour effectuer un zoom horizontal et vertical, 
maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée, cliquez et faites 
glisser sur la playlist de la piste.

La zone agrandie remplit toute la fenêtre Edit.

Mode de zoom unique 
Le mode de zoom unique réactive l'outil précédent 
lorsque le zoom a été effectué.

Lorsque vous utilisez par exemple l'outil Smart, 
vous pouvez cliquer sur l'outil de zoom unique, puis 
effectuer une opération de zoom ; Pro Tools 
réactive alors automatiquement l'outil Smart.

Appuyez sur la touche F5 pour sélectionner 
le zoom et basculer entre les modes de zoom 
normal et unique.

Outil de zoom

Zoom horizontal avec l'outil de zoom
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Pour utiliser le mode de zoom unique, procédez 
comme suit :

 Cliquez sur le menu de l'outil de zoom et 
sélectionnez le mode de zoom unique.

 Effectuez un clic droit sur une piste et 
sélectionnez Tools > Zoomer Tools > 
Single Zoom.

 Appuyez sur la touche F5 pour passer en mode 
de zoom unique.

Le mode de zoom unique est identifié par une flèche 
vers la droite dans l'icône de l'outil de zoom. 

Cette flèche est absente en mode de zoom normal.

Zoom sur une règle

Pour effectuer un zoom horizontal sur une règle :

1 Appuyez sur Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) et déplacez le curseur 
sur la zone des règles pour afficher l'outil 
de zoom.

2 Effectuez l'une des opérations suivantes :

• Cliquez une fois pour zoomer en avant d'un 
niveau autour d'un certain point.

• Cliquez et faites glisser votre souris pour 
zoomer sur une plage spécifique de la règle.

Zoom continu avec l'outil de 
zoom
Utilisez l'outil de zoom pour effectuer un zoom 
avant ou arrière continu. 

Pour effectuer un zoom continu sur une piste ou 
un groupe de pistes :

1 Sélectionnez l'outil de zoom. 

2 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, cliquez puis effectuez 
l'une des opérations suivantes :

• faites glisser vers le haut pour un zoom avant 
vertical continu ; 

• faites glisser vers le bas, pour un zoom arrière 
vertical continu ; 

• faites glisser vers la droite, pour un zoom avant 
horizontal continu ;

• faites glisser vers la gauche, pour un zoom 
arrière horizontal continu.

Pour un zoom horizontal, le zoom est effectué 
simultanément sur toutes les pistes. Le zoom avant 
ou arrière sera centré sur le point de la piste où 
vous avez cliqué. 

Zoom vertical avant ou arrière 
continu sur l'ensemble des 
pistes audio

Pour effectuer un zoom vertical continu avant ou 
arrière sur l'ensemble des pistes audio :

 Cliquez et faites glisser votre souris vers le haut 
ou le bas sur le bouton de zoom audio avant ou 
arrière. 

Pour effectuer un zoom vertical continu avant ou 
arrière sur toutes les pistes MIDI et d'instrument 
affichées en vue Notes :

 Cliquez et faites glisser votre souris vers le haut 
ou le bas sur le bouton de zoom MIDI avant ou 
arrière. Les hauteurs de pistes relatives sont 
conservées.

Mode de zoom unique

Zoom sur une règle
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Pour zoomer horizontalement et afficher la 
session entière en rétablissant la hauteur par 
défaut des formes d'onde audio, effectuer un 
zoom MIDI pour voir toutes les notes d'une piste et 
zoomer sur l'éditeur de tempo pour voir tous les 
événements de tempo, effectuez l'une des 
opérations suivantes :

 Double-cliquez sur l'outil de zoom. 

 Appuyez sur Alt+A (Windows) ou Option+A 
(Mac).

Pour effectuer uniquement un zoom horizontal 
afin d'afficher toute la session sans affecter le 
zoom vertical ou le défilement :

 Appuyez sur Alt+Démarrer+A (Windows) ou 
Option+Ctrl+A (Mac).

Pour appliquer la hauteur de forme d'onde de la 
piste audio figurant le plus haut dans la fenêtre 
Edit à toutes les autres pistes audio :

 Cliquez sur le bouton de zoom audio en 
maintenant les touches Ctrl+Maj (Windows) ou 
Commande+Maj (Mac) enfoncées. Les hauteurs 
de forme d'onde relatives sont perdues.

Pour appliquer la hauteur de forme d'onde de la 
piste MIDI ou d'instrument figurant le plus haut 
dans la fenêtre Edit à toutes les autres pistes MIDI 
ou d'instrument :

 Cliquez sur le bouton de zoom MIDI en 
maintenant les touches Ctrl+Maj (Windows) ou 
Commande+Maj (Mac) enfoncées. Les hauteurs 
de forme d'onde relatives sont perdues.

Boutons de preset de zoom
Pro Tools peut mémoriser jusqu'à cinq presets de 
zoom horizontal dans la fenêtre Edit, que vous 
pouvez rappeler en tapant leur chiffre ou en 
cliquant sur le bouton de preset correspondant. 

Pour mémoriser un affichage en tant que preset 
de zoom :

1 Utilisez le zoom pour configurer la vue de piste. 

2 Cliquez sur un bouton de preset de zoom (de 1 
à 5) et maintenez le bouton de la souris enfoncé, 
puis sélectionnez Save Zoom Preset dans le 
menu déroulant du preset de zoom. Le bouton 
du preset clignote momentanément, puis le 
preset de zoom précédemment mémorisé est 
remplacé. 

Pour rappeler un preset de zoom mémorisé, 
effectuez l'une des opérations suivantes :

 Cliquez sur le bouton du preset de zoom 
correspondant (de 1 à 5). 

 Cliquez sur le bouton du preset de zoom 
et maintenez le bouton de la souris enfoncé, 
puis sélectionnez Recall Zoom Preset dans le 
menu contextuel.

Cette opération affectera également la 
hauteur des notes MIDI.

Pour rétablir les hauteurs de forme d'onde 
audio par défaut sans affecter le niveau de 
zoom horizontal ou la hauteur des notes MIDI, 
appuyez sur Ctrl+Alt+Démarrer+[ (Windows) 
ou Commande+Option+Ctrl+[ (Mac).

Menu contextuel de preset de zoom
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Changement de zoom
La fonction de changement de zoom permet de 
basculer entre des états de zoom dans la fenêtre 
Edit.

Paramètres de changement de 
zoom
La fonction de changement de zoom mémorise et 
rappelle les paramètres suivants :

• Niveau de zoom vertical

• Niveau de zoom horizontal

• Hauteur des pistes

• Vue des pistes

• Configuration de la grille

Préférences de changement de 
zoom 
Les préférences Zoom Toggle déterminent 
le fonctionnement du changement de zoom. 
Configurez les préférences du changement de 
zoom afin de l'adapter à votre workflow. 

Pour modifier les préférences du changement 
de zoom :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Editing.

3 Modifiez les paramètres et options de 
changement de zoom.

4 Cliquez sur OK.

Zoom vertical

Selection : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant effectue un 
zoom vertical sur la sélection d'édition actuelle.

Last Used : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant effectue un 
zoom vertical sur les notes MIDI en vue Notes 
uniquement, pour rétablir le dernier état de 
changement de zoom mémorisé. 

Zoom horizontal

Selection : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant effectue 
un zoom horizontal sur la sélection actuelle. 
Ce paramètre est particulièrement utile pour 
l'édition audio.

Last Used : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant effectue un 
zoom horizontal pour rétablir le dernier état de 
changement de zoom mémorisé. Ce paramètre 
permet d'émuler une seconde fenêtre d'édition, 
particulièrement utile pour l'édition des notes 
MIDI.

Préférences de changement de zoom

Pour l'édition MIDI, configurez les 
préférences de changement de zoom de la 
manière suivante : Vertical Zoom sur Last 
Used, Horizontal Zoom sur Last Used, Track 
View sur Waveform/Notes et Track Height 
sur Fit to Window.

Pour l'édition audio, configurez les préférences 
de changement de zoom de la manière suivante : 
Vertical Zoom sur Selection, Horizontal Zoom 
sur Selection, Track Height sur Fit to Window et 
Track View sur No Change.
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Remove Range Selection After Zooming In. 

Lorsque cette option est sélectionnée, la sélection 
d'édition actuelle est réduite en un point d'insertion 
après un changement de zoom vers l'avant.

Hauteur des pistes

Last Used : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant rappelle la 
dernière hauteur de piste utilisée sur toutes les 
pistes contenant une sélection d'édition.

Medium : lorsque ce paramètre est sélectionné, un 
changement de zoom vers l'avant applique la 
hauteur de piste Medium à toutes les pistes 
contenant une sélection d'édition.

Large : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant applique la 
hauteur de piste Large à toutes les pistes contenant 
une sélection d'édition.

Jumbo : lorsque ce paramètre est sélectionné, un 
changement de zoom vers l'avant applique la 
hauteur de piste Jumbo à toutes les pistes 
contenant une sélection d'édition.

Extreme : lorsque ce paramètre est sélectionné, un 
changement de zoom vers l'avant applique la 
hauteur de piste Extreme à toutes les pistes 
contenant une sélection d'édition.

Fit To Window : lorsque ce paramètre est 
sélectionné, un changement de zoom vers l'avant 
applique la hauteur de piste Fit To Window à 
toutes les pistes contenant une sélection d'édition.

Vue des pistes

Waveform/Notes : lorsque ce paramètre est 
sélectionné, un changement de zoom vers l'avant 
active la vue Waveform sur les pistes audio et la 
vue Notes sur les pistes MIDI et d'instrument.

Warp/Notes : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant remplace la 
vue des pistes audio par la vue Warp et celle des 
pistes d'instrument et MIDI par la vue Notes.

Last Used : lorsque ce paramètre est sélectionné, 
un changement de zoom vers l'avant remplace la 
vue des pistes audio par la dernière vue de piste 
mémorisée par le changement de zoom.

No Change : lorsque ce paramètre est sélectionné, 
la vue des pistes n'est pas modifiée suite à un 
changement de zoom avant ou arrière.

Separate Grid Settings When Zoomed In

Lorsque cette option est sélectionnée, 
la configuration de la grille correspondant au zoom 
est rappelée lorsque vous effectuez un zoom avant. 
Lorsqu'elle est désélectionnée, la configuration de 
grille actuelle est conservée suite à un changement 
de zoom vers l'avant ou l'arrière. 

Zoom Toggle Follows Edit Selection

Lorsque cette option est sélectionnée, un 
changement de zoom suit automatiquement la 
sélection d'édition actuelle. Lorsque cette option 
est désélectionnée, la modification de la sélection 
d'édition n'a aucun effet sur la piste agrandie 
(zoom avant) actuelle.
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Utilisation du changement de 
zoom 
Selon la configuration des préférences de 
changement de zoom, le bouton de changement de 
zoom de la fenêtre Edit permet de définir un état de 
zoom, puis de basculer de cet état vers l'état actuel 
et vice versa, ou d'effectuer un zoom en fonction 
des paramètres des préférences de changement de 
zoom. Lorsque le changement de zoom est activé, la 
fenêtre Edit affiche l'état de zoom mémorisé. De 
plus, toute modification apportée à la vue pendant 
que le changement de zoom est activé sera 
mémorisée avec cet état de zoom.

Lorsque le changement de zoom est désactivé, 
la fenêtre Edit rétablit le dernier état de zoom.

Pour mémoriser un état de zoom à l'aide du bouton 
de changement de zoom :

1 Configurez les préférences du changement 
de zoom

2 Créez une sélection d'édition.

3 Cliquez sur le bouton de changement de zoom. 
Le bouton s'allume pour indiquer que le 
changement de zoom est activé et Pro Tools suit 
les paramètres configurés dans les préférences 
de changement de zoom.

Lorsque la valeur Last Used est sélectionnée pour 
un ou plusieurs des paramètres suivants, vous 
pouvez régler le zoom, la hauteur ou la vue 
correspondant(e) dans la fenêtre Edit afin de 
mettre à jour l'état de zoom enregistré :

• Zoom vertical

• Zoom horizontal

• Hauteur des pistes

• Vue des pistes

Pour modifier l'état du changement de zoom 
mémorisé lorsque le paramètre Last Used est 
sélectionné :

1 Assurez-vous que le bouton de changement de 
zoom est allumé (activé). 

2 Configurez la hauteur des pistes, le niveau de 
zoom vertical, la vue des pistes ou la grille, en 
fonction des préférences configurées avec le 
paramètre Last Used. Les changements sont 
mémorisés en tant que nouvel état de 
changement de zoom.

Bouton de changement de zoom dans la fenêtre Edit

Lorsque le focus clavier est activé sur les 
commandes (reportez–vous à la section 
« Focus clavier » à la page 26), appuyez 
sur la touche E pour activer ou désactiver la 
commande de changement de zoom.

Appuyez sur Alt+Maj+E (Windows) ou 
Option+Maj+E (Mac) pour annuler le 
changement de zoom sans revenir à la vue 
précédente.
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Pour effacer l'état de changement de zoom 
mémorisé :

1 Assurez-vous que le bouton de changement de 
zoom est allumé (activé). 

2 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton de 
changement de zoom.

Pour utiliser le changement de zoom sans 
modifier les vues des playlists :

1 Créez une sélection sur une ou plusieurs pistes.

2 Effectuez l'une des opérations suivantes :

• Appuyez sur Alt+Démarrer+E (Windows) ou 
Option+Ctrl+E (Mac).

• Lorsque le focus clavier est activé sur les 
commandes (reportez-vous à la section « Focus 
clavier » à la page 26), appuyez sur Alt+E 
(Windows) ou Option+E (Mac).

Basculement automatique lors 
d'un changement de sélection
Lorsque le changement de zoom est activé, 
la sélection d'une plage de données différente ou la 
sélection de données sur une piste différente 
affecte le changement de zoom de la manière 
suivante : 

• La modification de la durée de la sélection 
n'entraîne pas de nouveau zoom sur la fenêtre, 
le niveau de zoom actuel est conservé. 

• La création d'une sélection sur une piste 
différente définit les nouveaux paramètres 
mémorisés pour la hauteur et la vue de piste. Le 
niveau de zoom horizontal reste cependant 
inchangé. Lorsque la sélection est déplacée 
à partir d'une piste agrandie (zoom avant), 
la hauteur réduite des pistes (zoom arrière) est 
rétablie.

Zoom avec la molette de 
défilement
Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un zoom avant et arrière sur 
les pistes, verticalement et horizontalement.

Pour effectuer un zoom horizontal continu à l'aide 
de la molette de défilement :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée tout en faisant tourner la 
molette de la souris.

Pour effectuer un zoom continu sur les données 
audio dans la fenêtre Edit (zoom vertical) :

 Maintenez les touches Alt+Maj (Windows) ou 
Option+Maj (Mac) enfoncées tout en faisant 
tourner la molette de la souris.

Pour effectuer un zoom continu sur les données 
MIDI dans la fenêtre Edit (zoom vertical) :

 Maintenez les touches Alt+Démarrer 
(Windows) ou Option+Ctrl (Mac) enfoncées 
tout en faisant tourner la molette de la souris.

Utilisation du changement de zoom

La fonction de basculement automatique 
ne fonctionne pas avec les sélections d'édition 
réparties sur plusieurs pistes dont le zoom a 
été ajusté à la taille de la fenêtre.
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Pour faire défiler le contenu de la fenêtre Edit ou 
de la fenêtre Mix horizontalement :

1 Activez la fenêtre dont vous voulez faire défiler 
le contenu en cliquant dessus ou en la plaçant au 
premier plan.

2 Maintenez la touche Maj enfoncée tout en 
faisant tourner la molette de la souris. 

Utilisation des outils de trim
Les outils de trim exécutent des opérations de 
trimming sur les clips, les notes et les données. Les 
outils de trim suivants sont disponibles :

• Outil de trim, également appelé outil de trim 
standard

• Outil de trim par compression/expansion 
temporelle, également appelé outil de trim TCE

• Outil de trim par scrubbing (Pro Tools HD 
uniquement)

• Outil de trim de boucle

L'utilisation des outils de trim standard et par 
scrubbing est restreinte uniquement par les limites 
du fichier audio entier référencé par un clip. L'outil 
de trim TCE est restreint uniquement par le facteur 
TCE maximal.

Outil de trim
L'outil de trim permet de raccourcir ou d'allonger 
rapidement un clip (jusqu'à rétablir la durée totale 
du fichier audio source). La première fois que vous 
effectuez une opération de trimming sur un clip, 
Pro Tools l'ajoute automatiquement à la liste des 
clips, en tant que nouveau clip (en lui attribuant un 
nom dérivé du nom d'origine) pour le différencier de 
l'original.

L'outil de trim standard est non destructif et ne 
modifie pas les données audio ou MIDI d'origine 
(lorsque vous travaillez sur des clips). Pour rétablir 
la durée du clip d'origine, faites-le glisser depuis la 
liste des clips ou rétablissez la durée d'origine du clip 
édité à l'aide de l'outil de trim.

L'utilisation de l'outil de trim dépend du mode 
d'édition actif : Shuffle, Slip, Spot ou Grid 
(reportez-vous à la section « Modes d'édition » à la 
page 543).

Pour effectuer une opération de trimming sur un 
clip avec l'outil de trim :

1 Sélectionnez l'outil de trim. 

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu déroulant de l'outil de trim 
et sélectionnez Standard.

• Effectuez un clic droit sur une piste puis 
sélectionnez Tools > Trim Tools > Standard.

3 Placez le curseur près du début ou de la fin d'un 
clip, afin que le curseur de l'outil de trim 
apparaisse.

Pour inverser la direction de l'outil de trim 
standard, appuyez sur Alt (Windows) ou Option 
(Mac).

L'outil de trim peut également être utilisé pour 
rallonger ou raccourcir des notes MIDI 
(reportez-vous à la section « Trim des points 
de début et de fin d'une note » à la page 704), 
ou pour modifier de manière proportionnelle 
un groupe de données d'automation et de 
contrôleur vers le haut ou le bas. Reportez-
vous à la section « Dessin d'automation » à la 
page 1093.

Outil de trim

Outil de trim
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4 Effectuez l'une des opérations suivantes :

• Pour une opération de trimming sur la fin d'un 
clip, cliquez et faites glisser votre souris vers la 
gauche pour raccourcir le clip ou vers la droite 
pour le rallonger.

• Pour une opération de trimming sur le début d'un 
clip, cliquez et faites glisser votre souris vers la 
droite pour raccourcir le clip ou vers la gauche 
pour le rallonger.

Lorsque vous effectuez une opération de trimming 
sur des clips d'une piste stéréo ou multicanal, tous 
les canaux sont affectés.

En mode Shuffle, les clips suivants se décalent 
de l'intervalle nécessaire à l'édition d'un clip. 
En mode Grid, les nouvelles heures de début et de 
fin s'alignent sur la limite de grille la plus proche. 
En mode Spot, la boîte de dialogue Spot s'ouvre et 
vous invite à entrer le nouvel emplacement des 
points de début et de fin du clip.

Outil de trim par 
compression/expansion 
temporelle
L'outil de trim par compression/expansion 
temporelle (outil de trim TCE) est idéal pour faire 
correspondre la durée d'un clip à celle d'un autre, à 
une grille de tempo, une scène vidéo ou à 
pratiquement tout autre point de référence 
possible.

Outil de trim TCE Elastic Audio
Sur les pistes Elastic Audio, l'outil TCE utilise 
le plug-in Elastic Audio sélectionné pour la piste 
(en temps réel ou en rendu) afin d'appliquer le 
traitement Elastic Audio en temps réel ou en rendu. 
Le clip résultant affiche un indicateur de 
déformation pour indiquer un traitement Elastic 
Audio.

Outil de trim TCE AudioSuite
Sur les pistes audio non Elastic Audio, 
le fonctionnement de l'outil de trim TCE est basé 
sur le plug-in TCE AudioSuite sélectionné dans les 
préférences de traitement de Pro Tools, afin de 
créer de nouveaux fichiers audio. 

Préférences du plug-in de 
compression/expansion 
temporelle
Vous pouvez sélectionner le plug-in AudioSuite 
à utiliser pour les opérations de trimming à l'aide 
de l'outil de trim TCE sur les pistes audio non 
Elastic Audio. 

Lorsque vous travaillez avec de l'audio, il est 
impossible d'étendre une opération de 
trimming au-delà des limites des clips 
adjacents.

Outil de trim TCE utilisé sur un clip

L'outil de trim TCE annule toute mise en 
boucle et entraîne la consolidation des clips 
en boucle.

Il est possible de faire correspondre la durée 
d'une sélection d'édition à celle d'une sélection 
de timeline en sélectionnant la commande 
Edit > TCE Edit to Timeline Selection 
(reportez-vous à la section « TCE Edit To 
Timeline Selection » à la page 622).

Pour plus d'informations sur les plug-ins 
Elastic Audio, reportez-vous à la section 
« Plug-ins Elastic Audio » à la page 916.
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Pour choisir le plug-in AudioSuite à utiliser avec 
l'outil de trim TCE :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Processing.

3 Dans le menu déroulant TC/E Plug-in, 
sélectionnez le plug-in AudioSuite à utiliser 
avec l'outil de trim de compression/expansion 
temporelle.

4 Dans le menu déroulant Default Settings, 
sélectionnez le paramètre de plug-in adapté au 
type de données avec lesquelles vous travaillez 
le plus (Stereo Mix Default, par exemple).

5 Cliquez sur OK.

Utilisation de l'outil de trim TCE 
en mode Grid
L'outil de trim TCE peut être utilisé en mode Grid 
pour faire correspondre le tempo d'un clip à celui 
d'une session ou d'un passage d'une session. Vous 
pouvez par exemple importer une boucle de 
batterie d'une mesure avec un tempo de 90 BPM 
dans une session dont le tempo est de 120 BPM. 
Vous pourrez utiliser cet outil en mode Grid pour 
rapidement et simplement « compresser 
temporellement » la boucle de batterie afin qu'elle 
ne s'étende que sur une mesure, sans perte de 
fidélité audio audible. 

Pour utiliser l'outil de trim TCE en mode Grid :

1 Sélectionnez le mode d'édition Grid.

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu déroulant de l'outil de trim 
et sélectionnez TCE.

• Effectuez un clic droit sur une piste, puis 
sélectionnez Tools > Trim Tools > TCE.

3 À l'aide de l'outil de trim TCE, faites glisser le 
point de début ou de fin du clip pour étendre ou 
compresser le clip en fonction des pas de la 
grille (par intervalles d'une noire par exemple). 

Utilisation de l'outil de trim TCE 
en mode Slip

Pour utiliser l'outil de trim TCE en mode Slip :

1 Activez le mode d'édition Slip.

2 Cliquez sur le menu déroulant de l'outil de trim 
et sélectionnez TCE.

3 Avec l'outil de trim TCE, faites glisser le point 
de début ou de fin du clip pour étendre ou 
compresser le clip librement. 

 Préférences TC/E

Pour plus d'informations sur les plug-ins 
AudioSuite, reportez-vous au Chapitre 39, 
« Traitement AudioSuite ».

Les opérations de trimming réalisées en 
mode Grid relatif s'effectuent par pas de 
grille, tout en maintenant les intervalles 
relatifs par rapport à la grille, le cas échéant.

Outil de trim par compression/expansion temporelle
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Utilisation de l'outil de trim TCE 
en mode Spot
En mode Spot, lorsque vous cliquez avec l'outil de 
trim TCE sur un clip, la boîte de dialogue Spot 
s'affiche. Vous pouvez préciser l'emplacement 
auquel vous souhaitez que le clip débute ou se 
termine, ou la durée du clip afin d'appliquer 
automatiquement la compression ou l'expansion 
temporelle nécessaire.

Pour utiliser l'outil de trim TCE en mode Spot :

1 Activez le mode d'édition Spot.

2 Cliquez sur le menu déroulant de l'outil de trim 
et sélectionnez TCE.

3 Cliquez sur le clip à proximité de son point de 
début ou de fin. La boîte de dialogue Spot 
s'ouvre. Saisissez une nouvelle valeur de début 
ou de fin (ou une durée) pour le clip, dans l'une 
des échelles temporelles, puis cliquez sur OK. 

Outil de trim par scrubbing
(Pro Tools HD uniquement)

L'outil de trim par scrubbing est particulièrement 
efficace pour écouter des données (sur deux pistes 
au maximum) afin de localiser un point de 
trimming. Vous pouvez cliquer sur une piste et 
faire glisser votre souris pour écouter les données 
audio, puis déclencher une opération de trimming 
à un endroit précis en relâchant le bouton de la 
souris.

Cette opération crée un clip. Notez que le curseur 
de l'outil de trim par scrubbing se transforme en 
curseur de « trim vers la droite » ou de « trim vers 
la gauche » selon sa position sur le clip. Pour 
inverser la direction de l'outil de trim par 
scrubbing, maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée avant de cliquer sur le clip.

Le sens et la vitesse de lecture en scrubbing varient 
selon le mouvement du contrôleur. L'audio lu lors 
d'un scrubbing est routé sur le chemin de signal de 
la piste, les effets éventuellement présents sont 
donc audibles.

Pour effectuer une opération de trimming par 
scrubbing sur une piste :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de l'outil de trim et 
sélectionnez Scrub. 

• Effectuez un clic droit sur une piste, puis 
sélectionnez Tools > Trim Tools > Scrub.

Le curseur se transforme en haut-parleur 
accompagné d'un crochet.

2 Cliquez sur une piste et faites glisser votre 
souris vers la gauche ou la droite. L'audio d'une 
piste lue en scrubbing est routé sur le chemin de 
signal de la piste, en incluant les éventuels effets 
DSP. Lorsque vous avez localisé le point de 
trimming recherché, relâchez le bouton de la 
souris pour réaliser l'opération.

• Pour effectuer une opération de trimming par 
scrubbing sur deux pistes, cliquez avec l'outil de 
trim par scrubbing entre deux pistes adjacentes 
et faites glisser votre souris.

• Pour un scrubbing plus précis (sans zoom 
avant), maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée pendant l'opération.

Outil de trim par scrubbing utilisé sur un clip
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Outil de trim de boucle
Utilisez l'outil de trim de boucle pour créer ou 
effectuer une opération de trimming sur des clips 
mis en boucle (reportez-vous à la section « Mise en 
boucle de clips » à la page 873). 

Création de boucles avec l'outil 
de trim de boucle

Pour créer un clip mis en boucle à l'aide de l'outil 
de trim de boucle :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu déroulant de l'outil de trim 
et sélectionnez Loop.

• Effectuez un clic droit sur une piste puis 
sélectionnez Tools > Trim Tools > Loop.

2 Placez le curseur sur la moitié supérieure d'un 
clip ou d'un groupe de clips audio ou MIDI non 
lu en boucle. Le curseur change de forme pour 
indiquer que vous pouvez effectuer une 
opération de trimming de boucle sur le clip. Si 
vous placez le curseur sur la moitié inférieure 
du clip, le curseur de trim standard s'affiche.

3 Effectuez l'une des opérations suivantes :

• Cliquez à la fin du clip, puis faites glisser le 
curseur vers la gauche ou la droite jusqu'à 
l'endroit où la boucle doit se terminer.

• Cliquez au début du clip, puis faites glisser le 
curseur vers la gauche ou la droite jusqu'à 
l'endroit où la boucle doit commencer.

Trimming de clips mis en boucle
Vous pouvez effectuer une opération de trimming 
sur un clip mis en boucle de deux manières 
différentes :

• Utilisez l'outil de trim de boucle sur un clip mis 
en boucle pour modifier sa durée. Utilisez par 
exemple l'outil de trim de boucle sur un clip mis 
en boucle pour allonger sa durée de 2 à 
4 mesures. Pour un clip d'une mesure, le nombre 
de boucles passe de 2 à 4. Toutes les itérations 
de boucle conservent la même durée, mais la 
durée globale du clip mis en boucle change.

• Effectuez une opération de trimming sur le clip 
source (itération de boucle) tout en conservant la 
durée globale de la boucle. Le nombre 
d'itérations de boucles contenues dans le clip mis 
en boucle est modifié en conséquence. Effectuez 
par exemple une opération de trimming sur une 
itération de boucle de 2 mesures issue d'un clip 
de 4 mesures, pour obtenir une durée d'une seule 
mesure. La durée du clip mis en boucle de 
4 mesures reste identique, mais le nombre 
d'itérations de boucle passe de 2 à 4. La durée des 
itérations de boucle est modifiée mais celle du 
clip mis en boucle reste la même.

Outil de trim de boucle

Curseur de trim de boucle

Clip mis en boucle

Outil de trim de boucle

Icône de boucle
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Pour effectuer une opération de trimming de 
boucle sur un clip mis en boucle :

1 Sélectionnez l'outil de trim de boucle.

2 Déplacez le curseur sur la moitié supérieure du 
clip mis en boucle (pas sur une icône de boucle). 
Le curseur représente l'outil de trim de boucle.

3 Effectuez une opération de trimming sur le clip 
mis en boucle.

Le nombre de boucles augmente ou diminue pour 
couvrir la nouvelle durée de la boucle entière.

Pour effectuer une opération de trimming sur 
le clip source (itération de boucle) d'un clip mis 
en boucle :

1 Sélectionnez l'outil de trim de boucle.

2 Placez le curseur sur une icône de boucle du clip 
mis en boucle, ou à n'importe quel endroit dans 
la partie inférieure du clip. Le curseur se 
transforme en icône d'outil de trim.

3 Effectuez l'opération de trimming sur le début 
ou la fin de l'itération de boucle.

Le nombre d'itérations de boucle augmente ou 
diminue pour couvrir la durée originale de la 
boucle entière.

Outil de trim de boucle

Opération de trimming de boucle sur un clip mis 
en boucle

Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée lors de l'opération 
pour effectuer un trimming itération de 
boucle par itération de boucle.

Le trimming d'un clip mis en boucle n'affecte 
pas les fondus sous-jacents.

Outil de trim de boucle

Trimming d'un clip mis en boucle

Clip mis en boucle après l'opération de trimming
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Utilisation du Sélecteur
Utilisez le Sélecteur pour placer le curseur 
d'édition sur une piste ou une règle de base de 
temps, ou pour créer des sélections de timeline ou 
d'édition sur des pistes.

Positionnement du curseur 
d'édition

Pour positionner le curseur d'édition à l'aide du 
Sélecteur :

1 Activez le Sélecteur dans la fenêtre Edit.

2 Cliquez sur un emplacement d'une piste ou 
d'une règle de base de temps.

Création d'une sélection 
d'édition à l'aide du Sélecteur

Pour créer une sélection d'édition avec le 
Sélecteur :

1 Activez le Sélecteur dans la fenêtre Edit.

2 Effectuez l'une des opérations suivantes :

• Pour créer une sélection d'édition sur une seule 
piste, cliquez et faites glisser le Sélecteur sur la 
piste.

• Pour créer une sélection d'édition sur plusieurs 
pistes, cliquez et faites glisser le Sélecteur sur 
les différentes pistes.

• Si l'option Link Timeline and Edit Selection est 
activée, cliquez et faites glisser le Sélecteur sur 
la règle de base de temps pour créer une 
sélection d'édition sur toutes les pistes.

Pour sélectionner un clip entier avec le Sélecteur :

1 Activez le Sélecteur dans la fenêtre Edit.

2 Double-cliquez sur un clip d'une piste.

Pour sélectionner une piste entière avec le 
Sélecteur :

1 Activez le Sélecteur dans la fenêtre Edit.

2 Cliquez trois fois sur la piste souhaitée.

Positionnement du curseur d'édition à l'aide du 
Sélecteur

Création d'une sélection à l'aide du Sélecteur
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Création d'une sélection de 
timeline à l'aide du Sélecteur

Pour créer une sélection de timeline avec le 
Sélecteur :

1 Activez le Sélecteur dans la fenêtre Edit.

2 Effectuez l'une des opérations suivantes :

• Cliquez et faites glisser le Sélecteur sur une 
règle de base de temps.

• Si l'option Link Timeline and Edit Selection est 
sélectionnée, cliquez et faites glisser le Sélecteur 
sur une piste.

Utilisation des outils de saisie
Utilisez les outils de saisie afin de sélectionner, 
séparer ou déplacer des clips sur des pistes. Trois 
modes de l'outil de saisie sont disponibles : outil de 
saisie du temps, outil de séparation et outil de 
saisie d'objet. Pour en savoir plus sur l'organisation 
des clips, reportez-vous au Chapitre 37, 
« Organisation des clips ».

Outil de saisie du temps : sélectionne un clip 
entier sur une piste d'un simple clic. Pour plus 
d'informations sur la sélection des clips, reportez-
vous à la section « Sélection du contenu des 
pistes » à la page 577.

Outil de séparation : permet de copier et de coller 
une sélection d'édition d'un emplacement à un 
autre en cliquant dessus, puis en la faisant glisser. 
Pour plus d'informations, reportez-vous à la 
section « Outil de séparation » à la page 602.

Outil de saisie d'objet : permet de sélectionner 
plusieurs clips non contigus. Pour plus 
d'informations, reportez-vous à la section 
« Sélections d'objets » à la page 579.

Pour sélectionner l'un des outils de saisie, 
effectuez l'une des opérations suivantes :

 Cliquez sur la Main dans la fenêtre Edit et 
sélectionnez l'un des outils de saisie dans le 
menu contextuel.

 Effectuez un clic droit sur une piste et 
sélectionnez l'outil de saisie dans Tools > 

Grabber Tools.

Outil de saisie du temps

Outil de séparation

Outil de saisie d'objet

Sélection d'un outil de saisie
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Utilisation de l'outil Smart
L'outil Smart permet d'accéder instantanément au 
Sélecteur, à la Main et à l'outil de trim, ainsi que de 
créer des fondus et fondus enchaînés. La position 
du curseur par rapport à un clip, une note, ou au 
sein d'une playlist d'automation, détermine le 
fonctionnement de l'outil Smart.

Pour sélectionner l'outil Smart, cliquez sur son 
icône en haut à gauche de la fenêtre Edit, 
ou appuyez simultanément sur F6+F7 (ou F7+F8).

L'outil Smart en vue Waveform 
(audio) ou Clips (MIDI)

Les fonctions suivantes sont disponibles avec 
l'outil Smart lorsque vous travaillez sur des pistes 
audio en vue Waveform ou Blocks, ou sur des 
pistes MIDI ou d'instrument en vue Clips :

 Pour activer le Sélecteur, placez le curseur au 
milieu d'un clip, dans sa moitié supérieure.

 Pour activer l'outil de saisie, placez le curseur au 
milieu d'un clip, dans sa moitié inférieure.

 Pour activer l'outil de trim, placez le curseur 
à proximité du point de début ou de fin d'un clip. 

 Pour créer un fondu d'entrée ou de sortie, placez 
le curseur à proximité du point de début ou de fin 
d'un clip, près de son bord supérieur. Lorsque le 
curseur de fondu apparaît, cliquez et faites glisser 
votre souris vers l'intérieur du clip pour définir la 
durée du fondu. Le fondu est créé 
automatiquement, en fonction du paramètre 
Default Fade Settings des préférences d'édition.

 Pour créer un fondu enchaîné, placez le curseur 
entre deux clips audio adjacents, près du bord 
inférieur d'un clip. Lorsque le curseur de fondu 
enchaîné apparaît, cliquez et faites glisser votre 
souris vers la gauche ou la droite pour définir la 
durée du fondu enchaîné. Le fondu enchaîné est 
créé automatiquement, en fonction du paramètre 
Default Fade Settings des préférences d'édition.

L'outil Smart en vue Warp

Outil Smart activé dans la fenêtre Edit

Outil Smart en vue Waveform

Fondu d'entrée Fondu de sortieSélecteur

Outil de saisie

Outil de 
trim

(début)

Outil 
de trim 

(fin)

Fondu enchaîné

Pour passer provisoirement de l'outil Smart à 
l'outil de scrubbing, placez le curseur sur un 
clip pour activer le Sélecteur, puis maintenez 
la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée.

Outil Smart en vue Warp

Sélecteur

Outil de saisie

Outil de 
trim

(début)

Outil de 
trim 
(fin)
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Les fonctions suivantes sont disponibles avec 
l'outil Smart lorsque vous travaillez sur des pistes 
Elastic Audio en vue Warp, ou sur des pistes MIDI 
ou d'instrument en vue Clips :

 Pour activer le Sélecteur, placez le curseur au 
milieu d'un clip, dans sa moitié supérieure.

 Pour activer l'outil de saisie, placez le curseur 
au milieu d'un clip, dans sa moitié inférieure, en 
évitant tout marqueur d'événement ou de 
déformation.

 Pour effectuer une déformation Elastic Audio, 
placez le curseur sur un marqueur d'événement ou 
de déformation, dans la moitié inférieure d'un clip 
(pour plus d'informations sur la déformation de 
l'audio, reportez-vous à la section « Édition en vue 
Warp » à la page 920).

 Pour activer l'outil de trim, placez le curseur à 
proximité du point de début ou de fin d'un clip, 
dans sa moitié supérieure. 

L'outil Smart en vue Notes

Les fonctions suivantes sont disponibles avec 
l'outil Smart lorsque vous travaillez sur des pistes 
MIDI et d'instrument en vue Notes dans les 
fenêtres Edit et de l'éditeur MIDI :

 Pour activer le rectangle de sélection, placez le 
curseur sur une zone ne contenant aucune note.

 Pour activer l'outil de saisie, placez le curseur 
près du milieu d'une note. 

 Pour activer l'outil de trim, placez le curseur à 
proximité du point de début ou de fin d'une note.

 Pour activer l'outil de trim de vélocité, placez le 
curseur sur une note et maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée.

Pour passer provisoirement de l'outil Smart 
à l'outil de scrubbing, placez le curseur 
dans la moitié supérieure d'un clip pour 
activer le Sélecteur, puis maintenez la 
touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée.

Outil Smart en vue Notes

Sélecteur (rectangle de sélection)

Outil de saisieTrimming du 
début de la note

Trimming de la 
fin de la note

Trimming de la vélocité d'une note

Pour passer provisoirement de l'outil Smart 
au Crayon, maintenez la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée. 

Pour passer temporairement de l'outil Smart 
à la Gomme, maintenez les touches 
Alt+Démarrer (Windows) ou Option+Ctrl 
(Mac) enfoncées. 
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L'outil Smart en vue 
d'automation ou de contrôleur
Les fonctions suivantes sont disponibles avec 
l'outil Smart lorsque vous travaillez en vue 
d'automation ou de contrôleur :

 Pour activer le Sélecteur, placez le curseur dans 
les 3/4 inférieurs d'une playlist. Cliquez et faites 
glisser le Sélecteur pour sélectionner des points 
d'automation. 

 Pour activer les outils de trim, placez le curseur 
dans le 1/4 supérieur d'une playlist. Cliquez et 
faites glisser l'outil de trim pour effectuer une 
opération de trimming sur des points d'automation. 
Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée pour une opération de 
trimming plus précise.

 Pour activer les outils de saisie, appuyez sur 
Ctrl (Windows) ou Commande (Mac), puis cliquez 
sur la ligne d'automation pour créer des points 
d'automation.

• Pour éditer des points d'automation existants, 
placez le curseur à proximité d'un point 
d'automation pour activer la Main.

• Pour plus de précision avec la Main, appuyez sur 
la touche Ctrl (Windows) ou Commande (Mac), 
ou maintenez-la enfoncée si vous créez un point 
d'automation. 

• Maintenez la touche Maj enfoncée pour 
restreindre le mouvement de la Main sur l'axe 
vertical.

• Pour restreindre le mouvement de la Main sur 
l'axe vertical et effectuer une opération de 
précision, appuyez sur Ctrl+Maj (Windows) 
ou Commande+Maj (Mac). 

L'outil Smart avec les pistes 
stéréo et multicanal
Si vous utilisez l'outil Smart sur des pistes stéréo et 
multicanal, il est impossible d'éditer 
indépendamment les canaux. Toutes les 
modifications apportées affecteront l'ensemble des 
canaux. 

L'activation des outils avec l'outil Smart sur des 
pistes stéréo et multicanal est déterminé par la 
position du curseur sur la piste globale, et non par 
rapport à chacun canal individuel.

Utilisation de l'outil de 
scrubbing
L'outil de scrubbing permet d'effectuer un 
scrubbing sur deux pistes audio maximum dans la 
fenêtre Edit. Le scrubbing est une technique qui 
provient du montage sur bande magnétique et qui 
consiste à faire défiler la bande d'avant en arrière 
sur la tête de lecture, à une vitesse inférieure à la 
vitesse normale, afin de mieux repérer un endroit 
particulier (généralement pour réaliser des 
coupes/assemblages).

L'affichage des formes d'onde audio dans 
Pro Tools est utile pour localiser visuellement un 
point d'édition. Cependant, il peut arriver qu'une 
forme d'onde ne permette pas de repérer un point 
précis dans les données audio, du fait de leurs 
caractéristiques sonores. En effectuant un 
scrubbing d'avant en arrière dans Pro Tools, vous 
pouvez écouter et localiser un point d'édition 
précis. 

Lorsque l'option Edit Insertion Follows 
Scrub/Shuttle est activée dans les préférences de 
fonctionnement, le curseur d'édition se place 
automatiquement au point ou vous arrêtez 
le scrubbing.
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Lorsque l'option de défilement est réglée sur 
Continuous (Pro Tools HD uniquement) ou Center 
Playhead (Pro Tools HD uniquement), un clic avec 
l'outil de scrubbing sur la playlist d'une piste centre 
la fenêtre Edit sur ce point et y positionne la tête de 
lecture. Avec ces options de défilement, la tête de 
lecture reste stationnaire et centrée lors d'une 
opération de scrubbing.

Pour effectuer un scrubbing sur une seule piste 
audio :

1 Sélectionnez l'outil de scrubbing.

2 Cliquez et faites-le glisser vers la gauche pour 
une lecture arrière, ou vers la droite pour une 
lecture avant.

La distance et la vitesse du déplacement (avec la 
souris ou la molette de scrubbing d'une surface de 
contrôle) détermine la durée et la vitesse du 
scrubbing audio. L'audio de la piste sur laquelle 
vous effectuez l'opération est routé sur sa sortie, 
avec les effets éventuellement assignés.

La résolution de l'outil de scrubbing dépend du 
facteur de zoom appliqué sur la piste sur laquelle 
l'opération est effectuée.

Pour effectuer un scrubbing sur plusieurs pistes 
audio, effectuez l'une des opérations suivantes :

 Après avoir sélectionné l'outil de scrubbing, 
cliquez et faites-le glisser entre deux pistes 
adjacentes.

 Effectuez un scrubbing sur une sélection 
contenant plusieurs pistes.

Lorsque vous effectuez un scrubbing sur plusieurs 
pistes, vous n'entendez que les deux premières.

Scrubbing d'une piste audio avec l'outil de scrubbing

Pour passer provisoirement du Sélecteur 
à l'outil de scrubbing, maintenez la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée 
et cliquez. Pour un scrubbing plus précis, 
maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et cliquez.

Scrubbing entre deux pistes audio

Vous pouvez effectuer un scrubbing sur un 
maximum de huit canaux dans Pro Tools, ce 
qui permet de lire une piste 7.1, deux pistes 
stéréo (quatre canaux), mais pas deux pistes 
en surround 5.1 (12 canaux).
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Mode Scrub/Shuttle
Lors d'un scrubbing normal, la vitesse de lecture 
est normale ou inférieure à la normale. Le mode 
Scrub/Shuttle, en revanche, permet d'effectuer un 
scrubbing à plusieurs fois la vitesse normale, 
ce qui peut être utile pour lire des plages étendues 
et repérer des données.

Pour effectuer un scrubbing en mode Shuttle 
(plusieurs fois la vitesse normale) :

1 Sélectionnez l'outil de scrubbing.

2 Tout en maintenant la touche Alt (Windows) ou 
Option (Mac) enfoncée, cliquez et faites glisser 
sur une piste vers la gauche pour une recherche 
arrière ou vers la droite pour une recherche 
avant. Les boutons Fast Forward et Rewind de 
la fenêtre de transport s'enclenchent. 

La distance et la vitesse du déplacement 
déterminent la vitesse du scrubbing audio.

Mode de shuttle verrouillé
Le mode de shuttle verrouillé permet d'utiliser le 
pavé numérique pour effectuer un shuttle avant ou 
arrière sur un maximum de deux pistes audio, 
à différentes vitesses : 5 correspond à la vitesse 
normale, les touches 6 à 9 correspondent à des 
vitesses d'avance rapide de plus en plus élevées et 
les touches 4 à 1 à des vitesses de retour rapide de 
plus en plus élevées (4 étant la vitesse de retour 
rapide la plus faible et 1 la plus élevée). 
Si plusieurs pistes sont sélectionnées, seules les 
deux premières sont prises en compte pour 
l'opération de shuttle.

Pour lire une ou deux pistes en mode de shuttle 
verrouillé : 

1 Dans Pro Tools HD, assurez-vous que le mode 
du pavé numérique n'est pas configurée sur 
Shuttle dans les préférences de fonctionnement 
(reportez-vous à la section « Préférences de 
fonctionnement » à la page 107).

2 À l'aide du Sélecteur, cliquez sur une piste 
à l'endroit où vous souhaitez que la lecture 
commence. Pour effectuer un shuttle sur deux 
pistes, maintenez la touche Maj enfoncée et 
cliquez sur une seconde piste.

3 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, puis appuyez sur 
un chiffre du pavé numérique compris entre 
0 et 9 (9 étant la vitesse la plus élevée, 
5 la vitesse normale et 0 l'arrêt du shuttle).

Dès que le mode de shuttle verrouillé est activé, 
les boutons Fast Forward et Rewind sont mis en 
surbrillance dans la fenêtre de transport.

4 Appuyez sur d'autres touches pour faire varier la 
vitesse de lecture, ou sur Plus (+) ou Moins (-) 
pour inverser le sens de lecture (Plus pour une 
lecture avant, Moins pour une lecture arrière).

5 Pour arrêter la lecture, appuyez sur Démarrer+0 
(Windows) ou Ctrl+0 (Mac).

Pour quitter le mode de shuttle verrouillé, 
effectuez l'une des opérations suivantes :

 Appuyez sur le bouton Stop de la fenêtre 
de transport.

 Appuyez sur la barre d'espace.
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Vitesse personnalisée de 
shuttle verrouillé
(Pro Tools HD uniquement)

Utilisez la préférence Custom Shuttle Lock Speed 
pour personnaliser la vitesse d'avance rapide la 
plus élevée du mode de shuttle verrouillé 
(touche 9), afin qu'elle soit plus adaptée à vos 
habitudes de travail.

Pour configurer la vitesse personnalisée de 
shuttle verrouillé :

1 Dans Pro Tools, sélectionnez Setup > 

Preferences, puis cliquez sur l'onglet 
Operation. 

2 Assurez-vous que le pavé numérique est en 
mode Transport ou Classic (reportez-vous à la 
section « Préférences de fonctionnement » à la 
page 107).

3 Saisissez un pourcentage pour le paramètre 
Custom Shuttle Lock Speed. La plage autorisée 
est comprise entre 50 et 800 %. Utilisez les 
touches Flèche haut et bas pour augmenter ou 
réduire la valeur. 

4 Cliquez sur OK. 

La vitesse choisie pour le paramètre Custom 

Shuttle Lock Speed est enregistrée avec vos 
préférences système Pro Tools (et non pas avec la 
session).

Pour activer la vitesse personnalisée de shuttle 
verrouillé :

 Appuyez sur Démarrer+9 (Windows) ou Ctrl+9 
(Mac) sur le pavé numérique.

Pavé numérique en mode 
Shuttle
(Pro Tools HD uniquement)

Pro Tools propose une autre méthode de shuttle, 
différente du mode de shuttle verrouillé. Lorsque le 
pavé numérique est en mode Shuttle, la lecture de la 
sélection d'édition actuelle est déclenchée lorsque 
vous appuyez sur les touches du pavé numérique et se 
poursuit tant que vous les maintenez enfoncées ; la 
lecture s'arrête dès que vous relâchez les touches. 
Plusieurs vitesses de lecture avant et arrière sont 
disponibles. Dans ce mode, les plages de pré et post-
roll sont ignorées.

Pour effectuer un shuttle lorsque le pavé 
numérique est en mode Shuttle :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Activez le mode Shuttle du pavé numérique, 
puis cliquez sur OK.

3 À l'aide du Sélecteur, cliquez sur une piste 
à l'endroit où vous souhaitez que la lecture 
commence. Pour effectuer un shuttle sur deux 
pistes, maintenez la touche Maj enfoncée et 
cliquez sur une seconde piste.

4 Maintenez l'une des touches (ou combinaisons 
de touches) suivantes enfoncée sur le pavé 
numérique pour déclencher la lecture.

5 Appuyez sur une autre touche pour inverser la 
direction ou changer de vitesse. Relâchez pour 
arrêter.

Vitesse de 
shuttle

Touche de 
retour 
rapide

Touche 
d'avance 
rapide

Vitesse 1 x 4 6

Vitesse 4 x 7 9

Vitesse 1/4 x 1 3

Vitesse 1/2 x 4+5 5+6

Vitesse 2 x 7+8 8+9
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Utilisation du Crayon
Le Crayon permet de dessiner plusieurs types de 
données dans Pro Tools :

• Formes d'onde audio (reportez-vous à la section 
« Réparation d'une forme d'onde avec le 
Crayon » à la page 572)

• Données MIDI (reportez-vous à la section 
« Utilisation du Crayon » à la page 696)

• Changements de tempo (reportez-vous à la 
section « Édition d'événements de tempo dans 
l'éditeur de tempo » à la page 804)

• Automation (reportez-vous à la section « Dessin 
d'automation » à la page 1093) 

Réparation d'une forme d'onde 
avec le Crayon
Sur les pistes audio, le Crayon permet de 
« redessiner » de façon destructive les données de 
la forme d'onde. Cet outil est couramment utilisé 
pour réparer un bruit ou un clic dans un fichier 
audio. Un clic apparaît sous la forme d'une pointe 
soudaine et franche dans une forme d'onde. Cet 
outil est actif dans la fenêtre Edit uniquement 
lorsque un zoom au niveau de l'échantillon est 
appliqué.

Bien que vous puissiez annuler une opération 
d'édition réalisée avec le Crayon, il est conseillé de 
créer une copie de sauvegarde de l'audio cible 
avant d'utiliser cet outil. Vous pouvez pour cela 
utiliser le plug-in AudioSuite Duplicate.

Pour éditer de façon destructive une forme d'onde 
audio avec le Crayon :

1 Localisez la zone à éditer.

2 À l'aide de l'outil de zoom ou des boutons de 
zoom, effectuez un zoom au niveau de 
l'échantillon, afin que la forme d'onde se 
présente sous la forme d'une fine ligne continue. 
Ajustez la hauteur de la piste pour éditer la 
forme d'onde avec plus de précision. Pour une 
meilleure résolution, vous pouvez également 
effectuer un zoom vertical.

3 Sélectionnez le Crayon.

4 Dessinez avec précaution la zone désirée de la 
forme d'onde à l'aide du Crayon.

Évitez d'appliquer des opérations d'édition 
successives pour obtenir des résultats satisfaisants. 
Vous avez toutefois la possibilité d'annuler la 
dernière opération d'édition à l'aide de la 
commande Undo.

Le Crayon est un outil d'édition destructif qui 
modifie définitivement le fichier audio sur le 
disque et doit être utilisé avec précaution.

Pour plus d'informations sur le plug-in 
AudioSuite Duplicate, reportez-vous au 
Guide des plug-ins audio.

Vous pouvez rappeler des niveaux de zoom 
à l'aide des boutons de preset de zoom 
(reportez-vous à la section « Méthodes de 
zoom » à la page 548) ou d'emplacements 
mémoire (reportez-vous à la section « Rappel 
d'emplacements mémoire » à la page 843). 
Par défaut, le preset de zoom 5 active un zoom 
au niveau de l'échantillon pour une édition 
avec le Crayon.

Crayon

Réparation d'un « pop » avec le Crayon
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Le Crayon peut être utilisé pour éditer 
indépendamment différents canaux d'une piste 
multicanal. 

Essayez de limiter l'opération d'édition à une toute 
petite zone, et veillez à ce que vos corrections 
soient homogènes avec le reste de la forme d'onde. 

Verrouillage du mode 
d'édition et des outils
Activez Options > Edit/Tool Mode Keyboard Lock 
pour verrouiller les outils d'édition actuellement 
sélectionnés (outil de zoom, de trim, Main et 
Crayon uniquement) et ainsi éviter d'en changer 
par inadvertance suite à l'utilisation d'un raccourci 
clavier. Toutefois, même lorsque l'option Edit/Tool 

Mode Keyboard Lock est activée, il reste possible 
de changer de type d'outil d'édition avec la souris 
ou un menu contextuel. Vous pouvez également 
passer d'un outil à un autre (de la Main à l'outil de 
trim par exemple) en utilisant des raccourcis 
clavier.

Pour verrouiller (ou déverrouiller) les modes 
actuels des outils d'édition :

1 Sélectionnez les modes d'édition que vous 
souhaitez (outil de trim standard, outil de saisie 
du temps et la forme Main levée du Crayon par 
exemple). 

2 Sélectionnez (ou désélectionnez) Options > 

Edit/Tool Mode Keyboard Lock.
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Chapitre 26 : Création de sélections

Pro Tools fournit plusieurs outils de sélection du 
contenu de la fenêtre Edit.

Liaison ou dissociation des 
sélections d'édition et de 
timeline
Les sélections d'édition et de timeline dans 
Pro Tools peuvent être liées ou dissociées. 

Lorsque les sélections d'édition et de timeline sont 
liées, la sélection sur une playlist de piste (sélection 
d'édition) définit également la plage de lecture et 
d'enregistrement (sélection de timeline).

Lorsque vous dissociez les sélections d'édition et 
de timeline, vous pouvez sélectionner une plage de 
piste à éditer, indépendamment de la sélection de 
timeline (qui correspond à la plage de lecture et 
d'enregistrement).

Pour lier ou dissocier les sélections d'édition et de 
timeline, effectuez l'une des opérations 
suivantes :

 Sélectionnez ou désélectionnez Options > Link 

Timeline and Edit Selection.

 Dans la fenêtre Edit, une fenêtre d'éditeur MIDI 
ou la fenêtre de l'éditeur de partition, cliquez sur 
le bouton Link Timeline and Edit Selection pour 
le mettre en surbrillance (activé) ou non 
(désactivé). L'activation ou la désactivation du 
bouton Link Timeline and Edit Selection dans 
une fenêtre d'éditeur affecte toutes les fenêtres 
d'éditeur.

Si vous travaillez sur une scène de film ou de 
vidéo, il peut être utile de séparer les sélections 
d'édition et de timeline pour rechercher ou lire des 
données se trouvant hors de la sélection de 
timeline actuelle. Les sélections d'édition peuvent 
être lues (sélectionnez Edit > Selection > Play Edit) 
sans perdre la sélection de timeline actuelle. 
Lorsque vous avez repéré les données, vous 
pouvez revenir à la sélection de timeline et les 
placer dans le contexte de la scène.

L'image suivante illustre une autre application 
possible de la séparation des sélections d'édition et 
de timeline. Dans cet exemple, la sélection de 
timeline définit une plage à lire en boucle, tandis 
qu'un clip MIDI (se trouvant dans la boucle) est 
sélectionné pour son édition. 

En cours de lecture, la sélection d'édition peut être 
déplacée par incrément, quantifiée ou transposée ; 
la lecture en boucle continue de façon 
complètement indépendante et sans interruption.

Bouton Link Timeline and Edit Selection activé dans la 
fenêtre Edit

Appuyez sur Maj+barre oblique (/) pour 
activer ou désactiver l'option Link Timeline 
and Edit Selection.
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Bien que ces opérations soient théoriquement 
possibles lorsque les sélections d'édition et de 
timeline sont liées, un arrêt de la lecture entraîne 
une mise à jour immédiate de la plage de lecture 
afin qu'elle corresponde à la dernière plage 
d'édition, ou à la durée de la dernière note MIDI 
éditée.

Marqueurs de sélections 
d'édition et de timeline
Les sélections de timeline sont représentées sur la 
règle de base de temps principale avec des 
marqueurs de sélection de timeline, sous la forme 
de flèches bleues (rouges en enregistrement). 
De plus, des drapeaux de pré et post-roll (verts 
lorsqu'ils sont activés) indiquent les emplacements 
de pré et post-roll.

Lorsque les sélections de timeline et d'édition sont 
dissociées, les sélections d'édition sont 
représentées sur la règle avec des marqueurs 
d'édition, sous la forme de crochets noirs.

Lorsque les sélections d'édition et de timeline sont 
liées, les sélections d'édition sont représentées par 
des marqueurs de sélection de timeline bleus.

Pour plus d'informations sur l'utilisation des 
sélections d'édition et de timeline, reportez-vous 
aux sections suivantes :

• « Sélection du contenu des pistes » à la page 577

• « Sélections de timeline » à la page 588

• « Configuration des points de punch et de 
boucle » à la page 463

• « Configuration des durées de pré-roll et post-
roll » à la page 466

Liaison ou dissociation des 
sélections d'édition et de 
piste
La liaison des sélections d'édition et de piste peut 
être activée ou désactivée dans Pro Tools.

Lorsque les sélections d'édition et de piste sont 
liées, vous pouvez créer une sélection sur une ou 
plusieurs pistes pour les éditer, chaque piste 
associée étant sélectionnée (les nomes de piste sont 
automatiquement mis en surbrillance). 
Vous pouvez ainsi rapidement exécuter des 
commandes agissant au niveau des pistes 
(changement de vue de piste ou de hauteur de piste 
par exemple) afin qu'elles s'appliquent à toutes les 
pistes sur lesquelles vous travaillez. 

Lorsque les sélections d'édition et de piste sont 
dissociées, la création d'une sélection d'édition ne 
sélectionne pas automatiquement les pistes 
associées. 

Pour lier ou dissocier les sélections de piste et 
d'édition, effectuez l'une des opérations suivantes :

 Sélectionnez ou désélectionnez Options > Link 

Track and Edit Selection.

 Dans le coin supérieur gauche de la fenêtre Edit, 
sous les outils d'édition, cliquez sur le bouton 
Link Track and Edit Selection pour le mettre en 
surbrillance (activé) ou non (désactivé).

Sélections de timeline et d'édition dissociées

Marqueurs de sélection de timeline et drapeaux de pré 
et post-roll

Marqueurs d'édition
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Sélection du contenu des 
pistes
Avant de pouvoir éditer le contenu audio et MIDI, 
vous devez au préalable le sélectionner. La vue de 
piste détermine la manière dont son contenu est 
affiché et sélectionné. 

Lorsque vous créez une sélection, elle apparaît sous 
la forme d'une zone en surbrillance sur la piste et est 
également indiquée par des flèches bleues de début 
et de fin (marqueurs de sélection de timeline) sur la 
règle de base de temps principale. Si une piste 
(audio ou MIDI) de la session est activée pour 
l'enregistrement, ces marqueurs apparaissent en 
rouge, même si la piste est masquée. 

Lorsque les sélections d'édition et de timeline sont 
indépendantes, la plage de sélection d'édition est 
indiquée par des marqueurs d'édition sur la règle 
de base de temps principale. Reportez-vous à la 
section « Liaison ou dissociation des sélections 
d'édition et de timeline » à la page 575 pour plus de 
détails.

Sélections et groupes d'édition

Lorsque vous créez une sélection sur des pistes 
membres d'un groupe d'édition, toutes les pistes du 
groupe sont sélectionnées.

Sélections et pistes masquées

Lorsque vous éditez des pistes membres d'un 
groupe d'édition actif, les pistes masquées du 
groupe ne sont pas affectées. Pour éditer tous les 
membres d'un groupe, assurez-vous qu'ils soient 
visibles à partir de la liste des pistes. 

Sélections sur plusieurs pistes

Pour créer une sélection sur plusieurs pistes :

 À l'aide du Sélecteur, cliquez et faites glisser 
votre souris verticalement pour inclure des 
pistes adjacentes dans la sélection (faites-la 
glisser horizontalement pour définir la plage 
temporelle). 

Liaison des sélections de piste et d'édition activée

Marqueurs de sélection de timeline indiquant une 
sélection d'édition
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Sélection de clips

Pour sélectionner une partie d'un clip :

 Avec le Sélecteur, cliquez et faites glisser votre 
souris (vers la gauche ou la droite) pour 
sélectionner du contenu sur une seule piste. Il 
est également possible d'utiliser le Sélecteur sur 
plusieurs pistes adjacentes pour créer une 
sélection de plusieurs pistes.

Pour sélectionner un clip entier, procédez comme 
suit :

 Cliquez sur le clip à l'aide de l'outil de saisie du 
temps.

 Double-cliquez sur le clip avec le Sélecteur.

Pour sélectionner deux clips et la plage de temps 
qui les sépare :

1 Cliquez sur le premier clip avec l'outil de saisie 
du temps.

2 Maintenez la touche Maj enfoncée et cliquez 
sur le second clip. Les deux clips sont 
sélectionnés, ainsi que la plage de temps qui les 
sépare (et d'éventuels autres clips, le cas 
échéant).

Pour sélectionner une piste entière, effectuez l'une 
des opérations suivantes :

 Cliquez sur la piste avec le Sélecteur, puis 
sélectionnez Edit > Select All.

 Cliquez trois fois sur une piste avec le Sélecteur.

Pour sélectionner l'ensemble des clips présents 
sur toutes les pistes :

1 Sélectionnez le groupe d'édition All dans le 
menu de la liste des groupes.

2 Effectuez l'une des opérations suivantes :

• Cliquez sur une piste avec le Sélecteur, puis 
sélectionnez Edit > Select All.

• Cliquez trois fois sur n'importe quelle piste avec 
le Sélecteur.

Clip List Selection Follows Edit 
Selection
Lorsque la préférence d'édition Clip List Selection 

Follows Edit Selection est activée, la sélection d'un 
clip sur une piste entraîne également sa sélection 
dans la liste des clips.

Inversement, lorsque la préférence d'édition Edit 

Selection Follows Clip List Selection est activée, la 
sélection d'un clip dans la liste des clips entraîne 
également sa sélection sur la piste.

Sélection de tous les éléments 
à partir des règles de base de 
temps

Pour sélectionner tout le contenu de toutes les 
pistes audio et MIDI affichées :

1 Activez l'option Link Timeline and Edit Selection 
(Options > Link Timeline and Edit Selection).

2 Double-cliquez sur n'importe quelle règle de 
base de temps. Tous les clips présents sur 
l'ensemble des pistes audio et MIDI affichées 
sont sélectionnés. Les pistes masquées ne sont 
pas sélectionnées.

Sélection d'une partie d'un clip

Appuyez sur Ctrl+A (Windows) ou 
Commande+A (Mac) pour tout sélectionner.

Pour sélectionner tous les clips de toutes les 
pistes sans sélectionner le groupe d'édition 
All, appuyez sur Entrée (Windows) ou Retour 
(Mac), puis sur Ctrl+A (Windows) ou 
Commande+A (Mac). L'option Link Timeline 
and Edit Selection doit être activée.
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Pour sélectionner tout le contenu de toutes les 
pistes, y compris les événements du chef 
d'orchestre :

1 Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 

Selection).

2 Double-cliquez sur n'importe quelle règle de 
base de temps en maintenant la touche Ctrl 
(Windows) ou Option (Mac) enfoncée. Tous les 
clips de toutes les pistes audio et MIDI affichées 
sont sélectionnés, y compris les événements sur 
chacune des pistes du chef d'orchestre.

Sélection en cours de lecture
Pro Tools permet d'effectuer des sélections en 
cours de lecture à l'aide des touches Flèche haut et 
bas.

Pour créer une sélection en cours de lecture :

1 Activez l'option Link Timeline and Edit Selection 
(Options > Link Timeline and Edit Selection).

2 À l'aide du Sélecteur, cliquez au début de 
la piste sur laquelle vous souhaitez créer la 
sélection.

3 Pour lancer la lecture, cliquez sur le bouton Play 
de la fenêtre de transport ou appuyez sur la barre 
d'espace.

4 Lorsque la lecture atteint le point où vous 
souhaitez que la sélection commence, appuyez 
sur la touche Flèche bas.

5 Appuyez sur la touche Flèche haut au point où 
vous souhaitez que la sélection se termine. La 
plage sélectionnée est affichée en surbrillance.

6 Pour arrêter la lecture, cliquez sur le bouton 
Stop de la fenêtre de transport ou appuyez sur la 
barre d'espace.

Afin que l'affichage revienne automatiquement au 
début de la sélection (ou à l'emplacement du 
curseur), appuyez sur la touche Flèche gauche. 
Appuyez sur la touche Flèche droite pour atteindre 
la fin de la sélection.

En mode de défilement par page ou continu, lorsque 
vous créez une sélection dans la timeline ou sur une 
playlist en cours de lecture et que la tête de lecture 
sort de l'écran, le défilement des pages est 
suspendu. Pour reprendre le défilement des pages et 
accéder à l'emplacement actuel de la tête de lecture, 
cliquez sur le localisateur du curseur de lecture sur 
la règle de base de temps principale (reportez-vous 
à la section « Localisation du curseur de lecture 
lorsqu'il se trouve en dehors de l'écran » à la page 
416).

Sélections d'objets 
Utilisez l'outil de saisie d'objet pour sélectionner 
des clips non contigus sur une ou plusieurs pistes. 
Les sélections non contiguës doivent inclure des 
clips entiers. Si vous souhaitez une partie d'un clip 
dans une sélection non contiguë, convertissez au 
préalable la partie en nouveau clip avec la 
commande Separate Clip (reportez-vous à la 
section « Commandes de séparation » à la page 
600).

Pour sélectionner des clips non contigus :

1 Activez le mode d'édition Slip ou Grid.

2 Cliquez sur le menu des outils de saisie et 
sélectionnez Object.

L'outil de saisie d'objet n'est pas disponible 
en mode d'édition Shuffle ou Spot.

Outil de saisie d'objet
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3 Maintenez la touche Maj enfoncée et cliquez 
sur chaque clip à inclure dans la sélection. Les 
clips peuvent même se trouver sur des pistes 
différentes.

Chaque clip sur lequel vous cliquez est entouré 
d'une bordure foncée, qui indique sa sélection.

L'outil de saisie d'objet ignore les groupes d'édition 
lors de la création de sélections. La sélection d'un 
clip sur une piste groupée par exemple ne 
sélectionne pas de clips sur les autres pistes du 
groupe.

Conversion entre sélection 
temporelle et sélection d'objet 
Il est possible de convertir une sélection 
temporelle en sélection d'objet, et vice versa. Les 
sélections temporelles sont créées avec le 
Sélecteur et les outils de saisie du temps. 
Les sélections d'objet sont créées avec l'outil de 
saisie d'objet.

Une conversion en sélection d'objet est utile 
lorsque vous travaillez avec des sélections 
importantes, sur plusieurs pistes en particulier, et 
que vous souhaitez supprimer certains clips de la 
sélection.

Une conversion en sélection temporelle est utile 
lorsque vous souhaitez sélectionner tous les clips 
compris entre deux objets sélectionnés non 
contigus.

Pour convertir une sélection temporelle en 
sélection d'objet :

1 Cliquez et faites glisser le Sélecteur sur 
n'importe quelle piste pour créer une sélection, 
ou sur une règle de base de temps pour 
sélectionner toutes les pistes.

2 Une fois l'outil de saisie d'objet sélectionné, 
double-cliquez sur l'icône de la Main dans la 
barre d'outils. Les clips compris dans la plage de 
la sélection sont alors sélectionnés en tant 
qu'objets. Les clips qui étaient partiellement 
sélectionnés le sont maintenant entièrement.

Pour sélectionner des clips partiellement 
sélectionnés, maintenez la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée et double-
cliquez sur l'icône de la Main.

Sélection non contiguë

Clips sélectionnés

Clips sélectionnés en tant qu'objets
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Pour convertir une sélection d'objet en sélection 
temporelle :

1 Sélectionnez les clips de votre choix avec l'outil 
de saisie d'objet.

2 Double-cliquez sur le Sélecteur sur la barre 
d'outils. La plage temporelle qui sépare le 
premier et le dernier clip est sélectionnée.

Si vous utilisez l'outil de saisie d'objet pour des 
pistes appartenant à un groupe d'édition, les clips 
des autres pistes du groupe sont sélectionnés s'ils se 
trouvent dans la plage du clip sélectionné.

Modification de la durée d'une 
sélection
La plage d'une sélection peut être raccourcie ou 
rallongée. Cette opération n'affecte pas le contenu 
de la sélection.

Pour changer la durée d'une sélection, effectuez 
l'une des opérations suivantes :

 À l'aide du Sélecteur, placez le curseur à l'une 
des extrémités de la sélection actuelle, 
maintenez la touche Maj enfoncée et cliquez ou 
faites glisser votre souris vers la gauche ou la 
droite.

 Sur la règle de base de temps principale, faites 
glisser le marqueur de sélection de timeline de 
début ou de fin.

 Si l'option Link Timeline and Edit Selection est 
désactivée, faites glisser le marqueur d'édition 
pour modifier la durée de la sélection.

Pour créer une sélection de longue durée :

1 À l'aide du Sélecteur, cliquez à l'endroit où vous 
souhaitez que la sélection commence.

2 Déplacez le curseur jusqu'au point de fin et 
cliquez à l'endroit où vous souhaitez que la 
sélection finisse. 

Pour vérifier la position des points de début et de 
fin d'une sélection longue, appuyez sur la touche 
Flèche gauche pour retourner au début de la 
sélection, ou Flèche droite pour aller à la fin de la 
sélection.

Déplacement par incrément 
d'une plage de sélection
La plage de la sélection (et non le contenu au sein 
de la sélection) peut être déplacée par incréments.

Pour déplacer une plage de sélection par 
incrément :

1 Configurez la valeur de déplacement par 
incrément. Pour plus de détails, reportez-vous à 
la section « Définition de la valeur 
d'incrément » à la page 607.

2 Créez la sélection initiale avec le Sélecteur.

3 Maintenez la touche Maj enfoncée et appuyez 
sur la touche Plus (+) ou Moins (–) du clavier 
numérique pour déplacer la plage de sélection de 
la valeur de déplacement par incrément.

Déplacement d'un marqueur de sélection de timeline

marqueurs d'édition
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Déplacement par incrément des 
points de début/fin de sélection
Les points de début et fin des sélections peuvent 
être déplacés par incréments.

Pour déplacer le point de début ou de fin de la 
valeur de déplacement par incrément :

1 Configurez la valeur de déplacement par 
incrément. Pour plus de détails, reportez-vous à 
la section « Définition de la valeur 
d'incrément » à la page 607.

2 Créez la sélection initiale avec le Sélecteur.

3 Effectuez l'une des opérations suivantes :

• Maintenez les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées et appuyez sur 
la touche Plus (+) ou Moins (–) du pavé 
numérique pour déplacer le point de début de la 
sélection de la valeur de l'incrément.

• Maintenez les touches Ctrl+Maj (Windows) ou 
Commande+Maj (Mac) enfoncées et appuyez 
sur la touche Plus (+) ou Moins (–) du pavé 
numérique pour déplacer le point de fin de la 
sélection de la valeur de l'incrément.

Extension des sélections
Vous pouvez étendre des sélections jusqu'aux 
points de début et de fin des clips, afin d'inclure un 
clip adjacent, ou jusqu'à des marqueurs et 
emplacements mémoire.

Pour étendre une sélection jusqu'à un point de 
début ou de fin d'un clip :

1 À l'aide du Sélecteur, sélectionnez une partie 
d'un clip ou cliquez à n'importe quel 
emplacement d'un clip.

2 Effectuez l'une des opérations suivantes :

• Appuyez sur Maj+Tab pour étendre la sélection 
jusqu'au point de fin du clip.

• Appuyez sur Ctrl+Maj+Tab (Windows) ou 
Option+Maj+Tab (Mac) pour étendre la 
sélection jusqu'au point de début du clip.

Pour étendre une sélection afin d'inclure un clip 
adjacent :

1 Sélectionnez le premier clip à l'aide de l'outil de 
saisie du temps.

2 Effectuez l'une des opérations suivantes :

• L'option Tab to Transients étant désactivée, 
appuyez sur Démarrer+Maj+Tab (Windows) 
ou Ctrl+Maj+Tab (Mac) pour étendre la 
sélection à la limite de clip suivante.

• Appuyez sur Ctrl+Démarrer+Maj+Tab 
(Windows) ou Option+Ctrl+Maj+Tab (Mac) 
pour étendre la sélection et inclure la limite de 
clip précédente.

Pour étendre une sélection jusqu'à un marqueur 
ou un emplacement mémoire :

1 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur, cliquez sur une piste pour 
définir le point de début ou de fin.

• Créez une sélection avec le Sélecteur ou l'outil 
de saisie du temps.

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et cliquez sur 
un marqueur de la règle des marqueurs.

• Maintenez la touche Maj enfoncée et cliquez sur 
un emplacement mémoire dans la fenêtre 
Memory Locations.

La sélection est étendue depuis le point d'insertion 
d'origine jusqu'au marqueur ou à l'emplacement 
mémoire.
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Utilisation des indicateurs de 
sélection d'édition (Start, End et 
Length)
Les indicateurs de sélection d'édition situés en haut 
de la fenêtre Edit peuvent définir des sélections 
d'édition précises. Les valeurs temporelles des 
indicateurs de sélection d'édition sont au format de 
l'échelle temporelle principale.

Pour créer une sélection avec les indicateurs de 
sélection d'édition :

1 Avec le Sélecteur, cliquez sur la piste 
à sélectionner.

2 Cliquez dans le champ Start en haut de la 
fenêtre Edit.

3 Saisissez le point de début de la sélection et 
appuyez sur la barre oblique (/) pour entrer la 
valeur et passer automatiquement au champ 
de fin.

4 Saisissez le point de fin de la sélection et 
appuyez sur Entrée pour accepter la valeur.

Raccourcis de saisie numérique pour les 
indicateurs de sélection

Vous pouvez utiliser les raccourcis suivants pour 
saisir des valeurs dans les indicateurs de sélection 
d'édition :

• Appuyez sur la touche / (barre oblique) pour 
naviguer dans les trois indicateurs de sélection 
d'édition.

• Utilisez la touche Point (.) ou les touches Flèche 
droite et gauche pour vous déplacer dans les 
champs temporels de chaque indicateur de 
sélection d'édition.

• Utilisez les touches Flèche haut et bas pour 
augmenter ou réduire les valeurs numériques.

• Faites tourner la molette de la souris vers le haut 
ou le bas pour augmenter ou réduire les valeurs 
numériques.

• Cliquez et faites glisser votre souris sur un 
champ pour définir une nouvelle valeur. Pour 
affiner la résolution, appuyez sur la touche Ctrl 
(Windows) ou Commande (Mac) et faites glisser 
le curseur.

• Appuyez sur Ctrl (Windows) ou Commande 
(Mac) et sur la touche Plus (+) ou Moins (-), puis 
saisissez une valeur à ajouter ou à soustraire de 
la valeur actuelle du champ. Par exemple, pour 
ajouter 10 à la valeur actuelle d'un champ, 
appuyez sur Ctrl (Windows) ou Commande 
(Mac), puis sur la touche Plus (+), saisissez 10 et 
appuyez sur Entrée.

• Appuyez sur Échap pour quitter les indicateurs 
de sélection d'édition sans entrer de nouvelle 
valeur.

Mode calculatrice

Vous pouvez modifier les valeurs des indicateurs 
de sélection d'édition en mode calculatrice.

Pour soustraire des valeurs temporelles :

1 Dans l'indicateur de sélection d'édition, 
sélectionnez le champ que vous voulez 
modifier.

2 Appuyez sur la touche Moins (–) du pavé 
numérique.

3 Entrez la valeur à soustraire de la valeur 
temporelle actuelle et appuyez sur Entrée.

4 Appuyez de nouveau sur Entrée pour appliquer 
la modification.

Indicateurs de sélection d'édition 

Ces raccourcis servent également à entrer les 
valeurs de début et de fin dans la fenêtre de 
transport.
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Pour ajouter des valeurs temporelles :

1 Dans l'indicateur de sélection d'édition, 
sélectionnez le champ que vous voulez 
modifier.

2 Appuyez sur la touche Plus (+) du pavé 
numérique.

3 Entrez la valeur à additionner à la valeur 
temporelle actuelle et appuyez sur Entrée.

4 Appuyez de nouveau sur Entrée pour appliquer 
la modification.

Sélection sur plusieurs pistes
Pour réaliser des opérations d'édition sur plusieurs 
pistes ou toutes, vous devez au préalable les 
sélectionner. Pour cela, il suffit d'inclure d'autres 
pistes à la sélection ou d'effectuer une sélection sur 
une règle de base de temps (pour sélectionner 
toutes les pistes).

Pour créer une sélection sur plusieurs pistes :

 À l'aide du Sélecteur, cliquez et faites glisser 
votre souris verticalement pour inclure des 
pistes adjacentes dans la sélection (faites-la 
glisser horizontalement pour définir la plage 
temporelle). 

Pour étendre une sélection à une autre piste :

1 À l'aide du Sélecteur ou de l'outil de saisie du 
temps, effectuez une sélection sur la ou les 
premières pistes.

2 Maintenez la touche Maj enfoncée et cliquez 
sur d'autres pistes avec le Sélecteur. Une plage 
identique est sélectionnée sur chaque piste 
supplémentaire.

Pour raccourcir ou allonger la sélection sur 
chacune des pistes, maintenez la touche Maj 
enfoncée et faites glisser votre souris dans la 
direction souhaitée.

Pour créer une sélection sur toutes les pistes, 
effectuez l'une des opérations suivantes :

 Activez le groupe d'édition All et créez une 
sélection sur n'importe quelle piste.

 Faites glisser avec le Sélecteur sur l'une des 
règles de base de temps (assurez-vous que les 
sélections de timeline et d'édition sont liées).

Ces sélections incluent toutes les pistes de la 
fenêtre Edit, mais pas les pistes du chef d'orchestre 
(tempo, métrique et marqueurs).

Pour créer une sélection sur toutes les pistes, 
y compris celles du chef d'orchestre (pour le 
tempo, la métrique et les marqueurs) :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée, cliquez avec le Sélecteur et 
faites glisser votre souris sur l'une des règles de 
base de temps.

Déplacement et extension de 
sélections entre les pistes
Lorsque le focus clavier sur les commandes est 
actif, les sélections d'édition peuvent être 
déplacées ou étendues vers les pistes adjacentes.

Pour déplacer une sélection vers une piste 
adjacente :

1 Activez le focus clavier sur les commandes 
(reportez-vous à la section « Focus clavier » à la 
page 26).

2 Créez une sélection à l'aide du Sélecteur ou de 
l'outil de saisie du temps.

Bouton de focus clavier sur les commandes activé 
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3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche P du clavier de votre 
ordinateur pour déplacer la sélection vers la 
piste précédente.

• Appuyez sur la touche Point-virgule (;) pour 
déplacer la sélection vers la piste suivante.

Dans les deux cas, la sélection d'édition d'origine 
est désélectionnée.

Pour étendre une sélection à une piste adjacente :

1 Activez le focus clavier sur les commandes 
(reportez-vous à la section « Focus clavier » à la 
page 26).

2 Créez une sélection à l'aide du Sélecteur ou de 
l'outil de saisie du temps.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur Maj+P pour étendre la sélection 
à la piste précédente.

• Appuyez sur Maj+Point-virgule (;) pour étendre 
la sélection à la piste suivante.

Dans les deux cas, la sélection d'édition d'origine 
reste sélectionnée.

Pour enlever la dernière piste d'une sélection :

 Appuyez sur Alt+Démarrer+Point-virgule (;) 
(Windows) ou Option+Ctrl+Point-virgule (;) 
(Mac) pour supprimer la piste du bas.

Autres techniques de sélection
La section suivante présente d'autres techniques de 
sélection.

Pour positionner le curseur d'édition précisément 
au début, à la fin ou sur le point de 
synchronisation d'un clip :

1 Assurez-vous que le bouton Tab to Transients 
n'est pas activé. Reportez-vous à la section 
« Tabulation vers les transitoires » à la page 587.

2 Cliquez sur la piste avec le Sélecteur.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Tab pour déplacer le 
curseur jusqu'au point de début, de fin ou de 
synchronisation du clip ou groupe de clips 
suivant.

• Appuyez sur Ctrl+Tab (Windows) ou 
Option+Tab (Mac) pour déplacer le curseur sur le 
point de début, de fin ou de synchronisation du 
clip ou du groupe de clips précédent.

Pour déplacer la sélection vers la piste 
précédente, appuyez sur Démarrer+P 
(Windows) ou Ctrl+P (Mac) avec le focus 
clavier sur les commandes activé ; pour 
déplacer la sélection vers la piste suivante, 
appuyez sur Démarrer+Point-virgule (;) 
(Windows) ou Ctrl+Point-virgule (;) (Mac).

Pour étendre la sélection vers la piste 
précédente, appuyez sur Démarrer+Maj+P 
(Windows) ou Ctrl+Maj+P (Mac) avec le focus 
clavier sur les commandes désactivé ; pour 
étendre la sélection vers la piste suivante, 
appuyez sur Démarrer+Maj+Point-virgule (;) 
(Windows) ou sur Ctrl+Maj+Point-virgule (;) 
(Mac).
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Pour créer une sélection avec l'outil de 
scrubbing :

1 Sélectionnez Setup > Preferences, puis cliquez 
sur l'onglet Operation.

2 Sélectionnez l'option Edit Insertion Follows 
Scrub/Shuttle, et cliquez sur OK.

3 Effectuez un scrubbing avec l'outil de scrubbing 
pour localiser un point de début approprié pour 
la sélection, puis relâchez-le.

4 Tout en maintenant la touche Maj enfoncée, 
effectuez un scrubbing pour localiser un point 
de fin approprié pour la sélection, puis relâchez 
votre souris. La plage comprise entre les points 
de scrubbing de début et de fin est sélectionnée.

Pour déplacer une sélection sur un clip adjacent 
de la même piste :

1 Sélectionnez un clip avec l'outil de saisie 
du temps.

2 Effectuez l'une des opérations suivantes :

• Pour déplacer la sélection sur le clip suivant, 
appuyez sur Démarrer+Tab (Windows) ou 
Ctrl+Tab (Mac). 

• Pour déplacer la sélection sur le clip précédent, 
appuyez sur Ctrl+Démarrer+Tab (Windows) ou 
Option+Ctrl+Tab (Mac).

Dans les deux cas, le clip d'origine est 
désélectionné.

Pour faire glisser une sélection d'édition sur la 
règle de base de temps principale :

1 Créez une sélection à l'aide du Sélecteur ou de 
l'outil de saisie du temps.

2 Tout en maintenant la touche Alt (Windows) 
ou Option (Mac) enfoncée, déplacez le curseur 
sur l'un des marqueurs de sélection de timeline 
de la règle (l'outil de saisie du temps apparaît).

3 Faites glisser le curseur vers la gauche ou la 
droite pour avancer ou reculer temporellement 
la sélection d'édition tout en conservant 
sa durée.

Si l'option Link Timeline and Edit Selection est 
désactivée (Options > Link Timeline and Edit 
Selection), maintenez la touche Alt (Windows) 
ou Option (Mac) enfoncée et faites glisser les 
marqueurs d'édition pour obtenir le même résultat.

Commandes contextuelles et 
conservation des sélections
Les commandes contextuelles, associées aux 
combinaisons de touches, permettent d'effectuer 
certaines opérations sur des objets tout en 
conservant les sélections dans les fenêtres Edit et 
Mix. Vous pouvez par exemple conserver les 
sélections affichées dans les zones suivantes tout 
en effectuant certaines opérations :

• sélections de clips dans la timeline ;

• sélections de noms de clip dans la liste des clips ;

• sélections de pistes.

Pour appliquer une commande à un objet tout en 
conservant la sélection actuelle :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et effectuez un clic 
droit sur l'objet, puis choisissez une commande 
du menu contextuel.

Glissement d'une sélection d'édition sur la règle de 
base de temps principale
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Tabulation vers les transitoires
Lorsque le bouton Tab to Transients est activé, 
vous pouvez naviguer automatiquement entre les 
transitoires des formes d'onde audio en vue 
Waveform, afin de placer le curseur 
immédiatement avant la crête détectée de chaque 
transitoire. Vous pouvez ainsi créer des sélections 
et plages de lecture, ainsi que des points de début et 
de fin pour de nouveaux clips, sans effectuer de 
zoom avant sur la forme d'onde. 

En vue Warp, la fonction de tabulation vers les 
transitoires permet de déplacer le curseur sur tous les 
marqueurs d'événement et de déformation d'un clip. 
Le mode de tabulation normal déplace le curseur sur 
les limites des clips et tous les marqueurs de 
déformation. Si vous appuyez sur la touche Tab en 
vue Analysis, le curseur se déplace sur tous les 
marqueurs d'événement, que la fonction de tabulation 
vers les transitoires soit activée ou non.

Si vous utilisez la touche Tab sur une piste MIDI 
ou d'instrument en vue Notes, le curseur se déplace 
sur la note suivante, que la fonction de tabulation 
vers les transitoires soit activée ou non. En vue 
Clips, la fonction de tabulation vers les transitoires 
déplace le curseur sur les notes et le mode de 
tabulation normal déplace le curseur sur les limites 
des clips. 

Lorsque vous utilisez la touche Tab sur des accords 
de notes MIDI, chaque note d'un accord est 
considérée comme un événement unique. Vous 
pouvez donc sélectionner chaque note d'un accord 
l'une après l'autre.

Lorsque la fonction de tabulation vers les 
transitoires est activée, la fonction de tabulation 
prend également en compte les points de début et 
de fin des clips, mais pas leurs points de 
synchronisation.

Pour définir les points de début et de fin d'une 
sélection avec la fonction de tabulation vers les 
transitoires :

1 En haut à gauche de la fenêtre Edit, cliquez sur 
le bouton Tab to Transients pour le sélectionner.

2 Pour définir la plage de lecture avec cette 
sélection, sélectionnez Options > Link Timeline 

and Edit Selection.

3 Cliquez sur la piste audio juste avant le début 
des données que vous voulez sélectionner.

4 Appuyez plusieurs fois sur la touche de 
tabulation jusqu'à ce que le curseur se 
positionne sur le transitoire correspondant au 
début de la sélection.

Si nécessaire, vous pouvez revenir au transitoire 
précédent en appuyant sur Ctrl+Tab (Windows) ou 
Option+Tab (Mac).

5 Appuyez sur Maj+Tab jusqu'à ce que le curseur 
se positionne à la fin des données à sélectionner.

Pour déplacer le point de fin de la sélection sur le 
transitoire précédent, appuyez sur Ctrl+Maj+Tab 
(Windows) ou Option+Maj+Tab (Mac).

Une fois sélectionné, le contenu peut être mis 
en boucle pour l'enregistrement ou la lecture, 
ou peut être converti en nouveau clip avec la 
commande Separate ou Capture.

Bouton Tab to Transients activé 

Pour activer et désactiver la fonction de 
tabulation vers les transitoires, appuyez sur 
Ctrl+Alt+Tab (Windows) ou 
Commande+Option+Tab (Mac).
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Tabulation vers les transitoires sur 
plusieurs pistes

Si le curseur d'édition s'étend sur plusieurs pistes, 
vous pouvez utiliser la fonction de tabulation vers 
les transitoires pour déplacer le curseur vers le 
prochain transitoire de l'une de ces pistes. Lorsque 
les transitoires de ces multiples pistes sont alignés 
et sont proches les uns des autres, la fonction de 
tabulation vers les transitoires déplace le curseur 
sur le premier transitoire de l'une de ces pistes.

Sélections de timeline
Lorsque l'option Link Timeline and Edit Selection 
est désactivée, les sélections de timeline peuvent 
être créées indépendamment des sélections 
d'édition.

Lorsque les sélections d'édition et de timeline sont 
liées, toutes les sélections d'édition sont reflétées 
dans la timeline et toutes les sélections de timeline 
sont reflétées en tant que sélections d'édition sur 
toutes les pistes.

Que les sélections de timeline et d'édition soient 
liées ou non, ma plage indiquée par les marqueurs 
de sélection de timeline déterminent toujours la 
plage de lecture et d'enregistrement (sauf en mode 
de transport dynamique, reportez-vous à la section 
« Mode de transport dynamique » à la page 427).

Avec Pro Tools HD, lorsque l'option Scrolling est 
définie sur Center Playhead, elle détermine 
l'emplacement de début de lecture (reportez-vous à 
la section « Lecture des sélections d'édition et de 
timeline avec la tête de lecture » à la page 424).

Pour créer une sélection de timeline avec le 
Sélecteur :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Cliquez et faites glisser le Sélecteur sur une 
règle de base de temps.

La sélection de timeline est indiquée sur la règle de 
base de temps principale par les marqueurs de 
sélection de timeline bleus (ou rouges si une piste 
est activée pour l'enregistrement). Le début, la fin 
et la durée de la sélection de timeline apparaissent 
dans les champs correspondants de la fenêtre de 
transport.

Les transitoires sont généralement visibles 
dans la forme d'onde. Cependant, certains 
transitoires basses fréquences peuvent ne pas 
apparaître sous forme de crêtes visibles.

Création d'une sélection de timeline à l'aide du 
Sélecteur

Pour sélectionner toutes les pistes, y compris 
celles du chef d'orchestre, maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée tout 
en faisant glisser le Sélecteur sur une règle de 
base de temps.
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Pour définir la sélection de timeline en faisant 
glisser les marqueurs de sélection de timeline :

1 Si vous souhaitez restreindre le déplacement 
aux limites de la grille actuelle, activez le mode 
d'édition Grid. 

2 À l'aide de l'outil de saisie du temps, déplacez le 
premier marqueur de sélection de timeline 
(flèche orientée vers le bas) sur le point 
de début.

3 Déplacez le second marqueur de sélection de 
timeline (flèche orientée vers le haut) sur le 
point de fin.

Pour définir la sélection de timeline avec les 
champs de la fenêtre de transport :

1 Si nécessaire, activez la vue étendue de la 
fenêtre de transport afin que les heures de début 
et de fin soient affichées (View > Transport > 
Expanded).

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le champ Start de la fenêtre de 
transport.

• Appuyez sur Alt+barre oblique (/) (Windows) 
ou Option+barre oblique (/) (Mac) sur le pavé 
numérique pour sélectionner le champ Start de la 
fenêtre de transport.

3 Tapez le nouvel emplacement de début et 
appuyez sur la barre oblique (/) pour entrer 
la valeur et passer automatiquement au 
champ End.

4 Tapez le nouvel emplacement de fin et appuyez 
sur Entrée pour accepter la valeur.

Déplacement d'une sélection de 
timeline
De même que les sélections d'édition, les 
sélections de timeline peuvent être déplacées sur la 
règle de base de temps principale.

Pour déplacer une sélection de timeline sur la 
règle de base de temps principale :

1 Tout en appuyant sur Alt (Windows) ou Option 
(Mac), déplacez le curseur sur l'un des 
marqueurs de sélection de timeline (l'outil 
de saisie du temps apparaît).

2 Faites glisser votre souris vers la gauche ou la 
droite pour avancer ou reculer la sélection de 
timeline dans le temps, tout en conservant sa 
durée.

Copie des sélections de timeline 
vers ou à partir de sélections 
d'édition
Lorsque les sélections d'édition et de timeline ne 
sont pas liées, vous pouvez copier des sélections 
entre elles.

Pour faire correspondre la sélection de timeline à 
la sélection d'édition actuelle :

 Sélectionnez Edit > Selection > Change 

Timeline to Match Edit.

Déplacement d'un marqueur de sélection de timeline

Les raccourcis de saisie des valeurs de début 
et de fin dans la fenêtre de transport sont 
répertoriés dans la section « Raccourcis de 
saisie numérique pour les indicateurs de 
sélection » à la page 583.

Appuyez sur Alt+Maj+5 (Windows) ou 
Option+Maj+5 (Mac) pour modifier la 
sélection de la timeline afin qu'elle 
corresponde à la sélection d'édition.
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Pour faire correspondre la sélection d'édition à la 
sélection de timeline actuelle :

 Sélectionnez Edit > Selection > Change Edit to 

Match Timeline.

Navigation dans la timeline avec 
les compteurs et indicateurs de 
la fenêtre Edit
Les compteurs et indicateurs situés en haut de la 
fenêtre Edit affichent l'emplacement de lecture et la 
sélection d'édition actuels. Ils incluent 
les compteurs principaux et secondaires et 
les indicateurs de début (Start), fin (End) et durée 
(Length) de la sélection d'édition.

Il est possible d'entrer une valeur dans tous les 
compteurs et indicateurs (excepté le compteur 
secondaire) de la fenêtre Edit pour accéder 
à l'emplacement temporel associé.

Le compteur principal indique l'emplacement de 
lecture, exprimé dans le format de l'échelle 
temporelle principale. Le compteur secondaire 
peut être basé sur n'importe quel autre format 
d'échelle temporelle, afin de fournir une autre 
référence temporelle.

Les indicateurs de sélection d'édition (à droite des 
compteurs principal et secondaire) affichent les 
heures de début et de fin et la durée de la sélection 
d'édition actuelle, dans le format de la base de 
temps principale.

Les compteurs principal et secondaire, ainsi 
que les indicateurs de sélection d'édition, 
apparaissent également dans la fenêtre de 
transport, lorsqu'elle est configurée pour afficher 
les compteurs.

Pour naviguer à l'aide du compteur principal de la 
fenêtre Edit (ou à l'aide d'un indicateur de 
sélection d'édition) :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur l'un des compteurs.

• Appuyez sur la touche astérisque (*) du pavé 
numérique pour mettre en surbrillance le 
compteur principal de la fenêtre Edit (ou celui de 
la fenêtre de transport ou de la fenêtre du grand 
compteur, si l'une ou l'autre est à l'écran).

2 Entrez la nouvelle position. Appuyez sur 
le point (.) pour passer d'un champ temporel à 
l'autre.

3 Appuyez sur Entrée pour valider la nouvelle 
valeur et vous y rendre automatiquement.

Défilement sur une règle de 
base de temps
Vous pouvez faire défiler le contenu de la fenêtre 
Edit en cliquant sur une règle et en faisant glisser 
votre souris. Bien que cette opération n'affecte pas 
réellement la position actuelle dans la session, elle 
permet de faire défiler la fenêtre vers la gauche ou 
la droite pour localiser et éditer des éléments.

Cette méthode de défilement est particulièrement 
utile en mode de défilement continu, car elle ne 
modifie ni ne suit les sélections de timeline.

Appuyez sur Alt+Maj+6 (Windows) ou 
Option+Maj+6 (Mac) pour modifier la 
sélection d'édition afin qu'elle corresponde à 
la sélection de la timeline.

Compteurs principal et secondaire, indicateurs de 
sélection d'édition
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Pour faire défiler tout le contenu de la fenêtre Edit 
à partir d'une règle :

 Tout en maintenant les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option +Ctrl (Mac) enfoncées, 
cliquez et faites glisser votre souris vers la 
gauche ou la droite sur l'une des règles de base 
de temps.

Défilement avec une molette de 
souris
Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un défilement vertical ou 
horizontal dans n'importe quelle fenêtre de 
Pro Tools dotée d'une barre de défilement (telle 
que la liste des événements MIDI).

Pour faire défiler verticalement une fenêtre de 
Pro Tools :

1 Placez la souris sur la fenêtre que vous voulez 
faire défiler (vous pouvez par exemple faire 
défiler l'affichage des pistes ou la liste des clips 
dans la fenêtre Edit).

2 Faites tourner la molette vers le haut ou le bas 
pour faire défiler la fenêtre dans la direction 
correspondante.

Pour faire défiler horizontalement une fenêtre de 
Pro Tools :

1 Placez la souris sur la fenêtre que vous voulez 
faire défiler (vous pouvez par exemple faire 
défiler l'affichage des pistes ou la liste des clips 
dans la fenêtre Edit).

2 Maintenez la touche Maj enfoncée et faites 
tourner la molette vers le haut ou le bas pour 
faire défiler la fenêtre vers la gauche ou la 
droite.

Défilement automatique des 
pistes dans les fenêtres Mix 
et Edit
Si vous travaillez avec de nombreuses pistes et que 
les fenêtres Edit ou Mix ne peuvent pas toutes les 
afficher simultanément, vous pouvez sélectionner 
une piste dans une fenêtre et Pro Tools défilera 
automatiquement jusqu'à cette piste dans les deux 
fenêtres.

Pour faire défiler automatiquement les fenêtres 
Mix et Edit et afficher une piste, effectuez l'une des 
opérations suivantes :

 Dans la liste des pistes, effectuez un clic droit 
sur le nom d'une piste et sélectionnez Scroll Into 

View.

 Dans la liste des pistes, maintenez la touche Ctrl 
(Mac) enfoncée et cliquez sur le nom d'une 
piste, puis sélectionnez Scroll Into View.

La sélection de la piste entraîne le défilement des 
fenêtres Mix et Edit pour afficher la piste 
sélectionnée.

Navigation vers des pistes 
à l'aide de leurs numéros
Lorsque la vue Track Number est activée, chaque 
piste se voit attribuer un numéro correspondant à 
sa position dans les fenêtres Mix et Edit. Vous 
pouvez accéder directement à n'importe quelle 
piste grâce à son numéro.

Défilement sur une règle

Lorsque l'ordre des pistes est modifié, 
les numéros sont réattribués afin qu'ils 
se suivent.
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Pour accéder directement à la piste de votre choix 
à l'aide de son numéro :

1 Sélectionnez View > Track Number.

2 Sélectionnez Track > Scroll to Track.

3 Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de la piste à laquelle vous 
souhaitez accéder.

4 Cliquez sur OK.

La piste est sélectionnée et les fenêtres sont mises 
à jour de la manière suivante :

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus possible 
à gauche. 

Appuyez sur Ctrl+Alt+F (Windows) ou sur 
Commande+Option+F (Mac) pour accéder 
à la piste.

Boîte de dialogue Scroll To Track
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Vue Universe
La vue Universe affiche un aperçu de la session Pro Tools entière dans la fenêtre Edit, au-dessus des pistes. 

Cette vue d'ensemble représente les contenus 
audio et MIDI de toutes les pistes de la session non 
masquées (y compris les pistes désactivées ou qui 
contiennent des clips offline). L'ordre d'affichage 
des éléments dans la vue Universe correspond à 
l'ordre des pistes dans la fenêtre Edit.

Dans la vue Universe, les clips audio, MIDI et 
vidéo des pistes sont représentés par des lignes 
horizontales de la même couleur que les clips sur 
les pistes. Chaque piste audio est représentée à la 
même hauteur, quel que soit le nombre de canaux. 
De plus, la hauteur de la représentation des pistes 
augmente pour chaque ligne d'automation, de 
contrôleur ou de playlist affichée sur une piste.

Les pistes d'entrée auxiliaire, Master Fader et de 
Master VCA ne contenant pas de clips audio ou 
MIDI, elles sont affichées sous la forme de zones 
vides dans la vue Universe.

Vue Universe en haut de la fenêtre Edit
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Affichage de la fenêtre Universe

Pour afficher (ou masquer) la vue Universe dans 
la fenêtre Edit, effectuez l'une des opérations 
suivantes :

 Sélectionnez (ou désélectionnez) View > Other 

Displays > Universe.

 Double-cliquez sur la barre de séparation située 
au-dessus de la règle de base de temps 
principale. 

 Dans le menu de la fenêtre Edit, sélectionnez ou 
désélectionnez Universe.

 Cliquez sur le bouton Afficher/masquer de la 
vue Universe.

Zone encadrée de la vue 
Universe
La zone encadrée de la vue Universe représente le 
contenu actuellement visible dans la fenêtre Edit. Si 
vous le contenu affiché dans la fenêtre Edit (par un 
zoom, un défilement horizontal ou vertical, en 
masquant/affichant des pistes ou en changeant leur 
hauteur), la zone encadrée de la vue Universe est 
repositionnée et redimensionnée en conséquence. Si 
la fenêtre Edit défile en cours de lecture, la zone 
encadrée de la vue Universe défile également.

Si toutes les pistes sont visibles dans la fenêtre Edit 
et que la session est en zoom arrière complet avec 
tous les clips visibles, la totalité de la fenêtre 
Universe est encadrée.

Sélection de la vue Universe à partir du menu de la 
fenêtre Edit

Bouton Afficher/masquer de la vue Universe

La zone encadrée représente la partie de la session 
affichée dans le panneau des pistes de la fenêtre Edit.
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Navigation avec la vue Universe
En cliquant dans la vue Universe, vous pouvez faire 
défiler horizontalement et/ou verticalement le 
contenu de la fenêtre Edit. Cette méthode est 
efficace pour déplacer la fenêtre Edit sur un 
emplacement particulier de la session.

Pour naviguer dans la session à l'aide de la vue 
Universe :

1 Assurez-vous que la vue Universe est affichée 
(View > Other Displays > Universe).

2 Cliquez dans la vue Universe pour déplacer la 
zone encadrée. La fenêtre Edit est mise à jour en 
conséquence.

Redimensionnement de la vue 
Universe
Vous pouvez redimensionner la hauteur de la vue 
Universe pour l'ajuster au nombre total de pistes de 
la session, ou afficher plus de contenu de la fenêtre 
Edit.

Pour redimensionner la hauteur de la vue 
Universe :

1 Cliquez sur la zone située entre la partie 
inférieure de la fenêtre Universe et la partie 
supérieure des règles de base de temps. 
Le curseur change de forme pour signaler que la 
vue Universe peut être redimensionnée.

2 Faites glisser le curseur vers le haut pour réduire 
la hauteur de la vue Universe ou vers le bas pour 
l'augmenter.

Défilement dans la vue Universe
Si la session contient plus de pistes que celles 
visibles dans la vue Universe, vous pouvez faire 
défiler les pistes vers le haut ou le bas.

Pour faire défiler la vue Universe vers le haut ou 
le bas :

 Cliquez sur les flèches de défilement vers le 
haut ou le bas situées à droite de la vue 
Universe.

Redimensionnement de la vue Universe

Flèches de défilement de la vue Universe
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Navigation dans une session 
Pro Tools
En plus de la vue Universe, des raccourcis clavier 
permettent de naviguer facilement et rapidement 
dans une session Pro Tools. Cette section présente 
les principales commandes de navigation et de 
création de sélections d'édition dans une session.

Zoom sur la session entière et la 
sélection d'édition

Pour effectuer un zoom sur la session entière :

1 Appuyez sur Alt+Démarrer+A (Windows) ou 
Option+Ctrl+A (Mac) pour ajuster 
horizontalement le début et la fin de la session à 
la largeur de la fenêtre Edit.

2 Appuyez sur Alt+Démarrer+Flèche haut 
(Windows) ou Option+Ctrl+Flèche haut (Mac) 
pour ajuster toutes les pistes de la session à la 
hauteur de la fenêtre Edit.

Pour zoomer sur une sélection d'édition :

1 Créez une sélection d'édition à l'aide du 
Sélecteur ou de la Main.

2 Appuyez sur Alt+Démarrer (Windows) ou 
Option+Ctrl+F (Mac) pour ajuster la largeur de 
la sélection à la largeur de la fenêtre Edit.

3 Appuyez sur Ctrl+Démarrer+Flèche haut 
(Windows) ou Commande+Ctrl+Flèche haut 
(Mac) pour zoomer sur la sélection d'édition et 
ajuster sa hauteur à celle de la fenêtre Edit.

Pour zoomer sur une sélection d'édition à l'aide de 
la fonction de changement de zoom :

1 Créez une sélection d'édition à l'aide du 
Sélecteur ou de la Main.

2 Appuyez sur Démarrer+E (Windows) ou 
Ctrl+E (Mac) pour activer le changement de 
zoom.

3 Effectuez l'une des opérations suivantes :

• Appuyez de nouveau sur Démarrer+E 
(Windows) ou Ctrl+E (Mac) pour revenir au 
niveau de zoom précédent.

• Appuyez sur Alt+Maj+E (Windows) ou 
Option+Maj+E (Mac) pour annuler le 
changement de zoom sans revenir à la vue 
précédente.

Création de sélections d'édition 
avec la fonction de tabulation 
vers les transitoires
Si vous éditez de l'audio avec des transitoires 
marqués, vous pouvez utiliser la fonction Tab to 
Transients pour créer des sélections d'édition. 

Pour activer ou désactiver la fonction Tab to 
Transients :

 Appuyez sur Ctrl+Alt+Tab (Windows) ou 
Commande+Option+Tab (Mac).

Appuyez sur F7 pour activer le Sélecteur ou 
sur F8 pour activer la Main.

Appuyez sur F7 pour activer le Sélecteur ou 
sur F8 pour activer la Main.

Dans les préférences d'édition, sélectionnez 
le paramètre Fit To Window pour l'option 
Track Height du changement de zoom.
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Pour naviguer et étendre une sélection vers l'avant 
avec la fonction Tab to Transients :

1 Avec le Sélecteur activé, placez le curseur 
d'édition avant le premier transitoire à inclure 
dans votre sélection.

2 Appuyez sur la touche Tab pour placer le 
curseur d'édition sur le premier transitoire.

3 Appuyez sur Maj+Tab pour étendre la sélection 
jusqu'au transitoire suivant.

Pour naviguer et étendre une sélection vers 
l'arrière avec la fonction Tab to Transients :

• Pour déplacer le curseur d'édition sur le 
transitoire précédent, appuyez sur Ctrl+Tab 
(Windows) ou Option+Tab (Mac).

• Pour étendre la sélection au transitoire 
précédent, appuyez sur Ctrl+Maj+Tab 
(Windows) ou Option+Maj+Tab (Mac).

Création d'une sélection 
d'édition en cours de lecture

Pour créer une sélection d'édition en cours de 
lecture :

1 Faites glisser le curseur d'édition sur la ou les 
pistes sur lesquelles vous souhaitez créer la 
sélection.

2 Lancez la lecture.

3 Appuyez sur la touche Flèche bas pour placer le 
curseur d'édition à l'emplacement de lecture 
actuel et marquer le début de la sélection 
d'édition.

4 Appuyez sur la touche Flèche haut pour 
marquer la fin de la sélection d'édition.

5 Arrêtez la lecture.

6 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Flèche gauche pour 
accéder au début de la sélection d'édition.

• Appuyez sur la touche Flèche droite pour 
accéder à la fin de la sélection d'édition.

Modification de la sélection 
d'édition
Pro Tools inclut plusieurs raccourcis clavier 
permettant de déplacer, étendre ou réduire la plage 
d'une sélection d'édition (ou de timeline).

Pour déplacer la sélection vers le bas sur la piste 
suivante :

 Appuyez sur Démarrer+Point-virgule (;) 
(Windows) ou Ctrl+Point-virgule (;) (Mac).

Pour déplacer la sélection vers le haut sur la piste 
précédente :

 Appuyez sur Démarrer+P (Windows) ou Ctrl+P 
(Mac).

Pour déplacer la sélection en aval, de la durée de la 
sélection :

 Appuyez sur Ctrl+Alt+Démarrer+' (apostrophe) 
(Windows) ou Commande+Ctrl+Option+ 
' (apostrophe) (Mac).

Pour déplacer la sélection en amont, de la durée 
de la sélection :

 Appuyez sur Ctrl+Alt+Démarrer+L (Windows) 
ou Commande+Ctrl+Option+L (Mac).

Pour étendre une sélection d'édition vers le bas 
et englober plusieurs pistes, appuyez sur 
Démarrer+Maj+Point-virgule (;) (Windows) 
ou Ctrl+Maj+Point-virgule (;) (Mac).

Pour étendre une sélection d'édition vers le 
haut et englober plusieurs pistes, appuyez 
sur Démarrer+Maj+P (Windows) ou 
Ctrl+Maj+P (Mac).
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Pour doubler la durée de la sélection d'édition :

 Appuyez sur Ctrl+Alt+Démarrer+Maj+ 
' (apostrophe) (Windows) ou 
Commande+Ctrl+Option+Maj+' (apostrophe) 
(Mac).

Pour réduire de moitié la durée de la sélection 
d'édition :

 Appuyez sur Ctrl+Alt+Démarrer+Maj+L 
(Windows) ou 
Commande+Ctrl+Option+Maj+L (Mac).

Déplacement du point d'insertion 
au début ou à la fin d'une 
sélection
Lorsque le transport est arrêté, vous pouvez utiliser 
la touche Flèche haut ou bas de votre clavier 
alphanumérique pour déplacer le curseur au début 
ou à la fin de la sélection d'édition (ou de timeline), 
et ainsi réduire la sélection.

Pour déplacer le point d'insertion au début de la 
sélection :

 Appuyez sur la touche Flèche bas.

Pour déplacer le point d'insertion à la fin de la 
sélection :

 Appuyez sur la touche Flèche haut.

Restauration de la dernière 
sélection
Lors d'une opération d'édition, il est possible de 
perdre une sélection. Si vous perdez la sélection 
d'édition (ou de timeline) actuelle et souhaitez la 
restaurer, utilisez la commande Restore Last 

Selection. 

Pour restaurer la dernière sélection :

 Sélectionnez Edit > Restore Last Selection.

Modification de la hauteur des 
pistes

Pour ajuster la hauteur des pistes contenant la 
sélection d'édition à la hauteur de la fenêtre Edit :

 Appuyez sur Ctrl+Démarrer+Flèche haut 
(Windows) ou Commande+Ctrl+Flèche 
haut (Mac).

Pour modifier de façon proportionnelle la hauteur 
des pistes contenant la sélection d'édition :

 Appuyez sur Démarrer+Flèche haut ou bas 
(Windows) ou Ctrl+Flèche haut ou bas (Mac).

Pour modifier la vue des pistes sur toutes les 
pistes simultanément :

 Appuyez sur Alt+Démarrer+Flèche haut ou bas 
(Windows) ou Option+Ctrl+Flèche haut ou bas 
(Mac).

Changement de vue de piste

Pour modifier la vue des pistes contenant la 
sélection d'édition :

 Appuyez sur Ctrl+Démarrer+Flèche gauche ou 
droite (Windows) ou Commande+Ctrl+Flèche 
gauche ou droite (Mac).

Pour modifier la vue des pistes sur toutes les 
pistes simultanément :

 Appuyez sur Ctrl+Alt+Démarrer+Flèche 
gauche ou droite (Windows) ou 
Commande+Option+Ctrl+Flèche gauche ou 
droite (Mac).

Pour restaurer la sélection précédente, vous 
pouvez également appuyer sur Ctrl+Alt+Z 
(Windows) ou Commande+Option+Z (Mac).
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Chapitre 27 : Édition des clips et sélections

Les clips sont les composants de base permettant 
d'organiser l'audio et le MIDI dans Pro Tools. Pour 
profiter pleinement des fonctions d'édition offertes 
par Pro Tools, il est essentiel de bien comprendre 
les processus de création, d'édition et 
d'organisation des clips.

Ce chapitre aborde les fonctions d'édition 
fondamentales qui s'appliquent aux clips et 
groupes de clips, ainsi que les sélections 
qui concernent, dans la majorité des cas, 
les données audio et/ou MIDI. 

Pour obtenir des informations sur les procédures 
d'édition spécifiques au MIDI, reportez-vous au 
Chapitre 31, « Édition MIDI ». Pour des 
informations sur les procédures d'édition 
spécifiques à la vidéo, reportez-vous à la section 
« Clips vidéo » à la page 1262.

Création de clips
Pro Tools offre plusieurs commandes de création 
de clips et de groupes de clips, chacune ayant un 
effet légèrement différent sur la sélection. Lorsque 
vous créez un clip ou un groupe de clips, il s'affiche 
dans la liste des clips et sur la playlist de la piste. 
Lors de la création d'un clip à partir d'un clip 
existant, le clip d'origine reste dans la liste des clips. 
Les nouveaux clips sont nommés automatiquement 
(reportez-vous à la section « Options d'attribution 
automatique des noms » à la page 276). 

Commande Capture Clip
La commande Capture Clip se base sur une 
sélection pour créer un clip qui sera ajouté à la liste 
des clips. Vous pouvez ensuite déposer ce nouveau 
clip sur des pistes existantes.

Pour capturer un nouveau clip :

1 Avec le Sélecteur, cliquez et faites glisser votre 
souris sur un clip existant afin de sélectionner 
du contenu.

2 Sélectionnez Clip > Capture.

3 Attribuez un nom au nouveau clip et cliquez 
sur OK.

Le nouveau clip apparaît dans la liste des clips. 
Le clip d'origine n'est pas modifié.

Sélection d'une partie d'un clip

Appuyez sur Ctrl+R (Windows) ou 
Commande+R (Mac) pour capturer un clip.
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Commandes de séparation
Les commandes Separate se basent sur une 
sélection créée à l'intérieur d'un clip existant ou 
sur un clip partiellement sélectionné pour créer 
un clip, puis le séparer du contenu adjacent. 
Les commandes Separate peuvent également être 
utilisées sur des notes MIDI (reportez-vous à la 
section « Séparation de notes MIDI » à la 
page 705).

Les nouveaux clips apparaissent sur les pistes sur 
lesquelles ils ont été créés, séparés des données qui 
les entourent. Ils apparaissent également dans la 
liste des clips. 

Trois commandes Separate sont disponibles :

At Selection (ou Edit Cursor) : crée de nouvelles 
limites de clips aux points de début et de fin de la 
sélection. Si aucune sélection n'est définie et si le 
curseur d'édition est placé à l'intérieur du clip, il est 
divisé en deux nouveaux clips au point d'insertion. 
De la même façon, les notes MIDI peuvent être 
séparées aux points de début et de fin de la 
sélection (ou au niveau du curseur d'édition).

On Grid : crée des clips en fonction de la valeur de 
grille sélectionnée (reportez-vous à la section 
« Définition de la valeur de la grille » à la 
page 859). De la même façon, les notes MIDI 
peuvent être séparées sur la grille.

At Transients : crée automatiquement des limites 
de clip au niveau des transitoires détectés dans une 
sélection. Cette commande et la fonction de 
tabulation vers les transitoires sont basées sur le 
même algorithme (reportez-vous à la section 
« Tabulation vers les transitoires » à la page 587). 
Sur les pistes Elastic Audio, la commande 
Separate At Transients se base sur les événements 
transitoires détectés par l'analyse Elastic Audio 
(reportez-vous à la section « Analyse Elastic 
Audio » à la page 913). La commande Separate At 
Transients s'applique uniquement à l'audio, et ne 
peut être appliquée aux clips ou notes MIDI.

Pour séparer un ou plusieurs clips (ou notes MIDI) 
sur les limites de la sélection (ou au niveau du 
curseur d'édition) :

1 Effectuez l'une des opérations suivantes :

• Créez une sélection d'édition à l'aide du 
Sélecteur.

• À l'aide du Sélecteur, cliquez à l'endroit où vous 
souhaitez séparer le clip (ou la note MIDI).

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Separate > At Selection.

• Créez une sélection d'édition, puis effectuez un 
clic droit près de la position du curseur ou de la 
sélection et sélectionnez la commande Separate 
dans le menu contextuel.

3 Si l'option Auto-Name Separated Clips des 
préférences d'édition n'est pas activée, entrez le 
nom du nouveau clip à l'invite, puis cliquez sur 
OK.

Pour séparer des clips (ou des notes MIDI) sur les 
limites de la grille actuelle :

1 Créez une sélection d'édition.

2 Sélectionnez Edit > Separate > On Grid.

3 Dans la boîte de dialogue Pre-Separate Amount, 
saisissez une durée de pré-séparation en 
millisecondes. Vous pouvez ainsi ajouter une 
plage de temps au début des nouveaux clips.

4 Cliquez sur OK.

Appuyez sur les touches Ctrl+E (Windows) ou 
Commande+E (Mac) pour séparer les clips ou 
notes MIDI sur les limites de la sélection.

Boîte de dialogue Pre-Separate Amount
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Pour séparer des clips audio au niveau des 
transitoires :

1 Créez une sélection d'édition.

2 Sélectionnez Edit > Separate > At Transients.

3 Dans la boîte de dialogue Pre-Separate Amount, 
saisissez une durée de pré-séparation en 
millisecondes. Vous pouvez ainsi ajouter une 
plage de temps au début des nouveaux clips.

4 Cliquez sur OK.

Option Auto-Name Separated 
Clips
Lorsque l'option Auto-Name Separated Clips des 
préférences d'édition est sélectionnée, Pro Tools 
attribue automatiquement des noms à chaque clip. 
Chaque nom est une déclinaison du nom du clip 
d'origine auquel est ajouté un chiffre.

Lorsque vous séparez un clip, d'autres clips sont 
créés automatiquement à partir des données situées 
de part et d'autre de la séparation ; de nouveaux 
chiffres sont assignés à leur nom. Le clip d'origine 
n'est pas modifié dans la liste des clips.

"Separate Clip" Operates on All 
Related Takes
Lorsque l'option "Separate Clip" Operates on All 

Related Takes est activée dans les préférences 
d'édition, l'édition d'un clip à l'aide de la 
commande Separate Clip affecte également toutes 
les autres prises associées ayant le même marqueur 
temporel utilisateur.

Cette option aide à comparer différentes sections 
d'un groupe de prises associées. Par exemple, vous 
pouvez rapidement séparer en sections tout un 
groupe de prises de voix associées, puis écouter et 
sélectionner indépendamment les meilleurs 
passages de chaque section.

Si cette option est sélectionnée, assurez-vous que 
les options Track Name et Clip Start and End le 
sont également dans la fenêtre Matching Criteria 
(reportez-vous à la section « Critères de 
correspondance » à la page 657). Si ce n'est pas le 
cas, tous les clips de la session possédant le même 
marqueur temporel utilisateur seront concernés.

Dans la plupart des cas, il est conseillé de 
désélectionner l'option Separate Clip Operates On 

All Related Takes pour éviter de créer un grand 
nombre de clips lorsque vous utiliserez la 
commande Separate Clip.

La liste des clips peut se remplir rapidement 
de clips créés automatiquement. Pour 
faciliter la gestion des clips, dans le menu de 
la liste des clips, désactivez Show > Auto-
Created pour masquer tous les clips créés 
automatiquement dans la liste des clips.
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Séparation sur plusieurs pistes
La figure suivante illustre une séparation sur une 
piste audio mono et deux pistes stéréo. Pour 
certaines pistes, la sélection se trouve dans un clip, 
tandis que d'autres incluent le début ou la fin d'un 
clip.

Une fois séparées, ces données peuvent être 
déplacées ou copiées vers un autre emplacement.

Outil de séparation
L'outil de séparation permet de séparer 
automatiquement une sélection d'édition et de la 
déplacer vers un autre emplacement ou une autre 
piste.

Pour séparer une sélection avec l'outil de 
séparation :

1 Créez une sélection d'édition à l'aide du 
Sélecteur. La sélection peut se trouver à 
l'intérieur d'un même clip, sur des clips 
adjacents de la même piste ou englober 
plusieurs pistes.

2 Dans le menu déroulant des outils de saisie, 
sélectionnez l'outil de séparation.

3 Faites glisser la sélection vers le nouvel 
emplacement ou une autre piste.

Un ou plusieurs clips contenant la sélection 
précédente sont créés, séparément de la sélection 
d'origine. De nouveaux clips sont également créés 
à partir des données se trouvant hors de la sélection 
d'origine.

Séparation sur plusieurs pistes

Outil de séparation

Déplacement d'une sélection en aval sur une piste 
avec l'outil de séparation
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Pour séparer une sélection sans affecter les clips 
d'origine :

1 Créez une sélection d'édition à l'aide du 
Sélecteur. La sélection peut se trouver 
à l'intérieur d'un même clip, sur des clips 
adjacents de la même piste ou englober 
plusieurs pistes.

2 Dans le menu déroulant des outils de saisie, 
sélectionnez l'outil de séparation.

3 Tout en maintenant la touche Alt (Windows) ou 
Option (Mac) enfoncée, faites glisser la 
sélection vers le nouvel emplacement ou une 
autre piste.

De nouveaux clips contenant la sélection 
précédente sont créés et placés au nouvel 
emplacement. La sélection et les clips d'origine 
demeurent intacts.

Chevauchement de clips avec 
recouvrement ou superposition
Lorsqu'une piste audio basée sur les références de 
tempo comporte plusieurs clips, une augmentation 
du tempo peut engendrer un chevauchement de 
clips adjacents. Il est possible de configurer les 
clips audio afin qu'un coin écorné soit affiché 
lorsque des limites se chevauchent. 

Pour activer ou désactiver l'affichage des limites 
de clips recouverts ou superposés :

 Sélectionnez View > Clip > Overlap.

Inversion de l'état recouvert/superposé 
des clips

Lorsque vous modifiez le tempo avec de l'audio 
basé sur les références de tempo, ou effectuez 
d'autres opérations d'édition, le chevauchement de 
certains clips peut être inapproprié. Le cas échéant, 
il est possible de mettre un clip au premier plan, ou 
à l'inverse de l'envoyer à l'arrière-plan.

Pour inverser l'état recouvert/superposé d'un 
clip :

1 Dans la fenêtre Edit, sélectionnez le ou les clips 
dont vous souhaitez modifier l'ordre.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Bring to Front pour que le 
clip soit superposé aux clips adjacents.

• Sélectionnez Clip > Send to Back pour que le 
clip soit recouvert par les clips adjacents. 

Si la sélection englobe plusieurs chevauchements, 
Pro Tools appliquera la commande à chaque clip, 
par rapport au clip situé immédiatement à droite. 

Déplacement d'une sélection vers une autre piste 
avec l'outil de séparation

Chevauchements avec recouvrement et superposition

Clip superposé

Clip recouvert

Clip superposé
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Suppression des séparations 
de clips
La commande Heal Separation rétablit l'état 
d'origine de clips séparés, à la condition que les 
clips se trouvent encore l'un à côté de l'autre et que 
leurs points de début et de fin relatifs n'aient pas été 
modifiés depuis la séparation.

Si vous avez effectué une opération de trim ou 
modifié d'une manière ou d'une autre les points de 
début et de fin des deux clips, ou si vous les avez 
éloignés l'un de l'autre, vous ne pourrez pas les 
rétablir tels qu'ils étaient à l'aide de la commande 
Heal Separation. Il est impossible de supprimer la 
séparation entre deux clips créés à partir de 
fichiers audio différents.

Pour supprimer une séparation entre deux clips :

1 Cliquez avec le Sélecteur et faites glisser pour 
sélectionner une partie du premier clip et une 
partie du second clip, ainsi que l'espace qui les 
sépare.

2 Sélectionnez Edit > Heal Separation.

Si la commande Heal Separation ne parvient pas 
à reconstituer un clip divisé, effectuez l'une des 
opérations suivantes :

 Supprimez l'un des deux clips (assurez-vous 
que le mode Slip soit activé afin que l'espace 
ainsi créé ne soit pas comblé), puis, à l'aide de 
l'outil de trim, rallongez la fin du clip restant 
pour rétablir sa durée d'origine (reportez-vous 
à la section « Utilisation des outils de trim » à la 
page 558).

 Supprimez les deux clips séparés et faites 
glisser le clip d'origine de la liste des clips vers 
l'emplacement d'origine (reportez-vous à la 
section « Placement de clips sur les pistes » à la 
page 849).

Trim des clips
En plus des outils de trim (reportez-vous à la section 
« Utilisation des outils de trim » à la page 558), 
Pro Tools propose plusieurs options d'édition des 
limites des clip et des groupes de clips. 

Commande Trim To Selection
La commande Trim To Selection supprime les 
données situées avant et après un clip ou une 
sélection de notes MIDI, pour ne conserver que la 
sélection. Vous pouvez ainsi supprimer rapidement 
toutes les données d'un clip (et, dans certains cas, 
l'intégralité d'une piste), à l'exception de celles 
contenues dans la sélection active.

Pour exclure des données d'un clip ou d'une note 
par trimming :

1 À l'aide du Sélecteur, sélectionnez une partie d'un 
clip ou d'une note (ou d'une plage de notes).

2 Sélectionnez Edit > Trim Clip > To Selection 
pour supprimer les données situées hors de la 
sélection.

Commandes Trim To Insertion
Vous pouvez effectuer un trim sur un clip ou une note 
MIDI en supprimant automatiquement les données 
qui se trouvent entre le point d'insertion d'édition et le 
point de début ou de fin du clip.

Pour effectuer un trimming du point de début 
jusqu'au point d'insertion :

1 À l'aide du Sélecteur, cliquez sur un clip ou une 
note, à l'endroit où vous souhaitez définir le 
nouveau point de début.

2 Sélectionnez Edit > Trim Clip > Start To 
Insertion. Un trimming automatique supprime 
les données comprises entre le point de début du 
clip et le point d'insertion.

Appuyez sur Ctrl+H (Windows) ou 
Commande+H (Mac) pour supprimer la 
séparation.

Appuyez sur Alt+Maj+7 (Windows) ou 
Option+Maj+7 (Mac) pour exécuter la 
commande Trim Start To Insertion.
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Pour effectuer un trimming depuis un point de fin 
jusqu'au point d'insertion :

1 À l'aide du Sélecteur, cliquez sur un clip ou une 
note, à l'endroit où vous souhaitez définir le 
nouveau point de fin.

2 Sélectionnez Edit > Trim Clip > End To 

Insertion. Un trimming automatique supprime 
les données comprises entre le point d'insertion 
et le point de fin du clip.

Commandes Trim to Fill Selection
Les commandes Trim to Fill Selection permettent 
de révéler automatiquement des données sous-
jacentes dans les espaces compris entre des clips, 
ou avant ou après des clips individuels, comme 
suit :

Pour effectuer un trimming depuis un point de 
début pour combler des espaces :

1 Faites glisser le Sélecteur pour sélectionner au 
moins un espace entre des clips.

2 Sélectionnez Edit > Trim Clip > Start to Fill 

Selection.

Un trimming automatique est appliqué au point de 
début du clip situé après l'espace jusqu'au clip 
précédent, ou le plus loin possible en fonction de la 
quantité de données sous-jacentes.

Pour effectuer un trimming depuis un point de fin 
pour combler des espaces :

1 Faites glisser le Sélecteur pour sélectionner au 
moins un espace entre des clips.

2 Sélectionnez Edit > Trim Clip > End to Fill 

Selection. 

Un trimming automatique est appliqué au point de 
fin du clip situé avant l'espace jusqu'au clip 
suivant, ou le plus loin possible en fonction de la 
quantité de données sous-jacentes.

Fin du clip déplacée jusqu'au point d'insertion par 
trimming

Appuyez sur Alt+Maj+8 (Windows) ou 
Option+Maj+8 (Mac) pour exécuter la 
commande Trim Start To Insertion.

Trimming du début d'un clip pour combler un espace

Trimming de la fin d'un clip pour combler un espace
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Pour effectuer un trimming depuis les points de 
début et de fin d'un clip pour combler une 
sélection :

1 Avec le Sélecteur, effectuez une sélection 
d'édition incluant le clip que vous souhaitez 
étendre.

2 Sélectionnez Edit > Trim Clip > To Fill Selection.

Un trimming automatique est appliqué au point de 
début du clip jusqu'au début de la sélection 
d'édition, ou le plus loin possible en fonction de la 
quantité de données sous-jacentes. En parallèle, un 
trimming automatique est appliqué au point de fin 
du clip jusqu'à la fin de la sélection d'édition, ou le 
plus loin possible en fonction de la quantité de 
données sous-jacentes.

L'effet de la commande Trim to Fill Selection est 
l'inverse de la commande Trim to Fit Selection : la 
commande Trim to Fill Selection étend un clip pour 
l'ajuster à la sélection d'édition tandis que la 
commande Trim to Fit Selection exclut des données 
d'un clip pour l'ajuster à la sélection d'édition.

Trim par incrément
Vous pouvez effectuer un trimming aux points de 
début et de fin des clips (ou des notes MIDI) basé 
sur la valeur d'incrément actuelle.

Pour effectuer un trimming sur le point de début 
ou de fin d'un clip selon la valeur d'incrément :

1 Configurez la valeur d'incrément (reportez-
vous à la section « Définition de la valeur 
d'incrément » à la page 607).

2 À l'aide de l'outil de saisie du temps, 
sélectionnez le clip sur lequel vous souhaitez 
effectuer l'opération de trim.

3 Effectuez l'une des opérations suivantes :

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et appuyez sur la touche Plus (+) 
ou Moins (-) du pavé numérique pour effectuer un 
trimming de la valeur d'incrément sur le point de 
début de la sélection.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur la 
touche Plus (+) ou Moins (-) du pavé numérique 
pour effectuer un trimming de la valeur 
d'incrément sur le point de fin de la sélection.

Déplacement de clips par 
incrément
Pro Tools permet de déplacer des clips (ou des 
notes MIDI) par incrément précis à l'aide des 
touches Plus (+) et Moins (-) du pavé numérique. 
L'amplitude de ce déplacement est déterminée par 
la valeur spécifiée dans le menu déroulant des 
valeurs d'incrément. Le déplacement par 
incrément est utilisable dans n'importe quel mode 
d'édition.

Le déplacement par incrément peut être 
particulièrement efficace pour ajuster le 
« groove » d'une phrase musicale ou le placement 
d'un effet sonore par rapport aux autres éléments 
de la session. Pro Tools pouvant déplacer des 
données par incrément en cours de lecture, vous 
pouvez utiliser cette fonction de façon continue et 
en temps réel pour ajuster le timing entre les pistes.

Le déplacement par incrément sert également 
à ajuster le placement des points d'automation. 
Pour plus d'informations, reportez-vous à la 
section « Édition de l'automation » à la page 1095.
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Définition de la valeur 
d'incrément
La valeur d'incrément détermine l'amplitude du 
déplacement par incrément des clips et sélections. 

Vous pouvez également déplacer par incrément les 
points de début et de fin des sélections (reportez-
vous à la section « Déplacement par incrément des 
points de début/fin de sélection » à la page 582). 
De plus, vous pouvez effectuer une opération de 
trimming sur des clips en vous basant sur cette 
valeur d'incrément (reportez-vous à la section 
« Trim par incrément » à la page 606).

Pour définir la valeur d'incrément :

1 Effectuez l'une des opérations suivantes :

• Dans le menu View > Main Counter, sélectionnez 
l'échelle temporelle de la valeur d'incrément.

• Pour conserver l'échelle temporelle principale et 
utiliser un format temporel différent pour la 
valeur d'incrément, désélectionnez l'option 
Follow Main Timebase dans le menu déroulant 
des valeurs d'incrément.

2 Spécifiez une valeur d'incrément en effectuant 
l'une des opérations suivantes :

• Dans le menu déroulant des valeurs d'incrément 
de la fenêtre Edit, sélectionnez la valeur 
souhaitée.

• Pour spécifier une valeur d'incrément ne 
figurant pas dans le menu, cliquez sur 
l'indicateur du champ, puis tapez la valeur.

Déplacement de clips selon la 
valeur d'incrément

Pour déplacer par incrément un ou plusieurs 
clips :

1 Configurez la valeur d'incrément (reportez-
vous à la section « Définition de la valeur 
d'incrément » à la page 607).

2 À l'aide de l'outil de saisie du temps ou du 
Sélecteur, sélectionnez le ou les clips, ou groupes 
de clips, que vous voulez déplacer par incrément. 
Les clips peuvent se trouver sur des pistes 
différentes. Seuls les clips entièrement 
sélectionnés sont déplacés par incrément.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Plus (+) du pavé 
numérique pour déplacer la sélection en aval de 
la valeur d'incrément.

• Appuyez sur la touche Moins (-) du pavé 
numérique pour reculer la sélection de la valeur 
de déplacement par incrément.

Format de timecode sélectionné dans le menu des 
valeurs d'incrément
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La commande Nudge fonctionne de la même 
manière, quel que soit le mode d'édition. Les clips 
adjacents sont superposés en mode Shuffle, la 
boîte de dialogue Spot ne s'ouvre pas en mode Spot 
et les données décalées ne s'alignent pas sur la 
grille en mode Grid.

Déplacement par incrément de 
clips sur plusieurs pistes et sur 
des pistes multicanal
Lorsque vous déplacez par incrément une sélection 
de plusieurs clips, sur une seule ou plusieurs pistes 
contenant également des silences, les données 
d'automation résidant dans les silences sont 
également déplacées par incrément.

Déplacement selon la valeur 
d'incrément suivante
Le déplacement par incrément est basé sur la 
valeur actuelle, mais il est également possible 
d'effectuer un déplacement de la valeur suivante du 
menu des valeurs d'incrément. 

Par exemple, si la valeur d'incrément est définie 
sur 1 image et que vous souhaitez effectuer un 
déplacement d'une valeur plus importante, vous 
pouvez utiliser la valeur de 10 images.

Pour effectuer un déplacement par incrément 
vers l'avant ou l'arrière basé sur la valeur suivante 
du menu :

1 Activez le focus clavier sur les commandes 
(reportez-vous à la section « Focus clavier » à la 
page 26). 

2 Sélectionnez les clips ou les notes à déplacer par 
incrément.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la barre oblique (/) pour avancer les 
données sélectionnées de la valeur d'incrément 
suivante.

• Appuyez sur M pour reculer les données 
sélectionnées de la valeur d'incrément suivante.

Déplacement par incrément du 
contenu d'un clip
Il est fréquent que le point de début d'un clip se 
trouve à l'emplacement correct, par rapport à une 
image SMPTE ou une mesure spécifique, mais que 
les données du clip commencent trop tard ou trop 
tôt. Vous pouvez déplacer par incrément la forme 
d'onde audio ou les notes MIDI d'un clip sans en 
déplacer les points de début et de fin.

Ce « glissement » du contenu du clip n'est possible 
que si des données se trouvent au-delà des points 
de début et de fin du clip, c'est-à-dire si une 
opération de trim a été effectuée sur le clip ou s'il 
a été capturé à partir d'un clip plus long.

Lorsque le focus clavier sur les commandes n'est 
pas activé, appuyez sur Démarrer+barre oblique 
(/) (Windows) ou Ctrl+barre oblique (/) (Mac) 
pour avancer les données sélectionnées de la 
valeur d'incrément suivante, et sur Démarrer+M 
(Windows) ou Ctrl+M (Mac) pour reculer les 
données sélectionnées de la valeur d'incrément 
suivante.

Déplacement par incrément du contenu d'un clip sans 
en modifier les limites
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Pour déplacer par incrément le contenu d'un clip 
sans changer ses points de début et de fin :

1 Configurez la valeur d'incrément (reportez-
vous à la section « Définition de la valeur 
d'incrément » à la page 607).

2 À l'aide de l'outil de saisie du temps, 
sélectionnez le clip dont vous voulez déplacer le 
contenu par incrément.

3 Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et appuyez sur la touche 
Plus (+) ou Moins (-) du pavé numérique pour 
déplacer les données de la valeur d'incrément 
spécifiée.

Quantification des clips sur 
la grille
La commande Quantize to Grid permet d'ajuster le 
positionnement des clips MIDI et audio 
sélectionnés afin d'aligner avec précision leur 
point de début (ou de synchronisation, le cas 
échéant) sur la limite de grille la plus proche.

Pour quantifier des notes MIDI individuelles ou 
des événements Elastic Audio, utilisez la fenêtre 
Quantize Event Operations. Vous pouvez 
également utiliser cet outil pour quantifier des 
clips audio (reportez-vous à la section 
« Commande Quantize » à la page 938).

Pour quantifier un ou plusieurs clips :

1 Sélectionnez la valeur de grille (reportez-vous à 
la section « Définition de la valeur de la grille » 
à la page 859).

2 À l'aide du Sélecteur ou de l'outil de saisie 
du temps, sélectionnez le ou les clips 
à quantifier. Les clips peuvent se trouver sur des 
pistes différentes. Seuls les clips entièrement 
sélectionnés seront quantifiés.

3 Sélectionnez Clip > Quantize to Grid. 
Les heures de début (ou les points de 
synchronisation) des clips sont alignées sur les 
limites les plus proches de la grille. 

Pour les clips MIDI, la quantification s'effectue 
uniquement au niveau des clips, et toutes les 
données MIDI contenues dans ces clips (telles que 
les notes) sont déplacées de façon proportionnelle. 
Elles conservent par conséquent leur relation 
rythmique. 

Pour les clips Elastic Audio, la quantification 
s'effectue uniquement au niveau des clips, et tous les 
événements Elastic Audio contenus dans ces clips 
(tels que les événements transitoires) sont déplacés de 
façon proportionnelle. Elles conservent par 
conséquent leur relation rythmique. 

Édition de pistes stéréo et 
multicanal
Les clips se trouvant sur des canaux individuels au 
sein de pistes stéréo et multicanal ne peuvent être 
sélectionnés de façon indépendante. Toutes les 
sélections sur ces pistes sont basées sur le temps, 
ce qui signifie que les clips sélectionnés avec le 
Sélecteur ou l'outil de saisie du temps s'étendent 
à chaque canal de la piste.

Lorsque des clips de pistes multicanal sont édités 
avec l'outil de trim ou déplacés avec l'outil de 
saisie du temps, les données de chaque canal sont 
affectées de la même manière.

Appuyez sur Ctrl+0 (Windows) ou 
Commande+0 (Mac) pour activer la 
commande Quantize to Grid.

Pour quantifier des notes MIDI individuelles 
ou des événements Elastic Audio, utilisez la 
fenêtre Quantize Event Operations. Vous 
pouvez également utiliser cet outil pour 
quantifier des clips audio. Pour plus 
d'informations, reportez-vous à la section 
« Commande Quantize » à la page 938.
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Division de pistes sélectionnées
Pour éditer un canal spécifique d'une piste stéréo 
ou multicanal sans intervenir sur les autres canaux, 
vous pouvez la diviser en plusieurs pistes mono. 
Lorsque vous avez effectué vos modifications sur 
les données séparées, vous pouvez les déplacer ou 
les copier vers la piste multicanal d'origine.

Pour diviser une piste stéréo ou multicanal :

1 Sélectionnez une ou plusieurs pistes stéréo ou 
multicanal (reportez-vous à la section 
« Sélection de pistes » à la page 221). 

2 Sélectionnez Track > Split Into Mono. Les clips 
provenant des canaux sur les pistes sélectionnées 
sont placés sur de nouvelles pistes audio mono.

Les noms des nouvelles pistes sont basés sur celui 
de la piste source et sur le suffixe du canal. 
Par exemple, après division d'une piste stéréo 
nommée Funkit, deux nouvelles pistes appelées 
Funkit.L et Funkit.R sont créées.

Les assignations de sortie et des départs ainsi que les 
paramètres de volume et de panoramique sont 
conservés sur les nouvelles pistes. Des équivalents 
mono des plug-in stéréo et multi-mono sont assignés 
aux nouvelles pistes. Cependant, aucun plug-in 
multicanal n'est assigné aux nouvelles pistes.

Déplacement de clips vers et 
à partir de pistes stéréo et 
multicanal

Lors du déplacement de clips vers et à partir des 
pistes stéréo ou multicanal, les règles suivantes 
s'appliquent :

 Si les nombres de pistes et de canaux sont 
identiques pour la source et la destination, vous 
pouvez déplacer des clips entre des pistes 
multicanal et des pistes mono.

 Les formats source et de destination des clips 
déplacés peuvent être mixtes. Vous pouvez par 
exemple déplacer des clips d'une piste 5.0 
(contenant cinq canaux) vers une piste stéréo et 
trois pistes audio mono.

 Lorsque vous déplacez des clips multicanal vers 
des pistes mono, les pistes de destination doivent 
être adjacentes.

 Lorsque vous déplacez des clips depuis des 
pistes mono vers une piste multicanal, les pistes 
source peuvent ne pas être adjacentes.

Les clips multicanal peuvent également être 
déplacés de la liste des clips vers des pistes 
multicanal de même format, des groupes de pistes 
audio mono ou une combinaison des deux. 

Clip stéréo déposé sur deux pistes audio mono
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Inversement, un ensemble de clips mono uniques 
peut être déplacé de la liste des clips vers des pistes 
multicanal, à condition que le nombre de clips 
déplacés corresponde au nombre de canaux de la 
piste de destination.

Gain du clip
Pro Tools fournit un réglage de gain basé sur les 
clips permettant de rapidement et facilement faire 
correspondre le gain des clips (auparavant appelés 
« régions » dans Pro Tools) de différentes sources 
d'une session Pro Tools. Le gain du clip est appliqué 
pré-mixeur (pré-fader et avant tout traitement de 
plug-in). Cette fonction est particulièrement utile 
pour travailler avec des sources d'enregistreur 
portable et des bibliothèques de samples dans les 
sessions de post-production.

En ajustant le gain de chaque clip individuel 
sur une piste unique, vous pouvez équilibrer les 
niveaux de gain relatifs afin de ne pas avoir 
à utiliser d'automation de volume complexe pour 
les compenser.

Les réglages de gain du clip sont conservés avec le 
clip, ce qui signifie que vous pouvez déplacer et 
copier-coller des clips avec les réglages de gain du 
clip correspondants. Les réglages de gain du clip 
peuvent maintenant être importés à partir des 
séquences AAF et OMF exportées depuis 
Media Composer. De la même façon, les réglages 
de gain du clip peuvent être exportés à partir de 
Pro Tools avec les séquences AAF (mais pas OMF) 
devant être importées dans Media Composer.

Par défaut, le gain du clip de tous les clips est 
défini sur 0 dB. Il peut être ajusté entre -144 dB 
et +36.0 dB.

Gain du clip statique ou dynamique

Vous pouvez appliquer des réglages de gain du clip 
statiques ou dynamiques pour un même clip. 
Un gain du clip statique signifie simplement qu'un 
unique réglage de gain est appliqué à l'ensemble du 
clip (reportez-vous à la section « Ajustement simple 
du gain du clip » à la page 613). Un gain du clip 
dynamique signifie que les réglages de gain du clip 
varient dans le temps (reportez-vous à la section 
« Édition graphique du gain du clip » à la page 614).

Affichage des informations de 
gain du clip
Lorsque la vue Clip Gain Info est activée (View > 

Clip > Clip Gain Info), une icône de fader de gain du 
clip est affichée au début du clip, dans le coin 
inférieur gauche. Si le gain du clip est statique, 
la valeur correspondante (-144 dB à +36,0 dB) 
est affichée à droite de l'icône de fader. Si le gain 
du clip est dynamique (basé sur des points 
d'automation), la valeur de gain du clip n'est 
pas affichée. 

Les commandes de gain du clip (fader de gain 
du clip et commandes contextuelles) agissent 
uniquement sur la totalité du clip auquel elles sont 
associées.

Plusieurs clips avec différents réglages de gain du 
clip (statiques)

Icône de gain du clip
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Pour afficher ou masquer l'icône de gain du clip, 
effectuez l'une des opérations suivantes :

 Sélectionnez ou désélectionnez View > Clip > 

Clip Gain Info.

 Appuyez sur Ctrl+Maj+Égal (=) (Mac) ou 
Démarrer+Maj+Égal (=) (Windows).

Menu contextuel de l'icône de fader de gain 
du clip

Vous pouvez effectuer un clic droit sur l'icône de 
fader de gain du clip de n'importe quel clip 
individuel pour accéder aux commandes de gain 
de ce clip. 

Le menu contextuel de l'icône de fader de gain du 
clip fonctionne indépendamment du sous-menu 
Clip Gain auquel vous pouvez accéder en 
effectuant un clic droit sur une sélection d'édition. 
Lorsque les réglages de gain du clip sont rendus, 
des poignées de trim apparaissent aux extrémités 
du clip résultant, en fonction du paramètre Default 
Handle Length des préférences de traitement.

Bypass du gain du clip

Lorsque l'option Bypass Clip Gain est sélectionnée 
dans le menu contextuel, les réglages actuels de 
gain du clip sont ignorés et le clip est lu avec un 
gain de 0 dB.

Réinitialisation du gain du clip

Sélectionnez l'option Clear Clip Gain du menu 
contextuel pour effacer les réglages de gain 
du clip.

Rendu du gain du clip

Sélectionnez l'option Render Clip Gain du menu 
contextuel pour imprimer le rendu des réglages 
actuels de gain du clip. Une fois le clip rendu avec 
son nouveau gain, les réglages de gain du clip sont 
réinitialisés à 0 dB.

Affichage/masquage de la courbe de gain 
du clip

Sélectionnez Show/Hide Clip Gain Line dans le 
menu contextuel pour afficher ou masquer la 
courbe de gain du clip de tous les clips.

Courbe de gain du clip
La courbe de gain du clip permet de modifier les 
réglages de gain de n'importe quel clip en déplaçant 
des points d'automation, de manière très semblable à 
l'automation de volume des pistes. Toutefois, 
contrairement à l'automation de volume des pistes, 
les réglages de gain du clip sont toujours associés au 
clip plutôt qu'à la piste. La courbe de gain du clip peut 
être affichée ou masquée pour tous les clips de la 
fenêtre Edit.

Menu contextuel de l'icône de gain du clip

Courbe de gain du clip (avec plusieurs points 
d'automation)
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Pour afficher ou masquer la courbe de gain du 
clip, effectuez l'une des opérations suivantes :

 Sélectionnez ou désélectionnez View > Clip > 

Clip Gain Line.

 Appuyez sur Ctrl+Maj+Trait d'union (-) (Mac) 
ou Démarrer+Maj+Trait d'union (-) (Windows).

 Effectuez un clic droit sur l'icône de fader de 
gain du clip de n'importe quel clip, puis 
sélectionnez Show Clip Gain Line ou Hide Clip 
Gain Line.

 Effectuez un clic droit sur un clip, puis 
sélectionnez Clip Gain > Show Clip Gain Line ou 
Clip Gain > Hide Clip Gain Line.

Courbe de gain du clip et fondus 
enchaînés

Le gain du clip est appliqué de manière individuelle 
à chaque clip. Lorsque vous créez un fondu enchaîné 
entre deux clips, la courbe de gain du premier clip est 
appliquée sur l'ensemble du segment de fondu de 
sortie, la courbe de gain du second clip est appliquée 
sur l'ensemble du segment de fondu d'entrée. Par 
conséquent, deux courbes de gain du clip peuvent 
être affichées sur un fondu enchaîné, l'une pour le 
premier clip, l'autre pour le second.

Édition du gain du clip
Pro Tools permet d'ajuster facilement les 
paramètres de gain d'un clip à l'aide du fader de 
gain du clip ou, pour un ajustement encore plus 
précis, en éditant les points d'automation de la 
courbe de gain du clip. 

Ajustement simple du gain du clip

Vous pouvez ajuster facilement les paramètres de 
gain d'un clip à l'aide de l'icône du fader de gain du 
clip.

Pour augmenter ou réduire le gain du clip d'un clip 
unique :

1 Assurez-vous que l'option Clip Gain Info est 
activée.

2 Cliquez sur l'icône du fader de gain du clip, puis 
faites glisser le fader vers le haut ou le bas pour 
augmenter ou réduire le gain du clip.

La courbe de gain du clip est affichée 
uniquement à partir de la hauteur de piste Small.

Courbes de gain du clip avant la création d'un fondu 
enchaîné

Courbes de gain du clip après la création d'un fondu 
enchaîné

Lorsque l'édition d'un clip est verrouillée et 
que vous essayez d'éditer le gain du clip, 
un message vous invite à annuler ou 
confirmer l'édition.

Ajustement d'un gain du clip statique à l'aide du fader

Ajustement de tous les points d'automation de gain du 
clip à l'aide du fader



Guide de référence Pro Tools614

Édition graphique du gain du clip

Vous pouvez éditer graphiquement le gain des 
clips individuels en ajoutant des points 
d'automation à leur courbe de gain du clip. Lorsque 
vous déplacez un point d'automation de gain du 
clip vers le haut ou le bas, la modification de la 
valeur de gain s'affiche sous forme numérique. Le 
fait de déplacer un point d'automation de gain du 
clip vers la gauche ou la droite permet de modifier 
sa position temporelle. 

Utilisation de la Main

La Main permet d'ajouter, ajuster et supprimer des 
points d'automation individuels de gain du clip.

Pour ajouter un point d'automation de gain du clip 
avec la Main :

1 Assurez-vous que l'option Clip Gain Line est 
activée.

2 Sélectionnez la Main.

3 Cliquez à l'emplacement de la courbe de gain du 
clip sur lequel vous souhaitez ajouter un point 
d'automation. La Main pointe et affiche un 
signe Plus (+).

Pour ajuster un point d'automation de gain du clip 
avec la Main :

1 Assurez-vous que l'option Clip Gain Line est 
activée.

2 Sélectionnez la Main.

3 Cliquez sur un point d'automation de la courbe 
de gain du clip et déplacez-le vers le haut ou le 
bas pour ajuster le gain, ou vers la gauche ou la 
droite pour modifier sa position temporelle. Le 
réglage de gain s'affiche en dB au-dessus du 
point d'automation sélectionné.

Pour plus de précision, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
lors de l'ajustement du fader de gain du clip.

Ajout d'un point d'automation de gain du clip avec la Main

Appuyez sur Ctrl+Maj+E (Mac) ou 
Démarrer+Maj+E (Windows) pour ajouter 
un point d'automation de gain du clip 
àl'emplacement d'édition actuel.

Ajustement d'un point d'automation de gain du clip 
avec la Main
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Pour supprimer un point d'automation de gain du 
clip avec la Main :

1 Assurez-vous que l'option Clip Gain Line est 
activée.

2 Sélectionnez la Main.

3 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée, puis cliquez sur le point 
d'automation à supprimer. La Main pointe et 
affiche un signe Moins (-).

Utilisation du Crayon

Le Crayon permet de créer des points d'automation 
en cliquant une fois sur la courbe de gain. 
Le Crayon de Pro Tools propose plusieurs formes 
de tracé des courbes de gain du clip : Main levée, 
Ligne, Triangle, Carré et Aléatoire. Les formes de 
Crayon Parabolique et Courbe en S ne sont pas 
disponibles pour l'édition du gain du clip.

Lorsque vous dessinez des réglages de gain du clip 
avec le Crayon, son effet est limité par la sélection 
d'édition et ne s'étend pas au-delà. Toutefois, si le 
Crayon demeure entièrement à l'extérieur d'une 
sélection, il crée des points d'automation de gain 
du clip à l'extérieur de cette sélection. 

Pour ajouter des points d'automation de gain 
du clip avec le Crayon :

1 Assurez-vous que l'option Clip Gain Line 
est activée.

2 Sélectionnez le Crayon.

3 Effectuez l'une des opérations suivantes :

• Cliquez une fois sur la courbe de gain du clip 
pour ajouter un seul point d'automation.

• Cliquez sur la courbe de gain du clip et faites 
glisser votre souris pour dessiner plusieurs 
points d'automation.

Pour supprimer un point d'automation de gain du 
clip avec le Crayon :

1 Assurez-vous que l'option Clip Gain Line 
est activée.

2 Sélectionnez le Crayon.

3 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée, puis cliquez sur le point 
d'automation à supprimer. 

Suppression d'un point d'automation de gain du clip 
avec la Main

Utilisation du Crayon (Main levée) pour dessiner les 
réglages de gain du clip

Utilisation du Crayon (Main levée) pour dessiner des 
paramètres de gain du clip limités par une sélection 
d'édition
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Utilisation des outils de trim

Les outils de trim permettent d'ajuster les points 
d'automation sélectionnés vers le haut ou  le bas en 
les faisant glisser à partir d'un point quelconque de 
la sélection. Contrairement à l'automation de 
volume des pistes, où un trimming proportionnel 
est appliqué, le gain du clip permet d'effectuer une 
véritable opération de trimming (les réglages de 
gain du clip conservent un écart fixe les uns par 
rapport aux autres).

Pour effectuer un trimming vers le haut ou le bas 
des réglages de gain du clip :

1 Assurez-vous que l'option Clip Gain Line est 
activée.

2 Créez une sélection d'édition en incluant les 
réglages de gain du clip à ajuster. 

3 Sélectionnez l'outil de trim.

4 Faites glisser la souris vers le haut ou le bas sur 
la courbe de gain du clip à l'intérieur de la 
sélection d'édition.

Déplacement par incrément du gain 
du clip

Pro Tools permet de déplacer les réglages de gain 
du clip sélectionnés vers le haut ou le bas selon la 
valeur Nudge Clip Gain By spécifiée dans les 
préférences d'édition. Vous pouvez également 
déplacer les paramètres de gain du clip 
sélectionnés en aval ou en amont dans le clip, selon 
la valeur d'incrément spécifiée.

Pour définir la valeur d'incrément de gain du clip :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Editing.

3 Saisissez une valeur pour le paramètre Nudge 

Clip Gain By.

4 Cliquez sur OK.

Pour déplacer par incrément le gain du clip vers 
le haut :

 Appuyez sur Ctrl+Maj+Flèche haut (Mac) ou 
Démarrer+Maj+Flèche haut (Windows).

Pour déplacer par incrément le gain du clip vers 
le bas :

 Appuyez sur Ctrl+Maj+Flèche bas (Mac) ou 
Démarrer+Maj+Flèche bas (Windows).

Utilisation de l'outil de trim pour monter ou baisser des 
points d'automation de gain du clip

Vous avez également la possibilité de déplacer 
par incrément le gain du clip vers le haut ou 
le bas via le protocole EUCON. Pour plus 
d'informations, reportez-vous aux Guide de 
Pro Tools et des Artist Series. 

Si votre souris possède une molette, vous 
pouvez l'utiliser pour déplacer par 
incrément les réglages de gain du clip 
sélectionnés vers le haut ou le bas. Appuyez 
sur Ctrl+Maj (Mac) ou Démarrer+Maj 
(Windows) et faites tourner la molette vers 
le haut ou le bas.
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Pour déplacer le gain du clip sélectionné d'un 
incrément vers l'arrière, effectuez l'une des 
opérations suivantes :

 Appuyez sur Ctrl+Maj+Moins (-) (Mac) 
ou Démarrer+Maj+Moins (-) (Windows).

 Appuyez sur Ctrl+Maj+M (Mac) ou 
Démarrer+Maj+M (Windows).

 Appuyez sur Ctrl+Maj+Virgule (,) (Mac) 
ou Démarrer+Maj+Virgule (,) (Windows).

Pour déplacer le gain du clip sélectionné d'un 
incrément vers l'avant, effectuez l'une des 
opérations suivantes :

 Appuyez sur Ctrl+Maj+Plus (+) (Mac) 
ou Démarrer+Maj+Plus (+) (Windows).

 Appuyez sur Ctrl+Maj+Point (.) (Mac) 
ou Démarrer+Maj+Point (.) (Windows)

 Appuyez sur Ctrl+Maj+Barre oblique (/) (Mac) 
ou Démarrer+Maj+Barre oblique (/) (Windows).

Réinitialisation du gain du clip

Pro Tools permet d'effacer les réglages de gain du 
clip de la sélection d'édition actuelle. Le gain du 
clip de la sélection est alors réinitialisé à 0 dB. 
Pour les clips partiellement inclus dans la sélection 
d'édition, seuls les réglages de gain du clip situés 
dans la sélection d'édition sont affectés.

Pour réinitialiser le gain du clip, effectuez l'une des 
opérations suivantes :

 Effectuez un clic droit sur un clip ou une 
sélection d'édition, puis sélectionnez Clip Gain 

> Clear Clip Gain.

 Effectuez un clic droit sur une icône de fader de 
gain du clip, puis sélectionnez Clear Clip Gain.

 Sélectionnez un clip ou créez une sélection 
d'édition, puis sélectionnez Edit > Clip Special > 

Clear Clip Gain.

 Sélectionnez un clip ou créez une sélection 
d'édition, puis appuyez sur Ctrl+Maj+B (Mac) 
ou Démarrer+Maj+B (Windows).

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur l'icône de 
fader de gain du clip d'un clip unique.

Coupe, copie et collage du gain du clip

Pro Tools permet de couper, copier et coller des 
réglages de gain du clip afin de pouvoir les 
appliquer d'un clip à un autre. Les réglages de gain 
du clip ne peuvent pas être coupés, copiés ou collés 
au-delà des limites du clip.

Pour couper des réglages de gain du clip :

1 Sélectionnez un clip entier ou créez une 
sélection d'édition dans un clip entier.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Cut Special > Cut Clip Gain.

• Appuyez sur Ctrl+Maj+X (Mac) ou 
Démarrer+Maj+X (Windows).

Les réglages de gain du clip sélectionnés sont 
coupés et copiés dans le presse-papiers. 
Des marqueurs temporels sont ajoutés aux points 
d'automation de gain du clip stockés dans le 
presse-papiers, basés sur le format de la base de 
temps de la piste copiée. Cela signifie que si vous 
coupez des réglages de gain du clip à partir de 
pistes basées sur les références de tempo, ils seront 
collés aux emplacements en mesures et temps 
correspondants d'autres pistes basées sur les 
références de tempo.

Vous pouvez couper les réglages de gain du 
clip de n'importe quelle sélection d'édition. 
Toutefois, si vous souhaitez couper et coller 
des réglages de gain du clip, vous pouvez 
uniquement coller les réglages de gain du 
clip coupés à partir d'un clip unique.
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Pour copier des réglages de gain du clip :

1 Sélectionnez un clip entier ou créez une 
sélection d'édition dans un clip entier.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Copy Special > Copy Clip 

Gain.

• Appuyez sur Ctrl+Maj+C (Mac) ou 
Démarrer+Maj+C (Windows).

• Effectuez un clic droit sur n'importe quelle 
sélection de clip entier, puis sélectionnez Clip 

Gain > Copy Clip Gain.

Les réglages de gain du clip sélectionnés sont 
copiés dans le presse-papiers. Des marqueurs 
temporels sont ajoutés aux points d'automation de 
gain du clip stockés dans le presse-papiers, basés 
sur le format de la base de temps de la piste copiée. 
Cela signifie que si vous coupez des réglages de 
gain du clip à partir de pistes basées sur les 
références de tempo, ils seront collés aux 
emplacements en mesures et temps correspondants 
d'autres pistes basées sur les références de tempo.

Pour coller des réglages de gain du clip :

1 Coupez ou copiez les réglages de gain du clip 
souhaités.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez un autre clip.

• Créez une sélection d'édition dans un clip entier.

• Placez le point d'entrée d'édition à l'endroit où 
vous souhaitez coller les réglages de gain du clip 
coupés ou copiés.

3 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Paste Clip Gain.

• Appuyez sur Commande+V (Mac) ou Ctrl+V 
(Windows).

Les réglages de gain du clip du presse-papiers sont 
collés sur le clip à partir du point d'entrée d'édition. 
Les réglages de gain du clip sont collés dans leur 
intégralité, mais ils s'appliquent uniquement à un 
seul clip. Si les réglages de gain du clip collés 
s'étendent au-delà de la fin du clip, ils demeurent 
liés au clip. Cela signifie que si vous allongez le 
clip par une opération de trim ultérieure, le gain du 
clip collé s'affichera. Lorsque vous collez les 
réglages de gain dans un clip (plutôt que sur un clip 
entier de durée identique), des points d'automation 
sont ajoutés avant et après les données collées afin 
que tous les réglages de gain du clip à l'extérieur de 
la zone collée restent inchangés.

Conversion du gain du clip et de 
l'automation de volume de piste
(Pro Tools HD uniquement)

Pro Tools permet de convertir des réglages de gain 
du clip en automation de volume de piste, et vice 
versa. 

Lors de la conversion des réglages de gain du clip 
en automation de volume, les réglages de gain sont 
coupés du clip, puis collés sur l'automation de 
volume de la piste, aux mêmes emplacements de la 
timeline. 

Lors de la conversion de l'automation de volume de 
piste en gain du clip, l'automation de volume est 
coupée de la playlist d'automation de volume de la 
piste, puis collée sur le clip. Une fois l'automation de 
volume convertie en gain du clip, les réglages de 
gain du clip restent liés au clip lorsque vous le 
déplacez, coupez, copiez ou collez.
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Pour convertir des réglages de gain du clip en 
automation de volume de piste :

1 Sélectionnez un clip ou créez une sélection 
d'édition.

2 Sélectionnez Edit > Automation > Convert Clip 

Gain to Volume Automation.

Pour convertir l'automation de volume de piste en 
gain du clip :

1 Sélectionnez un clip ou créez une sélection 
d'édition.

2 Sélectionnez Edit > Automation > Convert 

Volume to Clip Gain.

Fusion du gain du clip et de 
l'automation de volume de piste
(Pro Tools HD uniquement)

Pro Tools permet de fusionner des réglages de gain 
du clip avec l'automation de volume des pistes, et 
vice versa. 

Lors de la fusion des réglages de gain du clip avec 
l'automation de volume, les réglages de gain sont 
coupés du clip, puis fusionnés avec l'automation de 
volume de piste, aux mêmes emplacements de la 
timeline. 

Lors de la fusion de l'automation de volume de 
piste avec le gain du clip, l'automation de volume 
est coupée de la playlist d'automation de volume 
de piste, puis fusionnée avec les paramètres de 
gain du clip sélectionnés. Une fois l'automation de 
volume fusionnée avec le gain du clip, 
l'automation de volume est définie sur 0 dB pour la 
sélection.

Pour fusionner des paramètres de gain du clip sur 
l'automation de volume de piste :

1 Sélectionnez un clip ou créez une sélection 
d'édition.

2 Sélectionnez Edit > Automation > Coalesce Clip 

Gain to Volume Automation.

Pour fusionner l'automation de volume de piste 
sur les réglages de gain du clip :

1 Sélectionnez un clip ou créez une sélection 
d'édition.

2 Sélectionnez Edit > Automation > Coalesce 

Volume to Clip Gain.

Bypass du gain du clip
Pro Tools permet de mettre en bypass les réglages 
actuels de gain du clip de n'importe quel clip entier 
sélectionné. Cela signifie que vous pouvez écouter 
le clip en ne lui appliquant aucune modification 
de gain, sans perdre vos réglages actuels de gain 
du clip. 

Les réglages de gain du clip supérieurs à +12 dB 
sont perdus lors de la conversion en automation 
de volume. De plus, un fondu enchaîné est 
appliqué entre l'automation de volume et les 
réglages de gain du clip convertis à partir d'une 
zone de fondu enchaîné.

Les réglages de gain du clip supérieurs à +12 dB 
sont perdus lors de la fusion avec l'automation de 
volume. De plus, un fondu enchaîné est appliqué 
entre l'automation de volume et le gain du clip 
d'une zone de fondu enchaîné.
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Pour activer ou désactiver le bypass des réglages 
de gain d'un clip, effectuez l'une des opérations 
suivantes :

 Sélectionnez un ou plusieurs clips entiers, puis 
sélectionnez Clip > Clip Gain > Bypass Clip Gain 
ou Clip > Clip Gain > Unbypass Clip Gain.

 Effectuez un clic droit sur une icône de fader  
de gain du clip, puis sélectionnez 
(ou désélectionnez) Bypass.

 Effectuez un clic droit sur un clip ou une 
sélection d'édition, puis sélectionnez Clip Gain 

> Bypass Clip Gain ou Clip Gain > Unbypass 

Clip Gain.

Le bypass des réglages de gain de tous les clips 
entiers dans la sélection d'édition est alors activé 
(ou désactivé).

Rendu du gain du clip
Pro Tools permet de calculer le rendu des réglages 
actuels de gain du clip d'un clip entier sélectionné. 
Le rendu du gain du clip applique les réglages 
actuels de gain du clip à un nouveau clip, puis 
rétablit les réglages de gain de ce nouveau clip 
sur 0 dB.

Pour calculer le rendu du gain d'un clip, effectuez 
l'une des opérations suivantes :

 Sélectionnez un ou plusieurs clips entiers, puis 
sélectionnez Clip > Clip Gain > Render Clip 

Gain.

 Effectuez un clic droit sur une icône de fader de 
gain du clip, puis sélectionnez Render 

Clip Gain.

 Effectuez un clic droit sur un clip ou une 
sélection d'édition, puis sélectionnez Clip 

Gain > Render Clip Gain.

Le calcul de rendu est effectué pour tous les clips 
entiers dans la sélection d'édition, puis leurs réglages 
de gain du clip sont réinitialisés à 0 dB.

Pour les clips dont les réglages de gain du clip 
sont différents de 0 dB, la commande Prepare 
DPE Tracks (pour DestructivePunch) calcule 
automatiquement le rendu de tous les réglages 
de gain du clip et réinitialise tous les réglages 
de gain du clip à 0 dB.

Lors d'un traitement AudioSuite dans un mode 
AudioSuite générant le rendu du gain du clip, 
tous les réglages de gain du clip sont rendus en 
premier, puis le traitement AudioSuite est 
appliqué. Le gain du clip est réinitialisé à 0 dB 
pour le clip résultant. Toutefois, lorsque vous 
créez des fichiers individuels avec AudioSuite ou 
que vous écrasez les fichiers un clip à la fois, les 
réglages de gain du clip sont conservés. Pour 
plus d'informations, reportez-vous à la section 
« Conditions pour le rendu AudioSuite avec 
poignées, fondus, gain du clip et métadonnées » 
à la page 900.
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Consolidation des clips
De nombreux clips peuvent s'accumuler suite aux 
diverses opérations d'édition. Cependant, 
lorsqu'une piste ou un passage d'une piste 
(un couplet ou un refrain) vous convient, 
vous pouvez consolider ses clips pour n'en créer 
qu'un seul.

Lorsque vous consolidez une piste audio entière ou 
uniquement une sélection d'édition, un nouveau 
fichier audio est écrit. Il correspond à la sélection 
entière avec tous les espaces vierges qu'elle 
contient. 

Lors de la consolidation, les clips mutés sont traités 
comme des zones de silence. En revanche, l'état de 
la commande Mute d'une piste ou la présence d'une 
automation de mute n'a pas d'incidence sur la 
commande Consolidate.

Pour consolider des clips d'une piste :

1 Effectuez l'une des opérations suivantes :

• À l'aide de l'outil de saisie du temps ou du 
Sélecteur, sélectionnez les clips à consolider. 

• Pour sélectionner tous les clips d'une piste, 
cliquez trois fois sur sa playlist avec le Sélecteur.

2 Sélectionnez Edit > Consolidate.

Compactage d'un fichier audio
La commande Compact supprime les parties 
inutilisées des fichiers audio, afin d'économiser de 
l'espace disque et de préparer des sauvegardes plus 
propres. La commande Compact Selected 
supprime également les fichiers audio qui ne sont 
référencés par aucun clip ni aucune piste.

La commande Compact supprime des données 
définitivement et ne doit donc être utilisée que 
lorsque vous avez terminé vos opérations d'édition 
et que vous êtes certain de ne plus avoir besoin de 
l'audio non utilisé.

La commande Compact peut ajouter des marges 
autour des clips du fichier compacté, d'une durée 
définie par l'utilisateur. Si les clips de la session 
utilisent des fondus enchaînés ou si vous souhaitez 
ajouter des marges en prévision d'une opération de 
trimming, entrez la durée correspondante (en 
millisecondes).

Pour compacter un fichier audio :

1 Dans la liste des clips, sélectionnez le ou les 
clips à compacter.

2 Dans le menu de la liste des clips, cliquez sur 
Compact.

3 Entrez la durée en millisecondes que vous 
souhaitez définir pour chaque clip du fichier.

4 Cliquez sur Compact pour compacter le fichier 
ou sur Cancel pour annuler la commande. 

Lorsque la commande Compact a été exécutée, 
la session est automatiquement enregistrée.

La consolidation d'une piste audio ne prend 
pas en compte les données d'automation sous-
jacentes. Pour créer un seul fichier prenant en 
compte les données d'automation, utilisez la 
commande Bounce to Disk (reportez-vous à la 
section « Bounce to Disk » à la page 1133).

Appuyez sur Alt+Maj+3 (Windows) ou 
Option+Maj+3 (Mac) pour activer la 
commande Consolidate.

La commande Compact est destructive et ne 
peut être annulée. Elle modifie définitivement 
les fichiers audio d'origine. Il n'existe aucun 
moyen de restaurer les données supprimées 
par cette commande.



Guide de référence Pro Tools622

Traitement audio avec les 
plug-ins AudioSuite
Les plug-ins AudioSuite livrés avec votre système 
Pro Tools permettent de traiter et de modifier des 
clips audio ainsi que des fichiers audio entiers. 
Ce type d'opération permet d'appliquer un 
traitement AudioSuite spécifique aux clips audio de 
votre session, tel que la normalisation ou la 
suppression de composante continue.

TCE Edit To Timeline 
Selection
(Pro Tools HD uniquement)

Lorsque les sélections d'édition et de timeline sont 
dissociées, vous pouvez compresser ou étirer 
temporellement une sélection audio afin qu'elle 
corresponde à la sélection de timeline. Sur les pistes 
audio, la commande TCE Edit to Timeline Selection 
utilise le plug-in AudioSuite TCE sélectionné dans 
les préférences de traitement (reportez-vous à la 
section « Préférences de traitement » à la page 124). 
Sur les pistes Elastic Audio, la commande TCE Edit 

To Timeline Selection utilise le plug-in Elastic 
Audio sélectionné pour la piste (reportez-vous à la 
section « Plug-ins Elastic Audio » à la page 916).

Pour adapter la durée d'une sélection d'édition 
à celle de la sélection de timeline :

1 Désélectionnez Options > Link Timeline and 

Edit Selection.

2 À l'aide du Sélecteur, sélectionnez les données 
audio à compresser ou à étirer.

3 Sur n'importe quelle règle de base de temps, 
sélectionnez la plage temporelle dans laquelle 
vous voulez inscrire les données audio.

4 Sélectionnez Edit > TCE Edit to Timeline 

Selection. La sélection d'édition est compressée 
ou étirée en fonction de la durée de la sélection 
de timeline.

Commande TCE Edit to Timeline 
Selection sur plusieurs pistes et 
canaux
La commande TCE Edit to Timeline est applicable 
à des sélections multicanal et de plusieurs pistes. 
Tous les clips sont compressés ou étirés de façon 
égale du même pourcentage, basé sur la plage de la 
sélection d'édition. Le timing entre les différents 
canaux ou les différentes pistes est ainsi maintenu.

Adaptation de la durée d'un clip 
audio à celle d'une sélection 
d'édition
Les clips peuvent être déplacés de la liste des clips 
pour s'inscrire dans une sélection d'édition. Le clip 
déplacé est compressé ou étiré en fonction de la 
durée de la sélection. Sur les pistes audio, 
l'ajustement du clip audio à une sélection d'édition 
est effectué à l'aide du plug-in AudioSuite TCE 
sélectionné dans les préférences de traitement 
(reportez-vous à la section « Préférences de 
traitement » à la page 124). Sur les pistes Elastic 
Audio, c'est le plug-in Elastic Audio sélectionné 
pour la piste qui est utilisé (reportez-vous à la 
section « Plug-ins Elastic Audio » à la page 916).

Pour plus d'informations sur les plug-ins 
AudioSuite, reportez-vous au Chapitre 39, 
« Traitement AudioSuite ».
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Pour adapter la durée d'un clip audio à celle d'une 
sélection d'édition :

1 À l'aide du Sélecteur, créez une sélection 
d'édition sur une piste audio.

2 Faites glisser le clip depuis la liste des clips vers 
la piste où vous avez effectué la sélection, en 
maintenant les touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac) enfoncées. Le début 
du clip est placé au début de la sélection, et le 
clip voit sa durée compressée ou étirée pour 
correspondre à celle de la sélection.

Adaptation à la durée d'une 
sélection pour plusieurs pistes 
et canaux
La commande Fit to Selection permet de faire 
glisser plusieurs clips de la liste des clips vers 
plusieurs pistes ou vers des pistes multicanal.

Tous les clips déplacés sont alors compressés ou 
étirés de façon identique, du même pourcentage, 
basé sur la durée du dernier clip sur lequel vous 
avez cliqué avant le déplacement.

Notation des clips
Vous pouvez noter les clips sur une échelle de 1 à 5, 
5 étant la note la plus élevée (la meilleure) et 1 étant 
la note la plus faible. La notation des clips permet 
d'identifier les prises (clips) que vous préférez lors 
du compositing des playlists. Vous pouvez afficher 
ou masquer la notation des clips afin de faciliter la 
création de pistes composites et les tâches d'édition 
courantes. Vous pouvez également afficher ou 
masquer les lignes de playlists en fonction de la 
notation des clips de la playlist (reportez-vous à la 
section « Filtrage des lignes » à la page 656).

Pour noter un clip :

1 Sélectionnez le clip.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Rating et sélectionnez une 
valeur de 1 à 5. 

• Effectuez un clic droit sur le clip, sélectionnez 
Rate, puis une valeur de 1 à 5. 

Pour afficher la notation des clips :

 Sélectionnez View > Clip > Rating.

Pour masquer la notation des clips :

 Désélectionnez View > Clip > Rating.

Vous pouvez noter des clips sélectionnés 
en cours de lecture en appuyant sur 
Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac), puis en 
saisissant la note (de 1 à 5) sur le pavé 
numérique.

Notation affichée sur un clip
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Chapitre 28 : Fondus et fondus enchaînés

Pro Tools calcule les fondus et fondus enchaînés 
dans la RAM en temps réel. Vous pouvez 
appliquer facilement et rapidement un fondu 
d'entrée ou de sortie sur un clip audio, ainsi que des 
fondus enchaînés sur des clips audio adjacents. 
Un fondu enchaîné consiste à fondre deux clips 
audio pour éviter les clics ou les changements de 
niveau soudains. Les fondus enchaînés trouvent de 
nombreuses applications, du « lissage » des 
transitions entre clips à la création d'effets 
spéciaux. Vous pouvez définir la durée, la position 
et la forme des fondus enchaînés. 

À propos des fondus 
enchaînés et des courbes
Pour créer un fondu enchaîné entre deux clips, 
utilisez le Sélecteur pour sélectionner à la fois le 
point de fin du premier clip et le point de début du 
second. C'est la durée de cette sélection qui 
détermine celle du fondu enchaîné. Bien que les 
fondus apparaissent comme des clips à part entière, 
ils ne peuvent en réalité être séparés des clips à partir 
desquels ils ont été créés. Vous pouvez toutefois 
créer des fondus d'entrée et de sortie pour des clips 
individuels (reportez-vous à la section « Création de 
fondus au début et à la fin des clips » à la page 633).

La boîte de dialogue Fades permet de sélectionner, 
visualiser et manipuler les courbes utilisées pour 
les fondus et fondus enchaînés. Vous pouvez 
affecter différentes co urbes de niveau aux portions 
de fondu d'entrée et de sortie d'un fondu enchaîné. 
La boîte de dialogue Fades permet également 
d'écouter un fondu ou un fondu enchaîné avant 
de l'appliquer.

Le type de sélection effectué détermine le 
caractère du fondu enchaîné.

Fondu enchaîné standard (centré)

Ce type de sélection crée un fondu enchaîné des 
deux côtés du point de raccord, et affecte le volume 
des clips 1 et 2. Il s'agit du type de fondu enchaîné 
le plus courant.

Ce type de fondu enchaîné implique que le clip 1 
contienne des données audio au-delà de son point 
de fin et que le clip 2 en contienne également avant 
son point de début.

Étant donné que les fondus enchaînés sont 
créés à partir de contenus audio qui se 
chevauchent, il est impossible d'effectuer un 
fondu enchaîné sur des clips ne contenant pas 
de données audio au-delà de leurs limites.

Si un clip fait référence à une quantité de 
données insuffisante pour appliquer le fondu 
ou fondu enchaîné sélectionné, vous êtes invité 
à ignorer ces fondus ou à ajuster les limites de 
la sélection.

Fondu enchaîné centré

clip 2clip 1

Courbe de fondu 
de sortie

Point de 
raccord Courbe de fondu d'entrée

Plage de fondu enchaîné
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Pré-fondu enchaîné

Ce type de sélection crée un fondu enchaîné avant 
le point de raccord. Cela permet de conserver le 
volume du tout début du clip 2 au lieu de lui 
appliquer un fondu, ce qui est utile lorsque vous 
souhaitez conserver une attaque forte. Lorsque 
vous effectuez des sélections de fondus enchaînés 
intervenant sur le bord de deux clips, vous pouvez 
utiliser la touche de tabulation pour déplacer le 
curseur exactement au début ou à la fin d'un clip.

Ce type de fondu enchaîné implique que le clip 2 
contienne des données audio avant son point de 
début.

Post-fondu enchaîné

Ce type de sélection crée un fondu enchaîné après 
le point de raccord. Il est utile lorsque vous 
souhaitez conserver l'amplitude du clip 1 jusqu'à 
sa fin. Lorsque vous effectuez des sélections de 
fondus enchaînés intervenant sur le bord de deux 
clips, vous pouvez utiliser la touche de tabulation 
pour déplacer le curseur exactement au début ou 
à la fin d'un clip.

Ce type de fondu enchaîné implique que le clip 1 
contienne des données audio au-delà de son point 
de fin.

Vue Overlapping Crossfades
Pro Tools  permet de visualiser le chevauchement 
des formes d'onde dans un fondu enchaîné. 

Pour afficher (ou masquer) le chevauchement des 
fondus enchaînés :

 Sélectionnez (ou désélectionnez) View > 

Waveform > Overlapping Crossfades.

Pré-fondu enchaîné

clip 2clip 1 clip 2clip 1

Point de raccord

Plage de fondu enchaîné

Post-fondu enchaîné

Vue Overlapping Crossfades

clip 2clip 1

Point de raccord

Plage de fondu enchaîné
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Boîte de dialogue Fades
La boîte de dialogue Fades, ouverte avec la 
commande Edit > Fades, permet de sélectionner, 
visualiser et manipuler les fondus et fondus 
enchaînés et de modifier les courbes 
correspondantes. Les fondus d'entrée sont 
caractérisés par les paramètres In Shape et ceux de 
sortie par les paramètres Out Shape.

Les commandes de la boîte de dialogue Fades sont 
les suivantes :

Écoute

Cliquez sur ce bouton pour écouter les fondus. 
Pro Tools prend en charge l'écoute des fondus 
directement depuis les sorties de l'interface audio.

Affichage de la première piste (fondus enchaînés 
uniquement)

Si vous appliquez un fondu enchaîné sur plus d'une 
piste, ce bouton permet de visualiser et d'écouter 
l'aperçu audio de la première piste d'une paire de 
pistes adjacentes.

Affichage de la seconde piste (fondus enchaînés 
uniquement)

Si vous appliquez un fondu enchaîné sur plus d'une 
piste, ce bouton permet de visualiser et d'écouter 
l'aperçu audio de la seconde piste d'une paire de 
pistes adjacentes.

Affichage des deux pistes (fondus enchaînés 
uniquement)

Ce bouton permet d'afficher les formes d'onde des 
deux premières pistes adjacentes pour un fondu 
enchaîné sur plusieurs pistes. 

Boîte de dialogue Fades, fondu de sortie

Boîte de dialogue Fades, fondu enchaîné
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Courbes de fondu uniquement. 

Cliquez sur ce bouton pour afficher les courbes de 
fondu spécifiées sans visualisation des formes 
d'onde audio. Il s'agit de la vue par défaut lorsque 
vous ouvrez la boîte de dialogue Fades.

Courbes de fondu et formes d'onde séparées. 

Cliquez sur ce bouton pour afficher les courbes de 
fondu spécifiées ainsi que des vues séparées des 
formes d'onde des fondus d'entrée et de sortie.

Courbes de fondu et formes d'onde 
superposées. 

Cliquez sur ce bouton pour afficher les courbes de 
fondu spécifiées ainsi que des vues superposées 
des formes d'onde des fondus d'entrée et de sortie. 

Courbes de fondu et formes d'onde sommées. 

Ce bouton permet d'afficher les courbes de fondu 
spécifiées ainsi qu'une seule forme d'onde 
représentant la sommation de l'audio du fondu 
enchaîné.

Zoom avant. 

Cliquez sur ce bouton pour agrandir l'échelle de la 
vue de l'amplitude de la forme d'onde. Maintenez 
la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez pour rétablir l'échelle par 
défaut.

Zoom arrière. 

Cliquez sur ce bouton pour réduire l'échelle de la 
vue de l'amplitude de la forme d'onde. Maintenez 
la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez pour rétablir l'échelle par 
défaut.

Paramètres de la forme du fondu 
de sortie
La section Out Shape permet de définir la forme du 
fondu de sortie appliqué à un clip pour un fondu, 
ou au clip 1 pour un fondu enchaîné. 

Standard : sélectionne une courbe de fondu unique 
et continue. Le fondu créé peut ensuite être édité en 
faisant glisser la courbe elle-même.

Forme de fondu de sortie
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S-Curve : sélectionne une courbe en S, dont les 
caractéristiques s'inversent au début et à la fin. Un 
fondu de sortie plus rapide au début de la courbe et 
plus lent à la fin peut par exemple être créé avec ce 
type de courbe. Les courbes en S sont utiles avec 
les données sur lesquelles les fondus enchaînés 
sont difficiles à réaliser. Les courbes en S peuvent 
être éditées en faisant glisser la courbe dans 
l'éditeur de courbes.

Presets de courbes : sept presets de courbes sont 
à votre disposition pour faciliter la création rapide 
de fondus enchaînés. Ces presets peuvent être 
édités en faisant glisser le point de fin de la courbe 
dans l'éditeur de courbe de cette boîte de dialogue. 
Ces sept presets sont les suivants :

 Le preset de courbe 1 maintient le volume au 
maximum pendant toute la durée du fondu, puis le 
réduit immédiatement à la fin du fondu.

 Le preset de courbe 2 applique un fondu de 
sortie relativement lent, en conservant un niveau 
de volume relativement élevé pendant toute la 
durée du fondu.

 Le preset de courbe 3 applique un fondu de 
sortie légèrement plus rapide, en conservant un 
niveau de volume un peu moins élevé pendant le 
fondu.

 Le preset de courbe 4 applique un fondu de 
sortie linéaire. Il s'agit de la courbe par défaut.

 Le preset de courbe 5 applique un fondu de 
sortie rapide au début du fondu enchaîné.

 Le preset de courbe 6 fait chuter le niveau du 
volume encore plus rapidement au début du fondu.

 Le preset de courbe 7 coupe intégralement le 
son de l'audio au début du fondu.

Preset de courbe 1

Preset de courbe 2

Preset de courbe 3

Preset de courbe 4

Preset de courbe 5

Preset de courbe 6

Preset de courbe 7
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Paramètres de liaison
(Fondus enchaînés uniquement)

Le paramètre Link lie les courbes sélectionnées 
pour les fondus d'entrée et de sortie d'un fondu 
enchaîné. Si vous modifiez l'une des courbes, 
l'autre est également modifiée. Cette liaison 
garantit un fondu enchaîné résultant caractérisé par 
une puissance constante ou un gain constant, 
suivant l'option sélectionnée.

Equal Power : cette option est recommandée pour 
les données dont la phase n'est pas cohérente, 
comme dans le cas d'un fondu enchaîné entre deux 
types d'éléments complètement différents. Utilisez 
cette option pour éviter la chute de niveau qui peut 
se produire avec un fondu enchaîné de gain égal. 
Avec ce type de fondu, vous pouvez maintenir la 
touche Alt (Windows) ou Option (Mac) enfoncée 
et cliquer sur la courbe de fondu pour la rétablir sa 
forme par défaut.

Equal Gain : cette option est recommandée pour 
les données qui sont cohérentes en phase ou 
presque, comme dans le cas d'un fondu enchaîné 
entre deux clips ou instruments identiques (une 
boucle de batterie répétée, par exemple). Utilisez 
cette option pour éviter l'écrêtage qui peut se 
produire avec un fondu enchaîné de puissance 
égale. Avec ce type de fondu, vous pouvez 
maintenir la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquer sur la courbe de fondu 
pour la rétablir sa forme par défaut.

None : cette option désactive la liaison entre les 
courbes de fondu d'entrée et de sortie, ce qui 
permet de les ajuster séparément, notamment leurs 
points de début et de fin. Elle permet de créer des 
formes de fondu enchaîné personnalisées. 

Lorsque le paramètre Link est défini sur Equal 
Power ou Equal Gain, vous pouvez éditer le fondu 
d'entrée de la courbe en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée et en faisant 
glisser votre souris. Pour éditer uniquement le 
fondu de sortie de la courbe, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée et 
faites glisser votre souris.

Paramètres de la forme du fondu 
d'entrée
La section In Shape permet de définir la forme du 
fondu d'entrée appliqué à un clip pour un fondu, ou 
au clip 2 pour un fondu enchaîné. 

Standard : sélectionne une courbe de fondu unique 
et continue. Le fondu créé peut ensuite être édité 
en faisant glisser la courbe elle-même.

S-Curve : sélectionne une courbe en S, dont les 
caractéristiques s'inversent au début et à la fin. Un 
fondu d'entrée plus rapide au début de la courbe et 
plus lent à la fin peut par exemple être créé avec ce 
type de courbe. Les courbes en S sont utiles avec 
les données sur lesquelles les fondus sont difficiles 
à réaliser. Les courbes en S peuvent être éditées en 
faisant glisser la courbe dans l'éditeur de courbes.

Liaison des fondus

Ajustement du point de fin d'une courbe de fondu
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Presets de courbes : sept presets de courbes sont 
à votre disposition pour faciliter la création rapide 
de fondus. Ces presets peuvent être édités en 
faisant glisser le point de fin de la courbe dans 
l'éditeur de courbe de cette boîte de dialogue. Ces 
sept presets sont les suivants :

 Le preset de courbe 1 applique un fondu 
d'entrée instantané et à plein volume dès le début et 
maintient ce volume sur toute la durée du fondu.

 Le preset de courbe 2 applique un fondu 
d'entrée rapide, pour atteindre l'amplitude 
maximale relativement tôt dans la courbe 
de fondu.

 Le preset de courbe 3 applique un fondu 
d'entrée relativement rapide.

 Le preset de courbe 4 applique un fondu 
d'entrée linéaire. Il s'agit de la courbe par défaut.

 Le preset de courbe 5 applique un fondu 
d'entrée lent au début du fondu.

 Le preset de courbe 6 applique un fondu 
d'entrée encore plus lent que la courbe précédente.

 Le preset de courbe 7 coupe intégralement le 
son de l'audio jusqu'à la fin du fondu.

Preset de courbe 1

Preset de courbe 2

Preset de courbe 3

Preset de courbe 4

Preset de courbe 5

Preset de courbe 6

Preset de courbe 7
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Combinaisons classiques de 
courbes
Vous trouverez ci-après les combinaisons 
possibles de courbes de fondu d'entrée et de sortie.

Fondu enchaîné linéaire : il s'agit d'un fondu 
enchaîné polyvalent, créant une transition douce et 
progressive entre les clip 1 et 2.

Fondu enchaîné à puissance constante : il s'agit 
d'un fondu enchaîné polyvalent qui est utile 
lorsqu'un fondu enchaîné linéaire semble créer une 
chute notable de niveau au point de raccord.

Fondu avec recouvrement : cette combinaison de 
courbes maintient les deux clips à une amplitude 
maximale pendant toute la durée du fondu 
enchaîné : le niveau du clip 2 monte instantanément 
jusqu'au maximum dès le début, et celui du clip 1 
effectue le mouvement inverse en fin de fondu.

Préférences des fondus et 
fondus enchaînés
Vous pouvez configurer les paramètres par défaut 
des fondus et fondus enchaînés. Ces paramètres 
sont chargés en tant que paramètres « de base » 
lorsque vous utilisez la commande Create Fades, 
ainsi que les commandes Fade to Start et Fade to 
End.

Pour configurer les préférences de fondu et de 
fondu enchaîné :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Editing.

2 Définissez les durées de pré-roll et de post-
roll pour l'aperçu des fondus.

3 Cliquez sur Fade In, configurez la forme par 
défaut des fondus d'entrée créés avec l'outil 
Smart, puis cliquez sur OK.

Fondu enchaîné linéaire

Fondu enchaîné à puissance constante

1. Sortie 2. Entrée

1. Sortie 2. Entrée

Fondu enchaîné avec recouvrement

Préférences de fondu

1. Sortie 2. Entrée
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4 Cliquez sur Fade Out, configurez la forme par 
défaut des fondus de sortie créés avec l'outil 
Smart, puis cliquez sur OK.

5 Cliquez sur Crossfade, configurez la forme par 
défaut des fondus enchaînés créés avec l'outil 
Smart, puis cliquez sur OK.

6 Cliquez sur OK.

Création de fondus au début 
et à la fin des clips
Pro Tools permet de créer des fondus d'entrée et de 
sortie en début et en fin de clip. 

Sur Pro Tools HD, vous pouvez également utiliser 
une option de fondu automatique d'entrée et de 
sortie, qui permet d'appliquer automatiquement des 
fondus d'entrée ou de sortie en temps réel à tous les 
clips en cours de lecture. Pour plus d'informations, 
reportez-vous à la section « Utilisation des fondus 
automatiques » à la page 637.

Création de fondus d'entrée et 
de sortie
Suivant la manière dont vous créez la sélection, vous 
pouvez placer un fondu d'entrée ou de sortie 
exactement au début ou à la fin d'un clip, ou de façon 
à ce qu'il déborde sur une zone vierge de la piste. La 
longueur de la sélection sur le clip détermine la durée 
du fondu d'entrée ou de sortie.

Vous pouvez également appliquer un fondu 
jusqu'au début ou à la fin d'un clip à partir d'un 
point d'insertion.

Bien que les fondus apparaissent comme des clips 
à part entière, ils ne peuvent pas être séparés des 
clips à partir desquels ils ont été créés. 

Lorsque le tempo est modifié, les fondus d'entrée 
et de sortie d'une piste audio basée sur les 
références de tempo demeurent avec leurs clips 
parents. Les fondus conservent leur durée absolue 
et sont recalculés après les changements de tempo.

Pour créer un fondu d'entrée :

1 Sélectionnez le début du clip sur lequel 
vous souhaitez créer le fondu d'entrée. 
La sélection doit s'étendre jusqu'au début exact 
du clip ou jusqu'à une zone vierge de la piste en 
amont du clip.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Create. 

• Appuyez sur Ctrl+F (Windows) ou 
Commande+F (Mac).

3 Sélectionnez la courbe de fondu d'entrée et 
configurez les autres paramètres du fondu.

4 Cliquez sur le bouton d'écoute pour obtenir un 
aperçu du résultat.

Pour appliquer la forme par défaut de fondu 
ou de fondu enchaîné, créez une sélection 
d'édition, puis appuyez sur Ctrl+Démarrer+F 
(Windows) ou Commande+Ctrl+F (Mac).

Clip avec fondu d'entrée

Sélection du début d'un clip pour la création d'un 
fondu d'entrée

Pour appliquer le fondu d'entrée par défaut 
(configuré dans la page des préférences 
d'édition), et sans ouvrir la boîte de dialogue 
Fades, appuyez sur Ctrl+Démarrer+F 
(Windows) ou Commande+Ctrl+F (Mac).
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5 Ajustez la courbe en la faisant glisser ou en 
choisissant une forme différente dans le menu 
des formes de fondu d'entrée In Shape.

6 Cliquez sur OK. 

La courbe de fondu sélectionnée apparaît sur le clip.

Pour créer un fondu de sortie :

1 Sélectionnez la fin du clip sur lequel vous voulez 
appliquer un fondu de sortie. La sélection doit 
s'étendre jusqu'à la fin exacte du clip ou jusqu'à 
une zone vierge de la piste, après le clip.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Create. 

• Appuyez sur Ctrl+F (Windows) ou 
Commande+F (Mac).

3 Sélectionnez la courbe de fondu de sortie et 
configurez les autres paramètres du fondu.

4 Cliquez sur le bouton d'écoute pour obtenir un 
aperçu du résultat.

5 Ajustez la courbe en la faisant glisser ou en 
choisissant une forme différente dans le menu 
des formes de fondu de sortie Out Shape.

6 Cliquez sur OK. 

Pro Tools calcule alors le fondu et la courbe de 
fondu sélectionnée apparaît sur le clip.

Pour appliquer un fondu depuis le point 
d'insertion jusqu'au point de début d'un clip :

1 Placez le curseur à l'emplacement désiré dans le 
clip.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Fade To Start.

• Appuyez sur Alt+D (Windows) ou Ctrl+D (Mac).

Le fondu est alors appliqué conformément aux 
préférences de fondu d'entrée (reportez-vous à la 
section « Préférences des fondus et fondus 
enchaînés » à la page 632).

Pour appliquer un fondu depuis le point 
d'insertion jusqu'au point de fin d'un clip :

1 Placez le curseur à l'emplacement désiré dans 
le clip.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Fade To End.

• Appuyez sur Alt+G (Windows) ou Ctrl+G (Mac).

Le fondu est alors appliqué conformément aux 
préférences de fondu de sortie (reportez-vous à la 
section « Préférences des fondus et fondus 
enchaînés » à la page 632).

Sélection de la fin d'un clip pour la création d'un fondu 
de sortie

Pour appliquer le fondu de sortie par défaut 
(configuré dans la page des préférences 
d'édition), et sans ouvrir la boîte de dialogue 
Fades, appuyez sur Ctrl+Démarrer+F 
(Windows) ou Commande+Ctrl+F (Mac).

Les durées des fondus peuvent être ajustées 
à l'aide de l'un des outils de trim, dont les 
commandes de trim par incrément. Reportez-
vous aux sections « Utilisation des outils de 
trim » à la page 558 et « Trim par incrément » 
à la page 606.
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Création d'un fondu enchaîné
Pour créer un fondu enchaîné entre deux clips :

1 Cliquez avec le Sélecteur sur le point où vous 
souhaitez que commence le fondu enchaîné 
dans le premier clip et faites glisser votre souris 
jusqu'au point du second clip où vous souhaitez 
qu'il se termine. Les sélections de fondu 
enchaîné peuvent commencer et se terminer 
n'importe où dans leurs clips respectifs.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Create.

• Appuyez sur Ctrl+F (Windows) ou 
Commande+F (Mac).

3 Utilisez les boutons de vue pour ajuster 
l'affichage du fondu enchaîné. Le calcul de 
l'affichage de la forme d'onde peut demander 
quelques instants lorsque les sélections sont 
longues.

4 Sélectionnez une forme de sortie (Out Shape) et 
une forme d'entrée (In Shape).

5 Sélectionnez une option de liaison (Linking).

6 Cliquez sur le bouton d'écoute pour obtenir un 
aperçu du résultat. Pour les longs fondus 
enchaînés, Pro Tools peut prendre quelques 
instants pour calculer et charger les données 
audio dans la RAM de lecture. 

7 Effectuez l'une des opérations suivantes :

• Ajustez les courbes en sélectionnant des presets 
de forme différents dans les menus Out Shape et 
In Shape.

• Faites glisser les courbes de fondu d'entrée et de 
sortie pour personnaliser la forme. Si vous 
sélectionnez None comme option de liaison, 
vous pouvez déplacer et ajuster les points de 
début ou de fin d'une courbe de fondu.

8 Cliquez sur le bouton d'écoute pour obtenir un 
aperçu du résultat.

9 Lorsque le fondu enchaîné vous convient, 
cliquez sur OK. 

Pour supprimer un fondu enchaîné, effectuez l'une 
des opérations suivantes :

 Sélectionnez la partie de la piste contenant les 
fondus enchaînés à supprimer, puis sélectionnez 
Edit > Fades > Delete. 

 Sélectionnez le fondu enchaîné avec l'outil de 
saisie du temps, puis appuyez sur la touche 
Retour arrière (Windows) ou Suppr (Mac). 

 Sélectionnez un outil d'édition, effectuez un clic 
droit sur le fondu enchaîné à supprimer, puis 
sélectionnez Delete Fades dans le menu 
contextuel. 

Pour appliquer le fondu enchaîné par défaut 
(configuré dans la page des préférences 
d'édition), et sans ouvrir la boîte de dialogue 
Fades, appuyez sur Ctrl+Démarrer+F 
(Windows) ou Commande+Ctrl+F (Mac).

Les durées des fondus enchaînés peuvent être 
ajustées à l'aide de l'un des outils de trim, dont 
les commandes de trim par incrément. 
Reportez-vous aux sections « Utilisation des 
outils de trim » à la page 558 et « Trim par 
incrément » à la page 606.
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Pour effectuer un trim sur un fondu enchaîné :

1 Sélectionnez le fondu enchaîné avec l'outil de 
saisie du temps ou en double-cliquant dessus 
avec le Sélecteur.

2 À l'aide d'un outil de trim, ajustez la position de 
l'une des extrémités du fondu enchaîné. Le 
fondu enchaîné est recalculé pour refléter la 
nouvelle durée après l'opération de trim.

Fondus enchaînés sur des pistes 
audio basées sur les références 
de tempo
Un nouveau rendu des fondus enchaînés est 
calculé en cas de modification du tempo sur une 
piste audio basée sur les références de tempo. 
La durée du nouveau fondu enchaîné est identique 
à celle qu'il avait avant le changement de tempo. 

Si la quantité de données audio est insuffisante 
pour appliquer le fondu enchaîné, ou si la zone du 
nouveau fondu enchaîné sort des limites de clips 
valides, le fondu enchaîné est supprimé.

Sélections de pré/post fondu 
enchaîné
En créant une sélection qui commence ou se 
termine précisément sur la limite séparant deux 
clips, vous pouvez créer des pré ou post fondus 
enchaînés. Utilisez la touche de tabulation pour 
placer le point d'insertion exactement au début ou 
à la fin d'un clip.

Pour créer un pré ou post fondu enchaîné :

1 À l'aide du Sélecteur, cliquez sur la piste 
contenant les clips entre lesquels vous souhaitez 
appliquer le fondu enchaîné.

2 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche de tabulation pour 
avancer à la limite de clip suivante. 

• Pour revenir à la limite de clip précédente, 
appuyez sur Ctrl+Tab (Windows) ou 
Option+Tab (Mac).

3 Étendez la sélection de l'une des manières 
suivantes :

• Pour ajuster votre sélection, maintenez la touche 
Maj enfoncée et faites glisser votre souris, ou 
appuyez sur Maj+Tab pour étendre la sélection 
jusqu'à la limite de clip suivante. 

• Pour étendre la sélection à la limite de clip 
précédente, appuyez sur Ctrl+Maj+Tab 
(Windows) ou Option+Maj+Tab (Mac).

4 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Create.

• Appuyez sur Ctrl+F (Windows) ou 
Commande+F (Mac).

5 Sélectionnez un type de fondu et cliquez sur OK.



Chapitre 28 : Fondus et fondus enchaînés 637

Utilisation des fondus 
automatiques
(Pro Tools HD uniquement)

Pro Tools HD permet d'appliquer des fondus 
d'entrée et de sortie en temps réel à toutes les 
limites de clip d'une session en lecture. Indiquez la 
durée (de 0 à 10 ms) des fondus automatiques en 
temps réel à l'aide de l'option Auto Clip Fade In/Out 
Length des préférences de fonctionnement. Ces 
fondus d'entrée et de sortie sont appliqués en cours 
de lecture et n'apparaissent pas dans la fenêtre Edit.

L'option de fondu automatique a également un 
effet sur l'emprunt des voix dans une session. 
Dès qu'aucune donnée n'est présente sur une piste 
de priorité supérieure, sa voix peut être empruntée 
par une piste de priorité inférieure ; des fondus 
d'entrée et de sortie sont alors appliqués lors des 
transitions.

Cette fonction est particulièrement utile dans les 
situations de post-production telles que 
l'enregistrement de dialogues. Vous pouvez par 
exemple assigner une même voix à une piste de 
dialogue et à une piste ne contenant que des bruits 
d'ambiance correspondants. Vous pouvez ensuite 
configurer l'option AutoFade sur une durée 
modérée (4 ms environ), afin qu'à chaque silence 
sur la piste de dialogue, la lecture bascule 
doucement sur la piste d'ambiance, puis revienne 
à la piste de dialogue sans aucun clic ou pop.

L'utilisation des fondus automatiques d'entrée et de 
sortie évite les tâches fastidieuses d'édition aux 
points de passages à zéro ou le rendu de nombreux 
fondus pour éliminer les clics ou les pops en 
lecture. Toutefois, ces clics sont toujours présents 
dans le fichier son d'origine. Ces anomalies seront 
donc encore audibles si vous utilisez le plug-in 
AudioSuite Duplicate ou la commande Export 
Clips As Files (à partir de la liste des clips) pour 
dupliquer plusieurs clips sous la forme d'un fichier 
continu. Pour calculer le rendu de ces fondus 
automatiques en temps réel, sélectionnez File > 
Bounce to > Disk.

Pour configurer la durée des fondus automatiques 
d'entrée et de sortie :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2 Entrez une valeur comprise entre 0 et 10 ms 
dans le champ Clip Auto Fade In/Out Length. 
La valeur zéro (par défaut) indique l'absence de 
fondu automatique.

3 Cliquez sur OK. La valeur de l'option AutoFade 
est enregistrée avec la session et appliquée 
automatiquement à toutes les limites des clips 
présents sur les pistes, jusqu'à ce qu'elle soit 
modifiée.

Les fondus automatiques ne sont pas 
appliqués aux traitements AudioSuite.
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Création de fondus et fondus 
enchaînés par lots
La boîte de dialogue Batch Fades permet de créer 
plusieurs fondus simultanément. Créez une 
sélection englobant plusieurs clips, puis utilisez 
la commande Create Fades pour créer des fondus 
enchaînés à chaque transition entre des clips. 
Si votre sélection inclut des clips dans lesquels se 
trouvent déjà des fondus enchaînés, vous pouvez 
alors les modifier.

Pour appliquer des fondus enchaînés entre 
plusieurs clips :

1 À l'aide du Sélecteur, cliquez sur le premier clip 
sur lequel vous voulez créer un fondu enchaîné. 
Assurez-vous le clip entier soit inclus dans la 
sélection.

2 Cliquez et faites glisser le Sélecteur pour 
étendre la sélection de manière à inclure le 
dernier clip sur lequel vous voulez créer un 
fondu enchaîné. Assurez-vous le clip entier soit 
inclus dans la sélection.

3 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Fades > Create.

• Appuyez sur Commande+F (Mac) ou Ctrl+F 
(Windows).

4 La boîte de dialogue Batch Fades permet de créer 
des fondus (Create New Fades), de créer des 
fondus d'entrée et de sortie (Create New Fade-Ins 
& Outs), d'ajuster des fondus existants (Adjust 
Existing Fades) ou d'effectuer plusieurs de ces 
opérations à la fois. 

Si vous choisissez de créer des fondus et des 
fondus d'entrée et de sortie, de nouveaux fondus 
enchaînés sont créés à chaque limite de clip bordée 
par un autre clip sélectionné, un fondu d'entrée est 
créé au début du premier clip et un fondu de sortie 
est créé à la fin du dernier clip.

5 Spécifiez la position des fondus : Pre-Splice 
(avant le point de raccord), Centered (centrés) ou 
Post-Splice (après le point de raccord). Reportez-
vous à la section « À propos des fondus enchaînés 
et des courbes » à la page 625. 

6 Entrez une durée de fondu enchaîné en 
millisecondes.

7 Cliquez sur OK. 

Pro Tools crée alors les fondus sur tous les clips 
sélectionnés.

Clips sélectionnés pour la création de fondus par lots

Boîte de dialogue Batch Fades

Les durées des fondus peuvent être ajustées 
à l'aide de l'un des outils de trim, dont les 
commandes de trim par incrément. Reportez-
vous aux sections « Utilisation des outils de 
trim » à la page 558 et « Trim par incrément » 
à la page 606.
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Déplacement et déplacement 
par incrément des fondus et 
fondus enchaînés
Les fondus et les fondus enchaînés peuvent être 
déplacés de manière classique ou par incrément sur 
les pistes, indépendamment des clips parents. De 
l'audio des clips parents est révélé ou masqué lors 
du déplacement simple ou par incrément de fondus 
d'entrée ou de sortie. Le point de chevauchement 
entre deux clips est également déplacé suite au 
déplacement simple ou par incrément de fondus 
enchaînés. Le déplacement de fondus est enfin 
restreint par les limites de clip sous-jacentes.

Déplacement classique ou par 
incrément des fondus ou fondus 
enchaînés dans les clips

Pour déplacer un fondu un fondu enchaîné dans 
les clips parents :

1 Sélectionnez le fondu ou fondu enchaîné 
à déplacer en procédant comme suit :

• Sélectionnez l'outil de saisie du temps pour 
sélectionner le fondu.

• Sélectionnez une plage de données incluant le 
fondu à l'aide du Sélecteur.

2 Déplacez le fondu en effectuant l'une des 
opérations suivantes :

• Faites glisser le fondu vers un nouvel 
emplacement sur la piste à l'aide de l'outil de 
saisie du temps.

• Déplacez le fondu par incrément sur la piste en 
appuyant sur les touches Plus (+) ou Moins (–) 
du pavé numérique.

Déplacement de clips contenant 
des fondus ou des fondus 
enchaînés
Lorsque vous déplacez une sélection de clips 
contenant un fondu d'entrée, un fondu de sortie ou 
un fondu enchaîné, le fondu est déplacé avec la 
sélection.

Pour déplacer une sélection de clip contenant des 
fondus ou des fondus enchaînés :

1 Effectuez l'une des opérations suivantes :

• À l'aide de l'outil de saisie du temps, cliquez sur 
un clip (ou double-cliquez sur un clip à l'aide du 
Sélecteur) pour sélectionner le clip ainsi que le 
fondu (d'entrée ou de sortie) correspondant.

• Sélectionnez plusieurs clips contenant les 
fondus et fondus enchaînés à déplacer. 

2 Déplacez la sélection de clip en effectuant l'une 
des opérations suivantes :

• Faites glisser la sélection de clips vers un nouvel 
emplacement de la piste à l'aide de la Main.

Sélection d'un fondu à l'aide de l'outil de saisie du temps

Déplacement d'un fondu à l'aide de l'outil de saisie du 
temps

Nouvelle position du fondu suite à son déplacement
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• Déplacez la sélection de clips par incrément sur 
la piste en appuyant sur les touches Plus (+) ou 
Moins (–) du pavé numérique.

Déplacement par incrément des 
clips adjacents aux fondus 
d'entrée ou de sortie
Lorsque vous déplacez une sélection de clips 
adjacente à un fondu d'entrée ou de sortie sans 
sélectionner le fondu, la durée du fondu augmente 
ou diminue afin de conserver la position du point de 
début ou de fin du fondu. L'étendue du changement 
dépend de la quantité de données audio situées au-
delà du point de début ou de fin du fondu.

Pour déplacer un clip sans son fondu :

1 Sélectionnez le clip sans sélectionner le fondu.

2 Déplacez le clip par incrément en appuyant sur 
les touches Plus (+) ou Moins (–) du pavé 
numérique.

Déplacement de clips adjacents 
à des fondus enchaînés
Lorsque vous déplacez l'un des deux clips 
impliqués dans un fondu enchaîné, les clips 
se séparent. L'état du fondu dépend de la 
configuration de l'option Preserve Fades when 
Editing des préférences d'édition. 

Pour séparer des clips impliqués dans un fondu 
enchaîné et conserver les fondus correspondant :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Editing.

2 Sélectionnez Preserve Fades when Editing.

3 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

4 Utilisez l'outil de saisie du temps ou l'outil de 
séparation pour sélectionner l'un des deux clips 
impliqués dans le fondu enchaîné.

5 Déplacez le clip sélectionné avec la Main.

Déplacement d'un clip et de son fondu

Sélection d'un clip sans son fondu

Déplacement par incrément d'un clip sans son fondu

Sélection d'un clip avec un fondu enchaîné

Séparation de clips et conservation des fondus
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Pour séparer des clips impliqués dans un fondu 
enchaîné et supprimer le fondu :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Editing.

2 Désélectionnez l'option Preserve Fades when 

Editing.

3 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences.

4 Utilisez l'outil de saisie du temps ou l'outil de 
séparation pour sélectionner l'un des deux clips 
impliqués dans le fondu enchaîné.

5 Déplacez le clip sélectionné avec la Main.

Déplacement par incrément de 
clips adjacents à des fondus 
enchaînés
Lorsque vous déplacez par incrément l'un des deux 
clips impliqués dans un fondu enchaîné, le fondu 
s'étend afin de conserver la position relative des 
points de début et de fin du fondu enchaîné. La 
quantité d'extension dépend de la longueur du 
chevauchement entre les deux clips. 

Si le déplacement par incrément du clip s'étend au-
delà des données audio disponibles pour le fondu 
enchaîné, le fondu est supprimé.

Pour déplacer un clip par incrément et étendre le 
fondu enchaîné correspondant :

1 Utilisez l'outil de saisie du temps pour 
sélectionner l'un des deux clips impliqués dans 
le fondu enchaîné.

2 Déplacez le clip par incrément en appuyant sur 
les touches Plus (+) ou Moins (–) du pavé 
numérique.

Sélection d'un clip avec un fondu enchaîné

Séparation de clips et conservation des fondus

Sélection d'un clip avec un fondu enchaîné

Extension du fondu enchaîné suite à un déplacement 
par incrément
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Séparation de clips incluant 
des fondus ou des fondus 
enchaînés
Vous pouvez créer des clips à partir de données de 
piste se chevauchant à l'aide de fondus ou de fondus 
enchaînés. Si l'option Preserve Fades when Editing 
est activée dans les préférences d'édition, les fondus 
du clip source sont ajustés au nouveau clip.

Pour séparer un clip contenant un fondu ou un 
fondu enchaîné :

1 Cliquez avec le Sélecteur et faites glisser votre 
souris pour sélectionner les données du nouveau 
clip.

2 Sélectionnez Edit > Separate Clip > At Selection.

Un trim est appliqué à tout fondu d'entrée ou de 
sortie sur lequel la sélection s'étend, pour adapter 
sa durée à la sélection.

Si votre sélection s'étend sur un fondu enchaîné, 
il est séparé en un fondu de sortie et un fondu 
d'entrée au niveau de la limite de la sélection.

Sélection de données chevauchant un fondu d'entrée

Effet de l'utilisation de la commande Separate Clip sur 
un fondu d'entrée

Sélection de données chevauchant un fondu enchaîné

Effet de l'utilisation de la commande Separate Clip sur 
un fondu enchaîné

Si l'option Preserve Fades when Editing n'est 
pas activée dans les préférences d'édition, 
tous les fondus inclus dans la sélection sont 
effacés lors d'une édition.
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Opérations de trim sur des 
clips incluant des fondus ou 
des fondus enchaînés
Vous pouvez effectuer un trim sur des clips qui 
incluent des fondus ou fondus enchaînés.

Trim d'un clip au niveau d'une 
limite de fondu
Vous pouvez effectuer une opération de trim sur 
des clips adjacents à des limites de fondu et de 
fondu enchaîné. 

Pour effectuer un trim sur un clip au niveau d'une 
limite de fondu :

 À l'aide de l'outil de trim, cliquez sur la limite de 
clip, puis faites glisser votre souris pour ajuster 
la position de la limite. Le fondu suit la nouvelle 
limite de clip et sa durée reste constante.

Trimming sur une sélection 
comprenant des fondus et 
fondus enchaînés
Vous pouvez effectuer une opération de trim sur 
des sélections qui contiennent des fondus ou 
fondus enchaînés.

Pour réaliser une opération de trim sur une 
sélection comprenant des fondus, effectuez l'une 
des opérations suivantes :

 Créez une sélection sur la piste, puis sélectionnez 
Edit > Trim > To Selection. L'opération peut 
s'appliquer à plusieurs clips et fondus. Les fondus 
affectés sont ajustés pour correspondre aux 
nouvelles limites des clips.

 À l'aide du Sélecteur, cliquez sur le clip, puis 
sélectionnez Edit > Trim > Start to Insertion ou 
End to Insertion. L'opération de trim peut 
s'étendre jusqu'à la limite du clip ou du fondu 
sur la piste.

Déplacement d'une limite de clip à l'aide de l'outil de 
trim 

Fondu déplacé suite à l'opération de trim

Opération de trim sur une sélection comprenant 
plusieurs fondus
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Formes et limites de fondu 
affichées en vue 
d'automation
Les limites et formes des fondus sont affichées et 
peuvent être éditées dans les vues d'automation, 
qui permettent une visualisation et une édition plus 
précises des données d'automation. Pour plus 
d'informations sur l'automation et les vues 
d'automation, reportez-vous au Chapitre 45, 
«Automation».

Informations de fondu dans une vue d'automation
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Chapitre 29 : Playlists

La création de playlists est une fonctionnalité 
extrêmement puissante de Pro Tools. Chaque piste 
est associée à une playlist « principale » et à un 
certain nombre de playlists d'édition 
« alternatives ».

Les playlists d'édition sont des « instantanés » d'un 
arrangement des clips d'une piste, et permettent 
d'expérimenter librement différents arrangements, 
puisque vous pouvez toujours revenir sur les 
playlists précédemment sauvegardées.

Une playlist, qui peut contenir un ou plusieurs clips, 
ne peut être assignée à une piste que si elle n'est pas 
déjà utilisée sur une autre piste. Vous pouvez créer 
un nombre pratiquement illimité de playlists 
d'édition partagées entre toutes les pistes. Chaque 
piste possède une playlist d'automation dédiée.

Les playlists d'automation des pistes audio, 
d'entrée auxiliaire, Master Fader et d'instrument 
hébergent les données des commandes de volume, 
de panoramique, de mute et de plug-in. 
Les playlists d'automation des pistes MIDI, 
en revanche, stockent uniquement les informations 
de mute. Les événements de contrôleur continu, 
de changement de programme et Sysex sont 
stockés dans les clips MIDI et, à ce titre, font partie 
des playlists d'édition, à la fois pour les pistes 
MIDI et les pistes d'instrument (reportez-vous au 
Chapitre 45, « Automation »).

Utilisation des playlists
Lors de la création d'une piste, celle-ci ne contient 
qu'une seule et unique playlist vide jusqu'à ce que 
vous y enregistriez, importiez ou déposiez des 
éléments.

De nouvelles playlists, vides ou dupliquées à partir 
de la playlist actuelle, peuvent être créées. Une fois 
une playlist créée, vous pouvez la rappeler, 
la renommer et la supprimer comme vous le 
souhaitez, à l'aide du sélecteur de playlist.

Les playlists nouvelles ou dupliquées sont 
nommées automatiquement selon le modèle 
suivant : nom de la piste, suivi d'un point (.) et du 
numéro de la playlist. La première playlist 
dupliquée d'une piste intitulée « Kick », 
par exemple, est automatiquement nommée 
« Kick.01 », et les playlists dupliquées par la suite 
seront nommées « Kick.02 », « Kick.03 », etc.

Vous pouvez faire glisser des contenus audio 
sur une piste à partir de la liste des clips, des 
navigateurs de l'espace de travail, de 
l'Explorateur Windows ou du Finder Mac.

Sélecteur de playlist
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Création d'une playlist
Vous pouvez créer des playlists vierges pour 
y enregistrer ou y importer des données audio et 
MIDI. Vous pouvez ainsi enregistrer des prises 
audio ou MIDI supplémentaires ou construire de 
nouveaux arrangements.

Pour créer une playlist (vide) :

1 Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez New.

2 Nommez la nouvelle playlist, puis cliquez sur OK. 

Une playlist vide, portant le nom spécifié, apparaît 
alors sur la piste.

Duplication d'une playlist
Lorsque vous éditez une piste, vous pouvez 
travailler sur une copie de la playlist de la piste et 
conserver l'originale intacte.

Pour dupliquer la playlist actuelle d'une piste :

1 Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez Duplicate dans le menu déroulant.

2 Nommez la nouvelle playlist, puis cliquez sur OK. 

La playlist dupliquée apparaît sur la piste, dont le 
nom change pour prendre celui de la nouvelle 
playlist.

Assignation d'une playlist à une 
autre piste
Par défaut, une playlist est disponible uniquement 
pour la piste sur laquelle elle a été créée. Toutefois, 
lorsqu'une playlist n'est plus utilisée sur sa piste 
d'origine ou toute autre piste, elle peut être 
réassignée à une autre piste à l'aide du sous-menu 
Other Playlists. Lorsqu'une playlist a été 
réassignée à une autre piste (quelle que soit la 
piste), elle n'est plus disponible pour les autres 
pistes, y compris sa piste d'origine.

La base de temps d'une playlist audio est 
enregistrée avec la playlist. Lorsque vous assignez 
une playlist non assignée à une piste, la piste prend 
en compte la base de temps enregistrée pour la 
playlist.

Pour assigner une playlist de piste :

 Cliquez sur le sélecteur de playlist et effectuez 
l'une des opérations suivantes :

• Sélectionnez l'une des playlists de la piste.

• Sélectionnez une playlist à partir d'une autre 
piste en cliquant sur le sous-menu Other 
Playlists.

La playlist sélectionnée apparaît sur la piste, le 
nom de la piste est mis à jour et prend le nom de la 
playlist sélectionnée.

Appuyez sur Ctrl+\ (Mac) ou Démarrer+\ 
(Windows) afin de créer une playlist pour la 
première piste sélectionnée dans la session.

Appuyez sur Commande+Ctrl+\ (Mac) ou 
Ctrl+Démarrer+\ (Windows) afin de 
dupliquer la playlist principale de la première 
piste sélectionnée dans la session.

Sélection d'une playlist d'une autre piste
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Changement du nom d'une 
playlist
Vous pouvez renommer une playlist en 
renommant la piste à laquelle elle est assignée. 

Pour renommer la playlist assignée à une piste :

1 Double-cliquez sur le nom de la piste.

2 Saisissez un nouveau nom et cliquez sur OK. 

Les noms de la piste et de la playlist sont tous deux 
mis à jour.

Suppression d'une playlist
Vous pouvez supprimer complètement une playlist 
d'une session. Cependant, les playlists n'occupant 
que très peu d'espace sur le disque, il n'est pas 
nécessaire de les supprimer pour économiser de 
l'espace de stockage.

Pour supprimer une ou plusieurs playlists d'une 
piste :

1 Cliquez sur le sélecteur de playlist et 
sélectionnez Delete Unused.

2 Sélectionnez les playlists non assignées que 
vous souhaitez supprimer. Cliquez tout en 
maintenant la touche Maj (Windows ou Mac), 
Ctrl (Windows) ou Commande (Mac) enfoncée 
pour sélectionner plusieurs playlists 
simultanément.

3 Cliquez sur OK pour supprimer les playlists 
sélectionnées. Une fois confirmée, cette 
suppression ne peut être annulée.

Playlists et groupes d'édition
Lorsque vous créez des playlists avec des pistes 
groupées, le suffixe ajouté au nom des playlists est 
automatiquement incrémenté pour chaque piste du 
groupe d'édition actif. Cela permet de revenir à une 
prise précédente en sélectionnant les prises de 
playlist par groupes. 

Cette méthode permet d'ajouter des pistes au 
groupe existant ; les suffixes de leur nom de 
playlist sont synchronisés avec les pistes d'origine. 

Des playlists vides sont automatiquement créées 
afin de conserver la synchronisation des prises de 
playlist lors d'un retour à des prises plus récentes 
du groupe.

Pour conserver la cohérence entre les noms et 
les performances des playlists (exemple de 
workflow) :

1 Créez des pistes et groupez-les.

2 Assurez-vous que le groupe est activé.

3 Créez une playlist (cliquez sur le sélecteur de 
playlist de l'une des pistes du groupe, puis 
sélectionnez New). Le suffixe par défaut sera 
« .01 », ce qui signifie qu'il s'agit de la prise 1.

4 Enregistrez la prise 1, puis créez une nouvelle 
playlist. Les playlists de toutes les pistes du 
groupe sont incrémentées et prennent la valeur 
« .02 ».

Vous pouvez également supprimer des 
playlists en vue Playlists. Sur une ligne ou 
dans la liste des pistes, effectuez un clic droit 
sur le nom d'une playlist, puis sélectionnez 
Delete.

Lorsque vous supprimez une piste d'une 
session, vous avez la possibilité de supprimer 
ou de conserver ses playlists pour les utiliser 
sur d'autres pistes.

Pour plus d'informations sur le groupement 
de pistes, reportez-vous à la section 
« Groupement de pistes », à la page 253.
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5 Créez des pistes (par exemple, pour un musicien 
ou un micro supplémentaire), puis ajoutez ces 
pistes au groupe (ou créez un groupe avec toutes 
les pistes).

6 Incrémentez toutes les playlists. Pour cela, 
cliquez sur le sélecteur de playlist de l'une des 
pistes du groupe et sélectionnez New.

Le même suffixe est désormais ajouté à toutes 
les playlists. Si vous créez des playlists 
supplémentaires sur l'une des pistes du groupe, 
toutes les playlists correspondantes sont 
incrémentées afin d'assurer une cohérence entre 
elles.

7 Si vous souhaitez écouter la prise .01 du 
premier groupe de pistes, vous pouvez revenir 
à la playlist .01 de n'importe quelle piste du 
groupe.

Les playlists de toutes les pistes du groupe sont 
numérotées à l'aide de suffixes .01 (y compris les 
pistes ajoutées au groupe d'origine après les prises 
initiales). Des playlists vides sont automatiquement 
créées sur les membres nouvellement ajoutés, 
afin que les numéros de playlists correspondent 
sur l'ensemble des membres du groupe. 

Elastic Audio et playlists 
alternatives
Les playlists alternatives des pistes Elastic Audio 
basées sur les références de tempo sont affectées 
uniquement par les changements de tempo. Elles 
ne sont pas affectées par l'édition de marqueurs de 
déformation ou d'événement dans la playlist 
principale.

Création de pistes 
composites
Pro Tools inclut des outils de création de pistes 
composites pour les pistes audio. La création de 
pistes composites consiste à assembler diverses 
sélections provenant de prises ou de playlists 
alternatives, afin de créer la meilleure version 
d'une interprétation à partir de plusieurs passes 
d'enregistrement. Pour les pistes audio en vue 
Playlists, vous pouvez sélectionner les meilleures 
passages des playlists alternatives de la piste et les 
copier sur la playlist principale. Vous pouvez ainsi 
créer rapidement et facilement la « prise parfaite » 
à partir de plusieurs playlists alternatives.

Exemple de création d'une piste 
composite
Ce workflow présente certaines tâches de base de 
création de pistes composites :

• Configuration d'une session pour ce workflow.

• Enregistrement en boucle de plusieurs prises sur 
une piste audio.

• Écoute et sélection de la meilleure prise.

• Copie de la meilleure prise sur la playlist 
principale.

Pour configurer une session :

1 Ouvrez une session Pro Tools ou créez-en une.

2 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

3 Sur la page Operation, dans la section Record, 
activez l'option Automatically Create New 

Playlists When Loop Recording.

4 Cliquez sur OK.
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Pour enregistrer en boucle plusieurs prises :

1 Créez une piste audio (stéréo ou mono) 
ou utilisez une piste existante.

2 Assurez-vous que la source que vous souhaitez 
enregistrer est correctement connectée et 
assignée à l'entrée de la piste.

3 À partir du sélecteur de vue de la piste, 
sélectionnez Playlists. 

4 Pour entendre le contenu de la piste jusqu'au 
point de début de la boucle, activez le pré-roll et 
configurez sa durée.

5 Activez l'enregistrement en boucle en 
effectuant l'une des opérations suivantes :

• Sélectionnez Options > Loop Playback.

• Effectuez un clic droit sur le bouton Play de la 
fenêtre de transport et sélectionnez Loop.

6 Assurez-vous que Options > Link Timeline and 

Edit Selection est sélectionné.

7 À l'aide du Sélecteur, sélectionnez la plage de la 
boucle sur la piste. 

8 Activez la piste audio pour l'enregistrement en 
cliquant sur son bouton d'activation pour 
l'enregistrement.

9 Dans la fenêtre de transport, cliquez sur Record 
pour préparer Pro Tools à l'enregistrement.

10 Cliquez ensuite sur Play pour lancer 
l'enregistrement.

11 Une fois l'enregistrement terminé, cliquez sur le 
bouton Stop.

12 Si vous ne souhaitez pas effectuer d'autre passe 
d'enregistrement en boucle, cliquez à nouveau 
sur le bouton d'activation pour l'enregistrement 
de la piste audio.

Une fois l'enregistrement en boucle arrêté, les prises 
enregistrées en boucle s'affichent sur les lignes de 
playlist situées en dessous de la playlist principale 
(y compris le clip du fichier audio entier contenant 
toutes les passes d'enregistrement en boucle).

Vue Playlists avec plusieurs playlists alternatives

Si l'option Automatically Create New 
Playlists When Loop Recording a été 
désactivée avant le début de l'enregistrement 
en boucle, effectuez un clic droit sur le clip de 
la playlist principale et sélectionnez Matches 
> Expand Alternates to New Playlists.
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Pour masquer la playlist du clip de fichier entier, 
effectuez l'une des opérations suivantes :

 Effectuez un clic droit sur la ligne de la playlist 
et sélectionnez Hide.

 Avec la même sélection d'édition utilisée pour 
l'enregistrement en boucle, effectuez un clic 
droit sur le nom de la piste ou un nom de ligne 
de playlist, puis sélectionnez Filter Lanes > 

Show Only Lanes With > Clips Within the Edit 

Selection.

Pour écouter les pistes alternatives :

1 Activez la lecture en boucle en effectuant l'une 
des opérations suivantes :

• Sélectionnez Options > Loop Playback.

• Effectuez un clic droit sur le bouton Play de la 
fenêtre de transport et sélectionnez Loop.

2 Conservez la même sélection de timeline et les 
mêmes durées de pré/post-roll, puis lancez la 
lecture. La playlist principale est lue.

3 Cliquez sur le bouton Solo de la playlist 
alternative que vous souhaitez écouter. Répétez 
cette étape pour chaque ligne de playlist. 
La lecture en solo d'une ligne de playlist 
s'applique uniquement aux playlists de la piste 
et ne mute pas les autres pistes de la session.

Pour sélectionner et copier la meilleure prise sur la 
playlist principale :

1 Une fois la meilleure prise identifiée, apportez 
les modifications nécessaires à la sélection 
d'édition. Cette sélection sera copiée sur la 
playlist principale.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Copy Selection To > Main 

Playlist.

• Effectuez un clic droit sur la sélection et 
sélectionnez Copy Selection to Main Playlist.

• Cliquez sur le bouton Copy Selection to Main 
Playlist de la ligne de la playlist.

Options de filtrage des lignes de playlist

Copie de la sélection d'édition d'une playlist 
alternative sur la playlist principale

Pour copier la sélection sur la playlist 
principale, appuyez sur Alt+Démarrer+V 
(Windows) ou Option+Ctrl+V (Mac).

Bouton de copie de la sélection 
sur la playlist principale
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Vue Playlists
La vue Playlists permet d'afficher la playlist 
principale de la piste, ainsi que toutes les playlists 
alternatives associées. Les playlists alternatives 
s'affichent directement sous la piste, sur des lignes 
de playlist.

Vous pouvez éditer les playlists alternatives en vue 
Playlists, de la même façon que vous éditez la 
playlist principale en vue Waveform. En vue 
Playlists, les opérations d'édition effectuées sur les 
sélections s'appliquent à toutes les playlists 
alternatives affichées. Les playlists alternatives qui 
ne sont pas affichées ne sont pas affectées.

Pour afficher les lignes de playlist d'une piste :

 À partir du sélecteur de vue de la piste, 
sélectionnez Playlists.

 

Si la piste ne contient aucune playlist alternative, 
une seule ligne de playlist vide s'affiche sous la 
playlist principale. Pour créer une playlist 
alternative sur la piste, ajoutez de l'audio sur cette 
ligne par glisser-déposer à partir de la liste des 
clips, des navigateurs de l'espace de travail ou 
d'autres pistes audio.

Si la piste contient une ou plusieurs playlists 
alternatives en plus de la playlist principale, elles 
sont affichées sous forme de lignes en dessous de 
la playlist principale. La ligne de playlist en bas de 
la fenêtre reste toujours vide et peut être utilisée 
pour ajouter des clips afin de créer de nouvelles 
playlists alternatives.

Avant de commencer à travailler sur le création 
d'une piste composite, créez une copie de la 
playlist principale de la piste afin de l'utiliser 
comme playlist alternative de sauvegarde.

Les groupes de clips ne sont pas pris en 
charge en vue de piste Playlists.

Sélection de la vue de piste Playlists

Pour basculer entre les vues Playlists et 
Waveform, vous pouvez également cliquer sur 
le sélecteur de playlist tout en maintenant les 
touches Ctrl+Alt (Windows) ou 
Commande+Ctrl (Mac) enfoncées.

Audio déposé à partir de la liste des clips pour créer 
une playlist alternative

Piste avec playlists alternatives en vue de piste Playlists
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Écoute des playlists 
alternatives
Seule la playlist principale est lue via le chemin de 
sortie audio de la piste. Pour écouter une playlist 
alternative, vous devez mettre en solo sa ligne de 
playlist. La ligne est lue en solo via le chemin de 
sortie audio de la piste, à la place de la playlist 
principale.

Pour écouter une playlist alternative :

1 Cliquez sur le bouton Solo de la ligne de playlist 
que vous souhaitez écouter. La lecture en solo 
d'une ligne de playlist s'applique uniquement 
aux playlists de la piste et ne mute pas les autres 
pistes de la session.

2 Lancez la lecture dans Pro Tools.

Copie de playlists alternatives 
sur la playlist principale
Si vous souhaitez utiliser une sélection d'une 
playlist alternative sur la playlist principale, copiez 
et collez la sélection sur la playlist principale. 
De cette façon, vous pouvez créer la meilleure 
combinaison de sélections à partir des playlists 
alternatives. 

En plus de l'opération de copier/coller manuelle 
vers la playlist principale, Pro Tools propose 
plusieurs commandes pour copier et coller une 
sélection sur la playlist principale.

Copy Selection To Main Playlist : copie et colle la 
sélection sur la playlist principale. Toutes les 
données se trouvant déjà au même emplacement 
sur la playlist principale sont remplacées.

Copy Selection to New Playlist : crée une playlist 
principale vide, puis copie et colle la sélection sur 
celle-ci.

Copy Selection to Duplicate Playlist : duplique la 
playlist principale actuelle, puis copie et colle la 
sélection sur la copie dupliquée. La playlist 
principale précédente se déplace sur une nouvelle 
ligne de playlist.

Mise en solo d'une playlist alternative

Appuyez sur Maj+S pour mettre en solo la 
ligne de playlist contenant le curseur 
d'édition. Si plusieurs lignes de playlist 
contiennent le curseur d'édition, la ligne 
affichée le plus haut est lue en solo.

Pour déplacer le curseur d'édition vers le haut 
ou le bas entre les lignes de playlist, appuyez 
sur Démarrer+P et Démarrer+; (Windows) 
ou Ctrl+P et Ctrl+; (Mac)
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Pour copier une sélection d'une playlist alternative 
sur la playlist principale :

1 En vue Playlists, créez une sélection sur une 
playlist alternative.

2 Effectuez l'une des opérations suivantes :

• Dans les commandes de la ligne de playlist, 
cliquez sur le bouton Copy Selection To Main 
Playlist.

• Sélectionnez Edit > Copy Selection to Main 

Playlist.

• Effectuez un clic droit sur la sélection et 
sélectionnez Copy Selection to Main Playlist.

Les données sélectionnées dans la playlist 
alternative sont copiées au même emplacement 
temporel sur la playlist principale.

Pour copier une sélection d'une playlist alternative 
sur une nouvelle playlist principale :

1 En vue Playlists, créez une sélection sur une 
playlist alternative.

2 Sélectionnez Edit > Copy Selection to New 

Playlist.

Création d'une sélection sur une playlist alternative

Pour copier la sélection sur la playlist 
principale, appuyez sur Alt+Démarrer+V 
(Windows) ou Option+Ctrl+V (Mac).

Sélection copiée sur la playlist principale

Sélection copiée sur une nouvelle playlist principale
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Pour copier une sélection d'une playlist alternative 
sur une copie de la playlist principale :

1 En vue Playlists, créez une sélection sur une 
playlist alternative.

2 Sélectionnez Edit > Copy Selection to Duplicate 

Playlist.

Glisser-déposer de clips sur des 
lignes de playlist
Vous pouvez déplacer des clips par glisser-déposer 
vers n'importe quelle ligne de playlist disponible et 
pour toute piste ayant la même largeur de canal. 
Il est par exemple impossible de déposer un clip 
stéréo sur une ligne de playlist d'une piste mono. 
De la même manière, vous pouvez déplacer des 
clips à partir de n'importe quelle ligne de playlist 
vers toute autre piste de largeur de canal identique.

Édition sur les lignes de playlist
Vous pouvez éditer les clips d'une ligne de playlist 
de la même façon que sur une playlist principale. 
Vous avez également la possibilité de déplacer 
un clip d'une ligne de playlist vers une autre 
(y compris la playlist principale), d'une piste vers 
une autre, et d'un emplacement temporel vers un 
autre. Pour écouter les éditions effectuées sur les 
lignes de playlist, vous devez mettre les lignes en 
solo (reportez-vous à la section « Écoute des 
playlists alternatives », à la page 652).

Modification de l'ordre des 
lignes de playlist
Vous pouvez modifier l'ordre des lignes de playlist 
de la même façon que pour les pistes.

Pour modifier l'ordre des lignes de playlist :

 Cliquez sur le nom de la playlist alternative et 
faites-la glisser vers l'emplacement souhaité.Sélection copiée sur la copie d'une playlist principale

Modification de l'ordre des lignes de playlist
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Redimensionnement des lignes 
de playlist
Vous pouvez modifier la taille des lignes de 
playlist de la même façon que pour les pistes. 

Pour redimensionner la piste et toutes les lignes 
de playlist en même temps, effectuez l'une des 
opérations suivantes :

 Cliquez sur la ligne de séparation située entre 
deux lignes de playlist et faites glisser votre 
souris vers le haut ou le bas. La piste et toutes 
les lignes de playlist sont redimensionnées en 
conséquence.

 Effectuez un clic droit sur l'échelle verticale 
située entre la zone de playlist et les commandes 
de ligne de playlist, et sélectionnez la taille de 
ligne souhaitée. La piste et toutes les lignes de 
playlist sont redimensionnées en conséquence.

Pour redimensionner une ligne de playlist, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Ctrl enfoncée et cliquez sur 
la ligne de séparation située entre deux lignes de 
playlist, puis faites glisser votre souris vers le 
haut ou le bas. La ligne supérieure est 
redimensionnée en conséquence.

 Maintenez la touche Ctrl enfoncée et effectuez 
un clic droit sur l'échelle verticale située entre la 
zone de playlist et les commandes de ligne de 
playlist, puis sélectionnez la taille de ligne 
souhaitée.

Modification du nom d'une 
playlist alternative
Vous pouvez renommer les playlists alternatives 
de la même façon que pour les pistes. 

Pour renommer une playlist alternative :

1 Double-cliquez sur le nom de la playlist 
alternative.

2 Dans la boîte de dialogue Name, saisissez le 
nom souhaité.

3 Cliquez sur OK.

Appuyez sur Démarrer+Flèche haut ou bas 
(Windows) ou Ctrl+Flèche haut ou bas (Mac) 
pour modifier la hauteur des pistes, 
des playlists et des lignes contenant le curseur 
ou la sélection d'édition.

Redimensionnement d'une ligne de playlist

Sélection d'un preset de taille pour une ligne de 
playlist
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Playlists alternatives dans la 
liste des pistes
Lorsqu'une piste audio est affichée en vue Playlists, 
toutes les playlists associées sont répertoriées sous 
le nom de la piste, dans la liste des pistes. Les noms 
des playlists alternatives associées sont décalés sur 
la droite afin de les distinguer de ceux des pistes. 
Vous pouvez afficher ou masquer les playlists 
alternatives à partir de la liste des pistes. Vous 
pouvez également accéder au menu contextuel des 
playlists alternatives, qui contient les commandes 
Show ou Hide, Scroll Into View, Rename, Delete et 
Filter Lanes.

Filtrage des lignes
Vous pouvez filtrer les lignes de playlist afin de les 
afficher ou de les masquer selon différents critères.

Pour filtrer les lignes de playlist :

1 Effectuez un clic droit sur le nom de la piste ou 
de la playlist.

2 Dans le menu contextuel, sélectionnez l'une des 
commandes suivantes :

• Show All Lanes (afficher toutes les lignes) 

• Show Only Lanes With > Clips Within The Edit 

Selection (afficher uniquement les lignes 

contenant des clips dans la sélection d'édition) 

• Show Only Lanes With > Clips Outside The Edit 

Selection (afficher uniquement les lignes 

contenant des clips hors de la sélection 

d'édition) 

• Show Only Lanes With > “Clips Rated >= 1–5” 
(afficher uniquement les clips dont le classement 
est >= 1-5) 

• Hide All Lanes (masquer toutes les lignes) 

• Hide Only Lanes With > Clips Within The Edit 

Selection (masquer uniquement les lignes 

contenant des clips dans la sélection d'édition) 

• Hide Only Lanes With > Clips Outside The Edit 

Selection (masquer uniquement les lignes 

contenant des clips hors de la sélection 

d'édition) 

• Hide Only Lanes With > “Clips Rated >= 1–5” 
(masquer uniquement les clips dont le 
classement est >= 1-5) 

Les lignes de playlist sont affichées ou masquées 
en conséquence.

Liste des pistes avec les lignes de playlist de la piste 
Audio 1
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Correspondance des clips 
alternatifs
Pro Tools permet de remplacer des clips de la 
playlist principale de pistes par des clips alternatifs 
correspondants, qui proviennent d'autres playlists 
associées à la même piste, d'autres pistes ou de la 
liste des clips. Les clips alternatifs correspondants 
sont des clips répondant à certains critères. 
Par exemple, les clips basés sur le même marqueur 
temporel utilisateur sont des correspondances. 

Il existe plusieurs façons de créer des clips 
alternatifs correspondants dans Pro Tools :

• Lorsque vous effectuez un enregistrement en 
punch-in/out (audio ou MIDI), Pro Tools crée 
une correspondance entre le clip d'origine 
(le cas échéant) et le nouveau clip enregistré. 

• En cas d'enregistrement en boucle (audio ou 
MIDI), Pro Tools crée plusieurs clips 
correspondants pour chaque passe 
d'enregistrement. 

• Si vous dupliquez des playlists (audio ou MIDI), 
des correspondances sont créées entre les clips 
alternatifs des playlists.

• Lorsque vous importez de l'audio multicanal 
à partir d'un enregistreur portable, des 
correspondances sont créées entre les clips 
alternatifs des canaux.

L'accès et l'écoute des différents clips alternatifs 
correspondants peuvent se faire de plusieurs 
façons dans Pro Tools.

• Dans le menu contextuel des clips, sélectionnez 
les clips alternatifs correspondants selon divers 
critères.

• Dans le menu des prises alternatives, 
sélectionnez les clips alternatifs correspondants.

• Utilisez la commande Expand Alternates to New 
Tracks pour copier les clips alternatifs 
correspondants sur de nouvelles pistes.

• Utilisez la commande Expand Alternates to New 
Playlists pour copier les clips alternatifs 
correspondants sur de nouvelles playlists 
alternatives de la même piste. Pour accéder aux 
playlists alternatives, activez la vue Playlists.

Critères de correspondance
La fenêtre Matching Criteria permet de sélectionner 
les critères des clips alternatifs correspondants. 
Ces critères permettent d'affiner la liste des clips 
correspondants disponibles dans les menus des 
prises alternatives et des prises correspondantes.

Pour configurer les critères de correspondance 
des clips alternatifs :

1 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip avec le 
Sélecteur ou la Main et sélectionnez Matches > 

Match Criteria.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez avec le 
Sélecteur sur le début de la plage 
d'enregistrement en boucle ou en punch-in/out. 
Sélectionnez ensuite Match Criteria.

Fenêtre Matching Criteria

Les critères de correspondance s'appliquent 
aux clips MIDI et audio.
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2 Dans la fenêtre Matching Criteria, activez les 
options de la section Alternates Match (toutes 
les combinaisons sont possibles) :

• Track ID

• Track Name

• Clip Rating

3 Sélectionnez l'une des options suivantes de la 
section In Addition To :

• All

• Clip Start

• Clip Start and End

• Within Selection

• None

4 Gardez ouverte la fenêtre Matching Criteria 
pour modifier les paramètres selon le besoin 
lors de la création de pistes composites. Fermez 
la fenêtre Matching Criteria lorsque vous avez 
terminé.

Options des critères de 
correspondance

Options de la section Alternates 
Match
Vous pouvez sélectionner les options suivantes de 
la section Alternates Match (toutes les 
combinaisons sont possibles) :

Track ID : tous les clips enregistrés sur la même 
piste sont considérés comme des clips 
correspondants. Utilisez cette option pour 
sélectionner des prises alternatives issues d'un 
enregistrement en boucle ou en punch-in/out.

Track Name : tous les clips partageant le même 
nom racine avec la piste ou la playlist sont 
considérés comme des clips correspondants. 
Par exemple, les clips Gtr.L_01 et Gtr.L_02-01 
sont considérés comme des correspondances de la 
piste Gtr.L, mais pas le clip Guitar.L_01. 

Clip Rating : tous les clips ayant la même notation 
sont considérés comme des clips correspondants. 
Activez cette option si vous avez attribué une 
notation aux clips (reportez-vous à la section 
« Notation des clips », à la page 623). 

Options de la section In 
Addition To
Les options suivantes de la section In Addition To 
sont mutuellement exclusives.

All : tout clip qui inclut l'emplacement temporel du 
curseur d'édition, ou tout clip situé partiellement 
ou entièrement dans la plage temporelle actuelle de 
la sélection d'édition.

Clip Start : tout clip dont l'heure de début 
correspond à l'emplacement temporel du curseur 
d'édition ou de la sélection d'édition.

Clip Start and End : tout clip ayant les mêmes 
heures de début et de fin que la sélection d'édition.

Within Selection : tout clip complet entièrement 
inclus dans la sélection d'édition.

None : aucun autre critère de filtre des clips 
alternatifs correspondants n'est utilisé en plus des 
options Alternates Match sélectionnées.

Les paramètres Matching Criteria sont 
enregistrés avec votre session Pro Tools.
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Sélection de prises 
alternatives sur des pistes
L'heure de début (marqueur temporel utilisateur) 
de chaque clip issu d'une passe d'enregistrement en 
punch-in/out ou en boucle est identique. Vous 
pouvez sélectionner et écouter des prises 
alternatives à partir du sous-menu des prises 
correspondantes ou du menu des prises 
alternatives, et ce même en cours de lecture.

Pour sélectionner une prise alternative :

1 Configurez la fenêtre Matching Criteria si 
nécessaire (reportez-vous à la section « Critères 
de correspondance », à la page 657).

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip avec le 
Sélecteur ou la Main, puis sélectionnez une prise 
alternative à partir du sous-menu Matches.

• Si la prise se trouvant actuellement sur la piste 
est sélectionnée, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée et 
cliquez n'importe où dans la prise avec le 
Sélecteur afin de sélectionner une prise 
différente dans le menu des prises alternatives.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez avec le 
Sélecteur sur le début de la plage 
d'enregistrement en boucle ou en punch-in/out. 
Sélectionnez ensuite une prise différente dans le 
menu des prises alternatives.

Le clip (prise) alternatif correspondant sélectionné 
remplace le clip dans la playlist principale et se 
positionne précisément au bon emplacement.

Pour vous assurer que les prises suivantes utilisent 
le même marqueur temporel utilisateur (et sont 
donc disponibles en tant que clips alternatifs 
correspondants), mémorisez les sélections 
d'enregistrement en boucle ou en punch-in/out 
avec des emplacements mémoire. Si vous devez 
enregistrer d'autres prises par la suite, il vous suffit 
de rappeler l'emplacement mémoire 
correspondant. 

Pour modifier le marqueur temporel utilisateur 
d'autres clips afin qu'ils soient disponibles en tant 
que clips alternatifs correspondants pour un 
emplacement précis, utilisez la commande Time 

Stamp du menu de la liste des clips. 

Sous-menu contextuel des prises correspondantes

Menu des prises alternatives
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Correspondances et pistes 
multiples
Si vous avez effectué des enregistrements en 
boucle sur plusieurs pistes et si chacune contient 
plusieurs prises avec des marqueurs temporels 
utilisateur identiques, vous pouvez modifier toutes 
les prises simultanément.

Pour modifier les prises de plusieurs pistes :

1 Configurez la fenêtre Matching Criteria 
(reportez-vous à la section « Critères de 
correspondance », à la page 657) afin que les 
options suivantes soient sélectionnées :

• Track Name 

• Plage de la sélection

2 À l'aide du Sélecteur, sélectionnez la plage de la 
prise de chaque piste à remplacer.

3 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur la sélection d'édition 
et sélectionnez une autre prise correspondante 
à partir du sous-menu Matches.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur la 
sélection d'édition, puis sélectionnez une prise 
différente à partir du menu des prises 
alternatives.

La prise sélectionnée remplace la prise précédente 
et se positionne à l'endroit approprié sur chaque 
piste.

Création automatique de 
nouvelles playlists lors d'un 
enregistrement en boucle
Lors d'un enregistrement en boucle, Pro Tools crée 
un fichier unique contenant toutes les passes 
d'enregistrement (chaque passe correspond à un 
clip du fichier). Sur la piste, seule la dernière passe 
d'enregistrement apparaît en tant que clip sur la 
playlist principale. Tous les autres clips (c'est-à-
dire les autres passes d'enregistrement) sont 
masqués, mais peuvent être sélectionnés en tant 
que clips (prises) alternatifs correspondants.

Lorsque l'option Automatically Create New 

Playlists When Loop Recording est activée dans les 
préférences de fonctionnement, chaque clip (prise) 
est copié automatiquement sur une nouvelle 
playlist de la piste. Cela facilite l'utilisation de la 
vue Playlists pour l'écoute et la sélection de prises 
alternatives.

Pour créer automatiquement des playlists lors 
d'un enregistrement en boucle :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2 Dans la section Recording, activez l'option 
Automatically Create New Playlists When Loop 

Recording.

3 Cliquez sur OK.

Pour plus d'informations sur l'enregistrement 
en boucle, reportez-vous à la section 
« Enregistrement audio en boucle », à la 
page 472.
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Développement des prises 
alternatives sur de nouvelles 
playlists ou pistes
Pro Tools permet de développer les prises ou canaux 
alternatifs sur de nouvelles playlists ou pistes. 
L'écoute, l'édition et le mixage de plusieurs prises ou 
canaux alternatifs sont ainsi simplifiés. Les prises 
alternatives sont créées lors d'un enregistrement en 
punch-in/out ou en boucle. Les canaux alternatifs 
sont inclus dans les fichiers importés dans Pro Tools 
à partir d'enregistreurs portables.

Développement des prises 
alternatives sur de nouvelles 
playlists
Le développement de prises alternatives sur de 
nouvelles playlists facilite la création de pistes 
composites. Une fois que vous avez développé les 
prises alternatives sur de nouvelles playlists d'une 
piste, vous pouvez les écouter et les éditer en vue 
Playlists afin d'assembler les meilleures prises sur 
la playlist principale.

Pour développer des prises alternatives sur de 
nouvelles playlists :

1 Identifiez le clip de la playlist principale 
contenant des clips (prises) alternatifs 
correspondants. 

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip et sélectionnez 
Matches > Expand Alternates To New Playlists.

• Si le clip est sélectionné, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
et cliquez avec le Sélecteur sur le clip, puis 
sélectionnez Matches > Expand Alternates To 
New Playlists.

• Si le clip n'est pas sélectionné, maintenez la 
touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez avec le Sélecteur sur le début 
exact de la plage d'enregistrement en boucle ou 
en punch-in/out, puis sélectionnez Matches > 
Expand Alternates To New Playlists.

Tous les clips alternatifs correspondants sont 
développés sur de nouvelles playlists de piste. 
Pour afficher toutes les playlists de la piste, 
sélectionnez la vue Playlists. Quelle que soit la vue 
de piste sélectionnée, vous pouvez également 
sélectionner n'importe quelle playlist alternative 
disponible et la définir comme playlist principale 
à partir du sélecteur de playlist.

Développement des prises 
alternatives sur de nouvelles 
pistes
Le développement de prises alternatives sur de 
nouvelles pistes facilite l'écoute, l'édition et le 
mixage des prises alternatives de chaque piste.

Pour développer des prises alternatives sur de 
nouvelles pistes :

1 Identifiez le clip de la playlist principale 
contenant des clips (prises) alternatifs 
correspondants. 

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip et sélectionnez 
Matches > Expand Alternates To New Tracks.

• Si le clip est sélectionné, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
et cliquez avec le Sélecteur sur le clip, puis 
sélectionnez Matches > Expand Alternates To 
New Tracks.

• Si le clip n'est pas sélectionné, maintenez la 
touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez avec le Sélecteur sur le début 
exact de la plage d'enregistrement en boucle ou 
en punch-in/out, puis sélectionnez Matches > 
Expand Alternates To New Tracks.

3 Sélectionnez l'une des options suivantes dans le 
sous-menu Expand Alternates To New Tracks :
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By Track Name : nomme toutes les nouvelles 
pistes en fonction du nom de la piste source.

By Clip Name : nomme toutes les nouvelles pistes 
en fonction du nom du clip d'origine correspondant, 
tel qu'il apparaît dans la liste Matches.

By Track and Clip Name : nomme toutes les 
nouvelles pistes en fonction du nom de la piste 
source. Le nom du clip d'origine correspondant 
apparaît entre parenthèses.

Tous les clips alternatifs correspondants sont 
copiés sur de nouvelles pistes.

Développement des canaux 
alternatifs sur de nouvelles 
playlists ou pistes
(Pro Tools HD uniquement)

Lorsque vous travaillez avec un clip mono 
appartenant à un enregistrement multicanal importé 
à partir d'un enregistreur portable, vous pouvez 
développer ce clip (ou un passage de celui-ci) sur de 
nouvelles playlists reflétant les canaux alternatifs 
correspondants, tout en conservant les éditions et les 
fondus (reportez-vous au Chapitre 51, « Utilisation 
d'enregistreurs portables avec Pro Tools »).

Conditions de disponibilité des 
canaux alternatifs
Pour qu'un canal alternatif puisse remplacer un 
canal d'origine (représenté par un clip ou une partie 
de clip sélectionné sur la timeline), toutes les 
conditions suivantes doivent être remplies :

• Les deux canaux font partie du même groupe 
multicanal correspondant à un enregistrement 
effectué en simultané sur un ou plusieurs 
enregistreurs portables.

• Certaines métadonnées du canal d'origine 
correspondent à celles du canal alternatif.

• Les métadonnées intégrées lors du tournage ou 
de l'enregistrement ont été conservées avant 
l'importation dans Pro Tools.

Si les enregistrements multicanal proviennent d'un 
ou plusieurs enregistreurs portables, les deux 
canaux doivent se chevaucher au moins une fois 
entre les positions de timecode de début et de fin, 
et doivent remplir l'une des conditions suivantes :

• scène et prise correspondantes ;

• date de tournage correspondante (uniquement si 
la scène et la prise contiennent des informations 
concernant les deux canaux) ;

• nom de bande correspondant ;

• nom de bande son correspondant ;

• nom de bande son du canal de remplacement 
correspondant au nom de bande du canal actuel ;

• nom de bande du canal de remplacement 
correspondant au nom de bande son du canal 
actuel.

Développement de canaux sur 
de nouvelles playlists

Pour développer des canaux alternatifs sur de 
nouvelles playlists :

1 Dans la timeline, effectuez l'une des opérations 
suivantes :

• Pour développer uniquement une partie des clips 
de la piste, créez une sélection comprenant ou 
chevauchant le nombre de clips souhaité, puis 
effectuez un clic droit sur la sélection (Windows 
ou Mac) ou cliquez en maintenant la touche Ctrl 
enfoncée (Mac).

• Pour développer tous les clips d'une piste, 
effectuez un clic droit sur le nom de la piste 
(Windows ou Mac) ou cliquez en maintenant la 
touche Ctrl enfoncée (Mac).
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2 Dans le menu contextuel qui s'affiche, 
sélectionnez la commande Expand Channels to 
New Playlists, puis sélectionnez la méthode de 
développement des canaux alternatifs de la 
sélection sur les nouvelles pistes :

• By Channel Name

• By Channel Number

• By Channel Name and Number

• By Timecode Only

Si des canaux alternatifs sont disponibles, 
Pro Tools les développe sur de nouvelles playlists 
(y compris le canal représenté sur la piste 
d'origine) en fonction de l'option sélectionnée.

Développement de canaux sur 
de nouvelles pistes

Pour développer des canaux alternatifs sur de 
nouvelles pistes :

1 Dans la timeline, effectuez l'une des opérations 
suivantes :

• Pour développer uniquement une partie des clips 
de la piste, créez une sélection comprenant ou 
chevauchant le nombre de clips souhaité, puis 
effectuez un clic droit sur la sélection (Windows 
ou Mac) ou cliquez en maintenant la touche Ctrl 
enfoncée (Mac).

• Pour développer tous les clips d'une piste, 
effectuez un clic droit sur le nom de la piste 
(Windows ou Mac) ou cliquez en maintenant la 
touche Ctrl enfoncée (Mac).

2 Dans le menu contextuel qui s'affiche, 
sélectionnez la commande Expand Channels to 
New Tracks, puis sélectionnez la méthode de 
développement des canaux alternatifs de la 
sélection sur les nouvelles pistes :

• By Channel Name

• By Channel Number

• By Channel Name and Number

• By Timecode Only

Si des canaux alternatifs sont disponibles, 
Pro Tools les développe sur de nouvelles pistes 
(y compris le canal représenté sur la piste 
d'origine) en fonction de l'option sélectionnée.

Développement de canaux par 
timecode uniquement
La commande Expand To New Tracks By 
Timecode Only permet de développer une piste 
entière ou uniquement les clips sélectionnés sur de 
nouvelles playlists appartenant à la même piste ou 
sur de nouvelles pistes séparées. Cela permet 
d'afficher tous les autres clips enregistrés au même 
emplacement de timecode, quel que soit le nom 
ou le numéro du canal. Cette commande est 
particulièrement utile pour développer des 
pistes témoin éditées de l'audio source d'origine 
enregistré avec synchronisation du timecode, mais 
dont les nom et numéros des canaux n'ont pas été 
enregistrés dans les fichiers audio. 

Exemple de workflow : utilisation d'une piste 
témoin pour des vidéos de concert live

1 La piste audio multipiste est enregistrée dans 
Pro Tools avec asservissement au timecode. 
Un mix mono ou stéréo est enregistré 
simultanément comme piste témoin pour le 
monteur vidéo.

2 Les pistes témoins vidéo et audio sont montées 
dans une application de montage vidéo. 

3 Les pistes témoin audio montées sont exportées 
à partir du monteur vidéo sous la forme d'une 
séquence AAF (ou OMF), avec des marges d'au 
moins deux images. 

Il est impossible de renommer des fichiers 
encodés avec des métadonnées XML. 
L'extension de fichier sera soit .A1 soit .A2 
(même pour les fichiers stéréo). De plus, il est 
impossible de renommer les fichiers utilisant le 
suffixe .L/.R. Par conséquent, Pro Tools ne 
reconnaît pas toujours ces canaux comme 
étant une paire stéréo.
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4 La séquence AAF (ou OMF) est importée 
dans Pro Tools en tant que nouvelle session. 
Les fichiers audio source d'origine et la piste 
témoin non montée sont également importés 
dans la session.

5 La piste témoin non montée d'origine est reliée 
à la session (reportez-vous à la section 
« Rétablissement du lien avec la piste témoin 
non montée d'origine », à la page 664).

6 Dans Pro Tools, le monteur sélectionne l'option 
Expand Channels to New Tracks > By 
Timecode Only en effectuant un clic droit sur le 
nom de la piste témoin. Les pistes source 
d'origine sont développées sur de nouvelles 
pistes, avec les points d'édition et fondus de la 
piste témoin.

Rétablissement du lien avec la piste témoin non 
montée d'origine

Une fois la séquence AAF (ou OMF) et les fichiers 
audio source d'origine importés dans la session, 
il est recommandé de rétablir le lien entre la piste 
témoin montée et la piste audio source non montée 
d'origine.

Pour rétablir le lien avec la piste témoin non 
montée d'origine :

1 Dans le navigateur de l'espace de travail, accédez 
à la session et ouvre le dossier Audio Files. 

2 Dans le navigateur, effectuez un clic droit sur le 
fichier audio de la piste témoin montée, puis 
sélectionnez Relink Selected.

3 Dans le panneau supérieur de la fenêtre Relink, 
naviguez vers le fichier audio de la piste témoin 
non montée d'origine qui a été enregistré dans 
Pro Tools. 

4 Dans le panneau Select Files To Relink, 
sélectionnez le fichier de la piste témoin montée.

5 Faites glisser le fichier audio de la piste témoin 
non montée vers le panneau Candidates. Si une 
boîte de dialogue s'affiche et indique qu'un ou 
plusieurs fichiers sont plus courts que le fichier 
média pour lequel vous tentez de rétablir le lien, 
cliquez sur Yes pour poursuivre l'opération.

6 Dans le panneau Candidates, activez la case à 
cocher située à gauche du fichier pour afficher 
l'icône de lien. 

7 En haut de la fenêtre Relink, cliquez sur Commit 
Links, puis fermez la fenêtre.

8 Effectuez un clic droit sur le nom de la piste 
témoin et sélectionnez Expand To New Tracks > 
By Timecode Only. Toutes les pistes développées 
sont alors synchronisées avec la piste témoin.

Si le fichier non monté d'origine n'est pas 
disponible, vous pouvez rétablir le lien avec 
l'un des fichiers audio source, à la condition 
que ses heures de début et de fin soit 
identiques à celles de la piste témoin.
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Chapitre 30 : Beat Detective

Beat Detective est un puissant outil d'analyse, 
d'édition et de manipulation de données audio ou 
MIDI à caractère rythmique.

Beat Detective analyse une sélection audio ou 
MIDI, détecte ses transitoires ou notes accentuées 
et crée des déclencheurs rythmiques basés sur les 
transitoires ou notes MIDI détecté(e)s. À partir de 
ces déclencheurs, Beat Detective peut : 

• Extraire les informations de tempo et de 
métrique pour créer des marqueurs Bars|Beats 
utilisables pour définir la table de tempos de la 
session. Reportez-vous à la section « Génération 
de marqueurs Bars|Beats avec Beat Detective » 
à la page 676.

• Extraire les informations de tempo et de groove 
pour créer des modèles de groove, appelés 
DigiGrooves. Ces modèles peuvent être 
appliqués à l'audio ou au MIDI à l'aide de Beat 
Detective ou de la commande Groove Quantize 
(reportez-vous à la section « Modèles 
DigiGroove » à la page 677).

• Diviser la sélection audio en clips séparés, puis 
conformer (ou « quantifier ») les clips divisés en 
fonction de la table de tempos de la session ou 
d'un modèle de groove. Reportez-vous aux 
sections « Séparation de clips avec 
Beat Detective » à la page 680 et « Conformation 
de clips avec Beat Detective » à la page 682.

Beat Detective et contenus 
source
Beat Detective est extrêmement efficace avec les 
contenus audio ou MIDI caractérisés par des 
transitoires d'attaque ou des accentuations 
marqués, et notamment les pistes de la plupart des 
instruments actuels, tels que la batterie, la guitare 
ou la basse. Beat Detective fonctionnera moins 
bien avec les contenus audio dont les attaques sont 
moins franches ou au phrasé legato (telles que les 
cordes et les voix).

Applications de Beat 
Detective
Beat Detective peut servir dans de nombreuses 
situations :

Extraction de tempo à partir de données audio ou 
MIDI : Beat Detective peut générer des marqueurs 
Bars|Beats, à partir desquels il peut extraire un 
tempo, même s'il varie, ou si la rythmique est 
complexe. Par ailleurs, les marqueurs Bars|Beats 
générés peuvent ensuite servir pour quantifier 
d'autres clips et événements audio ou MIDI. 

Création de DigiGrooves : Beat Detective peut 
extraire des modèles de groove, appelés 
DigiGrooves, à partir d'une sélection audio ou 
MIDI. Les DigiGrooves peuvent être utilisés pour 
appliquer le groove ou le feeling d'un passage 
capturé à d'autres sélections audio (mode de 
conformation Groove) ou à des données MIDI 
(quantification sur le groove). 
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Conformation de clips audio : Beat Detective 
peut conformer (« quantifier ») les données audio 
ayant un tempo différent ou des tempos variés, à la 
table de tempos actuelle de la session ou à un 
modèle de groove. 

« Mise en place » des performances : Beat 
Detective peut améliorer la mise en place rythmique 
de certains contenus audio en calculant et en 
extrayant son tempo moyen, puis en conformant ses 
composantes rythmiques (les clips générés par Beat 
Detective) à la table de tempos de la session.

Correspondance de boucles : comme Beat 
Detective peut extraire les informations de tempo 
et de métrique des données audio et MIDI, puis 
conformer les données audio à une table de tempos 
ou à un modèle de groove existants, vous pouvez 
l'utiliser pour aligner des boucles sur différents 
tempos ou grooves. Si le tempo d'une boucle est 
différent de celui de la session actuelle, Beat 
Detective permet de séparer rapidement les temps 
de la boucle et de les conformer à la table de 
tempos (alternative à la compression ou à 
l'extension temporelle de la boucle, qui peut 
modifier la hauteur et le timbre de l'audio). 

Remix : Beat Detective peut servir pour les remix 
ou pour créer de nouveaux rythmes. Il peut extraire 
le tempo des pistes de batterie d'origine et même, 
dans certains cas, du mix stéréo d'origine. 
De nouvelles pistes audio ou MIDI peuvent être 
conformées à un tempo d'origine ou, à l'inverse, 
un contenu peut être conformé au tempo de 
nouvelles pistes de batterie, ce qui lui confère une 
assise rythmique entièrement inédite.

Travail des points d'édition en post-production 
(audio uniquement) : le lissage des points 
d'édition avec Beat Detective permet de nettoyer 
automatiquement des pistes de bruitage contenant 
de nombreux clips nécessitant des opérations 
de trim et la création de fondus enchaînés. 
Les silences créés entre les clips peuvent ainsi 
être supprimés, ce qui permet de conserver 
l'atmosphère d'une piste.

Configuration requise pour 
Beat Detective
Beat Detective est disponible sur tous les systèmes 
Pro Tools.

Spécifications relatives à la RAM pour 
Beat Detective

Les traitements de Beat Detective peuvent 
demander une grande quantité de RAM, en 
particulier si vous travaillez avec plusieurs pistes 
ou des sélections de longue durée. Afin d'éviter les 
erreurs liées à un manque de RAM avec Beat 
Detective, procédez de la façon suivante :

• Si vous remarquez un ralentissement du 
fonctionnement de Beat Detective, ajoutez plus 
de RAM à votre ordinateur. 

• Si vous ne pouvez ajouter de RAM à votre 
ordinateur, travaillez avec des sélections plus 
courtes ou sur des pistes individuelles.

• Réduisez le nombre de niveaux d'annulation 
dans les préférences d'édition (reportez-vous à la 
section « Niveaux d'annulation et RAM » à la 
page 536). Les opérations nécessitant beaucoup 
de mémoire, telles que le lissage des points 
d'édition (audio uniquement) avec Beat 
Detective, peuvent immobiliser une grande 
quantité de mémoire lorsqu'elles se trouvent 
dans la file d'annulation.

Si vous travaillez avec de l'audio basé sur les 
références de tempo, utilisez la commande Clip 
Separation de Beat Detective pour séparer 
rapidement les clips audio en « attaques » 
(ou tranches) individuelles. Il est également 
possible de grouper les clips séparés pour 
simplifier leur édition et leur arrangement.
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La fenêtre Beat Detective
L'outil Beat Detective est géré à partir de la fenêtre Beat Detective.

Pour ouvrir la fenêtre Beat Detective, effectuez 
l'une des opérations suivantes :

 Sélectionnez Event > Beat Detective.

 Appuyez sur Ctrl+8 (Windows) ou 
Commande+8 (Mac) sur le pavé numérique.

La fenêtre Beat Detective est flottante et peut rester 
ouverte lorsque vous travaillez. Vous pouvez donc 
ajuster les paramètres en temps réel en cours de 
lecture, tout en visualisant les déclencheurs de votre 
sélection dans la fenêtre Edit.

Modes de Beat Detective
La fenêtre Beat Detective est divisée en trois 
zones : Operation, Selection et Detection. 
Les actions réalisables varient en fonction du 
mode sélectionné dans le menu Operation. 
Les options de sélection de Beat Detective restent 
disponibles dans tous les modes de 
fonctionnement.

Les modes de Beat Detective sont les suivants :

Operation : permet d'analyser, au choix, 
des contenus MIDI ou audio.

Bar|Beat Marker Generation : génère des 
marqueurs Bars|Beats sur les transitoires détectés 
d'une sélection audio ou les patterns d'accentuation 
de notes MIDI.

Groove Template Extraction : extrait les 
informations rythmiques et dynamiques de contenus 
audio ou MIDI, et sauvegarde ces informations dans 
le presse-papiers de Groove, ou en tant que modèle 
DigiGroove.

Clip Separation (audio uniquement) : sépare et 
crée de nouveaux clips à chaque transitoire détecté 
dans la sélection audio.

Clip Conform (audio uniquement) : conforme 
tous les clips séparés de la sélection à la table de 
tempos actuelle. Beat Detective peut conformer 
des clips audio à des modèles de groove (tels que 
des modèles DigiGrooves), plutôt que d'appliquer 
une quantification standard.

Edit Smoothing (audio uniquement) : remplit les 
espaces entre les clips conformés en appliquant des 
opérations de trim automatiques, puis en insérant 
des fondus enchaînés.

Fenêtre Beat Detective
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Définition d'une sélection 
pour Beat Detective
Que ce soit pour générer des marqueurs 
Bars|Beats, extraire un modèle DigiGroove ou 
séparer des clips pour les conformer, vous devez 
toujours définir la sélection audio ou MIDI 
à analyser. La fenêtre Beat Detective offre des 
outils permettant de définir et de capturer la plage 
d'une sélection audio, sa signature rythmique et 
son swing (subdivision rythmique).

Pour que Beat Detective puisse créer des 
déclencheurs correspondant à la métrique, la durée et 
la métrique de la sélection doivent être correctement 
définies. De plus, la sélection ne doit contenir aucun 
changement de métrique ou de tempo.

Pour définir une sélection pour Beat Detective :

1 Dans la fenêtre Edit, sélectionnez une plage de 
données audio ou MIDI sur une ou plusieurs 
pistes.

Assurez-vous que les points de début et de fin de la 
sélection tombent précisément sur des temps. Pour 
atteindre les points de début et de fin d'un clip 
audio, faites un zoom au niveau de l'échantillon 
et utilisez la fonction de tabulation vers les 
transitoires (reportez-vous à la section 
« Tabulation vers les transitoires » à la page 587).

2 Sélectionnez Event > Beat Detective.

3 Vous devez définir ou capturer la sélection 
chaque fois que vous créez une nouvelle 
sélection ou changez la table de tempos. Pour 
définir la plage de la sélection, effectuez l'une 
des opérations suivantes :

• Si le tempo et la métrique de la sélection audio 
ne correspondent pas à ceux par défaut de la 
session, entrez la signature rythmique (Time 
Signature), ainsi que les emplacements de début 
(Start Bars|Beats) et de fin (End Bars|Beats). 
Pour une sélection s'étendant sur quatre mesures 
et commençant sur le premier temps, entrez 1|1 
et 5|1.

• Si le tempo et la métrique de la sélection audio ne 
correspondent pas à ceux par défaut de la session et 
si vous ne connaissez pas la durée des données 
enregistrées, entrez la signature rythmique (Time 

Signature), ainsi que l'emplacement de début 
(Start Bars|Beats), puis lancez la lecture et cliquez 
sur le bouton Tap End B|B en suivant le tempo 
pour calculer automatiquement l'emplacement 
de fin (End Bars|Beats). Lorsque vous utilisez le 
bouton Tap End B|B sur de longues sélections, 
continuez à battre la mesure jusqu'à stabilisation de 
la valeur du champ End Bars|Beats. Une fois cette 
valeur stabilisée, il peut être nécessaire d'ajuster 
manuellement la valeur afin qu'elle corresponde 
à la limite de mesure la plus proche.

Pour obtenir les meilleurs résultats possibles 
avec Beat Detective, assurez-vous que le 
passage sélectionné démarre exactement sur 
l'attaque du premier temps. 

Utilisez la lecture en boucle pour vérifier la 
précision de votre sélection.

Pour conserver intacte la sélection d'édition 
tout en lançant la lecture normale ou en 
boucle à partir de n'importe quel 
emplacement, désélectionnez Options > Link 
Timeline and Edit Selection.

Création d'une sélection audio pour Beat Detective

Pour éviter de perdre une sélection existante, 
sauvegardez-la en tant qu'emplacement 
mémoire afin de pouvoir la rappeler 
ultérieurement. Reportez-vous au 
Chapitre 36, « Emplacements mémoire ».
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• Si le tempo et la métrique de la sélection 
correspondent à ceux de la session (reportez-
vous à la section « Calcul du tempo avec Beat 
Detective » à la page 670), et si la sélection est 
correctement alignée sur les mesures et temps de 
la session, cliquez sur le bouton Capture 

Selection. Les valeurs correctes de signature 
rythmique (Time Signature), de point de début 
(Start Bars|Beats) et de fin (End Bars|Beats) 
s'affichent automatiquement.

4 Pour améliorer la précision de Beat Detective 
dans l'analyse de notes basées sur un swing 
marqué, sélectionnez l'option Contains qui 
indique la plus petite subdivision du temps 
contenue dans la sélection. L'option Contains 
propose les valeurs noire, croche, double croche 
(par défaut), triple croche, ainsi qu'une case 
pour les rythmes en triolet. L'option Contains 
sélectionnée détermine les emplacements de la 
grille utilisés pour la création de modèles de 
groove DigiGroove.

Analyse Beat Detective
Beat Detective fournit plusieurs algorithmes 
d'analyse de détection rythmique pour le 
traitement de différents types de contenus audio.

High Emphasis : donne de bons résultats avec les 
sons hautes fréquences de nature inharmonique, 
tels que ceux de cymbales et charleys, et ne prend 
pas en compte les basses fréquences.

Low Emphasis : donne de bons résultats avec les 
sons basses fréquences, tels que ceux d'une guitare 
basse ou d'une grosse caisse, ainsi qu'avec la 
plupart des sons harmoniques, tels que ceux d'un 
piano ou d'une guitare rythmique.

Enhanced Resolution : donne de bons résultats 
avec des contenus large bande, tels que des mix 
entiers et des boucles.

Détection rythmique sur plusieurs pistes

Lorsque vous analysez une sélection sur plusieurs 
pistes, Beat Detective analyse chaque piste 
indépendamment. Des déclencheurs sont ajoutés 
sur toutes les pistes, dès qu'un transitoire est 
détecté sur l'une des pistes, qu'il soit présent ou non 
sur les autres pistes. Toutefois, si des événements 
de plusieurs pistes sont quasiment alignés, Beat 
Detective n'identifiera que le premier transitoire 
détecté de l'événement rythmique global. 

Section Selection de Beat Detective

Tant que les données audio sont correctement 
alignées sur la table de tempos de la session, 
utilisez le bouton Capture Selection chaque 
fois que vous créez une nouvelle sélection ou 
apportez des modifications à la table de 
tempos (changement de tempo ou de métrique 
par exemple).

La définition de la sélection n'est pas 
conservée lorsqu'une session est fermée, puis 
ouverte à nouveau.
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Si vous prenez l'exemple de quatre pistes de batterie 
(grosse caisse, caisse claire et une paire d'overheads), 
les transitoires générés par une attaque apparaissent 
légèrement plus tard sur les pistes des overheads que 
sur celles de la caisse claire et de la grosse caisse. 
En effet, le son met plus de temps à arriver aux 
overheads qu'aux deux autres micros de proximité. 
Si vous créez une sélection sur ces quatre pistes et 
l'analysez avec Beat Detective, seuls les transitoires 
des pistes de la grosse caisse et de la caisse 
claire seront identifiés comme déclencheurs. 
Les transitoires des pistes des overheads sont 
considérés comme faisant partie du même événement 
rythmique (ils sont simplement légèrement en 
retard). Pour plus d'informations sur l'analyse 
individuelle de plusieurs pistes, reportez-vous à la 
section « Utilisation du mode Collection » à la 
page 687.

Calcul du tempo avec Beat 
Detective 
Si vous connaissez la métrique, les points de début 
et de fin d'une sélection audio, vous pouvez utiliser 
Beat Detective pour calculer son tempo.

Pour calculer le tempo d'une sélection avec Beat 
Detective :

1 Créez une sélection d'édition dans la fenêtre 
Edit ou la fenêtre de l'éditeur MIDI (MIDI 
uniquement) et définissez la sélection dans la 
fenêtre Beat Detective, tel qu'expliqué à la 
section « Définition d'une sélection pour Beat 
Detective » à la page 668.

2 Sélectionnez Bar|Beat Marker Generation.

3 Dans la zone Detection (mode Normal), cliquez 
sur Analyze.

4 Réglez le curseur Sensitivity sur 0 %.

5 Cliquez sur Generate.

Des marqueurs Bars|Beats sont automatiquement 
créés au début et à la fin de la sélection, 
et indiquent le tempo et la métrique des données.

Mode de détection de Beat Detective

Génération de marqueurs Bars|Beats avec Beat 
Detective identifiant le tempo et la métrique
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Création de déclencheurs 
rythmiques
Une fois la plage de la sélection définie avec 
précision, Beat Detective peut générer des 
déclencheurs rythmiques sur les transitoires audio 
ou notes MIDI détecté(e)s. Les paramètres de la 
zone Detection permettent d'ajuster l'amplitude et 
le type de transitoires détectés, ce qui permet 
d'affiner la détermination des emplacements des 
mesures, temps et subdivisions des données, 
en évitant la détection d'événements non 
rythmiques.

Pour générer des déclencheurs à partir d'une 
sélection audio:

1 Dans la fenêtre Edit, créez une sélection audio

2 Sélectionnez Audio dans le menu Operation.

3 Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants:

• Bar|Beat Marker Generation

• Groove Template Extraction 

• Clip Separation (audio uniquement)

4 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

5 Sélectionnez un algorithme de détection à partir 
du menu Analysis.

6 Cliquez sur Analyze.

7 En fonction du contenu rythmique de la 
sélection, sélectionnez la résolution Bars 
(mesures), Beats (temps) ou Sub-Beats 
(subdivisions de temps).

8 Ajustez le curseur Sensitivity jusqu'à ce que des 
déclencheurs apparaissent sur les temps et 
subdivisions de temps de la sélection.

Les déclencheurs des mesures apparaissent sous la 
forme de lignes épaisses, les déclencheurs des 
temps sous la forme de lignes d'épaisseur 
moyenne, et les déclencheurs des subdivisions de 
temps sous la forme de lignes fines. 

9 Vous pouvez zoomer au niveau de l'échantillon 
et cliquer sur le bouton Scroll Next pour accéder 
au déclencheur suivant de la sélection. Pour 
revenir au déclencheur précédent, maintenez la 
touche Option (Mac) ou Alt (Windows) 
enfoncée et cliquez sur le bouton Scroll Next 
(reportez-vous à la section « Navigation entre 
des déclencheurs successifs » à la page 676). 
Vous pouvez ainsi vérifier le positionnement 
des différents déclencheurs. Si des « faux 
déclencheurs » apparaissent entre les temps ou 
subdivisions (sur des événements non 
rythmiques), supprimez-les (reportez-vous à la 
section « Suppression de déclencheurs » à la 
page 674), ou réduisez la sensibilité de 
détection (curseur Sensitivity).

10 Pour afficher les emplacements des 
déclencheurs dans les mesures, sélectionnez 
l'option Show Trigger Time.

11 Si les déclencheurs n'apparaissent pas aux 
emplacements corrects, répétez les étapes 
5 à 10 et testez les autres algorithmes d'analyse 
(High ou Low Emphasis).

Déclencheurs rythmiques

MesureTemps Subdivision
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Pour générer des déclencheurs à partir d'une 
sélection MIDI :

1 Dans la fenêtre Edit, activez la vue Notes sur la 
piste MIDI que vous souhaitez utiliser.

2 Dans la fenêtre Edit ou dans une fenêtre de 
l'éditeur MIDI, sélectionnez une plage de notes 
MIDI. Assurez-vous que les points de début et 
de fin de la sélection soient alignés sur des 
emplacements rythmiques pertinents (barres de 
mesure, par exemple).

3 Sélectionnez Event > Beat Detective.

4 Sélectionnez MIDI dans le menu Operation.

5 Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants:

• Bar|Beat Marker Generation

• Groove Template Extraction 

6 Définissez la plage de la sélection. Si le 
tempo et la métrique de la sélection audio ne 
correspondent pas à ceux par défaut de la 
session, entrez la signature rythmique (Time 

Signature), ainsi que les emplacements de début 
(Start Bars|Beats) et de fin (End Bars|Beats). 
Par exemple, pour une sélection s'étendant sur 
quatre mesures et commençant sur le premier 
temps, entrez 1|1 et 5|1.

7 Si votre piste MIDI contient des accords, 
sélectionnez l'un des algorithmes de 
reconnaissance des accords MIDI suivants dans 
le menu Analysis :

• Last Note (dernière note)

• First Note (première note)

• Loudest Note (note la plus forte)

• Average Location (emplacement moyen)

• Highest Note (note la plus aiguë)

• Lowest Note (note la plus grave)

8 Cliquez sur Analyze. 

Reconnaissance des accords 
MIDI
Étant donné que les notes MIDI d'un accord 
peuvent être jouées avec un léger décalage, Beat 
Detective considère les notes jouées dans un 
intervalle de temps rapproché (équivalent à moins 
de la moitié de la valeur de note spécifiée dans la 
section Selection) comme faisant partie d'un même 
accord. 

Beat Detective se base sur le critère sélectionné 
dans le menu Analysis pour interpréter la position 
du temps par rapport aux notes de l'accord.

Last Note : génère le déclencheur sur le début de la 
dernière note jouée dans l'accord.

First Note : génère le déclencheur sur le début de 
la première note jouée dans l'accord.

Loudest Note : génère le déclencheur sur le début 
de la note de l'accord de plus haute vélocité.

Average Location : génère le déclencheur sur un 
point se trouvant à équidistance entre les débuts 
des première et dernière notes jouées dans l'accord.

Highest Note : génère le déclencheur sur le début 
de la note la plus aiguë de l'accord.

Lowest Note : génère le déclencheur sur le début 
de la note la plus grave de l'accord.

Analyse des accords MIDI

Première
note Dernière

note

Note la plus aiguë

Note la plus grave
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Réalignement de session
La fonction Realign Session de Beat Detective 
permet de créer des marqueurs Bars|Beats sans 
décaler les contenus basés sur les références de 
tempo. Cette fonction est utile pour extrapoler des 
marqueurs Bars|Beats à partir de contenus basés 
sur les références de tempo, afin d'aligner la table 
de tempos et la grille Bars|Beats sur ces contenus. 

La création de marqueurs Bars|Beats dans des 
sessions avec du contenu basé sur les références de 
tempo (pistes MIDI et pistes audio basées sur les 
références de tempo, par exemple) peut entraîner 
un décalage de ce contenu en valeur absolue. Cela 
peut être utile pour aligner des contenus basés sur 
les références de tempo sur des marqueurs 
Bars|Beats générés à partir de contenus basés sur 
les échantillons.

Lorsque vous générez des marqueurs Bars|Beats 
dans une session contenant de l'audio ou du MIDI 
basé sur les références de tempo, Beat Detective 
donne la possibilité de préserver la position de ces 
contenus ou d'autoriser leur décalage.

Pour générer des marqueurs Bars|Beats avec Beat 
Detective dans une session contenant des pistes 
basées sur les références de tempo :

1 Dans la fenêtre Edit, effectuez une sélection 
audio ou MIDI

2 Dans la fenêtre Beat Detective, sélectionnez 
Bars|Beats Marker Generation.

3 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

4 Définissez la résolution Bars ou Beats.

5 Cliquez sur Generate. 

6 Effectuez l'une des opérations suivantes :

• Dans la boîte de dialogue Realign Session, 
sélectionnez Preserve Tick Position si vous 
souhaitez autoriser le décalage absolu des 
contenus basés sur les références de tempo.

• Sélectionnez Preserve Sample Position si vous 
préférez maintenir la position absolue des 
contenus basés sur les références de tempo. 
Cette option peut être pratique lors de l'ajout 
d'une table de métriques et de tempos à une 
performance jouée librement.

7 Cliquez sur OK.

Vous pouvez également convertir des contenus 
basés sur les références de tempo (tels que des 
performances MIDI) en contenus basés sur les 
échantillons, puis insérer manuellement des 
marqueurs Bars|Beats.

Boîte de dialogue Realign Session
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Conseils pour une détection 
efficace des déclencheurs
Les conseils suivants vous permettront de vérifier 
le positionnement des déclencheurs :

 Pour vous concentrer sur une zone particulière 
de la sélection, dissociez les sélections d'édition et 
de timeline, puis définissez la plage de lecture en 
cliquant ou en faisant glisser votre souris sur l'une 
des règles de base de temps.

 Observez l'épaisseur des déclencheurs pour 
vérifier s'ils sont correctement alignés avec les 
données audio. Les lignes épaisses correspondent 
aux barres de mesure, les lignes moyennes aux 
temps et les lignes fines aux subdivisions de temps. 

 Sélectionnez l'option Show Trigger Time et 
vérifiez si les emplacements dans les mesures 
(supposés) des déclencheurs correspondent à la 
réalité. Un « faux » déclencheur doit être déplacé 
ou supprimé car il peut décaler le positionnement 
des déclencheurs suivants (reportez-vous à la 
section « Édition des déclencheurs rythmiques » à 
la page 674).

 Évaluez si les sélections longues doivent être 
divisées en sélections plus petites, plus facilement 
gérables. Par exemple, l'utilisation de sections de 8 
ou 4 mesures peut produire des résultats de 
meilleure qualité, plus rapidement. 

 Les déclencheurs sont préservés lorsque vous 
passez du mode audio au mode MIDI. Vous 
pouvez donc vous baser sur des déclencheurs 
MIDI pour l'édition audio, ou même sur un 
mélange de déclencheurs provenant de pistes 
MIDI et audio.

 Pour les sélections englobant plusieurs pistes, 
évaluez s'il est plus simple de travailler sur 
chacune d'entre elles individuellement, ou sur 
l'ensemble. Reportez-vous à la section « Détection 
normale et mode Collection » à la page 687.

Édition des déclencheurs 
rythmiques
Bien que Beat Detective offre une grande 
flexibilité de détection des transitoires, il peut être 
nécessaire de supprimer, déplacer ou insérer 
manuellement quelques déclencheurs. Vous 
pouvez également promouvoir des déclencheurs 
afin qu'ils soient conservés, même à des niveaux de 
sensibilité moins élevés. 

Suppression de déclencheurs
Des « faux » déclencheurs, non alignés sur un 
temps ou une subdivision de temps des données 
source, peuvent apparaître lorsque vous 
augmentez la sensibilité de la détection pour 
l'analyse de contenus de nature peu rythmique. 
Dans ce cas, vous pouvez localiser et supprimer 
manuellement ces faux déclencheurs.

Pour supprimer un déclencheur :

1 La fenêtre Beat Detective étant ouverte, 
sélectionnez l'un des outils de saisie dans la 
fenêtre Edit.

2 Localisez le faux déclencheur à supprimer. 
Les transitoires correspondant à de faux 
déclencheurs présentent généralement des 
crêtes de plus faible amplitude que celles des 
autres déclencheurs, et tombent souvent entre 
des subdivisions de temps.

3 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un déclencheur 
pour le supprimer.

Suppression d'un déclencheur
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Déplacement de déclencheurs
Il est possible d'ajuster la position des déclencheurs 
pour conserver l'attaque de transitoires ou 
légèrement décaler un transitoire spécifique.

Pour déplacer un déclencheur :

1 La fenêtre Beat Detective étant ouverte, 
sélectionnez l'un des outils de saisie dans la 
fenêtre Edit.

2 Localisez le déclencheur que vous souhaitez 
déplacer puis faites-le glisser vers la gauche ou 
la droite.

Insertion de déclencheurs
Si un temps (ou une subdivision de temps) 
important n'est pas détecté du fait d'un niveau trop 
faible, vous pouvez insérer un déclencheur 
manuellement.

Pour insérer un déclencheur :

1 La fenêtre Beat Detective étant ouverte, 
sélectionnez l'un des outils de saisie dans la 
fenêtre Edit.

2 Cliquez dans la sélection à l'endroit où vous 
souhaitez insérer le nouveau déclencheur. 
Une fois le déclencheur inséré, vous pouvez le 
faire glisser vers la gauche ou la droite pour 
ajuster sa position (reportez-vous à la section 
« Déplacement de déclencheurs » à la 
page 675).

Promotion de déclencheurs
Vous pouvez promouvoir certains déclencheurs 
importants afin qu'ils ne soient pas supprimés pas 
lorsque vous réduisez la sensibilité de détection. 
Cela peut être utile pour travailler avec une sélection 
dans laquelle trop de faux déclencheurs on été 
détectés pour pouvoir les supprimer manuellement, 
à un niveau de sensibilité auquel des déclencheurs 
essentiels que vous souhaitez conserver sont 
également affichés. Si ces déclencheurs 
disparaissent lorsque vous réduisez la sensibilité 
de détection, il faut alors les promouvoir.

Pour promouvoir un déclencheur :

1 Augmentez la sensibilité jusqu'à ce que le 
transitoire soit détecté et qu'un déclencheur 
apparaisse.

2 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur le 
déclencheur pour le promouvoir. 

3 Si nécessaire, vous pouvez promouvoir d'autres 
déclencheurs en répétant les étapes 1 et 2.

4 Réduisez la sensibilité jusqu'à ce que les faux 
déclencheurs disparaissent.

Une fois que vous avez promu des déclencheurs, 
ils ne disparaissent que si vous réglez la sensibilité 
à 0 %. Pour rétrograder tous les déclencheurs de la 
sélection et rétablir leur état d'origine, cliquez sur 
le bouton Analyze.

Déplacement d'un déclencheur

Si vous cliquez trop près d'un déclencheur 
existant, il sera déplacé vers le nouvel 
emplacement.

Promotion d'un déclencheur
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Redéfinition de l'emplacement 
d'un déclencheur dans une 
mesure
Il est indispensable que les déclencheurs soient 
positionnés à l'emplacement correct dans une 
mesure. Si un transitoire détecté est légèrement 
hors tempo, Beat Detective peut lui assigner un 
emplacement incorrect dans la mesure, ainsi qu'à 
d'autres transitoires de la sélection.

Si par exemple la note d'un premier temps d'une 
piste de basse a été jouée un peu trop tôt, Beat 
Detective peut l'interpréter comme une note devant 
effectivement être jouée avant ce premier temps. 
Si par la suite vous séparez et conformez au tempo 
le clip qui contient cette note, il sera déplacé sur un 
mauvais emplacement. Cette erreur peut 
également se répercuter sur les clips suivants.

Si un déclencheur n'est pas assigné au bon 
emplacement d'une mesure, réattribuez-lui 
l'emplacement correct à l'aide de la fonction 
Identify Trigger.

Pour modifier l'emplacement d'un déclencheur 
dans une mesure :

1 Double-cliquez sur le déclencheur 
à repositionner. La boîte de dialogue Identify 
Trigger s'ouvre.

2 Dans la boîte de dialogue Identify Trigger, 
entrez l'emplacement correct du déclencheur, 
puis cliquez sur OK. 

Navigation entre des 
déclencheurs successifs
Utilisez le bouton Scroll Next pour passer d'un 
déclencheur au suivant. Pour revenir au déclencheur 
précédent, maintenez la touche Option (Mac) ou 
Alt (Windows) enfoncée et cliquez sur le bouton 
Scroll Next. Cette méthode de navigation est 
particulièrement utile pour l'édition au niveau de 
l'échantillon de déclencheurs successifs.

Génération de marqueurs 
Bars|Beats avec Beat 
Detective
Une fois que Beat Detective a détecté avec 
précision les crêtes des transitoires d'une sélection 
audio et a généré des déclencheurs précis, vous 
pouvez convertir ces derniers en marqueurs 
Bars|Beats. Les marqueurs Bars|Beats générés par 
Beat Detective créent une table de tempos et 
peuvent être utilisés dans toute la session.

Lorsqu'une table de tempos a été générée, d'autres 
clips audio et notes MIDI peuvent être conformés 
aux marqueurs Bars|Beats créés par Beat 
Detective.

Si vous souhaitez aligner des contenus audio à la 
table des tempos existante de la session ou à un 
modèle de groove, il est conseillé de ne pas générer 
de marqueurs Bars|Beats. Il est préférable d'utiliser 
Beat Detective pour séparer et conformer les 
contenus (reportez-vous à la section « Séparation 
de clips avec Beat Detective » à la page 680).

Boîte de dialogue Identify Trigger

Si vous souhaitez simplement aligner un 
passage approximatif avec d'autres pistes, 
il n'est pas utile de générer des marqueurs 
Bars|Beats.
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Pour générer des marqueurs Bar|Beat avec Beat 
Detective :

1 Créez une sélection d'édition.

2 Dans la fenêtre Beat Detective, sélectionnez le 
mode Bar|Beat Marker Generation.

3 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

4 Choisissez la résolution Bars ou Beats et 
configurez le paramètre Detection pour 
permettre la détection précise des crêtes des 
transitoires (ou des attaques de notes MIDI) de la 
sélection (reportez-vous à la section « Création 
de déclencheurs rythmiques » à la page 671).

5 Cliquez sur Generate. 

Des marqueurs Bar|Beat sont alors générés, basés 
sur les positions des déclencheurs, et apparaissent 
sur la règle de tempo.

Utilisation des subdivisions
Le tempo est dérivé des marqueurs Bars|Beats. 
Le groove, ou feeling, est dérivé des subdivisions 
de temps; la déviation des subdivisions du temps 
par rapport à la grille stricte de tempo détermine le 
groove ou feeling. 

Pour extraire le groove d'une sélection, réglez 
la résolution de la détection sur Sub-Beats. 
Ce paramètre permet de prendre en compte les 
rythmes internes à chaque mesure (le cas échéant) 
lors de la génération des marqueurs Bars|Beats. 
Ces marqueurs Bars|Beats peuvent ensuite servir 
à quantifier d'autres clips audio ou pistes MIDI, 
et ainsi de les conformer à ces marqueurs.

Modèles DigiGroove
Beat Detective permet d'extraire les plus infimes 
nuances de la mise en place d'une performance 
rythmique et de les enregistrer en tant que modèle 
de groove, appelé modèle DigiGroove. Les 
DigiGrooves peuvent être enregistrés localement 
dans le presse-papiers de Groove ou sur le disque 
en tant que DigiGrooves. 

Les modèles de groove peuvent être utilisés pour 
reproduire le feeling d'une performance 
particulière sur les éléments suivants :

• Clips audio sélectionnés, mode de conformation 
Groove (reportez-vous à la section « Mode de 
conformation Groove » à la page 684).

• Données MIDI sélectionnées, avec quantification 
sur le groove (reportez-vous à la section 
« Quantification sur un groove » à la page 945).

Marqueurs Bar|Beat générés avec la résolution Bar 
(sur chaque mesure)

Marqueurs Bar|Beat générés avec la résolution Beat 
(sur chaque temps)

Lorsque vous quantifiez des clips ou notes MIDI 
sur des marqueurs Bars|Beats de subdivisions 
de temps correspondant à une rythmique 
« swing », assurez-vous d'utiliser une valeur de 
quantification régulière (et de désactiver 
l'option Swing pour la quantification).
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Les modèles de groove sont des « tables de 
quantification » dérivées de performances 
musicales réelles. Les caractéristiques rythmiques 
de chaque interprétation sont analysées et 
sauvegardées dans un modèle de groove. Beat 
Detective analyse une sélection audio pour détecter 
les crêtes des transitoires en fonction d'un seuil 
défini, et reporte leurs positions rythmiques dans un 
modèle comprenant 960 parties par noire (ppq).

Lors de la création de modèles DigiGroove, Beat 
Detective analyse également la dynamique des 
performances. Les données de vélocité MIDI sont 
sauvegardées à partir des pistes MIDI et les accents 
et niveaux crête sont incorporés dans le modèle de 
groove en tant que données de vélocité, lesquelles 
peuvent être appliquées pour modifier la 
dynamique des pistes MIDI. 

Beat Detective convertit l'amplitude des signaux 
des pistes audio en vélocité MIDI en respectant 
une échelle linéaire. Par exemple :

• Un signal à 0 dBFS équivaut à une vélocité 
MIDI de 127.

• Un signal à -6 dBFS équivaut à une vélocité 
MIDI de 64.

• Un signal à -12 dBFS équivaut à une vélocité 
MIDI de 32.

• Un signal à -48 dBFS équivaut à une vélocité 
MIDI de 1.

Il est très important de capturer ces informations 
afin de préserver le feeling d'une performance, 
et de pouvoir ajouter de la vie à des pistes MIDI 
manquant de dynamique. 

Extraction des modèles de 
groove

Pour extraire un modèle de groove :

1 Dans la fenêtre Edit, créez une sélection 
d'édition (incluant de l'audio ou du MIDI). 
La sélection doit être constituée d'une ou 
plusieurs mesures complètes, en commençant et 
en finissant sur un premier temps.

2 Dans la fenêtre Beat Detective, sélectionnez 
Groove Template Extraction.

3 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

4 Configurez les options de détection de manière 
à détecter avec précision les crêtes des 
transitoires (ou les attaques de notes MIDI) de la 
sélection (reportez-vous à la section « Création 
de déclencheurs rythmiques » à la page 671).

5 Cliquez sur Extract. 

Beat Detective capture les données de durée 
uniquement à partir des pistes MIDI, et non 
des pistes audio.

Lors de l'extraction des modèles de groove, 
la sélection capturée ne doit pas inclure de 
marqueurs Bars|Beats. En effet, la précision 
du modèle de groove serait compromise.
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6 Dans la boîte de dialogue Extract Groove 
Template, entrez des commentaires sur le 
groove. Les commentaires peuvent comporter 
jusqu'à 255 caractères pour décrire le groove. 
Vous pouvez consulter les commentaires en 
cliquant sur le bouton Show Info dans la fenêtre 
Beat Detective.

7 Effectuez l'une des opérations suivantes :

• Pour sauvegarder le modèle extrait et l'utiliser 
dans la session actuelle sans enregistrer le 
fichier de modèle sur le disque, cliquez sur Save 

To Groove Clipboard. Ce modèle sera perdu 
lorsque vous fermerez la session actuelle.

• Pour enregistrer le modèle extrait sur le disque 
afin de l'utiliser dans d'autres sessions ou de le 
partager avec d'autres utilisateurs de Pro Tools, 
cliquez sur Save To Disk. Donnez un nom au 
modèle et cliquez sur Save. Ne modifiez pas 
l'emplacement des dossiers et fichiers de 
modèles DigiGroove ; ils ne seraient plus 
disponibles dans vos sessions. 

• Cliquez sur Cancel pour annuler sans enregistrer 
le modèle. 

Contenu avec swing et création 
de modèles de groove
Lorsque vous définissez la quantité de swing d'une 
sélection, sélectionnez la valeur d'une croche dans 
le champ Contains si la sélection audio est 
caractérisée par un groove basé sur des croches 
dont le swing est marqué. Si la sélection audio est 
plus articulée autour de croches relativement 
régulières, préférez la valeur d'une double-croche 
pour le champ Contains. L'application du modèle 
DigiGroove résultant sur d'autre contenus sera plus 
efficace. Bien qu'un groove puisse être basé sur des 
contenus à la croches sans swing, vous pouvez 
choisir d'appliquer le modèle à des contenus basés 
sur des doubles-croches. Si la résolution rythmique 
du modèle est uniquement à la croche, mais que le 
contenu auquel il est appliqué contient des 
doubles-croches, les doubles-croches adjacentes 
seront mappées sur la même position de croche.

Boîte de dialogue Extract Groove Template

Utilisez des dossiers et des sous-dossiers pour 
organiser les modèles DigiGroove. Toutefois, 
assurez-vous qu'ils sont toujours situés 
à l'emplacement Applications/Avid/ 
Pro Tools/Grooves (Mac) ou 
C:\Program Files\Avid\Pro Tools\Grooves 
(Windows). Les fichiers de modèles de groove 
situés à d'autres emplacements ne seront pas 
disponibles pour les outils Groove Quantize 
ou Beat Detective. 
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Extrapolation de groove
La capacité de Beat Detective à extraire des 
données de tempo à partir de contenus de nature 
diverse est améliorée par la puissance de sa logique 
« d'extrapolation de groove ». L'extrapolation de 
groove génère automatiquement des déclencheurs 
à inclure dans les modèles de groove, même si 
aucune crête de transitoire n'a été détectée. 
Le troisième temps d'une boucle de batterie par 
exemple peut ne contenir aucun son de batterie, 
aucun transitoire ne sera donc détecté, ni aucun 
déclencheur généré. Beat Detective effectuera une 
extrapolation à partir des autres déclencheurs de la 
sélection et créera un déclencheur pour le 
troisième temps du modèle de groove.

Par ailleurs, les déclencheurs extrapolés suivent le 
feeling de ceux créés à partir des crêtes des 
transitoires. Par exemple, si trois déclencheurs ont 
été détectés sur une mesure de grosse caisse et que 
chacun est positionné 20 ticks avant le temps, tout 
déclencheur extrapolé sera également placé 
20 ticks avant le temps.

Séparation de clips avec 
Beat Detective 
(Audio uniquement)

Lorsque des déclencheurs apparaissent dans votre 
sélection, ils peuvent être utilisés pour définir les 
points de début et de fin de nouveaux clips, 
qui peuvent être séparés automatiquement. 
Les nouveaux clips peuvent être conformés à la table 
de tempos existante de la session ou à un modèle de 
groove.

Si vous souhaitez affiner la mise en place 
rythmique de la sélection, sans modifier son 
tempo, commencez d'abord par calculer le tempo 
en générant des marqueurs Bars|Beats (reportez-
vous à la section « Calcul du tempo avec Beat 
Detective » à la page 670).

Pour séparer des clips avec Beat Detective :

1 Dans la fenêtre Edit, créez une sélection audio

2 Dans la fenêtre Beat Detective, sélectionnez 
Clip Separation.

3 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

4 Configurez les options de détection de manière 
à détecter avec précision les crêtes des transitoires 
de la sélection (reportez-vous à la section 
« Création de déclencheurs rythmiques » à la 
page 671).

5 Cliquez sur Separate. 

Les clips sont séparés à chaque déclencheur 
détecté.

Trigger Pad

Lors de la séparation de clips, la fenêtre Beat 
Detective affiche une option nommée Trigger Pad.

Mode de séparation des clips dans les paramètres 
Detection



Chapitre 30 : Beat Detective 681

Entrez une valeur dans ce champ (entre 0 et 50 ms) 
pour ajouter une plage de sécurité aux points de 
début des clips, entre le point de séparation et le 
déclencheur (transitoire). Un espace est ainsi créé 
entre le point de début du clip et le point de 
synchronisation du clip, ce qui assure que la 
portion d'attaque des données demeure intacte.

Lors de la conformation de clips séparés, 
l'emplacement des clips est déterminé par leur point 
de synchronisation (reportez-vous à la section 
« Points de synchronisation » à la page 863). 

séparation sur plusieurs pistes
Vous pouvez utiliser les déclencheurs d'une seule 
piste ou d'un sous-ensemble de pistes, pour séparer 
un groupe de pistes. 

Dans l'exemple suivant, la sélection définie est une 
boucle de batterie composée de deux mesures en 5/4. 
La grosse caisse, la caisse claire, le charley et les 
overheads sont enregistrés sur des pistes différentes.

En analysant la piste de grosse caisse de la boucle, 
avec une résolution configurée sur Beats, Beat 
Detective place des déclencheurs sur les 
transitoires des temps 1 et 4.

L'extension de la sélection aux pistes de caisse 
claire, de charley et des overheads, puis la 
séparation, se traduisent par des clips séparés sur 
chacune des pistes de batterie aux mêmes 
emplacements, basés sur les déclencheurs de la 
piste de grosse caisse. 

Les clips séparés peuvent alors être conformés en 
tant que groupe.

Vous pouvez également utiliser le mode 
Collection lorsque vous travaillez avec plusieurs 
pistes. Le mode Collection permet d'analyser 
et de détecter les déclencheurs de chaque piste 
individuellement et, si vous le souhaitez, 
de n'ajouter que les déclencheurs de la piste 
actuelle à l'ensemble des pistes. Pour plus 
d'informations, reportez-vous à la section 
« Détection normale et mode Collection » à la 
page 687. 

Clip séparé avec une plage de protection de 20 ms

Piste de grosse caisse avec déclencheurs

Début du clip (point
de séparation)

20 ms
Point de synchro 
(déclencheur)

Pistes de grosse caisse, caisse claire, charley et 
overheads avec déclencheurs
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Conformation de clips avec 
Beat Detective 
(Audio uniquement)

Après avoir séparé des clips avec Beat Detective , 
vous pouvez les conformer dans l'un des deux 
modes suivants : 

Mode de conformation Standard : se base sur la 
table (grille) de tempos actuelle de la session.

Mode de conformation Groove : se base sur les 
modèles de groove.

Beat Detective conformera tout clip sélectionné, 
qu'il ait été séparé avec cet outil ou non. Toutefois, 
afin de conformer correctement des clips avec Beat 
Detective, les points de début des clips doivent 
correspondre au début des données à aligner sur les 
mesures et temps de la session. C'est généralement 
le cas pour des clips séparés avec Beat Detective 
(et non créés suite à des opérations de séparation 
ou de trim manuelles).

Mode de conformation Standard
Ce mode est similaire à l'utilisation de la 
commande Clip > Quantize to Grid, mais avec une 
différence importante : en une seule opération, 
Beat Detective peut ajuster la position de tous les 
clips, qu'ils aient un feeling régulier ou swing.

Pour conformer des clips en mode Standard :

1 Dans la fenêtre Beat Detective, sélectionnez 
Clip Conform.

2 Assurez-vous que le mode Standard est 
sélectionné.

3 Dans la fenêtre Edit, sélectionnez les clips 
séparés à conformer, s'ils ne le sont pas déjà. 
Assurez-vous que les points de début et de fin 
de la sélection tombent précisément sur des 
temps.

4 Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué à la 
section « Définition d'une sélection pour Beat 
Detective » à la page 668.

5 Pour définir le degré de conformation des clips 
par rapport à la grille (table de tempos), ajustez 
le curseur Strength ou tapez directement une 
valeur pour spécifier un pourcentage : 

• Les pourcentages faibles préservent le feeling 
rythmique d'origine des clips.

• Les pourcentages élevés entraînent un 
alignement des clips plus précis par rapport à la 
table de tempos, la valeur 100 % correspondant 
à un alignement exact sur la table de tempos.

Options de conformation du mode Standard de Beat 
Detective

Pour « corriger » la mise en place d'une 
performance tout en conservant son feeling, 
positionnez le curseur Strength sur une 
valeur comprise entre 85 et 88 %.
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6 Pour définir les clips à conformer, sélectionnez 
l'option Exclude Within et indiquez une valeur 
en pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre :

• Les pourcentages faibles garantissent que les 
clips les plus éloignés des pas de la grille soient 
conformés et que les clips les plus proches ne le 
soient pas.

• Les pourcentages élevés garantissent que les 
clips plus proches de la grille, ainsi que les plus 
éloignés, soient conformés.

7 Pour obtenir un feeling caractérisé par un swing 
avec les clips conformés, sélectionnez l'option 
Swing et déterminez si le swing est basé sur des 
croches ou des doubles croches, puis indiquez 
une valeur en pourcentage, soit à l'aide du 
curseur, soit en saisissant un nombre :

• Les pourcentages plus faibles produisent moins 
de swing, la valeur 0 % n'en produit aucun.

• Les pourcentages plus élevés produisent 
davantage de swing, la valeur 100 % produit un 
feeling de swing ternaire.

• Les valeurs de pourcentage comprises entre 
100 et 150 déplacent les clips au-delà du swing 
ternaire, tendant vers la double croche suivante 
(à condition d'avoir sélectionné une double-
croche en tant que valeur de note de swing).

8 Cliquez sur le bouton Conform pour conformer 
automatiquement tous les clips de la sélection.

9 Pour écouter les nouveaux clips conformés, 
cliquez sur le bouton Play de la fenêtre de 
transport. 

10 Effectuez l'une des opérations suivantes :

• Si nécessaire, sélectionnez Edit > Undo et 
répétez les étapes 4 à 8 en testant d'autres 
paramètres de conformation.

• Si nécessaire, lissez les points d'édition 
(reportez-vous à la section « Lissage des points 
d'édition » à la page 685).

Pour « corriger » la mise en place d'une 
performance tout en conservant son feeling, 
positionnez le curseur Exclude Within sur 
une valeur comprise entre 10 et 15 %.

Si Beat Detective a capturé suffisamment de 
subdivisions de temps à partir d'une sélection 
avant la séparation, vous pouvez effectuer la 
conformation avec l'option Swing pour faire 
passer le groove d'un feeling « régulier » à un 
feeling « swing ». Vous pouvez également 
importer un modèle de groove basé sur un 
feeling swing (reportez-vous à la section 
« Mode de conformation Groove » à la 
page 684).

Clips conformés avec Beat Detective
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Mode de conformation Groove
Plutôt que d'utiliser une grille basée sur la table de 
tempos de la session, le mode de conformation 
Groove utilise une grille basée sur un modèle de 
groove, ou DigiGroove. Les DigiGrooves peuvent 
être utilisés pour reproduire le feeling d'un passage 
capturé sur des clips audio sélectionnés. Pour plus 
d'informations sur la création de modèles 
DigiGroove, reportez-vous à la section « Modèles 
DigiGroove » à la page 677.

Pour conformer des clips en mode Groove :

1 Dans la fenêtre Beat Detective, sélectionnez 
Clip Conform.

2 Sélectionnez Groove.

3 Dans la fenêtre Edit, sélectionnez les clips 
séparés à conformer, s'ils ne le sont pas déjà. 
Assurez-vous que les points de début et de fin de 
la sélection tombent précisément sur des temps.

4 Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué à la 
section « Définition d'une sélection pour Beat 
Detective » à la page 668.

5 Dans le menu déroulant des modèles de groove, 
sélectionnez Groove Clipboard ou un modèle de 
groove enregistré (pour plus d'informations sur 
la création de modèles de groove, reportez-vous 
à la section « Modèles DigiGroove » à la 
page 677).

6 Pour consulter les commentaires du modèle 
sélectionné, cliquez sur Show Info. 

7 Pour déterminer le degré de conformation des 
clips par rapport au modèle de groove, ajustez le 
curseur Timing ou tapez directement une valeur 
pour spécifier un pourcentage : 

• Les pourcentages faibles préservent le feeling 
rythmique d'origine des clips.

• Les pourcentages élevés entraînent un 
alignement des clips plus précis par rapport à la 
grille du modèle de groove, la valeur 100 % 
correspondant à un alignement exact sur la grille 
du modèle.

• Si le curseur est réglé sur 200 %, les clips sont 
déplacés de deux fois l'intervalle entre 
l'emplacement du clip d'origine et la position de 
l'événement du modèle de référence. 

Par exemple, si une note (une double croche) a été 
jouée à la mesure 1|1|060, et si l'événement du 
modèle correspondant se trouve à l'emplacement 
1|1|073, une valeur de 100 % se traduit par le 
décalage de la note à l'emplacement 1|1|073; 
une valeur de 200 % décale la note à 
l'emplacement 1|1|086. 

Options du mode de conformation Groove de Beat 
Detective

Lors de l'utilisation du mode de conformation 
Groove, la sélection capturée ne doit pas 
inclure de marqueurs Bars|Beats. En effet, 
la précision du modèle de groove serait 
compromise.
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8 Pour conformer les données avant d'appliquer le 
modèle de groove, activez l'option Pre-Process 

Using Standard Conform.

Lorsque cette option est activée, Beat Detective 
conforme les clips selon les paramètres actuels 
du mode Standard courants avant d'appliquer 
le modèle de groove. Pour le traitement de 
performances peu précises, l'option Pre-Process 

using Standard Conform peut produire de 
meilleurs résultats à condition de s'assurer que les 
performances sont mappées sur les mesures, temps 
et subdivisions corrects avant d'appliquer le 
modèle de groove. L'expérimentation est le 
meilleur moyen de déterminer si cette option doit 
être utilisée ou non. 

9 Cliquez sur le bouton Conform pour conformer 
automatiquement tous les clips de la sélection.

10 Pour écouter les nouveaux clips conformés, 
cliquez sur le bouton Play de la fenêtre de 
transport. 

11 Effectuez l'une des opérations suivantes :

• Si nécessaire, sélectionnez Edit > Undo et 
répétez les étapes 4 à 9 en testant un autre 
modèle de groove ou des paramètres de mode 
Groove différents.

• Si nécessaire, lissez les points d'édition 
(reportez-vous à la section « Lissage des points 
d'édition » à la page 685).

Lissage des points d'édition 
(Audio uniquement)

Après avoir conformé des clips, des espaces peuvent 
apparaître entre certains d'entre eux. Ces intervalles 
peuvent produire un résultat peu naturel en lecture.

Beat Detective peut remplir automatiquement les 
espaces entre les clips et même ajouter des fondus 
enchaînés si vous le désirez. Cette option de 
lissage des points d'édition peut être utilisée avec 
des clips qui ont été conformés ou avec une piste 
contenant de nombreux clips (une piste d'effets 
sonores, par exemple), nécessitant des opérations 
de trim et la création de fondus enchaînés. 
Ce processus automatisé de lissage des points 
d'édition des clips peut économiser de nombreuses 
heures d'édition fastidieuse.

Pour appliquer le lissage des points d'édition sur 
des clips conformés :

1 Dans la fenêtre Beat Detective, sélectionnez 
Edit Smoothing.

2 Sélectionnez une option de lissage :

Fill Gaps : cette option réalise une opération de 
trim sur les points de fin des clips pour remplir les 
espaces entre les clips.

Fill And Crossfade : cette option réalise une 
opération de trim sur les points de fin des clips et 
ajouter automatiquement un pré-fondu (en ms) 
directement avant le point de début de chaque clip.

Lors de la conformation d'un passage audio 
à un modèle de groove fortement « swingué », 
l'utilisation de l'option Pre-Process using 
Standard Conform produira souvent de 
meilleurs résultats.

Options de la section Smoothing de Beat Detective
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3 Dans la fenêtre Edit, sélectionnez la plage des 
clips audio conformés à lisser, si ce n'est déjà 
fait. Assurez-vous que les points de début et de 
fin de la sélection tombent précisément sur des 
temps.

4 Cliquez sur le bouton Smooth pour lisser les 
points d'édition des clips sélectionnés.

5 Écoutez le résultat en cliquant sur le bouton 
Play de la fenêtre de transport. 

6 Si nécessaire, sélectionnez Edit > Undo et 
répétez les étapes 2 à 5 et testez une durée de 
fondu différente (Crossfade Length).

Création de points de synchro 
suite au lissage
Après avoir lissé des points d'édition avec Beat 
Detective, des points de synchro (correspondant aux 
points de début des contenus) sont automatiquement 
créés sur les clips conformés. Vous pourrez ainsi 
conformer ultérieurement les clips à une table de 
tempos ou à un modèle de groove différents, 
ou utiliser des paramètres de conformation 
différents. 

Toutefois, les points de synchronisation ne sont 
créés que lorsqu'ils sont nécessaires : si des espaces 
sont créés entre des clips suite à une conformation, 
l'option Fill Gaps de lissage des points d'édition 
appliquera un trim aux clips afin de combler les 
intervalles et un point de synchro sera créé au point 
de début d'origine de chaque clip. Si aucun espace 
n'est présent entre des clips, aucun point de synchro 
ne sera créé suite au lissage des points d'édition.

Consolidation des clips après 
lissage
Le processus de séparation, de conformation et de 
lissage avec Beat Detective peut déboucher sur des 
pistes comportant de nombreux clips et fondus 
enchaînés. Si vous travaillez avec plusieurs pistes, 
la densité de ces points d'édition peut engendrer 
une baisse des performances du système.

Une fois que vous êtes satisfait des résultats 
obtenus avec Beat Detective, il est recommandé de 
mettre à plat les pistes avec la commande 
Consolidate. La commande Consolidate crée un 
seul fichier audio contigu à partir de l'ensemble des 
clips sélectionnés afin de réduire la densité des 
points d'édition dans la session. Reportez-vous à la 
section « Consolidation des clips » à la page 621. 

Clips avant et après lissage des points d'édition

Pour plus d'informations sur les points de 
synchronisation des clips, reportez-vous à la 
section « Points de synchronisation » à la 
page 863.

Si vous ne constatez pas de baisse des 
performances, utilisez la commande Clip Group 
pour éditer et manipuler les clips plus 
simplement. L'arrangement de rythmes découpés 
avec Beat Detective sera ainsi plus efficace, 
particulièrement si vous prévoyez de modifier le 
tempo avec des pistes audio basées sur les 
références de tempo. Pour plus d'informations 
sur les groupes de clips, reportez-vous à la 
section « Groupes de clips » à la page 877.
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Détection normale et mode 
Collection 
Dans certains cas, Beat Detective peut avoir du 
mal à analyser correctement plusieurs pistes avec 
des paramètres de détection identiques. Le mode 
Collection de Beat Detective permet de rassembler 
un ensemble de déclencheurs issus de différentes 
pistes, chacune basée sur des paramètres de 
détection différents, puis d'utiliser cet ensemble de 
déclencheurs pour générer des marqueurs 
Bars|Beats ou des modèles DigiGroove, ou séparer 
de nouveaux clips. Le mode Collection est le seul 
moyen d'analyser et de créer des déclencheurs sur 
une piste et de les appliquer à une autre.

Cette méthode d'ajout sélectif de déclencheurs 
à partir de plusieurs passes d'analyse sur des pistes 
différentes, jusqu'à conserver uniquement les 
déclencheurs dont vous avez besoin, est 
potentiellement bien plus efficace que la 
suppression, l'insertion ou l'ajustement manuel 
de déclencheurs incorrects ou faux.

Pistes de batterie et mode 
Collection
Supposons que vous travailliez sur des pistes de 
grosse caisse, de caisse claire, de toms et 
d'overheads. Si vous lancez l'analyse d'une 
sélection s'étendant sur toutes les pistes, il est 
probable que de faux déclencheurs apparaissent 
lorsque vous augmenterez la sensibilité afin de 
pouvoir détecter les transitoires du charley 
(principalement sur les pistes des overheads). 

Par ailleurs, si vous effectuez l'analyse uniquement 
sur la piste des overheads, les déclencheurs seront 
détectés légèrement en retard par rapport aux 
mêmes événements sur les autres pistes (le son 
mettant plus de temps à parvenir à ces micros). 
Si vous étendez ensuite la sélection aux autres 
pistes de batterie et que vous les séparez, les clips 
des pistes de la grosse caisse, de la caisse claire et 
des toms seront coupés un peu en retard.

Le mode Collection permet d'analyser 
individuellement chaque piste de batterie et 
d'optimiser les paramètres de détection de chaque 
piste jusqu'à obtenir les déclencheurs désirés. 
Les déclencheurs de chaque piste peuvent s'ajouter 
successivement à la collection, mais vous pouvez 
également choisir de ne conserver que ceux d'une 
piste spécifique. La collection de déclencheurs 
résultante peut ensuite être utilisée pour générer 
des marqueurs Bars|Beats ou un modèle 
DigiGroove, ou pour séparer de nouveaux clips.

Utilisation du mode Collection
Le mode Collection est disponible en mode 
Bar|Beat Marker Generation, Groove Template 
Extraction ou Clip Separation (audio uniquement), 
et il est accessible en sélectionnant Collection dans 
le menu Detection.

Avant de consolider une longue sélection sur 
plusieurs pistes, assurez-vous que le système 
dispose de suffisamment de RAM. Reportez-
vous à la section « Spécifications relatives à 
la RAM pour Beat Detective » à la page 666.

Déclencheurs détectés légèrement en retard sur les 
overheads
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Pour utiliser le mode Collection :

1 Dans la fenêtre Edit, créez une sélection audio 
sur une seule piste. Assurez-vous que les points 
de début et de fin de la sélection tombent 
précisément sur des temps.

2 Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants:

• Bar|Beat Marker Generation

• Groove Template Extraction 

• Clip Separation (audio uniquement)

3 Définissez ou capturez la sélection comme 
indiqué à la section « Définition d'une sélection 
pour Beat Detective » à la page 668.

4 Configurez les options de détection de manière 
à détecter avec précision les crêtes des 
transitoires de la sélection (reportez-vous à la 
section « Création de déclencheurs 
rythmiques » à la page 671).

5 Dans le menu déroulant Detection, sélectionnez 
Collection.

6 Dans la zone Detection (mode Collection), 
cliquez sur Add All pour ajouter tous les 
déclencheurs actuels à la collection. 

7 Dans le menu déroulant Detection, sélectionnez 
Normal et déplacez la sélection sur la piste 
suivante à analyser. Assurez-vous que la plage 
de sélection soit identique pour chaque piste. 

8 Configurez les options de détection de manière 
à détecter avec précision les crêtes des 
transitoires de la sélection (reportez-vous 
à la section « Création de déclencheurs 
rythmiques » à la page 671).

9 Sélectionnez de nouveau le mode Collection.

10 Effectuez l'une des opérations suivantes :

• Dans la zone Detection (mode Collection), 
cliquez sur Add Unique pour n'ajouter que les 
déclencheurs uniques de la piste à la collection. 
Lorsque vous choisissez d'ajouter des 
déclencheurs uniques, Pro Tools recherche les 
déclencheurs situés à proximité d'autres 
déclencheurs déjà collectés à partir d'autres 
pistes. Lorsque des déclencheurs existent déjà, 
les nouveaux déclencheurs détectés sont annulés.

• Cliquez sur Add All pour ajouter tous les 
déclencheurs à la collection.

• Cliquez sur Clear All pour supprimer tous les 
déclencheurs de la collection.

Chaque nouvel ensemble de déclencheurs ajouté 
à la collection apparaît dans une couleur 
différente. Si des déclencheurs de la collection se 
suivent de très près (un événement capté par deux 
micros, par exemple), Beat Detective ne conserve 
que les déclencheurs dont la position est la plus 
en amont.

Options du mode Collection de Beat Detective

Pour déplacer la sélection vers le haut, 
appuyez sur Ctrl+P (Mac) ou Démarrer+P 
(Windows) ; pour déplacer la sélection vers le 
bas, appuyez sur Ctrl+Point-virgule (Mac) ou 
Démarrer+Point-virgule (Windows).

Après avoir activé le focus clavier sur les 
commandes, appuyez sur la touche P du 
clavier de votre ordinateur pour déplacer la 
sélection vers le haut, ou sur la touche Point-
virgule (;) pour la déplacer vers le bas. 
Maintenez la touche Maj enfoncée pour 
ajouter la nouvelle piste à la sélection actuelle.
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11 Répétez les étapes 7 à 10 pour chaque piste 
supplémentaire à analyser.

Les déclencheurs stockés dans le mode Collection 
sont sauvegardés avec les sessions. Cela signifie 
que lorsque vous rouvrez une session, les données 
de la collection précédente sont à votre disposition 
(jusqu'à ce que vous les supprimiez). 

12 Une fois que les déclencheurs ont été ajoutés à la 
collection, vous pouvez les utiliser pour créer des 
marqueurs Bars|Beats ou un modèle de groove, 
ou séparer de nouveaux clips. Néanmoins, cette 
opération doit être réalisée à partir de la section 
du mode Collection (lorsque les déclencheurs 
sont affichés dans plusieurs couleurs).

Piste des overheads avec déclencheurs collectés à partir des déclencheurs uniques des pistes de grosse caisse, 
caisse claire et charley

1.Déclencheurs détectés sur la piste 
de grosse caisse ajoutés à la 
collection

2.Déclencheurs uniques détectés 
sur la piste de caisse claire 
ajoutés à la collection

3.Déclencheurs uniques détectés 
sur la piste de charley ajoutés à 
la collection

4.Déclencheurs collectés appliqués 
à la piste des overheads

Pour séparer des clips sur plusieurs pistes, 
veillez à étendre la sélection à toutes les pistes 
supplémentaires avant d'effectuer la 
séparation.
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Chapitre 31 : Édition MIDI

Pro Tools inclut des outils d'édition MIDI 
puissants. Vous pouvez créer et éditer des notes 
MIDI individuelles et des événements de 
contrôleur à l'aide du Crayon, de l'outil de 
trimming et de la Main dans la fenêtre Edit, 
des fenêtres de l'éditeur MIDI (reportez-vous au 
Chapitre 32, « Éditeurs MIDI ») et de la fenêtre de 
l'éditeur de partition (reportez-vous au 
Chapitre 33, « Éditeur de partition »). 

Vous pouvez transformer de manière destructive 
des groupes de notes MIDI et modifier la hauteur, 
la mise en place rythmique, la dynamique et le 
phrasé grâce aux différentes commandes Event 
Operations, telles que Quantize, Transpose, 
Change Velocity et Change Duration (reportez-
vous au Chapitre 41, « Opérations d'événement »). 

Il est également possible d'utiliser les propriétés en 
temps réel pour affecter de façon non destructive 
les données MIDI présentes sur les pistes, ou 
reçues en entrée (reportez-vous à la section 
« Propriétés MIDI en temps réel » à la page 725). 

Pro Tools offre, en outre, une multitude d'outils de 
zoom et d'affichage optimisés pour l'édition MIDI.

Options d'édition MIDI
Pro Tools propose quelques options permettant de 
déterminer le fonctionnement de l'édition MIDI. 
Ces options sont disponibles dans la fenêtre Edit 
et les fenêtres des éditeurs MIDI et de partition. 
Toutefois, ces options sont uniquement 
disponibles si au moins une piste MIDI ou 
d'instrument est présente dans votre session 
Pro Tools.

Lecture des notes MIDI lors de 
leur édition
Lorsqu'elle est activée, l'option Play MIDI Notes 
When Editing permet d'entendre les notes MIDI 
(envoi d'un message MIDI Note On) en cours 
d'édition. 

Durée de note par défaut
Le paramètre Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement. La fenêtre Edit, les fenêtres de 
l'éditeur MIDI et la fenêtre de l'éditeur de partition 
peuvent toutes disposer d'un paramètre Default 
Note Duration différent.

Pour plus de détails sur l'édition des contenus 
audio et MIDI des clips, reportez-vous au 
Chapitre 27, « Édition des clips et sélections ».

Commandes d'édition MIDI dans la fenêtre Edit

Lecture des notes MIDI
lors de leur édition

Vélocité d'attaque par défaut

Durée de note par défaut
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Pour sélectionner une durée de note par défaut :

1 Cliquez sur le paramètre Default Note Duration 
dans la fenêtre Edit, une fenêtre de l'éditeur 
MIDI ou la fenêtre de l'éditeur de partition.

2 Sélectionnez la valeur de la durée de note par 
défaut de votre choix. Par exemple, sélectionnez 
l'option 1/4 Note pour insérer des noires à l'aide 
du Crayon.

Le paramètre Default Note Duration se met à jour 
et affiche la valeur de note sélectionnée.

3 Pour définir une valeur de durée pointée ou en 
triolet, effectuez l'une des opérations suivantes :

• Pour pointer la valeur Default Note Duration 
sélectionnée, cliquez sur le paramètre Default 
Note Duration et sélectionnez Dotted.

• Pour faire de la valeur Default Note Duration 
sélectionnée un triolet, cliquez sur le paramètre 
Default Note Duration et sélectionnez Triplet.

Follow Grid

Sélectionnez l'option Follow Grid afin que la valeur 
Default Note Duration suive la valeur de grille 
sélectionnée. Pour ne plus suivre la valeur de 
grille, sélectionnez la valeur rythmique pour le 
paramètre Default Note Duration.

Vélocité d'attaque par défaut
Le paramètre Default Note On Velocity permet de 
définir la vélocité de l'attaque (Note On) par défaut 
des notes insérées manuellement. La fenêtre Edit, 
les fenêtres de l'éditeur MIDI et la fenêtre de 
l'éditeur de partition peuvent toutes disposer d'un 
paramètre Default Note On Velocity différent.

Pour définir la valeur Default Note On Velocity, 
effectuez l'une des opérations suivantes :

 Cliquez sur le paramètre Default Note On 
Velocity dans la fenêtre Edit, une fenêtre de 
l'éditeur MIDI ou la fenêtre de l'éditeur de 
partition et faites glisser votre souris vers le haut 
ou le bas.

 Cliquez sur le paramètre Default Note On 
Velocity dans la fenêtre Edit, une fenêtre de 
l'éditeur MIDI ou la fenêtre de l'éditeur de 
partition, saisissez une nouvelle valeur et 
appuyez sur la touche Entrée.

Sélection d'une durée de note par défaut dans la 
fenêtre Edit

Noire sélectionnée comme durée de note par défaut

Vélocité d'attaque par défaut
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Édition MIDI en miroir
Le mode d'édition MIDI en miroir permet d'éditer 
des clips MIDI et d'appliquer vos modifications 
à chaque copie du même clip MIDI. Elle est 
particulièrement utile lors de l'édition de clips 
MIDI en boucle.

Pour activer l'édition MIDI en miroir, effectuez l'une 
des opérations suivantes :

 Sélectionnez Options > Mirror MIDI Editing.

 Activez le bouton du mode d'édition MIDI en 
miroir dans la fenêtre Edit, une fenêtre de 
l'éditeur MIDI ou la fenêtre de l'éditeur de 
partition.

En mode d'édition MIDI en miroir, le bouton 
clignote une fois en rouge dès que vous effectuez 
une opération d'édition, pour vous alerter que 
l'opération est appliquée à plus d'un clip.

Pour désactiver l'édition MIDI en miroir, effectuez 
l'une des opérations suivantes :

 Désélectionnez Options > Mirror MIDI Editing.

 Désactivez le bouton du mode d'édition MIDI 
en miroir dans la fenêtre Edit, la fenêtre de 
l'éditeur MIDI ou la fenêtre de l'éditeur de 
partition.

Définition de la valeur 
de grille
Lors de l'insertion de notes MIDI à l'aide du 
Crayon, la valeur de grille détermine entre autres 
l'emplacement de l'attaque de chaque note (Note 
On), ou d'autres caractéristiques, en fonction de la 
forme du Crayon (reportez-vous à la section 
« Utilisation du Crayon » à la page 696). 
La fenêtre Edit, les fenêtres de l'éditeur MIDI et la 
fenêtre de l'éditeur de partition peuvent chacune 
utiliser une valeur de grille différente.

Pour définir la valeur de grille pour l'édition MIDI :

1 Cliquez sur le sélecteur de valeur de grille et 
sélectionnez Bars|Beats. Si l'option Follow Main 

Time Scale est activée, vous pouvez simplement 
définir l'échelle temporelle principale sur 
Bars|Beats (reportez-vous à la section 
« Définition de l'échelle temporelle principale » 
à la page 792).

2 Dans le sélecteur de valeur de grille, 
sélectionnez une valeur de note 
(par exemple 1/4, 1/8 ou 1/16).

Bouton du mode d'édition MIDI en miroir dans la 
fenêtre Edit

Lorsque le mode d'édition MIDI en miroir est 
désactivé et que vous éditez des notes de clips 
mis en boucle en vue Notes, la boucle est mise 
à plat. De la même manière, l'édition de 
groupes de clips a pour effet de les séparer.

Sélection de la valeur de grille dans la fenêtre Edit
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3 Pour définir une valeur pointée ou en triolet, 
effectuez l'une des opérations suivantes :

• Pour pointer la valeur de grille sélectionnée, 
cliquez de nouveau sur le sélecteur de valeur de 
grille et sélectionnez Dotted.

• Pour faire de la valeur de grille sélectionnée un 
triolet, cliquez de nouveau sur le sélecteur de 
valeur de grille et sélectionnez Triplet.

4 Vérifiez la métrique et le tempo par défaut 
de la session (reportez-vous aux sections 
« Configuration de la métrique de la session » à 
la page 439 et « Configuration du tempo de la 
session » à la page 440).

Pour afficher (ou masquer) les lignes de la grille 
dans la fenêtre Edit ou une fenêtre de l'éditeur 
MIDI :

 Sélectionnez (ou désélectionnez) le bouton 
Grid.

Utilisation du Crayon
Le Crayon sert à créer et éditer des données MIDI. 
Les cinq premières formes du Crayon (Main levée, 
ligne, triangle, carré et aléatoire) permettent de 
créer des notes MIDI avec des durées et des 
vélocités différentes. Dans la fenêtre Edit, 
les fenêtres de l'éditeur MIDI et la fenêtre de 
l'éditeur de partition, les vélocités des notes 
sont déterminées par la forme du Crayon. 
Les différentes formes du Crayon peuvent s'avérer 
particulièrement utiles pour le dessin et l'édition de 
différents types de données MIDI. Vous pouvez 
par exemple utiliser la forme ligne pour le volume, 
la forme triangle pour le panoramique, les formes 
carré et aléatoire pour la vélocité et la main levée 
pour le pitch bend.

Pour sélectionner la forme du Crayon :

1 Dans la barre d'outils, cliquez sur l'icône du 
Crayon pour afficher le menu des formes 
disponibles.

2 Sélectionnez une forme de Crayon.

Pour plus d'informations sur le mode Grid, 
reportez-vous à la section « Mode Grid » à la 
page 545.

Bouton Grid sélectionné dans la fenêtre Edit

Les formes de Crayon Parabolic et S-Curve 
servent à définir des événements de tempo 
dans l'éditeur de tempo uniquement. 
Reportez-vous à la section «Dessin 
d'événements de tempo» à la page 805.

Formes de Crayon disponibles pour le MIDI
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Formes de Crayon pour le MIDI

Free Hand

Dans la fenêtre Edit pour les pistes MIDI ou 
d'instrument en vue Notes, dans les fenêtres de 
l'éditeur MIDI et dans l'éditeur de partition, la forme 
Free Hand du Crayon insère une seule note MIDI 
dont la vélocité est définie par le paramètre Default 
Note On Velocity. La hauteur, l'emplacement et la 
durée de la note dépendent de l'endroit où vous 
cliquez sur la piste.

Lors de l'édition des vélocités ou de données de 
contrôleur MIDI, la forme Free Hand permet de 
dessiner librement en suivant le mouvement de la 
souris. La forme est reproduite sous forme d'une 
série de paliers, conformément à la préférence 
Pencil Tool Resolution When Drawing Controller 
Data MIDI.

Line

Dans la fenêtre Edit pour les pistes MIDI ou 
d'instrument en vue Notes, dans les fenêtres de 
l'éditeur MIDI et dans l'éditeur de partition, la forme 
Line du Crayon insère une série de notes MIDI de 
même hauteur et dont la vélocité est définie par le 
paramètre Default Note On Velocity. La durée 
des notes insérées et l'espace entre celles-ci sont 
déterminés par la valeur de grille actuelle et par la 
valeur Default Note Duration.

Lors de l'édition des vélocités ou des données de 
contrôleur MIDI, la forme Line du Crayon permet 
de tracer une ligne droite à partir de l'emplacement 
où vous cliquez. Les valeurs de contrôleur continu 
MIDI se transforment en une série de paliers selon 
la résolution définie pour le paramètre Pencil Tool 

Resolution When Drawing Controller Data des 
préférences MIDI.

Triangle

Dans la fenêtre Edit pour les pistes MIDI ou 
d'instrument en vue Notes, dans les fenêtres de 
l'éditeur MIDI et dans l'éditeur de partition, la forme 
Triangle du Crayon insère une série de notes MIDI 
de même hauteur et dont la vélocité varie entre la 
valeur Default Note On Velocity et la valeur 127, 
formant ainsi des dents de scie. La durée des notes 
insérées et l'espace entre celles-ci sont déterminés 
par la valeur de grille actuelle et par la valeur 
Default Note Duration.

Lors de l'édition de vélocités ou de données de 
contrôleur MIDI, la forme Triangle du Crayon 
permet de tracer une ligne en dents de scie qui 
dépend de la valeur de grille actuelle. Les valeurs de 
contrôleur MIDI se transforment en une série de 
paliers selon la résolution définie pour le paramètre 
Pencil Tool Resolution When Drawing Controller 

Data des préférences MIDI.

Square

Dans la fenêtre Edit pour les pistes MIDI ou 
d'instrument en vue Notes, dans les fenêtres de 
l'éditeur MIDI et dans l'éditeur de partition, 
la forme Square du Crayon insère une série de 
notes MIDI de même hauteur et dont la vélocité 
alterne entre la valeur du paramètre Default Note 
On Velocity et 127. La durée des notes insérées et 
l'espace entre celles-ci sont déterminés par la 
valeur de grille actuelle et par la valeur Default 
Note Duration.

Lors de l'édition de vélocités ou de données de 
contrôleur MIDI, la forme Square du Crayon 
permet de tracer des paliers successifs qui se 
répètent en fonction de la valeur de grille actuelle.



Guide de référence Pro Tools698

Random

Dans la fenêtre Edit pour les pistes MIDI ou 
d'instrument en vue Notes, dans les fenêtres de 
l'éditeur MIDI et dans l'éditeur de partition, 
la forme Random du Crayon insère une série de 
notes MIDI de même hauteur et dont la vélocité 
varie de manière aléatoire entre la valeur du 
paramètre Default Note On Velocity et 127. 
La durée des notes insérées et l'espace entre celles-
ci sont déterminés par la valeur de grille actuelle et 
par la valeur Default Note Duration.

Lors de l'édition de vélocités ou de données de 
contrôleur MIDI, la forme Random du Crayon 
permet de tracer une série de valeurs aléatoires qui 
varient en fonction de la valeur de grille actuelle.

Insertion de notes MIDI
En plus de pouvoir enregistrer en mode normal ou 
pas à pas et importer du MIDI dans Pro Tools, 
vous pouvez insérer manuellement des notes MIDI 
à l'aide du Crayon. 

Pour insérer une note MIDI sur une piste dans la 
fenêtre Edit :

1 Dans la fenêtre Edit, affichez la piste MIDI ou 
d'instrument en vue Notes. 

2 Sélectionnez le Crayon et assurez-vous que la 
forme Free Hand est activée. Le curseur se 
transforme en Crayon lorsque vous le placez sur 
la playlist d'une piste MIDI ou d'une piste 
d'instrument en vue Notes.

3 Pour insérer des noires sur les temps, effectuez 
les opérations suivantes :

• Définissez l'échelle temporelle principale sur 
Bars|Beats.

• Sélectionnez le mode d'édition Grid.

• Définissez la valeur de grille sur ¼ Note (noire).

• Définissez la valeur Default Note Duration sur 
¼ Note (ou sur Follow Grid).

4 Déplacez le Crayon dans la zone de la playlist 
de la piste MIDI ou d'instrument. Utilisez la 
règle de la fenêtre Edit et le mini-clavier de la 
piste pour repérer la hauteur et l'emplacement 
temporel souhaités.

Lorsque le Crayon est activé, la position et la 
hauteur de note de l'emplacement ciblé par le 
curseur sont affichées dans la barre d'outils de la 
fenêtre.

5 Lorsque vous avez atteint la hauteur de note et 
l'emplacement temporel, cliquez pour créer 
la note.

Lorsque vous insérez des notes MIDI ou 
d'autres données MIDI avec le Crayon, des 
limites de clip MIDI sont créées sur les barres 
de mesure les plus proches.

Position et hauteur de note ciblées par le curseur

Note MIDI insérée avec le Crayon

Hauteur de note ciblée par le curseur
Curseur du Crayon

Position du curseur sur la timeline
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La vélocité des notes insérées est déterminée par le 
paramètre Default Note On Velocity. La durée est 
déterminée par la valeur Default Note Duration. 
En mode Grid, l'emplacement de l'attaque de la 
note est déterminé par la valeur de grille. 

Si l'option Play MIDI Notes when Editing est 
activée, un son est émis à chaque fois qu'une note 
est insérée.

Vous pouvez faire glisser le Crayon après avoir 
cliqué (et avant d'avoir relâché le bouton de la 
souris), pour ajuster la hauteur et la durée de la 
note. Faites glisser la souris vers la droite pour 
allonger la note sans en modifier le point de début 
et vers la gauche pour raccourcir la note sans en 
modifier le point de fin.

Insertion d'une série de 
notes
Dans la fenêtre Edit et dans les fenêtres de l'éditeur 
MIDI, les différentes formes du Crayon (ligne, 
triangle, carré et aléatoire) permettent d'entrer une 
série de hauteurs identiques avec des vélocités 
différentes. La durée des notes insérées et l'espace 
entre celles-ci sont déterminés par la valeur de 
grille actuelle et par la valeur Default Note 
Duration. 

Lorsque la valeur Default Note Duration est 
supérieure à la valeur de grille, les notes insérées 
sont tronquées afin de correspondre à la valeur de 
grille et éviter les chevauchements.

Les vélocités des notes sont déterminées par la 
forme du Crayon.

• Utilisez la forme Line pour entrer des notes avec 
des vélocités identiques.

• Utilisez la forme Triangle pour créer des rampes 
de vélocités vers le haut et vers le bas. 

• Utilisez la forme Square pour alterner entre 
vélocités hautes et basses. 

• Utilisez la forme Random pour insérer une série 
de notes avec des vélocités aléatoires.

Activez l'outil Smart (reportez-vous à la 
section « Utilisation de l'outil Smart » à la 
page 566) et cliquez en maintenant la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée 
pour changer le curseur en Crayon, puis 
insérez les notes MIDI ; cliquez tout en 
maintenant les touches Option+Ctrl (Mac) 
ou Alt+Démarrer (Windows) enfoncées pour 
supprimer des notes.

En mode Grid, le point de début de la note 
MIDI est aligné par défaut sur la limite de 
grille la plus proche. Avec la forme Free 
Hand du Crayon, cliquez et maintenez le 
bouton de la souris enfoncé, puis appuyez sur 
la touche Ctrl (Windows) ou Commande 
(Mac) pour désactiver momentanément 
l'alignement sur la grille.

Ajustement de la durée d'une note insérée

En mode Grid, le point de fin de la note MIDI 
est aligné par défaut sur la limite de grille la 
plus proche. Pour désactiver momentanément 
l'alignement sur la grille, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
pendant que vous faites glisser le Crayon.
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Par exemple, pour insérer une série de notes avec 
des vélocités aléatoires dans la fenêtre Edit :

1 Dans la fenêtre Edit, affichez la piste MIDI ou 
d'instrument en vue Notes. 

2 Sélectionnez le Crayon et assurez-vous que la 
forme Random est activée.

3 Pour insérer des noires consécutives sur chaque 
temps, effectuez les opérations suivantes :

• Définissez l'échelle temporelle principale sur 
Bars|Beats.

• Sélectionnez le mode d'édition Grid.

• Définissez la valeur de grille sur ¼ Note (noire).

• Définissez la valeur Default Note Duration sur 
¼ Note (ou sur Follow Grid).

Avec ces paramètres, les notes insérées seront 
espacées d'une noire.

4 Cliquez sur le point où sera insérée la première 
note, puis faites glisser la souris vers la droite 
jusqu'à atteindre le nombre de notes souhaité.

Édition manuelle des notes 
MIDI
Vous pouvez éditer tous les aspects d'une note 
MIDI à partir de la fenêtre Edit ou d'une fenêtre de 
l'éditeur MIDI : ses points de début et de fin, 
sa durée, sa hauteur et sa vélocité. Le Sélecteur, 
la Main et le Crayon permettent de travailler sur 
des notes individuelles ou des groupes de notes.

Sélection de notes MIDI
Vous devez sélectionner les notes MIDI avant de 
pouvoir les éditer.

Pour sélectionner des notes MIDI, effectuez l'une 
des opérations suivantes :

 Avec le Crayon ou l'un des outils de saisie, 
cliquez sur chaque note en maintenant la touche 
Maj enfoncée.

 Avec un outil de saisie, positionnez le curseur 
à un emplacement vide (le rectangle de 
sélection apparaît) et dessinez un rectangle 
autour du groupe de notes à éditer.

Lorsque vous utilisez un outil de saisie, si une 
partie du rectangle touche une note (que ce soit son 
point de début ou de fin), celle-ci est incluse dans 
la sélection. Toutefois, les sélections créées avec 
un outil de saisie sont des sélections d'objet et 
n'incluent pas les données sous-jacentes de 
contrôleur et d'automation de la piste MIDI.

Insertion d'une série de notes avec le Crayon

Sélection de notes à l'aide d'un outil de saisie
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 Faites glisser le Sélecteur sur une plage 
de notes.

Lorsque vous utilisez le Sélecteur, une note n'est 
sélectionnée que si son point de début est inclus. 
Lorsqu'une piste MIDI ou d'instrument est en vue 
Notes ou Clips, les sélections créées à l'aide du 
Sélecteur sont des sélections de plage et incluent 
toutes les données sous-jacentes de contrôleur et 
d'automation.

Pour désélectionner une ou plusieurs notes :

 Avec le Crayon ou un outil de saisie, cliquez sur 
les notes tout en appuyant sur la touche Maj.

Sélection et écoute de notes 
MIDI à l'aide du mini-clavier
Le mini-clavier permet de sélectionner et de jouer 
des notes sur les pistes MIDI et d'instrument. Vous 
pouvez cliquer sur le mini-clavier avec n'importe 
quel outil d'édition.

Pour jouer une note sur une piste MIDI ou 
d'instrument et sélectionner toutes les notes de 
même hauteur sur la piste :

 Sélectionnez un outil d'édition, puis cliquez sur 
une touche du mini-clavier.

Sélection de notes avec le Sélecteur

Avec le Sélecteur, maintenez la touche Alt 
(Windows) ou Option (Mac) enfoncée et 
cliquez pour afficher le Sélecteur de notes 
dans la fenêtre Edit et les fenêtres de l'éditeur 
MIDI (le Sélecteur crée toujours des sélections 
de notes dans l'éditeur de partition). 
Le Sélecteur de notes sélectionne en tant 
qu'objets toutes les notes MIDI sur la durée de 
la sélection et ne sélectionne aucun autre 
événement MIDI (tel que des données de 
contrôleur ou des changements de 
programmes).

Vous pouvez également sélectionner des 
notes dans la fenêtre Select/Split Notes. 
Reportez-vous à la section « Commande 
Select/Split Notes » à la page 960.

Note jouée sur le mini-clavier avec sélection de toutes 
les notes de même hauteur

Pour jouer une note sans créer de sélection, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée.

Pour sélectionner et désélectionner des notes 
et créer des sélections non contiguës, cliquez 
sur les notes souhaitées en maintenant la 
touche Commande (Mac) ou Ctrl (Windows) 
enfoncée.
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Pour sélectionner et jouer une plage de notes sur 
une piste MIDI ou d'instrument :

 Sélectionnez un outil d'édition, cliquez sur une 
touche, puis faites glisser votre souris vers le 
haut ou le bas sur le mini-clavier.

Sélection des notes MIDI 
uniquement à l'aide du 
Sélecteur de notes
Lorsque les pistes MIDI et d'instrument sont 
affichées en vue Notes ou Velocity dans la fenêtre 
Edit ou dans une fenêtre de l'éditeur MIDI, 
le Sélecteur crée une sélection de plage temporelle 
qui inclut tous les types d'événements MIDI en 
plus des notes et vélocités MIDI (tels que les 
changements de programme et les données de 
contrôleur continu). Le Sélecteur de notes peut être 
utilisé pour sélectionner uniquement les notes et 
vélocités MIDI dans une sélection de plage 
temporelle. 

Pour sélectionner uniquement des notes et 
vélocités MIDI avec le Sélecteur de notes :

1 Activez le Sélecteur.

2 Sur des pistes MIDI ou d'instrument dans la 
fenêtre Edit en vue Notes ou Velocity ou dans 
une fenêtre de l'éditeur MIDI, maintenez la 
touche Alt (Windows) ou Option (Mac) 
enfoncée, cliquez et faites glisser votre souris 
sur la plage temporelle incluant les notes 
à sélectionner.

Lorsque vous utilisez l'outil Smart en maintenant 
la touche Alt (Windows) ou Option (Mac) 
enfoncée, le Sélecteur est disponible dans la partie 
supérieure de la piste et le Sélecteur de notes dans 
la partie inférieure.

Plage de notes jouée avec le mini-clavier et sélection 
de toutes les notes situées dans cette plage

Vous pouvez également cliquer sur le mini-
clavier en maintenant la touche Maj enfoncée 
pour étendre ou réduire la plage de notes.

Sélection des notes MIDI uniquement à l'aide du 
Sélecteur de notes
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Utilisation des outils de 
saisie
Utilisez les outils de saisie afin de sélectionner, 
séparer ou déplacer des clips sur des pistes. Trois 
versions de l'outil de saisie sont disponibles : outil 
de saisie du temps, outil de séparation et outil de 
saisie d'objet. Pour en savoir plus sur l'organisation 
des clips, reportez-vous au Chapitre 37, 
« Organisation des clips ».

Transposition des notes
Vous pouvez transposer les notes MIDI en les 
faisant glisser vers le haut ou le bas avec un outil 
de saisie ou le Crayon. Si plusieurs notes sont 
sélectionnées avant de faire glisser l'outil de saisie, 
elles sont toutes transposées.

Pour transposer une note MIDI :

1 Affichez la piste MIDI ou d'instrument en vue 
Notes.

2 Sélectionnez le Crayon ou un outil de saisie.

3 Tout en maintenant la touche Maj enfoncée, 
faites glisser la note vers le haut ou le bas.

La touche Maj garantit que la note transposée 
conserve son point de début d'origine. 

Vous entendez les notes à mesure que vous les faites 
glisser et l'indicateur de valeur d'emplacement du 
curseur (dans la fenêtre Edit) indique le nombre de 
demi-tons et le sens (+/-) de la transposition.

Déplacement des notes
Tout comme pour les clips, vous pouvez déplacer 
les notes MIDI vers la gauche ou la droite avec un 
outil de saisie ou le Crayon pour changer leur point 
de début. Si plusieurs notes sont sélectionnées 
avant de faire glisser la sélection, elles sont 
déplacées ensemble.

Pour déplacer une note MIDI :

1 Affichez la piste MIDI ou d'instrument en vue 
Notes.

2 Avec un outil de saisie ou le Crayon, faites 
glisser la note vers la gauche ou la droite 
(appuyez sur Maj pour conserver la hauteur 
de la note).

Au fur et à mesure que vous faites glisser la note, 
l'indicateur de valeur d'emplacement du curseur 
(dans la fenêtre Edit) affiche le nouveau point de 
début.

Transposition à l'aide d'un outil de saisie

Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et appuyez sur la touche 
Plus (+) du pavé numérique pour transposer 
les notes MIDI sélectionnées d'un demi-ton 
vers le haut, ou sur la touche Moins (–) pour 
les transposer d'un demi-ton vers le bas.

Pour transposer une copie de la note sans 
modifier la note originale, maintenez la touche 
Option (Mac) ou Alt (Windows) enfoncée 
pendant que vous faites glisser la note.

Les notes MIDI peuvent également être 
transposées à l'aide d'une opération de 
transposition d'événement (reportez-vous à la 
section « Transpose » à la page 958) ou des 
propriétés MIDI en temps réel (reportez-vous 
à la section « Propriétés MIDI en temps réel » 
à la page 725). 
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En mode d'édition Grid, la note déplacée s'aligne 
sur la limite de grille la plus proche. En mode 
d'édition Spot, la boîte de dialogue Spot s'ouvre.

Trim des points de début et de 
fin d'une note
Tout comme pour les clips, vous pouvez ajuster les 
points de début et de fin des notes MIDI avec 
l'outil de trim. Si plusieurs notes sont sélectionnées 
lorsque vous utilisez l'outil de trim, elles sont 
toutes modifiées.

Pour ajuster la position des points de début ou de 
fin d'un groupe de notes MIDI :

1 Affichez la piste MIDI ou d'instrument en vue 
Notes.

2 Avec un outil de saisie ou le Crayon, maintenez 
la touche Maj enfoncée et cliquez sur chaque 
note sur laquelle le trimming doit s'appliquer.

3 Effectuez l'une des opérations suivantes :

• Sélectionnez l'outil de trim. 

• Utilisez le Crayon.

4 Déplacez le curseur près du début de l'une des 
notes sélectionnées ; le pointeur de l'outil de 
trim apparaît. Faites-le glisser vers la droite 
pour raccourcir les notes ou vers la gauche 
pour les rallonger.

En mode d'édition Grid, le point de début ou de 
fin déplacé s'aligne sur la limite de grille la plus 
proche. En mode d'édition Spot, la boîte de 
dialogue Spot s'ouvre et vous invite à entrer le 
nouvel emplacement des points de début et de fin 
de la note.

Vous pouvez également effectuer un trimming sur 
des notes à l'aide des commandes Trim Clip to 

Selection (reportez-vous à la section « Commande 
Trim To Selection » à la page 604) et Trim To 

Insertion (reportez-vous à la section « Trim par 
incrément » à la page 606).

Pour copier les notes sélectionnées sans 
toucher aux notes originales, maintenez la 
touche Option (Mac) ou Alt (Windows) 
enfoncée pendant que vous faites glisser 
les notes.

Le placement des notes MIDI peut également 
être ajusté à l'aide de la commande Shift 
(reportez-vous à la section « Commande 
Shift » à la page 865) ou Nudge (reportez-vous 
à la section « Déplacement de clips par 
incrément » à la page 606).

Il est également possible d'utiliser l'outil de trim 
sur des clips MIDI. Pour plus d'informations, 
reportez-vous à la section « Outil de trim de 
compression/expansion temporelle pour les 
clips MIDI » à la page 710.

Modification du point de fin d'une note avec l'outil 
de trim

En mode Grid, appuyez sur la touche Ctrl 
(Windows) ou Commande (Mac) pour 
désactiver momentanément le mode Grid.
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Trimming des notes MIDI par 
incrément (Nudge)
Vous pouvez effectuer un trimming sur les points 
de début et de fin des notes MIDI sélectionnées, 
selon la valeur d'incrément actuelle.

Pour effectuer un trimming sur le point de début 
ou de fin de notes MIDI sélectionnées, selon la 
valeur d'incrément :

1 Configurez la valeur d'incrément (reportez-
vous à la section « Définition de la valeur 
d'incrément » à la page 607).

2 À l'aide de l'outil de saisie du temps, 
sélectionnez les notes MIDI sur lesquelles le 
trimming doit s'appliquer.

3 Effectuez l'une des opérations suivantes :

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et appuyez sur la touche Plus (+) 
ou Moins (–) du pavé numérique pour effectuer 
un trimming sur le point de début des notes 
MIDI sélectionnées, selon la valeur d'incrément.

• Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur la 
touche Plus (+) ou Moins (–) du pavé numérique 
pour effectuer un trimming sur le point de fin des 
notes MIDI sélectionnées, selon la valeur 
d'incrément.

Transposition des notes MIDI 
par incrément (Nudge)
Vous pouvez transposer des notes MIDI 
sélectionnées par incréments d'un demi-ton à l'aide 
des touches Plus (+) ou Moins (–) du pavé 
numérique.

Pour transposer des notes MIDI sélectionnées par 
demi-tons :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez les notes MIDI à transposer.

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et appuyez sur la touche 
Plus (+) du pavé numérique pour transposer les 
notes MIDI sélectionnées d'un demi-ton vers 
le haut.

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et appuyez sur la touche 
Moins (-) du pavé numérique pour transposer les 
notes MIDI sélectionnées d'un demi-ton vers 
le bas.

Séparation de notes MIDI
La commande Separate permet de séparer les notes 
MIDI au niveau de la position du curseur d'édition 
ou des limites de la sélection d'édition. En vue Notes 
dans la fenêtre Edit et dans les fenêtres de l'éditeur 
MIDI, la séparation de clips MIDI crée des notes 
MIDI, mais pas de clips MIDI. Toutefois, en vue 
Clips dans la fenêtre Edit, la séparation des clips 
MIDI crée uniquement des clips MIDI. De même, 
si la sélection d'édition inclut des pistes audio, 
la commande Separate sépare uniquement les clips 
des pistes MIDI et d'instrument, quels que soient les 
paramètres d'affichage des pistes.

Pour séparer des notes MIDI au niveau de la 
position du curseur ou des limites de la sélection 
d'édition :

1 Créez une sélection d'édition ou placez le 
curseur d'édition à l'endroit où vous souhaitez 
séparer une ou plusieurs notes MIDI.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Separate > At Selection.

• Effectuez un clic droit dans le volet Notes et 
sélectionnez Separate.

Appuyez sur les touches Ctrl+E (Windows) ou 
Commande+E (Mac) pour séparer les notes 
MIDI sur les limites de la sélection.
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Pour séparer les notes MIDI sur la grille :

1 Sélectionnez la valeur de grille.

2 Créez une sélection d'édition ou définissez un 
rectangle de sélection qui inclut les notes MIDI 
à séparer.

3 Sélectionnez Edit > Separate > On Grid.

4 Dans la boîte de dialogue Pre-Separate Amount, 
cliquez sur OK.

Outils de séparation et de 
consolidation des notes MIDI
En vue Notes dans la fenêtre Edit et les fenêtres de 
l'éditeur MIDI, le Crayon et les outils de saisie 
peuvent être utilisés pour séparer et consolider les 
notes MIDI. 

Le curseur se transforme en « couteau » pour 
l'outil de séparation et en « pansement » pour 
l'outil de consolidation.

Pour séparer une note MIDI à l'aide de l'outil de 
séparation :

 À l'aide de l'outil de saisie ou du Crayon, 
maintenez les touches Démarrer+Maj 
(Windows) ou Ctrl+Maj (Mac) enfoncées et 
cliquez sur la note MIDI à l'endroit où vous 
voulez effectuer la séparation.

Pour consolider des notes MIDI à l'aide de l'outil de 
consolidation :

 À l'aide de l'outil de saisie ou du Crayon, 
maintenez les touches Démarrer+Maj 
(Windows) ou Ctrl+Maj (Mac) enfoncées et 
cliquez entre les notes MIDI séparées.

Consolidation de notes MIDI
La commande Consolidate permet de combiner au 
moins deux notes MIDI consécutives de la même 
hauteur en une seule note MIDI.

Pour consolider des notes MIDI :

1 Sélectionnez les notes MIDI à consolider.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Consolidate.

• Effectuez un clic droit sur les notes 
sélectionnées et choisissez Consolidate.

Note MIDI séparée en deux à l'aide de l'outil de 
séparation

Consolidation de notes MIDI en une seule note à l'aide 
de l'outil de consolidation

Appuyez sur les touches Alt+Maj+3 
(Windows) ou Option+Maj+3 (Mac) pour 
consolider les notes MIDI adjacentes 
sélectionnées de la même hauteur.
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Mute de notes MIDI
La commande Mute permet de muter des notes 
MIDI individuelles. Si des clips entiers sont 
sélectionnés, la commande Mute vous invite 
à muter les clips ou les notes MIDI.

Pour muter une ou plusieurs notes MIDI :

1 Sélectionnez les notes MIDI à muter.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Mute Notes.

• Effectuez un clic droit sur les notes MIDI 
sélectionnées et choisissez Mute Notes.

Pour démuter une ou plusieurs notes MIDI :

1 Sélectionnez les notes MIDI à démuter.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Unmute Notes.

• Effectuez un clic droit sur les notes MIDI 
sélectionnées et choisissez Unmute Notes.

Édition manuelle de la vélocité 
des notes
Lorsqu'une piste MIDI ou d'instrument est affichée 
en vue Velocity ou si la ligne de vélocité est 
affichée sous une piste, la vélocité d'attaque des 
notes est représentée par une barre verticale. Plus 
elle est haute, plus la valeur de vélocité est élevée 
(0 à 127).

Pour éditer les vélocités MIDI dans la fenêtre Edit :

1 Effectuez l'une des opérations suivantes :

• Affichez la piste MIDI ou d'instrument en vue 
Velocity.

• Affichez la ligne de contrôleur de la piste MIDI 
ou d'instrument et affichez les vélocités.

2 Sélectionnez un outil de saisie.

3 Faites glisser l'extrémité supérieure (losange) 
de la barre de vélocité vers le haut ou le bas.

Les vélocités d'une plage de notes peuvent être 
éditées à l'aide du Crayon.

Pour dessiner des valeurs de vélocité en 
crescendo :

1 Effectuez l'une des opérations suivantes :

• Affichez la piste MIDI ou d'instrument en vue 
Velocity.

• Affichez la ligne de contrôleur de la piste MIDI 
ou d'instrument et affichez les vélocités.

2 Sélectionnez la forme Line du Crayon.

Appuyez sur les touches Ctrl+M (Windows) 
ou Commande+M (Mac) pour muter ou 
démuter les notes MIDI sélectionnées.

Affichage de la ligne de vélocité

Déplacement d'une barre de vélocité
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3 Cliquez au début de la plage de notes, vers le 
bas de la plage de vélocité, puis faites glisser le 
Crayon vers la droite tout en le faisant remonter, 
jusqu'à ce que la ligne englobe la plage de notes 
à inclure dans le fondu.

Vous pouvez également utiliser l'outil de trim pour 
décaler globalement les vélocités de toutes les 
notes sélectionnées. Cette méthode est utile si vous 
êtes satisfait du rapport des vélocités entre les 
notes, mais si vous souhaitez qu'elles soient 
globalement plus ou moins fortes.

Pour décaler globalement des vélocités avec 
l'outil de trim :

1 Affichez la piste MIDI ou d'instrument en vue 
Velocity.

2 À l'aide du Sélecteur ou de l'un des outils de 
saisie, sélectionnez la série de notes à éditer.

3 À l'aide de l'outil de trim, cliquez à proximité de 
la série de notes sélectionnée, puis faites glisser 
vers le haut ou le bas. La vélocité de toutes les 
notes augmente lorsque vous faites glisser 
l'outil de trimming vers le haut et diminue 
lorsque vous le faites glisser vers le bas.

Outil de trim de vélocité

Pour effectuer un trimming sur la vélocité d'une ou 
plusieurs notes MIDI sélectionnées :

 Avec le Crayon, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée, 
cliquez sur la note, puis faites glisser votre 
souris vers le haut ou le bas. Vous constaterez 
que la Main se transforme en outil de trim de 
vélocité.

Faites glisser le losange vers le haut pour 
augmenter la vélocité ou vers le bas pour la 
réduire. Lorsque vous le faites glisser, il devient 
bleu et la note associée est sélectionnée. 
Les valeurs de vélocité modifiées apparaissent 
dans l'indicateur de valeur d'emplacement du 
curseur (dans la fenêtre Edit).

Écoute des modifications de 
vélocité
Si l'option Play MIDI Notes When Editing est 
activée, Pro Tools lit la note avec la nouvelle 
vélocité lors de l'édition à l'aide de l'outil de saisie. 
Vous pouvez ainsi écouter le résultat de l'opération 
afin de définir la vélocité d'une note MIDI.

Modification de vélocités avec la forme Line

En vue Velocity, l'outil de trim permet 
d'effectuer un trimming sur la durée des notes, 
en plus de leurs vélocités.

Modification de vélocités avec l'outil de trim

Édition simultanée de plusieurs vélocités

Si deux notes ont la même heure de début 
(leurs barres de vélocité se superposent), 
faites glisser la note elle-même vers le haut 
ou le bas en maintenant la touche Commande 
(Mac) ou Ctrl (Windows) enfoncée pour 
ajuster sa vélocité.
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Saisie des attributs des notes
Lorsque vous sélectionnez une note individuelle 
avec un outil de saisie ou le Crayon, ses attributs 
s'affichent dans la zone d'édition des événements.

La hauteur est indiquée par le nom de la note et son 
numéro d'octave. Les vélocités d'attaque et de 
relâchement apparaissent sous forme de valeurs 
MIDI (0 à 127). Les valeurs de début, fin et durée 
de la sélection d'édition sont affichées dans 
l'échelle temporelle principale.

Pour modifier un attribut d'une note MIDI :

1 Dans la fenêtre Edit, sélectionnez la note avec 
un outil de saisie ou le Crayon sur une piste 
MIDI ou d'instrument en vue Notes.

2 Cliquez sur le champ d'attribut et effectuez l'une 
des opérations suivantes :

• Entrez la nouvelle valeur sur le pavé numérique.

• Appuyez sur la touche Flèche haut ou Flèche bas 
pour augmenter ou réduire la valeur.

• Cliquez et faites glisser votre souris vers le haut 
ou le bas pour définir la nouvelle valeur. 

• Jouez la nouvelle valeur de note sur votre 
clavier MIDI.

Appuyez sur la barre oblique (/) pour passer 
d'un champ à l'autre dans la zone d'édition des 
événements.

Notes multiples et zone 
d'édition des événements
Les valeurs que vous entrez dans la zone d'édition 
des événements s'appliquent à toutes les notes 
sélectionnées. Un triangle (symbole delta) apparaît 
à gauche de la note affichée pour indiquer que 
plusieurs notes sont sélectionnées.

La saisie d'une nouvelle valeur dans le champ Start 
déplace la première note de la sélection jusqu'à cet 
endroit, et toutes les autres notes la suivent.

Les valeurs entrées dans les champs de hauteur et 
de vélocité s'ajoutent ou se soustraient à celles de 
toutes les notes sélectionnées. Par exemple, pour 
transposer d'une octave vers le bas toutes les notes 
sélectionnées, entrez une valeur de hauteur de -12.

Suppression de notes MIDI
Il est possible de supprimer des notes sélectionnées 
avec la commande Clear du menu Edit. Les notes 
individuelles peuvent également être supprimées 
avec le Crayon.

Pour supprimer un groupe de notes MIDI avec la 
commande Clear :

1 À l'aide du Sélecteur ou de l'outil de saisie, 
sélectionnez les notes à supprimer (reportez-
vous à la section « Sélection de notes MIDI » à 
la page 700).

Zone d'édition des événements affichant les 
informations d'une piste MIDI 

Vous pouvez également modifier les attributs 
des notes MIDI dans la liste des événements 
MIDI (reportez-vous au Chapitre 34, « Liste 
des événements MIDI »).

Hauteur
Vélocité d'attaque

Vélocité de
relâchement

Notes multiples dans la zone d'édition des événements
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2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Clear pour supprimer les 
notes sélectionnées. Les données de contrôleur 
sous-jacentes de la piste demeurent intactes.

• Avec un outil d'édition, effectuez un clic droit 
sur une note sélectionnée, puis sélectionnez 
Clear.

• Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Mac).

Pour supprimer une note MIDI unique avec le 
Crayon :

 Sélectionnez le Crayon, puis cliquez sur la note 
tout en appuyant sur la touche Alt (Windows) 
ou Option (Mac). Le Crayon se transforme en 
gomme lorsque vous appuyez sur la touche Alt 
(Windows) ou Option (Mac).

Outil de trim de 
compression/expansion 
temporelle pour les clips 
MIDI
L'outil de trim de compression/expansion 
temporelle (TCE) est utile pour faire correspondre 
un clip MIDI à la longueur d'un autre clip, à une 
grille de tempo ou à tout autre point de référence.

À l'aide de l'outil de trim de compression/expansion 
temporelle, vous pouvez déplacer le point de début 
ou de fin du clip MIDI pour étendre ou compresser 
le clip, en repositionnant les données MIDI en 
conséquence, quelle que soit la base de temps de la 
piste (références de tempo ou échantillons).

Lorsque vous supprimez des notes MIDI dans 
une sélection de plage temporelle, toutes les 
données de contrôleur et d'automation sous-
jacentes sont également supprimées.

Suppression d'une note avec le Crayon

Vous pouvez également supprimer des 
événements de changement de programme et 
Sysex en maintenant la touche Alt (Windows) 
ou Option (Mac) enfoncée puis en cliquant 
dessus avec le Crayon.

Avant le trimming d'un clip MIDI à l'aide de l'outil de 
trim de compression/expansion temporelle

Après le trimming d'un clip MIDI à l'aide de l'outil de 
trim de compression/expansion temporelle
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Utilisation de l'outil de trim TCE 
en mode Grid
L'outil de trim TCE peut être utilisé en mode Grid 
pour faire correspondre un clip au tempo d'une 
session ou d'une partie d'une session, ou pour 
doubler ou réduire de moitié le tempo d'une 
performance.

Pour compresser ou étirer des clips MIDI en 
mode Grid :

1 Activez le mode d'édition Grid.

2 Si nécessaire, affichez la piste MIDI ou 
d'instrument en vue Clips.

3 Sélectionnez l'outil de trim TCE.

4 À l'aide de l'outil de trim TCE, faites glisser le 
point de début ou de fin du clip MIDI pour 
l'étirer ou le compresser jusqu'à une limite de la 
grille (par exemple, par noires). Le nouveau clip 
MIDI, créé automatiquement, apparaît dans la 
playlist et dans la liste des clips.

Utilisation de l'outil de trim TCE 
en mode Slip

Pour compresser ou étirer des clips MIDI en 
mode Slip :

1 Activez le mode d'édition Slip.

2 Affichez la piste MIDI ou d'instrument en vue 
Clips.

3 Sélectionnez l'outil de trim TCE.

4 Avec l'outil de trim TCE, faites glisser le point 
de début ou de fin du clip MIDI pour l'étirer ou 
le compresser. Le nouveau clip MIDI, créé 
automatiquement, apparaît dans la playlist et 
dans la liste des clips.

Utilisation de l'outil de trim TCE 
en mode Spot
En mode Spot, lorsque vous cliquez sur un clip avec 
l'outil de trim TCE, la boîte de dialogue Spot 
s'affiche. Vous pouvez spécifier l'emplacement sur 
lequel vous voulez que le clip débute ou se termine, 
ou la durée du clip pour que celui-ci s'ajuste 
automatiquement.

Pour compresser ou étirer des clips MIDI en 
mode Spot :

1 Activez le mode d'édition Spot.

2 Affichez la piste MIDI ou d'instrument en vue 
Clips.

3 Sélectionnez l'outil de trim TCE.

4 Cliquez sur le clip MIDI à proximité de son point 
de début ou de fin. La boîte de dialogue Spot 
s'ouvre. Entrez une nouvelle heure de début ou de 
fin (ou une durée) pour le clip dans l'une des 
échelles temporelles, puis cliquez sur OK. 
Le nouveau clip MIDI, créé automatiquement, 
apparaît dans la playlist et dans la liste des clips.

Utilisation de l'outil de trim TCE 
en mode Shuffle
En mode Shuffle, le clip sur lequel le trimming est 
appliqué commence systématiquement au niveau 
du point de départ du clip d'origine, quel que soit la 
direction du trimming (de l'avant vers l'arrière ou 
de l'arrière vers l'avant).

Pour compresser ou étirer des clips MIDI en mode 
Shuffle :

1 Activez le mode d'édition Shuffle.

2 Affichez la piste MIDI ou d'instrument en vue 
Clips.

3 Sélectionnez l'outil de trim TCE.

4 Avec l'outil de trim TCE, faites glisser le point 
de début ou de fin du clip MIDI pour l'étirer ou 
le compresser librement. Le nouveau clip MIDI, 
créé automatiquement, apparaît dans la playlist 
et dans la liste des clips.
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Événements de contrôleur 
continu
Les événements de contrôleur continu des pistes 
MIDI et d'instrument s'affichent sous la forme d'un 
graphique linéaire composé d'une série de points 
d'automation éditables. Les événements de 
contrôleur des pistes MIDI et d'instrument 
diffèrent des données d'automation des pistes 
audio dans la mesure où les points d'automation 
définissent des paliers (et non des vecteurs), 
chaque point d'automation représentant un seul 
événement de contrôleur. 

Pour afficher les données de contrôleur MIDI d'une 
piste, effectuez l'une des opérations suivantes :

 Sélectionnez la vue de piste correspondante 
dans le menu des vues de piste.

 Affichez la ligne du contrôleur MIDI 
correspondante sous la piste.

Vous pouvez insérer et éditer dans Pro Tools les 
événements de contrôleur continu suivants :

• Volume

• Panoramique

• Variation de hauteur

• Aftertouch (mono)

• Contrôleurs MIDI 0 à 127

Les contrôleurs MIDI numéro 7 (volume) et 
numéro 10 (panoramique) sont traités par 
Pro Tools comme des données d'automation. 
Cela signifie que ces événements de contrôleur 
(ainsi que les mutes) peuvent être enregistrés et 
automatisés à partir de la fenêtre Mix. Par ailleurs, 
chaque mode d'automation d'une piste MIDI ou 
d'une piste d'instrument a une incidence sur la 
lecture et l'enregistrement de ces événements. Il est 
possible de suspendre les événements de volume, 
de panoramique et de mute d'une piste MIDI, 
mais la lecture de tous les autres événements de 
contrôleur de la piste se poursuit. Les pistes 
d'instrument prennent en charge aussi bien le 
volume, le mute et le panoramique MIDI que le 
volume, le mute et le panoramique audio.

Enregistrez en mode MIDI Merge pour ne pas 
écraser les données d'automation de panoramique et 
de volume MIDI. Lors de l'enregistrement en mode 
MIDI Merge, les données de panoramique et de 
volume ne sont pas lues pendant l'enregistrement 
des nouvelles données MIDI. 

Événements de volume MIDI d'une piste d'instrument 
en vue MIDI Volume

Ligne de volume MIDI d'une piste d'instrument

Sélecteur de type de contrôleur

Afficher des lignes de contrôleur

L'aftertouch polyphonique ne peut pas être 
affiché dans la fenêtre Edit. Pour afficher les 
données d'aftertouch polyphonique dans 
Pro Tools, utilisez la liste des événements 
MIDI (reportez-vous au Chapitre 34, « Liste 
des événements MIDI »).
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Les événements de contrôleur continu (volume et 
panoramique inclus) émis par un contrôleur MIDI 
externe (clavier ou surface de contrôle) peuvent 
être enregistrés, puis insérés dans la playlist d'une 
piste MIDI à l'aide d'un outil de saisie ou du 
Crayon.

Insertion et édition 
d'événements de contrôleur
Les événements de contrôleur continu peuvent être 
édités à l'aide de l'une des méthodes suivantes :

 Vous pouvez déplacer des points d'automation 
individuels à l'aide d'un outil de saisie afin d'ajuster 
leur emplacement ou leur valeur.

 Vous pouvez décaler un groupe de points 
d'automation sélectionné vers le haut ou le bas 
à l'aide d'un outil de trim.

 Vous pouvez dessiner de nouveaux événements 
de contrôleur avec le Crayon pour remplacer des 
événements existants. Ceux-ci peuvent être 
dessinés avec le Crayon (Main levée, ligne, 
triangle, carré ou aléatoire).

 Vous pouvez couper, copier, coller, déplacer et 
décaler des événements de contrôleur.

Définition de la résolution des 
événements de contrôleur 
insérés
Lorsque vous insérez des événements de contrôleur 
avec le Crayon, leur densité est déterminée par le 
paramètre Pencil Tool Resolution When Drawing 

Controller Data des préférences MIDI.

Pour définir la résolution du Crayon :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2 Indiquez une valeur (de 1 à 100 millisecondes) 
pour le paramètre Pencil Tool Resolution When 

Drawing Controller Data. 

3 Cliquez sur OK.

Pour modifier un événement de contrôleur continu 
à l'aide du Crayon, il convient d'abord d'ajouter le 
contrôleur à la liste des contrôleurs MIDI 
automatisés.

Pour copier des événements de contrôleur 
continu MIDI et les coller sur un autre 
contrôleur MIDI, utilisez la fonction de 
collage spécial (Edit > Paste Special > To 
Current Automation Type). Par exemple, vous 
pouvez utiliser les mêmes données de contrôle 
pour le volume et un filtre de coupure ou bien 
pour le panoramique et la variation de 
hauteur. Pour plus d'informations, reportez-
vous à la section « Fonction Special Paste 
pour les données d'automation » à la 
page 1102.

Les modifications apportées aux données de 
volume affectent toutes les pistes d'un groupe 
d'édition actif. Ce n'est toutefois pas le cas 
pour les autres playlists de contrôleur 
(panoramique, notamment). Pour insérer et 
éditer d'autres types de contrôleurs sur toutes 
les pistes d'un groupe d'édition, maintenez la 
touche Ctrl (Mac) ou Démarrer (Windows) 
enfoncée pendant l'opération d'édition.

Le contrôleur est ajouté automatiquement 
à la liste des contrôleurs MIDI automatisés 
lorsque vous enregistrez des informations de 
contrôleur à partir d'un périphérique externe.
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Pour activer manuellement un contrôleur continu 
pour l'automation : 

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le sélecteur de vue de la piste MIDI 
ou d'instrument que vous souhaitez éditer et 
sélectionnez Add/Remove Controller dans le 
sous-menu controllers.

• Si les lignes du contrôleur sont affichées sous la 
piste MIDI ou d'instrument à éditer, cliquez sur 
le sélecteur de type de contrôleur correspondant 
à la ligne du contrôleur sous la piste, puis 
sélectionnez Add/Remove Controller dans le 
sous-menu controllers.

2 Dans la boîte de dialogue Automated MIDI 
Controllers, sélectionnez la plage de contrôleurs 
MIDI correspondant au contrôleur à automatiser. 

3 Sélectionnez le contrôleur à automatiser dans 
la liste de gauche, puis cliquez sur Add. 
Le contrôleur sélectionné est ajouté à la liste 
des contrôleurs MIDI automatisés.

4 Répétez les étapes 2 et 3 pour ajouter tous les 
contrôleurs MIDI à automatiser.

5 Pour supprimer un contrôleur de la liste des 
contrôleurs MIDI automatisés, sélectionnez-le 
dans la liste de droite, puis cliquez sur Remove.

6 Cliquez sur OK pour fermer la boîte de dialogue 
Automated MIDI Controller.

Sélection de la commande Add/Remove Controllers 
dans le sélecteur de vue de la piste

Sélection de la commande Add/Remove Controllers 
à partir du sélecteur de type de contrôleur sur une 
ligne de contrôleur

Sélection d'une plage de contrôleurs MIDI

Boîte de dialogue Automated MIDI Controllers
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Sélection de patch 
(changements de programme 
et de banque)
Chaque piste MIDI et d'instrument peut envoyer 
un changement de programme par défaut, chaque 
fois que la piste est lue. D'autres changements de 
programme peuvent être insérés à n'importe quel 
point de la piste.

À propos des changements de 
programme et de banque
Le protocole MIDI permet de choisir parmi une 
plage de 128 programmes (0 à 127). Toutefois, 
la plupart des instruments MIDI possèdent 
plusieurs banques de 128 programmes. Pour 
spécifier une banque, un message de sélection de 
banque doit être envoyé. Pour cela, certains 
instruments utilisent le contrôleur 0 et d'autres le 
contrôleur 32 (certains utilisent une combinaison 
des deux). La boîte de dialogue Patch Select de 
Pro Tools permet d'utiliser l'un ou l'autre de ces 
messages de sélection de banque lorsque vous 
insérez un événement de changement de 
programme. Vérifiez la valeur de contrôleur 
utilisée pour votre appareil MIDI dans la 
documentation de son fabricant.

Lorsque vous enregistrez des informations de 
contrôleur continu à partir d'un périphérique 
MIDI externe, le contrôleur est ajouté 
automatiquement à la liste des contrôleurs 
MIDI.

Les changements de programme sont envoyés 
aux périphériques MIDI externes. Les plug-
ins d'instrument dans Pro Tools ne répondent 
pas aux informations de changement de 
programme.

Si vous ignorez la commande de sélection de 
banque utilisée par votre instrument, vous 
pouvez effectuer un enregistrement MIDI dans 
Pro Tools pendant que vous procédez à un 
changement de banque à partir de l'instrument. 
Il suffit ensuite d'examiner les informations de 
sélection de banque enregistrées par votre 
instrument dans Pro Tools dans la liste des 
événements MIDI.

Certains appareils MIDI anciens (le Kurzweil 
K1000, par exemple) utilisent un message de 
changement de programme à la place d'un 
message de sélection de banque pour changer 
de banque. Pour ces appareils, vous devez 
donc envoyer deux messages de changement 
de programme pour accéder à un programme 
particulier, le premier définissant la banque et 
le second le programme.
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Changement de programme par 
défaut
Vous pouvez spécifier le changement de 
programme envoyé par défaut pour chaque piste 
MIDI en cliquant sur le bouton de sélection de 
patch depuis la fenêtre Edit ou Mix. Le message de 
changement de programme est alors envoyé 
à votre instrument lorsque la piste est lue.

Pour définir le changement de programme par 
défaut d'une piste MIDI ou d'instrument :

1 Dans la fenêtre Mix ou Edit, cliquez sur le 
bouton de sélection de patch.

2 Effectuez l'une des opérations suivantes :

• Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro de programme.

• Si vous utilisez des fichiers de nom de patch, 
sélectionnez un nom de patch (reportez-vous à la 
section « Noms de patch MIDI » à la page 716).

3 Cliquez sur Done.

Une fois sélectionné, le numéro (ou le nom de 
patch) du programme apparaît sur le bouton de 
sélection de patch de la fenêtre Edit.

Contrairement aux événements de changement de 
programme enregistrés et insérés, le changement 
de programme par défaut n'apparaît pas dans la 
playlist de la piste.

Pour supprimer le changement de programme par 
défaut, sélectionnez None dans la boîte de 
dialogue Patch Select.

Noms de patch MIDI
Pro Tools prend en charge le format XML 
(Extensible Markup Language) pour le stockage et 
l'importation des noms de patch des périphériques 
MIDI externes (tels que des instruments MIDI). 
Pro Tools installe les fichiers de noms de patch 
MIDI (.midnam) qui contiennent les noms de 
patch par défaut de nombreux périphériques MIDI 
standard.

Sur Mac, ces fichiers se trouvent à l'emplacement 
/Bibliothèque/Audio/MIDI Patch Names/Avid. 

Sous Windows, ces fichiers se trouvent 
à l'emplacement Program Files\Common Files\ 
Avid\Pro Tools\MIDI Patch Names\.

Boutons de sélection de patch

Boîte de dialogue Patch Select

Bouton de sélection de patch dans la fenêtre Edit

Vous pouvez modifier les fichiers .midnam 
dans un éditeur de texte. Vous pouvez 
également créer vos propres noms de patch 
à l'aide d'éditeurs ou de bibliothèques de noms 
de patch tiers.
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Pour importer des noms de patch MIDI dans 
Pro Tools :

1 Sélectionnez Setup > MIDI > MIDI Studio.

2 En fonction de votre système d'exploitation, 
effectuez l'une des opérations suivantes :

• Sur Mac, notez le nom du périphérique MIDI 
indiqué dans la fenêtre MIDI Studio (reportez-
vous à la section « Configuration de MIDI 
Studio (Mac) » à la page 143).

• Sous Windows, notez le nom du périphérique 
MIDI indiqué dans la fenêtre MIDI Studio Setup 
(reportez-vous à la section « Configuration de 
MIDI Studio (Windows) » à la page 145).

3 Assurez-vous que la sortie de la piste MIDI ou 
d'instrument est correctement assignée au 
périphérique MIDI.

4 Cliquez sur le bouton de sélection de patch de la 
piste MIDI ou d'instrument.

5 Dans la boîte de dialogue Patch Select, cliquez 
sur Change.

6 Dans la boîte de dialogue Open, effectuez l'une 
des opérations suivantes :

• Sur Mac, naviguez jusqu'à l'emplacement 
/Bibliothèque/Audio/MIDI Patch 
Names/Avid/<nom du fabricant>, puis 
sélectionnez le fichier de noms de patch MIDI 
(.midnam) du périphérique MIDI.

• Sous Windows, naviguez jusqu'à l'emplacement 
Program Files\Common Files\Avid\Pro Tools\ 
MIDI Patch Names\<nom du fabricant>, puis 
sélectionnez le fichier de noms de patch MIDI 
(.midnam) du périphérique MIDI.

7 Sélectionnez le fichier de noms de patch MIDI 
(.midnam) du périphérique MIDI.

Pour plus d'informations sur la configuration 
du MIDI sur les systèmes Windows et Mac, 
reportez-vous au Chapitre 10, 
« Configuration du MIDI ».

Bouton de sélection de patch dans la fenêtre Edit

Bouton de sélection de patch dans la fenêtre Mix

Boîte de dialogue Patch Select

Bouton Change



Guide de référence Pro Tools718

8 Cliquez sur Open. La boîte de dialogue Patch 
Select affiche les noms de patch du fichier 
sélectionné.

9 Pour les périphériques MIDI qui disposent de 
plusieurs banques de patchs, sélectionnez celle 
de votre choix dans le menu déroulant Bank.

Une fois les noms de patch importés dans 
Pro Tools, vous pouvez les utiliser pour ce 
périphérique MIDI dans toutes les sessions.

Pour effacer des noms de patch :

1 Dans la boîte de dialogue Patch Select, cliquez 
sur Clear.

2 Cliquez sur Done.

Insertion et édition des 
changements de programme
Vous pouvez insérer des changements de 
programme dans la playlist d'une piste à l'aide du 
Crayon. Les changements de programme existants 
peuvent être édités, déplacés, copiés et collés.

Pour insérer un changement de programme avec 
le Crayon :

1 Effectuez l'une des opérations suivantes : 

• Affichez la piste MIDI ou d'instrument en vue 
Program Change.

• Affichez la ligne de contrôleur de la piste MIDI 
ou d'instrument, puis affichez les changements 
de programme.

2 Pour que l'événement inséré soit aligné sur une 
valeur de grille, activez le mode Grid. 

3 À l'aide du Crayon, cliquez dans la playlist de la 
piste à l'endroit où vous souhaitez insérer le 
changement de programme.

4 Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro de programme (ou un 
nom de patch) et, si nécessaire, spécifiez une 
valeur de changement de banque.

Boîte de dialogue Patch Select avec les noms de 
patch

Sélection d'une banque dans la boîte de dialogue 
Patch Select

Pour certains instruments, la réception de 
messages de changement de programme en 
cours de lecture peut interrompre la lecture. 
Pour éviter ce cas de figure, placez les 
événements de changement de programme sur 
la piste à un endroit auquel aucune note n'est 
présente.
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5 Cliquez sur Done pour insérer l'événement de 
changement de programme dans la playlist de 
la piste.

Pour éditer un événement de changement de 
programme :

1 À l'aide d'un outil de saisie ou du Crayon, 
double-cliquez sur le changement de 
programme à éditer.

2 Dans la boîte de dialogue Patch Select, 
sélectionnez le nouveau numéro de programme 
ou son nom et spécifiez une valeur de 
changement de banque si nécessaire.

3 Cliquez sur Done.

Pour déplacer un événement de changement de 
programme :

 À l'aide d'un outil de saisie ou du Crayon, faites 
glisser le changement de programme vers la 
gauche ou la droite.

Si le mode d'édition est défini sur Grid, 
l'événement déplacé s'aligne sur la limite de grille 
la plus proche. En mode d'édition Spot, la boîte de 
dialogue Spot s'ouvre.

Pour supprimer un événement de changement de 
programme :

1 Lorsque la piste ou la ligne du contrôleur est 
affichée en vue Program Change, cliquez sur 
l'événement de changement de programme 
à l'aide d'un outil de saisie pour le sélectionner.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

• Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Mac).

Écoute des programmes
Lorsque la boîte de dialogue Patch Select est 
ouverte, Pro Tools peut parcourir 
automatiquement les différents patchs d'un 
périphérique MIDI assigné à une piste.

Pour écouter des patchs :

1 Si vous souhaitez écouter des patchs pour une 
piste MIDI ou d'instrument en cours de lecture, 
cliquez sur le bouton Play de la fenêtre de 
transport.

2 Ouvrez la boîte de dialogue Patch Select en 
cliquant sur le bouton de sélection de patch ou 
en insérant ou éditant un changement de 
programme sur une piste MIDI ou d'instrument.

3 Cliquez sur le numéro de programme (ou nom 
de patch) à partir duquel l'écoute sera lancée.

Événement de changement de programme

Le placement des changements de programme 
peut également être ajusté avec les 
commandes Shift (reportez-vous à la section 
« Commande Shift » à la page 865) ou Nudge 
(reportez-vous à la section « Déplacement de 
clips par incrément » à la page 606).

Si le clip contient d'autres événements 
à supprimer, vous pouvez supprimer le clip et 
l'événement de changement de programme 
sera également supprimé.

Vous pouvez également supprimer des 
événements de changement de programme 
individuels en cliquant dessus avec le Crayon 
tout en maintenant la touche Option (Mac) 
ou Alt (Windows) enfoncée.
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4 Entrez le nombre de secondes souhaité entre 
chaque changement de programme.

5 Sélectionnez l'option Increment Patch.

Après le nombre de secondes indiqué, Pro Tools 
sélectionne le patch suivant et transmet le 
changement de programme à la sortie MIDI 
assignée de la piste.

6 Lorsque l'écoute des patchs est terminée, 
désélectionnez l'option Increment Patch, 
sélectionnez le numéro de programme (ou le 
nom de patch) de votre choix, puis cliquez sur 
Done.

Événements System 
Exclusive
Vous pouvez enregistrer des événements System 
Exclusive (Sysex) sur des pistes MIDI ou 
d'instrument de Pro Tools (reportez-vous à la 
section « Saisie MIDI pas à pas » à la page 496). 
Lorsque des événements ont été enregistrés, ils 
apparaissent dans la playlist de la piste sous forme 
de blocs en vue Sysex ou sur une ligne de 
contrôleur en vue Sysex.

Si vous ne pouvez pas éditer le contenu des 
événements System Exclusive enregistrés 
directement dans Pro Tools, vous pouvez 
néanmoins les déplacer, les déplacer par 
incrément, les copier/coller, ou les supprimer.

Pour enregistrer un événement Sysex :

1 Créez une piste MIDI.

2 Définissez l'entrée de piste MIDI sur le port 
MIDI auquel le périphérique MIDI est 
connecté.

3 Configurez votre périphérique MIDI pour 
envoyer des données Sysex (transfert de groupe 
de données par exemple).

4 Lancez l'enregistrement dans Pro Tools.

5 Lancez le transfert de données Sysex à partir de 
votre périphérique MIDI.

6 Après le transfert des données Sysex depuis le 
périphérique MIDI, cliquez sur le bouton Stop 
de la fenêtre de transport.

Pour déplacer un événement Sysex :

1 Effectuez l'une des opérations suivantes : 

• Affichez la piste MIDI ou d'instrument en vue 
Sysex.

• Affichez la ligne de contrôleur de la piste MIDI 
ou d'instrument associée aux événements Sysex.

2 À l'aide d'un outil de saisie, faites glisser 
l'événement Sysex vers la gauche ou la droite.

En mode d'édition Grid, l'événement déplacé 
s'aligne sur la limite de grille la plus proche. 
En mode d'édition Spot, la boîte de dialogue 
Spot s'ouvre.

Bloc d'événement Sysex en vue Sysex

Pour lancer l'enregistrement du transfert de 
données Sysex depuis votre périphérique 
MIDI au niveau du point d'insertion de la 
timeline, activez le bouton Wait For Note.

Le placement des blocs d'événements Sysex 
peut également être ajusté à l'aide des 
commandes Shift (reportez-vous à la section 
« Commande Shift » à la page 865) et Nudge 
(reportez-vous à la section « Déplacement de 
clips par incrément » à la page 606).
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Pour supprimer un ou plusieurs événements 
Sysex :

1 Effectuez l'une des opérations suivantes : 

• Affichez la piste MIDI ou d'instrument en vue 
Sysex.

• Affichez la ligne de contrôleur de la piste MIDI 
ou d'instrument associée aux événements Sysex.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

• Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Mac).

Poursuite des notes et des 
contrôleurs

Note Chasing
La fonction Note Chasing permet d'entendre les 
notes MIDI avec un long sustain, même lorsque la 
lecture est lancée à partir d'un point situé après leur 
début. Par exemple, si une note démarre 
à l'emplacement 1|1|000 et s'étend sur 8 mesures 
(jusqu'à l'emplacement 9|1|000), la fonction Note 
Chasing permet, même si vous lancez la lecture 
depuis la mesure 5, d'entendre cette note puisque 
son sustain s'étend jusqu'à l'emplacement 9|1|000.

La fonction Note Chasing peut être activée et 
désactivée individuellement sur chaque piste MIDI 
ou d'instrument. Par défaut, la fonction Note 

Chasing est activée sur les nouvelles pistes MIDI 
et d'instrument.

Pour activer la fonction Note Chasing sur une 
piste MIDI :

 Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez l'option Note Chasing.

Assurez-vous de désactiver la fonction Note 

Chasing lorsque vous travaillez avec des 
échantillonneurs qui jouent des boucles. Si une piste 
MIDI, par exemple, déclenche une boucle de 
batterie de 4 mesures et si vous lancez la lecture à la 
mesure 3, la boucle débutera au mauvais moment et 
sera décalée par rapport aux autres pistes. 

Poursuite de contrôleurs et de 
programmes
Pro Tools poursuit en permanence les événements 
de contrôleur continu et les changements de 
programme des pistes MIDI. De ce fait, les valeurs 
de contrôleur et les patchs des périphériques MIDI 
sont toujours corrects.

Prenons par exemple une piste MIDI de 
32 mesures débutant avec un volume MIDI de 127 
et comportant un fondu de sortie jusqu'à 0 dans la 
dernière mesure. Si, après avoir lu intégralement la 
piste, vous lancez la lecture à partir de la mesure 8, 
le volume MIDI initial de 127 est poursuivi et 
envoyé au périphérique assigné à la piste, sans 
quoi la piste ne serait pas audible puisque 
l'événement de volume le plus récent 
correspondrait alors à une valeur de 0.

Vous pouvez également supprimer des blocs 
d'événements Sysex individuels en cliquant 
dessus avec le Crayon tout en maintenant la 
touche Option (Mac) ou Alt (Windows) 
enfoncée.

Option Note Chasing activée dans le sélecteur de 
playlist
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La poursuite se produit également pour un 
changement de programme par défaut d'une 
piste MIDI, ainsi qu'avec tout événement de 
changement de programme se trouvant sur la piste. 
Par conséquent, si vous avez choisi un changement 
de programme par défaut pour une piste, lorsque 
vous lancez la lecture depuis n'importe quel point 
de la piste, cet événement de changement de 
programme est envoyé au périphérique assigné 
à la piste.

Valeurs de contrôleur par défaut 
et poursuite
Bien que les nouvelles pistes MIDI semblent avoir 
des valeurs par défaut pour les playlists de 
contrôleur continu, ce n'est en fait pas le cas. 
Par exemple, si vous affichez la playlist de la 
molette de modulation d'une piste MIDI, vous 
constaterez que la ligne de points d'automation est 
définie sur zéro par défaut. Cependant, étant donné 
que la molette de modulation de votre contrôleur 
MIDI a pu être intentionnellement réglée sur une 
valeur différente, la valeur par défaut de la piste 
n'est pas transmise lors de la lecture.

Par exemple, si vous enregistrez une automation 
de la molette de modulation qui passe de 0 à 90 à la 
fin de la piste, et si vous lancez ensuite la lecture 
depuis le début de la piste, ou à partir d'un 
emplacement situé avant la modification, la valeur 
de la molette de modulation restera sur 90 jusqu'à 
ce que la valeur 0 soit atteinte, ce qui ne 
conviendra certainement pas.

Pour vous assurer que la valeur par défaut du 
contrôleur d'une playlist est envoyée (et poursuivie), 
cliquez sur le premier point d'automation au début 
de la piste, déplacez-le légèrement puis 
redéfinissez-le sur la valeur par défaut.

Décalage des pistes MIDI
Pro Tools peut décaler les pistes MIDI 
globalement ou individuellement.

Décalage de lecture MIDI global
Pro Tools offre une préférence de décalage MIDI 
qui permet d'avancer ou de retarder la lecture 
des pistes MIDI et d'instrument (par rapport aux 
pistes audio) d'un nombre d'échantillons donné. 
Le décalage n'affecte que la lecture et non 
l'affichage des données MIDI dans la fenêtre Edit.

Cette fonction est offerte en grande partie pour 
compenser la latence du monitoring audio pour les 
systèmes Pro Tools basés sur hôte. Si le monitoring 
de la sortie de vos instruments MIDI externes est 
pris en charge par une console de mixage ou un 
système de sonorisation externe (ou un casque), 
aucune latence n'est présente. En revanche, si le 
monitoring de la sortie de vos périphériques MIDI 
est pris en charge par une interface Pro Tools 
(par exemple, une interface 003), la lecture des 
pistes MIDI semble être légèrement en retard par 
rapport aux pistes audio. Plus le paramètre de la 
H/W Buffer Size est élevé (128, 256, 512 ou 1 024 
échantillons), plus la latence est importante.

En configurant l'option Global MIDI Playback 

Offset, vous pouvez avancer légèrement la lecture 
de vos pistes MIDI (d'un nombre spécifié 
d'échantillons), de manière à compenser la latence 
du monitoring audio sur les systèmes Pro Tools 
basés sur hôte.

Lorsque la compensation du délai est activée, 
les délais des pistes MIDI et d'instrument sont 
automatiquement compensés pour permettre 
un monitoring à faible latence. Pour plus 
d'informations, reportez-vous à la section 
« Compensation du délai pour le MIDI » à la 
page 1026.
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Pour configurer le décalage global de lecture 
MIDI :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2 Entrez le nombre d'échantillons (–10 000 
à 10 000) pour le paramètre Global MIDI 

Playback Offset. Une valeur négative avance la 
lecture des pistes MIDI par rapport aux pistes 
audio, tandis qu'une valeur positive retarde la 
lecture des pistes MIDI.

Pour compenser la latence du monitoring des 
systèmes Pro Tools basés sur hôte, définissez le 
décalage sur une valeur à peu près équivalente 
à celle du paramètre H/W Buffer Size.

3 Cliquez sur OK.

Décalages individuels de pistes MIDI et 
d'instrument

Vous pouvez décaler des pistes MIDI et d'instrument 
individuelles dans Pro Tools pour compenser la 
latence de périphériques MIDI (le temps nécessaire 
au déclenchement d'événements sur un 
échantillonneur ou un synthétiseur).

Par exemple, si des grosses caisses sont lues par 
une piste audio dans Pro Tools et si vous voulez 
qu'elles soient parfaitement synchronisées avec les 
sons de grosse caisse générés par un périphérique 
MIDI, vous devrez peut-être appliquer un décalage 
MIDI. Dans cet exemple, 5 ms sont généralement 
nécessaires pour déclencher les notes MIDI, voire 
davantage avec certains périphériques MIDI.

Pour mesurer la latence d'un périphérique MIDI 
assigné à une piste MIDI, réenregistrez sa sortie 
audio dans Pro Tools. Comparez ensuite les 
emplacements des échantillons des événements 
audio enregistrés et ceux des notes MIDI d'origine 
pour calculer la latence.

Pour configurer le décalage d'une piste MIDI ou 
d'instrument :

1 Sélectionnez Event > MIDI Track Offsets.

Le décalage global de lecture MIDI peut 
également être défini dans la fenêtre MIDI 
Track Offsets. Vous pouvez également 
appliquer un délai depuis les propriétés 
MIDI en temps réel pour décaler le MIDI 
(reportez-vous à la section « Propriétés 
MIDI en temps réel » à la page 725).

Mesure de la latence MIDI

Fenêtre MIDI Track Offsets

Décalage approximatif 
en échantillons

Transitoire audio enregistré 
à partir du périphérique MIDI

Attaque de note MIDI
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2 Cliquez dans la colonne Sample Offset de la 
piste MIDI ou d'instrument et entrez le nombre 
d'échantillons (-10 000 à 10 000) pour le 
décalage. Une valeur négative avance la lecture 
des pistes MIDI ou d'instrument par rapport aux 
pistes audio, tandis qu'une valeur positive 
retarde leur lecture.

Le décalage équivalent apparaît en millisecondes 
dans la colonne msec Offset. Cette valeur ne peut 
être éditée mais elle est automatiquement mise 
à jour lorsque vous entrez une nouvelle valeur 
dans la colonne Sample Offset.

3 Appuyez sur Retour (Mac) ou sur Entrée 
(Windows) pour valider la valeur de décalage.

Pour réinitialiser tous les décalages de toutes les 
pistes MIDI et d'instrument, cliquez sur le bouton 
Reset en haut à gauche de la fenêtre.

Notes bloquées
Si des notes sont bloquées sur l'un de vos 
périphériques MIDI, vous pouvez les couper avec 
la commande All MIDI Notes Off.

Pour couper toutes les notes bloquées :

 Sélectionnez Event > All MIDI Notes Off. 

Remove Duplicate Notes
La commande Remove Duplicate Notes permet de 
supprimer les notes MIDI en double. Lorsqu'une 
note débute dans les premiers 25 % de la durée 
d'une autre note de même hauteur (ou dans 
l'intervalle d'une croche, selon la durée la plus 
courte), elle est considérée comme un doublon et 
est combinée avec la note précédente. Si la note 
démarre après ce laps de temps, la première note 
est raccourcie pour se terminer exactement sur le 
tick où commence la nouvelle note.

Pour supprimer des notes en double :

1 Créez une sélection d'édition incluant les notes 
en double à supprimer.

2 Sélectionnez Event > Remove Duplicate Notes.

Appuyez sur Ctrl+Maj+Point (.) (Windows) 
ou Commande+Maj+Point (.) (Mac) pour 
envoyer une commande All MIDI Notes Off.
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Propriétés MIDI en temps réel
Certaines propriétés MIDI des pistes MIDI et 
d'instrument (ou des clips MIDI) peuvent être 
modifiées en temps réel en cours de lecture. 
Il existe cinq types de propriétés MIDI en temps 
réel : Quantize, Duration, Delay, Velocity et 
Transpose. 

Il est possible d'ajuster les propriétés MIDI en 
temps réel en cours de lecture, ce qui permet 
d'écouter le résultat. Une fois les paramètres 
désirés identifiés, vous pouvez les écrire sur les 
pistes ou clips sélectionnés. Cela a pour effet de 
remplacer les propriétés MIDI correspondantes sur 
les pistes ou clips sélectionnés et de rétablir 
l'affichage des propriétés en temps réel avec ses 
paramètres par défaut.

Les propriétés en temps réel peuvent être 
redéfinies à partir de la vue Real-Time Properties 
dans la fenêtre Edit ou à partir de la fenêtre Real-
Time Properties.

Vue Real-Time Properties
La vue Real-Time Properties de la fenêtre Edit ne 
s'applique qu'aux pistes. Pour appliquer des 
propriétés en temps réel aux clips, utilisez la fenêtre 
Real-Time Properties (reportez-vous à la section 
« Fenêtre Real-Time Properties » à la page 726).

Pour activer la vue Real-Time Properties dans la 
fenêtre Edit :

 Sélectionnez View > Edit Window > Real-Time 

Properties. 

Pour les hauteurs de piste micro, mini et small, 
la colonne des propriétés en temps réel contient 
une ou deux propriétés selon le cas. La ou les deux 
premières propriétés activées sont affichées 
automatiquement.

Pour sélectionner une autre propriété en temps 
réel sur une piste en vue Mini ou Small :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et cliquez sur une 
propriété en temps réel pour choisir un autre 
élément dans le menu déroulant.Afin d'appliquer les propriétés en temps réel 

MIDI aux données MIDI entrantes avec la 
fonction MIDI Thru, les pistes MIDI et 
d'instrument correspondantes doivent être 
activées pour l'enregistrement.

Colonne des propriétés en temps réel dans la fenêtre 
Edit

Menu des propriétés en temps réel pour une hauteur 
de piste Mini
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Fenêtre Real-Time Properties
Cette fenêtre permet d'appliquer des propriétés en 
temps réel aux pistes ou clips sélectionnés.

Pour ouvrir la fenêtre Real-Time Properties :

 Sélectionnez Event > MIDI Real-Time 

Properties. 

La fenêtre Real-Time Properties peut être utilisée 
pour appliquer des propriétés en temps réel basées 
à des pistes ou des clips en créant une sélection 
d'édition, puis en sélectionnant les pistes ou les clips 
souhaités à partir du menu déroulant Apply To.

Fenêtre Real-Time Properties étendue

Dans la fenêtre Real-Time Properties, les sections 
Quantize, Duration et Velocity disposent d'un 
triangle Développer/Réduire permettant d'afficher 
ou de masquer des paramètres supplémentaires. 

Activation de propriétés en 
temps réel

Pour activer des propriétés en temps réel :

1 Sélectionnez une piste ou créez une sélection 
d'édition.

2 Dans la vue Real-Time Properties de la fenêtre 
Edit ou dans la fenêtre Real-Time Properties, 
sélectionnez les propriétés en temps réel 
voulues en cliquant sur leur nom (Quantize, 
Duration, Delay, Velocity ou Transpose). 
Les propriétés en temps réel activées sont mises 
en surbrillance et affichent leurs paramètres.

3 Si vous utilisez la fenêtre Real-Time Properties 
et si le mode Link Track and Edit Selection est 
activé, sélectionnez la piste ou le clip souhaité 
dans le menu déroulant Apply To.

Fenêtre Real-Time Properties avec les propriétés 
activées

Fenêtre Real-Time Properties en vue étendue

Lorsque vous utilisez les propriétés en temps 
réel, activez le mode Link Track and Edit 
Selection pour créer une sélection de piste 
à partir d'une sélection d'édition (reportez-vous 
à la section « Liaison ou dissociation des 
sélections d'édition et de piste » à la page 576).

Triangles
Développer/Rédu
ire
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4 Définissez les paramètres de la fenêtre Real-
Time Properties (reportez-vous à la section 
« Paramètres des propriétés en temps réel » à la 
page 727).

Les propriétés en temps réel activées sont audibles 
lors de la lecture et sont appliquées aux pistes et 
clips sélectionnés.

Paramètres des propriétés 
en temps réel

Quantize
La propriété Quantize peut être basée sur une grille 
ou un modèle de groove. Dans le premier cas, vous 
disposez de paramètres supplémentaires de triolet 
et de décalage de grille, en plus des propriétés de 
quantification MIDI standard. Dans le second cas, 
des commandes supplémentaires sont disponibles 
pour définir les limites d'application de la durée et 
des vélocités du groove. Dans l'un comme dans 
l'autre, il est possible de définir trois valeurs 
importantes (Strength, Include et Randomize).

Menu Quantize : sélectionnez la valeur de 
quantification. Toutes les valeurs rythmiques de 
note standard de la ronde à la quadruple croche, 
valeurs pointées ou triolets compris, sont autorisées. 
Ce menu déroulant donne également accès à tous les 
modèles de groove standard et personnalisés.

Swing : entrez la quantité de swing sous forme 
d'une valeur en pourcentage comprise entre 
0 et 300 %. 

Tuplet : activez l'option Tuplet et indiquez le 
rapport du triolet (1–99), tel que 3 pour 2 ou 5 pour 
4. L'option Tuplet est accessible uniquement dans 
la vue étendue de la fenêtre Real-Time Properties.

Offset : activez l'option Offset et indiquez une 
valeur en ticks comprise entre -2 000 et 2 000. 
L'option Offset est accessible uniquement dans la 
vue étendue de la fenêtre Real-Time Properties.

Strength : activez l'option Strength et indiquez la 
quantité souhaitée sous forme d'une valeur en 
pourcentage comprise entre 0 et 100 %. L'option 
Strength est accessible uniquement dans la vue 
étendue de la fenêtre Real-Time Properties.

Include : activez l'option Include et définissez une 
plage comprise entre 0 et 100 %. L'option Include 
est accessible uniquement dans la vue étendue de 
la fenêtre Real-Time Properties.

Random : activez l'option Random et entrez une 
valeur en pourcentage comprise entre 0 et 100 %. 
L'option Random est accessible uniquement dans 
la vue étendue de la fenêtre Real-Time Properties.

La propriété Quantize ne peut pas être 
appliquée en temps réel à une entrée MIDI ou 
à une entrée MIDI Thru.

Sélection d'une valeur de quantification sur la grille ou 
un modèle de groove
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Duration
La propriété Duration peut servir à augmenter ou 
réduire la durée des notes MIDI selon une valeur 
fixe ou un pourcentage. Elle est particulièrement 
utile pour la création de passages legato ou 
staccato.

Menu du mode Duration

Sélectionnez l'une des options suivantes dans le 
menu déroulant du mode Duration : Set, Add, 
Subtract, Scale, Legato/Gap ou Legato/Overlap.

Set : sélectionnez cette option pour définir des 
notes de la durée spécifiée.

Add : sélectionnez cette option pour ajouter la 
durée spécifiée à la durée actuelle de chaque note.

Subtract : sélectionnez cette option pour 
soustraire la durée spécifiée de la durée actuelle de 
chaque note.

Scale : sélectionnez cette option pour multiplier la 
durée actuelle de chaque note par un pourcentage 
compris entre 1 et 400 %.

Legato/Gap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est ensuite soustraite pour créer 
un espace constant entre les notes.

Legato/Overlap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est ensuite ajoutée pour créer un 
chevauchement constant.

Valeur de la propriété Duration

Si le menu déroulant Ticks/Notes est défini sur 
ticks, saisissez une durée sous la forme d'un 
nombre de noires, suivi d'un nombre de ticks, 
tel que 4|000. Si le menu déroulant Ticks/Notes est 
défini sur une taille de note, saisissez un nombre 
par lequel multiplier cette valeur, tel que 
sept doubles croches.

Menu déroulant Ticks/Notes

Le menu déroulant Ticks/Notes vous permet de 
sélectionner soit un nombre de ticks, soit une taille 
de note pour la durée des notes. Vous disposez 
également d'un menu déroulant Ticks/Notes pour 
les valeurs maximale et minimale de durée.

Valeurs Min et Max de durée

Activez au choix l'une ou les deux valeurs 
(durée minimale et durée maximale) et entrez une 
valeur sous la forme d'un nombre de noires suivi 
d'un nombre de ticks, ou d'un multiple d'une valeur 
de note. Les options de durée minimale (Min) et 
maximale (Max) sont disponibles uniquement dans 
la vue étendue de la fenêtre Real-Time Properties.

La propriété Duration ne peut pas être 
appliquée en temps réel à une entrée MIDI ou 
à une entrée MIDI Thru.

Sélection d'un mode pour la propriété Duration

Menus déroulants Ticks/Notes des propriétés en 
temps réel
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Delay
La propriété Delay permet de retarder ou d'avancer 
toutes les données MIDI du clip ou de la piste 
sélectionné(e). Sélectionnez « + » dans le menu 
déroulant de la propriété Delay pour retarder les 
données MIDI ou « - » pour les avancer. Indiquez 
l'unité souhaitée (Ticks ou millisecondes (MS)) dans 
le menu déroulant Ticks/Milliseconds. Spécifiez la 
valeur du délai en ticks ou millisecondes. Le délai 
maximum est limité à 2 000 ms ou 999 ticks.

Velocity
La propriété Velocity permet de modifier la 
vélocité MIDI selon un pourcentage ou une valeur 
constante. Saisissez une valeur en pourcentage 
dans le champ Dyn afin de modifier la vélocité 
autour de la vélocité médiane de 64. Vous pouvez 
également spécifier un décalage en ajoutant (+) ou 
en soustrayant (-) des valeurs comprises entre 1 et 
127. Enfin, vous pouvez introduire des valeurs de 
vélocité limites minimale et maximale. Les options 
de vélocité minimale (Min) et maximale (Max) sont 
disponibles uniquement dans la vue étendue de la 
fenêtre Real-Time Properties.

Transpose
La propriété Transpose permet de transposer des 
notes MIDI vers le haut ou le bas selon un nombre 
d'octaves et de demi-tons spécifiés, ou par degrés 
d'une même tonalité, en se basant sur la règle 
d'armure. Il est également possible d'appliquer une 
transposition vers une hauteur de note donnée. 
Sélectionnez By, To ou In dans le menu Transpose 
pour appliquer une transposition par intervalle, 
vers une hauteur spécifique ou par degrés d'une 
même tonalité. 

Pour appliquer une transposition par intervalle, 
entrez le nombre d'octaves et de demi-tons 
souhaité sous forme de valeurs positives ou 
négatives. 

Pour appliquer une transposition vers une hauteur 
spécifique, entrez le nom de la note MIDI.

Pour transposer par degrés d'une même tonalité, 
entrez le nombre de degrés sous forme de nombres 
positifs ou négatifs. Par exemple, entrez +2 pour 
appliquer une transposition d'une tierce vers le 
haut (l'unisson plus une seconde égale une tierce).

Menu déroulant Ticks/Milliseconds des propriétés en 
temps réel

La propriété Delay ne peut pas être 
appliquée en temps réel à une entrée MIDI ou 
à une entrée MIDI Thru.

La propriété Velocity peut être appliquée en 
temps réel à une entrée MIDI ou à une entrée 
MIDI Thru sur des pistes MIDI et 
d'instrument activées pour l'enregistrement.

La propriété Transpose peut être appliquée 
en temps réel à une entrée MIDI ou à une 
entrée MIDI Thru sur des pistes MIDI et 
d'instrument activées pour l'enregistrement.
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Propriétés en temps réel sur 
les pistes et les clips
Des propriétés en temps réel peuvent être 
configurées pour s'appliquer à une piste entière 
(c'est-à-dire à tous ses clips), ou clip par clip. 
Les propriétés s'appliquant à des pistes 
s'appliquent également en temps réel aux vélocités 
et à la transposition d'une entrée MIDI.

La présence de propriétés en temps réel basées sur 
des pistes est signalée par un « T » dans le coin 
supérieur droit des clips MIDI. Les propriétés en 
temps réel basées sur des clips sont désignées par 
un R dans le coin supérieur droit des clips. 
Les limites de clips comprenant le T et le R sont 
indiquées en vue Notes et dans la fenêtre de 
l'éditeur MIDI, mais pas dans la fenêtre de l'éditeur 
de partition.

Propriétés en temps réel basées sur 
des clips

Les propriétés en temps réel basées sur des clips 
peuvent être appliquées uniquement par le biais de 
la fenêtre Real-Time Properties (Event > MIDI 

Real-Time Properties). Les propriétés en temps 
réel peuvent s'appliquer à plusieurs clips. Après 
avoir assigné des propriétés en temps réel à un clip, 
le clip peut être déplacé ou copié et collé et 
conserver ses propriétés en temps réel.

Propriétés en temps réel basées sur 
des pistes

Toutes les propriétés en temps réel basées sur des 
pistes s'appliquent de manière égale aux données 
MIDI de la piste entière. Toutefois, les propriétés 
en temps réel basées sur des clips ont priorité sur 
les propriétés en temps réel basées sur des pistes. 
Vous pouvez supprimer des propriétés en temps 
réel basées sur des clips en sélectionnant le clip et 
en cliquant sur le bouton Clear Clip Properties dans 
la fenêtre Real-Time Properties (reportez-vous à la 
section « Écriture de propriétés en temps réel sur 
les pistes ou les clips » à la page 730).

Pour plus de flexibilité, chaque fois que des 
propriétés en temps réel sont assignées à une piste, 
elles sont regroupées dans une playlist de piste. 
Vous pouvez ainsi créer plusieurs playlists 
incluant différentes combinaisons de propriétés en 
temps réel.

Écriture de propriétés en 
temps réel sur les pistes ou 
les clips
Lorsque la configuration des propriétés en temps 
réel vous convient, vous pouvez les écrire sur les 
pistes ou clips sélectionnés à l'aide de la fenêtre 
Real-Time Properties. Les propriétés en temps réel 
sont appliquées aux données MIDI actuelles de la 
piste ou d'un clip.

Pour écrire des propriétés en temps réel sur des 
pistes :

1 Activez l'option Link Track and Edit Selection.

2 Sélectionnez la ou les pistes auxquelles vous 
souhaitez appliquer des propriétés en temps réel.

3 Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

4 Sélectionnez Tracks dans le menu déroulant 
Real-Time Properties Apply To.

Indicateurs de propriétés en temps réel basées sur 
des clips et sur des pistes

Indique des propriétés en temps 
réel basées sur des pistes

Indique des propriétés 
en temps réel basées 

sur des clips



Chapitre 31 : Édition MIDI 731

5 Configurez les paramètres des propriétés en 
temps réel.

6 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Write to Track dans la 
fenêtre Real-Time Properties.

• Sélectionnez Track > Write MIDI RealTime 

Properties.

Pour écrire des propriétés en temps réel sur des 
clips :

1 Sélectionnez le ou les clips auxquels vous 
souhaitez appliquer des propriétés en temps 
réel.

2 Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3 Si l'option Link Track and Edit Selection est 
activée, sélectionnez Clips dans le menu 
déroulant Real-Time Properties Apply To.

4 Configurez les paramètres des propriétés en 
temps réel.

5 Cliquez sur le bouton Write to clip.

Pour supprimer les propriétés en temps réel d'un 
clip :

1 Sélectionnez le clip pour lequel vous souhaitez 
réinitialiser les propriétés en temps réel.

2 Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3 Sélectionnez Clips dans le menu déroulant Real-

Time Properties Apply To.

4 Cliquez sur le bouton Clear Clip Properties.

Propriétés en temps réel 
dans la liste des événements 
MIDI
Dans la liste des événements MIDI, la présence de 
propriétés en temps réel basées sur des pistes est 
signalée par un T affiché à droite de chaque 
événement. Les propriétés en temps réel basées sur 
des clips sont signalées par un R.

Affichage des effets des 
propriétés en temps réel
L'option Display Events as Modified by Real-Time 

Properties détermine si Pro Tools affiche les effets 
des propriétés en temps réel à la fois dans la fenêtre 
Edit, les fenêtres de l'éditeur MIDI, la fenêtre de 
l'éditeur de partition et la liste des événements 
MIDI. La fenêtre Edit, les fenêtres de l'éditeur 
MIDI, la fenêtre de l'éditeur de partition et la liste 
des événements MIDI affichent les effets des 
propriétés en temps réel lorsque l'option Display 

Events as Modified by Real-Time Properties est 
activée. Lorsque cette option est désactivée, 
les effets des propriétés en temps réel sont audibles, 
mais non visibles. Vous voyez les notes et les autres 
événements MIDI avec leur emplacement, leur 
hauteur, leur durée et leur vélocité d'origine, mais 
vous entendez le résultat obtenu après application 
des propriétés en temps réel. 

Pour activer ou désactiver l'option Display Events 
as Modified by Real-Time Properties :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2 Activez ou désactivez l'option Display Events 

as Modified by Real-Time Properties.

3 Cliquez sur OK.

Pour plus d'informations sur la liste des 
événements MIDI, reportez-vous au 
Chapitre 34, « Liste des événements MIDI ».



Guide de référence Pro Tools732

Effets des propriétés en temps réel affichés 
dans la liste des événements MIDI

La liste des événements MIDI prend en compte les 
effets des propriétés en temps réel à condition 
d'avoir activé l'option Display Events as Modified 

by Real-Time Properties. Lorsque vous modifiez 
ou insérez un événement dans une piste ou un clip 
possédant des propriétés en temps réel actives, 
Pro Tools tient compte des propriétés et modifie 
ou insère l'événement à un autre endroit, 
si nécessaire, pour refléter les effets des propriétés 
en temps réel.

Effets des propriétés en temps réel affichés 
dans la fenêtre Edit

Les événements MIDI apparaissent aux 
emplacements correspondants aux sons qu'ils 
émettent dans la fenêtre Edit, les fenêtres de 
l'éditeur MIDI et la fenêtre de l'éditeur de partition, 
lorsque l'option Display Events as Modified by 

Real-Time Properties est activée dans les 
préférences MIDI. Toutefois, les événements 
MIDI ne sont pas réellement écrits à leurs 
emplacements modifiés tant que les propriétés en 
temps réel ne sont pas écrites sur la piste ou le clip.

Lorsque vous faites glisser des événements MIDI, 
les emplacements réels (hauteur ou emplacement 
temporel) sont décalés en fonction de la quantité de 
déplacement des événements, mais l'effet des 
propriétés en temps réel est affiché.

Lorsque vous insérez un événement dans une piste 
ou un clip possédant des propriétés en temps réel 
actives, Pro Tools tient compte des propriétés et 
modifie ou insère l'événement à un autre endroit, 
si nécessaire, pour refléter les effets des propriétés 
en temps réel.
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Chapitre 32 : Éditeurs MIDI

Pro Tools dispose de fenêtres d'éditeur MIDI permettant de réaliser des opérations d'édition MIDI 
détaillées.

Fenêtre de l'éditeur MIDI

Solo

Mute

Vue Notation

Outils 
d'édition

Sélecteur d'édition de piste

Durée de note par défaut

Vélocité par défaut
Lecture des notes MIDI lors de l'édition

Édition MIDI en miroir
Liaison des sélections de timeline et d'édition

Modes d'édition
Emplacement 
du curseur Sélecteur de grille

Focus clavier

Menu de l'éditeur MIDI

Cible

Sélecteur de valeur 
d'incrémentation

Liste des groupes

Liste des pistes
Lignes de vélocité, 
de contrôleur et d'automation

Pistes MIDI et 
d'instrument 

Commandes de zoom



Guide de référence Pro Tools734

Pistes MIDI et d'instrument superposées

Les fenêtres de l'éditeur MIDI vous permettent 
d'afficher et d'éditer les données MIDI (notes, 
vélocités et données de contrôleur continu) d'une 
ou plusieurs pistes MIDI ou d'instrument. Lorsque 
plusieurs pistes sont affichées dans la fenêtre de 
l'éditeur MIDI, les notes MIDI de ces différentes 
pistes sont superposées. Les fenêtres de l'éditeur 
MIDI peuvent également afficher les pistes 
d'entrée auxiliaire.

Lignes d'automation et de contrôleur

La vélocité, d'autres données de contrôleur continu 
(pistes MIDI et d'instrument) et les données 
d'automation (pistes d'entrée auxiliaire et 
d'instrument uniquement) peuvent être éditées en 
même temps que les notes MIDI et apparaissent 
sur des lignes de contrôleur sous le volet Notes. 
Les vélocités des notes MIDI de différentes pistes 
sont également superposées dans la ligne de 
vélocité. Toutefois, pour toutes les autres données 
d'automation et de contrôleur, des lignes 
supplémentaires sont affichées pour chaque type 
d'automation et de contrôleur, pour chaque piste. 

Par exemple, si deux pistes d'instrument sont 
affichées dans la fenêtre de l'éditeur MIDI, 
les notes MIDI de chaque piste sont superposées 
dans le volet Notes et les vélocités de chaque piste 
sont superposées dans la ligne de vélocité. Vous 
pouvez toutefois voir deux lignes de contrôleur 
Mod Wheel, une pour chaque piste, et deux lignes 
Volume, une pour chaque piste également.

Ouverture d'une fenêtre de 
l'éditeur MIDI
Pour ouvrir une fenêtre de l'éditeur MIDI, effectuez 
l'une des opérations suivantes :

 Sélectionnez Window > MIDI Editor.

 Dans la fenêtre Edit, effectuez un clic droit sur un 
clip MIDI de la piste, ou sur le nom de la piste 
dans les commandes de la piste ou la liste des 
pistes, puis sélectionnez Open In MIDI Editor.

 Dans la fenêtre de l'éditeur de partition, effectuez 
un clic droit sur la partition ou sur un nom de 
piste dans la liste des pistes, puis sélectionnez 
Open In MIDI Editor.

Pour ouvrir des fenêtres supplémentaires de 
l'éditeur MIDI, effectuez l'une des opérations 
suivantes :

 Désactivez le bouton Cible dans la fenêtre de 
l'éditeur MIDI ouverte et ouvrez une autre 
fenêtre de l'éditeur MIDI.

 Effectuez un clic droit sur la fenêtre de l'éditeur 
MIDI ouverte et sélectionnez Open in New MIDI 

Editor.

Appuyez sur Démarrer+« = » (Windows) ou 
Ctrl+« = » (Mac) pour ouvrir une fenêtre de 
l'éditeur MIDI.

Si le paramètre Double Clicking a MIDI Clip 
Opens des préférences MIDI de Pro Tools est 
défini sur l'option MIDI Editor, vous pouvez 
double-cliquer sur un clip MIDI pour l'ouvrir 
dans un éditeur MIDI.
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Pour ramener une fenêtre de l'éditeur MIDI ouverte 
au premier plan :

 Sélectionnez Window > MIDI Editor, puis 
sélectionnez la fenêtre de l'éditeur MIDI de 
votre choix.

Barre d'outils de la fenêtre 
de l'éditeur MIDI
La barre d'outils de la fenêtre de l'éditeur MIDI est 
similaire à celle de la fenêtre Edit, à quelques 
exceptions près. Toutes les fenêtres de l'éditeur 
MIDI et la fenêtre Edit peuvent être configurées 
indépendamment les unes des autres. Par exemple, 
la vue Notation peut être sélectionnée dans l'une 
des fenêtres de l'éditeur MIDI mais pas dans une 
autre, ou le mode Grid peut être activé pour une 
fenêtre de l'éditeur MIDI, alors que la fenêtre Edit 
est en mode Slip. Vous pouvez également 
personnaliser la barre d'outils des fenêtres de 
l'éditeur MIDI.

Boutons Solo et Mute
Les boutons Solo et Mute d'une fenêtre de l'éditeur 
MIDI ont une incidence sur les pistes de toutes les 
fenêtres. Ils vous permettent d'écouter uniquement 
les pistes affichées dans la fenêtre de l'éditeur 
MIDI actuelle sans le reste du mixage, 
ou uniquement le mixage sans les pistes affichées 
dans la fenêtre de l'éditeur MIDI.

Solo

Le bouton Solo permet d'écouter en solo toutes les 
pistes actuellement affichées dans la fenêtre de 
l'éditeur MIDI.

Mute

Le bouton Mute permet de couper le son de toutes 
les pistes actuellement affichées dans la fenêtre de 
l'éditeur MIDI.

Combinaison des statuts Mute et Solo

Les boutons Solo et Mute sont des commandes 
générales qui ont une incidence sur toutes les 
pistes affichées dans une fenêtre de l'éditeur MIDI. 
Si, dans la fenêtre Edit, vous mettez en solo ou 
mute des pistes qui sont également affichées dans 
une fenêtre de l'éditeur MIDI, l'apparence des 
boutons Solo et Mute change pour indiquer des 
statuts mixtes. Des statuts Mute et Solo mixtes se 
produisent lorsqu'une ou plusieurs pistes affichées 
dans la fenêtre de l'éditeur MIDI, mais pas toutes, 
sont mises en solo ou mutées.

Pour parcourir les fenêtres de l'éditeur MIDI 
ouvertes, appuyez sur Démarrer+« = » 
(Windows) ou Ctrl+« = » (Mac) plusieurs fois 
jusqu'à ce que la fenêtre souhaitée s'affiche au 
premier plan.
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Vue Notation
Le bouton Vue Notation permet d'afficher les notes 
MIDI dans la fenêtre de l'éditeur MIDI sous forme 
de notation musicale. En vue Notation, les pistes 
MIDI et d'instrument ne sont pas superposées, 
mais affichées sous forme de portées, comme dans 
la fenêtre de l'éditeur de partition.

Outils d'édition
Les outils d'édition des fenêtres de l'éditeur MIDI 
peuvent être affichés comme un outil unique avec 
un menu déroulant permettant de sélectionner 
d'autres outils, ou sous forme d'une rangée d'icônes 
d'outils d'édition complète, développée comme dans 
la fenêtre Edit. Les outils d'édition dans les fenêtres 
de l'éditeur MIDI fonctionnent exactement de la 
même façon pour les données MIDI que dans la 
fenêtre Edit. Les paramètres des outils d'édition 
peuvent être définis indépendamment dans chaque 
fenêtre de l'éditeur MIDI et sont indépendants de la 
sélection d'outils dans la fenêtre Edit et l'éditeur 
de partition.

Pour afficher la vue développée des outils 
d'édition dans une fenêtre de l'éditeur MIDI, 
effectuez l'une des opérations suivantes :

 Cliquez sur le menu de la barre d'outils de la 
fenêtre de l'éditeur MIDI et sélectionnez 
Expanded Edit Tools.

 Effectuez un clic droit sur la barre d'outils et 
sélectionnez Expanded Edit Tools.

Pour restaurer l'affichage d'une seule icône d'outil 
d'édition avec le menu déroulant des outils 
d'édition :

 Désélectionnez Expanded Edit Tools.

Commandes d'édition MIDI
Les commandes d'édition MIDI fonctionnent 
exactement de la même façon dans les fenêtres de 
l'éditeur MIDI que dans la fenêtre Edit.

Vue Notation activée dans une fenêtre de l'éditeur 
MIDI

En vue Notation, vous pouvez accéder 
à l'option Notation Display Track Settings 
dans une fenêtre de l'éditeur MIDI. 
Sélectionnez l'option Notation Display Track 
Settings dans le menu de la liste des pistes ou 
effectuez un clic droit dans le volet Notes et 
sélectionnez l'option Notation Display Track 
Settings dans le menu contextuel. Pour plus 
d'informations, reportez-vous à la section 
« Notation Display Track Settings » à la 
page 764.

Commandes d'édition MIDI

Les paramètres globaux Play MIDI Notes 
When Editing, Link Timeline and Edit 
Selection et Mirrored MIDI Editing sont 
disponibles dans la fenêtre Edit, les fenêtres 
de l'éditeur MIDI et la fenêtre de l'éditeur de 
partition.

Sélecteur d'édition de piste

Durée de note par défaut

Vélocité par défaut

Lecture des notes MIDI lors de l'édition

Édition MIDI en miroir
Liaison des sélections 
de timeline et d'édition
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Sélecteur d'édition des pistes

Si la fenêtre de l'éditeur MIDI contient plusieurs 
pistes MIDI ou d'instrument, le sélecteur d'édition 
des pistes vous permet de sélectionner la piste 
à éditer à l'aide du Crayon. Vous ne pouvez insérer 
des notes MIDI manuellement que sur les pistes 
activées pour l'édition au Crayon. Vous pouvez 
également activer des pistes pour l'édition au 
Crayon dans la liste des pistes (reportez-vous à la 
section « Insertion manuelle de notes MIDI » à la 
page 746).

Durée de note par défaut

Le sélecteur Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Vélocité d'attaque par défaut

Le paramètre Default Note On Velocity permet de 
définir la valeur de vélocité de l'attaque par défaut 
des notes insérées manuellement.

Lecture des notes MIDI en cours 
d'édition

Lorsqu'elle est activée, cette option déclenche un 
son lorsque vous insérez des notes MIDI à l'aide du 
Crayon, lorsque vous cliquez dessus à l'aide de l'un 
des outils de saisie, lorsque vous y accédez à l'aide 
de la touche Tab ou lorsque vous les sélectionnez 
à l'aide du sélecteur de notes. 

Liaison des sélections de timeline et 
d'édition

Lorsque ce bouton est activé, les sélections de 
timeline et d'édition sont liées. Lorsqu'il est 
désactivé, vous pouvez effectuer des sélections de 
timeline et d'édition de manière indépendante.

Édition MIDI en miroir

Cette option permet d'éditer des clips MIDI et 
d'appliquer vos modifications à chaque copie du 
même clip MIDI. Elle est particulièrement utile 
lors de l'édition de clips MIDI en boucle.

Modes d'édition
Les modes d'édition dans les fenêtres de l'éditeur 
MIDI fonctionnent exactement de la même façon 
pour les données MIDI que dans la fenêtre Edit. 
Les paramètres du mode d'édition sont propres 
à chaque fenêtre de l'éditeur MIDI et sont 
également définis indépendamment de la 
fenêtre Edit.

Affichage de l'emplacement du 
curseur
L'affichage de l'emplacement du curseur dans les 
fenêtres de l'éditeur MIDI fonctionne exactement 
de la même façon que dans la fenêtre Edit. 

Affichage de la sélection 
d'édition
L'affichage de la sélection d'édition dans les 
fenêtres de l'éditeur MIDI fonctionne exactement 
de la même façon pour les données MIDI dans les 
fenêtres de l'éditeur MIDI que dans la fenêtre Edit. 
L'affichage de la sélection peut être affiché ou 
masqué dans la barre d'outils.

Lorsque le mode d'édition MIDI en miroir est 
désactivé et que vous éditez des notes de clips 
mis en boucle dans la vue Notes, l'opération 
d'édition a pour effet de mettre à plat la 
boucle. De même, l'édition de groupes de 
clips a pour effet de séparer les clips.
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Pour afficher (ou masquer) l'affichage de la 
sélection d'édition dans une fenêtre de l'éditeur 
MIDI, effectuez l'une des opérations suivantes :

 Cliquez sur le menu de la barre d'outils de la 
fenêtre de l'éditeur MIDI et sélectionnez 
(ou désélectionnez) Selection Display.

 Effectuez un clic droit sur la barre d'outils et 
sélectionnez (ou désélectionnez) Selection 

Display

Sélecteurs de valeur de grille et 
d'incrément
Lorsque l'option Expanded Grid/Nudge Display est 
activée dans le menu de la fenêtre de l'éditeur MIDI, 
les sélecteurs de valeur de grille et d'incrément des 
fenêtres de l'éditeur MIDI fonctionnent exactement 
de la même façon que dans la fenêtre Edit. 

Lorsque l'option Expanded Grid/Nudge Display est 
désactivée dans le menu de la fenêtre de l'éditeur 
MIDI, vous pouvez basculer entre l'affichage des 
valeurs de grille et d'incrément à l'aide du sélecteur 
d'affichage Grid/Nudge.

Cible
En général, le bouton Cible des fenêtres de 
l'éditeur MIDI fonctionne de la même façon que 
celui des fenêtres de plug-in, de sortie et de départ. 
De plus, le bouton Cible d'une fenêtre de l'éditeur 
MIDI synchronise l'affichage de l'emplacement 
dans la timeline avec celui de la fenêtre Edit. Toute 
modification de la sélection d'édition dans la 
fenêtre Edit est répercutée dans la fenêtre de 

l'éditeur MIDI ciblée. Une seule fenêtre de 
l'éditeur MIDI peut être ciblée à la fois. La fenêtre 
de l'éditeur MIDI ciblée peut également être 
stockée dans une configuration de fenêtres. 

Une ou plusieurs fenêtres de l'éditeur MIDI non 
ciblées peuvent rester ouvertes et accessibles en 
même temps, tout comme les fenêtres de plug-in 
non ciblées. Le fait de cibler une fenêtre de 
l'éditeur MIDI non ciblée désactive le ciblage de la 
fenêtre de l'éditeur MIDI précédente.

La fenêtre la plus en avant, qu'elle soit ciblée ou 
non, reçoit toujours un focus clavier sur les 
commandes et une priorité de la surface de contrôle.

Pour activer ou désactiver le ciblage d'une fenêtre 
de l'éditeur MIDI :

 Cliquez sur le bouton Cible de la fenêtre de 
l'éditeur MIDI afin qu'il soit mis en surbrillance 
(fenêtre ciblée) ou non (fenêtre non ciblée).

Sélecteur d'affichage Grid/Nudge avec sélection de 
l'affichage Nudge

Fenêtre de l'éditeur MIDI ciblée

Fenêtre de l'éditeur MIDI non ciblée
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Menu de la fenêtre de l'éditeur 
MIDI
Le menu de la fenêtre de l'éditeur MIDI donne 
accès aux options d'affichage de la fenêtre de 
l'éditeur MIDI et aux options de défilement.

Options d'affichage de la 
fenêtre de l'éditeur MIDI

Expanded Edit Tools

Lorsqu'elle est sélectionnée, l'option Expanded Edit 

Tools permet d'afficher tous les outils d'édition dans 
la barre d'outils de la fenêtre de l'éditeur MIDI. 

Si cette option n'est pas activée, seule l'icône de 
l'outil d'édition sélectionné est affichée. Tous les 
autres outils d'édition peuvent être sélectionnés 
à partir du menu déroulant des outils d'édition.

Expanded Grid/Nudge Display

Lorsqu'elle est sélectionnée, l'option Expanded 

Grid/Nudge Display affiche le sélecteur de valeur 
d'incrément en plus du sélecteur de valeur de grille 
sur la barre d'outils de la fenêtre de l'éditeur MIDI.

Selection Display

Lorsque l'option Selection Display est 
sélectionnée, la sélection d'édition est affichée sur 
la barre d'outils de la fenêtre de l'éditeur MIDI.

Track List

Lorsqu'elle est sélectionnée, l'option Track List 
affiche la liste des pistes dans la fenêtre de l'éditeur 
MIDI.

Sous-menu Scrolling
Le sous-menu Scrolling permet de sélectionner les 
options de défilement de la fenêtre de l'éditeur 
MIDI, indépendamment des autres fenêtres de 
l'éditeur MIDI et de la fenêtre Edit. Les options de 
défilement sont les suivantes :

No Scrolling : la fenêtre de l'éditeur MIDI ne 
défile ni pendant ni après la lecture. Le curseur de 
lecture se déplace dans la fenêtre de l'éditeur 
MIDI, indiquant la position du point de lecture.

After Playback : le curseur de lecture se déplace 
dans la fenêtre de l'éditeur MIDI, indiquant la 
position du point de lecture. La fenêtre de l'éditeur 
MIDI défile jusqu'au dernier point d'arrêt de la 
lecture.

Barre d'outils d'édition développée d'une fenêtre de 
l'éditeur MIDI

Menu déroulant des outils d'édition

Sélecteurs de grille et d'incrément

Affichage de la sélection
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Page : le curseur de lecture se déplace dans la 
fenêtre de l'éditeur MIDI, indiquant la position du 
point de lecture. Lorsque le bord droit de la fenêtre 
d'édition MIDI est atteint, l'ensemble de son 
contenu défile et le curseur de lecture reprend son 
déplacement depuis le bord gauche de la fenêtre.

Continuous : la fenêtre de l'éditeur MIDI défile en 
continu au-delà du curseur de lecture, qui reste au 
centre de la fenêtre. Avec cette option, la lecture 
est toujours basée sur la sélection de timeline 
(contrairement à ce qui se produit avec l'option 
Center Playhead Scrolling).

Center Playhead (Pro Tools HD uniquement) : 
la fenêtre de l'éditeur MIDI défile en continu au-
delà de la tête de lecture, matérialisée par une ligne 
bleue au centre de la fenêtre (rouge pendant 
l'enregistrement).

Follow Edit Window : lorsque cette option est 
sélectionnée, la fenêtre de l'éditeur MIDI utilise 
l'option de défilement sélectionnée pour la fenêtre 
Edit (Options > Edit Window Scrolling).

Barre d'outils personnalisable
Vous pouvez personnaliser la barre d'outils dans 
les fenêtres de l'éditeur MIDI en réorganisant, 
affichant et masquant les commandes et affichages 
disponibles, comme dans la fenêtre Edit ou la 
fenêtre de l'éditeur de partition.

Modification des options d'affichage de 
la barre d'outils

Pour modifier les options d'affichage de la barre 
d'outils d'une fenêtre de l'éditeur MIDI :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la barre d'outils de la 
fenêtre de l'éditeur MIDI.

• Effectuez un clic droit sur la barre d'outils.

2 Dans le menu contextuel, sélectionnez ou 
désélectionnez un ou plusieurs des éléments 
suivants :

• Expanded Edit Tools

• Expanded Grid/Nudge Display

• Selection Display

Réorganisation des commandes et 
affichages

Vous pouvez réorganiser les commandes et 
affichages dans la barre d'outils de la fenêtre de 
l'éditeur MIDI, tout comme dans la fenêtre Edit ou 
la fenêtre de l'éditeur de partition.

Pour réorganiser les commandes et affichages 
dans la barre d'outils d'une fenêtre de l'éditeur 
MIDI :

 Cliquez sur les commandes ou affichages que 
vous souhaitez déplacer tout en maintenant 
la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, puis faites les glisser vers 
l'emplacement de votre choix sur la barre 
d'outils.

Commandes de zoom de 
l'éditeur MIDI
Boutons de zoom avant/arrière horizontal et 
vertical

Outre les commandes de zoom de la barre d'outils, 
Pro Tools offre des boutons de zoom horizontal et 
vertical dans le coin inférieur droit des fenêtres de 
l'éditeur MIDI. 

Boutons de zoom vertical : agrandissent la 
hauteur des lignes proportionnellement pour les 
lignes d'automation et de contrôleur.
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Boutons de zoom horizontal : agrandissent la 
timeline tout comme les commandes de zoom 
horizontal de la barre d'outils de la fenêtre de 
l'éditeur MIDI.

Boutons de zoom MIDI avant/arrière

Pro Tools dispose de boutons de zoom MIDI 
avant/arrière situés dans le coin supérieur droit des 
fenêtres de l'éditeur MIDI. Ces commandes 
fonctionnent exactement de la même façon que les 
commandes de zoom MIDI de la barre d'outils, 
et permettent d'effectuer un zoom avant/arrière 
vertical sur les notes MIDI.

Liste des pistes
La liste des pistes dans les fenêtres de l'éditeur 
MIDI permettent d'afficher ou de masquer les 
pistes MIDI, d'instrument et d'entrée auxiliaire. 
Les paramètres de la liste de pistes sont propres 
à chaque fenêtre de l'éditeur MIDI. Toutefois, 
l'ordre des pistes dans la liste de pistes est global. 
Le tri ou la modification de l'ordre des pistes 
a une incidence sur la liste des pistes dans toutes 
les fenêtres.

Colonnes de la liste des pistes
La liste des pistes dans les fenêtres de l'éditeur 
MIDI comporte quatre colonnes : 

Afficher/Masquer : indique les pistes affichées 
ou masquées dans la fenêtre de l'éditeur MIDI.

Couleur de la piste : affiche la couleur de chaque 
piste par type ou par piste.

Nom : affiche le nom de chaque piste.

Crayon : permet d'activer une piste pour l'édition 
manuelle des notes MIDI à l'aide du Crayon.

Boutons de zoom avant/arrière horizontal et vertical

Boutons de zoom MIDI avant/arrière

Liste des pistes

Nom de la piste
Icône du type de piste

Code couleur de la piste
Afficher/Masquer la piste

Activation de l'édition au Crayon

Menu de la liste 
des pistes
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Menu de la liste des pistes
Le menu de la liste des pistes permet d'afficher 
ou de masquer les pistes MIDI, d'instrument et 
d'entrée auxiliaire dans la fenêtre de l'éditeur MIDI 
(reportez-vous à la section « Affichage et 
masquage des pistes » à la page 742). 

Dans ce menu, vous pouvez également trier les 
pistes dans la liste des pistes par nom, type, groupe 
d'édition, groupe de mixage ou voix (reportez-vous 
à la section « Tri des pistes dans la liste des pistes » 
à la page 742).

Affichage et masquage des 
pistes

Pour afficher des pistes MIDI, d'instrument et 
d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

 Activez l'icône Masquer/Afficher dans la liste 
des pistes pour les pistes à afficher dans la 
fenêtre de l'éditeur MIDI.

Pour afficher toutes les pistes MIDI, d'instrument 
et d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

 Dans le menu déroulant de la liste des pistes, 
sélectionnez Show All Tracks.

Pour afficher uniquement les pistes MIDI, 
d'instrument et d'entrée auxiliaire sélectionnées 
dans une fenêtre de l'éditeur MIDI :

1 Dans la liste des pistes, sélectionnez les pistes 
MIDI, d'instrument et d'entrée auxiliaire 
à afficher dans la fenêtre de l'éditeur MIDI.

2 Dans le menu déroulant de la liste des pistes, 
sélectionnez Show Only Selected Tracks.

Pour afficher toutes les pistes d'un type donné 
(MIDI ou d'instrument) dans une fenêtre de 
l'éditeur MIDI :

 Dans le menu déroulant de la liste des pistes, 
sélectionnez Show Only, puis sélectionnez le 
type de piste de votre choix.

Pour masquer des pistes MIDI, d'instrument et 
d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

 Désactivez l'icône Masquer/Afficher pour les 
pistes que vous souhaitez masquer dans la 
fenêtre de l'éditeur MIDI.

Pour masquer toutes les pistes MIDI, d'instrument 
et d'entrée auxiliaire (sauf une) dans une fenêtre 
de l'éditeur MIDI :

 Dans le menu déroulant de la liste des pistes, 
sélectionnez Hide All Tracks. 

Toutes les pistes sont masquées, sauf la première 
piste MIDI ou d'instrument de la liste des pistes. 
Les fenêtres de l'éditeur MIDI nécessitent qu'au 
moins une piste MIDI ou d'instrument soit toujours 
affichée.

Pour masquer les pistes MIDI, d'instrument et 
d'entrée auxiliaire sélectionnées dans une fenêtre 
de l'éditeur MIDI :

1 Dans la liste des pistes, sélectionnez les pistes 
MIDI, d'instrument et d'entrée auxiliaire que 
vous souhaitez masquer.

2 Dans le menu déroulant de la liste des pistes, 
sélectionnez Hide Selected Tracks.

Tri des pistes dans la liste des 
pistes
Vous pouvez trier les pistes dans la liste des pistes 
selon les critères suivants :

Name : trie les pistes de la liste des pistes selon 
leur nom.

Type : trie les pistes de la liste des pistes selon 
leur type.
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Edit Group : trie les pistes de la liste des pistes par 
groupes d'édition.

Mix Group : trie les pistes de la liste des pistes par 
groupes de mixage.

Voice : trie les pistes de la liste des pistes par 
allocation de voix.

Menu contextuel de la liste des 
pistes
Outre les commandes communes de gestion des 
pistes, le menu contextuel de la liste des pistes 
partage des commandes avec le menu déroulant 
de la liste des pistes et le menu contextuel du 
volet Notes.

Pour accéder au menu contextuel de la liste des 
pistes de l'éditeur MIDI :

 Effectuez un clic droit sur un nom de piste dans 
la liste des pistes.

Options du menu contextuel de la liste des 
pistes

Les options suivantes sont disponibles selon le 
type de piste (d'entrée auxiliaire, d'instrument 
ou MIDI).

Hide : masque la piste sélectionnée.

Hide and Make Inactive : masque la piste 
sélectionnée et la désactive.

Make Inactive : désactive la piste sélectionnée.

Export MIDI : exporte la piste sélectionnée dans un 
fichier MIDI.

New : ouvre la boîte de dialogue New Track.

Rename : renomme la piste sélectionnée.

Duplicate : duplique la piste sélectionnée.

Split into Mono : divise la piste d'entrée auxiliaire 
ou d'instrument stéréo sélectionnée en deux pistes 
mono.

Delete : supprime la piste sélectionnée.

MIDI Real-Time Properties : ouvre la fenêtre 
MIDI Real-Time Properties pour la piste 
sélectionnée.

Open in New MIDI Editor : ouvre les pistes 
affichées dans la fenêtre actuelle de l'éditeur MIDI 
dans une nouvelle fenêtre MIDI. La nouvelle 
fenêtre de l'éditeur MIDI n'est pas ciblée.

Open in Score Editor : ouvre les pistes affichées 
dans une fenêtre de l'éditeur de partition.

Open in MIDI Event List : ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Notation Display Track Settings : ouvre la fenêtre 
Notation Display Track Settings.

Liste des groupes
La liste des groupes dans les fenêtres de l'éditeur 
MIDI offre les mêmes fonctionnalités que dans 
la fenêtre Edit. Vous pouvez créer, éditer et 
supprimer des groupes d'édition à l'aide de la liste 
de groupes dans toutes les fenêtres de l'éditeur 
MIDI. La liste des groupes est liée entre la fenêtre 
Edit et toutes les fenêtres de l'éditeur MIDI.

Pour plus d'informations sur le groupement 
de pistes, reportez-vous au Chapitre 14, 
« Groupement de pistes ».
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Règles de base de temps et 
de chef d'orchestre
Les règles de base de temps et de chef d'orchestre 
des fenêtres de l'éditeur MIDI fonctionnent 
exactement de la même façon que dans la fenêtre 
Edit. Toutefois, la fenêtre Edit et les fenêtres de 
l'éditeur MIDI peuvent chacune disposer d'une vue 
unique de la timeline : vous pouvez décider quelles 
règles de base de temps et de chef d'orchestre sont 
affichées, ainsi que le niveau de zoom et 
l'emplacement temporel.

Vue superposée des notes
Le volet Notes des fenêtres de l'éditeur MIDI 
permettent de voir et d'éditer des notes MIDI 
superposées de différentes pistes MIDI et 
d'instrument. Vous pouvez ainsi facilement éditer 
des arrangements multipistes depuis une unique 
constellation de notes de couleurs différentes. 
Le volet Notes permet d'éditer les notes MIDI 
à peu près de la même façon que dans la vue Notes 
des pistes MIDI et d'instrument dans la fenêtre 
Edit, à la seule différence que vous pouvez éditer 
les notes MIDI de plusieurs pistes MIDI et 
d'instrument en même temps.

Vous pouvez également afficher et éditer les 
notes MIDI en vue Notation dans le volet Notes 
(reportez-vous à la section « Vue Notation » à 
la page 749).

Volet Notes d'une fenêtre de l'éditeur MIDI, avec cinq pistes d'instrument superposées
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Codage couleur des notes MIDI
Vous pouvez appliquer un code couleur aux notes MIDI selon leur piste d'origine ou leur vélocité.

Codage couleur par piste

Lorsque le codage couleur par piste est activé, les pistes de l'éditeur MIDI sont affichées dans l'une des 
seize couleurs disponibles, dans l'ordre dans lequel elles apparaissent dans la liste des pistes.

Pour appliquer un code couleur aux notes MIDI selon leur piste d'origine :

 Activez le bouton de codage couleur des notes MIDI par piste.

Codage couleur par vélocité

Lorsque le codage couleur par vélocité est activé, les notes MIDI sont toutes de la même couleur rouge 
(teinte) pour toutes les pistes affichées. La saturation des couleurs des notes MIDI varie (de rouge clair 
à rouge foncé) selon leur vélocité d'attaque. Les notes avec des vélocités faibles sont indiquées par des 
couleurs plus claires, et celles avec des vélocités rapides par des couleurs plus foncées.

Pour appliquer un code couleur aux notes MIDI selon leur vélocité :

 Activez le bouton de codage couleur des notes MIDI par vélocité.

Aucun codage couleur

Si les boutons de codage couleur par piste ou par vélocité sont désactivés, les notes sont affichées dans 
l'éditeur MIDI avec les mêmes couleurs que dans la fenêtre Edit, en respectant les options de codage 
couleur définies pour les paramètres Track Color Coding des préférences d'affichage.

Bouton de codage couleur des notes MIDI par piste activé dans la fenêtre de l'éditeur MIDI

Bouton de codage couleur des notes MIDI par vélocité activé dans la fenêtre de l'éditeur MIDI

Affichage des notes sans code couleur dans une fenêtre de l'éditeur MIDI
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Édition des notes MIDI
Vous pouvez éditer toutes les notes de toutes les 
pistes affichées dans le volet Notes. L'édition des 
notes MIDI dans le volet Notes est identique 
à l'édition des pistes MIDI et d'instrument en vue 
Notes dans la fenêtre Edit, à la seule différence que 
les notes des différentes pistes sont superposées. 

Insertion manuelle de notes 
MIDI
À l'aide du Crayon, vous pouvez insérer 
manuellement des notes MIDI sur les pistes 
activées pour l'édition au Crayon affichées dans le 
volet Notes. Si une seule piste est affichée dans la 
fenêtre de l'éditeur MIDI, elle est automatiquement 
activée pour l'édition au Crayon. Si plusieurs pistes 
superposées sont affichées dans le volet Notes, les 
notes MIDI seront insérées uniquement sur les 
pistes activées pour l'édition au Crayon.

Pour insérer des notes MIDI sur une piste 
spécifique du volet Notes :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez la piste à activer pour l'édition au 
Crayon dans le sélecteur d'édition des pistes de 
la barre d'outils.

• Cliquez sur la colonne Crayon de la liste des 
pistes pour activer pour l'édition au Crayon la 
piste de votre choix.

2 À l'aide du Crayon, cliquez sur la hauteur et 
l'emplacement temporel désirés pour insérer 
une note MIDI sur la piste activée pour l'édition 
au Crayon, avec la vélocité d'attaque et la durée 
de note par défaut sélectionnées.

Pour en savoir plus sur l'édition des notes 
MIDI, reportez-vous au Chapitre 31, 
« Édition MIDI ».

Pour en savoir plus sur l'insertion manuelle 
de notes MIDI, reportez-vous à la section 
« Insertion de notes MIDI » à la page 698.

Sélection d'une piste pour l'édition

Seules les pistes actuellement affichées dans 
la fenêtre de l'éditeur MIDI sont disponibles 
dans le menu du sélecteur d'édition des pistes.

Piste « Blad Pad Midi » activée pour l'édition au 
Crayon

Insertion d'une note MIDI sur la piste « Inst 3 » 
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Menu contextuel du volet 
Notes
Le menu contextuel du volet Notes offre plusieurs 
commandes d'édition, d'exportation et d'affichage 
des données MIDI.

Pour accéder au menu contextuel de l'éditeur 
MIDI :

 Effectuez un clic droit dans le volet Notes.

Options du menu contextuel du 
volet Notes

Tools

Le sous-menu Tools permet de sélectionner les 
outils d'édition appropriés pour l'éditeur de 
partition.

Zoomer : sélectionne le zoom.

Trim : sélectionne l'outil de trim.

Selector : active le Sélecteur.

Grabber : sélectionne la Main.

Scrubber : sélectionne l'outil de scrubbing.

Pencil : sélectionne le Crayon.

Smart : sélectionne l'outil Smart.

Zoomer Tools : permet de sélectionner le mode de 
zoom normal ou unique.

Pencil Tools : permet de sélectionner l'un des 
Crayons.

Insert

Le sous-menu Insert permet d'insérer des 
changements de tonalité et de mesure, ainsi que 
des symboles d'accord à l'emplacement du curseur 
d'édition.

Key : insère un changement de tonalité.

Meter : insère un changement de mesure.

Chord : insère un symbole d'accord.

Cut

La commande Cut coupe la sélection d'édition 
actuelle.

Copy

La commande Copy copie la sélection d'édition 
actuelle.

Paste

La commande Paste colle le contenu du presse-
papiers sur la sélection d'édition actuelle ou 
à l'emplacement actuel du curseur d'édition. 
Toutes les notes MIDI déjà présentes au même 
emplacement sont remplacées.

Merge

La commande Merge copie le contenu du presse-
papiers sur la sélection d'édition actuelle ou 
à l'emplacement actuel du curseur d'édition et 
fusionne les données copiées avec les notes MIDI 
déjà existantes au même emplacement.

Afin d'activer pour l'édition au Crayon 
plusieurs pistes contiguës, maintenez la touche 
Maj enfoncée et cliquez sur la colonne Crayon 
de la plage de pistes de votre choix. Afin 
d'activer pour l'édition au Crayon plusieurs 
pistes non contiguës, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée et 
cliquez sur la colonne Crayon de chaque piste 
à ajouter. Afin d'activer toutes les pistes pour 
l'édition au Crayon, maintenez la touche Alt 
(Windows) ou Option (Mac) enfoncée et 
cliquez sur la colonne Crayon. Les notes 
insérées manuellement s'inscrivent sur toutes 
les pistes activées pour l'édition au Crayon.
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Clear

La commande Clear efface (supprime) la sélection 
d'édition actuelle.

Separate

La commande Separate permet de diviser les notes 
MIDI à l'emplacement du curseur d'édition.

Consolidate

La commande Consolidate permet de consolider 
plusieurs notes MIDI sélectionnées consécutives 
de la même hauteur.

Mute Notes

La commande Mute Notes (ou Unmute Notes) 
permet de muter (ou démuter) les notes MIDI 
sélectionnées.

MIDI Real-Time Properties

L'option MIDI Real-Time Properties ouvre la 
fenêtre MIDI Real-Time Properties.

Event Operations

Le sous-menu Event Operations permet de 
sélectionner l'une des fenêtres Event Operations 
(Quantize ou Change Velocity par exemple).

Open in New MIDI Editor

L'option Open In New MIDI Editor ouvre toutes les 
pistes affichées dans une nouvelle fenêtre de 
l'éditeur MIDI.

Open in Score Editor

L'option Open In Score Editor ouvre les pistes 
affichées dans la fenêtre de l'éditeur de partition.

Open in MIDI Event List

L'option Open In MIDI Event List ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Display Notation

L'option Display Notation active la vue Notation de 
l'éditeur MIDI. Si vous désélectionnez cette 
option, la vue Notes est rétablie.
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Vue Notation
Le volet Notes des fenêtres de l'éditeur MIDI permet également d'afficher les notes MIDI sous forme de 
notation musicale standard. En vue Notation, chaque piste MIDI et d'instrument est affichée 
indépendamment, avec une piste par portée. 

Dans les fenêtres de l'éditeur MIDI, la notation est 
affichée sous forme d'une timeline continue et non 
pas en mode page comme dans la fenêtre de 
l'éditeur de partition. 

Pour activer la vue Notation, effectuez l'une des 
opérations suivantes :

 Activez le bouton de la vue Notation sur la barre 
d'outils de la fenêtre de l'éditeur MIDI.

 Effectuez un clic droit sur le volet Notes et 
sélectionnez Notation View.

Volet Notes de l'éditeur MIDI en vue Notation

Pour plus d'informations sur l'édition des 
notations, reportez-vous à la section 
« Édition de notes » à la page 767.

Vue Notation activée dans une fenêtre de l'éditeur 
MIDI
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L'édition en vue Notation dans une fenêtre de 
l'éditeur MIDI fonctionne de la même façon que 
dans la fenêtre de l'éditeur de partition, avec 
l'avantage de pouvoir accéder aux lignes de 
vélocité, de contrôleur et d'automation. 

Double barre de mesure en vue 
Notation
Le bouton de double barre de mesure est 
disponible uniquement en vue Notation. Lorsqu'il 
est activé, le bouton double barre de mesure 
affiche la double barre de mesure finale dans la 
fenêtre de l'éditeur MIDI. Cette double barre se 
situe à la fin du dernier clip MIDI ou du dernier 
événement de la session.

Lorsque le bouton de double barre de mesure est 
désactivé, plusieurs mesures vides suivent la fin du 
dernier événement de la session. Le nombre de 
mesures vides est déterminé par le paramètre 
Additional Empty Bars In The Score Editor des 
préférences MIDI (Setup > Preferences). 
Désactivez le bouton de double barre de mesure 
pour entrer manuellement des notes dans l'éditeur de 
partition après le dernier clip ou événement MIDI de 
la session.

Menu contextuel de la vue 
Notation
En vue Notation, le menu contextuel du volet 
Notes offre des options légèrement différentes par 
rapport à celui de la vue superposée des notes. 

Dans les deux cas, les options suivantes sont 
disponibles :

• Tools

• Insert

• Cut

• Copy

• Paste

• Clear

• Separate

• Consolidate

• Mute

• MIDI Real-Time Properties

• Event Operations

• Open in New MIDI Editor

• Open in Score Editor

• Open in MIDI Event List

• Display Notation

En vue Notation, l'option Notation Display Track 
Settings est également disponible dans le menu 
contextuel. Sélectionnez cette option pour ouvrir la 
boîte de dialogue Notation Display Track Settings 
et configurer les paramètres d'affichage des pistes 
en vue Notation. Pour plus d'informations sur la 
boîte de dialogue Notation Display Track Settings, 
reportez-vous à la section « Notation Display 
Track Settings » à la page 764.

Notez qu'en vue Notation, l'outil de trim 
fonctionne de la même façon que la Main 
lorsqu'il passe sur une note, et de la même 
façon que le sélecteur de notes lorsqu'il n'est 
pas sur une note.

En vue Notation, le mode d'édition est 
automatiquement défini sur Grid et ne peut 
pas être changé.

Bouton de double barre de mesure activé dans une 
fenêtre de l'éditeur MIDI
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Lignes de vélocité, de contrôleur et d'automation
Les fenêtres de l'éditeur MIDI permettent d'éditer les vélocités, les données de contrôleur MIDI et 
l'automation de toutes les pistes MIDI, d'instrument et d'entrée auxiliaire sur les lignes situées en dessous 
du volet Notes.

Vous pouvez déplacer et redimensionner les lignes 
de contrôleur et d'automation comme dans la 
fenêtre Edit.

Lors de l'affichage de plusieurs pistes MIDI et 
d'instrument, les vélocités des notes de pistes 
séparées sont superposées sur une seule ligne, tout 
comme les notes dans le volet Notes. Toutefois, 
toutes les autres lignes de contrôleur sont regroupées 
par type d'automation et de contrôleur, et proposent 
des lignes individuelles pour chaque piste affichée.

Pour afficher ou masquer des lignes sous le volet 
Notes :

 Cliquez sur le bouton Afficher/Masquer les lignes.

Pour ajouter des lignes :

 Cliquez sur le bouton Ajouter une ligne.

Pour supprimer des lignes :

 Cliquez sur le bouton Supprimer la ligne.

Pour modifier le type d'automation ou de 
contrôleur d'une ligne :

 Cliquez sur le sélecteur de type d'automation ou 
de contrôleur et sélectionnez le type de votre 
choix.

Lignes de vélocité, de contrôleur et d'automation de deux pistes d'instrument stéréo

 

Afficher/masquer 
les lignes

Ligne de vélocité 
(2 pistes superposées)

Supprimer la ligne
Ajouter une ligne

Sélecteur de type de 
contrôleur/automation

Lignes d'automation 
couplées pour des 
pistes séparées
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Chapitre 33 : Éditeur de partition

La fenêtre de l'éditeur de partition permet d'afficher, éditer, organiser et imprimer les données MIDI de 
votre session sous forme de notation musicale. Les notes MIDI sont transcrites en temps réel lorsque vous 
enregistrez, importez, dessinez (à l'aide du Crayon) ou entrez des notes MIDI en pas à pas. 

Fenêtre de l'éditeur de partition

Outils d'édition

Durée de note par défaut

Vélocité de note par défaut

Lecture des notes MIDI lors de l'édition

Édition MIDI en miroir
Liaison des sélections d'édition et de timeline

Double barre de mesure

Emplacement du curseur

Menu de l'éditeur de partition

Cible

Sélection
Sélecteur de grille

Liste des pistes Commandes de page Commandes de zoom
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Ouverture de la fenêtre de 
l'éditeur de partition
Pour ouvrir la fenêtre de l'éditeur de partition :

 Sélectionnez Window > Score Editor.

Pour ouvrir la fenêtre de l'éditeur de partition en 
affichant une seule piste MIDI ou d'instrument :

1 Assurez-vous qu'aucune sélection d'édition 
n'est effectuée.

2 Effectuez un clic droit sur le nom d'une piste 
non sélectionnée de la fenêtre Edit ou Mix, 
ou dans la liste de pistes de la fenêtre Edit, Mix 
ou de l'éditeur MIDI.

3 Dans le menu contextuel, sélectionnez Open In 

Score Editor.

Pour ouvrir la fenêtre de l'éditeur de partition en 
affichant la sélection d'édition actuelle :

1 Dans la fenêtre Edit ou dans une fenêtre de 
l'éditeur MIDI, effectuez une sélection d'édition 
sur une ou plusieurs pistes qui incluent les 
éléments que vous souhaitez afficher dans la 
fenêtre de l'éditeur de partition.

2 Effectuez un clic droit sur la sélection d'édition 
et sélectionnez Open In Score Editor.

Outils d'édition
Les outils d'édition dans la fenêtre de l'éditeur de 
partition fonctionnent à peu près comme ceux de la 
fenêtre Edit, avec toutefois quelques différences au 
niveau de l'édition de la notation musicale.

Zoom
L'outil de zoom permet d'effectuer un zoom avant 
et arrière sur une zone particulière de la partition. 

Deux modes de zoom sont disponibles : 

Zoom normal : l'outil de zoom reste sélectionné 
même après avoir zoomé. 

Zoom unique : l'outil d'édition précédemment 
sélectionné est automatiquement resélectionné une 
fois le zoom effectué.

Mode de zoom normal

Pour effectuer un zoom sur un point particulier de 
la partition :

1 Cliquez dans le menu déroulant du zoom et 
sélectionnez le mode de zoom normal.

2 Cliquez une fois avec l'outil de zoom sur un 
point de la partition. Un zoom avant d'un niveau 
est effectué et centré autour de l'emplacement 
sélectionné de la partition.

3 Pour revenir au niveau de zoom précédent, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le zoom.

Appuyez sur Alt+Démarrer+signe égal 
(Windows) ou Option+Ctrl+signe égal (Mac) 
pour afficher la fenêtre de l'éditeur 
de partition.

Si le paramètre Double Clicking a MIDI Clip 
Opens dans la page des préférences MIDI est 
défini sur l'option Score Editor, vous pouvez 
double-cliquer sur un clip MIDI pour l'ouvrir 
dans l'éditeur de partition.

Appuyez sur la touche F5 pour sélectionner 
le zoom et basculer entre les modes de zoom 
normal et unique.

Reportez-vous également à la section 
« Commandes de zoom de l'éditeur de 
partition » à la page 763.
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Pour effectuer un zoom par sélection sur une zone 
particulière de la partition :

1 Cliquez dans le menu déroulant du zoom et 
sélectionnez le mode de zoom normal.

2 Faites glisser sur la partition, et définissez un 
rectangle de sélection sur la zone sur laquelle 
vous souhaitez zoomer.

La zone agrandie remplit toute la fenêtre Edit.

Mode de zoom unique 

Le mode de zoom unique réactive l'outil précédent 
lorsque le zoom a été effectué.

Par exemple, lorsque vous utilisez le Crayon, 
si vous sélectionnez le zoom, chaque fois qu'un 
zoom aura été effectué, Pro Tools reviendra 
automatiquement au Crayon.

Le mode de zoom unique est identifié par une 
flèche vers la droite sur l'icône de l'outil de zoom. 
Cette flèche est absente en mode de zoom normal.

Pour activer le mode de zoom unique :

 Cliquez sur le menu contextuel de l'outil de 
zoom et sélectionnez le mode de zoom unique.

Trim
L'outil de trim permet d'allonger ou de raccourcir 
la durée d'une note dans la fenêtre de l'éditeur 
de partition.

Sélecteur de notes
Utilisez le sélecteur de notes pour sélectionner des 
notes sur une ou plusieurs portées dans la fenêtre 
de l'éditeur de partition. Les notes sélectionnées 
sont affichées en bleu. Vous pouvez supprimer, 
déplacer, transposer et traiter les notes 
sélectionnées (par le biais de la boîte de dialogue 
Event Operations). 

Main
Utilisez la Main pour sélectionner une ou plusieurs 
notes dans la fenêtre de l'éditeur de partition. Vous 
pouvez utiliser cet outil pour déplacer une seule 
note, ou toutes les notes sélectionnées, vers une 
hauteur ou un emplacement temporel différent.

Zoom par sélection à l'aide de l'outil de zoom

Appuyez sur la touche F6 pour sélectionner 
l'outil de trim.

Appuyez sur la touche F7 pour activer le 
sélecteur de notes.

Le sélecteur de notes crée une sélection qui 
n'inclut que les notes MIDI et leurs vélocités. 
Il n'inclut aucune autre donnée MIDI, telle 
que les changements de programme ou les 
données de contrôleur continu par exemple. 

Appuyez sur la touche F8 pour sélectionner 
la Main.
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Crayon
Utilisez le Crayon pour insérer, sélectionner, 
déplacer ou supprimer des notes dans la fenêtre de 
l'éditeur de partition. Les divers Crayons diffèrent 
dans la manière de dessiner la durée des notes, 
les notes répétées et les vélocités, mais ils 
fonctionnent de la même façon que pour dessiner 
des notes en vue Notes dans la fenêtre Edit ou une 
fenêtre de l'éditeur MIDI.

Pour sélectionner un Crayon :

 Cliquez sur le menu déroulant de l'outil Crayon 
et sélectionnez le Crayon de votre choix.

Les Crayons suivants sont disponibles dans 
l'éditeur de partition :

Main levée

Le Crayon à main levée permet de dessiner des 
notes individuelles de durées différentes. 

Les vélocités des notes sont déterminées par le 
paramètre Default Note Velocity (reportez-vous 
à la section « Vélocité d'attaque par défaut » à la 
page 757). 

La durée minimale des notes est déterminée par la 
durée de note par défaut sélectionnée (reportez-
vous à la section « Durée de note par défaut » à la 
page 757).

Ligne

La forme Ligne du Crayon permet de dessiner 
plusieurs notes de hauteur et de durée identiques. 

Les vélocités des notes sont déterminées par le 
paramètre Default Note Velocity (reportez-vous 
à la section « Vélocité d'attaque par défaut » à la 
page 757). 

La durée est déterminée par la durée de note par 
défaut sélectionnée (reportez-vous à la section 
« Durée de note par défaut » à la page 757). 

L'heure de début de chaque note est déterminée par 
la valeur de grille sélectionnée (reportez-vous à la 
section « Sélecteur de grille » à la page 759).

Triangle

La forme Triangle du Crayon permet de dessiner 
une série de notes MIDI ayant toutes la même 
hauteur et dont la vélocité varie entre la valeur 
Default Note Velocity définie et la valeur 127, 
formant ainsi des dents de scie. La durée de chaque 
note est déterminée par la valeur de grille actuelle.

La durée est déterminée par la durée de note par 
défaut sélectionnée (reportez-vous à la section 
« Durée de note par défaut » à la page 757). 

L'heure de début de chaque note est déterminée par 
la valeur de grille sélectionnée (reportez-vous à la 
section « Sélecteur de grille » à la page 759).

Carré

La forme Carré du Crayon permet de dessiner une 
série de notes MIDI ayant toutes la même hauteur 
et dont la vélocité varie entre la valeur Default 
Note Velocity définie et la valeur 127, dessinant 
ainsi un motif carré. La durée de chaque note est 
déterminée par la valeur de grille actuelle.

La durée est déterminée par la durée de note par 
défaut sélectionnée (reportez-vous à la section 
« Durée de note par défaut » à la page 757). 

L'heure de début de chaque note est déterminée par 
la valeur de grille sélectionnée (reportez-vous à la 
section « Sélecteur de grille » à la page 759).

Appuyez plusieurs fois sur F10 pour passer 
d'un Crayon à l'autre.
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Aléatoire

La forme Aléatoire du Crayon permet de dessiner 
une série de notes MIDI ayant toutes la même 
hauteur et dont la vélocité varie aléatoirement dans 
la plage comprise entre la valeur Default Note 
Velocity définie et la valeur 127, dessinant ainsi un 
motif aléatoire. La durée de chaque note est 
déterminée par la valeur de grille actuelle.

La durée est déterminée par la durée de note par 
défaut sélectionnée (reportez-vous à la section 
« Durée de note par défaut » à la page 757). 

L'heure de début de chaque note est déterminée par 
la valeur de grille sélectionnée (reportez-vous à la 
section « Sélecteur de grille » à la page 759).

Durée de note par défaut
Le sélecteur Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Pour définir une durée de note par défaut :

 Sélectionnez une valeur de note dans le 
sélecteur Default Note Duration. Sélectionnez 
l'option Follow Grid afin que la durée de note 
par défaut utilise la valeur de grille 
sélectionnée.

Pour ajouter des valeurs de notes pointées, 
sélectionnez également l'option Dotted.

Pour ajouter des valeurs de triolets, sélectionnez 
également l'option Triplet.

Vélocité d'attaque par défaut
Le paramètre Default Note On Velocity permet de 
définir la valeur de vélocité de l'attaque par défaut 
pour les notes insérées manuellement.

Lecture des notes MIDI en 
cours d'édition
Lorsqu'elle est activée, cette option déclenche un 
son lorsque vous insérez des notes MIDI à l'aide du 
Crayon ou que vous les faites glisser à l'aide de 
la Main. 

Liaison des sélections de 
timeline et d'édition
Lorsque ce bouton est activé, les sélections de 
timeline et d'édition sont liées. Lorsqu'il est 
désactivé, vous pouvez effectuer des sélections 
de timeline et d'édition de manière indépendante.

Sélecteur de durée de note par défaut

Option de lecture des notes MIDI en cours d'édition 
activée dans la fenêtre de l'éditeur de partition

Bouton de liaison des sélections de timeline et d'édition 
activé dans la fenêtre de l'éditeur de partition
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Édition MIDI en miroir
Cette option permet d'éditer des clips MIDI et 
d'appliquer vos modifications à chaque copie du 
même clip MIDI. Elle est particulièrement utile 
lors de l'édition de clips MIDI en boucle.

En mode d'édition MIDI en miroir, le bouton 
Mirrored MIDI Editing clignote une fois en rouge 
dès qu'une opération d'édition est appliquée à plus 
d'un clip.

Pour activer l'édition MIDI en miroir, procédez 
comme suit :

 Sélectionnez Options > Mirror MIDI Editing.

 Sélectionnez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit, la fenêtre de l'éditeur MIDI 
ou la fenêtre de l'éditeur de partition.

Pour désactiver l'édition MIDI en miroir, procédez 
comme suit :

 Désélectionnez Options > Mirror MIDI Editing.

 Désactivez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit, la fenêtre de l'éditeur MIDI 
ou la fenêtre de l'éditeur de partition.

Double barre de mesure
Lorsqu'elle est activée, l'option Double Bar affiche 
la double barre de mesure finale dans la fenêtre de 
l'éditeur de partition. Cette double barre se situe 
à la fin du dernier clip MIDI ou du dernier 
événement de la session. Activez l'option Double 
Bar lorsque vous êtes prêt à imprimer la partition.

Lorsque l'option Double Bar est désactivée, 
un certain nombre de mesures vides apparaît à la 
fin du dernier clip MIDI de la session. Le nombre 
de mesures vides est déterminé par le paramètre 
Additional Empty Bars In The Score Editor des 
préférences MIDI de Pro Tools (Setup > 

Preferences). Désactivez l'option Double Bar pour 
saisir manuellement les notes dans l'éditeur de 
partition après le dernier clip MIDI.

Emplacement du curseur
L'affichage de l'emplacement du curseur fournit 
des informations sur l'emplacement actuel du 
curseur dans Bars|Beats|Ticks et la hauteur.

Option d'édition MIDI en miroir désactivée dans la 
fenêtre de l'éditeur de partition

Lorsque le mode Mirrored MIDI Editing est 
désactivé et que vous éditez des notes de clips 
mis en boucle dans la vue Notes, l'opération 
d'édition a pour effet de mettre à plat la 
boucle. De même, l'édition de groupes de 
clips a pour effet de séparer les clips.

Option Double barre de mesure activée dans la 
fenêtre de l'éditeur de partition

Indicateur d'emplacement du curseur dans la fenêtre 
de l'éditeur de partition
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Sélecteur de grille
Le sélecteur de grille permet de définir la valeur de 
grille pour les notes MIDI insérées et affichées 
dans la fenêtre de l'éditeur de partition. 

Pour définir la valeur de grille pour la fenêtre de 
l'éditeur de partition :

 Dans le menu déroulant Grid Value, 
sélectionnez une valeur de note.

Pour ajouter des valeurs de notes pointées, 
sélectionnez également l'option Dotted.

Pour ajouter des valeurs de triolets, sélectionnez 
également l'option Triplet.

Insertion de notes sur la grille
Lors de l'insertion de notes MIDI en utilisant une 
des formes du Crayon (Ligne, Triangle, Carré 
ou Aléatoire), la valeur de la grille détermine 
l'emplacement de l'attaque et la durée de note 
par défaut détermine la durée des notes (reportez-
vous à la section « Durée de note par défaut » à la 
page 757). 

Par exemple, si la durée de note par défaut est 
définie sur une noire et si la valeur de grille est 
réglée sur une blanche, en utilisant la forme Ligne 
du Crayon, vous créerez alternativement des noires 
et des silences.

Si la valeur de grille sélectionnée est inférieure à la 
durée de note par défaut, la valeur de grille 
détermine l'emplacement de l'attaque et la durée 
des notes pour les notes insérées à l'aide du 
Crayon. Par exemple, si la durée de note par défaut 
est définie sur une noire et si la valeur de grille est 
définie sur une croche, en dessinant avec la forme 
Ligne du Crayon, vous créerez une séquence de 
croches.

Ciblage de la fenêtre de 
l'éditeur de partition
Lorsque la fenêtre de l'éditeur de partition est 
désignée en tant que fenêtre cible, le fait de 
naviguer dans la fenêtre Edit entraîne 
automatiquement la navigation dans la fenêtre de 
l'éditeur de partition. Par exemple, si vous accédez 
à la mesure 32, temps 3 dans une piste MIDI dans 
la fenêtre Edit, la fenêtre de l'éditeur de partition 
affiche le même emplacement.

Lorsque le ciblage est désactivé, l'éditeur de 
partition ne se met pas à jour pour afficher la 
sélection actuelle de la fenêtre Edit ou 
l'emplacement du curseur d'édition.

Définition de la valeur de grille

Insertion de notes sur la grille
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Menu de la fenêtre de 
l'éditeur de partition
Le menu de la fenêtre de l'éditeur de partition 
permet d'accéder aux options Expanded Edit 
Tools, Selection Display, Track List et Scrolling.

Expanded Edit Tools
Lorsqu'elle est sélectionnée, l'option Expanded 

Edit Tools permet d'afficher tous les outils d'édition 
sur la barre d'outils de la fenêtre de l'éditeur de 
partition. 

Si cette option n'est pas sélectionnée, seule l'icône 
de l'outil d'édition sélectionné est affichée. Tous 
les autres outils d'édition peuvent être sélectionnés 
à partir du menu déroulant des outils d'édition.

Selection Display
Lorsque l'option Selection Display est 
sélectionnée, la sélection d'édition est affichée sur 
la barre d'outils de la fenêtre de l'éditeur MIDI.

Track List
Lorsque l'option Track List est sélectionnée, la liste 
des pistes est affichée dans la fenêtre de l'éditeur de 
partition.

Scrolling
Le sous-menu Scrolling permet de sélectionner les 
options de défilement pour la fenêtre de l'éditeur 
de partition indépendamment des autres fenêtres 
de l'éditeur MIDI et de la fenêtre Edit. Les options 
de défilement incluent :

No Scrolling : la fenêtre de l'éditeur de partition ne 
défile ni pendant ni après la lecture. Le curseur de 
lecture se déplace dans la fenêtre Edit, indiquant la 
position de lecture.

After Playback : le curseur de lecture se déplace 
dans la fenêtre de l'éditeur de partition, indiquant 
la position de lecture. La fenêtre de l'éditeur de 
partition défile jusqu'au dernier point lu après 
l'arrêt de la lecture.

Page : le curseur de lecture se déplace dans la 
fenêtre de l'éditeur de partition, indiquant la 
position de lecture. Lorsque le bord droit de la page 
actuellement affichée dans la fenêtre de l'éditeur de 
partition est atteint, son contenu défile à la page 
suivante et le curseur de lecture reprend son 
déplacement depuis le bord gauche de la fenêtre.

Follow Edit Window : lorsque cette option est 
sélectionnée, la fenêtre de l'éditeur de partition 
utilise l'option de défilement sélectionnée pour la 
fenêtre Edit (Options > Edit Window Scrolling).Affichage de la sélection

Pour les systèmes Pro Tools|HD, les options 
de défilement Continuous et Center Playhead 
ne sont pas disponibles dans la fenêtre de 
l'éditeur de partition. Si l'option de défilement 
Follow Edit Window est sélectionnée dans la 
fenêtre de l'éditeur de partition et si l'option 
Continuous ou Center Playhead est activée 
dans la fenêtre Edit, la fenêtre de l'éditeur de 
partition défile par page.
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Barre d'outils 
personnalisable
Vous pouvez personnaliser la barre d'outils de la 
fenêtre de l'éditeur de partition en réorganisant, 
en affichant et en masquant les commandes et 
affichages disponibles, de la même façon que dans 
la fenêtre Edit ou les fenêtres de l'éditeur MIDI.

Modification des options 
d'affichage de la barre d'outils

Pour modifier les options d'affichage de la barre 
d'outils de la fenêtre de l'éditeur de partition :

1 Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la barre d'outils de la 
fenêtre de l'éditeur de partition.

• Effectuez un clic droit sur la barre d'outils.

2 Dans le menu contextuel, sélectionnez ou 
désélectionnez un ou plusieurs des éléments 
suivants :

• Selection Display

• Expanded Edit Tools

Réorganisation des commandes 
et affichages

Pour réorganiser les commandes et affichages de 
la barre d'outils d'une fenêtre de l'éditeur MIDI :

 Cliquez sur les commandes ou affichages que 
vous souhaitez déplacer tout en maintenant la 
touche Ctrl (Windows) ou Commande (Mac) 
enfoncée, puis faites-les glisser vers le nouvel 
emplacement de la barre d'outils.

Liste des pistes
La liste des pistes vous permet d'afficher et de 
masquer des pistes MIDI et d'instrument dans 
l'éditeur de partition. Elle permet également 
d'accéder aux boîtes de dialogue Notation Display 
Track Settings et Score Setup (reportez-vous aux 
sections « Notation Display Track Settings » à la 
page 764 et « Score Setup » à la page 766).

Pour afficher ou masquer la liste des pistes dans 
la fenêtre de l'éditeur de partition :

 Dans le menu de la fenêtre de l'éditeur de 
partition, sélectionnez ou désélectionnez Track 

List.

Affichage et masquage des 
pistes
Utilisez la liste des pistes pour afficher et masquer 
les pistes MIDI et d'instrument sous forme de 
portée dans la partition.

Pour afficher les pistes MIDI et d'instrument dans 
l'éditeur de partition :

 Activez l'icône Track Show/Hide dans la liste 
des pistes pour les pistes que vous souhaitez 
afficher dans la partition.

Partition partielle : les pistes Violin I et Violin II sont 
affichées, toutes les autres sont masquées
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Pour afficher toutes les pistes MIDI et d'instrument 
dans l'éditeur de partition :

 Dans le menu déroulant de la liste des pistes, 
sélectionnez Show All Tracks.

Pour afficher uniquement les pistes MIDI et 
d'instrument sélectionnées dans l'éditeur de 
partition :

1 Dans la liste des pistes, sélectionnez les pistes 
MIDI et d'instrument que vous souhaitez 
afficher dans la partition.

2 Dans le menu déroulant de la liste des pistes, 
sélectionnez Show Only Selected Tracks.

Pour masquer les pistes MIDI et d'instrument dans 
l'éditeur de partition :

 Désactivez l'icône Track Show/Hide dans la 
liste des pistes pour les pistes que vous 
souhaitez afficher dans la partition.

Pour masquer toutes les pistes MIDI et 
d'instrument dans l'éditeur de partition :

 Dans le menu déroulant de la liste des pistes, 
sélectionnez Hide All Tracks.

Pour masquer les pistes MIDI et d'instrument 
sélectionnées dans l'éditeur de partition :

1 Dans la liste des pistes, sélectionnez les pistes 
MIDI et d'instrument que vous souhaitez 
masquer dans la partition.

2 Dans le menu déroulant de la liste des pistes, 
sélectionnez Hide Selected Tracks.

Commandes de page
La fenêtre de l'éditeur de partition offre des 
commandes permettant de naviguer en avant ou en 
arrière par page. Le numéro de la page actuelle est 
affiché dans le coin inférieur gauche de la fenêtre.

Pour afficher la page suivante de la partition :

 Cliquez sur le bouton Page suivante.

Pour afficher la page précédente de la partition :

 Cliquez sur le bouton Page précédente.

Pour afficher une page particulière de la partition :

1 Cliquez sur le bouton Page actuelle.

2 Entrez le numéro de la page que vous souhaitez 
afficher.

3 Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac).

Commandes de page de l'éditeur de partition

Page suivante

Page précédente

Page actuelle
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Commandes de zoom de 
l'éditeur de partition
En plus de l'outil de zoom, l'éditeur de partition 
dispose de boutons de zoom avant et arrière situés 
dans le coin inférieur droit de la fenêtre, ainsi que 
d'un sélecteur de zoom qui permet d'effectuer un 
zoom à un pourcentage prédéfini ou une taille de 
page. Lors de l'utilisation de ces commandes de 
zoom, l'éditeur de partition effectue un zoom 
autour de la sélection d'édition actuelle.

Pour effectuer un zoom avant d'un niveau :

 Cliquez sur le bouton de zoom avant.

Pour effectuer un zoom arrière d'un niveau :

 Cliquez sur le bouton de zoom arrière.

Pour effectuer un zoom d'un pourcentage prédéfini :

1 Cliquez sur le sélecteur de zoom.

2 Dans le menu déroulant Zoom, sélectionnez le 
pourcentage de zoom.

Pour effectuer un zoom à une taille de page :

1 Cliquez sur le sélecteur de zoom.

2 Dans le menu déroulant Zoom, sélectionnez la 
taille de page.

Zoom à des tailles de page
Le menu déroulant Zoom propose les tailles de 
page suivantes :

Fit Page Width : effectue un zoom en ajustant la 
largeur de la page à celle de la fenêtre de l'éditeur 
de partition.

Fit Page Height : effectue un zoom en ajustant la 
hauteur de la page à celle de la fenêtre de l'éditeur 
de partition.

Fit Page : effectue un zoom en ajustant la totalité 
de la page à la fenêtre de l'éditeur de partition.

Fit 2 Pages : effectue un zoom de sorte en ajustant 
deux pages horizontalement dans la fenêtre de 
l'éditeur de partition.

Commandes de zoom de l'éditeur de partition

Zoom avant
Zoom arrière

Sélecteur de zoom

Sélection d'une valeur de zoom dans le menu 
déroulant Zoom
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Notation Display Track 
Settings
Les paramètres Notation Display Track déterminent 
l'apparence des pistes MIDI et d'instrument 
individuelles dans l'éditeur de partition. Vous 
pouvez définir la clé, la quantification d'affichage et 
le mode d'affichage de chaque portée, avec ou sans 
transposition (par exemple pour un saxophone ténor 
en si bémol).

Pour configurer les paramètres Notation Display 
Track :

1 Effectuez l'une des opérations suivantes :

• Dans le menu Track de l'éditeur de partition, 
sélectionnez Notation Display Track Settings.

• Effectuez un clic droit et sélectionnez Notation 
Display Track Settings.

• Double-cliquez sur la clé d'une portée.

2 Dans le menu contextuel Track, sélectionnez la 
piste MIDI ou d'instrument dont vous souhaitez 
modifier les paramètres d'affichage.

3 Configurez les paramètres.

4 Répétez les étapes précédentes pour les autres 
pistes MIDI et d'instrument, si nécessaire.

Options d'affichage de la 
notation des pistes

Track

Dans le menu contextuel Track, sélectionnez la 
piste à configurer.

Clef

Dans le menu contextuel Clef, sélectionnez la clé 
de votre choix pour la piste sélectionnée, parmi les 
choix suivants :

• Grand Staff

• Treble Clef

• Bass Clef

• Alto Clef

• Tenor Clef

Display Transposition

Dans le menu déroulant Key, sélectionnez la 
tonalité de transposition de la piste. Pour les 
instruments qui se transposent à partir d'une autre 
octave, vous pouvez également régler le curseur 
Octave. Par exemple, pour une piste de clarinette 
basse, sélectionnez la tonalité de si bémol et réglez 
le curseur Octave sur +1. Ainsi, lorsque vous 
imprimez la partie de la clarinette basse, 
le musicien pourra lire la partition et la hauteur 
perçue sera correcte, une neuvième majeure en 
dessous de celle qui est écrite.

Notation Display Track Settings
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Attributes

L'onglet Attributes permet de spécifier les 
paramètres de quantification de l'affichage de la 
piste sélectionnée. Si l'option Clef est réglée sur 
Grand Staff, vous pouvez également définir le 
paramètre de point de séparation Split Point afin de 
diviser les notes entre les clés grave et aiguë.

Follow Globals

Lorsque l'option Follow Globals est sélectionnée, 
les attributs de piste utilisent les paramètres 
d'attributs globaux (reportez-vous à la section 
« Globals » à la page 765). Par défaut, cette option 
est activée pour toutes les pistes.

Display Quantization

Le paramètre Display Quantization permet de 
sélectionner la grille de quantification pour 
l'affichage des notes MIDI sur la partition. 
Les notes MIDI dans Pro Tools conservent leurs 
heures de début et leur durée d'origine, mais ce 
paramètre affecte les valeurs de note affichées. 
L'affichage de la partition est quantifié sur la 
valeur de note de sélection la plus proche.

Straighten Swing

Lorsque l'option Straighten Swing est activée, 
les notes swinguées sont affichées sous la forme de 
notes régulières. Par exemple, une suite de croches 
swinguées sera affichée sous forme de croches 
simples.

Allow Note Overlap

Pro Tools affiche une seule ligne rythmique sur une 
seule portée. Lorsque deux notes qui commencent 
à des moments différents se superposent, 
la première note est tronquée au moment où 
démarre la deuxième note. Si l'option Allow Note 

Overlap est activée, Pro Tools affiche la longueur 
totale des notes qui se chevauchent à l'aide de notes 
liées.

Split Point

Lorsque l'option Clef de la piste sélectionnée est 
réglée sur Grand Staff, le paramètre Split Point 
détermine la hauteur à laquelle les notes sont 
placées sur la portée supérieure ou inférieure de la 
portée Grand Staff.

Automatic : lorsque cette option est sélectionnée, 
Pro Tools divise les notes entre les portées 
supérieure et inférieure de la portée Grand Staff 
selon des groupes de notes logiques.

Fixed : cette option vous permet de spécifier une 
hauteur particulière à laquelle doit s'effectuer la 
répartition des notes entre la portée supérieure et 
inférieure de la double portée.

Globals

L'onglet Globals propose les mêmes paramètres 
que l'onglet Attributes (reportez-vous à la section 
« Attributes » à la page 765). Vous pouvez 
sélectionner les pistes qui suivent les paramètres 
de l'onglet Globals sur l'onglet Attributes de chaque 
piste.

Onglet Attributes de la fenêtre Notation Display Track 
Settings
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Score Setup
La fenêtre Score Setup permet de configurer la 
disposition de la page et l'espace entre les portées. 
Vous pouvez y indiquer le titre et le compositeur 
de la partition. Vous pouvez également 
sélectionner les éléments de la partition à afficher. 
Les modifications apportées à la fenêtre Score 
Setup sont immédiatement répercutées dans 
l'éditeur de partition.

Pour ouvrir la fenêtre Score Setup, effectuez l'une 
des opérations suivantes :

 Sélectionnez File > Score Setup.

 Dans le menu Tracks de la fenêtre de l'éditeur de 
partition, sélectionnez Score Setup.

 Effectuez un clic droit dans la fenêtre de 
l'éditeur de partition et sélectionnez Score 

Setup.

Options de la fenêtre Score 
Setup

Information

Title : saisissez le titre de la partition. Celui-ci 
apparaîtra en haut de la première page.

Composer : saisissez le nom du compositeur de la 
partition. Il apparaît dans le coin supérieur droit de 
la première page.

Display

Les options Display déterminent les éléments 
à afficher sur la partition. Désélectionnez les 
éléments que vous ne souhaitez pas afficher.

Fenêtre Score Setup



Chapitre 33 : Éditeur de partition 767

Title and Composer : sélectionnez cette option 
pour que le titre et le nom du compositeur soient 
affichés sur la partition.

Page Numbers : sélectionnez cette option pour 
que les numéros de page soient affichés au bas de 
chaque page.

Bar Numbers : sélectionnez cette option pour 
afficher les numéros des mesures au début de 
chaque système au-dessus de la portée supérieure.

Track Names : sélectionnez cette option pour 
afficher le nom des pistes pour chaque portée au 
début de la partition.

Chord Symbols : sélectionnez cette option pour 
afficher les symboles d'accord sur la partition.

Chord Diagrams : sélectionnez cette option pour 
afficher les diagrammes d'accord (tablatures) sur la 
partition (reportez-vous à la section « Symboles et 
diagrammes d'accord » à la page 773).

Spacing

Between Staves : spécifiez l'espacement à 
appliquer entre chaque portée.

Between Systems : spécifiez l'espacement à 
appliquer entre chaque système.

Below Title and Composer : indiquez 
l'espacement à appliquer entre le titre et le 
compositeur et la première portée de la partition.

Below Chord Symbols and Diagrams : indiquez 
l'espacement à appliquer entre les symboles et les 
diagrammes d'accords et la portée supérieure de 
chaque système.

Layout

Page Size : sélectionnez la taille de la page (Letter, 
Legal, Tabloid ou A4).

Portrait : sélectionnez cette option pour définir 
l'orientation de la page sur portrait.

Landscape : sélectionnez cette option pour définir 
l'orientation de la page sur paysage.

Staff Size : indiquez la taille de la portée.

Page Margins : indiquez la taille des marges 
supérieure, inférieure, gauche et droite. 

Inches : sélectionnez cette option pour saisir la 
taille de la portée et les marges de la page en 
pouces.

Millimeters : sélectionnez cette option pour saisir 
la taille de la portée et les marges de la page en 
millimètres.

Édition de notes
L'édition de notes MIDI dans la fenêtre Edit, 
les fenêtres de l'éditeur MIDI et la fenêtre de 
l'éditeur de partition affecte les mêmes données 
MIDI. Lors de l'édition dans une fenêtre, 
vos modifications sont répercutées dans toutes 
les autres fenêtres. 

L'éditeur de partition propose des outils d'édition 
simples permettant de saisir, déplacer et transposer 
les notes MIDI sous la forme de notation musicale : 

• L'outil de trim permet de rallonger ou de 
raccourcir la durée des notes.

• Le sélecteur de notes permet de sélectionner des 
notes en tant qu'objets sur la partition.

Désactivez l'option Chord Diagrams lorsque 
vous imprimez des partitions simplifiées sur 
lesquelles vous voulez uniquement voir les 
symboles d'accord.

Sur les pages sur lesquelles la partition est 
justifiée verticalement, la distance entre les 
portées et les systèmes sera supérieure aux 
valeurs indiquées.
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• L'outil de saisie (Main) permet de sélectionner 
et de déplacer les notes vers une hauteur ou un 
emplacement temporel différent sur la même 
piste. 

• Le Crayon permet d'insérer et de déplacer les 
notes vers une hauteur ou un emplacement 
temporel différent sur la même piste.

Sélection de notes
Vous pouvez utiliser le sélecteur de notes ou la 
Main pour sélectionner des notes sur une ou 
plusieurs portées.

Pour sélectionner des notes sur une ou plusieurs 
portées à l'aide du sélecteur de notes :

1 Cliquez sur le sélecteur de notes.

2 Faites glisser sur la partition afin de mettre en 
surbrillance les notes que vous souhaitez 
sélectionner.

Pour définir une sélection sur une ou plusieurs 
portées à l'aide de la Main :

1 Cliquez sur la Main.

2 Faites glisser sur la partition afin de mettre en 
surbrillance les notes que vous souhaitez 
sélectionner.

Transposition de notes
Vous pouvez utiliser l'outil de saisie ou le Crayon 
pour transposer manuellement une note vers le 
haut ou vers le bas. Vous pouvez également utiliser 
la fenêtre Transpose Event Operation (Event > 

Event Operations > Transpose) pour transposer les 
notes sélectionnées.

Pour transposer une seule note :

1 Cliquez sur la Main.

2 Faites glisser la note que vous souhaitez 
transposer vers le haut ou vers le bas.

Pour transposer toutes les notes sélectionnées :

1 Cliquez sur la Main.

2 Faites glisser le curseur autour des notes que 
vous souhaitez transposer pour les sélectionner.

3 Faites glisser une des notes sélectionnées vers le 
haut ou vers le bas pour les transposer.

Sélection de notes avec le sélecteur de notes

Sélection de notes avec la Main

Transposition d'une note à l'aide de la Main

Transposition des notes sélectionnées avec la Main
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Déplacement de notes
Utilisez la Main pour déplacer les notes 
sélectionnées d'un emplacement temporel à un 
autre sur la même portée. Lors du déplacement de 
notes dans l'éditeur de partition, les notes MIDI 
sous-jacentes conservent leur position relative sur 
la grille.

Pour déplacer des notes vers un autre 
emplacement temporel :

1 Cliquez sur la Main.

2 Pour déplacer plusieurs notes, faites glisser le 
curseur autour des notes que vous souhaitez 
déplacer pour les sélectionner.

3 Faites glisser l'une des notes sélectionnées vers 
un autre emplacement temporel sur la même 
portée.

Insertion de notes
Utilisez le Crayon pour insérer manuellement des 
notes dans l'éditeur de partition. Lorsque vous 
insérez une note, l'éditeur de partition la place 
automatiquement sur la grille et crée des silences 
aux emplacements appropriés.

Pour insérer une note manuellement :

1 Sélectionnez une durée de note par défaut 
(reportez-vous à la section « Durée de note par 
défaut » à la page 757).

2 Sélectionnez la valeur de grille de votre choix 
(reportez-vous à la section « Sélecteur de 
grille » à la page 759).

3 Sélectionnez la vélocité par défaut (reportez-
vous à la section « Vélocité d'attaque par 
défaut » à la page 757).

4 Cliquez sur le Crayon et sélectionnez la forme 
Main levée.

5 Avec la forme Main levée du Crayon, effectuez 
l'une des opérations suivantes :

• Cliquez sur l'emplacement temporel et la 
hauteur de votre choix pour saisir une note de la 
durée par défaut sélectionnée.

Déplacement des notes sélectionnées avec la Main

Vous pouvez également déplacer les notes par 
incrément, de la valeur de grille sélectionnée.

Vous pouvez également entrer des notes en 
enregistrant des données, en important des 
données MIDI à partir d'un fichier ou en mode 
pas à pas (Event > Event Operations > Step 
Input).

Saisie d'une seule note à l'aide du Crayon
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• Cliquez sur l'emplacement temporel et la 
hauteur de votre choix et faites glisser le curseur 
vers la droite pour augmenter la durée de la note.

Pour insérer manuellement plusieurs notes de la 
même hauteur :

1 Sélectionnez une durée de note par défaut 
(reportez-vous à la section « Durée de note par 
défaut » à la page 757).

2 Sélectionnez la valeur de grille de votre choix 
(reportez-vous à la section « Sélecteur de 
grille » à la page 759).

3 Sélectionnez la vélocité par défaut (reportez-
vous à la section « Vélocité d'attaque par 
défaut » à la page 757).

4 Cliquez sur le Crayon et sélectionnez l'une des 
formes suivantes :

• Ligne

• Triangle

• Carré

• Aléatoire

5 Cliquez sur l'emplacement temporel et la 
hauteur de votre choix et faites glisser le curseur 
vers la droite. Les notes répétées de la durée de 
note par défaut sélectionnée sont saisies sur la 
grille sélectionnée. La vélocité d'attaque de 
chaque note est déterminée par le paramètre 
Default Note On Velocity et la forme du Crayon 
sélectionnée (reportez-vous à la section 
« Crayon » à la page 756).

Silences
L'éditeur de partition ajoute les silences 
automatiquement, dès que nécessaire. 
Les silences ne peuvent pas être déplacés ou 
insérés manuellement.

Menu contextuel de l'éditeur 
de partition
Le menu contextuel de l'éditeur de partition fournit 
plusieurs commandes pour l'édition, l'exportation 
et la mise en forme de la partition et des données 
MIDI.

Pour accéder au menu contextuel de l'éditeur de 
partition :

 Effectuez un clic droit sur la partition.

Éléments du menu contextuel 
de l'éditeur de partition

Tools

Le sous-menu Tools permet de sélectionner les 
outils d'édition appropriés pour l'éditeur de 
partition.

Zoom : sélectionne l'outil de zoom.

Sélecteur de notes : active le sélecteur de notes.

Main : sélectionne la Main.

Crayon : sélectionne le Crayon.

Saisie d'une note plus longue à l'aide du Crayon

Saisie de plusieurs notes de même hauteur à l'aide de 
la forme Ligne du Crayon
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Insert

Le sous-menu Insert permet d'insérer des 
changements de tonalité et de mesure et des 
symboles d'accord dans la partition à 
l'emplacement du curseur d'édition.

Key : insère un changement de tonalité.

Meter : insère un changement de mesure.

Chord : insère un symbole d'accord.

Cut

La commande Cut coupe la sélection d'édition 
actuelle.

Copy

La commande Copy copie la sélection d'édition 
actuelle.

Paste

La commande Paste colle le contenu du presse-
papiers sur la sélection d'édition actuelle ou à 
l'emplacement actuel du curseur d'édition. Toutes 
les notes MIDI déjà présentes au même 
emplacement sont remplacées.

Merge

La commande Merge copie le contenu du presse-
papiers sur la sélection d'édition actuelle ou à 
l'emplacement actuel du curseur d'édition et 
fusionne les données copiées avec les notes MIDI 
déjà existantes au même emplacement.

Clear

La commande Clear efface (supprime) la sélection 
d'édition actuelle.

Event Operations

Le sous-menu Event Operations permet de 
sélectionner l'une des fenêtres Event Operations 
(Quantize ou Change Velocity par exemple).

Open in MIDI Editor

L'option Open in MIDI Editor ouvre les pistes 
affichées dans l'éditeur de partition dans une 
fenêtre de l'éditeur MIDI.

Open in MIDI Event List

L'option Open In MIDI Event List ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Notation Display Track Settings

L'option Notation Display Track Settings ouvre la 
boîte de dialogue Notation Display Track Settings 
(reportez-vous à la section « Notation Display 
Track Settings » à la page 764).

Score Setup

L'option Score Setup ouvre la boîte de dialogue 
Score Setup (reportez-vous à la section « Score 
Setup » à la page 766).

Send to Sibelius

La commande Send to Sibelius envoie la partition, 
telle qu'elle apparaît dans la fenêtre de l'éditeur de 
partition, vers le logiciel de notation Sibelius 
(reportez-vous à la section « Exportation de 
partitions » à la page 774).

Print Score

La commande Print Score imprime la partition 
(reportez-vous à la section « Impression de 
partitions » à la page 775).
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Changements de tonalité
Vous pouvez ajouter, modifier et supprimer des 
armures dans votre partition. Les armures affectent 
l'écriture des notes MIDI sur la partition. Ainsi la 
note MIDI numéro 58 (Si bémol 3) correspond 
à un Si bémol en Fa majeur, mais devient La dièse 
en Si majeur.

Pour ajouter une armure :

1 Avec le sélecteur de notes, la Main ou le 
Crayon, effectuez un clic droit à l'emplacement 
de la partition où vous souhaitez changer la 
tonalité et sélectionnez Insert > Key Change.

2 Dans la boîte de dialogue Key Change, 
sélectionnez le mode (majeur ou mineur), 
la tonalité, l'emplacement et la durée, puis 
indiquez le type de modification apportée à la 
hauteur.

3 Cliquez sur OK.

L'armure sélectionnée s'affiche sur la partition et 
l'écriture des notes est mise à jour pour refléter le 
changement de tonalité.

Pour modifier une armure :

1 À l'aide de la Main, double-cliquez sur l'armure 
à modifier.

2 Saisissez les valeurs dans la boîte de dialogue 
Key Change et cliquez sur OK.

Pour supprimer une armure :

 Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et cliquez sur 
l'armure à supprimer à l'aide de la Main.

Changements de mesure
Vous pouvez ajouter, modifier et supprimer des 
événements de métrique dans votre partition. 
Les modifications apportées à la métrique 
affectent le nombre de mesures de la partition 
(et de votre session). Lorsque la métrique est 
changée, les notes ne sont pas déplacées, mais 
les barres de mesure sont retracées.

Pour ajouter un changement de mesure :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Event > Time Operations > 

Change Meter.

• Avec le sélecteur de notes, la Main ou le Crayon, 
effectuez un clic droit à l'emplacement de la 
partition où vous souhaitez changer la métrique 
et sélectionnez Insert > Meter Change.

2 Renseignez les champs Location et Meter de la 
boîte de dialogue Meter Change.

3 Pour placer l'événement de métrique inséré 
précisément sur le premier temps de la mesure 
la plus proche, cochez l'option Snap To Bar.

Vous pouvez également ajouter et supprimer 
les armures sur la règle Key Signature de la 
fenêtre Edit ou dans l'une des fenêtres de 
l'éditeur MIDI.

Vous pouvez également ajouter et supprimer 
des événements de métrique sur la règle de 
tempo de la fenêtre Edit et dans les fenêtres 
de l'éditeur MIDI.

Boîte de dialogue Meter Change
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4 Sélectionnez une valeur de note (ronde, 
blanche, noire, etc.) pour définir le nombre de 
battements entendus dans chaque mesure. 
Sélectionnez l'option point (.) si vous souhaitez 
pointer la valeur de note.

5 Cliquez sur OK pour insérer le nouvel 
événement de métrique.

Pour modifier un changement de mesure :

1 À l'aide de la Main, double-cliquez sur 
l'événement de métrique à modifier.

2 Saisissez les valeurs dans la boîte de dialogue 
Meter Change et cliquez sur OK.

Pour supprimer un changement de mesure :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur l'événement de 
métrique à supprimer à l'aide de la Main.

Symboles et diagrammes 
d'accord
Vous pouvez ajouter, modifier et supprimer les 
symboles et diagrammes d'accord (tablatures) dans 
votre partition. Les symboles d'accord n'ont aucun 
effet sur les données MIDI. De plus, les symboles 
d'accord ne sont pas inclus lors de l'exportation des 
données MIDI de Pro Tools vers un fichier MIDI, 
mais ils sont inclus lors de l'exportation vers un 
fichier Sibelius (.sib) ou lors de l'utilisation de la 
commande Send to Sibelius.

Pour insérer un symbole d'accord:

1 Avec le sélecteur de notes, la Main ou le 
Crayon, effectuez un clic droit à l'emplacement 
de la partition où vous souhaitez ajouter un 
symbole d'accord et sélectionnez Insert > 

Chord.

2 Dans la boîte de dialogue Chord Change, 
sélectionnez un nom pour la fondamentale 
de l'accord dans le sélecteur d'accord (ré par 
exemple).

Avec certaines métriques, il peut être 
souhaitable d'utiliser une valeur pointée. 
Par exemple, dans le cas d'une mesure en 6/8, 
le choix d'une noire pointée (donnant deux 
battements par métrique) est généralement 
mieux adapté qu'une croche simple 
(six battements par métrique).

Vous pouvez également ajouter et supprimer 
des symboles d'accord sur la règle de 
symboles d'accord de la fenêtre Edit et dans 
les fenêtres de l'éditeur MIDI. Toutefois, 
les diagrammes d'accords (tablatures) 
s'affichent uniquement dans la fenêtre de 
l'éditeur de partition.

Boîte de dialogue Chord Change

Sélecteur d'accord

Sélecteur de 
type d'accord

Sélecteur de 
note basse

Diagrammes d'accord
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3 Sélectionnez le type à partir du sélecteur de type 
d'accord (majeur ou mineur par exemple).

4 Sélectionnez la note basse de l'accord dans le 
sélecteur de note basse (par exemple, un si 
bémol pour un accord de sol dièse mineur 
inversé).

5 Sélectionnez un diagramme d'accord (tablature) 
parmi les options disponibles.

6 Cliquez sur OK.

Le symbole d'accord sélectionné est placé au-
dessus de la portée supérieure dans le système.

Pour modifier un symbole d'accord :

1 À l'aide de la Main, double-cliquez sur le 
symbole d'accord à modifier.

2 Effectuez les modifications dans la boîte de 
dialogue Chord Change et cliquez sur OK.

Pour déplacer un symbole d'accord :

 Faites glisser le symbole d'accord vers son 
nouvel emplacement à l'aide de la Main.

Pour supprimer un symbole d'accord :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le symbole 
d'accord à supprimer à l'aide de la Main.

Pour afficher ou masquer les symboles d'accord 
sur la partition :

 Dans la boîte de dialogue Score Settings (File > 

Score Setup), activez ou désactivez l'option 
Chord Symbols.

Pour afficher ou masquer les diagrammes 
d'accord (tablatures) sur la partition :

 Dans la boîte de dialogue Score Settings (File > 

Score Setup), activez ou désactivez l'option 
Chord Diagrams.

Exportation de partitions
Pro Tools permet d'exporter la partition de votre 
session sous forme de fichier Sibelius (.sib). Vous 
pouvez alors ouvrir votre partition telle qu'elle 
a été transcrite par Pro Tools dans Sibelius, 
y modifier la notation et imprimer la partition 
à partir de Sibelius.

Pour exporter une partition depuis Pro Tools :

1 Configurez la partition pour votre session dans 
la fenêtre de l'éditeur de partition.

2 Sélectionnez File > Export > To Sibelius.

3 Sélectionnez une destination et cliquez sur Save.

Pour envoyer la partition de votre session 
Pro Tools vers Sibelius, effectuez l'une des 
opérations suivantes :

1 Configurez la partition pour votre session dans 
la fenêtre de l'éditeur de partition.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez File > Send to Sibelius.

• Effectuez un clic droit dans l'éditeur de partition 
et sélectionnez Send to Sibelius.

Symbole et diagramme d'accord sur la partition

Sibelius version 5.x ou supérieure est requis 
pour ouvrir les fichiers .sib exportés depuis 
Pro Tools.
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Pro Tools exporte vers Sibelius toutes les pistes 
d'instrument et MIDI affichées dans l'éditeur de 
partition dans un fichier .sib et lance Sibelius s'il 
est installé sur votre ordinateur. Vous pouvez 
apporter des modifications supplémentaires à la 
notation dans Sibelius et imprimer la partition de 
votre session.

Impression de partitions
Pro Tools permet d'imprimer la partition depuis 
votre session Pro Tools. La partition est imprimée 
exactement telle qu'elle apparaît dans la fenêtre de 
l'éditeur de partition. Configurez la boîte de 
dialogue Score Setup et affichez ou masquez des 
pistes MIDI et d'instrument. Seules les pistes 
affichées seront imprimées.

Pour imprimer la partition à partir de votre session 
Pro Tools :

1 Ouvrez la fenêtre de l'éditeur de partition et 
configurez votre partition.

2 Sélectionnez File > Print Score.

3 Configurez la boîte de dialogue Print et cliquez 
sur OK (Windows) ou Print (Mac).

Appuyez sur Commande+P (Mac) ou Ctrl+P 
(Windows) pour imprimer la partition.
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Chapitre 34 : Liste des événements MIDI

La Liste des événements MIDI répertorie les 
détails de tous les événements présents sur une 
piste MIDI ou d'instrument unique. Ceux-ci 
apparaissent sous forme de texte et de nombres, 
ce qui permet d'éditer précisément leur 
emplacement, leur longueur et leur valeur.

Les événements de la liste des événements MIDI 
peuvent être copiés et collés, sélectionnés ou 
supprimés. Tout événement MIDI (à l'exception 
des données Sysex) peut être inséré et édité dans la 
liste. Certains types d'événements MIDI peuvent 
être masqués à l'aide du filtre d'affichage.

Ouverture de la liste des 
événements MIDI
Pour ouvrir la liste des événements MIDI, effectuez 
l'une des opérations suivantes :

 Sélectionnez Window > MIDI Event List.

 Effectuez un clic droit sur une piste MIDI ou 
d'instrument dans la fenêtre Mix ou Edit, 
ou dans la liste des pistes.

Sélecteur de piste
Le sélecteur de piste de la liste des événements 
MIDI indique la piste MIDI ou d'instrument 
affichée et permet d'en choisir une autre.

Liste des événements MIDI

Nombre d'événements Menu de la liste des 
événements MIDISélecteur de piste

Cible

Contrairement aux playlists de la fenêtre Edit, 
vous pouvez insérer et afficher les données 
d'aftertouch polyphonique dans la liste des 
événements MIDI.

Les données de mute des pistes MIDI et des 
pistes d'instrument n'apparaissent pas dans 
la liste des événements MIDI.

Appuyez sur les touches Alt+signe égal 
(Windows) ou Option+signe égal (Mac) pour 
ouvrir la liste des événements MIDI.
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Nombre d'événements
Le nombre d'événements MIDI sur la piste 
sélectionnée est affiché en haut de la liste des 
événements MIDI.

Cible
Le bouton Cible de la liste des événements MIDI 
détermine si la liste des événements MIDI suit le 
curseur d'édition et les sélections d'édition de la 
fenêtre Edit et des fenêtres de l'éditeur MIDI. 
Par exemple, lorsque le bouton Cible est activé, 
les événements affichés dans la Liste des 
événements MIDI sont mis à jour pour présenter 
l'événement de la sélection d'édition dans la 
fenêtre Edit. Lorsqu'il est désactivé, la liste des 
événements MIDI affiche les mêmes événements 
quelles que soient les modifications apportées à la 
sélection d'édition dans d'autres fenêtres.

Menu de la liste des événements 
MIDI
Le menu de la Liste des événements MIDI contient 
des commandes et options agissant sur cette 
fenêtre (reportez-vous à la section « Options de la 
liste des événements MIDI » à la page 785). 

Colonnes de la liste des 
événements MIDI
Les informations relatives aux événements de la 
liste des événements MIDI sont affichées dans les 
trois colonnes suivantes :

Colonne Start : affiche l'emplacement de début, 
selon l'échelle temporelle principale, de chaque 
événement. Les emplacements peuvent aussi être 
affichés dans l'échelle temporelle secondaire si 
l'option Show Sub Counter est sélectionnée dans le 
menu contextuel Options.

Le curseur de lecture apparaît sous forme de flèche 
bleue (rouge lorsque les pistes sont activées en 
enregistrement) dans la colonne Start.

Lorsque plusieurs événements se trouvent au 
même emplacement, celui-ci n'est indiqué que 
pour l'événement du haut, les autres étant 
assombris. Vous pouvez éditer ces derniers 
en double-cliquant dessus.

Colonne Event : affiche le type d'événement, 
indiqué par une icône, ainsi que les valeurs qui 
y sont associées.

Colonne Length/Info : affiche le point de fin 
ou la durée des notes en fonction de l'option 
sélectionnée dans le menu déroulant Options. Sont 
également affichés les noms des événements de 
contrôleur continu et les changements de 
programme.

Colonnes de la liste des événements MIDI

 

Curseur de
lecture

Double-
cliquer pour 
éditer

Événements
MIDI
simultanés
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Filtre d'affichage de la liste des 
événements MIDI
Utilisez le filtre d'affichage pour spécifier les 
types d'événements à afficher dans la liste de 
événements MIDI. Ceci vous aide à n'atteindre 
que les événements sur lesquels vous voulez 
intervenir et protège les autres événements MIDI 
des opérations d'édition et de suppression. 
Les événements n'apparaissant pas dans la liste 
des événements MIDI sont néanmoins lus.

Le filtre d'affichage peut être réglé pour afficher 
tous les messages (All), seulement les messages 
spécifiés (Only), ou tous les messages sauf ceux-ci 
(All except).

Exemple : pour filtrer les messages d'aftertouch et 
System Exclusive dans la liste de événements 
MIDI :

1 Dans le menu de la liste des événements MIDI, 
sélectionnez View Filter.

2 Dans la boîte de dialogue MIDI Event List View 
Filter, sélectionnez l'option All Except.

3 Sélectionnez les options pour Mono Aftertouch, 
Polyphonic Aftertouch et System Exclusive. 
Ne cochez pas les autres cases d'option.

L'option All Except exclut les événements 
sélectionnés de l'affichage. Inversement, l'option 
Only permet d'afficher uniquement les événements 
sélectionnés.

4 Cliquez sur OK.

Lorsque vous insérez un type d'événement qui 
a été filtré à partir de la liste des événements 
MIDI, il ne peut plus être filtré.

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+F (Windows) 
ou Commande+F (Mac) pour ouvrir la boîte 
de dialogue MIDI Event List View Filter.

Boîte de dialogue MIDI Event List View Filter
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Navigation dans la liste des 
événements MIDI
Vous pouvez utiliser les touches fléchées et la 
touche Tab pour naviguer dans la liste des 
événements MIDI. Vous pouvez également 
repérer le point de début de l'édition ou tout 
autre emplacement spécifié.

Pour explorer le contenu de la liste des 
événements MIDI, effectuez l'une des opérations 
suivantes :

• Double-cliquez pour passer en mode édition.

• Appuyez sur la touche de tabulation ou Flèche 
bas pour vous placer sur l'événement suivant 
(après avoir sélectionné ou non le champ 
d'édition).

• Maintenez la touche Option (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous appuyez 
sur la touche de tabulation ou Flèche haut pour 
déplacer le curseur sur l'événement précédent 
(après avoir sélectionné ou non le champ 
d'édition).

• Si vous avez sélectionné un champ d'édition, 
appuyez sur la touche Flèche droite pour vous 
placer sur le champ d'édition situé à droite.

• Appuyez sur la touche Flèche gauche pour vous 
placer sur le champ d'édition situé à gauche.

Pour conserver le dernier événement sélectionné, 
maintenez la touche Maj enfoncée pendant que 
vous vous placez sur l'événement suivant ou 
précédent.

Pour vous placer sur le point de début de l'édition :

 Dans le menu de la liste des événements MIDI, 
sélectionnez Scroll To Edit Selection.

Pour accéder à un emplacement spécifique de la 
liste des événements MIDI :

1 Dans le menu de la liste des événements MIDI, 
sélectionnez Go To.

2 Dans la boîte de dialogue Go To, sélectionnez 
un format dans le menu Time Scale.

3 Si vous utilisez un timecode, vous pouvez 
activer l'option Use Subframes.

4 Saisissez l'emplacement auquel vous souhaitez 
accéder, puis cliquez sur OK.

Les éléments suivants du menu de la liste des 
événements MIDI ont une incidence sur la 
navigation dans la liste des événements MIDI :

• Lorsque l'option Page Scroll During Playback 
est activée, la liste des événements MIDI défile 
en cours de lecture.

• Lorsque l'option Scroll During Edit Selection est 
activée, la liste de événements MIDI défile 
automatiquement dès que la sélection d'édition 
est modifiée dans la fenêtre Edit.

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+G (Windows) 
ou Commande+G (Mac) pour ouvrir la boîte 
de dialogue Go To.

Boîte de dialogue Go To
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Insertion d'événements dans 
la liste des événements MIDI
Vous pouvez insérer des événements en 
sélectionnant un type d'événement dans le menu de 
la liste des événements MIDI. Vous trouverez ci-
après plusieurs exemples d'insertion d'événements 
dans la liste des événements MIDI.

Pour insérer une note dans la liste des 
événements MIDI :

1 Dans le menu de la liste des événements MIDI, 
sélectionnez Insert > Note.

2 Entrez l'emplacement, la hauteur, les vélocités 
d'attaque et de release, ainsi que la durée de la 
nouvelle note. Pour naviguer d'un champ 
à l'autre, utilisez les touches Flèche gauche et 
droite. 

Lorsqu'un champ est sélectionné, entrez une valeur 
en effectuant l'une des opérations suivantes :

• Entrez la valeur sur le pavé numérique.

• Cliquez et faites glisser vers le haut ou le bas 
pour faire défiler la valeur.

• Jouez la note sur votre contrôleur MIDI, puis 
appuyez sur la touche Retour (Mac) ou Entrée 
(Windows) du clavier alphanumérique pour 
confirmer la valeur.

3 Effectuez l'une des opérations suivantes :

• Pour insérer la note et rester en mode de saisie 
d'événement, appuyez sur la touche Entrée du 
pavé numérique.

• Pour insérer la note et quitter le mode de saisie 
d'événement, appuyez sur la touche Retour 
(Mac) ou Entrée (Windows) du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'événement, sans 
insérer l'événement de note, appuyez sur la 
touche Échap du clavier alpha numérique.

Pour insérer un événement de contrôleur dans la 
liste des événements MIDI :

1 Dans le menu de la liste des événements MIDI, 
sélectionnez Insert > Controller.

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+N (Windows) 
ou Commande+N (Mac) pour insérer une note.

Champs de saisie d'événement pour une note

Hauteur

Vélocité d'attaque

Vélocité de relâchement

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement l'emplacement 
d'un autre événement présent sur la piste en 
cliquant dessus.

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+L (Windows) 
ou Commande+L (Mac) pour insérer un 
événement de contrôleur.
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2 Tapez l'emplacement, le numéro du type de 
contrôleur et la valeur de contrôleur du nouvel 
événement. Le nom du contrôleur est affiché 
dans la colonne Length/Info, à droite de la 
valeur du contrôleur. Pour naviguer d'un champ 
à l'autre, utilisez les touches Flèche gauche 
et droite.

Lorsqu'un champ est sélectionné, entrez une valeur 
en effectuant l'une des opérations suivantes :

• Entrez la valeur sur le pavé numérique.

• Appuyez sur la touche Flèche haut ou Flèche bas 
pour faire défiler la valeur.

• Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous vous 
déplacez vers le haut ou le bas pour faire défiler 
la valeur.

• Jouez l'événement de contrôleur sur votre 
contrôleur MIDI et appuyez sur la touche Retour 
(Mac) ou Entrée (Windows) du clavier 
alphanumérique pour confirmer la valeur.

3 Effectuez l'une des opérations suivantes :

• Pour insérer l'événement de contrôleur et rester 
en mode de saisie d'événement, appuyez sur la 
touche Entrée du clavier numérique.

• Pour insérer l'événement de contrôleur et quitter 
le mode de saisie d'événement, appuyez sur la 
touche Retour (Mac) ou Entrée (Windows) du 
clavier alphanumérique.

• Pour quitter le mode de saisie d'événement sans 
insérer d'événement de contrôleur, appuyez sur 
la touche Échap du clavier alphanumérique.

Pour insérer un changement de programme dans 
la liste des événements MIDI :

1 Dans le menu de la liste des événements MIDI, 
sélectionnez Insert > Program Change.

2 Entrez l'emplacement du nouvel événement.

3 Entrez un numéro de changement de programme 
et une valeur de sélection de banque (le cas 
échéant). Le nom du changement de programme 
apparaît dans la colonne Length/Info.

Vous pouvez cliquer dans la colonne Length/Info 
pour ouvrir la fenêtre Program Change (pour plus 
de détails, reportez-vous à la section « Sélection de 
patch (changements de programme et de banque) » 
à la page 715). 

Champs de saisie d'événement pour un événement 
de contrôleur

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement l'emplacement 
d'un autre événement présent sur la piste en 
cliquant dessus.

Numéro du contrôleur Nom du contrôleur

Valeur du contrôleur

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+P (Windows) 
ou Commande +P (Mac) pour insérer un 
changement de programme.

Champs de saisie d'événement pour un changement 
de programme

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement présent 
sur la piste en cliquant dessus.

Numéro du programme Nom du programme

Valeur du contrôleur 0

Valeur du contrôleur 32
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4 Effectuez l'une des opérations suivantes :

• Pour insérer le changement de programme et 
rester en mode de saisie d'événement, appuyez 
sur la touche Entrée du pavé numérique.

• Pour insérer le changement de programme et 
quitter le mode de saisie d'événement, appuyez 
sur la touche Retour (Mac) ou Commande 
(Windows) du clavier alphanumérique.

• Pour quitter le mode de saisie d'événement sans 
insérer de changement de programme, appuyez 
sur la touche Échap du clavier alphanumérique.

Insertion d'un autre événement
Après avoir inséré un événement, vous pouvez 
facilement en insérer un autre du même type. 
Le type d'événement à insérer est indiqué en bas du 
menu Insert.

Exemple : Pour insérer une note après en avoir 
inséré une première, effectuez l'une des 
opérations suivantes :

 Dans le menu de la liste des événements MIDI, 
sélectionnez Insert > Another Note.

Édition d'événements dans la 
liste des événements MIDI
Les événements de la liste des événements MIDI 
peuvent être édités, sélectionnés, supprimés, 
copiés et collés.

Pour éditer un événement dans la liste des 
événements MIDI :

1 Effectuez l'une des opérations suivantes :

• Double-cliquez sur le champ de l'événement 
à éditer.

• Appuyez sur Commande+Entrée (Mac) ou 
Ctrl+Entrée (Windows) pour éditer un 
événement sélectionné.

2 Pour entrer une nouvelle valeur, effectuez l'une 
des opérations suivantes :

• Entrez la nouvelle valeur sur le pavé numérique.

• Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous appuyez 
sur la touche Flèche haut ou Flèche bas pour 
faire défiler l'affichage jusqu'à la nouvelle valeur 
désirée.

• Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée tout en vous déplaçant vers 
le haut ou le bas pour faire défiler l'affichage 
jusqu'à la nouvelle valeur désirée.

• Jouez la nouvelle note ou valeur de contrôleur 
sur votre contrôleur MIDI, puis appuyez sur la 
touche Retour (Mac) ou Entrée (Windows) du 
clavier alphanumérique pour valider la valeur.

3 Effectuez l'une des opérations suivantes :

• Pour entrer la nouvelle valeur d'événement et 
vous déplacer vers un autre champ ou un autre 
événement, utilisez les touches fléchées.

• Pour entrer la nouvelle valeur et rester en mode 
d'édition, appuyez sur la touche Entrée du pavé 
numérique.

Avec la liste des événements MIDI active au 
premier plan, appuyez sur Ctrl+M 
(Windows) ou Commande+M (Mac) pour 
insérer une note.

Lorsque l'option Insert At Playback 
Location est activée (reportez-vous à la 
section « Options de la liste des événements 
MIDI » à la page 785), vous pouvez utiliser 
les raccourcis clavier pour insérer à la 
volée un « autre » événement de même 
nature.
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• Pour entrer la nouvelle valeur et quitter le mode 
d'édition, appuyez sur la touche Retour (Mac) ou 
Entrée (Windows) du clavier alphanumérique.

• Pour quitter le mode de saisie d'édition sans 
valider la nouvelle valeur, appuyez sur la touche 
Échap du clavier alphanumérique.

Sélection d'événements dans la 
liste des événements MIDI

Pour sélectionner une plage d'événements dans la 
liste des événements MIDI, effectuez l'une des 
opérations suivantes :

 Cliquez sur l'événement au début de la sélection 
et faites glisser le curseur jusqu'à l'événement 
de fin.

 Tout en appuyant sur Maj, cliquez sur 
l'événement au début de la sélection puis sur 
l'événement de fin.

Pour sélectionner des événements non contigus 
dans la liste des événements MIDI :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous cliquez 
sur chaque événement.

Pour désélectionner un événement MIDI de la 
liste :

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous cliquez 
sur l'événement sélectionné.

Suppression d'événements dans 
la liste des événements MIDI

Pour supprimer un événement de la liste des 
événements MIDI :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous cliquez 
sur l'événement à supprimer.

Pour supprimer une sélection d'événements de la 
liste des événements MIDI :

1 Sélectionnez les événements que vous voulez 
supprimer en vous déplaçant dans la colonne 
Start ou en cliquant sur chaque événement tout 
en appuyant sur Maj.

2 Pour afficher uniquement les événements que 
vous souhaitez supprimer, utilisez le filtrage 
d'affichage (reportez-vous à la section « Filtre 
d'affichage de la liste des événements MIDI » à 
la page 779). Les événements qui ne sont pas 
affichés ne peuvent être supprimés.

3 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Clear pour supprimer tous 
les événements sélectionnés.

• Appuyez sur la touche Supprimer (Mac) ou 
Retour arrière (Windows) du clavier 
alphanumérique.

Les notes sélectionnées dans la liste des 
événements MIDI peuvent être modifiées par 
les commandes de la fenêtre Event 
Operations (reportez-vous au Chapitre 41, 
« Opérations d'événement »).
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Copier/coller d'événements 
dans la liste des événements 
MIDI

Pour copier et coller dans la liste des événements 
MIDI :

1 Sélectionnez les événements à copier dans la 
liste des événements MIDI.

2 Sélectionnez Edit > Copy.

3 Effectuez l'une des opérations suivantes :

• Pour coller les données à l'emplacement d'un 
événement, cliquez dessus dans la liste des 
événements MIDI.

• Pour coller les données à un emplacement, 
sélectionnez Go To dans le menu Options de la 
liste des événements MIDI, entrez 
l'emplacement auquel vous voulez effectuer le 
collage et cliquez sur OK.

4 Sélectionnez Edit > Paste. Les événements du 
presse-papiers sont collés et remplacent les 
événements existants.

Options de la liste des 
événements MIDI
Le menu de la liste des événements MIDI propose 
les options suivantes :

Show Sub Counter : affiche la durée des 
événements dans l'échelle temporelle secondaire.

Go To : ouvre la boîte de dialogue Go To, dans 
laquelle vous pouvez préciser un emplacement, 
exprimé dans n'importe quelle échelle temporelle, 
sur lequel le point d'insertion de l'édition se déplace.

Scroll To Edit Selection : fait défiler la liste des 
événements MIDI sur le point de début d'édition 
ou le point d'insertion d'édition.

Page Scroll During Playback : fait défiler la liste 
des événements MIDI lors de la lecture.

Show Note Length : affiche la durée au lieu des 
heures de fin des notes dans la colonne Length/Info 
de la liste des événements MIDI.

Show Note End Time : affiche les heures de fin 
des notes au lieu de la durée dans la colonne 
Length/Info de la liste des événements MIDI.

Insert : ouvre un sous-menu d'options permettant 
d'insérer tout type d'événement MIDI.

Insert At Edit Location : insère les événements par 
défaut à l'emplacement du point de début d'édition 
ou du point d'insertion d'édition.

Insert At Playback Location : permet d'insérer des 
événements dans la liste des événements MIDI en 
temps réel, tout en écoutant la session. 

Insert At Playback Location With Grid : aligne 
l'emplacement des événements insérés en temps 
réel sur la grille.

View Filter : ouvre la boîte de dialogue View Filter, 
dans laquelle vous pouvez spécifier les événements 
à afficher dans la liste des événements MIDI 
(reportez-vous à la section « Filtre d'affichage de la 
liste des événements MIDI » à la page 779).

Sélection dans la liste des événements MIDI

Pour coller des événements sans en écraser 
d'autres, utilisez la commande Merge Paste 
Special.
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Partie VII: Arrangement
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Chapitre 35 : Temps, tempo, métrique, 
tonalité et accords

Dans Pro Tools, l'édition et l'arrangement des 
pistes sont généralement effectués par rapport 
à une timeline fixe. 

Les clips et les événements peuvent être ancrés à des 
points en temps absolu ou relatif, tel que mesuré sur 
la timeline de la session. La timeline inclut deux 
types de règles pour mesurer le temps : les règles de 
base de temps et les règles de chef d'orchestre.

Les règles de base de temps peuvent mesurer le temps 
de deux façons : valeurs basées sur les échantillons 
(temps absolu), ou sur des références de tempo 
(temps relatif). La règle Minutes:Seconds, par 
exemple, mesure le temps absolu, tandis que la règle 
Bars|Beats mesure le temps relatif.

Le temps relatif de la règle Bars|Beats est déterminé 
en partie par le tempo et la métrique. Les règles de 
tempo (Tempo), de métrique (Meter) et d'armure 
(Key Signature) sont associées aux pistes de chef 
d'orchestre. Les événements de métrique et de tempo 
ont une incidence sur la mise en place rythmique des 
pistes basées sur des références de tempo et 
fournissent également la table de métriques et de 
tempos de la grille Bar:Beat et du métronome. Vous 
pouvez éditer les événements de tempo sur la règle 
de tempo ou dans l'éditeur de tempo. 

Les changements de tonalité peuvent se répercuter 
sur les notes MIDI lors de l'application d'une 
transposition. Vous pouvez modifier la tonalité et 
les changements de tonalité sur la règle d'armure 
(Key Signature).

Règles de base de temps et 
règles de chef d'orchestre

Règles de base de temps
Vous pouvez afficher les règles de base de temps 
suivantes en haut de la fenêtre Edit et des fenêtres 
de l'éditeur MIDI :

Bars|Beats : affiche l'échelle temporelle en 
mesures et temps. Utilisez cette échelle si vous 
travaillez avec des éléments musicaux devant être 
alignés sur des mesures et des temps. L'échelle 
temporelle Bars|Beats est relative. Elle est affectée 
par la table de tempos et de mesures de la session.

Pro Tools fournit également une règle de 
marqueurs pour les emplacements 
mémoire (reportez-vous au Chapitre 36, 
« Emplacements mémoire »).

Affichage de toutes les règles 
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Minutes:Seconds : affiche l'échelle temporelle en 
minutes et secondes. À mesure que vous zoomez 
vers l'avant, l'échelle temporelle est graduée en 
dixièmes, puis en centièmes et en millièmes de 
seconde. L'échelle temporelle Minutes:Seconds 
est absolue.

Timecode : affiche l'échelle temporelle en images 
SMPTE. La cadence d'images et l'heure de début 
de la session sont définies dans la fenêtre Session 
Setup. L'échelle temporelle Timecode est absolue 
et basée sur la cadence d'images.

Pro Tools prend en charge les cadences d'images 
suivantes :

• 23.976 i/s

• 24 i/s

• 25 i/s

• 29.97 i/s

• 29.97 i/s Drop

• 30 i/s

• 30 i/s Drop

Règle de timecode secondaire : une règle de 
timecode secondaire, intitulée Time Code 2, 
permet de référencer les cadences d'images vidéo 
de la timeline qui diffèrent de la fréquence de 
timecode de la session. Il est toutefois impossible 
d'effectuer des placements sur la règle Timecode 2 

qui, par ailleurs, ne peut pas être définie en tant 
qu'échelle temporelle principale. La règle de 
timecode secondaire peut être définie de façon 
à afficher toutes les cadences d'images prises en 
charge par Pro Tools. La règle Timecode 2 permet 
également d'afficher les cadences d'images 
supplémentaires suivantes :

• 50 i/s

• 59.94 i/s

• 59.94 i/s Drop

• 60 i/s

• 60 i/s Drop

Feet+Frames : affiche l'échelle temporelle en pieds 
et images afin de constituer une référence pour les 
projets audio destinés au cinéma. L'affichage horaire 
Feet+Frames est basé sur le format de film 35 mm. 
L'échelle temporelle Feet+Frames est absolue et basée 
sur la cadence d'images.

Samples : affiche l'échelle temporelle en 
échantillons. Ce format est très pratique pour 
l'édition d'échantillons avec une haute précision. 
L'échelle temporelle Samples est absolue et basée 
sur la cadence d'images.

Outre le fait qu'elles référencent temporellement 
les données des pistes, les règles de base de temps 
servent également à définir les sélections d'édition 
du contenu des pistes et les sélections de timeline 
des plages d'enregistrement et de lecture.

Pour que vos pistes s'alignent correctement 
sur les mesures et les temps de votre session, 
enregistrez avec un métronome (reportez-
vous à la section « Enregistrement avec un 
clic » à la page 436). Toutefois, dans 
Pro Tools, les données enregistrées sans 
métronome peuvent être alignées plus tard 
sur la grille de mesures/temps à l'aide de la 
commande Identify Beat (reportez-vous à la 
section « Commande Identify Beat » à la 
page 817) ou de Beat Detective (reportez-
vous au Chapitre 30, « Beat Detective »).

Faites glisser le sélecteur sur une règle de 
base de temps pour sélectionner des contenus 
sur toutes les pistes affichées dans la fenêtre 
Edit ou l'éditeur MIDI. Pour inclure les pistes 
de chef d'orchestre dans la sélection, faites 
glisser ces pistes en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée.
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Règles de chef d'orchestre
Vous pouvez afficher les règles de chef d'orchestre 
suivantes :

• Markers

• Tempo (et éditeur de tempo)

• Meter

• Keys (et armure)

• Chords

Les règles Meter et Tempo indiquent les 
modifications apportées aux données de tempo et 
de métrique au cours de la session. La règle Key 
Signature indique les changements de tonalité. 
La règle Chord Symbols affiche les marqueurs 
d'accord. La règle Markers affiche des marqueurs 
aux emplacements importants de la piste.

Affichage des règles

Pour afficher toutes les règles :

 Sélectionnez View > Rulers > All.

Pour supprimer une règle de l'affichage, effectuez 
l'une des opérations suivantes :

 Cliquez sur le nom de la règle en appuyant sur 
Option (à gauche de la règle).

 Sélectionnez View > Rulers et désactivez une 
option de règle.

Pour afficher uniquement l'échelle temporelle 
principale sur la règle de base de temps :

 Sélectionnez View > Rulers > None (reportez-
vous à la section « Échelle temporelle 
principale » à la page 792.)

Pour ajouter une règle spécifique, telle que la règle 
Markers :

 Sélectionnez View > Rulers > Marker.

Pour modifier l'ordre dans lequel les règles sont 
affichées :

 Faites glisser le nom d'une règle vers le haut ou 
le bas jusqu'à un nouvel emplacement.

Pour copier la sélection de plage d'une règle de 
chef d'orchestre afin de créer une sélection 
d'édition sur la piste du haut de la fenêtre Edit (ou 
dans le volet Notes des fenêtres de l'éditeur MIDI) :

 Appuyez sur Ctrl+Point-virgule (;) (Mac) ou 
Démarrer+Point-virgule (;) (Windows)

Sélecteur de vue des règles
Vous pouvez également configurer les règles de 
base de temps et les règles de chef d'orchestre 
à l'aide du sélecteur de vue des règles.

Pour plus d'informations sur les marqueurs 
d'emplacement mémoire, reportez-vous au 
Chapitre 36, « Emplacements mémoire ».

Sélecteur de vue des règles dans la fenêtre Edit
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Échelle temporelle principale
Vous pouvez afficher simultanément toutes les règles 
de base de temps dans les fenêtres Edit et de l'éditeur 
MIDI, mais une seule d'entre elles représente 
l'échelle temporelle principale. Cette règle est 
également appelée règle de base de temps principale. 

L'échelle temporelle principale détermine le 
format temporel utilisé pour :

• Le compteur principal de la fenêtre de transport ;

• Le compteur principal en haut des fenêtres Edit 
et de l'éditeur MIDI ;

• Les valeurs de début, de fin et de durée ;

• Les valeurs de pré et post-roll ;

• Les valeurs de grille et d'incrément.

L'échelle temporelle principale peut être définie 
dans les formats suivants :

• Bars|Beats 

• Minutes:Secondes

• Timecode

• Feet+Frames

• Samples

Définition de l'échelle 
temporelle principale
Pour définir l'échelle temporelle principale, 
effectuez l'une des opérations suivantes :

 Cliquez sur le sélecteur de compteur principal 
(en haut de la fenêtre Edit ou de la fenêtre de 
transport lorsque l'affichage des compteurs est 
activé) et sélectionnez une échelle temporelle.

 Si une règle de base de temps est déjà affichée, 
cliquez sur son nom. Il s'affiche alors en 
surbrillance.

Navigation à l'aide des 
compteurs principaux
Les compteurs principaux (en haut de la fenêtre 
Edit et dans la fenêtre de transport) facilitent 
l'accès à un emplacement temporel spécifique. 

Pour naviguer à l'aide d'un compteur principal :

1 Cliquez sur un compteur principal.

2 Entrez une position.

3 Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac) pour accéder automatiquement 
à la nouvelle position.

Sélecteur de compteur principal (dans la fenêtre Edit)

Lorsque vous définissez l'échelle temporelle 
principale sur la base de temps du compteur 
secondaire, les deux échelles temporelles sont 
modifiées. En d'autres termes, l'échelle 
temporelle secondaire prend l'ancienne valeur de 
la référence temporelle de l'échelle principale.

Basculement de l'échelle temporelle principale de 
Bars|Beats à Min:Sec

L'indicateur du compteur principal de la 
fenêtre de transport ne s'affiche que lorsque 
les compteurs sont activés sur la fenêtre de 
transport.
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Compteur secondaire
Sous chaque compteur principal se trouve un 
compteur secondaire pouvant être affiché ou 
masqué. Le compteur secondaire fournit une 
référence temporelle supplémentaire.

Pour afficher ou masquer le compteur secondaire 
dans la fenêtre Edit :

 Depuis le sélecteur de compteur principal, 
activez (ou désactivez) l'option Show Sub 

Counter. 

Pour afficher le compteur secondaire dans la 
fenêtre de transport :

 Dans le menu de la fenêtre de transport, 
assurez-vous que les options Counters et 
Expanded Transport sont activées.

Pour définir l'échelle temporelle du compteur 
secondaire :

 Cliquez sur le sélecteur de compteur secondaire 
et sélectionnez une échelle temporelle.

Timing basé sur des 
références de tempo
Pro Tools est un programme fonctionnant 
à l'échantillon près, doté d'une résolution MIDI 
interne de 960 000 ticks par noire (ppn). Toutefois, 
lorsque l'échelle temporelle est définie sur 
Bars|Beats, la résolution affichée dans Pro Tools 
est de 960 ppn et la règle de base de temps est 
basée sur des références de tempo. 

Lorsque vous travaillez en Bars|Beats, vous devez 
indiquer des références de tempo pour un certain 
nombre d'opérations, en particulier :

• Le placement et le positionnement de clips ;

• La définition des durées des clips ou des notes 
MIDI ;

• La recherche et la définition des plages de 
lecture et d'enregistrement (avec pré/post-roll) ;

• La spécification des paramètres des pages 
Quantize et Change Duration de la fenêtre Event 
Operations ;

• La définition des valeurs de grille et d'incrément.

Sélecteur de compteur secondaire (dans la fenêtre 
Edit)

Avec l'échelle temporelle Bars|Beats, 
Pro Tools se base sur des références de 
tempo (960 ticks par noire). Il est possible 
que l'insertion d'événements à certains 
emplacements entraîne un léger arrondi de 
sa position en échantillons (reportez-vous 
à la section « Arrondi des échantillons et 
opérations d'édition » à la page 796).
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Le tableau ci-dessous répertorie les nombres de 
ticks pour chaque valeur de note :

Bases de temps basées sur 
les échantillons et les 
références de tempo
Dans Pro Tools, vous pouvez définir les bases de 
temps des pistes sur les échantillons ou les 
références de tempo.

Par défaut, les pistes audio de Pro Tools sont 
basées sur les échantillons. Ainsi, si un clip ou un 
événement audio se trouve à une position donnée, 
exprimée en échantillons, il ne bougera pas si le 
tempo de la session est modifié. En revanche, 
l'expression de sa position en mesures et temps est 
modifiée.

Par défaut, les pistes MIDI et d'instrument de 
Pro Tools sont basées sur les références de tempo. 
Ainsi, si un clip ou un événement MIDI se trouve 
à une position donnée, exprimée en mesures et 
temps, il ne bougera pas si le tempo change au cours 
de la session. En revanche, l'expression de sa position 
en échantillons est modifiée.

Pistes audio et MIDI basées sur 
les échantillons
Avec une piste audio basée sur les échantillons, 
tous les clips audio de la piste possèdent un 
emplacement absolu sur la timeline absolue 
(sur la règle de base de temps Samples ou 
Minutes:Seconds, par exemple). La source audio 
ne bouge pas par rapport aux références 
d'échantillon, que le tempo et la métrique soient 
modifiés ou non au cours de la session.

Pour les pistes MIDI et d'instrument basées sur les 
échantillons, tous les événements MIDI de la piste 
possèdent un emplacement absolu sur la timeline 
absolue (sur la règle de base de temps Samples ou 
Minutes:Seconds, par exemple). Les événements 
MIDI ne bougent pas par rapport aux références 
d'échantillon, que le tempo et la métrique soient 
modifiés ou non au cours de la session.

Lorsque l'échelle temporelle principale est 
définie sur Bars|Beats et que vous utilisez des 
changements de tempo, définissez le mode 
Linearity Display sur Linear Tick Display 
(reportez-vous à la section « Modification du 
mode d'affichage linéaire » à la page 810). 
Ainsi, la règle Bars|Beats demeure fixe 
(au niveau de zoom sélectionné) et les règles 
basées sur les échantillons, telles que 
Minutes:Seconds, sont dimensionnées de façon 
à suivre les changements de tempo, tandis que 
les longueurs de mesure demeurent constantes. 

Valeur de 
note

Normale Pointée Triolet

Blanche 1 920 2 880 1 280

Noire 960 1 440 640

Croche 480 720 320

Double 
croche

240 360 160

Triple croche 120 180 80

Quadruple 
croche

60 90 40
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Pistes audio et MIDI basées sur 
les références de tempo
Une piste audio basée sur des références de tempo 
demeure fixe par rapport au temps relatif de la règle 
de base de temps Bars|Beats et se déplace 
relativement à la timeline en échantillons lorsque le 
tempo et la métrique sont modifiés. Cependant, les 
événements MIDI et Elastic Audio et les clips audio 
(non Elastic Audio) basés sur des références de 
tempo répondent différemment aux changements de 
tempo en termes de durée. La durée des événements 
de note MIDI et des clips Elastic Audio change 
lorsque le tempo est modifié, contrairement aux 
clips audio non Elastic Audio. Les changements de 
tempo ont une incidence uniquement sur le point de 
début (ou point de synchronisation) des clips audio 
d'une piste audio basée sur les références de tempo 
(non Elastic Audio).

Vous pouvez décider si une piste doit être basée 
sur les échantillons ou les références de tempo lors 
de sa création, ou modifier la base de temps 
ultérieurement. 

Pistes Elastic Audio basées sur 
les références de tempo
Les pistes Elastic Audio basées sur des références 
de tempo appliquent automatiquement le traitement 
Elastic Audio en temps réel (ou rendu) lorsque le 
tempo est modifié. Pour plus d'informations, 
reportez-vous à la section « Changements de tempo 
et pistes Elastic Audio basées sur les références de 
tempo » à la page 802.

Changement de base de temps
Il est possible de basculer toutes les pistes de 
Pro Tools entre le format basé sur les échantillons 
et le format basé sur les références de tempo.

La hauteur de la piste influe sur l'affichage des 
différentes commandes dans la fenêtre Edit. 
Le sélecteur de base de temps, utilisé pour changer la 
base de temps d'une piste, n'est visible que pour les 
hauteurs de pistes supérieures ou égales à Medium.

Pour appliquer une autre base de temps à une 
piste, procédez comme suit :

 Si la hauteur de la piste est définie sur Medium 
ou une valeur plus élevée, cliquez sur le 
sélecteur de base de temps de la piste et 
sélectionnez la base de temps souhaitée. L'icône 
du sélecteur de base de temps est modifiée afin 
de prendre en compte votre modification.

Pour que toutes les nouvelles pistes soient 
basées par défaut sur les références de tempo, 
activez l'option New Tracks Default to Tick 
Timebase dans les préférences d'édition.

Sélecteur de base de temps (échantillons)

Sélecteur de base de temps (références de tempo)



Guide de référence Pro Tools796

 Si la hauteur de la piste est définie sur Small 
(ou une valeur inférieure), cliquez sur le 
sélecteur de hauteur de piste et sélectionnez la 
base de temps souhaitée dans le sous-menu de 
base de temps de la piste.

Base de temps des playlists 
alternatives
Après avoir modifié la base de temps d'une piste, 
vous pouvez décider d'appliquer cette modification 
uniquement à la piste ou à la playlist active de la 
piste et à l'ensemble des playlists alternatives. 

Pour configurer un changement de base de temps 
s'appliquant à l'ensemble des playlists d'une piste :

 Cliquez sur le sélecteur de base de temps (ou le 
sélecteur de hauteur de piste) et activez l'option 
Selection Changes Alternate Playlists. 

Groupes
Lorsque vous modifiez la base de temps d'une piste 
audio appartenant à un groupe d'édition actif, 
toutes les pistes audio du groupe sont alors 
configurées sur la même base de temps.

Emplacement des clips audio
Sur les pistes audio basées sur une référence de 
tempo, l'emplacement d'un clip audio est 
déterminé par son point de début, sauf si le clip 
comprend un point de synchronisation.

Dans ce cas, le point de synchronisation détermine 
l'emplacement du clip audio sur la grille. 

Emplacement des marqueurs
Lorsque vous créez des marqueurs et des 
emplacements mémoire de sélection, vous pouvez 
leur attribuer une référence absolue (basée sur 
les échantillons) ou relative, en mesures et temps 
(basée sur une référence de tempo). Pour plus 
d'informations, reportez-vous à la section 
« Références Bar|Beat et absolue » à la page 841.

Arrondi des échantillons et 
opérations d'édition
Lorsque les données audio de Pro Tools sont basées 
sur les échantillons, il peut se produire un léger 
arrondi au niveau des échantillons lorsque l'échelle 
temporelle principale est définie sur Bars|Beats. 
Cela est particulièrement évident lorsque vos clips 
audio doivent tomber parfaitement sur le temps 
(cas d'une boucle par exemple) : vous constaterez 
parfois un léger décalage, d'un ou deux ticks. Pour 
éviter ce phénomène, il suffit de prendre quelques 
précautions simples.

Pour garantir un alignement précis des sélections 
sur la grille pour les boucles, la copie, la duplication 
ou la répétition, notez les points suivants : 

 Si vous utilisez le Sélecteur, activez le mode 
Grid et sélectionnez la valeur de grille appropriée 
(double croche, par exemple).

 Pour une précision optimale, indiquez les points 
de début et de fin de la sélection dans la zone Event 
Edit. 

 Ne sélectionnez pas de contenu avec l'un des outils 
de saisie (ou en double-cliquant avec le Sélecteur). 

Menu déroulant de hauteur de piste
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Marqueur de début de 
morceau
Le marqueur de début de morceau définit le tempo 
initial du contenu basé sur les mesures et temps. 
Les nouvelles sessions s'ouvrent avec un tempo par 
défaut de 120 BPM.

Lorsqu'une session est créée, le marqueur de début 
de morceau n'est associé à aucun événement de 
métrique. Un événement de métrique est ajouté 
automatiquement au début du morceau si vous 
insérez un événement de métrique à un autre 
emplacement de la règle de métrique.

Le marqueur de début de morceau peut être 
déplacé, mais pas supprimé.

Pour déplacer le marqueur de début de morceau 
en le faisant glisser :

 Sur la règle de tempo, faites glisser le marqueur 
vers la gauche ou la droite à l'aide de l'outil 
d'édition de votre choix.

Si le mode d'édition est défini sur Grid, le 
marqueur de début de morceau se déplace par 
incréments de la valeur de grille actuelle. 

Pour modifier le tempo initial du marqueur de 
début de morceau :

1 Sur la règle de tempo, double-cliquez sur le 
marqueur de début de morceau.

2 Dans la boîte de dialogue Change Tempo, 
entrez une nouvelle valeur en BPM.

3 Cliquez sur OK.

Tempo
La règle de tempo permet de modifier les événements 
de tempo, un par un ou selon des courbes de tempo. 
Vous pouvez modifier le tempo visuellement dans 
l'éditeur ou apporter des modifications précises dans 
la fenêtre Tempo Operations. 

Pour afficher la règle de tempo :

 Sélectionnez View > Rulers > Tempo.

Marqueur de début de morceau

L'emplacement du marqueur de début de 
morceau peut également être modifié dans la 
fenêtre Time Operations (reportez-vous à la 
section « Move Song Start » à la page 829).

Déplacement du marqueur de début de morceau

Pour déplacer uniquement le marqueur de 
début de morceau, sans déplacer aucune 
donnée basée sur des références de tempo, 
maintenez les touches Démarrer+Maj 
(Windows) ou Ctrl+Maj (Mac) enfoncées 
pendant que vous le faites glisser. Au cours de 
cette opération, le déplacement est limité à des 
incréments de mesure uniquement. 

Pour définir le tempo par défaut d'une 
session, reportez-vous à la section 
« Configuration de la métrique et du tempo 
de la session » à la page 439.

Il est possible d'utiliser Beat Detective pour 
générer des marqueurs Bar|Beat (table de 
tempos). Pour plus d'informations, reportez-vous 
à la section « Génération de marqueurs 
Bars|Beats avec Beat Detective » à la page 676.
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Événements de tempo
Des événements de tempo peuvent être assignés au 
marqueur de début de morceau pour remplacer le 
tempo par défaut (120 BPM) et permettent de 
modifier le tempo à l'emplacement de session où 
ils sont insérés. 

Tempo actuel

Lorsque des événements de tempo surviennent en 
cours de lecture, le tempo actuel de la session est 
mis à jour dans la fenêtre de transport.

Insertion d'événements de tempo

Pour insérer un événement de tempo :

1 Cliquez sur la règle de tempo à l'endroit où vous 
voulez insérer l'événement de tempo.

2 Cliquez sur le bouton Add Tempo Change situé 
à gauche de la règle de tempo.

3 Dans la fenêtre Tempo Change, entrez 
l'emplacement et la valeur en BPM du 
changement du tempo. 

4 Pour placer l'événement de tempo inséré 
précisément sur le premier temps de la mesure la 
plus proche, activez l'option Snap To Bar. 

5 Pour baser la valeur BPM sur une autre valeur 
que la noire par défaut, sélectionnez une valeur 
de note différente.

6 Cliquez sur OK. Le nouvel événement de tempo 
est inséré et apparaît sur la règle de tempo.

Lorsque vous utilisez les changements de 
tempo et des données basées sur les 
références de tempo, définissez le mode 
d'affichage linéaire sur Linear Tick Display. 

En mode de tempo manuel, la règle de tempo 
est ignorée et la session est lue au tempo 
défini dans la fenêtre de transport (reportez-
vous à la section « Utilisation du mode de 
tempo manuel » à la page 440).

Tempo actuel affiché dans la fenêtre de transport

Bouton ajout d'un changement de tempo

Boîte de dialogue Tempo Change

Événement de tempo inséré
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À chaque événement de tempo est associé un petit 
triangle vert qui indique son emplacement. Vous 
pouvez faire glisser ce triangle pour déplacer 
l'événement de tempo ou double-cliquer dessus 
pour l'éditer.

Édition et déplacement des 
événements de tempo
Les événements de tempo existants peuvent être 
déplacés, édités, supprimés, copiés et collés.

Pour déplacer un événement de tempo en le 
faisant glisser :

 Sur la règle de tempo, faites glisser le triangle 
de l'événement de tempo vers la gauche ou la 
droite.

En mode d'édition Grid, l'événement déplacé 
s'aligne sur la valeur de grille actuelle. 

Pour éditer un événement de tempo :

1 Sur la règle de tempo, double-cliquez sur 
l'événement de tempo.

2 Dans la boîte de dialogue Tempo Change, 
entrez un nouvel emplacement (Location) ou 
une nouvelle valeur en BPM pour l'événement 
de tempo.

3 Cliquez sur OK.

Pour supprimer un événement de tempo :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur l'événement de 
tempo (le curseur prend la forme d'une Main 
avec le symbole « - »).

Pour copier et coller plusieurs événements de 
tempo :

1 À l'aide du Sélecteur, cliquez et faites glisser sur 
la règle de tempo pour sélectionner la plage de 
mesures qui contient les événements de tempo.

2 Sélectionnez Edit > Copy.

3 Cliquez sur la règle de tempo à l'endroit où vous 
souhaitez coller les événements de tempo.

4 Sélectionnez Edit > Paste. Le contenu du 
presse-papiers est collé à partir du point 
d'insertion et remplace les événements de 
tempo existants.

Pour étendre une sélection d'édition créée sur une 
piste à la règle de tempo :

1 Créez une sélection de timeline à l'aide du 
Sélecteur ou de l'outil de saisie.

2 Cliquez sur la règle de tempo tout en appuyant 
sur Maj. 

Pour sélectionner tous les événements de tempo :

 Double-cliquez avec le Sélecteur sur la règle de 
tempo.

Déplacement d'un événement de tempo

Événements de tempo sélectionnés

Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée, cliquez et faites 
glisser votre souris pour créer une sélection 
sur toutes les pistes de chef d'orchestre.
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Pour supprimer une plage d'événements de tempo 
sélectionnée :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Avec le Sélecteur, cliquez et faites glisser sur la 
règle de tempo pour sélectionner les 
événements de tempo à supprimer.

3 Sélectionnez Edit > Clear pour supprimer les 
événements de tempo sélectionnés.

Tap Tempo
Vous pouvez définir manuellement le tempo d'une 
session Pro Tools à l'aide des touches de votre 
clavier. Vous pouvez également utiliser un clavier 
MIDI connecté pour battre le tempo.

Pour définir le tempo manuellement à l'aide d'un 
clavier d'ordinateur :

1 Pour afficher les commandes MIDI dans la 
fenêtre de transport, sélectionnez View > 

Transport > MIDI Controls.

2 Dans la fenêtre de transport, cliquez sur le 
bouton d'activation de la règle de tempo 
(chef d'orchestre) pour qu'il ne soit pas en 
surbrillance. Pro Tools passe en mode de tempo 
manuel. Dans ce mode, tous les événements de 
tempo de la règle de tempo sont ignorés.

3 Cliquez dans le champ du tempo pour le mettre 
en surbrillance et appuyez sur la touche T de 
votre clavier de façon répétée au rythme du 
nouveau tempo.

Pour définir le tempo manuel en battant la mesure 
sur un clavier MIDI externe :

1 Pour afficher les commandes MIDI dans la 
fenêtre de transport, sélectionnez View > 

Transport > MIDI Controls.

2 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet MIDI.

3 Assurez-vous que l'option Use MIDI to Tap 

Tempo est sélectionnée.

4 Dans la fenêtre de transport, cliquez sur le 
bouton d'activation de la règle de tempo 
(chef d'orchestre) pour qu'il ne soit pas en 
surbrillance. Pro Tools passe en mode de tempo 
manuel. Dans ce mode, tous les événements de 
tempo de la règle de tempo sont ignorés.

5 Cliquez dans le champ du tempo pour le mettre 
en surbrillance et battez le tempo en jouant une 
note de façon répétée sur le clavier de votre 
contrôleur MIDI.

Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou moins). 
La valeur BPM calculée apparaît dans le champ 
Tempo de la fenêtre de transport.

Bouton de la règle de tempo (non activé), en mode de 
tempo manuel

Pour appliquer le nouveau tempo 
à l'intégralité de la session, il suffit de 
modifier le tempo par défaut du marqueur de 
début de morceau. Reportez-vous à la section 
« Marqueur de début de morceau » à la 
page 797.
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Décalage de tempo et 
d'automation
(Clips basés sur les échantillons sur des 
pistes basées sur les références de tempo 
uniquement)

Lorsqu'une piste est basée sur les échantillons, 
la playlist d'automation de la piste n'est pas 
concernée par les modifications apportées au tempo. 
Dès lors, l'automation s'aligne systématiquement 
sur les données audio de la piste, à l'échantillon près.

En revanche, lorsqu'une piste est basée sur les 
références de tempo, les points d'automation sont 
modifiés pour s'adapter aux changements de tempo. 

Cela est généralement souhaitable lorsque des 
changements de tempo sont effectués sur des pistes 
MIDI basées sur des références de tempo ou sur des 
pistes Elastic Audio. Vous pouvez même définir 
toutes les pistes de votre session contenant des 
données d'automation sur une règle basée sur des 
références de tempo. Ainsi, tout changement de 
tempo affecte aussi bien l'automation de la piste 
basée sur des références de tempo que le contenu de 
la piste. Toutefois, lors de l'utilisation de données 
audio basées sur les échantillons (non Elastic 
Audio) sur des pistes basées sur les références de 
tempo, les changements de tempo affectent 
l'emplacement de début des clips audio, mais pas 
leur durée.

Lorsque vous changez le tempo, la durée de 
chaque clip audio d'une piste basée sur les 
échantillons ne subit aucune modification. Aussi, 
les données d'automation existantes des pistes 
basées sur les références de tempo ne sont plus 
synchronisées avec l'audio. 

Changement de tempo appliqué à un long clip audio 
basé sur les échantillons, sur une piste basée sur 
les références de tempo, avec un décalage de 
l'automation

Tempo à 146 BPM

Tempo à 120 BPM
Pas de traitement Elastic Audio

Références de tempo
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Atténuation du décalage de l'automation

En général, plus les clips audio basés sur les 
échantillons sont longs, plus le décalage de 
l'automation est marqué. En créant de nombreux 
clips de petite taille, il est possible de minimiser les 
effets du décalage de l'automation, car le point de 
début de chaque clip successif suit le changement 
de tempo. Lorsque le tempo est réduit, l'automation 
s'étire. Lorsque le tempo augmente, l'automation 
se contracte.

Changements de tempo et 
pistes Elastic Audio basées sur 
les références de tempo
Les clips situés sur des pistes Elastic Audio basées 
sur des références de tempo appliquent la 
compression/expansion temporelle (TCE) en 
prenant en compte les changements de tempo. 
Pour les changements de tempo simples, les clips 
situés sur des pistes Elastic Audio basées sur des 
références de tempo s'adaptent automatiquement 
pour suivre le nouveau tempo. Les changements de 
tempo n'ont pas d'incidence sur les pistes Elastic 
Audio basées sur les échantillons. 

Sur la figure suivante, le premier clip de deux 
mesures est au tempo d'origine de 120 BPM. Le 
second clip de deux mesures s'est adapté au 
changement de tempo de 100 BPM. Étant donné 
qu'une déformation a été appliquée au second clip 
afin de maintenir les deux mesures à un tempo plus 
lent, l'indicateur de déformation du clip apparaît 
dans l'angle supérieur droit.

Changement de tempo appliqué à de petits clips 
basés sur les échantillons, sur une piste basée sur les 
références de tempo, avec un décalage d'automation 
minime

Pour diviser un clip audio en clips plus petits, 
utilisez Beat Detective. Pour plus 
d'informations, reportez-vous au Chapitre 30, 
« Beat Detective ».

Tempo à 110 BPM

Pas de traitement Elastic Audio

Références de tempo

Tempo à 92 BPM

Vous pouvez également séparer les clips au 
niveau des transitoires ou en fonction de la 
résolution actuelle de la grille. Pour plus 
d'informations, reportez-vous à la section 
« Commandes de séparation » à la page 600.

Audio conformé au tempo avec un changement de 
tempo linéaire
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Pour les courbes de tempo (accelerando ou 
ritardando, par exemple), des marqueurs de 
déformation d'événement de tempo sont 
automatiquement créés pour chaque événement de 
tempo et le clip est conformé en conséquence. 
La figure suivante présente un clip en vue Warp. 
Notez la conformation de l'audio à la courbe de 
tempo.

Les marqueurs de déformation générés par les 
événements de tempo ne peuvent pas être édités. 
Ils indiquent simplement les emplacements des 
déformations de l'audio afin de rester synchronisé 
avec les changements de tempo.

Conformation au tempo
Pro Tools vous permet de conformer les clips des 
pistes Elastic Audio (basées sur les échantillons ou 
des références de tempo) au tempo de la session. 
Si nécessaire, la commande Conform to Tempo 
analyse le clip sélectionné afin de déterminer son 
tempo et sa durée (en mesures et en temps), 
puis applique le traitement Elastic Audio afin de 
conformer le clip au tempo de la session.

Pour conformer un clip au tempo de la session :

1 Sélectionnez le clip que vous souhaitez 
conformer au tempo de la session.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Conform to Tempo.

• Effectuez un clic droit sur le clip à conformer au 
tempo, puis sélectionnez Conform to Tempo.

Pro Tools analyse les événements Elastic Audio et 
le tempo du fichier entier du clip. Si un tempo est 
détecté et si une durée en temps et mesures est 
déterminée, le clip est automatiquement conformé 
au tempo de la session. Si le tempo et la durée ne 
sont pas détectés (par exemple dans le cas d'un clip 
ne contenant qu'un échantillon de batterie ou d'un 
long clip sans tempo clairement défini), le clip 
n'est pas conformé au tempo de la session. 

Playlists alternatives et tempo
Les playlists alternatives des pistes Elastic Audio 
basées sur des références de tempo sont affectées 
uniquement par les changements de tempo. Elles 
ne sont pas affectées par l'édition de marqueurs de 
déformation ou d'événement dans la playlist 
principale.

Audio conformé au tempo avec une courbe de tempo

Si vous modifiez la base de temps de la piste 
(en passant de références de tempo à des 
échantillons), tous les marqueurs de 
déformation générés par des événements de 
tempo se transforment en marqueurs de 
déformation éditables.

Vous pouvez également utiliser la 
déformation télescopique en vue Warp pour 
conformer manuellement un clip long au 
tempo de la session. Reportez-vous à la 
section « Déformation télescopique » à la 
page 922.

La commande Conform to Tempo ne peut 
être appliquée qu'à des clips, et non à des 
groupes de clips. Pour conformer des 
groupes de clips au tempo, vous devez 
d'abord dissocier le groupe, appliquer la 
commande Conform to Tempo aux clips sous-
jacents, puis les regrouper.
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Éditeur de tempo graphique
L'éditeur de tempo, représenté par une fenêtre 
redimensionnable située sous la règle de tempo 
dans la fenêtre Edit, permet de visualiser et de 
modifier graphiquement les informations.

Affichage de l'éditeur de tempo 
L'éditeur de tempo est une extension de la règle de 
tempo et s'ouvre à partir de la zone des règles de la 
fenêtre Edit. 

Pour afficher l'éditeur de tempo, effectuez l'une 
des opérations suivantes :

 Sélectionnez View > Rulers > Tempo, puis 
View > Rulers > Tempo > Tempo Editor.

 Cliquez sur le triangle Développer/Réduire de 
l'éditeur de tempo

Zoom et défilement dans 
l'éditeur de tempo 

Pour effectuer un zoom avant vertical dans 
l'éditeur de tempo :

 Cliquez sur le bouton de zoom avant (+) de 
l'éditeur de tempo.

Pour effectuer un zoom arrière vertical dans 
l'éditeur de tempo :

 Cliquez sur le bouton de zoom arrière (-) de 
l'éditeur de tempo.

Pour faire défiler verticalement l'éditeur de tempo, 
effectuez l'une des opérations suivantes :

 Cliquez sur la flèche vers le haut pour faire 
défiler vers le haut.

 Cliquez sur la flèche vers le bas pour faire 
défiler vers le bas.

 Faites glisser la barre de défilement vers le haut 
ou le bas.

Édition d'événements de 
tempo dans l'éditeur de 
tempo
Pour éditer les événements de tempo contenus 
dans l'éditeur de tempo, effectuez l'une des 
opérations suivantes :

 Vous pouvez déplacer des événements de tempo 
individuels à l'aide de l'un des outils de saisie afin 
d'ajuster leur emplacement ou leur valeur.

 Vous pouvez développer ou réduire un groupe 
de tempos sélectionné avec l'outil de trim.

 Vous pouvez dessiner de nouveaux événements 
de tempo avec le Crayon pour remplacer des 
événements.

 Vous pouvez copier et coller, déplacer et décaler 
des événements de tempo.

Éditeur de tempo

Triangle Développer/Réduire de l'éditeur de tempo

Résolution du tempo
Densité du tempo

Ajout d'un changement de tempo
Événements de tempo

Boutons de zoom avant/arrière de l'éditeur de tempo
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Dessin d'événements de tempo
Les événements de tempo peuvent être dessinés 
dans l'éditeur de tempo à l'aide du Crayon.

Main libre : permet de dessiner librement en 
faisant glisser la souris. La forme est reproduite par 
une série d'étapes, conformément au paramètre 
Tempo Edit Density. Pour en savoir plus, reportez-
vous à la section « Sélection de la densité d'édition 
du tempo » à la page 806.

Ligne : la forme Ligne du Crayon trace une ligne 
droite lorsque vous cliquez puis relâchez la souris. 
Les valeurs de tempo se transforment en une série 
d'étapes selon les paramètres Tempo Edit Density 
et Resolution.

Parabolique : la forme parabolique dessine la 
meilleure courbe possible afin de s'ajuster à votre 
courbe tracée à main levée. La forme est reproduite 
par une série d'étapes, conformément au paramètre 
Tempo Edit Density.

Courbe en S : la forme Courbe en S du Crayon 
trace la meilleure courbe en S possible afin de 
s'ajuster à votre courbe tracée à main levée. 
La forme est reproduite par une série d'étapes, 
conformément au paramètre Tempo Edit Density.

Sélection de la résolution du 
tempo (vitesse BPM) 
L'éditeur de tempo permet de spécifier une valeur 
de note pour les événements de tempo en 
modifiant la résolution du tempo. La valeur de note 
de chaque temps sélectionnée pour la résolution du 
tempo est généralement basée sur la métrique. Par 
exemple, dans le cas d'une mesure en 4/4, la valeur 
de note est une noire, tandis que pour une mesure 
en 6/8, il s'agit généralement d'une noire pointée.

Pour sélectionner la résolution du tempo (vitesse 
BPM) pour l'édition au Crayon, effectuez l'une des 
opérations suivantes :

 Cliquez sur le sélecteur de résolution de tempo et 
sélectionnez une valeur de note dans le menu 
déroulant. La résolution de tempo des événements 
de tempo créés à l'aide du Crayon est définie sur la 
valeur de note spécifiée pour la vitesse BPM.

 Cliquez sur le sélecteur de résolution de tempo 
et sélectionnez Follow Metronome Click. 
La résolution de tempo pour les événements 
de tempo créés à l'aide du Crayon reflète 
automatiquement les valeurs du clic définies par 
les événements de métrique sur la règle de 
métrique. 

Une courbe de tempo peut inclure des valeurs 
BPM différentes en cas de modification du clic 
dans la plage sélectionnée.

Les autres formes du Crayon (triangle, carré 
et forme aléatoire) ne s'appliquent pas aux 
événements de tempo.

Sélecteur de résolution du tempo et menu déroulant

Avid recommande de choisir l'option Follow 
Metronome Click dans la majorité des cas. 
Il est en effet inutile et complexe de définir des 
événements de métrique différents pour 
chaque événement de tempo.

Courbe de tempo avec différentes valeurs de clic

Clic à la noire Clic à la noire pointée
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Sélection de la densité d'édition 
du tempo
L'éditeur de tempo permet de spécifier la densité 
des événements de tempo créés sur la règle de 
tempo lorsque vous dessinez une courbe de tempo 
à l'aide du Crayon.

Pour sélectionner la densité d'édition du tempo 
pour l'édition au Crayon :

 Cliquez sur le sélecteur de densité d'édition du 
tempo et sélectionnez une valeur temporelle 
dans le menu déroulant. Les événements de 
tempo créés à l'aide du Crayon sont placés sur la 
règle de tempo en fonction du paramètre de 
densité spécifié.

Mode d'ajustement de la courbe
Immédiatement après avoir tracé de nouveaux 
tempos à l'aide du Crayon, une courbe s'affiche en 
bleu correspondant à la nouvelle représentation 
graphique du tempo. Des poignées d'ajustement de 
couleur bleue sur la courbe permettent de régler la 
forme et la taille du graphique.

Les poignées d'ajustement restent actives tant que 
vous n'avez pas sélectionné un nouvel outil ou 
exécuté une autre commande. 

Sélecteur de densité d'édition du tempo et menu 
déroulant

Appuyez sur la touche Démarrer (Windows) ou 
Ctrl (Mac) avant de tracer une ligne à l'aide du 
Crayon pour appliquer les événements de 
tempo déjà créés à cette ligne au lieu d'en créer 
de nouveaux. 

Poignées d'ajustement de la courbe de tempo

Tous les événements de tempo au-dessous de la 
courbe sont affectés par le déplacement des 
poignées d'ajustement de la courbe de tempo. 
Pour ajuster la forme de la courbe sans modifier 
immédiatement les données de piste, appuyez sur 
Démarrer (Windows) ou Ctrl (Mac) pendant 
l'ajustement. Les événements de tempo sont 
modifiés pour correspondre à la nouvelle courbe 
lorsque vous relâchez le bouton de la souris.
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Création de nouveaux 
paramètres de tempo à l'aide 
des outils de saisie
Les outils de saisie permettent de créer des 
paramètres de tempo en faisant glisser les 
événements de tempo dans l'éditeur de tempo.

Pour modifier le tempo d'un événement de tempo :

 Utilisez la Main pour faire glisser un événement 
de tempo vers le haut ou le bas.

Pour ajuster la position du changement de tempo :

 À l'aide de la Main, faites glisser un événement 
de tempo vers la gauche ou la droite.

Pour supprimer un événement de tempo :

 À l'aide de la Main, cliquez sur l'événement de 
tempo tout en appuyant sur la touche Alt 
(Windows) ou Option (Mac).

Sélection des événements de 
tempo
Vous pouvez facilement sélectionner un 
événement de tempo ou la totalité de la courbe de 
tempo dans l'éditeur de tempo.

Pour sélectionner un événement de tempo dans 
l'éditeur de tempo :

 À l'aide du Sélecteur ou de la Main, double-
cliquez entre deux événements de tempo. 
Le premier événement est sélectionné.

Pour sélectionner une courbe de tempo dans 
l'éditeur de tempo :

 À l'aide du Sélecteur ou de la Main, cliquez trois 
fois sur la ligne horizontale de tempo de la 
courbe à sélectionner.

Utilisation d'un outil de saisie pour modifier un 
événement de tempo

Sélection d'un événement de tempo unique

Sélection d'une courbe de tempo
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Extension de sélections de tempo
Il est possible d'étendre la sélection à l'événement 
de tempo suivant ou précédent.

Pour étendre une sélection de tempo :

1 À l'aide du Sélecteur, sélectionnez une plage 
d'événements de tempo.

2 Effectuez l'une des opérations suivantes :

• Appuyez sur Maj+Tab pour étendre la sélection 
à l'événement de tempo suivant.

• Pour étendre la sélection et inclure l'événement 
de tempo précédent, appuyez sur Maj+Ctrl+Tab 
(Windows) ou Maj+Option+Tab (Mac).

Mise à l'échelle et extension des 
événements de tempo à l'aide 
de l'outil de trim
L'outil de trim permet de mettre à l'échelle 
l'ensemble des événements de tempo d'une session 
ou d'une sélection de timeline. Il permet également 
d'étirer un clip d'événements de tempo pour 
couvrir une plus grande ou une plus petite zone de 
la timeline. 

Pour mettre à l'échelle l'ensemble des événements 
de tempo de la session à l'aide de l'outil de trim :

1 Ouvrez l'éditeur de tempo.

2 À l'aide de l'outil de trim, cliquez au-dessus d'un 
événement de tempo, puis faites glisser votre 
souris vers le haut ou le bas. Les valeurs de 
tempo augmentent pour tous les événements de 
tempo en BPM lorsque vous faites glisser l'outil 
de trim vers le haut, elles diminuent lorsque 
vous le faites glisser vers le bas.

Pour mettre à l'échelle des événements de tempo 
à l'aide de l'outil de trim :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone à éditer.

3 À l'aide de l'outil de trim, cliquez sur la zone 
sélectionnée, puis faites glisser votre souris vers 
le haut ou le bas. Les valeurs de tempo en BPM 
augmentent lorsque vous faites glisser l'outil de 
trim vers le haut, elles diminuent lorsque vous 
le faites glisser vers le bas.

Modification de tous les événements de tempo avec 
l'outil de trim

Modification des événements de tempo sélectionnés 
avec l'outil de trim
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Pour ajuster la fréquence des changements de 
tempo en temps absolu à l'aide de l'outil de trim :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone 
à éditer.

3 Avec l'outil de trim, cliquez sur la poignée 
de début ou de fin de la plage sélectionnée, 
puis faites-la glisser vers le haut ou le bas. 
Les valeurs BPM des événements de tempo 
sont mises à jour en conséquence et les 
événements de tempo se répartissent sur une 
durée absolue plus longue ou plus courte.

Pour modifier la durée de changement du tempo 
à l'aide de l'outil de trim :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone 
à éditer.

3 À l'aide de l'outil de trim, cliquez au début ou 
à la fin de la sélection et faites glisser votre 
souris horizontalement. Les valeurs BPM des 
événements de tempo ne sont pas modifiées. 
Les événements se répartissent sur une durée 
absolue plus longue ou plus courte.

Déplacement, coupe, collage et 
déplacement par incrément 
dans l'éditeur de tempo
Pour déplacer un groupe sélectionné 
d'événements de tempo dans l'éditeur de tempo :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone 
à déplacer.

3 Cliquez sur un événement de tempo à l'aide de 
l'un des outils de saisie et faites-le glisser 
horizontalement pour déplacer les événements 
vers leur nouvel emplacement. 

Pour copier et coller des événements dans 
l'éditeur de tempo :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone à copier.

3 Sélectionnez Edit > Copy.

4 Cliquez dans l'éditeur de tempo à l'endroit où vous 
souhaitez coller les événements de tempo.

5 Sélectionnez Edit > Paste. Les éléments copiés 
sont collés à partir du point d'insertion et 
remplacent les événements de tempo existants.

Pour déplacer une sélection par incrément dans 
l'éditeur de tempo :

1 Ouvrez l'éditeur de tempo.

2 À l'aide du Sélecteur, sélectionnez la zone 
à déplacer par incrément.

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Plus (+) du pavé 
numérique pour déplacer les événements de 
tempo sélectionnés vers l'avant de la valeur de 
déplacement par incrément.

• Appuyez sur la touche Moins (-) du pavé 
numérique pour reculer la sélection de la valeur 
de déplacement par incrément.

Ajustement de la vitesse du changement de tempo 
avec l'outil de trim

Modification de la durée des événements de tempo 
sélectionnés avec l'outil de trim

Maintenez la touche Alt (Windows) ou Option 
(Mac) et faites glisser pour déplacer une 
copie de la sélection.
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Modification du mode 
d'affichage linéaire
Vous avez la possibilité d'afficher la timeline au 
format linéaire soit à l'échelle temporelle relative 
(Linear Tick Display), soit à l'échelle temporelle 
absolue (Linear Sample Display). Les pistes MIDI 
et d'instrument, les pistes audio et les courbes de 
tempo peuvent s'afficher et fonctionner très 
différemment selon les paramètres d'affichage de 
la base de temps.

Le menu déroulant du mode d'affichage linéaire 
détermine si l'éditeur de tempo affiche les 
événements selon le format temporel absolu 
(basé sur les échantillons) ou relatif (basé sur des 
références de tempo).

Linear Sample Display : l'affichage de la timeline 
est basé sur les échantillons et les événements basés 
sur des références de tempo (temps et mesures, par 
exemple) sont déplacés après la création d'une courbe 
de tempo. Ainsi, lorsque vous modifiez le tempo, 
l'emplacement des temps et des mesures suit la 
timeline fixe basée sur les échantillons (Minutes: 
Seconds, par exemple). Lorsque vous utilisez des 
données basées sur les échantillons, lors des étapes 
d'alignement ou de mixage par exemple, assurez-vous 
que l'option Linear Sample Display est sélectionnée. 
Cela est particulièrement important si vous souhaitez 
aligner la table de tempos et de métriques sur des 
événements basés sur les échantillons.

Linear Tick Display : l'affichage des événements 
de tempo est basé sur des références de tempo et 
les positions des événements de tempo exprimées 
en mesures et en temps demeurent inchangées une 
fois la courbe de tempo dessinée. Tous les 
événements basés sur les échantillons se déplacent 
en fonction des positions exprimées en temps et en 
mesures dans la timeline. Lorsque vous utilisez des 
données basées sur des références de tempo, telles 
que des notes MIDI ou des événements Elastic 
Audio, assurez-vous que le mode d'affichage 
Linear Sample Display est sélectionné. Cela est 
particulièrement important si vous prévoyez 
d'effectuer des changements de tempo mais 
souhaitez que les mesures et les temps restent fixes 
au niveau de la timeline.

Pour modifier l'affichage de la base de temps :

 Cliquez sur le sélecteur du mode d'affichage 
linéaire et sélectionnez une base de temps dans 
le menu déroulant.

Densité d'édition du tempo et 
mode d'affichage linéaire
Si les deux paramètres Tempo Edit Density 
(dans l'éditeur de tempo) et Linearity Display 
Mode sont définis selon une échelle temporelle 
Bars|Beats ou selon une échelle temporelle 
absolue, les modifications du tempo sont réparties 
à intervalles réguliers. Lorsque les deux 
paramètres sont définis de telle manière que l'un 
est régi par une échelle temporelle absolue et 
l'autre par une échelle temporelle Bars|Beats, 
le nombre de changements de tempo augmente 
ou diminue au fil du temps (en fonction du 
temps absolu).

Sélecteur du mode d'affichage de la linéarité et menu 
déroulant

Lorsque vous dessinez des événements de 
tempo en mode Linear Sample Display, les 
données basées sur les mesures et les temps 
sont déplacées. Cela peut rendre difficile 
l'utilisation de données basées sur des 
références de tempo. Dans la plupart des cas, 
il est préférable d'activer le mode Linear 
Sample Display pour la création de 
changements de tempo.
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Fenêtre Tempo Operations
La fenêtre Tempo Operations permet de définir 
les événements de tempo sur une plage de temps 
(ou de mesures) donnée. Cette période est 
exprimée dans le format de l'échelle temporelle 
principale. De plus, la fenêtre Tempo Operations 
vous permet d'effectuer les opérations suivantes :

• Adaptation d'un nombre spécifique de mesures et 
temps à une plage temporelle donnée.

• Création de tempos pour accélérer ou ralentir, 
de manière linéaire et selon différentes courbes.

• Redistribution et extension des tempos existants.

La fenêtre Tempo Operations comporte six pages 
d'onglets correspondant chacune à un type 
d'opération liée au tempo.

Constant : permet de créer un tempo constant sur 
une plage de temps sélectionnée.

Linear : permet de créer des tempos qui changent 
à intervalle régulier sur une plage de temps 
sélectionnée.

Parabolic : permet de créer des tempos qui vont en 
accélérant ou en décélérant selon une courbe de tempo 
visant à changer le tempo plus rapidement ou plus 
lentement sur une période donnée.

S-Curve : permet de créer des tempos qui vont en 
accélérant ou en décélérant selon une courbe de 
tempo comprenant un point d'automation 
définissable déterminant les valeurs de temps et de 
tempo à mi-parcours.

Scale : permet de mettre à l'échelle des tempos 
dans une sélection par un pourcentage. 

Stretch : permet de sélectionner un clip 
d'événements de tempo et de les appliquer à une 
zone plus grande ou plus petite de la sélection.

Pour ouvrir une page spécifique de la fenêtre 
Tempo Operations :

 Sélectionnez Event > Tempo Operations, puis la 
commande correspondant à la page Tempo 
Operations souhaitée (Constant, par exemple).

Pour ouvrir la dernière page activée de la fenêtre 
Operations :

 Sélectionnez Event > Tempo Operations > 

Tempo Operations Window.

Pour définir les événements de tempo sur une 
plage de temps donnée :

1 Créez une sélection dans la base de temps ou sur 
une piste.

2 Sélectionnez Event > Tempo Operations > 

Tempo Operations Window.

3 Sélectionnez une page dans le menu déroulant 
situé en haut de la fenêtre Tempo Operations.

4 Modifiez les paramètres de la page choisie, 
si nécessaire.

5 Effectuez l'une des opérations suivantes :

• Cliquez sur Apply.

• Appuyez sur Entrée (Windows) ou Retour 
(Mac) pour appliquer automatiquement les 
valeurs, puis fermez la fenêtre.

La fenêtre Tempo Operations n'est pas 
disponible en mode de tempo manuel.

Si la fenêtre Tempo Operations est toujours 
ouverte, vous pouvez sélectionner une des 
pages à partir du menu déroulant situé en 
haut de la fenêtre.

Appuyez sur les touches Alt+2 (Windows) ou 
Option+2 (Mac) du pavé numérique pour 
ouvrir la dernière page active de la fenêtre 
Tempo Operations.
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Constant
La page Constant de la fenêtre Tempo Operations 
permet de créer un tempo constant sur une plage de 
temps sélectionnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer le 
tempo ou l'heure de fin de la sélection.

Selection Start and End : spécifie la valeur de 
début ou de fin du changement de tempo en 
Bars|Beats. Lorsqu'une sélection d'édition est 
créée, les champs Start et End affichent les limites 
de la sélection.

End Time (option avancée) : affiche l'heure de fin 
de la sélection. Si la valeur de l'échelle temporelle 
principale est Bars|Beats, la valeur de fin s'affiche 
dans l'échelle temporelle secondaire. Si l'échelle 
temporelle principale utilise une base de temps 
absolue, l'heure de fin est calculée et exprimée en 
Bars|Beats. La modification de l'heure de fin entraîne 
un changement du tempo.

Tempo : indique le tempo, exprimé en battements 
par minute (BPM) à appliquer à la plage 
sélectionnée.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement de tempo 
écrits sur la règle de tempo.

Preserve Tempo after Selection : si cette option est 
sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Linear
La page Linear de la fenêtre Tempo Operations 
permet de créer des tempos qui varient de façon 
régulière au cours de la plage de temps 
sélectionnée.

Page Constant (option avancée)

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du clic 
définie par les marqueurs de métrique.

Page Linear (option avancée)
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Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
l'heure de fin de la sélection, le tempo de début ou 
celui de fin.

Selection Start and End :  affiche les points de 
début et de fin du changement du tempo dans la base 
de temps principale actuellement sélectionnée. 
Lorsqu'une sélection d'édition est créée, les champs 
Start et End affichent les limites de la sélection. 
Le fait de modifier les valeurs de début et de fin 
a pour effet de modifier la plage de la sélection.

End Time (option avancée) : affiche l'heure 
absolue de la fin de la sélection. Si l'échelle 
temporelle principale est en Bars|Beats, l'heure de 
fin s'affiche dans l'échelle temporelle secondaire. 
Si l'échelle temporelle principale utilise une base 
de temps absolue, l'heure de fin est calculée et 
exprimée en Bars|Beats. La modification de l'heure 
de fin entraîne un changement du tempo.

Tempo Start and End : affiche le tempo, 
en battements par minute (BPM), pour les points 
de début et de fin de la plage sélectionnée. 
Un changement de tempo entraîne une 
modification de l'heure de fin.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement de tempo 
écrits sur la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà 
de la plage sélectionnée.

Parabolic
La page Parabolic de la fenêtre Tempo Operations 
permet de créer des tempos qui vont en accélérant 
ou en décélérant selon une courbe de tempo visant 
à changer le tempo plus rapidement ou plus 
lentement sur une période donnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
l'heure de fin de la sélection, le tempo de début, 
le tempo de fin ou la courbure du changement 
de tempo. 

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du clic 
définie par les marqueurs de métrique.

Page Parabolic (option avancée)
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Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la base 
de temps principale actuellement sélectionnée. 
Lorsqu'une sélection d'édition est créée, les champs 
Start et End affichent les limites de la sélection. 
Le fait de modifier les valeurs de début et de fin 
a pour effet de modifier la plage de la sélection.

End Time (option avancée) : affiche l'heure 
absolue de la fin de la sélection. Si l'échelle 
temporelle principale est en Bars|Beats, l'heure de 
fin s'affiche dans l'échelle temporelle secondaire. 
Si l'échelle temporelle principale utilise une base 
de temps absolue, l'heure de fin est calculée et 
exprimée en Bars|Beats. La modification de l'heure 
de fin entraîne un changement du tempo.

Tempo Start and End : affiche le tempo, 
en battements par minute (BPM), pour les points 
de début et de fin de la plage sélectionnée. 
Un changement de tempo entraîne une modification 
de l'heure de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement de 
tempo plus rapide au début de la plage de temps et 
les nombres positifs indiquent un changement de 
tempo plus rapide à la fin de la plage. Cette valeur 
peut être définie avec le curseur Curvature.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement de tempo 
écrits sur la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà 
de la plage sélectionnée.

S-Curve
La page S-Curve permet de créer des tempos 
qui vont en accélérant ou en décélérant selon 
une courbe de tempo comprenant un point 
d'automation définissable déterminant les valeurs 
de temps et de tempo à mi-parcours.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles. 

Calculate (option avancée) : permet de calculer 
l'heure de fin de la sélection, le tempo de début, 
le tempo de fin ou la courbe du changement de 
tempo. 

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du clic 
définie par les marqueurs de métrique.

Page S-Curve (option avancée)
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Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la base 
de temps principale actuellement sélectionnée. 
Lorsqu'une sélection d'édition est créée, les champs 
Start et End affichent les limites de la sélection. 
Le fait de modifier les valeurs de début et de fin 
a pour effet de modifier la plage de la sélection.

Start and End Time (option avancée) : affiche 
l'heure absolue de la fin de la sélection. Si l'échelle 
temporelle principale est en Bars|Beats, l'heure de 
fin s'affiche dans l'échelle temporelle secondaire. 
Si l'échelle temporelle principale utilise une base 
de temps absolue, l'heure de fin est calculée et 
exprimée en Bars|Beats.

Tempo Start and End : affiche le tempo, 
en battements par minute (BPM), pour les points 
de début et de fin de la plage sélectionnée. 
Un changement de tempo entraîne une modification 
de l'heure de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement 
du tempo plus rapide au début et à la fin de la plage 
de temps alors que cette valeur est la plus faible 
à mi-parcours. Les nombres positifs indiquent une 
valeur de changement faible vers le début et la fin 
de la plage sélectionnée, la valeur la plus élevée se 
trouvant à mi-parcours. Cette valeur peut être 
définie avec le curseur Curvature.

Mid Point : indique l'emplacement sur l'échelle 
temporelle principale du point médian de la 
courbe. Cette valeur peut être définie avec le 
curseur Mid Point.

Mid Tempo : spécifie le tempo au point médian. 
Cette valeur peut être définie avec le curseur Mid 
Tempo.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement de tempo 
écrits sur la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà 
de la plage sélectionnée.

Scale
La page Scale permet de redistribuer les 
événements de tempo d'une sélection selon un 
pourcentage spécifié.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du clic 
définie par les marqueurs de métrique.

Page Scale (option avancée)
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Calculate (option avancée) : associé aux 
paramètres sélectionnés dans la liste déroulante 
Scale, le menu Calculate permet de calculer l'heure 
de fin de la sélection, le tempo moyen, le tempo de 
début ou le tempo de fin. 

Scale (option avancée) : associé aux paramètres 
sélectionnés dans la liste déroulante Calculate, 
le menu Scale permet de mettre à l'échelle tous les 
événements de tempo, celui de début ou celui de fin.

La mise à l'échelle de l'ensemble des événements de 
tempo s'effectue de manière égale sur toute la plage 
sélectionnée. La mise à l'échelle de l'événement 
de tempo de début entraîne une mise à l'échelle 
proportionnelle sur la sélection : plus importante 
au début, puis de moins en moins jusqu'au tempo de 
fin qui reste identique. La mise à l'échelle de 
l'événement de tempo de fin entraîne aussi une mise 
à l'échelle proportionnelle sur la sélection : plus 
importante à la fin, puis de moins en moins jusqu'au 
tempo de début qui reste identique.

Selection Start and End : affiche les points de 
début et de fin de l'opération liée au tempo dans la 
base de temps principale actuellement sélectionnée. 
Lorsqu'une sélection d'édition est créée, les champs 
Start et End affichent les limites de la sélection. 
Le fait de modifier les valeurs de début et de fin 
a pour effet de modifier la plage de la sélection.

Start and End Time : affiche la référence 
temporelle absolue des points de début et de fin de 
la sélection. Si l'échelle temporelle principale est 
en Bars|Beats, les heures s'affichent dans l'échelle 
temporelle secondaire. Si l'échelle temporelle 
principale utilise une base de temps absolue, les 
heures sont calculées et exprimées en Bars|Beats.

Average Tempo : affiche le tempo moyen, 
en battements par minute (BPM) sur la plage 
sélectionnée. Le fait de modifier le tempo moyen 
affecte le pourcentage de mise à l'échelle.

Scale : affiche le pourcentage de modification du 
tempo, en battements par minute (BPM) sur la 
plage sélectionnée. La modification de la mise 
à l'échelle affecte le tempo moyen.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà 
de la plage sélectionnée.

Stretch
La page Stretch permet de sélectionner des 
événements de tempo et de les appliquer à une 
zone plus grande ou plus petite de la sélection.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini par 
l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Selection Start and End : indique la plage des 
événements de tempo que vous voulez modifier. 
Lorsqu'une sélection d'édition est créée, 
les champs Start et End affichent les limites de la 
sélection. 

Page Stretch (option avancée)
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Stretch To End : spécifie un nouveau point de fin 
pour le clip auquel vous voulez appliquer les 
événements de tempo sélectionnés. La modification 
du point de fin a un impact sur le pourcentage Stretch.

Stretch To Start (option avancée) : spécifie un 
nouveau point de début pour le clip auquel vous 
voulez appliquer les événements de tempo 
sélectionnés. La modification du point de fin 
a un impact sur le pourcentage Stretch.

Stretch : détermine le pourcentage de temps 
couvert pour les événements de tempo 
sélectionnés à couvrir.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo précédent 
appliqué au point de fin de sélection est préservé 
après la sélection. Lorsque l'option est désactivée, 
le dernier événement de tempo créé par l'opération 
liée au tempo reste en vigueur à la fin de la session, 
ou jusqu'à l'événement de tempo suivant au-delà 
de la plage sélectionnée.

Commande Identify Beat 
La commande Identify Beat permet d'établir une 
table de tempo/métrique pour des l'audio 
enregistré sans clic ou pour de l'audio importé dont 
le tempo est inconnu.

La commande Identify Beat analyse une plage 
de sélection (généralement avec un nombre précis 
de temps ou de mesures) et calcule son tempo 
d'après la métrique spécifiée. Au cours du processus, 
les marqueurs Bar|Beat correspondant au tempo 
calculé sont insérés et apparaissent sur la règle de 
tempo au début et à la fin de la sélection ; de plus, 
les événements de métrique sont insérés sur la règle 
de métrique.

Marqueurs Bar|Beat
Les marqueurs Bar|Beat ressemblent aux 
événements de tempo, mais leur emplacement est 
indiqué par de petits triangles bleus.

Choix entre les marqueurs 
Bar|Beat et les événements de 
tempo
Les événements de tempo étant basés sur des 
références de tempo et les marqueurs Bar|Beat sur 
les échantillons, ils ne peuvent pas être mélangés. 
Si une session contient des événements de tempo 
et si vous tentez d'insérer des marqueurs Bar|Beat, 
les événements de tempo existants sont convertis 
en marqueurs Bar|Beat (et inversement).

Utilisez Beat Detective pour générer des 
marqueurs Bar|Beat dans une sélection 
comportant des changements rythmiques sur 
chaque temps et subdivision de temps (reportez-
vous au Chapitre 30, « Beat Detective »).

Marqueur Bar|Beat



Guide de référence Pro Tools818

Les événements de tempo peuvent également être 
convertis en marqueurs Bar|Beat (et inversement). 
Lors de la conversion d'événements de tempo en 
marqueurs Bar|Beat et inversement, leur position 
exprimée en échantillons peut être légèrement 
arrondie.

Pour utiliser des événements de tempo ou des 
marqueurs Bar|Beat :

1 Appuyez sur la touche Ctrl (Windows) ou 
Commande (Mac) et cliquez sur le bouton Add 
Tempo Change.

2 Sélectionnez Tempo Events ou Bar|Beat 
Markers dans le menu déroulant. 

Identification des rythmes

Identification du rythme d'une boucle de batterie 
d'une mesure et création des marqueurs Bar|Beat 
correspondants :

1 Placez une boucle de batterie d'une mesure au 
début d'une piste audio.

2 Sélectionnez View > Rulers > Samples. Ceci 
garantit que la sélection des données audio 
s'effectuera à l'échantillon près.

3 Sélectionnez le clip audio avec l'outil de saisie du 
temps, puis sélectionnez Event > Identify Beat.

4 Dans la boîte de dialogue Bar|Beat Markers, 
indiquez les points de début et de fin 
correspondant aux marqueurs Bar|Beat insérés. 
Cet exemple utilisant une boucle d'une mesure, 
entrez 1|1|000 et 2|1|000.

5 Le cas échéant, indiquez la signature rythmique 
correspondant aux plages de début et de fin.

6 Cliquez sur OK pour calculer automatiquement 
le nouveau tempo et insérer les marqueurs 
Bar|Beat et événements de métrique nécessaires. 
Tout événement de tempo et de métrique se 
trouvant dans la sélection est supprimé.

Lorsque vous travaillez avec une sélection, 
la commande Identify Beat ne calcule qu'un seul 
tempo pour la plage sélectionnée. Si le tempo varie 
d'une mesure à l'autre ou d'un temps à l'autre, vous 
devrez utiliser la commande Identify Beat pour 
chaque variation de tempo (en vous assurant de 
définir une plage de sélection ou un emplacement 
correspondant précisément au changement de 
tempo).

Menu déroulant de la règle de tempo

Boîte de dialogue Identify Beat

Marqueurs Bar|Beat insérés
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Pour définir avec précision les tempos 
correspondant à une plage de données audio au 
moyen de la commande Identify Beat, vous devez 
veiller à ce que la sélection initiale représente un 
nombre précis de temps ou de mesures. Il peut être 
utile de lire la sélection en boucle (reportez-vous 
à la section « Mode de lecture en boucle » à la 
page 426) afin de s'assurer de la précision du 
résultat. Pour éviter tout décalage et garantir une 
précision à l'échantillon près, sélectionnez les 
données audio en ayant préalablement défini 
l'échelle temporelle sur Samples plutôt que sur 
Bars|Beats.

Déplacement des marqueurs 
Bar|Beat
Vous pouvez faire glisser les marqueurs Bar|Beat 
vers de nouveaux emplacements pour les aligner 
sur des clips audio qui ont été déplacés ou sur un 
point légèrement différent d'un clip audio. Cela 
a pour effet d'aligner les données MIDI sur la 
nouvelle table de tempos.

Les marqueurs Bar|Beat sont basés sur les 
échantillons et les événements de tempo sur des 
références de tempo, c'est pourquoi ils se 
comportent de façon différente lorsque vous les 
faites glisser sur la règle de tempo.

Lorsque vous faites glisser un marqueur Bar|Beat :

• Sa valeur BPM est recalculée d'après le 
marqueur Bar|Beat qui se trouve immédiatement 
à sa gauche. Les marqueurs Bar|Beat situés à la 
droite du marqueur déplacé restent en place.

• Son emplacement, exprimé en mesures et en 
temps, est déplacé avec le marqueur Bar|Beat. 
Si le marqueur Bar|Beat a été placé au départ 
à 3|1|000, il y reste (sauf si vous l'éditez).

• Les expressions de son emplacement en 
échantillons et en adresse SMPTE changent en 
fonction du calcul du nouveau tempo.

• Les événements MIDI voisins, ainsi que la règle 
Bars|Beats, raccourcissent ou s'allongent pour 
s'ajuster au nouveau tempo.

Lorsque vous faites glisser un événement de tempo :

• L'événement de tempo est placé à un nouvel 
emplacement exprimé en mesures et en temps. 
Les expressions en échantillons et en adresse 
SMPTE des positions de l'événement sont 
également mises à jour.

• La valeur BPM correspondant à l'événement de 
tempo déplacé reste constante, de même que 
pour les autres événements de tempo de la 
session.

• Les événements MIDI voisins et les clips audio 
des pistes basées sur des références de tempo, 
de même que la règle, raccourcissent ou 
s'allongent pour s'ajuster au nouvel emplacement 
de tempo.

Lors de l'identification de rythmes, 
sélectionnez une zone aussi large que 
possible. Par exemple, si vous travaillez avec 
un fichier audio de quatre mesures, 
sélectionnez les toutes au lieu d'une seule afin 
de limiter les erreurs d'arrondi (reportez-
vous à la section « Arrondi des échantillons 
et opérations d'édition » à la page 796)

Déplacement d'un marqueur Bar|Beat
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Édition des marqueurs Bar|Beat
Un marqueur Bar|Beat peut être édité pour 
redéfinir son emplacement exprimé en mesures et 
en temps, ce qui redéfinit également le point de 
début et de fin de la plage analysée pour le tempo. 
Ceci est différent du déplacement d'un marqueur 
Bar|Beat en le faisant glisser. 

Pour éditer un marqueur Bar|Beat :

1 Double-cliquez sur le marqueur Bar|Beat sur la 
règle de tempo.

2 Dans la boîte de dialogue Edit Bar|Beat, entrez 
le nouvel emplacement du marqueur Bar|Beat.

3 Entrez une nouvelle signature rythmique. 

4 Cliquez sur OK.

Pour supprimer un marqueur Bar|Beat :

 À l'aide de la Main, cliquez sur un marqueur 
Bar|Beat tout en appuyant sur la touche Alt 
(Windows) ou Option (Mac).

Insertion de marqueurs 
Bar|Beat individuels
Contenu basé sur les échantillons avec 
tempos variables

Vous pouvez insérer des marqueurs Bar|Beat un 
par un, en définissant un point d'insertion d'édition 
(plutôt que de créer une sélection) avant d'utiliser 
la commande Identify Beat. La possibilité 
d'identifier chaque rythme, l'un après l'autre, 
est particulièrement utile avec du contenu dont les 
tempos varient.

Par exemple, si une mesure accélère légèrement, 
vous pouvez insérer un marqueur Bar|Beat sur 
chaque temps afin de refléter précisément les 
variations du tempo.

Même après avoir inséré des marqueurs Bar|Beat, 
d'autres ajustements de la table de tempos restent 
possibles, en faisant glisser chaque marqueur, 
pour les aligner avec le temps associé dans les 
données audio.

Boîte de dialogue Edit Bar|Beat

Marqueurs Bar|Beat sur chaque temps
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Événements de métrique
Vous pouvez modifier la métrique sur la règle de 
métrique ou apporter des modifications précises 
dans la fenêtre Time Operations.

Les événements de métrique peuvent être insérés au 
début d'une session pour remplacer la mesure par 
défaut (à 4/4), et n'importe où dans la session pour 
d'autres modifications de la métrique.

Pour afficher la règle de métrique :

 Sélectionnez View > Rulers > Meter.

Métrique actuelle
La métrique actuelle de la session est affichée dans la 
fenêtre de transport et reflète les événements de 
métrique rencontrés en cours de lecture.

Insertion d'événements de 
métrique

Pour insérer un événement de métrique :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Event > Time Operations > 
Change Meter.

• Cliquez sur le bouton d'ajout de changement de 
métrique situé à droite de la règle de métrique.

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et cliquez avec la Main 
à l'emplacement où vous souhaitez insérer 
l'événement.

• Double-cliquez sur le champ d'affichage de la 
métrique dans la fenêtre de transport.

2 Renseignez les champs Location et Meter de la 
fenêtre Meter Change.

3 Pour placer l'événement de métrique inséré 
précisément sur le premier temps de la mesure 
la plus proche, activez l'option Snap To Bar.

4 Sélectionnez une valeur de note (ronde, blanche, 
noire, etc.) pour le nombre de clics à jouer dans 
chaque mesure. Sélectionnez l'option point (.) 
si vous voulez une valeur de note pointée.

Métrique actuelle affichée dans la fenêtre de transport

Bouton d'ajout de changement de métrique

Insertion manuelle d'un événement de métrique

Métrique actuelle affichée dans la fenêtre de transport

Fenêtre Meter Change
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5 Cliquez sur OK pour insérer le nouvel événement 
de métrique. Le nouvel événement de métrique 
est inséré et apparaît sur la règle de métrique.

À chaque événement de métrique est associé un petit 
triangle jaune qui indique son emplacement. Vous 
pouvez sélectionner ce triangle pour le copier et le 
coller ou double-cliquer dessus pour éditer 
l'événement de métrique.

Édition des événements de 
métrique
Les événements de métrique existants peuvent être 
édités, supprimés, copiés et collés.

Pour éditer un événement de métrique :

1 Double-cliquez sur l'événement de métrique sur 
la règle de métrique.

2 Dans la boîte de dialogue Meter Change, entrez 
un nouvel emplacement (Location) ou une 
nouvelle métrique (Meter) pour l'événement.

3 Cliquez sur OK.

Pour supprimer un événement de métrique :

 Cliquez sur l'événement de métrique en 
maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée.

Pour copier et coller plusieurs événements de 
métrique :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Cliquez et faites glisser votre souris sur la règle 
de métrique pour sélectionner une plage 
d'événements de métrique.

Si le début de la sélection inclut un événement de 
métrique, appuyez sur Ctrl (Windows) ou 
Commande (Mac) pour faire apparaître le 
Sélecteur.

3 Sélectionnez Edit > Copy.

4 Cliquez sur la règle de métrique à l'endroit où vous 
souhaitez coller les événements de métrique.

5 Sélectionnez Edit > Paste. Le contenu du 
presse-papiers est collé à partir du point 
d'insertion et remplace les événements de 
métrique existants.

Pour étendre une sélection d'édition d'une piste 
à la règle de métrique :

1 À l'aide du Sélecteur ou de l'un des outils de 
saisie, sélectionnez une plage de la piste.

2 Cliquez sur la règle de métrique tout en 
appuyant sur Maj.

Cliquez de nouveau sur la règle de métrique tout en 
appuyant sur Maj pour la retirer de la sélection.

Pour sélectionner tous les événements de 
métrique :

 Double-cliquez avec le sélecteur sur la règle de 
métrique.

Avec certaines métriques, il peut être 
souhaitable d'utiliser une valeur pointée. 
Par exemple, dans le cas d'une mesure en 6/8, 
le choix d'une noire pointée (donnant deux 
battements par mesure) est généralement plus 
adapté qu'une croche simple (six battements 
par mesure).

Événement de métrique inséré

Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée, cliquez et faites glisser votre 
souris pour créer une sélection sur toutes les 
pistes de chef d'orchestre.
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Pour supprimer une plage sélectionnée 
d'événements de métrique :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Cliquez et faites glisser le Sélecteur sur la règle 
de métrique pour sélectionner les événements 
de métrique à supprimer.

3 Sélectionnez Edit > Clear pour supprimer les 
événements de métrique sélectionnés.

Mesures partielles
Si nécessaire, Pro Tools créera une mesure 
partielle pour s'adapter à l'événement de métrique 
inséré. Lorsqu'un événement de métrique est 
précédé d'une mesure partielle, il apparaît en 
italique sur la règle de métrique.

Les métriques partielles peuvent également 
apparaître lorsque vous collez des événements de 
métrique à d'autres emplacements que le premier 
temps d'une mesure.

Time Operations
La fenêtre Time Operations permet d'effectuer les 
opérations suivantes :

• Changer la métrique

• Insérer du temps

• Couper du temps

• Déplacer le début d'un morceau

Pour ouvrir une fenêtre Time Operations 
spécifique :

 Sélectionnez Event > Time Operations, suivi de 
l'une des commandes Time Operations (Change 

Meter, par exemple).

Pour ouvrir la dernière fenêtre Time Operations 
active :

 Sélectionnez Event > Time Operations > Time 

Operations Window.

Mesure partielle en 4/4

Pour insérer des événements de métrique en 
évitant les mesures partielles, utilisez la 
commande Change Meter de la fenêtre Time 
Operations. Reportez-vous à la section 
« Change Meter » à la page 824.

Si la fenêtre Time Operations est toujours 
ouverte, vous pouvez sélectionner la page de 
votre choix à partir du menu déroulant situé 
en haut de la fenêtre.

Appuyez sur les touches Alt+1 (Windows) ou 
Option+1 (Mac) du pavé numérique pour 
ouvrir la fenêtre Time Operations et afficher 
la dernière fenêtre Time Operations active.
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Change Meter
La page Change Meter permet de spécifier des 
changements de métrique complexes pour le 
contenu basé sur les mesures et temps. Vous 
pouvez entrer des changements de métrique pour 
une mesure donnée, changer la métrique sur une 
période de temps sélectionnée ou ajouter des 
changements de métrique de manière séquentielle, 
d'une mesure à l'autre.

Exemples de changements de 
métrique

Pour modifier la métrique sur une plage de 
mesures :

1 Effectuez l'une des opérations suivantes :

• Faites glisser le sélecteur pour sélectionner une 
plage de mesures à modifier.

• Pour que le changement de métrique soit 
appliqué jusqu'à l'événement de métrique 
suivant, cliquez à l'aide du Sélecteur sur l'endroit 
où vous souhaitez que le changement 
commence. Le changement de métrique se 
produit au début de la mesure la plus proche.

2 Sélectionnez Event > Time Operations > 

Change Meter.

3 Spécifiez une nouvelle métrique et une valeur 
de note pour le clic. Pro Tools définit 
automatiquement les options de sélection de 
manière à ce que la nouvelle métrique concorde 
le mieux possible avec la plage sélectionnée, 
en ajoutant ou soustrayant éventuellement 
des temps.

4 Sélectionnez To Selected Range dans le menu 
déroulant Apply Change.

5 Sélectionnez les règles et pistes que vous 
souhaitez réaligner après l'application des 
changements de métrique.

6 Cliquez sur Apply.

Pour ajouter une série de changements de 
métrique, de mesure en mesure :

1 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur, cliquez à l'endroit où 
vous souhaitez que le changement commence. 
Le changement de métrique se produit au début 
de la mesure la plus proche.

• Entrez le numéro de la première mesure dans le 
champ Starting At Bar. 

2 Sélectionnez Event > Time Operations > 

Change Meter.

3 Spécifiez une nouvelle métrique et une valeur 
de note pour le clic. 

4 Sélectionnez Until the Next Bar dans le menu 
déroulant Apply Change To.

5 Cliquez sur Apply pour valider la nouvelle 
métrique et placer le point d'insertion à la fin de 
la nouvelle mesure.

6 Spécifiez une nouvelle métrique et une valeur 
de note pour le clic pour la mesure suivante.

7 Répétez les étapes 5 et 6 pour tout changement 
de métrique supplémentaire à insérer.

Fenêtre Change Meter
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Options de la page Change Meter
Les options de la page Change Meter sont les 
suivantes :

New Meter : permet de spécifier une nouvelle 
signature rythmique. Le premier champ permet de 
saisir le nombre de temps (jusqu'à 99) compris 
dans une mesure et le second, la durée de note 
correspondant à un temps.

Click : permet de spécifier la valeur de note qui 
déclenche le clic du métronome. Si, par exemple, 
vous sélectionnez la croche, un clic se produit sur 
toutes les croches, et ce quel que soit le tempo.

Starting at Bar : définit la mesure où intervient le 
changement de métrique. Les changements de 
métrique créés sur la page Change Meter peuvent 
uniquement être insérés au début d'une mesure.

Apply Change To : permet d'appliquer le 
changement de métrique à la plage sélectionnée, 
jusqu'à la fin de la session ou jusqu'à la mesure 
suivante. 

Change : les champs Change permettent 
d'indiquer le nombre de mesures utilisant la 
nouvelle métrique que vous voulez insérer dans la 
plage sélectionnée.

Pro Tools calcule automatiquement le nombre 
entier de mesure le plus proche ; vous pouvez 
également spécifier le nombre de mesures qui seront 
concernées. Du temps est inséré ou supprimé, sous 
forme d'incréments de mesures complets, à la fin de 
la sélection, sur toutes les pistes affectées lorsque 
vous remplacez la plage calculée.

Realign

Les commandes Realign permettent de choisir les 
éléments à réaligner après les changements de 
métrique. Vous pouvez choisir de réaligner les 
événements de métrique ou les événements de 
métrique et de tempo, les marqueurs et les pistes 
basés sur des références de tempo ou les marqueurs 
(tous ou aucun) et les pistes (toutes ou aucune) 
basés sur les échantillons.

Meter Ruler Only : applique le changement de 
métrique et réaligne uniquement la règle de 
métrique. Les autres règles et pistes ne subissent 
aucune modification.

Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks, and Sample-Based 
Markers and Tracks : applique le changement de 
métrique et réaligne les règles de métrique, 
de tempo, de tonalité et d'accord, ainsi que tous les 
marqueurs et pistes basés sur des références de 
tempo. Vous pouvez également sélectionner All ou 
No dans le menu déroulant pour réaligner tous les 
marqueurs et toutes les pistes basés sur les 
échantillons ou aucun d'entre eux. Du temps est 
inséré ou supprimé, le cas échéant, à la fin de la 
sélection pour préserver l'alignement du contenu 
qui suit la sélection.
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Insert Time
La page Insert Time de la fenêtre Time Operation 
permet d'insérer du silence sur les règles de chef 
d'orchestre, les pistes MIDI et audio.

Exemple d'insertion de temps

Pour insérer quatre mesures vides en 4/4 dans une 
session :

1 Définissez l'échelle temporelle principale sur 
Bars|Beats.

2 Sélectionnez Event > Time Operations > Insert 

Time.

3 Dans le champ Start, spécifiez la mesure à partir 
de laquelle vous voulez insérer les nouvelles 
mesures. 

4 Entrez quatre mesures dans le champ Length.

5 Sélectionnez les options Realign Meter, Tempo, 

Key, and Chord Rulers, Tick-Based Markers 

and Tracks et All Sample-Based Markers and 

Tracks.

6 Cliquez sur Apply.

Options de la page Insert Time
Les options de la page Insert Time sont les suivantes :

Start, End, and Length : définit les points de début 
et de fin de la sélection ainsi que sa durée. 

Set Meter : si l'échelle temporelle principale est 
au format Bars|Beats, Set Meter permet d'indiquer 
une nouvelle métrique pour le temps inséré. 
La sélection est quantifiée sur les mesures les plus 
proches ; la métrique précédente est insérée après la 
sélection. Si l'échelle temporelle principale est basée 
sur les échantillons, cette option n'est pas disponible.

Realign

Les commandes Realign permettent de sélectionner 
les éléments qui seront décalés (c'est-à-dire qui se 
produiront ultérieurement) lors de l'insertion du 
temps, de la manière suivante :

• Si l'échelle temporelle principale est au format 
Bars|Beats, vous pouvez choisir de réaligner 
uniquement les événements de métrique ou de 
réaligner une combinaison des règles de métrique 
et de tempo, tous les marqueurs et toutes les pistes 
basés sur des références de tempo et une sélection 
de pistes basées sur les échantillons.

• Si l'échelle temporelle principale utilise une base 
de temps absolue (Min:Secs par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements de chef d'orchestre, les marqueurs et 
les pistes basées sur des références de tempo et 
une sélection de pistes basées sur les échantillons. 

Meter Ruler Only : si l'échelle temporelle principale 
est au format Bars|Beats, vous avez la possibilité 
d'insérer du temps uniquement sur la règle de 
métrique. Les événements de métrique situés après 
le point de début de la sélection sont décalés après le 
point de fin, de la durée de la sélection. 

Si l'échelle temporelle principale est basée sur les 
échantillons, l'option Realign Meter Ruler Only 
n'est pas disponible.

Fenêtre Insert Time
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Meter, Tempo, Key, and Chord Rulers, Tick-Based 
Markers and Tracks, and Sample-Based Markers 
and Tracks : permet d'insérer du temps sur les 
règles de métrique, de tempo, de tonalité et 
d'accord et dans tous les marqueurs et pistes basés 
sur des références de tempo. Les événements de 
métrique situés après le point de début de la 
sélection sont décalés après le point de la fin, de la 
durée du temps inséré. 

Si la sélection de timeline inclut des clips audio sur 
des pistes basées sur des références de tempo, 
les clips audio sont séparés à leur point de début ; 
le nouveau clip contenant la sélection précédente 
est décalé vers le point de fin.

Vous pouvez également sélectionner All ou No 
dans le menu déroulant pour insérer du temps dans 
tous les marqueurs et pistes basés sur les 
échantillons ou aucun d'entre eux. Si vous 
sélectionnez All et si la sélection inclut des clips 
audio de pistes basées sur les échantillons, 
les parties sélectionnées des clips audio sont 
séparées au point de début ; le nouveau clip 
contenant la sélection précédente est décalé vers 
le point de fin.

Cut Time 
La page Cut Time de la fenêtre Time Operation 
permet de couper un intervalle de temps défini 
(données de base de temps et de piste) sur les règles 
de chef d'orchestre et les pistes MIDI et audio.

Exemple de suppression de 
temps

Pour couper trente secondes d'une session :

1 Définissez le format Minutes:Seconds pour 
l'échelle temporelle principale.

2 Sélectionnez Event > Time Operations > Cut 

Time.

3 À l'aide du Sélecteur, cliquez au début de la 
zone à couper. 

4 Entrez trente secondes (0:30.000) dans le 
champ Length.

5 Sélectionnez les options Realign Meter, Tempo, 

Key, and Chord Rulers, all Tick-Based Markers 

and Tracks et All Sample-Based Markers and 

Tracks.

6 Cliquez sur Apply.

Fenêtre Cut Time
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Options de la page Cut Time
Les options de la page Cut Time sont les suivantes :

Start, End, and Length : définit les points de début 
et de fin de la sélection ainsi que sa durée. 

Realign

Les commandes Realign permettent de choisir les 
éléments qui seront décalés après la suppression du 
temps, de la manière suivante :

• Si l'échelle temporelle principale est au format 
Bars|Beats, vous pouvez choisir de réaligner 
uniquement les événements de métrique ou de 
réaligner une combinaison des règles de métrique 
et de tempo, tous les marqueurs et toutes les pistes 
basés sur des références de tempo et une sélection 
de pistes basées sur les échantillons.

• Si l'échelle temporelle principale utilise une base 
de temps absolue (Min:Secs par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements de chef d'orchestre, les marqueurs et 
les pistes basées sur des références de tempo et 
une sélection de pistes basées sur les échantillons. 

Meter Ruler Only : si l'échelle temporelle 
principale est au format Bars|Beats, vous pouvez 
uniquement supprimer du temps sur la règle de 
métrique. Les événements de métrique dans la 
sélection sont supprimés et ceux qui se produisent 
après le point de fin de la sélection sont décalés 
vers le point de début de la sélection. 

Si l'échelle temporelle principale est basée sur les 
échantillons, l'option Realign Meter Ruler Only 
n'est pas disponible.

Meter, Tempo, Key, and Chord Rulers, Tick-Based 
Markers and Tracks, and Sample-Based Markers 
and Tracks : coupe du temps et réaligne les règles 
de métrique, de tempo, de tonalité et d'accord, ainsi 
que tous les marqueurs et pistes basés sur des 
références de tempo. 

Si la sélection de temps inclut des clips audio basés 
sur des références de tempo, la zone sélectionnée 
du clip est supprimée et les clips qui suivent la 
sélection sont décalés vers l'avant.

Vous pouvez également sélectionner All ou No 
dans le menu déroulant pour supprimer du temps 
dans tous les marqueurs et pistes basés sur les 
échantillons ou aucun d'entre eux. Si vous 
sélectionnez All et si la sélection de temps inclut 
des clips audio basés sur les échantillons, la zone 
sélectionnée du clip est supprimée et les clips qui 
suivent la sélection sont décalés vers l'avant.
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Move Song Start 
La page Move Song Start de la fenêtre Time 
Operation permet de redéfinir l'emplacement du 
début d'un morceau.

Exemple de déplacement du 
début d'un morceau

Pour déplacer le marqueur de début d'un morceau 
de 15 secondes sur la timeline :

1 Sélectionnez Event > Time Operations > Move 
Song Start.

2 Sélectionnez Minutes:Seconds dans le menu 
déroulant Timebase. 

3 Dans le champ Move Song Start To, entrez 
0:15:000 pour déplacer le début du morceau de 
15 secondes vers l'avant.

4 Si vous souhaitez renuméroter les mesures afin 
que le marqueur de début du morceau se trouve 
sur une mesure différente, sélectionnez l'option 
Renumber Song Start et entrez le numéro de 
mesure.

5 Indiquez si vous voulez déplacer tous les 
marqueurs et toutes les pistes basés sur les 
échantillons (All) ou aucun (No). 

6 Cliquez sur Apply.

Options de la page Move Song 
Start
Les options de la page Move Song Start sont les 
suivantes :

Timebase : permet de redéfinir avec précision la 
position du marqueur de début de morceau, 
par rapport à une base de temps compatible.

Move Start To : définit l'emplacement du 
marqueur de début de morceau dans la base de 
temps choisie. 

Renumber Song Start To : lorsque cette option est 
activée, elle permet de définir le marqueur de 
début de morceau sur n'importe quel numéro de 
mesure.

Move

Les commandes Move permettent de déterminer 
les éléments à décaler lorsque le début du morceau 
est déplacé, de la manière suivante :

Song Start Only : déplace le marqueur de début de 
morceau uniquement.

Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks, and Sample-Based 
Markers and Tracks : déplace le marqueur de 
début de morceau, les événements des règles de 
métrique, de tempo, de tonalité et d'accord, ainsi 
que tous les marqueurs et pistes basés sur des 
références de tempo et tous les marqueurs et les 
pistes basés sur les échantillons ou aucun d'eux.

Fenêtre Move Song Start
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Renumérotation des mesures
La commande Renumber Bars permet de 
renuméroter toutes les mesures d'une session, 
en changeant l'expression, en mesures et en temps, 
des emplacements de tous les clips et des 
événements de métrique et de tempo, sans 
modifier leur position. À l'issue de cette 
manipulation, les expressions en échantillons et en 
valeurs SMPTE des emplacements des données 
audio de la session ne sont pas modifiées.

Pour renuméroter les mesures :

1 Sélectionnez Event > Renumber Bars.

2 Indiquez la mesure à renuméroter ainsi que son 
nouveau numéro, puis cliquez sur Renumber.

Armures
La règle d'armure permet d'ajouter des armures aux 
sessions Pro Tools. Ces armures peuvent être 
importées et exportées avec les données MIDI. 
Cette fonctionnalité est particulièrement utile pour 
exporter des séquences MIDI vers des programmes 
de notation tels que Sibelius (reportez-vous à la 
section « Exportation de fichiers Sibelius » à la 
page 351). L'armure par défaut est do majeur.

Règle d'armure
La règle d'armure permet d'ajouter, de modifier et 
de supprimer des armures. Les armures permettent 
d'indiquer les tonalités et les changements de 
tonalité utilisés dans une session Pro Tools. Elles 
s'utilisent également pour certaines fonctions 
diatoniques (par exemple, pour la transposition de 
tonalité ou pour restreindre les hauteurs à la 
tonalité spécifiée).

Pour afficher la règle d'armure, effectuez l'une des 
opérations suivantes :

 Sélectionnez View > Rulers > Key Signature.

 Dans le sélecteur de vue de règle de la fenêtre 
Edit, sélectionnez Key.

Vous pouvez également afficher ou masquer la 
portée de la règle d'armure.

Pour afficher la portée de la règle d'armure :

1 Affichez la règle d'armure.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez View > Rulers > Key Signature 

Staff.

• Cliquez sur le triangle d'affichage/masquage de 
la règle d'armure.

Boîte de dialogue Renumber Bars

Règle d'armure
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Modification des armures
Vous pouvez ajouter, modifier et supprimer des 
armures.

Pour ajouter une armure :

1 Positionnez le curseur à l'emplacement de la 
timeline auquel vous souhaitez ajouter une 
armure.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Event > Add Key Change.

• Cliquez sur le bouton plus (+) de la règle d'armure.

3 Dans la boîte de dialogue Key Change, 
sélectionnez le mode (majeur ou mineur), 
la tonalité, l'emplacement et la plage, puis 
indiquez la façon dont le changement doit 
affecter les pistes harmoniques.

4 Cliquez sur OK.

Pour modifier une armure :

1 Double-cliquez sur le marqueur d'armure sur la 
règle d'armure.

2 Effectuez les modifications dans la boîte de 
dialogue Key Change.

3 Cliquez sur OK.

Pour supprimer une armure, effectuez l'une des 
opérations suivantes :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le marqueur 
d'armure sur la règle d'armure.

 Sur la règle d'armure, créez une sélection 
contenant l'armure à supprimer, puis 
sélectionnez Edit > Clear ou appuyez sur la 
touche Suppr.

Boîte de dialogue Key Change
La boîte de dialogue Key Change permet de 
spécifier le mode (majeur ou mineur), la tonalité 
(entre sept dièses et sept bémols), la plage affectée 
(par exemple, de la première mesure au prochain 
changement de tonalité) et si les notes MIDI des 
pistes harmoniques doivent être transposées ou 
restreintes à la tonalité (reportez-vous à la section 
« Pistes harmoniques » à la page 832). La boîte de 
dialogue Key Change s'ouvre chaque fois que vous 
ajoutez ou modifiez un marqueur d'armure.

Major Keys : affiche les tonalités majeures (de sept 
bémols à sept dièses).

Minor Keys : affiche les tonalités mineures 
(de sept bémols à sept dièses). Pro Tools applique 
uniquement le mode mineur naturel.

Sharps : permet de sélectionner une tonalité en 
dièse entre les sept dièses et le do majeur (ou le 
la mineur).

Flats : permet de sélectionner une tonalité en 
bémol entre les sept bémols et le do majeur (ou le 
la mineur).

From : permet d'indiquer l'emplacement du 
marqueur d'armure en Bars|Beats.

Boîte de dialogue Key Change
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To : permet de spécifier à quel emplacement 
le changement de tonalité doit être appliqué : 
au prochain marqueur d'armure, sur une sélection 
ou jusqu'à la fin de la session.

Snap To Bar : permet d'aligner le marqueur 
d'armure sur la barre de mesure.

Edit Pitched Tracks : permet de transposer vers le 
haut ou le bas les notes MIDI existantes des pistes 
harmoniques, de manière diatonique ou chromatique 
(suivant le changement de tonalité) ou de restreindre 
les hauteurs à la nouvelle tonalité. Pour plus 
d'informations les pistes harmoniques, reportez-vous 
à la section « Pistes harmoniques » à la page 832.

Transpose : si l'option Edit Pitched Tracks est 
activée, vous pouvez transposer vers le haut ou le bas 
les notes MIDI existantes des pistes harmoniques, 
de manière diatonique ou chromatique. Par exemple, 
si la session est en do majeur et si vous ajoutez un 
changement de tonalité vers ré mineur, sélectionnez 
Edit Pitched Tracks, Transpose, Up et Diatonically 
pour transposer les notes des pistes harmoniques d'un 
ton vers le haut et abaisser d'un demi-ton la tierce, 
la sixte et la septième. La séquence do, ré, mi est 
transposée en ré, mi, fa (naturelle, et non dièse, 
comme c'est le cas pour une transposition 
chromatique). 

Lors de la transposition diatonique, les notes 
chromatiques sont conservées lors d'un changement 
de tonalité. Par exemple, lors d'un changement de 
tonalité de do majeur en mi majeur, la note si bémol 
devient un ré naturel. Vous pouvez dès lors 
conserver les « blue notes » lors d'un changement de 
tonalité impliquant une transposition diatonique.

Constrain Pitches To Key : si l'option Edit 
Pitched Tracks est activée, vous pouvez restreindre 
les hauteurs aux notes de la nouvelle tonalité. Si les 
hauteurs diatoniques de l'ancienne tonalité ne se 
trouvent pas dans la nouvelle tonalité, elles sont 
transposées individuellement vers la hauteur 
diatonique la plus proche. Par exemple, si vous 
remplacez la tonalité do majeur par ré majeur, 
la séquence do, ré, mi, fa, sol devient une séquence 
en do dièse, ré, mi, fa dièse et sol.

La restriction des hauteurs à la tonalité entraîne 
également une restriction des hauteurs chromatiques 
à la nouvelle échelle diatonique. Par exemple, 
si vous changez la tonalité do majeur en ré majeur, 
la séquence do, ré, ré dièse, mi devient une séquence 
en do dièse, ré, ré et mi.

Pistes harmoniques
Les pistes harmoniques sont des pistes MIDI 
ou d'instrument pouvant être affectées par les 
transpositions liées aux changements de tonalité 
(y compris la restriction à une tonalité). 
Par défaut, les pistes MIDI et d'instrument sont 
« harmoniques ». Toutefois, si certaines pistes 
MIDI ou d'instrument sont assignées à des boîtes 
à rythmes ou à des échantillonneurs, elles ne 
doivent pas être affectées par les changements de 
tonalité en raison des assignations de note. Pour 
verrouiller ces pistes lors de l'application d'un 
changement de tonalité, désactivez l'option Pitched.
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Pour activer (ou désactiver) l'option Pitched d'une 
piste :

 Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez (ou désélectionnez) l'option Pitched.

Importation d'armures
Lors de l'importation de données MIDI (ou de 
données de session comportant des données 
MIDI), vous pouvez choisir d'importer ou non les 
armures contenues dans les fichiers MIDI.

Importation MIDI

La boîte de dialogue Import MIDI contient l'option 
Import Key Signature from MIDI File. Si cette 
option est sélectionnée, les armures existantes sont 
importées dans Pro Tools en même temps que les 
autres données MIDI.

Importation des données de session

La boîte de dialogue Import Session Data contient 
l'option Import Key Signature/Chord Map. Lorsque 
cette option est activée, les armures et les marqueurs 
d'accord (le cas échéant) sont importés avec les 
données de session dans la session actuelle.

Symboles d'accord
La règle de symboles d'accord permet d'ajouter des 
symboles d'accord aux sessions Pro Tools dans la 
fenêtre Edit et les fenêtres de l'éditeur MIDI. Vous 
pouvez également ajouter des symboles d'accord et 
des diagrammes dans l'éditeur de partition 
Reportez-vous à la section « Symboles et 
diagrammes d'accord » à la page 773.

Les symboles d'accord n'ont aucun effet sur les 
données MIDI. De plus, les symboles d'accord ne 
sont pas inclus lors de l'exportation des données 
MIDI de Pro Tools vers un fichier MIDI, mais ils 
sont inclus lors de l'exportation vers un fichier 
Sibelius (.sib) ou de l'utilisation de la commande 
Send to Sibelius.

Option Pitched activée dans le sélecteur de playlist

Boîte de dialogue Midi Import Options

Importation de données de session
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Règle de symboles d'accord
La règle de symboles d'accord permet d'ajouter, 
de modifier et de supprimer des symboles 
d'accord. Les symboles d'accord permettent 
d'indiquer les changements d'accord utilisés dans 
une session Pro Tools. 

Pour afficher la règle de symboles d'accord, 
effectuez l'une des opérations suivantes :

 Sélectionnez View > Rulers > Chord Symbols.

 Dans le sélecteur de vue de règle de la fenêtre 
Edit ou dans une fenêtre de l'éditeur MIDI, 
sélectionnez Chords.

Pour insérer un symbole d'accord :

1 Positionnez le curseur à l'emplacement de la 
timeline où vous souhaitez ajouter un symbole 
d'accord.

2 Effectuez l'une des opérations suivantes :

• Placez le curseur sur la timeline, puis cliquez sur 
le bouton Plus (+) de la règle d'accord.

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et déplacez le curseur sur la 
règle d'accord (le curseur prend la forme d'une 
Main accompagnée du signe +) et cliquez 
à l'emplacement où vous souhaitez placer le 
symbole d'accord.

3 Dans la boîte de dialogue Chord Change, 
sélectionnez le nom de la note fondamentale de 
l'accord, la qualité, la note de basse et le diagramme 
de l'accord (les diagrammes d'accord sont affichés 
uniquement dans l'éditeur de partition).

4 Cliquez sur OK.

Pour modifier un symbole d'accord :

1 Double-cliquez sur le marqueur de symbole 
d'accord sur la règle de symboles d'accord.

2 Effectuez les modifications dans la boîte de 
dialogue Chord Change.

3 Cliquez sur OK.

Pour déplacer un symbole d'accord :

 Faites glisser le marqueur de symbole d'accord 
vers un nouvel emplacement de la timeline.

Pour supprimer un symbole d'accord, effectuez 
l'une des opérations suivantes :

 Cliquez sur le marqueur de symbole d'accord 
sur la règle d'accord en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée.

 Sur la règle d'accord, créez une sélection 
contenant les symboles d'accord à supprimer, 
puis sélectionnez Edit > Clear ou appuyez sur la 
touche Suppr.

Règle des symboles d'accord

Règle d'accord
Ajouter un symbole d'accord

Marqueurs de symbole d'accord
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Boîte de dialogue Chord Change
La boîte de dialogue Chord Change permet de 
spécifier un symbole et un diagramme d'accord 
(tablature) à insérer sur la règle d'accord ou la 
partition dans l'éditeur de partition. La boîte de 
dialogue Chord Change s'ouvre chaque fois que 
vous ajoutez ou modifiez un marqueur d'accord.

Chord : sélectionnez le nom de la note 
fondamentale de l'accord (ré, par exemple).

Chord Quality : sélectionnez la qualité de l'accord 
à partir du sélecteur (majeur ou mineur).

Bass : sélectionnez la note de basse de l'accord 
(si bémol pour un accord en sol mineur en premier 
renversement).

Chord Diagram : sélectionnez le diagramme 
d'accord pour la tablature de guitare.

Boîte de dialogue Chord Change

Sélecteur 
d'accord

Sélecteur de 
qualité d'accord

Sélecteur de 
note de basse

Diagrammes d'accords

Pour afficher ou masquer les symboles et 
diagrammes d'accord dans l'éditeur de 
partition, sélectionnez ou désélectionnez 
l'option correspondante dans la boîte de 
dialogue Score Setup.
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Chapitre 36 : Emplacements mémoire

Les emplacements mémoire constituent une méthode 
de navigation dans votre session particulièrement 
utile pour l'édition et l'arrangement. 

Chaque session peut mémoriser jusqu'à 
999 emplacements mémoire, qui peuvent servir 
à rappeler :

• Des marqueurs indiquant les emplacements 
importants de la session ;

• Des sélections d'édition sur une ou plusieurs 
pistes ;

• Des plages d'enregistrement et de lecture, avec 
les valeurs de pré et de post-roll ;

• Des paramètres des pistes, y compris le statut 
Afficher/Masquer, la hauteur de piste et les 
valeurs de zoom ;

• L'activation de groupes d'édition et de mixage ;

• Des configurations de fenêtres.

Les emplacements mémoire sont affichés et triés 
dans la fenêtre Memory Locations, à partir de 
laquelle vous pouvez les rappeler d'un simple clic.

Création d'emplacements 
mémoire
Plusieurs méthodes de création d'emplacements 
mémoire sont disponibles selon leur type :

Emplacement mémoire de type marqueur : 
renvoie à un point spécifique dans la timeline.

Emplacement mémoire de sélection : renvoie 
à une sélection d'édition.

Emplacement mémoire des propriétés 
générales : renvoie à une combinaison de 
paramètres de session (tels que les paramètres de 
zoom, les valeurs de pré et post-roll, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage).

Lorsque vous créez un emplacement mémoire, 
le numéro disponible suivant lui est attribué 
(de 1 à 999). Ce numéro sert à rappeler 
l'emplacement mémoire depuis le pavé numérique.
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Pour créer un emplacement mémoire de type 
marqueur :

1 Configurez les paramètres de la session que vous 
sauvegarderez avec l'emplacement mémoire de 
type marqueur, tels que les paramètres de zoom, 
le statut d'affichage/masquage des pistes, les 
hauteurs de pistes et l'activation des groupes 
d'édition et de mixage.

2 Si nécessaire, activez Options > Link Timeline 
and Edit Selection.

3 Assurez-vous que la règle des marqueurs est 
affichée (View > Rulers > Markers).

4 Effectuez l'une des opérations suivantes :

• Avec le Sélecteur, cliquez sur une piste ou une 
règle à l'emplacement où vous souhaitez placer le 
marqueur. Pour placer un marqueur au début d'un 
clip sélectionnez le clip à l'aide de l'outil de saisie 
du temps. Cliquez sur le bouton Add 
Marker/Memory Location (ou appuyez sur la 
touche Entrée du pavé numérique).

• Tout en appuyant sur la touche Démarrer 
(Windows) ou Ctrl (Mac), déplacez le curseur 
sur la règle des marqueurs (le curseur prend la 
forme d'une Main accompagnée du signe plus 
« + ») et cliquez à l'emplacement où vous 
souhaitez placer le marqueur.

5 Dans la boîte de dialogue New Memory Location, 
sélectionnez l'option Marker et définissez la 
référence sur Bar|Beat ou Absolute.

6 Entrez le nom du nouveau marqueur et 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec le marqueur.

7 Cliquez sur OK. Le marqueur est créé et 
apparaît sur la règle des marqueurs, ainsi que 
dans la fenêtre Memory Locations.

Pour créer un emplacement mémoire de 
sélection :

1 Configurez les paramètres de la session que vous 
sauvegarderez avec l'emplacement mémoire des 
propriétés générales, tels que les paramètres de 
zoom, le statut d'affichage/masquage des pistes, 
les hauteurs de pistes et l'activation des groupes 
d'édition et de mixage.

2 Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Entrée du pavé numérique.

• Dans menu de la fenêtre Memory Locations, 
cliquez sur Add Memory Location.

4 Dans la boîte de dialogue New Memory 
Location, sélectionnez l'option Selection et 
définissez sa référence sur Bar|Beat ou Absolute.

5 Entrez le nom du nouvel emplacement mémoire 
et sélectionnez les propriétés générales que 
vous voulez sauvegarder.

6 Cliquez sur OK. L'emplacement mémoire de 
sélection est créé et apparaît dans la fenêtre 
Memory Locations.

Bouton d'ajout de marqueur/emplacement mémoire

Insertion manuelle d'un marqueur
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Pour créer un emplacement mémoire des 
propriétés générales :

1 Configurez les paramètres de la session que vous 
sauvegarderez avec l'emplacement mémoire des 
propriétés générales, tels que les paramètres de 
zoom, le statut d'affichage/masquage des pistes, 
les hauteurs de pistes et l'activation des groupes 
d'édition et de mixage.

2 Appuyez sur la touche Entrée du pavé numérique.

3 Dans la boîte de dialogue Memory Location, 
sélectionnez l'option None.

4 Entrez le nom du nouvel emplacement mémoire 
et sélectionnez les propriétés générales que 
vous voulez sauvegarder.

5 Cliquez sur OK. L'emplacement mémoire des 
propriétés générales est créé et apparaît dans la 
fenêtre Memory Locations.

Création d'emplacements 
mémoire en cours de lecture
Lorsque l'option Auto-Name Memory Locations 

When Playing est activée dans la page des 
préférences d'édition, vous pouvez créer des 
emplacements mémoire en cours de lecture sans 
ouvrir la boîte de dialogue New Memory Location. 
Cette option peut également être sélectionnée 
à partir du menu de la fenêtre Memory Locations.

Cette fonction est utile lorsque vous voulez 
marquer certains emplacements tout en écoutant 
une passe d'enregistrement, ou marquer certaines 
images lors du visionnage d'une scène vidéo.

Pour créer un marqueur en cours de lecture :

1 Dans le menu de la fenêtre Memory Locations, 
sélectionnez Default To Marker. Tous les 
nouveaux emplacements mémoire seront ainsi 
des marqueurs par défaut.

2 Dans le menu de la fenêtre Memory Locations, 
sélectionnez Auto-Name Memory Locations.

3 Pour que les marqueurs insérés aient une 
référence Bar|Beat, veillez à définir l'échelle 
temporelle principale sur Bars|Beats.

4 Cliquez sur le bouton Play de la fenêtre de 
transport.

5 Lorsque l'emplacement est atteint, appuyez 
sur la touche Entrée du pavé numérique. 
Un marqueur est créé automatiquement et 
apparaît sur la règle des marqueurs.

Les marqueurs créés automatiquement sont 
nommés « Marker 1 », « Marker 2 » et 
« Marker 3 » selon une suite croissante.

Dans la boîte de dialogue New Memory 
Location, vous pouvez cliquer sur n'importe 
quelle propriété générale tout en maintenant la 
touche Alt (Windows) ou Option (Mac) enfoncée 
afin d'activer ou de désactiver toutes les 
propriétés. Vous pouvez également cliquer sur 
une propriété en appuyant sur Ctrl (Windows) ou 
Commande (Mac) pour changer son état et celui 
de toutes les autres propriétés générales.
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Lorsque l'option Default To Marker est 
désélectionnée, les nouveaux emplacements 
mémoire seront par défaut identiques au dernier 
type créé. Ainsi, si le dernier emplacement 
mémoire créé était une sélection, le nouvel 
emplacement mémoire créé au cours de la lecture 
sera également de type sélection. Dans ce cas, 
le nom de l'emplacement mémoire créé est basé 
sur le début de la sélection d'édition, en reprenant 
le format de l'échelle temporelle principale (tel que 
« 2|2|305 » ou « 0:02.658 »).

Propriétés des 
emplacements mémoire
Lorsque vous créez un emplacement mémoire 
(reportez-vous à la section « Création 
d'emplacements mémoire » à la page 837), vous 
êtes invité à définir ses propriétés temporelles (Time 
Properties) et générales (General Properties).

Propriétés temporelles
Sous Time Properties, vous pouvez définir un 
emplacement mémoire sur Marker, Selection ou 
None. Ce choix détermine le type d'emplacement 
mémoire créé. Chacun de ces trois types 
d'emplacement mémoire peut également 
enregistrer n'importe quelle combinaison de 
propriétés générales.

Lorsque l'option Use Separate Play and Stop 
Keys est sélectionnée dans la page Operation 
Preferences, la touche Entrée ne permet plus 
d'ajouter des marqueurs d'emplacements 
mémoire. Pour effectuer cette opération, 
vous devez d'abord appuyer sur le point (.), 
puis sur la touche Entrée du pavé numérique. 
Le nouveau marqueur apparaît lorsque vous 
appuyez sur la touche Entrée.

Fenêtre Memory Locations



Chapitre 36 : Emplacements mémoire 841

Marker : rappelle un emplacement de timeline, dont 
la référence peut être de type Bar|Beat 
(mesures/temps, basée sur les références de tempo) 
ou absolue (basée des échantillons). Lorsque vous 
rappelez un emplacement mémoire de type Marker, 
le curseur de lecture se place à l'emplacement du 
marqueur, et les heures de début et de fin de la 
fenêtre de transport sont également mises à jour. 
Si les sélections d'édition et de timeline sont 
couplées, le curseur d'édition se déplace également 
sur l'emplacement du marqueur.

Les marqueurs apparaissent sur la règle des 
marqueurs avec une fine ligne jaune qui s'étend sur 
toutes les pistes de la fenêtre Edit, pour vous aider 
à réorganiser et à aligner le contenu des pistes. 
Cliquer sur un marqueur sur la règle des marqueurs 
rappelle son emplacement et ses propriétés générales.

Selection : rappelle un emplacement de sélection 
d'édition ou de curseur d'édition, dont la référence 
peut être de type Bar|Beat (mesures/temps, basée 
sur les références de tempo) ou absolue (basée des 
échantillons). Un emplacement mémoire de type 
Selection permet de mémoriser des sélections 
d'édition, sur une ou plusieurs pistes, fréquemment 
utilisées pendant une session. Si les sélections 
d'édition et de timeline sont liées, un emplacement 
mémoire de sélection peut aussi rappeler des 
plages d'enregistrement et de lecture.

None : ne rappelle aucune propriété temporelle et 
est donc appelé emplacement mémoire de 
propriétés générales.

Références Bar|Beat et absolue

Le menu Reference détermine si l'emplacement 
mémoire de type marqueur ou sélection se réfère 
à une valeur Bar|Beat ou absolue. Si vous 
sélectionnez l'option Bar|Beat, l'emplacement 
mémoire est basé sur des références de tempo. 
Autrement dit, l'expression de son emplacement en 
mesures/temps demeure constante, même si vous 
modifiez le tempo. En revanche, sa relation à la 
position absolue de l'échantillon change en 
conséquence.

Si vous sélectionnez l'option Absolute, 
l'emplacement mémoire est exprimé en 
échantillons. Autrement dit, son emplacement 
exprimé en mesures/temps change dès qu'on 
modifie le tempo. En revanche, la relation aux 
données audio, elles aussi basées sur les 
échantillons, n'est pas altérée.

Dans la règle des marqueurs, les marqueurs de type 
Bar|Beat s'affichent sous la forme d'écussons 
jaunes, tandis que les marqueurs absolus prennent 
la forme de losanges jaunes.

Marqueurs sur la règle des marqueurs

Seules des sélections contiguës peuvent être 
sauvegardées avec des emplacements 
mémoire. Les sélections non contiguës, 
effectuées avec l'outil de saisie d'objet, seront 
rappelées comme si la sélection avait été faite 
avec l'outil de saisie du temps.

Marqueur Bar|Beat (à gauche) et marqueur absolu 
(à droite)
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Propriétés générales
Les trois types d'emplacement mémoire (Marker, 
Selection et None) peuvent stocker et rappeler 
n'importe quelle combinaison des propriétés 
générales suivantes :

Number : la modification du numéro permet de 
remplacer un emplacement mémoire ou de 
modifier l'ordre des emplacements mémoire dans 
la fenêtre Memory Locations.

Name : sélectionnez un nom explicite pour chaque 
emplacement de mémoire.

Zoom Settings : rappelle les valeurs de zoom 
horizontal, audio et MIDI pour les pistes audio, 
MIDI et Instrument.

Pre/Post Roll Times : rappelle les valeurs de pré et 
de post-roll (mais pas l'éventuelle activation des 
fonctions correspondantes). Cette propriété peut 
être stockée avec un emplacement mémoire de 
sélection pour rappeler des plages d'enregistrement 
et de lecture avec des valeurs de pré/post-roll.

Track Show/Hide : rappelle quelles pistes sont 
masquées. Cette propriété vous permet d'afficher 
des groupes de pistes pour l'édition et le mixage.

Track Heights : rappelle toutes les hauteurs de 
pistes. Utilisez cette option avec l'option Zoom 
Settings pour rappeler des environnements 
d'édition adaptés à des tâches particulières, comme 
l'édition jusqu'au niveau de l'échantillon ou le trim 
de notes MIDI.

Group Enables : rappelle quels groupes d'édition 
et de mixage sont actifs. Cette option est utile pour 
rappeler des groupes pour des tâches particulières 
d'édition et de mixage, telles que le mute de toutes 
les pistes de batterie ou l'atténuation d'une paire 
stéréo.

Window Configuration : permet de rappeler une 
configuration de fenêtre spécifique. Cette option 
s'utilise pour rappeler une configuration de fenêtre 
adaptée aux tâches d'édition ou de mixage. Pour 
plus d'informations sur les configurations de 
fenêtres, reportez-vous à la section 
« Configurations de fenêtres » à la page 189.

Commentaires
Les trois types d'emplacement mémoire (Marker, 
Selection et None) peuvent stocker et rappeler des 
commentaires. Vous pouvez entrer un maximum 
de 255 caractères pour décrire un emplacement 
mémoire. Vous avez également la possibilité 
d'éditer les commentaires précédemment saisis.

Si vous utilisez VENUE Link pour 
l'interopérabilité entre Pro Tools et une 
console Avid VENUE, des options 
supplémentaires sont disponibles. Pour plus 
d'informations, reportez-vous au Guide de 
l'enregistrement live VENUE.

Reportez-vous aux sections « Création 
d'emplacements mémoire » à la page 837 et 
« Édition des emplacements mémoire » à la 
page 843 pour plus d'informations.



Chapitre 36 : Emplacements mémoire 843

Rappel d'emplacements 
mémoire
Vous pouvez rappeler des emplacements mémoire 
à partir de la fenêtre Memory Locations et du pavé 
numérique. De plus, les marqueurs d'emplacement 
mémoire peuvent être rappelés d'un simple clic sur 
la règle des marqueurs.

Pour rappeler un emplacement mémoire :

1 Sélectionnez Window > Memory Locations pour 
afficher la fenêtre Memory Locations.

2 Si vous rappelez un emplacement mémoire de 
sélection qui définit une plage d'enregistrement ou 
de lecture, assurez-vous que Options > Link 

Timeline and Edit Selection est sélectionné.

3 Effectuez l'une des opérations suivantes :

• Cliquez sur l'emplacement mémoire désiré dans 
la fenêtre Memory Locations pour le rappeler.

• Lorsque le mode du pavé numérique est réglé sur 
Classic, appuyez sur le numéro de l'emplacement 
mémoire suivi de la touche point (.). 

• Lorsque le mode du pavé numérique est réglé 
sur Transport ou Shuttle, appuyez sur la touche 
point (.), sur le numéro de l'emplacement 
mémoire, puis à nouveau sur la touche point (.).

Pour rappeler un marqueur depuis la règle des 
marqueurs :

1 Sélectionnez View > Rulers > Markers pour 
afficher la règle des marqueurs.

2 Cliquez sur le marqueur de votre choix. 
Le curseur de lecture se positionne sur le 
marqueur et les propriétés générales stockées 
avec le marqueur sont rappelées.

Édition des emplacements 
mémoire
Les emplacements mémoire peuvent être 
renommés, édités, supprimés, copiés et collés.

Pour renommer un emplacement mémoire :

1 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, double-
cliquez sur l'emplacement mémoire pour ouvrir 
la boîte de dialogue Edit Memory Location.

• Sur la règle des marqueurs, double-cliquez sur le 
marqueur pour ouvrir la boîte de dialogue Edit 
Memory Location et repositionner le point 
d'insertion à l'emplacement du marqueur.

• Sur la règle des marqueurs, maintenez la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée et 
cliquez sur le marqueur pour ouvrir la boîte de 
dialogue Edit Memory Location sans positionner 
le point d'insertion à l'emplacement du marqueur.

2 Saisissez le nouveau nom de l'emplacement 
mémoire, puis cliquez sur OK.

Pour redéfinir les propriétés générales 
mémorisées dans un emplacement mémoire :

1 Configurez les paramètres de la session tels que 
les paramètres de zoom, les valeurs de pré et 
de post-roll, le statut d'affichage/masquage des 
pistes, les hauteurs de pistes et l'activation 
des groupes.

2 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, double-
cliquez sur l'emplacement mémoire pour ouvrir 
la boîte de dialogue Edit Memory Location.

Si vous rappelez un emplacement mémoire 
à partir du pavé numérique, il n'est pas nécessaire 
que la fenêtre Memory Locations soit ouverte.

Même si la règle des marqueurs n'est pas 
affichée, vous pouvez rappeler des marqueurs 
à partir de la fenêtre Memory Locations ou 
à partir du pavé numérique.
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• Sur la règle des marqueurs, double-cliquez sur le 
marqueur pour ouvrir la boîte de dialogue Edit 
Memory Location et repositionner le point 
d'insertion à l'emplacement du marqueur.

• Sur la règle des marqueurs, maintenez la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée et 
cliquez sur le marqueur pour ouvrir la boîte de 
dialogue Edit Memory Location sans positionner 
le point d'insertion à l'emplacement du marqueur.

3 Dans la boîte de dialogue Memory Locations, 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec l'emplacement mémoire.

4 Saisissez un nom pour l'emplacement mémoire, 
puis cliquez sur OK.

Pour modifier le type d'un emplacement mémoire :

1 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, double-
cliquez sur l'emplacement mémoire pour ouvrir 
la boîte de dialogue Edit Memory Location.

• Sur la règle des marqueurs, double-cliquez sur le 
marqueur pour ouvrir la boîte de dialogue Edit 
Memory Location et repositionner le point 
d'insertion à l'emplacement du marqueur.

• Sur la règle des marqueurs, maintenez la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée et 
cliquez sur le marqueur pour ouvrir la boîte de 
dialogue Edit Memory Location sans positionner 
le point d'insertion à l'emplacement du marqueur.

2 Dans la boîte de dialogue Memory Location, 
sélectionnez le type d'emplacement mémoire 
Marker, Selection ou None. 

3 Saisissez un nom pour l'emplacement mémoire, 
puis cliquez sur OK.

Pour modifier la sélection mémorisée dans un 
emplacement mémoire :

1 Sélectionnez View > Rulers > Markers pour 
afficher la règle des marqueurs.

2 Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3 Dans la fenêtre Memory Locations, cliquez 
avec le bouton droit de la souris (Windows) ou 
en maintenant la touche Ctrl enfoncée (Mac) sur 
l'emplacement mémoire à redéfinir.

4 Saisissez un nom pour l'emplacement mémoire, 
puis cliquez sur OK.

Pour déplacer un marqueur en faisant glisser 
votre souris :

 Sur la règle des marqueurs, faites glisser le 
marqueur vers la gauche ou la droite.

Lorsque le mode d'édition est réglé sur Grid, 
l'événement déplacé s'aligne sur la valeur de grille 
actuelle. En mode Spot, la boîte de dialogue Spot 
s'ouvre.

Pour aligner un marqueur sur un autre emplacement :

1 Si nécessaire, sélectionnez Options > Link 
Timeline and Edit Selection.

2 Effectuez l'une des opérations suivantes :

• Sur n'importe quelle règle de base de temps, cliquez 
avec le Sélecteur au nouvel emplacement.

• Cliquez dans la playlist de n'importe quelle 
piste. Pour aligner le marqueur sur le début d'un 
clip, sélectionnez le clip avec l'outil de saisie du 
temps.

3 Dans la fenêtre Memory Locations ou la règle 
des marqueurs, cliquez sur l'emplacement 
mémoire de type marqueur que vous voulez 
redéfinir en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée.

4 Saisissez un nom pour le marqueur, puis cliquez 
sur OK.
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Suppression d'emplacements 
mémoire
Pour supprimer un emplacement mémoire, 
effectuez l'une des opérations suivantes :

 Sélectionnez l'emplacement mémoire, puis 
sélectionnez Delete Memory Location dans le 
menu de la fenêtre Memory Locations.

 Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire en maintenant la touche 
Alt (Windows) ou Option (Mac) enfoncée.

Pour supprimer tous les emplacements mémoire, 
effectuez l'une des opérations suivantes :

 Sélectionnez Delete All dans le menu de la 
fenêtre Memory Locations.

 Cliquez sur un emplacement mémoire dans la 
fenêtre Memory Locations en maintenant 
enfoncées les touches Alt+Maj (Windows) ou 
Option+Maj (Mac).

Pour supprimer un marqueur de la règle des 
marqueurs :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un marqueur.

Copie d'emplacements 
mémoire de type marqueur
Pour copier et coller plusieurs marqueurs :

1 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

2 Déplacez-vous sur la règle de tempo pour 
sélectionner les mesures de façon à inclure les 
marqueurs.

Si le début de la sélection inclut un marqueur, 
appuyez sur Ctrl (Windows) ou Commande (Mac) 
pour faire apparaître le Sélecteur.

3 Sélectionnez Edit > Copy.

4 Cliquez sur la règle des marqueurs à l'endroit où 
vous souhaitez coller les événements de tempo.

5 Sélectionnez Edit > Paste. Le contenu du presse-
papiers est collé à partir du point d'insertion et 
remplace les marqueurs existants.

Pour étendre une sélection d'édition d'une piste à 
la règle des marqueurs :

1 À l'aide du Sélecteur ou de la Main, 
sélectionnez une plage de piste.

2 Cliquez sur la règle des marqueurs tout en 
appuyant sur Maj. 

Cliquez de nouveau sur la règle des marqueurs tout 
en appuyant sur Maj pour retirer la plage de la 
sélection.

Pour sélectionner tous les marqueurs de la règle 
des marqueurs :

 Double-cliquez avec le Sélecteur sur la règle 
des marqueurs.

Appuyez sur Alt (Windows) ou Option (Mac) 
tout en déplaçant le curseur pour effectuer la 
sélection dans toutes les pistes du chef 
d'orchestre.
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Fenêtre Memory Locations
La fenêtre Memory Locations répertorie les 
emplacements mémoire en indiquant leur numéro, 
leur nom ainsi que les icônes des filtres d'affichage. 
Cette fenêtre permet de rappeler et de modifier les 
emplacements.

Pour rappeler un emplacement mémoire à partir de 
la fenêtre Memory Locations :

 Cliquez sur l'emplacement mémoire.

Commandes et options des 
emplacements mémoire
Vous pouvez sélectionner les options d'affichage 
et de tri, ainsi que les commandes permettant de 
créer et de supprimer des emplacements mémoire, 
à partir du menu de la fenêtre Memory Locations.

Sous-menu View Filter : regroupe les commandes 
permettant d'afficher ou de masquer les différentes 
propriétés d'emplacement mémoire :

• Show Icons

• View Markers

• View Selections

• View Locations with Zoom Info

• View Locations with Pre/Post Roll Info

• View Locations with Track Show/Hide Info

• View Locations with Track Height Info

• View Locations with Group Info

• View Locations with Window Configuration 
Info 

• Show Markers Only

• View All

Fenêtre Memory Locations et icônes des filtres 
d'affichage

Lorsque le mode du pavé numérique est réglé 
sur Classic, appuyez sur le numéro de 
l'emplacement mémoire suivi de la touche 
point (.). Lorsque le mode du pavé numérique 
est réglé sur Transport ou Shuttle, appuyez sur 
la touche point (.), sur le numéro de 
l'emplacement mémoire, puis à nouveau sur la 
touche point (.).

Menu de la fenêtre Memory Locations
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Show Main Counter : lorsque cette option est 
sélectionnée, une colonne apparaît dans la fenêtre 
Memory Locations afin d'afficher les 
emplacements par rapport à l'échelle temporelle 
principale (pour les marqueurs) et les temps de 
début des emplacements mémoire de sélection. 
Les emplacements mémoire des propriétés 
générales n'affichent rien dans cette colonne.

Pour accéder au menu déroulant permettant de 
modifier l'échelle temporelle principale, cliquez 
sur la partie supérieure de la colonne Main Time 
Scale.

Show Sub Counter : lorsque cette option est 
sélectionnée, une colonne apparaît dans la fenêtre 
Memory Locations afin d'afficher les 
emplacements par rapport à l'échelle temporelle 
secondaire (pour les marqueurs) et les points de 
début des emplacements mémoire de sélection. 
Les emplacements mémoire des propriétés 
générales n'affichent rien dans cette colonne.

Pour accéder au menu déroulant permettant de 
modifier l'échelle temporelle secondaire, cliquez 
sur la partie supérieure de la colonne Sub Time 
Scale.

Show Comments : lorsque cette option est 
sélectionnée, une colonne apparaît dans la fenêtre 
Memory Locations afin d'afficher les 
commentaires de chacun des marqueurs.

Sort by Time : lorsque cette option est 
sélectionnée, les marqueurs sont triés selon leur 
ordre dans la timeline, suivis des emplacements 
mémoire de sélection et de propriétés générales, 
classés par ordre de création.

Lorsque l'option Sort by Time est désélectionnée, 
tous les emplacements mémoire sont classés selon 
leur numéro.

New Memory Location : cette commande permet 
de créer un emplacement mémoire.

Edit <Nom> : permet d'accéder à la boîte de 
dialogue Edit Memory Location correspondant 
à l'emplacement mémoire sélectionné. Pour 
modifier un emplacement mémoire, vous pouvez 
également double-cliquer dans la fenêtre Memory 
Locations.

Clear <Nom> : efface l'emplacement mémoire 
sélectionné, sans le supprimer définitivement. 
Le numéro attribué aux emplacements mémoire 
suivants n'est pas modifié.

Compteurs principal et secondaire dans la fenêtre 
Memory Locations

Fenêtre Memory Locations, sélection de l'échelle 
temporelle principale

Échelle temporelle principale
Échelle temporelle secondaire

Commentaires dans la fenêtre Memory Locations

Pour supprimer un emplacement, cliquez 
dessus dans la fenêtre Memory Locations en 
maintenant enfoncée la touche Alt (Windows) 
ou Option (Mac).
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Delete All : supprime tous les emplacements 
mémoire. L'emplacement mémoire suivant est 
associé au numéro d'emplacement 1.

Insert Slot Before <Nom> : ajoute un 
emplacement mémoire vide au-dessus de 
l'emplacement sélectionné. Le numéro des 
emplacements suivants est mis à jour.

Delete <Nom> Slot : supprime l'emplacement 
mémoire sélectionné et met à jour le numéro des 
emplacements suivants.

Default To Marker : lorsque cette option est 
sélectionnée, les nouveaux emplacements 
mémoire créés sont des marqueurs par défaut, 
même si vous pouvez définir un autre type dans 
la boîte de dialogue New Memory Location.

Auto-Name Memory Location : lorsque cette 
option est sélectionnée, les emplacements 
mémoire sont créés automatiquement sans que 
la boîte de dialogue New Memory Location ne 
s'ouvre. Si l'option Default To Marker est 
sélectionnée, un emplacement mémoire de type 
marqueur est créé automatiquement. Sinon, le type 
d'emplacement mémoire est déterminé par le 
dernier type créé (Marker, Selection ou None).

Icônes des filtres d'affichage
Lorsque vous sélectionnez l'option Show Icons 
dans le menu déroulant Memory Locations, 
la fenêtre Memory Locations propose un filtre 
basé sur les icônes qui permet d'afficher ou de 
masquer les emplacements mémoire en fonction 
de leurs propriétés. 

Pour afficher ou masquer les emplacements 
mémoire contenant une propriété spécifique :

 Cliquez sur l'icône de recherche appropriée.

Couleurs et propriétés

Lorsqu'une icône d'affichage est active, elle 
apparaît en couleur. Lorsqu'elle est désactivée, elle 
apparaît en grisé.

Si une icône est désactivée (grisée), tous les 
emplacements mémoire associés à cette propriété 
sont masqués. Cependant, un emplacement mémoire 
qui contient d'autres propriétés correspondant à une 
icône encore active restera affiché. 

De plus, le filtre d'affichage est utile pour indiquer 
les propriétés stockées dans chaque emplacement 
mémoire (indiquées par une rangée d'icônes pour 
chaque emplacement mémoire).

Icônes des filtres d'affichage des emplacements 
mémoire

Marqueur Paramètres 
de zoom

Afficher/
Masquer

Hauteurs 
de piste

Configuration de 
fenêtre

Groupes actifsPré et post-roll

Emplacement 
mémoire de sélection
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Chapitre 37 : Organisation des clips

Une fois un clip créé, il apparaît dans la liste des 
clips. Vous pouvez le faire glisser de la liste vers 
une piste pour l'ajouter à un arrangement de clips 
existant, ou bien créer une piste pour y ajouter des 
clips un par un. Le placement exact des clips sur 
une piste dépend du mode d'édition actif, Shuffle, 
Slip, Spot ou Grid (reportez-vous à la section 
« Modes d'édition » à la page 543).

Placement de clips sur les 
pistes
Pour placer un clip sur une piste :

1 Dans la liste des clips, sélectionnez le ou les 
clips que vous souhaitez placer.

2 Faites glisser les clips sélectionnés de la liste 
des clips vers la position souhaitée sur la piste. 

Si vous faites glisser plusieurs clips, ils seront 
déposés sur des pistes adjacentes, de gauche 
à droite, ou sur plusieurs pistes de haut en bas 
en fonction de l'option Timeline Drop Order 
sélectionnée (reportez-vous à la section 
« Définition de l'ordre de placement sur la 
timeline » à la page 850). Si vous faites glisser un 
clip audio stéréo, il doit être placé sur une piste 
stéréo ou deux pistes mono.

Les clips sont placés en fonction du mode d'édition 
actuel :

• En mode Shuffle, les clips existants de la piste se 
décalent pour libérer la place nécessaire au 
nouveau clip.

• En mode Spot, vous êtes invité à saisir 
l'emplacement désiré pour le clip déplacé dans la 
boîte de dialogue Spot (reportez-vous à la 
section « Placement de clips en mode Spot » à la 
page 857). 

• En mode Grid, le clip déplacé s'aligne sur la 
limite de grille la plus proche.

• En mode Slip, les clips se placent exactement 
à l'endroit où ils sont déposés sur la piste de 
destination.

Vous pouvez rechercher un clip dans la liste 
des clips en saisissant les premières lettres de 
son nom (reportez-vous à la section 
« Sélection de clips au clavier » à la 
page 273).

Pour désactiver temporairement le mode 
Grid lorsque vous déplacez un clip par 
glisser-déposer, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée 
après avoir cliqué sur le bouton de la souris.
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Utilisation de plusieurs 
éléments de la liste des clips

Définition de l'ordre de 
placement sur la timeline
L'option Timeline Drop Order du menu de la liste 
des clips permet de déterminer si les pistes 
sélectionnées à partir de la liste des clips sont 
déposées les unes derrière les autres sur une seule 
piste ou si elles sont réparties sur plusieurs pistes :

Top to Bottom : lorsque cette option est activée, 
les clips sont répartis sur plusieurs pistes de 
destination ou sur de nouvelles pistes (lorsque 
vous les faites glisser en dessous de la dernière 
piste ou vers la liste des pistes). 

Left to Right : lorsque cette option est activée, 
les clips sont placés les uns derrière les autres sur 
une seule piste de destination ou sur une nouvelle 
piste (lorsque vous les faites glisser en dessous de 
la dernière piste ou vers la liste des pistes).

Pour définir l'ordre de placement des clips :

 Sélectionnez Clip List > Timeline Drop Order, 
puis Top to Bottom ou Left to Right. 

Glisser-déposer de plusieurs 
éléments depuis la liste des clips

Pour faire glisser, puis déposer plusieurs 
éléments de la liste des clips sur de nouvelles 
pistes :

1 Dans le menu de la liste des clips, sélectionnez 
Timeline Drop Order > Top to Bottom.

2 Triez la liste des clips pour configurer l'ordre de 
positionnement des éléments. 

3 Sélectionnez plusieurs éléments dans la liste des 
clips, puis effectuez l'une des opérations 
suivantes :

• Pour placer les clips à un endroit spécifique sur 
de nouvelles pistes, déposez-les à cet 
emplacement en dessous de la dernière piste. 

• Pour placer les clips en début de session sur de 
nouvelles pistes, déposez-les sur la liste des pistes. 

Pour placer plusieurs clips sur plusieurs pistes 
existantes :

1 Dans le menu de la liste des clips, sélectionnez 
Timeline Drop Order > Top to Bottom.

2 Sélectionnez plusieurs éléments de la liste des 
clips, puis déposez-les à l'endroit voulu dans 
la playlist d'une piste compatible. Lorsque 
le curseur est placé sur une destination 
compatible, les contours du clip s'affichent. 

Nouvelles pistes après avoir déposé plusieurs clips, 
l'ordre de placement sur la timeline étant défini de haut 
en bas
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Pour faire glisser, puis déposer plusieurs 
éléments de la liste des clips sur une seule piste : 

1 Dans le menu de la liste des clips, sélectionnez 
Timeline Drop Order > Left to Right.

2 Triez la liste des clips pour configurer l'ordre de 
positionnement des éléments. 

3 Sélectionnez plusieurs éléments dans la liste des 
clips, puis effectuez l'une des opérations 
suivantes :

• Pour placer le premier élément à l'endroit voulu 
sur une nouvelle piste, déposez-le dans la zone 
située en dessous de la dernière piste affichée 
dans la fenêtre Edit. 

• Pour placer le premier élément en début de 
session sur une nouvelle piste, déposez-le dans 
la liste des pistes. 

• Pour placer des éléments sur une piste existante, 
déposez-les sur la playlist d'édition de la piste. 

Si la sélection contient des clips de types différents 
(audio et MIDI ou groupes de clips et MIDI, 
par exemple), les pistes adéquates sont créées 
et chaque type est réparti sur les pistes 
correspondantes. De même, si la sélection contient 
plusieurs formats (mono, stéréo ou autres), 
des pistes sont créées pour chaque format et 
les clips sont placés sur les pistes qui leur 
correspondent. 

Placement de clips au point 
d'insertion d'édition
Vous pouvez faire glisser une piste de la liste des 
clips, d'une piste à une autre ou sur la même piste, 
puis aligner son point de début, de fin ou de 
synchronisation sur le point d'insertion d'édition. 
Cette technique est utile en post-production. 
En effet, elle permet de définir un point de 
sélection d'édition lors de la lecture ou à l'arrêt et 
de placer facilement des effets sonores au point 
d'insertion d'édition.

Pour placer le début d'un clip sur le point 
d'insertion d'édition :

1 Avec le Sélecteur, cliquez sur la piste, 
à l'emplacement temporel où vous souhaitez 
placer le début du clip. 

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et faites glisser le clip de la 
liste des clips, ou d'une autre piste, vers la piste 
de destination.

• Si la piste contient déjà ce clip, maintenez la 
touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et cliquez sur le clip à déplacer avec 
l'outil de saisie du temps.

Nouvelle piste après avoir déposé plusieurs clips, 
l'ordre de placement sur la timeline étant défini de la 
gauche vers la droite

Dans Pro Tools HD, lorsque l'option Scrolling 
est définie sur Center Playhead, les clips 
s'alignent sur la tête de lecture et non sur le 
point d'insertion d'édition.
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Pour placer la fin d'un clip sur le point d'insertion 
d'édition :

1 Avec le Sélecteur, cliquez sur la piste, 
à l'emplacement temporel où vous souhaitez 
placer la fin du clip. 

2 Effectuez l'une des opérations suivantes :

• Maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et faites glisser le clip de la liste des 
clips, ou d'une autre piste, vers la piste de 
destination.

• Si la piste contient déjà ce clip, maintenez 
les touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées et cliquez sur 
le clip à déplacer avec l'outil de saisie du temps.

Pour placer le point de synchronisation d'un clip 
sur le point d'insertion d'édition :

1 Avec le Sélecteur, cliquez sur la piste, 
à l'emplacement temporel où vous souhaitez 
placer le point de synchronisation du clip. 

2 Effectuez l'une des opérations suivantes :

• Maintenez les touches Démarrer+Maj 
(Windows) ou Ctrl+Maj (Mac) enfoncées et 
faites glisser le clip de la liste des clips, ou d'une 
autre piste, vers la piste de destination.

• Si la piste contient déjà ce clip, maintenez les 
touches Maj+Démarrer (Windows) ou Maj+Ctrl 
(Mac) enfoncées et cliquez sur le clip à déplacer 
avec l'outil de saisie du temps.

Alignement des points de 
début de clips
Vous pouvez aligner le point de début, de fin et de 
synchronisation d'un clip sur le début d'un autre 
clip d'une autre piste.

Pour aligner les points de début de clips de pistes 
différentes :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le clip sur lequel vous voulez 
effectuer l'alignement en cliquant dessus.

2 Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début du clip 
sélectionné. Pour plus d'informations, reportez-
vous à la section « Déplacement de la tête 
de lecture » à la page 425.

3 Effectuez l'une des opérations suivantes :

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et faites glisser un clip 
depuis la liste des clips vers une autre piste.

• Si la piste contient déjà ce clip, maintenez la 
touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et cliquez sur le clip à déplacer avec 
l'outil de saisie du temps.

Avec Pro Tools HD, lorsque l'option Scrolling 
est définie sur Center Playhead, les points de 
début, de fin et de synchronisation des clips 
s'alignent sur la tête de lecture.
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Pour aligner le point de fin d'un clip avec le point 
de début d'un autre clip (sur une piste différente) :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le clip sur lequel vous voulez 
effectuer l'alignement en cliquant dessus.

2 Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début du clip 
sélectionné (reportez-vous à la section 
« Déplacement de la tête de lecture » à la 
page 425).

3 Effectuez l'une des opérations suivantes :

• Maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et faites glisser un clip depuis la liste 
des clips vers une autre piste.

• Si la piste contient déjà ce clip, maintenez les 
touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées et cliquez sur 
le clip à déplacer avec l'outil de saisie du temps.

Pour aligner le point de synchronisation d'un clip 
avec le point de début d'un autre clip (sur une piste 
différente) :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le clip sur lequel vous souhaitez 
aligner le clip.

2 Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début du clip 
sélectionné (reportez-vous à la section 
« Déplacement de la tête de lecture » à la 
page 425).

3 Effectuez l'une des opérations suivantes :

• Maintenez les touches Démarrer+Maj 
(Windows) ou Ctrl+Maj (Mac) enfoncées et 
faites glisser un clip depuis la liste des clips vers 
une autre piste.

• Si la piste contient déjà ce clip, maintenez les 
touches Démarrer+Maj (Windows) ou Ctrl+Maj 
(Mac) enfoncées et cliquez sur le clip à déplacer 
avec l'outil de saisie du temps.

Glissement de clips
L'outil de saisie du temps permet de faire glisser un 
clip ou un groupe de clips sélectionné (sur la même 
piste ou sur plusieurs pistes) vers de nouveaux 
emplacements ou d'autres pistes. En post-
production, cette fonction s'avère utile pour la 
synchronisation des événements audio, notamment 
pour repérer les effets sonores et les dialogues sur 
une musique, un film ou une vidéo.

Le déplacement des clips par glissement dépend du 
mode d'édition actif, Shuffle, Slip, Spot ou Grid 
(reportez-vous à la section « Modes d'édition » à la 
page 543).

Vous pouvez faire glisser une copie d'un clip 
vers un autre emplacement ou une autre piste 
en appuyant sur Alt (Windows) ou sur Option 
(Mac).

Pour conserver l'emplacement temporel d'un 
clip lorsque vous le déplacez vers une autre 
piste, maintenez la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée lors de 
l'opération.
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Déplacement de clips en 
mode Shuffle
En mode Shuffle, vous pouvez déplacer librement 
les clips sur une piste ou vers une autre piste, mais 
leur mouvement est contraint par les autres clips. 
Cela signifie que si vous placez plusieurs clips sur 
une piste, leurs points de début et de fin s'alignent 
automatiquement les uns sur les autres. Vous 
pouvez ensuite modifier l'ordre dans lequel ils se 
succèdent, mais vous ne pouvez pas les séparer, 
ni les superposer comme en mode Slip. En mode 
Shuffle, l'ajout d'un autre clip au début d'une piste 
décale les clips suivants vers la droite, de la durée 
du clip ajouté.

Pour déplacer des clips en mode Shuffle :

1 Activez le mode Shuffle (reportez-vous à la 
section « Modes d'édition » à la page 543).

2 Faites glisser un clip mono de la liste des clips 
vers une piste vide. Le clip s'aligne sur le début 
de la piste.

3 Faites glisser un second clip de la liste des clips 
vers le milieu de la même piste. Le point de 
début du second clip est aligné sur la fin du 
premier clip.

4 Avec l'outil de saisie du temps, faites glisser le 
second clip vers le début de la piste.

Pro Tools « réorganise » la position des deux clips. 
Le second se place en premier, mais les deux clips 
restent collés l'un à l'autre.

5 Faites d'autres essais en mode Shuffle en faisant 
glisser d'autres clips vers la piste et en les 
réorganisant.

Les clips verrouillés (reportez-vous à la section 
« Verrouillage des clips » à la page 866), ainsi que 
tous les clips situés en aval, ne bougent pas lorsque 
d'autres clips voisins sont déplacés en mode 
Shuffle. S'il n'y a pas assez d'espace pour placer ou 
dupliquer un clip devant un clip verrouillé, la zone 
d'insertion est désactivée.

Si vous placez un clip alors que vous vous trouvez 
en mode Slip, puis que vous passez en mode 
Shuffle, Pro Tools conserve la mise en place 
rythmique et la position relatives du clip déplacé 
par glissement, ainsi que tout espace vide entre lui 
et les autres.

Il est important d'exclure le mode Shuffle avec 
certains workflows afin de s'assurer que la 
position temporelle des clips ne soit pas affectée 
par les opérations d'édition. Le verrouillage du 
mode Shuffle entraîne la désactivation de toutes 
les touches de raccourci et de surface de 
contrôle liées à ce mode. Le mode Shuffle ne 
peut plus être sélectionné, même par 
inadvertance. Pour plus d'informations, 
reportez-vous à la section « Verrouillage du 
mode Shuffle » à la page 544.
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Déplacement en mode Shuffle 
de plusieurs pistes et de clips 
multicanal
Il est possible de déplacer en mode Shuffle des 
sélections sur plusieurs pistes ou sur des pistes 
multicanal. Dans ce cas, tout clip partiellement 
sélectionné est coupé et suit le clip déplacé. Ceci 
permet de ne conserver que les données qui 
correspondent au clip déplacé.

Déplacement de clips à l'aide 
des outils de saisie
Les outils de saisie permettent de déplacer un ou 
plusieurs clips, ou la sélection d'édition, vers un 
nouvel emplacement. La sélection est alors coupée 
et collée au nouvel emplacement. 

Pour déplacer un ou plusieurs clips ou la sélection 
d'édition à l'aide des outils de saisie :

1 Créez une sélection.

2 À l'aide de l'un des outils de saisie (temps, 
séparation ou saisie d'objet), faites glisser la 
sélection vers le nouvel emplacement.

Outil de saisie du temps et d'objet
Si vous déplacez des données audio, les outils de 
saisie du temps et de saisie d'objet superposent 
uniquement les données audio sur la piste de 
destination.

Le déplacement d'un clip en mode shuffle entraîne un 
découpage des canaux

Pour copier la sélection sans la couper, 
maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée tout en cliquant et en déplaçant 
la sélection à l'aide d'un outil de saisie.

Déplacement d'une sélection à l'aide de l'outil de 
saisie du temps
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Outil de séparation
L'outil de séparation entraîne le remplacement de 
l'ensemble de la plage sélectionnée sur la timeline 
de la piste de destination. 

Alignement sur le clip 
précédent ou suivant d'une 
piste
Un clip, ou une sélection d'édition incluant un ou 
plusieurs clips sur la même piste ou plusieurs pistes, 
peut s'aligner sur la fin du clip précédent ou le début 
du clip suivant. Cette méthode est utile pour 
raccorder bout à bout les clips adjacents d'une piste.

Pour aligner un clip sur le clip précédent d'une 
piste :

1 Effectuez l'une des opérations suivantes :

• Avec l'outil de saisie du temps, sélectionnez 
un clip.

• Avec le Sélecteur, sélectionnez une zone de piste 
contenant des clips entiers. Ces clips peuvent ne 
pas être adjacents.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Snap To > Previous. 

• Effectuez un clic droit sur le clip ou la sélection 
d'édition, puis sélectionnez Snap to Previous.

Le clip sélectionné s'aligne sur le clip précédent de 
la piste. Les deux clips sont alors raccordés bout 
à bout.

Pour aligner un clip sur le clip suivant d'une piste :

1 Effectuez l'une des opérations suivantes :

• Avec l'outil de saisie du temps, sélectionnez 
un clip.

• Avec le Sélecteur, sélectionnez une zone de piste 
contenant des clips entiers. Ces clips peuvent ne 
pas être adjacents.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Snap To > Next. 

• Effectuez un clic droit sur le clip ou la sélection 
d'édition, puis sélectionnez Snap to Next.

Le clip sélectionné s'aligne sur le clip suivant sur la 
piste. Les deux clips sont alors raccordés bout à bout.

Déplacement d'une sélection à l'aide de l'outil de 
séparation

Alignement d'un clip sur le clip suivant d'une piste
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Déplacement de clips en 
mode Slip
En mode Slip, l'outil de saisie du temps permet de 
déplacer les clips librement sur une piste ou vers 
d'autres pistes. Dans ce mode, il est possible de 
placer un clip sur une piste en laissant un espace 
entre lui et les autres clips. Lors de la lecture de la 
piste, aucun son ne sera émis lors de ce passage de 
silence. Vous pouvez également déplacer un clip 
pour qu'il recouvre partiellement ou complètement 
un autre clip.

Pour déplacer des clips en mode Slip :

1 Activez le mode Slip (reportez-vous à la section 
« Modes d'édition » à la page 543).

2 Faites glisser un clip de la liste des clips vers 
une piste vide.

3 Faites glisser un second clip de la liste des clips 
vers le milieu de la même piste. Le second clip 
se place à l'endroit où vous le relâchez. 
Contrairement au mode Shuffle, ce mode ne 
permet pas d'aligner le second clip sur le 
premier.

4 Faites glisser les clips vers différents endroits de 
la piste pour comprendre le fonctionnement du 
mode Slip. Essayez de placer le second clip 
pour qu'il recouvre légèrement le premier. 
Lancez la lecture pour entendre le résultat.

Placement de clips en mode 
Spot
Le mode Spot est utile dans le cadre de sessions 
pour lesquelles vous souhaitez positionner des 
clips à un emplacement précis, quelle que soit 
l'échelle temporelle. Il s'utilise notamment pour les 
tâches de post-production. Le mode Spot permet 
de placer un clip en précisant un emplacement 
SMPTE ou un nombre de mesures et de temps, 
en capturant une adresse de timecode entrante, 
ou en utilisant les marqueurs temporels du clip.

Pour placer un clip en mode Spot :

1 Activez le mode Spot (reportez-vous à la 
section « Modes d'édition » à la page 543).

2 Effectuez l'une des opérations suivantes :

• Faites glisser un clip à partir de la liste des clips 
ou faites glisser des fichiers audio ou des 
sessions à partir d'un navigateur de l'espace de 
travail vers une piste existante. 

• Cliquez avec l'outil de saisie du temps sur un 
clip se trouvant déjà sur la piste.

3 Dans la boîte de dialogue Spot, sélectionnez le 
format temporel désiré dans le menu déroulant 
Time Scale.

Vous pouvez également utiliser les 
commandes d'alignement Snap To avec une 
sélection d'édition comprenant plusieurs clips 
sur une ou plusieurs pistes.

Pour un repérage encore plus rapide, si vous 
utilisez le VITC, utilisez la commande Auto-
Spot Clips pour placer un clip à 
l'emplacement SMPTE actuel avec l'outil de 
saisie du temps. Pour plus d'informations, 
reportez-vous à la section « Placement 
automatique de clips » à la page 1214.

Pour plus d'informations sur l'utilisation du 
SMPTE dans Pro Tools, reportez-vous au 
Chapitre 50, « Utilisation de la 
synchronisation ».
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Les valeurs des champs de la boîte de dialogue Spot 
sont affichées dans l'échelle temporelle spécifiée.

4 Si l'échelle temporelle est définie sur Timecode, 
sélectionnez l'option Use Subframes pour 
afficher les sous-images dans les champs afin 
d'améliorer la précision.

5 Effectuez l'une des opérations suivantes :

• Cliquez dans le champ Start, Sync Point ou End et 
saisissez un nouvel emplacement. La modification 
de l'un de ces points de repère met à jour 
automatiquement les autres points de repère.

• Cliquez sur la flèche vers le haut du champ 
Original Time Stamp ou sur celle du champ User 
Time Stamp pour entrer la valeur du marqueur 
temporel d'origine ou du marqueur temporel 
utilisateur.

• Si vous utilisez une source de timecode SMPTE 
externe, cliquez sur la flèche du bas, située à côté 
du champ Current Timecode (ou appuyez sur la 
touche égal (=) du pavé numérique) pour 
capturer une adresse de timecode entrant.

6 Cliquez sur OK. Le clip est déplacé au nouvel 
emplacement indiqué par ses points de début, 
de fin ou de synchronisation.

Si un clip ne possède pas de point de synchronisation 
défini, le champ Sync Point de la boîte de dialogue 
Spot fonctionne comme le champ Start.

Placement de clips à l'aide de 
commandes contextuelles
Vous pouvez définir le placement des clips sur une 
piste à l'aide de combinaisons de touches et de 
commandes contextuelles.

Pour placer un clip sur une sélection :

1 Cliquez ou faites glisser le Sélecteur pour 
localiser le curseur ou créer une sélection sur la 
piste sur laquelle vous souhaitez placer le clip.

2 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et effectuez un clic 
droit sur le clip, puis sélectionnez l'une des 
commandes suivantes dans le menu contextuel :

• Move Clip Start to Selection Start 

• Move Clip Sync to Selection Start 

• Move Clip End to Selection Start 

Marqueurs temporels des clips
Lorsqu'un clip est créé, il est marqué 
temporellement relativement à l'heure de début 
SMPTE spécifiée pour la session. Ce marquage 
temporel d'origine est lié de façon permanente au 
clip et ne peut pas être modifié. Si un clip est 
déplacé, il peut facilement être replacé à sa 
position d'origine depuis la boîte de dialogue Spot.

Lors de la définition initiale du marqueur temporel 
d'origine d'un clip, ce même emplacement sert 
également à définir le marqueur temporel 
utilisateur du clip.

Contrairement au marqueur temporel d'origine, 
le marqueur temporel utilisateur peut être redéfini 
via la commande Time Stamp du menu de la liste 
des clips (reportez-vous à la section « Marquage 
temporel » à la page 1215). 

Boîte de dialogue Spot

Dans les versions antérieures de Pro Tools, 
vous pouviez définir l'emplacement d'un clip 
sur une sélection en effectuant un clic droit 
dessus avec la Main.
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Marquage temporel dans l'espace de travail

Les navigateurs de l'espace de travail contiennent 
des colonnes pour le marquage temporel original et 
le marquage temporel utilisateur. 

Marquage temporel et correspondances

Les clips possédant des marqueurs temporels 
utilisateur identiques sont regroupés dans le sous-
menu Matches du menu contextuel lors de l'écoute 
des prises (reportez-vous à la section « Sélection 
de prises alternatives sur une piste » à la 
page 474).

Glissement de clips en mode 
Grid
Le mode Grid offre plusieurs fonctions utiles pour 
faire glisser et déplacer des clips sur les playlists 
des pistes. Ce mode est particulièrement utile pour 
disposer des clips à intervalles précis, lorsque vous 
travaillez avec une session basée sur les mesures et 
les temps. Les limites de la grille, en fonction de 
l'échelle temporelle principale, peuvent être 
exprimés en images, en nombre de mesures et de 
temps, en minutes/secondes ou en nombre 
d'échantillons. 

Le mode Grid offre également deux modes de 
fonctionnement : absolu et relatif. Ces modes 
régissent l'application de la grille (reportez-vous 
à la section « Modes Grid absolu et relatif » à la 
page 860).

Configuration de la grille
Lorsque l'option Draw Grid in Edit Window est 
activée dans la page des préférences d'affichage, 
des graduations verticales s'affichent dans la 
fenêtre Edit.

Vous pouvez également activer et désactiver ces 
graduations de la fenêtre Edit en cliquant sur le 
nom de la règle de base de temps en surbrillance.

Définition de la valeur de la 
grille
Outre son influence sur le placement des clips, 
la valeur de la grille restreint les sélections 
d'édition et de timeline, et détermine le 
fonctionnement de la commande Clip > Quantize 

to Grid.

Pour définir la valeur de la grille :

1 Effectuez l'une des opérations suivantes :

• Dans le menu View > Main Counter, sélectionnez 
l'échelle temporelle de la valeur de grille.

• Pour conserver l'échelle temporelle principale et 
utiliser un format temporel différent pour la grille, 
désélectionnez l'option Follow Main Timebase 
dans le menu déroulant des valeurs de grille.

2 Effectuez l'une des opérations suivantes :

• Dans le menu déroulant des valeurs de grille, 
sélectionnez la valeur temporelle pour les 
limites de la grille.

Pour suspendre temporairement le mode Grid 
et basculer en mode Slip tout en déplaçant un 
clip, maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée.
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• Pour définir une grille basée sur les marqueurs, 
sélections et limites des clips d'une session, 
sélectionnez Clips/Markers dans le menu des 
valeurs de grille.

Modes Grid absolu et relatif
Le mode Grid peut être appliqué en mode absolu 
ou relatif. 

 En mode Grid absolu, le déplacement d'un clip 
entraîne l'alignement de son début sur une limite 
de la grille. Si le point de départ d'un clip se trouve 
entre deux temps et que la grille est définie sur des 
noires, le déplacement du clip déplace l'heure de 
début lui correspondant sur la noire la plus proche 
(la valeur actuelle de grille absolue). 

 En mode Grid relatif, les clips peuvent être 
déplacés par unités de grille (ou incrément). Si le 
point de départ d'un clip se trouve entre deux 
temps et que la grille est définie sur une noire, 
le déplacement du clip est contraint à des 
intervalles de noire et conserve la position relative 
du clip par rapport au temps le plus proche.

Pour sélectionner le mode Grid absolu ou relatif :

 Cliquez sur le sélecteur de mode Grid, puis 
sélectionnez Absolute Grid ou Relative Grid.

Pour placer ou déplacer un clip en mode Grid :

1 Configurez la valeur de grille (reportez-vous à 
la section « Définition de la valeur de la grille » 
à la page 859).

2 Effectuez l'une des opérations suivantes :

• Faites glisser un clip de la liste des clips vers une 
piste existante. 

• Avec l'outil de saisie du temps, faites glisser un 
clip se trouvant déjà sur une piste vers un nouvel 
emplacement.

Le point de début du clip s'aligne sur la limite 
de grille la plus proche. Si un point de 
synchronisation a été défini pour le clip, il s'aligne 
sur la limite de la grille.

Menu déroulant des valeurs de grille, en mode 
Bars|Beats

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant un clip, maintenez la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée.
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Remplacement de clips audio
(Pro Tools HD uniquement)

La fonction Replace Clip permet de remplacer 
plusieurs occurrences d'un clip audio dans une 
playlist par un autre clip. Cette fonction est utile 
en post-production si vous utilisez un effet 
sonore, un bruit ou un clip d'ambiance plusieurs 
fois au cours d'une session et que vous décidez 
ensuite de remplacer un ou tous les clips 
d'origine par un clip différent.

Elle est également utile en production musicale, 
lorsque vous voulez remplacer une boucle ou un 
sample donnés (par exemple un son de batterie) par 
un nouveau. Vous pouvez l'utiliser en composition, 
si vous connaissez le tempo d'une section ou d'une 
session, pour créer un morceau en partant de zéro 
avec des clips « bruts » de la bonne longueur et les 
remplacer plus tard par les clips « finaux » de 
même longueur.

Pour remplacer des clips par glisser-déposer :

1 Sélectionnez dans la playlist de la piste un clip 
que vous voulez remplacer. La sélection peut 
s'étendre au-delà du point de fin du clip et 
inclure des données provenant d'un clip de 
remplacement plus long que le clip d'origine.

2 Faites glisser le clip de remplacement de la liste 
des clips vers le clip sélectionné en maintenant 
les touches Ctrl+Maj (Windows) ou 
Commande+Maj (Mac) enfoncées. La boîte de 
dialogue Replace Clip s'ouvre.

3 Configurez la boîte de dialogue Replace Clip 
(reportez-vous à la section « Options de la boîte 
de dialogue Replace Clip » à la page 862).

4 Cliquez sur OK.

Remplacement de clips depuis 
la liste des clips
La commande Replace Clips est également 
disponible dans le menu de la liste des clips. Avant 
de l'utiliser, assurez-vous d'avoir sélectionné un 
clip sur une piste ainsi qu'un clip de remplacement 
dans la liste des clips. 

Pour remplacer des clips à l'aide du menu de la 
liste des clips :

1 Sélectionnez le clip à remplacer sur une piste. 

2 Effectuez l'une des opérations suivantes :

• Effectuez un clic droit sur le clip de remplacement 
dans la liste des clips, puis sélectionnez Replace 

Clips dans le menu contextuel.

• Sélectionnez le clip de remplacement dans la 
liste des clips, puis cliquez sur Replace Clips 
dans le menu de la liste des clips. Si la 
préférence Clip List Selection Follows Edit 

Selection est activée, maintenez la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
et cliquez sur le clip sélectionné pour le 
désélectionner. Maintenez ensuite la touche 
Commande (Mac) ou Ctrl (Windows) enfoncée 
et cliquez sur le clip de remplacement pour le 
sélectionner, et sélectionnez enfin la commande 
Replace Clips dans le menu de la liste des clips.

3 Configurez la boîte de dialogue Replace Clip 
(reportez-vous à la section « Options de la boîte 
de dialogue Replace Clip » à la page 862).

4 Cliquez sur OK.

Pour ouvrir la boîte de dialogue Replace 
Clip sans créer de sélection au préalable, 
maintenez les touches Ctrl+Maj (Windows) 
ou Commande+Maj (Mac) enfoncées et 
faites glisser un clip de la liste des clips vers 
un clip de piste non sélectionné.
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Remplacement de clips et pistes 
multicanal
La commande Replace Clip permet de faire glisser 
des clips multicanal à partir de la liste des clips 
vers des pistes multicanal, à condition que le 
format des canaux soit identique. Par exemple, 
vous pouvez remplacer un clip stéréo sélectionné 
dans une piste audio stéréo par un autre clip stéréo 
de la liste des clips. En revanche, vous ne pouvez 
pas le remplacer par deux clips audio mono. 
De même, vous ne pouvez pas remplacer des clips 
de plusieurs pistes mono par des clips multicanal.

Options de la boîte de dialogue 
Replace Clip

Les options suivantes sont disponibles dans la 
boîte de dialogue Replace Clip :

Replace > Original Clip Only : remplace 
uniquement le clip sélectionné par le clip de 
remplacement que vous avez fait glisser depuis 
la liste des clips.

Replace > All Instances of the Original Clip : 
remplace toutes les occurrences du clip sélectionné 
correspondant aux critères de la zone On par le clip 
de remplacement de la liste des clips.

• On This Track : remplace les clips correspondant 
aux critères spécifiés et se trouvant sur la même 
piste que le clip d'origine.

• On All Tracks : remplace les clips correspondant 
aux critères spécifiés sur toutes les pistes de la 
session.

• On Within the Selection : remplace les clips 
correspondant aux critères spécifiés au sein de la 
sélection active.

Replace > All Clips that Match Original Clip's : 
remplace tous les clips correspondant aux critères 
de recherche et de la section On par le clip de 
remplacement que vous avez fait glisser depuis la 
liste des clips. 

• Start Position : remplace tous les clips possédant 
la même heure de début que le clip sélectionné. 
Ceci inclut les clips ayant été créés 
automatiquement lors du trim des points de fin.

• End Position : remplace tous les clips possédant 
la même heure de fin que le clip sélectionné. Ceci 
inclut les clips ayant été créés automatiquement 
lors du trim des points de début.

• Name : remplace tous les clips provenant du 
même fichier audio et renommés de la même 
manière.

Boîte de dialogue Replace Clip
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• On This Track : remplace les clips correspondant 
aux critères spécifiés et se trouvant sur la même 
piste que le clip d'origine.

• On All Tracks : remplace les clips correspondant 
aux critères spécifiés sur toutes les pistes de la 
session.

• On Within the Selection : remplace les clips 
correspondant aux critères spécifiés au sein de la 
sélection active.

La correspondance des clips utilise tous les critères 
spécifiés. Par exemple, si vous sélectionnez Start 
Position et End Position, tous les clips issus du 
même fichier audio d'origine que votre sélection et 
possédant les mêmes temps de début et de fin 
seront remplacés.

Fit clip using the > Original Clip Length : si le 
clip de remplacement est plus court que le clip 
d'origine, il est placé sur la playlist et toute donnée 
audio restante du clip d'origine est supprimée. 

Si le clip de remplacement est plus long que la 
sélection, il est placé sur la playlist et un trim est 
appliqué pour l'adapter à la durée du clip d'origine.

Fit clip using the > Original Selection Length : si 
la sélection de la playlist s'étend au-delà du clip 
d'origine, un trim est appliqué au clip de 
remplacement (s'il est plus long que le clip 
d'origine) pour l'adapter à la sélection.

Fit clip using the > Replacement Clip Length : le 
clip de remplacement est placé dans son 
intégralité, quelle que soit la durée du clip ou de la 
sélection d'origine.

Points de synchronisation
Le placement des clips dans en mode Grid et 
Spot peut être basé sur la définition d'un point 
de synchronisation du clip. Des points de 
synchronisation peuvent être ajoutés aux clips audio, 
MIDI et vidéo, ainsi qu'aux groupes de clips. 
Les points de synchronisation sont utiles pour aligner 
un point donné d'un clip sur la grille ou sur un 
emplacement particulier (exprimé en code SMPTE 
ou en mesures/temps). Cette fonction est 
particulièrement importante pour placer des 
musiques et effets sonores sur des films et de la vidéo.

Supposons par exemple que le clip audio d'une 
fermeture de porte contienne à la fois le 
grincement de la porte en train de se fermer, 
le claquement de la porte et la réverbération du 
claquement. L'utilisation d'un point de 
synchronisation pour le claquement permet de 
placer ce dernier à un endroit précis de la session.

Pour définir le point de synchronisation d'un clip :

1 Activez le mode Slip (reportez-vous à la section 
« Modes d'édition » à la page 543).

2 Effectuez l'une des opérations suivantes :

• Cliquez avec le Sélecteur sur le point d'un clip où 
vous souhaitez définir le point de synchronisation.

• Appuyez sur la touche Flèche bas en cours de 
lecture. 

3 Sélectionnez Clip > Identify Sync Point. Une petite 
flèche orientée vers le bas s'affiche en bas du clip, 
avec une fine ligne grise verticale, pour indiquer 
l'emplacement du point de synchronisation.

Point de synchronisation
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Pour modifier l'emplacement d'un point de 
synchronisation :

 Cliquez avec le Sélecteur sur un point du clip, 
puis sélectionnez Clip > Identify Sync Point. 
Le nouvel emplacement est identifié en tant que 
point de synchronisation du clip.

Suppression de points de 
synchronisation

Pour supprimer un point de synchronisation, 
effectuez l'une des opérations suivantes :

 Sélectionnez le clip entier et sélectionnez Clip > 

Remove Sync Point.

 À l'aide de l'outil de saisie du temps, cliquez sur 
le point de synchronisation à supprimer tout en 
maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée.

Affichage des points de 
synchronisation
Vous avez la possibilité d'afficher ou de masquer 
les points de synchronisation des clips audio.

Pour désactiver l'affichage des points de 
synchronisation des clips audio :

 Désélectionnez View > Clip > Sync Point.

Pour activer l'affichage des points de 
synchronisation des clips audio :

 Sélectionnez View > Clip > Sync Point. 

Déplacement des points de 
synchronisation à l'aide de la 
souris
Vous pouvez faire glisser un point de 
synchronisation d'un clip audio. 

Pour définir un point de synchronisation à la souris :

1 Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille actuelle, 
activez le mode Grid (reportez-vous à la section 
« Modes d'édition » à la page 543).

2 Sélectionnez l'outil de saisie du temps.

3 Faites glisser le point de synchronisation vers 
un nouvel emplacement.

Scrubbing des points de 
synchronisation
Si l'affichage d'une forme d'onde audio aide 
à définir un point de synchronisation, il ne permet 
pas toujours de repérer le point souhaité dans les 
données audio. La technique de scrubbing permet 
de détecter précisément l'endroit où placer le point 
de synchronisation lorsque vous le déplacez sur 
une forme d'onde audio.

Vous pouvez également modifier 
l'emplacement d'un point de synchronisation 
en le faisant glisser (reportez-vous à la section 
« Déplacement des points de synchronisation 
à l'aide de la souris » à la page 864).

Scrubbing d'un point de synchronisation (curseur)
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Pour effectuer un scrubbing lors du déplacement 
du point de synchronisation :

1 Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille actuelle 
à la fin du scrubbing, réglez le mode d'édition 
sur Grid (reportez-vous à la section « Modes 
d'édition » à la page 543).

2 Sélectionnez l'outil de scrubbing.

3 Faites glisser le point de synchronisation vers 
un nouvel emplacement. Lors du déplacement 
du point de synchronisation, un scrubbing de 
l'audio est réalisé.

Commande Shift
La commande Shift permet d'avancer ou reculer 
temporellement le contenu d'une piste, d'une quantité 
définie. La commande Shift est utilisable sur les 
sélections, les clips, les notes MIDI, les données de 
contrôleur MIDI et les points d'automation.

Pour décaler une sélection ou un clip :

1 À l'aide du Sélecteur ou de l'outil de saisie 
du temps, sélectionnez le contenu de la piste 
à décaler. Le contenu sélectionné peut se 
trouver sur plusieurs pistes différentes.

2 Sélectionnez Edit > Shift. Dans la boîte de 
dialogue Shift, choisissez si le contenu doit être 
avancé (Earlier) ou reculé (Later).

3 Cliquez dans l'un des champs de base de temps 
pour spécifier la valeur de décalage souhaitée. 
Lorsque vous entrez une valeur dans l'un des 
champs de base de temps, les autres sont mis 
à jour automatiquement.

4 Si vous voulez décaler des données avec une 
meilleure précision, vous pouvez sélectionner 
l'option Use Subframes.

5 Cliquez sur OK. Le contenu est décalé, vers 
l'avant ou l'arrière, de la valeur indiquée. 

Si une partie d'un clip était sélectionnée, de 
nouveaux clips sont créés à partir de la sélection et 
des données se trouvant hors de celle-ci. 

La commande Shift fonctionne de la même 
manière, quel que soit le mode d'édition. 
Par exemple, les clips adjacents sont superposés en 
mode Shuffle, la boîte de dialogue Spot ne s'ouvre 
pas en mode Spot et les données décalées ne 
s'alignent pas sur la grille en mode Grid.

Boîte de dialogue Shift
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Verrouillage des clips
Dans de nombreux cas, il est nécessaire de 
« verrouiller » des clips ou des groupes de clips sur 
un emplacement temporel spécifique afin d'éviter 
qu'ils ne soient déplacés involontairement. 
Pro Tools inclut deux commandes différentes 
pour le verrouillage des clips : Edit locking 
(verrouillage pour l'édition) et Time locking 
(verrouillage temporel). verrouillage de l'édition 
et verrouillage temporel

Verrouillage de clips pour 
l'édition
Si vous souhaitez protéger un clip ou un groupe 
de clips d'une édition involontaire, vous avez la 
possibilité de les verrouiller. Les clips verrouillés 
pour l'édition ne peuvent pas être modifiés 
(coupés, supprimés, séparés, ajustés), ni être 
déplacés vers un autre emplacement temporel. 
Les clips verrouillés pour l'édition peuvent être 
copiés, puis collés vers une autre piste ou un autre 
emplacement temporel, mais la copie sera 
également verrouillée pour l'édition.

Pour verrouiller (ou déverrouiller) un clip pour 
l'édition :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le ou les clips à verrouiller 
(ou déverrouiller) pour l'édition. Les clips 
peuvent se trouver sur des pistes différentes.

2 Sélectionnez Clip > Edit Lock/Unlock.

Lorsque l'édition est verrouillée, une petite icône 
apparaît sur le clip. Ce dernier ne peut alors être ni 
déplacé, ni supprimé, ni modifié. Si vous tentez 
d'effectuer des modifications sur un clip verrouillé, 
Pro Tools vous avertit (reportez-vous à la section 
« Édition de clips verrouillés pour l'édition » à la 
page 867).

En mode Shuffle, les clips pour lesquels l'édition 
a été verrouillée, ainsi que tous les clips situés 
après le clip verrouillé, ne sont pas déplacés 
lorsque d'autres clips voisins le sont.

Pour les pistes Elastic Audio basées sur des 
références de tempo, les clips verrouillés pour 
l'édition se conforment aux changements de 
tempo, mais les autres traitements Elastic Audio 
(la quantification ou la déformation manuelle par 
exemple) ne peuvent pas être appliqués.

Verrouillage temporel de clips
Vous pouvez verrouiller les clips à un emplacement 
précis d'une piste (une mesure, une image SMPTE ou 
un échantillon) afin qu'il ne soit pas déplacé par 
inadvertance. Les clips verrouillés temporellement ne 
peuvent pas être déplacés. Néanmoins, les 
modifications n'ayant pas d'impact sur l'emplacement 
temporel du clip peuvent être effectuées (séparation, 
trimming, traitement AudioSuite ou déplacement du 
clip vers une autre piste par exemple). Les clips 
verrouillés temporellement peuvent également être 
supprimés. Lorsque vous séparez un clip de ce type, 
tous les nouveaux clips seront également verrouillés 
temporellement.

Appuyez sur Ctrl+L (Windows) ou 
Commande+L (Mac) pour verrouiller ou 
déverrouiller pour l'édition le clip 
sélectionné.

Icône de verrouillage pour l'édition
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Pour verrouiller (ou déverrouiller) temporellement 
un clip :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le ou les clips à verrouiller 
(ou déverrouiller) temporellement. Les clips 
peuvent se trouver sur des pistes différentes.

2 Sélectionnez Clip > Time Lock/Unlock.

Lorsqu'un clip est verrouillé sur un emplacement 
temporel, une icône de verrouillage s'affiche sur le 
clip ; le clip ne peut pas être déplacé, ni modifié, ni 
même supprimé.

En mode Shuffle, les clips verrouillés 
temporellement, ainsi que tous les clips situés 
après le clip verrouillé, ne sont pas déplacés 
lorsque d'autres clips voisins le sont.

Pour les pistes Elastic Audio basées sur des 
références de tempo, les clips verrouillés 
temporellement se conforment aux changements 
de tempo, mais les autres traitements Elastic Audio 
(la quantification ou la déformation manuelle par 
exemple) ne peuvent pas être appliqués.

Édition de clips verrouillés pour 
l'édition
Si vous tentez de modifier un clip verrouillé pour 
l'édition, Pro Tools vous avertit et vous invite à annuler 
(Cancel) ou autoriser (Allow) la modification. Si vous 
autorisez une édition mais que celle-ci ne modifie pas 
le clip, le verrouillage reste activé.

Muter/démuter un clip
La sélection de la commande Mute/Unmute Clip 
mute la lecture du clip sélectionné. Si vous 
sélectionnez cette commande une seconde fois, 
le son du clip est démuté. Lorsque le son est muté, 
les clips correspondants sont estompés.

Pour muter ou démuter un ou plusieurs clips :

1 À l'aide de l'outil de saisie du temps, 
sélectionnez le ou les clips à muter ou démuter. 
Les clips peuvent même se trouver sur des 
pistes différentes.

2 Sélectionnez Edit > Mute/Unmute. Lorsque le 
son est muté, les clips correspondants sont 
estompés.

Suppression du silence des 
clips
La commande Strip Silence analyse les sélections 
audio sur plusieurs pistes et supprime (ou extrait) 
toutes les zones de silence en divisant la sélection 
en clips plus petits.

La commande Strip Silence permet de supprimer 
les silences d'un clip ou d'extraire les données 
audio tout en conservant les silences. 
La suppression des zones de silence s'utilise 
notamment lors de la préparation au compactage 
audio (reportez-vous à la section « Compactage 
d'un fichier audio » à la page 621). La commande 
Strip Silence permet de diviser automatiquement 
une sélection en plusieurs clips, afin de quantifier 
l'audio sur des valeurs de note ou de placer des 
effets sonores à des emplacements SMPTE précis.

Appuyez sur Ctrl+L (Windows) ou 
Commande+L (Mac) pour verrouiller ou 
déverrouiller temporellement le clip sélectionné.

Icône de verrouillage temporel

Clip audio muté (au milieu)
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Attribution automatique de noms 
après suppression du silence
Le bouton Rename de la fenêtre Strip Silence 
ouvre la boîte de dialogue Rename Selected Clips, 
qui détermine le nom des clips créés par la 
commande Strip Silence. La boîte de dialogue 
mémorise vos paramètres précédents. Vous 
pouvez les effacer en cliquant sur le bouton Clear.

Name : spécifie le nom de base des clips créés par 
la commande Strip Silence.

Number : spécifie le chiffre de départ de la 
numérotation automatique séquentielle. 

Zeros : spécifie le nombre de zéros apparaissant 
avant le numéro attribué automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

Par exemple, si vous définissez ces options 
d'attribution des noms sur :

• Name = SFX

• Starting Number = 23

• Number of Places = 1

• Suffix = .Reel1

Les noms des clips successivement créés par la 
commande Strip Silence seront :

• SFX023.Reel1

• SFX024.Reel1

• SFX025.Reel1

• SFX026.Reel1

Utilisation de la commande 
Strip Silence

Pour supprimer le silence d'une sélection audio :

1 Sélectionnez un ou plusieurs clips audio. 

2 Sélectionnez Edit > Strip Silence.

3 Pour définir la méthode d'attribution 
automatique des noms aux clips créés par la 
commande Strip Silence, cliquez sur Rename 
pour ouvrir la boîte de dialogue Rename 
Selected Clips. Pour plus d'informations, 
reportez-vous à la section « Attribution 
automatique de noms après suppression du 
silence » à la page 868.

4 Dans la fenêtre Strip Silence, ajustez les curseurs 
Strip Threshold et Min Strip jusqu'à ce que des 
rectangles apparaissent dans la sélection.

Pour affiner le réglage de ces paramètres, appuyez 
sur la touche Ctrl (Windows) ou Commande (Mac) 
pendant que vous les ajustez.

Boîte de dialogue Rename Selected Clips

Pour ouvrir la fenêtre Strip Silence, appuyez 
sur Ctrl+U (Windows) ou Commande+U 
(Mac).

Rectangles de suppression du silence
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5 Pour garder le contenu situé avant et après les 
nouveaux clips, ajustez les paramètres Clip Start 
Pad et Clip End Pad.

6 Lorsque les rectangles de suppression du 
silence englobent l'audio que vous voulez 
conserver, cliquez sur le bouton Strip.

Le contenu défini comme du silence est supprimé 
de la sélection et de nouveaux clips sont créés : ils 
apparaissent également dans la liste des clips.

La commande Strip Silence est non destructive et 
ne supprime pas les données audio des fichiers 
audio parents. En plus de la commande Undo, 
la commande Heal Separation permet de restaurer 
les données supprimées.

Pour extraire l'audio d'une sélection audio à l'aide 
de la commande Strip Silence :

1 Créez une sélection d'édition.

2 Sélectionnez Edit > Strip Silence.

3 Pour définir la méthode d'attribution des noms 
aux clips créés par la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue Rename Selected Clips (reportez-vous 
à la section « Attribution automatique de noms 
après suppression du silence » à la page 868).

4 Dans la fenêtre Strip Silence, ajustez les curseurs 
Strip Threshold et Min Strip jusqu'à ce que des 
rectangles apparaissent dans la sélection.

5 Cliquez sur le bouton Extract.

Toutes les données audio au-delà du seuil indiqué 
sont supprimées et les portions de silence de la 
piste sont conservées.

Pour séparer des clips à l'aide de la commande 
Strip Silence :

1 Créez une sélection de timeline ou d'édition.

2 Sélectionnez Edit > Strip Silence.

3 Pour définir la méthode d'attribution des noms 
aux clips créés par la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue Rename Selected Clips (reportez-vous 
à la section « Attribution automatique de noms 
après suppression du silence » à la page 868).

4 Dans la fenêtre Strip Silence, ajustez les curseurs 
Strip Threshold et Min Strip jusqu'à ce que des 
rectangles apparaissent dans la sélection.

5 Cliquez sur le bouton Separate.

De nouveaux clips sont créés en fonction des 
limites détectées par la commande Strip Silence. 

Fenêtre Strip Silence
La fenêtre Strip Silence contient les commandes 
suivantes d'ajustement des paramètres pris en 
compte lors de la définition des zones de silence 
à l'aide de la commande Strip Silence.

Suppression du silence, ajout de marges avant et 
après un clip

La suppression du silence fonctionne sur les 
pistes stéréo et multicanal et conserve la 
cohérence de phase de leurs clips audio.

Attaque à ajouter Decay à ajouter

Fenêtre Strip Silence
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L'ajustement de ces curseurs entraîne l'apparition 
temporaire de rectangles dans la sélection, qui 
indiquent les zones de silence auxquelles les 
commandes Strip, Extract ou Separate vont 
s'appliquer.

Strip Threshold : définit le seuil d'amplitude (de -
96 dB à 0 dB) pris en compte pour la suppression 
du silence. Les données audio dont le niveau se 
situe au-dessous de ce seuil sont considérées 
comme du silence et sont supprimées. Les données 
audio se situant au-dessus de ce seuil sont 
conservées et définies comme de nouveaux clips.

Minimum Strip Duration : définit la durée 
minimale (de 0 à 4 000 ms) pendant laquelle le 
niveau des données doit rester au-dessus du seuil 
pour qu'elles soient considérées comme du silence. 
Utilisez ce paramètre pour éviter de créer une 
multitude de petits clips dans une même sélection.

Clip Start Pad : indique une valeur de temps devant 
être ajoutée au début de chaque nouveau clip créé 
par la commande Strip Silence. Cela permet de 
conserver des données musicales se situant au-
dessous du seuil, telles qu'une inspiration avant une 
phrase vocale ou le glissement des doigts sur les 
cordes avant un accord de guitare.

Clip End Pad : indique une valeur de temps devant 
être ajoutée à la fin de chaque nouveau clip créé 
par la commande Strip Silence, afin de respecter la 
résonance des sons.

Strip : supprime les silences détectés en 
conservant uniquement les clips contenant des 
données audio sur la piste.

Extract : supprime les données audio et conserve 
les parties silencieuses de la piste (cela correspond 
en quelque sorte à une fonction de suppression 
inverse du silence idéale pour générer une ambiance 
acoustique de la pièce que vous utiliserez ailleurs).

Rename : affiche la boîte de dialogue Rename 
Selected Clips (reportez-vous à la section 
« Attribution automatique de noms après 
suppression du silence » à la page 868).

Separate : sépare les clips sur les limites détectées 
par la commande Strip Silence. 

Insertion de silence
La commande Insert Silence constitue une 
méthode simple et pratique pour insérer des zones 
de silence dans les pistes audio, MIDI et 
d'instrument. Cette commande permet d'effectuer 
une sélection sur une piste (ou plusieurs) et 
d'insérer précisément cette durée de silence. 

En mode Shuffle, toutes les données de la piste 
sont décalées plus loin sur la piste d'une durée 
égale à la sélection.

En mode Grid, la commande Insert Silence 
fonctionne comme la commande Clear.

Mode Shuffle : les conditions suivantes 
s'appliquent lorsque vous insérez du silence sur 
plusieurs pistes :

 Si des pistes sont affichées sous forme de 
données audio ou MIDI, la durée de silence 
sélectionnée est insérée dans les données audio 
ou MIDI et dans toutes les données d'automation 
sous-jacentes de toutes les pistes sélectionnées. 
Tous les clips situés en aval sont déplacés de la 
durée de silence insérée. Sur les pistes MIDI, 

Rectangles de suppression du silence

La commande Insert Silence a également une 
incidence sur les marqueurs des règles de 
chef d'orchestre sélectionnées (telles que les 
règles de tempo ou de métrique).
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seules les notes sélectionnées à partir de leur début 
sont concernées, ce qui signifie que si vous avez 
sélectionné la fin d'une note et que vous insérez du 
silence, cette note restera inchangée.

 Si toutes les pistes sélectionnées apparaissent 
sous forme de données d'automation, la plage 
sélectionnée n'est nettoyée que du type de données 
d'automation affiché dans chaque piste. Les clips 
ne sont pas déplacés en mode Shuffle. À la place, 
un espace vierge apparaît, d'une durée égale à celle 
de la sélection.

 Si toutes les pistes sélectionnées s'affichent sous 
forme de données d'automation, appuyez sur la 
touche Démarrer (Windows) ou sur Ctrl (Mac) tout 
en choisissant la commande Insert Silence pour 
insérer du silence sur toutes les playlists 
d'automation de toutes les pistes sélectionnées. Les 
clips ne sont pas déplacés en mode Shuffle.

Mode Slip : les conditions suivantes s'appliquent 
lorsque vous insérez du silence sur plusieurs pistes :

 Si des pistes sont affichées sous forme de 
données audio ou MIDI, la plage sélectionnée est 
supprimée des données audio ou MIDI et de toutes 
les données d'automation sous-jacentes de toutes 
les pistes sélectionnées.

 Si toutes les pistes sélectionnées s'affichent sous 
forme de données d'automation, le silence n'est 
inséré que dans le type de données d'automation 
affiché dans chaque piste.

 Si toutes les pistes sélectionnées s'affichent sous 
forme de données d'automation, appuyez sur la 
touche Démarrer (Windows) ou Ctrl (Mac) tout en 
choisissant la commande Insert Silence pour 
insérer du silence sur toutes les playlists 
d'automation de toutes les pistes sélectionnées.

Pour insérer du silence sur une piste :

1 Créez une sélection sur une ou plusieurs pistes. 
La longueur de la sélection détermine la durée 
du silence inséré.

2 Sélectionnez Edit > Insert Silence.

En mode Shuffle, Pro Tools insère la durée de 
silence sélectionnée. En même temps, il divise les 
clips au début du point d'insertion et décale plus 
loin les nouveaux clips, d'une durée égale à celle 
de la sélection.

Duplication des clips
La commande Duplicate copie une sélection et la 
place immédiatement après la fin de la sélection. 
Bien qu'elle soit similaire aux commandes Copy et 
Paste, la commande Duplicate est plus pratique et 
plus rapide, en particulier lorsque vous travaillez 
avec des données réparties sur plusieurs pistes. 

Pour effectuer plusieurs copies d'une sélection, 
utilisez la commande Repeat (reportez-vous à la 
section « Répétition de clips » à la page 872). 
Vous pouvez également activer la lecture en 
boucle des clips (reportez-vous à la section « Mise 
en boucle de clips » à la page 873).

Comme avec les commandes Copy et Paste, 
un certain nombre de règles s'appliquent lorsque 
vous dupliquez des données sur plusieurs pistes 
(reportez-vous à la section « Édition simultanée de 
plusieurs pistes » à la page 541).

Pour dupliquer une sélection ou un clip :

1 Si vous travaillez avec des données basées sur 
les mesures/temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars|Beats.

2 Pour restreindre la sélection en fonction de la 
valeur de grille actuelle, passez en mode 
d'édition Grid. 

3 Créez une sélection d'édition.

4 Sélectionnez Edit > Duplicate. Les données sont 
placées immédiatement après le point de fin de 
la sélection.

Appuyez sur Ctrl+D (Windows) ou 
Commande+D (Mac) pour dupliquer les clips 
sélectionnés.
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En mode Shuffle, les données dupliquées sont 
placées directement après la fin de la sélection. 
Les clips qui se trouvent après sont décalés pour 
laisser la place aux données dupliquées. En mode 
Slip, les données dupliquées se superposent aux 
données adjacentes.

Lorsque vous utilisez les commandes Duplicate 
(ou Repeat) avec des notes MIDI sélectionnées 
avec l'outil de saisie du temps, les données sont 
toujours dupliquées une mesure plus tard et 
fusionnées avec les données existantes de la piste 
(au lieu de les remplacer).

Duplication d'audio et 
préservation de la mise en place
Lorsque vous utilisez les commandes Duplicate 
(ou Repeat) avec des données audio qui doivent 
tomber parfaitement sur les temps (comme des 
boucles rythmiques), il est important de 
sélectionner les données audio à l'aide du Sélecteur 
ou en saisissant les points de début et de fin dans la 
zone Event Edit. Si vous sélectionnez un clip audio 
à l'aide de l'outil de saisie du temps (ou en double-
cliquant sur le clip avec le Sélecteur), les données 
peuvent être décalées de plusieurs ticks du fait de 
l'arrondi à l'échantillon le plus proche.

Par ailleurs, si vous souhaitez dupliquer (ou répéter) 
des données audio qui ne sont pas basées sur les 
mesures/temps, définissez l'échelle temporelle sur 
un autre format que Bars|Beats. Cela permet 
d'attribuer aux données audio dupliquées le nombre 
correct d'échantillons et de les placer précisément.

Répétition de clips
La commande Repeat est similaire à la commande 
Duplicate, mais permet de préciser le nombre de 
duplications du contenu sélectionné.

Comme avec les commandes Copy et Paste, un 
certain nombre de règles s'appliquent lorsque vous 
répétez des données sur plusieurs pistes (reportez-
vous à la section « Édition simultanée de plusieurs 
pistes » à la page 541).

Vous pouvez coller plusieurs fois des données afin 
de remplir toute une sélection (reportez-vous à la 
section « Repeat to Fill Selection » à la page 540).

Vous pouvez également activer la lecture en 
boucle des clips (reportez-vous à la section « Mise 
en boucle de clips » à la page 873).

Pour répéter une sélection ou un clip :

1 Si vous travaillez avec des données basées 
sur les mesures/temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars|Beats.

2 Pour restreindre la sélection sur les limites de la 
grille actuelle, passez en mode d'édition Grid. 

3 Créez une sélection d'édition.

4 Sélectionnez Edit > Repeat. Dans la boîte de 
dialogue Repeat, entrez le nombre de 
répétitions du contenu et cliquez sur OK.

Le contenu est placé immédiatement après le point 
de fin de la sélection et dupliqué autant de fois que 
vous l'avez indiqué.

En mode Shuffle, le contenu répété est placé 
directement après la fin de la sélection. Les clips 
qui se trouvent après sont décalés pour laisser la 
place au contenu répété. En mode Slip, le contenu 
répété se superpose aux données suivantes.

Boîte de dialogue Repeat

Appuyez sur Alt+R (Windows) ou Option+R 
(Mac) pour ouvrir la boîte de dialogue 
Repeat pour les clips sélectionnés.
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Chapitre 38 : Boucles et groupes de clips

Pro Tools vous permet de mettre en boucle des 
clips ou des groupes de clips.

Mise en boucle de clips
Pro Tools permet de lire en boucle les clips audio, 
MIDI et les groupes de clips. Dans le cadre de la 
composition et de l'arrangement des données 
audio, la mise en boucle de clips est un moyen 
simple et efficace de répéter un clip sur une piste 
ou plusieurs clips sur plusieurs pistes. La mise en 
boucle des clips offre plus de souplesse que les 
commandes Repeat et Duplicate.

La mise en boucle de clips consiste à répéter le clip 
source autant de fois que le spécifie la boîte de 
dialogue Clip Looping ou de manière à combler la 
longueur de boucle indiquée (30 secondes ou 
jusqu'au clip suivant sur la piste, par exemple). 
Le clip source correspond au clip d'origine 
sélectionné pour la mise en boucle. Les itérations 
de boucle correspondent aux clips mis en boucle 
qui suivent le clip source. Si vous n'avez pas défini 
le nombre de répétitions, la dernière itération de 
boucle est tronquée de sorte à combler la sélection 
jusqu'au point de fin ou jusqu'à la longueur de 
boucle spécifiée.

Une fois mis en boucle, un clip s'édite de la même 
manière qu'un groupe de clips. Par exemple, 
lorsque vous déplacez un clip mis en boucle, vous 
déplacez le clip source en même temps que toutes 
ses itérations de boucle.

Les clips mis en boucle (toutes les itérations) sont 
signalés par une icône de boucle située dans l'angle 
inférieur droit de chaque itération. 

Clip mis en boucle

La mise en boucle d'un clip ne s'applique pas 
à l'automation associée au clip source. Pour 
copier l'automation définie pour la boucle 
source sur les itérations de boucle, utilisez 
les commandes Copy Special et Paste Special 
Repeat To Fill Selection (reportez-vous à la 
section « Automation et clips mis en boucle » 
à la page 876).

Clip mis en boucle

Clip source Itérations de boucle

Icônes de boucle
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Création de boucles de clips
Pour créer des boucles de clips, vous pouvez utiliser 
la commande Loop ou l'outil de trim de boucle. 

Pour mettre en boucle un clip :

1 Sélectionnez un clip audio ou MIDI, ou un 
groupe de clips. 

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Loop. 

• Effectuez un clic droit sur le clip à mettre en 
boucle, puis sélectionnez Loop.

3 Dans la boîte de dialogue Clip Looping, 
effectuez l'une des opérations suivantes :

• Sélectionnez l'option Number of Loops et 
saisissez le nombre de boucles du clip.

• Sélectionnez l'option Loop Length et saisissez la 
durée selon la base de temps principale. S'il ne 
s'agit pas d'un multiple exact de la durée de la 
boucle source, la dernière itération de boucle est 
tronquée.

• Sélectionnez l'option Loop Until End of Session 
or Next Clip. Le clip mis en boucle est répété 
jusqu'au clip suivant sur la piste ou jusqu'à la fin 
de la session. Si nécessaire, la dernière itération 
de boucle est ajustée par troncation.

4 Pour ajouter un fondu enchaîné au début de la 
boucle, sélectionnez l'option Enable Crossfade. 
Pour modifier le fondu enchaîné de la boucle, 
effectuez la procédure suivante :

• Cliquez sur le bouton Settings.

• Configurez les fondus enchaînés de la boucle.

• Cliquez sur OK.

5 Dans la boîte de dialogue Clip Looping, cliquez 
sur OK.

Pour plus d'informations sur l'utilisation de 
l'outil de trim de boucle, reportez-vous à la 
section « Outil de trim de boucle » à la 
page 562.

Vous pouvez aussi sélectionner des clips sur 
plusieurs pistes.

Boîte de dialogue Clip Looping

Appuyez sur les touches Ctrl+Alt+L 
(Windows) ou Command+Option+L (Mac) 
pour ouvrir la boîte de dialogue Clip Looping.

Boîte de dialogue Loop Crossfade

Pour plus d'informations sur l'utilisation des 
fondus enchaînés, reportez-vous au 
Chapitre 28, « Fondus et fondus enchaînés ».
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Annulation de la mise en 
boucle de clips
Pour annuler la mise en boucle d'un clip :

1 Sélectionnez le clip mis en boucle.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Unloop. 

• Effectuez un clic droit sur le clip dont vous 
souhaitez annuler la mise en boucle, puis 
sélectionnez Unloop.

3 Effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour annuler la mise en 
boucle et supprimer toutes les itérations, 
exception faite de la première boucle complète 
(clip source).

• Cliquez sur Flatten pour annuler la mise en boucle 
et créer un clip pour chaque itération de boucle.

Pour annuler la mise en boucle et le groupement 
d'une sélection de clips :

1 Sélectionnez un clip mis en boucle contenant un 
ou plusieurs groupes de clips.

2 Sélectionnez Clip > Ungroup All.

Annulation de boucle et mise à plat de clips 
à l'aide des commandes de menu Separate 
Clips

Les commandes Separate Clips (At Selection, 
On Grid et At Transients) annulent automatiquement 
la mise en boucle de clips et les met à plat avant la 
séparation.

Édition de clips mis en boucle
Les clips mis en boucle peuvent être édités en tant 
que clips individuels (chaque itération séparément) 
ou groupes de clips (toutes les itérations). 
Par exemple, lorsque vous utilisez la Main pour 
sélectionner un clip mis en boucle, vous sélectionnez 
la boucle dans son intégralité (clip source et 
itérations de boucle). En revanche, un clic sur l'icône 
de boucle d'une itération sélectionne uniquement 
l'itération correspondante.

Le déplacement d'un clip mis en boucle déplace 
à la fois le clip source et toutes les itérations de 
boucle qui s'y rapportent. Les itérations de boucle 
ne peuvent pas être déplacées sans leur clip source. 
Si vous déplacez ou collez un clip plus court sur un 
clip mis en boucle, la boucle ne s'arrête pas après le 
nouveau clip. Les parties constituantes d'un clip 
mis en boucle ne peuvent pas être ajustées 
séparément. 

Pour sélectionner un clip mis en boucle en tant 
que groupe (toutes les itérations de boucle), 
effectuez l'une des opérations suivantes :

 Cliquez une fois sur le clip mis en boucle avec 
la Main ou l'outil Smart. 

 Double-cliquez sur le clip mis en boucle avec le 
Sélecteur.

Le clip source et toutes ses itérations de boucle 
sont sélectionnés.

La commande Clip Ungroup a le même effet 
sur les boucles que le bouton Flatten de la 
commande Unloop.

La distorsion manuelle d'une partie d'un clip 
mis en boucle dans la vue Warp sépare 
uniquement cette itération du clip mis en 
boucle.
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Pour sélectionner un clip source ou une itération 
de boucle individuellement, effectuez l'une des 
opérations suivantes :

 Cliquez une fois sur l'icône de boucle du clip 
source ou d'une itération de boucle à l'aide de la 
Main ou du Smart Tool.

 À l'aide du Sélecteur, cliquez une fois sur l'icône 
de boucle et sélectionnez le clip en déplaçant le 
curseur vers la gauche.

Tabulation vers transitoires et limites de clips

L'option Tab to Transients déplace le curseur vers 
les transitoires et les limites internes d'un clip mis 
en boucle. La tabulation normale (option Tab to 
Transients désactivée) déplace le curseur vers les 
limites de début et de fin du clip mis en boucle. 
Pour plus d'informations, reportez-vous à la section 
« Tabulation vers les transitoires » à la page 587.

Trimming de clips mis en boucle
Pour effectuer le trimming des clips mis en boucle, 
vous disposez de l'outil de trim, de l'outil de trim de 
boucle et des commandes Trim Clip. L'outil de 
trim de boucle effectue le trimming du clip mis en 
boucle dans son ensemble. L'outil de trim effectue 
le trimming uniquement de l'itération de boucle et 
augmente ou diminue le nombre d'itérations de 
manière à remplir la totalité de la longueur du clip 
mis en boucle.

Si vous étendez vers la gauche le clip source avec 
l'outil de trim pour modifier la longueur totale du clip 
mis en boucle, le clip source se déplace en amont de 
la timeline et des itérations de boucle comblent 
l'espace jusqu'au point de fin de la dernière itération 
de la boucle d'origine. Si le trimming vers la gauche 
s'étend sur une partie de la longueur du clip source, 
celui-ci n'est pas déplacé et une itération de boucle 
partielle est créée sur sa gauche. Cette fonction vous 
permet d'effectuer de rapides changements de vos 
compositions. En effet, vous pouvez utiliser des 
boucles partielles en tant que levés ou étendre des 
effets sonores mis en boucle et une ambiance en 
amont d'une musique de film.

Pour effectuer le trimming d'un clip mis en boucle 
au niveau de la sélection :

1 À l'aide du Sélecteur, créez une sélection 
d'édition portant sur la totalité ou une partie d'un 
clip mis en boucle.

2 Cliquez sur Edit > Trim Clip, puis sélectionnez 
l'une des commandes Trim Clip (To Selection, 
To Fill Selection, Start to Fill Selection ou End to 

Fill Selection).

Automation et clips mis en 
boucle
La mise en boucle d'un clip audio ne s'applique pas 
à l'automation associée au clip source. Cette 
opération permet d'appliquer une automation 
à l'échelle de la totalité du clip mis en boucle. 
Par exemple, vous pouvez insérer un long fondu de 
volume sur une partie ou la totalité d'un clip mis en 
boucle fonctionnant indépendamment des 
itérations de boucle. 

Vous pouvez aussi répéter l'automation sur chaque 
itération de boucle. Pour les clips audio mis en 
boucle, utilisez les commandes Copy Special et 
Paste Special Repeat to Fill Selection afin de 
copier et coller tout ou partie des données 
d'automation du clip source vers tout ou partie des 
itérations de boucle qui lui sont associées. 

Icône de boucle

Pour plus d'informations sur le trimming des 
clips mis en boucle à l'aide de l'outil de trim 
de boucle, reportez-vous à la section « Outil 
de trim de boucle » à la page 562.
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Pour copier et coller les données d'automation 
depuis un clip source vers des itérations de boucle :

1 Sélectionnez le clip source.

2 Sélectionnez Edit > Copy Special, puis l'une des 
commandes Copy Special (All Automation, 
Pan Automation, Plug-in Automation) en 
fonction du type de données d'automation 
à copier.

3 Sélectionnez le clip mis en boucle entier.

4 Sélectionnez Edit > Paste Special > Repeat to 

Fill Selection.

Groupes de clips
Un groupe de clips est une combinaison de clips 
audio et MIDI qui se présente et agit comme un 
clip unique. Les groupes de clips servent 
essentiellement de conteneur à un ou plusieurs 
clips. Les groupes de clips peuvent être créés sur 
une ou plusieurs pistes adjacentes audio, MIDI et 
d'instrument. Ils permettent de rassembler 
plusieurs clips en un macro-clip et facilitent ainsi 
la manipulation, l'édition et l'arrangement des 
ambiances et du tempo. 

Sur les pistes, vous pouvez placer les groupes 
de clips à côté de clips standard et les modifier 
à l'aide des mêmes techniques d'édition. Certaines 
opérations d'édition effectuées sur un groupe, 

notamment avec les commandes Cut ou Delete, 
s'appliquent à tous les clips qu'il englobe. 
D'autres, par exemple avec la commande Trim, 
ne s'appliquent qu'aux limites du groupe de clips et 
n'ont aucune incidence sur les clips sous-jacents.

Chaque groupe de clips est enregistré en même 
temps que la session dans un fichier .cgrp. 
Les fichiers de groupes de clips peuvent être 
exportés et importés entre plusieurs sessions 
Pro Tools.

Les groupes de clips s'utilisent notamment dans le 
cadre des opérations suivantes :

• Groupement d'un clip audio basé sur des 
références de tempo, ayant été divisé en une 
multitude de petits clips à l'aide de percussions 
individuelles ou d'un modèle à percussions. 
Vous pouvez facilement créer ces petits clips 
avec Beat Detective ou la commande Separate 

Region At Transients, ou les exporter en tant que 
fichiers REX ou ACID.

• Groupement de parties ou de sections de la 
session afin de faciliter la composition ou 
l'organisation (par exemple, groupement des 
clips de la section de cuivres joués pendant un 
refrain afin de les copier sur le refrain suivant).

Automation de panoramique sélectionnée pour la 
commande Special Copy

Automation de panoramique sélectionnée pour la 
commande Special Paste to Fill Selection

Les groupes de clips sont entièrement 
indépendants des groupes de mixage et 
d'édition, et sont uniques.

La modification des propriétés Elastic Audio 
n'est pas autorisée pour les groupes de clips.

Les groupes de clips ne sont pas pris en 
charge sur les pistes audio définies sur la 
vue de playlists. Si vous définissez une piste 
audio sur la vue de playlists, le groupement 
de tous les groupes de clips de la piste est 
automatiquement annulé. 
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Création de groupes de clips
Pour créer un groupe de clips :

1 Sélectionnez un ou plusieurs clips sur une ou 
plusieurs pistes. Pour plus d'informations sur 
les groupes de clips multipistes, reportez-vous 
à la section « Groupes de clips multipistes » à la 
page 880.

La longueur de la sélection détermine la durée du 
groupe de clips. Vous pouvez définir le début et la fin 
d'une sélection sur les limites d'un clip, sur un espace 
vide ou même sur la partie centrale d'un clip. Lors de 
la création d'un groupe de clips, si votre sélection 
démarre ou s'achève à l'intérieur d'un clip, celui-ci est 
scindé à la limite de la sélection. Les groupes de clips 
créés à partir de sélections d'objets incluent tous les 
clips, sélectionnés ou non, situés entre le premier et le 
dernier clip sélectionnés sur la piste.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Group.

• Effectuez un clic droit sur la sélection d'édition 
et sélectionnez Group.

Le groupe de clips est représenté sous la forme 
d'un seul clip associé à une icône de groupe de 
clips affichée dans le coin inférieur gauche. 
Les groupes de clips s'inscrivent également dans 
la liste des clips.

Base de temps des groupes de clips

Les groupes de clips sont associés à la base de 
temps (références de tempo ou échantillons) des 
pistes sur lesquelles ils sont créés. Les groupes de 
clips multipistes peuvent inclure à la fois des pistes 
basées sur des échantillons et des pistes basées sur 
des références de tempo.

Sélection de clips à grouper sur une seule piste audio

Appuyez sur les touches Ctrl+Alt+G 
(Windows) ou Command+Option+G (Mac) 
pour grouper les clips sélectionnés.

Les commandes du menu Group and Ungroup 
Clip s'appliquent à toutes les sélections 
d'édition quelle que soit la vue de piste actuelle.

Icônes de groupes de clips sur une piste audio et dans 
la liste des clips

Icône de groupe de clips audio sur une piste audio

Icône de groupe de clips MIDI sur une piste MIDI

Vous pouvez créer des groupes de clips 
à partir de sélections vides. Cela s'avère 
particulièrement utile en mode Shuffle pour 
conserver les espaces entre les clips.
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Annulation du groupement de 
clips
Pour annuler le groupement d'un groupe de clips :

1 Sélectionnez un groupe de clips. 

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Ungroup.

• Effectuez un clic droit sur la sélection d'édition 
et sélectionnez Ungroup.

Le groupe de clips est supprimé et tous les clips 
sous-jacents et groupes de clips imbriqués 
s'affichent. S'il existe plusieurs groupes de clips 
imbriqués, la commande Ungroup annule le 
groupement de clips de la couche supérieure, sans 
affecter les groupes de clips sous-jacents.

Pour annuler le groupement d'un groupe de clips 
(et inclure tous les groupes de clips imbriqués qui 
s'y rapportent) :

1 Sélectionnez un groupe de clips.

2 Sélectionnez Clip > Ungroup All.

Regroupement de clips
La commande de menu Regroup annule la dernière 
commande Ungroup et restaure le groupe de clips. 
Vous pouvez ainsi annuler le groupement de clips, 
éditer les clips sous-jacents, puis les grouper de 
nouveau pour poursuivre vos opérations globales 
de composition et d'organisation.

Pour regrouper un groupe de clips :

1 Sélectionnez un clip appartenant à l'ancien 
groupe de clips à reconstituer.

2 Sélectionnez Clip > Regroup.

Si vous avez utilisé la commande Ungroup All, 
la commande Regroup recrée tous les anciens 
groupes de clips imbriqués.

3 Pour reconstituer un groupe de clips utilisé 
plusieurs fois au cours de la session, effectuez 
l'une des opérations suivantes dans la boîte de 
dialogue Change All qui s'affiche.

• Sélectionnez Modify pour appliquer les 
modifications à toutes les autres instances du 
groupe de clips. 

• Sélectionnez Copy pour créer une copie et 
appliquer uniquement les modifications au 
groupe de clips copié. 

Appuyez sur les touches Ctrl+Alt+U 
(Windows) ou Commande+Option+U (Mac) 
pour annuler le groupement des clips 
sélectionnés. Appuyez sur les touches Ctrl+Alt+R 

(Windows) ou Commande+Option+R (Mac) 
pour reconstituer le groupe que formaient les 
clips sélectionnés.
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Groupes de clips multipistes
Les groupes de clips multipistes (groupes créés 
sur plusieurs pistes) facilitent le groupement de 
parties (pistes de percussions enregistrées à partir 
de plusieurs micros, par exemple) ainsi que 
l'arrangement et la composition. Pour créer des 
groupes de clips multipistes, vous pouvez utiliser 
une combinaison quelconque de pistes audio, 
MIDI et d'instrument, basées sur des échantillons 
et/ou des références de tempo.

Les groupes de clips multipistes et monopistes 
fonctionnent de manière similaire. Les groupes de 
clips multipistes s'affichent sur plusieurs pistes 
adjacentes sous la forme d'un seul objet.

Pour créer un groupe de clips multipistes :

1 Sélectionnez plusieurs clips de pistes adjacentes.

2 Sélectionnez Clip > Group.

Division de groupes de clips 
multipistes
L'insertion, le déplacement, le masquage et la 
suppression de pistes dans un groupe de clips 
multipistes, bien que possibles, peuvent provoquer 
la division du groupe. Lorsqu'un groupe de clips 
est divisé, une rupture apparaît dans l'icône de 
groupe de clips. Le groupe de clips divisé 
fonctionne toujours en tant que groupe unique, 
mais l'icône rompue indique un groupe inachevé 
ou divisé sur plusieurs pistes séparées.

Sélection de clips à grouper sur plusieurs pistes

Icône de groupe de clips

Icône de groupe de clips mixtes (groupe de clips 
multipiste formé d'audio basé sur les références de 
tempo et les échantillons, et de MIDI basé sur les 
références de tempo)

Les groupes de clips multipistes créent des 
groupes de clips imbriqués de plusieurs clips 
par piste avant de les regrouper sur les pistes.

La commande Regroup prend en charge les 
groupes de clips multipistes.
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L'une des opérations suivantes peut être à l'origine 
d'une division d'un groupe de clips :

• Insertion d'une piste dans un groupe de clips 
multipistes ;

• Déplacement d'une piste d'un groupe de clips 
multipiste occasionnant sa séparation d'avec les 
autres pistes du groupe ;

• Masquage d'une piste faisant partie d'un groupe 
de clips multipiste ;

• Suppression d'une piste faisant partie d'un 
groupe de clips multipiste ;

• Modification du tempo d'un groupe mixte de 
clips basés sur des références de tempo et des 
échantillons ;

• Enregistrement dans un groupe de clips ;

• Modification d'une playlist sur une piste faisant 
partie d'un groupe de clips multipiste ;

• Modification dans la vue Playlists ;

• Application d'une distorsion manuelle en vue 
Warp.

La division de groupes de clips peut s'avérer utile 
dans certains cas. Par exemple, si vous appliquez 
un accompagnement aux deux premiers vers d'une 
chanson, vous pouvez grouper les parties 

constituantes du premier vers et les copier en tant 
que groupe de clips pour le deuxième vers, tout en 
conservant une piste vocale continue entre les deux 
groupes de clips.

Groupes de clips sur des 
pistes basées sur des 
références de tempo
Lorsque vous modifiez le tempo, les groupes de clips 
sur les pistes basées sur des références de tempo 
règlent leur longueur en ajustant en conséquence la 
position de tous leurs clips. Ce réglage peut être utile 
dans le cadre de l'organisation de données rythmiques 
et de la lecture de groupes de clips importés à partir de 
fichiers REX et ACID. 

Icône de groupe de clips divisé

Si vous souhaitez supprimer une piste tout 
en conservant intact le groupe de clips, 
commencez par annuler le groupement du 
groupe en question, supprimez ensuite la 
piste, puis reconstituez le groupe de clips. 
Le groupe de clips est recréé sans altération, 
à l'exception de la suppression de la piste.

Groupe de clips sur une piste basée sur des 
références de tempo à 120 BPM et 160 BPM
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Modification de la base de 
temps d'un groupe de clips
Vous pouvez modifier le format de la base de 
temps d'un groupe de clips en effectuant les 
opérations suivantes :

• En modifiant la base de temps de la piste ;

• En déplaçant le groupe de clips sur une piste 
dont la base de temps est différente.

La modification de la base de temps crée une copie 
du groupe de clips d'origine. L'original et la copie 
s'affichent dans la liste des clips avec une base de 
temps différente.

Conversion d'échantillons en références de tempo

Le déplacement d'un groupe de clips d'une piste 
basée sur des échantillons vers une piste basée sur des 
références de tempo ne modifie en rien sa longueur. 
En effet, les échantillons sont convertis en références 
de tempo après le déplacement du groupe sur la piste 
basée sur des références de tempo. La longueur du 
groupe varie uniquement si le tempo est modifié par 
la suite. Si nécessaire, ajustez le tempo local de la 
piste basée sur des références de tempo sur le tempo 
du groupe de clips basé sur des échantillons avant le 
déplacement du groupe.

Conversion de références de tempo en 
échantillons 

Le déplacement d'un groupe de clips d'une piste 
basée sur des références de tempo vers une piste 
basée sur des échantillons ne modifie pas la longueur 
du groupe à moins qu'il ne soit déplacé vers un autre 
emplacement temporel pour lequel un tempo 
différent a été défini. En effet, les références de tempo 
sont converties en échantillons après le déplacement 
du groupe sur la piste basée sur des échantillons. 

Groupes de clips multipistes incluant des 
pistes basées sur des échantillons et des 
pistes basées sur des références de tempo

Les groupes de clips multipistes peuvent inclure 
à la fois des pistes basées sur des échantillons et 
des pistes basées sur des références de tempo. 
Toutefois, la modification du tempo sépare les 
pistes basées sur des échantillons des pistes basées 
sur des références de tempo.

Édition des groupes de clips
L'édition des groupes de clips s'effectue de la 
même façon qu'avec des clips normaux : vous 
pouvez les nommer, les déplacer, les couper, 
les copier, les coller, effectuer un trimming, 
les muter, les verrouiller, etc. Il existe néanmoins 
quelques différences importantes entre l'édition de 
clips normaux et de groupes de clips. 

Édition des groupes de clips MIDI
Toute modification d'un clip MIDI au sein 
d'un groupe de clips crée une copie du clip, 
qui est ensuite superposée au groupe de clips. 
Par exemple, un nouveau clip est créé sur le groupe 
de clips si vous effectuez un enregistrement, 
insérez une note, éditez les données d'un 
contrôleur MIDI ou quantifiez une sélection de 
timeline.

Groupe de clips multipiste dont les pistes basées sur les 
échantillons et les pistes basées sur les références de 
tempo ont été séparées après modification du tempo
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Édition des groupes de clips 
audio
Certaines commandes d'édition audio créent de 
nouveaux clips sur les groupes de clips. Pour les 
utiliser tout en conservant le groupe de clips, 
annulez le groupement des clips, effectuez les 
modifications, puis reconstituez le groupe.

Les commandes d'édition suivantes créent de 
nouveaux clips sur les groupes de clips :

• Le traitement AudioSuite d'un clip groupé 
entraîne la création d'un clip sur le groupe de clips.

• Le regroupement d'une sélection d'un clip 
groupé crée un fichier audio et un clip sur le 
groupe de clips.

• Un enregistrement dans un groupe de clips crée 
un fichier audio et un clip sur le groupe de clips.

• Si vous redessinez une forme d'onde avec le 
Crayon, un nouveau clip est créé sur le groupe 
de clips.

Tabulation vers transitoires et 
limites de clips
Si l'option Tab to Transients est activée, la touche Tab 
permet de déplacer le curseur vers les transitoires et 
les limites de clip internes à un groupe de clips. 

Si l'option est désactivée, la touche de tabulation 
déplace le curseur vers les limites du groupe de 
clips uniquement (et le point de synchronisation, 
le cas échéant).

Trimming de groupes de clips

Le trimming de groupes de clips à l'aide de l'outil 
de trim standard est identique à celui des clips 
classiques, qu'il concerne un groupe de clips 
monopiste ou multipiste.

Le trimming d'un groupe de clips n'agit pas sur les 
clips sous-jacents ; il s'applique aux limites du 
groupe de clips. Les clips sous-jacents conservent 
leur longueur et leur emplacement d'origine. Cette 
règle s'applique à tous les clips MIDI et audio 
sous-jacents, ainsi qu'aux groupes de clips 
imbriqués. Si les clips sous-jacents d'un groupe de 
clips se retrouvent en dehors des limites du groupe 
après une opération de trimming, ils seront peut-
être inaudibles à la lecture. 

Lorsque vous effectuez un trimming sur des 
groupes de clips avec l'outil de trim TC/E, 
le trimming s'applique uniquement aux clips audio 
ou MIDI, selon le type de clip contenu dans le 
groupe qui fait l'objet du trimming. Un nouveau 
clip est créé sur le groupe de clips.

Après avoir effectué le trimming d'un groupe, 
si vous annulez le groupement, les clips audio se 
retrouvant en dehors des limites du groupe actif 
sont ajustés de manière à respecter les limites du 
groupe de clips ou sont supprimés.

Enregistrement
Lors d'enregistrements audio ou MIDI, de nouveaux 
clips sont superposés, et non inclus, aux groupes de 
clips. Pour enregistrer dans un groupe de clips, 
annulez d'abord le groupement des clips, effectuez 
l'enregistrement, puis regroupez les clips. Le groupe 
de clips est recréé sans altération, à l'exception des 
nouvelles données de l'enregistrement.

Pour plus d'informations, reportez-vous à la 
section « Tabulation vers les transitoires » à 
la page 587.
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Fondus et fondus enchaînés 
sur des groupes de clips
Tout comme les clips normaux, les groupes de clips 
peuvent comporter des fondus et des fondus 
enchaînés. Toutefois, les fondus s'appliquent 
uniquement aux clips audio. Vous pouvez créer un 
fondu enchaîné entre des groupes de clips, mais aussi 
entre des groupes de clips et des clips audio normaux.

Gain du clip et groupes de 
clips
Les paramètres de gain des clips individuels sont 
préservés dans les groupes de clips. Vous pouvez 
également ajuster les réglages de gain de ces 
groupes de clips. L'édition du gain de clip a un 
comportement identique, qu'elle s'applique à un 
clip spécifique ou à un groupe de clips (reportez-
vous à la section « Gain du clip » à la page 611).

Pour ajuster les réglages de gain des clips 
individuels constituant un groupe de clips, les clips 
doivent être dégroupés au préalable, édités, puis 
regroupés. 

Les réglages de gain du clip sont conservés lorsque 
les groupes de clips sont exportés. Les groupes de 
clips peuvent ensuite être importés dans d'autres 
sessions avec les mêmes réglages de gain du clip.

Deux groupes de clips multipistes adjacents, avec des 
fondus enchaînés sur les pistes audio et sans fondu 
enchaîné sur la piste MIDI

L'annulation du groupement d'un groupe de 
clips supprime tous les fondus et fondus 
enchaînés au niveau du groupe de clips. Ils sont 
restaurés dès que le groupe est reconstitué.

Les groupes de clips comprenant des clips 
avec fondus ne sont pas autorisés sur les pistes 
Elastic Audio.

Lorsque vous modifiez le tempo avec des 
groupes de clips appartenant à des pistes 
basées sur des références de tempo, vous 
devrez peut-être annuler le groupement, 
rétablir ou créer des fondus, puis regrouper 
les clips afin de conserver les fondus.

Pour plus d'informations sur l'utilisation des 
fondus et des fondus enchaînés dans 
Pro Tools, reportez-vous au Chapitre 28, 
« Fondus et fondus enchaînés ».

Groupe de clips avec réglages de gain des clips
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Importation et exportation 
de fichiers des groupes de 
clips
Pro Tools permet d'exporter et d'importer des 
groupes de clips sous forme de fichiers .cgrp afin 
d'autoriser les opérations suivantes :

• séparation des métadonnées des groupes de clips 
des fichiers audio pour éviter les opérations de 
copie de fichiers inutiles lors de l'exportation de 
groupes de clips audio composés de plusieurs 
fichiers source ;

• exportation des données MIDI sous forme de 
groupe de clips ;

• création de boucles multipistes ;

Les fichiers de groupe de clips contiennent les 
métadonnées suivantes :

• Références à tous les fichiers audio au sein du 
groupe de clips ;

• Noms des clips et emplacements relatifs dans les 
pistes ;

• Fondus et fondus enchaînés intégrés ;

• Paramètres de gain de clip pour les groupes de 
clips et chaque clip du groupe ;

• Noms et format (monopiste ou multipiste) des 
groupes de clips ;

• Toutes les données MIDI du groupe de clips 
(notes, contrôleurs, données Sysex, etc.) ;

• Nom des pistes ;

• Marqueurs de distorsion Elastic Audio et facteur 
TCE ;

• Base de temps du clip (références de tempo ou 
échantillons) ;

• Points de synchronisation ;

• Boucles ;

• Table de tempos.

Les fichiers de groupe de clips ne contiennent pas 
les données suivantes :

• Automation ; 

• Plug-ins ;

• Assignation des pistes ;

• Table de métriques ; 

• Informations de la liste des clips.

Les groupes de clips créés avec Pro Tools 10 
(.cgrp) ne peuvent pas être importés dans les 
versions antérieures de Pro Tools, tandis que 
les groupes de régions (.rgp) créés dans des 
versions antérieures de Pro Tools peuvent 
être importés dans Pro Tools 10. Pour plus d'informations, reportez-vous à la 

section « Importation et exportation de 
fichiers de groupe de clips » à la page 388.
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Chapitre 39 : Traitement AudioSuite

Les plug-ins AudioSuite servent à appliquer un 
traitement avec rendu qui modifie les fichiers 
audio sur le disque. Le traitement AudioSuite est 
appliqué en temps non réel, ou rendu, sur des clips 
audio sélectionnés dans votre session Pro Tools. 
Selon sa configuration, un plug-in AudioSuite 
modifiera le fichier audio source ou créera un 
fichier audio source entièrement nouveau. 

Menu AudioSuite
L'accès aux plug-ins AudioSuite s'effectue depuis 
le menu AudioSuite. Dans le menu AudioSuite de 
Pro Tools, les plug-ins peuvent être classés par 
ordre alphabétique, catégorie, fabricant, 
ou catégorie et fabricant. 

Pour ouvrir une fenêtre de plug-in AudioSuite :

1 Créez une sélection d'édition incluant le ou les 
clips audio à traiter.

2 Dans le menu AudioSuite, sélectionnez le 
plug-in souhaité.

Fenêtre AudioSuite
Lorsque vous sélectionnez un plug-in dans le menu 
AudioSuite, la fenêtre AudioSuite s'affiche. Cette 
fenêtre flottante permet d'accéder et d'ajuster les 
commandes du plug-in AudioSuite sélectionné.

Pour plus d'informations sur les plug-ins 
AudioSuite spécifiques fournis avec 
Pro Tools, reportez-vous au Guide des 
plug-ins audio.

Pour plus d'informations, reportez-vous à la 
section « Organisation des menus de plug-ins » 
à la page 1039.

 Fenêtre AudioSuite du plug-in EQ III 1 bande
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En-tête de la fenêtre 
AudioSuite
L'en-tête de la fenêtre AudioSuite contient des 
commandes permettant de changer de plug-in 
AudioSuite, de manipuler les presets et de choisir la 
façon dont sera appliqué le traitement AudioSuite.

Sélecteur de plug-in AudioSuite
Ce menu permet de sélectionner les plug-ins 
AudioSuite installés dans le dossier Plug-Ins. 
Les plug-ins sont répertoriés dans le menu du 
sélecteur de plug-ins, selon la configuration du 
paramètre Organize Plug-Ins Menu By des 
préférences d'affichage.

Référence de sélection
Ce menu limite le traitement sélectionné aux clips 
sélectionnés sur une piste audio, une playlist ou 
dans la liste des clips.

Lorsque vous sélectionnez un clip (sur une piste 
audio/playlist ou dans la liste des clips), Pro Tools 
sélectionne en principe les deux occurrences du 
clip. Si vous souhaitez appliquer le traitement 
uniquement à l'une de ces occurrences, utilisez ce 
menu pour restreindre la portée du traitement 
AudioSuite.

Playlist : applique le traitement AudioSuite aux 
clips sur la timeline (playlists des pistes audio). 
Les clips traitées apparaissent également dans la 
liste des clips.

Clip List : applique le traitement AudioSuite 
uniquement aux clips sélectionnés dans la liste des 
clips. Le traitement AudioSuite n'est pas appliqué 
aux clips présents sur la timeline (playlists des 
pistes audio).

 En-tête de la fenêtre AudioSuite

Menu des plug-ins (affichage par ordre alphabétique, 
sans catégorie)

Bouton Use in Playlist
Menu de paramètres 
de plug-in

Bouton de ciblage

Menu de 
bibliothèque

Référence de sélection

Sélecteur de plug-in

Sélecteur du mode de fichier

Sélecteur du mode de traitement Bouton Compare

Sélection de
paramètres

Paramètre suivant
Paramètre précédent

Menu de la référence de sélection (plug-in Invert)

Si l'option Use In Playlist est activée 
conjointement à l'option Clip List du menu de 
la référence de sélection, le traitement est 
appliqué au clip sélectionné à la fois dans la 
playlist et dans la liste des clips.
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Traitement AudioSuite de groupes de clips de la 
liste des clips

Les plug-ins AudioSuite peuvent traiter les 
groupes de clips de la liste des clips avec certaines 
restrictions. Les traitements AudioSuite sont 
appliqués à toutes les copies d'un fichier audio 
unique dans votre session lorsque les options Clip 

List et Use in Playlist sont activées. Cependant, 
si un groupe de clips est sélectionné dans la liste 
des clips pour un traitement AudioSuite, Pro Tools 
ne le reconnaît pas en tant qu'audio. Cela est dû au 
fait qu'un groupe de clips n'est pas considéré en 
tant qu'audio avant d'être utilisé sur une piste. Pour 
appliquer un traitement AudioSuite à un groupe de 
clips de la liste des clips, dégroupez au préalable 
les clips du groupe, puis regroupez-les après leur 
traitement.

Pour appliquer un traitement AudioSuite 
simultanément à toutes les copies d'un groupe de 
clips d'une session, procédez comme suit :

1 Sélectionnez le groupe de clips à traiter.

2 Dans le menu Clip, sélectionnez Ungroup All. 
L'ensemble des éléments du groupe restent 
sélectionnés.

3 Appliquez le traitement AudioSuite.

4 Dans le menu Clip, sélectionnez Regroup.

Lorsque vous y êtes invité, sélectionnez Modify 
afin d'appliquer le traitement AudioSuite à toutes 
les copies du groupe de clips dans la session, 
ou Copy pour l'appliquer uniquement au groupe de 
clips sélectionné.

Bouton Use In Playlist
Ce bouton détermine si le traitement AudioSuite 
doit remplacer toutes les occurrences des clips 
sélectionnés sur l'ensemble de la session ou 
uniquement les occurrences des clips actuellement 
sélectionnés.

Bouton Use In Playlist désactivé : lorsque le 
bouton Use in Playlist est désactivé, une nouvelle 
version traitée du clip sélectionné est ajoutée à la 
liste des clips. Aucun clip d'origine n'est remplacé 
ou écrasé, quel que soit l'emplacement dans la 
session.

Bouton Use In Playlist activé, référence = Clip 
List : lorsque le bouton Use In Playlist est activé et 
que le menu de la référence de sélection est défini 
sur Clip List, toutes les copies du clip sélectionné 
sont remplacées, quel que soit leur emplacement 
dans la session.

Bouton Use In Playlist activé, référence = Playlist : 
lorsque le bouton Use in Playlist est activé et que le 
menu de la référence de sélection est défini sur 
Playlist, seuls les clips sélectionnés sur les pistes de 
la fenêtre Edit sont remplacés. Si la session inclut 
d'autres copies du clip utilisées dans d'autres 
playlists, ces copies du clip original non traité ne 
sont pas remplacées.

Sélecteur de mode de fichier
Ce menu permet de spécifier la façon dont le 
plug-in AudioSuite doit traiter l'audio sélectionné 
(destructive ou non destructive) et dont il doit 
modifier les fichiers d'origine.

Si le menu de la référence de sélection est 
défini sur Clip List, le bouton Use in Playlist 
est automatiquement désactivé pour éviter de 
remplacer accidentellement toutes les 
occurrences du clip dans une session.

Menu du mode de fichier (plug-in Invert)
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Trois modes de fichier sont disponibles :

Overwrite Files : traite les clips sélectionnés de 
manière destructive en remplaçant l'audio 
d'origine. Certains plug-ins AudioSuite ne peuvent 
pas être utilisés dans ce mode. 

Create Individual Files : traite les clips audio 
sélectionnés de manière non destructive, en créant 
un nouveau fichier audio pour chaque clip. 
Les nouveaux fichiers audio sont ensuite ajoutés 
à la session, et les fichiers audio source de la liste 
des clips restent inchangés. Le paramètre de la 
référence de sélection détermine si les données 
audio traitées sont ajoutées à la playlist actuelle ou 
seulement à la liste des clips.

Create Continuous File : traite les clips audio 
sélectionnés de manière non destructive, en créant 
un nouveau fichier audio composé des clips 
sélectionnés consolidés en un seul clip 
ininterrompu. Ce mode est particulièrement utile 
pour assembler une piste composite créée à partir 
de plusieurs prises. Ce mode n’est pas disponible 
lorsque la référence de sélection est définie sur 
Clip List.

Sélecteur de mode de 
traitement
Si votre sélection est composée de plusieurs clips, 
ce menu déroulant permet de spécifier si le 
traitement AudioSuite doit être appliqué clip par 
clip ou sur l'ensemble de la sélection.

Clip by Clip : analyse individuellement chaque 
clip de la sélection, plutôt que la sélection entière 
de clips. 

Entire Selection : analyse l'ensemble de la 
sélection en une seule fois. Tous les clips seront 
analysés et traités en fonction de la durée totale de 
la sélection.

Commandes des presets des 
plug-ins AudioSuite
La plupart des plug-ins AudioSuite permettent de 
charger et d'enregistrer des presets (fichiers 
de paramètres de plug-in). Cependant, certains 
plug-ins AudioSuite, tels que DC Offset Removal 
ou Duplicate, n'incluent pas de commandes de 
preset ni aucune commande de paramètre.

Sélecteur de plug-in : permet de sélectionner un 
plug-in AudioSuite installé sur votre système.

Menu des paramètres de plug-in : permet de 
copier, coller, enregistrer et importer des presets de 
plug-in.

L'option Create Continuous File n'est pas 
disponible avec certains plug-ins de 
manipulation temporelle. Pour obtenir un 
résultat similaire, utilisez le plug-in 
Duplicate pour consolider des clips traités 
avec ces plug-ins.

Sélecteur de mode de traitement (plug-in Invert)

 Commandes de preset AudioSuite

Pour plus d'informations sur les presets de 
plug-in, reportez-vous à la section « Presets 
de plug-in » à la page 1048.

Menu de paramètres de plug-in

Menu de bibliothèque

Bouton Compare

Sélection de paramètres

Paramètre suivant

Paramètre précédent
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Menu de bibliothèque du plug-in : rappelle des 
fichiers de paramètres (presets) enregistrés à la 
racine du dossier du plug-in ou dans le dossier 
Settings de la session actuelle.

Boutons Paramètre précédent (-) et Paramètre 
suivant (+) : permettent de sélectionner le 
paramètre de plug-in précédent ou suivant dans le 
menu de bibliothèque du plug-in.

Bouton de sélection de paramètres de plug-in : 
ouvre la boîte de dialogue des paramètres de 
plug-in qui répertorie les presets du plug-in 
actuel. Dans cette liste, vous pouvez sélectionner 
un nouveau preset ou écouter l'aperçu d'une série 
de presets.

Bouton Compare : bascule entre les presets 
d'origine du plug-in et leurs valeurs après 
modification, afin de comparer les effets obtenus.

Bouton de ciblage
Plusieurs fenêtres de plug-in AudioSuite peuvent 
être affichées simultanément dans Pro Tools. 
Chaque fenêtre de plug-in AudioSuite dispose de 
son propre bouton de ciblage. Les fenêtres de 
plug-in non ciblées restent ouvertes, alors que 
différents plug-ins AudioSuite peuvent être 
chargés et être paramétrés dans la fenêtre de plug-
in ciblée.

Pour activer ou désactiver le ciblage d'une fenêtre 
de plug-in AudioSuite :

 Cliquez sur le bouton de ciblage de la fenêtre de 
plug-in AudioSuite afin de l'allumer (fenêtre 
ciblée) ou de l'éteindre (fenêtre non ciblée).

Autres commandes AudioSuite
En plus des commandes AudioSuite standard 
communes à tous les plug-ins AudioSuite, 
plusieurs paramètres spécifiques figurent sur 
certaines fenêtres de plug-in :

Sélecteur de déclencheur

Ce bouton sélectionne la piste ou le bus utilisé pour 
déclencher le traitement. Pour utiliser cette 
fonction, l'audio source utilisé comme déclencheur 
doit être placé à la même position temporelle que 
l'audio traité. L'entrée side chain est 
monophonique. Reportez-vous à la section 
« Entrée side-chain » à la page 1047.

Bouton de mode de canal

Le bouton de mode de canal permet de traiter des 
canaux contigus d'un clip sélectionné comme s'il 
s'agissait de pistes mono ou stéréo (et dans certains 
cas de pistes de format supérieur à stéréo), quel que 
soit le type de piste sur lequel ils sont placés.

Mode Mono : traite chaque canal contigu d'un clip 
sélectionné en tant que piste mono distincte. Un clip 
composé de six pistes mono, par exemple, serait 
traité comme s'il s'agissait de six pistes mono.

Mode Stereo : traite chaque paire contiguë de 
canaux d'un clip sélectionné en tant que piste stéréo. 
Lorsqu'il est appliqué à un nombre impair de 
canaux, le plug-in traite le dernier canal seul, 
de numéro impair, en mode mono, avec les 
paramètres du canal gauche du plug-in stéréo. 
Si vous souhaitez que la dernière piste soit traitée 
en stéréo, vous devez sélectionner une piste 
supplémentaire pour l'apparier (une piste vide, 
si nécessaire).

Enregistrez les paramètres de plug-in 
actuels avant d'utiliser les boutons 
Précédent et Suivant, ou ces réglages 
seront perdus. Enregistrez toujours vos 
paramètres de plug-in en tant que presets 
dans le menu des paramètres de plug-in.

Les entrées side chain des plug-ins n'ont 
aucun effet sur les traitements AudioSuite 
lorsque l'option Clip List est sélectionnée 
dans le menu de référence de sélection.
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Un clip composé par exemple de deux pistes mono 
serait traité en tant que piste stéréo : la première 
piste mono serait traitée en tant que canal gauche et 
la seconde piste mono en tant que canal droit.

Mode Multi : traite chaque groupe de trois canaux 
contigus ou plus d'un clip sélectionné en tant que 
piste stéréo de format supérieur à stéréo, dont le 
nombre de canaux sélectionnés détermine le type 
de piste. Cinq canaux contigus sélectionnés, 
par exemple seraient traités en tant que piste 5.0, 
alors que sept canaux contigus sélectionnés 
seraient traités en tant que piste 7.1.

Bandeau inférieur de la 
fenêtre AudioSuite
Le bandeau inférieur de la fenêtre AudioSuite 
donne accès à des commandes destinées à l'écoute 
de l'aperçu et à l'application du traitement 
AudioSuite.

Bouton d'aperçu
Le bouton d'aperçu permet d'écouter l'effet d'un 
plug-in avant d'appliquer le traitement à l'audio. 
Vous pouvez ajuster précisément l'effet obtenu en 
utilisant les commandes du plug-in, tout en 
écoutant l'aperçu. L'aperçu n'est pas pris en charge 
par tous les plug-ins AudioSuite. 

La fonction d'aperçu route l'audio vers les sorties 
spécifiques sélectionnées pour le paramètre 
Audition Path de la page Outputs de la boîte de 
dialogue I/O Setup. Assurez-vous que cette option 
est correctement configurée sur votre système afin 
de pouvoir écouter cet aperçu audio. 

Avant d'écouter l'aperçu d'un traitement 
AudioSuite, notez les points suivants : 

 Les performances de la fonction d'aperçu 
dépendent de la vitesse de votre CPU. Plus 
l'ordinateur est rapide, plus l'aperçu des effets 
AudioSuite est fidèle.

 Quel que soit le nombre de pistes ou de clip 
sélectionnés, le bouton d'aperçu lance uniquement 
l'écoute de la première piste stéréo sélectionnée ou 
de la première paire de pistes mono sélectionnée.

 En mode Mono, seul le premier canal d'un clip 
multicanal sélectionné sera pris en compte pour 
l'aperçu.

 Si vous utilisez le mode de traitement Clip by 
clip, l'aperçu ne lira que le premier clip d'une 
sélection de plusieurs clips. Pour écouter tous les 
clips sélectionnés, activez temporairement l'option 
Create Continuous File du menu de mode de 
fichier avant de lancer l'aperçu.

Commande de volume de 
l'aperçu
La commande de volume de l'aperçu de la fenêtre 
AudioSuite permet d'ajuster le volume de l'aperçu 
du traitement AudioSuite.

Le mode Multi est uniquement disponible 
pour certains plug-ins, tels que le 
Dynamics III.

 Bandeau inférieur de la fenêtre AudioSuite

Bouton d'aperçu

Volume d'aperçu
Indicateurs de niveau d'aperçu Bouton Render

Bouton Bypass Bouton Whole File

Durée des poignées

Pour plus d'informations sur la boîte de 
dialogue I/O Setup et la configuration des 
sorties audio de votre système, reportez-vous 
à la section « Audition Paths » à la page 78.
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Pour ajuster le volume de l'aperçu du traitement 
AudioSuite :

1 Cliquez sur la commande de volume de 
l'aperçu.

2 Un fader apparaît ; faites-le glisser vers le haut 
pour augmenter le volume de l'aperçu ou vers le 
bas pour le réduire.

Indicateurs de niveau d'aperçu

Les indicateurs de niveau d'aperçu affichent les 
niveaux de l'aperçu du traitement AudioSuite. 
Ils permettent de contrôler d'éventuels écrêtages 
dans le signal traité.

Bouton Bypass
Lorsque le bouton Bypass est activé dans la 
fenêtre AudioSuite, aucun traitement n'est 
appliqué pour l'aperçu de l'audio sélectionné. 
Le bouton Bypass n'affecte que l'aperçu et n'agit 
pas sur le traitement AudioSuite réel. 

Bouton Reverse
Pro Tools propose un bouton Reverse dans le 
bandeau inférieur de la fenêtre des plug-ins 
AudioSuite de delay et de reverb. Il permet de 
générer rapidement un rendu d'effet de delay ou 
reverb inversé, en un seul clic. En cliquant sur le 
bouton Reverse, les trois opérations suivantes sont 
effectuées : 

• la sélection d'édition est tout d'abord inversée ;

• le traitement est ensuite appliqué à la sélection 
d'édition inversée avec les paramètres de plug-in 
actuels ;

• enfin, la sélection d'édition traitée est à nouveau 
inversée. 

Bouton Whole File
Lorsque le bouton Whole File de la fenêtre 
AudioSuite est activé, l'audio sélectionné est rendu 
dans un nouveau clip dont la durée correspond 
exactement à celle de la sélection. Cependant, il est 
possible de réaliser une opération de trim sur le 
clip pour récupérer l'ensemble de la durée du 
fichier entier. Cette option n'est pas disponible en 
mode Create Continuous File ou pour un rendu en 
mode Entire Selection combiné avec le mode 
Create Individual Files.

Durée des poignées
Le champ de durée des poignées définit la 
durée des poignées ajoutées lors du rendu, 
de 0 à 60 secondes. Cela signifie qu'il est possible 
d'effectuer des opérations de trim au-delà de la 
sélection rendue après traitement, sur la durée de 
poignée spécifiée. Pour plus d'informations, 
reportez-vous à la section « Poignées AudioSuite » 
à la page 898.

Bouton Render
Cliquez sur le bouton Render pour appliquer le 
traitement AudioSuite à l'audio sélectionné. 
Le traitement peut être appliqué en cours de 
lecture (il prendra alors un peu plus de temps). 
Les fichiers traités reçoivent automatiquement le 
nom du clip ou du fichier audio, auquel est ajouté 
un acronyme correspondant au traitement 
AudioSuite appliqué. 

Ajustement du volume de l'aperçu du traitement 
AudioSuite
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Les nouveaux fichiers sont écrits sur le disque dur 
défini pour cette piste dans la boîte de dialogue Disk 
Allocation ou sur le disque du fichier original si le clip 
ne figure sur aucune piste. Reportez-vous à la section 
« Attribution de noms automatique aux fichiers audio 
traités par AudioSuite » à la page 896.

Traitement multicanal

La plupart des plug-ins AudioSuite sont capables 
de traiter jusqu'à 48 canaux audio simultanément.

Annulation d'un traitement AudioSuite

Si vous avez traité une sélection audio de manière 
non destructive, les commandes Undo et Redo 
permettent d'annuler et de rétablir le traitement 
AudioSuite appliqué. Vous pouvez annuler ou 
rétablir un traitement AudioSuite pendant la 
lecture audio. 

Attribution de noms automatique aux fichiers 
audio traités par AudioSuite

Pro Tools attribue automatiquement un nom aux 
fichiers audio créés suite à un traitement 
AudioSuite. Ce nom est fonction du type de plug-in 
utilisé. Le nom du clip détermine le préfixe et le type 
de plug-in AudioSuite détermine le suffixe.

L'attribution automatique de noms aux fichiers 
obéit aux règles suivantes :

 Le nom des nouveaux clips commence par le 
nom du clip, suivi d'une abréviation du traitement 
AudioSuite appliqué, puis du numéro de fichier et 
de clip Pro Tools standard.

 Si le mode de fichier du plug-in est configuré 
sur Overwrite Files, le nom du clip original ne sera 
pas modifié. 

 Si le mode de fichier du plug-in est configuré 
sur Create Individual Files, une version abrégée du 
nom du plug-in sera ajoutée à la fin du nom du clip.

Utilisation des plug-ins 
AudioSuite
Vous pouvez appliquer les plug-ins AudioSuite 
à des clips entiers, des portions de clips ou des 
sélections composées de clips entiers et partiels, 
présents sur une ou plusieurs pistes.

Si l'audio sélectionné dans la fenêtre Edit inclut 
des clips partiels, ils seront automatiquement 
séparés en deux ou plusieurs clips lors du 
traitement. Le traitement n'est appliqué qu'à la 
sélection, les autres clips restent inchangés.

Seuls les fichiers audio stockés sur des disques 
durs locaux peuvent être traités avec des plug-ins 
AudioSuite. Il est impossible de traiter des fichiers 
audio enregistrés sur des lecteurs distants sur un 
réseau (à moins qu’il ne s’agisse d’un réseau Avid 
Unity). 

Lorsque plusieurs clips de formats différents 
sont sélectionnés (mono et surround 
multicanal, par exemple), tous les canaux 
seront traités selon le format de canal du plug-
in AudioSuite. Les plug-ins AudioSuite Mono 
peuvent traiter des clips stéréo, et vice versa.

L'annulation est impossible lorsqu'un 
plug-in fonctionne en mode destructif, 
car le traitement modifie directement le 
fichier audio source.

Le traitement d'un clip verrouillé entraîne 
son déverrouillage, et le traitement d'un clip 
muté le démute.
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Pour traiter de l'audio avec un plug-in AudioSuite : 

1 Effectuez l'une des opérations suivantes :

• Créez une sélection d'édition sur l'audio que 
vous souhaitez traiter.

• Sélectionnez les clips audio que vous souhaitez 
traiter dans la liste des clips.

2 Dans le menu AudioSuite, sélectionnez un 
plug-in AudioSuite. 

3 Ajustez les commandes du plug-in pour obtenir 
l'effet souhaité. Ces paramètres déterminent les 
modalités de traitement du fichier et l'effet du 
traitement sur les clips d'origine. 

• Pour ne traiter le clip sélectionné que sur la piste 
où il apparaît, sélectionnez Playlist dans le menu 
de la référence de sélection. Si vous souhaitez 
traiter le clip sélectionné dans la liste des clips 
uniquement, sélectionnez Clip List.

• Si vous souhaitez traiter et mettre à jour chaque 
occurrence du clip sélectionné sur l'ensemble de 
la session, activez le bouton Use In Playlist 
(et sélectionnez Clip List dans le menu de la 
référence de sélection). Si, au contraire, vous ne 
souhaitez pas mettre à jour toutes les 
occurrences du clip sélectionné, désactivez le 
bouton Use In Playlist.

• Pour que le traitement du plug-in soit destructif, 
sélectionnez Overwrite Files dans le menu du 
mode de fichier. Les fichiers audio source seront 
alors modifiés de manière irréversible. 

• À l'inverse, pour appliquer un traitement non 
destructif, sélectionnez le mode de fichier 
Create Individual Files. De nouveaux fichiers 
audio traités par le plug-in AudioSuite seront 
ainsi créés, les fichiers audio source d'origine 
resteront quant à eux inchangés.

• Si vous avez sélectionné plusieurs clips à traiter 
et souhaitez créer un nouveau fichier consolidé 
les incluant tous, sélectionnez Create 

Continuous File dans le menu de mode de 
fichier.

4 Cliquez sur le bouton d'aperçu pour écouter le 
traitement AudioSuite de votre sélection. 

5 Si nécessaire, ajustez les commandes du plug-in.

6 Lorsque les résultats vous conviennent, cliquez 
sur le bouton Render. 

L'audio sélectionné est traité avec les réglages 
définis. Pro Tools ajoute du texte au nom du clip, 
pour indiquer le traitement AudioSuite qui a été 
appliqué. Les nouveaux fichiers correspondants 
apparaissent dans la liste des clips.

Sélection de pistes pour un 
traitement AudioSuite
Les traitements AudioSuite sont appliqués sur les 
clips spécifiques que vous sélectionnez, il est donc 
important de ne sélectionner que les clips ou 
portions de clips que vous souhaitez réellement 
traiter. 

Lorsque vous traitez un seul canal audio avec 
un plug-in AudioSuite, assurez-vous qu'il soit 
bien en mode Mono (le cas échéant).
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Sélection de pistes pour un 
traitement de delay ou de reverb
Certains effets AudioSuite, tels qu'un delay ou une 
reverb, continuent à générer des données après à la 
fin de l'audio sélectionné. Il est donc important de 
sélectionner une plage plus longue que les données 
source originales afin que le plug-in puisse écrire 
la fin du fichier audio traité. Si vous sélectionnez 
seulement les données d'origine sans laisser 
d'espace supplémentaire à la fin, tout decay de 
réverbération ou delay encore présent après la fin 
du clip sera coupé.

Pour éviter ce phénomène, placez votre clip sur 
une piste et sélectionnez l'audio plus une quantité 
d'espace vide après la fin du clip, suffisante pour 
enregistrer le delay ou le decay de reverb produit 
par le plug-in. Des données pourront alors être 
écrites à la fin du clip, selon l'effet appliqué. 
Si vous sélectionnez plus de temps que nécessaire, 
vous pourrez toujours effectuer un trim après le 
traitement AudioSuite.

Poignées AudioSuite
Pro Tools permet d'ajouter des « poignées » autour 
d'un clip rendu suite à un traitement AudioSuite. 
D'une durée de 0 à 60 secondes, elles contiennent 
les données situées à chaque extrémité de la 
sélection d'édition actuelle et peuvent même 
inclure l'ensemble du fichier entier référencé par le 
clip. Cela signifie qu'une opération de trim peut 
permettre d'exploiter des données initialement 
situées hors de la sélection rendue.

Pour générer un rendu de clip avec des poignées 
AudioSuite :

1 Sélectionnez le segment d'audio que vous 
souhaitez traiter.

2 Sélectionnez le plug-in AudioSuite que vous 
souhaitez utiliser dans le menu AudioSuite.

3 Configurez les options et paramètres du plug-in 
AudioSuite.

4 Effectuez l'une des opérations suivantes :

• Saisissez la durée de poignée souhaitée dans le 
champ correspondant (0 à 60 secondes). 
La durée de poignée par défaut peut être définie 
dans la boîte de dialogue Preferences.

• Cliquez sur le bouton Whole File pour générer le 
rendu du fichier entier. Notez que seule la 
sélection d'édition actuelle apparaîtra dans la 
timeline.

5 Cliquez sur Render.

La sélection est rendue dans un nouveau clip dont la 
durée correspond exactement à celle de la sélection. 
Cependant, il est possible de réaliser une opération 
de trim sur le clip sur la durée de poignée spécifiée.

Champ de durée de poignée d'une fenêtre de plug-in 
AudioSuite

Option Whole File activée dans la fenêtre d'un plug-in 
AudioSuite
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Préférences de durée de poignée 
AudioSuite par défaut

Dans Pro Tools, deux préférences permettent 
de configurer la durée de poignée AudioSuite 
par défaut. 

Pour définir la durée de poignée AudioSuite 
par défaut :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Processing.

3 Dans la section AudioSuite, activez l'une des 
options suivantes :

• Whole File : par défaut, le rendu est généré sur la 
durée du fichier entier référencé par la sélection.

• Length : par défaut, le rendu est généré sur la 
durée de la sélection, plus la durée de poignée 
spécifiée (0 à 60 secondes).

4 Cliquez sur OK.

Utilisation des plug-ins 
AudioSuite en stéréo
Certains plug-ins AudioSuite peuvent être utilisés 
en mode mono ou stéréo. Si vous prévoyez de les 
utiliser en stéréo, tenez compte des points 
suivants :

 Pour traiter une piste mono et obtenir un résultat 
stéréo, sélectionnez la piste ou le clip souhaité, 
ainsi qu'une piste ou un clip vide. Configurez 
ensuite le plug-in en mode stéréo et activez le 
bouton Sum Inputs (le cas échéant), si vous 
souhaitez centrer le signal non traité. Lorsque 
l'audio aura été traité, vous obtiendrez deux pistes 
ou deux clips représentant les canaux droit et 
gauche du signal audio traité. Réglez le 
panoramique d'une de ces pistes entièrement 
à gauche, et celui de l'autre entièrement à droite. 

 Si vous configurez un plug-in en mode Stereo et 
sélectionnez un nombre impair de pistes de Pro Tools 
à traiter (par opposition à un nombre pair), le plug-in 
traite les pistes sélectionnées par paires, en stéréo. 
Cependant, la dernière piste seule, de numéro impair, 
sera traitée en tant que piste mono, avec les 
paramètres du canal gauche du plug-in stéréo. Si vous 
souhaitez que la dernière piste soit traitée en stéréo, 
vous devez sélectionner une piste supplémentaire 
pour l'apparier (une piste vide, si nécessaire). 

Durée de poignée par défaut dans la section 
AudioSuite des préférences de traitement

Pour plus d'informations, reportez-vous à la 
section « Bouton de mode de canal » à la 
page 893.
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Conditions pour le rendu AudioSuite avec poignées, fondus, 
gain du clip et métadonnées
La plupart des plug-ins AudioSuite proposent plusieurs options de rendu des clips, mais seuls certains 
paramètres permettent de créer des poignées AudioSuite. Par exemple, les poignées AudioSuite ne sont pas 
disponibles en mode Entire Selection (puisque cette option sert à générer un rendu uniquement sur la durée 
de la sélection entière). Les fondus, fondus enchaînés et paramètres de gain du clip sont conservés, selon 
les modes de fichier et de rendu AudioSuite. De plus, les métadonnées des clips peuvent être conservées 
pour les clips rendus dans certaines conditions. Les conditions suivantes s'appliquent.

Création de poignées et critères de conservation des fondus, du gain du clip et des métadonnées avec le rendu 
AudioSuite

Mode de 
fichier

Mode de 
rendu

Compor-
tement des 
poignées

Whole 
File

Fondus
Gain du 
clip

Métadonnées

Overwrite 
File

Clip By 
Clip

Aucune 
poignée

Non 
disponible

Conservés Conservé Conservées

Overwrite 
File

Entire 
Selection

Aucune 
poignée

Non 
disponible

Rendus Rendu Conservées

Individual 
Files

Clip By 
Clip

Poignées 
créées

Disponible Conservés Conservé Conservées

Individual 
Files

Entire 
Selection

Aucune 
poignée

Non 
disponible

Rendus Rendu Conservées

Continuous 
File

Clip By 
Clip

Poignées 
créées au 
début et à la 
fin du 
nouveau 
fichier 
continu

Non 
disponible

Rendus Rendu Non 
conservées

Continuous 
File

Entire 
Selection

Poignées 
créées au 
début et à la 
fin du 
nouveau 
fichier 
continu

Non 
disponible

Rendus Rendu Non 
conservées
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Certains plug-ins dont le traitement dépend de la sélection d'édition (notamment ceux nécessitant une 
passe d'analyse) peuvent ne pas fonctionner comme prévu pour la création de poignées. Dans ce cas, 
il est recommandé de définir la durée de poignée sur zéro.

L'enregistrement destructif et l'enregistrement en mode Destructive Punch ne sont pas pris en charge 
pour les clips AudioSuite rendus avec poignées.
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Chapitre 40 : Elastic Audio

Le traitement Elastic Audio peut être utilisé pour 
appliquer une compression et expansion temporelle 
(TCE) en temps réel et avec rendu aux pistes, ainsi 
qu'un pitch shifting (transposition) aux clips. 
Le traitement Elastic Audio de Pro Tools est basé 
sur des algorithmes de détection des transitoires de 
haute qualité, une analyse rythmique et du tempo, 
ainsi que sur des algorithmes de traitement TCE et 
de pitch shifting en temps réel. Cette fonctionnalité 
permet de transposer rapidement et simplement la 
hauteur de clips audio et de conformer de l'audio 
(beatmatching) à la table de tempos de la session. 
Elle offre également un degré de contrôle inégalé 
sur la détection des transitoires et le traitement TCE 
événement par événement.

Pour le traitement Elastic Audio, Pro Tools 
analyse l'intégralité des fichiers audio pour 
détecter leurs événements transitoires. 
Un événement peut par exemple être un son de 
batterie, une note chantée ou un accord de guitare. 
Ces événements détectés peuvent ensuite servir de 
points de contrôle pour la déformation de l'audio. 
Pro Tools peut déformer automatiquement des 
événements audio (TCE), pour conformer l'audio 
au tempo de la session ou quantifier la position des 
événements audio. Vous pouvez également 
déformer l'audio manuellement à l'aide des outils 
d'édition standard en vue Warp.

Le traitement Elastic Audio est utile pour plusieurs 
workflows courants : manipulation de boucles, 
mise en place d'interprétations, remixage, sound 
design et effets spéciaux ou encore travail sur une 
bande son de film. 

Manipulation de boucles

Si vous travaillez avec des boucles, le traitement 
Elastic Audio permet d'écouter leur aperçu dans 
les navigateurs de l'espace de travail à leur 
tempo d'origine (BPM), ou à celui de la session 
(BPM). Il est également possible d'écouter l'aperçu 
d'une boucle alors que la session est en cours 
de lecture. Une fois la boucle de votre choix 
sélectionnée, faites-la glisser depuis le navigateur 
et ajoutez-la à la session. La boucle se conforme 
automatiquement à la table de tempos de la 
session ainsi qu'à la grille Bars|Beats. Vous pouvez 
ensuite ajuster sa mise en place plus précisément ou 
transposer la hauteur d'un clip afin qu'elle 
corresponde à celle d'autres boucles de votre 
session.

Mise en place d'interprétations

Le traitement Elastic Audio permet de quantifier la 
position d'événements audio afin d'améliorer une 
prise ou même de replacer manuellement une note 
spécifique jouée un peu trop tard. De la même 
manière, une interprétation peut être excellente, 
mais à un tempo légèrement inférieur à celui de la 
session. Le traitement Elastic Audio, basé sur les 
références de tempo déforme automatiquement 
l'audio afin de le conformer aux changements de 
tempo. Lorsque vos pistes sont basées sur des 
références de tempo et que vous augmentez le 
tempo de la session, une compression temporelle 
est automatiquement appliquée à l'audio.
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Remixage

Le traitement Elastic Audio permet de conformer 
rapidement un morceau entier au tempo de la session 
et à la grille Bars|Beats. Il est également possible de 
transposer des clips pour ajuster leur hauteur.

Sound design et effets spéciaux

Utilisez le traitement Elastic Audio pour créer des 
effets spéciaux avec une TCE extrême ou très 
variable ou une manipulation de la hauteur. 
Utilisez l'algorithme Varispeed pour obtenir des 
effets similaires à ceux obtenus avec un 
magnétophone en termes de variation de la vitesse 
et de la hauteur.

Travail sur la bande son d'un film

Si vous travaillez sur la bande son d'une scène d'un 
film, utilisez le traitement Elastic Audio pour 
adapter la durée de la musique aux images. Vous 
pouvez même utiliser les modifications de tempo 
pour créer des accelerando et des ritardando.

Exemple de workflow Elastic 
Audio
Cette section présente certaines tâches Elastic Audio 
de base permettant de manipuler des boucles :

• Créez et configurez une nouvelle session pour 
ce workflow.

• Pour rechercher une boucle dans un navigateur 
de l'espace de travail et écouter son aperçu au 
tempo de la session :

• Importez la boucle au tempo de la session sur 
une piste Elastic Audio basée sur les références 
de tempo.

• Modifiez le tempo de la session pour changer le 
tempo du clip de la piste Elastic Audio basée sur 
les références de tempo.

• Quantifiez la position de l'audio pour appliquer 
un modèle de groove au rythme.

• Transposez le clip afin d'ajuster la hauteur de 
l'audio importé par rapport à celle des autres 
données audio et MIDI de la session.

Pour créer et configurer une session :

1 Créez une session Pro Tools.

2 Réglez la règle de base de temps principale de la 
session sur Bars|Beats. 

3 Assurez-vous d'afficher les règles Tempo 
et Meter. 

4 Utilisez le tempo par défaut de 120 BPM 
à la noire.

N'oubliez pas que lorsque vous effectuez des 
ajustements de tempo pour des sessions qui 
comportent de multiples repères, le timecode 
de repères situés plus tard sur la timeline peut 
être modifié.

Il est déconseillé d'utiliser le traitement 
Elastic Audio pour les workflows de pull-up et 
pull-down. Utilisez les paramètres de pull-up 
ou pull-down en temps réel de la fenêtre 
Session Setup, ou les presets inclus avec les 
plug-ins Time Shift ou X-Form.
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Pour rechercher une boucle dans un navigateur de 
l'espace de travail et écouter son aperçu au tempo 
de la session :

1 Ouvrez l'espace de travail (Window > 

Workspace).

2 Naviguez jusqu'au dossier où sont stockées vos 
boucles de batterie. Double-cliquez sur le nom 
du dossier pour ouvrir une fenêtre de navigateur 
affichant uniquement le contenu du dossier.

3 Sélectionnez la boucle dont vous souhaitez 
écouter l'aperçu.

4 Cliquez sur le bouton d'aperçu pour écouter 
l'aperçu de la boucle à son tempo d'origine.

5 Cliquez sur le bouton de conformation des 
fichiers audio au tempo de la session ; il est mis 
en surbrillance. 

6 Cliquez de nouveau sur le bouton d'aperçu pour 
écouter le fichier au tempo de la session.

7 Notez que si la boucle était basée sur les 
échantillons à l'origine, une fois l'analyse 
effectuée, la durée du fichier est indiquée en 
mesures et en temps et non plus en minutes et en 
secondes, l'icône de fichier basé sur les 
échantillons est remplacée par une icône de 
fichier basé sur les références de tempo et le 
tempo détecté des fichiers est affiché dans la 
colonne Tempo.

8 Répétez les étapes précédentes pour écouter 
l'aperçu d'autres boucles au tempo de la session.

Vous pouvez sélectionner les chemins 
d'écoute utilisés pour l'aperçu dans la fenêtre 
I/O Setup (sélectionnez Setup > I/O, puis 
cliquez sur l'onglet Output).

Boutons d'aperçu et de conformation des fichiers 
audio au tempo de la session d'un navigateur de 
l'espace de travail

Bouton de conformation des fichiers 
audio au tempo de la session

Bouton d'aperçu
Commandes et indicateurs Elastic Audio dans un 
navigateur de l'espace de travail

Icône de fichier basé sur 
les références de tempo

Durée

Tempo 
détecté

Icône de fichier basé 
sur les échantillons
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Pour importer la boucle au tempo de la session :

1 Assurez-vous que le bouton de conformation 
des fichiers audio au tempo de la session soit 
toujours en surbrillance. Le fichier sera ainsi 
importé en tant que clip Elastic Audio basé sur 
les références de tempo et peut être conformé au 
tempo de la session.

2 Faites glisser la boucle à partir du navigateur 
vers la liste des pistes de la fenêtre Edit de 
la session.

3 Un des événements suivants se produit :

• Si la session ne contient aucune piste et si le 
fichier est basé sur les références de tempo, vous 
êtes invité à importer le tempo du fichier ou 
à utiliser le tempo de la session. Pour conserver 
le tempo de la session et conformer la boucle 
à ce tempo, cliquez sur Don't Import. 

• Si la session ne contient aucune piste, le fichier 
est importé et automatiquement conformé au 
tempo de la session.

4 Une nouvelle piste audio basée sur les 
références de tempo est créée avec le plug-in 
Elastic Audio par défaut activé.

5 Si vous avez choisi de ne pas importer le tempo 
d'origine du fichier, vous remarquerez que la 
boucle se conforme à la table de tempos et à la 
grille Bars|Beats de la session. Un indicateur de 
déformation apparaît sur le clip situé sur la piste 
et dans la liste des clips. 

Notez également que la liste des clips contient 
deux clips. L'un d'entre eux correspond au clip du 
fichier entier basé sur les échantillons (le fichier 
source importé), et l'autre à la copie Elastic Audio 
traitée et basée sur les références de tempo.

Si l'option Drag and Drop From Desktop 
Conforms to Session Tempo est définie sur All 
Files dans la page des préférences de 
traitement, vous pouvez également faire 
glisser et déposer des fichiers audio depuis le 
bureau. Ils sont alors importés en tant que 
fichiers Elastic Audio basés sur les 
références de tempo.

Vous pouvez également conformer des clips 
placés sur des pistes Elastic Audio au tempo 
de la session à l'aide de la commande 
Conform to Tempo (reportez-vous à la 
section « Conformation au tempo » à la 
page 803).
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Glisser-déposer d'un fichier audio basé sur les références de tempo vers la liste des pistes, depuis un navigateur 
de l'espace de travail

Nouvelle piste 
Elastic Audio basée sur
les références de tempo

Fichier audio basé sur les références de tempo importé avec traitement Elastic Audio

Indicateurs de déformation

Clip traité Elastic Audio basé sur 
les références de tempo

Clip de fichier entier basé sur 
les échantillons
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Modifiez le tempo de la session pour changer celui 
du clip :

1 Modifiez le tempo de la valeur 120 BPM par 
défaut à la valeur 110 BPM (reportez-vous à la 
section « Tempo » à la page 797).

2 Notez qu'étant donné que le clip est basé sur les 
références de tempo, les pistes Elastic Audio en 
temps réel se conforment automatiquement au 
nouveau tempo.

Quantifiez la position des événements audio pour 
appliquer un modèle de groove :

1 Sélectionnez le clip sur la piste Elastic Audio en 
temps réel basée sur les références de tempo.

2 Sélectionnez Event > Event Operations > 

Quantize.

3 Assurez-vous que l'option Elastic Audio Events 
est bien sélectionnée dans la section What to 
Quantize.

4 Dans le menu Quantize Grid, sélectionnez un 
modèle de groove.

5 Configurez les options restantes.

6 Cliquez sur Apply.

7 Sur la figure ci-après, notez que la position des 
événements audio a été quantifiée selon le 
modèle de groove sélectionné. En vue Warp, 
vous pouvez constater que des marqueurs de 
déformation ont été ajoutés sur tous les 
marqueurs d'événements proches de la grille de 
quantification, et qu'ils ont été utilisés pour 
appliquer la quantification à ces événements. 

Modification du tempo par défaut
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Pour transposer le clip audio d'un ton entier 
vers le bas :

1 Sélectionnez le clip sur la piste Elastic Audio.

2 Sélectionnez Event > Event Operations > 

Transpose.

3 Activez l'option Transpose By.

4 Saisissez « -2 » demi-tons.

5 Cliquez sur Apply.

Événements audio quantifiés (marqueurs de déformation) en vue Warp
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Pistes Elastic Audio
Toutes les pistes audio de votre session Pro Tools 
peuvent être activées pour le traitement Elastic 
Audio. Les pistes Elastic Audio sont basées soit 
sur les échantillons, soit sur les références de 
tempo. Les pistes Elastic Audio basées sur les 
échantillons permettent d'appliquer un traitement 
Elastic Audio en temps réel ou rendu en éditant 
l'audio en vue Warp, en appliquant une 
quantification et en utilisant l'outil de trim TCE. 
Toutefois, seules les pistes Elastic Audio basées 
sur les références de tempo appliquent 
automatiquement un traitement Elastic Audio en 
fonction des changements de tempo de la session.

Activation du traitement 
Elastic Audio sur les pistes
Pour activer le traitement Elastic Audio sur 
une piste :

1 Créez une piste audio ou sélectionnez une piste 
audio existante.

2 Cliquez sur le sélecteur de plug-in Elastic 
Audio de la piste, puis sélectionnez le plug-in 
Elastic Audio adapté au contenu de la piste, 
en fonction des résultats attendus : Polyphonic, 
Rhythmic, Monophonic, Varispeed ou X-Form 
(reportez-vous à la section « Plug-ins Elastic 
Audio » à la page 916). 

Les clips audio de la piste deviennent 
temporairement offline lors de l'analyse, 
et repassent online une fois l'analyse terminée. 
La forme d'onde des clips audio offline pendant 
l'analyse Elastic Audio est grisée.

Lors de l'enregistrement d'une piste Elastic Audio 
en temps réel, une fois l'enregistrement terminé, 
les nouvelles données audio deviennent 
temporairement offline afin d'être analysées, puis 
repassent online une fois l'analyse terminée.

3 Dans le menu des plug-ins Elastic Audio, 
sélectionnez Real-Time Processing ou 
Rendered Processing pour appliquer un 
traitement Elastic Audio en temps réel ou rendu. 

Pour que toutes les nouvelles pistes soient 
basées sur les références de tempo, activez 
l'option New Tracks Default to Tick Timebase 
dans les préférences d'édition. 

Lors de la création de pistes par glisser-déposer 
d'un fichier audio depuis un navigateur de 
l'espace de travail, si le bouton de conformation 
des fichiers audio au tempo de la session est 
activé, Pro Tools crée des pistes Elastic Audio 
basées sur les références de tempo, que le 
fichier analysé par Elastic Audio soit basé sur 
les références de tempo ou les échantillons. Si 
ce bouton n'est pas activé, Pro Tools crée des 
pistes classiques basées sur les échantillons.

Dans Pro Tools HD, le traitement Elastic 
Audio est désactivé sur les pistes assignées 
à une voix. Utilisez l'allocation dynamique 
des voix pour les pistes sur lesquelles vous 
souhaitez utiliser le traitement Elastic Audio. 
Pro Tools prend uniquement en charge 
l'allocation dynamique des voix et ne peut 
pas spécifiquement allouer de voix 
individuelles.

Menu des plug-ins Elastic Audio
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Création de nouvelles pistes 
activées pour le traitement 
Elastic Audio
Les nouvelles pistes créées sont automatiquement 
activées pour le traitement Elastic Audio dans les 
cas suivants :

• Lorsque l'option Enable Elastic Audio On New 

Tracks est activée dans la page des préférences 
de traitement (reportez-vous à la section 
« Options Elastic Audio » à la page 343).

• Lors d'un glisser-déposer de fichiers analysés 
Elastic Audio et basés sur les références de 
tempo, depuis un navigateur de l'espace de travail 
vers la liste des pistes ou un espace vide de la 
fenêtre Edit avec le bouton de conformation des 
fichiers audio au tempo de la session activé 
(reportez-vous à la section « Traitement Elastic 
Audio lors de l'importation » à la page 336).

• Lors d'un glisser-déposer de fichiers REX ou 
ACID depuis le bureau (si l'option REX and ACID 

Files Only ou All Files est activée pour le paramètre 
Drag and Drop from Desktop Conforms to Session 

Tempo de la page des préférences de traitement) 
ou depuis un navigateur de l'espace de travail (si le 
bouton de conformation des fichiers audio au 
tempo de la session est activé) vers la liste des 
pistes ou un espace vide de la fenêtre Edit 
(reportez-vous à la section « Importation de 
fichiers ACID et REX » à la page 339).

Désactivation du traitement 
Elastic Audio sur des pistes
Pour désactiver le traitement Elastic Audio sur 
une piste :

1 Sélectionnez None - Disable Elastic Audio dans 
le sélecteur de plug-in Elastic Audio de la piste.

2 Si la piste a été traitée par Elastic Audio, vous 
êtes invité à annuler (Cancel), restaurer (Revert) 
ou appliquer (Commit) le traitement.

Cancel : le traitement Elastic Audio reste activé 
sur la piste.

Revert : tous les traitements Elastic Audio sont 
supprimés, les clips de la piste d'origine retrouvent 
leur durée d'origine et le traitement Elastic Audio 
est désactivé sur la piste.

Commit : applique les traitements Elastic Audio 
sur la piste, écrit de nouveaux fichiers sur le disque 
et désactive le traitement Elastic Audio sur la piste.

Clips mis à plat
Les clips qui ont été mis à plat lors de la 
désactivation du traitement Elastic Audio sur une 
piste ou du déplacement d'un clip vers une piste 
non Elastic Audio sont enregistrés sur le disque en 
tant que nouveaux fichiers audio. Ces nouveaux 
fichiers audio incluent l'audio du clip, ainsi que les 
fondus éventuels et une plage audio 
supplémentaire de 5 secondes avant et après le 
clip, le cas échéant. 

Désactivation du traitement 
Elastic Audio et playlists 
secondaires
La désactivation du traitement Elastic Audio sur 
une piste affecte toutes les playlists de la piste. 
Tous les clips des playlists de la piste sont générés 
ou retrouvent leur état d'origine, selon l'option 
sélectionnée.

Le traitement Elastic Audio peut être en temps 
réel ou rendu. Le traitement en temps réel est 
instantané, mais sollicite davantage de 
ressources du système. Le traitement rendu est 
appliqué en temps non réel, mais sollicite 
moins de ressources du système. Si vous 
travaillez sur un système disposant de 
ressources limitées, utilisez le traitement 
Elastic Audio rendu. Pour plus d'informations, 
reportez-vous à la section « Traitement Elastic 
Audio en temps réel et rendu » à la page 914.
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Commandes des pistes 
Elastic Audio
Les pistes audio proposent des commandes qui 
permettent d'activer le traitement Elastic Audio, 
de sélectionner le plug-in Elastic Audio et de 
choisir entre un traitement en temps réel ou rendu. 

Sélecteur de plug-in Elastic Audio : sélectionne le 
plug-in Elastic Audio utilisé pour le traitement 
Elastic Audio (reportez-vous à la section « Plug-ins 
Elastic Audio » à la page 916). Vous pouvez 
également utiliser le sélecteur de plug-in Elastic 
Audio pour désactiver le traitement Elastic Audio, 
ainsi que pour sélectionner un traitement en temps 
réel ou rendu (reportez-vous à la section 
« Traitement Elastic Audio en temps réel et rendu » 
à la page 914).

Bouton du plug-in Elastic Audio : affiche le nom 
du plug-in Elastic Audio sélectionné. Cliquez sur 
le bouton du plug-in Elastic Audio pour ouvrir sa 
fenêtre (reportez-vous à la section « Plug-ins 
Elastic Audio » à la page 916).

Indicateur de traitement en temps réel ou rendu : 
s'allume lorsque le traitement Elastic Audio en 
temps réel est activé et s'éteint lorsque le 
traitement Elastic Audio rendu est activé 
(reportez-vous à la section « Traitement Elastic 
Audio en temps réel et rendu » à la page 914).

Vues de piste Elastic Audio
Les pistes Elastic Audio disposent de deux vues de 
piste spéciales : Warp et Analysis.

Vue Warp
La vue Warp permet d'appliquer une déformation 
temporelle (traitement Elastic Audio) à l'audio. 
En vue Warp, vous pouvez créer et éditer des 
marqueurs de déformation. Si vous utilisez le 
traitement Elastic Audio pour corriger la mise en 
place d'une interprétation ou créer des effets 
spéciaux, travaillez en vue Warp (reportez-vous à la 
section « Édition en vue Warp » à la page 920).

Vue Analysis
La vue Analysis permet d'éditer les marqueurs 
d'événements détectés. Dans la plupart des cas, vous 
n'avez pas besoin d'utiliser la vue Analysis. 
Toutefois, avec des données qui ne contiennent 
pas de transitoires marqués, la vue Analysis peut 
permettre d'ajouter ou de repositionner des 
marqueurs d'événements, ou d'en supprimer 
d'autres. Si vous utilisez par exemple le traitement 
Elastic Audio pour corriger la mise en place d'une 
interprétation, vous pouvez passer en vue Analysis 
pour ajouter, déplacer ou supprimer des marqueurs 
d'événements afin d'obtenir un traitement Elastic 
Audio d'une qualité optimale (reportez-vous à la 
section « Édition en vue Analysis » à la page 927). 

Commandes des pistes Elastic Audio

Sélecteur de 
plug-in Elastic 

Audio

Indicateur de 
traitement en 

temps réel 
ou rendu

Bouton du plug-in 
Elastic Audio

Menu déroulant des vues de piste
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Analyse Elastic Audio
Lors de l'enregistrement, de la copie, 
du déplacement ou de l'importation d'audio non 
analysé sur une piste Elastic Audio, ou lors de 
l'activation du traitement Elastic Audio sur une 
piste audio existante, Pro Tools lance une analyse 
automatique des événements transitoires de 
l'audio. En vue Waveform, la forme d'onde 
apparaît tout d'abord grisée car les clips passent 
offline pendant l'analyse Elastic Audio. Une fois 
l'analyse terminée, les données audio repassent 
online. L'analyse Elastic Audio est basée sur les 
fichiers, ce qui signifie que même si vous ne 
travaillez que sur un court clip d'un grand fichier, 
l'intégralité du fichier audio sera analysée.

L'analyse Elastic Audio détecte les événements 
transitoires du fichier audio. Ces événements 
transitoires sont repérés par des marqueurs 
d'événements. Ces marqueurs sont affichés dans les 
vues de piste Warp et Analysis. L'analyse Elastic 
Audio calcule également le tempo d'origine du fichier 
audio analysé et sa durée en mesures et en temps.

Les données d'analyse Elastic Audio (événements 
détectés, tempo et durée en Bars|Beats) sont 
stockées dans le fichier. Dans les navigateurs de 
l'espace de travail, les fichiers audio analysés sont 
indiqués par une coche placée à gauche de leur nom. 
Les durées sont affichées en Bars|Beats, leur base de 
temps en ticks et leur tempo d'origine en BPM.

Détection du tempo
L'analyse Elastic Audio tente de détecter un tempo 
régulier pour toutes les données audio analysées. 
Toutes les données audio contenant un rythme 
périodique et régulier peuvent être analysées avec 
succès en termes de tempo et de durée en mesures 
et en temps. Les fichiers dans lesquels un tempo 
a été détecté sont traités comme des fichiers basés 
sur les références de tempo. Ces fichiers peuvent 
être conformés au tempo de la session pour 
l'aperçu et l'importation.

Les fichiers dans lesquels aucun tempo n'a été 
détecté sont traités comme des fichiers basés sur 
les échantillons. Si le fichier ne contient qu'un seul 
transitoire (dans le cas d'un coup de caisse claire 
unique par exemple), aucun tempo n'est détecté. 
De même, pour les fichiers les plus longs qui 
contiennent des changements de tempo ou des 
rubato, ou qui ne sont pas basés sur des modèles 
rythmiques périodiques et réguliers, aucun tempo 
ne sera détecté et ils seront traités comme des 
fichiers basés sur les échantillons.

Indice de confiance des 
événements
Les événements transitoires sont détectés avec un 
certain indice de confiance. Ce niveau est basé sur 
la clarté relative des transitoires.

Par exemple, il est probable qu'une boucle de batterie 
contienne des transitoires clairs et nets. Ils seront 
détectés avec un indice de confiance élevé. 
À l'inverse, une mélodie de violon jouée legato peut 
ne pas contenir de transitoires très marqués, leur 
indice de confiance sera alors inférieur. 

Notez que l'amplitude des crêtes n'est pas le 
critère mesuré le plus important pour 
déterminer l'indice de confiance d'un 
événement. La netteté des transitoires est 
mesurée en partie selon la transition 
spectrale entre deux instants successifs. 
Cette méthode tend à favoriser les hautes 
fréquences en termes d'indice de confiance 
des événements. Par exemple, si vous 
modifiez le paramètre Event Sensitivity de la 
fenêtre Elastic Properties d'une boucle de 
batterie spécifique, les transitoires les plus 
marqués des sons d'un charley dans les 
hautes fréquences auront un indice de 
confiance d'événement supérieur à celui des 
transitoires moins définis des sons de la 
grosse caisse dans les basses fréquences, 
même si l'amplitude des crêtes du son de la 
grosse caisse est supérieure.
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La méthode de détection des transitoires de Pro Tools 
est très précise et détecte un maximum d'événements 
audio. Par conséquent, il est possible que des 
événements audio soient détectés par erreur. 
Ces événements seront analysés avec un faible indice 
de confiance et pourront être filtrés en réduisant la 
valeur du paramètre Event Sensitivity de la fenêtre 
Elastic Properties (reportez-vous à la section 
« Propriété Event Sensitivity » à la page 931). 
En filtrant les transitoires inappropriés, vous 
obtiendrez un traitement Elastic Audio de 
qualité supérieure. 

À l'inverse, pour les données contenant peu de 
transitoires clairs, l'analyse Elastic Audio peut ne 
pas détecter les événements audio de façon 
précise, et l'indice de confiance des événements 
détectés peut être faible. Vous pouvez 
repositionner ou ajouter des marqueurs 
d'événements aux emplacements appropriés en 
vue Analysis (reportez-vous à la section « Édition 
en vue Analysis » à la page 927). 

Une nappe de synthé homogène par exemple peut ne 
pas contenir de transitoires clairs, et les marqueurs 
d'événements détectés peuvent être placés aux 
mauvais endroits, ou ne pas être détectés du tout. 
En vue Analysis, vous pouvez repositionner, 
supprimer et ajouter des marqueurs d'événements 
à votre convenance (sur les changements d'accord par 
exemple). En positionnant les marqueurs 
d'événements de manière précise, vous obtiendrez de 
meilleurs résultats lors de l'application du traitement 
Elastic Audio.

Traitement Elastic Audio en 
temps réel et rendu
Le traitement en temps réel signifie que tout 
changement apporté au traitement Elastic Audio 
est immédiatement appliqué, qu'il s'agisse d'un 
changement de tempo, d'une déformation TCE 
manuelle ou d'un pitch shifting. Cependant, 
le traitement Elastic Audio en temps réel peut 
consommer de nombreuses ressources du système. 
Le traitement Elastic Audio rendu est donc plus 
indiqué dans certaines situations. En effet, lorsque 
vous apportez un changement au traitement Elastic 
Audio dans ce mode, tous les clips audio concernés 
passent temporairement offline, un nouveau 
fichier audio rendu est généré, puis les clips audio 
repassent online.

Pour traiter de l'audio non rythmique (telles 
que des cordes en legato) avec le plug-in 
Polyphonic, la réduction du nombre de 
marqueurs d'événements garantit 
généralement une qualité sonore optimale. 
Vous pouvez supprimer les marqueurs 
d'événements manuellement en vue Analysis 
(reportez-vous à la section « Édition en vue 
Analysis » à la page 927) ou réduire la valeur 
du paramètre Event Sensitivity de la fenêtre 
Elastic Properties du clip à traiter (reportez-
vous à la section « Fenêtre Elastic 
Properties » à la page 930).

En mode rendu, toute modification apportée 
est calculée à partir des données audio 
source d'origine afin d'éviter une perte de 
qualité due à de nombreuses éditions 
successives.
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Pour activer le mode temps réel ou rendu d'une 
piste Elastic Audio :

1 Cliquez sur le sélecteur de plug-in Elastic 
Audio de la piste.

2 Sélectionnez un plug-in Elastic Audio dans 
ce menu.

3 Sélectionnez ensuite l'une des options 
suivantes :

• Real-Time Processing 

• Rendered Processing 

À propos des fichiers rendus
Pro Tools crée des fichiers temporaires pour 
appliquer le traitement Elastic Audio rendu. 
Ces fichiers sont conservés dans un dossier 
Rendered Files créé automatiquement dans le 
dossier de la session. Une fois que vous avez 
appliqué définitivement le traitement Elastic 
Audio rendu sur une piste, un nouveau fichier est 
enregistré sur le disque dans le dossier Audio Files, 
et le fichier de rendu temporaire à partir duquel il a 
été créé est supprimé du dossier Rendered Files.

Indicateur d'écrêtage
(Traitement rendu uniquement)

Le traitement rendu n'est pas appliqué en temps 
réel, les écrêtages engendrés par le traitement 
Elastic Audio ne sont donc pas indiqués dans la 
fenêtre de plug-in Elastic Audio. Lorsqu'un 
écrêtage dû au traitement Elastic Audio rendu se 
produit, un indicateur d'écrêtage de traitement 
Elastic Audio est ajouté sur le clip, à gauche de 
l'indicateur de déformation. 

Pour éviter un écrêtage en cours de lecture, réduisez 
la valeur de gain d'entrée du clip dans la fenêtre 
Elastic Properties (reportez-vous à la section 
« Fenêtre Elastic Properties » à la page 930).

Sélectionnez l'option Real-Time Processing 
pour un traitement Elastic Audio basé sur les 
références de tempo (tels que les changements 
de tempo). Le traitement audio rendu est plus 
adapté pour les opérations Elastic Audio 
basée sur les échantillons, ou pour économiser 
les ressources du système.

Sélecteur et menu des plug-ins Elastic Audio

Pour basculer entre le traitement Elastic 
Audio en temps réel et rendu, cliquez sur le 
bouton du plug-in Elastic Audio tout en 
maintenant les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées.

Indicateur d'écrêtage Elastic Audio

Indicateurs d'écrêtage Elastic Audio Indicateurs de 
déformation
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Plug-ins Elastic Audio
Pro Tools propose plusieurs algorithmes de 
traitement Elastic Audio en temps réel et rendu pour 
chaque piste. Le plug-in Elastic Audio sélectionné 
détermine la façon dont l'audio est traité. Chaque 
plug-in utilise des algorithmes de traitement Elastic 
Audio différents. Ils sont plus ou moins adaptés aux 
différents types d'audio. Sélectionnez le plug-in 
dont l'algorithme est le plus adapté au contenu de la 
piste que vous souhaitez traiter.

Les plug-ins Elastic Audio disposent de leur 
propre sélecteur, disponible uniquement dans la 
fenêtre Edit. Vous ne pouvez pas insérer de plug-in 
Elastic Audio sur des inserts de piste. 

Les paramètres des plug-ins Elastic Audio ne sont 
pas ajustables, à de rares exceptions près. 
Les commandes ajustables, le cas échéant, sont 
accessibles dans la fenêtre de plug-in Elastic 
Audio. Les paramètres des plug-ins Elastic Audio 
ne peuvent pas être automatisés.

Pour ouvrir une fenêtre de plug-in Elastic Audio :

 Cliquez sur le bouton de plug-in Elastic Audio.

Commandes de la fenêtre de 
plug-in Elastic Audio
La fenêtre de plug-in Elastic Audio offre un 
ensemble de commandes dans son en-tête, 
communes à tous les plug-ins Elastic Audio.

Sélecteur de piste : permet d'accéder à toute autre 
piste audio de la session.

Sélecteur de plug-in : permet de sélectionner un 
plug-in Elastic Audio ou de désactiver le 
traitement Elastic Audio.

Menu des paramètres de plug-in : permet de 
copier, coller, enregistrer et importer des presets de 
plug-in.

Menu de bibliothèque du plug-in : rappelle les 
fichiers de paramètres de plug-in (presets) 
enregistrés à la racine du dossier du plug-in ou 
dans le dossier Settings de la session actuelle.

Boutons Paramètre précédent (–) et Paramètre 
suivant (+) : permettent de sélectionner le 
paramètre de plug-in précédent ou suivant dans le 
menu de bibliothèque du plug-in.

Bouton de plug-in Elastic Audio

Commandes des plug-ins Elastic Audio

Menu de bibliothèque

Sélecteur de piste Menu de paramètres
Bouton de 

ciblage

Sélecteur de plug-in

Paramètre suivant

Bouton Compare
Bouton de sélection de paramètres de
plug-in

Paramètre précédent
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Bouton de sélection de paramètres de plug-in : 
ouvre la boîte de dialogue des paramètres de 
plug-in qui répertorie les presets du plug-in 
actuel. Dans cette liste, vous pouvez sélectionner 
un nouveau preset ou écouter l'aperçu d'une série 
de presets.

Compare : bascule entre les paramètres d'origine 
du plug-in et leurs valeurs après modification, afin 
de comparer les effets obtenus.

Bouton de ciblage : lorsque plusieurs fenêtres de 
plug-in Elastic Audio sont ouvertes, cliquez sur ce 
bouton pour sélectionner le plug-in qui reçoit 
toutes les commandes clavier. Si vous désactivez 
le bouton de ciblage, une autre fenêtre de plug-in 
Elastic Audio peut être ciblée.

Plug-in Polyphonic
Le plug-in Polyphonic applique un algorithme 
général, multitâche, efficace avec un large éventail 
de contenus. Utilisez le plug-in Polyphonic pour 
les boucles complexes et les mix multi-
instruments. Le plug-in Polyphonic prend en 
charge le pitch shifting basé sur les clips.

Follow

La sélection de l'option Follow active un suiveur 
d'enveloppe qui reproduit les caractéristiques 
acoustiques d'origine de l'audio traité. Cliquez sur 
le bouton Follow pour activer ou désactiver le 
suivi d'enveloppe.

Fenêtre d'analyse

Le plug-in Polyphonic offre une commande 
unique d'ajustement de la durée de la fenêtre 
d'analyse du traitement TCE. Testez plusieurs 
valeurs avec différents types de données jusqu'à 
obtenir des résultats optimaux. Le tableau suivant 
indique certaines durées de fenêtre recommandées 
pour différents types de données.

Enregistrez les paramètres de plug-in actuels 
avant d'utiliser les boutons Précédent et 
Suivant, ou ces réglages seront perdus. 
Enregistrez vos paramètres de plug-in en tant 
que presets à l'aide du menu de paramètres 
du plug-in.

Le plug-in Polyphonic est le plug-in par 
défaut utilisé pour l'aperçu et l'importation 
depuis les navigateurs de l'espace de travail 
ou la liste des clips.

Plug-in Elastic Audio : Polyphonic

Si vous travaillez fréquemment avec des types 
de données différents, trouvez les réglages de 
durée fenêtre optimaux pour chacun de ces 
types et enregistrez-les en tant que paramètres 
de plug-in afin de pouvoir les rappeler 
facilement et rapidement.

Type de données
Durée de fenêtre 
recommandée

Polyvalent 30 à 40 ms

Percussions 20 ms ou inférieure

Pads et autres 
contenus legato

60 ms ou supérieure
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Plug-in Rhythmic
Le plug-in Rhythmic est le plus adapté aux données 
contenant des transitoires d'attaque marqués, telles 
que les pistes de batterie. Le plug-in Rhythmic 
prend en charge le pitch shifting basé sur les clips.

Decay Rate

La commande Decay Rate détermine la quantité de 
decay audible après chaque transitoire de l'audio 
traité par time stretching. Lorsque le plug-in 
Rhythmic est sélectionné, tous les espaces compris 
entre les transitoires, créés par le time stretching 
sont comblés par de l'audio. La commande Decay 
Rate détermine la portion de ces segments audio 
qui sera audible, en leur appliquant un coefficient 
de fondu de sortie. Ajustez la commande Decay 
Rate jusqu'à 100 % pour entendre l'audio qui 
comble les espaces créés par le time stretching 
avec un léger fondu, ou jusqu'à 1 % pour appliquer 
un fondu de sortie complet entre les transitoires 
d'origine.

Plug-in Monophonic
Le plug-in Monophonic est le plus adapté aux 
sources monophoniques pour lesquelles les 
rapports de formant doivent rester intacts, les voix 
par exemple. Le plug-in Monophonic fonctionne 
également particulièrement bien avec les lignes 
instrumentales monophoniques, telles qu'une piste 
de basse. Ce plug-in ne fournit aucun paramètre de 
plug-in particulier.

Plug-in Elastic Audio : Rhythmic

Plug-in Elastic Audio : Monophonic

Le pitch shifting Elastic Audio n'est pas pris 
en charge par l'algorithme Monophonic.

Le plug-in Monophonic analyse la hauteur 
ainsi que les crêtes des transitoires afin de 
produire une TCE de haute qualité avec des 
sources à hauteur déterminée. De ce fait, 
l'analyse de l'algorithme Monophonic est plus 
longue que pour les algorithmes Polyphonic, 
Rhythmic et Varispeed. De même, lorsque 
vous passez de l'un des plug-ins Elastic Audio 
au plug-in Monophonic, Pro Tools analyse de 
nouveau toutes les données audio de la piste 
afin de collecter les données d'analyse 
supplémentaires.
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Plug-in Varispeed
Utilisez le plug-in Varispeed pour lier les 
modifications temporelles et de hauteur afin de 
créer des effets de variation de vitesse similaires 
à ceux obtenus avec un magnétophone, ainsi que 
pour les workflows de post-production. Ce plug-in 
ne fournit aucun paramètre de plug-in particulier.

Plug-in X-Form
(Rendu uniquement)

Le plug-in Elastic Audio X-Form est une version 
modifiée du plug-in de traitement autonome 
AudioSuite X-Form (basé sur l'algorithme Radius® 
d'iZotope). Le plug-in Elastic Audio X-Form est 
réservé au traitement Elastic Audio rendu et ne 
fonctionne pas en temps réel ou comme plug-in 
AudioSuite. Il fournit des algorithmes de 
compression temporelle de haute qualité pour les 
applications de production musicale, de sound 
design et de manipulation de boucles audio. 
Utilisez ce plug-in pour travailler avec des boucles 
audio et les adapter au tempo ou pour appliquer un 
pitch shifting avec correction des formants à des 
pistes de voix.

Quality

Sélectionnez le paramètre Maximum ou Low 

(Faster) dans le menu Quality. Maximum 
correspond à l'algorithme de traitement le plus lent, 
mais offre les meilleurs résultats. Low (Faster) 
produit des résultats relativement bons et est 
beaucoup plus rapide que le paramètre Maximum.

Formant

Pour les contenus audio contenant des formants 
clairs, activez l'option Formant pour conserver la 
forme des formants de l'audio lors de l'application 
du traitement TCE.

Plug-in Elastic Audio : Varispeed

Essayez d'utiliser le plug-in Varispeed avec 
la commande Quantize sur des boucles de 
batterie pour obtenir des effets intéressants.

Plug-in Elastic Audio : X-Form

Les données audio dont la hauteur fondamentale 
est définie sont caractérisées par une série de 
fréquences harmoniques plus élevées. L'intensité 
de ces harmoniques supérieures crée une forme 
de formant, visible sur un analyseur de spectre. 
Les séries de fréquences harmoniques sont 
espacées d'un intervalle égal fonction de la 
hauteur et ont la même forme globale, quelle que 
soit la hauteur de la fondamentale. C'est cette 
forme des formants qui confère à l'audio ses 
caractéristiques sonores ou timbre global. Lors 
d'un pitch shifting audio, la forme des formants 
est décalée avec le reste des données, ce qui peut 
produire un résultat peu naturel. Il est important 
de conserver une forme constante afin d'obtenir 
un pitch shifting correct des formants et un 
résultat sonore naturel.



Guide de référence Pro Tools920

Édition en vue Warp
La vue Warp permet d'appliquer manuellement une 
déformation temporelle (TCE) à l'audio pour corriger 
ou ajuster la mise en place d'une interprétation ou créer 
des effets spéciaux. Vous pouvez ajouter, déplacer et 
supprimer des marqueurs de déformation en vue 
Warp. Ces marqueurs lient des point précis de l'audio 
(en général des événements transitoires détectés) à des 
points particuliers de la timeline. De cette façon, vous 
pouvez appliquer une déformation (TCE) précise et 
nuancée aux événements audio.

Pour afficher la vue Warp :

1 Cliquez sur le sélecteur de vue de piste de la 
piste Elastic Audio.

2 Dans le menu des vues de piste, cliquez sur Warp.

Marqueurs Elastic Audio en 
vue Warp
Trois types de marqueurs sont affichés en vue 
Warp : les marqueurs d'événements, les marqueurs 
de déformation et les marqueurs de déformation 
générés par des événements de tempo. Utilisez les 
marqueurs d'événements et les marqueurs de 
déformation comme points de contrôle pour 
appliquer un traitement Elastic Audio. 

Marqueurs d'événements
Les marqueurs d'événements indiquent les 
événements audio détectés ou créés manuellement. 
Ils sont affichés uniquement en vue Warp et en 
vue Analysis. En vue Warp, les marqueurs 
d'événements apparaissent sous la forme de lignes 
grises verticales qui n'atteignent pas totalement le 
haut et le bas de la piste. Dans cette vue, l'outil de 
saisie permet de faire glisser les marqueurs 
d'événements afin d'appliquer différents types de 
déformation, selon la présence ou l'absence de 
marqueurs de déformation dans le clip. Il est 
impossible d'ajouter, de déplacer ou de supprimer 
des marqueurs d'événements en vue Warp. Activez 
la vue Analysis pour éditer les marqueurs 
d'événements (reportez-vous à la section « Édition 
en vue Analysis » à la page 927).

Marqueurs de déformation
Les marqueurs de déformation ancrent l'audio à un 
point précis de la timeline. Ils sont uniquement 
affichés en vue Warp. En vue Warp, un marqueur de 
déformation apparaît sous la forme d'une ligne noire 
verticale et épaisse, avec un triangle à sa base.

Pour mieux comprendre le fonctionnement des 
marqueurs de déformation, pensez au clip audio 
comme s'il s'agissait d'un élastique, à la timeline 
comme à une règle et aux marqueurs de 
déformation comme à des épingles. Les marqueurs 
de déformation peuvent être utilisés pour fixer un 
point particulier de l'élastique (l'audio) à un point 
particulier de la règle (la timeline). 

La vue Warp est disponible uniquement pour 
les pistes Elastic Audio.

Marqueurs Elastic Audio en vue Warp

Marqueur d'événement

Marqueurs de déformation générés 
par des événements de tempo

Marqueur de déformation

L'affichage des marqueurs d'événements 
dépend du niveau de zoom horizontal. Si le 
zoom est trop éloigné, ils ne sont pas affichés. 
Pour afficher les marqueurs d'événements, 
effectuez un zoom avant.
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Si vous fixez un point de l'élastique à un point de la 
règle, que vous utilisez une deuxième épingle pour 
fixer un autre point de l'élastique à un autre point 
de la règle, puis une troisième épingle à égale 
distance entre les deux autres sur l'élastique, mais 
plus proche de la deuxième épingle sur la règle, 
l'élastique sera étiré (ou étendu) entre la première 
épingle et celle du milieu, et détendu (ou 
compressé) entre l'épingle du milieu et la dernière. 

En vue Warp, vous pouvez ajouter, repositionner 
(sans appliquer de déformation) ou supprimer des 
marqueurs de déformation. Vous pouvez 
également déplacer un marqueur de déformation 
pour appliquer un traitement Elastic Audio 
(reportez-vous à la section « Déformation de 
l'audio » à la page 922).

Pour ajouter un marqueur de déformation :

1 Assurez-vous d'être en vue Warp.

2 Effectuez l'une des opérations suivantes :

• À l'aide du Crayon, cliquez sur un emplacement 
du clip pour ajouter un marqueur de déformation 
à cet endroit. Si vous cliquez sur un marqueur 
d'événement, un marqueur de déformation est 
ajouté au-dessus du marqueur d'événement.

• À l'aide de l'outil de saisie, cliquez sur un 
emplacement du clip tout en appuyant sur la 
touche Démarrer (Windows) ou Ctrl (Mac) pour 
ajouter un marqueur de déformation à cet 
endroit. Si vous cliquez sur un marqueur 
d'événement, un marqueur de déformation est 
ajouté au-dessus du marqueur d'événement.

• À l'aide de l'outil de saisie, si aucun marqueur de 
déformation n'est présent dans le clip, ou si les 
marqueurs de déformation sont uniquement 
présents avant l'endroit où vous souhaitez 
ajouter un nouveau marqueur de déformation, 
double-cliquez sur un marqueur d'événement 
pour ajouter un marqueur de déformation 
à cet endroit.

• Avec l'outil de saisie, double-cliquez sur un 
emplacement d'un clip sur lequel aucun 
marqueur d'événement n'est présent pour ajouter 
un marqueur de déformation à cet endroit.

• Avec l'outil de saisie, cliquez sur un marqueur 
d'événement situé avant un autre marqueur de 
déformation existant dans le clip pour ajouter un 
marqueur de déformation sur ce marqueur 
d'événement.

• Avec n'importe quel outil d'édition, effectuez un 
clic droit sur le clip, puis sélectionnez Add Warp 

Marker dans le menu contextuel pour ajouter un 
marqueur de déformation à cet emplacement. 
Si une sélection d'édition est présente, 
des marqueurs de déformation sont ajoutés au 
début et à la fin de la sélection.

Pour repositionner un marqueur de déformation 
(sans appliquer de déformation) :

 Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et faites glisser un 
marqueur de déformation vers un nouvel 
emplacement avec la Main ou le Crayon.

Pour supprimer un marqueur de déformation :

1 Assurez-vous d'être en vue Warp.

2 Effectuez l'une des opérations suivantes :

• Avec l'outil de saisie, double-cliquez sur un 
marqueur de déformation.

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur un marqueur de 
déformation avec la Main ou le Crayon.

• À l'aide de n'importe quel outil d'édition, 
effectuez un clic droit sur un marqueur de 
déformation, puis sélectionnez Remove Warp 

Marker dans le menu contextuel.



Guide de référence Pro Tools922

Pour supprimer tous les marqueurs de 
déformation d'une sélection :

1 En vue Warp, effectuez une sélection d'édition 
contenant uniquement les marqueurs de 
déformation que vous souhaitez supprimer 
(et aucun de ceux que vous voulez conserver).

2 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Suppr ou Retour arrière 
de votre clavier.

• À l'aide de n'importe quel outil d'édition, 
effectuez un clic droit sur la sélection d'édition, 
puis sélectionnez Remove Warp Marker dans le 
menu contextuel.

Marqueurs de déformation 
générés par des événements 
de tempo
Les marqueurs de déformation générés par des 
événements de tempo ne sont pas éditables et sont 
uniquement affichés pour indiquer les 
emplacements auxquels un traitement Elastic 
Audio a été appliqué pour conformer l'audio aux 
événements de tempo. Ces marqueurs ne sont 
affichés que sur les pistes basées sur les références 
de tempo.

Si vous modifiez la base de temps de la piste (en 
passant des références de tempo aux échantillons), 
tous les marqueurs de déformation générés par les 
événements de tempo se transforment en 
marqueurs de déformation éditables.

Déformation de l'audio
En vue Warp, vous pouvez déformer les données 
audio manuellement de trois manières différentes : 
déformation télescopique, déformation en 
accordéon et déformation de plage. 

Déformation télescopique
Une déformation télescopique peut être appliquée 
à un clip audio avant ou après un marqueur de 
déformation dans la mesure où aucun autre 
marqueur de déformation ne le précède ou ne le 
suit. L'audio peut provenir d'une piste basée sur les 
références de tempo ou les échantillons. 
La déformation télescopique est particulièrement 
utile pour ajuster la position de fichiers audio en 
fonction de la table des tempos de la session et de 
la grille Bars|Beats. 

Pour appliquer une déformation télescopique 
à un clip :

1 Assurez-vous d'être en vue Warp. 

2 Effectuez l'une des opérations suivantes :

• À l'aide de l'outil de saisie, faites glisser vers la 
gauche ou la droite un marqueur d'événement 
situé après le dernier marqueur de déformation 
du clip pour appliquer une déformation 
télescopique dans le sens correspondant 
à l'audio situé après le marqueur de déformation. 
Si le clip ne contient aucun marqueur de 
déformation, un marqueur est automatiquement 
créé au début du clip. Le début du clip reste 
ancré à son emplacement sur la timeline.

Pour plus d'informations, reportez-vous à la 
section « Changements de tempo et pistes 
Elastic Audio basées sur les références de 
tempo » à la page 802.

L'automation ne suit pas la déformation 
manuelle des clips audio, qu'il s'agisse d'un 
trim TCE ou d'une quantification Elastic 
Audio. Toutefois, l'automation suit les 
changements de tempo sur les pistes basées 
sur les références de tempo.



Chapitre 40 : Elastic Audio 923

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et faites glisser avec l'outil de 
saisie un marqueur d'événement situé avant le 
premier marqueur de déformation du clip vers la 
gauche ou la droite pour appliquer une déformation 
télescopique dans le sens correspondant à l'audio 
situé avant le marqueur de déformation. Si le clip 
ne contient aucun marqueur de déformation, un 
marqueur est automatiquement créé à la fin du clip. 
La fin du clip reste ancrée à son emplacement sur la 
timeline.

Exemple de workflow

Pour appliquer une déformation télescopique et 
faire correspondre le tempo d'un morceau à celui 
de la session et à la grille Bars|Beats :

1 Assurez-vous que la règle de base de temps 
principale soit bien réglée sur Bars|Beats.

2 Définissez le tempo et la métrique par défaut.

3 Activez le mode Grid.

4 Importez un morceau ou tout autre fichier audio 
plus long à partir d'un navigateur de l'espace 
de travail.

5 Assurez-vous que le traitement Elastic Audio 
soit bien activé sur la piste. 

6 Sélectionnez la vue Warp.

7 Vérifiez qu'aucun marqueur de déformation ne 
soit présent dans le clip. Si nécessaire, 
supprimez les marqueurs de déformation 
existants.

8 À l'aide du Crayon, ajoutez un marqueur de 
déformation sur le premier temps de la première 
mesure du clip.

9 À l'aide de l'outil de saisie, faites glisser le 
marqueur de déformation vers la mesure de la 
timeline sur laquelle vous souhaitez que soit 
placé le premier temps du fichier audio.

10 Faites glisser le marqueur d'événement sur le 
premier temps de la deuxième mesure du clip 
pour appliquer une déformation télescopique 
à l'audio ; le marqueur d'événement correspond 
ainsi au bon numéro de mesure sur la règle 
Bars|Beats.

11 Si le tempo du clip varie, ajoutez un marqueur 
de déformation sur le premier temps de la 
mesure sur laquelle le changement survient et 
répétez les étapes précédentes.

Déformation en accordéon
Une déformation en accordéon applique un 
traitement Elastic Audio des deux côtés d'un 
marqueur de déformation unique dans un clip. 
L'audio présent de chaque côté d'un point fixe peut 
ainsi subir une extension ou une compression 
équivalente. La déformation en accordéon est 
efficace avec les fichiers audio pour lesquels le 
premier temps se situe au milieu d'un clip.

Avant et après déformation, application d'une 
déformation télescopique avec début de clip fixe
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Pour appliquer une déformation en accordéon 
à un clip :

1 En vue Warp, ajoutez un marqueur de 
déformation unique sur le point du clip que vous 
souhaitez fixer sur la timeline.

2 À l'aide de l'outil de saisie, faites glisser vers la 
gauche ou la droite n'importe quel marqueur 
d'événement situé avant ou après le marqueur 
de déformation.

Déformation de plage
Une déformation de plage applique un traitement 
Elastic Audio entre deux points fixes d'un clip. 
Pour appliquer une déformation de plage, le clip 
doit contenir au moins deux marqueurs de 
déformation.

Pour appliquer une déformation de plage 
à un clip :

1 En vue Warp, ajoutez un marqueur de 
déformation sur le premier point que vous 
souhaitez fixer à la timeline.

2 Ajoutez un autre marqueur de déformation sur 
le point suivant que vous souhaitez fixer à la 
timeline.

3 À l'aide de l'outil de saisie, faites glisser vers la 
gauche ou la droite un marqueur d'événement 
entre les deux marqueurs de déformation. 
Un marqueur de déformation est ajouté sur le 
marqueur d'événement et l'audio est compressé 
ou étiré de chaque côté du marqueur déplacé, 
tandis que l'audio situé au-delà des marqueurs 
n'est pas affecté.

Déformation de plage avec une 
sélection d'édition
Pro Tools permet d'appliquer une déformation de 
plage entre deux marqueurs de déformation, tout 
en conservant les intervalles entre les autres 
marqueurs de déformation d'une sélection 
d'édition.

Pour appliquer une déformation de plage avec une 
sélection d'édition :

1 En vue Warp, ajoutez un marqueur de 
déformation sur le premier point que vous 
souhaitez fixer à la timeline.

2 Ajoutez un autre marqueur de déformation sur 
le point suivant que vous souhaitez fixer à la 
timeline.

Avant et après déformation, application d'une 
déformation en accordéon à un clip autour d'un 
point fixe

Avant et après déformation, application d'une 
déformation de plage entre deux marqueurs de 
déformation dans un clip
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3 Ajoutez autant de marqueurs de déformation 
que vous le souhaitez entre ces marqueurs.

4 À l'aide du sélecteur, effectuez une sélection 
d'édition qui inclut les marqueurs de 
déformation compris entre les marqueurs 
présents à chaque extrémité.

5 À l'aide de l'outil de saisie, faites glisser vers la 
gauche ou la droite l'un des marqueurs de 
déformation de la sélection d'édition. 

Le traitement Elastic Audio est uniquement 
appliqué à l'audio situé entre les deux marqueurs 
de déformation limite et le premier et le dernier 
marqueur de déformation de la sélection d'édition. 
Toutes les données audio comprises entre le 
premier et le dernier marqueur de déformation de 
la sélection d'édition conservent leur mise en place 
rythmique relative.

Déformation de plage 
individuelle
Une déformation de plage individuelle applique 
une déformation à un événement audio unique, 
sans affecter les événements audio adjacents.

Pour appliquer une déformation de plage 
individuelle :

1 En vue Warp, maintenez la touche Maj 
enfoncée et faites glisser un marqueur de 
déformation ou d'événement. S'ils n'existent 
pas, des marqueurs de déformation sont 
automatiquement créés sur les marqueurs 
d'événements adjacents.

2 Faites glisser vers la droite ou la gauche 
l'événement sur lequel vous avez cliqué.

Clips déformés
Les clips qui ont été déformés, manuellement ou 
automatiquement par un changement de tempo, 
une quantification ou un pitch shifting, sont 
indiqués par un indicateur de déformation dans 
leur angle supérieur droit. Cet indicateur apparaît 
dans toutes les vues de piste. 

Avant et après déformation, application d'une 
déformation de plage à une sélection entre deux 
marqueurs de déformation

Avant et après déformation, application d'une 
déformation de plage individuelle 
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Étant donné que des clips sans déformation 
peuvent se trouver sur des pistes Elastic Audio, 
les clips des pistes Elastic Audio ne comportent 
pas forcément d'indicateur de déformation. 
L'indicateur de déformation indique uniquement 
qu'un traitement Elastic Audio a été appliqué 
à un clip.

Affichage de l'indicateur de 
déformation
L'indicateur de déformation des clips Elastic 
Audio peut être affiché ou masqué.

Pour activer ou désactiver l'affichage 
de l'indicateur de déformation des clips 
Elastic Audio :

 Sélectionnez (ou désélectionnez) View > Clip > 

Processing State.

Traitement hors plage
Pro Tools permet d'appliquer des traitements 
Elastic Audio extrêmes. Toutefois, ces paramètres 
extrêmes peuvent dépasser la plage de traitement 
des plug-ins Elastic Audio sélectionnés. Il est 
possible dans ce cas que tous les échantillons ne 
soient pas traités correctement et que des dropouts 
audio se produisent.

La plage valide de traitement TCE Elastic Audio 
s'étend de 1/4x à 4x pour tous les plug-ins Elastic 
Audio à l'exception de X-Form, pour lequel cette 
plage s'étend de 1/8x à 8x. Les traitements TCE 
dont le facteur est inférieur ou supérieur à ces 
plages sont effectivement « hors plage ».

Lorsqu'un traitement hors plage est appliqué, 
la section du clip audio hors plage s'affiche en 
rouge. Vous pouvez toujours appliquer le 
traitement Elastic Audio, mais vous êtes averti par 
le changement de couleur que le facteur TCE se 
trouve en dehors de la plage normale de traitement 
Elastic Audio.

Suppression de la déformation 
d'un clip
Si une déformation a été appliquée à un clip, vous 
pouvez la supprimer et restaurer la durée d'origine 
du clip. Vous pouvez ainsi rétablir l'état du clip 
antérieur à la déformation si les résultats ne sont 
pas satisfaisants. Les marqueurs de déformation ne 
sont pas supprimés par la commande Remove 
Warp, mais la déformation est supprimée.

Pour supprimer la déformation d'un clip :

1 Sélectionnez le clip dont vous souhaitez 
supprimer la déformation.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Remove Warp.

• Avec n'importe quel outil d'édition, effectuez un 
clic droit sur le clip, puis sélectionnez Remove 

Warp dans le menu contextuel.

Indicateur de déformation d'un clip en vue Waveform

Facteur TCE hors plage (en rouge)

Dans la fenêtre Elastic Properties, le facteur 
TCE peut varier de 1 à 9 999 %. Toutefois, 
les facteurs hors de la plage 25 à 400 % 
seront « hors plage » et affichés en rouge.
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Groupes d'édition et édition des 
déformations
Les pistes Elastic Audio peuvent être incluses dans 
des groupes d'édition. Dans le cas de pistes Elastic 
Audio qui font partie d'un groupe d'édition, 
l'application du traitement Elastic Audio sur une 
piste applique le même traitement à toutes les 
autres pistes de ce groupe d'édition. 

Lorsque vous ajoutez ou déplacez un marqueur de 
déformation sur une piste d'un groupe d'édition, 
de nouveaux marqueurs de déformation sont créés 
aux mêmes points des autres pistes Elastic Audio 
du groupe, sauf si des marqueurs sont déjà présents 
à ces emplacements.

Édition en vue Analysis
En vue Analysis, vous pouvez ajouter, déplacer, 
promouvoir ou supprimer des marqueurs 
d'événements. En règle générale, Pro Tools détecte 
avec précision tous les événements transitoires 
(marqueurs d'événements) d'un fichier audio, vous 
n'aurez donc pas à travailler en vue Analysis. 
Toutefois, Pro Tools peut ne pas détecter avec 
précision tous les événements audio ou détecter 
des événements audio de manière erronée avec 
certains types de données audio. Cela est 
particulièrement vrai pour les données audio qui ne 
contiennent pas de transitoires clairs, telles que les 
cordes jouées legato, les voix mélismatiques ou les 
pads de synthé. 

Utilisez la vue Analysis pour corriger 
manuellement la présence et l'emplacement des 
marqueurs d'événements. L'identification précise 
des événements audio permet d'obtenir des 
résultats optimaux lors de l'application du 
traitement Elastic Audio.

Pour passer en vue Analysis :

1 Cliquez sur le sélecteur de vue de piste de la 
piste Elastic Audio.

2 Dans le menu des vues de piste, sélectionnez 
Analysis.

Ajout de marqueurs 
d'événements

Pour ajouter un marqueur d'événement :

1 Assurez-vous d'être en vue Analysis. 

2 Effectuez l'une des opérations suivantes :

• À l'aide du Crayon, cliquez à l'endroit où vous 
souhaitez ajouter un marqueur d'événement.

La commande Remove Warp ne peut être 
appliquée qu'à des clips, et non à des groupes 
de clips. Pour supprimer la déformation de 
groupes de clips, dégroupez les clips au 
préalable, utilisez la commande Remove 
Warp avec tous les clips sous-jacents, puis 
regroupez les clips.

La vue Analysis est disponible uniquement 
pour les pistes Elastic Audio.

En vue Analysis, vous pouvez uniquement 
éditer les marqueurs à l'aide des outils 
d'édition. Ces outils ne peuvent être utilisés 
pour éditer les clips. Passez en vue Warp ou 
Waveform afin de pouvoir utiliser les 
fonctions des outils d'édition sur les clips.

Lorsque vous éditez manuellement les 
marqueurs en vue Analysis, Pro Tools crée 
des fichiers d'analyse Elastic Audio (.aan) 
temporaires dans le dossier Rendered Files 
de la session. Tous les fichiers d'analyse 
temporaire non utilisés sont supprimés 
lorsque vous fermez la session.
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• À l'aide de l'outil de saisie, double-cliquez 
à l'endroit où vous souhaitez ajouter un 
marqueur d'événement.

• Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée et cliquez avec la Main sur 
l'emplacement où vous souhaitez ajouter un 
marqueur d'événement.

• À l'aide d'un outil d'édition, effectuez un clic 
droit à l'endroit où vous souhaitez ajouter un 
marqueur d'événement, puis sélectionnez Add 

Event Marker dans le menu contextuel.

Déplacement de marqueurs 
d'événements

Pour déplacer un marqueur d'événement :

1 Assurez-vous d'être en vue Analysis.

2 Effectuez l'une des opérations suivantes :

• À l'aide du Crayon, faites glisser le marqueur 
d'événement vers un nouvel emplacement.

• À l'aide de l'outil de saisie, faites glisser le 
marqueur d'événement vers un nouvel 
emplacement.

Promotion de marqueurs 
d'événements
Les marqueurs d'événements sont détectés avec 
des indices de confiance relatifs (entre 1 % et 
100 %). Vous pouvez éliminer les marqueurs 
d'événements parasites en réglant le paramètre 
Event Sensitivity de la fenêtre Elastic Properties. 
Les marqueurs d'événements dont les indices de 
confiance sont les plus faibles sont éliminés en 
premier. Toutefois, certains événements 
importants peuvent ne pas être reconnus avec un 
indice de confiance élevé. Dans ce cas, vous 
pouvez promouvoir un marqueur d'événement afin 
d'être sûr qu'il ne soit pas éliminé lors de la 
réduction de la valeur du paramètre Event 
Sensitivity. Les marqueurs d'événements promus, 
tout comme les marqueurs d'événements créés 
manuellement ou déplacés, ont un indice de 
confiance de 100%.

Pour promouvoir un marqueur d'événement :

 En vue Analysis, à l'aide de l'outil de saisie ou 
du Crayon (ou à l'aide de l'outil Smart sur la 
moitié inférieure de la piste), cliquez sur le 
marqueur d'événement à promouvoir. 

Ajout d'un marqueur d'événement à l'aide du Crayon

Déplacement d'un marqueur d'événement

Les marqueurs d'événements promus sont 
identiques aux marqueurs d'événements 
détectés. Pour afficher tous les marqueurs 
d'événements dont l'indice de confiance est de 
100 %, réduisez la valeur du paramètre Event 
Sensitivity dans la fenêtre Elastic Properties 
(reportez-vous à la section « Propriété Event 
Sensitivity » à la page 931).
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Suppression de marqueurs 
d'événements

Pour supprimer un marqueur d'événement :

1 Assurez-vous d'être en vue Analysis. 

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée puis cliquez avec le Crayon sur 
le marqueur d'événement à supprimer.

• Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée puis cliquez avec l'outil de 
saisie sur le marqueur d'événement à supprimer.

• À l'aide du sélecteur, effectuez une sélection 
d'édition contenant tous les marqueurs 
d'événements à supprimer, puis appuyez sur la 
touche Suppr ou Retour arrière de votre clavier.

• À l'aide du sélecteur, effectuez une sélection 
d'édition contenant tous les marqueurs 
d'événements à supprimer, effectuez un clic 
droit sur la sélection, puis sélectionnez Remove 
Event Marker dans le menu contextuel.

Groupes d'édition et édition 
d'événements
Les pistes Elastic Audio peuvent être incluses dans 
des groupes d'édition. Dans le cas de pistes Elastic 
Audio qui font partie d'un groupe d'édition, 
l'édition de marqueurs d'événements sur une piste 
applique le même traitement à toutes les autres 
pistes de ce groupe d'édition.

Propriétés Elastic
Chaque clip d'une piste Elastic Audio possède des 
propriétés Elastic Audio particulières (telles que le 
tempo, la métrique, le facteur TCE, le gain d'entrée 
et le pitch shifting). 

La fenêtre Elastic Properties permet de visualiser 
et de modifier les propriétés des clips sélectionnés. 
Vous pouvez par exemple réduire le gain d'entrée 
pour le traitement Elastic Audio afin d'éviter un 
éventuel écrêtage.

Dans la fenêtre Elastic Properties, vous pouvez 
également filtrer les marqueurs d'événements des 
clips Elastic Audio sur les pistes basées sur les 
références de tempo. Le filtrage des marqueurs 
d'événements permet d'améliorer la qualité du 
traitement Elastic Audio pour les données 
contenant des transitoires peu marqués.

Pour afficher la fenêtre Elastic Properties 
d'un clip :

1 Sélectionnez un clip sur une piste Elastic Audio. 
La piste peut être basée sur les échantillons ou 
sur les références de tempo.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Elastic Properties. 

• Effectuez un clic droit sur le clip et sélectionnez 
Elastic Properties.

Suppression d'un marqueur d'événement à l'aide 
du Crayon

Appuyez sur Alt+5 (Windows) ou Option+5 
(Mac) sur le pavé numérique pour ouvrir la 
fenêtre Elastic Properties.
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Fenêtre Elastic Properties
La fenêtre Elastic Properties affiche des 
informations sur le traitement et l'analyse Elastic 
Audio d'un ou plusieurs clips. Cette fenêtre permet 
également d'ajuster le traitement Elastic Audio et 
les données d'analyse.

La fenêtre Elastic Properties contient différentes 
propriétés, suivant les références de la piste, 
échantillons ou tempo. Si la piste est basée sur les 
échantillons, le nombre de propriétés Elastic 
Audio est réduit.

Propriété Clip
La propriété Clip affiche le nom du clip et indique 
s'il provient d'une piste basée sur les références de 
tempo ou les échantillons. Si plusieurs clips sont 
sélectionnés, le nombre de clips est affiché. Si des 
clips provenant à la fois de pistes basées sur les 
références de tempo et sur les échantillons sont 
sélectionnés, un nombre réduit de propriétés 
est affiché.

Propriété Source Length (pistes 
basées sur les références de 
tempo uniquement)
La propriété Source Length de la fenêtre Elastic 
Properties affiche la durée du clip, basée sur le 
fichier source en mesures et en temps. Si la durée 
du fichier source n'a pas été bien analysée, vous 
pouvez la modifier. 

Pour modifier la propriété Source Length 
d'un clip :

1 Ouvrez la fenêtre Elastic Properties du clip.

2 Effectuez l'une des opérations suivantes :

• Saisissez les valeurs de mesure, de temps et de 
tick correctes dans le champ Source Length.

• Si la durée incorrectement analysée correspond 
à la moitié de la durée réelle du fichier source, 
cliquez sur le bouton x2.

• Si elle correspond à deux fois la durée réelle du 
fichier source, cliquez sur le bouton 1/2.

Propriétés Elastic, piste basée sur les références 
de tempo

Propriétés Elastic, piste basée sur les échantillons
Si vous modifiez la durée d'un clip d'une piste 
Elastic Audio à l'aide de l'outil de trim TCE, 
la propriété Source Length de la fenêtre 
Elastic Properties est mise à jour.



Chapitre 40 : Elastic Audio 931

Propriété Source Tempo (pistes 
basées sur les références de 
tempo uniquement)
La propriété Source Tempo indique le tempo 
moyen du fichier source, calculé à partir des 
événements transitoires détectés et de la durée du 
fichier. Si le tempo du fichier source n'a pas été 
bien analysé, vous pouvez le modifier.

Pour modifier la propriété Source Tempo 
d'un clip :

1 Ouvrez la fenêtre Elastic Properties du clip.

2 Sélectionnez une valeur de note correspondant 
au battement dans le menu Tempo Resolution. 
Par exemple, si le fichier source est en 5/8, 
sélectionnez la valeur croche (1/8 note).

3 Effectuez l'une des opérations suivantes :

• Saisissez le tempo dans le champ Source Tempo.

• Si le tempo incorrectement analysé correspond 
à la moitié du tempo réel du fichier source, 
cliquez sur le bouton x2.

• S'il correspond à deux fois le tempo réel du 
fichier source, cliquez sur le bouton 1/2.

Champ Meter (pistes basées sur 
les références de tempo 
uniquement)
L'analyse Elastic Audio ne détecte pas la métrique 
et suppose que tous les fichiers sont en 4/4. Si vous 
utilisez une métrique différente, utilisez la 
propriété Meter afin d'identifier correctement la 
mesure source.

Pour modifier la propriété Meter d'un clip :

1 Ouvrez la fenêtre Elastic Properties du clip.

2 Cliquez sur le nominateur du champ Meter et 
saisissez le nombre de temps correct par 
mesure. Par exemple, si le clip est en 3/4, 
saisissez 3.

3 Cliquez sur le dénominateur du champ 
Meter et saisissez la valeur de note correcte. 
Par exemple, si le clip est en 6/8, saisissez 8.

Propriété TCE Factor
La propriété TCE Factor affiche le pourcentage de 
modification appliqué au fichier source. Sur les 
pistes basées sur les références de tempo, cette 
propriété est uniquement affichée et ne peut être 
modifiée. Sur les pistes basées sur les échantillons, 
vous pouvez modifier la valeur TCE Factor pour 
appliquer le traitement TCE correspondant au clip. 
Le pourcentage du facteur TCE est toujours 
calculé par rapport au fichier source. La valeur 
TCE Factor est affichée en rouge lorsque les 
traitements Elastic Audio sont hors de la plage 
valide (reportez-vous à la section « Traitement 
hors plage » à la page 926).

Propriété Event Sensitivity
La propriété Event Sensitivity permet de filtrer les 
marqueurs d'événements en fonction de leur indice 
de confiance. L'indice de confiance d'un 
événement transitoire détecté est basé, en partie, 
sur la netteté du transitoire. Par exemple, si le 
fichier est une boucle de batterie, les coups les plus 
accentués se verront attribuer un indice de 
confiance supérieur à celui des coups plus faibles, 
moins accentués. 
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Le paramètre Event Sensitivity agit comme un 
seuil permettant de n'afficher que les événements 
transitoires détectés avec un indice de confiance 
élevé. En vue de piste Warp ou Analysis, 
le nombre de marqueurs d'événements affichés 
augmente ou diminue lorsque vous augmentez ou 
baissez la valeur Event Sensitivity. 

Baisser la sensibilité des événements permet de 
réduire le nombre de transitoires détectés de manière 
erronée, ce qui peut produire un résultat de meilleure 
qualité pour le traitement Elastic Audio. Pro Tools 
préserve les transitoires détectés lors de l'application 
du traitement TCE afin d'éviter un effet de flam ou 
de granulation des transitoires. Par conséquent, 
les transitoires erronés sont également conservés et la 
qualité sonore obtenue peut s'avérer médiocre. 
Si vous travaillez avec des données audio qui ne 
contiennent pas de transitoires clairement définis, 
vous pouvez réduire la valeur du paramètre Event 
Sensitivity de la fenêtre Elastic Properties, ou éditer 
les marqueurs d'événements en vue Analysis.

Si le fait de réduire la valeur du paramètre Event 
Sensitivity entraîne une élimination importante des 
marqueurs d'événements, vous pouvez 
promouvoir ces marqueurs en vue Analysis 
(reportez-vous à la section « Promotion de 
marqueurs d'événements » à la page 928).

Bouton Reset
Cliquez sur le bouton Reset pour réinitialiser les 
données d'analyse des événements du clip afin 
qu'elles correspondent à celles du fichier d'origine. 
La propriété Event Sensitivity est réinitialisée 
à 100 %.

Propriété Input Gain
Il est possible qu'un écrêtage se produise en cas 
de compression temporelle des données audio. 
Les plug-ins Elastic Audio en temps réel 
fournissent un indicateur d'écrêtage qui montre 
qu'un écrêtage s'est produit. Dans ce cas, le bouton 
du plug-in Elastic Audio devient également rouge. 
Les clips Elastic Audio rendus affichent un 
indicateur d'écrêtage lorsqu'un écrêtage s'est 
produit (reportez-vous à la section « Indicateur 
d'écrêtage » à la page 915).

En cas d'écrêtage lors du traitement Elastic Audio, 
utilisez la propriété Input Gain pour atténuer le 
gain du signal audio avant son traitement.

Propriété Pitch Shift (Polyphonic, 
Rhythmic et X-Form uniquement)
La propriété Pitch Shift permet de modifier la 
hauteur de clips entiers présents sur des pistes 
Elastic Audio à l'aide des plug-ins Polyphonic, 
Rhythmic et X-Form. Vous pouvez appliquer un 
pitch shifting en temps réel par demi-tons et 
centièmes de +/- 2 octaves.

Dans le cas des fichiers REX, Pro Tools 
convertit les tranches en événements dont 
l'indice de confiance est de 100 %. Si vous 
réglez le paramètre Event Sensitivity de 99 % 
à 1 %, les événements basés sur des tranches 
ne seront pas éliminés par filtrage. Toutefois, 
si vous le réglez sur 0 %, tous les marqueurs 
seront filtrés.

Lorsque vous modifiez manuellement la 
propriété Event Sensitivity, Pro Tools crée 
des fichiers d'analyse Elastic Audio (.aan) 
temporaires dans le dossier Rendered Files 
de la session. Les fichiers d'analyse 
temporaires non utilisés sont supprimés 
lorsque vous fermez la session.
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Pitch shifting de clips Elastic 
Audio
(Polyphonic, Rhythmic et X-Form uniquement)

En plus des traitements de compression et 
d'extension temporelle Elastic Audio de Pro Tools, 
vous pouvez également modifier la hauteur de 
clips audio entiers par demi-tons et centièmes, 
sur une plage de +/- 2 octaves. 

Pour appliquer un pitch shifting à un clip :

1 Assurez-vous que le ou les clips dont vous 
souhaitez modifier la hauteur se trouvent sur 
des pistes Elastic Audio (basées sur l'algorithme 
Polyphonic, Rhythmic ou X-Form).

2 À l'aide de l'outil de saisie ou du Sélecteur, 
sélectionnez le clip audio dont vous souhaitez 
modifier la hauteur. Seuls les clips entièrement 
sélectionnés seront transposés.

3 Ouvrez la fenêtre Elastic Properties du clip.

4 Ajustez les paramètres Pitch Shift vers le haut 
(+) ou le bas (-) par incréments de demi-tons et 
centièmes.

Pour transposer la hauteur d'un clip audio dans la 
fenêtre Transpose :

1 Assurez-vous que le ou les clips à transposer 
se trouvent sur des pistes Elastic Audio 
(basées sur l'algorithme Polyphonic, Rhythmic 
ou X-Form).

2 À l'aide de la Main ou du Sélecteur, 
sélectionnez le clip audio que vous souhaitez 
transposer. Seuls les clips entièrement 
sélectionnés seront transposés.

3 Sélectionnez Event > Event Operations > 

Transpose.

La transposition de hauteur Elastic Audio 
n'est pas prise en charge par l'algorithme 
Monophonic. Toutefois, si vous passez au 
plug-in Monophonic après avoir appliqué un 
pitch shifting à l'aide d'un autre plug-in, 
les métadonnées de hauteur du clip sont 
conservées.

La transposition de hauteur Elastic Audio ne 
peut pas être appliquée à des clips ou 
groupes de clips en boucle.

Fenêtre Elastic Properties

Page Transpose de la fenêtre Event Operations
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4 Effectuez l'une des opérations suivantes :

• Ajustez les paramètres Transpose By en demi-tons 
et en centièmes.

• Ajustez les paramètres Transpose From et 
Transpose To en demi-tons et centièmes.

5 Cliquez sur Apply.

Varispeed et pitch shifting
Lorsque vous utilisez l'algorithme Varispeed, 
transposition de hauteur et compression/extension 
temporelle (TCE) sont toujours liées. Si vous 
appliquez une transposition de hauteur à un clip audio 
à l'aide des algorithmes Polyphonic ou Rhythmic, 
ces données de transposition sont enregistrées avec 
les métadonnées du clip. Par conséquent, si vous 
passez ensuite à l'algorithme Varispeed, modifiez le 
facteur TCE, puis revenez à l'algorithme Elastic 
Audio d'origine, le clip retrouvera la valeur de pitch 
shifting d'origine tout en conservant la valeur de 
compression/extension temporelle appliquée par 
l'algorithme Varispeed.

Suppression du pitch shifting 
d'un clip
Si vous avez appliqué un pitch shifting à un clip, 
vous pouvez le supprimer et restaurer la hauteur 
d'origine. Cela peut être utile si vous n'êtes pas 
satisfait des résultats et souhaitez retrouver l'état 
d'origine du clip.

Pour supprimer le pitch shifting d'un clip :

1 Sélectionnez le clip dont vous souhaitez 
supprimer la déformation.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Clip > Remove Pitch Shift.

• À l'aide d'un outil d'édition, effectuez un clic droit 
sur un clip, puis sélectionnez Remove Pitch Shift.

Traitement AudioSuite et 
clips Elastic Audio
Le traitement Elastic Audio en temps réel est non 
destructif. Toutefois, étant donné que les plug-ins 
AudioSuite traitent l'intégralité des clips et créent 
de nouveaux fichiers audio (ou plus exactement 
appliquent un traitement destructif), lorsque vous 
appliquez un traitement AudioSuite à des clips de 
pistes Elastic Audio, tout traitement Elastic Audio 
est d'abord rendu, puis le fichier rendu subit le 
traitement AudioSuite. Le nouveau fichier audio 
ainsi créé est ensuite analysé pour le traitement 
Elastic Audio. 

Les paramètres Transpose All Notes To et 
Transpose In Key peuvent être appliqués 
uniquement aux notes MIDI. Lorsque seuls 
des clips audio sont sélectionnés, ces options 
ne sont pas disponibles.

La commande Remove Pitch Shift ne peut être 
appliquée qu'à des clips, et non à des groupes 
de clips. Pour supprimer le pitch shifting de 
groupes de clips, vous devez au préalable 
dégrouper les clips, puis appliquer la 
commande Remove Pitch Shift à tous les clips 
sous-jacents, et enfin regrouper ces clips.
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Déplacement de clips Elastic Audio entre des pistes
Lorsque des clips sont déplacés entre des pistes Elastic Audio et non Elastic Audio, Pro Tools analyse et 
conforme l'audio, puis applique les traitements de manière différente. Le tableau ci-dessous présente les 
différents résultats du déplacement de clips entre des pistes Elastic Audio en temps réel, des pistes Elastic 
Audio avec rendu et des pistes audio non Elastic Audio.

Déplacement de clips Elastic Audio entre des pistes

Origine Destination Résultat

Piste Elastic Audio en 
temps réel

Piste Elastic Audio 
avec rendu

Rendu du clip avec le plug-in Elastic Audio de la piste 
de destination

Piste Elastic Audio en 
temps réel

Piste audio (non Elastic 
Audio)

Rendu du clip avec le plug-in Elastic Audio de la piste 
source et copie du clip rendu sur la piste de destination

Piste Elastic Audio avec 
rendu

Piste Elastic Audio en 
temps réel

Application du traitement Elastic Audio en temps réel 
à l'aide du plug-in Elastic Audio de la piste de 
destination

Piste Elastic Audio avec 
rendu

Piste audio (non Elastic 
Audio)

Application du traitement et copie sur la piste

Piste audio (non Elastic 
Audio)

Piste Elastic Audio en 
temps réel

Calcul de l'analyse Elastic Audio et application du 
traitement Elastic Audio en temps réel à l'aide du plug-
in Elastic Audio de la piste de destination

Piste audio (non Elastic 
Audio)

Piste Elastic Audio avec 
rendu

Calcul de l'analyse Elastic Audio et rendu du clip à l'aide 
du plug-in Elastic Audio de la piste de destination

Piste Elastic Audio avec 
pitch shifting

Piste audio (non Elastic 
Audio)

Rendu du pitch shifting du clip avec le plug-in Elastic 
Audio de la piste source et copie du clip rendu sur la 
piste de destination

Les clips rendus puis copiés sur une piste, soit après désactivation du traitement Elastic Audio d'une 
piste, soit après avoir déplacé un clip sur une piste non Elastic Audio, sont enregistrés sur le disque dans 
de nouveaux fichiers audio (reportez-vous à la section « Clips mis à plat » à la page 911.)
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Formes d'onde 
approximatives
Avec le traitement Elastic Audio en temps réel, 
le contour des formes d'onde ne peut être 
qu'approximatif. Par exemple, si vous enregistrez via 
un bus une piste Elastic Audio en temps réel sur une 
autre piste, vous remarquerez que la forme d'onde de 
la piste source ne correspond pas exactement à celle 
de la piste enregistrée. Toutefois, ce que vous 
entendez est un rendu précis du traitement Elastic 
Audio en temps réel, même si le contour de la forme 
d'onde sur la piste source est approximatif.

Préférences Elastic Audio
Grâce aux paramètres Elastic Audio de la page des 
préférences de traitement, vous pouvez déterminer 
le plug-in Elastic Audio utilisé pour l'aperçu et 
l'importation, et choisir si les nouvelles pistes créées 
sont activées ou non pour le traitement Elastic 
Audio avec le plug-in sélectionné par défaut.

Default Plug-In : permet de sélectionner n'importe 
quel plug-in Elastic Audio en temps réel en tant 
que plug-in par défaut pour l'aperçu et 
l'importation Elastic Audio. Le plug-in Elastic 
Audio sélectionné par défaut est également utilisé 
pour la création de nouvelles pistes Elastic Audio. 
Le sélecteur de plug-in Elastic Audio dans les 
navigateurs de l'espace de travail hérite du 
paramètre Default Plug-In sélectionné. De même, 
la modification du plug-in sélectionné dans les 
navigateurs de l'espace de travail met à jour le 
paramètre Default Plug-In dans la page des 
préférences de traitement.

Default Input Gain : permet d'atténuer le gain 
d'entrée du signal envoyé aux plug-ins Elastic 
Audio pour l'aperçu et l'importation, de 0 à 6 dB. 
Si le traitement Elastic Audio provoque un 
écrêtage lors d'un aperçu ou à la suite d'une 
importation, vous pouvez ajuster le paramètre 
Default Input Gain de façon à atténuer légèrement 
le gain d'entrée du signal audio traité par Elastic 
Audio. Cette préférence s'appliquera à toute 
donnée audio importée sur une piste Elastic Audio.

Si vous appliquez définitivement le traitement de 
clips d'une piste (en désactivant le traitement Elastic 
Audio sur la piste) qui ont été importés avec une 
valeur spécifique du paramètre Input Gain, cette 
valeur est réinitialisée à 0 pour tous les clips.

La fenêtre Elastic Properties hérite de la valeur du 
paramètre Default Input Gain. Pour appliquer un 
gain d'entrée supplémentaire pour le traitement 
Elastic Audio d'un clip, sélectionnez le clip et 
ajustez la valeur du paramètre Input Gain de la 
fenêtre Elastic Properties (reportez-vous à la section 
« Fenêtre Elastic Properties » à la page 930).

Enable Elastic Audio on New Tracks : lorsque 
cette option est sélectionnée, le traitement Elastic 
Audio est activé sur les nouvelles pistes créées. 
Le plug-in Elastic Audio sélectionné comme plug-
in par défaut est utilisé.

Préférences Elastic Audio
Si l'option Enable Elastic Audio on New Tracks 
est sélectionnée, il peut être conseillé de 
sélectionner l'option New Tracks Default to Tick 
Timebase de la page des préférences d'édition.
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Chapitre 41 : Opérations d'événement

De nombreux événements dans Pro Tools (tels que 
les groupes de notes MIDI, les positions de début 
ou points de synchro des clips audio ou des clips 
entiers) peuvent être transformés grâce à des 
opérations d'événement.

Fenêtre Event Operations
Les commandes de la fenêtre Event Operations 
permettent de transformer des groupes de notes 
MIDI pour modifier leur hauteur, leur mise en place 
rythmique ainsi que leur phrasé. Les opérations 
d'événement Quantize et Restore Performance 
peuvent également être appliquées à l'heure de 
début (ou au point de synchro) d'un clip audio 
ou à des événements Elastic Audio. L'opération 
d'événement Transpose peut s'appliquer à des clips 
entiers provenant de pistes Elastic Audio.

La fenêtre Event Operations comprend neuf pages, 
une pour chaque commande d'opération 
d'événement.

• Quantize

• Restore Performance

• Flatten Performance

• Change Velocity

• Change Duration

• Transpose

• Select/Split Notes

• Input Quantize

• Step Input

La fenêtre Event Operations peut rester ouverte si 
vous souhaitez y revenir pour appliquer une 
commande ou essayer une option différente pour 
une commande donnée.

Pour ouvrir une page spécifique de la fenêtre 
Event Operations :

 Sélectionnez Event > Event Operations, puis 
l'une des opérations d'événement (Quantize, 
par exemple).

Vous pouvez également appliquer une 
quantification, modifier la durée, retarder et 
transposer des données MIDI de manière non 
destructive à partir des propriétés MIDI en temps 
réel. Reportez-vous à la section « Propriétés 
MIDI en temps réel » à la page 725.

Page Quantize de la fenêtre Event Operations
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Pour revenir sur la dernière page ouverte de la 
fenêtre Event Operations :

 Sélectionnez Event > Event Operations > Event 

Operations.

Pour appliquer une commande d'opération 
d'événement, effectuez l'une des opérations 
suivantes :

 Cliquez sur Apply ou appuyez sur la touche 
Entrée du pavé numérique. La commande est 
ainsi appliquée et la fenêtre reste ouverte au 
premier plan.

 Appuyez sur la touche Retour (Mac) ou Entrée 
(Windows) du clavier alphanumérique. 
La commande est ainsi appliquée et la fenêtre 
se ferme.

Pour annuler une commande dans la fenêtre Event 
Operations :

 Sélectionnez Edit > Undo.

Utilisation de la fenêtre Event 
Operations
Utilisez l'une des méthodes suivantes pour 
configurer les options de la fenêtre Event 
Operations :

 Pour passer d'un champ au suivant ou revenir au 
champ précédent, appuyez sur Tab ou Maj+Tab.

 Augmentez ou diminuez les valeurs des champs 
sélectionnés à l'aide des touches Flèche haut et 
Flèche bas. Maintenez ces touches enfoncées pour 
faire défiler rapidement les valeurs.

 Sélectionnez un champ et faites glisser votre 
souris vers le haut ou le bas pour modifier la 
valeur.

 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et faites glisser les curseurs 
pour les régler avec plus de précision.

 Jouez une note sur votre clavier MIDI pour 
automatiquement saisir la valeur de hauteur ou 
vélocité correspondante dans un champ.

 Le changement de la valeur d'un paramètre 
particulier (par exemple le pourcentage de swing 
dans la fenêtre Quantize), active automatiquement 
ce paramètre. 

Commande Quantize
La commande Quantize de la fenêtre Event 
Operations peut être appliquée aux notes MIDI, 
aux clips audio et aux événements Elastic Audio. 
Dans le cas du MIDI, la quantification ajuste la 
position et la durée des notes MIDI pour améliorer 
leur mise en place ou créer une sensation rythmique 
particulière. Dans le cas des clips audio, la 
quantification ajuste leurs heures de début (ou 
points de synchro). Enfin, la quantification ajuste la 
position des événements transitoires détectés et 
applique un traitement Elastic Audio en 
conséquence.

Pour ouvrir la fenêtre Event Operations, 
appuyez sur Alt+3 (Windows) ou 
Option+3 (Mac).

Si la fenêtre Event Operations est toujours 
ouverte, vous pouvez sélectionner une des 
pages à partir du menu déroulant situé en 
haut de la fenêtre.

Lorsque vous utilisez simultanément la 
fenêtre Event Operations et les propriétés 
MIDI en temps réel, les opérations 
d'événement sont appliquées aux données 
MIDI elles-mêmes. Les propriétés MIDI en 
temps réel sont appliquées en aval.
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La fenêtre Quantize Event Operations permet 
d'appliquer une quantification basée sur une grille 
graduée selon des valeurs rythmiques (une double 
croche, par exemple) ou une quantification de 
groove basée sur des modèles de groove. 
Les options disponibles pour ces deux modes sont 
légèrement différentes.

Les commandes Quantize Event Operation et 
Quantize to Grid peuvent toutes les deux être 
utilisées pour quantifier la position des clips. 
Cependant, chacune d'elle est spécialisée pour des 
opérations particulières.

Utilisez la commande Quantize to Grid (Clip > 

Quantize to Grid) pour ajuster la position des 
points de début (ou des points de synchro) des clips 
sélectionnés. La commande Quantize to Grid peut 
être appliquée aussi bien à des clips audio que 
MIDI (reportez-vous à la section « Quantification 
des clips sur la grille » à la page 609).

La commande Quantize Event Operation peut 
quant à elle être appliquée individuellement aux 
notes MIDI et aux événements Elastic Audio, ainsi 
qu'aux heures de début (ou aux points de synchro) 
des clips audio. Certaines notes ou certains 
événements peuvent être retardés, d'autres 
avancés. Il est possible de raccourcir ou d'allonger 
certaines notes MIDI. L'amplitude possible de la 
modification est plus ou moins importante selon 
les notes.

Pour ouvrir la fenêtre Quantize :

 Sélectionnez Event > Event Operations > 
Quantize. 

Pour sélectionner une quantification sur la grille :

 Dans le menu Quantize Grid, sélectionnez une 
valeur de note.

Pour sélectionner une quantification sur un 
groove :

 Dans le menu Quantize Grid, sélectionnez un 
modèle de groove.

Vous pouvez également appliquer une 
quantification directement sur l'entrée MIDI 
(reportez-vous à la section « Commande 
Input Quantize » à la page 963).

Les paramètres de la fenêtre Quantize sont 
sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris pour vos 
futures sessions, enregistrez-les dans un 
modèle de session (reportez-vous à la section 
« Modèles de session » à la page 168). 

Appuyez sur Alt+0 (Windows) ou Option+0 
(Mac) pour accéder à la fenêtre Quantize.

Page Quantize de la fenêtre Event Operations
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Quantification sur la grille
La fenêtre Quantize permet d'appliquer une 
quantification sur la grille lorsqu'une valeur 
rythmique particulière est sélectionnée dans le 
menu Quantize Grid. Si vous sélectionnez un 
modèle de groove dans ce menu, la quantification 
se basera alors sur ce groove. Pour plus 
d'informations à ce sujet, reportez-vous à la section 
« Quantification sur un groove » à la page 945.

Section What to Quantize
Les paramètres de la section What to Quantize 
déterminent les aspects des notes MIDI 
sélectionnées concernés par la quantification : 
Note On (attaques), Note Off (relâchements) ou les 
deux. Vous pouvez également choisir entre une 
quantification des clips audio ou des événements 
Elastic Audio. En fonction du type de contenu 
sélectionné sur les pistes, certaines options 
peuvent ne pas être disponibles. Si seules des 
données MIDI sont sélectionnées, les options 
Audio Clips et Elastic Audio Events ne sont pas 
disponibles. Si seul de l'audio est sélectionné, 
les options Note On, Note Off et Preserve Note 

Duration ne sont pas disponibles.

Note On : lorsque vous activez cette option, 
la position des débuts de note est quantifiée.

Note Off : lorsque vous activez cette option, 
la position des fins de note est quantifiée.

Preserve Note Duration : lorsque vous activez 
cette option, la durée des notes MIDI est 
conservée. 

Si elle n'est pas activée, mais que l'option Note On 
l'est, les points de fin des notes ne sont pas 
déplacés. 

Si elle n'est pas activée, mais que l'option Note Off 
l'est, les points de début des notes ne sont pas 
déplacés.

Si les options Note On et Note Off sont toutes les 
deux sélectionnées, l'option Preserve Note 

Durations n'est pas disponible.

La figure suivante illustre l'effet des options de la 
section What To Quantize sur la position et la 
durée des notes MIDI.

Audio Clips : cette option du menu de la section 
What to Quantize applique une quantification aux 
heures de début (ou points de synchro le cas 
échéant) des clips audio sélectionnés. Les clips 
MIDI ne sont pas affectés. En règle générale, 
la quantification est efficace avec des clips audio 
ou des groupes de clips divisés en tranches (tels 
que des fichiers REX importés ou des clips créés à 
l'aide de la commande Separate Clips at Transients 
ou de Beat Detective). La quantification peut être 
appliquée à des sélections mixtes de notes MIDI et 
de clips audio.

Avant quantification, et deux exemples illustrant les 
résultats de différentes configurations des options 
What To Quantize
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Elastic Audio Events : cette option du menu de la 
section What to Quantize applique une 
quantification à la position d'événements 
transitoires détectés d'une sélection d'édition de 
pistes Elastic Audio. La quantification peut être 
appliquée à des sélections mixtes de notes MIDI et 
d'événements Elastic Audio. Des marqueurs de 
déformation sont créés automatiquement sur les 
marqueurs d'événements les plus proches de la 
grille de quantification. La quantification se base 
ensuite sur ces marqueurs de déformation.

Grille de quantification
Menu Quantize Grid : détermine la valeur de grille 
sur laquelle les notes MIDI, les événements Elastic 
Audio et les points de début des clips audio sont 
alignés. Vous pouvez sélectionner n'importe quelle 
valeur de note, de la ronde (1/1) à la quadruple 
croche (1/64), valeurs pointées ou triolets compris. 

Tuplet : sélectionnez l'option Tuplet pour 
appliquer une quantification basée sur des groupes 
de notes irréguliers, tels que les quintolets (5 notes 
sur 4 temps). dans ce cas, la valeur de grille de 
quantification est calculée à partir de la valeur de 
note sélectionnée et de la valeur du paramètre 
tuplet. par exemple, si une double croche équivaut 
à 240 ticks, des croches en quintolets (5 pour 4) 
donnent une valeur de grille de (240 /5)*4, soit 
192 ticks.

Offset Grid By : applique un offset temporel 
positif ou négatif à la grille de quantification, d'un 
nombre de ticks donné. Utilisez cette option pour 
créer un effet de jeu « devant le temps » (valeurs 
positives) ou « au fond du temps » (valeurs 
négatives).

Randomize : lorsque cette option est sélectionnée, 
les notes MIDI, les événements Elastic Audio et 
les clips audio sont déplacés dans le temps de 
façon aléatoire en avant ou en arrière (après la 
quantification). Par exemple, lorsque la grille de 
quantification est définie sur la croche et l'option 
Randomize sur 50 %, les notes et les événements 
sont déplacés jusqu'à une triple croche avant ou 
après les limites de la grille. Le paramètre 
Randomize a également une incidence sur la durée 
des notes (si l'option Releases est sélectionnée).

Options supplémentaires de 
quantification sur la grille
Les options supplémentaires de quantification sur 
la grille sont les suivantes :

Swing : lorsque vous activez cette option, toutes les 
limites de grille sont décalées du pourcentage spécifié 
(de 0 à 300) pour ajouter du swing à la quantification. 
La valeur 0 % ne produit aucun swing, la valeur 
100 % produit un feeling ternaire. Les valeurs 
supérieures à 100 % atténuent progressivement le 
swing jusqu'au maximum de 300 %, seuil à partir 
duquel toutes les limites de grille sont décalées 
jusqu'au point suivant de la grille.

Le mode Relative Grid n'affecte pas la 
grille de quantification.

Pour appliquer la quantification uniquement 
aux temps pairs des mesures, réglez la valeur 
de grille de quantification sur une blanche 
avec un offset de 960 ticks.

Grille à la croche, swing de 100 %

Tous les autres points de la grille sont 
décalés du pourcentage de swing

Swing de 0 %
(480 ticks)

Swing de 
100 %



Guide de référence Pro Tools942

Include Within : lorsque vous sélectionnez cette 
option, la position des attaques et relâchements des 
notes MIDI, ainsi que des événements Elastic 
Audio et des clips audio est quantifiée uniquement 
s'ils sont situés dans le pourcentage spécifié de la 
grille de quantification. Cette option permet de 
nettoyer les temps forts sans toucher aux notes 
swinguées ou très fortement décalées par rapport 
au tempo.

La figure suivante illustre une grille de 
quantification définie sur la noire, l'option Include 
Within étant réglée sur 50 %. Dans cet exemple, 
seules les attaques et les relâchements de notes 
MIDI situés dans la zone ombrée (équivalente 
à une croche de part et d'autre de chaque temps) 
sont quantifiés.

Exclude Within : lorsque vous sélectionnez cette 
option, la position des attaques et relâchements des 
notes MIDI, ainsi que des événements Elastic 
Audio et des clips audio n'est pas quantifiée s'ils 
sont situés dans le pourcentage spécifié de la grille 
de quantification. Cette option permet de préserver 
le feeling des événements proches du temps, tout 
en corrigeant la position d'autres trop hors tempo.

La figure suivante illustre une grille de 
quantification définie sur la noire, l'option Include 
Within étant réglée sur 25 %. Dans cet exemple, 
les attaques et les relâchements des notes MIDI 
situés dans la zone ombrée (équivalente à une 
double croche de part et d'autre de chaque temps) 
ne sont pas quantifiés.

Strength : lorsque vous sélectionnez cette option, 
les notes MIDI, les événements Elastic Audio et 
les clips audio sont déplacés d'un certain 
pourcentage vers la grille de quantification. 
Les faibles pourcentages préservent le feeling 
d'origine des événements, les pourcentages élevés 
alignent les notes plus précisément sur la grille.

Exemples de quantification 
sur la grille
Les exemples qui suivent illustrent certaines des 
utilisations les plus courantes de la quantification 
sur la grille.

Si vous souhaitez lire en boucle une sélection tout 
en configurant les options de quantification, 
désactivez Options > Link Timeline and Edit 
Selection. La plage de lecture ne sera ainsi pas 
modifiée lorsque les événements sélectionnés 
seront déplacés par les opérations de quantification 
successives.

Option Include Within

Option Exclude Within

Après la quantification, vous pouvez utiliser 
la commande Restore Performance pour 
revenir à la version d'origine (reportez-vous 
à la section « Commande Restore 
Performance » à la page 952).
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Quantification stricte

Pour appliquer une quantification stricte sur les 
doubles croches :

1 Sélectionnez la plage de notes MIDI, 
d'événements Elastic Audio ou de clips audio 
à quantifier.

2 Sélectionnez Event > Event Operations > 

Quantize.

3 Dans la section What to Quantize, activez 
l'option Note On de quantification des notes 
MIDI. Pour quantifier également la durée des 
notes MIDI, sélectionnez l'option Note Off. 
Pour quantifier de l'audio, sélectionnez Audio 

Clips ou Elastic Audio Events dans le menu 
déroulant.

4 Dans le menu Quantize Grid, sélectionnez la 
valeur d'une double croche (1/16). Assurez-
vous que les autres options (Tuplet, Offset Grid 
By et Swing) ne sont pas cochées.

5 Vérifiez l'état des options de quantification 
restantes, qui doivent être désactivées.

6 Cliquez sur Apply.

Quantification préservant le 
feeling d'origine
Vous pouvez appliquer une quantification moins 
stricte, préservant le feeling d'origine de vos pistes 
MIDI et audio enregistrées.

Pour appliquer une quantification tout en 
préservant le feeling d'origine :

1 Sélectionnez la plage de notes MIDI, 
d'événements Elastic Audio ou de clips audio 
à quantifier.

2 Sélectionnez Event > Event Operations > 

Quantize.

3 Dans la section What to Quantize, activez 
l'option Note On de quantification des notes 
MIDI. Pour quantifier également la durée des 
notes MIDI, sélectionnez l'option Note Off. 
Pour quantifier de l'audio, sélectionnez Audio 

Clips ou Elastic Audio Events dans le menu 
déroulant.

4 Dans le menu Quantize Grid, sélectionnez la 
valeur de note à utiliser. 

5 Assurez-vous que les autres options (Tuplet, 
Offset Grid By et Swing) ne sont pas cochées.

6 Sélectionnez l'option Exclude Within et entrez 
une valeur entre 10 et 15 %.

7 Sélectionnez l'option Strength et entrez une 
valeur entre 70 et 80 %.

8 Vérifiez l'état des options de quantification 
restantes, qui doivent être désactivées.

9 Cliquez sur Apply.

10 Écoutez les modifications. Si vous n'êtes pas 
satisfait du résultat, annulez les modifications et 
essayez d'autres valeurs pour les options 
Exclude Within et Strength.

Quantification avec swing
Si vous travaillez avec des charleys, des lignes de 
basse MIDI ou des équivalents audio, vous pouvez 
appliquer davantage de swing lors de la 
quantification.

Pour appliquer une quantification à la croche avec 
du swing :

1 Sélectionnez la plage de notes MIDI, 
d'événements Elastic Audio ou de clips audio 
à quantifier.

2 Sélectionnez Event > Event Operations > 

Quantize.
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3 Dans la section What to Quantize, activez 
l'option Note On de quantification des notes 
MIDI. Pour quantifier également la durée des 
notes MIDI, sélectionnez l'option Note Off. 
Pour quantifier de l'audio, sélectionnez Audio 

Clips ou Elastic Audio Events dans le menu 
déroulant.

4 Dans le menu Quantize Grid, sélectionnez la 
valeur d'une croche (1/8). 

5 Cochez l'option Swing et entrez le pourcentage 
souhaité :

• Pour un swing léger, entrez la valeur 12 %.

• Pour un swing plus prononcé, entrez la valeur 
24 %.

• Pour un swing ternaire, entrez une valeur de 
50 à 75 %.

6 Assurez-vous que les options Tuplet, Offset 
Grid By et Randomize ne sont pas 
sélectionnées. 

7 Cliquez sur Apply.

8 Écoutez les modifications. Si vous n'êtes pas 
satisfait du résultat, annulez les modifications et 
essayez un autre pourcentage de swing.

Quantification aléatoire
Si le résultat d'une quantification est trop 
mécanique ou trop sur le tempo, utilisez l'option 
Randomize de la fenêtre Quantize pour le rendre 
plus naturel.

Pour « humaniser » le feeling rythmique 
d'événements :

1 Sélectionnez la plage de notes MIDI, 
d'événements Elastic Audio ou de clips audio 
à quantifier.

2 Sélectionnez Event > Event Operations > 

Quantize.

3 Dans la section What to Quantize, activez 
l'option Note On de quantification des notes 
MIDI. Pour quantifier également la durée des 
notes MIDI, sélectionnez l'option Note Off. 
Pour quantifier de l'audio, sélectionnez Audio 

Clips ou Elastic Audio Events dans le menu 
déroulant.

4 Dans le menu Quantize Grid, sélectionnez la 
valeur de note à utiliser. 

5 Sélectionnez l'option Randomize et entrez une 
valeur de 5 %.

6 Cliquez sur Apply.

7 Écoutez les modifications. Si vous n'êtes pas 
satisfait du résultat, annulez les modifications et 
essayez un autre pourcentage pour le paramètre 
Randomize.

Essais de quantification sur 
la grille
Lorsque vous utilisez la commande Quantize, il est 
probable que vous ayez à tester différents 
configurations des paramètres avant d'obtenir le 
résultat recherché. Essayez différentes valeurs 
pour les options Include Within et Exclude Within, 
ainsi que l'option Strength ; ces paramètres 
déterminent quelles notes sont affectées par le 
processus et dans quelle mesure elles sont 
modifiées. Vous pouvez également utiliser l'option 
Randomize pour ajouter un côté aléatoire à la 
quantification, et ainsi rendre le feeling des pistes 
moins mécanique.
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Quantification sur un groove
La fenêtre Quantize permet d'appliquer une 
quantification sur un groove en sélectionnant un 
modèle de groove dans le menu Quantize Grid. 
La quantification sur un groove ajuste l'emplacement 
et la durée des notes MIDI, les événements Elastic 
Audio et les clips audio en se basant sur un modèle de 
groove plutôt qu'une grille de quantification stricte. 
Les modèles de groove extraient le feeling rythmique 
spécifique d'une performance audio ou MIDI 
enregistrée afin de l'appliquer à une autre séquence 
MIDI ou sélection audio. Il est possible de créer des 
modèles DigiGroove à l'aide de Beat Detective.

Modèles de groove
Les modèles de groove (tels que les modèles 
DigiGroove) sont des « cartes de quantification » 
créées d'après des performances musicales réelles. 
Les caractéristiques rythmiques de chaque 
interprétation sont analysées et sauvegardées 
dans un modèle de groove. Ces modèles peuvent 
être utilisés pour reproduire le feeling d'une 
performance particulière avec des notes MIDI 
(mise en place, durée et vélocité), des événements 
Elastic Audio et des clips audio.

Il est possible de créer des modèles DigiGroove 
à l'aide de Beat Detective. Beat Detective analyse 
une sélection audio pour détecter les crêtes des 
transitoires en fonction d'un seuil défini, et reporte 
leurs positions rythmiques dans un modèle 
comprenant 960 parties par noire (ppq). Beat 
Detective permet également d'analyser les attaques 
et la vélocité d'une sélection MIDI afin de générer 
des modèles de groove. Ce modèle peut être utilisé 
pour une quantification sur un groove, ainsi 
qu'avec Beat Detective.

Les modèles DigiGroove sont également 
disponibles auprès d'Avid et de fabricants tiers. 

Options de quantification sur un modèle de groove 
sélectionné

Pour plus d'informations sur Beat Detective et 
la création de modèles de groove, reportez-
vous au Chapitre 30, « Beat Detective ».

Les modèles Feel Injector Templates de 
Numerical Sound (960 ppq) sont pris en 
charge par Pro Tools, mais pas les modèles 
DNA Groove Templates (192 ppq).
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Paramètres de quantification 
sur un groove
Menu Quantize Grid : détermine le modèle de 
groove à utiliser pour la quantification. Tous les 
fichiers de modèles de groove du dossier Grooves 
sont disponibles dans le menu Quantize Grid. 

Les fichiers de groove sont stockés dans le dossier 
Grooves du dossier Root Settings. Vous pouvez 
modifier l'emplacement du dossier Root Settings dans 
les préférences de fonctionnement (reportez-vous à la 
section « Section User Library » à la page 110).

Si vous organisez vos modèles de groove en sous-
dossiers dans le dossier Groove, ceux-ci 
apparaissent sous forme de sous-menus dans le 
menu déroulant. Lorsque vous sélectionnez un 
modèle, des informations spécifiques relatives à sa 
métrique et à sa durée (en mesures) s'affichent en 
dessous du menu.

Show Comments : le champ Comments affiche 
les commentaires enregistrés avec le modèle de 
groove dans Beat Detective. Vous ne pouvez pas 
modifier ce champ sur la page Quantize. 
En revanche, vous pouvez le modifier lorsque 
vous enregistrez un modèle de groove à partir de la 
page Groove Quantize.

Pre-Quantize : activez cette option pour appliquer 
une quantification stricte aux notes MIDI 
sélectionnées sur une grille à la double croche, avant 
l'application de la quantification sur un groove. 

Options de quantification sur un groove

Timing : activez cette option pour appliquer la 
quantification sur un groove aux notes MIDI, 
événements Elastic Audio ou clips audio 
sélectionnés. Faites glisser le curseur pour faire 
varier le niveau de quantification appliqué à la 
sélection. Sur la position 0 %, la mise en place 
rythmique n'est pas affectée. Sur la position 100 %, 
les notes sont déplacées vers les position des 
modèles sous-jacents. Sur 200 %, les événements 
sont déplacés du double de la différence entre la 
position de l'événement d'origine et celle de 
l'événement du modèle référencé. 

Ainsi, si un événement se trouvait à l'emplacement 
1|1|060 (une double croche) alors que l'événement 
correspondant du modèle est lui à l'emplacement 
1|1|073, un réglage de 100 % décale la note vers la 
position 1|1|073 (sur 200 %, la note est décalée sur 
la position 1|1|086).

Par défaut, le curseur Timing est réglé sur 100 %.

Duration : activez cette option pour affecter la 
durée des notes MIDI sélectionnées. L'option 
Duration ne s'applique pas aux sélections audio. 
Sur 100 %, les durées changent pour correspondre 
au modèle de groove actuel. Sur 200 %, les durées 
varient en fonction du rapport entre la durée 
d'origine des notes sélectionnées et les durées dans 
le modèle. 

Par défaut, le curseur Duration est réglé sur 100 %.

Beat Detective ne permet pas l'extraction 
d'informations relatives aux durées 
provenant de performances audio. 
Les modèles DigiGroove créés avec Beat 
Detective ont une valeur de durée fixe, 
égale à 50 % de la résolution du modèle 
sélectionné (reportez-vous à la section 
« Définition d'une sélection pour Beat 
Detective » à la page 668).



Chapitre 41 : Opérations d'événement 947

Velocity : activez cette option pour affecter la 
vélocité des notes MIDI sélectionnées. L'option 
Velocity ne s'applique pas aux sélections audio. 
Si le curseur est sur la position 0 %, les vélocités 
sélectionnées ne sont pas modifiées. Sur la 
position 100 %, toutes les vélocités correspondent 
alors à celles du modèle de groove actuel. 
Sur 200 %, les vélocités sont exagérées : le 
volume des notes fortes est encore plus élevé et 
celui des notes faibles encore plus bas. 

Par exemple, si deux notes adjacentes ont une 
vélocité de 80, et que les notes correspondantes du 
modèle ont des vélocités de 70 et 90, les vélocités 
résultantes après application du modèle avec un 
réglage de 200 % seront de 60 et 100.

Par défaut, le curseur Velocity est réglé sur 100 %.

Rappel de réglages des options

Pour enregistrer le modèle de groove en incluant 
la configuration des paramètres de la section 
Options :

1 Dans la fenêtre Quantize, activez l'option Recall 

with Template pour stocker les options de 
quantification avec le modèle actuel.

2 Cliquez sur le bouton Save.

3 Entrez ou modifiez les commentaires que vous 
souhaitez enregistrer avec le modèle.

4 Effectuez l'une des opérations suivantes :

• Pour enregistrer le modèle de groove avec la 
configuration des paramètres de la section 
Options, cliquez sur Save.

• Pour créer une copie du modèle de groove avec 
la configuration des paramètres de la section 
Options, cliquez sur Save as. Lorsque la boîte 
de dialogue d'enregistrement s'ouvre, attribuez 
un nom à la copie et cliquez sur Save.

Vous risquez de perdre la configuration des 
paramètres si vous effectuez l'une des opérations 
suivantes sans les avoir enregistrés au préalable :

• Sélection d'une autre fenêtre d'opérations 
d'événements

• Fermeture de la fenêtre d'opération d'événement

• Sélection d'un autre modèle de groove
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Application de modèles de 
groove
Les modèles de groove peuvent être de n'importe 
quelle durée et peuvent être appliqués à un nombre 
illimité de mesures. En général, les modèles de 
groove sont appliqués à des sélections de même 
durée et de métrique identique. Toutefois, 
des modèles de groove peuvent être appliqués sur 
des métriques différentes (un modèle de groove 
en 6/8 peut par exemple être appliqué à une 
sélection en 4/4). De plus, la sélection ne doit pas 
obligatoirement commencer sur le premier temps 
d'une mesure pour appliquer un modèle de groove.

Pour appliquer une quantification sur un groove :

1 À l'aide du Sélecteur ou de la Main, 
sélectionnez les notes MIDI, les événements 
Elastic Audio ou les clips audio souhaités.

2 Sélectionnez Event > Event Operations > 

Quantize.

3 Sélectionnez un modèle de groove dans le menu 
Grid Quantize.

4 Activez les options Timing, Duration et Velocity 
et réglez leurs valeurs en pourcentage à l'aide 
des curseurs.

5 Si nécessaire, activez l'option Pre-Quantize.

6 Cliquez sur le bouton Apply. 

Modèle DigiGroove (dérivé de l'audio de la piste affichée) appliqué à une série de doubles croches, avec les 
options Timing et Velocity sur 100 %
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Mappage des modèles de groove
Pro Tools applique des modèles de groove par 
rapport au début du morceau. Ainsi, un modèle 
de groove de deux mesures est répété 
automatiquement à chaque mesure impaire de la 
session (mesure 1, 3, 5, 7, etc.).

Mappage de modèles sur des mesures impaires 
de métrique identique

Si un modèle de groove de deux mesures est 
appliqué à une sélection d'une mesure de métrique 
identique, seule la première mesure du modèle est 
utilisée. Si la sélection n'inclut pas les limites de la 
mesure, par exemple 1|2|000 à 2|1|000, le modèle 
de groove ne modifie que les notes sélectionnées.

Mappage de modèles sur des mesures paires 
de métrique identique

Si la sélection commence sur une mesure paire, 
seule la partie correspondante du modèle de 
groove sera utilisée. Ainsi, si la sélection contient 
deux mesures et si la première est paire, le modèle 
est d'abord appliqué à la deuxième mesure puis à la 
première. 

Mappage de modèles sur des mesures de 
métrique différente

Lorsque les modèles de groove et les sélections de 
piste sont basés sur des métriques différentes, 
le modèle est répété ou tronqué pour correspondre 
au nombre de temps de la sélection.

Ainsi, si le nombre de temps du modèle de groove 
est inférieur à celui de la sélection, le modèle est 
répété pour combler la différence. C'est le cas, par 
exemple, lorsqu'un modèle d'une mesure en 6/8 est 
appliqué à une sélection d'une seule mesure en 4/4.

Répétition d'un modèle de groove de deux mesures

Application d'un modèle de groove de deux mesures à 
une seule mesure impaire

Modèle
de groove

de 2 mesures

Modèle
de groove

de 2 mesures

Modèle
de groove

de 2 mesures

Modèle
de groove

de 2 mesures

Mesure 1 en 4/4 Mesure 2 en 4/4 (non utilisée)

Sélection d'une mesure 
en 4/4

Application d'un modèle de groove de deux mesures 
à une seule mesure paire

Application d'un modèle de groove d'une mesure 
en 6/8 à une sélection d'une mesure en 4/4

Mesure 1 en 4/4 (non utilisée) Mesure 2 en 4/4

Sélection d'une 
mesure en 4/4

Mesure 1 en 6/8

Sélection d'une 

Mesure 1 en 

(temps 3 à 6 
non utilisés)

mesure en 4/4

6/8 répétée
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Si le nombre de temps du modèle de groove est 
supérieur à celui de la sélection, seul le nombre 
nécessaire de temps est utilisé. C'est le cas, 
par exemple, lorsqu'un modèle d'une mesure en 6/4 
est appliqué à une sélection d'une mesure en 4/4.

Mappage de modèles avec des métriques 
mixtes

Si la sélection contient plusieurs métriques 
différentes, le modèle de groove est toujours 
mappé de façon à ce que les premiers temps soient 
alignés. Ainsi, si le modèle de groove est composé 
d'une mesure en 4/4 et est appliqué à une sélection 
composée d'une mesure en 4/4 suivie d'une mesure 
en 7/16 et d'une mesure en 5/8, le premier temps 
du modèle de groove est aligné sur ceux de la 
sélection et seul le nombre approprié de temps du 
modèle est utilisé.

Quantification d'événements 
Elastic Audio
Pro Tools permet d'appliquer une quantification aux 
événements Elastic Audio, de la même manière que 
pour des notes MIDI. Cette quantification peut 
être appliquée aux marqueurs d'événement et de 
déformation les plus proches de la grille de 
quantification sur des pistes Elastic Audio, qu'elles 
soient basées sur les échantillons ou les références 
de tempo. Pour cela, les marqueurs d'événements les 
plus proches de la grille sont convertis en marqueurs 
de déformation, et l'ensemble des marqueurs de 
déformation les plus proches de la grille sont 
déplacés selon les paramètres de quantification.

Application d'un modèle de groove d'une mesure 
en 6/4 à une sélection d'une mesure en 4/4

Mesure 1 en 6/4

Sélection d'une 

(temps 3 à 6 
non utilisés)

mesure en 4/4

Application d'un modèle de groove d'une mesure 
en 4/4 à une sélection de 3 mesures de métriques 
différentes

Il est possible de réinitialiser la grille du 
modèle de groove en ajoutant un nouveau 
marqueur de métrique (il peut s'agir de la 
même métrique). Le modèle de groove 
redémarre sur le marqueur de métrique, quel 
que soit le numéro de la mesure, que la 
métrique ait été modifiée ou non.

Sélection de 3 mesures de métriques 

Mesure 1 en 4/4

Mesure 1 en 4/4

Mesure 1 en 4/4

(non utilisé)

différentes
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La quantification peut également être appliquée 
aux heures de début (ou points de synchro) des 
clips des pistes audio, que le traitement Elastic 
Audio y soit activé ou non et qu'elles soient basées 
sur les échantillons ou les références de tempo. 
Vous pouvez donc rapidement appliquer une 
quantification à des clips audio sans aucun 
traitement TCE, ce qui est particulièrement utile 
lorsque vous travaillez avec des clips constitués 
d'un seul son (clips à événement unique), tels que 
des clips ou groupes de clips divisés en tranches.

Pour quantifier des événements Elastic Audio :

1 Sélectionnez l'audio à quantifier sur des pistes 
Elastic Audio. L'audio ne se trouvant pas sur 
des pistes Elastic Audio ne sera pas quantifié.

2 Sélectionnez Events > Event Operations > 

Quantize. 

3 Dans la fenêtre Quantize, sélectionnez Elastic 

Audio Events dans le menu de la section What 
to Quantize.

4 Configurez les paramètres des sections 
Quantize Grid et Options.

5 Cliquez sur Apply.

Les marqueurs de déformation et d'événement les 
plus proches de la grille de quantification sont 
déplacés en conséquence. Un traitement TCE est 
appliqué entre ces marqueurs et tous les autres 
marqueurs conservent leur position relative par 
rapport à la grille de quantification.

Quantification de clips audio
Pro Tools permet de quantifier la position des 
points d'entrée (ou des points de synchro) des clips 
audio à l'aide de l'opération Quantize. Les points 
d'entrée (ou points de synchro) des clips audio sont 
déplacés sur la valeur de la grille de quantification 
la plus proche. 

Pour quantifier des clips audio :

1 Sélectionnez les clips audio à quantifier. 

Utilisez la commande Restore Performance 
pour annuler une quantification audio 
ou MIDI. Reportez-vous à la section 
« Commande Restore Performance » à la 
page 952.

Avant quantification d'événements Elastic Audio en 
vue Warp

Après quantification d'événements Elastic Audio en 
vue Warp

La quantification d'un groupe de clips 
n'ajuste que sa position de début (ou de son 
point de synchro). Pour appliquer une 
quantification aux clips divisés en tranches 
d'un groupe de clips, vous devez au préalable 
les dégrouper, effectuer l'opération, puis les 
regrouper. Pour plus d'informations sur les 
groupes de clips, reportez-vous à la section 
« Groupes de clips » à la page 877.
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2 Sélectionnez Events > Event Operations > 

Quantize. 

3 Dans la fenêtre Quantize, sélectionnez Audio 

Clips dans le menu de la section What to 
Quantize.

4 Configurez les paramètres des sections 
Quantize Grid et Options.

5 Cliquez sur Apply.

Les heures de début (ou les points de synchro le cas 
échéant) des clips sont déplacés selon les paramètres 
de quantification.

Quantification de sélections 
mixtes
Vous pouvez appliquer une quantification 
commune à des notes MIDI et à des clips audio, 
ou à des notes MIDI et à des événements Elastic 
Audio. Il est en revanche impossible d'appliquer 
une quantification simultanée à des clips audio 
(non Elastic Audio) et à des événements Elastic 
Audio.

Commande Restore 
Performance
La commande Restore Performance de la fenêtre 
Event Operations rétablit l'état d'origine de toutes 
les notes MIDI sélectionnées (telles qu'elles ont été 
enregistrées ou saisies manuellement), même après 
avoir enregistré la session ou purgé l'historique des 
annulations. La commande Restore Performance 
peut être également appliquée aux événements 
Elastic Audio ou aux clips audio ayant subi une 
quantification.

Clips audio avant et après quantification

Page Restore Performance de la fenêtre Event 
Operations

La commande Restore Performance ne peut 
pas être annulée.
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Les attributs suivants des note MIDI, événement 
Elastic Audio et clips audio peuvent être restaurés :

Timing (Quantization) : restaure les heures 
de début d'origine des notes, clips audio et 
événements Elastic Audio sélectionnés. Seule la 
durée des notes MIDI sélectionnées est modifiée si 
l'option Duration n'est pas activée. 

Duration : restaure les durées d'origine des notes 
sélectionnées. Si l'option Timing (Quantization) 
n'est pas activée, la position de début des notes 
sélectionnées n'est pas restaurée et leur position de 
fin est affectée. L'option Duration n'a aucun effet 
sur l'audio.

Velocity : restaure les vélocités d'origine des notes 
sélectionnées. L'option Velocity n'a aucun effet sur 
les données audio.

Pitch : restaure la hauteur d'origine des notes 
sélectionnées et des clips Elastic Audio avec pitch 
shifting.

Pour restaurer la position, durée, vélocité ou 
hauteur d'origine de notes MIDI, clips audio ou 
événements Elastic Audio sélectionnés :

1 Sélectionnez les notes MIDI, clips audio ou 
événements Elastic Audio à restaurer.

2 Sélectionnez Event > Event Operations > 

Restore Performance.

3 Sélectionnez les attributs de performance 
à restaurer.

4 Cliquez sur Apply.

Les modifications apportées par les commandes 
Quantize, Change Duration (MIDI uniquement), 
Change Velocity (MIDI uniquement) ou 
Transpose sont annulées et l'interprétation 
d'origine est restaurée. De même, les notes MIDI 
enregistrées avec la quantification en entrée 
activée sont restaurées (reportez-vous à la section 
« Commande Input Quantize » à la page 963).

Suppression d'une 
quantification en entrée
La commande Restore Performance peut servir 
à supprimer une quantification en entrée MIDI. 
Si vous enregistrez par exemple une performance 
avec la quantification en entrée activée, il est 
toujours possible de la restaurer pour la retrouver 
telle qu'elle a été jouée.

La commande Restore Performance ne 
restaure pas les notes MIDI, clips audio ou 
événements Elastic Audio coupés, copiés, 
collés ou déplacés manuellement de 
quelque manière que ce soit.

La commande Restore Performance n'annule 
pas les modifications de durée liées au trim 
du début d'une note. Cette opération revient 
en effet à modifier sa mise en place, 
Pro Tools agit donc comme si la note avait 
été déplacée manuellement.

Pour plus d'informations sur la 
quantification en entrée, reportez-vous à la 
section « Commande Input Quantize » à la 
page 963.
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Flatten Performance
La commande Flatten Performance de la fenêtre 
Event Operations capture l'état actuel des notes 
sélectionnées, créant ainsi un point de restauration 
pour les attributs de notes affectés par la 
commande Restore Performance.

Pour mettre à plat une performance :

1 Avec la Main ou le Sélecteur, sélectionnez les 
notes MIDI à mettre à plat.

2 Sélectionnez Event > Event Operations > 

Flatten Performance pour ouvrir la page Flatten 
Performance.

3 Sélectionnez les attributs de notes à mettre 
à plat. Pour une description de ces attributs, 
reportez-vous à la section « Commande Restore 
Performance » à la page 952.

4 Cliquez sur Apply. 

Change Velocity
La commande Change Velocity de la fenêtre Event 
Operations ajuste automatiquement les vélocités 
d'attaque (Note On) et de release (Note Off) 
des notes MIDI sélectionnées. Utilisez cette 
commande pour rendre des notes plus fortes ou 
moins fortes, ou pour créer des crescendos ou des 
diminuendos.

Les vélocités peuvent être éditées manuellement 
à l'aide du Crayon et des outils de saisie (reportez-
vous à la section « Édition manuelle des notes 
MIDI » à la page 700).

Fondu des vélocités

Pour faire varier les vélocités progressivement 
dans le temps :

1 Sélectionnez la plage de notes MIDI à éditer.

2 Sélectionnez Event > Event Operations > 

Change Velocity.

3 Activez l'option Change Smoothly, avec une 
plage de 127 à 0.

4 Cliquez sur Apply.

Page Flatten Performance de la fenêtre Event 
Operations

La commande Flatten Performance ne peut 
pas être annulée.

Vous pouvez également changer la vélocité 
en temps réel, de manière non destructive, 
à l'aide des propriétés MIDI en temps réel. 
Reportez-vous à la section « Propriétés MIDI 
en temps réel » à la page 725.



Chapitre 41 : Opérations d'événement 955

Conservation des écarts de 
vélocité existants
Pour conserver partiellement les écarts de vélocité 
existants avec des fondus des vélocités, utilisez 
l'option Change Smoothly by Percentage. 
Les figures suivantes illustrent la différence entre 
les deux options Change Smoothly.

Modification proportionnelle 
des vélocités
Il est fréquent que les écarts existants entre les 
vélocités soient corrects, mais qu'elles soient 
globalement soit trop faibles, soit trop élevées. 
Utilisez dans ce cas l'option Scale By.

Par exemple, pour augmenter les valeurs de 
vélocité de 20 % :

1 Sélectionnez la plage de notes MIDI à éditer.

2 Sélectionnez Event > Event Operations > 

Change Velocity.

3 Activez l'option Scale By, et réglez la valeur de 
pourcentage sur 120.

4 Cliquez sur Apply.

Paramètres de modification des 
vélocités

Vélocités d'origine

Vélocités avec option Change Smoothly by 
Percentages, de 100 % à 20 %

Vélocités avec option Change Smoothly, de 100 à 10

Page Change Velocity de la fenêtre Event Operations

Les valeurs de vélocité ont généralement une 
incidence sur l'intensité sonore des notes 
MIDI. Selon la manière dont elles sont 
mappées sur les instruments MIDI, 
les vélocités peuvent également affecter 
d'autres aspects du son d'un instrument 
(comme par exemple la coupure d'un filtre, 
les enveloppes et les modulations).



Guide de référence Pro Tools956

Note On : applique les options de modification des 
vélocités aux attaques des notes MIDI.

Note Off : applique les options de modification des 
vélocités aux relâchements (release) des notes 
MIDI.

Set All To : règle toutes les vélocités sur la valeur 
spécifiée (1 à 127).

Add : ajoute la valeur spécifiée (1 à 127) aux 
vélocités existantes.

Subtract : soustrait la valeur spécifiée (1 à 127) 
aux vélocités existantes.

Scale By : multiplie toutes les valeurs de vélocités 
par un pourcentage (1 à 400 %).

Change Smoothly : permet de passer 
progressivement d'une valeur de vélocité à une 
autre.

Change Smoothly by Percentage : permet de 
faire passer progressivement les valeurs de 
vélocité d'un pourcentage à un autre. 

La courbe régissant cette transformation peut être 
ajustée (+/- 99) pour contrôler sa pente.

Limit To : lorsqu'elle est sélectionnée, cette option 
restreint la portée de la commande Change 

Velocity à une plage comprise entre des valeurs 
minimale et maximale, pour l'application des 
options de modification des vélocités (ainsi 
qu'après une randomisation).

Randomize : lorsque cette option est sélectionnée, 
une randomisation est appliquée aux options de 
modification des vélocités sélectionnées, suivant 
un pourcentage spécifique. Par exemple, si l'option 
Set All To est activée avec une valeur de 64 et si 
l'option Randomize est activée avec une valeur de 
50 %, les vélocités obtenues seront comprises 
entre 48 et 80 (+/- 25 % de la valeur de la 
vélocité). 

Pour appliquer une randomisation aux vélocités 
sélectionnées sans modifier d'autre attribut :

1 Activez l'option Scale By et définissez-la sur 
100 %.

2 Activez l'option Randomize et définissez le 
niveau de randomisation souhaité.

3 Cliquez sur Apply.

Plages de vélocité
La plage valide des vélocités des notes MIDI 
s'étend de 1 à 127. Aucune vélocité modifiée par la 
commande Change Velocity ne peut sortir de cette 
plage ; 1 reste la valeur minimale et 127 la valeur 
maximale. Cela signifie que, dans certains cas, 
la commande Change Velocity peut n'avoir aucun 
effet sur certaines notes.

Par exemple, si un coefficient de 200 % est 
appliqué à une note dont la vélocité est de 64, 
sa vélocité passe à 127. Il est alors impossible 
d'augmenter cette vélocité, quelle que soit l'option 
utilisée.

Les paramètres de la fenêtre Change Velocity 
sont sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris comme 
ceux par défaut pour vos futures sessions, 
enregistrez la session en tant que modèle 
(reportez-vous à la section « Modèles de 
session » à la page 168).

Bien que certaines options ajustent à la fois les 
vélocités d'attaque (Note On) et de release 
(Note Off) des notes, la plupart des 
périphériques MIDI ignorent les informations 
de vélocité de release. Pour savoir si votre 
instrument prend en charge les vélocités de 
release veuillez consulter la documentation du 
fabricant.
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Change Duration
La commande Change Duration de la fenêtre 
Event Operations ajuste les durées des notes MIDI 
sélectionnées. Utilisez cette commande pour 
modifier l'articulation des notes sélectionnées et 
produire un jeu plus staccato ou legato.

Paramètres de modification 
des durées

Option Set/Add/Subtract/Scale

Set All To : attribue une même durée à toutes les 
notes, exprimée en noires et en ticks.

Add : ajoute à toutes les durées de notes la même 
valeur, exprimée en noires et en ticks.

Subtract : soustrait à toutes les durées de notes la 
même valeur, exprimée en noires et en ticks.

Scale By : multiplie les durées de notes par un 
coefficient (de 1 à 400 %).

Legato

Activez l'option Legato pour donner un effet legato 
à la sélection MIDI. Sélectionnez Gap ou Overlap 
dans le menu déroulant Legato et entrez la valeur 
d'espacement ou de chevauchement désirée en 
temps et ticks.

Remove Overlap

L'option Remove Overlap supprime le 
chevauchement de notes pour toutes les notes de 
même hauteur. Elle est différente de l'option 
Legato dans la mesure où elle préserve les notes 
qui ne se chevauchent pas (qu'elles aient la même 
hauteur ou non). Pour créer un espace entre les 
notes qui se chevauchaient auparavant, entrez la 
valeur d'espacement en temps et ticks. 

Transform Sustain Pedal To Duration

L'option Transform Sustain Pedal To Duration 
prolonge les notes émises lorsque la pédale de sustain 
(contrôleur 64) est enfoncée (64 à 127) jusqu'au point 
où elle remonte (0 à 63). Activez l'option Delete 
Sustain Pedal Events pour convertir les événements 
de pédale de sustain en durées de note. Cette 
opération peut faciliter considérablement le travail 
d'édition tout en préservant l'effet de performance 
voulu. En cas de suppression en cours d'édition d'un 
événement d'activation de la pédale de sustain, par 
exemple, la performance MIDI qui en résulte perd 
son effet legato.

Vous pouvez également modifier la durée 
des notes en temps réel, de manière non 
destructive, à l'aide des propriétés MIDI 
en temps réel. Reportez-vous à la section 
« Propriétés MIDI en temps réel » à la 
page 725.

Page Change Duration de la fenêtre Event Operations

Les paramètres de la page Change Duration 
sont sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris comme 
ceux par défaut pour vos futures sessions, 
enregistrez la session en tant que modèle 
(reportez-vous à la section « Modèles de 
session » à la page 168).
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Option Change Continuously

L'option Change Continuously permet de modifier 
la durée des notes de façon continue en ticks ou en 
pourcentage. Pour modifier la courbe du 
changement, ajustez le curseur Curve.

Change Continuously in Ticks : permet de faire 
passer progressivement les durées de notes d'une 
valeur à une autre. Les valeurs de durée sont 
spécifiées en noires et en ticks.

Change Continuously by Percentage : permet de 
faire passer progressivement les durées de notes 
d'un pourcentage à un autre. 

La courbe régissant cette transformation peut être 
ajustée (+/- 99) pour contrôler sa pente.

Limit Range : lorsque cette option est activée, elle 
restreint la portée de la commande Change 

Duration à une valeur minimale et maximale 
(exprimée en noires et en ticks).

Randomize : lorsque cette option est activée, 
une randomisation est appliquée à la commande 
Change Duration, selon le pourcentage spécifié. 
Par exemple, l'utilisation de la fonction Set all to 
avec une valeur de 480 ticks et une valeur de 
randomisation de 50 % produit des durées 
aléatoires, comprises entre 360 et 600 (+/- 25 % de 
la valeur de durée).

Exemples d'application de 
changements de durée

Pour rendre des notes plus staccato :

1 Sélectionnez la plage de notes MIDI à éditer.

2 Sélectionnez Event > Event Operations > 

Change Duration.

3 Sélectionnez l'option Scale By avec une valeur 
de pourcentage de 50.

4 Cliquez sur Apply. La durée des notes 
sélectionnées est réduite de 50 %.

Avec cette option, il se peut que vous deviez 
essayer plusieurs valeurs de pourcentage avant 
d'obtenir l'effet recherché.

Pour rendre des notes plus legato :

1 Sélectionnez la plage de notes MIDI à éditer.

2 Sélectionnez Event > Event Operations > 

Change Duration.

3 Sélectionnez l'option Legato.

4 Dans le menu Legato, sélectionnez Overlap.

5 Entrez 0|000 comme valeur de chevauchement.

6 Cliquez sur Apply. 

Les points de fin des notes sélectionnées sont 
étendus jusqu'aux points de début des notes 
suivantes, ce qui élimine l'espace entre chaque note.

Transpose
Les outils de saisie servent à transposer 
manuellement des notes MIDI individuelles ou de 
petits groupes de notes. La commande Transpose 
de la fenêtre Event Operations quant à elle peut 
être utilisée avec des pistes et clips MIDI entiers. 
L'une des utilisations les plus courantes de la 
commande Transpose est le changement de 
tonalité de vos pistes MIDI. Vous pouvez définir 
un groupe de pistes MIDI devant être transposées, 
en veillant à exclure les pistes de batterie du 
groupe (les transposer changerait les sons de 
batterie). Vous pouvez également appliquer une 
transposition dans une gamme donnée. Appuyez sur Alt+P (Windows) ou Option+P 

(Mac) pour accéder à la fenêtre Change 
Duration.
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La commande Transpose peut également être 
appliquée à des clips entiers provenant de pistes 
Elastic Audio, à l'aide des plug-ins Polyphonic, 
Rhythmic ou X-Form.

Transpose By (Octaves) : transpose les notes 
MIDI sélectionnées sur +/- 10 octaves, ou 
transpose les clips Elastic Audio sélectionnés sur 
+/- 2 octaves.

Transpose By (Semitones) : transpose les notes 
MIDI sélectionnées chromatiquement vers le haut ou 
le bas de +/- 127 demi-tons, ou transpose les clips 
Elastic Audio sélectionnés chromatiquement vers le 
haut ou le bas de +/- 48 demi-tons (4 octaves).

Transpose (From et To) : transpose les notes MIDI 
ou les clips Elastic Audio sélectionnés par demi-
tons, en se basant sur la différence entre une 
hauteur d'origine et une hauteur cible. Ainsi, 
une transposition de C3 à F#3 transpose les notes 
d'une quarte augmentée vers le haut (six demi-tons). 

Transpose All Notes To : transpose toutes les 
notes sélectionnées à la même hauteur. Utilisez le 
curseur ou le champ de saisie pour spécifier la 
hauteur à laquelle vous souhaitez transposer toutes 
les notes sélectionnées. Cette option ne s'applique 
pas aux clips Elastic Audio.

Transpose In Key : transpose les notes 
sélectionnées vers le haut ou le bas par pas d'un 
demi-ton, dans la gamme actuelle de la règle 
d'armure. Cette option ne s'applique pas aux clips 
Elastic Audio.

Pour transposer des notes MIDI :

1 Si vous souhaitez transposer un groupe de 
pistes, activez le groupe d'édition.

2 Sélectionnez les notes MIDI à transposer.

3 Sélectionnez Event > Event Operations > 

Transpose.

4 Sélectionnez l'option Transpose (By, From and 

To, All Notes To ou In Key).

Vous pouvez également transposer des notes 
MIDI en temps réel, de manière non destructive, 
à l'aide des propriétés MIDI en temps réel. 
Reportez-vous à la section « Propriétés MIDI en 
temps réel » à la page 725.

Pour plus d'informations sur la 
transposition de clips Elastic Audio, 
reportez-vous à la section « Pitch shifting 
de clips Elastic Audio » à la page 933.

La transposition de hauteur Elastic Audio 
n'est pas prise en charge par l'algorithme 
Monophonic.

La transposition de hauteur Elastic Audio ne 
peut pas être appliquée à des clips ou 
groupes de clips en boucle.

Page Transpose de la fenêtre Event Operations

Appuyez sur Alt+T (Windows) ou Option+T 
(Mac) pour ouvrir la fenêtre Transpose.
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5 Paramétrez les champs de hauteur 
correspondants.

Si le champ de hauteur est sélectionné, jouez une 
note sur votre contrôleur MIDI pour la saisir 
automatiquement comme valeur de hauteur.

6 Cliquez sur Apply.

Pour transposer toutes les notes d'une piste d'une 
octave vers le bas :

1 À l'aide du Sélecteur, double-cliquez sur la piste 
pour sélectionner toutes les notes MIDI.

2 Sélectionnez Event > Event Operations > 

Transpose.

3 Activez l'option Transpose By.

4 Entrez la valeur -1 octave.

5 Cliquez sur Apply.

Pour transposer des notes sélectionnées dans la 
tonalité actuelle :

1 Sélectionnez les notes MIDI à transposer.

2 Sélectionnez Event > Event Operations > 

Transpose.

3 Sélectionnez Transpose in Key.

4 Ajustez le curseur (ou entrez un chiffre) pour 
définir le nombre de pas de transposition de la 
sélection (+ ou –). Entrez par exemple -2 pour 
appliquer une transposition d'une tierce vers 
le bas.

5 Cliquez sur Apply.

Pour transposer un clip Elastic Audio :

1 Assurez-vous que le ou les clips que vous 
souhaitez transposer se trouvent sur des pistes 
Elastic Audio.

2 À l'aide de la Main ou du Sélecteur, 
sélectionnez le clip audio que vous souhaitez 
transposer. Seuls les clips entièrement 
sélectionnés seront transposés.

3 Sélectionnez Event > Event Operations > 

Transpose.

4 Effectuez l'une des opérations suivantes :

• Ajustez les paramètres Transpose By en demi-tons 
et en centièmes.

• Ajustez les paramètres Transpose From et 
Transpose To en demi-tons et centièmes.

5 Cliquez sur Apply.

Commande Select/Split 
Notes
La commande Select/Split Notes de la fenêtre 
Event Operations offre un ensemble complet 
d'outils de sélection et de séparation de notes 
MIDI, basés sur de nombreux critères. Des outils 
supplémentaires permettent de choisir si les 
données sélectionnées doivent être copiées dans le 
presse-papiers ou sur de nouvelles pistes, si elles 
doivent être séparées et réparties sur de nouvelles 
pistes ou une seule destination, etc. 

La transposition de hauteur Elastic Audio 
n'est pas prise en charge par l'algorithme 
Monophonic.

Les paramètres Transpose All Notes To et 
Transpose In Key peuvent être appliqués 
uniquement aux notes MIDI. Lorsque seuls 
des clips audio sont sélectionnés, ces options 
ne sont pas disponibles.
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Paramètres de 
sélection/division de notes

Section Pitch Criteria

All Notes : sélectionne toutes les notes.

Notes Between : sélectionne une plage de notes 
comprises entre les notes supérieure et inférieure 
spécifiées. Vous pouvez entrer les valeurs des 
notes sous forme de hauteur (C1 à G8) ou de 
numéro de note MIDI (0 à 127).

Top : sélectionne la ou les notes les plus hautes de 
chaque accord.

Bottom : sélectionne la ou les notes les plus basses 
de chaque accord.

Section Other Criteria

Velocity : activez l'option Velocity pour définir la 
plage de vélocités utilisée pour la sélection ou la 
division des notes. Entrez une vélocité minimale et 
maximale. 

Duration : activez l'option Duration pour définir la 
plage de durées (en temps et ticks) utilisée pour la 
sélection ou la division des notes. Entrez une durée 
minimale et maximale.

Position : activez l'option Position pour 
sélectionner ou séparer toutes les notes figurant 
dans une plage de positions relatives (en temps 
et ticks) au sein de chaque mesure. La valeur 
minimale détermine le début de la plage et la 
valeur maximale la fin de la plage.

Section Action

Select Notes : sélectionne les notes MIDI en 
fonction des critères spécifiés.

Split Notes: The Clipboard : copie les données 
sélectionnées dans le presse-papiers uniquement.

Split Notes: A New Track : copie toutes les 
données sélectionnées sur une seule nouvelle piste. 
Si la sélection inclut plusieurs pistes, le même 
nombre de pistes est créé. Les nouvelles pistes 
correspondent au type de la piste d'origine (piste 
d'instrument ou MIDI). 

Split Notes: A New Track per Pitch : copie toutes 
les données sélectionnées sur plusieurs nouvelles 
pistes (une nouvelle piste pour chaque hauteur de 
note). Un zoom est appliqué sur les nouvelles 
pistes pour n'afficher que cette hauteur de note. 
Si la sélection inclut plusieurs pistes, les données 
de chaque piste sont réparties séparément.

Include All Continuous MIDI Data : intègre toutes 
les données MIDI continues (y compris celles 
relatives au pitch bend et à l'aftertouch) sur la piste 
entière, sans restriction en matière de sélection 
temporelle.

Page Select/Split Notes de la fenêtre Event 
Operations
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Sélection et division de notes

Pour sélectionner et diviser des notes :

1 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur ou de la Main, sélectionnez 
la plage de notes MIDI contenant les notes.

• Cliquez sur une piste avec le Sélecteur pour 
que toutes ses notes MIDI soient affectées. 
Le curseur d'édition se met alors à clignoter.

2 Sélectionnez Event > Event Operations > 

Select/Split Notes. 

3 Configurez les paramètres de la section Pitch 
Criteria.

4 Configurez les paramètres de la section Other 
Criteria (vélocité, durée et position).

5 Activez l'option Select ou Split. 

6 Dans le menu déroulant Split Notes, 
sélectionnez Copy ou Cut. 

7 Si vous divisez des notes, sélectionnez l'option 
Copy ou Cut to destination.

8 Si vous séparez des notes, activez l'option 
Include All Continuous MIDI Data. L'activation 
de cette option permet de prendre en compte 
toutes les données de contrôleur associées aux 
notes divisées sur les nouvelles pistes. 
Désactivez cette option si vous souhaitez 
uniquement diviser les données de note sur de 
nouvelles pistes. 

9 Cliquez sur Apply. 

Les propriétés en temps réel associées à la piste ou 
aux clips sont copiées sur les nouvelles pistes 
créées par la commande Select/Split Notes. 

Sélection d'une plage de 
hauteurs de notes
La commande Select/Split Notes est couramment 
utilisée pour sélectionner une seule note sur 
toute la durée d'un clip ou d'une piste. Cela est 
particulièrement pratique si vous souhaitez 
sélectionner une note d'une piste de batterie MIDI (un 
charley, par exemple), et la modifier, sur la plage de 
temps sélectionnée, avec les commandes Quantize, 
Groove Quantize, Transpose ou Change Duration.

Pour ne sélectionner que le charley d'une piste de 
batterie General MIDI :

1 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur ou de la Main, sélectionnez 
la plage de notes MIDI contenant les notes.

• Cliquez sur une piste avec le Sélecteur pour que 
toutes ses notes MIDI soient affectées. 
Le curseur d'édition se met alors à clignoter.

2 Sélectionnez Event > Event Operations > 

Select/Split Notes.

3 Sélectionnez l'option Notes Between, la plage de 
notes étant définie entre F#1 et F#1 (si le paramètre 
MIDI Note Display est réglé sur Standard Pitch 
dans la page des préférences MIDI).

Pour les kits de batterie General MIDI, le son de 
charley fermé est assigné au numéro de note 
MIDI 42 (F#1 à la hauteur standard). Si le son de 
charley de votre kit de batterie est assigné à une 
autre note, pensez à le spécifier.

4 Cliquez sur Apply.

Vous pouvez également sélectionner toutes les 
notes ayant une hauteur spécifique sur une 
piste en utilisant le mini-clavier. Pour plus 
d'informations, reportez-vous à la section 
« Sélection de notes MIDI » à la page 700.
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Sélection de notes d'un accord
La commande Select/Split Notes sert également 
à sélectionner uniquement les notes les plus hautes 
ou les plus basses d'un accord. Le plus souvent, 
seules les notes les plus hautes ou les plus basses 
d'un accord doivent être retouchées (augmentation 
de leur vélocité ou transposition de leur hauteur, 
par exemple).

Pour ne sélectionner que les notes les plus basses 
d'un accord :

1 Effectuez l'une des opérations suivantes :

• À l'aide du Sélecteur ou de la Main, sélectionnez 
la plage de notes MIDI contenant les notes.

• Cliquez sur une piste avec le Sélecteur pour 
que toutes ses notes MIDI soient affectées. 
Le curseur d'édition se met alors à clignoter.

2 Sélectionnez Event > Event Operations > 
Select/Split Notes.

3 Activez l'option Bottom et laissez le nombre de 
notes défini sur 1.

4 Cliquez sur Apply.

Commande Input Quantize
Lorsque la commande Input Quantize est activée 
dans la fenêtre Event Operations, toutes les notes 
MIDI enregistrées sont automatiquement 
quantifiées.

Pour activer la quantification en entrée :

1 Sélectionnez Event > Event Operations > Input 
Quantize.

2 Dans la page Input Quantize, activez l'option 
Enable Input Quantize.

3 Configurez les autres options de la page Input 
Quantize. Pour plus d'informations sur les 
options de quantification, reportez-vous à la 
section « Commande Quantize » à la page 938. 

4 Lorsque vous avez terminé, fermez la fenêtre 
Event Operations.

Afin que des notes forment un accord, leurs 
heures de début doivent être distantes d'un 
maximum de trente-deux ticks.

Page Input Quantize de la fenêtre Event Operations

Utilisez la commande Input Quantize pour les 
enregistrements en boucle de type boîte 
à rythmes (reportez-vous à la section 
« Enregistrement en boucle en mode de 
fusion MIDI » à la page 493).
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Commande Step Input
La commande Step Input de la fenêtre Event 
Operations permet d'utiliser un contrôleur MIDI 
pour saisir séparément des notes, pas à pas. Vous 
pouvez ainsi contrôler précisément la position, 
la durée et la vélocité des notes. La saisie pas à pas 
MIDI permet également de créer des passages 
musicaux difficiles à jouer avec précision ou à un 
tempo plus rapide. 

Pour saisir des notes MIDI avec la commande Step 
Input (à l'aide d'un périphérique MIDI externe) :

1 Assurez-vous que votre périphérique MIDI 
externe soit correctement connecté et 
fonctionne avec Pro Tools.

2 Sélectionnez Event > Event Operations > 

Step Input.

3 Activez l'option Enable.

4 Sélectionnez la piste MIDI ou la piste 
d'instrument de destination de la saisie pas à pas 
dans le menu Destination track.

5 Sélectionnez la valeur de la note à saisir dans la 
section Step Increment.

6 Jouez une note ou un accord sur votre 
instrument MIDI. La note est saisie et le point 
d'insertion passe au pas suivant.

Pour augmenter la durée d'une note saisie pas 
à pas :

1 Maintenez une touche enfoncée sur votre 
instrument MIDI.

2 Sélectionnez la valeur de la note que vous 
voulez ajouter et appuyez sur le bouton 
Increment.

Relâchez la note sur votre clavier MIDI pour 
passer au pas suivant.

Fenêtre Step Input

Utilisez la commande Step Input pour saisir 
des notes MIDI dans une fenêtre de l'éditeur 
MIDI ou de partition.

Lorsque la commande Step Input est activée, 
chaque piste MIDI précédemment préparée 
à l'enregistrement sort de cet état et si un 
instrument est spécifié pour la préférence 
Default Thru Instrument, il est désactivé.

Lorsqu'une note est ainsi jouée sur le 
clavier MIDI, l'option Next Step affiche 
Increment. 
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Commandes de saisie pas à pas
La page Step Input propose les paramètres 
suivants :

Enable : lorsque cette option est sélectionnée, 
des événements MIDI sont ajoutés sur la piste de 
destination si vous jouez sur votre clavier MIDI 
externe. De plus, toutes les pistes MIDI 
précédemment préparées à l'enregistrement sortent 
de cet état. 

Si l'option Default Thru Instrument est activée 
dans la page des préférences MIDI, l'instrument 
par défaut est désactivé lorsque la commande Step 
Input est sélectionnée, puis réactivé lorsqu'elle 
n'est plus utilisée.

Destination : permet de sélectionner la piste de 
destination de la saisie pas à pas à partir d'une liste 
déroulante de toutes les pistes MIDI de votre 
session. 

Commandes de la section Step 
Increment

Les commandes de la section Step Increment 
permettent de définir l'espacement et la durée des 
événements MIDI saisis pas après pas. Vous 
pouvez sélectionner n'importe quelle valeur de 
note, de la ronde à la quadruple croche (valeurs 
pointées comprises). 

Tuplet : permet de saisir des groupes de notes 
irréguliers, tels que des triolets ou quintolets. 
La durée du triolet est calculée à partir de la 
sélection de l'espacement de note et de la valeur 
Tuplet. Si, par exemple, une croche équivaut 
à 480 ticks, des croches en triolet (3 pour 2) 
donnent un espace de note de 320 ticks 
(480 ticks / 3 * 2).

Note Length : cette option permet de sélectionner 
la durée de la note sous forme d'un pourcentage 
de la valeur d'espacement. Si, par exemple, 
une croche équivaut à 480 ticks, une croche d'une 
durée de 80 % correspond à une durée de 384 ticks.

Options de saisie pas à pas

Use Input Velocity : lorsque cette option est 
sélectionnée, les notes MIDI sont enregistrées avec 
la vélocité à laquelle vous les jouez sur votre 
clavier MIDI.

Set Velocity To : lorsque cette option est 
sélectionnée, les notes MIDI sont enregistrées avec 
la vélocité spécifiée dans le champ associé. 
Définissez cette valeur avec le curseur.

Enable Numeric Keypad Shortcuts : cette option 
permet de sélectionner les options de saisie pas 
à pas à partir du pavé numérique. Reportez-vous à 
la section « Raccourcis de saisie pas à pas du 
clavier numérique » à la page 967.

Undo Step, Next Step et Redo Step

Utilisez les boutons Undo Step et Next Step pour 
effectuer les opérations suivantes :

• Passer au pas suivant, soit en supprimant la note 
précédente, soit en avançant le point d'insertion 
de la valeur de pas sélectionnée.

• Allonger et raccourcir les notes qui sont jouées 
sur le contrôleur MIDI en ajoutant ou en 
supprimant la valeur de pas sélectionnée. 
La valeur de pas peut être modifiée à mi-note 
pour créer une note de durée hybride.

Pourcentages de longueur de note

100 % 80 % 120 %
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Utilisez le bouton Redo Step pour rétablir la 
séquence des opérations précédemment annulées. 

Undo Step : lorsque vous avez relâché la note 
précédente sur le clavier MIDI et que le point 
d'insertion est passé sur la note suivante, 
la commande Undo Step supprime entièrement la 
dernière note.

Lorsqu'une note est maintenue sur le clavier MIDI, 
la commande Undo Step affiche alors le texte 
Decrement et supprime la durée de la dernière 
valeur de pas ajoutée à la note actuellement jouée.

Next Step (ou Increment) : si aucune note n'est 
jouée sur le clavier MIDI, la commande Next Step 
déplace le point d'insertion de la valeur de pas 
sélectionnée et insère une pause musicale.

Lorsqu'une note est jouée sur le clavier MIDI, 
la commande Next Step affiche alors le texte 
Increment et ajoute la valeur de pas sélectionnée 
à la note jouée, ce qui allonge sa durée de cette 
valeur. 

Si vous maintenez la note enfoncée, la valeur de 
pas peut être modifiée, ce qui permet de créer des 
notes de n'importe quelle durée.

Redo Step : réinsère la dernière note supprimée 
par la commande Undo Step. 

Déclenchement des 
commandes Undo Step, Next 
Step, ou Redo Step
Les commandes Undo Step, Next Step et Redo 

Step peuvent être configurées de manière à être 
déclenchées par un synthétiseur MIDI externe, 
un pad de batterie ou tout autre contrôleur. 

Pour définir les événements MIDI de 
déclenchement des commandes Undo Step, Next 
Step et Redo Step :

1 Placez le point d'insertion d'édition sur la piste 
de votre choix, à l'emplacement où vous 
souhaitez entrer la première note MIDI.

2 Sélectionnez Event > Event Operations > 

Step Input.

3 Recherchez le bouton que vous souhaitez 
assigner à un événement MIDI et cliquez dans 
le champ situé sous ce bouton.

4 Jouez l'événement MIDI à utiliser comme 
déclencheur. 

5 Appuyez sur Entrée pour confirmer 
l'assignation du déclencheur MIDI.

Si vous utilisez un contrôleur continu 
(tel qu'une molette de pitch bend) comme 
déclencheur, assurez-vous d'utiliser une 
valeur de contrôleur extrême afin d'éviter 
toute saisie de données erronée.
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Raccourcis de saisie pas à pas 
du clavier numérique
Si vous avez activé l'option Enable Numeric 

Keypad Shortcuts, vous pouvez exécuter de 
nombreuses commandes de la page Step Input, 
ainsi que plusieurs commandes de sélection depuis 
le pavé numérique de votre ordinateur. 
:

Raccourcis de saisie 
pas à pas

Touche

Ronde 1

Blanche 2

Noire 4

Croche 5

Double croche 6

Triple croche 7

Quadruple croche 8

Note pointée . (point)

Activer/désactiver les 
triolets

3

Pas suivant Entrée

Annuler le pas 0

Avancer d'un pas +

Reculer d'un pas –

Sélectionner le compteur 
principal

=

indicateurs de sélection 
d'édition

/
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Chapitre 42 : HEAT

HEAT (Harmonically Enhanced Algorithm 
Technology) est une option logicielle qui ajoute 
une « couleur analogique » aux systèmes 
Pro Tools|HDX.

HEAT est appliqué à toutes les pistes audio actives 
de votre session et reproduit l'effet des bandes 
d'enregistrement magnétiques combinées à la 
coloration harmonique qui caractérise généralement 
les consoles de mixage analogiques. HEAT vous 
permet de débuter vos mixages avec une distorsion 
légèrement saturée pleine de chaleur imitant 
l'analogique.

Activation de HEAT
Lorsque l'option logicielle HEAT est activée, elle 
est appliquée à toutes les pistes audio actives de 
votre session et reproduit l'effet d'une console de 
mixage analogique. HEAT est pris en charge avec 
tous les formats mono, stéréo, et surround. HEAT 
vous permet de débuter vos mixages avec une 
distorsion légèrement saturée pleine de chaleur 
imitant l'analogique.

HEAT utilise des ressources DSP sur toutes les 
pistes audio actives. Ce point est important, 
car lorsque vous augmentez ou diminuez le 
nombre de pistes audio dans la session, vous 
augmentez ou diminuez également la quantité de 
ressources DSP requises pour le fonctionnement 
de HEAT. Notez que HEAT n'utilise pas de 
ressources DSP pour les pistes audio désactivées.

Pour activer ou désactiver HEAT dans une 
session, effectuez l'une des opérations 
suivantes :

 Sélectionnez ou désélectionnez Options > 

Activate HEAT.

 Sélectionnez ou désélectionnez le bouton 
On/Off de HEAT dans la fenêtre Mix, dans la 
vue HEAT.

Vous pouvez également activer l'option Enable 

HEAT in New Sessions dans les préférences 
Pro Tools pour que HEAT soit automatiquement 
activée pour toutes les nouvelles sessions.

Pour activer ou désactiver HEAT pour les 
nouvelles sessions :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Processing.

3 Dans la section DSP Management, sélectionnez 
ou désélectionnez l'option Enable HEAT in New 

Sessions.

4 Cliquez sur OK.
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À propos du traitement HEAT
HEAT propose des commandes globales pour les 
paramètres Drive et Tone. Ces commandes 
affectent toutes les pistes audio sur lesquelles 
HEAT n'est pas en bypass.

Drive
La commande Drive applique un traitement non 
linéaire qui émule les bandes d'enregistrement 
magnétiques combinées aux informations 
harmoniques caractéristiques des équipements 
analogiques. 

Tourner la commande Drive dans le sens inverse 
des aiguilles d'une montre émule une distorsion 
non linéaire de type bande analogique. Comme 
pour une bande analogique, le fait d'augmenter la 
commande Drive en la faisant tourner dans le sens 
inverse des aiguilles d'une montre densifie le 
contenu harmonique en ajoutant des harmoniques 
impaires de plus haute fréquence (en commençant 
par la 3e et la 5e). HEAT émule également 
l'enregistrement et la reproduction des égaliseurs 
de magnétophones à bande qui modifient plus 
encore le contenu harmonique. De ce fait, lorsque 
vous tournez la commande Drive dans le sens 
inverse des aiguilles d'une montre, HEAT densifie 
les basses fréquences et médiums de l'audio traité 
et lisse les transitoires haute fréquence. 

Tourner la commande Drive dans le sens des 
aiguilles d'une montre génère un effet plus agressif 
en ajoutant aux harmoniques impaires des 
harmoniques paires d'ordinaire produites par les 
circuits à lampes triodes. Cette opération permet 
notamment d'émuler les microphones à lampes, 
entre autres équipements analogiques de ce type. 

Notez que la structure harmonique varie selon le 
niveau du signal et la quantité de traitement 
appliquée, à l'image des authentiques tubes 
à lampes du domaine analogique.

Tone
Comme avec une bande analogique, une perte dans 
les hautes fréquences peut survenir par rapport aux 
basses fréquences lorsque le niveau d'entrée est 
suffisamment élevé, les hautes fréquences étant 
compressées plus tôt que les basses. HEAT peut 
compenser ces pertes en ajoutant plus de détail et 
de brillance, selon le type de contenu et son niveau. 
Vous pouvez accentuer (sens des aiguilles d'une 
montre) ou atténuer (sens inverse) les niveaux de 
détail et de brillance en déplaçant la commande 
Tone par rapport à sa position par défaut.

L'effet produit par la commande Tone varie selon 
le réglage de la commande Drive. La quantité et le 
caractère du contenu harmonique varient de façon 
non linéaire, contrairement à une commande de 
tonalité d'un égaliseur.

Traitement HEAT
Avec le traitement HEAT, les crêtes du signal sont 
atténuées alors que le contenu harmonique de 
faible niveau est augmenté, réduisant ainsi le 
niveau des crêtes existantes. Ce fonctionnement 
est similaire à celui d'un tube ou d'une bande 
analogique qui produit un écrêtage doux en 
« écrasant » les crêtes et en appliquant une 
compression analogique sur une large plage 
dynamique.

Quelle quantité de traitement utiliser ?

Le traitement HEAT dépend du type de contenu 
et de son niveau. Bien qu'un réglage général puisse 
fonctionner avec de nombreuses sources, 
un réglage optimal pour une source spécifique 
n'aura pas l'effet souhaité sur une autre source. 
Si vous avez besoin d'un réglage polyvalent, 
déplacez la commande Drive de deux crans (dans 
un sens ou dans l'autre).
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Comme votre ouïe peut ne pas être habituée au 
contenu harmonique généré par HEAT, il se peut 
que vous deviez passer du temps à écouter l'effet 
du traitement HEAT sur vos contenus pour vous y 
habituer. L'oreille humaine apprécie une légère 
génération d'harmoniques. Essayez différents 
réglages pour identifier les sons qui vous plaisent 
le plus. 

Une fois habitué à la façon dont vos contenus 
sonnent avec le traitement HEAT, vous 
remarquerez son effet subtil mais significatif dès 
que vous le désactiverez.

La quantité de traitement appliquée peut se 
traduire par des nuances subtiles ou plus marquées, 
selon le type de contenu et la manière dont il a été 
enregistré. Il en va de même pour la différence de 
traitement entre les enregistrements analogiques et 
numériques. L'effet du traitement est plus facile 
à percevoir lorsque le contenu source est plus 
« ouvert », contrairement aux contenus plus 
denses. La quantité d'informations dans les basses 
fréquences ajoutées affectent également la manière 
dont vous percevrez le traitement.

Commandes HEAT
HEAT fournit un ensemble simple de commandes 
principales pour le réglage précis de la couleur de 
l'effet, et un ensemble de commandes pour chaque 
piste audio de votre session.

Commandes HEAT principales
Les commandes HEAT principales permettent de 
déterminer la quantité et la couleur du traitement 
HEAT pour toutes les pistes audio. Prenez le temps 
d'essayer différents réglages pour obtenir la 
couleur sonore souhaitée pour votre mixage.

On/Off (HEAT) : active (ou désactive) HEAT dans 
votre session Pro Tools.

Bypass (BYPASS) : ignore le traitement HEAT 
sans le désactiver. Notez que le fait de mettre 
HEAT en bypass ne libère pas les ressources DSP 
requises pour ce dernier.

Indicateur de niveau : affiche la quantité moyenne 
de traitement HEAT sur toutes les pistes audio.

Drive : ajuste la quantité de Drive pour HEAT, 
qui émule la distorsion obtenue lorsque vous 
saturez un canal analogique sur une console. Sur la 
position par défaut (midi), aucun traitement HEAT 
n'est appliqué. Tournez le bouton dans le sens 
inverse des aiguilles d'une montre pour ajouter des 
harmoniques impaires au mixage (effet similaire 
à la saturation d'une bande magnétique). 

Commandes HEAT principales
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Tournez le bouton dans le sens des aiguilles d'une 
montre pour ajouter des séries d'harmoniques 
paires et obtenir un effet similaire à un celui 
produit par un circuit à lampes triodes.

Tone : ajuste la tonalité (de grave à aigüe) du 
traitement HEAT. Tournez la commande vers la 
droite pour un son plus clair ou vers la gauche pour 
un son plus sourd.

Affichage et masquage des 
commandes HEAT principales

Les commandes HEAT principales sont 
accessibles dans la fenêtre Mix. 

Pour afficher (ou masquer) les commandes HEAT 
principales :

 Cliquez sur le bouton Afficher/Masquer de la 
vue HEAT dans le coin inférieur droit de la 
fenêtre Mix.

Commandes de pistes HEAT
Les commandes de pistes HEAT sont disponibles 
sur toutes les pistes audio. HEAT affecte 
uniquement les pistes audio.

Bypass (BYP) : ignore le traitement HEAT pour 
une piste audio individuelle. Notez que le fait de 
bypasser HEAT sur des pistes individuelles ne 
libère pas les ressources DSP requises par HEAT 
pour cette piste.

Pre/Post Insert (PRE) : définit la position du 
traitement HEAT entre pré et post-inserts 
sur la piste individuelle. Le traitement HEAT est 
pré-inserts lorsque le bouton PRE est allumé.

Indicateur de niveau : affiche la quantité de 
traitement HEAT sur une piste audio individuelle. 
Sur des pistes multicanal, l'indicateur affiche la 
quantité moyenne de traitement HEAT appliqué 
sur tous les canaux de cette piste.

Affichage et masquage des 
commandes de pistes HEAT

Les commandes de pistes HEAT sont accessibles 
dans la fenêtre Mix. 

Pour afficher ou masquer les commandes de 
pistes HEAT, effectuez l'une des opérations 
suivantes :

 Sélectionnez ou désélectionnez View > Mix 

Window Views > HEAT.

Bouton Afficher/Masquer de la vue principale HEAT 
dans la fenêtre Mix

Commandes de pistes HEAT
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 Sélectionnez ou désélectionnez la vue HEAT 
dans le sélecteur de la fenêtre Mix.

Indicateurs de bypass 
principal et de piste
Un code couleur est appliqué au bouton de bypass 
des pistes pour indiquer si une piste est bypassée 
de manière explicite ou implicite lorsque le 
bypass principal est activé. Les pistes bypassées 
explicitement le restent lorsque le bypass principal 
est désactivé.

Lorsqu'une piste est explicitement bypassée, 
le bouton BYP devient orange.

Lorsque le bypass principal est activé, l'indicateur 
devient orange et les boutons BYP des pistes 
explicitement bypassées restent également en 
orange. Les boutons BYP des pistes implicitement 
bypassées sont affichés en orange foncé.

Remarque sur les autres 
types de pistes
HEAT affecte uniquement les pistes audio. Il ne 
s'applique pas aux pistes d'instrument, d'entrée 
auxiliaire et Master. Si vous utilisez des plug-ins 
d'instrument virtuel sur une piste d'instrument ou 
d'entrée auxiliaire et souhaitez appliquer le 
traitement HEAT, vous pouvez enregistrer l'audio 
de cette piste sur une piste audio ou router la sortie 
de la piste vers l'entrée d'une piste audio et activer 
le monitoring d'entrée.

Configuration DSP requise et 
nombre de voix
La quantité de ressources DSP utilisées par HEAT 
dépend du nombre de voix utilisées pour les pistes 
audio, du type de matériel DSP et de la fréquence 
d'échantillonnage de la session.

Le tableau suivant répertorie le nombre de pistes 
audio mono disponibles par puce DSP lorsque le 
traitement HEAT est activé. 

Sélection de la vue HEAT dans le sélecteur de la 
fenêtre Mix

Commandes principales et de pistes HEAT avec une 
piste en bypass

Commandes principales et de pistes HEAT avec 
bypass principal
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Les pistes stéréo requièrent deux fois plus de DSP 
que les pistes mono, et les formats surround autant 
de DSP par canal que le nombre correspondant de 
pistes mono (par exemple, une piste au format 5.1 
utilise la même quantité de DSP que 6 pistes mono).

Ressources DSP insuffisantes
Il se peut que votre système ne dispose pas de 
ressources DSP suffisantes pour ajouter des pistes 
audio supplémentaires à la session lorsque HEAT 
est activé (car il n'y a pas suffisamment de DSP 
disponibles pour HEAT sur les nouvelles pistes). 
Dans ce cas, Pro Tools vous invite à effectuer l'une 
des opérations suivantes :

• Créer les nouvelles pistes, mais en les 
désactivant (les pistes audio désactivées 
n'utilisent pas de ressources DSP).

• Désactiver HEAT et créer les nouvelles pistes.

Lorsque vous ouvrez une session enregistrée avec 
HEAT activé, si votre système ne dispose pas de 
suffisamment de DSP pour appliquer HEAT 
à toutes les pistes audio actives dans la session, 
HEAT est automatiquement désactivé. La boîte de 
dialogue de notes de session indique que HEAT 
a été désactivé.

Une fois la session ouverte, vous pouvez gérer les 
pistes qui doivent être actives avec HEAT activé 
dans les limites DSP de votre système. Vous 
pouvez également étendre votre système Avid 
HDX avec des cartes supplémentaires pour 
accroître les ressources DSP disponibles pour 
HEAT.

Dans certains cas, si la session à ouvrir compte un 
grand nombre de plug-ins DSP actifs, la session 
peut s'ouvrir avec HEAT activé, mais risque de 
désactiver quelques plug-ins DSP de la session. 
Ceci est dû au fait que le traitement HEAT est 
prioritaire sur le traitement des plug-ins DSP.

Nombre de voix nécessaires
Lors de l'activation de HEAT, des voix 
supplémentaires peuvent être requises si le 
traitement est appliqué pré-inserts sur une piste et 
si le premier plug-in de cette piste est un plug-in 
Native. Si le nombre de voix disponibles est 
insuffisant, HEAT ne peut pas être activé.

Si HEAT est déjà actif, appliqué post-inserts sur une 
piste, et si le premier plug-in de cette piste est un 
plug-in Native, HEAT nécessitera des voix 
supplémentaires pour passer post-inserts. 
Si le nombre de voix disponibles est insuffisant, 
le bouton Pre est inactif jusqu'à ce que vous 
augmentiez le nombre de voix (dans le moteur de 
lecture) ou que des voix supplémentaires soient 
disponibles (par exemple, en désactivant des pistes 
audio).

Nombre de pistes audio mono disponibles par 
puce DSP

Type de 
puce 
DSP

44,1/ 
48 kHz

88,2/ 
96 kHz

176,4/ 
192 kHz

HDX 86 42 19
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Utilisation de HEAT avec une 
surface de contrôle
(ICON et C|24 uniquement)

Vous pouvez utiliser les fonctionnalités suivantes 
d'une surface ICON (D-Control et D-Command) et 
C|24 pour contrôler HEAT. 

D-Control et D-Command
Avec une D-Control ou une D-Command, vous 
pouvez accéder aux commandes HEAT 
principales dans la section Custom Fader, et aux 
commandes de canal HEAT directement à partir 
des tranches de console. 

Commandes principales

Les commandes HEAT principales permettent 
d'activer/désactiver le traitement, d'activer le bypass 
et de contrôler les paramètres Drive et Tone. 

Pour accéder aux commandes HEAT principales 
à partir d'une D-Control ou d'une D-Command :

 Dans la section Custom Fader, appuyez sur le 
bouton Plug-Ins tout en maintenant les touches 
Maj+Ctrl enfoncées. 

Un Custom Fader est créé pour HEAT et les 
commandes sont mappées sur les encodeurs 
centraux comme décrit ci-dessous. 

D-Control 

Sur une D-Control, vous pouvez contrôler les 
commandes HEAT principales depuis un seul 
Custom Fader (n°8).

D-Command (Custom Faders 7 et 8)

Sur une D-Command, vous pouvez contrôler les 
commandes HEAT principales depuis les sections 
d'encodeurs de deux Custom Fader (7 et 8). 

Pour plus d'informations sur l'utilisation de 
HEAT avec les surfaces de contrôle Avid 
Artist et Pro Series, reportez-vous au Guide 
Pro Tools EUCON.

Commandes HEAT principales sur une D-Control

Encodeur Paramètre Action

N°3 HEAT 
(On/Off)

Tourner l'encodeur ou 
appuyer sur 
l'encodeur 3 BMP pour 
activer/désactiver

N°4 MstByp 
(Master 
Bypass)

Tourner l'encodeur ou 
appuyer sur 
l'encodeur 4 BMP pour 
activer/désactiver

N°5 Drive Tourner l'encodeur

N°6 Tone Tourner l'encodeur

Commandes HEAT principales sur une D-Command

Encodeur Paramètre Action

N°1
(Fader 7)

HEAT (On/Off) Appuyer sur 
BMP pour 
activer/désactiver 
la commande, 
ou tourner 
l'encodeur

N°2
(Fader 7)

MstByp 
(Master 
Bypass)

Appuyer sur 
BMP pour 
activer/désactiver 
la commande, 
ou tourner 
l'encodeur

N°1
(Fader 8)

Drive Tourner 
l'encodeur

N°2
(Fader 8)

Tone Tourner 
l'encodeur
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Commandes de canal HEAT Bypass 
et Pre/Post

Lorsque HEAT est activé dans une session, chaque 
tranche de console fournit des fonctions HEAT 
Bypass et Pre/Post. Ces paramètres de canal sont 
directement accessibles depuis les tranches de 
console d'une D-Control ou d'une D-Command. 
Les commandes de canal HEAT suivent les 
fonctions des touches de modification Do To All et 
Do to All Selected. 

Pour accéder aux commandes HEAT sur une 
tranche de console :

1 Vérifiez que HEAT est activé pour la session. 

2 Appuyez sur la touche Inserts du canal tout en 
maintenant les touches Maj+Ctrl enfoncées. 

D-Control

Sur une D-Control, les encodeurs/boutons BMP 
5 et 6 sont associés respectivement aux 
commandes Pre/Post et Bypass de HEAT. 

Pour basculer un canal entre les positions pré et 
post-inserts (HEAT) : 

 Effectuez l'une des opérations suivantes : 

• Tournez l'encodeur 5

• Appuyez sur le bouton BMP de l'encodeur 5. 

Pour activer ou désactiver le bypass de HEAT sur 
un canal : 

 Effectuez l'une des opérations suivantes : 

• Tournez l'encodeur 6

• Appuyez sur le bouton BMP de l'encodeur 6. 

D-Command

Sur une D-Command, les encodeurs de canal et 
leurs boutons BMP sont associés aux commandes 
Pre/Post (rangée supérieure d'encodeurs) et 
Bypass (rangée inférieure d'encodeurs) de HEAT. 

Pour activer ou désactiver le bypass de HEAT sur 
un canal : 

 Effectuez l'une des opérations suivantes : 

• Tournez l'encodeur inférieur.

• Appuyez sur le bouton BMP de l'encodeur 
inférieur. 

Pour basculer un canal entre les positions pré et 
post-inserts (HEAT) : 

 Effectuez l'une des opérations suivantes : 

• Tournez l'encodeur supérieur.

• Appuyez sur le bouton BMP de l'encodeur 
supérieur. 

HEAT prend en charge le mode Flip à la fois 
pour ses commandes principales et de canal. 
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C|24
Une C|24 permet d'ajuster les commandes HEAT principales à partir des encodeurs 21 à 24, et les 
commandes HEAT de canal depuis chaque tranche de console. 

Commandes principales

Pour accéder aux commandes HEAT principales sur une C|24 : 

 Appuyez sur le bouton Soft Keys dans la barre des canaux. Pour quitter ce mode, appuyez de nouveau 
sur le bouton Soft Keys.

Les commandes HEAT principales sont associées à l'encodeur et aux boutons d'encodeur des tranches de 
console 21 à 24, comme indiqué dans le Tableau 1 à la page 977.

Commandes de canal Bypass et Pre/Post de HEAT

Lorsque HEAT est activé dans une session, chaque tranche de console fournit des fonctions HEAT Bypass 
et Pre/Post. Ces paramètres de canal sont directement accessibles depuis les tranches de console d'une 
C|24. Les commandes de canal HEAT suivent les fonctions des touches de modification Do To All et Do 
to All Selected. 

Pour accéder aux commandes de canal HEAT :

1 Vérifiez que HEAT est activé pour la session actuelle. 

2 Sur la tranche de console, maintenez enfoncé le bouton Insert correspondant au canal. Pour quitter ce 
mode, appuyez de nouveau sur ce bouton.

Pour activer ou désactiver le bypass de HEAT sur un canal : 

 Appuyez sur le bouton Bypass du canal. 

Pour basculer un canal entre les positions pré et post-inserts (HEAT) : 

Tournez l'encodeur du canal ou appuyez sur le bouton d'encodeur et sélectionnez Pre ou Post.

Tableau 1. Commandes HEAT principales sur une C|24

Encodeur 21 22 23 24

Paramètre
HEAT (On/Off) MstByp (Master 

Bypass)
Drive Tone

Action

Appuyez sur le 
bouton encodeur 
pour 
activer/désactiver

Appuyez sur le 
bouton encodeur 
pour 
activer/désactiver

Tourner l'encodeur Tourner 
l'encodeur
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Partie IX : Mixage
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Chapitre 43 : Principes de base du mixage

Le mixage dans Pro Tools consiste à manipulercréez 
des CD audio et des fichiers au format MP3 à partir 
d'un état provisoire du mix et écoutez-les hors studio, 
dans des environnements d'écoute différents.

des éléments de flux de signaux audio, notamment 
des entrées, des sorties, des bus, des inserts et des 
départs afin d'assurer le sous-groupe de mixage et le 
mixage final.

Les tâches de mixage peuvent être réalisées à tout 
moment dans une session, y compris avant 
le mixdown final. 

Lors du mixage, des plug-ins en temps réel et des 
points d'inserts matériels assurent les effets et le 
traitement des signaux (pour plus d'informations, 
reportez-vous au Chapitre 44, « Inserts de plug-in et 
matériels »). 

Concepts du mixage
Le mixage consiste à modifier certains éléments, tels 
que les niveaux de son, le panoramique et les effets 
en studio. Bien que vous puissiez contrôler de 
nombreuses variables en studio (par exemple les 
haut-parleurs et l'acoustique de la salle), vous ne 
pouvez pas contrôler l'environnement d'écoute du 
mixage final. Les conseils suivants vous aident à 
garantir la meilleure qualité de mixage possible pour 
le plus grand nombre d'auditeurs :

Haut-parleurs alternatifs et monitoring 
de référence : écoutez vos mixages sur différents 
types d'enceintes afin d'en évaluer la qualité sur 
plusieurs systèmes de reproduction.

Mixage de référence : Vérification de la 
compatibilité de formats : vérifiez la compatibilité 
des mixages stéréo avec les systèmes d'écoute mono, et 
celle des mixages multicanal surround avec les 
systèmes d'écoute stéréo.

Indication des niveaux 
et étalonnage
Les indicateurs de niveau indiquent visuellement 
le niveau des signaux. Ils spécifient la présence 
d'un signal sur un canal et sa valeur par rapport au 
repère « 0 dB » (supérieure ou inférieure). 

L'étalonnage de tous vos équipements avec des 
niveaux de référence standard permet de maintenir 
(et de mesurer) un niveau constant lors du passage 
d'un appareil d'enregistrement à un autre dans 
un studio, à l'échelle d'une structure de post-
production ou tout au long de la chaîne de 
production. Un signal de niveau 18 dBFS sortant 
d'un magnétophone DAT par exemple doit être lu et 
mesuré à 18 dBFS dans Pro Tools.

Étalonnage d'interfaces audio
(HD I/O uniquement)

Si vous utilisez un système Pro Tools|HDX 
ou Pro Tools|HD Native avec une HD I/O, utilisez 
l'option Calibration Reference Level (de la page 
des préférences de fonctionnement) pour définir le 
niveau de référence lorsque Pro Tools fonctionne 
en mode Calibration.
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Flux des signaux par type 
de piste
Pro Tools propose les types de piste suivants :

• Audio

• Entrée auxiliaire

• Master Fader

• MIDI

• Piste d'instrument

• Master VCA (Pro Tools HD uniquement)

Les pistes audio, d'entrée auxiliaire, Master Fader et 
d'instrument peuvent router de l'audio. Les pistes 
MIDI et d'instrument peuvent router des données 
MIDI. 

Les pistes Master VCA ne transfèrent pas 
de données audio ou MIDI, mais elles affectent les 
commandes d'autres pistes. Reportez-vous à la 
section « Pistes Master VCA » à la page 987. 

Dans la fenêtre Mix, les pistes sont identifiées par 
leur icône de type.

Pistes audio et flux du signal
Les pistes audio lisent et enregistrent les données 
audio sur disque ou permettent, lorsqu'elles sont 
activées pour l'enregistrement ou en mode 
de monitoring TrackInput, d'écouter les signaux 
d'entrée. Les inserts sur les pistes audio sont pré-
fader. Les départs sur les pistes audio peuvent être 
pré-fader ou post-fader.

Tous les systèmes Pro Tools disposent de pistes 
audio mono et stéréo. 

Pour plus d'informations sur l'étalonnage d'une 
HD I/O, reportez-vous au Guide HD I/O.

Pistes audio, d'entrée auxiliaire, Master Fader, Master 
VCA, MIDI et d'instrument

Pour plus d'informations sur la création 
de pistes, reportez-vous à la section 
« Création de pistes » à la page 217.

Icônes de type de piste
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Les pistes audio multicanal et les formats 
de mixage surround sont uniquement pris 
en charge par Pro Tools HD.

Flux du signal des pistes 
d'entrée auxiliaire
Les pistes d'entrée auxiliaire offrent les mêmes 
options de routing des signaux que les pistes audio, 
à ceci près que leurs entrées doivent provenir d'un 
bus interne ou d'une entrée matérielle. Les inserts 
sur les entrées auxiliaires sont pré-fader.

Les pistes d'entrée auxiliaire sont utilisées comme 
entrées pour les signaux audio provenant 
d'instruments MIDI externes et d'autres sources 
sonores, ainsi que pour créer des sous-groupes 
de mixage à partir de chemins de bus et de sorties 

Flux de signal audio d'une piste audio

 

 

 Source
ou entrée

Option HEAT, pré-insert

Source : fichier audio mono, stéréo
ou multicanal, lu depuis le disque

Entrée : monitoring en 
enregistrement ou mode 
TrackInput

Option HEAT, post-insert

Départs, pré-fader

Inserts 
(plug-ins 
ou inserts 
matériels)

Entrée 
Solo

Record
Mute

Volume

Départs, post-fader

Sortie 
principale 

+ Sorties 
supplémentaires

Sortie

Panora-
mique

Flux de signal audio d'une piste d'entrée auxiliaire

 

Entrée

Source : bus ou chemin 
d'entrée matérielle

Inserts 
(plug-ins 
ou inserts 
matériels)

Départs, pré-fader

Solo

Volume 

Mute

Départs, post-fader

Panora-
mique

Sortie Sortie 
principale

+ Sorties 
supplémentaires 
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internes. Elles peuvent être entièrement 
automatisées. Lorsque vous utilisez des pistes 
d'entrée auxiliaire comme entrées pour des sources 
externes, c'est sur ces sources elles-mêmes qu'il 
convient de régler le volume de sortie afin 
d'obtenir un niveau d'enregistrement approprié. 

Utilisations courantes des 
entrées auxiliaires
Vous pouvez utiliser les entrées auxiliaires pour :

• appliquer des plug-ins en temps réel ou un 
processeur externe à un sous-groupe de mixage 
en utilisant l'entrée auxiliaire comme retour 
d'effets (par exemple pour une réverbération ou 
une compression du bus) ;

• recevoir de l'audio à partir d'instruments MIDI 
externes et d'autres sources audio, pour 
le monitoring ou le routing de pistes audio 
à enregistrer sur disque (par exemple, à partir de 
sorties audio d'un synthétiseur MIDI) ;

• consolider le contrôle du volume d'un sous-
groupe de mixage sur un seul fader ;

• mixer plusieurs sorties à partir d'un plug-in 
d'instrument.

Routing d'une entrée auxiliaire
Pour router une entrée auxiliaire :

1 Pour choisir un chemin de bus ou d'entrée, 
cliquez sur le sélecteur de chemin d'entrée 
de l'entrée auxiliaire.

2 Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de 
l'entrée auxiliaire. 

3 Réglez le fader de l'entrée auxiliaire pour 
définir le volume de retour. 

Pistes Master Fader et flux 
de signal
Les pistes Master Fader contrôlent le niveau de sortie 
général des chemins de sortie et des bus. Lorsqu'elles 
sont affectées à un chemin de sortie ou de bus actif, 
elles permettent d'appliquer des effets post-fader et de 
contrôler le niveau général d'un mixage principal, 
de mixages casque, des stems, des départs d'effets et 
d'autres applications de routing des signaux. Les 
pistes Master Fader prennent en charge tous les 
formats de pistes reconnus par votre système 
Pro Tools.

Les pistes Master Fader ne consomment aucune 
ressource de traitement audio de votre système. 
Les pistes Master Fader fournissent jusqu'à cinq 
inserts post-fader, mais aucun départ. Les pistes 
Master Fader ne disposent pas non plus de curseurs de 
panoramique, ni de boutons Mute et Solo.

Reportez-vous aux exemples de sous-groupe de 
mixage de la section « Routing du signal pour 
le monitoring et les sous-groupes de mixage » 
à la page 1013.

Flux du signal audio sur un Master Fader

 

 

 

Entrée (source) déterminée 
par l'assignation des 
sorties (d'autres pistes)Volume

Inserts 
post-fader 
(plug-ins 

ou matériels)

Sortie Sortie 
principale 

+ Sorties 
supplémentaires 
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Contrairement aux inserts des pistes audio et des 
entrées auxiliaires, les inserts des Master Faders sont 
post-fader. Il est ainsi possible d'insérer un plug-in de 
dithering ou un équivalent sur le mixage principal et 
de modifier son traitement à l'aide du niveau du 
Master Fader (pour plus d'informations, reportez-
vous à la section « Dithering » à la page 1029). 

Indicateurs de niveau des Master Faders

Les indicateurs de niveau des Master Faders 
affichent toujours les niveaux post-fader, quel que 
soit le paramètre Pre-Fader Metering sélectionné 
dans le menu Options. 

Master Faders et chemins

Vous pouvez assigner des pistes Master Fader 
à des chemins principaux ou à des sous-chemins, 
comme défini dans la boîte de dialogue I/O Setup. 
Il n'est pas possible d'assigner plusieurs Master 
Faders à un même chemin.

Master Faders activés et désactivés

Lorsqu'une piste Master Fader est désactivée, 
les plug-ins et assignations d'E/S associés, ainsi 
que leurs ressources sont désactivés. 

Lorsqu'une assignation de sortie d'un Master Fader 
(assignation à un chemin) est désactivée, la piste 
Master Fader ne contrôle plus le gain principal du 
chemin concerné.

La duplication d'une piste Master Fader désactive 
l'assignation de la piste dupliquée.

Utilisations courantes des 
Master Faders
Vous pouvez utiliser des Master Faders pour :

• contrôler le niveau et traiter des mixages 
de sortie ;

• le monitoring et la mesure des niveaux 
d'une sortie (par exemple une sortie de bus ou 
matérielle) pour éviter l'écrêtage ;

• contrôler les niveaux de sous-groupes 
de mixage ;

• contrôler les niveaux de départs d'effets ;

• contrôler les niveaux de pistes submaster (pistes 
routées sur un bus) ; 

• appliquer un dithering ou d'autres traitements 
d'insert à l'ensemble d'un mixage.

Utilisez les pistes Master Fader pour contrôler les 
niveaux de sous-groupes de mixage, les niveaux 
principaux des départs ainsi que d'autres sorties. Les 
pistes Master Fader peuvent contrôler des bus de 
sortie ou des bus internes. Une piste Master Fader 
assignée à un chemin de sortie peut être utilisée en 
tant que commande de volume principale. Une piste 
Master Fader assignée à un bus peut également être 
utilisée pour atténuer les entrées de pistes d'entrée 
auxiliaire de sous-groupes de mixage, afin d'éviter 
l'écrêtage. 

Si vous avez absolument besoin d'appliquer un 
insert pré-fader au signal du Master Fader, 
configurez une entrée auxiliaire avant le 
Master Fader. Si vous voulez par exemple 
appliquer une compression au mixage et créer 
en même temps un fondu de sortie, insérez un 
plug-in de compression sur la piste d'entrée 
auxiliaire et insérez un plug-in de dithering sur 
la piste Master Fader affectée au chemin de 
sortie de la piste d'entrée auxiliaire. 
Vous pouvez alors faire un fondu de sortie avec 
le Master Fader sans changer le seuil 
de compression du mixage.
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Utilisation d'un Master Fader

Pour utiliser un Master Fader comme commande 
de volume stéréo principale :

1 Créez une piste Master Fader stéréo.

2 Configurez les sorties de toutes les pistes audio 
de la session sur le chemin de sortie principal 
(par exemple, sorties 1-2 de votre interface 
audio principale), puis réglez le panoramique 
de chaque piste.

3 Configurez la sortie de la piste Master Fader sur 
le chemin de sortie principal. 

Pour utiliser un Master Fader pour atténuer les 
entrées d'un sous-groupe de mixage :

1 Créez une piste d'entrée auxiliaire.

2 Routez les signaux des pistes audio de votre 
session vers l'entrée de la piste d'entrée 
auxiliaire.

3 Créez une piste Master Fader stéréo et assignez 
la sortie au chemin de bus qui alimente la piste 
d'entrée auxiliaire.

Pistes d'instrument et flux 
du signal
Les pistes d'instrument offrent les mêmes options de 
routing des signaux audio que les pistes d'entrée 
auxiliaire, à ceci près que leurs entrées doivent 
provenir d'un plug-in d'instrument inséré sur cette 
même piste d'instrument, d'un bus ou d'une entrée 
matérielle.

Les pistes d'instrument sont utilisées en tant 
qu'entrées pour des plug-ins d'instrument 
et d'autres sources (notamment les bus internes). 
Elles peuvent être entièrement automatisées. 
Lorsque vous utilisez des pistes d'instrument 
en tant qu'entrées pour des sources externes, c'est 
sur ces sources elles-mêmes qu'il convient de 
régler le volume de sortie afin d'obtenir un volume 
d'enregistrement approprié. 

Flux du signal audio sur une piste d'instrument

Volume 

 

Plug-in d'instrument, 
bus interne ou 
instrument matériel

Entrée

Inserts 
(plug-ins 
ou inserts 
matériels)

Record (MIDI 
uniquement)
Solo/Mute

Départs, pré-fader

Départs, post-fader

Panora-
mique

Sortie
Sortie 
principale 

+ Sorties 
supplémentaires 
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Utilisations courantes des 
pistes d'instrument
En lisant des données MIDI présentes ou reçues sur 
une piste d'instrument, vous pouvez contrôler et 
écouter l'audio provenant :

• de plug-ins d'instrument, tels que des synthétiseurs 
logiciels ou des échantillonneurs ;

• d'instruments MIDI externes, tels que des 
synthétiseurs logiciels ou des échantillonneurs.

Routing avec une piste 
d'instrument
Pour router de l'audio à partir d'un instrument MIDI 
externe vers une piste d'instrument :

1 Cliquez sur le sélecteur de chemin d'entrée de la 
piste d'instrument et sélectionnez l'entrée 
matérielle correspondant à votre instrument 
MIDI externe.

2 Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de la 
piste d'instrument. 

3 Dans la vue Instruments, cliquez sur le sélecteur 
d'entrée MIDI et assignez un périphérique et un 
canal à partir du menu pour enregistrer et contrôler 
l'instrument MIDI externe.

4 Dans la vue Instruments, cliquez sur le sélecteur de 
sortie MIDI et assignez un port et un canal 
à l'instrument MIDI externe à partir du menu.

5 Pour régler le volume, ajustez le fader 
de l'instrument.

Pistes Master VCA 
(Pro Tools HD uniquement)

Les pistes Master VCA reproduisent le 
fonctionnement des canaux d'amplificateurs 
commandés par tension des consoles analogiques, 
sur lesquels un fader de canal VCA est utilisé pour 
contrôler, grouper, ou modifier simultanément les 
niveaux de signal d'autres canaux de la console.

Les pistes Master VCA ne transmettent pas de 
données audio. Elles n'ont par conséquent ni 
entrées, ni sorties, ni inserts, ni départs. Les pistes 
Master VCA sont associées à un groupe de mixage 
qui apparaît dans le sélecteur d'assignation de 
groupe de la piste VCA. Les commandes des pistes 
de ce groupe de mixage (appelées pistes esclaves) 
sont modifiées par celles de la piste Master VCA. 

Pour plus d'informations sur l'assignation d'une 
entrée et d'une sortie MIDI à des pistes 
d'instrument, reportez-vous à la section 
« Assignation d'une entrée et d'une sortie MIDI 
sur des pistes d'instrument » à la page 243.

Pour plus d'informations sur l'insertion 
de plug-ins sur des pistes, reportez-vous à la 
section « Insertion de plug-ins sur les pistes » 
à la page 1038.

Piste Master VCA

 

Indicateurs de niveau

Sélecteur d'assignation 
de groupe

TrackInput

Solo

Record

Mute

Indicateur de type 
de piste VCA

Volume
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Indications des commandes des 
pistes esclaves VCA
Contrairement aux pistes VCA des consoles 
analogiques traditionnelles, les pistes Master VCA 
dans Pro Tools affectent directement leurs pistes 
esclaves, de sorte que les commandes des pistes 
esclaves affichent toujours leurs valeurs réelles : 

• le niveau de sortie de chaque piste esclave 
est indiqué par la position de son fader ; 

• les états Solo, Mute, Record Enable et TrackInput 
de chaque piste esclave sont indiqués par les 
commandes correspondantes de la piste.

Ainsi, même si une piste Master VCA n'est pas 
visible, l'état réel de ses pistes esclaves est affiché 
avec précision. 

Commandes des pistes esclaves 
VCA et comportement de groupe
Lorsqu'un groupe est assigné à un Master VCA, 
par défaut, les commandes ajustables par VCA 
(Volume, Mute, Solo, Record Enable et TrackInput) 
de ses pistes esclaves ne suivent pas les 
comportements de groupe paramétrés sur la page 
Attributes de la boîte de dialogue Groups. Vous 
pouvez ainsi contrôler les niveaux de sortie des 
pistes du groupe tout en conservant la possibilité 
d'ajuster leur niveau individuellement. 

Vous pouvez paramétrer les pistes esclaves 
de façon à ce qu'elles suivent un comportement de 
groupe normal. Reportez-vous à la section 
« Assignation de groupes à des Masters VCA » 
à la page 990.

Utilisations courantes des 
pistes Master VCA
En regroupant les pistes dans un groupe de mixage 
et en assignant ce groupe à une piste Master VCA, 
vous pouvez :

• contrôler les niveaux de sortie de toutes les pistes du 
groupe VCA sans les router vers une piste d'entrée 
auxiliaire ou un même chemin de sortie ;

• créer plusieurs groupes VCA imbriqués 
et commander les niveaux de sortie de plusieurs 
sous-groupes de mixage simultanément ;

• automatiser un sous-groupe de mixage 
en automatisant sa piste Master VCA.

Commandes des pistes Master 
VCA
Les commandes d'une piste Master VCA affectent 
les commandes correspondantes des pistes 
esclaves du groupe de mixage assigné. Les pistes 
Master VCA disposent des commandes suivantes :

Volume

Le fader de volume VCA contrôle le fader de volume 
des pistes audio, d'entrée auxiliaire, d'instrument, 
de Master Fader et des autres pistes Master VCA 
appartenant à un groupe contrôlé par VCA (les faders 
de volume des pistes MIDI ne sont pas affectés). 
Les faders de volume des pistes esclaves se déplacent 
pour indiquer le niveau composite, ou le niveau de 
chaque piste affecté par la position du fader de 
volume du Master VCA. 

Mute

Le bouton Mute des pistes VCA contrôle le mute des 
pistes audio, d'entrée auxiliaire, Instrument, MIDI 
et des autres pistes Master VCA dans un groupe 
contrôlé par VCA. Le fait de muter un groupe contrôlé 
par VCA ne modifie pas l'état de mute sous-jacent des 
pistes esclaves (les boutons Mute des pistes esclaves 
qui n'étaient pas mutées au préalable affichent un mute 
implicite). 
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Solo

Le bouton Solo des pistes VCA contrôle la mise en 
solo des pistes audio, d'entrée auxiliaire, 
d'instrument, MIDI et des autres pistes Master 
VCA appartenant à un groupe contrôlé par VCA.

• La mise en solo d'une piste Master VCA mute 
implicitement toutes les pistes à l'exception de 
ses pistes esclaves. Celles-ci sont donc 
indirectement mises en solo.

• Cette opération entraîne la désactivation de tous les 
solos explicites sur les pistes esclaves. Celles-ci sont 
mises en solo indirectement et toutes les autres 
pistes sont implicitement mutées.

• La mise en solo explicite d'une piste esclave 
alors que la piste Master VCA correspondante 
est également en solo a priorité sur le solo de la 
piste Master VCA.

Activation pour l'enregistrement

Le bouton d'activation pour l'enregistrement des 
pistes VCA permet de changer le mode d'activation 
pour l'enregistrement des pistes audio, 
d'instrument et des autres pistes VCA déjà activées 
individuellement pour l'enregistrement. Une fois 
les pistes configurées individuellement, vous 
pouvez activer ou désactiver l'enregistrement à l'aide 
de ce bouton. 

Pour forcer temporairement les pistes esclaves 
à basculer leur état d'enregistrement :

 Cliquez sur le bouton d'activation pour 
l'enregistrement de la piste Master VCA tout en 
maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée.

TrackInput

Le bouton TrackInput des pistes VCA permet 
d'activer ou de désactiver le monitoring des 
signaux d'entrée des pistes audio activées pour 
l'enregistrement appartenant à un groupe contrôlé 

par VCA. Une fois les pistes activées pour 
l'enregistrement, le bouton TrackInput permet 
d'alterner l'état du monitoring des signaux d'entrée 
pour ces pistes. 

Pour forcer temporairement les pistes esclaves 
à basculer leur état de monitoring des signaux 
d'entrée :

 Cliquez sur le bouton TrackInput de la piste 
Master VCA tout en maintenant la touche 
Alt (Windows) ou Option (Mac) enfoncée. 

Indicateur de niveau

Sur les pistes Master VCA, les indicateurs 
de niveau affichent le niveau le plus élevé observé 
sur l'une des pistes esclaves, et non le niveau 
sommé de toutes les pistes esclaves. 

Le format de canal des indicateurs de niveau de la 
piste Master VCA est défini selon les formats de 
canal des pistes esclaves, comme suit :

• Si toutes les pistes esclaves ont le même format de 
canal (mono, stéréo ou multicanal), la piste Master 
VCA contient autant d'indicateurs de niveau que 
les pistes esclaves.

• Si les pistes esclaves ont des formats différents, 
la piste Master VCA contient un seul indicateur de 
niveau.

Activation pour l'enregistrement, 
TrackInput et pistes esclaves
Lorsqu'une piste esclave est activée pour 
l'enregistrement (bouton Record Enable allumé) 
ou en mode de monitoring Input Only 
(bouton TrackInput allumé), son automation 
est temporairement désactivée et son fader 
de volume n'est plus contrôlé par la piste Master 
VCA.
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Assignation de groupes à des 
Masters VCA
Vous pouvez assigner un groupe de mixage existant 
à une piste Master VCA. Vous pouvez également 
assigner un nouveau groupe de mixage lors de la 
création d'une piste Master VCA. Vous ne pouvez 
assigner qu'un groupe à la fois à une piste Master 
VCA. Une piste Master VCA ne peut pas contrôler 
un groupe auquel elle appartient.

Pour assigner un groupe existant à un Master VCA :

 Cliquez sur le sélecteur d'assignation de groupe 
sur la piste Master VCA et sélectionnez un 
groupe disponible dans le menu.

Pour assigner un nouveau groupe à un Master VCA :

1 Lors de la création d'un nouveau groupe, 
sélectionnez Mix ou Mix/Edit en tant que 
type de groupe.

2 Dans la boîte de dialogue de création de groupe, 
sélectionnez une piste Master VCA à partir du 
menu VCA. 

Appartenance de pistes à plusieurs groupes VCA

Une piste esclave peut être membre de plusieurs 
groupes contrôlés par VCA. Dans ce cas, 
les contributions de tous les faders de volume 
de pistes Master VCA sont sommées sur la piste 
esclave. Les commandes Mute, Solo, Record Enable 
et TrackInput suivent les mêmes règles pour 
l'activation ou la désactivation des pistes esclaves. 

Autorisation du comportement 
de groupe pour les commandes 
des pistes esclaves VCA
Lorsqu'une piste est une piste esclave VCA, 
ses commandes Volume, Mute, Solo, Record 
Enable et TrackInput suivent les fonctions du VCA 
et ne suivent normalement pas le comportement du 
groupe de mixage. 

Cependant, vous pouvez paramétrer ces commandes de 
pistes esclaves pour autoriser le comportement de 
groupe de mixage en plus de leurs fonctions VCA.

Pour autoriser le comportement de groupe des 
commandes VCA sur les pistes esclaves :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing. 

2 Dans la section Automation, désélectionnez 
l'option Standard VCA Logic for Group Attributes. 

3 Cliquez sur OK.

Les commandes Volume, Mute, Solo, Record Enable 
et TrackInput sont alors disponibles en tant 
qu'attributs de groupe de mixage dans la boîte de 
dialogue Group. 

Inserts
Pro Tools permet d'insérer jusqu'à dix inserts 
(A à E et F à J) sur chaque piste audio, d'entrée 
auxiliaire, Master Fader ou d'instrument. Chaque 
insert peut être un plug-in logiciel, un insert 
matériel ou un plug-in d'instrument (pour plus 
d'informations, reportez-vous au Chapitre 44, 
« Inserts de plug-in et matériels »). 

Les inserts offrent les fonctionnalités suivantes : 

• Les plug-ins et les inserts matériels routent le 
signal d'une piste vers l'effet de votre choix, puis 
le renvoient automatiquement sur la même piste. 

Assignation d'un groupe existant à un Master VCA
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• Les inserts matériels envoient et renvoient 
le signal vers les canaux d'entrée et de sortie 
correspondants d'une interface audio, qui peut 
être connectée à des effets externes.

• Certains plug-ins d'instrument acceptent l'audio 
provenant de l'entrée d'une piste, ce qui vous 
permet de les utiliser comme des plug-ins 
d'effet.

• Les inserts des pistes audio, d'entrée auxiliaire et 
d'instrument sont pré-fader. 

• Les inserts des pistes Master Fader sont 
post-fader.

• Les inserts peuvent être bypassés ou désactivés.

• La plupart des commandes des plug-ins sont 
entièrement automatisables.

Format de sortie de piste et 
plug-ins
Pro Tools prend en charge les plug-ins mono, 
multi-mono, stéréo et multicanal (Pro Tools HD 
avec mixeur surround uniquement). 

Les inserts fonctionnant en série, la modification du 
format d'un plug-in risque d'altérer le format du 
canal. L'insertion d'un plug-in mono vers stéréo sur 
une entrée auxiliaire mono, par exemple, modifie le 
chemin du signal à partir de ce plug-in et sur tout le 
reste de la piste. De ce fait, les inserts matériels ou 
les plug-ins insérés après un plug-in stéréo doivent 
être des plug-ins stéréo en entrée comme en sortie 
(ou dans un format multicanal pris en charge). 

Formats des plug-ins
Pro Tools prend en charge les plug-ins mono et 
stéréo, avec les trois types de chemins suivants : 

• Entrée mono/sortie mono

• Entrée mono/sortie stéréo

• Entrée stéréo/sortie stéréo

Les sessions Pro Tools HD avec mixeur surround 
prennent également en charge les plug-ins multi-
mono et multicanal de 3 à 8 canaux.

Configuration de la vue 
Inserts dans les fenêtres Mix 
et Edit
Les pistes audio, d'entrée auxiliaire, Master Fader et 
d'instrument incluent deux groupes de vues pour les 
inserts : Inserts A–E (inserts 1 à 5) et Inserts F–J 
(inserts 6 à 10). Le menu View offre des options 
distinctes pour l'affichage des ensembles d'inserts 
dans les fenêtres Mix et Edit.

Pour afficher les inserts dans la fenêtre Mix :

 Sélectionnez l'une des options suivantes :

• View > Mix Window > Inserts A–E.

• View > Mix Window > Inserts F–J.

Pour afficher les inserts dans la fenêtre Edit :

 Sélectionnez l'une des options suivantes :

• View > Edit Window > Inserts A–E.

• View > Edit Window > Inserts F–J.

HEAT
(Systèmes Pro Tools|HDX avec option HEAT 
uniquement)

HEAT (Harmonically Enhanced Algorithm 
Technology) est une option logicielle qui ajoute 
une « couleur analogique » aux systèmes 
Pro Tools|HDX. HEAT est appliqué à toutes les 
pistes audio actives de votre session et reproduit 
l'effet d'une console de mixage analogique. HEAT 
vous permet de débuter vos mixages avec une 
distorsion légèrement saturée pleine de chaleur 
imitant l'analogique. En utilisant HEAT avec 
l'option Stereo Pan Depth (de la fenêtre Session 
Setup), vous pouvez reproduire directement dans 
Pro Tools l'effet d'une console analogique 
classique.

Pour plus d'informations, reportez-vous 
au Chapitre 42, « HEAT ».
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Profondeur de panoramique 
stéréo
Pro Tools vous permet de sélectionner la profondeur de 
panoramique pour les chemins de sortie stéréo. Vous 
pouvez définir la profondeur de panoramique dans la 
fenêtre Session Setup. Le paramètre Pan Depth vous 
permet de définir le niveau d'atténuation du signal 
lorsqu'une piste est routée vers une sortie stéréo avec un 
panoramique réglé au centre.

Pour définir la profondeur de panoramique stéréo :

1 Sélectionnez Setup > Session pour ouvrir 
la fenêtre Session Setup.

2 Sélectionnez une option du sélecteur Pan Depth.

Options de profondeur 
de panoramique stéréo
Les options suivantes sont disponibles pour 
le paramètre Pan Depth :

-2.5 dB : profondeur de panoramique stéréo 
standard dans Pro Tools 8.0.x et versions 
antérieures. Lorsque vous ouvrez une session 
Pro Tools 8.0.x ou version antérieure dans 
Pro Tools 8.1, il s'agit de l'option par défaut.

3.0 dB : profondeur de panoramique standard pour 
un mixeur surround et de nombreuses autres 
consoles. Il s'agit du paramètre par défaut pour les 
sessions Pro Tools 8.1 et supérieur.

-4.5 dB : profondeur de panoramique standard pour 
de nombreuses consoles analogiques britanniques.

-6.0 dB : profondeur de panoramique standard 
pour une compatibilité mono intégrale.

Vues dans les fenêtres Mix 
et Edit
Vous pouvez configurer les fenêtres Mix et Edit pour 
afficher ou masquer un certain nombre 
de commandes de mixage à l'aide des commandes de 
menu ou des sélecteurs de vue. 

La plupart de ces vues sont disponibles dans les 
deux fenêtres, sauf indication contraire.

Sélecteurs de vue de fenêtre
La fenêtre Edit et la fenêtre Mix disposent 
de sélecteurs de vue de fenêtre permettant 
de configurer leurs vues.

Un mixeur surround requiert un peu plus de 
ressources DSP qu'un mixeur stéréo. 
Par conséquent, si vous prévoyez de mixer 
régulièrement en stéréo et d'utiliser une 
profondeur de panoramique de -2,5 dB, nous 
vous conseillons d'utiliser le plug-in pour 
mixeur stéréo. 

Fenêtre Session Setup

Pour les formats supérieur à stéréo (tels que 5.1 
par exemple), tous les panoramiques des 
sorties surround sont fixés à -3.0 dB. Les 
options de profondeur de panoramique ne sont 
disponibles que pour les sorties stéréo.
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Affichage des vues

Pour afficher toutes les vues dans la fenêtre Mix 
ou Edit, effectuez l'une des opérations suivantes :

 Sélectionnez View > Mix Window (ou Edit 

Window) > All.

 Cliquez sur le sélecteur de vue de la fenêtre Mix 
(ou celui de la fenêtre Edit), puis sélectionnez All.

Pour n'afficher aucune vue dans la fenêtre Mix 
ou Edit, effectuez l'une des opérations suivantes :

 Sélectionnez View > Mix Window (ou Edit 

Window) > None.

 Cliquez sur le sélecteur de vue de la fenêtre Mix 
(ou celui de la fenêtre Edit), puis sélectionnez 
None.

Pour afficher (ou masquer) les vues disponibles 
dans les fenêtres Mix et Edit, effectuez l'une des 
opérations suivantes :

 Sélectionnez View > Mix Window (ou Edit 

Window), puis sélectionnez ou désélectionnez l'un 
des types de vue (Comments par exemple).

 Cliquez sur le sélecteur de vue de la fenêtre Mix 
(ou celui de la fenêtre Edit), puis sélectionnez l'un 
des types de vue (Comments par exemple).

Masquage de vues dans 
la fenêtre Edit
Vous pouvez rapidement masquer des colonnes 
dans la fenêtre Edit à l'aide d'un simple raccourci 
clavier. 

Pour masquer une colonne dans la fenêtre Edit :

 Tout en maintenant la touche Alt (Windows) ou 
Option (Mac) enfoncée, cliquez en haut de la 
colonne à masquer (Mic Pre, Comments, 
Instrument, Inserts A-E, Inserts F-J, Sends A-E, 
Sends F-J, I/O, Real-Time Properties ou Track 
Color).

Sélecteur de vue de la fenêtre Edit

Sélecteur de vue de la fenêtre Mix
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Options des vue de fenêtre
Vue Comments : affiche tout texte de commentaire 
saisi dans la boîte de dialogue Track Name/
Comments. Pour plus d'informations, reportez-vous 
à la section « Attribution de noms aux pistes » 
à la page 219.

Vue Mic Preamps : affiche les commandes 
de chaque piste d'un préampli PRE. Pour des 
informations détaillées, reportez-vous au Guide PRE.

Vue Instruments : affiche les commandes MIDI 
des pistes d'instrument (sélecteur d'entrée MIDI, 
sélecteur de sortie MIDI, volume MIDI, 
panoramique MIDI et mute MIDI).

Vue HEAT (systèmes Pro Tools|HDX avec option 
HEAT uniquement) (fenêtre Mix uniquement) : 
affiche les commandes de pistes HEAT sur les 
pistes audio dans la fenêtre Mix. Cette vue est 
uniquement disponible dans la fenêtre Mix des 
systèmes Pro Tools|HD avec une version autorisée 
et installée de l'option HEAT. 

Vue Inserts (Inserts A-E et Inserts F-J) : affiche 
les inserts (plug-ins logiciels et inserts matériels) 
pour chaque piste. Pour plus d'informations, 
reportez-vous à la section « Configuration de la vue 
Inserts dans les fenêtres Mix et Edit » à la page 991.

Vue Sends (Sends A-E et Sends F-J) : affiche 
les assignations des départs de chaque piste. 
Pour masquer ces éléments, désélectionnez l'option. 
Pour plus d'informations, reportez-vous à la section 
« Configuration de la vue Sends dans les fenêtres 
Mix et Edit » à la page 1002.

Vue Comments dans les fenêtres Mix et Edit

Vue Mic Preamps

Vue Instruments

Vue HEAT

Vues dans la fenêtre Mix

Vue Inserts (A-E)

Vue Sends (A-E)

Vue I/O

Vue Sends (F-J)

Vue Inserts (F-J)
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Vue Meters and Faders (fenêtre Mix uniquement) :
affiche les indicateurs de niveau et les faders des 
pistes. En masquant cette vue, vous pouvez 
économiser de l'espace à l'écran, en particulier 
si vous travaillez avec une surface de contrôle.

Vue I/O (fenêtre Edit uniquement) : affiche les 
sélecteurs d'entrée et de sortie, ainsi que les 
indicateurs de volume et de panoramique pour 
chaque piste.

Cliquez sur les champs de volume ou de panoramique 
de la vue I/O dans la fenêtre Edit pour régler le volume 
ou les commandes de panoramique à l'aide d'une 
fenêtre contextuelle de fader.

Vue RealTime Properties (fenêtre Edit uniquement) : 
affiche les commandes des propriétés en temps 
réel des pistes MIDI et d'instrument. Pour plus 
d'informations sur les propriétés en temps réel, 
reportez-vous à la section « Propriétés MIDI en 
temps réel » à la page 725.

Vue Delay Compensation : la vue Delay 
Compensation indique la quantité totale de délai 
des plug-ins sur chaque piste, ainsi que celui 
des inserts matériels. Elle permet d'appliquer 
un décalage défini par l'utilisateur pour pour 
compenser le délai de la piste et affiche la quantité 
totale de délai appliquée par Pro Tools à chaque 
piste. La vue Delay Compensation peut être 
affichée ou masquée dans la fenêtre Mix.

Vue Meters and Faders (fenêtre Mix)

Vue I/O (fenêtre Edit)

Fenêtre contextuelle de fader dans la vue I/O (fenêtre Edit)

Fenêtre contextuelle de panoramique dans la vue I/O 
(fenêtre Edit)

Vue RealTime Properties (fenêtre Edit)

Vue Delay Compensation

 

Indicateur de délai

Décalage défini par l'utilisateur 

Indicateur de compensation de la piste
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Les valeurs de délai peuvent être exprimées 
en échantillons ou en millisecondes, selon le 
paramètre sélectionné dans les préférences de 
fonctionnement. Pour en savoir plus sur la 
compensation du délai, reportez-vous à la section 
« Compensation du délai » à la page 1021.

Vue Track Color : affiche la couleur de piste de 
chaque piste. Pour plus d'informations, reportez-
vous à la section « Code couleur des pistes, clips, 
marqueurs et groupes » à la page 248.

Chemins d'entrée et de sortie 
audio
Pro Tools vous permet de configurer les entrées et 
sorties physiques de vos interfaces audio, ainsi que 
les chemins et sous-chemins de bus internes dans la 
boîte de dialogue I/O Setup et la boîte de dialogue 
Hardware Setup. Ces entrées et sorties matérielles, 
ainsi que ces chemins de bus internes peuvent être 
affectés en tant qu'entrées et sorties de pistes audio, 
de pistes d'entrée auxiliaire, de pistes d'instrument et 
de pistes Master Fader.

Chemin d'entrée audio
Les sélecteurs de chemin d'entrée déterminent 
l'entrée source des pistes audio, des pistes d'entrée 
auxiliaire et, de manière facultative, des pistes 
d'instrument. Les entrées de piste peuvent être 
configurées à partir d'un chemin ou sous-chemin 
d'entrée matérielle ou de bus interne. Pour plus 
d'informations sur l'affectation d'entrées de piste, 
reportez-vous à la section « Assignation des entrées 
audio » à la page 235.

Les chemins d'entrée matérielle et de bus peuvent 
être configurés dans la boîte de dialogue I/O Setup. 
Pour plus d'informations, reportez-vous au 
Chapitre 7, « I/O Setup ».

Vous pouvez également définir les ports physiques 
routés vers les ports d'entrée de Pro Tools dans 
la boîte de dialogue Hardware Setup. Pour plus 
d'informations, reportez-vous à la section 
« Configuration des paramètres système de 
Pro Tools » à la page 52.

Chemin de sortie audio
Les sélecteurs de chemin de sortie de piste routent les 
signaux post-fader vers les chemins de sortie ou de 
bus assignés. Le sélecteur de chemin de sortie route la 
sortie de piste principale vers le chemin principal ou 
secondaire choisi. Les pistes peuvent être routées 
directement vers des chemins et sous-chemins de 
sorties matérielles ou de bus internes pour créer des 
sous-groupes de mixage (chemin principal ou 
secondaire). 

Le format de piste (mono, stéréo ou multicanal) 
détermine les choix de chemin principal et de sous-
chemins disponibles pour la sortie de piste. Pour plus 
d'informations sur l'affectation de sorties de piste, 
reportez-vous à la section « Assignation des sorties 
audio » à la page 235.

Le format (mono, stéréo ou encore multicanal 
stéréo ou supérieur) des pistes audio, d'entrée 
auxiliaire, Master Fader et d'instrument est défini 
lors de leur création :

• Les pistes mono peuvent être affectées à tout 
chemin principal ou à tout sous-chemin mono, 
stéréo ou multicanal disponible.

• Les pistes stéréo peuvent être affectées à tout 
chemin principal ou à tout sous-chemin mono, 
stéréo ou multicanal disponible.

• Les pistes multicanal (Pro Tools HD 
uniquement) peuvent être affectées à tout 
chemin mono ou tout chemin dont le nombre de 
canaux est identique (une piste LCRS peut être 
affectée à un chemin LCRS ou mono par 
exemple). 
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Fenêtres Output
Les fenêtres Output contiennent les principales 
commandes de mixage des pistes (telles que 
le panoramique et le volume), et sont des 
alternatives aux vues des fenêtres Mix et Edit. 
Les fenêtres Output et Send multicanal fournissent 
également des vues panoramiques étendues et 
d'autres commandes spécifiques au surround. 
Reportez-vous au Chapitre 49, « Mixage et 
panoramique surround ».

Les fenêtres Output sont utiles dans les grandes 
sessions, afin de conserver les pistes importantes 
ancrées à des emplacements spécifiques, leur 
affichage n'étant pas affecté par les opérations 
de navigation au sein des banques de pistes, 
effectuées dans les fenêtre Mix et Edit ou depuis une 
surface de contrôle. Reportez-vous à la section 
« Fenêtres Output pour les pistes et les départs » 
à la page 1008.

Assignations de sorties multiples
Les pistes audio, d'entrée auxiliaire et d'instrument de 
Pro Tools peuvent être assignées à plusieurs chemins 
de sortie. Une assignation à plusieurs chemins est un 
moyen efficace qui permet de router un mix 
identique vers d'autres sorties séparées, telles que des 
moniteurs différents, des mixages casque, ou toute 
autre situation où un mixage en parallèle est 
nécessaire.

Pour affecter une piste à plusieurs sorties :

1 Affectez un chemin de sortie principal en le 
choisissant dans le sélecteur de chemin de sortie 
de la piste. 

2 Maintenez la touche Démarrer (Windows) ou Ctrl 
enfoncée (Mac) et cliquez sur un autre chemin de 
sortie dans le sélecteur de chemin de sortie de la 
piste. La nouvelle destination de sortie est ajoutée 
en tant que sortie supplémentaire. 

Affichage des assignations 
de sorties multiples
Lorsqu'une piste est assignée à plusieurs chemins de 
sortie, le sélecteur de chemin de sortie signale son 
état (assignations, actif/inactif) à l'aide des 
indicateurs suivants :

• Un signe plus (+) indique que plusieurs sorties 
sont assignées à cette piste. 

• Dans le menu du sélecteur de chemin de sortie, 
toutes les sorties actuellement affectées à la piste 
sont cochées afin d'indiquer qu'elles sont actives. 

• Un astérisque (*) indique qu'une ou plusieurs 
sorties affectées sont désactivées. 

Sorties désactivées
Vous pouvez désactiver un chemin de sortie en 
totalité dans la boîte de dialogue I/O Setup (ce qui 
affectera toutes les pistes assignées à ce chemin) ou 
par assignation (ce qui concernera uniquement cette 
sortie de la piste audio, de la piste d'entrée auxiliaire 
ou de la piste d'instrument). 

Maintenez les touches Alt+Démarrer (Windows) 
ou Ctrl+Option (Mac) enfoncées et cliquez pour 
ajouter l'assignation à toutes les pistes, 
ou maintenez les touches Alt+Démarrer+Maj 
(Windows) ou Option+Maj+Ctrl (Mac) 
enfoncées et cliquez pour ajouter l'assignation 
à toutes les pistes sélectionnées.

Indication d'assignations de sortie multiples

Indication d'assignations de sortie multiples avec 
au moins une sortie désactivée
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Pour désactiver un chemin de sortie, effectuez 
l'une des opérations suivantes :

 Maintenez les touches Ctrl+Démarrer (Windows) 
ou Commande+Ctrl (Mac) enfoncées et cliquez 
sur le sélecteur de sortie.

 Effectuez un clic droit sur le sélecteur de sortie 
et sélectionnez Make Inactive.

À l'ouverture d'une session, si le matériel nécessaire ou 
les autres ressources ne sont pas disponibles, les sorties 
sont automatiquement désactivées. 

Les sorties désactivées conservent toutes les playlists 
d'automation associées. Les modifications réalisées 
au cours de la session affectent également les 
playlists d'automation de sortie des pistes inactives.

Pour activer un chemin de sortie inactif, effectuez 
l'une des opérations suivantes :

 Maintenez les touches Ctrl+Démarrer (Windows) 
ou Commande+Ctrl (Mac) enfoncées et cliquez 
sur le sélecteur de sortie.

 Effectuez un clic droit sur le sélecteur de sortie 
et sélectionnez Make Active.

Sorties désactivées 
et ressources DSP
La désactivation d'une sortie de piste la coupe, tout 
en conservant toutes les données de playlist et 
d'automation. Les sorties désactivées n'utilisent pas 
de ressources pour les connexions du mixeur DSP 
HDX, mais les plug-ins assignés à la piste 
continuent d'exploiter les ressources DSP requises. 
Les plug-ins AAX basés sur hôte requièrent des 
ressources CPU. Les plug-ins AAX basés sur DSP 
utilisent les ressources DSP disponibles sur les 
cartes Pro Tools|HDX.

Pour libérer les ressources DSP des plug-ins 
inutilisés, vous pouvez désactiver la piste associée 
ou désactiver uniquement le plug-in. 

À propos de l'option No Output
Le paramètre No Output peut être sélectionné pour 
les sorties des pistes. Le choix de l'option No 

Output entraîne la perte de toute automation de 
panoramique associée aux pistes.

Les pistes configurées sur No Output ne sont 
pas audibles, mais ne libèrent pas pour autant les 
ressources DSP associées. 

Départs
Pro Tools permet d'insérer jusqu'à dix départs 
(A à E et F à J) sur chaque piste audio, d'entrée 
auxiliaire ou d'instrument.

Les départs offrent les fonctionnalités suivantes :

• Les départs peuvent être configurés pré ou post-
fader.

• Des indicateurs de niveau peuvent être affichés 
sur les départs.

• Les commandes de niveau, de panoramique, 
de mute et LFE des départs peuvent être 
configurées pour suivre ou non les groupes.

• Le niveau, le mute et le panoramique des départs 
(dans le cas de départs stéréo ou multicanal) 
peuvent être entièrement automatisés. Reportez-
vous à la section « Automation des départs » 
à la page 1081.

• Les commandes des départs peuvent être 
affichées et modifiées dans les fenêtres Mix 
ou Edit ou dans leurs propres fenêtres Output.

Reportez-vous à la section « Désactivation 
des pistes » à la page 247.

Pour plus d'informations, reportez-vous aux 
sections « Éléments activés et désactivés » 
à la page 17 et « Désactivation des inserts » 
à la page 1037.
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• Les départs peuvent être assignés à tout chemin 
de sortie et de bus disponible (chemins principaux 
ou sous-chemins), au format mono, stéréo ou 
dans tout format multicanal pris en charge pour le 
mixage surround. 

• Chaque départ peut avoir plusieurs affectations 
(vers des chemins de sortie et de bus disponibles 
par exemple).

Les départs doivent être réinjectés dans le mixage via 
une entrée auxiliaire, une piste audio ou une piste 
d'instrument pour être audibles dans Pro Tools. 
Ils peuvent ensuite être écoutés et traités via une 
entrée auxiliaire (ou une piste d'instrument), 
enregistrés sur des pistes audio et bouncés sur 
disque. Les notions de sous-groupe de mixage et 
de mixdown sont exposées au Chapitre 46, 
« Mixdown ».

Assignation de départs à des 
pistes

Pour ajouter un départ à une piste :

1 Assurez-vous que la vue Sends est activée dans 
la fenêtre Mix ou Edit (pour en savoir plus, 
reportez-vous à la section « Vues dans les 
fenêtres Mix et Edit » à la page 992). 

2 Cliquez sur le sélecteur de départ de la piste, puis 
sélectionnez un chemin dans le menu déroulant.

Le départ peut être assigné à un chemin de sortie ou 
de bus mono ou stéréo (ou dans tout format 
multicanal pris en charge pour le mixage surround).

3 Définissez le niveau de sortie du départ dans la 
fenêtre Send en effectuant l'une des opérations 
suivantes :

• Réglez le fader du niveau de départ.

• Pour régler le niveau d'un départ sur le gain 
unitaire (0 dB), maintenez la touche 
Alt (Windows) ou Option (Mac) enfoncée tout 
en cliquant sur le fader du niveau de départ.

Lors de la création d'un nouveau départ, son niveau 
de sortie initial dépend de la préférence Sends 

Default to -INF.

Les panoramiques des départs peuvent être liés au 
panoramique du chemin de sortie principal de la 
piste en activant la préférence Send Pans Default 

To Follow Main Pan. 

Assignation d'un départ à un chemin de bus stéréo 

Fenêtre Send (stéréo)



Guide de référence Pro Tools1000

Pour modifier la configuration par défaut des départs :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Sends Default to “-INF”.

• Désélectionnez Sends Default to “-INF” pour que 
les nouveaux départs soient configurés par 
défaut sur le gain unitaire (0 dB).

3 Effectuez l'une des opérations suivantes :

• Sélectionnez Send Pans Default to Follow 

Main Pan.

• Désélectionnez Send Pans Default to Follow 

Main Pan pour contrôler les panoramiques des 
départs indépendamment du panoramique 
du chemin de sortie principal de la piste.

Pour supprimer un départ d'une piste :

 Cliquez sur le bouton Sends de la piste, puis 
sélectionnez No Send dans le menu déroulant. 

Mute des départs
Pro Tools permet de muter individuellement les 
départs de toutes les pistes sélectionnées de votre 
session, ou uniquement les départs A à E ou F à J 
des pistes sélectionnées.

Pour muter (ou démuter) un départ depuis la 
fenêtre Send, ou dans la fenêtre Mix en vue 
étendue des départs :

 Cliquez sur le bouton Mute du départ.

Pour muter (ou démuter) des départs à partir du 
menu Track :

1 Sélectionnez les pistes sur lesquelles vous 
souhaitez muter des départs. Maintenez la 
touche Option (Mac) ou Alt (Windows) 
enfoncée et cliquez pour sélectionner toutes les 
pistes affichées dans la session.

2 Sélectionnez l'une des commandes suivantes :

 Track > Mute Sends > All.
 Track > Mute Sends > A–E.
 Track > Mute Sends > F–J.

Commandes clavier de mute des départs

Pro Tools propose des commandes clavier pour 
muter les départs des pistes dans la fenêtre Mix :

 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et cliquez sur un bouton 
d'assignation de départ dans la fenêtre Mix ou Edit 
pour muter ce départ, ainsi que tous ceux situés en 
aval sur la piste.

 Maintenez les touches Ctrl+Option (Mac) 
ou Démarrer+Alt (Windows) enfoncées et cliquez 
sur un bouton d'assignation de départ dans 
la fenêtre Mix ou Edit pour muter ce départ, ainsi 
que tous ceux situés en aval, sur toutes les pistes. 
Vous pouvez ainsi muter tous les départs de votre 
session d'un simple clic.

 Appuyez sur Maj+Q pour muter (ou démuter) 
tous les départs sur les pistes sélectionnées.

 Appuyez sur Maj+3 pour muter (ou démuter) 
les départs A à E sur les pistes sélectionnées.

 Appuyez sur Maj+4 pour muter (ou démuter) 
les départs F à J sur les pistes sélectionnées.

Création et assignation d'une 
piste à partir d'un départ
Pro Tools vous permet de créer une nouvelle 
piste d'entrée auxiliaire, audio ou d'instrument à partir 
du sélecteur de départ et d'assigner automatiquement 
le départ à l'entrée de la nouvelle piste à l'aide d'un bus 
de mixage interne disponible.

Pour créer une piste à partir d'un départ :

1 Sur une piste existante, cliquez sur le sélecteur de 
départ et sélectionnez New Track.

2 Dans la boîte de dialogue New Track, 
sélectionnez les options Width, Type et Time 
Base pour la nouvelle piste.

Boîte de dialogue New Track
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3 Saisissez le nom de la nouvelle piste.

Le nom saisi est utilisé à la fois pour la nouvelle 
piste et le nouveau bus de mixage. Par exemple, 
si vous avez saisi le nom « Drum Sub », Pro Tools 
crée une piste d'entrée auxiliaire nommée « Drum 
Sub », ainsi qu'un bus de mixage interne, lui aussi 
nommé « Drum Sub ».

4 Indiquez si la piste doit être créée à côté de la 
piste actuelle (avec le départ) en cochant ou non 
l'option correspondante.

5 Cliquez sur OK.

Pro Tools crée une piste ; la sortie du départ 
d'origine est automatiquement routée vers l'entrée 
de la nouvelle piste via un bus de mixage interne 
disponible. 

Assignation d'une piste 
existante à partir d'un départ
Pro Tools permet d'assigner directement un départ 
à une piste d'entrée auxiliaire, audio ou d'instrument 
active via un bus de mixage interne disponible. 
Notez que la piste de destination doit être définie sur 
un bus de mixage interne ou sur l'option No Input 
afin d'être disponible pour l'assignation.

Pour assigner un départ à une entrée disponible 
d'une piste existante :

1 Sur une piste existante, cliquez sur le sélecteur de 
départ et sélectionnez Track.

2 Dans le sous-menu Track, sélectionnez la piste 
de destination souhaitée.

Nouvelle piste d'entrée auxiliaire avec assignation 
automatique du départ de piste audio au bus 1–2

Assignation d'un départ à une piste d'entrée auxiliaire 
existante
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Pro Tools route automatiquement le départ vers 
l'entrée de la piste sélectionnée via un bus 
de mixage interne disponible.

Formats de départ
Départs mono et stéréo : lorsque vous cliquez sur 
le bouton Sends d'une piste, vous pouvez choisir 
parmi une liste de chemins de sortie ou de bus 
mono ou stéréo. 

Départs multicanal (Pro Tools HD uniquement) : 
lorsque vous cliquez sur le bouton Sends d'une 
piste, vous pouvez choisir parmi une liste 
de chemins de sortie ou de bus multicanal. 

Choix du sélecteur de chemin 
de départ
Les sélecteurs de départs permettent de choisir les 
chemins de bus et de sortie.

Bus de mixage internes : Pro Tools fournit 
256 bus de mixage internes pour le routing interne 
des signaux. Ces chemins de bus internes facilitent 
la gestion des sous-groupes de mixage et le 
traitement avec des plug-ins. Les chemins de bus 
sont définis dans la boîte de dialogue I/O Setup et 
sont disponibles dans tous les formats de canaux 
pris en charge (mono, stéréo ou multicanal, selon le 
système).

Sorties matérielles : les départs matériels sont 
souvent réservés aux mixages casques ou à l'envoi de 
signaux vers des processeurs d'effets externes. 
Contrairement aux inserts matériels, les départs ne 
renvoient pas automatiquement l'audio. 

Configuration de la vue Sends 
dans les fenêtres Mix et Edit
Les pistes audio, d'entrée auxiliaires et 
d'instrument incluent deux groupes de vues 
Sends : Sends A–E (départs 1 à 5) et Sends F–J 
(départs 6 à 10). Le menu View offre des options 
distinctes pour l'affichage de ces départs dans les 
fenêtres Mix et Edit.

Pour afficher les départs dans la fenêtre Mix :

 Sélectionnez l'une des options suivantes :

• View > Mix Window > Sends A–E.

• View > Mix Window > Sends F–J.

Pour afficher les départs dans la fenêtre Edit :

 Sélectionnez l'une des options suivantes :

• View > Edit Window > Sends A–E.

• View > Edit Window > Sends F–J.

Options de la vue Sends
Les départs apparaissent dans les fenêtres Mix et 
Edit conformément aux options des vues Sends A-
E et Sends F-J. Chaque vue Send propose six 
choix : la vue Assignments et cinq vues Send 
individuelles (A–E ou F–J).

Vue Assignments
Il s'agit de la vue Sends par défaut, qui affiche les 
cinq départs (Sends A-F ou Sends F-J) sur toutes 
les pistes affichées dans les fenêtres Mix et Edit.

Dans la vue Assignment, les commandes des départs 
sont réglées à partir des fenêtres Output des départs 
(reportez-vous à la section « Fenêtres Output pour les 
pistes et les départs » à la page 1008). Vous pouvez 
également ajuster certaines commandes des départs 
en vue étendue des départs (reportez-vous à la section 
« Vues Expanded Send (A–J) » à la page 1003).

Vous pouvez personnaliser les noms, 
le format et le mappage des chemins de bus 
et de sortie dans la boîte de dialogue I/
O Setup. Reportez-vous à la section « Bus de 
sortie » à la page 96.
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Pour afficher ou masquer les assignations 
des départs :

 Effectuez l'une des opérations suivantes :

• Sélectionnez ou désélectionnez View > Sends A-

E > Assignments.

• Sélectionnez ou désélectionnez View > Sends F-

J > Assignments. 

• Maintenez la touche Commande (Mac) ou 
Ctrl (Windows) enfoncée et cliquez sur l'un des 
sélecteurs de départ pour alterner entre la vue 
Sends et la vue Expanded Sends.

Vues Expanded Send (A–J)
Pro Tools permet d'étendre l'affichage des vues de 
chaque assignation de départ, dans la combinaison 
de votre choix. Les vues étendues des départs 
incluent les commandes de niveau, de 
panoramique et de mute pour un départ spécifique 
sur l'ensemble des pistes. Vous pouvez ajuster les 
commandes des départs directement depuis ces 
vues Send. Les départs peuvent également être 
ouverts pour édition ou visualisation des niveaux 
dans les fenêtres Send. Reportez-vous à la section 
« Fenêtres Output pour les pistes et les départs » 
à la page 1008.

Pour développer (ou réduire) un départ :

 Sélectionnez (ou désélectionnez) View > 

Expanded Sends > Send <n> (A–J).

Vue Assignments, sans départ (à gauche) et avec un 
départ assigné (à droite)

Départ A, vue Assignment

Sélecteurs de départ (A à E) 

Sélecteurs de départ (F à J) 

Vue étendue pour les départs A, B et F

Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et cliquez sur un sélecteur 
de départ pour le développer ou le réduire.
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Pour développer tous les départs :

 Sélectionnez View > Expanded Sends > All.

Pour réduire tous les départs :

 Sélectionnez View > Expanded Sends > None.

Indicateurs de niveau sur les 
assignations de départ
Des indicateurs de niveau à segments peuvent être 
affichés dans Pro Tools, à droite des noms de 
chemin des départs sur leurs boutons d'assignation, 
en vue normale. Les niveaux affichés sur les 
départs sont uniquement post-fader de départ.

Pour afficher (ou masquer) les indicateurs de 
niveau sur les assignations de départ, effectuez 
l'une des opérations suivantes :

 Sélectionnez Setup > Preferences > Metering et 
sélectionnez (ou désélectionnez) l'option Show 

Send Assignment Level Meter (reportez-vous 
à la section « Show Send Assignment Level 
Meter » à la page 123).

 Effectuez un clic droit sur l'indicateur de niveau 
d'une piste et sélectionnez (ou désélectionnez) 
l'option Show Send Assignment Level Meter.

Modification des départs 
dans les fenêtres Mix et Edit 
(vues Send individuelles)
Les vues Send individuelles (Send A par exemple) 
affichent l'ensemble des paramètres relatifs à un 
départ donné dans la zone réservée aux départs des 
fenêtres Mix et Edit. Ces vues permettent d'accéder 
à toutes les commandes associées au départ 
concerné, sur toutes les pistes. 

Les commandes de niveau et de mute du départ 
peuvent suivre le comportement des groupes 
de mixage, ce qui permet de régler simultanément les 
paramètres d'un grand nombre de départs.

Vues Send individuelles 
et indicateurs de niveau
Lorsque vous affichez les commandes associées 
à un départ spécifique, vous avez également la 
possibilité d'afficher ses indicateurs de niveau.

Ces indicateurs de niveau affichent les valeurs 
crêtes ainsi que les écrêtages (si un départ est 
écrêté alors que son indicateur de niveau n'est pas 
affiché, cet écrêtage n'apparaît pas). Si vous 
utilisez un ordinateur plutôt lent, le masquage des 
indicateurs de départ peut améliorer la fréquence 
de rafraîchissement de l'affichage.

Pour remettre à zéro l'indicateur d'écrêtage d'un 
indicateur de niveau de départ :

 Cliquez sur l'indicateur d'écrêtage. 

Maintenez les touches Commande+Option 
(Mac) ou Ctrl+Alt (Windows) enfoncées et 
cliquez sur un sélecteur de départ pour 
développer ou réduire tous les départs du 
groupe de départs associé (A à E ou F à J).

Vue Assignments avec indicateur de niveau

Vue du départ A, départ mono

Sélecteur 
de départ

Indicateur 
de niveau 
du départ

Bouton d'assignation 
de départ
Pan du départ

Bouton pré/post-fader

Mute du départ

Niveau 
du départ 
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Pour réinitialiser tous les indicateurs de niveau, 
effectuez l'une des opérations suivantes :

 Maintenez la touche Option enfoncée et cliquez 
sur un indicateur d'écrêtage.

 Sélectionnez Track > Clear All Clip Indicators.

 Appuyez sur Alt+C (Windows) ou Option+C 
(Mac).

Affichage de l'état des départs
Lorsque vous affichez toutes les commandes d'une 
vue Send individuelle, l'indicateur d'état des 
départs est visible directement dans les fenêtres 
Mix et Edit.

Dans la vue Assignment, l'état des départs est 
affiché de la manière suivante :

• Par défaut, le bouton du départ est grisé, pour 
indiquer que le départ n'est pas muté.

• Le texte du bouton du départ est rouge lorsqu'un 
écrêtage s'est produit sur le départ.

• Le bouton du départ est bleu lorsque le départ est 
muté. 

• Le bouton du départ est allumé dès qu'une 
fenêtre de départ est ouverte. 

Si vous utilisez une surface de contrôle (telle que D-
Control ou 003) avec Pro Tools, le contrôleur actif 
est repéré par des contours colorés sur les départs, 
les inserts et les sorties.

Départs désactivés 
Il est possible de désactiver les départs. Le fait 
de désactiver un départ libère les ressources DSP et 
de mixeur qu'il consomme, tout en permettant de 
conserver sa position dans la vue Sends. Les départs 
désactivés ne sortent pas d'audio. Toutefois, les 
départs désactivés conservent toutes les playlists 
d'automation associées. De plus, toute modification 
apportée à des clips de pistes comportant des départs 
désactivés peut encore affecter leurs playlists 
d'automation.

À l'ouverture d'une session, les départs sont 
automatiquement désactivés en cas d'indisponibilité 
du matériel ou d'autres ressources. 

Pour désactiver un départ, effectuez l'une des 
opérations suivantes :

 Maintenez les touches Ctrl+Démarrer (Windows) 
ou Commande+Ctrl enfoncées et cliquez sur 
l'assignation du départ.

 Désactivez la piste. Reportez-vous à la section 
« Désactivation des pistes » à la page 247.

Dans la vue Assignment, vous pouvez modifier 
les départs en ouvrant la fenêtre Output 
correspondante. Reportez-vous à la section 
« Fenêtres Output pour les pistes et les 
départs » à la page 1008.

Indication de l'état de mute, d'écrêtage et d'ouverture 
de la fenêtre d'un départ

Non muté Écrêté 
(texte rouge) 

Muté 
(bleu) 

Fenêtre ouverte 
(bouton allumé)

Affichage des départs désactivés

Départ activé 
(texte normal)

Départ désactivé 
(en italique et grisé)

Piste désactivée 
(la piste entière est 
en italique et grisée)
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Pour activer ou désactiver les départs occupant la 
même position (A à J) et assignés au même 
chemin sur toutes les pistes :

 Maintenez les touches Ctrl+Démarrer+Alt 
(Windows) ou Commande+Ctrl+Option (Mac) 
et cliquez sur un bouton de départ, à la position 
souhaitée.

Pour activer ou désactiver les départs occupant 
la même position (A à J) et assignés au même 
chemin sur toutes les pistes sélectionnées :

 Maintenez les touches Ctrl+Démarrer+Alt+Maj 
(Windows) ou Commande+Ctrl+Option+Maj 
(Mac) et cliquez sur un bouton de départ, à la 
position souhaitée.

Déplacement ou copie de départs 
Les départs peuvent être déplacés ou copiés sur 
d'autres pistes ou à d'autres emplacements d'une 
même piste par glisser-déposer. Les départs 
peuvent être glissés-déposés pour créer de 
nouveaux départs, ou remplacer sur des 
assignations de départs existantes. 

Les départs peuvent être déplacés ou copiés sur des 
pistes comportant des formats de départs 
compatibles (mono, stéréo ou autre). Pro Tools 
vous avertit lorsque vous tentez de déplacer ou de 
copier un départ vers une destination non 
compatible. Pour plus d'informations, reportez-
vous à la section « Format des départs et 
compatibilité des pistes » à la page 1006. 

Pour déplacer un départ :

 Cliquez sur le nom du départ et faites-le glisser 
vers son nouvel emplacement sur la piste 
d'origine ou une autre piste. 

Pour copier un départ :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée, cliquez sur le départ et faites-le 
glisser vers une nouvelle position. 

Lors du déplacement ou de la copie, toutes les 
assignations de routing, l'automation, les paramètres 
de niveau/panoramique/mute, ainsi que le format de 
sortie du départ sont préservés. 

Format des départs et compatibilité des pistes

Les départs ne peuvent être copiés que sur des 
pistes comportant un format de sortie de départ 
compatible (mono, stéréo ou autre). De plus, 
les conditions suivantes sont applicables lors 
du déplacement ou de la copie de départs d'une 
piste vers une autre :

• Lorsque vous copiez un départ stéréo d'une piste 
mono vers une piste stéréo, l'automation de 
panoramique du départ (le cas échéant) 
est supprimée sans avertissement. 

• Lorsque vous copiez un départ stéréo d'une piste 
stéréo vers une piste mono, les données de 
gauche de l'automation de panoramique 
du départ sont conservées et celles de droite 
sont supprimées. Une boîte de dialogue 
d'avertissement s'affiche pour vous permettre de 
confirmer ou d'annuler cette opération 
destructive. 

• Lorsque vous déplacez ou copiez un départ pour 
remplacer un départ existant, toute automation 
du départ existant est remplacée. Une boîte de 
dialogue d'avertissement s'affiche pour vous 
permettre de confirmer ou d'annuler cette 
opération destructive. 

Copie de paramètres de pistes 
sur les départs
(Pro Tools HD uniquement)

Il est parfois nécessaire que les paramètres des 
départs soient identiques à ceux de la piste elle-
même ; c'est le cas par exemple si vous voulez créer 
un mixage casque basé sur le mixage principal. 
Vous pouvez copier les valeurs actuelles ou la 
totalité de la playlist d'automation de pistes 
sélectionnées vers n'importe lequel de leurs départs. 
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Liaison des panoramiques de 
départ et principal
Vous pouvez lier les commandes de panoramique 
de départs individuels aux commandes 
de panoramique principales des pistes 
correspondantes. Vous pouvez ainsi configurer 
rapidement des mixages casque ou le 
routing d'effets.

Les commandes de panoramique de départs liés 
apparaissent en gris clair.

Pour lier les commandes de panoramique d'un 
départ aux commandes de panoramique 
principales d'une piste :

1 Cliquez sur le bouton d'assignation du départ 
que vous souhaitez lier pour ouvrir 
la fenêtre Send. 

2 Dans la fenêtre Send, cliquez sur le bouton FMP 
(Follow Main Pan). 

Pour modifier les paramètres par défaut FMP pour 
les départs récemment crées :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Setup, sélectionnez ou désélectionnez 
l'option Send Pans Default to Follow Main Pan.

Options d'interrogation 
des bus
Pro Tools permet de sélectionner ou d'afficher des 
pistes en fonction de leur assignation d'entrée ou 
de sortie, d'une assignation de départ ou d'insert 
matériel. Cette fonction est très utile pour identifier 
rapidement toutes les pistes qui utilisent une entrée, 
un bus interne, un bus de sortie ou un insert matériel 
spécifique.

Effectuez un clic droit sur le sélecteur d'assignation et 
sélectionnez l'une des options suivantes :

Select Assignments To : cette option sélectionne 
toutes les pistes qui utilisent une entrée, un bus 
interne, un bus de sortie ou un insert matériel 
spécifique.

Show Assignments To : cette option affiche 
toutes les pistes, y compris les pistes masquées, 
qui utilisent une entrée, un bus interne, un bus de 
sortie ou un insert matériel spécifique. Toutes les 
autres pistes restent également affichées.

Show Only Assignments To : cette option affiche 
uniquement les pistes qui utilisent une entrée, 
un bus interne, un bus de sortie ou un insert 
matériel spécifique. Toutes les autres pistes sont 
automatiquement masquées.

Restore Previously Shown Tracks : cette option 
rétablit l'affichage précédent des pistes. Cette 
option est uniquement disponible si les pistes ont 
été masquées suite à l'utilisation de la commande 
Show Only Assignments To.

Pour plus d'informations, reportez-vous à la 
section « Copie de l'automation de piste sur 
les départs » à la page 1082.

Bouton Follow Main Pan
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Pour sélectionner des pistes en fonction de leur 
assignation d'entrée ou de sortie, d'une 
assignation de départ ou d'insert matériel :

 Effectuez un clic droit sur le sélecteur 
d'assignation, puis sélectionnez Select 

Assignments To pour le bus souhaité.

Pour afficher toutes les pistes utilisant une 
assignation d'entrée ou de sortie, une assignation 
de départ ou d'insert matériel spécifique :

 Effectuez un clic droit sur le sélecteur 
d'assignation, puis sélectionnez Show 

Assignments To pour le bus souhaité. Toutes les 
pistes masquées utilisant la même assignation 
sont affichées.

Pour afficher uniquement les pistes utilisant une 
assignation d'entrée ou de sortie, une assignation 
de départ ou d'insert matériel spécifique :

 Effectuez un clic droit sur le sélecteur d'assignation, 
puis sélectionnez Show Only Assignments To pour 
le bus souhaité. Toutes les autres pistes sont 
automatiquement masquées.

Pour restaurer toutes les pistes précédemment 
affichées :

 Effectuez un clic droit sur un sélecteur 
d'assignation, puis sélectionnez Restore 

Previously Shown Tracks.

Fenêtres Output pour les 
pistes et les départs
Les fenêtres Output et Send contiennent les 
commandes standard de Pro Tools de piste, 
de départ, de cible, etc. Les sorties de piste et les 
départs peuvent être ouverts pour affichage et 
édition dans des fenêtres prévues à cet effet. 

• Les fenêtres Output contiennent les commandes de 
fader, de panoramique, d'automation, de solo et de 
mute de la piste. 

• Les fenêtres Send contiennent les commandes 
de niveau, de panoramique, d'automation et de 
mute du départ. 

• Les commandes des fenêtres standard Output 
et Send offrent des paramètres supplémentaires 
d'assignation, de routing et d'affichage.

Appuyez sur Option (Mac) ou Alt (Windows) tout 
en effectuant un clic droit, puis en sélectionnant 
l'une des commandes d'interrogation des bus, 
pour l'appliquer à tous les chemins et sous-
chemins associés. Par exemple, maintenez 
la touche Option (Mac) ou Alt (Windows) 
enfoncée et effectuez un clic droit sur un sélecteur 
de sortie, puis sélectionnez Show Only 
Assignments To Bus 1. Si le bus 1 est un sous-
chemin du bus 1–2, toutes les pistes qui utilisent le 
chemin Bus 1–2, et toutes celles qui utilisent les 
sous-chemins Bus 1 et Bus 2 s'affichent, toutes les 
autres sont masquées.

Sélection de l'option Select Assignments To Bus 9–10
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Pour ouvrir la fenêtre Output d'une piste :

 Cliquez sur le bouton de la fenêtre Output sur la 
tranche de console. 

Pour ouvrir une fenêtre Send :

 Cliquez sur le bouton Send Assignment dans la 
fenêtre Mix ou Edit. 

Pour afficher une autre fenêtre Output ou Send :

 Cliquez sur un bouton de fenêtre Output 
ou d'assignation de départ dans la fenêtre Mix 
ou Edit. 

Si une fenêtre Output similaire est déjà ouverte et 
ciblée (icône rouge, allumée), le nouveau départ 
sélectionné s'ouvre à sa place. 

Ouverture d'une fenêtre Output de piste

Ouverture d'une fenêtre Send
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Ouverture de plusieurs fenêtres 
Output
Il est possible d'afficher simultanément plusieurs 
fenêtres Output et Send à l'aide de l'une des 
méthodes ci-après : 

Pour ouvrir d'autres fenêtres Output ou Send :

 Maintenez la touche Maj enfoncée et cliquez 
sur le bouton de la fenêtre Output d'une piste ou 
d'une assignation de départ.

Pour configurer une fenêtre afin qu'elle reste 
ouverte lorsque d'autres fenêtres Output ou Send 
sont ouvertes :

 Assurez-vous que le bouton de ciblage 
est désactivé. 

Fader, commandes de 
panoramique, solo, mute et 
d'automation de piste ou départ
Les fenêtres Output contiennent le fader de volume 
de la piste, les commandes de panoramique, 
les commutateurs Solo et Mute et le sélecteur de 
mode d'automation. Ces commandes permettent de 
régler ou d'automatiser les commandes de la fenêtre 
Output. 

Liaison du panoramique
Les sorties stéréo offrent deux commandes de 
panoramique, une pour chaque côté de la paire 
gauche/droite. Les sorties multicanal offrent un 
panoramique multicanal.

Les commandes de la fenêtre Output permettent 
de lier des canaux pour un contrôle précis 
du panoramique des pistes stéréo et multicanal.

Dans ce mode, chaque modification apportée 
au panoramique sur un côté est immédiatement 
répercutée à l'identique de l'autre côté. Il s'agit d'un 
mode de liaison absolu. Pour refléter les modifications 
du panoramique, reportez-vous à la section 
« Panoramique lié inversé » à la page 1011.

Une fois dissociées, les commandes de panoramique 
redeviennent entièrement indépendantes.

Pour activer la liaison :

 Activez l'icône de liaison.

Plusieurs fenêtres Send ouvertes

Ciblage activé Ciblage désactivé

Fenêtre Send non liée (à gauche), liée (au milieu), 
avec liaison inversée à l'avant (à droite)

Icône 
d'inversion

Icône de 
liaison



Chapitre 43 : Principes de base du mixage 1011

Pour dissocier une sortie et contrôler 
indépendamment son panoramique :

 Désélectionnez l'icône de liaison. 

Panoramique lié inversé
Lorsque le panoramique est lié et en mode inversé, 
les mouvements de panoramique sont reproduits 
à l'inverse sur les autres canaux. 

Le mode de panoramique inversé répercute 
à l'inverse, dans une direction donnée, le 
mouvement d'un son d'un canal à l'autre. S'il est 
activé pour une inversion avant, par exemple, et si 
vous déplacez de droite à gauche le son d'un des 
canaux d'une sortie de piste stéréo, le son de l'autre 
canal subira le déplacement équivalent de gauche 
à droite. 

Le mode de liaison inversée à l'avant est disponible 
sur tous les systèmes. Les liaisons inversées arrière et 
avant/arrière sont disponibles sur les systèmes 
Pro Tools HD uniquement et ne s'affichent que sous 
forme d'options dans les fenêtres de plug-in et de 
panoramique/sortie multicanal.

Pour activer le mode de liaison inversée :

1 Activez l'icône de liaison.

2 Sélectionnez un mode d'inversion 
de panoramique. 

Commandes de sélecteur 
standard dans les fenêtres Output
Toutes les fenêtres Output contiennent des 
sélecteurs standard de chemin, d'automation 
et d'autres commandes, situés dans la zone 
supérieure (zone Output Editor).

Sélecteur de piste : permet d'accéder à toutes les 
pistes audio, d'entrée auxiliaire et Master Fader de 
la session.

Sélecteur de vue Output : permet d'accéder aux 
autres sorties (de piste et de départ) sur la piste, 
le cas échéant, et fait apparaître la sortie 
sélectionnée dans la fenêtre active.

Sélecteur Send View (fenêtre Send uniquement) : 
permet d'accéder aux autres départs de la piste.

Sélecteur Output Path : permet d'assigner le 
chemin de sortie souhaité à la piste ou au départ 
actuel. 

Bouton Pré/post fader (fenêtre Send uniquement) : 
détermine si le départ est pré-fader ou post-fader.

Sélecteurs de liaison et de mode inversé (piste multicanal)

Liaison

Inversion avant/arrière

Inversion avant

Inversion arrière

Commandes standard d'une fenêtre Output

Commandes standard d'une fenêtre Send

Sélecteur de piste

Sélecteur de chemin

Protection 
de l'automation 

Cible

Sélecteur de 
vue Output
Pan inversé

Liaison

Sélecteur de piste

Sélecteur 
de chemin

Protection 
de l'automation 

Liaison

Cible

Sélecteur de départ

Pré/post fader
Follow Main Pan

Pan inversé
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Bouton FMP (Follow Main Pan) (fenêtre Send 
uniquement) : indique si le panoramique du départ 
est lié ou non au panoramique de la piste. Lorsque 
le bouton FMP est activé, les commandes de 
panoramique de la fenêtre Send sont inaccessibles 
et le départ adopte les paramètres de panoramique 
de la piste.

Protection de l'automation : protège le niveau 
de piste et de départ, les panoramiques et autres 
commandes contre tout risque d'effacement. Pour 
plus d'informations, reportez-vous au Chapitre 45, 
« Automation ». 

Pan inversé : répercute à l'inverse, dans une 
direction donnée, le mouvement d'un son d'un 
canal à l'autre (par exemple commandes du 
panoramique des canaux gauche et droit). 

Liaison et dissociation : permet de lier/dissocier les 
sorties gauche et droite (ou d'autres sorties) en stéréo 
(ou multicanal). Le mode dissocié permet de régler 
indépendamment les côtés ou canaux individuels. 
Lorsqu'ils sont liés, les modifications affectent tous les 
canaux. Reportez-vous à la section « Liaison du 
panoramique » à la page 1010. 

Cible : identifie la « cible » des commandes 
de configuration des plug-ins. Sélectionne 
également la fenêtre active dans l'affichage des 
fenêtres Output.

Bouton Path Meter View : ouvre la vue Meter 
du chemin. Ces indicateurs de niveau affichent les 
niveaux du chemin sélectionné (et non les niveaux 
de la piste ou du départ). 

Indicateurs de niveau de 
sortie
Pro Tools fournit des indicateurs de niveau de 
sortie dans la fenêtre de transport et la fenêtre Edit. 
Ils affichent les niveaux de monitoring des signaux 
routés depuis votre session vers les sorties 
physiques de vos interfaces audio, ou vers des 
bus internes de la session. La LED rouge du 
haut signale un écrêtage des convertisseurs de 
votre interface audio (CNA) sur les canaux 
correspondants ou les bus internes. 

Pour les systèmes Pro Tools HD avec des chemins de 
sortie de format supérieur à stéréo, jusqu'à 
8 indicateurs de niveau sont affichés. Le nombre 
d'indicateurs de sortie affichés est déterminé par les 
chemins de sortie sélectionnés sur les pistes. L'ordre 
des indicateurs correspond à celui des canaux des 
chemins de sortie, paramétré dans la boîte de 
dialogue I/O Setup. 

Vue des indicateurs de niveau du chemin dans une 
fenêtre Send

Bouton de 
la vue des 
indicateurs 
de niveau 
du chemin

Indicateur 
de niveau 
du départ Indicateurs 

de niveau 
du chemin

Sélecteur de 
l'indicateur 
de niveau 
du chemin



Chapitre 43 : Principes de base du mixage 1013

Les chemins audio dont le niveau est affiché sur les 
indicateurs de sortie sont déterminés par 
le paramètre Output Meter Path de la page Output 
de la boîte de dialogue I/O Setup.

Pour définir les chemins des indicateurs de niveau 
de sortie :

1 Sélectionnez Setup > I/O Setup.

2 Cliquez sur l'onglet Output.

3 Depuis le sélecteur Output Meter Path, sélectionnez 
le chemin de sortie dont vous souhaitez contrôler le 
niveau sur les indicateurs.

4 Cliquez sur OK.

L'ordre des canaux est déterminé par la 
configuration des chemins de sortie dans la boîte 
de dialogue I/O Setup.

Des indicateurs de niveau stéréo (L/R) sont 
affichés pour tous les systèmes Pro Tools utilisant 
des chemins de sortie stéréo.

Pour afficher (ou masquer) les indicateurs 
de niveau de sortie dans la fenêtre Edit 
ou la fenêtre de transport :

 Depuis le menu de la fenêtre Edit ou de 
la fenêtre de transport, sélectionnez 
(ou désélectionnez) Output Meter.

Routing du signal pour 
le monitoring et les sous-
groupes de mixage
Les outils de routing et de mixage de Pro Tools 
fournissent de nombreuses possibilités en termes de 
gestion des sous-groupes de mixage et 
du monitoring, notamment pour les 
applications suivantes :

• Monitoring et lecture du mixage de pistes audio 
avec des entrées audio ou des instruments MIDI.

• Création de sous-groupes de mixage via des bus 
pour l'application d'effets ou le monitoring 
(y compris les mixages casque).

• Création de sous-groupes de mixage avec les 
Master Faders.

Sélection d'un chemin pour les indicateurs de sortie 
dans I/O Setup

L'ordre des canaux sur les indicateurs de sortie est 
déterminé par la configuration des sorties dans I/O Setup

Indicateurs de niveau de sortie stéréo dans la fenêtre 
de transport

Sélection de l'option Output Meters dans le menu 
de la fenêtre de transport
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Monitoring et mixage d'audio 
avec des pistes d'entrée 
auxiliaire
Utilisez des pistes d'entrée auxiliaire pour écouter et 
mixer de l'audio provenant de sources externes 
telles que l'entrée d'instruments MIDI, 
de magnétophones ou de micros dans un mixage 
Pro Tools.

Pour utiliser une piste d'entrée auxiliaire pour le 
monitoring et le mixage de sources audio externes :

1 Connectez les sorties audio de votre source audio 
(telle qu'un synthétiseur MIDI ou une sortie de 
magnétophone) à des entrées disponibles sur 
votre interface audio Pro Tools. 

2 Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte 
de dialogue I/O Setup (reportez-vous 
au Chapitre 7, « I/O Setup ».).

3 Utilisez une piste d'entrée auxiliaire (nouvelle 
ou existante) disposant du même format 
de canal que votre source audio (mono, stéréo 
ou multicanal).

4 Définissez l'entrée de la piste d'entrée auxiliaire 
sur le chemin d'entrée correspondant.

5 Assignez la sortie de piste au(x) chemin(s) 
approprié(s) pour le monitoring.

6 Ajustez le fader de l'entrée auxiliaire pour mixer 
l'entrée audio. 

Monitoring et mixage d'audio 
avec des pistes d'instrument
Utilisez les pistes d'instrument pour écouter 
et mixer de l'audio provenant de plug-ins 
d'instrument ou d'instruments MIDI externes 
dans un mixage Pro Tools.

Pour utiliser une piste d'instrument pour le 
monitoring et le mixage de la sortie d'un plug-in 
d'instrument :

1 Utilisez une piste d'instrument existante 
ou créez-en une.

2 Sélectionnez View > Mix Window > Instruments 
pour afficher les commandes MIDI de la piste 
d'instrument. 

3 Sélectionnez un plug-in d'instrument à l'aide du 
premier sélecteur d'insert de la piste 
d'instrument (Xpand2 par exemple).

4 Le nœud MIDI virtuel (port) du plug-in 
d'instrument doit être automatiquement 
sélectionné pour la sortie MIDI de la piste 
d'instrument. Si ce n'est pas le cas, sélectionnez le 
canal MIDI souhaité ainsi que le port 
correspondant du plug-in d'instrument à partir du 
sélecteur de sortie MIDI.

5 Assignez la sortie audio de la piste au(x) 
chemin(s) approprié(s) pour le monitoring.

6 Ajustez le fader de la piste d'instrument pour 
mixer l'entrée audio. 

7 Si vous contrôlez le plug-in d'instrument 
à partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide des 
commandes de volume MIDI et de 
panoramique de la vue Instrument.

Pour plus d'informations sur la configuration 
du routing des signaux audio et MIDI pour le 
contrôle et le monitoring des applications 
client ReWire, reportez-vous au Guide des 
plug-ins audio.
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Pour utiliser une piste d'instrument pour 
le monitoring et le mixage d'audio provenant d'un 
instrument MIDI externe :

1 Connectez les sorties audio de votre instrument 
MIDI externe (un synthétiseur MIDI par exemple) 
à des entrées disponibles sur votre interface audio 
Pro Tools. 

2 Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte 
de dialogue I/O Setup (reportez-vous 
au Chapitre 7, « I/O Setup ».).

3 Connectez l'entrée et la sortie MIDI de votre 
instrument MIDI externe à des ports d'entrée et 
de sortie disponibles de votre interface MIDI.

4 Le cas échéant, configurez les paramètres MIDI 
Studio Setup (Setup > MIDI > MIDI Studio). 

5 Utilisez une piste d'instrument (nouvelle 
ou existante) disposant du même format 
de canal que votre source audio (mono, stéréo 
ou multicanal).

6 Sélectionnez View > Mix Window > Instruments 
pour afficher les commandes MIDI de la piste 
d'instrument. 

7 Définissez l'entrée audio de la piste d'instrument sur 
le chemin d'entrée correspondant.

8 Dans la vue Instrument de la piste d'instrument, 
définissez la sortie MIDI sur le port MIDI 
correspondant connecté à l'entrée MIDI de votre 
instrument MIDI externe.

9 Assignez la sortie de piste au(x) chemin(s) 
approprié(s) pour le monitoring.

Piste d'instrument configurée pour le contrôle et le 
monitoring d'un plug-in d'instrument (Xpand2)

Sélecteur 
d'entrée MIDI
Commande de 
volume MIDI
Commande de 
panoramique 
MIDI

Mute MIDI

Sélecteur de 
sortie MIDI
Indicateur de 
vélocité MIDI
Plug-in d'instrument

Sélecteur 
d'entrée audio 
(aucune entrée)

Sélecteur de 
sortie audio

Piste d'instrument configurée pour le contrôle et le 
monitoring d'un instrument MIDI externe (K2600)

Sélecteur d'entrée MIDI
Commande de 
volume MIDI

Commande de 
panoramique MIDI
Sélecteur de 
sortie audio

Mute MIDI
Sélecteur de sortie MIDI
Indicateur de vélocité 
MIDI

Sélecteur d'entrée 
audio (configuré pour 
l'entrée du périphérique 
MIDI externe)
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10 Ajustez le fader de la piste d'instrument pour 
mixer l'entrée audio. 

11 Si vous contrôlez l'instrument MIDI externe 
à partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide des 
commandes de volume MIDI et de panoramique 
de la vue Instrument.

Pour écouter et mixer de l'audio provenant d'un 
plug-in d'instrument avec plusieurs sorties audio :

1 Utilisez une piste d'instrument existante 
ou créez-en une.

2 Sélectionnez View > Mix Window > Instruments 
pour afficher les commandes MIDI de la piste 
d'instrument. 

3 Sélectionnez un plug-in d'instrument à plusieurs 
sorties dans le premier sélecteur d'insert de la piste 
d'instrument (Xpand!2 par exemple).

4 Le nœud MIDI virtuel (port) du plug-in 
d'instrument doit être automatiquement 
sélectionné pour la sortie MIDI de la piste 
d'instrument. Si ce n'est pas le cas, sélectionnez le 
canal MIDI souhaité ainsi que le port 
correspondant du plug-in d'instrument.

5 Assignez les sorties audio individuelles 
du plug-in dans la fenêtre de plug-in.

6 Créez une piste d'entrée auxiliaire pour chaque 
sortie du plug-in. Assurez-vous que le format de 
canal des entrées auxiliaires correspond au 
format de canal des sorties du plug-in (mono, 
stéréo ou multicanal).

7 Configurez les entrées des pistes d'entrée 
auxiliaire afin qu'elles reçoivent les sorties 
individuelles du plug-in. 

8 Assignez les sorties des pistes d'entrée 
auxiliaire au(x) chemin(s) approprié(s) pour le 
monitoring.

9 Ajustez les faders des entrées auxiliaires pour 
mixer les sorties individuelles du plug-in.

Création d'un sous-groupe 
de mixage
Un sous-groupe de mixage est créé en routant 
plusieurs sources audio vers un même chemin de 
bus ou de sortie. Les sources sont ainsi prémixées 
et envoyées sur un seul chemin qui peut être 
renvoyé vers une entrée auxiliaire pour traiter le 
sous-groupe à l'aide de plug-ins ou de processeurs 
d'effets externes.

Plug-in d'instrument avec plusieurs sorties routées 
vers des pistes d'entrée auxiliaire

 
Plug-in 
d'instrument

Entrées 
à partir 
des sorties 
du plug-in
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Pour créer un sous-groupe de mixage audio, 
il suffit d'assigner une combinaison de départs et 
de sorties de pistes vers des bus ou des chemins de 
sortie disponibles.

Création de sous-groupes avec des sorties 
ou départs de piste 

Vous pouvez utiliser les sorties et départs des pistes 
pour router de l'audio vers le type de sous-groupe 
souhaité : séparé ou départ/retour.

Sortie de sous-groupe séparé
Pro Tools permet de router l'audio source vers un 
sous-groupe de mixage séparé. Cette méthode est 
préférable pour le dithering ou autres traitements de 
mastering, lorsque l'on ne désire pas entendre de 
signaux audio non traités en plus des signaux traités. 
Pour un sous-groupe de mixage séparé, on utilise les 
sorties de piste (et non les départs) pour assigner des 
pistes à un chemin de bus. Dans ce cas, l'équilibre 
entre les signaux traités et non traités est contrôlé 
par les paramètres Wet/Dry du plug-in.

Pour créer un sous-groupe de mixage séparé :

1 Définissez la sortie des pistes à inclure dans le 
sous-groupe de mixage sur un chemin de bus 
stéréo. 

2 Réglez le panoramique de chaque piste.

3 Sélectionnez Track > New.

4 Spécifiez le type de piste (Aux Input) et le 
format (stereo), puis cliquez sur Create.

5 Définissez l'entrée de l'entrée auxiliaire sur le 
même chemin de bus que celui auquel sont 
assignées toutes les pistes à traiter.

6 Définissez la sortie de la piste d'entrée auxiliaire 
sur les sorties de mixage stéréo principales 
(les sorties 1-2 en général). 

7 Définissez le niveau de la piste d'entrée 
auxiliaire.

8 Pour traiter le sous-groupe de mixage, assignez 
un plug-in ou un insert matériel à l'entrée 
auxiliaire. 

9 Réglez les commandes du plug-in. Le cas échéant, 
les commandes Bypass et Wet/Dry du plug-in 
contrôlent la quantité d'effet audible.

Les niveaux relatifs du sous-groupe de mixage 
sont contrôlés par les faders de piste. La piste 
d'entrée auxiliaire contrôle les niveaux de sortie de 
toutes les pistes routées. 

Vous pouvez automatiser les niveaux, 
panoramiques, mutes ainsi que les niveaux, 
panoramiques et mutes des départs 
de l'entrée auxiliaire.

Il est également possible de bouncer un sous-
groupe de mixage sur disque, afin de libérer les 
voix des pistes qui le composent pour d'autres 
pistes. Pour plus d'informations, reportez-vous au 
Chapitre 46, « Mixdown ».

Sous-groupe de type départ/ 
retour pour l'application d'effets
Lorsque vous groupez des pistes pour leur appliquer 
une réverbération, un delay ou d'autres effets 
similaires, utilisez des départs pour configurer un 
routing départ/retour traditionnel. Vous pouvez 
alors partager un plug-in en temps réel ou un insert 
matériel entre toutes les pistes incluses dans le sous-

Lorsque vous routez des signaux mono via des 
bus de mixage internes, nous vous 
recommandons d'utiliser des bus mono plutôt 
que de scinder des bus stéréo. Les bus stéréo 
étant en phase dans Pro Tools, la scission des 
bus stéréo peut entraîner une compensation 
incorrecte du délai.
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groupe de mixage. La quantité d'effet (Wet/Dry) 
dans le mixage peut être modifiée à l'aide des faders 
de piste (niveau de son direct, Dry) et du fader 
d'entrée auxiliaire (niveau de signal d'effet, Wet).

Pour créer un sous-groupe de retour d'effet avec 
un insert de plug-in ou matériel :

1 Assignez la sortie principale de chaque piste 
aux sorties principales du mix.

2 Sur les pistes source, assignez un départ (mono ou 
stéréo) et sélectionnez un chemin de bus mono ou 
stéréo dans le sélecteur de départ. Configurez les 
départs pré ou post-fader, selon vos besoins.

3 Sélectionnez Track > New.

4 Spécifiez le type de piste (Aux Input) et le 
format (stereo), puis cliquez sur Create.

5 Dans le sélecteur de chemin d'entrée de la piste 
d'entrée auxiliaire, sélectionnez le chemin de 
bus de départ.

6 Protégez la piste contre la mise en solo de sorte 
que si vous mettez une autre piste qui utilise le 
départ d'effets en solo, le retour d'effets ne soit 
pas muté (reportez-vous à la section « Mode de 
protection de la mise en solo » à la page 247).

7 Assignez un plug-in ou un insert matériel sur 
l'entrée auxiliaire.

8 Réglez l'effet sur « 100 % Wet », ainsi que les 
autres commandes.

9 Dans le sélecteur de chemin de sortie de la piste 
d'entrée auxiliaire, sélectionnez un chemin de 
sortie (sorties principales).

Réglez chaque fader de piste pour équilibrer les 
pistes non traitées. Lorsque le départ est pré-fader, 
la quantité d'effet est contrôlée par le niveau du 
fader de niveau de départ ou du fader du volume 
d'entrée auxiliaire. Si le départ est post-fader, le 
fader du niveau de départ suit le niveau du volume.

Pour plus d'informations, reportez-vous au 
Chapitre 44, « Inserts de plug-in et matériels ».

Configuration départ/retour pour un plug-in ou 
un insert matériel

Insert d'effet 
(plug-in ou matériel)

Départ vers le bus d'effet

Contrôle le niveau du départ 
vers le bus d'effets

Entrée définie sur le chemin 
de bus du départ

Sortie définie sur les sorties 
principales du mix 

Contrôle le niveau 
du retour d'effet

Contrôle le niveau 
du signal non traité
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Sous-groupes de type départ/
retour avec des périphériques 
externes

Pour créer un sous-groupe de retour d'effet avec 
un périphérique externe :

1 Assignez la sortie principale de chaque piste 
aux sorties principales du mix.

2 Assignez un départ (mono ou stéréo) et définissez 
les destinations des départs sur les pistes source 
vers le chemin de sortie connecté au périphérique 
externe. Configurez les départs pré ou post-fader, 
selon vos besoins.

3 Sélectionnez Track > New.

4 Spécifiez le type de piste (Aux Input) 
et le format (stereo ou mono), puis cliquez 
sur Create.

5 Cliquez sur le sélecteur de chemin d'entrée de la 
piste d'entrée auxiliaire pour choisir un chemin 
d'entrée relié au périphérique externe.

6 Dans le sélecteur de chemin de sortie de la piste 
d'entrée auxiliaire, sélectionnez un chemin de 
sortie (sorties principales).

7 Réglez chaque fader de piste pour équilibrer les 
pistes non traitées. 

La quantité d'effet est contrôlée par le niveau 
du fader de niveau de départ ou du fader 
du volume d'entrée auxiliaire.

Configuration départ/retour pour un périphérique externe

Départ vers le 
périphérique externe

Contrôle le niveau 
du départ vers le 
périphérique externe

Entrée définie pour assurer 
le retour du périphérique
Sortie définie sur les sorties 
principales du mix 

Contrôle le niveau 
du retour d'effet
Contrôle le niveau 
du signal non traité
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Création de sous-groupes pour 
le monitoring
Routez les départs de piste vers une ou plusieurs 
pistes d'entrée auxiliaire pour gérer le monitoring des 
sous-groupes dans un environnement de studio. Vous 
pouvez écouter le mixage principal en régie sur une 
ou plusieurs paires de sorties audio tout en routant un 
sous-groupe vers une autre paire de sorties audio pour 
envoyer un mixage casque à un artiste. Vous pouvez 
par exemple envoyer à un bassiste un prémixage de la 
batterie avec sa propre piste pour enregistrer un 
overdub.

Pour créer un sous-groupe de monitoring :

1 Assignez la sortie principale de chaque piste 
aux sorties principales du mix.

2 Assignez un départ (mono ou stéréo) et définissez 
les destinations des départs sur les pistes source 
vers le chemin de sortie connecté au périphérique 
externe. Configurez les départs pré ou post-fader, 
selon vos besoins.

3 Sélectionnez Track > New.

4 Spécifiez le type de piste (Aux Input) et le format 
(stereo ou mono), puis cliquez sur Create.

5 Dans le sélecteur de chemin de sortie de la piste 
d'entrée auxiliaire, sélectionnez le chemin de 
sortie (et non pas les sorties principales) pour le 
monitoring du mixage. 

Ajustez le fader de la piste d'entrée auxiliaire pour 
contrôler le volume du mixage de monitoring.

Création d'une commande 
master de niveau de départ 
Un Master Fader peut contrôler le niveau global 
des chemins de bus et de sortie. 

Pour créer une commande master de niveau 
de départ :

1 Sélectionnez Track > New.

2 Spécifiez le type de piste (Master Fader) et le 
format mono, stéréo ou tout autre format 
multicanal pris en charge pour le mixage 
surround.

3 Cliquez sur Create.

Pour les mixages casque dans le cadre 
d'overdubs, il est recommandé de ne pas 
utiliser d'insert (ou uniquement des inserts ne 
générant qu'un délai très faible) sur la piste 
d'enregistrement afin d'éviter toute latence 
inutile dans le chemin de monitoring.

Sous-groupe du mixage de batterie pour le monitoring
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4 Effectuez l'une des opérations suivantes :

• Définissez la sortie du Master Fader sur 
le chemin utilisé pour le routing vers une piste 
d'entrée auxiliaire.

• Définissez la sortie du Master Fader afin qu'elle 
corresponde au chemin choisi pour votre départ 
d'effet.

Vous pouvez ensuite ajuster les niveaux de départ 
pour régler la balance des pistes source et utiliser le 
Master Fader en tant que commande de niveau 
principale pour le sous-groupe entier.

Mise en solo de pistes d'un sous-
groupe
La mise en solo de pistes mute implicitement 
toutes les autres pistes, y compris les entrées 
auxiliaires. La protection contre la mise en solo 
d'une entrée auxiliaire évite ce mute implicite et 
permet à l'entrée auxiliaire de continuer 
à transmettre les données audio lorsque ses pistes 
source sont en solo.

Pour protéger une entrée auxiliaire contre la mise 
en solo :

 Cliquez sur le bouton Solo de la piste d'entrée 
auxiliaire tout en appuyant sur la touche 
Ctrl (Windows) ou Commande (Mac).

Pour mettre en solo une piste particulière 
appartenant à un groupe :

 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, puis cliquez sur 
le bouton Solo. 

Génération d'une sortie stéréo 
à partir d'un départ/retour mono
Pour générer une sortie stéréo à partir d'un départ 
mono, vous pouvez recourir à une entrée auxiliaire. 
Réglez la destination du départ vers une piste d'entrée 
auxiliaire sur laquelle vous placez un plug-in mono 
vers stéréo. La sortie de l'entrée auxiliaire devient dès 
lors une sortie stéréo. 

Pour créer un effet « stéréo » à partir d'une source 
mono, vous devez utiliser une réverbération, 
un delay ou tout autre effet temporel.

Compensation du délai
Pro Tools fournit une compensation du délai 
automatique pour la gestion des délais dus aux DSP 
et à l'ordinateur hôte du fait des inserts de plug-in, 
ainsi que du routing du mixeur (utilisation des bus 
et départs). Lorsque la compensation du délai est 
activée, Pro Tools préserve l'alignement de phase des 
pistes dont les plug-ins génèrent des délais différents, 
des pistes utilisant des chemins de mixage différents, 
des pistes divisées et recombinées au sein du mixeur 
et des pistes comportant des inserts matériels.

Lorsque la compensation du délai est activée, 
Pro Tools alloue 16 383 échantillons à 44,1/48 kHz, 
32 767 échantillons à 88,2/96 kHz ou 65 534 
échantillons à 176,4/192 kHz pour la compensation 
du délai de chaque canal du mixeur. Activez la 
compensation pour les sessions dont les plug-ins 
insérés sur les canaux du mixeur engendrent plus de 
4 000 échantillons de délai à 48 kHz.

Il est conseillé de toujours activer la compensation du 
délai lors de la lecture et du mixage pour conserver un 
alignement temporel avec une phase cohérente. 
La compensation du délai doit également être utilisée 
dans la plupart des situations d'enregistrement.
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Activation de la compensation 
du délai

Pour activer la compensation du délai :

 Sélectionnez Options > Delay Compensation.

Lorsqu'elle est activée, l'indicateur d'état de la 
compensation du délai est affiché dans la barre 
d'outils de la fenêtre Edit.

Si vous le souhaitez, la vue Delay Compensation 
pour les pistes peut être affichée dans la fenêtre 
Mix (reportez-vous à la section « Vue Delay 
Compensation » à la page 1022).

Delay Compensation Time Mode
Les valeurs de délai peuvent être exprimées 
en échantillons ou en millisecondes, selon le 
paramètre Delay Compensation Time Mode 
sélectionné dans les préférences de fonctionnement. 

Délai du système
Pro Tools ajoute la quantité exacte de délai 
nécessaire pour que le délai d'une piste donnée soit 
le même que le délai total du système. Le délai 
total du système correspond au délai le plus long 
indiqué sur une piste, plus tout délai supplémentaire 
causé par le routing du mixeur.

Le délai du système apparaît dans la fenêtre Session 
Setup (Session > Setup). Consultez le délai du 
système indiqué afin de vérifier si vous risquez de 
dépasser la limite de compensation du délai.

Vue Delay Compensation
La vue Delay Compensation indique la quantité 
totale de délai générée par les plug-ins et inserts 
matériels de chaque piste (HD uniquement), ainsi 
que la quantité totale de délai appliquée par 
Pro Tools à chaque piste. Vous avez aussi 
la possibilité d'appliquer individuellement aux 
différentes pistes un décalage pour le délai de piste. 
La vue Delay Compensation peut être affichée ou 
masquée dans la fenêtre Mix.

Indicateur de compensation du délai

L'indicateur de compensation du délai dans 
la fenêtre Edit devient rouge si votre session 
comporte des délais dépassant la 
compensation du délai maximale disponible 
(reportez-vous à la section « Délai supérieur à 
la limite de compensation » à la page 1024).

L'indicateur rouge peut également indiquer que 
vous avez créé une boucle de réinjection dont le 
délai ne peut être compensé. C'est par exemple 
le cas si la sortie d'une piste est routée vers 
l'entrée de la même piste. Faites glisser la souris 
au-dessus de l'indicateur de compensation du 
délai dans la fenêtre Edit pour voir si l'info-bulle 
identifie un problème.

Délai du système dans la fenêtre Session Setup

Pro Tools HD prend en compte les délais des 
convertisseurs lorsque la compensation 
du délai automatique est activée. Toutefois, 
lorsque du matériel non HD est utilisé, le délai 
du système n'affiche que le délai interne et 
ne prend pas en compte les éventuels 
délais imputables aux convertisseurs 
analogique/numérique (CAN) ou numérique/
analogique (CNA) de votre interface audio.
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Pour afficher les informations de compensation 
du délai : 

 Sélectionnez View > Mix Window > Delay 

Compensation.

Champs et indicateurs de la vue 
Delay Compensation
Indicateur du délai (dly)

L'indicateur du délai (dly) indique le délai total 
généré par les inserts de plug-in et matériels sur la 
piste. Le rapport de l'indicateur de délai au moteur 
de compensation du délai de Pro Tools peut être 
ignoré lorsque la compensation du délai est activée. 
Cela s'avère utile pour synchroniser une piste 
manuellement lorsque le délai total sur une piste 
dépasse la limite de compensation du délai. Reportez-
vous à la section « Délai supérieur à la limite 
de compensation » à la page 1024.

La couleur affichée indique les délais de piste 
rapportés de la manière suivante :

Vert : indique que le rapport du délai est activé 
et que la piste ne dépasse pas la quantité 
de compensation du délai disponible.

Orange : indique qu'il s'agit de la piste avec le 
délai le plus long de la session au niveau des inserts 
de plug-in et des inserts matériels. 

Rouge : indique que la quantité de délai au niveau 
des inserts de plug-in et des inserts matériels 
dépasse la quantité de compensation du délai 
disponible (reportez-vous à la section « Délai 
supérieur à la limite de compensation » 
à la page 1024). 

Gris : le rapport du délai de la piste est ignoré.

Champ du décalage défini par l'utilisateur (+/-) 

Ce champ permet d'ajuster les délais de piste 
manuellement lorsque la compensation du délai est 
activée. Le décalage défini par l'utilisateur s'ajoute 
ou se soustrait à la quantité de délai appliqué via la 
compensation du délai de piste. Il peut s'avérer 
utile dans les cas suivants :

• pour aligner temporellement une piste 
manuellement dans le cas où un plug-in rapporte 
son délai de manière incorrecte ;

• pour modifier le « feeling » de la mise en place 
d'une piste.

Pour modifier le délai d'une piste à l'aide du champ 
de décalage utilisateur :

1 Dans la vue Delay Compensation, cliquez dans 
le champ du décalage utilisateur.

2 Pour définir la valeur de délai (en échantillons ou en 
millisecondes selon vos préférences actuelles), 
effectuez l'une des opérations suivantes :

• Entrez une valeur positive (avec ou sans le 
modificateur +) pour un délai positif (plus loin dans 
le temps) ou négatif (avec le modificateur -) pour un 
délai négatif (plus tôt dans le temps). 

• Cliquez sur le champ du décalage utilisateur 
et faites glisser votre souris pour définir une 
nouvelle valeur. Pour un réglage plus précis, 
maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée pendant l'opération.

Vue Delay Compensation

La vue Delay Compensation affiche uniquement 
le délai au niveau des inserts pour chaque piste. 
Pour afficher le délai de l'ensemble du système, 
y compris les délais du mixeur, cochez l'option 
System Delay dans la fenêtre Session Setup 
(reportez-vous à la section « Délai du système » 
à la page 1022).

 
 

Indicateur de délai
Champ du décalage 
défini par l'utilisateur
Indicateur de com-
pensation de la piste
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• Appuyez sur les touches Flèche haut et bas pour 
augmenter ou réduire les valeurs numériques. 

3 Appuyez sur la touche Entrée.

Pour ignorer le délai utilisateur :

 Cliquez dans le champ +/- tout en maintenant 
les touches Démarrer+Ctrl (Windows) ou 
Commande+Ctrl (Mac) enfoncées. Le délai 
utilisateur apparaît alors grisé et n'est plus 
appliqué à la piste.

Indicateur de compensation du délai (cmp) 

Cet indicateur affiche la quantité de compensation du 
délai que Pro Tools applique à chaque piste. 

La couleur affichée indique la quantité de 
compensation du délai appliquée, comme suit :

Vert : la compensation de piste est activée et la 
piste ne dépasse pas la limite de compensation du 
délai autorisée. La quantité de compensation du 
délai affichée sur l'indicateur est appliquée à la 
piste.

Bleu (pistes audio uniquement) : indique que la 
compensation du délai est activée de force sur la 
piste. Lorsque la piste est en mode d'enregistrement 
ou TrackInput, la compensation du délai n'est 
pas suspendue et reste activée (pour plus 
d'informations, reportez-vous à la section 
« Annulation du monitoring à faible latence lors de 
l'enregistrement » à la page 1025).

Rouge : indique que le délai de cette piste dépasse 
la quantité de compensation du délai disponible et 
qu'aucune compensation du délai n'est appliquée 
à la piste (reportez-vous à la section « Délai 
supérieur à la limite de compensation » 
à la page 1024). 

Gris : indique que la compensation du délai pour la 
piste est ignorée et qu'aucun délai n'est appliqué.

Compensation du délai pour les 
side chains
(Systèmes Pro Tools|HDX uniquement)

Les systèmes Pro Tools|HDX permettent de 
compenser automatiquement le délai des signaux 
induit par un traitement side chain. Dans certains cas, 
il peut être utile de désactiver la compensation 
automatique du délai pour les side chains, par exemple 
pour des sessions créées sur des versions antérieures 
de Pro Tools dans lesquelles le délai des side chains 
a déjà été compensé manuellement.

Pour activer (ou désactiver) la compensation 
automatique du délai des side chains :

1 Sélectionnez Setup > Preferences.

2 Cliquez sur l'onglet Opération.

3 Sélectionnez (ou désélectionnez) l'option 
Compensate Side Chains.

4 Cliquez sur OK.

Délai supérieur à la limite 
de compensation
Lorsque le délai total d'une piste dépasse la quantité 
totale de compensation du délai disponible 
(sélectionnée dans la boîte de dialogue Playback 
Engine), aucune compensation du délai n'est 
appliquée à cette piste. L'audio éventuellement 
présent sur cette piste n'est plus synchronisé et 
devient hors phase. L'indicateur de compensation 
du délai et l'indicateur de compensation de piste 
s'affichent en rouge pour indiquer que le délai de la 
piste dépasse la limite de compensation du délai. 
La compensation du délai maximale est appliquée 
au reste des pistes. 

Toutefois, vous pouvez compenser manuellement 
le délai sur les pistes dont le délai est supérieure 
à la limite de compensation.
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Pour compenser un délai supérieur à la limite 
de compensation :

1 Ignorez le délai indiqué pour la piste en 
effectuant l'une des opérations suivantes :

• Maintenez les touches Commande+Ctrl (Mac) 
ou Ctrl+Démarrer (Windows) enfoncées et 
cliquez sur l'indicateur de délai. 

• Effectuez un clic droit sur l'indicateur de délai et 
sélectionnez Disable Plug-In Delay.

L'information concernant la piste s'affiche en grisé 
une fois qu'elle est désactivée.

2 Avancez manuellement toute donnée audio 
se trouvant à un point antérieur de la piste en 
fonction de la quantité de délai rapporté par 
l'indicateur de la piste.

 

Monitoring à faible latence lors 
de l'enregistrement
Lorsqu'une piste audio est armée (activée pour 
l'enregistrement), en mode TrackInput, en mode 
DestructivePunch, ou lorsque vous effectuez un 
punch-in sur la piste, la compensation du délai est 
automatiquement suspendue et l'indicateur de 
compensation de la piste affiche 0. Cela permet de 
réduire la latence du monitoring sur les sorties de ces 
pistes. Lors de la lecture de la piste (avec l'activation 
en enregistrement et TrackInput désactivés), celle-ci 
est alignée correctement avec les autres pistes avec 
délai compensé.

Les pistes qui ne sont pas activées en 
enregistrement appliquent tout de même 
la compensation du délai. Pro Tools compense 
automatiquement tout décalage de temps entre les 
contenus enregistrés et le mixage avec 
compensation du délai. 

Annulation du monitoring à faible 
latence lors de l'enregistrement
Vous pouvez annuler le monitoring à faible latence lors 
de l'enregistrement sur des pistes activées en 
enregistrement, mais cela peut entraîner une latence 
dans le chemin du signal en fonction de la quantité de 
compensation du délai. Cette latence peut être 
acceptable en fonction de la source d'enregistrement. 
Dans certains workflows non destinés à la 
représentation, le fait d'annuler le monitoring à faible 
latence lors de l'enregistrement permet d'assurer que la 
compensation du délai est appliquée de manière 
régulière, que la piste soit activée pour l'enregistrement 
ou pour l'enregistrement en punch in/out, ou encore que 
Pro Tools se trouve en mode enregistrement ou en mode 
lecture.

Pour annuler le monitoring à faible latence lors 
de l'enregistrement sur des pistes spécifiques :

 Maintenez les Commande+Ctrl (Mac) ou 
Ctrl+Démarrer (Windows) enfoncées et cliquez 
sur l'indicateur de compensation de piste. 
La compensation du délai est appliquée à la piste 
et l'indicateur de compensation de piste s'affiche 
en bleu.

Utilisez les plug-ins Time Adjuster pour 
appliquer un décalage manuel en temps 
réel aux pistes. Pour plus d'informations, 
reportez-vous au Guide des plug-ins audio.

Lors de certaines procédures de doublage, vous 
pouvez souhaiter transférer les enregistrements 
à partir d'un bus vers plusieurs pistes. Dans ces 
cas de figure, vous devez vous assurer d'annuler 
le monitoring à faible latence sur les pistes en 
enregistrement.

Maintenez les touches Commande+Ctrl+Maj 
(Mac) ou Ctrl+Démarrer+Maj (Windows) 
enfoncées et cliquez sur l'indicateur de 
compensation de piste pour annuler le 
monitoring à faible latence pour toutes les 
pistes sélectionnées.
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Compensation du délai sur les 
entrées auxiliaires
La compensation du délai sur les entrées auxiliaires 
peut être ignorée pour vous permettre d'écouter 
les sources externes (comme les pistes audio d'un 
magnétoscope asservi) avec une latence minime, 
tout en continuant à prendre en compte le délai de la 
piste.

Pour désactiver la compensation du délai d'une 
entrée auxiliaire :

 Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Commande+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste. Le délai de piste porte la valeur 0 et 
apparaît grisée.

Compensation du délai pour 
le MIDI
Pro Tools préserve automatiquement l'alignement 
temporel entre des événements MIDI enregistrés et 
leur lecture avec compensation du délai. 

Lorsque la compensation du délai est activée, 
un événement MIDI enregistré de façon à sembler 
synchronisé avec des données à compensation du 
délai est en fait enregistré avec un décalage égal 
au délai total en vigueur. Pour compenser, 
les événements MIDI sont reculés dans le temps 
d'un délai total de session suivant chaque passage 
d'enregistrement MIDI. La lecture MIDI après 
un passage d'enregistrement avec compensation 
du délai activé prend en compte le chemin 
d'enregistrement à faible latence et préserve 
l'alignement temporel avec phase cohérente avec 
la lecture MIDI.

Enregistrement à faible latence 
avec des instruments MIDI 
virtuels et compensation du délai
Lorsqu'une piste MIDI ou d'instrument qui route 
des données MIDI vers un plug-in d'instrument est 
activée pour l'enregistrement, Pro Tools suspend 
automatiquement la compensation du délai via les 
sorties principales de la piste audio, d'entrée 
auxiliaire ou d'instrument sur laquelle le plug-in 
d'instrument est inséré. Cela permet d'obtenir un 
monitoring sans latence du plug-in d'instrument 
lors de l'enregistrement.

Maintenez les touches Commande+Option+ 
Ctrl (Mac) ou Ctrl+Alt+Démarrer (Windows) 
enfoncées et cliquez sur l'indicateur de 
compensation de piste pour annuler le 
monitoring à faible latence pour toutes les 
pistes. 

Lorsqu'une piste d'instrument ou MIDI est 
activée en enregistrement, toutes les pistes 
d'instrument et d'entrée auxiliaire comportant 
des inserts de plug-in d'instrument configurées 
pour recevoir des données MIDI dans 
Pro Tools sont placées en mode à faible 
latence. Dans ce cas, les indicateurs de 
compensation du délai pour ces pistes 
affichent 0. 

La compensation du délai pour les plug-ins 
d'instruments fonctionne uniquement lorsque 
toutes les connexions MIDI et audio sont 
établies dans Pro Tools. Tant que Pro Tools ne 
suspend pas la compensation du délai lorsque 
vous utilisez ReWire pour connecter des 
synthétiseurs et des échantillonneurs dans 
d'autres applications client ReWire (telles que 
Reason), Pro Tools ne peut prendre en compte 
aucune latence au niveau du client ReWire 
même.
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Plug-ins de traitement MIDI et audio

Certains plug-ins de traitement audio (tels que 
Bruno et Reso) et de nombreux plug-ins 
d'instrument vous laissent traiter des données 
audio tout en permettant aux données MIDI de 
contrôler les paramètres de traitement. Lorsque 
vous activez pour l'enregistrement une piste MIDI 
ou d'instrument qui contrôle un plug-in de 
traitement audio, la piste sur laquelle le plug-in est 
inséré passe en mode à faible latence, entraînant la 
lecture anticipée des données audio traitées. 
La procédure pour éviter cela et conserver la 
synchronisation de l'audio dépend du type de piste 
sur laquelle se trouve le plug-in. 

Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé 
via MIDI sur une piste audio :

 Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Commande+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de la piste audio pour appliquer la compensation 
du délai. 

Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé via 
MIDI sur une entrée auxiliaire :

1 Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Commande+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste de l'entrée auxiliaire pour ignorer 
la compensation du délai.

2 Saisissez le délai total du système dans 
le champ du décalage utilisateur.

Configuration de mixages casque 
avec compensation du délai
Si votre session Pro Tools utilise des chemins 
de routing variés pour les inserts et le mixeur, 
il est conseillé d'activer la compensation du délai. 
Cependant, si vous souhaitez enregistrer un 
musicien en overdub, vous devrez configurer des 
mix de monitoring (mixage casque). 

Utilisez les départs pour router les mixages casques 
vers les chemins de sortie audio envoyés au casque. 
En plus du mix principal, envoyé en régie, routez des 
départs de piste vers un ou plusieurs chemins de sortie 
supplémentaires pour le monitoring des mixages 
casque. L'utilisation de départs permet de configurer 
différents mixages à partir du mixage principal pour 
une écoute des mixages casque. Par exemple, lorsque 
vous enregistrez un guitariste, il peut souhaiter 
s'entendre davantage dans le mixage casque que vous 
ne souhaitez l'entendre dans le mixage principal.

Exemple de configuration utilisant des départs 
pour les mixages casque :

1 Assignez la sortie principale de chaque piste 
aux sorties principales du mix.

2 Affectez un départ (mono ou stéréo) à chaque 
piste et définissez les sorties de départ sur les 
chemins de sortie 3 et 4 de votre interface audio. 

3 Activez le bouton FMP (Follow Main Pan) sur 
tous les départs pour que le panoramique du 
mixage casque soit identique à celui du mixage 
principal.

4 Définissez tous les départs post-fader sur le gain 
unitaire. Vous pouvez ainsi utiliser le même mix 
pour l'artiste, mais aussi amplifier (ou atténuer) 
le niveau de son retour dans le mixage casque en 
ajustant le niveau du départ.

5 Sélectionnez Track > New.

6 Spécifiez le type de piste (Main Fader) et le 
format (stereo), puis cliquez sur Create.
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7 À partir du sélecteur de chemin de sortie de la 
piste Master Fader, sélectionnez les chemins de 
sortie 3 et 4 pour écouter le mixage. 

8 Ajustez le fader de la piste Master Fader afin de 
contrôler le niveau de volume global du mixage 
casque.

9 Répétez la procédure précédente pour les 
mixages casques supplémentaires sur d'autres 
sorties de votre interface audio.

Définition d'un décalage du 
délai pour un insert matériel
Pour compenser manuellement la latence des 
périphériques matériels externes (une unité d'effets 
par exemple) utilisés dans la session, vous pouvez 
définir la valeur de compensation du délai d'insert 
matériel (en millisecondes) de chacun d'entre eux 
dans la boîte de dialogue I/O Setup. Les valeurs 
saisies seront utilisées par le moteur de 
compensation du délai pour synchroniser les 
chemins d'entrées lorsque l'insert matériel est en 
cours d'utilisation et que la compensation du délai 
est activée.

Pour définir un décalage de délai d'un insert :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet H/W Insert Delay.

3 Saisissez une valeur en millisecondes dans 
le champ correspondant à l'entrée sur laquelle 
l'insert matériel est connecté.

Définition du délai d'un insert 
matériel
Reportez-vous à la documentation de votre matériel 
externe pour vérifier que celui-ci permet d'identifier 
la latence du matériel, ou suivez la procédure de 
Pro Tools pour déterminer la latence des inserts 
matériels.

Pour définir le délai d'insert de votre matériel :

1 Assurez-vous que l'option Automatic Delay 

Compensation est activée (Options > Delay 

Compensation).

2 Modifiez l'échelle temporelle principale de 
votre session sur Min:Sec.

3 Créez deux pistes. 

4 Placez un son bref (ou un autre son avec une 
attaque marquée) sur la piste 1.

5 Insérez l'insert matériel sur la piste 1. 

6 Assurez-vous que seul le signal non traité est 
transmis via le périphérique. 

7 Routez la sortie de la piste 1 vers l'entrée de la 
piste 2. 

8 Activez l'enregistrement de la piste 2 et cliquez 
sur Record Enable puis Play dans la fenêtre de 
transport pour lancer la lecture de la piste 1 et 
l'enregistrer sur la piste 2.

9 Après l'enregistrement, effectuez un zoom avant 
et mesurez la différence entre l'endroit où le son 
débute sur la piste 1 et celui où il débute sur la 
piste 2. La différence correspond à la valeur que 
vous devez entrer en tant que décalage de délai 
pour votre insert matériel.

Lorsque la compensation du délai est activée, 
il est recommandé de ne pas utiliser d'insert sur 
les pistes d'entrée auxiliaire ou Master Fader 
que vous pourriez utiliser pour contrôler le 
volume du mixage casque. Évitez également 
d'utiliser des inserts sur les pistes 
d'enregistrement (certains inserts à faible 
latence peuvent être acceptables selon les 
préférences de l'artiste).

Les décalages de délai des inserts n'ont un 
effet que lorsque l'E/S est utilisée pour les 
inserts matériels.
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Dithering
Le dithering est utilisé pour réduire les artefacts de 
quantification lors de la réduction de la résolution d'un 
signal audio, par exemple de 24 bits à 16 bits. 
Les artefacts de quantification sont particulièrement 
apparents lorsque le signal est proche de la limite 
inférieure de sa plage dynamique, par exemple lors 
d'un passage de faible niveau sonore ou d'un fondu.

Le dithering réduit les artefacts de quantification en 
introduisant un bruit aléatoire de très faible niveau 
sur un signal, ce qui lisse la distorsion possible lors 
de la réduction de la résolution. 

Le dithering est donc un compromis entre les 
performances en termes de rapport signal/bruit et le 
taux de distorsion. Une utilisation appropriée du 
dithering permet de tirer des performances 
subjectives maximales lors de la réduction de la 
résolution des données audio. 

Le dithering dans Pro Tools
Le dithering peut être utilisé de plusieurs façons dans 
Pro Tools. Chacune est destinée à une application 
spécifique parmi les différentes opérations 
susceptibles de bénéficier du dithering. 

Plug-ins de dithering pour un mixdown : lorsque 
vous réalisez un mixdown ou un bounce sur disque 
et que la résolution de destination est inférieure 
à 24 bits, insérez un plug-in de dithering sur un 
Master Fader qui contrôle le mixage de sortie. 
Vous pouvez utiliser des plug-ins de dithering en 
temps réel Avid ou tiers. 

Pour obtenir des informations sur l'utilisation du 
dithering lors d'un mixdown ou d'un bounce sur 
disque, reportez-vous à la section « Utilisation du 
dithering » à la page 1130.

Dithering pour l'exportation et l'importation 

Lorsque vous exportez des données audio avec une 
résolution inférieure, ou lorsque vous importez un 
fichier audio dans une session dont la résolution 
est inférieure à celle du fichier, des presets de 
dithering avec mise en forme du bruit sont 
appliqués.

Mise en forme du bruit
La mise en forme du bruit peut encore améliorer 
les performances audio et réduire le bruit 
perceptible inhérent à l'audio après dithering. 
La mise en forme du bruit utilise un filtrage pour 
éliminer le bruit des fréquences situées au milieu 
du spectre audio (autour de 4 kHz), où l'oreille 
humaine est la plus sensible.

La mise en forme du bruit est disponible dans les 
plug-ins Dither et POWr Dither. 

Pour plus d'informations sur les plug-ins de 
dithering, reportez-vous au Guide des plug-
ins audio.

Pour obtenir davantage d'informations sur 
l'application du dithering lors d'une 
exportation, reportez-vous à la section 
« Exportation audio » à la page 345 . 

Pour obtenir davantage d'informations sur 
l'application du dithering lors d'une 
importation, reportez-vous à la section 
« Conversion de la résolution et dithering » 
à la page 332. 

Pour plus d'informations sur la mise en forme 
du bruit, reportez-vous au Guide des plug-ins 
audio.
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Utilisation d'une surface 
de contrôle Ethernet avec 
Pro Tools
Avid offre plusieurs options de surface de contrôle 
Ethernet pour Pro Tools.

D-Control et D-Command (Pro Tools HD 
uniquement)

Les surfaces de travail tactiles D-Control et D-
Command font partie du système flexible et intégré 
ICON, qui étend les fonctionnalités de Pro Tools. 

C|24

La C|24 est une surface de contrôle dédiée 
permettant d'accéder à la plupart des fonctions 
d'enregistrement, de mixage, d'édition, de routing 
des signaux, de contrôle des plug-ins et 
d'automation de Pro Tools. 

EUCON

Pro Tools prend en charge les surfaces de contrôle 
Avid par le biais du protocole EUCON (Extended 
User Control) (reportez-vous au Guide Pro Tools 
EUCON). EUCON est un protocole Ethernet haut 
débit novateur élaboré par Avid pour permettre 
aux surfaces de contrôle matérielles de 
communiquer directement avec une application 
logicielle telle que Pro Tools.

Activation d'une surface de 
contrôle Ethernet dans Pro Tools

Pour activer une surface de contrôle Ethernet 
dans Pro Tools :

1 Sélectionnez Setup > Peripherals et cliquez sur 
l'onglet Ethernet Controllers.

2 Sélectionnez Enable. 

3 Si votre surface de contrôle Ethernet est formée de 
plusieurs unités, sélectionnez les unités dans 
l'ordre numérique si vous souhaitez qu'elles soient 
ordonnées de gauche à droite. 

4 Cliquez sur OK.

Pour activer le contrôle EUCON dans Pro Tools :

1 Sélectionnez Setup > Peripherals.

2 Cliquez sur l'onglet Ethernet Controllers.

3 Sélectionnez l'option EUCON.

4 Cliquez sur OK.

Lorsque l'option EUCON est sélectionnée, 
Pro Tools peut être contrôlé par un ou plusieurs 
contrôleurs compatibles EUCON.

Utilisation d'une surface de 
contrôle MIDI avec Pro Tools
Les surfaces de contrôle MIDI permettent 
de contrôler tactilement différentes fonctions de 
Pro Tools, afin d'ajuster les faders et boutons, 
d'activer les commandes de transport ou de régler 
les paramètres des plug-ins. 

Command|8

La Command|8 est une surface de contrôle MIDI 
USB pour les systèmes Pro Tools. 

Pour plus d'informations, reportez-vous à la 
documentation livrée avec votre surface 
de contrôle Ethernet.

Pour plus d'informations sur l'utilisation 
de Pro Tools avec EUCON, reportez-vous 
au Guide Pro Tools EUCON.

Pour obtenir des instructions détaillées sur la 
connexion et la configuration de la Command|8, 
reportez-vous au Guide Command|8.
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Autres surfaces de contrôle MIDI

Pro Tools prend en charge certaines surfaces 
de contrôle MIDI capables d'exploiter des 
personnalités de contrôleur HUI.

Personnalités de surfaces de 
contrôle MIDI
Les personnalités de surfaces de contrôle MIDI 
sont des fichiers qui permettent à Pro Tools 
de communiquer avec la surface de contrôle MIDI. 
Lorsque vous installez Pro Tools, ces fichiers sont 
installés par défaut dans le répertoire Controllers 
du dossier Applications de Pro Tools. S'ils n'y sont 
pas, exécutez le fichier d'installation Pro Tools 
pour installer les fichiers de personnalité.

Connexion d'une surface de 
contrôle MIDI
Si votre matériel Pro Tools dispose de ports MIDI, 
vous pouvez connecter une surface de contrôle MIDI 
directement sur votre système. Sinon, vous devrez 
utiliser une interface MIDI. Les surfaces de contrôle 
MIDI USB (telles que la Command|8) et les surfaces 
de contrôle FireWire (telles que la 003) ne nécessitent 
pas de connexion MIDI supplémentaire à votre 
ordinateur.

Pour connecter une surface de contrôle MIDI 
(non USB ou FireWire) :

1 À l'aide d'un câble MIDI 5 broches standard, 
connectez le port de sortie MIDI de votre 
surface de contrôle MIDI au port d'entrée MIDI 
de votre matériel ou de votre interface MIDI 
Pro Tools.

2 À l'aide d'un câble MIDI 5 broches standard, 
connectez le port d'entrée MIDI de votre surface 
de contrôle MIDI au port de sortie MIDI de 
votre matériel ou de votre interface MIDI 
Pro Tools.

3 Si vous disposez d'une interface MIDI 
multiport, notez les ports auxquels la surface de 
contrôle est connectée.

Configuration de votre système 
pour une surface de contrôle MIDI
Une surface de contrôle MIDI se configure de la 
même façon que tout autre périphérique MIDI 
dans Pro Tools, dans la fenêtre MIDI Studio Setup 
(Windows) ou Audio MIDI Setup (Mac).

Activation d'une surface de 
contrôle MIDI dans Pro Tools

Pour activer une surface de contrôle MIDI dans 
Pro Tools :

1 Sélectionnez Setup > Peripherals et cliquez sur 
l'onglet MIDI Controllers.

2 Sélectionnez le nom de périphérique de la 
surface de contrôle MIDI dans le menu Type.

3 Sélectionnez le port source de la surface 
de contrôle MIDI dans le menu Receive From.

4 Sélectionnez un port de destination dans le 
menu Send To.

5 Si votre surface de contrôle MIDI dispose 
de plus de huit tranches ou si vous utilisez 
plusieurs périphériques du même type en série, 
sélectionnez le nombre de tranches approprié 
dans le menu sous #Ch's.

6 Cliquez sur OK.

Vous pouvez configurer des surfaces de contrôle 
MIDI supplémentaires (jusqu'à quatre) en répétant 
la procédure ci-dessus. Assurez-vous qu'aucune 
des surfaces de contrôle n'est assignée à la même 
source MIDI ni aux mêmes ports ou canaux de 
destination dans la boîte de dialogue Peripherals 
de Pro Tools. 

Pour obtenir des instructions détaillées sur la 
configuration de votre studio MIDI, 
reportez-vous au guide de l'utilisateur 
de votre système.
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Activation d'une surface de 
contrôle MIDI en tant que 
périphérique d'entrée
Vous devez vous assurer que la surface de contrôle 
MIDI est activée en tant que périphérique d'entrée 
dans Pro Tools.

Pour activer une surface de contrôle MIDI en tant 
que périphérique d'entrée :

1 Sélectionnez Setup > MIDI > Input Devices.

2 Sélectionnez le port source sélectionné dans le 
menu Receive From de la page MIDI Controllers 
de la boîte de dialogue Peripherals. 

3 Cliquez sur OK.

Si vous souhaitez éviter que les données MIDI 
d'une surface de contrôle ne soient envoyées 
à Pro Tools, vous pouvez désactiver son port 
source dans la fenêtre MIDI Input Enable.



Chapitre 44 : Inserts de plug-in et matériels 1033

Chapitre 44 : Inserts de plug-in et matériels

Dans Pro Tools, les inserts routent les signaux des 
pistes vers les plug-ins ou périphériques externes de 
votre choix, puis les renvoient automatiquement 
vers les mêmes pistes. Les inserts ne modifient pas 
les fichiers source audio originaux, mais traitent les 
sons en temps réel en cours de lecture. Il est possible 
de « figer » à tout moment des effets en temps réel 
appliqués aux pistes, en les enregistrant ou en les 
prémixant sur disque (pour plus d'informations, 
reportez-vous au Chapitre 46, « Mixdown »).

Pro Tools fournit jusqu'à dix inserts à gain 
unitaire sur chaque piste audio, entrée auxiliaire, 
Master Fader et piste d'instrument. Les inserts de 
pistes audio, d'entrée auxiliaire et d'instrument 
sont pré-fader et les inserts de Master Fader 
sont post-fader.

Lorsqu'une piste comporte plusieurs plug-ins 
ou inserts matériels, ceux-ci sont traités en série. 
Chaque effet vient donc s'ajouter à celui de l'insert 
précédent (de haut en bas dans la vue Inserts de la 
fenêtre Mix et de gauche à droite dans la vue 
Inserts de la fenêtre Edit).

Les inserts des pistes audio, d'entrée auxiliaire et 
Instrument sont placés avant le fader. Si vous 
réglez les paramètres du plug-in sur des valeurs 
extrêmes, de gain notamment, vous risquez 
de provoquer un écrêtage, plus particulièrement 
sur les pistes enregistrées avec une amplitude 
élevée. Les indicateurs de niveau à l'écran 
permettent de surveiller l'écrêtage (les inserts des 
Master Faders sont post-fader).

Types d'insert
Un insert peut être un plug-in DSP ou un 
insert matériel. 

Inserts de plug-in
Les inserts de plug-in sont des inserts logiciels qui 
traitent les données audio d'une piste en temps réel. 
Par exemple, les plug-ins d'EQ, de compression et 
de delay fournis avec votre système Pro Tools 
peuvent être utilisés en tant qu'inserts de plug-in en 
temps réel.

Vous pouvez vous procurer d'autres plug-ins 
en temps réel auprès d'Avid et de nombreux autres 
développeurs. 

Bouton et sélecteur d'insert d'une piste

Bouton d'insert

Sélecteur d'insert

Pour plus d'informations sur les plug-ins 
inclus avec votre système Pro Tools, reportez-
vous au Guide des plug-ins audio.

Pour plus d'informations sur les plug-ins 
optionnels, rendez-vous sur www.avid.com.



Guide de référence Pro Tools1034

Inserts d'E/S matériels
Les inserts d'E/S matériels peuvent router les 
signaux audio vers un périphérique externe 
connecté aux entrées et aux sorties parallèles de 
votre interface audio. Le traitement des sons sur 
une piste peut être effectué à l'aide d'un insert 
matériel en temps réel.
 

Les chemins d'inserts nécessitent des entrées et des 
sorties de l'interface audio : ils sont déterminés lors de 
la configuration des E/S sur votre système.

Utilisation des inserts pour 
le traitement d'effets 
Les inserts peuvent être utilisés de deux façons : 

Sur une seule piste : vous pouvez appliquer 
un insert à une piste audio, d'entrée auxiliaire, 
Master Fader ou d'instrument individuelle.

Dans le cas des inserts en série, vous pouvez 
contrôler la quantité d'effet souhaitée à l'aide du 
potentiomètre Balance (ou le mix wet/dry) du 
plug-in ou du périphérique externe.

En tant que ressources partagées : pour utiliser 
un insert en tant que ressource partagée, dans une 
disposition départ-retour, assignez les signaux de 
plusieurs pistes à un même bus envoyé vers une 
entrée auxiliaire, puis appliquez l'insert à la piste. 
Vous pouvez alors contrôler le niveau de départ sur 
chaque piste, ainsi que le niveau global de l'effet 
depuis la piste d'entrée auxiliaire. L'utilisation de 
départs et d'autres fonctions d'acheminement des 
signaux permet d'optimiser la puissance de 
traitement d'un système. 

Formats d'insert
Inserts mono : s'utilisent sur des pistes mono. 
Les inserts ajoutés à une piste après un insert 
stéréo sont automatiquement utilisés en stéréo.

Inserts stéréo : s'utilisent sur des pistes stéréo. 
Il est également possible de créer un insert d'E/S 
matériel stéréo sur une piste stéréo.

Inserts de plug-in mono en entrée/stéréo en sortie : 
conçus pour renvoyer un effet stéréo à partir d'une 
source mono. Certains plug-ins (par exemple D-Verb) 
permettent de générer une sortie stéréo à partir d'un 
canal mono. Une piste ainsi convertie au format stéréo 
dispose de commandes de panoramique pour chaque 
canal du signal stéréo. Tout insert placé sur une piste 
après un insert stéréo est automatiquement utilisé en 
stéréo.

Inserts de plug-in multi-mono : s'utilisent pour des 
pistes stéréo ou comportant davantage de canaux 
lorsqu'aucune version multicanal du plug-in n'est 
disponible. Les commandes de tous les canaux 
sont liées par défaut afin de permettre un réglage 
par paire. Pour régler les commandes 
indépendamment, dissociez-les à l'aide du bouton 
Master Link. Reportez-vous à la section « Liaison 
et dissociation des commandes des plug-ins multi-
mono » à la page 1060.

Inserts de plug-in multicanal : s'utilisent pour des 
pistes multicanal au format stéréo ou supérieur. 
Sur les pistes multicanal de format supérieur 
au format stéréo, les commandes de tous les 
canaux sont généralement couplées.

Insert d'E/S matériel

Vous trouverez des exemples de bus de type 
départ/retour ainsi que d'autres configurations de 
mixage à la section « Routing du signal pour 
le monitoring et les sous-groupes de mixage » 
à la page 1013. 

Le relinking peut provoquer la perte 
de l'automation. Reportez-vous à la section 
« Liaison et dissociation des commandes des 
plug-ins multi-mono » à la page 1060.
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Formats de plug-in
Pro Tools prend en charge trois formats de plug-
in : DSP, Native et AudioSuite. Deux d'entre eux 
peuvent être utilisés en tant qu'inserts en temps 
réel :

Plug-ins DSP : appliquent un traitement en temps 
réel basé sur DSP, sur les systèmes 
Pro Tools|HDX uniquement.

Plug-ins Native : appliquent un traitement 
en temps réel basé sur les ressources de l'hôte.

Plug-ins AudioSuite : appliquent un traitement non 
temps réel (avec rendu), basé sur les fichiers.

Les plug-ins en temps réel peuvent être utilisés des 
manières suivantes, selon le logiciel Pro Tools 
utilisé :

Systèmes Pro Tools|HDX

Les plug-ins DSP et Native peuvent être utilisés 
sur les pistes audio, d'entrée auxiliaire, 
Master Fader et d'instrument.

Systèmes Pro Tools basés sur hôte

Les plug-ins Native peuvent être utilisés sur 
les pistes audio, d'entrée auxiliaire, Master Fader 
et d'instrument. 

Utilisation des voix et latence 
totale pour les plug-ins Native 
(basés sur hôte)
(Systèmes Pro Tools|HDX uniquement)

Sur les systèmes Pro Tools|HDX, le premier insert 
de plug-in Native (basé sur hôte) peut générer une 
latence supérieure et prendra un maximum de deux 
voix supplémentaires par canal (une voix pour 
l'entrée et une pour la sortie), dans les conditions 
suivantes :

• lorsqu'il est inséré sur une piste d'entrée 
auxiliaire ou Master Fader ; 

• lorsqu'il est inséré sur une piste d'instrument 
sans plug-in d'instrument ;

• lorsqu'il est inséré après un plug-in DSP, quel 
que soit le type de la piste.

Par exemple, le premier insert d'un plug-in basé sur 
hôte sur une piste d'entrée auxiliaire mono utilise 
deux voix (un canal avec deux voix), alors que le 
premier insert du même plug-in sur une piste 
d'entrée auxiliaire stéréo utilise quatre voix 
(deux canaux avec deux voix chacun).

Les plug-ins basés sur hôte suivants de la même 
piste ne prennent pas de voix supplémentaire, sauf 
si un plug-in DSP est inséré entre les autres plug-
ins basés sur hôte. 

Une voix supplémentaire est utilisée dans chacun 
des cas suivants, lors de l'utilisation de plug-ins 
basés sur hôte sur une piste :

• lorsque vous utilisez le déclencheur externe du 
side-chain d'un plug-in basé sur hôte de la piste ;

• lorsque vous sélectionnez plusieurs sorties 
de piste pour cette piste (une voix par sortie) ;

• lorsque vous sélectionnez un chemin de sortie 
AFL/PFL sur l'onglet Output de la boîte de 
dialogue I/O Setup (une voix pour chaque canal).

Pour plus d'informations sur l'utilisation 
des plug-ins AudioSuite dans Pro Tools, 
reportez-vous au Chapitre 39, « Traitement 
AudioSuite ».

Sur les systèmes Avid HDX, les plug-ins Native 
insérés sur les entrées auxiliaires, les Master 
Faders et les pistes d'instrument utilisent des 
voix supplémentaires et peuvent induire une 
latence supérieure, basée sur la taille de la 
mémoire tampon matérielle. Reportez-vous à la 
section « Utilisation des voix et latence totale 
pour les plug-ins Native (basés sur hôte) » 
à la page 1035.

Pour obtenir des conseils sur l'optimisation 
des performances avec les plug-ins Native, 
reportez-vous à la section « Configuration des 
paramètres système de Pro Tools » 
à la page 52.

Évitez d'insérer des plug-ins DSP entre des 
plug-ins Native basés sur hôte, quel que soit 
le type de piste. En effet, cela entraîne une 
utilisation de voix inutile et peut engendrer 
une latence supérieure.
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Affichage des inserts
Vous pouvez configurer les fenêtres Mix et Edit 
pour afficher ou masquer les inserts A à E et F à J. 
Les fenêtres de plug-in fournissent un accès 
complet aux commandes des plug-ins. 

Pour afficher ou masquer des inserts, effectuez 
l'une des opérations suivantes :

 Dans la fenêtre Mix (ou Edit), sélectionnez 
View > Mix Window (ou Edit Window) > Inserts 

A–E ou Inserts F–J.

 Sélectionnez Inserts A-E ou Inserts F-J dans le 
sélecteur de vue de la fenêtre Edit ou de la 
fenêtre Mix.

Affichage de l'état des fenêtres 
de plug-in
Dans les fenêtres Mix et Edit, le bouton et le 
sélecteur de plug-in indiquent le nom du plug-in 
inséré, l'état de bypass (reportez-vous à la section 
« Bypass des plug-ins » à la page 1059), l'état de 
sélection et celui de la fenêtre.

Indication de sélection du contrôleur

Pour la plupart des surfaces de contrôle, un seul 
plug-in peut être sélectionné à la fois. Jusqu'à 
quatre plug-ins peuvent être sélectionnés 
simultanément sur les surfaces de contrôle ICON 
(à l'aide des commandes EQ, Dynamics et Custom 
Faders de la surface de contrôle).

La sélection de contrôleur actuelle, le cas échéant, 
est signalée par un contour coloré :

Inserts et départs dans la fenêtre Mix

Vue Inserts (A-E)

Vue Sends (A-E)

Vue I/O

Vue Sends (F-J)

Vue Inserts (F-J)

Un nom de plug-in allumé indique que la fenêtre 
du plug-in est ouverte

Sélection de contrôleur
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Désactivation des inserts
Il est possible de désactiver les inserts de plug-in et 
matériels pour libérer leurs ressources et les affecter 
à un autre usage. Lorsqu'il est désactivé, un insert de 
plug-in conserve les informations relatives à son 
affectation, sa position et aux playlists d'automation 
qui lui sont associées. Toutefois, il ne reçoit pas 
d'audio et ne consomme pas de ressources DSP.

À l'ouverture d'une session, les plug-ins sont 
automatiquement désactivés dans les cas suivants :

• Les ressources DSP du système sont insuffisantes ;

• un plug-in n'est pas installé ;

• un type de plug-in n'est pas disponible ;

• l'ouverture de la session entraîne des 
substitutions de type de plug-in. Cela peut 
se produire lorsque le type est disponible mais sa 
substitution entraînerait une condition non prise 
en charge, telle que l'ouverture d'une session 
contenant un plug-in basé sur DSP pour lequel 
aucune version basée sur hôte n'est disponible.

Pour désactiver un insert, effectuez l'une des 
opérations suivantes :

 Cliquez sur le bouton d'insert en maintenant 
les touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées.

 Effectuez un clic droit sur le bouton d'insert et 
sélectionnez Make Inactive.

 Désactivez la piste. Reportez-vous à la section 
« Désactivation des pistes » à la page 247.

Pour activer ou désactiver les inserts occupant 
la même position sur toutes les pistes :

 Cliquez sur un bouton d'insert pour l'activer ou 
le désactiver, en maintenant les touches 
Ctrl+Démarrer+Alt (Windows) ou 
Commande+ Ctrl+Option (Mac) enfoncées.

Pour activer ou désactiver les inserts occupant 
la même position sur toutes les pistes sélectionnées :

 Cliquez sur un bouton d'insert pour l'activer ou 
le désactiver en maintenant les touches 
Ctrl+Démarrer+Alt+Maj (Windows) ou 
Commande+Ctrl+Option+Maj (Mac) 
enfoncées.

Inserts de plug-in désactivés 

Les inserts de plug-in désactivés conservent toutes 
les playlists d'automation qui leur sont associées. 
De plus, toutes les modifications apportées au cours 
de la session se répercutent sur les playlists 
d'automation des plug-ins. Vous ne pouvez pas 
enregistrer d'automation ni ajuster de commandes 
pour un plug-in désactivé. 

Inserts matériels désactivés

Un insert matériel désactivé conserve son 
assignation, mais ne reçoit pas d'audio et ne 
consomme pas de ressources DSP.

Affichage de plug-ins désactivés

Affichage d'une fenêtre de plug-in désactivé

Les inserts matériels n'offrent pas 
de commande de bypass. Vous pouvez utiliser la 
fonction de désactivation pour muter un insert 
matériel ou le mettre en bypass.

 
Désactivé
(italique)

Activé
(police normale)
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Insertion de plug-ins sur les 
pistes
Pour utiliser un plug-in en temps réel, vous devez 
l'insérer sur une piste. 

Pour insérer un plug-in sur une piste :

1 Dans la fenêtre Mix ou Edit, assurez-vous que 
l'affichage des inserts (A-E ou F-J) est visible.

2 Cliquez sur le sélecteur d'insert de la piste, puis 
sélectionnez le plug-in à utiliser. Reportez-vous 
à la section « Formats de plug-in » à la page 1035 
pour plus d'informations.

Pour supprimer un insert d'une piste :

 Cliquez sur le sélecteur d'insert, 
puis sélectionnez No Insert.

Ordre des plug-ins Native et DSP 
sur les pistes audio
(Systèmes Pro Tools|HDX uniquement)

Sur les systèmes Pro Tools|HDX, l'ordre d'insertion 
des plug-ins Native et DSP sur les pistes audio, 
d'entrée auxiliaire ou Master Fader a une incidence 
sur les résultats obtenus :

Plug-ins Native groupés avant les plug-ins DSP : 
dans cet ordre, aucune voix supplémentaire n'est 
utilisée et aucune latence de traitement n'est induite. 
Les plug-ins Native sont bypassés lorsque la piste 
est activée pour l'enregistrement ou lorsque le 
monitoring TrackInput est activé. 

Plug-ins Native groupés après les plug-ins DSP : 
chaque premier insert d'un plug-in Native situé après 
un plug-in DSP sur la piste générera une latence de 
traitement et utilisera des voix, comme décrit à la 
section « Utilisation des voix et latence totale pour 
les plug-ins Native (basés sur hôte) » à la page 1035. 
Les plug-ins Native restent activés lorsque la piste est 
activée pour l'enregistrement ou lorsque le 
monitoring TrackInput est activé. 

Recommandations pour l'ordre d'insertion

Pour insérer des plug-ins Native et DSP sur une 
piste audio, appliquez l'une des stratégies 
suivantes, en fonction de vos besoins :

• Pour vous assurer que les plug-ins Native restent 
activés lorsque vous activez une piste pour 
l'enregistrement ou passez en monitoring 
TrackInput, regroupez tous les plug-ins DSP 
avant les plug-ins Native.

• Pour économiser des voix et réduire la latence de 
traitement, groupez tous les plug-ins Native 
avant les plug-ins DSP.

Vous ne pouvez ni insérer, ni supprimer de 
plug-in en cours d'enregistrement.

Insertion d'un plug-in DSP

Vous pouvez insérer un plug-in sur une piste en 
glissant l'un de ses fichiers de paramètres (.txf) 
à partir d'un navigateur de l'espace de travail 
et en le déposant sur une position d'insert 
disponible dans la fenêtre Mix. Reportez-vous 
à la section « Glisser-déposer de fichiers 
de paramètres de plug-in » à la page 1052.

En règle générale, regroupez toujours les 
plug-ins du même type, particulièrement si 
des plug-ins Native sont insérés après des 
plug-ins DSP. Cela vous évitera d'utiliser des 
voix supplémentaires.
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Organisation des menus 
de plug-ins
Vous pouvez personnaliser le classement des listes 
(ou menus) de plug-ins dans le sélecteur d'insert et 
le sélecteur de plug-in. 

Utilisez le paramètre Organize Plug-in Menus 

By des préférences d'affichage pour organiser les 
menus de plug-ins en Flat List (les plug-ins sont 
classés par ordre alphabétique), ou par Category 
(catégorie), Manufacturer (fabricant) ou Category 

and Manufacturer (catégorie et fabricant). 

Prise en charge des surfaces de contrôle

Les surfaces de contrôle équipées d'écrans LCD 
multicolores (telles que la D-Control) affichent les 
plug-ins de la manière suivante :

• Les catégories de plug-ins (EQ par exemple) 
et les fabricants de plug-ins (Aphex par 
exemple) sont indiqués en jaune (ambre).

• Les plug-ins spécifiques placés dans le sous-
dossier d'un plug-in (le plug-in EQ III contenu 
dans le sous-dossier EQ par exemple) sont 
indiqués en vert.

Les surfaces de contrôle à affichage monochrome 
(comme Command|8) n'indiquent pas les choix 
d'affichage des plug-ins. Elles affichent le contenu 
d'un dossier de plug-in sous forme de liste simple.

Paramètre Organize Plug-In 
Menus By
Flat List : présente les plug-ins dans une liste 
simple triée par ordre alphabétique.

Category : affiche les plug-ins par catégorie 
de traitement (par exemple, EQ, Dynamics, Delay), 
chaque plug-in étant répertorié dans les sous-menus 
de catégorie. Les plug-ins qui ne correspondent pas 
à une catégorie standard (par exemple, Signal 

Generator) ou les plug-ins tiers dont la catégorie n'a 
pas été spécifiée par leurs développeurs figurent 
dans la catégorie Other. Certains plug-ins peuvent 
figurer dans plusieurs catégories. 

Les catégories de plug-ins sont les suivantes :

• EQ

• Dynamics

• Pitch Shift

• Reverb

• Delay

• Modulation

• Harmonic

• Noise Reduction

• Dither

• Sound Field

• Instrument

• Other

• Effects

Le sous-dossier Effects regroupe les effets spéciaux, 
les processeurs multi-effets et autres plug-ins. Tout 
plug-in dont la catégorie fait référence à un type d'effet 
s'affiche dans le sous-dossier Effects.

Manufacturer : affiche les plug-ins par fabricant, 
chaque plug-in étant répertorié dans les sous-
menus de fabricant. Les plug-ins n'appartenant 
à aucun fabricant en particulier s'affichent dans le 
dossier Other. 

Si aucun plug-in d'une catégorie donnée n'est 
installé sur votre système, le nom de cette 
catégorie ne s'affiche pas dans le menu.

Si aucun plug-in d'un fabricant donné n'est 
installé sur votre système, le nom 
correspondant à ce fabricant ne s'affiche 
pas dans le menu.
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Category and Manufacturer : permet de classer les 
plug-ins selon deux niveaux de menus. Les menus de 
la partie supérieure de la fenêtre affichent les plug-ins 
par catégorie de processus (EQ, Dynamics, Delay par 
exemple), chaque plug-in étant répertorié dans les 
sous-menus de catégorie. Les menus de la partie 
inférieure affichent les plug-ins par fabricant, avec 
chaque plug-in répertorié dans les sous-menus de 
fabricant.

Pour choisir le type de classement des plug-ins :

1 Ouvrez ou créez une session. 

2 Sélectionnez Setup > Preferences, puis cliquez 
sur Display.

3 Cliquez sur le menu Organize Plug-In Menus 
By et sélectionnez l'une des options d'affichage.

4 Cliquez sur OK.

Le paramètre Organize Plug-In Menus By est 
enregistré avec les préférences de Pro Tools 
(et non avec le fichier de session Pro Tools).

Plug-ins par défaut d'EQ et de 
traitement dynamique
Vous pouvez définir un plug-in EQ et un plug-in 
Dynamics par défaut, ce qui les place en haut du 
menu contextuel de sélection d'insert, et en 
première position dans la liste de choix de menu 
lors de l'affectation d'inserts sur des surfaces de 
travail ICON.

Pour définir un plug-in par défaut :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing. 

2 Sous Setup, sélectionnez un plug-in à partir du 
menu déroulant Default EQ ou Default 

Dynamics.

3 Cliquez sur OK pour fermer la fenêtre 
des préférences.

Plug-ins favoris
Vous pouvez désigner un plug-in en tant que favori 
pour y accéder plus rapidement. Les plug-ins favoris 
sont affichés en tête du menu des plug-ins. 

Le nom d'un plug-in favori est affiché en gras dans les 
sous-menus de plug-ins classés par catégorie.

Pour désigner un plug-in en tant que favori :

 Maintenez la touche Commande (Mac) 
ou Ctrl (Windows) enfoncée et cliquez sur 
le sélecteur d'insert, puis désignez un plug-in en 
tant que favori.

Pour modifier l'état d'un plug-in favori :

 Maintenez la touche Commande (Mac) 
ou Ctrl (Windows) enfoncée et cliquez sur 
le sélecteur d'insert, puis désignez le plug-in 
à retirer de la liste des favoris. 

Vous pouvez sélectionner ce plug-in favori dans la 
liste des favoris au-dessus du menu des plug-ins ou 
dans le sous-menu des plug-ins classés par 
catégorie. Dans ce dernier, le plug-in concerné 
apparaît en gras.

Plug-ins par défaut affichés dans le menu de sélection 
d'insert

Affichage du menu des plug-ins favoris

 

 

Plug-ins
favoris

Catégories
de plug-ins
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Déplacement et duplication 
d'inserts de plug-in 
et matériels
Pour déplacer ou dupliquer un insert, faites-
le glisser vers un autre emplacement de la piste 
ou vers une autre piste. Les inserts déplacés 
ou dupliqués conservent leurs paramètres 
et données d'automation d'origine.

Pour déplacer un insert :

 Faites glisser l'insert jusqu'à l'emplacement choisi.

Pour dupliquer un insert :

 Faites-le glisser vers l'emplacement choisi en 
appuyant sur la touche Alt (Windows) ou Option 
(Mac). Les inserts plug-in dupliqués conservent 
leurs paramètres d'origine et leur automation.

Fenêtres de plug-in
Une fenêtre de plug-in s'ouvre dès que vous 
cliquez sur un bouton d'insert de plug-in sur une 
piste. Cette fenêtre flottante permet d'ajuster les 
commandes de tout insert de plug-in en temps réel 
utilisé sur une piste.

Vous ne pouvez ni déplacer ni dupliquer les 
plug-ins en cours d'enregistrement.

Déplacement d'un plug-in

Pour remplacer un insert, ainsi que 
l'automation, faites glisser un autre insert 
sur celui-ci.

Vous pouvez également dupliquer les départs. 
Reportez-vous à la section « Déplacement ou 
copie de départs » à la page 1006.

Bouton et sélecteur d'insert sur une piste

Fenêtre de plug-in (EQ III 1 bande mono)

Bouton d'insert

Sélecteur d'insert

Bouton 
de ciblage

Bypass 
de l'effet

Protection de l'automation

Bouton Auto

Conversion 
du plug-in

Commandes 
d'assignation du plug-in

Commandes 
de piste

Commandes 
des presets
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Commandes de piste des 
fenêtres de plug-in

Sélecteur de piste : permet d'accéder à toutes les 
pistes de la session à l'exception des pistes MIDI, 
VCA et vidéo.

Sélecteur de position d'insert : permet d'accéder 
à n'importe quel insert de la piste actuelle.

Sélecteur de plug-in : permet de sélectionner 
n'importe quel plug-in temps réel installé dans le 
dossier Plug-Ins, créé lors de l'installation 
de Pro Tools.

Sélecteur de déclencheur : permet de sélectionner 
l'audio d'une entrée ou d'un bus spécifique et de le 
router pour déclencher le plug-in. Ce sélecteur 
n'apparaît que pour les plug-ins comprenant 
un circuit side-chain. Les déclencheurs 
sont monophoniques.

Affichage du nœud MIDI : affiche les informations 
relatives au nœud MIDI des plug-ins compatibles 
MIDI. Les nœuds MIDI sont des connexions 
virtuelles qui relient Pro Tools à des instruments 
logiciels et à d'autres plug-ins compatibles MIDI. 
Ils sont particulièrement utiles pour 
l'acheminement de pistes MIDI vers plusieurs 
canaux appartenant à un même périphérique MIDI 
virtuel. Les numéros des nœuds MIDI s'affichent 

également dans le sélecteur de sortie MIDI d'une 
piste. L'indicateur de nœud MIDI apparaît 
uniquement sur les plug-ins pouvant recevoir des 
données MIDI.

Commandes des presets des fenêtres 
de plug-in

Menu des paramètres du plug-in : ce menu permet 
de copier, coller, enregistrer et importer des 
paramètres de plug-in.

Menu de bibliothèque du plug-in : restaure les 
réglages prédéfinis du plug-in (fichiers 
de paramètres de plug-in enregistrés à la racine du 
dossier du plug-in ou dans le dossier Settings de la 
session actuelle). Reportez-vous à la section 
« Presets de plug-in » à la page 1048.

Boutons des paramètres suivant (+) et précédent (-) : 
permettent de sélectionner le fichier de presets 
précédent ou suivant dans le menu 
de bibliothèque.

Commandes de piste d'une fenêtre de plug-in

Sélecteur de déclencheur (Compressor/Limiter Dyn III)

Sélecteur de piste

Sélecteur de position d'insert

Sélecteur de plug-in

Indicateur d'affichage du nœud MIDI (Transfuser)

Commandes des presets d'une fenêtre de plug-in

Cette opération supprime les paramètres 
actuels si ceux-ci n'ont pas été enregistrés. 
Enregistrez toujours vos paramètres 
de plug-in en tant que preset à l'aide 
du menu de paramètres du plug-in.

Menu des paramètres du plug-in

Menu de bibliothèque du plug-in

Bouton Compare

Sélection de paramètres

Paramètre suivant

Paramètre précédent



Chapitre 44 : Inserts de plug-in et matériels 1043

Bouton de sélection de paramètres : permet 
d'accéder à la boîte de dialogue des paramètres du 
plug-in, qui affiche la liste des presets du plug-in 
sélectionné. Vous pouvez avoir un aperçu des 
presets et les sélectionner depuis cette liste.

Compare : bascule entre les paramètres d'origine du 
plug-in et leurs valeurs après modification, afin de 
comparer les effets obtenus.

Commandes d'automation des 
fenêtres de plug-in

Bouton Auto : active l'enregistrement 
d'automation sur les commandes individuelles des 
plug-ins. Reportez-vous à la section « Automation 
de plug-ins » à la page 1082.

Protection de l'automation : interdit l'effacement 
des playlists d'automation existantes du plug-in.

Commandes d'assignation des 
fenêtres de plug-in
(Surfaces de contrôle uniquement)

Lorsqu'une surface de contrôle compatible est 
déclarée dans Pro Tools, les commandes 
d'assignation de plug-in sont affichées dans les 
fenêtres de plug-in. 

Menu d'options d'assignation : permet de créer, 
renommer, enregistrer, supprimer, importer, 
exporter et définir les cartes d'assignation de plug-
in par défaut. 

Menu de presets d'assignation : permet 
de sélectionner une carte d'assignation de plug-in 
parmi les cartes d'assignation personnalisées 
disponibles pour le plug-in. 

Bouton Learn : permet de sélectionner le mode 
Learn pour le plug-in, dans lequel vous pouvez 
assigner les paramètres de plug-in à une surface 
de contrôle. 

Menu de paramètres : en mode Learn, permet 
de sélectionner un paramètre sur le plug-in pour 
l'assignation. Si vous cliquez sur un paramètre 
dans une fenêtre de plug-in en mode Learn, 
ce menu affiche le nom du paramètre. 

Commandes de plug-in 
supplémentaires des fenêtres 
de plug-in

Commandes d'automation d'une fenêtre de plug-in

Bouton Auto

Bouton de protection de l'automation

Commandes d'assignation de plug-in dans une 
fenêtre de plug-in

Commandes d'assignation de plug-in dans une 
fenêtre de plug-in

Menu d'options d'assignation

Menu de presets d'assignation

Bouton Learn

Menu de paramètres

Bouton Bypass du plug-in

Bouton de ciblage

Sélecteur de conversion du plug-in
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Bouton Bypass de l'effet : désactive le plug-in 
actuellement affiché. Vous pouvez ainsi comparer 
le résultat obtenu avec et sans l'effet.

Sélecteur de conversion de plug-in : permet 
de convertir le format du plug-in d'insert de DSP 
à Native, et vice versa. Cette fonctionnalité ne peut 
être utilisée que sur les plug-ins disponibles dans 
les deux formats.

Bouton Cible : lorsque plusieurs fenêtres de plug-
in sont ouvertes, cliquez sur ce bouton pour 
désigner le plug-in en tant que cible de toutes les 
commandes clavier.

Commandes multi-mono des 
fenêtres de plug-in

Bouton de liaison principal : lie les réglages 
de tous les canaux d'un plug-in multi-mono pour 
vous permettre de les régler par paire.

Boutons de liaison des canaux : permettent 
de lier ou dissocier sélectivement les commandes de 
canaux spécifiques d'un plug-in multi-mono. 
Chaque carré représente un canal de haut-parleur. 
Désactivez le bouton de liaison principale avant 
d'utiliser les boutons de liaison des canaux. 
Reportez-vous à la section « Liaison et 
dissociation des commandes des plug-ins multi-
mono » à la page 1060.

Sélecteur de canal : permet d'accéder à un canal 
spécifique d'une piste multicanal afin de régler ses 
commandes. Ce menu apparaît uniquement sur les 
plug-ins multi-mono insérés sur des pistes 

comprenant plusieurs canaux. Maintenez la touche 
Maj enfoncée et cliquez sur le sélecteur pour ouvrir 
une fenêtre de plug-in séparée pour chaque canal de 
la piste multicanal sur laquelle le plug-in est inséré.

Ouverture des fenêtres de 
plug-in
Pour ouvrir une fenêtre de plug-in :

 Cliquez sur le bouton du plug-in dans la vue 
Inserts de la fenêtre Mix ou Edit.

Par défaut, chaque nouvelle fenêtre de plug-in 
s'ouvre au même emplacement et vient remplacer 
la fenêtre de plug-in précédemment ouverte, le cas 
échéant. 

Ouverture de plusieurs fenêtres 
de plug-in
Pro Tools affiche généralement une seule fenêtre de 
plug-in dans laquelle vous pouvez ajuster les 
commandes de n'importe quel plug-in d'une 
session. Vous pouvez également ouvrir des 
fenêtres de plug-in supplémentaires. Lorsque vous 
travaillez avec plusieurs fenêtres de plug-in, 
cliquez sur le bouton de ciblage correspondant au 
plug-in dont vous voulez ajuster les commandes 
à l'aide du clavier.

Pour ouvrir une fenêtre de plug-in supplémentaire :

 Dans la fenêtre Mix, maintenez la touche Maj 
enfoncée, puis cliquez sur le bouton d'insert 
d'un plug-in. La nouvelle fenêtre de plug-in 
s'ouvre, et n'est pas ciblée.

Pour ouvrir une fenêtre de plug-in pour chaque 
canal d'un plug-in multi-mono :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le sélecteur de 
canal de la fenêtre d'un insert de plug-in. 

Fenêtre de plug-in (EQ 1 bande multi-mono)

Sélecteur de canal

Boutons de liaison des canaux

Bouton de liaison principal
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Pour fermer toutes les fenêtres de plug-in ouvertes :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton 
de fermeture de l'une des fenêtres de plug-in 
ouvertes. 

Utilisation des commandes 
des fenêtres de plug-in
Tous les plug-ins disposent de commandes 
standard de Pro Tools pour la sélection, le bypass 
et d'autres opérations agissant sur les pistes 
et inserts, en plus des commandes spécifiques 
à chaque effet : EQ, traitement dynamique, etc. 

Pour sélectionner un autre plug-in sur la même 
piste :

 Cliquez sur le sélecteur d'insert, puis 
sélectionnez un autre plug-in dans le menu 
déroulant.

Pour choisir une autre piste :

 Cliquez sur le sélecteur de piste, puis sélectionnez 
une piste dans le menu déroulant.

Fenêtre cible et raccourcis de paramètres

Lorsque plusieurs fenêtres de plug-in sont ouvertes, 
la fenêtre ciblée est indiquée par le bouton de cible 
mis en surbrillance. Une seule fenêtre de plug-in peut 
être ciblée dans Pro Tools. Lorsque vous ouvrez un 
nouveau plug-in, sa fenêtre s'ouvre au même 
emplacement et est automatiquement ciblée. De plus, 
les raccourcis clavier d'ajustement des paramètres des 
plug-ins s'appliquent à la fenêtre de plug-in ciblée. 

Ajustement des commandes 
de plug-in
Pour ajuster une commande de plug-in, déplacez son 
curseur ou son bouton, ou saisissez une valeur dans 
la zone de texte associée. Pour obtenir des 
informations à propos du réglage de plug-ins 
spécifiques, consultez la documentation du plug-in.

Pour ajuster une commande de plug-in :

1 Lancez la lecture audio afin d'entendre en temps 
réel les réglages apportés à la commande.

2 Ajustez les commandes du plug-in pour obtenir 
l'effet souhaité.

3 Lorsque vous refermez la fenêtre du plug-in, 
les modifications les plus récentes 
sont enregistrées.

Ajustement des paramètres des 
plug-ins à l'aide de la souris
Vous pouvez ajuster les commandes rotatives 
en faisant glisser la souris horizontalement 
ou verticalement. La valeur des paramètres 
augmente lorsque vous faites glisser la souris vers 
le haut ou la droite, et diminue lorsque vous la 
faites glisser vers le bas ou la gauche.

Raccourcis clavier

 Pour affiner les réglages, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée et 
faites glisser la commande.

 Pour restaurer la valeur par défaut d'une 
commande, maintenez la touche Alt (Windows) 
ou Option (Mac) enfoncée et cliquez sur 
la commande.

Pour plus d'informations sur les commandes 
spécifiques de chaque plug-in (installé avec 
Pro Tools), reportez-vous au Guide des plug-ins 
audio. Des plug-ins gratuits supplémentaires 
(et d'autres payants) pouvant être installés avec 
Pro Tools sont également répertoriés dans le 
Guide des plug-ins audio.



Guide de référence Pro Tools1046

Ajustement des paramètres des 
plug-ins à l'aide du clavier
Vous pouvez ajuster les commandes d'un plug-in 
à partir de votre clavier.

Si plusieurs fenêtres de plug-in sont ouvertes, 
la touche Tab et les valeurs entrées au clavier 
s'appliquent uniquement au plug-in ciblé.

Pour ajuster la valeur d'une commande à l'aide 
du clavier :

1 Pour activer le champ, cliquez ou naviguez dans la 
zone de texte de la commande à ajuster. 

2 Modifiez la valeur en effectuant l'une des 
opérations suivantes :

• Pour augmenter une valeur, appuyez sur 
la touche Flèche haut du clavier. 

• Pour diminuer une valeur, appuyez sur la touche 
Flèche bas du clavier.

• Saisissez la valeur.

3 Pour confirmer la valeur, effectuez l'une des 
opérations suivantes :

• Appuyez sur la touche Entrée du pavé numérique 
pour saisir la valeur et rester en mode d'édition au 
clavier.

• Pour valider la saisie et quitter le mode d'édition au 
clavier, appuyez sur la touche Retour (Mac) ou 
Entrée (Windows) du clavier alphanumérique.

Pour supprimer toutes les indications d'écrêtage 
de la session, y compris l'écrêtage du plug-in :

 Appuyez sur Alt+C (Windows) ou Option+C 
(Mac).

Modes d'automation et de 
protection des plug-ins
Tous les plug-ins en temps réel peuvent être 
entièrement automatisés et prennent en charge tous 
les modes d'automation de Pro Tools 
(Write, Touch, Latch et Trim). 

Le bouton Auto ouvre la boîte de dialogue Plug-In 
Automation, qui permet d'activer des paramètres 
individuels du plug-in pour l'enregistrement 
d'automation (reportez-vous à la section 
« Automation de plug-ins » à la page 1082).

Le bouton Safe active le mode de protection 
de l'automation. Lorsqu'il est activé, l'automation de 
plug-in existante est protégée contre l'écrasement 
(reportez-vous à la section « Protection contre 
l'enregistrement de l'automation de plug-in » 
à la page 1084).

Les raccourcis clavier agissant sur les paramètres 
de plug-in s'appliquent également à la fenêtre de 
plug-in ciblée. Pour définir un plug-in comme 
cible des commandes clavier (y compris des 
raccourcis), cliquez sur le bouton Cible dans la 
fenêtre du plug-in.

Pour vous déplacer d'un champ 
de commande au suivant, appuyez sur la 
touche Tab. Pour revenir sur le paramètre 
précédent, appuyez sur Maj+Tab.

Dans les champs prenant en charge les 
valeurs en kilohertz, les valeurs sont 
multipliées par 1 000 lorsque vous saisissez 
la lettre « k » après la valeur numérique. 
Pour entrer 8 000 par exemple, il suffit 
de saisir « 8k ».
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Entrée side-chain
L'entrée side-chain est le signal dérivé utilisé par 
le détecteur d'un plug-in pour déclencher le 
traitement dynamique. Ce signal est généralement 
récupéré en interne à partir du signal d'entrée. 
Toutefois, certains plug-ins permettent de choisir 
entre un traitement side-chain interne ou externe.

Dans le cas d'un traitement side-chain externe, 
le détecteur du plug-in est déclenché par un signal 
externe (une source audio ou une piste de référence 
distincte, par exemple) aussi appelé déclencheur.

Le traitement side-chain externe sert généralement 
à contrôler la dynamique d'un signal audio en 
se basant sur la dynamique d'un autre signal 
(le déclencheur). Une piste de grosse caisse, par 
exemple, peut servir à déclencher un noise gate sur 
une piste de basse pour plus de compacité, ou une 
piste de guitare rythmique peut contrôler le gate 
d'une nappe de clavier.

Filtres side-chain

Certains plug-ins disposent de filtres passe-haut et 
passe-bas pour le déclencheur. Ces commandes 
permettent de définir une gamme de fréquences du 
signal side-chain qui servira au déclenchement de 
l'effet du plug-in. Une astuce de production assez 
courante consiste à se servir de ces filtres pour, 
à partir d'une piste de batterie, activer le 
déclenchement uniquement à partir des sons aigus 
(charley par exemple) ou graves (tom ou grosse 
caisse par exemple).

Utilisation d'un déclencheur 
pour un traitement side-chain 
externe

Pour utiliser un déclencheur pour un traitement 
side-chain externe :

1 Cliquez sur le sélecteur de déclencheur 
et sélectionnez l'entrée ou le bus audio à utiliser 
pour déclencher le plug-in.

2 Pour activer le traitement side-chain externe, 
cliquez sur External Key.

3 Appuyez sur la barre d'espace pour lancer la lecture. 
Le plug-in utilise l'entrée ou le bus que vous avez 
choisi(e) comme déclencheur de l'effet.

4 Pendant la lecture, réglez le déclencheur 
de l'une des manières suivantes :

• Pour entendre la source audio sélectionnée afin de 
contrôler le déclencheur, cliquez sur le bouton 
Side-Chain Listen ou Key Listen (selon le plug-in). 
Une fois le réglage effectué, désactivez les boutons 
Side-Chain Listen ou Key Listen pour revenir au 
monitoring normal du plug-in.

• Pour filtrer le déclencheur de manière à ne 
déclencher le plug-in qu'en fonction de certaines 
fréquences, définissez la gamme de fréquences 
souhaitée à l'aide des commandes de filtrage, le cas 
échéant.

5 Au besoin, réglez également le seuil 
de déclenchement à l'aide de la commande 
Threshold (seuil) du plug-in (si disponible) 
et d'autres commandes.

Sélection d'un déclencheur
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Presets de plug-in
Pro Tools permet de créer facilement une 
bibliothèque de paramètres de plug-ins, ou presets. 
À partir du menu de paramètres du plug-in, vous 
pouvez copier, coller, enregistrer et importer ces 
paramètres d'un plug-in à un autre ou d'une session 
à une autre.

Une fois vos fichiers de paramètres créés et 
enregistrés sur le disque (et après avoir indiqué 
à Pro Tools l'emplacement de leur dossier racine), 
ils apparaissent dans le menu de bibliothèque de 
plug-in et dans la boîte de dialogue des paramètres 
du plug-in. Ils apparaissent également dans les 
navigateurs de l'espace de travail sous la forme de 
fichiers de paramètres de plug-in (.txf).

Menu de paramètres de plug-in
Utilisez les commandes du menu de paramètres 
de plug-in pour enregistrer, copier, coller et gérer les 
paramètres des plug-ins sous la forme de presets 
(fichiers de paramètres de plug-ins).

Les commandes du menu de paramètres de plug-in 
sont les suivantes :

Save Settings : enregistre les paramètres actuels. 
Cette commande remplace toute version précédente 
du preset.

Save Settings As : enregistre les paramètres 
actuels dans un nouveau preset, sous un 
nom différent.

Copy Settings : copie les paramètres actuels 
du plug-in. Vous pouvez ensuite les appliquer 
à un plug-in du même type sur une autre piste en 
sélectionnant la piste dans la fenêtre de plug-in et 
en collant les paramètres à l'aide de la commande 
Paste Settings.

Paste Settings : colle les paramètres de plug-in 
copiés à l'aide de la commande Copy Settings.

Import Settings : importe un fichier de paramètres 
de plug-in (.tfx) stocké dans un autre emplacement 
que le dossier racine des paramètres ou celui de la 
session. 

Delete Current Settings File : supprime de façon 
définitive le fichier de paramètres de plug-in (.tfx) 
actuel du disque.

Lock Settings File : empêche l'écrasement 
du preset actuel via la commande Save. Pour 
enregistrer des modifications apportées à des 
paramètres de plug-in, vous devez alors utiliser un 
nom ou un emplacement différent.

Set As User Default : définit le preset actuel 
comme preset personnalisé par défaut du plug-in 
sélectionné.

Vous pouvez utiliser la boîte de dialogue des 
paramètres du plug-in pour sélectionner des 
paramètres et écouter un aperçu de leur effet 
(reportez-vous à la section « Boîte de 
dialogue des paramètres de plug-in » 
à la page 1051).

Menu de paramètres de plug-in
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Settings Preferences
Le sous-menu Settings Preferences fournit 
des commandes permettant de configurer les 
préférences d'enregistrement et d'importation des 
presets. Ces commandes sont les suivantes :

Set Plug-In Default To : définit le preset par défaut 
sur Factory Default (paramètres par défaut standard 
du plug-in) ou User Default (vos paramètres 
personnalisés).

Save Plug-In Settings To : sélectionne le dossier 
dans lequel les presets (fichiers de paramètres 
de plug-in) sont enregistrés. Si vous sélectionnez 
Session Folder, les paramètres sont enregistrés dans 
un dossier nommé Plug-In Settings dans le dossier 
de la session actuelle. Si vous sélectionnez Root 

Settings Folder, les paramètres sont enregistrés dans 
le dossier spécifié à l'aide de la commande Set 

Root Settings Folder. Vous pouvez modifier 
l'emplacement du dossier Root Settings dans les 
préférences de fonctionnement (reportez-vous à la 
section « Section User Library » à la page 110).

Sélection d'une destination pour 
les paramètres
Avant d'enregistrer des paramètres de plug-in, 
sélectionnez leur dossier de destination.

Pour sélectionner un dossier de destination : 

 Dans le menu des paramètres de plug-in, 
sélectionnez Settings Preferences > Save Plug-

In Settings To, puis Session Folder ou Root 

Settings Folder.

Si vous sélectionnez Root Settings Folder, Pro Tools 
enregistre les données dans le dossier racine des 
paramètres de plug-in, à moins que vous n'ayez 
spécifié un emplacement différent pour ce dossier.

Pour sélectionner un autre dossier racine pour les 
paramètres de plug-in :

1 Dans le menu des paramètres de plug-in, 
sélectionnez Settings Preferences > Set Root 

Settings Folder.

2 Sélectionnez le dossier à utiliser comme dossier 
racine et cliquez sur Select. 

Création de sous-dossiers 
de paramètres
Pour simplifier la recherche de paramètres 
spécifiques, vous pouvez séparer les fichiers 
de paramètres en créant des sous-dossiers.

Pour créer un sous-dossier de paramètres :

1 Dans le menu des paramètres de plug-in, 
sélectionnez Save Settings.

2 Cliquez sur le bouton New Folder et attribuez un 
nom au sous-dossier.

3 Attribuez un nom au preset et cliquez sur Save. 
Le fichier de paramètres de plug-in est 
enregistré dans le sous-dossier. 

Gestion des presets
Utilisez le menu des paramètres de plug-in pour 
gérer les presets des plug-ins.

Pour enregistrer les paramètres de plug-in 
à un emplacement autre que le dossier Plug-In 
Settings, créez d'abord un dossier appelé Plug-
In Settings au nouvel emplacement, puis 
enregistrez vos données dans ce dossier.

Le paramétrage des plug-ins multi-mono non 
liés répond à des règles spécifiques. 
Reportez-vous à la section « Liaison et 
dissociation des commandes des plug-ins 
multi-mono » à la page 1060.
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Pour enregistrer un preset : 

1 Sélectionnez Save Settings dans le menu des 
paramètres de plug-in.

2 Saisissez un nom et cliquez sur OK. Le preset 
apparaît dans le menu de bibliothèque du plug-in.

Pour charger un preset de plug-in :

 Sélectionnez le nom du preset dans le menu de 
bibliothèque du plug-in.

Pour importer un preset : 

1 Dans le menu des paramètres de plug-in, 
sélectionnez Import Settings.

2 Recherchez le fichier de paramètres que vous 
souhaitez importer, puis cliquez sur Open. 
Pro Tools charge les paramètres et les copie 
dans le dossier de destination racine.

Pour copier des paramètres de plug-in : 

 Dans le menu des paramètres de plug-in, 
sélectionnez Copy Settings.

Pour coller des paramètres de plug-in : 

1 Ouvrez le plug-in de destination.

2 Dans le menu des paramètres de plug-in, 
sélectionnez Paste Settings.

Pour créer un preset utilisateur par défaut 
personnalisé :

1 Créez et enregistrez un fichier de paramètres de 
plug-in.

2 Sélectionnez Set As User Default dans le menu 
des paramètres de plug-in. 

Pour définir votre preset personnalisé comme 
preset par défaut du plug-in : 

 Dans le menu de paramètres du plug-in, 
sélectionnez Settings Preferences > Set Plug-In 

Default To > User Setting.

Changement de preset à l'aide 
des boutons de paramètre 
précédent (–) et suivant (+)
Ces boutons permettent de sélectionner les presets 
précédents ou suivants dans le menu 
de bibliothèque du plug-in.

Pour changer de preset à l'aide des boutons +/- :

 Cliquez sur le bouton plus (+) ou moins (-) pour 
sélectionner respectivement le preset de plug-in 
précédent ou suivant. Le preset suivant 
(ou précédent) est activé et le menu de bibliothèque 
du plug-in affiche le nom du nouveau preset.

Modification de paramètres sur 
les plug-ins multi-mono non liés
Lorsqu'un plug-in multi-mono n'est pas lié, 
l'importation, la copie, le collage ou le bypass 
de paramètres n'agit que sur le canal sélectionné.

Appuyez sur Ctrl+Maj+S (Windows) 
ou Commande+Maj+S (Mac) pour 
enregistrer les paramètres de plug-in.

Appuyez sur Ctrl+Maj+C (Windows) 
ou Commande+Maj+C (Mac) pour copier les 
paramètres de plug-in.

Appuyez sur Ctrl+Maj+V (Windows) 
ou Commande+Maj+V (Mac) pour coller les 
paramètres de plug-in.

Vous perdrez les paramètres de plug-in 
actuels s'ils n'ont pas été enregistrés avant 
d'utiliser les boutons de preset suivant 
et précédent. Enregistrez toujours vos 
paramètres de plug-in dans le dossier racine 
sélectionné.
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Boîte de dialogue des 
paramètres de plug-in
La boîte de dialogue des paramètres de plug-in 
affiche la liste des presets du type de plug-in actuel. 
Depuis cette liste, vous pouvez sélectionner et 
écouter des presets.

Utilisez le menu Folder en haut de la boîte 
de dialogue des paramètres de plug-in pour passer 
d'un sous-dossier de paramètres de plug-in à un 
autre, ou d'un dossier racine à un dossier de 
paramètres de session.

La boîte de dialogue de paramètres de plug-in 
inclut les éléments suivants :

Folder : ce menu déroulant permet d'alterner entre 
les presets stockés dans les dossiers racine ou de 
session (et les sous-dossiers éventuels).

Patch : ce champ indique le nom du preset actuel, 
mis en surbrillance dans la liste.

Increment Patch Every X Sec : cette option 
permet d'écouter les presets de plug-in les uns à la 
suite des autres, en les parcourant pendant une 
durée spécifique, exprimée en secondes.

Pour changer de preset de plug-in à l'aide de la 
boîte de dialogue des paramètres de plug-in :

1 Cliquez sur le bouton de sélection de paramètres.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez un preset dans la liste de la boîte de 
dialogue.

• À l'aide des touches fléchées, parcourez la liste 
des presets. 

3 Cliquez sur Done.

Aperçu des presets de plug-in
Lorsque la boîte de dialogue des paramètres 
de plug-in est ouverte, Pro Tools peut parcourir 
automatiquement la liste des presets et lire 
un aperçu des fichiers de paramètres de plug-in 
enregistrés dans le dossier racine ou de paramètres 
de la session actuelle.

Pour écouter l'aperçu de presets de plug-in :

1 Cliquez sur le bouton de sélection de paramètres.

2 Dans la liste de la boîte de dialogue, cliquez sur 
un preset pour le désigner comme premier 
fichier de paramètres pour l'aperçu.

3 Entrez le nombre de secondes souhaité entre 
chaque changement de preset.

4 Sélectionnez l'option Increment Setting.

Une fois la durée spécifiée écoulée, Pro Tools 
passe au preset suivant. 

5 Après avoir écouté l'aperçu des presets qui vous 
intéressent, effectuez l'une des opérations 
suivantes :

Boîte de dialogue des paramètres de plug-in

Pour alterner entre les sous-dossiers 
de paramètres de plug-in, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
et utilisez la touche Flèche haut ou bas.
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• Cliquez sur Done pour arrêter l'aperçu des 
presets et fermer la boîte de dialogue des 
paramètres de plug-in.

• Désélectionnez l'option Increment Patch pour 
arrêter l'aperçu des presets et garder la boîte de 
dialogue des paramètres de plug-in ouverte. 
Sélectionnez ensuite le preset de votre choix 
et cliquez sur Done.

Espace de travail et fichiers 
de paramètres de plug-in
Les navigateurs de l'espace de travail reconnaissent les 
fichiers de paramètres de plug-in (.txf). Vous pouvez 
donc les faire glisser directement vers les inserts et 
fenêtres de plug-in de Pro Tools. Vous pouvez 
également rechercher des paramètres de plug-in selon 
leur type.

Recherche de fichiers 
de paramètres de plug-in

Pour rechercher des fichiers de paramètres 
de plug-in :

1 Dans le navigateur de l'espace de travail, 
cliquez sur l'icône de recherche avancée.

2 Pour le critère de recherche, sélectionnez Kind > 

Is > Plug-In Settings File.

3 Pour affiner votre recherche, définissez des 
critères supplémentaires.

Glisser-déposer de fichiers 
de paramètres de plug-in
Vous pouvez insérer un plug-in avec un fichier 
de paramètres de plug-in spécifique, ou modifier les 
paramètres des plug-ins déjà insérés en faisant 
glisser des fichiers de paramètres à partir d'un 
navigateur de l'espace de travail.

Pour insérer un plug-in par glisser-déposer :

 Faites glisser un fichier de paramètres depuis un 
navigateur de l'espace de travail, vers un insert 
de la fenêtre Mix ou Edit.

Recherche de fichiers de paramètres de plug-in

Vous pouvez créer des catalogues de paramètres 
de plug-in fréquemment utilisés pour optimiser 
votre workflow. Pour plus d'informations sur les 
catalogues, reportez-vous à la section 
« Catalogues » à la page 320.

Fichier de paramètres de plug-in déplacé vers un insert



Chapitre 44 : Inserts de plug-in et matériels 1053

Pour changer un preset de plug-in par 
glisser-déposer :

 Faites glisser un fichier de paramètres de plug-in 
depuis un navigateur de l'espace de travail, vers 
la fenêtre du plug-in. Le fichier de paramètres de 
plug-in doit être destiné au plug-in du même 
nom. Par exemple, vous ne pouvez pas déposer 
un fichier de paramètres destiné au plug-in EQ 3 
4 bandes sur le plug-in EQ 3 1 bande.

Sélection de presets de plug-in 
depuis le sélecteur de plug-in
Pro Tools permet de sélectionner des paramètres 
de plug-in depuis le sous-menu User Presets du 
menu contextuel des inserts.

Pour sélectionner un paramètre de plug-in pour un 
insert dans la fenêtre Mix ou Edit :

1 Dans la fenêtre Mix ou Edit avec la vue Inserts 
activée, effectuez un clic droit sur l'insert 
du plug-in.

2 Dans le sous-menu User Presets, sélectionnez 
le paramètre de plug-in souhaité.

Mappage des plug-ins
(Surfaces de contrôle uniquement)

Pro Tools permet de personnaliser la disposition des 
commandes des paramètres des plug-ins sur les 
surfaces de contrôle prises en charge. Vous pouvez 
enregistrer ces cartes d'assignation de plug-in 
personnalisées en tant que presets et les exporter 
pour les utiliser sur différents systèmes et sessions. 
Les cartes d'assignation de plug-in sont stockées 
dans le dossier Plug-In Maps situé dans le dossier 
Root Settings de Pro Tools. Vous pouvez modifier 
l'emplacement du dossier Root Settings dans les 
préférences de fonctionnement (reportez-vous à la 
section « Section User Library » à la page 110).

Mode Learn des plug-ins

Vous pouvez mettre les plug-ins en mode Learn, 
dans lequel tout paramètre de plug-in pouvant être 
automatisé peut être assigné à un encodeur de 
tranche, un commutateur ou un fader (en mode 
Flip) de la surface de contrôle. 

Presets de carte d'assignation de plug-in

Vous pouvez enregistrer une carte d'assignation de 
plug-in et la rappeler pour tout plug-in du même 
type. 

Vous pouvez enregistrer plusieurs presets de carte 
d'assignation pour un même plug-in, et alterner 
entre les cartes d'assignation à tout moment en 
cours de session. 

Fichier de paramètres de plug-in déplacé vers un plug-in

Menu contextuel des inserts dans la fenêtre Mix
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Vous pouvez également utiliser plusieurs presets 
de carte d'assignation sur différentes instances d'un 
même plug-in. Cela peut s'avérer utile pour les 
instruments virtuels disposant de plusieurs 
configurations ou pour les procédures multi-
utilisateurs sur de vastes systèmes.

Vous pouvez définir une carte d'assignation 
personnalisée par défaut pour un plug-in, afin 
qu'elle soit appliquée automatiquement à toutes les 
instances de ce plug-in.

Fichiers de carte d'assignation de plug-in

Vous pouvez exporter les cartes d'assignation 
de plug-in (en tant que fichiers .pim) pour les 
utiliser dans d'autres sessions et sur d'autres 
systèmes disposant du même type de surface 
de contrôle (surfaces 8 faders, 24 faders ou ICON).

Mappage des surfaces de contrôle

Lorsque vous créez une carte d'assignation 
de plug-in personnalisée, ses paramètres sont 
organisés par pages qui correspondent aux 
commandes de la surface de contrôle. La taille 
d'une page dépend du type de surface de contrôle. 
Chaque carte d'assignation de plug-in 
personnalisée peut stocker jusqu'à 200 pages 
de paramètres mappés.

Les assignations de plug-in sont enregistrées selon 
les types de surfaces de contrôle suivants :

• 003

• C|24

• Command|8

• D-Control

• D-Command

• Contrôleurs compatibles EUCON

• Contrôleurs M-Audio

Commandes d'assignation des 
plug-ins
Lorsqu'une surface de contrôle compatible est 
déclarée dans Pro Tools, les commandes 
d'assignation sont affichées dans les fenêtres 
des plug-ins. 

Menu d'options d'assignation : permet de créer, 
renommer, enregistrer, supprimer, importer, 
exporter et définir les cartes d'assignation de plug-
in par défaut. 

Menu de presets d'assignation : permet de 
sélectionner une carte d'assignation de plug-in 
parmi les cartes d'assignation personnalisées 
disponibles pour le plug-in. 

Bouton Learn : permet d'activer le mode Learn 
pour le plug-in, dans lequel vous pouvez assigner 
ses paramètres à une surface de contrôle. 

Menu de paramètres : en mode Learn, permet 
de sélectionner un paramètre du plug-in à assigner. 
Si vous cliquez sur un paramètre dans une fenêtre 
de plug-in en mode Learn, ce menu affiche le nom 
du paramètre. 

Vous pouvez afficher ou masquer les commandes 
d'assignation de plug-in.

Si vous importez une carte d'assignation 
de plug-in créée sur un autre type de surface 
de contrôle, elle apparaît comme un choix 
inactif dans le menu des presets de carte 
d'assignation.

Commandes d'assignation dans une fenêtre de plug-in

Menu d'options d'assignation

Menu de presets d'assignation

Bouton Learn

Menu de paramètres
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Pour afficher (ou masquer) les commandes 
d'assignation de plug-in :

 Sélectionnez (ou désélectionnez) View > 

Plug-In > Map Controls.

Création de cartes d'assignation 
de plug-in
Cette section aborde la création de cartes 
d'assignation de plug-in sur les surfaces 
de contrôle suivantes :

• C|24

• 003

• Command|8

Activation du mode Learn pour un plug-in

La première fois qu'un plug-in passe en mode 
Learn, une carte d'assignation est créée 
(avec le nom par défaut de « Custom Map ») et le 
plug-in est mis en focus sur la surface de contrôle, 
avec une page de commandes vierge, prête pour 
l'assignation.

Un seul plug-in peut être en mode Learn au même 
moment.

Pour activer le mode Learn sur un plug-in, 
effectuez l'une des opérations suivantes :

 Cliquez sur le bouton Learn de la fenêtre 
du plug-in.

 Dans le menu des options d'assignation, 
sélectionnez New Map.

Pour désactiver le mode Learn sur un plug-in, 
effectuez l'une des opérations suivantes :

 Cliquez sur le bouton Learn actif de la fenêtre 
du plug-in. 

 Fermez la fenêtre du plug-in.

 Cliquez sur le bouton Learn d'une autre fenêtre 
de plug-in. 

Création et modification des 
cartes d'assignation de plug-in

Pour créer une carte d'assignation de plug-in 
personnalisée :

1 Ouvrez le plug-in dont vous voulez 
personnaliser les assignations. 

2 Activez le mode Learn. Le plug-in est sélectionné 
sur la surface de contrôle, mais avec une page de 
commandes vide, prête pour l'assignation. 

3 Dans la fenêtre du plug-in, cliquez sur 
le paramètre à assigner. Le nom du paramètre 
apparaît dans le menu des paramètres. 

4 Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Tournez l'encodeur ou appuyez sur 
le commutateur de sélection de canal sur lequel 
vous voulez assigner le paramètre. 

• Si la surface de contrôle est en mode Flip, déplacez 
le fader ou appuyez sur le commutateur de sélection 
de canal sur lequel vous voulez assigner le 
paramètre. 

5 Répétez les étapes 3 à 4 pour chaque paramètre 
à assigner. 

6 Désactivez le mode Learn.

Pour modifier l'assignation d'un paramètre d'une 
carte d'assignation de plug-in :

1 Ouvrez le plug-in dont vous voulez modifier la 
carte d'assignation personnalisée.

2 Sélectionnez la carte d'assignation à modifier 
dans le menu des presets d'assignation. 

Pour plus de détails sur l'assignation des plug-ins 
sur une D-Control ou une D-Command, 
reportez-vous aux Guides de la D-Control et de 
la D-Command.

Le mode Learn est automatiquement désactivé 
lorsqu'un plug-in est déplacé vers une position 
d'insert différente, lorsqu'il est désactivé 
ou converti entre les formats DSP et Native.
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3 Activez le mode Learn. Le plug-in est 
sélectionné sur la surface de contrôle.

4 Procédez comme suit pour chaque assignation 
de paramètre à modifier :

• Dans la fenêtre du plug-in, cliquez sur 
le nouveau paramètre de plug-in à assigner. 
Le nom du paramètre apparaît dans le menu des 
paramètres.

• Sur la surface de contrôle, parcourez les pages jusqu'à 
l'encodeur ou au commutateur pour lequel vous 
souhaitez modifier l'assignation, puis tournez 
l'encodeur ou appuyez sur le commutateur.

5 Désactivez le mode Learn.

Pour supprimer l'assignation d'un paramètre 
d'une carte d'assignation de plug-in :

1 Ouvrez le plug-in dont vous voulez modifier la 
carte d'assignation personnalisée.

2 Sélectionnez la carte d'assignation à modifier 
dans le menu des presets d'assignation. 

3 Activez le mode Learn. Le plug-in est 
sélectionné sur la surface de contrôle.

4 Procédez comme suit pour chaque assignation 
de paramètre à supprimer :

• Assurez-vous que No Control est affiché sur 
le menu des paramètres. 

• Sur la surface de contrôle, parcourez les pages 
jusqu'à l'encodeur ou au commutateur pour 
lequel vous souhaitez supprimer l'assignation, 
puis tournez l'encodeur ou appuyez sur le 
commutateur.

5 Désactivez le mode Learn.

Enregistrement de cartes 
d'assignation de plug-in
Vous pouvez enregistrer des cartes d'assignation 
de plug-in en tant que presets afin de les réutiliser 
ultérieurement sur le même système Pro Tools. 

Les cartes d'assignation de plug-in sont enregistrées 
comme des préférences générales sur un système 
Pro Tools, et sont donc disponibles pour toutes les 
sessions créées sur le système. 

Lorsque vous créez une carte d'assignation de plug-
in, elle devient disponible pour tous les autres plug-
ins du même type et format de canal. 

Vous pouvez également exporter des cartes 
d'assignation de plug-in afin de les utiliser sur 
d'autres systèmes Pro Tools disposant d'une surface 
de contrôle similaire (reportez-vous à la section 
« Exportation et importation de cartes d'assignation 
de plug-in » à la page 1058.

Pour enregistrer une copie d'une carte 
d'assignation de plug-in personnalisée :

1 Ouvrez le plug-in dont vous voulez copier 
la carte d'assignation.

2 Sélectionnez la carte d'assignation à copier dans 
le menu des presets d'assignation. 

3 Sélectionnez Save Map As dans le menu des 
options d'assignation. 

4 Saisissez le nom de la carte d'assignation 
de plug-in.

5 Cliquez sur OK. La nouvelle copie devient la 
carte d'assignation de plug-in active.

Pour assigner le même plug-in à différents 
formats de canaux (mono, stéréo et surround 
5.1), vous devez créer une carte d'assignation de 
plug-in distincte pour chaque format.
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Pour renommer une carte d'assignation de plug-in 
personnalisée :

1 Ouvrez le plug-in dont vous souhaitez modifier 
le nom de la carte d'assignation.

2 Sélectionnez la carte d'assignation à renommer 
dans le menu des presets d'assignation. 

3 Sélectionnez Rename Map dans le menu des 
options d'assignation. 

4 Saisissez le nouveau nom de la carte 
d'assignation de plug-in.

5 Cliquez sur OK.

Suppression de cartes 
d'assignation de plug-in
Vous pouvez supprimer des cartes d'assignation 
de plug-in individuelles à partir des fenêtres 
de plug-in. 

Vous pouvez également supprimer toutes les 
cartes d'assignation de plug-in personnalisées du 
système et restaurer les cartes d'assignation par 
défaut.

Pour supprimer une carte d'assignation de plug-in 
personnalisée :

1 Ouvrez le plug-in dont vous souhaitez 
supprimer la carte d'assignation.

2 Sélectionnez la carte d'assignation à supprimer 
dans le menu des presets d'assignation. 

3 Sélectionnez Delete Current Map dans le menu 
des options d'assignation.

4 Cliquez sur Delete.

Pour supprimer toutes les cartes d'assignation 
de plug-in du système :

1 Ouvrez un plug-in de la session. 

2 Sélectionnez Delete All Maps dans le menu des 
options d'assignation.

3 Cliquez sur Delete.

Définition d'une carte 
d'assignation de plug-in 
personnalisée en tant que carte 
d'assignation par défaut
Vous pouvez définir une carte d'assignation 
de plug-in personnalisée en tant que carte 
d'assignation par défaut pour un plug-in, au lieu 
de la carte d'assignation par défaut d'origine.

Lorsque vous définissez une carte d'assignation 
de plug-in personnalisée en tant que carte 
d'assignation par défaut, elle s'applique à l'ensemble 
de la session. Toutes les instances de ce plug-in qui 
utilisaient la carte d'assignation par défaut d'origine, 
ou une autre carte d'assignation personnalisée, 
utilisent désormais la nouvelle carte par défaut.

Si vous modifiez l'assignation d'un paramètre dans la 
carte d'assignation de plug-in personnalisée définie 
comme valeur par défaut, cette modification est 
répercutée sur toutes les instances de plug-in qui 
utilisent la carte par défaut.

Sur les systèmes D-Control et D-Command, 
lorsque vous supprimez toutes les cartes 
d'assignation de plug-in, vous supprimez 
également les assignations de plug-in des 
Custom Faders.

Lorsque vous exportez une carte d'assignation 
de plug-in, la carte par défaut sélectionnée pour 
ce plug-in est également exportée. Lorsque cette 
carte d'assignation est importée, la carte par 
défaut est également mise à jour et toutes les 
instances du plug-in adoptent la nouvelle carte 
par défaut. 
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Stockage des paramètres de carte 
d'assignation de plug-in par défaut

Les paramètres de carte d'assignation par défaut 
sont stockés en tant que préférences générales de 
Pro Tools (qui s'appliquent au système entier), 
et s'appliquent donc à toutes les sessions que vous 
ouvrez ou créez ensuite sur ce système.

Pour définir une carte d'assignation de plug-in 
personnalisée en tant que carte d'assignation 
de plug-in par défaut :

1 Ouvrez le plug-in dont vous voulez modifier la 
carte d'assignation de plug-in par défaut.

2 Sélectionnez la carte d'assignation à utiliser 
comme nouvelle carte par défaut dans le menu 
des presets d'assignation. 

3 Dans le menu des options d'assignation, 
sélectionnez Set As Default.

Masquage des pages de carte 
d'assignation de plug-in par défaut
Lorsque vous créez une carte d'assignation de plug-
in personnalisée, ses paramètres sont organisés par 
pages qui correspondent aux groupes de commandes 
d'une surface de contrôle. 

Lorsque vous parcourez les pages des commandes 
de plug-in sur une surface de contrôle, les pages des 
cartes d'assignation de plug-in personnalisées 
s'affichent en premier, suivies des pages des cartes 
d'assignation par défaut d'origine.

Vous pouvez masquer les pages par défaut 
d'origine d'un plug-in afin que seules les pages 
personnalisées s'affichent sur la surface 
de contrôle. Cela s'applique à toutes les instances 
du plug-in. 

Pour masquer les pages par défaut d'origine d'une 
carte d'assignation de plug-in :

1 Ouvrez le plug-in dont vous souhaitez masquer les 
pages de carte d'assignation par défaut.

2 Sélectionnez Hide Factory Default Pages dans 
le menu des options d'assignation.

Exportation et importation de 
cartes d'assignation de plug-in
Vous pouvez exporter les cartes d'assignation de 
plug-in en tant que fichiers .pim pour les utiliser 
sur d'autres systèmes Pro Tools. 

Lors de l'exportation des cartes d'assignation 
de plug-in, vous pouvez choisir d'enregistrer des 
fichiers de carte d'assignation individuels pour 
chaque plug-in, ou bien un seul fichier de carte 
d'assignation contenant toutes les cartes 
d'assignation de plug-in du système. 

Pour exporter une carte d'assignation de plug-in 
individuelle :

1 Ouvrez le plug-in pour lequel vous souhaitez 
exporter la carte d'assignation.

2 Sélectionnez la carte d'assignation à exporter 
dans le menu des presets d'assignation. 

3 Sélectionnez Export Current Plug-In Map dans 
le menu des options d'assignation.

4 Sélectionnez un emplacement pour le fichier de 
carte d'assignation.

5 Cliquez sur Save. 

Si vous envisagez de travailler avec la même 
carte d'assignation de plug-in au cours 
de plusieurs sessions, enregistrez vos paramètres 
en exportant régulièrement toutes les cartes 
d'assignation de plug-in et en enregistrant le 
fichier .pim avec vos sessions.

Sur les systèmes D-Control et D-Command, 
lorsque vous exportez toutes les cartes 
d'assignation de plug-in, vous exportez 
également les assignations de plug-in des 
Custom Faders dans le même fichier. Pour 
plus d'informations, consultez les Guides de la 
D-Control ou de la D-Command.
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Pour exporter toutes les cartes d'assignation 
de plug-in du système dans un seul fichier :

1 Ouvrez un plug-in de la session. 

2 Sélectionnez Export All Plug-In Maps dans 
le menu des options d'assignation.

3 Sélectionnez un emplacement pour le fichier de 
carte d'assignation.

4 Cliquez sur Save. 

Pour importer un fichier de carte d'assignation :

1 Ouvrez le plug-in pour lequel vous souhaitez 
importer une carte d'assignation de plug-in.

2 Sélectionnez Import Plug-In Maps From File 
dans le menu des options d'assignation.

3 Localisez le fichier de carte d'assignation 
de plug-in (.pim) à importer. 

4 Cliquez sur Open.

Bypass des plug-ins
Il est possible de bypasser les plug-ins depuis leur 
fenêtre ou la vue Inserts des fenêtres Mix et Edit. 

Pour bypasser un plug-in, effectuez l'une des 
opérations suivantes :

 Cliquez sur le bouton Bypass de la fenêtre 
du plug-in.

 Cliquez sur le bouton d'insert du plug-in dans la 
fenêtre Mix ou Edit tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée. 

Lorsqu'un plug-in est en bypass, son bouton 
d'insert devient bleu. Si seulement certains canaux 
d'un plug-in multi-mono sont en bypass, son bouton 
d'insert devient violet.

Pour activer ou désactiver le bypass de certains 
inserts à l'aide du menu Track :

1 Sélectionnez les pistes sur lesquelles vous 
souhaitez bypasser des inserts. Maintenez 
la touche Option (Mac) ou Alt (Windows) 
enfoncée et cliquez pour sélectionner toutes les 
pistes affichées dans la session.

2 Sélectionnez Track > Bypass Insert.

3 Sélectionnez (ou désélectionnez) l'une des 
options suivantes :

All : bypasse tous les inserts sur toutes les pistes 
sélectionnées dans la session.

Inserts A-E : bypasse les inserts A à E sur toutes 
les pistes sélectionnées dans la session.

Inserts F-J : bypasse les inserts F à J sur toutes les 
pistes sélectionnées dans la session.

EQ : bypasse tous les plug-ins d'EQ sur toutes les 
pistes sélectionnées dans la session. Pour les plug-
ins classés dans plusieurs catégories (tels que le 
Channel Strip), seul le module d'EQ du plug-in est 
bypassé.

Dynamics : bypasse tous les plug-ins de traitement 
dynamique sur toutes les pistes sélectionnées dans 
la session. Pour les plug-ins classés dans plusieurs 
catégories (tels que le Channel Strip), seul le 
module de traitement dynamique du plug-in est 
bypassé.

Reverb : bypasse tous les plug-ins de 
réverbération sur toutes les pistes sélectionnées 
dans la session.

Affichage d'un plug-in en bypass

Bypass
activé (bleu)

Bypass
non activé
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Delay : bypasse tous les plug-ins de delay sur 
toutes les pistes sélectionnées dans la session.

Modulation : bypasse tous les plug-ins de 
modulation sur toutes les pistes sélectionnées dans 
la session.

Commandes clavier de bypass des 
inserts

Pro Tools fournit des commandes clavier 
permettant de bypasser les pistes sélectionnées de 
la fenêtre Mix :

 Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et cliquez sur un bouton 
d'assignation d'insert dans la fenêtre Mix ou Edit 
pour bypasser cet insert, ainsi que tous ceux situés 
en aval sur la piste.

 Maintenez les touches Ctrl+Option (Mac) 
ou Démarrer+Alt (Windows) enfoncées et cliquez 
sur un bouton d'assignation d'insert dans la fenêtre 
Mix ou Edit pour bypasser cet insert, ainsi que tous 
ceux situés en aval sur toutes les pistes. Vous 
pouvez ainsi bypasser tous les plug-ins de votre 
session d'un simple clic.

 Appuyez sur Maj+A pour activer 
(ou désactiver) le bypass sur tous les inserts des 
pistes sélectionnées.

 Appuyez sur Maj+1 pour activer 
(ou désactiver) le bypass sur les inserts A à E des 
pistes sélectionnées.

 Appuyez sur Maj+2 pour activer 
(ou désactiver) le bypass sur les inserts F à J des 
pistes sélectionnées.

 Appuyez sur Maj+E pour activer 
(ou désactiver) le bypass sur tous les plug-ins d'EQ 
des pistes sélectionnées.

 Appuyez sur Maj+C pour activer 
(ou désactiver) le bypass sur tous les plug-ins de 
traitement dynamique des pistes sélectionnées.

 Appuyez sur Maj+V pour activer 
(ou désactiver) le bypass sur tous les plug-ins de 
réverbération des pistes sélectionnées.

 Appuyez sur Maj+D pour activer 
(ou désactiver) le bypass sur tous les plug-ins de 
delay des pistes sélectionnées.

 Appuyez sur Maj+W pour activer 
(ou désactiver) le bypass sur tous les plug-ins de 
modulation des pistes sélectionnées.

Liaison et dissociation des 
commandes des plug-ins 
multi-mono
Lorsqu'un plug-in multi-mono est inséré sur une 
piste stéréo ou multicanal de format supérieur 
à stéréo (Pro Tools HD uniquement), ses commandes 
sont liées par défaut. L'ajustement de la commande 
Gain d'un canal, par exemple, est répercuté sur tous 
les autres canaux.

Vous pouvez dissocier les commandes d'un plug-in 
multi-mono pour des canaux spécifiques d'une piste 
et les ajuster indépendamment. Vous pouvez 
également lier les commandes de manière sélective 
sur certains canaux seulement.

Pour dissocier les commandes d'un plug-in 
multi-mono :

 Désélectionnez le bouton de liaison principale.

Pour accéder aux commandes d'un canal spécifique :

 Sélectionnez le canal depuis le sélecteur de canal.

Sélecteur de canal et commandes de liaison 
(liaison désactivée)

Sélecteur de canal

Boutons de liaison
des canaux

Bouton de liaison principale
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Pour lier les commandes de canaux spécifiques :

1 Désélectionnez le bouton de liaison principale, si 
ce n'est déjà fait.

2 Cliquez sur les boutons de liaison pour les canaux 
dont vous souhaitez lier les commandes. 

Utilisation d'inserts matériels
Vous pouvez connecter des périphériques externes 
à votre système Pro Tools, tels que des reverbs ou 
des processeurs d'effet, puis les utiliser en tant 
qu'inserts matériels sur des pistes individuelles ou 
des sous-groupes.

Les inserts de Pro Tools exploitent les entrées et 
sorties matérielles correspondantes pour l'envoi et 
le retour des signaux. Dans la page Insert de la 
boîte de dialogue I/O Setup, il est possible de 
définir les inserts et de faire correspondre leurs 
canaux à ceux de l'interface audio. 

Pour utiliser un périphérique en insert, connectez-le 
aux entrées et sorties correspondantes de votre 
système. Un insert matériel connecté aux sorties 7-8 
par exemple doit renvoyer les signaux sur les entrées 
matérielles 7-8. 

Pour configurer un insert matériel :

1 Sélectionnez Setup > I/O, puis cliquez sur 
l'onglet Insert. 

2 Sélectionnez un chemin d'insert ou cliquez sur 
New Path pour en créer un.

3 Double-cliquez sur le nom du chemin pour 
attribuer un nom de chemin personnalisé 
à l'insert.

4 Assurez-vous que le chemin de l'insert est 
correct (mono, stéréo ou autre).

5 Placez à votre convenance les inserts dans 
la grille de canaux. Les chemins d'insert et de 
sortie sont régis par des règles particulières en ce 
qui concerne la correspondance aux canaux 
(reportez-vous à la section « Chemins valides et 
conditions » à la page 95).

Assignation d'inserts matériels

Pour assigner un insert matériel externe à une piste :

 Sélectionnez un insert dans le sélecteur d'insert 
de la piste. 

Tous les canaux sont liés, à l'exception du LFE.

La compensation du délai peut être appliquée 
aux inserts matériels. Reportez-vous à la 
section « Page H/W Insert Delay 
(Compensation) » à la page 75.

Sélection d'un insert d'E/S matériel

Fenêtre d'insert matériel
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Bypass d'inserts matériels
Les inserts matériels ne disposent pas 
de commande de bypass. Pour écouter une piste 
sans un insert matériel, désactivez-le, supprimez-le 
en sélectionnant No Insert dans le menu d'insert, 
ou utilisez le bouton Bypass du périphérique 
matériel lui-même. Reportez-vous à la section 
« Désactivation des inserts » à la page 1037 pour 
plus d'informations.

Connexion et intégration 
de périphériques externes
Pro Tools peut créer des connexions dédiées vers 
des périphériques externes analogiques 
ou numériques. Le nombre et le type des 
connexions dépend du type de système utilisé.

Pour relier un périphérique externe à un système 
Pro Tools : 

1 Reliez une sortie inutilisée (ou une paire 
de sorties dans le cas d'un périphérique stéréo) 
du système Pro Tools à une entrée 
du processeur externe.

2 Reliez la sortie du processeur externe à une 
entrée inutilisée (ou une paire d'entrées dans le 
cas d'un périphérique stéréo) du système 
Pro Tools.

3 Dans les boîtes de dialogue Hardware Setup ou 
I/O Setup, définissez les ports physiques 
à acheminer vers les ports d'entrée et de sortie 
Pro Tools.

4 Définissez les chemins de sortie, d'entrée 
ou d'insertion appropriés dans la boîte 
de dialogue I/O Setup. 

Pour utiliser un périphérique en insert, connectez-
le aux entrées et sorties correspondantes de votre 
système. Pour utiliser les sorties 7-8 par exemple, 
l'insert doit utiliser également les entrées 7-8. 

Connexion numérique d'effets
Si vous voulez utiliser les entrées et sorties 
numériques du système Pro Tools en tant que 
départs et retours d'effets pour un périphérique 
d'effets numérique, Pro Tools doit être défini 
en tant que périphérique de synchronisation maître 
dans la plupart des cas. Configurez l'effet 
numérique pour qu'il reçoive une horloge 
numérique externe afin de le synchroniser 
avec Pro Tools.

Pour configurer un départ numérique vers 
un périphérique externe à partir de systèmes 
Pro Tools|HDX et Pro Tools|HD Native :

1 Sélectionnez Setup > Hardware.

2 Sélectionnez l'interface audio dans la liste des 
périphériques (HD I/O, HD MADI ou HD 
OMNI).

3 Sélectionnez un format audio et un format 
d'horloge, puis définissez la paire de canaux 
appropriée sur Digital.

4 Sélectionnez Internal dans le menu Clock Source.

5 Cliquez sur OK. 

Pour plus d'informations sur la connexion 
de périphériques externes, reportez-vous au 
Guide de l'utilisateur fourni avec votre 
système.
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Pour configurer un départ numérique vers 
un périphérique externe à partir d'un système 
Pro Tools avec une interface 003, 003 Rack+ 
ou 003 Rack :

1 Sélectionnez Setup > Playback Engine 
et sélectionnez le périphérique.

2 Effectuez l'une des opérations suivantes :

• Si le périphérique externe est branché sur les 
connecteurs RCA S/PDIF, désélectionnez l'option 
S/PDIF Mirroring (lorsque l'option S/PDIF 
Mirroring est activée, la sortie numérique des 
connecteurs RCA S/PDIF reflète exactement 
la sortie des canaux analogiques 1-2).

• Si le périphérique externe est relié aux ports 
optiques, sélectionnez un format (généralement 
S/PDIF pour un périphérique d'effets) dans 
le menu Optical Format.

3 Sélectionnez Internal dans le menu Clock source.

4 Cliquez sur OK.

5 Vous pouvez également entrer de nouveaux 
noms de chemins pour le routing des effets dans 
la boîte de dialogue I/O Setup. 

Utilisation de sources d'horloge 
externes (pour l'enregistrement 
et le monitoring)
Lors de l'enregistrement ou du monitoring, Pro Tools 
peut être synchronisé sur une source d'horloge externe. 
Les choix de source d'horloge externe dépendent du 
type de système Pro Tools utilisé.

Systèmes Pro Tools|HDX et Pro Tools|HD Native

Les systèmes Pro Tools|HDX et Pro Tools|HD 
Native peuvent recevoir une horloge externe via 
n'importe quelle entrée numérique de n'importe 
quelle interface audio Avid HD (dont AES/EBU, 
S/PDIF et Optical).

Pour sélectionner une source d'horloge externe pour 
les systèmes Pro Tools|HDX ou Pro Tools|HD Native :

1 Sélectionnez Setup > Hardware.

2 Sélectionnez l'interface audio appropriée pour 
afficher ses paramètres sur la page principale.

3 Si nécessaire, activez le format numérique 
approprié (si ce n'est déjà fait) en suivant 
les instructions du Guide de l'utilisateur 
de votre interface.

4 Sélectionnez le paramètre Clock Source 
correspondant au type d'entrée.

5 Si nécessaire, configurez le routing d'entrée de 
la source numérique à l'aide des menus Input et 
Output.

6 Cliquez sur OK pour fermer la boîte de dialogue 
Hardware Setup.

Systèmes Pro Tools avec interface 003, 003 
Rack+ ou 003 Rack

Pro Tools peut recevoir un signal d'horloge externe 
provenant de l'entrée optique ou de l'entrée 
S/PDIF.

Pour sélectionner une source d'horloge externe 
pour un système Pro Tools avec une interface 003, 
003 Rack+ ou 003 Rack :

1 Sélectionnez Setup > Hardware.

2 Sélectionnez le paramètre Clock Source 
correspondant au type d'entrée.

3 Si vous sélectionnez Optical, assurez-vous que 
le paramètre Optical Format correspond au type 
d'entrée optique envoyé au système Pro Tools. 

Si vous choisissez le format optique S/PDIF, 
Pro Tools cherchera à recevoir les entrées audio 
sur le port optique et ignorera toutes celles 
arrivant sur les connecteurs RCA S/PDIF.

Pour plus d'informations sur la connexion 
des interfaces audio, reportez-vous au guide 
de votre interface audio.
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Systèmes Pro Tools avec Eleven Rack

Pro Tools peut recevoir un signal d'horloge externe 
provenant de l'entrée AES/EBU ou de l'entrée S/PDIF.

Pour sélectionner une source d'horloge externe 
pour Eleven Rack :

1 Sélectionnez Setup > Hardware.

2 Sélectionnez le paramètre Clock Source 
correspondant au type d'entrée.

Systèmes Pro Tools avec Mbox Pro, Mbox 2 
Pro, Mbox (3e génération) ou Mbox 2

Pro Tools peut recevoir un signal d'horloge externe 
provenant de l'entrée S/PDIF de ces interfaces.

Pour sélectionner une source d'horloge externe 
pour Pro Tools avec une Mbox Pro, Mbox 2 Pro, 
Mbox (3e génération) ou Mbox 2 :

1 Sélectionnez Setup > Hardware.

2 Sélectionnez SPDIF (Windows) ou SPDIF/RCA 
(Mac) dans le menu Clock Source . 

3 Cliquez sur OK.

Si vous sélectionnez le format optique S/PDIF, 
Pro Tools cherchera à recevoir le signal 
d'horloge externe sur le port optique et 
ignorera les signaux d'horloge envoyés sur les 
connecteurs RCA S/PDIF.

Votre périphérique d'entrée numérique doit 
être connecté et sous tension afin que 
Pro Tools puisse se synchroniser. S'il n'est pas 
sous tension, sélectionnez le paramètre 
Internal dans le menu Clock Source.
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Chapitre 45 : Automation

Les commandes de mixage de chaque type de piste de 
Pro Tools peuvent être automatisées de manière 
dynamique. Vous pouvez écrire des mouvements 
d'automation et les voir en temps réel dans votre 
session, en cours de lecture et d'enregistrement. Vous 
pouvez également modifier des données d'automation 
au moyen de la technique utilisée pour modifier les 
données audio et MIDI.

Précision de l'automation avec 
les surfaces de contrôle
Surfaces de contrôle : les surfaces de contrôle D-
Control, D-Command, ProControl, C|24 
et Command|8 (ainsi que la 003) prennent en charge 
les fonctions d'automation dans Pro Tools. Les surfaces 
de contrôle Pro Tools offrent une résolution de 
10 bits, ou 1 024 pas de fader. Pro Tools interpole ces 
données en cours de lecture en résolution 24 bits, 
pour une automation de fader extrêmement précise et 
fluide.

EUCON : les surfaces de contrôle Avid exploitant le 
protocole EUCON offrent un contrôle des faders et 
boutons avec une résolution de 12 bits.

Surfaces de contrôle MIDI : la majorité des 
surfaces de contrôle MIDI fonctionnent avec une 
résolution de 7 bits ou 128 pas. Pro Tools interpole 
ces données en cours de lecture en résolution 
24 bits, pour une automation de fader précise et 
fluide.

Présentation de l'automation
Pro Tools propose de nombreuses options pour 
l'enregistrement, le remplacement et l'édition des 
données d'automation. 

Les étapes élémentaires d'enregistrement 
d'automation sont les suivantes :

• Activez le type d'automation à enregistrer 
(volume, panoramique, mute, niveau de départ, 
panoramique de départ, mute de départ ou plug-
in). 

• Activez le mode d'écriture d'automation désiré 
(Write, Touch, Latch ou Trim) sur les pistes de 
votre choix. 

• Si vous souhaitez automatiser un plug-in, 
activez les commandes de plug-ins individuelles 
à automatiser.

• Protégez l'automation des plug-ins, sorties 
ou départs pour éviter le remplacement de leurs 
données d'automation existantes, en les plaçant 
en mode Automation Safe. 

• Lancez la lecture pour démarrer l'enregistrement 
de l'automation et ajustez les commandes de 
votre choix. Pro Tools enregistre toutes les 
modifications apportées aux commandes 
activées. 

Pour éditer une automation enregistrée :

• Répétez les étapes ci-dessus pour écraser les 
données précédentes à l'aide de nouvelles 
données d'automation.

• Éditez graphiquement les données d'automation 
dans la fenêtre Edit.

• Coupez, copiez, collez ou supprimez les données 
d'automation (certaines restrictions s'appliquent).

Pour plus d'informations sur l'utilisation des 
surfaces de contrôle pour créer des 
automations de mixage, reportez-vous 
au Guide de votre surface de contrôle.
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Playlists d'automation
Chaque piste de Pro Tools contient une playlist 
d'automation unique pour chaque paramètre 
automatisable.

Sur les pistes audio, ces paramètres sont les 
suivants :

• Volume

• Trim de volume (Pro Tools HD uniquement)

• Panoramique

• Mute

• Niveau de départ

• Trim de niveau de départ (Pro Tools HD 
uniquement)

• Panoramique de départ

• Mute de départ

• Commandes de plug-in

Sur les pistes d'entrée auxiliaire, ces paramètres sont 
les suivants :

• Volume

• Trim de volume (Pro Tools HD uniquement)

• Mute

• Panoramique

Sur les Master Faders, ces paramètres sont les 
suivants :

• Volume

• Trim de volume (Pro Tools HD uniquement)

• Sur les pistes MIDI, ces paramètres sont les 
suivants :

• Volume MIDI

• Panoramique MIDI

• Mute MIDI

Sur les pistes d'instrument, ces paramètres sont les 
suivants :

• Volume (audio)

• Trim de volume (audio) (Pro Tools HD uniquement)

• Mute (audio)

• Panoramique (audio)

Sur les pistes Master VCA (Pro Tools HD 
uniquement), ces paramètres sont les suivants :

• Volume

• Trim de volume

• Mute

Vous pouvez afficher et éditer individuellement 
chacune de ces playlists susceptibles d'être 
automatisées dans Pro Tools, même en cours 
de lecture.

De plus, vous pouvez afficher et éditer d'autres 
données de contrôleur continu MIDI sur des pistes 
MIDI et d'instrument (la molette de modulation, 
un contrôleur de souffle, un contrôleur au pied ou 
une pédale de sustain, par exemple) de manière 
similaire. Pour en savoir plus sur l'édition de 
données MIDI, reportez-vous à la section 
« Événements de contrôleur continu » à la 
page 712.
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Playlists d'automation et clips 
audio et MIDI
Pro Tools gère les clips audio et leurs playlists 
d'automation différemment des clips MIDI et de 
leurs playlists d'automation.

Pistes audio

Sur les pistes audio, les données d'automation ne 
résident pas dans la même playlist que les données 
et clips audio. Toutes les playlists d'édition d'une 
piste audio partagent les mêmes données 
d'automation. 

Pistes MIDI et d'instrument

Sur les pistes MIDI et d'instrument, toutes les 
données d'automation de contrôleur, à l'exception des 
données de mute MIDI ou audio (pistes d'instrument 
uniquement), sont enregistrées dans le clip MIDI 
auquel elles appartiennent. Sur les pistes, les playlists 
d'édition sont séparées et représentent une 
performance spécifique accompagnée de son 
automation de contrôleur. 

Playlists d'automation de trim
(Pro Tools HD uniquement)

Des playlists d'automation du trim distinctes sont 
disponibles pour le trim du volume et celui du niveau 
de départ. Le trim du volume est disponible sur tous 
les types de pistes à l'exception des pistes MIDI. 
Le trim du niveau de départ est disponible 
uniquement sur les pistes audio. 

Chaque playlist d'automation de trim indique 
la position du fader de trim par des points 
d'inflexion jaunes pouvant être modifiés. Pour plus 
d'informations sur les playlists de trim, reportez-vous 
aux sections « Mode Trim » à la page 1071 
et « Affichage de l'automation » à la page 1075. 

Playlists d'édition multiples et 
automation de pistes audio 
Toutes les playlists d'édition d'une même piste 
audio partagent les mêmes données d'automation. 
Lorsque vous enregistrez ou modifiez des données 
d'automation sur une piste audio, celles-ci sont 
enregistrées dans la playlist d'automation 
correspondante de la piste, ce qui permet de les 
modifier avec ou indépendamment des clips audio 
associés. 

 Lorsque vous copiez ou coupez des données 
audio sur une piste dans une vue Waveform, 
les données d'automation sous-jacentes sont 
également coupées ou copiées. 

 Si vous collez des données audio dans une 
playlist d'édition à partir d'autres emplacements 
ou pistes, vous pouvez modifier les données 
d'automation sous-jacentes sur la piste. 

 Lorsque vous effectuez une opération de trim sur 
des clips avec la commande Edit > Trim, les données 
d'automation sous-jacentes restent inchangées. 

Duplication de pistes pour 
l'édition de playlists
La commande Duplicate Track permet de copier 
facilement une piste pour modifier son routing, les 
plug-ins et l'automation, sans toucher à l'originale. 
La piste d'origine et ses données d'automation ne 
risquent donc pas d'être modifiées ni remplacées. 

Dans un clip MIDI, les données de mute MIDI 
sont indépendantes des données MIDI. Vous 
pouvez ainsi muter la lecture de pistes MIDI 
ou d'instrument individuelles dans Pro Tools 
sans altérer les données de contrôleur.

Les données de contrôleur continu MIDI reflètent 
toujours les modifications du clip à l'exception du 
mute. Pour plus d'informations, reportez-vous à la 
section « Pistes MIDI et d'instrument » à la 
page 1067.

Pour plus d'informations, reportez-vous à la 
section « Édition de l'automation » à la 
page 1095.

Pour plus d'informations, reportez-vous à la 
section « Duplication de pistes » à la page 222.



Guide de référence Pro Tools1068

Modes d'automation
Les modes d'automation contrôlent la méthode 
d'écriture et de lecture des données d'automation 
d'une piste. Chaque piste est dotée d'un sélecteur de 
mode d'automation permettant de sélectionner son 
mode d'automation.

Mode Off
Le mode Off désactive l'automation pour tous les 
paramètres susceptibles d'être automatisés :

• Volume

• Panoramique

• Mute

• Volume, panoramique et mute des départs

• Commandes de plug-in

• Volume, panoramique et mute MIDI

En mode Off, les données d'automation liées à ces 
paramètres sont ignorées lors de la lecture. Toutes 
les autres données de contrôleur MIDI sont 
envoyées. 

L'automation peut être basculée du mode Off vers 
un autre mode d'automation pendant la lecture ou 
l'enregistrement.

Mode Read
Le mode Read lit les données d'automation 
précédemment écrites pour une piste.

Mode Write
Le mode Write écrit les données d'automation 
entre le démarrage et l'arrêt de la lecture, en 
effaçant sur la durée de cette passe toutes les 
données d'automation antérieures. 

La fonction AutoMatch peut être appliquée à une 
passe d'automation en mode Write. Reportez-vous 
à la section « AutoMatch Time » à la page 1074.

Option After Write Pass, Switch To

Vous pouvez configurer Pro Tools afin de passer 
automatiquement en mode Touch ou Latch 
ou de rester en mode Write à l'issue d'une passe 
d'automation en mode Write.

Pour définir le mode d'automation à activer 
à l'issue d'une passe en mode Write :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Automation, sélectionnez l'une des 
options After Write Pass, Switch To (Touch, 
Latch ou No Change).

3 Cliquez sur OK pour fermer la fenêtre 
des préférences.

Mode Touch
Le mode Touch écrit les données d'automation 
uniquement lorsque vous touchez un fader ou un 
commutateur ou que vous cliquez dessus avec 
la souris. Au relâchement du fader, l'écriture des 
données d'automation s'arrête et le fader retrouve sa 
position d'automation antérieure, à une vitesse définie 
par les paramètres AutoMatch et Touch Timeout. 
Reportez-vous à la section « Préférences 
d'automation » à la page 1073.

En mode Touch, certaines surfaces de contrôle 
lancent l'écriture des données d'automation dès que 
vous touchez une commande. Ces surfaces sont des 
contrôleurs pourvus de faders tactiles, telles qu'une 
D-Control, une D-Command, une ProControl, 
une C|24, une 003 ou une Command|8.

Sur d'autres surfaces de contrôle en mode Touch, 
l'écriture des données d'automation commence 
lorsque le fader atteint le point d'intersection, soit la 
valeur d'automation précédente. Une fois ce point 
d'intersection atteint avec un fader, ou une commande 
rotative non sensible au toucher, l'écriture 
d'automation débute et se poursuit jusqu'à ce que 
vous arrêtiez de déplacer le fader.
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Mode Latch
Le mode Latch fonctionne de manière analogue 
au mode Touch, c'est-à-dire qu'il écrit les données 
d'automation uniquement lorsque vous touchez ou 
déplacez une commande. Cependant, à la différence 
de Touch, l'écriture des données d'automation 
se poursuit jusqu'à ce que vous arrêtiez la lecture ou 
que vous mettiez fin à la passe d'automation 
en activant le mode d'automation Read ou Touch.

La fonction AutoMatch peut être appliquée à une 
passe d'automation en mode Latch. Reportez-vous à 
la section « AutoMatch Time » à la page 1074.

Le mode Latch est particulièrement utile pour 
l'automation des commandes de panoramique 
et des plug-ins sur des commandes rotatives non 
tactiles puisqu'il n'est pas désactivé et ne rétablit 
pas la valeur d'automation précédente dès que vous 
relâchez la commande. 

AutoJoin et mode Latch
(Pro Tools HD uniquement)

Pro Tools offre deux méthodes différentes 
de reprise de l'écriture d'automation sur les 
commandes qui étaient actives au moment 
de l'arrêt du transport :

AutoJoin : permet de reprendre automatiquement 
l'écriture d'automation en mode Latch.

Join : permet de reprendre manuellement l'écriture 
d'automation en mode Latch. La fonction Join est 
uniquement disponible avec les surfaces de contrôle 
prises en charge.

Pour activer la fonction AutoJoin dans Pro Tools :

1 Sélectionnez Window > Automation.

2 Cliquez sur le bouton AutoJoin.

Reportez-vous également à la section « Écriture 
de données d'automation au début, à la fin ou sur 
l'ensemble d'une sélection ou d'une piste » à la 
page 1106.

Bouton d'activation de la fonction AutoJoin dans 
la fenêtre Automation

Reportez-vous au guide de votre surface 
de contrôle pour plus d'informations sur 
l'utilisation des fonctions Join et AutoJoin 
avec une surface de contrôle.
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Indicateur AutoJoin

Après une passe d'automation en mode Latch avec 
AutoJoin, l'indicateur AutoJoin s'affiche dans la 
fenêtre Edit de Pro Tools.

L'indicateur AutoJoin est une ligne verticale qui 
indique le point d'arrêt de la dernière passe 
d'automation et le point de départ automatique de 
« raccord » de toutes les pistes qui étaient activées 
pour l'écriture lors de la passe précédente. Lorsque 
l'écriture d'automation reprend à partir de ce point, 
la ligne disparaît.

Mode Touch/Latch
(Pro Tools HD uniquement)

Le mode d'automation Touch/Latch place 
la commande Volume d'une piste en mode Touch 
et toutes les autres commandes automatisables en 
mode Latch. 

En mode Touch/Latch, la commande Volume 
se comporte en mode Touch, écrivant l'automation 
lorsque vous la touchez et repassant aux niveaux 
d'écriture précédents lorsque vous la relâchez. 

Toutes les autres commandes se comportent en mode 
Latch, écrivant l'automation lorsque vous les touchez 
et ne s'arrêtant pas tant que la lecture n'est pas 
interrompue ou que vous n'insérez pas un point de 
sortie pour l'écriture de l'automation.

Indicateur AutoJoin dans la fenêtre Edit

Pour utiliser la fonction Join ou AutoJoin afin 
de reprendre l'écriture sur les commandes qui 
étaient activées pour l'écriture avant l'arrêt du 
transport, relancez le transport avant 
l'indicateur AutoJoin.

Sélection du mode Touch/Latch
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Mode Trim
(Pro Tools HD uniquement)

Pro Tools HD peut ajuster (trim) en temps réel 
le volume d'une piste et les données d'automation du 
niveau de départ. En revanche, il n'est pas possible de 
faire un trim de cette manière sur l'automation de 
panoramique, de mute et de plug-in. Le mode Trim 
fonctionne en association avec les autres modes 
d'automation (Read, Touch, Latch, Touch/Latch et 
Write). Il permet de conserver l'ensemble des 
modifications apportées aux données d'automation 
du volume tout en augmentant ou réduisant 
légèrement les niveaux afin d'équilibrer les mixages. 
Pour plus d'informations, reportez-vous à la section 
« Modes d'automation de trim » à la page 1071.

Lors de l'écriture de données d'automation en mode 
Trim, les mouvements de fader écrivent des valeurs 
relatives au lieu de valeurs absolues. Les données 
d'automation existantes varient en fonction de 
l'augmentation ou de la diminution (ou valeur delta) 
indiquée par les faders. 

En mode Trim, les commandes pour lesquelles 
le trim est impossible se comportent comme dans 
les modes d'automation standard, à l'exception du 
mode Write/Trim dans lequel elles fonctionnent 
comme en mode Touch.

Modes d'automation de trim
Lorsqu'une piste est dans un des modes 
d'automation de trim (à l'exception de Trim Off), 
ses faders principaux de volume et de niveau 
de départ sont affichés en jaune. Lors du trim, 
un indicateur de volume de piste ou de niveau de 
départ affiche la valeur delta en cours d'écriture 
plutôt que la valeur absolue.

Le comportement des modes d'automation du trim 
dépend également du paramètre de préférence 
Coalesce Trim Automation. Reportez-vous à la 
section « Fusion de l'automation de trim » à la 
page 1105. 

Trim Off

Le mode Trim Off désactive la lecture et l'écriture de 
toutes les données d'automation (principales et de 
trim) d'une piste. Tous les mouvements d'automation 
sont ignorés durant la lecture. Les faders de trim sont 
temporairement réglés sur zéro lorsqu'une piste passe 
en mode Trim Off.

En fonction de la préférence Coalesce Trim 
Automation sélectionnée, le passage d'une piste en 
mode Trim Off peut fusionner son automation de 
trim. Reportez-vous à la section « Fusion de 
l'automation de trim » à la page 1105. 

L'automation peut être basculée du mode Trim Off 
vers un autre mode d'automation en cours de 
lecture ou d'enregistrement.

Read Trim

En mode Read Trim, les faders de trim de volume et de 
niveau de départ ne suivent plus la playlist 
d'automation principale et suivent toute automation de 
trim existante. Vous pouvez déplacer un fader de trim 
pendant la lecture afin d'écouter des nouvelles valeurs 
de trim mais aucune donnée d'automation n'est écrite. 
Lorsque vous relâchez le fader de trim, il retourne aux 
valeurs d'automation de trim écrites précédemment.

Si une piste ne contient aucune donnée 
d'automation de trim, vous pouvez déplacer 
un fader de trim pendant la lecture afin d'écouter 
des nouvelles valeurs de trim mais aucune donnée 
d'automation n'est écrite. Le fader de trim reste 
dans la même position tant que la piste reste en 
mode Trim, ou si vous fondez manuellement le 
niveau de trim.

Lorsque ce mode est activé, les commandes 
auxquelles on ne peut appliquer de trim (toutes les 
commandes autres que le volume de piste et le 
niveau de départ) se comportent comme en mode 
Read standard : aucune donnée d'automation n'est 
écrite.



Guide de référence Pro Tools1072

Touch Trim

En mode Touch Trim, les faders de trim de volume 
et de niveau de départ ne suivent plus la playlist 
d'automation principale et suivent toute automation 
de trim existante. Lorsque vous touchez un fader de 
trim, l'écriture des données d'automation de trim 
commence. Lorsque vous relâchez le fader, 
l'écriture s'interrompt et le fader retourne aux 
valeurs d'automation de trim écrites précédemment.

La vitesse de retour du fader à des valeurs de trim 
antérieures dépend du paramètre AutoMatch Time 
défini dans la page des préférences de l'automation. 
Pour plus d'informations, reportez-vous à la section 
« AutoMatch Time » à la page 1074.

Lorsque ce mode est activé, les commandes 
auxquelles on ne peut appliquer de trim (toutes les 
commandes autres que le volume de piste et les 
niveaux de départ) se comportent comme en mode 
Touch standard : elles suivent les données 
d'automation précédemment enregistrées jusqu'à ce 
qu'elles soient touchées. Lorsqu'elles sont touchées, 
leur position absolue est écrite jusqu'à relâchement ou 
arrêt de la lecture. 

Latch Trim

En mode Latch Trim, les faders de trim de volume et 
de niveau de départ ne suivent plus la playlist 
d'automation principale et suivent toute automation 
de trim existante. Lorsque vous touchez un fader de 
trim, l'écriture des données d'automation de trim 
commence. L'écriture de données d'automation de 
trim continue tant que la lecture n'est pas arrêtée ou 
que vous n'arrêtez pas l'opération. 

Lorsque ce mode est activé, les commandes 
auxquelles on ne peut appliquer de trim (toutes les 
commandes autres que le volume de piste et les 
niveaux de départ) se comportent comme en mode 
Latch standard : elles suivent les données 

d'automation précédemment enregistrées jusqu'à ce 
qu'elles soient touchées. Dès qu'elles sont 
touchées, leur position absolue est écrite jusqu'à 
l'arrêt de la lecture.

Touch/Latch Trim

En mode Touch/Latch Trim, les faders de volume 
et de niveau de départ ne suivent plus la playlist 
d'automation principale et suivent toute 
automation de trim existante. Le fader du trim de 
volume principal se comporte en mode Touch 
Trim et les faders de trim de niveau de départ se 
comportent en mode Latch Trim. 

Write Trim

En mode Write Trim, dès que la lecture commence, 
l'écriture des données d'automation du trim 
commence pour le volume et les niveaux de départ, 
puis se poursuit tant que la lecture ou l'opération 
d'écriture des données de trim n'est pas arrêtée.

Lorsque le mode Write/Trim est activé, les 
commandes auxquelles on ne peut appliquer de trim 
(toutes les commandes autres que le volume de piste 
et les niveaux de départ) ne sont pas en mode Write 
mais se comportent comme en mode Touch 
standard : aucune donnée d'automation n'est écrite 
jusqu'à ce qu'une commande soit touchée. Ainsi, 
les commandes ne risquent pas de remplacer leurs 
données d'automation à chaque passage en mode 
Write Trim.

Le paramètre After Write Pass, Switch 
To affecte le mode Write Trim. Après une 
passe d'automation en mode Write/Trim, 
les pistes repassent automatiquement au mode 
Trim sélectionné pour cette préférence.
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Préférences d'automation
Pro Tools offre plusieurs options de contrôle 
de l'écriture et de la lecture des données 
d'automation.

Pour afficher les préférences d'automation :

 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

Niveaux de départ et mode Trim
(Pro Tools HD uniquement)

Vous pouvez configurer Pro Tools de façon 
à exclure les niveaux de départ du mode Trim afin 
que l'opération de trim ne concerne que le volume 
principal lorsqu'une piste passe en mode Trim. 
Cette fonctionnalité vous donne davantage de 
flexibilité pour configurer les niveaux de départ en 
mode Trim.

Pour exclure les niveaux de départ du mode Trim :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Automation, désactivez l'option Include 

Sends in Trim Mode.

3 Cliquez sur OK.

Lissage
Lorsque vous exécutez des mouvements 
d'automation (y compris des mouvements de trim) 
avec un contrôleur continu, Pro Tools enregistre 
chaque mouvement comme une série d'étapes très 
courtes, ce qui génère une courbe en « escalier » 
comportant de nombreux points d'automation. 
Le lissage gomme intelligemment cet escalier pour 
obtenir une rampe unique reliant les points 
d'automation entre eux (le lissage ne s'applique pas 
aux commandes commutées telles que le mute ou le 
bypass de plug-ins). L'activation du lissage accroît la 
précision de la représentation des mouvements 
d'automation effectués. 

Section Automation des préférences de mixage

Pour obtenir des informations détaillées sur les 
préférences d’automation de Pro Tools, 
reportez-vous à la section « Préférences de 
mixage » à la page 115.

Toute donnée d'automation non fondue sur 
un départ fond lorsque les autres données 
d'automation de cette piste sont fondues, 
même si l'option Include Sends in Trim Mode 
n'est pas sélectionnée.
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Affinage
L'affinage réduit automatiquement le nombre 
de points d'automation dans une playlist d'automation 
(y compris les playlists de trim) pour améliorer les 
performances du système. Le degré d'affinage 
appliqué est déterminé par le paramètre Degree of 
Thinning, dans la page des préférences d'automation. 
Un affinage important entraîne une automation 
sensiblement différente des mouvements d'automation 
réels. L'affinage s'applique uniquement aux pistes 
audio et n'affecte pas les pistes MIDI. Pour obtenir des 
instructions, reportez-vous à la section « Affinage de 
l'automation » à la page 1092.

AutoMatch Time
Le paramètre AutoMatch Time correspond 
au temps nécessaire à un fader pour revenir 
(en suivant une rampe vers le haut ou le bas) 
au niveau d'automation toujours présent sur 
la piste, à la fin de la passe d'automation. Cette 
valeur est définie sur la page des préférences 
d'automation (reportez-vous à la section 
« Préférences d'automation » à la page 1073).

L'option AutoMatch est automatiquement appliquée 
à tous les passages en mode Touch et peut être 
appliquée aux passages en mode Latch ou Write.

La valeur AutoMatch Time détermine également le 
taux auquel les valeurs delta écrites en mode Trim 
renvoient à 0 dB (valeur delta égale à zéro).

La fonctionnalité AutoMatch agit sur des 
commandes continues (telles que le volume ou le 
panoramique), dont elle ramène la valeur à des 
niveaux automatisés antérieurs. La plage de 
fonctionnement de certaines commandes 
discontinues (l'égaliseur dans le plug-in EQ 
à 1 bande, par exemple) s'étend sur plus de deux 
pas. La fonction AutoMatch n'exerce aucune 
influence sur ces commandes.

Option Automation Follows Edit
Lorsque cette commande est désactivée, 
les événements d'automation ne sont pas affectés 
par les modifications apportées aux notes audio ou 
MIDI. Lorsque cette commande est activée, 
les événements d'automation sont affectés par les 
modifications apportées aux notes audio ou MIDI.

Pour activer ou désactiver l'option Automation 
Follows Edit, effectuez l'une des opérations 
suivantes :

 Sélectionnez ou désélectionnez Options > 

Automation Follows Edit.

 Cliquez sur le bouton Automation Follows Edit 
de la barre d'outils de la fenêtre Edit. Le bouton 
apparaît en surbrillance lorsqu'il est activé, et en 
gris lorsqu'il est désactivé.

Bouton Automation Follows Edit dans la fenêtre Edit
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Automation Safe 
Il est possible de placer les sorties, les départs et les 
plug-ins en mode Automation Safe. En mode 
Automation Safe, les données d'automation associées 
à une fenêtre Output (niveau de piste ou de départ, de 
panoramique, de mute, etc.) ou à un plug-in de cette 
piste sont protégées contre le remplacement, tout en 
enregistrant des données d'automation pour les autres 
éléments de la piste. 

Le mode Automation Safe suspend l'enregistrement 
des données d'automation de l'élément (sortie, départ 
ou plug-in) de la piste sélectionnée pour lequel il est 
activé. Vous pouvez également suspendre 
l'enregistrement et la lecture des données 
d'automation pour toute la durée d'une session, dans la 
fenêtre Automation. Reportez-vous à la section 
« Activation et suspension de l'automation » à la 
page 1089. 

Affichage de l'automation
Pro Tools crée une playlist distincte dans la fenêtre 
Edit pour chaque type d'automation d'une piste, 
y compris une playlist pour chaque type 
d'automation de trim. Ces données peuvent être 
affichées et modifiées comme des données audio 
ou MIDI. Vous pouvez modifier la vue de piste 
pour afficher l'automation de votre choix, ou 
afficher une ligne d'automation sous la piste quelle 
que soit la vue de piste activée.

Vues de piste
Vous pouvez afficher les données d'automation par 
type en sélectionnant la vue de piste 
correspondante.

Pour afficher une playlist d'automation dans la vue 
de piste :

 Cliquez sur le sélecteur de vue de piste 
et sélectionnez le type d'automation à afficher.

Départ en mode Automation Safe

Vous pouvez facilement basculer d'une vue de 
piste vers une autre. Reportez-vous à la 
section « Changement de vue de piste » à la 
page 227.

Affichage d'une playlist d'automation standard

Affichage d'une playlist d'automation de trim

Playlist d'automation de trim
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Lignes d'automation 
et de contrôleur
Dans la fenêtre Edit, vous pouvez afficher les données 
d'automation et de contrôleur sous une piste (quelle 
que soit la vue de piste sélectionnée). Chaque piste 
propose des lignes d'automation et de contrôleur, 
qui permettent d'éditer ses données d'automation et de 
contrôleur sans changer de vue. Vous pouvez 
modifier les données d'automation et de contrôleur 
sur les lignes de la même façon que dans les autres 
vues de piste d'automation et de contrôleur.

Vous pouvez afficher ou masquer les lignes 
d'automation et de contrôleur. Vous pouvez 
également ajouter ou supprimer des lignes. 
Ces lignes restent toujours sous la piste, mais vous 
pouvez les redimensionner et les réorganiser 
indépendamment les unes des autres.

Pour afficher ou masquer les lignes d'automation 
sous la vue de la piste principale :

 Cliquez sur le bouton Afficher/Masquer les lignes.

Pour ajouter une ligne :

 Cliquez sur le bouton Ajouter une ligne.

Pour supprimer des lignes :

 Cliquez sur le bouton Supprimer la ligne.

Pour modifier le type d'automation ou de contrôleur 
d'une ligne :

 Cliquez sur le sélecteur de type d'automation/ 
contrôleur et sélectionnez le type de votre choix.

Pour remplacer toutes les lignes d'automation 
et de contrôleur sous la piste par une seule ligne 
du type de contrôleur ou d'automation spécifié :

1 Effectuez un clic droit sur le bouton 
Afficher/Masquer les lignes.

2 Sélectionnez le type d'automation ou de 
contrôleur de votre choix.

Affichage d'une ligne d'automation

Bouton Affiche/
Masquer les

lignes

Supprimer
la ligne

Ajouter
une ligne Sélecteur de type 

d'automation

Sélection d'un type d'automation pour une ligne

Menu contextuel permettant de sélectionner une seule 
ligne d'automation ou de contrôleur



Chapitre 45 : Automation 1077

Pour redimensionner la hauteur de toutes les 
pistes d'automation et de contrôleur d'une piste, 
effectuez l'une des opérations suivantes :

 Effectuez un clic droit sur l'échelle de zoom 
verticale située à droite des commandes 
de la piste et sélectionnez la hauteur dans 
le menu contextuel.

 Faites glisser la ligne inférieure d'une colonne 
de commandes de ligne vers le haut ou le bas. 
Le curseur change de forme pour signaler que la 
ligne peut être redimensionnée.

Pour modifier la hauteur d'une seule piste 
d'automation ou de contrôleur d'une piste :

 Appuyez sur la touche Démarrer (Windows) 
ou Ctrl (Mac) tout en sélectionnant une hauteur 
de ligne.

Pour réorganiser les lignes :

 Pour réorganiser les lignes à l'écran, faites glisser 
la section de commande de la ligne vers une 
nouvelle position dans la fenêtre Edit.

Affichage des données 
d'automation de trim avec 
la playlist principale
(Pro Tools HD uniquement)

L'apparence des données d'automation de trim 
dépend de la façon dont elles sont fusionnées. 
Reportez-vous à la section « Fusion de 
l'automation de trim » à la page 1105. 

Si les données d'automation ne sont pas configurées de 
façon à être fusionnées après chaque passe 
d'automation, vous pouvez afficher les données 
d'automation de trim ainsi que les données principales 
d'automation de volume ou de niveau de départ dans la 
même vue d'automation. Cet affichage des données 
d'automation de trim ne peut pas être édité 
directement.

Pour afficher la playlist d'automation de trim avec 
la playlist d'automation principale sur les pistes :

 Sélectionnez View > Automation > Trim Playlist.

Appuyez sur Démarrer+Flèche haut ou bas 
(Windows) ou Ctrl+Flèche haut ou bas (Mac) 
pour augmenter ou réduire la hauteur 
des lignes contenant le curseur ou la sélection 
d'édition.

Affichage des données d'automation de trim dans une 
playlist principale de volume 

 

Données 
de trim 
de volume

Données 
de volume
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Affichage de la playlist 
d'automation composite
(Pro Tools HD uniquement)

Si les données d'automation ne sont pas configurées 
de façon à être fusionnées après chaque passe 
d'automation, vous pouvez afficher une playlist 
d'automation composite indiquant la contribution des 
données d'automation de trim dans les données 
principales d'automation de volume ou de niveau 
de départ. Cet affichage de playlist composite ne peut 
pas être édité directement.

La playlist composite s'affiche dans la playlist 
d'automation principale ainsi que dans la playlist 
d'automation de trim.

Pour afficher la playlist composite : 

 Sélectionnez View > Automation > Composite 

Playlist. 

Indicateurs AutoMatch
Des indicateurs AutoMatch triangulaires sont placés 
dans l'angle inférieur gauche de chaque tranche de la 
fenêtre Mix. Lorsqu'ils sont allumés, ils indiquent la 
direction dans laquelle le fader se déplacera 
automatiquement pour revenir à la valeur 
d'automation actuelle sur la piste. 

Affichage de la playlist d'automation de trim et de la 
playlist composite dans une playlist principale de volume 

Données de trim de volume

Playlist 
composite

Données de volume

Indicateurs AutoMatch triangulaires d'une tranche
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Écriture d'automation
Vous pouvez écrire une automation pour toutes les 
commandes automatisables en les déplaçant en 
cours de lecture ou d'enregistrement. 

Pour écrire une automation sur des pistes :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est activée pour ce 
type d'automation.

3 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation de chaque 
piste à automatiser, puis définissez le mode 
d'automation. Pour une première passe 
d'automation, sélectionnez Write.

4 Lancez la lecture pour démarrer l'écriture 
de l'automation.

5 Déplacez les commandes que vous souhaitez 
automatiser (telles qu'un fader de volume de 
piste).

6 Une fois l'opération terminée, arrêtez la lecture.

Après la première passe d'automation, vous pouvez 
écrire d'autres mouvements d'automation sur la piste 
sans effacer complètement le passage précédent, 
en mode Touch ou Latch. Ces modes ajoutent des 
données d'automation uniquement lorsque vous 
déplacez une commande. Pour plus d'informations, 
reportez-vous à la section « Modes d'automation » à 
la page 1068.

Pour ajouter des données d'automation à une 
passe antérieure :

1 Activez Options > Link Timeline and Edit 

Selection.

2 Dans la fenêtre Edit, créez une sélection 
ou placez le curseur au point où vous souhaitez 
écrire les données d'automation.

3 Dans la fenêtre Mix ou Edit, cliquez sur le sélecteur 
de mode d'automation de chacune des pistes à 
automatiser, puis sélectionnez le mode Touch ou 
Latch comme mode d'automation.

Activez l'option Enable Automation in Record 
des préférences de fonctionnement afin de 
pouvoir écrire des données d'automation en 
cours d'enregistrement.

Fenêtre Automation

Sélection du mode d'automation d'une piste
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4 Lancez la lecture pour démarrer l'écriture 
de l'automation. 

5 Déplacez les commandes à automatiser.

6 Une fois l'opération terminée, arrêtez la lecture.

Mémorisation de la position 
initiale d'une commande
Lors de la création d'une piste audio, d'une piste 
d'entrée auxiliaire, d'une piste Master VCA, d'une 
piste MIDI ou d'une piste d'instrument, le mode Read 
est automatiquement activé. Bien que la piste soit 
configurée en mode Read, vous pouvez définir la 
position initiale des commandes qu'il est possible 
d'automatiser. Cette position sera enregistrée avec la 
session.

Dans cet état initial, un seul point d'automation 
apparaît au début de chaque liste d'automation. 
Si vous déplacez la commande sans écrire 
de données d'automation, le point d'automation se 
déplace jusqu'à la nouvelle valeur.

Pour mémoriser de manière permanente 
la position initiale d'une commande pouvant être 
automatisée, procédez comme suit :

• Activez le mode Write sur la piste, puis appuyez 
sur Play pour écrire quelques secondes de 
données d'automation sur la piste.

• Insérez manuellement un point d'automation sur la 
playlist d'automation après le point d'automation 
initial. Reportez-vous à la section « Édition 
graphique de données d'automation » à la 
page 1095 pour plus d'informations.

Automation des commandes 
commutées
Lors de l'automation de commandes commutées 
(telles que le mute, le bypass de plug-ins ou les 
commandes commutées des plug-ins), Pro Tools 
traite ces commandes comme des commandes 
tactiles. Les données d'automation sont écrites tant 
que le commutateur ou le bouton associé à la 
commande est actionné ou touché.

Par exemple, si vous venez d'écrire plusieurs états 
Mute on/off se succédant rapidement sur une piste, 
vous pouvez effacer ces données d'automation 
manuellement dans la fenêtre Edit, en choisissant la 
playlist d'automation de Mute, en sélectionnant les 
données d'automation correspondantes, puis en les 
supprimant. Dans Pro Tools, cette opération peut être 
effectuée automatiquement.

Pour automatiser une commande commutée 
(telle que le bouton Mute) :

1 Effectuez une autre passe d'automation sur la 
piste.

2 Lorsque vous atteignez l'emplacement de l'état de 
mute à supprimer, appuyez sur la commande 
commutée (le bouton Mute, par exemple) 
et maintenez-la enfoncée. 

3 Tant que vous ne relâchez pas le bouton, Pro Tools 
remplace les données sous-jacentes sur la piste par 
l'état actuel du commutateur (activé ou désactivé) 
jusqu'à l'arrêt de la lecture. 

Si vous écrivez les données d'automation 
en mode Touch avec l'option Loop Playback 
activée, l'écriture s'arrête automatiquement à la 
fin de la boucle sélectionnée. Au début 
de chaque nouvelle boucle, vous pouvez alors 
toucher ou déplacer à nouveau la commande 
pour écrire de nouvelles données.

Lorsque la lecture parvient à la première 
section dont le son est muté, le bouton Mute 
s'allume. 
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Commandes commutées 
automatisées en mode Touch
Lors de l'automation de commandes commutées 
(y compris le mute, le bypass de plug-ins et toute 
commande commutée sur des plug-ins) en mode 
Touch, ces commandes conservent leur état actuel 
après avoir été touchées.

Toutefois, afin de conserver toute donnée 
d'automation d'une commande commutée à un 
moment ultérieur de la timeline, ce comportement 
« verrouillé » prend fin dans les cas suivants :

• En présence d'un point d'inflexion d'automation, 
Pro Tools interrompt l'écriture des données 
d'automation en ce point.

• Si vous arrêtez la lecture ou arrêtez l'opération 
d'écriture de données d'automation avant 
d'atteindre un point d'automation existant, 
Pro Tools applique la fonction AutoMatch sur 
l'état d'automation sous-jacent.

Configuration d'un 
comportement temporaire des 
commandes commutées
Dans certaines situations, notamment lors 
du remplacement ou de l'extension de l'automation de 
la commande Mute, vous pouvez écrire 
temporairement les données d'automation d'une 
commande en la maintenant enfoncée, ce qui évite 
d'utiliser le verrouillage de la commande.

Pour configurer un comportement temporaire 
des commandes commutées : 

1 Sélectionnez Options > Preferences, puis 
cliquez sur Mixing.

2 Désélectionnez Latching Behavior for Switch 

Controls in "Touch".

3 Cliquez sur OK pour fermer la fenêtre des 
préférences.

Automation des départs 
Pro Tools permet d'automatiser dynamiquement le 
niveau, le mute et le panoramique des départs 
(aux formats stéréo et multicanal uniquement). 
Le niveau et le positionnement des effets sont ainsi 
plus faciles à contrôler avec précision lors du 
mixage final.

Il est également possible de configurer le niveau et le 
mute des départs pour qu'ils suivent les groupes. 

Pour automatiser le niveau, le mute ou le 
panoramique d'un départ :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée pour ce type d'automation 
(niveau, mute et panoramique de départ).

2 Dans la fenêtre Mix ou Edit, définissez le mode 
d'automation de chaque piste contenant des 
départs à automatiser. Pour chaque piste, cliquez 
sur le sélecteur de mode d'automation, puis 
définissez le mode d'automation. Pour une 
première passe d'automation, optez pour le mode 
Write.

3 Si les départs ne sont pas actuellement visibles 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A–E (ou Sends F–J).

4 Pour afficher les commandes de départ, 
exécutez l'une des actions suivantes :

• Cliquez sur le départ à automatiser pour ouvrir la 
fenêtre Output correspondante.

• Sélectionnez View > Sends A-E (ou Sends F-J) 
et sélectionnez une des vues individuelles (Send 
A, par exemple).

5 Lancez la lecture pour démarrer l'écriture 
de l'automation. 

6 Déplacez les commandes à automatiser.

7 Une fois l'opération terminée, arrêtez la lecture. 

Il est également possible de configurer le niveau, le 
mute et le panoramique des départs de façon à 
suivre les groupes de mixage (reportez-vous à la 
section « Préférences d'automation » à la 
page 1073). 
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Copie de l'automation de piste 
sur les départs
(Pro Tools HD uniquement)

Les paramètres de départ ou les données 
d'automation d'une piste doivent parfois refléter ceux 
ou celles de la piste elle-même, par exemple lors de la 
création d'un mixage casque basé sur le mixage 
principal ou lorsque le niveau d'un effet doit 
impérativement suivre les niveaux d'un mixage 
principal. Vous pouvez copier les paramètres actuels 
ou l'intégralité de la playlist d'automation des 
commandes sélectionnées dans la playlist 
correspondante pour le départ.

Pour copier les paramètres ou les données 
d'automation d'une piste sur l'un de ses départs :

1 Sélectionnez les pistes à modifier en cliquant 
sur leur nom pour les mettre en surbrillance.

2 Sélectionnez Edit > Automation > Copy to Send.

3 Dans la boîte de dialogue Copy To Send, 
effectuez l'une des opérations suivantes : 

• Sélectionnez Current Value pour copier les 
paramètres actuels des commandes 
correspondantes. 

• Sélectionnez Automation pour copier 
l'intégralité de la playlist d'automation 
des commandes correspondantes.

4 Sélectionnez les commandes à copier. 

5 Sélectionnez les départs sur lesquels vous 
souhaitez copier les données d'automation, puis 
cliquez sur OK.

Vous pouvez annuler les effets de la commande 
Copy To Send.

Automation de plug-ins 
Vous pouvez automatiser les réglages de la plupart 
des commandes de plug-in. L'automation d'un plug-
in diffère légèrement d'autres procédures 
d'automation : il est en effet nécessaire d'activer 
l'automation de chaque commande du plug-in. 

Pour activer l'automation des commandes 
d'un plug-in : 

1 Ouvrez la fenêtre du plug-in que vous souhaitez 
automatiser.

2 Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton d'activation de 
l'automation de la fenêtre du plug-in.

• Maintenez les touches Ctrl+Alt+Démarrer 
(Windows) ou Commande+Option+Ctrl (Mac) 
enfoncées et cliquez sur le sélecteur de vue 
de piste dans la fenêtre Edit.Boîte de dialogue Copy To Send

Bouton Automation Enable pour accéder à la boîte 
de dialogue Plug-In Automation
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3 Dans la boîte de dialogue Plug-in Automation, 
sélectionnez les commandes à automatiser, puis 
cliquez sur Add. Si une piste comporte plusieurs 
plug-ins, vous pouvez en sélectionner certains en 
cliquant sur le bouton correspondant dans la zone 
Inserts de la boîte de dialogue. 

4 Cliquez sur OK pour fermer la boîte de dialogue 
Plug-In Automation.

Pour automatiser un plug-in :

1 Dans la fenêtre Plug-In Automation Enable, 
assurez-vous que l'automation de plug-in est 
activée pour les commandes que vous souhaitez 
automatiser.

2 Dans la fenêtre Mix ou Edit, pour chaque piste 
contenant des plug-ins à automatiser, cliquez sur le 
sélecteur de mode d'automation, puis définissez le 
mode d'automation. Pour une première passe 
d'automation, sélectionnez Write.

3 Lancez la lecture pour commencer l'écriture de 
l'automation et déplacez les commandes 
à automatiser.

4 Une fois l'opération terminée, arrêtez la lecture.

Activation de l'automation pour 
des paramètres de plug-in 
individuels
Vous pouvez activer des commandes de plug-in 
individuelles directement depuis la fenêtre 
du plug-in.

Pour activer un paramètre de plug-in depuis 
la fenêtre du plug-in :

1 Assurez-vous que la fenêtre du plug-in 
à automatiser est ouverte. 

2 Cliquez sur la commande du paramètre tout 
en maintenant les touches Commande+ 
Option+Ctrl (Mac) ou Ctrl+Alt+Démarrer 
(Windows) enfoncées.

Activation de l’automation pour 
tous les paramètres de plug-in

Pour activer tous les paramètres d'un plug-in :

1 Assurez-vous que la fenêtre du plug-in 
à automatiser est ouverte. 

2 Tout en maintenant les touches Ctrl+Alt+ 
Démarrer (Windows) ou Commande+Option+ 
Ctrl (Mac) enfoncées, cliquez sur le bouton 
Auto situé en haut de la fenêtre du plug-in. 

Boîte de dialogue Plug-In Automation

Activation de l'automation de plug-in pour des 
paramètres individuels
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Activation automatique de 
l'automation des plug-ins
Vous pouvez configurer Pro Tools de façon à ce 
qu'il active automatiquement l'automation pour 
toutes les commandes d'un plug-in lorsque celui-ci 
est ajouté à votre session. 

Pour activer automatiquement l'automation 
de toutes les commandes d'un plug-in :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sélectionnez Plug-In Controls Default to 

Auto-Enabled.

3 Cliquez sur OK pour fermer la fenêtre 
des préférences.

Indication du mode d'automation 
pour les paramètres de plug-in
Dans la fenêtre de plug-in, les commandes de plug-in 
sont mises en surbrillance de différentes couleurs afin 
d'indiquer si elles sont automatisées ou non, ainsi que 
leur mode d'automation. Si un paramètre est contrôlé 
par une surface de contrôle (telle qu'une D-Command 
ou Command|8), sa couleur change également. 

Le tableau suivant indique le codage couleur des 
paramètres de plug-in automatisés, avec et sans 
surface de contrôle.

Protection contre l'enregistrement 
de l'automation de plug-in
Le mode Automation Safe empêche le remplacement 
des données d'automation d'un plug-in.

Pour activer le mode de protection d'un plug-in :

1 Ouvrez un plug-in. 

2 Cliquez sur le bouton Safe pour le mettre 
en surbrillance.

Commandes AutoMatch
(Pro Tools HD uniquement)

Utilisez le bouton AutoMatch de la fenêtre 
Automation pour configurer automatiquement les 
commandes d'automation sur leurs niveaux 
d'automation existants.

Utilisation de la fonction 
AutoMatch sur toutes 
les commandes
Vous pouvez appliquer automatiquement les 
niveaux d'automation actuels des commandes aux 
commandes d'écriture actuelles.

Codage couleur des paramètres de plug-in automatisés

Mode 
d'automation

Off Read
Touch, 
Latch, 
Write

Pas de surface 
de contrôle

Aucune Vert Rouge

Surface 
de contrôle

Aucune Bleu Jaune

Mode Automation Safe activé sur un plug-in

Bouton AutoMatch de la fenêtre Automation
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Pour appliquer la fonction AutoMatch à toutes les 
commandes d'écriture actuelles :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour 
les types d'automation auxquels vous souhaitez 
appliquer la fonction AutoMatch.

3 Lancez la lecture. 

4 Lorsque vous atteignez un point de la piste auquel 
vous souhaitez rétablir les valeurs d'écriture 
de commandes précédentes, cliquez sur le bouton 
AutoMatch de la fenêtre Automation.

Toutes les commandes d'écriture actuelles cessent 
d'écrire des données d'automation et reprennent 
leurs valeurs d'écriture précédentes définies par le 
paramètre AutoMatch Time dans les préférences 
de mixage.

Utilisation de la fonction 
AutoMatch sur des pistes 
individuelles
Vous pouvez appeler la fonction AutoMatch sur 
des pistes individuelles. Toutes les commandes 
écrivant des données d'automation sur la piste 
s'arrêtent et reprennent leurs niveaux d'automation 
existants.

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'une piste :

 Cliquez sur le sélecteur de mode d'automation de 
la piste tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée.

Utilisation de la fonction 
AutoMatch avec des types 
d'automation individuels
Vous pouvez appeler la fonction AutoMatch sur 
des types d'automation individuels dans une 
session entière. 

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un type d'automation donné :

 Dans la fenêtre Automation, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
et cliquez sur le bouton du type d'automation 
(Volume, Pan, Mute, Plug-In, Send Level, Send 
Pan ou Send Mute). 

Utilisation de la fonction 
AutoMatch sur des commandes 
individuelles
(D-Control et D-Command uniquement)

Sur des surfaces de travail ICON, vous pouvez 
appeler la fonction AutoMatch sur des commandes 
ou types de commandes individuels de canaux 
uniques.

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un type donné sur un seul canal :

 Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur l'une 
des commandes suivantes parmi les commandes 
Channel Strip Mode de la piste pour laquelle 
la fonction AutoMatch doit être activée :

• Inserts

• Sends

• Pan

• Dyn (D-Control uniquement)

• EQ (D-Control uniquement)
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Pour appliquer la fonction AutoMatch à une 
commande de panoramique ou aux commandes 
d'un insert ou d'un départ individuel :

1 Appuyez sur le commutateur situé dans la section 
des commandes Channel Strip Mode pour afficher 
les commandes de panoramique ou le niveau 
supérieur des inserts ou des départs du canal. 

2 Tout en maintenant la touche Ctrl (Windows) ou la 
touche Commande (Mac) enfoncée, appuyez sur 
le commutateur de sélection du codeur rotatif 
correspondant à la commande à laquelle appliquer 
la fonction AutoMatch :

• Pour les départs, la fonction AutoMatch est 
appliquée au niveau, au panoramique et au mute 
des départs. 

• Pour les inserts, la fonction AutoMatch est 
appliquée à toutes les commandes automatisées. 

• Pour le panoramique, la fonction AutoMatch est 
appliquée à tous les curseurs de panoramique du 
canal. 

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un plug-in affiché dans la section 
Dynamics ou EQ :

 Tout en maintenant la touche Ctrl (Windows) ou 
la touche Commande (Mac) enfoncée, appuyez 
sur le commutateur Auto de la section Dyn ou 
EQ de la console. 

Préparation des commandes 
pour l'écriture d'automation 
en mode Latch
(Pro Tools HD uniquement)

Lorsqu'une piste est en mode d'automation Latch 
ou Touch/Latch, vous pouvez préparer des 
commandes individuelles pour l'écriture de données 
d'automation pendant l'arrêt du transport. La fonction 
Latch Prime permet de préparer une passe 
d'automation avant le début de la lecture.

Pour préparer les commandes à une automation 
d'écriture en mode Latch pendant l'arrêt 
du transport :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Dans la section Automation, sélectionnez Allow 

Latch Prime in Stop.

3 Cliquez sur OK pour fermer la fenêtre 
des préférences.

4 Dans la fenêtre Automation, assurez-vous que 
les commandes à automatiser sont activées pour 
l'écriture.

5 Cliquez sur le sélecteur de mode d'automation 
de la piste sur laquelle écrire les données 
d'automation, puis effectuez l'une des 
opérations suivantes :

• Sélectionnez le mode Latch pour autoriser la 
préparation de toutes les commandes de la piste 
pour lesquelles l'automation est activée.

• Sélectionnez le mode Touch/Latch pour laisser 
le fader principal du volume en mode Touch et 
autoriser la préparation de toutes les autres 
commandes pour lesquelles l'automation est 
activée.
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6 Pendant que le transport est arrêté, touchez ou 
déplacez les commandes devant démarrer 
l'écriture au début de la passe d'automation. 
Lorsqu'une ou plusieurs commandes d'une piste 
sont préparées, le sélecteur de mode 
d'automation s'affiche en rouge.

7 Lancez la lecture. Toutes les commandes 
préparées démarrent l'écriture des données 
d'automation à leurs valeurs préparées.

8 Arrêtez la lecture pour mettre fin à la passe 
d'automation. Toutes les pistes sont sorties de 
leur état Latch Prime.

Sortie des pistes et commandes 
de l'état Latch Prime
Vous pouvez sortir une piste ou un type 
d'automation de son état Latch Prime avant 
ou pendant une passe d'automation. 

 Lorsque vous sortez une piste ou un type 
d'automation de son état Latch Prime avant 
de démarrer la lecture, il reste en mode Latch mais 
ses commandes ne sont pas préparées pour 
l'écriture lorsque la lecture démarre.

 Lorsque vous sortez une piste ou un type 
d'automation de son état Latch Prime pendant une 
passe d'automation, les commandes 
correspondantes sont automatiquement assorties 
à leurs valeurs écrites actuelles.

 Si vous appliquez la fonction AutoMatch à une 
commande en mode Latch Prime, cette commande 
ne sera plus préparée. 

Pour sortir une piste de son état Latch Prime :

 Cliquez sur le sélecteur de mode d'automation de 
la piste tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée. 

Le bouton du sélecteur ne s'affiche plus en gras 
pour signaler que la piste n'est plus préparée.

Pour sortir toutes les pistes de leur état Latch 
Prime, effectuez l'une des opérations suivantes :

 Cliquez sur le sélecteur de mode d'automation 
d'une piste tout en maintenant les touches 
Alt+Ctrl (Windows) ou Option+Commande 
(Mac) enfoncées. 

 Dans la fenêtre Automation, cliquez sur le 
bouton AutoMatch. 

Indicateur du mode d'automation avant (à gauche) 
et après (à droite) la préparation des 
commandes verrouillées

Vous pouvez utiliser la commande Write to 
Punch à la fin de la passe d'automation pour 
réécrire la valeur actuelle au début de la 
passe. 

Bouton AutoMatch de la fenêtre Automation
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Pour sortir toutes les pistes sélectionnées de leur 
état Latch Prime, effectuez l'une des opérations 
suivantes :

 Cliquez sur le sélecteur de mode d'automation 
d'une piste tout en maintenant les touches 
Alt+Ctrl+Maj (Windows) ou 
Option+Commande+Maj (Mac) enfoncées. 

 Maintenez les touches Option+Maj (Mac) ou 
Alt+Maj (Windows) enfoncées tout en cliquant sur 
le bouton AutoMatch de la fenêtre Automation. 

Pour sortir un type d'automation de son état Latch 
Prime sur toutes les pistes, effectuez l'une des 
opérations suivantes :

 Dans la fenêtre Automation, maintenez la 
touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et cliquez sur le bouton du type 
d'automation (Volume, Pan, Mute, Plug-In, 
Send Level, Send Pan ou Send Mute). 

Parcours des points d'entrée 
d'automation en mode Latch 
Prime
Après avoir préparé les commandes pour l'écriture des 
données d'automation pendant l'arrêt du transport, vous 
pouvez configurer Pro Tools de façon à ce qu'il insère 
automatiquement un point d'entrée après l'envoi d'une 
commande Back and Play, ou après un retour et 
verrouillage au timecode.

Pour configurer Pro Tools de façon à ce qu'il 
insère automatiquement l'écriture de données 
d'automation sur une piste :

1 Recherchez le curseur à l'endroit duquel insérer 
les données d'automation. 

2 Préparez les commandes pour l'écriture pendant 
l'arrêt du transport. Pour plus d'informations, 
reportez-vous à la section « Préparation des 
commandes pour l'écriture d'automation en mode 
Latch » à la page 1086.

3 Dans la fenêtre Automation, cliquez sur 
le bouton AutoJoin.

4 Dans la fenêtre Automation, cliquez sur le bouton 
Capture, puis sur le bouton Punch Capture. 
L'indicateur AutoJoin (ligne rouge verticale) 
s'affiche à l'écran au point de punch-in.

Boutons des types d'automation de la fenêtre Automation

Bouton Capture de la fenêtre Automation

Bouton Punch Capture de la fenêtre Automation
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5 Envoyez une commande Back and Play, recalez la 
machine externe sur un point antérieur au point de 
punch-in ou activez le pré-roll.

6 Lancez la lecture. Lorsque le transport atteint le 
point de punch-in, l'écriture des données 
d'automation démarre.

Activation et suspension 
de l'automation
Dans la fenêtre Automation, vous pouvez activer 
ou suspendre l'écriture des types d'automation 
suivants sur toutes les pistes :

• Volume

• Trim de volume

• Panoramique

• Mute

• Plug-in

• Niveau de départ

• Trim de niveau de départ

• Panoramique de départ

• Mute de départ

L'automation peut être suspendue ou activée en cours 
de lecture (sans avoir à arrêter le transport).

Suspension de l'automation sur 
toutes les pistes
Pour suspendre l'automation sur toutes les pistes :

1 Sélectionnez Window > Automation. 

2 Effectuez l'une des opérations suivantes :

• Pour suspendre l'écriture de toutes les données 
d'automation sur toutes les pistes, cliquez sur le 
bouton Suspend.

• Pour suspendre l'écriture d'un type de données 
d'automation particulier sur toutes les pistes, 
cliquez sur le bouton de ce type (volume, mute, 
panoramique, plug-in, niveau de départ, mute de 
départ ou panoramique de départ).

Pour suspendre l'automation de trim sur toutes les 
pistes (Pro Tools HD uniquement) :

 Dans la fenêtre Automation, cliquez sur le 
bouton Suspend tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée. 

Le bouton Suspend s'allume en jaune pour indiquer 
que l'automation de trim est suspendue. 

Suspension de l'automation 
de commandes individuelles
Vous pouvez suspendre l'automation d'une 
ou plusieurs commandes. Lorsqu'une commande 
est suspendue, son nom s'affiche en italique dans le 
sélecteur de vue de piste.

Bouton Suspend de la fenêtre Automation

La suspension de l'automation à partir de la 
fenêtre Edit prend en compte les groupes 
d'édition. Pour supprimer le comportement de 
groupe, maintenez la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée lors de la 
suspension d'une commande.
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Pour suspendre l'automation de commandes 
individuelles d'une piste :

1 Dans la fenêtre Edit, configurez le sélecteur 
de vue de piste pour qu'il affiche la playlist 
d'automation de la commande que vous 
souhaitez suspendre.

2 Effectuez l'une des opérations suivantes :

• Pour suspendre l'écriture et la lecture des données 
d'automation de la commande affichée 
uniquement, cliquez sur son nom dans le sélecteur 
de vue de piste tout en appuyant sur la touche Ctrl 
(Windows) ou Commande (Mac).

• Pour suspendre l'écriture et la lecture des données 
d'automation de toutes les commandes, maintenez 
les touches Ctrl+Maj (Windows) 
ou Commande+Maj (Mac) enfoncées et cliquez 
sur leur nom dans le sélecteur de vue de piste.

• Pour suspendre l'écriture et la lecture des 
données d'automation d'une commande 
spécifique sur toutes les pistes, maintenez les 
touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac) enfoncées et cliquez 
sur son nom dans le sélecteur de vue de piste.

Pour suspendre l'automation de trim pour des 
commandes individuelles d'une piste 
(Pro Tools HD uniquement) :

1 Dans la fenêtre Edit, configurez le sélecteur 
de vue de piste pour qu'il affiche la playlist 
d'automation de la commande de trim 
à suspendre (trim de volume ou trim de niveau 
de départ). 

2 Effectuez l'une des opérations suivantes :

• Pour suspendre uniquement la commande 
de trim affichée sur une seule piste, cliquez sur 
son nom dans le sélecteur de vue de piste tout en 
appuyant sur la touche Ctrl (Windows) ou 
Commande (Mac).

• Pour suspendre la commande de trim affichée 
sur toutes les pistes, cliquez sur son nom dans le 
sélecteur de vue de piste tout en appuyant sur les 
touches Ctrl+Alt (Windows) ou 
Commande+Option (Mac).

Affichage de l'état d'activation 
de l'automation

Sélecteurs de mode d'automation de piste

 Lorsque l'automation est activée pour une piste 
mais que l'automation d'écriture ne l'est pas, 
le sélecteur de mode affiche le nom du mode en 
texte rouge normal. 

 Lorsque l'automation d'écriture est activée pour 
la commande d'une piste, le sélecteur de mode 
d'automation affiche le nom du mode surligné en 
rouge.

Boutons de la fenêtre Automation

 Lorsque l'automation d'écriture est activée pour 
un type d'automation d'une piste de la session, 
le bouton correspondant s'affiche en texte rouge 
gras dans la fenêtre Automation. 

 Lorsqu'un type d'automation est activé mais 
n'effectue aucun enregistrement dans la session, 
le bouton correspondant s'affiche en texte rouge 
normal dans la fenêtre Automation. 

Sélecteur de mode d'automation indiquant l'état activé 
(à gauche) et l'état écriture (à droite)

Fenêtre Automation contenant divers états d'automation

Activé

Non activé
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Instructions d'activation 
de l'automation
Les règles ci-après déterminent si l'automation est 
activée sur une piste :

 Bien que Pro Tools n'affiche qu'un seul mode 
d'automation pour chaque piste, toutes les 
commandes pouvant être automatisées et qui sont 
associées à cette piste ne sont pas forcément 
configurées dans ce mode.

 Si l'automation est suspendue globalement dans la 
fenêtre Automation, toutes les commandes pouvant 
être automatisées se comportent comme si elles 
étaient désactivées et ce, quel que soit le mode 
d'automation de la piste.

 Lorsque vous suspendez une commande 
d'automation en cliquant dessus tout en appuyant sur 
la touche Ctrl (Windows) ou Commande (Mac) dans 
le sélecteur de vue de piste, elle se comporte comme 
si elle était désactivée et ce, quel que soit le mode 
d'automation de la piste.

 Si une commande d'automation est suspendue 
dans la fenêtre Automation, elle se comporte 
comme si elle était en mode Read lorsque la piste est 
configurée dans un mode d'automation autorisant 
l'écriture de données (Touch, Latch ou Write).

Suppression de données 
d'automation
Les données d'automation se présentent sous la forme 
d'une ligne graphique avec des points d'automation 
modifiables. Le moyen le plus facile de supprimer 
l'automation d'une piste ou d'une sélection consiste 
à supprimer manuellement les points d'inflexion de la 
playlist d'automation.

Cette méthode de suppression des données diffère 
de la commande Cut qui crée des points 
d'automation ancrés aux limites des données 
restantes. Pour plus de détails, reportez-vous à la 
section « Coupe, copie et collage d'automation » à 
la page 1099. 

Pour supprimer des données d'automation, 
affichez la playlist d'automation à modifier en la 
sélectionnant dans le sélecteur de vue de piste ou 
en l'affichant dans la ligne d'automation, puis 
effectuez l'une des opérations suivantes :

Pour supprimer un seul point d'automation :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le point 
d'automation avec le Crayon ou l'un des outils 
de saisie.

Pour supprimer plusieurs points d'automation en 
une seule opération :

 Sélectionnez une plage contenant des points 
d'automation à l'aide du Sélecteur, puis appuyez 
sur la touche Retour arrière (Windows) ou 
Supprimer (Mac).

Pour supprimer toutes les données d'automation 
du type affiché :

 Cliquez sur la piste avec le Sélecteur et 
sélectionnez Edit > Select All, puis appuyez sur 
la touche Retour arrière (Windows) ou 
Supprimer (Mac).
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Pour supprimer toutes les données d'automation 
de toutes les playlists d'automation d'une piste :

1 Sélectionnez une plage de données à supprimer 
à l'aide du Sélecteur.

2 Appuyez sur Ctrl+Supprimer (Mac) 
ou Démarrer+Retour arrière (Windows).

Toutes les données d'automation se trouvant dans 
la sélection sont supprimées de toutes les playlists 
d'automation de cette piste, que l'écriture 
d'automation soit activée ou non pour ces 
commandes.

Suppression d'une automation 
de trim
(Pro Tools HD uniquement)

Si l'automation de trim n'a pas été fusionnée sur 
une piste, vous pouvez la supprimer. Lorsque vous 
supprimez l'automation de trim, les points 
d'automation de toutes les playlists de trim sont 
supprimés et tous les faders de trim sont remis 
à zéro.

Pour supprimer une automation de trim :

1 Sélectionnez la piste sur laquelle supprimer 
l'automation de trim.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Clear Trim Automation.

• Effectuez un clic droit sur le nom de la piste, 
puis sélectionnez Clear Trim Automation.

Affinage de l'automation
Lors d'une passe d'automation, Pro Tools écrit des 
données d'automation avec une densité maximale, 
sous la forme de points d'automation. Pro Tools 
créant des rampes entre les points d'automation, tous 
les points acquis ne sont pas forcément 
indispensables à la restitution sonore précise des 
mouvements d'automation exécutés. Chaque point 
d'automation occupe de l'espace dans la mémoire 
affectée à l'automation ; l'affinage des données par la 
suppression de points d'automation inutiles peut donc 
optimiser l'efficacité et les performances du système.

Pro Tools offre deux méthodes d'affinage des 
données d'automation : l'affinage automatique 
avec l'option Smooth and Thin Data After Pass 
et l'affinage manuel avec les commandes 
Thin Automation.

Smooth and Thin Data After Pass
Lorsque cette option est sélectionnée dans les 
préférences de mixage, Pro Tools procède 
automatiquement à l'affinage des données des 
points d'automation après chaque passe.

À la création d'une nouvelle session, l'option 
Smooth and Thin Data After Pass est sélectionnée 
par défaut et le paramètre Degree of Thinning est 
défini sur Some. Dans la plupart des cas, 
ce paramètre génère des performances optimales 
et reproduit précisément les mouvements 
d'automation.

Si l'option None est sélectionnée pour le paramètre 
Degree of Thinning, Pro Tools écrit le maximum 
de points d'automation possible. Vous pouvez 
affiner l'automation à tout moment, à l'aide de la 
commande Thin Automation. Pour plus 
d'informations sur le lissage des données 
d’automation, reportez-vous à la section 
« Lissage » à la page 1073.
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Commandes Thin Automation
Les commandes Thin Automation et Thin All 

Automation permettent d'affiner des zones 
sélectionnées, sur lesquelles les données 
d'automation sont trop denses. Vous pouvez 
utiliser la commande Undo pour visualiser les 
résultats de l'affinage (comparaison avec et sans 
affinage) avant de les appliquer définitivement.

Pour affiner manuellement l'automation :

1 Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher le type d'automation 
à affiner, ou affichez la ligne d'automation 
correspondante.

2 À l'aide du Sélecteur, mettez en surbrillance les 
données d'automation à affiner. Pour affiner les 
données d'automation de la piste dans son 
intégralité, cliquez sur la piste à l'aide du Sélecteur 
et sélectionnez Edit > Select All.

3 Effectuez l'une des opérations suivantes :

• Pour affiner uniquement le type d'automation 
actuellement affiché, sélectionnez Edit > 

Automation > Thin.

• Pour affiner tous les types d'automation, 
sélectionnez Edit > Automation > Thin All.

Dessin d'automation
Vous pouvez utiliser le Crayon pour créer des 
événements d'automation pour des pistes audio et 
MIDI, en les dessinant dans une playlist 
d'automation ou de contrôleur MIDI quelconque, 
y compris l'automation de trim si elle n'a pas été 
fusionnée.

Le Crayon peut être configuré pour dessiner une 
série d'événements d'automation avec les formes 
suivantes :

Main libre : permet de dessiner librement en faisant 
glisser la souris. Sur les pistes audio, la forme 
contient le nombre de points d'automation requis 
pour interpoler et reproduire avec fluidité la forme de 
l'automation. Sur les pistes MIDI, la forme est 
reproduite sous forme d'une série de pas, 
conformément au paramètre de résolution défini dans 
les préférences MIDI.

Ligne : cet outil dessine une ligne droite. Sur les 
pistes audio, la ligne comporte un point d'automation 
à chaque extrémité. Sur les pistes MIDI, la valeur du 
contrôleur change par paliers selon la résolution 
définie dans les préférences MIDI.

Triangle : cet outil dessine un motif en dents 
de scie répété à une fréquence définie par la valeur 
de grille. Sur les pistes audio, le motif comporte un 
point d'automation à chaque extrémité. Sur les 
pistes MIDI, la valeur du contrôleur change par 
paliers selon la résolution définie dans les 
préférences MIDI. L'amplitude est contrôlée par le 
mouvement vertical du Crayon. 

Carré : cet outil dessine un motif carré répété à une 
fréquence définie par la valeur de grille. 
L'amplitude est contrôlée par le mouvement 
vertical du Crayon. 
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Aléatoire : cet outil dessine un motif aléatoire dont 
le niveau évolue à une fréquence définie par la 
valeur de grille fixée. L'amplitude est contrôlée par 
le mouvement vertical du Crayon.

Utilisation des formes du 
Crayon
Vous pouvez dessiner une automation pour des 
pistes audio ou MIDI. Par exemple, utilisez 
le motif Triangle pour contrôler des fonctions 
continues ou le motif Carré pour contrôler une 
fonction commutée, telle qu'une commande Mute 
ou Bypass.

Le Crayon dessinant ces formes à partir de la valeur 
de grille, vous pouvez l'utiliser pour générer 
un panoramique cadencé au tempo d'un morceau de 
musique, ou pour caler des effets de changement de 
plan à l'image près en post-production.

Résolution des données 
de contrôleur MIDI
Si vous utilisez le Crayon pour dessiner des données 
d'automation MIDI, elles prennent l'aspect de paliers 
successifs. Vous pouvez contrôler la résolution 
(ou densité) de ces paliers afin de faciliter la gestion de 
la quantité de données MIDI envoyées pour un 
mouvement de contrôleur MIDI donné.

Pour configurer la résolution du Crayon :

1 Sélectionnez Setup > Preferences, puis cliquez 
sur MIDI.

2 Indiquez une valeur pour l'option Pencil Tool 

Resolution When Drawing Controller Data. Cette 
valeur peut aller de 1 à 100 millisecondes.

3 Cliquez sur OK pour fermer la fenêtre 
des préférences.

Les illustrations ci-après représentent les mêmes 
données d'automation de contrôleur MIDI dessinées 
avec différentes résolutions du Crayon.

Pour optimiser les performances, il est possible de 
définir une valeur inférieure pour les commandes 
MIDI nécessitant une résolution plus élevée 
(le volume MIDI, par exemple) et une valeur 
supérieure pour celles qui ne nécessitent pas 
une résolution importante (le panoramique, 
par exemple).

Les formes de Crayon parabolique et courbe 
en S ne sont pas disponibles pour l'édition des 
données d'automation.

Pour plus d'informations sur les données de 
contrôleur continu MIDI, reportez-vous à la 
section « Événements de contrôleur 
continu » à la page 712.

Données MIDI dessinées avec une résolution de 10 ms 

Données MIDI dessinées avec une résolution de 100 ms 
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Édition de l'automation
Dans Pro Tools, plusieurs méthodes d'édition des 
données d'automation sont disponibles pour 
l'ensemble des pistes d'une session, y compris pour 
l'automation de trim lorsqu'elle n'a pas été fusionnée 
(Pro Tools HD uniquement). Vous pouvez éditer les 
données d'automation graphiquement, en ajustant les 
points d'automation d'une playlist d'automation. 
Vous pouvez également couper, copier et coller les 
données d'automation comme s'il s'agissait de 
données audio ou MIDI.

Édition graphique de données 
d'automation
Les données d'automation se présentent sous 
la forme d'une ligne graphique avec des points 
d'automation éditables. 

Faites glisser ces points d'automation pour modifier 
les données d'automation directement dans la fenêtre 
Edit et les fenêtres de l'éditeur MIDI. Lorsque vous 
déplacez un point d'automation vers le haut ou le bas, 
le changement de valeur s'affiche en chiffres ou en 
lettres. 

Le déplacement d'un point d'automation vers 
la gauche ou la droite permet d'ajuster la position 
temporelle de l'événement d'automation. 

Pour afficher un type d'automation de piste 
spécifique, sélectionnez la vue de piste 
correspondante ou affichez la ligne d'automation ou 
de contrôleur correspondante sous la piste.

Utilisation des outils de saisie

Les outils de saisie permettent de créer de nouveaux 
points d'automation en cliquant sur la ligne graphique 
ou d'ajuster des points existants en les déplaçant. 
Cliquez sur les points d'automation avec la Main tout 
en appuyant sur la touche Alt (Windows) ou Option 
(Mac) pour les supprimer.

Utilisation du Crayon

Le Crayon permet de créer des points d'automation en 
cliquant sur la courbe de gain. Cliquez sur les points 
d'automation avec le Crayon tout en appuyant sur la 
touche Alt (Windows) ou Option (Mac) pour les 
supprimer.

Point d'automation

Valeur d'un point d'automation

Création d'un point d'automation avec la Main

Suppression d'un point d'automation avec le Crayon
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Utilisation des outils de trim

Les outils de trim permettent de déplacer les points 
d'automation sélectionnés vers le haut ou le bas en 
les faisant glisser à partir d'un point quelconque de 
la sélection.

Édition des types d'automation
Chaque commande automatisable dispose de sa 
propre playlist d'automation. Pour l'afficher, 
sélectionnez-la dans le sélecteur de vue de piste. 
« Affichage de l'automation » à la page 1075.

Édition d'une automation de volume

Faites glisser un point d'automation vers le haut ou 
le bas pour modifier le volume (valeur en dB). 
Déplacez un point d'automation vers la gauche ou la 
droite pour ajuster la durée du changement de 
volume.

Édition d'une automation de panoramique

Faites glisser un point d'automation vers le bas pour 
un panoramique à droite, et vers le haut pour 
un panoramique à gauche. Déplacez un point 
d'automation vers la gauche ou la droite pour ajuster 
la durée des mouvements de panoramique.

Édition d'une automation de Mute

Faites glisser le point d'automation vers le bas pour 
muter une section. Faites glisser un point 
d'automation vers le haut pour démuter la section. 
Déplacez un point d'automation vers la gauche ou la 
droite pour ajuster la durée du mute.

Déplacement de points d'automation avec l'outil de trim

Automation du volume de piste

Automation de panoramique d'une piste

Automation de mute d'une piste
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Édition de l'automation en paliers d'une commande

L'automation de certaines commandes, notamment 
les valeurs des contrôleurs MIDI ou les paramètres 
des plug-ins, apparaît sous forme d'une succession 
de paliers sur la ligne d'automation. Faites glisser un 
point d'automation vers le haut ou le bas pour 
changer de palier et modifier la valeur de la 
commande. Déplacez un point d'automation vers la 
gauche ou la droite pour ajuster la durée des paliers.

Édition de points d'automation
Pour éditer les points d'automation, affichez 
la playlist d'automation de la commande à éditer 
en la sélectionnant dans le sélecteur de vue de 
piste, puis effectuez l'une des opérations 
suivantes :

Pour créer un point d'automation :

 Cliquez sur la ligne graphique avec le Crayon 
ou l'un des outils de saisie.

Pour éditer un seul point d'automation :

 Cliquez sur un point existant de la ligne 
graphique avec l'un des outils de saisie, puis 
déplacez-le.

Pour effacer un seul point d'automation :

 Cliquez sur un point d'automation avec l'un des 
outils de saisie tout en appuyant sur la touche 
Alt (Windows) ou Option (Mac).

Pour éditer plusieurs points d'automation en une 
seule opération :

 À l'aide du Sélecteur, sélectionnez une plage 
dans la playlist d'automation contenant les 
points d'automation, puis effectuez l'une des 
opérations suivantes :

• Appuyez sur la touche plus (+) pour placer les 
points d'automation plus tard sur la piste (vers la 
droite) ou sur la touche moins (-) pour les placer 
plus tôt (vers la gauche). Les points 
d'automation se déplacent de la valeur 
d'incrément actuelle.

• Pour ajuster la valeur des points d'automation, 
cliquez avec l'un des outils de trim sur 
la sélection, puis faites glisser les points 
d'automation vers le haut ou le bas.

Pour éditer les valeurs de tous les points 
d'automation d'un clip :

 Cliquez sur le clip avec l'un des outils de trim, 
puis faites glisser les points d'automation vers le 
haut ou le bas.

Automation de commande en paliers

Lorsque vous déplacez par incrément une 
sélection contenant des points d'automation, 
de nouveaux points d'ancrage sont créés si 
nécessaire pour préserver la pente de la 
courbe d'automation à l'intérieur de la 
sélection. 

Lorsque vous éditez une sélection contenant des 
points d'automation à l'aide d'un outil de trim, 
de nouveaux points d'ancrage sont créés avant 
et après la zone sélectionnée. Pour éviter la 
création de ces points d'ancrage, maintenez la 
touche Alt (Windows) ou Option (Mac) 
enfoncée lors de l'opération. 
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Restriction des nouveaux points 
d’automation à la valeur 
d’automation suivante ou 
précédente
Les nouveaux points d’automation peuvent être 
restreints et écrits avec la même valeur que celle du 
point d’automation suivant ou précédent.

Pour écrire un nouveau point d'automation à la 
valeur d'automation suivante :

 Tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées, 
écrivez un point d'automation (en cliquant 
à l'aide de l'un des outils de saisie sur la playlist 
d'automation de la piste).

Pour écrire un nouveau point d'automation à la 
valeur d'automation précédente :

 Tout en maintenant les touches Ctrl+Alt 
(Windows) ou Commande+Option (Mac) 
enfoncées, écrivez un point d'automation 
(en cliquant à l'aide de l'un des outils de saisie sur 
la playlist d'automation de la piste).

Édition d'automation sur des 
pistes stéréo et multicanal
Les pistes stéréo et multicanal affichent une seule 
playlist d'automation par piste. Une seule playlist 
de volume et de mute est disponible pour la piste 
stéréo ou multicanal.

Playlists d'automation de plug-in sur des pistes 
stéréo et multicanal

Certains plug-ins multicanal offrent un seul jeu de 
commandes pouvant être automatisées pour tous les 
canaux d'une piste. Certains plug-ins multicanal et 
tous les plug-ins multi-mono offrent un seul jeu de 
commandes pour tous les canaux lorsqu'ils sont 
couplés et des commandes séparées lorsqu'ils sont 
découplés. Pour plus d'informations, reportez-vous 
au guide de votre plug-in.

En ce qui concerne les plug-ins multi-mono, il est 
possible d'afficher et de modifier les playlists 
d'automation par canal lorsque les plug-ins sont 
découplés et que la piste affiche les lignes 
d'automation. 

Pour afficher et éditer les playlists individuelles 
d'un plug-in multi-mono :

1 Dissociez les canaux du plug-in. 

2 Sélectionnez la playlist d'automation dans 
le sélecteur de vue de piste ou affichez-la dans 
une ligne d'automation sous la piste.

Restriction et écriture de nouveaux points 
d’automation (au marqueur 1)

L'outil Smart ne peut pas être utilisé pour 
écrire un nouveau point d'automation à la 
valeur d'automation suivante ou précédente.

Après l'écriture au point 
d'automation suivant

Après l'écriture au point d'automation précédent 

Automation d’origine

Sélection d'une ligne d'automation pour une 
commande de plug-in multi-mono dissociée
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Édition d'automation sur des 
pistes groupées
Lorsque vous éditez les données d'automation sur 
une piste audio appartenant à un groupe d'édition 
actif, ce type d'automation est modifié sur toutes 
les pistes du groupe. Ce phénomène se produit 
également lorsque la playlist pour ce type 
d'automation n'est pas affichée sur les autres pistes 
groupées.

Exemples

 Si vous créez des points d'automation sur une 
piste appartenant à un groupe (à l'aide du Crayon 
ou de l'un des outils de saisie), les points 
d'automation des autres membres du groupe sont 
placés de manière relative à cette piste.

 Si vous déplacez une automation sur une piste 
appartenant à un groupe (à l'aide de l'un des outils 
de trim), un trimming relatif est appliqué aux 
points d'automation des autres membres du 
groupe. Vous pouvez ainsi effectuer un trim sur des 
sections entières d'un mix.

Pour éditer individuellement l'automation d'un 
membre de groupe sans affecter les autres 
membres, effectuez l'une des opérations suivantes :

 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée pendant l'opération.

Coupe, copie et collage 
d'automation
Couper des données d'automation n'équivaut pas à les 
supprimer : les résultats obtenus sont différents (bien 
que dans les deux cas, les données d'automation 
existantes soient modifiées). La copie laisse intactes 
les données d'automation originales.

Pour supprimer des données d'automation, 
sélectionnez une plage de points d'automation, puis 
appuyez sur la touche Retour arrière (Windows) ou 
Supprimer (Mac). Reportez-vous à la section 
« Suppression de données d'automation » à la 
page 1091 pour plus de détails.

Pour couper des données d'automation, 
sélectionnez une plage de points d'automation dans 
une playlist d'automation et sélectionnez la 
commande Cut.

Lorsque vous coupez des données d'automation, puis 
les collez à un nouvel emplacement, des points 
d'ancrage s'ajoutent aux points d'extrémité des 
données. Ce phénomène préserve la pente 
d'atténuation réelle (pour les commandes continues 
telles que les faders de volume ou les panoramiques) 
ou l'état (pour les commandes commutées ou 
discontinues telles que les Mutes) des données 
d'automation, tant à l'intérieur qu'à l'extérieur de la 
sélection.

Les figures ci-après illustrent les différences entre 
couper et supprimer des données d'automation. Sur la 
figure suivante, une piste est configurée pour afficher 
l'automation du volume et une plage de données 
d'automation est sélectionnée.

Trimming de l'automation d'une piste active d'un groupe

Sélection de données d'automation



Guide de référence Pro Tools1100

Si vous sélectionnez la commande Cut, des points 
d'ancrage sont créés à chaque extrémité de la 
sélection et la pente d'atténuation de l'automation de 
chaque côté des données coupées est préservée, 
comme illustré sur la figure suivante. 

Si vous supprimez les données en appuyant sur 
la touche Retour arrière (Windows) ou Supprimer 
(Mac), les données d'automation sont supprimées et 
les valeurs d'automation s'étendent entre les points 
d'automation préexistants, comme l'illustre la figure 
suivante. 

De plus, si les données coupées ou copiées sont 
collées à un autre emplacement de la piste, des 
points d'automation sont créés aux extrémités des 
données collées afin d'en préserver la valeur 
« adjacente » (entrante et sortante) et la pente, 
comme l'illustre la figure suivante.

Édition et vues de piste
Les pistes audio, MIDI et d'instrument possèdent 
chacune une vue de piste constituant la vue 
principale pour les opérations d'édition. Lorsque la 
vue principale est affichée, toutes les modifications 
effectuées sur la piste s'appliquent à la totalité des 
données de cette piste.

Les vue principales sont les suivantes :

• Pistes audio : Blocks et Waveform

• Pistes MIDI et d'instrument : Blocks, Clips 
et Notes

Par exemple, lorsqu'une piste audio est en vue 
Waveform ou Blocks, les commandes 
couper/copier/coller s'appliquent aux données audio 
et à tous les types de données d'automation de la piste. 
Si la piste est configurée pour afficher les données 
d'automation de panoramique, seules les données de 
panoramique sont affectées.

Lorsqu'une sélection comprend plusieurs pistes 
dont l'une est en vue principale, toutes les données 
de toutes les pistes sélectionnées sont affectées.

Pour éditer tous les types d'automation sur une 
piste d'entrée auxiliaire ou Master Fader, effectuez 
l'une des opérations suivantes :

 Créez une sélection d'édition comprenant 
au moins une piste audio ou MIDI affichée dans 
sa vue principale.

 Maintenez la touche Ctrl enfoncée et coupez ou 
collez les données d'automation. 

Après avoir coupé des données d'automation

Après avoir supprimé des données d'automation

Après avoir collé des données d'automation à un autre 
emplacement

Pour plus de souplesse, vous pouvez utiliser 
des playlists ou la commande Duplicate Track 
pour travailler en toute sécurité sur une copie 
des données modifiées. 
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Conseils pour couper, copier 
et coller des données 
d'automation
 Sur les pistes audio, si vous coupez ou copiez 
une section de forme d'ondes dans une vue 
Waveform, toutes les données d'automation 
associées à cette forme d'ondes sont également 
coupées ou copiées.

 Sur les pistes audio, si vous coupez dans une 
vue Waveform des données audio sur une piste 
contenant également des données d'automation, 
des points d'automation sont automatiquement 
créés aux limites des données d'automation 
restantes.

 Sur les pistes audio, coller des données 
de forme d'ondes colle également toutes les 
données d'automation associées. 

 Sur les pistes d'entrée auxiliaire, Master Fader ou 
d'instrument, seules les données d'automation 
affichées sont coupées ou copiées. Pour couper 
ou copier toutes les données d'automation sur ces 
types de piste, appuyez sur la touche Ctrl tout 
en procédant au couper/copier.

 Sur les pistes contenant une playlist 
d'automation sans données (s'il n'existe qu'un seul 
point d'automation au début de la piste, par 
exemple), couper les données n'entraîne pas la 
création de nouveaux points d'automation.

 En cas de chevauchement de clips (lors du 
déplacement de clips en mode Slip, par exemple), 
la suppression d'un clip superposé entraîne la perte de 
tous les points d'automation situés en dessous.

 Si des données coupées ou copiées contiennent 
un type d'automation non présent sur la piste cible, 
Pro Tools vous avertit avant de permettre le collage 
des données. 

 Les données d'automation coupées ou copiées pour 
des plug-ins ou des départs non présents sur la piste 
cible sont ignorées lorsqu'elles sont collées.

Commandes Cut Special, 
Copy Special, Clear Special 
et Paste Special
Les quatre commandes « spéciales » (Cut Special, 
Copy Special, Paste Special et Clear Special) 
simplifient les tâches de déplacement ou de 
suppression de différents types de données 
d'automation et de données de contrôleur MIDI entre 
des pistes, des départs et des plug-ins. 
Ces commandes permettent :

• d'éditer uniquement les données d'automation et 
de contrôleur MIDI (sans l'audio ou les notes 
MIDI associés) ;

• d'éditer les données d'automation et de contrôleur 
MIDI sans avoir à changer de vue de piste.

De plus, la commande Paste Special permet 
de copier un type de données sur un autre (des données 
de panoramique gauche sur la playlist du panoramique 
de droite, par exemple).

Cut Special

Les commandes Cut Special permettent de couper 
uniquement les données d'automation de la sélection 
actuelle (sans l'audio ou les notes MIDI associés) et de 
les placer en mémoire pour les coller à un autre 
emplacement de la manière suivante :

All Automation : coupe toutes les données 
d'automation ou de contrôleur MIDI, affichées 
ou non. 

Pan Automation : coupe uniquement les données 
de panoramique MIDI ou d'automation de 
panoramique, affichées ou non.

Plug-In Automation : coupe uniquement les 
données d'automation de plug-in affichées.

Il est impossible coller des données 
de contrôleur MIDI sur des données 
d'automation, et inversement.
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Copy Special

Les commandes Copy Special permettent 
de copier uniquement les données d'automation de 
la sélection actuelle (sans l'audio ou les notes 
MIDI associés) et d'en placer une copie 
en mémoire pour les coller à un autre emplacement 
de la manière suivante :

All Automation : copie toutes les données 
d'automation ou de contrôleur MIDI, affichées 
ou non. 

Pan Automation : copie uniquement les données 
de panoramique MIDI ou d'automation de 
panoramique, affichées ou non.

Plug-In Automation : copie uniquement les 
données d'automation de plug-in affichées.

Paste Special

Les commandes Paste Special permettent 
de coller des données d'automation dans un autre 
clip (sans affecter l'audio ou les notes MIDI 
associés) de l'une des manières suivantes : 

Merge : permet d'ajouter les données collées à des 
données d'automation existantes du même type dans 
la sélection de destination. Cette fonction permet de 
regrouper sur une piste MIDI unique des données 
MIDI provenant de plusieurs pistes. Par exemple, 
vous aimez la variation de hauteur des trombones 
d'un synthétiseur et souhaitez l'appliquer à la guitare 
du synthétiseur.

Repeat to Fill Selection : colle plusieurs instances 
des données d'automation sur toute la plage 
de sélections. Si vous sélectionnez une zone dont la 
taille n'est pas un multiple exact de celle du clip copié, 
la partie restante de la sélection est remplie par une 
version ajustée de la sélection d'origine. Cette 
fonction permet de créer facilement des boucles de 
batterie et autres effets répétitifs. Avant de coller les 
données, Pro Tools vous invite à spécifier un fondu 
enchaîné pour lisser les transitions entre les clips. 

To Current Automation Type : colle les données 
d'automation ou de contrôleur MIDI contenues dans 
le presse-papiers sur la sélection, en tant que type 
d'automation actuel ou contrôleur MIDI. Cela vous 
permet de copier des données d'automation de toute 
type sur tout autre type. Par exemple, vous pouvez 
copier des données d’automation du panoramique 
gauche sur des données d’automation de plug-in. 
Vous pouvez également copier des données de 
volume MIDI pour les coller sur un panoramique 
MIDI.

Clear Special

Les commandes Clear Special permettent d'effacer 
uniquement les données d'automation du clip 
actuel, de la manière suivante :

All Automation : supprime toutes les données 
d'automation ou de contrôleur MIDI, affichées 
ou non. 

Pan Automation : n'efface que les données 
d'automation de panoramique ou les données de 
panoramique MIDI, qu'elles soient affichées ou non.

Plug-In Automation : supprime uniquement les 
données d'automation de plug-in affichées.

Fonction Special Paste pour les 
données d'automation
En général, les données d'automation copiées sont 
collées sur une playlist d'automation du même type 
(des données de panoramique gauche sont collées sur la 
playlist de panoramique gauche, par exemple). 

Toutefois, il peut être utile de coller un type de 
données sur un autre (des données de panoramique 
gauche sur la playlist de panoramique droit, 
par exemple).

La commande Special Paste permet de copier 
un type de données sur un autre. 

Pour ne coller que des données d'automation ou de 
contrôleur MIDI (sans l'audio ou les notes MIDI 
associés), utilisez la commande Paste Special.
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Pour que ce mode de collage spécial fonctionne, les 
conditions suivantes doivent être respectées :

• Chaque piste à coller doit être affichée en tant 
que données d'automation.

• Le presse-papiers de chaque piste cible ne doit 
contenir qu'une seule playlist d'automation. 
La fonction Special Paste ne peut pas copier 
plusieurs playlists d'automation par piste.

Pour coller des données sur une playlist 
d'automation différente :

 Maintenez la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée et sélectionnez Edit > Paste.

Conversion de l'automation 
de volume et du gain du clip
(Pro Tools HD uniquement)

Pro Tools permet de convertir des réglages de gain du 
clip en automation de volume de piste, et vice versa. 
Pour plus d'informations, reportez-vous à la section 
« Conversion du gain du clip et de l'automation de 
volume de piste » à la page 618.

Fusion de l'automation 
de volume et du gain du clip
(Pro Tools HD uniquement)

Pro Tools permet de fusionner des réglages de gain du 
clip avec l'automation de volume des pistes, et vice 
versa. Pour plus d'informations, reportez-vous à la 
section « Fusion du gain du clip et de l'automation de 
volume de piste » à la page 619.

Glide Automation
(Pro Tools HD uniquement)

Les commandes Glide Automation permettent 
de créer une automation de transition (Glide) d'une 
valeur d'automation existante à une nouvelle 
valeur, sur une zone sélectionnée.

Pour appliquer une commande Glide Automation 
au type de paramètre d'automation actuel :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée pour ce type 
d'automation.

2 Cliquez sur le sélecteur de vue de piste pour 
sélectionner le type d'automation à automatiser. 

3 Faites glisser le sélecteur sur la piste pour 
sélectionner la zone sur laquelle écrire 
le paramètre Glide.

4 En fin de sélection, donnez au paramètre 
d'automation la valeur souhaitée. Par exemple, 
pour faire glisser le volume d'automation vers 
l'infini, déplacez le curseur du volume vers 
l'infini.

5 Sélectionnez Edit > Automation > Glide to Current.

Il est impossible d'échanger des données 
d'automation entre des pistes audio et MIDI 
ou entre des commandes continues (faders ou 
panoramiques) et des commandes commutées ou 
discontinues (Mute ou contrôleurs MIDI).

Lorsque vous utilisez ces commandes pour 
plusieurs paramètres simultanément, par 
exemple avec le surround panner ou les plug-
ins, utilisez l'option Edit > Automation > Glide 
to All Enabled.

Dans le cas de l'automation MIDI, 
les commandes Glide To s'appliquent 
uniquement au volume, panoramique et mute 
MIDI. Les paramètres MIDI ne peuvent pas 
utiliser les commandes Write To.

Vous pouvez également appuyer sur les 
touches Alt+Barre oblique (/) (Windows) 
ou Option+Barre oblique (/) (Mac).
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Pour appliquer une commande Glide Automation 
à tous les paramètres activés :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée pour ces types 
d'automation.

2 Sur chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez le type 
d'automation à automatiser dans le 
menu déroulant.

3 À l'aide du Sélecteur, faites glisser 
horizontalement pour inclure toutes les pistes 
d'une sélection à automatiser (faites glisser 
verticalement pour définir la plage temporelle).

4 Sur chaque piste à automatiser, donnez 
au paramètre d'automation la valeur souhaitée 
en fin de sélection.

5 Sélectionnez Edit > Automation > Glide to 

All Enabled.

Considérations relatives aux 
commandes Glide Automation
Le comportement de la fonction Glide Automation 
appliquée à des données d'automation est le 
suivant :

• Lorsque vous effectuez une sélection, les points 
d'automation sont écrits aux points de début et de fin 
de l'automation de transition. La valeur 
d'automation au début de la sélection correspond au 
point de départ de l'automation de transition et la fin 
de la sélection, à son point de fin. L'automation de 
transition créée entre les deux points est basée sur la 
longueur de la sélection ainsi que sur la valeur finale 
sélectionnée.

• Si les points d'automation suivent la sélection, ils 
ne sont pas modifiés ; toutefois, la valeur 
sélectionnée pour la fin de la sélection est écrite 
à partir du point final, jusqu'au point d'automation 
suivant.

• Si aucun point d'automation ne suit la sélection, 
la valeur sélectionnée pour la fin de la sélection 
est écrite à la fin de la piste.

• Si aucune sélection n'est effectuée, un point 
d'automation est écrit à l'emplacement actuel et 
la valeur sélectionnée pour l'automation 
de transition est écrite au point 
d'automation suivant.

Trimming de l'automation
(Pro Tools HD uniquement)

Si vous avez déjà écrit des données d'automation, 
vous pouvez modifier celles qui se rapportent 
au volume de piste et aux niveaux de départ 
en temps réel, en mode Trim. Lorsque le trimming 
est autorisé sur une piste, vous n'enregistrez plus des 
positions de fader absolues mais des modifications 
relatives aux données d'automation existantes. Pour 
plus d'informations, reportez-vous à la section 
« Mode Trim » à la page 1071.

Pour activer le mode Trim :

 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation de la piste 
sur laquelle le trimming d'automation doit être 
réalisé, puis sélectionnez Trim.

Vous pouvez également appuyer sur les touches 
Alt+Maj+Barre oblique (/) (Windows) ou 
Option+Maj+Barre oblique (/) (Mac).

Activation du mode Trim
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Lorsque le mode Trim d'une piste est activé, ses faders 
de volume et de niveau de départ deviennent jaunes ; le 
contour du sélecteur de mode d'automation 
correspondant passe également au jaune. Ce contour 
reste allumé pour indiquer que le trim est autorisé sur 
la piste ; il clignote au cours de l'opération de trim du 
volume ou des niveaux de départ de la piste. 

Écriture d'une automation de trim
L'écriture d'une automation de trim dépend de la 
configuration de la fusion des données. Reportez-vous 
à la section « Fusion de l'automation de trim » à la 
page 1105. Si l'automation n'a pas été configurée pour 
que les données soient fusionnées à chaque passe, les 
mouvements d'automation de trim sont écrits dans une 
playlist de trim distincte. 

Pour effectuer un trimming du volume ou des 
niveaux de départ d'une piste :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée pour ce type 
d'automation (volume ou niveau de départ).

2 Cliquez sur le sélecteur de mode d'automation de 
la piste sur laquelle vous souhaitez écrire les 
données d'automation, puis sélectionnez 
un mode d'automation (Touch, Latch, 
Touch/Latch ou Write). 

3 Cliquez à nouveau sur le sélecteur de mode 
d'automation, puis sélectionnez Trim.

4 Lancez la lecture, puis ajustez le volume ou les 
niveaux des départs.

5 Arrêtez la lecture pour mettre fin à la passe de 
trim. 

Fusion de l'automation de trim
Vous pouvez configurer Pro Tools de façon à ce 
qu'il valide, ou fusionne, l'automation de trim dans 
la playlist d'automation principale par l'une des 
méthodes suivantes :

After Every Pass : les mouvements de trim sont 
automatiquement appliqués lorsque le transport est 
arrêté à la fin d'une passe d'automation. Les 
playlists d'automation de trim sont supprimées et 
les faders de trim sont remis à zéro.

On Exiting Trim Mode : les mouvements de trim 
sont enregistrés séparément dans la playlist 
d'automation de trim en attendant d'être fusionnés. 
L'automation du trim est automatiquement 
fusionnée sur une piste à condition que celle-ci ne 
soit pas en mode Trim. Vous pouvez répéter une 
passe d'automation, éditer manuellement 
l'automation de trim de toute playlist de trim ou 
supprimer cette dernière avant de la fusionner par 
cette méthode.

Manually : les mouvements de trim sont enregistrés 
séparément dans la playlist d'automation de trim en 
attendant d'être fusionnés. Avec ce paramètre, 
la seule façon de fusionner les mouvements de trim 
est d'utiliser la commande Coalesce Trim 

Automation. Vous pouvez répéter une passe 
d'automation, éditer manuellement l'automation de 
trim de toute playlist de trim ou supprimer cette 
dernière avant de la fusionner par cette méthode. 

Même lorsque l'automation a été configurée 
pour être fusionnée à la sortie du mode Trim, 
vous pouvez utiliser la commande Coalesce 
Trim Automation pour confirmer les 
mouvements de trim à tout moment.
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Pour définir la méthode de fusion de l'automation 
de trim :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Coalesce Trim Automation, sélectionnez 
l'une des options suivantes :

• After Every Pass 

• On Exiting Trim Mode 

• Manually 

Pour fusionner l'automation de trim sur une piste 
à la sortie du mode Trim :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Coalesce Trim Automation, sélectionnez 
On Exiting Trim Mode.

3 Cliquez sur OK pour fermer la fenêtre des 
préférences.

4 Assurez-vous que le transport est arrêté dans 
Pro Tools.

5 Sur la piste sur laquelle vous souhaitez 
fusionner l'automation de trim, cliquez sur 
le sélecteur de mode d'automation, puis 
désélectionnez Trim.

L'automation de trim est appliquée à la playlist 
d'automation principale ; les playlists d'automation 
de trim sont supprimées et les faders de trim sont 
remis à zéro. 

Pour fusionner manuellement des données 
d'automation de trim sur une piste :

1 Sélectionnez la piste sur laquelle vous souhaitez 
fusionner l'automation de trim.

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Coalesce Trim Automation.

• Effectuez un clic droit sur le nom de la piste, 
puis sélectionnez Coalesce Trim Automation.

L'automation de trim est appliquée à la playlist 
d'automation principale ; les playlists d'automation 
de trim sont supprimées et les faders de trim sont 
remis à zéro.

Écriture de données 
d'automation au début, à la fin 
ou sur l'ensemble d'une 
sélection ou d'une piste
(Pro Tools HD uniquement)

Pro Tools permet d'écrire les valeurs d'automation 
en cours à partir de n'importe quel point d'insertion 
en avançant (ou en reculant) vers la fin (ou le 
début) d'une piste ou d'une sélection d'édition sur 
une piste, ou sur la totalité d'une piste ou de la 
sélection d'édition, au cours d'une passe 
d'automation.

Si le transport n'est pas arrêté alors que vous 
écrivez des données d'automation, vous 
ne pouvez ni entrer ni quitter directement 
le mode Trim. Vous devez appliquer la fonction 
AutoMatch avant de quitter le mode Trim. Cette 
opération évite que les valeurs d'automation ne 
fassent des bonds soudains. 

Boutons Write Automation to Start, End et All de la 
fenêtre Automation
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Les commandes standard Write Automation to 

Start, All ou End ne fonctionnent pas lorsque 
le transport de Pro Tools est à l'arrêt. Elles influent 
uniquement sur les paramètres d'automation pour 
lesquels l'écriture est autorisée et actuellement en 
cours d'écriture. 

Il est possible de configurer les commandes Write 

Automation to Start, All et End afin qu'elles soient 
toujours automatiquement appliquées. Reportez-
vous à la section « Écriture de données 
d'automation au début, à la fin ou sur l'ensemble 
d'une sélection ou d'une piste à l'arrêt » à la 
page 1108. 

Conditions d'utilisation des 
commandes Write Automation 
standard
Pour que des données d'automation soient écrites 
pour un paramètre spécifique, la piste associée doit 
être configurée dans l'un des modes d'automation 
suivants et respecter les conditions ci-après :

Mode Latch : la commande du paramètre doit être 
modifiée (touchée) au cours de la 
passe d'automation. 

Mode Touch : la commande du paramètre doit être 
modifiée (touchée). 

Mode Write : toutes les commandes de la piste 
doivent être configurées en mode Write. 

Cette commande peut être annulée.

Pour écrire les valeurs actuelles d'automation au 
début, à la fin ou sur l'ensemble d'une piste ou 
d'une sélection d'édition :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour 
ce type d'automation.

3 Effectuez l'une des opérations suivantes :

• Cliquez sur une piste au niveau d'un point 
d'insertion.

• Avec le Sélecteur, sélectionnez une partie de la 
piste.

4 Lancez la lecture.

5 Si vous êtes en mode Latch ou Touch, assurez-
vous que l'écriture s'effectue sur la piste 
appropriée.

6 Lorsque vous atteignez un point de la piste 
ou de la sélection contenant les données 
d'automation à appliquer, cliquez sur le bouton 
Write Automation to Start, All ou End dans la 
fenêtre Automation. 

7 Arrêtez la lecture.

Les valeurs actuelles de toutes les données 
d'automation pour lesquelles l'écriture est 
autorisée sur ce point sont écrites dans la zone 
correspondante de la piste ou de la sélection.

Dans le cas de l'automation MIDI, les 
commandes Write To s'appliquent uniquement 
au volume MIDI, au panoramique MIDI et au 
mute MIDI. Les paramètres MIDI ne peuvent pas 
utiliser les commandes Write To.
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Write to Start, End ou All 
et mode Trim
En mode Trim, il est également possible d'écrire des 
valeurs delta de trim pour le volume de la piste et les 
niveaux de départ, vers le début, la fin ou l'ensemble de 
la piste ou de la sélection d'édition. 

Pour écrire les valeurs delta de trim en cours 
au début, à la fin ou sur l'ensemble d'une piste 
ou d'une sélection :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour ce 
type d'automation (volume de piste ou niveau de 
départ).

3 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation de la piste 
sur laquelle vous souhaitez réaliser un trimming 
d'automation, puis sélectionnez Trim. Les faders 
de volume de piste et de niveau de départ 
deviennent jaunes.

4 Effectuez l'une des opérations suivantes :

• Cliquez sur une piste au niveau d'un point 
d'insertion.

• Avec le Sélecteur, sélectionnez une partie de la 
piste.

5 Cliquez sur Play pour lancer la lecture. 

6 Lorsque vous atteignez un point de la piste 
ou de la sélection contenant le paramètre 
de trim (valeur delta) à appliquer, cliquez sur le 
bouton Write Automation to Start, All ou End 
dans la fenêtre Automation.

7 Arrêtez la lecture. 

Les modifications relatives apportées au volume 
de piste et aux niveaux de départ en ce point sont 
écrits dans la zone correspondante de la piste ou de 
la sélection.

Écriture de données 
d'automation au début, à la fin 
ou sur l'ensemble d'une 
sélection ou d'une piste à l'arrêt
La fenêtre Automation contient des options 
permettant d'écrire des données d'automation sur 
toute playlist d'automation (y compris les playlists 
de trim) après la une passe d'automation valide. 

Il est possible de configurer les commandes Write 
Automation to Start, End ou All de telle sorte 
qu'elles se désactivent ou restent actives après 
la réalisation d'une passe d'automation valide.

Reportez-vous à la section « Conditions 
d'utilisation des commandes Write Automation 
standard » à la page 1107. 

Pour configurer les modes d'écriture à l'arrêt pour 
qu'ils se désactivent après une passe d'automation :

1 Sélectionnez Window > Automation.

2 Cliquez sur l'un des modes Write On Stop 
(Start, All, End) pour l'activer.

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en bleu.

Boutons Write On Stop de la fenêtre Automation
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Pour configurer les modes Write On Stop pour qu'ils 
restent activés après une passe d'automation :

1 Sélectionnez Window > Automation.

2 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur l'un des boutons 
Write On Stop (Start, All ou End) pour activer le 
mode correspondant.

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en rouge.

Écriture de données 
d'automation jusqu'au 
point d'automation ou 
de punch suivant
(Pro Tools HD uniquement)

Lorsque vous effectuez une passe d'automation, 
Pro Tools vous permet d'écrire les valeurs 
d'automation actuelles, du point d'insertion actuel 
jusqu'au point d'automation suivant, ou en 
remontant jusqu'au point de punch (point de la 
piste à partir duquel l'écriture des données 
d'automation a débuté). 

 Write Automation to Next Breakpoint vous permet 
de mettre à jour les données d'automation d'une piste 
sans remplacer les données précédentes ou suivantes 
de la timeline, et sans avoir à définir de sélection avant 
l'édition de l'automation.

 Write Automation to Punch Point vous permet 
de remplir une valeur d'automation manquante 
d'une piste après avoir trouvé le niveau 
ou paramètre approprié au cours d'une passe 
d'automation, sans avoir à répéter la passe.

Tout comme les commandes standard Write 

Automation to Start, End et All, les commandes Write 

Automation to Next Breakpoint et Write Automation to 

Punch Point ne fonctionnent pas lorsque le transport 

de Pro Tools est à l'arrêt. Elles influent uniquement 
sur les paramètres d'automation pour lesquels 
l'écriture est autorisée et qui sont actuellement en 
cours d'écriture. 

Il est possible de configurer les commandes Write 

Automation to Next Breakpoint et Write Automation to 

Punch Point pour qu'elles soient appliquées 
automatiquement après une passe d'automation 
valide. Pour plus d'informations, reportez-vous à la 
section « Écriture des données d'automation jusqu'au 
point d'automation suivant ou jusqu'au point de 
punch à l'arrêt » à la page 1111.

Pour écrire les valeurs d'automation actuelles 
jusqu'au point d'automation suivant :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour 
ce type d'automation.

3 Cliquez sur une piste pour définir un point 
d'insertion.

4 Lancez la lecture.

5 Si vous êtes en mode Touch, Latch 
ou Touch/Latch, assurez-vous que l'écriture 
s'effectue sur la piste appropriée.

Dans le cas de l'automation MIDI, les 
commandes Write To s'appliquent uniquement 
au volume, panoramique et mute MIDI. Les 
autres paramètres MIDI ne peuvent pas utiliser 
les commandes Write To.

Les commandes Write Automation to Next 
Breakpoint et Write Automation to Punch Point 
fonctionnent dans les mêmes conditions que les 
commandes Write Automation to Start, End et All. 
Reportez-vous à la section « Écriture de données 
d'automation au début, à la fin ou sur l'ensemble 
d'une sélection ou d'une piste » à la page 1106.
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6 Lorsque vous avez atteint un point de la piste 
auquel vous souhaitez appliquer les paramètres 
actuels, cliquez sur le bouton Write Automation 
to Next Breakpoint.

7 Arrêtez la lecture. 

Les valeurs actuelles de toutes les commandes 
écrites à ce stade sont écrites jusqu'au point 
d'automation suivant.

Pour écrire les valeurs d'automation actuelles 
jusqu'au point d'automation précédent :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour 
ce type d'automation. 

3 Cliquez sur une piste pour définir un point 
d'insertion.

4 Lancez la lecture.

5 Si vous êtes en mode Touch, Latch 
ou Touch/Latch, assurez-vous que l'écriture 
s'effectue sur la piste appropriée.

6 Lorsque vous avez atteint un point de la piste 
auquel vous souhaitez appliquer les paramètres 
actuels, cliquez sur le bouton Write Automation to 
Punch Point.

Les valeurs actuelles de tous les paramètres pour 
lesquels l'écriture est autorisée sont écrites jusqu'au 
point auquel la première commande a commencé 
à écrire les données d'automation.

Boutons Write To Next Breakpoint de la fenêtre 
Automation

La commande Write Automation to Next 
Breakpoint reste activée après une passe 
d'automation valide. À l'inverse des commandes 
Write Automation standard, elle ne peut pas être 
configurée de façon à se désactiver après une 
passe d'automation.

Écriture jusqu'au point 
d'automation suivant

Écriture jusqu'au point 
d'automation suivant à l'arrêt

Boutons Write To Punch Point de la fenêtre Automation

Écriture jusqu'au point
de punch

Écriture jusqu'au point
de punch à l'arrêt



Chapitre 45 : Automation 1111

Write To Next Breakpoint 
ou Punch Point et mode Trim
En mode Trim, il est également possible d'écrire 
des valeurs de trim pour le volume de la piste et les 
niveaux de départ jusqu'au point d'inflexion écrit 
suivant ou jusqu'au point de punch-in d'automation 
précédent. 

Pour écrire les valeurs de trim actuelles jusqu'au point 
d'automation suivant ou jusqu'au point de punch :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour ce 
type d'automation (volume de piste ou niveau de 
départ).

3 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation, puis 
sélectionnez Trim. Les faders de volume de piste 
et de niveau de départ deviennent jaunes.

4 Cliquez sur une piste pour définir un point 
d'insertion.

5 Lancez la lecture. 

6 Lorsque vous avez atteint un point de la piste 
auquel vous souhaitez appliquer les valeurs de 
trim actuelles, cliquez sur le bouton Write 
Automation to Next Breakpoint de la fenêtre 
Automation.

Pour écrire les valeurs de trim actuelles jusqu'au 
point de punch :

1 Sélectionnez Window > Automation.

2 Assurez-vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou niveau 
de départ).

3 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation, puis 
sélectionnez Trim. Les faders de volume de piste 
et de niveau de départ deviennent jaunes.

4 Cliquez sur une piste pour définir un point 
d'insertion.

5 Lancez la lecture. 

6 Lorsque vous avez atteint le point de la piste 
auquel vous souhaitez appliquer les valeurs de 
trim actuelles, cliquez sur le bouton Write 
Automation to Punch Point de la fenêtre 
Automation.

Écriture des données 
d'automation jusqu'au point 
d'automation suivant ou 
jusqu'au point de punch à l'arrêt
La fenêtre Automation contient une option 
permettant l'écriture automatique des données 
d'automation jusqu'au point d'automation suivant 
jusqu'au point de punch à l'arrêt.

Pour configurer l'option Write Automation to Next 
Breakpoint on Stop :

1 Sélectionnez Window > Automation.

2 Cliquez sur le bouton Write Automation to Next 
Breakpoint on Stop ou Write Automation 
to Punch Point. 

Lorsque cette option est activée, l'écriture des 
données d'automation s'effectue automatiquement 
jusqu'au point d'automation suivant après une passe 
d'automation valide.

Pour configurer l'option Write Automation 
to Punch Point on Stop :

1 Sélectionnez Window > Automation.

2 Cliquez sur le bouton Write Automation to 
Punch Point on Stop. 

Lorsque cette option est activée, l'écriture des 
données d'automation s'effectue automatiquement 
jusqu'au point de punch-in d'automation après une 
passe d'automation valide.

La commande Write Automation to Next 
Breakpoint reste activée après une passe 
d'automation valide. À l'inverse des commandes 
Write Automation standard, elle ne peut pas être 
configurée de façon à se désactiver après une 
passe d'automation.
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Instructions d'utilisation des 
commandes Write To
(Pro Tools HD uniquement)

Utilisation des commandes 
Write To en cours de lecture
Vous pouvez exécuter les commandes Write 

Automation To sans arrêter le transport 
de Pro Tools. Sur les surfaces de contrôle prises en 
charge, le bouton Write To correspondant clignote 
tant que le transport n'est pas arrêté.

Lorsque le transport de Pro Tools n'est pas à l'arrêt, 
l'envoi d'une commande Write Automation To affecte 
l'écriture d'automation des manières suivantes :

• Write to Start/Selection Start : les commandes en 
cours d'écriture continuent à écrire les données 
d'automation.

• Write to All/Selection : les commandes en cours 
d'écriture (à l'exception des commandes 
en mode Write) arrêtent d'écrire les 
données d'automation.

• Write to End/Selection End : les commandes en 
cours d'écriture (à l'exception des commandes 
en mode Write) arrêtent d'écrire les données 
d'automation.

• Write to Next Breakpoint : les commandes 
en cours d'écriture (à l'exception des 
commandes en mode Write) arrêtent d'écrire les 
données d'automation.

• Write to Punch point : les commandes en cours 
d'écriture continuent à écrire les données 
d'automation.

Application de commandes 
Write To à des pistes 
sélectionnées
Les commandes Write Automation To s'appliquent 
en général à l'ensemble des pistes sur lesquelles 
l'écriture de données d'automation est en cours. 
Il est possible d'appliquer ces commandes 
uniquement à des pistes sélectionnées. 

Pour appliquer une ou plusieurs commandes 
Write Automation To à des pistes sélectionnées :

1 Sélectionnez les pistes sur lesquelles appliquer 
les commandes Write To.

2 Cliquez sur le bouton Write Automation requis 
tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées.

Suppression des 
avertissements lors de 
l'utilisation des commandes 
Write To
Lorsque vous exécutez une ou plusieurs commandes 
Write Automation To (à l'exception de Write to Next 
Breakpoint), Pro Tools affiche un message 
d'avertissement signalant que les valeurs d'automation 
vont être modifiées dans la session. Vous pouvez 
supprimer ces avertissements. 

Pour supprimer les boîtes de dialogue 
d'avertissement des commandes Write To :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing.

2 Sous Automation, sélectionnez Suppress 

Automation ‘Write To' Warnings. 

Dans le cas de l'automation MIDI, les 
commandes Write To s'appliquent uniquement 
au volume, panoramique et mute MIDI. Les 
paramètres MIDI ne peuvent pas utiliser les 
commandes Write To.
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Écrasement ou extension 
des données d'automation 
de mute 
(Pro Tools HD uniquement)

Pro Tools permet d'écraser ou d'étendre 
un événement de mute en temps réel sans pour 
autant modifier l'état de mute actuel.

Un événement de mute peut être écrasé lorsque la 
passe d'automation démarre avant le premier 
événement de mute et se termine après 
le deuxième événement. Dans ce cas, l'état actuel 
activé/désactivé du mute est conservé.

Un événement de mute peut être étendu lorsque la 
passe d'automation démarre avant un événement 
activé ou désactivé et se termine avant la fin du 
deuxième événement.

L'écrasement/extension d'événements de mute est 
pris(e) en charge en mode Touch ou Latch, comme 
suit :

Mode Touch : écrit l'état actuel tant que le bouton 
Mute est maintenu enfoncé.

Mode Latch : écrit l'état actuel jusqu'à ce que vous 
arrêtiez l'opération ou désactiviez la fonction 
AutoMatch.Écrasement d'un événement d'automation de mute

Automation de mute d'origine (mute 
désactivé, mute activé, mute désactivé)

Mute d'un événement écrasé

Extension d'un événement d'automation de mute

Automation de mute d'origine (mute 
désactivé, mute activé, mute désactivé)

Événement de mute désactivé rallongé (jusqu'à la fin 
de la passe d'automation)
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Pour écraser un état de mute sur une ou plusieurs 
pistes :

1 Sélectionnez Window > Automation. 

2 Assurez-vous que l'automation de mute est 
activée en écriture.

3 Dans la fenêtre Mix ou Edit, cliquez sur 
le sélecteur de mode d'automation de la piste 
dont l'état Mute doit être écrasé, puis 
sélectionnez le mode Touch ou Latch.

4 Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5 Placez le curseur avant le début de l'événement de 
mute à écraser.

6 Lancez la lecture.

7 Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur le 
bouton Mute de la piste avant le début 
de l'événement de mute à écraser.

8 Après la fin du deuxième événement de mute, 
relâchez les touches et le bouton Mute.

9 À la fin de la passe d'automation, arrêtez 
la lecture.

Pour étendre un état Mute sur une piste :

1 Sélectionnez Window > Automation. 

2 Assurez-vous que l'automation de mute est 
activée en écriture.

Bouton Mute de la fenêtre Automation activé

Pour écraser des états Mute sur plusieurs 
pistes, activez le même mode d'automation 
pour toutes ces pistes.

Placement du curseur avant le début de l'événement 
de mute

Pour écraser des états Mute sur plusieurs 
pistes, maintenez les touches Alt+Ctrl 
(Windows) ou Option+Commande (Mac) 
enfoncées et cliquez sur le bouton Mute sur 
l'une des pistes à automatiser.

En mode Touch, vous devez maintenir le bouton 
Mute enfoncé tout au long de l'écriture.

Arrêt de la passe d'automation après la fin d'un 
événement de mute

Exemple d'état Mute écrasé

État Mute écrasé
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3 Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste 
à automatiser, puis sélectionnez le mode Touch 
ou Latch.

4 Sur chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5 Placez le curseur avant le début de l'événement 
de mute à étendre.

6 Lancez la lecture.

7 Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur le 
bouton Mute de la piste avant le début 
de l'événement de mute à étendre.

8 Avant la fin du deuxième événement de mute, 
relâchez les touches et le bouton Mute.

9 À la fin de la passe d'automation, cliquez 
sur Stop.

Pour étendre des états Mute sur plusieurs 
pistes, activez le même mode d'automation 
pour toutes ces pistes.

Placement du curseur avant le début de l'événement 
de mute

Pour étendre des états Mute sur plusieurs 
pistes, maintenez les touches Alt+Ctrl 
(Windows) ou Option+Commande (Mac) 
enfoncées et cliquez sur le bouton Mute sur 
la piste.

Si vous étendez un événement au-delà 
de l'événement activé ou désactivé suivant, 
l'intégralité de l'événement est modifiée.

Arrêt de l'automation avant la fin d'un événement 
de mute

Exemple d'extension d'état de mute (jusqu'à la fin 
de la passe d'automation)
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Création d'automation par 
snapshot
(Pro Tools HD uniquement)

Pro Tools HD permet d'écrire des valeurs de données 
d'automation pour plusieurs paramètres en une seule 
opération. Il existe deux méthodes d'écriture 
d'automation par snapshot :

À une sélection : les données d'automation sont 
écrites sur la sélection de timeline (et sur 
la sélection d'édition si elles sont liées). Des points 
d'ancrage sont insérés immédiatement avant et 
après la sélection afin que les données qu'elle 
contient ne soient pas modifiées.

À l'emplacement du curseur : les données 
d'automation sont écrites au point d'insertion. Après 
le point d'insertion, les données d'automation 
rejoignent la valeur du point d'automation suivant 
ou, en l'absence de point d'automation, elles restent 
à l'emplacement de la nouvelle valeur écrite jusqu'à 
la fin de la session.

Pour plus d'informations sur les commandes 
couper, copier et coller avec les données 
d’automation d’une session, reportez-vous à la 
section « Écriture de données d'automation au 
début, à la fin ou sur l'ensemble d'une sélection ou 
d'une piste » à la page 1106.

Pour écrire une automation par snapshot :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est activée sur les paramètres à éditer. 
Désélectionnez tous les paramètres dont vous 
souhaitez conserver l'automation.

2 Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher les données 
d'automation à éditer.

3 Écrivez un point d'automation dans la playlist si 
elle n'en contient aucun, de la manière 
suivante :

• Placez le curseur dans la playlist (ou créez une 
sélection d'édition), puis appuyez sur Ctrl+Barre 
oblique (/) (Windows) ou Commande+Barre 
oblique (/) (Mac).

• Sélectionnez la Main puis cliquez sur la playlist.

4 Effectuez l'une des opérations suivantes :

• Sélectionnez une zone sur la playlist de la piste 
(ou sur plusieurs pistes) à laquelle vous 
souhaitez appliquer l'automation. 

• Placez le curseur à un point d'insertion d'édition.

5 Ajustez les commandes à automatiser. Vous pouvez 
également modifier un preset de plug-in.

6 Sélectionnez Edit > Automation, puis effectuez 
l’une des opérations suivantes :

• Pour écrire la valeur actuelle uniquement sur 
le paramètre d'automation affiché, sélectionnez 
Write to Current.

• Pour écrire les valeurs actuelles sur tous les 
paramètres d'automation activés dans la fenêtre 
Automation, sélectionnez Write to All Enabled.

Dans le cas de l'automation MIDI, les 
commandes Write To, Trim To et Glide 
To s'appliquent uniquement au volume, 
panoramique et mute MIDI. Les paramètres 
MIDI ne peuvent pas utiliser les commandes 
Write To.
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Ajout de données d'automation 
par snapshot à des playlists 
d'automation vides
Si vous exécutez la commande Write Automation 
sur une playlist d’automation ne contenant pas de 
données d’automation antérieures, la valeur 
choisie est écrite sur la playlist entière et non 
uniquement sur la zone sélectionnée.

En effet, une playlist sans données d'automation ne 
contient qu'un seul point d'automation, 
correspondant à la position actuelle de la 
commande pour le paramètre. La position du point 
d'automation est mise à jour à chaque modification 
de la valeur du paramètre. 

Pour que la commande Write Automation n'écrive 
pas la valeur d'automation sélectionnée sur 
l'ensemble de la playlist, vous pouvez :

• ancrer les données d'automation en plaçant 
le curseur à la fin de la session (ou sur tout autre 
point de fin) et en sélectionnant l'option Write to 

Current ;

• cliquer avec l'un des outils de saisie de chaque 
côté de la sélection.

La commande Write Automation n'écrira alors des 
données que sur la zone sélectionnée.

Écriture d'une automation par 
snapshot sur des données 
d'automation existantes
Lorsque vous déplacez le curseur de lecture, les 
commandes automatisées de Pro Tools sont mises 
à jour, de façon à refléter les données d'automation 
présentes sur la piste. Pour conserver les paramètres 
définis pour un snapshot, vous pouvez suspendre les 
paramètres d'automation afin d'éviter la mise à jour de 
leurs valeurs.

Pour écrire une automation par snapshot sur des 
données existantes :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée sur les paramètres 
d'automation à éditer. Désélectionnez tous les 
paramètres dont vous souhaitez conserver 
l'automation.

2 Ajustez les commandes des paramètres 
à automatiser.

3 Cliquez sur le sélecteur de mode d'automation, puis 
sélectionnez le mode Off pour les pistes auxquelles 
vous souhaitez appliquer l'automation.

4 À l'aide du Sélecteur, sélectionnez la plage sur 
laquelle vous souhaitez appliquer l'automation.

5 Sélectionnez Edit > Automation, puis sélectionnez 
l’une des options suivantes dans le sous-menu :

• Pour écrire la valeur actuelle uniquement sur le 
paramètre d'automation affiché dans la fenêtre 
Edit, sélectionnez Write to Current.

• Pour écrire les valeurs actuelles sur tous les 
paramètres d'automation activés dans la fenêtre 
Automation, sélectionnez Write to All Enabled.

6 Cliquez sur le sélecteur de mode d'automation, 
puis sélectionnez le mode Read pour les pistes que 
vous souhaitez lire avec l'automation.
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Capture de données 
d'automation et application 
à un autre emplacement
Les commandes Write Automation peuvent également 
permettre de capturer des états d'automation à des 
emplacements spécifiques d'une piste et de les 
appliquer à d'autres emplacements.

Pour capturer et appliquer des données 
d'automation :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée sur les paramètres 
d'automation à éditer. Désélectionnez tous 
les paramètres dont vous souhaitez 
conserver l'automation.

2 Cliquez sur le sélecteur de mode d'automation, 
puis sélectionnez le mode Read pour les pistes 
dont vous souhaitez capturer l'automation.

3 Assurez-vous que l'option Options > Link 

Timeline and Edit Selection est activée.

4 À l'aide du Sélecteur, sélectionnez l'emplacement 
auquel vous souhaitez capturer l'automation. 
Toutes les commandes automatisées sont mises 
à jour pour refléter les données d'automation à cet 
emplacement. Si vous définissez une sélection, les 
commandes sont mises à jour pour refléter les 
données d'automation du début de la sélection.

5 Cliquez sur le sélecteur de mode d'automation de 
chaque piste à laquelle vous souhaitez appliquer 
l'automation capturée, puis sélectionnez le mode 
d'automation Off.

6 À l'aide du Sélecteur, sélectionnez l'emplacement 
auquel vous souhaitez appliquer l'automation.

7 Activez les paramètres d'automation 
précédemment suspendus.

8 Sélectionnez Edit > Automation, puis sélectionnez 
l’une des options suivantes dans le sous-menu :

• Pour écrire la valeur actuelle uniquement sur le 
paramètre d'automation affiché dans la fenêtre 
Edit, sélectionnez Write to Current.

• Pour écrire les valeurs actuelles sur tous les 
paramètres d'automation activés dans la fenêtre 
Automation Enable, sélectionnez Write to All 

Enabled.

9 Cliquez sur le sélecteur de mode d'automation, 
puis sélectionnez le mode Read pour les pistes que 
vous souhaitez lire avec l'automation.

Automation par snapshot et trim 
de données d'automation
Pro Tools permet d'utiliser des valeurs de trim 
en tant que snapshots et d'appliquer les 
changements relatifs (valeurs delta) aux données 
d'automation sélectionnées à l'aide de la commande 
Trim Automation. Cette procédure est comparable 
à l'action de la commande Write Automation, à ceci 
près qu'elle écrit des valeurs delta (différentielles) et 
non des valeurs absolues sur les données 
d'automation. 

Vous pouvez utiliser des valeurs de trim pour 
écrire une automation par snapshot sur n'importe 
quel paramètre automatisable.

Pour créer un snapshot des changements relatifs 
apportés aux données d'automation :

1 Dans la fenêtre Automation, assurez-vous que 
l'écriture est autorisée sur les paramètres 
d'automation à éditer. Désélectionnez tous 
les paramètres dont vous souhaitez 
conserver l'automation.

2 Sélectionnez la zone de piste à éditer. Toutes les 
commandes automatisées sont mises à jour 
pour refléter les données d'automation au début 
de la sélection.



Chapitre 45 : Automation 1119

3 Déplacez les commandes du paramètre vers le 
haut ou le bas, de la différence à appliquer aux 
données. 

4 Sélectionnez Edit > Automation, puis effectuez 
l’une des opérations suivantes :

• Pour écrire uniquement la valeur delta actuelle sur 
le paramètre d'automation affiché, sélectionnez 
Trim to Current.

• Pour écrire la valeur delta actuelle sur tous les 
paramètres d'automation activés dans la fenêtre 
Automation, sélectionnez Trim to All Enabled.

Aperçu de l'automation
(Pro Tools HD uniquement)

Le mode Automation Preview vous permet d'écouter 
les modifications apportées à un mixage et de les 
comparer à des valeurs d'automation existantes sans 
les confirmer dans la playlist d'automation.

Lorsque vous placez Pro Tools en mode Automation 
Preview, vous pouvez obtenir un aperçu des valeurs 
des commandes dont l'automation est activée sur toute 
piste dont le mode d'automation d'écriture est activé. 

Lorsque vous touchez ou déplacez une commande en 
mode Automation Preview, celle-ci est isolée et 
désactivée dans la playlist d'automation. 
La commande s'arrête de lire ou d'écrire les données 
d'automation, vous permettant d'écouter librement les 
modifications apportées.

Une fois que vous avez trouvé le niveau ou l'état 
souhaité, vous pouvez confirmer ou effectuer 
un punch avec la valeur d'aperçu dans la playlist 
d'automation pour les commandes isolées. 

 Si vous effectuez un punch en cours de lecture, 
le mode d'automation Latch est sélectionné 
et l'écriture débute sur la valeur d'aperçu. 

 Si vous effectuez un punch à l'arrêt du transport, 
le mode d'automation Latch est sélectionné et la 
commande est préparée à partir de la valeur 
d'aperçu.

Aperçu de nouvelles valeurs 
d'automation
Pour écouter un aperçu d'une nouvelle valeur 
d'automation de commande :

1 Vérifiez que l'automation est activée pour 
la piste dont vous souhaitez écouter l'aperçu 
(modes Touch, Latch, Touch/Latch ou modes de 
trim correspondants). 

2 Vérifiez que le type d'automation dont vous 
souhaitez écouter l'aperçu est activé dans 
la fenêtre Automation (volume, panoramique, 
mute, niveau de départ, panoramique de départ, 
mute de départ ou plug-in). 

3 Dans la fenêtre Automation, cliquez sur 
le bouton Preview. Le bouton s'allume en vert 
pour signaler que le mode Preview est actif.

La préférence Allow Latch Prime in Stop 
ne doit pas nécessairement être activée pour 
que l'aperçu puisse mettre une commande en 
mode Latch Prime.

Commandes d'aperçu de la fenêtre Automation
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4 Pour isoler une commande, touchez ou déplacez 
une commande pour laquelle l'automation est 
activée. Vous pouvez isoler des commandes 
en cours de lecture ou à l'arrêt du transport. 

L'indicateur du mode d'automation de la piste 
s'allume en vert pour indiquer qu'au moins une de 
ses commandes est isolée. Le bouton Punch 
Preview de la fenêtre Automation s'allume pour 
indiquer qu'une valeur d'aperçu est disponible pour 
une opération de punch.

5 Lancez la lecture et ajustez la commande isolée 
afin d'écouter les modifications.

Sortie des commandes de l'état 
isolé
Vous pouvez sortir des commandes de l'état isolé 
sans avoir à quitter le mode Preview.

Pour sortir toutes les commandes d'une piste de 
l'état isolé, effectuez l'une des opérations suivantes :

 Cliquez sur le sélecteur de mode d'automation de 
la piste tout en maintenant la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée.

 Activez le mode d'automation Read ou Off pour 
la piste. 

Pour sortir toutes les commandes d'un certain 
type d'automation de l'état isolé :

 Dans la fenêtre Automation, désactivez le type 
d'automation

Isolement de plusieurs 
commandes
Dans certains cas, notamment lors du démarrage 
d'un nouveau mixage, vous pouvez isoler plusieurs 
commandes simultanément.

Pour isoler toutes les commandes activées pour 
l'écriture :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton Preview.

Pour isoler toutes les commandes activées pour 
l'écriture sur toutes les pistes sélectionnées :

 Maintenez les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées et cliquez sur 
le bouton Preview.

Suspension du mode Preview
Vous pouvez suspendre temporairement le mode 
Preview afin de basculer entre les valeurs d'aperçu 
et les données d'automation existantes. 

Pour suspendre le mode Preview :

 Maintenez la touche Ctrl (Windows) 
ou Commande (Mac) enfoncée et cliquez sur le 
bouton Preview.

Punch des valeurs d'aperçu
Une fois que vous avez isolé une commande 
et écouté une nouvelle valeur, vous pouvez 
effectuer un punch de la valeur (l'écrire) dans 
la playlist d'automation. 

Pour effectuer un punch d'une valeur d'aperçu 
dans la playlist d'automation :

 Cliquez sur le bouton Punch Preview (allumé).
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Mode Preview et commandes 
Write To
En mode Preview, les commandes Write Automation 

To fonctionnent de la manière suivante :

Avant un punch de valeurs d'aperçu : les 
commandes Write Automation To (à l'exception 
de Write to Next Breakpoint) peuvent être utilisées 
pour étendre les valeurs d'aperçu. La commande Write 

Automation To ne s'applique qu'aux commandes 
isolées. Pro Tools reste en mode Preview.

Après un punch de valeurs d'aperçu : les 
commandes Write Automation To (à l'exception 
de Write to Next Breakpoint) peuvent être utilisées 
pour étendre la valeur du punch de la même manière 
que les autres données d'automation. 

Capture d'automation
(Pro Tools HD uniquement)

Vous pouvez capturer les valeurs d'automation 
actuelles à un emplacement d'une session et les 
appliquer rapidement à un autre emplacement 
à l'aide des commandes Capture et Punch Capture. 
La commande Capture enregistre temporairement la 
valeur de toutes les commandes actuellement en 
cours d'écriture d'automation. Les commandes Punch 

Capture écrivent ces valeurs enregistrées sur tous les 
types d'automation activés.

 Les systèmes ICON permettent de capturer 
jusqu'à 48 valeurs différentes, ou snapshots. 

 Tous les autres systèmes ne permettent 
de capturer qu'une seule valeur.

Commandes de capture de la fenêtre Automation
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Capture de valeurs d'automation
Vous pouvez capturer les valeurs d'automation 
actuelles des commandes en cours d'écriture. 

Pour capturer des valeurs d'automation :

1 Vérifiez que toutes les pistes dont vous 
souhaitez capturer les valeurs d'automation sont 
dans un mode activé pour l'écriture (Write, 
Touch, Latch, Touch/Latch ou Latch).

2 Vérifiez que les types d'automation à capturer sont 
activés dans la fenêtre Automation 
(volume, panoramique, mute, niveau de départ, 
panoramique de départ, mute de départ ou plug-in).

3 Lancez la lecture. Lorsque vous atteignez 
un emplacement auquel vous souhaitez capturer 
les états d'automation actuels, cliquez sur le 
bouton Capture de la fenêtre Automation.

Le bouton Punch Capture de la fenêtre Automation 
s'allume pour indiquer qu'une valeur capturée est 
disponible pour un punch.

Punch de valeurs d'automation 
capturées
Une fois que des valeurs d'automation sont 
capturées, elles peuvent être utilisées pour 
un punch (écrites) à un autre emplacement de la 
piste. Les pistes en mode Read ou Off ne sont pas 
affectées.

 Si vous effectuez un punch en cours de lecture, 
le mode d'automation des pistes en mode Touch est 
remplacé par le mode Latch et l'écriture débute avec 
la valeur capturée.

 Si vous effectuez un punch à l'arrêt du transport, 
le mode d'automation des pistes en mode Touch est 
remplacé par le mode Latch et la commande est 
préparée avec la valeur capturée.

Pour effectuer un punch de valeurs d'automation 
capturées :

1 Accédez à l'emplacement où vous souhaitez 
appliquer les états d'automation capturés. Cette 
opération peut être effectuée en cours de lecture 
ou à l'arrêt du transport.

2 Cliquez sur le bouton Punch Capture de la fenêtre 
Automation pour appliquer les états d'automation 
capturés. Les états capturés sont appliqués à tous les 
types d'automation actuellement activés dans la 
fenêtre Automation.

Capture des valeurs 
d'automation de toutes les 
commandes
Vous pouvez capturer l'état de toutes les 
commandes pouvant être automatisées dans 
la session (à l'exception de celles des pistes dont le 
mode d'automation est Off), qu'elles soient en 
cours d'écriture d'automation ou non.

Pour capturer les valeurs d'automation de toutes 
les commandes :

 Lorsque vous atteignez un point auquel vous 
souhaitez capturer les états d'automation 
actuels, cliquez sur le bouton Capture tout 
en maintenant la touche Alt (Windows) 
ou Option (Mac) enfoncée.

Pour capturer les valeurs d'automation de toutes 
les commandes sur des pistes sélectionnées 
uniquement :

 Lorsque vous atteignez un point auquel vous 
souhaitez capturer les états d'automation 
actuels, cliquez sur le bouton Capture tout 
en maintenant les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) enfoncées.
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Punch de valeurs d'automation 
sur toutes les commandes
Vous pouvez insérer toutes les valeurs d'automation 
capturées à un autre emplacement de leurs pistes 
respectives (à l'exception des pistes dont le mode 
d'automation est Off). 

Pour effectuer un punch des valeurs d'automation 
sur toutes les commandes :

 Lorsque vous atteignez un point auquel vous 
souhaitez appliquer les états d'automation 
capturés, cliquez sur le bouton Punch Capture tout 
en maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée. Toute piste en mode Read ou 
Touch passe en mode Latch. Les pistes en mode 
Off ne sont pas affectées. 

Pour effectuer un punch des valeurs d'automation 
sur toutes les commandes des pistes 
sélectionnées :

 Lorsque vous atteignez un point auquel vous 
souhaitez appliquer les états d'automation 
capturés, cliquez sur le bouton Punch Capture tout 
en maintenant les touches Alt+Maj (Windows) ou 
Option+Maj (Mac) enfoncées. Toute piste 
sélectionnée en mode Read ou Touch passe en 
mode Latch. Les pistes sélectionnées dont le mode 
est Off ne sont pas affectées. 

Capture et mode Trim
Les commandes Capture et Punch Capture 
fonctionnent avec l'automation du trim de la même 
façon qu'avec l'automation standard. Pro Tools 
enregistre l'état de trim lors de la capture ; si vous 
tentez d'insérer des valeurs de trim capturées tout en 
affichant une playlist d'automation autre qu'une 
automation de trim, Pro Tools applique 
automatiquement les valeurs à la playlist de trim 
correspondante. 

Commandes Punch Capture et 
Write To
Après l'envoi d'une commande Punch Capture, 
les commandes affectées écrivent les données 
d'automation (en mode Latch) et toute commande 
Write Automation To peut alors être utilisée pour 
étendre la valeur insérée de la même manière que 
toute autre donnée d'automation. 

Capture et mode Preview

Chargement de valeurs capturées dans un aperçu

Vous pouvez prévisualiser et modifier les valeurs 
d'automation capturées en mode Preview avant 
d'insérer les valeurs dans la playlist d'automation. 

Pour capturer une valeur d'automation et l'utiliser 
dans un aperçu :

1 Vérifiez que l'automation est activée pour 
la piste dont vous souhaitez écouter l'aperçu 
(modes Touch, Latch, Touch/Latch ou modes de 
trim correspondants).

2 Vérifiez que le type d'automation dont vous 
souhaitez écouter l'aperçu est activé dans 
la fenêtre Automation (volume, panoramique, 
mute, niveau de départ, panoramique de départ, 
mute de départ ou plug-in). 

3 Capturez une valeur d'automation 
à prévisualiser à un autre emplacement d'une 
piste. Pour plus d'informations, reportez-vous 
à la section « Capture de valeurs d'automation » 
à la page 1122.

4 Accédez à un emplacement où vous souhaitez 
prévisualiser les états d'automation capturés, 
puis cliquez sur le bouton Preview de la fenêtre 
Automation. 

5 Cliquez sur le bouton Punch Capture.
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Les commandes affectées sont isolées et mises 
à jour avec les valeurs capturées. Le bouton Punch 
Preview de la fenêtre Automation s'allume pour 
indiquer que la valeur d'aperçu est disponible pour 
un punch.

6 Lancez la lecture et ajustez la commande isolée 
afin d'écouter les modifications.

7 Lorsque vous êtes prêt à insérer la valeur 
d'aperçu dans la playlist d'automation, cliquez 
sur le bouton Punch Preview allumé.

Capture de valeurs en mode Preview

Lorsque vous êtes en mode Preview, vous pouvez 
capturer les valeurs de commandes isolées pour les 
appliquer à un autre point d'une piste. En capturant 
des valeurs d'aperçu, vous pouvez conserver les 
données d'automation sous-jacentes au point de 
capture.

Sur les systèmes ICON, vous pouvez vous servir 
du mode Preview pour capturer plusieurs 
snapshots sans modifier l'automation. 

Pour capturer une valeur d'aperçu :

1 Activez le mode Preview et isolez une 
commande (reportez-vous à la section « Aperçu 
de nouvelles valeurs d'automation » à la 
page 1119). 

2 Lancez la lecture et ajustez la commande isolée 
afin d'écouter les modifications.

3 Lorsque vous êtes prêt à capturer une valeur 
d'aperçu, cliquez sur le bouton Capture de la 
fenêtre Automation.

Le bouton Punch Capture de la fenêtre Automation 
s'allume pour indiquer qu'une valeur capturée est 
disponible pour un punch.

Automation des pistes 
Master VCA
(Pro Tools HD uniquement)

Vous pouvez automatiser les commandes des 
pistes Master VCA (ainsi que celles des pistes 
esclave VCA).

Affichage de l'automation des 
pistes Master VCA
Les commandes suivantes des pistes Master VCA 
peuvent être automatisées et disposer de playlists 
d'automation distinctes :

• Volume

• Trim de volume

• Mute

Ces playlists d'automation se comportent de la même 
façon que les playlists d'automation d'autres types de 
pistes. Pour plus d'informations sur l'automation du 
trim de volume, reportez-vous vous à la section 
« Trimming de l'automation » à la page 1104. 
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Affichage de la playlist 
d'automation composite sur des 
pistes esclaves
Lorsqu'une piste est esclave VCA, vous pouvez 
afficher une playlist d'automation composite 
indiquant la contribution de la piste Master VCA aux 
données d'automation de volume ou de mute sur la 
piste esclave. Cette playlist composite reflète la 
position actuelle du fader du volume sur la piste 
esclave. L'affichage de la playlist composite ne peut 
pas être édité directement.

Pour afficher la playlist composite sur des pistes 
esclaves VCA :

 Sélectionnez View > Automation > Composite 

Playlist. 

Exclusion des pistes esclaves 
VCA de l'automation du Master 
VCA
Lors de l'écriture de données d'automation sur une 
piste Master VCA, les mouvements correspondants 
apparaissent sur la playlist d'automation composite 
de chacune de ses pistes esclaves. Pour exclure une 
piste esclave d'une passe d'automation, activez la 
piste esclave en écriture pour l'automation.

Pour exclure une piste esclave d'une passe 
d'automation de piste Master VCA :

1 Activez la piste Master VCA en écriture pour 
l'automation (mode Write, Touch ou Latch). 

2 Activez en écriture la piste esclave que vous 
souhaitez exclure de l'automation (mode Write). 

3 Assurez-vous que les autres pistes esclaves que 
vous souhaitez inclure dans la passe ne sont pas 
activées en écriture pour l'automation. 

4 Lancez la lecture. 

5 Déplacez le fader sur la piste Master VCA.

6 Arrêtez la lecture. 

L'automation est écrite sur la piste esclave exclue 
de sorte que les mouvements de fader de la piste 
Master VCA sont annulés et que le fader de la piste 
esclave exclue ne se déplace pas lors de la lecture 
suivante. 

Affichage de l'automation composite d'une piste 
esclave VCA

Playlist 
d'automation 
de volume
Playlist 
composite

Automation pour la piste de VCA esclave, annulation 
de l'automation de la piste Master VCA

Esclave inclus

Esclave exclu

Master VCA
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Fusion de l'automation de VCA
Il existe plusieurs façons de confirmer 
(ou fusionner) la contribution des données 
d'automation de volume et de mute d'une piste 
Master VCA sélectionnée pour des playlists 
d'automation de ses pistes esclaves.

Transfert de l'automation d'un 
Master VCA
Vous pouvez utiliser une piste Master VCA pour 
écrire des données d'automation groupées, fusionner 
les données d'automation VCA sur toutes les pistes 
esclaves, puis effacer les données d'automation de la 
piste Master VCA. Les pistes fusionnées seront lues 
comme si elles appartenaient encore au groupe VCA.

Pour fusionner les données d'automation d'une 
piste Master VCA sur toutes ses pistes esclaves 
tout en conservant la piste Master VCA :

1 Sélectionnez la piste Master VCA dont vous 
souhaitez fusionner l'automation. 

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Coalesce VCA Master 

Automation. 

• Effectuez un clic droit sur le nom de la piste 
Master VCA, puis sélectionnez Coalesce VCA 

Master Automation.

L'état composite du niveau de volume et de la 
commande mute est fusionné sur chacune des 
pistes esclaves. Le fader de volume de la piste 
Master VCA est remis à zéro, le paramètre de mute 
VCA est désactivé et toute donnée d'automation de 
la piste Master VCA est effacée.

Suppression d'un Master VCA
Vous pouvez utiliser une piste Master VCA 
temporairement pour écrire des données 
d'automation groupées, puis fusionner les données 
d'automation VCA sur toutes les pistes esclaves en 
supprimant la piste Master VCA. Les pistes 
fusionnées seront lues comme si elles 
appartenaient encore au groupe VCA.

Pour fusionner l'automation d'une piste Master 
VCA sur toutes ses pistes esclaves et supprimer 
la piste Master VCA :

1 Sélectionnez la piste Master VCA dont vous 
souhaitez fusionner l'automation.

2 Sélectionnez Track > Delete.

L'état composite du niveau de volume et de la 
commande mute est fusionné sur chacune des 
pistes esclaves.

Suppression d'une piste esclave 
d'un groupe VCA
Vous pouvez supprimer une piste esclave 
individuelle d'un groupe VCA. Vous confirmez ainsi 
les données d'automation VCA sur cette piste, sans 
affecter la piste Master VCA ni les autres pistes 
esclaves. La piste esclave fusionnée est lue comme si 
elle appartenait encore au groupe VCA.

Pour fusionner les données d'automation d'une 
piste Master VCA sur une piste esclave individuelle :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez Modify Groups dans le menu de la 
liste des groupes. 

• Cliquez sur l'indicateur d'ID de groupe de la 
piste, puis sélectionnez Modify. 

• Effectuez un clic droit sur le nom du groupe dans la 
liste des groupes, puis sélectionnez Modify.

Cette action ne peut pas être annulée.
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2 Dans la boîte de dialogue Groups, sélectionnez 
le groupe contrôlé par VCA contenant 
la piste esclave.

3 Dans la boîte de dialogue Groups, cliquez sur 
Tracks, puis supprimez la piste esclave du groupe.

4 Cliquez sur OK.

La piste esclave est supprimée du groupe VCA 
et l'état composite du niveau de volume et de la 
commande mute est fusionné sur la piste. 

Duplication d'une piste esclave
Lorsque vous dupliquez une piste esclave sans 
dupliquer ses affectations de groupes, les données 
d'automation VCA sont fusionnées sur la piste 
dupliquée. La piste dupliquée fusionnée est lue 
comme si elle appartenait au groupe VCA. 

Pour fusionner les données d'automation d'une 
piste Master VCA sur une piste esclave 
individuelle en dupliquant la piste :

1 Sélectionnez la piste esclave dont vous souhaitez 
fusionner les données d'automation. 

2 Sélectionnez Track > Duplicate.

3 Dans la boîte de dialogue Duplicate Track, 
désélectionnez Group Assignments.

4 Cliquez sur OK. 

L'état composite du niveau de volume et de la 
commande mute est fusionné sur la piste dupliquée. 
La piste esclave d'origine est conservée et le groupe 
VCA reste inchangé.

Fusion d'automation sur une 
sélection d'édition
Vous pouvez confirmer des données d'automation 
de VCA sur une sélection d'automation d'une piste 
Master VCA sans confirmer l'automation sur toute 
la durée de la piste.

Pour fusionner l'automation dans une sélection 
d'édition sur une piste Master VCA :

1 Sélectionnez la piste Master VCA dont vous 
souhaitez fusionner l'automation.

2 Créez une sélection d'édition sur une piste 
Master VCA englobant la plage de données 
d'automation à fusionner.

3 Effectuez l'une des opérations suivantes :

• Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur Track > 

Coalesce VCA Master Automation. 

• Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et effectuez un clic droit 
sur le nom de la piste Master VCA, puis 
sélectionnez Coalesce VCA Master Automation. 

L'état composite du niveau de volume et de la 
commande mute est confirmé sur chacune des 
pistes esclaves, sur toute la durée de la sélection 
d'édition. Le volume de la piste Master VCA est 
remis à zéro, le paramètre de mute VCA est 
désactivé et toute donnée d'automation de la piste 
Master VCA est supprimée, dans la zone 
sélectionnée uniquement. 
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Chapitre 46 : Mixdown

Pro Tools permet d'effectuer un mixdown final en 
enregistrant un mix sur de nouvelles pistes audio 
ou en effectuant un bounce sur disque.

Enregistrement sur pistes : De processus consiste 
à créer des sous-groupes de mixage, puis à les 
enregistrer sur de nouvelles pistes audio, comme 
pour n'importe quel autre signal d'entrée. Cette 
méthode requiert des pistes, des voix et des chemins 
de bus disponibles pour le mixage des sous-groupes 
et les nouvelles pistes. Lors de l'enregistrement sur 
pistes, vous pouvez ajuster manuellement les 
commandes du mixeur ou d'autres fenêtres.

Procédez à l'enregistrement sur de nouvelles pistes 
si vous souhaitez ajuster les commandes du mixeur 
en cours de mixdown. 

Bounce sur disque : La commande Bounce to Disk 
permet d'enregistrer un mixage final, de créer une 
nouvelle boucle, d'imprimer des effets ou de 
consolider un sous-groupe de mixage dans de 
nouveaux fichiers audio sur le disque. Cette méthode 
permet d'écrire toutes les voix disponibles sur disque, 
sans avoir à en garder en réserve.

Toute sortie ou chemin de bus disponible peut faire 
office de source de bounce. La fréquence 
d'échantillonnage, la résolution et les autres processus 
de conversion peuvent être appliqués en cours de 
bounce ou après. Bien qu'il soit possible d'écouter en 
temps réel le bounce en cours de création, vous ne 
pourrez pas ajuster les commandes du mixeur ou 
d'autres fenêtres au cours de l'opération. 

Utilisez la commande Bounce to Disk si vous 
devez convertir les fichiers de bounce ou si vous 
n'avez pas besoin d'ajuster manuellement les 
commandes du mixeur en cours de mixdown. 

Sélection d'audio pour des 
boucles, sous-groupes 
et effets
Le bounce sur disque et l'enregistrement sur pistes 
s'appliquent à la sélection de timeline ou d'édition, le 
cas échéant. Il est ainsi plus facile de convertir des 
sélections réalisées à partir de plusieurs pistes en 
boucles mono, stéréo ou multicanal. Les sous-
groupes de mixage, les stems et les autres types 
de mixage spécialisés peuvent également être 
enregistrés sur disque avec l'une de ces méthodes, ou 
être sortis vers d'autres supports d'enregistrement, de 
transfert ou d'archivage. 

La technique d'impression des effets sur disque 
permet d'ajouter de façon définitive des effets 
en temps réel (une égalisation ou une réverbération, par 
exemple) à une piste audio, en la routant vers de 
nouvelles pistes, puis en l'enregistrant avec les effets. 
L'audio d'origine est préservé, ce qui permet de 
revenir à tout moment à la piste source. Cette 
méthode peut être utile si vous disposez d'un nombre 
limité de pistes ou d'effets externes. 

Les plug-ins AudioSuite offrent une autre 
méthode pour enregistrer (ou « imprimer ») un 
effet de plug-in sur disque. Pour plus 
d'informations, reportez-vous au Chapitre 39, 
« Traitement AudioSuite ».
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Utilisation du dithering
Le processus de dithering peut considérablement 
améliorer la qualité du son lors de la réduction de la 
résolution de l'audio numérique. 

Dans quel cas utiliser un plug-in 
de dithering
Utilisez un plug-in de dithering dès lors que vous 
désirez réduire la résolution comme, par exemple, 
lors d'une sortie de mix en 16 bits avec la 
commande Bounce to Disk, ou lors de l'envoi d'un 
mixage final vers un périphérique numérique 
externe enregistrant en 16 bits.

Un plug-in de dithering est nécessaire même lors 
d'une sortie de mix au format 16 bits à partir d'une 
session 16 bits. Bien que ce type de session utilise 
des fichiers 16 bits, ils sont traités à une résolution 
interne supérieure. Les systèmes Pro Tools 
utilisent des chemins de signal audio d'entrée et de 
sortie 24 bits avec traitement à virgule flottante en 
64 bits pour le mixage et le traitement audio.

De ce fait, respectez les points suivants, que votre 
session soit en 32 bits virgule flottante, 24 bits ou 
16 bits virgule fixe :

• Lors d'une sortie de mix vers une destination 
16 bits, utilisez un plug-in de dithering sur 
la sortie principale.

• Lors de l'enregistrement d'un sous-groupe 
de mixage sur une piste de la même session, 
n'utilisez pas de plug-in de dithering sur la piste 
de destination.

• Lors d'une sortie de mix vers une destination 
24 bits, n'utilisez pas de plug-in de dithering sur 
la sortie principale.

• Lors d'une sortie de mix vers une destination 
analogique avec une interface compatible 
24 bits, n'utilisez pas de plug-in de dithering sur 
la sortie principale. 

• En cours d'enregistrement ou de lecture 
normal(e), désactivez tous les plug-ins de 
dithering sur la sortie principale.

Bounce sur disque et dithering
Le bounce sur disque n'applique pas de dithering lors 
de la réduction de la résolution. Pour appliquer un 
dithering lors d'un bounce sur disque, vous devez 
insérer un plug-in de dithering en tant que dernier 
processeur du chemin de signal sur une piste Master 
Fader assignée au chemin de sortie audio de la source 
du bounce. 

Il est préférable d'utiliser un plug-in sur une piste 
Master Fader plutôt qu'une entrée auxiliaire, car les 
inserts de Master Fader sont post-fader. Ainsi, le 
plug-in de dithering prend en compte les 
mouvements de fader de la piste Master Fader. 

En l'absence de plug-in de dithering sur le chemin 
source du bounce, si vous décidez d'opter pour une 
résolution inférieure pendant ou après le bounce sur 
disque, le fichier résultant est converti par troncation. 

Utilisation de dithering sur une 
sortie de mix
Pro Tools est fourni avec des plug-ins de dithering en 
temps réel qui améliorent les performances en 16, 18 
ou 20 bits et réduisent les artefacts de quantification 
lors de la réduction de la résolution d'un mixage de 
sortie.

Pour utiliser un plug-in de dithering sur une sortie 
de mix :

1 Sélectionnez Track > New, puis créez une piste 
Master Fader (stéréo).

2 Définissez la sortie de la piste Master Fader sur 
la sortie ou le chemin de bus à bouncer.

3 Assignez les sorties de toutes les pistes audio de 
la session au même chemin que celui 
sélectionné à l'étape 2. Le Master Fader 
contrôle désormais les niveaux de sortie 
de toutes les pistes routées dessus.
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4 Sur le Master Fader, insérez un plug-in 
de dithering en tant que dernier processeur de la 
chaîne de signal.

5 Dans la fenêtre du plug-in de dithering, réglez 
les paramètres Bit Resolution et Noise Shaping.

6 Effectuez l'une des opérations suivantes :

• Lisez la session pour enregistrer (ou « mettre à 
plat ») la sortie de Pro Tools sur un support de 
résolution inférieure, (tel qu'un Blu-ray 
16 ou 20 bits).

• Sélectionnez File > Bounce To > Disk. Dans la 
boîte de dialogue Bounce to Disk, sélectionnez la 
résolution appropriée (16 bits pour un CD audio, 
par exemple). Avant d'être converti par la 
commande Bounce to Disk, le signal est traité 
selon les paramètres de résolution et de mise en 
forme du bruit du plug-in de dithering inséré sur 
le Master Fader.

Conversion de fréquence 
d'échantillonnage et réduction 
de la résolution
Si vous souhaitez effectuer une conversion de la 
fréquence d'échantillonnage et une réduction de la 
résolution lors du mixdown, commencez par 
convertir la fréquence d'échantillonnage tout en 
conservant la résolution la plus élevée, puis 
réduisez la résolution du fichier obtenu à l'aide 
d'un dithering. En maintenant une résolution 
élevée lors de la conversion de la fréquence 
d'échantillonnage, vous garantissez une qualité de 
son optimale.

Enregistrement de sorties 
de bus sur pistes
Vous pouvez créer un sous-groupe de mixage dans 
une session Pro Tools, le router sur un bus, puis 
enregistrer la sortie de ce bus sur des pistes 
disponibles de la même session. Cette technique 
permet d'ajouter au mixage des entrées live et de 
modifier les niveaux, les panoramiques, les mutes 
ainsi que d'autres commandes en cours 
d'enregistrement. Cette méthode peut également 
être utilisée à la place d'un bounce sur disque pour 
créer des pistes mixées directement dans votre 
session Pro Tools.

Nombre de voix nécessaires 
pour l'enregistrement d'un sous-
groupe
L'enregistrement d'un sous-groupe de mixage sur 
de nouvelles pistes requiert une voix disponible 
pour chaque piste à enregistrer. Assurez-vous de 
disposer de suffisamment de voix pour lire toutes 
les pistes à enregistrer, et de suffisamment de voix 
disponibles pour enregistrer les pistes de 
destination. 

À l'inverse, la commande Bounce to Disk permet de 
bouncer sur disque toutes les voix disponibles sans 
avoir à en garder en réserve ; il est toutefois 
impossible d'intervenir manuellement sur les 
diverses commandes en cours d'opération. Pour plus 
d'informations, reportez-vous à la section « Bounce 
to Disk » à la page 1133.

 Pour plus d'informations sur les plug-ins de 
dithering, reportez-vous au Guide des plug-
ins audio.

Pour plus d'informations sur la gestion des voix, 
reportez-vous à la section « Priorité des pistes et 
assignation des voix » à la page 239.

Sur les systèmes Pro Tools HDX, les plug-ins 
Native placés sur des pistes d'entrée auxiliaire, 
Master Fader et d'instrument utilisent des voix 
supplémentaires et peuvent introduire une 
latence supplémentaire en fonction de la taille 
de la mémoire tampon matérielle. Pour plus 
d'informations, reportez-vous à la section 
« Utilisation des voix et latence totale pour les 
plug-ins Native (basés sur hôte) » 
à la page 1035. 
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Pour enregistrer un sous-groupe de mixage sur 
une piste :

1 Appliquez les plug-ins ou les processeurs 
externes à ajouter aux pistes audio et aux 
entrées auxiliaires avant l'enregistrement.

2 Sélectionnez le même chemin de bus pour 
la sortie de canal principale des pistes à inclure 
dans le sous-groupe. Réglez le panoramique de 
chaque piste si vous utilisez des pistes stéréo ou 
multicanal.

3 Vérifiez que l'option Loop Record n'est 
pas activée.

4 Sélectionnez Track > New, puis créez une 
ou plusieurs pistes audio mono, stéréo 
ou multicanal. 

5 Si vous enregistrez en stéréo, réglez le panoramique 
de la nouvelle piste stéréo (ou des pistes mono) 
entièrement à gauche et à droite.

6 Sélectionnez le chemin de bus dont vous 
souhaitez enregistrer la sortie comme entrée de 
chaque piste de destination.

7 Définissez la sortie des nouvelles pistes sur 
le chemin de sortie principal.

8 Assurez-vous que l'option Options > Link 

Timeline and Edit Selection est activée.

9 Sélectionnez l'audio à enregistrer. Le début, la 
fin et la durée de l'enregistrement peuvent être 
définis par l'emplacement du curseur ou par les 
sélections de timeline et d'édition. 

• Lorsque l'enregistrement est basé sur une sélection, 
l'entrée et la sortie de l'enregistrement s'effectuent 
automatiquement au début et à la fin de la 
sélection. N'oubliez pas d'ajouter du temps à la fin 
d'une sélection pour inclure les queues de 
réverbérations, les dernières répétitions des délais, 
etc.

• En l'absence de sélection, l'enregistrement 
débute au point d'insertion du curseur de lecture. 
Il se poursuit jusqu'à ce que vous appuyiez sur 
Stop. 

10 Activez les nouvelles pistes pour l'enregistrement, 
puis cliquez sur le bouton Record de la fenêtre de 
transport. 

11 Cliquez sur le bouton Play pour lancer 
l'enregistrement du sous-groupe.

12 Si vous enregistrez une sélection, 
l'enregistrement s'arrêtera automatiquement. Si 
vous enregistrez sans sélection, cliquez sur le 
bouton Stop ou effectuez un punch-out. 

13 Lorsque l'enregistrement est terminé, vous 
pouvez exporter le clip enregistré depuis 
la sortie de bus à l'aide de la commande Export 

Clips as Files (reportez-vous à la section 
« Exportation d'un clip en tant que nouveau 
fichier audio » à la page 345). 
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Bounce to Disk
La commande Bounce to Disk permet de réaliser le 
mixdown de toutes les voix disponibles sur votre 
système. Les données de bounce sont enregistrées 
dans des fichiers audio séparés, il n'est pas nécessaire 
de réserver des pistes pour l'opération. Un bounce 
peut être réalisé « offline » (plus rapidement qu'en 
temps réel), ou en temps réel (afin de pouvoir écouter 
votre mix durant le bounce).

Vous pouvez utiliser la commande Bounce to Disk 
pour exporter des boucles, des sous-groupes 
de mixage ou tout autre signal audio de votre session. 
Elle permet également de créer un fichier master final 
mono, stéréo ou multicanal dans l'un des différents 
formats de fichier audio existants. La commande 
Bounce to Disk dispose également d'options de 
conversion de la fréquence d'échantillonnage, de la 
résolution et du format. Elle permet même d'importer 
automatiquement les fichiers bouncés après 
l'opération.

Pour effectuer un bounce sur disque (instructions 
de base) : 

1 Sélectionnez sur la timeline la plage à inclure 
dans l'opération de bounce.

2 Sélectionnez File > Bounce to > Disk.

3 Configurez les options de bounce (reportez-
vous à la section « Options de bounce » 
à la page 1134). 

4 Cliquez sur Bounce.

Lors du bounce sur disque, le fichier résultant 
inclut les éléments suivants :

Pistes audibles : toutes les pistes audibles routées 
sur la sortie sélectionnée en tant que source du 
bounce sont incluses dans le bounce. Les pistes 
mutées ne sont pas incluses dans le bounce. Si une 
ou plusieurs pistes sont en solo, seules ces pistes 
seront incluses dans le bounce.

Automation : toutes les données d'automation dont 
la lecture est activée sont lues et incorporées dans le 
bounce. 

Inserts et départs : tous les inserts actifs, dont les 
plug-ins en temps réel et les inserts matériels, sont 
appliqués dans le bounce.

Durée de la sélection ou des pistes : si vous 
sélectionnez une partie d'une piste, la durée 
du bounce sera égale à celle de la sélection. 
En l'absence de sélection, la durée du bounce 
correspond à la durée de la piste audible la plus 
longue de la session.

Informations de marquage temporel : des 
marqueurs temporels sont automatiquement 
appliqués au contenu bouncé, ce qui permet de le 
faire glisser sur une piste et de le placer au même 
emplacement que le contenu d'origine. Pour plus 
d'informations sur le marquage temporel, reportez-
vous à la section « Marquage temporel » 
à la page 1215.

Fichiers bouncés et compensation du délai

Pro Tools compense tous les délais inhérents aux 
bus et plug-ins lors d'un bounce sur disque. Ainsi, 
lorsqu'un fichier de bounce est réimporté dans une 
session au même emplacement que le mixage 
source, il est aligné temporellement avec ce 
mixage source.

Pistes activées pour l'enregistrement ou en 
mode TrackInput et bounce

Pro Tools n'inclut dans un bounce aucune piste 
activée pour l'enregistrement ou en mode 
de monitoring d'entrée.
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Bounce de sorties de départs 
ou de pistes
En utilisant les menus contextuels de sorties 
spécifiques de départs ou de pistes de Pro Tools, vous 
pouvez accéder à la boîte de dialogue Bounce, 
préconfigurée avec le bon format de canal.

Pour réaliser un bounce sur disque à partir d'un 
chemin de sortie ou de départ :

1 Effectuez un clic droit sur le sélecteur de chemin 
de sortie ou le sélecteur de chemin de départ de la 
sortie ou du départ de la piste.

2 Dans le menu contextuel, sélectionnez Bounce 
<chemin>.

3 La boîte de dialogue Bounce s'ouvre avec 
le chemin de la sortie ou du départ sélectionné en 
tant que source du bounce.

4 Configurez les autres paramètres du bounce et 
cliquez sur Bounce.

Options de bounce
La commande Bounce to Disk donne accès à un certain 
nombre d'options pour les fichiers résultants.

Source du bounce
Tous les chemins de sortie (bus de sortie et bus de 
mixage internes) et sorties physiques actifs définis 
dans la boîte de dialogue I/O Setup sont 
disponibles en tant que source de bounce. 

Pour définir la source du bounce :

 Sélectionnez le chemin de bus, le chemin 
de sortie ou la sortie physique à l'aide 
du sélecteur de source de bounce.

Bus : le fichier bouncé inclut uniquement les 
sources audio routées sur le chemin de bus 
de mixage interne sélectionné.

Sortie : le fichier bouncé inclut uniquement les 
sources audio routées sur le chemin de bus 
de sortie sélectionné.

Menu contextuel d'une sortie de piste dans la fenêtre Mix

Menu contextuel d'un départ dans la fenêtre Mix

Boîte de dialogue Bounce to Disk (conversion 
et options activées)
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Sortie physique : le fichier bouncé inclut 
uniquement les sources audio de tous les chemins de 
sortie assignés à la sortie physique sélectionnée. Cette 
option est utile lorsque vous travaillez avec des 
chemins de sortie qui se chevauchent. 

Bounce simultané de plusieurs sources
(Pro Tools HD uniquement)

Pro Tools HD permet de bouncer simultanément 
jusqu'à 16 sources d'un maximum de 8 canaux 
chacune. 

Pour bouncer plusieurs sources sur disque :

1 Sélectionnez sur la timeline la plage à inclure 
dans l'opération de bounce.

2 Sélectionnez File > Bounce to > Disk.

3 Sélectionnez une source dans le menu Bounce 

Source parmi les chemins de sortie ou de bus 
disponibles.

4 Dans la boîte de dialogue Bounce, cliquez sur le 
bouton « + » situé à droite du sélecteur de la 
source du bounce.

5 Répétez les étapes 3 et 4 autant de fois 
que nécessaire (jusqu'à 16 sources 
de bounce simultanées).

6 Si nécessaire, cliquez sur le bouton « - » situé à 
droite d'une source de bounce (à l'exception de 
la première), pour la supprimer de l'opération.

7 Configurez les autres options de l'opération de 
bounce.

8 Cliquez sur Bounce.

Après avoir cliqué sur le bouton Bounce, une barre 
de progression affiche la durée et la vitesse de 
l'opération.

Sur Mac, appuyez sur Commande+Maj+Plus 
(+) ou Commande+Maj+Flèche bas 
ou Commande+Maj+N pour ajouter une 
ligne de source de bounce. Sur Windows, 
appuyez sur Ctrl+Maj+Plus (+) 
ou Ctrl+Maj+Flèche bas ou Ctrl+Maj+N 
pour ajouter une ligne de source de bounce.

Plusieurs sources de bounce sélectionnées

Sur Mac, appuyez sur Commande+Maj+Moins (-) 
ou Commande+Maj+Flèche haut pour supprimer 
la dernière ligne de source de bounce. Sur 
Windows, appuyez sur Ctrl+Maj+Moins (-) 
ou Ctrl+Maj+Flèche haut pour supprimer 
la dernière ligne de source de bounce.
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Type de fichier
Le sélecteur File Type permet de sélectionner 
un format pour les fichiers bouncés.

WAV (Broadcast .WAV Format)

Ce format est pris en charge sur Windows et Mac. 
Pour utiliser un fichier WAV dans Pro Tools, 
vous pouvez le faire glisser depuis un navigateur de 
l'espace de travail, l'Explorateur Windows, le Finder 
Mac ou un dossier, ou utiliser la commande Import 

Audio. Les fichiers de ce format n'ont pas à être 
convertis pour être utilisés dans Pro Tools.

AIFF (Audio Interchange File Format)

Ce format est pris en charge sur Windows et Mac. 
Pour utiliser un fichier AIFF dans Pro Tools, 
vous pouvez le faire glisser depuis un navigateur de 
l'espace de travail, l'Explorateur Windows, le Finder 
Mac ou un dossier, ou utiliser la commande Import 

Audio. Les fichiers de ce format n'ont pas à être 
convertis pour être utilisés dans Pro Tools.

MP3 (MPEG-1 Layer 3)

Le format de compression MPEG-1 Layer 3 
(MP3) est utilisé pour le streaming et le 
téléchargement d'audio sur Internet, ainsi que sur 
des appareils mobiles.

Lorsque ce format est sélectionné, le menu 
Resolution de la boîte de dialogue des options 
de sortie de Pro Tools n'est pas disponible. 
La résolution est définie par l'encodeur.

La fréquence d'échantillonnage choisie est 
transmise au codec comme fréquence 
d'échantillonnage de base pour les opérations. La 
fréquence d'échantillonnage réelle du fichier 
obtenu est définie dans la boîte de dialogue des 
options d'encodage MP3. Si vous sélectionnez, par 
exemple, une fréquence d'échantillonnage de base 
de 48 000 Hz, la boîte de dialogue des options 
d'encodage MP3 proposera une sortie en 48, 24 ou 
12 kHz, selon la qualité d'encodage.

Pour exporter ou bouncer des données au format 
MP3, vous pouvez définir les options suivantes :

Paramètres d'encodage

Encoder Speed : cette option détermine la qualité 
audio du fichier bouncé. Deux choix sont disponibles : 
Highest Quality et Fastest Encoding Time. 

Le traitement de l'audio peut durer jusqu'à cinq fois 
plus longtemps avec l'option Highest Quality qu'avec 
l'option Fastest Encoding. Il est donc préférable de 
réserver la première option aux situations dans 
lesquelles une qualité optimale est indispensable et 
pour lesquelles vous disposez de suffisamment de 
temps pour l'encodage. 

Constant Bit Rate (CBR) : encode le fichier avec 
un débit constant sélectionné dans le menu 
Constant Bit Rate (CBR). Ce débit étant fixe, 
la qualité de l'audio encodé varie selon la nature du 
contenu compressé. L'option 128 Kbit/s est 
généralement préconisée pour un streaming 
sur Internet, car la bande passante requise 
est prévisible. 

Options d'exportation en MP3
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Enable MP3 Surround Encoding : cette option est 
disponible uniquement lors du bounce d'une sortie 
stéréo dans un fichier MP3 entrelacé. La sortie 
stéréo est upmixée et encodée dans un fichier MP3 
surround 5.1 également compatible pour une 
lecture du MP3 en stéréo.

Paramètres ID3 Tag Info

ID3 Tag Type : le tag ID3 stocke les données 
concernant le fichier audio encodé et est utilisé par les 
lecteurs MP3 pour afficher des informations sur le 
fichier. Pro Tools prend en charge trois versions de ce 
tag afin d'assurer une compatibilité descendante avec 
des lecteurs MP3 moins récents : 

• ID3 v1.0 : apparaît à la fin d'un fichier MP3 
de streaming. Les informations du tag 
ne s'affichent qu'au terme du streaming.

• ID3 v1.1 : identique à la version 1.0, avec 
un numéro de plage ajouté au tag.

• ID3 v2.3 : apparaît au début d'un fichier MP3 de 
streaming. Les informations du tag s'affichent 
dès le début du streaming.

Title/Artist/Album/Comment : saisissez le titre, 
le nom de l'artiste et toute autre information 
concernant le fichier MP3. Un grand nombre 
de lecteurs MP3 affichent ces informations.

Genre : sélectionnez un genre décrivant le contenu 
du fichier. Cette information est lue par de 
nombreux lecteurs MP3 et peut apparaître dans des 
catalogues et des bases de données pour effectuer 
des recherches ciblées.

Track : avec les types de tag ID3 v1.1 et v2.3, vous 
pouvez indiquer un numéro de plage de CD pour le 
fichier. Un grand nombre de lecteurs MP3 
affichent ces informations.

Year : indiquez une année. Un grand nombre 
de lecteurs MP3 affichent ces informations.

Paramètres de fichier Mac

Mac File Type et Creator : si votre fichier est 
destiné à un ordinateur Mac, vous pouvez indiquer 
le type de fichier Mac et le nom de son créateur. Il 
suffira de double-cliquer sur le fichier pour ouvrir 
le lecteur MP3.

Bouton Defaults

Pour restaurer tous les paramètres de cette boîte de 
dialogue, cliquez sur Defaults.

QuickTime 

QuickTime est le format de fichier audio multimédia 
d'Apple. Ce type de fichier n'est pas pris en charge 
directement dans les sessions Pro Tools. Pour 
utiliser un fichier audio QuickTime sur un système 
Pro Tools, utilisez la commande Import Audio. 
Le format QuickTime est couramment utilisé pour 
envoyer des fichiers en pièce jointe pour simplifier 
la révision et l'approbation de projets à distance. De 
nombreuses applications multimédia populaires 
reconnaissent également le format QuickTime.

Windows Media 
(Windows uniquement)

Les fichiers formatés Windows Media peuvent 
contenir des données audio, vidéo ou de script, 
stockées au format Windows Media. Les fichiers 
au format Windows Media peuvent porter 
l'extension de nom de fichier .asf ou .wmv.

Pour obtenir des informations complètes sur 
la lecture des MP3 surround, rendez-vous 
sur www.fraunhofer.com.

Bien que ID3 v2.3 soit actuellement le format 
MP3 standard, il n'est pas reconnu par tous les 
lecteurs MP3. Contactez le développeur du 
logiciel de votre lecteur pour en savoir plus sur 
sa compatibilité.
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MXF (Material Exchange Format)

MXF est un format de fichier média qui comprend à 
la fois des fichiers audio et vidéo. Il permet 
d'échanger des contenus audiovisuels avec les 
données et métadonnées associées. Il a été conçu 
dans le but d'améliorer l'interopérabilité des fichiers 
entre les serveurs, stations de travail et autres 
périphériques de création de contenu.

Les fichiers de séquence AAF et OMF peuvent 
se référer aux fichiers média MXF ou intégrer des 
fichiers média MXF. Pro Tools prend en charge 
les séquences AAF intégrées.

Bounce simultané en MP3 et vers 
un autre type de fichier

La nouvelle option Add MP3 de la boîte de dialogue 
Bounce to Disk permet de créer simultanément une 
version MP3 de chaque source du bounce, en plus 
du fichier sélectionné dans le paramètre File Type 
(tel que WAV).

Lorsque l'option Add MP3 est sélectionnée et que 
vous ajoutez le fichier de bounce à votre bibliothèque 
iTunes ou le partagez sur Gobbler ou SoundCloud, 
c'est le type de fichier sélectionné qui est utilisé, et 
non la version MP3. Pour partager un MP3, 
sélectionnez MP3 dans le menu File Type.

L'option Add MP3 n'est pas disponible pour les 
bounces en QuickTime.

Pour bouncer plusieurs sources sur disque :

1 Sélectionnez sur la timeline la plage à inclure 
dans l'opération de bounce.

2 Sélectionnez File > Bounce to > Disk.

3 Sélectionnez un type de fichier dans le menu 
File Type.

4 Activez l'option Add MP3 (sources de bounce 
mono ou stéréo uniquement).

5 Configurez les autres options de l'opération de 
bounce.

6 Cliquez sur Bounce.

7 Configurez les options de la boîte de dialogue 
MP3 suivante et cliquez sur OK.

Format
Il s'agit du format du fichier de bounce résultant. 
Les choix disponibles sont Mono (Summed), 
Multiple Mono ou Stereo Interleaved. 

Pour configurer le format du fichier bouncé :

 Sélectionnez un format de fichier dans 
le sélecteur Format.

Mono (summed) : un seul fichier est créé sur 
le disque ; il s'agit d'un mixage mono sommé 
composé des sources en cours d'écoute. 

Avant de procéder à un bounce sur disque, vérifiez 
que vos niveaux sont inférieurs à -3 dB afin 
d'éviter l'écrêtage qui se produit lorsque les 
signaux droit et gauche dépassent -3 dB au-
dessous du niveau maximum, ou niveau « pleine 
échelle » (0 dBFS).

Multiple mono : plusieurs fichiers mono sont 
créés, avec le même nombre de canaux que 
le chemin source. 

• Si le chemin de sortie source ou de bus est 
stéréo, deux fichiers mono sont créés, dont les 
noms reçoivent le suffixe ".L" ou ".R" à l'issue 
du bounce. 

• Pour un format multicanal (six canaux, 5.1, par 
exemple), des fichiers mono individuels sont 
créés pour chaque membre du chemin. Les 
fichiers reçoivent des suffixes de chemin 
conformément à la définition des chemins 
d'entrée dans la boîte de dialogue I/O Setup.

• Si le chemin de sortie source ou de bus est mono, 
le menu contextuel passe de multiple mono à 
mono, et un fichier mono est créé (pas de 
sommation de sources multiples).



Chapitre 46 : Mixdown 1139

Interleaved : cette option crée un fichier entrelacé 
unique, contenant tous les flux bouncés depuis le 
chemin de sortie choisi. Dans un bounce stéréo 
entrelacé, les pistes assignées à des sorties 
impaires sont envoyées sur le canal gauche, et les 
pistes assignées à des sorties paires sont envoyées 
sur le canal droit.

Pro Tools permet également de bouncer des 
fichiers multicanal entrelacés dans chaque type de 
fichier multicanal reconnu (5.1, par exemple). Cette 
option simplifie la gestion des fichiers de mixages 
et de projets pour la sauvegarde et l'archivage. 

Bit Depth
Ce paramètre permet de choisir parmi quatre 
résolutions différentes pour la conversion du bounce. 
Notez que lors d'un bounce sur disque, aucun 
dithering n'est appliqué pour la conversion vers une 
résolution inférieure, que ce soit avant ou après 
l'opération. Pour effectuer un bounce vers un fichier 
de résolution inférieure, insérez un plug-in de 
dithering sur une piste Master Fader assignée au 
chemin source du bounce. Un dithering sera ainsi 
appliqué avant que le fichier ne soit tronqué lors de la 
conversion vers la résolution sélectionnée. Reportez-
vous à la section « Utilisation du dithering » 
à la page 1130.

Les options de résolution suivantes sont disponibles :

16-Bit : Il s'agit de la résolution standard des CD. 

24-Bit : Ce paramètre fournit la plus haute 
résolution, compatible avec la plupart des interfaces 
audio. Il est recommandé pour créer un mixage final 
sans perte de résolution (pour livrer un mix prêt à 
être masterisé par exemple).

32-Bit Float : Ce paramètre fournit la plus haute 
résolution pour le mixage et le traitement de plug-in 
internes de Pro Tools. Il est recommandé pour 
exporter et réimporter des boucles et effets sonores 
dans votre session Pro Tools, ou pour échanger des 
fichiers entre sessions.

Pour configurer la résolution du fichier bouncé :

 Sélectionnez une résolution dans le sélecteur Bit 

Depth.

Sample Rate
Cette option permet d'enregistrer votre fichier dans 
l'une des fréquences d'échantillonnage disponibles. 
Les choix possibles dépendent de votre système 
Pro Tools et de vos interfaces audio. Vous pouvez 
choisir des fréquences d'échantillonnage comprises 
entre 8 kHz et 192 kHz, y compris des fréquences 
d'échantillonnage avec options de pull up et pull 
down.

Qualité de conversion de la fréquence 
d'échantillonnage

Si vous optez pour une valeur de fréquence 
d'échantillonnage différente de la fréquence 
d'échantillonnage originale de la session, les options 
de conversion deviennent accessibles. Vous pouvez 
configurer la qualité de la conversion et planifier son 
exécution au cours du bounce ou après. Pour plus 
d'informations, reportez-vous à la section « Qualité 
de conversion de la fréquence d'échantillonnage » 
à la page 1140.

Fréquences d'échantillonnage courantes

Vous trouverez ci-après les fréquences 
d'échantillonnage les plus courantes et leurs 
applications. Des fréquences d'échantillonnage 
plus élevées fourniront une meilleure fidélité audio 

Dans une session en 16 bits, vous devrez tout de 
même utiliser un plug-in de dithering sur le 
mixage de sortie, car tous les systèmes 
Pro Tools traitent les sons en interne à une 
résolution supérieure.
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pour l'enregistrement et la lecture, ainsi que pour le 
traitement des plug-ins de dynamique, de dithering 
(avec mise en forme du bruit) et d'émulation 
analogique.

192 kHz : cette fréquence d'échantillonnage est 
prise en charge pour certains DVD audio et permet 
d'obtenir la meilleure fidélité audio possible avec 
des interfaces audio compatibles, telles qu'une 
HD I/O.

176,4 kHz : il est possible de travailler en 176,4 kHz 
pour une sortie finale en 44,1 kHz (disques 
compacts, par exemple). Cela permettra d'obtenir 
une conversion de fréquence d'échantillonnage 
en 44,1 kHz un peu plus rapide qu'à partir 
de 192 kHz.

96 kHz : cette fréquence d'échantillonnage est 
prise en charge pour les DVD audio et permet 
d'obtenir une fidélité audio de haute qualité avec 
des interfaces audio compatibles, telles qu'une 
HD I/O ou une 003. 

88,2 kHz : il est possible de travailler en 88,2 kHz 
pour une livraison finale en 44,1 kHz (disques 
compacts, par exemple). Cela permettra d'obtenir 
une conversion de fréquence d'échantillonnage en 
44,1 kHz un peu plus rapide qu'à partir de 96 kHz.

48 kHz : il s'agit de la fréquence d'échantillonnage 
standard pour la vidéo professionnelle et les DVD, 
ainsi que pour l'archivage de certains labels 
discographiques et de broadcast. Elle est prise 
en charge par les magnétophones DA-88/98, 
DAT et ADAT.

44,1 kHz : cette fréquence d'échantillonnage 
standard pour les disques compacts (CD) est prise 
en charge par les magnétophones DA-88/98, DAT et 
ADAT.

Les autres fréquences d'échantillonnage sont 8 kHz, 
11,025 kHz, 16 kHz, 22,050 kHz et 32 kHz.

Custom : pour définir une fréquence 
d'échantillonnage personnalisée, cliquez dans 
la fenêtre de la fréquence d'échantillonnage 
et entrez une valeur manuellement, comprise entre 
4 000 et 200 200 samples.

Fréquences de pull up et pull down : toutes les 
fréquences d'échantillonnage disponibles prennent 
en charge les fréquences de pull up et pull down, 
ou d'autres valeurs spécifiques. 

Qualité de conversion de la 
fréquence d'échantillonnage
Dès que vous sélectionnez une fréquence 
d'échantillonnage pour le fichier bouncé différente 
de celle de la session (par exemple pour une sortie 
CD audio en 44,1 kHz d'une session enregistrée en 
96 kHz), Pro Tools utilise l'option Conversion 

Quality pour déterminer la qualité de la conversion 
de fréquence d'échantillonnage appliquée. 

Cinq qualités de conversion sont disponibles, 
classées par ordre croissant de Low (qualité la plus 
basse) à Tweak Head (qualité la plus haute). Plus la 
qualité de conversion de la fréquence 
d'échantillonnage est élevée, plus la conversion du 
fichier bouncé est longue.
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Enforce Avid Compatibility
Activez cette option de la boîte de dialogue Bounce to 
Disk pour créer un fichier bouncé avec des 
alignements à l'image des points d'édition, encapsulé 
au format OMFI (sauf si le type de fichier est MXF), 
et restreindre les options de fréquence 
d'échantillonnage à 44,1 kHz ou 48 kHz. 
Un dithering sans mise en forme du bruit sera 
appliqué aux fichiers 24 bits exportés en 16 bits.

Add to iTunes Library
Pro Tools permet de bouncer votre mix directement 
dans votre bibliothèque iTunes à l'aide de l'option 
Add to iTunes Library de la boîte de dialogue Bounce 
to Disk. Lorsque cette option est sélectionnée, le 
fichier bouncé est copié dans votre bibliothèque 
iTunes locale. Vous pouvez spécifier l'emplacement 
de votre bibliothèque iTunes à l'aide du nouveau 
paramètre iTunes Library Folder des préférences de 
fonctionnement de Pro Tools.

Si l'option Add to iTunes Library est activée lors 
d'un bounce sur disque, le fichier audio résultant 
sera automatiquement importé dans iTunes lors de 
la prochaine ouverture de cette application. Si 
iTunes n'est pas installé sur votre ordinateur, cette 
option n'a aucun effet.

Pour exporter votre mix vers votre bibliothèque 
iTunes :

1 Sélectionnez File > Bounce to > Disk.

2 Dans la boîte de dialogue Bounce to Disk, 
sélectionnez une source dans le menu Bounce 

Source et configurez les autres options.

3 Activez l'option Add to iTunes Library.

4 Cliquez sur Bounce.

Import After Bounce
L'option Import After Bounce importe 
automatiquement les nouveaux fichiers bouncés dans 
la liste des clips. Vous pouvez alors les placer sur des 
pistes. Si vos nouveaux fichiers bouncés sont des 
fichiers stéréo (mono multiples) divisés, ils 
apparaissent ensemble dans la liste des clips.

Share With SoundCloud
SoundCloud est un site Web de partage audio. 
Les utilisateurs créent un profil public et y publient les 
fichiers audio qu'ils souhaitent partager. Ces fichiers 
peuvent ensuite être écoutés par tous les utilisateurs 
du site, ou uniquement par un groupe d'utilisateurs 
particuliers. Les outils de partage simples de 
SoundCloud permettent de publier vos morceaux ou 
listes de lecture sur d'autres sites Web, y compris des 
réseaux sociaux tels que Twitter, Facebook et 
Google+.

Pro Tools permet de partager votre mix sur 
SoundCloud à l'aide de l'option Share With 
SoundCloud de la boîte de dialogue Bounce to 
Disk ou Export Selected. Lorsque cette option est 
sélectionnée, le fichier bouncé (ou exporté) est 
automatiquement envoyé sur votre compte 
SoundCloud. Si vous n'avez pas encore de compte, 
vous pouvez en créer un gratuitement. 

L'option Add to iTunes Library est uniquement 
disponible si la source de bounce est un chemin 
mono ou stéréo et si le format est Mono 
(Summed) ou Interleaved.

L'option Import After Bounce n'est disponible que 
si le type de fichier cible et la fréquence 
d'échantillonnage du bounce sont identiques 
au type de fichier et à la fréquence 
d'échantillonnage de la session actuelle, et si la 
résolution cible (débit) est inférieure ou égale à la 
résolution de la session. En outre, les pistes 
bouncées dans un fichier stéréo entrelacé (Stereo 
Interleaved) ne peuvent pas être automatiquement 
importées après un bounce.

L'option Share with SoundCloud est 
uniquement disponible si le format est défini 
sur Mono (summed) ou Interleaved.

Pour plus d'informations sur SoundCloud, 
rendez-vous sur www.soundcloud.com.
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Pour partager votre mix sur SoundCloud via 
la boîte de dialogue Bounce to Disk :

1 Sélectionnez File > Bounce To > Disk.

2 Dans la boîte de dialogue Bounce to Disk, 
configurez les paramètres Bounce Source, File 

Type, Bit Depth et Sample Rate. 

3 Assurez-vous que le paramètre Format est 
défini sur Mono (summed) ou Interleaved.

4 Sélectionnez SoundCloud dans le menu 
Share With.

5 Cliquez sur Bounce.

6 Configurez les options de la boîte de dialogue 
Share With SoundCloud (reportez-vous à la 
section « Boîte de dialogue Share with 
SoundCloud » à la page 1142).

7 Cliquez sur Share.

8 Si vous n'êtes pas connecté à votre compte 
SoundCloud, vous êtes invité à vous identifier 
(reportez-vous à la section « Connexion à 
Gobbler » à la page 1144).

Le fichier bouncé est créé sur votre disque local, 
puis directement publié sur votre compte 
SoundCloud si vous êtes connecté.

Contrôle de la progression du transfert

Vous pouvez contrôler la progression du transfert 
dans le Gestionnaire de tâches (Window > 

Task Manager).

Si l'option Notify me when the upload is complete est 
activée dans la boîte de dialogue Share with 
SoundCloud, une notification apparaîtra dans la boîte 
de dialogue Upload Successful (depuis laquelle vous 
pouvez copier l'URL dans le presse-papiers) dès que 
le fichier bouncé est publié sur votre compte 
SoundCloud.

Connexion à SoundCloud

Pour se connecter à votre compte SoundCloud 
(et, si nécessaire, en créer un) :

1 Sélectionnez Setup > Connect To > SoundCloud.

2 Effectuez l'une des opérations suivantes :

• Pour utiliser un compte existant, remplissez les 
champs Email\Login et Password pour votre 
compte SoundCloud, puis cliquez sur le bouton 
Connect.

• Pour créer un compte, cliquez sur le bouton Not 
a member ? Signup ! . Une fois le site 
SoundCloud ouvert dans votre navigateur Web 
par défaut, suivez les instructions à l'écran.

Boîte de dialogue Share with SoundCloud

La boîte de dialogue Share with SoundCloud 
contient des champs de saisie de texte, des 
paramètres et des options qui vous permettent de 
spécifier les informations à inclure avec 
le morceau transféré sur SoundCloud. Elle inclut 
également les paramètres de licence et de droits de 
vos morceaux, afin de spécifier les utilisateurs qui 
peuvent y accéder, ainsi que le type d'utilisation 
qu'ils peuvent en faire. Les informations, options et 
paramètres associés à vos morceaux peuvent 
également être modifiés en ligne ultérieurement 
depuis votre compte SoundCloud.

Pour plus d'informations, rendez-vous sur 
www.soundcloud.com.

Boîte de dialogue Share with SoundCloud
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Title

Dans le champ Title, saisissez le titre du morceau à 
transférer sur SoundCloud.

Description

Dans le champ Description, saisissez un description 
du morceau à transférer sur SoundCloud.

Licence

Sélectionnez l'option License appropriée pour 
le morceau à transférer sur SoundCloud.

Type

Sélectionnez le Type du morceau à transférer sur 
SoundCloud.

Downloadable

Activez l'option Downloadable si vous souhaitez que 
les utilisateurs puissent télécharger votre morceau 
depuis SoundCloud. Si cette option n'est pas activée, 
votre morceau ne sera disponible qu'en streaming 
(écoute) et ne pourra pas être téléchargé.

Genre

Dans le champ Genre, saisissez le genre 
du morceau à transférer sur SoundCloud.

Tags

Saisissez tous les Tags que vous souhaitez associer 
au morceau à transférer sur SoundCloud. Pour 
saisir plusieurs tags, séparez-les par un espace. 
Pour créer des tags comprenant plusieurs mots et 
espaces, saisissez-les entre guillemets.

Private Track

Activez l'option Private Track pour que le morceau 
transféré sur SoundCloud ne soit accessible que 
par certains utilisateurs. Lorsque cette option est 
sélectionnée, vous pouvez saisir les adresses e-
mail des personnes autorisées à accéder à votre 
morceau. Pour saisir plusieurs adresses, séparez-
les par une virgule.

Notify

Activez l'option Notify me when the upload is 

complete pour être informé de la fin du transfert de 
votre morceau sur votre compte SoundCloud.

Share With Gobbler
Pro Tools permet de partager vos fichiers audio 
bouncés et exportés sur Gobbler à l'aide de l'option 
Share With Gobbler de la boîte de dialogue Bounce 
to Disk ou Export Selected. Lorsque cette option est 
sélectionnée, le fichier bouncé (ou exporté) est 
automatiquement envoyé à vos collaborateurs via 
votre compte Gobbler. Si vous n'avez pas encore 
de compte, vous pouvez en créer un gratuitement.

Pour envoyer votre mix sur Gobbler via la boîte 
de dialogue Bounce to Disk :

1 Sélectionnez File > Bounce To > Disk.

2 Dans la boîte de dialogue Bounce to Disk, 
configurez les paramètres Bounce Source, File 

Type, Format, Bit Depth et Sample Rate. 

3 Sélectionnez Gobbler dans le menu Share With.

4 Cliquez sur Bounce.

Pour plus d'informations sur Gobbler, 
rendez-vous sur www.gobbler.com.

Pour plus d'informations sur la commande 
Send To Gobbler, reportez-vous à la section 
« Transfert de sessions sur Gobbler » 
à la page 391.
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5 Si vous n'êtes pas connecté à votre compte 
Gobbler, vous êtes invité à vous identifier 
(reportez-vous à la section « Connexion à 
Gobbler » à la page 1144).

6 Une fois connecté à votre compte Gobbler, 
l'application Gobbler s'ouvre.

7 Dans la boîte de dialogue Send Files 
de l'application Gobbler, saisissez les adresses 
e-mail des personnes auxquelles vous souhaitez 
envoyer le fichier audio. 

8 Configurez les options restantes.

9 Cliquez sur Send.

Connexion à Gobbler

Pour vous connecter à votre compte Gobbler :

1 Sélectionnez Setup > Connect To > Gobbler.

2 Effectuez l'une des opérations suivantes :

• Pour utiliser un compte existant, remplissez les 
champs Email\Login et Password pour votre 
compte Gobbler, puis cliquez sur le bouton 
Connect.

• Pour créer un compte, cliquez sur le bouton Not 

a member ? Signup ! . Une fois le site Gobbler 
ouvert dans votre navigateur Web par défaut, 
suivez les instructions à l'écran pour créer votre 
compte et installer l'application gratuite 
Gobbler.

Nom de fichier de bounce
Pro Tools fournit un champ de texte File Name 
pour les opérations de bounce sur disque. Dans la 
boîte de dialogue Bounce, saisissez le nom 
souhaité pour le fichier résultant. Pour les 
opérations de bounce multisources, un suffixe est 
ajouté au nom de fichier saisi, avec le nom de la 
source du bounce et un chiffre, incrémenté pour 
chaque source : « <nom fichier>_<nom 
source>_<n> ».

Répertoire
Cliquez sur le bouton Choose pour spécifier 
un répertoire différent de l'emplacement 
d'enregistrement par défaut des fichiers bouncés.

Bounce hors ligne
Pro Tools propose une option Offline pour les 
commandes Bounce to Disk et Bounce 

to QuickTime. Dans la plupart des cas, le bounce sera 
plus rapide qu'en temps réel, en fonction de la taille 
du mixeur de la session et du nombre de plug-ins 
DSP.

Pour effectuer un bounce audio hors ligne sur 
le disque :

1 Sélectionnez sur la timeline la plage à inclure 
dans l'opération de bounce.

2 Sélectionnez File > Bounce to > Disk.

3 Dans la boîte de dialogue Bounce, activez 
l'option Offline.

4 Configurez les options de l'opération de bounce.

5 Cliquez sur Bounce.

Après avoir cliqué sur le bouton Bounce, une barre 
de progression affiche la durée et la vitesse de 
l'opération.

Barre de progression du bounce hors ligne
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Limitations du bounce hors ligne

Lorsque vous réalisez un bounce hors ligne, 
les sources suivantes ne sont pas incluses dans le 
fichier résultant :

• Inserts matériels

• Audio généré dans Pro Tools à partir 
de périphériques MIDI externes (synthétiseurs 
ou sampleurs MIDI externes par exemple)

• Sources audio externes routées sur des pistes 
d'entrée auxiliaire

• Plug-ins uniquement DSP (le bounce hors ligne 
utilise toujours la version Native des plug-ins 
DSP, à condition qu'elle soit disponible)

• Toutes les sources audio synchronisées en externe

Vitesse du bounce hors ligne

La vitesse des opérations de bounce hors ligne peut 
être affectée par les éléments suivants : 

• Utilisation du processeur : la vitesse de votre 
processeur et son taux d'utilisation par 
le système et d'autres applications. L'utilisation 
du processeur apparaît dans la fenêtre System 
Usage.

• Utilisation du disque : par exemple, si la jauge 
d'utilisation du disque de la fenêtre System Usage 
affiche 50 % en lecture, l'opération de bounce hors 
ligne sera effectuée au maximum à deux fois la 
vitesse en temps réel, car il est physiquement 
impossible de lire les données sur le disque plus 
rapidement. Si vous pouvez augmenter la valeur du 
paramètre Disk Playback Cache Size (Setup > 

Playback Engine) afin de stocker en cache 
l'ensemble de l'audio présent sur la timeline, 
ce problème ne devrait pas se produire 
(Pro Tools HD uniquement).

• Si l'utilisation des cœurs des processeurs de votre 
ordinateur est mal équilibrée du fait d'une taille de 
mixeur importante et du nombre de plug-ins 
Native activés, vérifiez si les jauges d'utilisation 
des cœurs sont également mal équilibrées dans 
la section CPU de la fenêtre System Usage. 
La suppression ou la désactivation de plug-ins 
Native sur des pistes d'entrée auxiliaire ou Master 
Fader peut atténuer ce problème.

• Certains plug-ins tiers peuvent ralentir les 
opérations de bounce hors ligne du fait de leurs 
besoins en ressources CPU.

Cancel
Le bouton Cancel ferme la boîte de dialogue 
Bounce to Disk sans lancer la conversion pour 
le bounce sur disque.

Bounce
Le bouton Bounce lance la conversion pour 
le bounce sur disque. Une boîte de dialogue 
d'enregistrement s'ouvre. Accédez au dossier dans 
lequel vous souhaitez enregistrer le fichier bouncé. 
Sélectionnez le dossier et cliquez sur Save. Une 
fenêtre de progression s'ouvre alors ; elle indique le 
temps restant avant la fin du bounce.

Sur les systèmes Pro Tools HD avec du matériel 
HDX, tout traitement HEAT présent sur le chemin 
du bounce est inclus dans l'opération.

Notez que pour certaines sessions avec des 
configurations de mixeur très importantes, 
de nombreux plug-ins basés sur DSP et de 
l'automation, il est possible que le bounce 
hors ligne soit plus lent que le bounce 
en temps réel.
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Enregistrement d'un sous-
groupe de mixage (avec la 
commande Bounce to Disk)
Vous pouvez créer un sous-groupe de mixage à l'aide 
de la commande Bounce to Disk, en mutant des pistes 
ou en bypassant les inserts n'appartenant pas au sous-
groupe, puis en sélectionnant la partie de la session à 
bouncer. Vous pouvez également mettre en solo 
uniquement les données audio à bouncer.

Il est également possible de créer un sous-groupe de 
mixage en enregistrant la sortie des pistes sur de 
nouvelles pistes. Pour plus d'informations, reportez-
vous à la section « Conversion de fréquence 
d'échantillonnage et réduction de la résolution » 
à la page 1131.

Pour bouncer un sous-groupe de mixage sur disque :

1 Configurez votre bounce à l'aide de départs, 
d'entrées auxiliaires et de pistes Master Fader. Pour 
plus d'informations, reportez-vous à la section 
« Routing du signal pour le monitoring et les sous-
groupes de mixage » à la page 1013.

2 Effectuez l'une des opérations suivantes :

• pour bouncer la session entière, cliquez sur 
Return to Zero dans la fenêtre de transport pour 
aller au début de la session ; 

• pour bouncer une partie de la session, activez 
Options > Link Timeline and Edit Selection, puis 
créez une sélection dans la fenêtre Edit.

3 Sélectionnez File > Bounce to > Disk.

4 Configurez les options et les paramètres 
de bounce. 

5 Assurez-vous que la résolution du fichier 
bouncé correspond à celle de la session.

6 Vérifiez que la fréquence d'échantillonnage 
du fichier bouncé est prise en charge par 
la session et par l'interface audio.

7 Si nécessaire, vérifiez que le type et le format du 
fichier bouncé correspondent au type et au 
format de fichier de la session.

8 Cliquez sur Bounce.

Pour importer les fichiers bouncés sur des pistes, 
effectuez l'une des opérations suivantes :

 Activez l'option Import after Bounce avant 
de lancer le bounce sur disque. Une fois les 
fichiers bouncés importés dans la liste des clips, 
vous pouvez les faire glisser sur des pistes.

 Importez le ou les fichiers bouncés dans 
la session à l'aide de la commande Import Audio 
(File > Import > Audio).

 Faites glisser les fichiers bouncés à partir d'un 
navigateur de l'espace de travail ou du poste de 
travail. 
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Mixdown final (avec la 
commande Bounce to Disk)
Au cours d'un mixdown final, vous créez 
un mixage prenant en compte toutes les éditions, 
toutes les automations et tous les traitements 
d'effet.

Pour bouncer un mix final sur disque :

1 Ajustez les niveaux de sortie des pistes 
et finalisez les automations de mixage 
éventuelles de chaque piste de la session.

2 Ajustez tous les paramètres de plug-in et d'effet 
en temps réel ainsi que l'automation sur chacune 
des pistes de la session.

3 Assurez-vous que toutes les pistes à inclure 
dans le bounce sont audibles (non mutées 
ou désactivées).

4 Assignez la sortie de chaque piste à inclure dans 
le bounce à un même chemin de sortie ou de 
bus.

5 Insérez un plug-in de dithering (reportez-vous à 
la section « Utilisation du dithering » 
à la page 1130).

6 Effectuez l'une des opérations suivantes :

• Pour bouncer la session entière, cliquez sur 
Return to Zero dans la fenêtre de transport pour 
aller au début de la session. 

• Pour bouncer une partie de la session, activez 
Options > Link Timeline and Edit Selection, 
puis créez une sélection dans la fenêtre Edit.

7 Sélectionnez File > Bounce to > Disk.

8 Sélectionnez le chemin de la source à bouncer.

9 Configurez les autres paramètres de la boîte de 
dialogue Bounce to Disk. Reportez-vous à la 
section « Options de bounce » à la page 1134.

10 Cliquez sur Bounce.

Par défaut, le bounce s'arrête à la fin de la 
dernière forme d'onde audio ou note MIDI. 
Pour arrêter le bounce plus tôt, créez une 
sélection d'édition ou de timeline afin de définir 
la fin (et le début) du bounce.
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Mastering
Lors de l'étape de mastering final, vous pouvez 
enregistrer la sortie de votre mix directement sur 
disque, Blu-ray, DAT, DVD, CD, un enregistreur 
de mastering stéréo ou un enregistreur multipiste 
(pour les mix surround).

Une fois le Master de votre session créé, 
vous pouvez le transférer sur un support mobile 
afin de le dupliquer. Il est également possible 
de transférer le fichier Master sur un CD ou DAT 
afin de graver des CD.

Mastering sur un enregistreur 
numérique
Bien qu'il soit généralement préférable 
de masteriser les sessions directement sur disque 
dur, Pro Tools permet de réaliser un mastering 
numérique sur tout enregistreur numérique équipé 
d'entrées AES/EBU ou S/PDIF, tel qu'un 
magnétophone DAT, par exemple.

Mastering et compression audio
Bien que la compression audio soit souvent un outil 
indispensable en enregistrement analogique, elle est 
parfois source de problèmes dans le domaine 
numérique. La compression d'un signal d'entrée à un 
taux très élevé résulte en un signal contenant une 
puissance totale extrêmement importante par rapport 
au niveau des transitoires. En enregistrant un certain 
nombre de ces signaux au niveau le plus élevé 
possible sur plusieurs pistes, vous créez une situation 
susceptible d'accroître le risque d'écrêtage du signal 
de sortie mixé.

Le mixage de signaux très puissants après 
compression génère un niveau de sortie 
extrêmement élevé. Il est possible que ce signal de 
sortie dépasse le niveau de pleine échelle, 
conduisant à un écrêtage. 

Pour éviter ce problème, surveillez le niveau global 
de votre mix : utilisez un indicateur de niveau sur un 
Master Fader, ou les indicateurs de niveau 
de l'enregistreur de mastering externe pour identifier 
les écrêtages. Pour un mastering sur disque dur, 
évitez de mixer des signaux audio au niveau pleine 
échelle (niveau 0, ou unitaire), cela provoquerait 
systématiquement de l'écrêtage.

Mastering et correction 
d'erreurs du support
Les supports à accès aléatoire (tels que les disques 
durs ou lecteurs USB ou flash) peuvent générer une 
copie numérique exacte de vos données, car la valeur 
de chaque bit est préservée. Les supports séquentiels 
(les bandes numériques, par exemple) utilisent des 
algorithmes de correction d'erreurs afin de compenser 
les données erronées éventuellement reçues lors de 
transferts numériques. Ces corrections dévient 
légèrement par rapport aux données réelles ; aussi les 
générations successives de copie entraînent-elles une 
dégradation progressive.

Pour éviter ces dégradations, créez et conservez 
vos Masters sur des supports numériques à accès 
aléatoire (un disque dur, par exemple), et ne les 
transférez vers un support numérique séquentiel 
qu'en cas de besoin.



Partie X : Surround
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Chapitre 47 : Configuration de Pro Tools pour 
le surround

Pro Tools HD permet de travailler avec les formats 
surround jusqu'en 7.1. 

Mixage surround dans 
Pro Tools
(Pro Tools HD uniquement)

Pro Tools prend en charge le mixage des formats 
multicanal suivants (supérieurs à stéréo) : LCR, 
Quad, LCRS, 5.0, 5.1, 6.0, 6.1, 7.0, 7.0 SDDS 
(Sony Dynamic Digital Sound), 7.1 et 7.1 SDDS.

Connexions audio de Pro 
Tools pour un mixage en 5.1
Même si tous les formats de mixage 5.1 prévoient 
une disposition des haut-parleurs identique, trois 
standards principaux régissent la disposition des 
différents canaux constituant le mixage multicanal 
au format 5.1 sur les pistes. 

Dans le tableau suivant, nous partons du principe 
que les canaux surround sont assignés aux 
sorties 1 à 6 d'une interface audio Pro Tools. 
Utilisez les canaux 7 et 8 pour le monitoring d'un 
mix stéréo pour une version stéréo ou pour des 
mixages casque.

Le tableau suivant présente le routing des piste 
mono X-MON pour un mixage SDDS 7.1. 
Un mixage 5.1 devrait utiliser le même routing, 
en excluant les sorties 2 et 4 (Lc et Rc).

Pour obtenir des informations à propos des 
concepts fondamentaux du surround, 
consultez le Guide Pro Tools des concepts de 
synchronisation et de son surround.

Disposition des pistes pour les formats 5.1

Formats Disposition des pistes

1 2 3 4 5 6

Film 
(Pro Tools par 

défaut)

L C R Ls Rs LFE

SMPTE/ITU 
pour Dolby 

Digital (AC3)

L R C LFE Ls Rs

DTS L R Ls Rs C LFE

C|24 L C R Ls Rs Lf

Disposition des pistes par défaut pour le format 
SDDS 7.1

Formats Disposition des pistes

1 2 3 4 5 6 7 8

X-MON L Lc C Rc R Ls Rs LFE
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Pour connecter vos interfaces audio pour le 
mixage et le monitoring au format 5.1 :

1 Déterminez le format 5.1 et la disposition des 
pistes à appliquer. 

2 Connectez les canaux de sortie de votre interface 
audio aux canaux d'entrée correspondants de 
votre système d'écoute, conformément aux 
assignations du tableau ci-dessus.

Formats 7.1 et 7.0

Formats 7.1 et 7.0
Les systèmes HD-DVD et Blu-Ray utilisent la 
disposition de pistes suivante pour les formats 
surround 7.1 et 7.0 : 

• 3 canaux avant (gauche, central, droit)

• 2 canaux latéraux (côté gauche surround, côté 
droit surround)

• 2 canaux arrière (arrière gauche surround, 
arrière droit surround)

• 1 canal LFE (formats x.1 uniquement)

Le tableau suivant affiche le routing de piste mono 
par défaut pour un mixage 7.1 dans Pro Tools.

Formats SDDS 7.1 et 7.0
Les formats surround Sony Dynamic Digital 
Sound (SDDS) 7.1 et 7.0 utilisent la disposition de 
pistes suivante : 

• 5 canaux avant (gauche, gauche central, central, 
droit central, droit)

• 2 canaux arrière (arrière gauche, arrière droit)

• 1 canal LFE (formats x.1 uniquement)

Le tableau suivant affiche le routing de piste mono 
par défaut pour un mixage SDDS 7.1 dans Pro Tools.

Configuration de Pro Tools 
pour les sessions multicanal
Il existe plusieurs méthodes permettant de configurer 
Pro Tools et les sessions pour le mixage multicanal :

Nouvelles sessions

Vous pouvez créer une session et choisir un fichier 
de paramètres d'E/S de mixage surround comme 
configuration d'E/S par défaut. Reportez-vous à la 
section « Nouvelles sessions et paramètres d'E/S » 
à la page 1153. 

Remixage de sessions en surround 
(importation de paramètres d'E/S multicanal)

En créant ou important un fichier de paramètres 
d'E/S de mixage surround dans la boîte de dialogue 
I/O Setup, il est possible de disposer de chemins 
multicanal dans n'importe quelle session stéréo 
(ou tout autre format). Vous pouvez ensuite 
réassigner les pistes des chemins stéréo originaux 
à ces chemins multicanal. Les chemins actifs et 
inactifs simplifient la réassignation Reportez-vous 
à la section « Importation de configurations d'E/S 
multicanal » à la page 1155.

Si vous utilisez une surface de contrôle, 
consultez son guide d'utilisation pour obtenir 
plus d'informations.

Disposition des pistes par défaut pour le format 7.1

Disposition des pistes

1 2 3 4 5 6 7 8

L C R Lss Rss Lsr Rsr LFE

Disposition des pistes par défaut pour le format SDDS 7.1

Disposition des pistes

1 2 3 4 5 6 7 8

L Lc C Rc R Ls Rs LFE
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Chemins multicanal personnalisés

Vous pouvez personnaliser et redéfinir des chemins 
existants dans la boîte de dialogue I/O Setup. Pour 
plus d'informations, reportez-vous à la section 
« Chemins multicanal personnalisés » à la 
page 1155. 

Importation de données de session

La commande Import Session Data (File > Import > 

Session Data) permet d’importer non seulement 
les pistes et les médias d'autres sessions, mais 
également les chemins et les assignations de piste 
associés. Après avoir importé les données de 
session, utilisez la boîte de dialogue I/O Setup 
pour configurer les chemins et les sous-chemins 
requis par la session. Pour plus d'informations, 
reportez-vous au Chapitre 7, « I/O Setup ».

Nouvelles sessions et 
paramètres d'E/S
Lors de la création d'une nouvelle session, 
vous pouvez choisir un format surround à utiliser 
en tant que configuration d'E/S par défaut. 
Des configurations de chemin par défaut sont 
fournies sous forme de fichiers de configuration 
d'E/S, pour des mixages stéréo et surround.

Une fois que vous avez créé une session, vous 
pouvez créer et importer des pistes, des données 
audio, et gérer le routing des signaux afin de 
préparer votre mixage. 

Pour créer une session pour un mixage multicanal :

1 Sélectionnez File > New Session.

2 Sélectionnez l'option Create Blank Session.

3 Sélectionnez le type de fichier audio (Audio File 

Type), la fréquence d'échantillonnage (Sample 

Rate) et la résolution (Bit Depth).

4 Dans le menu I/O Settings, sélectionnez l'une 
des options suivantes : 

• 5.1 Film Mix 

• SMPTE/ITU 

• DTS Monitoring 

• C24 Mix 

• ICON X-MON Mix 

5 Cliquez sur OK.

6 Dans la boîte de dialogue d'enregistrement, 
nommez la session, accédez à l'emplacement 
où vous souhaitez l'enregistrer, puis cliquez 
sur Save.

Le plug-in Surround Mixer doit être installé 
dans le dossier Plug-Ins pour que les options 
multicanal soient visibles dans Pro Tools. 
Ce plug-in peut être installé avec Pro Tools 
(reportez-vous au guide de l'utilisateur fourni 
avec votre système Pro Tools). S'il n'est pas 
installé, vous pouvez le déplacer du dossier 
Plug-Ins (Unused) au dossier Plug-Ins.

Boîte de dialogue New Session, paramètre d'E/S 5.1 
Film Mix sélectionné
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Les presets surround préconfigurent la boîte de 
dialogue I/O Setup pour la nouvelle session avec 
un chemin et des sous-chemins au format 5.1 par 
défaut pour les sorties et les bus.

Fichiers de paramètres de 
mixage surround
Les paramètres d'E/S de mixage surround 
fournissent les chemins de sortie et de bus pour six 
normes de dispositions de pistes spécifiques dans la 
nouvelle session. Pour obtenir des informations sur 
les entrées et les chemins des inserts, reportez-vous 
à la section « Chemins d'entrée et d'insert par défaut 
avec les paramètres de mixage 5.1 » à la page 1154.

Tous les paramètres d'E/S disponibles pour le 
format 5.1 et supérieur (Film, SMPTE/ITU, DTS, 
C24 Mix ou ICON X-MON Mix) proposent ces 
chemins de sortie et de bus par défaut pour la 
nouvelle session :

Chemins de sortie 5.1 par défaut

• Un chemin de sortie 5.1 principal. 

• Un chemin stéréo principal.

Chemins de bus 5.1 par défaut

• Un chemin de bus de sortie 5.1 principal et des 
sous-chemins 5.0 (sans LFE) pour les canaux 
gauche/droit (stéréo), LCR et central (mono) 

• Un chemin de bus de sortie stéréo principal et 
deux sous-chemins mono.

Chemins d'entrée et d'insert par défaut avec les 
paramètres de mixage 5.1

Les fichiers de paramètres de mixage 5.1 proposent 
par défaut des chemins d'entrée principaux et des 
sous-chemins mono pour les entrées et les inserts. 
Le cas échéant, vous pouvez créer des inserts ou 
chemins d'entrée multicanal dans la boîte de 
dialogue I/O Setup (reportez-vous à la section 
« Chemins multicanal personnalisés » à la 
page 1155). 

Chemins de sortie au format 5.1 (film) standard

Fichiers de paramètres et disposition des pistes

Paramètres 5.1 Disposition des pistes

5.1 Film Mix L, C, R, Ls, Rs et LFE

SMPTE/ITU Mix L R C LFE Ls Rs

DTS Mix L R Ls Rs C LFE

C24 Mix L C R Ls Rs Lf

ICON X-MON Mix L Lc C Rc R Ls Rs LFE

I/O Setup, page Output, assignations de sortie 5.1 
(Film) par défaut

Configuration d'E/S, page Bus, assignations de bus 
de sortie 5.1 (Film) par défaut
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Importation de configurations 
d'E/S multicanal
La boîte de dialogue I/O Setup permet d'importer et 
d'exporter des fichiers de paramètres. Ceci s'avère 
utile lorsque vous souhaitez remixer une session 
stéréo en surround. Vous pouvez également utiliser 
cette fonctionnalité pour préparer une session 
à un transfert sur un autre système Pro Tools, 
ou simplement pour sauvegarder et échanger 
les paramètres d'E/S. 

Pour importer un fichier de paramètres d'E/S 
multicanal :

1 Sélectionnez Setup > I/O.

2 Cliquez sur l'onglet Output.

3 Cliquez sur Import Settings.

4 Sélectionnez le fichier de paramètres (.pio) 
à importer et cliquez sur Open.

5 Si des chemins ont déjà été définis pour la 
session en cours et qu'ils ne correspondent pas 
à ceux du fichier de paramètres importé, 
Pro Tools vous demande si vous souhaitez 
supprimer les chemins existants ou les 
conserver et ajouter les paramètres importés 
à votre session. 

• Cliquez sur No pour ajouter les nouveaux 
chemins à votre configuration d'E/S actuelle.

• Cliquez sur Yes pour remplacer la configuration 
d'E/S actuelle par les paramètres importés. 

6 Cliquez sur l'onglet Bus.

7 Si la page Bus n'affiche pas les assignations de 
bus de sortie correspondant au fichier de 
paramètres d'E/S importé, cliquez sur le bouton 
Default (pour All Busses ou Output Busses).

8 Cliquez sur OK pour fermer la boîte de dialogue 
I/O Setup.

Exportation de paramètres d'E/S
L'exportation de fichiers de paramètres d'E/S 
permet de constituer une bibliothèque de 
configurations multicanal pour différents projets. 

Pour exporter un fichier de paramètres d'E/S 
multicanal :

1 Sélectionnez Setup > I/O.

2 Cliquez sur Export Settings.

3 Attribuez un nom au fichier de paramètres d'E/S 
actuel et enregistrez-le.

Chemins multicanal 
personnalisés
La boîte de dialogue I/O Setup permet de créer et 
de personnaliser des chemins de signaux pour tout 
format de mixage multicanal pris en charge. 

Les chemins multicanal et les sous-chemins sont 
assignés aux canaux d'entrée et de sortie dans 
la grille des canaux. Lorsque vous sélectionnez 
un fichier de paramètres d'E/S 5.1 prédéfini, 
la disposition par défaut des chemins multicanal 
créés correspond à celle des pistes du format 
sélectionné. 

De plus, la boîte de dialogue I/O Setup, comme la 
page Main de la boîte de dialogue Hardware Setup, 
contient des commandes pour l'assignation des 
entrées et sorties de votre interface audio vers les 
entrées et sorties disponibles dans Pro Tools.

Lorsque vous créez des chemins au format 5.1, 
vous pouvez spécifier la disposition par défaut 
des pistes. Reportez-vous à la section « Ordre 
des chemins par défaut des pistes 5.1 » à la 
page 1158. 
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Réassignation des canaux
La boîte de dialogue I/O Setup et sa grille de 
canaux permettent également de réassigner les 
canaux. Cette fonctionnalité est particulièrement 
utile pour l'assignation des canaux à l'intérieur d'un 
chemin multicanal sans avoir à modifier les 
connexions au niveau des interfaces audio.

Vous pouvez réassigner les chemins pour les 
configurer selon vos besoins. Les seules limites 
sont les ressources de votre système, ainsi que les 
conditions requises par la boîte de dialogue 
I/O Setup pour le chevauchement des canaux et 
l'attribution de noms (reportez-vous à la section 
« Chemins valides et conditions » à la page 95 
pour plus de détails).

Exemple de configuration LCRS
L'exemple suivant présente une façon de 
configurer la boîte de dialogue I/O Setup pour un 
mixage au format LCRS 4 canaux, avec une 
interface HD OMNI.

Pour définir un chemin LCRS :

1 Sélectionnez Setup > I/O et cliquez sur l'onglet 
Output. 

2 Cliquez sur New Path.

3 Sélectionnez LCRS à l'aide du sélecteur Path 
Format.

4 Nommez le chemin LCRS.

5 Dans la grille des canaux, cochez la case située 
en dessous du premier canal d'interface audio 
(à l'extrémité gauche) du chemin. Pro Tools 
remplit automatiquement les cases adjacentes 
sur la droite. Si vous cliquez sur la ligne LCRS 
sous le canal 1, le chemin LCRS sera assigné 
aux canaux 1 à 4. 

6 Cliquez sur l'onglet Bus.

7 Si la page Bus n'affiche pas les assignations de 
bus de sortie correspondant à la sortie LCRS, 
cliquez sur le bouton Default (pour All Busses 
ou Output Busses).

8 Sélectionnez le nouveau chemin LCRS et 
cliquez sur le triangle Reveal Sub-paths.

9 Si les sous-chemins ne sont pas tous présents, 
effectuez l'une des opérations suivantes :

• Cliquez sur New Sub-Path.

• Nommez le nouveau sous-chemin LCR et 
sélectionnez LCR comme format de chemin. 
Cliquez sur le canal 1 de la ligne LCR pour 
assigner le chemin du bus.

• Sélectionnez le chemin LCRS, cliquez sur New 

Sub-Path et créez un sous-chemin stéréo pour 
les canaux avant gauche et avant droit.

• Sélectionnez le chemin LCRS, cliquez sur New 

Sub-Path et créez un sous-chemin mono pour le 
canal central.

Reportez-vous également à la section 
« Exemple de chemins et de routing des 
signaux pour un mixage surround » à la 
page 1170. 

Pour en savoir plus sur la boîte de dialogue 
I/O Setup, reportez-vous à la section « Bus de 
sortie » à la page 96. 

Page Output, chemin de sortie LCRS
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• Sélectionnez le chemin LCRS, cliquez sur New 

Sub-Path et créez un sous-chemin mono pour le 
canal surround.

10 Cliquez sur OK pour fermer la boîte de dialogue 
I/O Setup.

Pistes 5.1, formats, assignations 
et mesure des niveaux
Les définitions de chemin de la boîte de dialogue 
I/O Setup déterminent de quelle façon les données 
audio sont routées via vos interfaces audio, 
et comment leur niveau est affiché sur celles-ci.

Dans Pro Tools, l'indication des niveaux interne 
(à l'écran) des chemins au format 5.1 suit toujours 
la disposition des pistes Film :

L, C, R, Ls, Rs et LFE

La disposition des pistes audio au format 5.1 dans 
la fenêtre Edit de Pro Tools adopte également la 
disposition Film (de haut en bas). Reportez-vous 
à la section « Disposition des pistes 5.1, routing et 
indication des niveaux » à la page 1159.

Dans la boîte de dialogue I/O Setup, vous pouvez 
récupérer ces signaux en sortie des interfaces 
audio, en adoptant n'importe quelle disposition de 
pistes (DTS, SMPTE/ITU ou autre). 

Pour réassigner les canaux d'un chemin :

 Faites glisser un canal vers un nouvel 
emplacement valide dans la grille. Les autres 
assignations de canaux se décalent en 
conséquence.

Sélecteurs par défaut de la 
boîte de dialogue I/O Setup
La page Output de la boîte de dialogue I/O Setup 
contient des sélecteurs permettant de définir les 
paramètres par défaut d'E/S pour les sessions 
multicanal.

Default Monitor Format : définit le format 
d'écoute par défaut (stéréo, 5.1 ou 7.1) pour les 
nouveaux chemins de sortie et lorsque vous 
cliquez sur le bouton Default.

5.1 Path Order : sélectionne la disposition 
(ou l'ordre des chemins) par défaut pour les 
nouveaux chemins de sortie (six canaux) 
au format 5.1.

Output Meter Path : sélectionne le chemin dont 
le niveau sera affiché sur les indicateurs de niveau 
de sortie de la surface de contrôle, ainsi que ceux de 
la fenêtre de transport. Pour plus d'informations, 
reportez-vous à la section « Pistes 5.1, formats, 
assignations et mesure des niveaux » à la page 1157.

Page Bus, bus de sortie LCRS avec sous-chemins

Sélecteurs par défaut de la boîte de dialogue I/O 
Setup

Ordre des chemins 5.1 par défaut Options d'I/O Setup
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Audition Paths : sélectionne le chemin de 
monitoring pour la pré-écoute audio dans les boîtes 
de dialogue Clip List, Import Audio et dans un 
navigateur de l'espace de travail. Seules les sorties 
de l'interface principale peuvent être utilisées 
comme chemin d'écoute.

Default Output Bus : sélectionne le chemin du bus 
de sortie par défaut pour toutes les nouvelles 
pistes, pour chaque format pris en charge. 

AFL/PFL Path (systèmes Pro Tools|HDX ou 
Pro Tools|HD Native uniquement) : sélectionne la 
destination vers laquelle les pistes sont routées 
lorsqu'elles sont écoutées en mode Solo AFL 
(écoute post-fader) ou PFL (écoute pré-fader).

AFL/PFL Mutes (chemin de sortie) (systèmes 
Pro Tools|HDX ou Pro Tools|HD Native 
uniquement) : sélectionne la sortie mutée en cas 
d'activation du mode Solo AFL (écoute post-fader) 
ou PFL (écoute pré-fader) et de la mise en solo 
d'une piste.

Ordre des chemins par défaut 
des pistes 5.1
Il est possible de spécifier la disposition par défaut 
des pistes pour tous les nouveaux chemins de 
format 5.1 que vous créez. 

Pour choisir un nouvel ordre pour les chemins 5.1 
(disposition des pistes) :

1 Sélectionnez Setup > I/O. 

2 Cliquez sur l'onglet Output.

3 Utilisez le paramètre 5.1 Default Path Order 

pour sélectionner la disposition de pistes 
souhaitée (Film, SMPTE/ITU ou DTS 

Monitoring). 

Le paramètre New Track Default Output peut 
être défini aussi bien pour des chemins de bus 
que pour des chemins de sortie.
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Disposition des pistes 5.1, routing et indication des niveaux

Disposition des pistes dans les différents formats 5.1

L, C, R, Ls, Rs et LFE

Format 5.1 Pistes Indicateurs de niveau Assignations des canaux dans I/O Setup

L R C LFE Ls Rs

L R Ls Rs C LFE

L x C x R Ls Rs LFE

L, C, R, Ls, Rs et LFE

idem
L C R Ls Rs LFE 

(de gauche à droite)

idem

L C R Ls Rs LFE 
(de haut en bas)

idem idem

idem idem

L, C, R, Ls, 
Rs et LFE

L, C, R, Ls, Rs et LFE

L, C, R, Ls, Rs et LFE L, C, R, Ls, Rs et LFE
(de haut en 

bas)
 (de gauche 

à droite)

Film (standard 
Pro Tools, et mix C|24) 
L C R Ls Rs LFE

SMPTE/ITU 
(mix Control|24) 
L R C LFE Ls Rs

DTS
L R Ls Rs C LFE

ICON X-MON 
(8 canaux 7.1) 
L x C x R Ls Rs LFE
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Chapitre 48 : Pistes multicanal et routing 
des signaux

Les sessions surround incluent généralement une 
combinaison d'inserts, de bus et de pistes d'entrée 
auxiliaire, Master Fader, d'instrument et audio 
mono, stéréo et multicanal.

Une fois la configuration d'E/S adéquate importée 
ou définie, il est possible de mixer les pistes audio, 
d'entrée auxiliaire, Master Fader et d'instrument au 
format surround multicanal grâce aux fonctions de 
mixage de Pro Tools. 

Le routing des E/S et des signaux multicanal est 
déterminé par les chemins définis dans la boîte de 
dialogue I/O Setup.

Pistes audio multicanal
(Pro Tools HD uniquement)

Les pistes audio multicanal incluent un canal 
pour chaque signal de la piste. Ainsi, une piste 
au format 5.1 dispose de six canaux (gauche, centre, 
droit, gauche surround, droit surround et LFE).

Les pistes audio multicanal peuvent être :

• enregistrées directement dans Pro Tools, à l'aide 
de plusieurs microphones ou ensembles de 
microphones, ou assignées aux chemins d'entrée 
multicanal appropriés de Pro Tools ;

• importées à partir d'autres sessions Pro Tools ;

• éditées, traitées et mixées en combinaison avec 
des pistes mono et stéréo.

Les fichiers audio et les pistes au format 5.1 
adoptent la disposition de pistes Film standard. 
Quelle que soit l'assignation des chemins dans la 
boîte de dialogue I/O Setup, toutes les pistes audio 
et tous les indicateurs de niveau au format 5.1 se 
conforment à la disposition de pistes Film standard :

L, C, R, Ls, Rs, LFE 

Le mixage surround multicanal est pris en 
charge sur Pro Tools HD uniquement.

Piste audio multicanal au format 5.1
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Les pistes audio multicanal ne doivent pas 
nécessairement être mixées dans un format 
multicanal. Les pistes mono, stéréo et de tout autre 
format pris en charge peuvent être mixées en 
utilisant les départs et sorties de piste de Pro Tools 
(reportez-vous à la section « Routing de signaux 
multicanal » à la page 1164).

Placement des données audio 
sur les pistes multicanal
Pour placer des fichiers audio et des clips sur des 
pistes audio multicanal, il suffit de les faire glisser 
depuis des navigateurs de l'espace de travail, 
la liste des clips, l'Explorateur Windows, le Finder 
Mac ou d'autres pistes.

Pour ce faire, le nombre de canaux déplacés doit 
correspondre au format de la piste de destination. 
Vous ne pouvez faire glisser qu'une paire stéréo 
ou deux clips mono vers une piste audio stéréo, 
par exemple. De même, vous ne pouvez placer de 
données audio sur une piste LCR que lorsque vous 
avez sélectionné trois clips. Dans le cas de pistes 
au format 5.1, vous devez sélectionner six fichiers 
ou clips mono. 

Solo, mute et gain des pistes et 
chemins multicanal
Les pistes stéréo et multicanal sont composées de 
plusieurs signaux audio liés. Par défaut, ces pistes 
multicanal sont liées et sont donc contrôlées par un 
seul fader de canal et deux boutons Solo et Mute. 

Si vous souhaitez contrôler séparément les signaux 
d'une piste multicanal, convertissez-la en pistes 
mono individuelles. Pour un ajustement séparé des 
niveaux et des phases, vous pouvez insérer un 
plug-in Trim multi-mono et dissocier ses canaux. 
Ces deux techniques sont détaillées ci-après.

Pour convertir une piste multicanal en pistes 
mono séparées :

1 Sélectionnez la piste multicanal.

2 Sélectionnez Track > Split Into Mono. 

Pour contrôler séparément le gain de chaque 
canal d'une piste multicanal : 

1 Insérez un plug-in Trim multi-mono sur la piste 
multicanal.

2 Dissociez les canaux du plug-in Trim en 
cliquant sur l'icône de liaison pour la désactiver. 

3 Utilisez le sélecteur de canal pour afficher les 
commandes d'un canal et ajuster le gain. 

Lorsque vous les faites glisser vers une piste 
multicanal, les fichiers audio sont classés de 
haut en bas dans l'ordre exact où ils 
apparaissent dans la liste des clips ou la 
playlist dont ils sont issus (l'option Top to 
Bottom doit être sélectionnée dans le menu 
Clip List > Timeline Drop Order). Aussi, 
vous devez veiller à ce qu'ils soient agencés 
dans l'ordre voulu dans la liste des clips 
avant de les faire glisser. Renommez ces 
fichiers pour pouvoir les placer dans l'ordre 
voulu en les triant par nom dans la liste des 
clips. Pour une piste au format 5.1 par 
exemple, renommez les pistes audio pour 
qu'elles soient affichées dans l'ordre des 
canaux L, C, R, Ls, Rs et LFE.

Une fois converties en mono, le format 
d'origine des pistes multicanal ne peut plus 
être rétabli. Vous pouvez cependant 
« réassembler » une piste multicanal en 
faisant glisser le nombre de fichiers mono 
possédant le suffixe approprié sur une piste 
multicanal. Des données d'automation 
risquent toutefois d'être perdues au cours 
de cette opération. Vous pouvez également 
enregistrer sur disque la sortie d'un sous-
groupe de mixage des pistes mono sur une 
piste multicanal.
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Formats de piste et de sortie
Lorsque vous créez des pistes, spécifiez le format 
mono, stéréo ou tout autre format multicanal pris 
en charge. 

Dans les fenêtres Mix et Edit, le format d'une piste 
est toujours visible d'après le nombre d'indicateurs 
de niveau affiché sur chaque tranche (un seul pour 
les pistes mono, une paire pour les pistes stéréo, 
et six pour les pistes 5.1).

L'assignation de la sortie d'une piste détermine 
le format de cette sortie. Une piste mono, 
par exemple, comporte toujours un seul indicateur 
de niveau de piste, même lorsqu'elle est assignée 
à un chemin de sortie stéréo. Si cette même piste 
mono est assignée à un chemin de sortie au format 
5.1, sa sortie sera répartie sur ces six canaux de 
sortie, en fonction de la position du panoramique. 

Changement de format

Changer de format de sortie pour une piste donnée 
a plusieurs effets :

• Le panoramique qui apparaît sur la piste est mis 
à jour pour refléter le nouveau format de sortie.

• Il peut être nécessaire de créer ou de supprimer 
une ou plusieurs playlists d'automation 
associées.

En raison des effets d'un changement de format de 
sortie, une boîte de dialogue d'avertissement 
apparaît à chaque fois que vous passez à un format 
de sortie de piste comportant un nombre de canaux 
inférieur. Plus précisément, cela se produit chaque 
fois que des playlists d'automation doivent être 
supprimées.

Assignations de sortie multiples et format 
des pistes

Lorsqu'une piste est assignée à plusieurs chemins, 
avec des formats différents, sa sortie principale 
correspond au format du chemin assigné qui 
comporte le plus grand nombre de canaux.

Sorties multiples et playlists d'automation

Lorsqu'une piste comporte plusieurs assignations 
de sortie, Pro Tools réparties les données de 
panoramique de manière appropriée pour chaque 
chemin assigné. Si vous assignez une piste mono 
simultanément à un chemin stéréo et à un chemin 
au format 5.1, par exemple, cette piste disposera 
d'un panoramique 5.1 dans la fenêtre Mix ou Edit. 
Lorsque vous effectuez un panoramique sur la 
piste, Pro Tools interprète les déplacements de 
panoramique 5.1 comme des déplacements de 
panoramique stéréo. 

Cela permet de disposer d'une forme de mixage 
parallèle. Vous pouvez ainsi créer simultanément 
plusieurs mixages de formats différents en 
envoyant vos éléments vers plusieurs chemins. 

Pour plus d'informations, reportez-vous 
à la section « Liaison et dissociation des 
commandes des plug-ins multi-mono » 
à la page 1166. 

Maintenez les touches Ctrl+Démarrer 
(Windows) ou Commande+Ctrl (Mac) 
enfoncées et cliquez sur une commande 
d'une fenêtre Output pour afficher sa playlist 
d'automation dans la fenêtre Edit et 
visualiser les automations de panoramique. 
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Routing de signaux multicanal
Pour effectuer un mixage dans un format multicanal, 
les pistes sont assignées à des chemins multicanal. 

Pour mixer les pistes en surround, les deux 
méthodes suivantes sont applicables :

• assignation d'une sortie principale de piste à un 
chemin multicanal ; 

• assignation d'un départ multicanal pour router 
l'audio vers un chemin multicanal. 

Sorties de pistes multicanal
Les pistes peuvent être routées vers des chemins de 
bus ou de sortie multicanal via leur sélecteur de 
chemin de sortie. Vous disposez ainsi d'un 
panoramique et d'un indicateur de niveau 
multicanal dans la vue I/O des fenêtres Mix et Edit. 

Pour ajouter d'autres assignations de sortie, 
maintenez la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée tout en cliquant sur le sélecteur 
pour assigner un autre chemin. 

Deux configurations différentes de pistes pour le 
mixage multicanal

Chemin de sortie 
multicanal

Départ multicanal
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Départs multicanal
Tous les formats de piste, dont mono et stéréo, 
permettent d'assigner un ou plusieurs départs 
multicanal. Vous disposez ainsi d'un panoramique 
multicanal dans la vue Sends. Les départs sont 
également utiles pour router des pistes vers un 
plug-in multicanal. 

La figure ci-dessous représente une piste audio 
mono avec un départ 5.1 (6 canaux) (View > Sends 
A–E > Send A).

Les outils de routing et de gestion de sous-groupes 
de mixage de Pro Tools sont disponibles pour tous 
les formats de canal, de mono/stéréo jusqu'au 
format 8 canaux. Pour obtenir des exemples de 
monitoring multicanal, de traitement d'effets et de 
routing, reportez-vous à la section « Mixage avec 
chemins et sous-chemins » à la page 1167. 
Pour des exemples de mixages mono et stéréo, 
reportez-vous au Chapitre 43, « Principes de base 
du mixage ». 

Entrées auxiliaires multicanal 
et Master Faders
Une entrée auxiliaire ou un Master Fader 
multicanal est utilisé en tant que retour pour le bus 
multicanal. Les départs sont utiles lorsque vous 
devez créer simultanément un mixage indépendant 
supplémentaire (dans un format différent, 
par exemple) qui nécessite des réglages de fader, 
de mute, de solo et d'automation dédiés.

Vous pouvez assigner des Master Faders aux 
chemins principaux et aux sous-chemins. 
Les chemins principaux doivent correspondre au 
format du Master Fader, et un seul Master Fader 
peut être actif et assigné à un chemin principal ou 
sous-chemin (actif) à la fois. Il n'est pas possible 
d'assigner un Master Fader à un sous-chemin si son 
chemin principal associé est déjà assigné à un autre 
Master Fader. Reportez-vous à la section « Pistes 
Master Fader et flux de signal » à la page 984. 

Pistes d'instrument multicanal
Vous pouvez utiliser les pistes multicanal pour le 
monitoring et le routing de plug-ins d'instrument 
multicanal ou d'instruments MIDI multicanal 
externes.Piste mono avec format de sortie mono et un départ 

multicanal

Panoramique de départ multicanal

Indicateur de niveau mono

Format de sortie mono
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Plug-ins mono, multi-mono et 
multicanal
Vous pouvez utiliser les plug-ins aux formats 
mono, multi-mono ou multicanal.

Pour en savoir plus sur les plug-ins mono, stéréo et 
mono vers stéréo, reportez-vous au Chapitre 44, 
« Inserts de plug-in et matériels ».

Plug-ins multi-mono : destinés aux pistes 
multicanal au format stéréo ou supérieur. Les plug-
ins multi-mono sont utiles, voire indispensables, 
dans les situations suivantes :

• lorsqu'un plug-in ne nécessite pas de traitement 
corrélé multicanal (égalisation des canaux d'un 
signal multicanal, par exemple) ;

• lorsque vous devez ajuster séparément chaque 
signal d'une piste multicanal ;

• lorsqu'un plug-in ne prend pas en charge les 
formats multicanal.

Lors de la première insertion d'un plug-in multi-
mono sur une piste multicanal, ses commandes 
sont liées. Vous pouvez les dissocier pour les 
ajuster individuellement. Pour plus d'informations, 
reportez-vous à la section « Liaison et dissociation 
des commandes des plug-ins multi-mono » 
à la page 1166.

Les plug-ins multi-mono peuvent également être 
insérés sur des pistes stéréo, afin d'exploiter des 
commandes dissociées sur les canaux droit et 
gauche.

Plug-ins multicanal : destinés à être utilisés sur 
des pistes stéréo et multicanal nécessitant un 
traitement corrélé, tel qu'une limitation, 
une compression et d'autres effets similaires 
stéréo et multicanal.

Liaison et dissociation des 
commandes des plug-ins 
multi-mono
Lorsqu'un plug-in multi-mono est utilisé sur une 
piste multicanal comportant plus de deux canaux, 
ses commandes sont généralement liées. 
L'ajustement de la commande de gain d'un canal, 
par exemple, affecte tous les autres canaux.

Si nécessaire, vous pouvez dissocier les commandes 
de plug-in pour des canaux spécifiques d'une piste et 
les modifier indépendamment. Vous pouvez 
également lier les commandes de certains canaux 
seulement.

Par exemple, pour appliquer des fréquences de 
coupure de filtre identiques sur les canaux Ls et 
Rs (surround) d'un mixage 5.1, vous pouvez lier 
uniquement ces deux canaux dans un plug-in 
d'égalisation multi-mono dont les autres commandes 
sont dissociées. L'ajustement des commandes de l'un 
de ces canaux (Ls ou Rs) dans la fenêtre du plug-in 
agit également sur l'autre canal lié.

Sélecteur de canal : permet d'accéder à un canal 
spécifique d'une piste multicanal afin de modifier 
les paramètres du plug-in. Ce menu apparaît 
uniquement sur les plug-ins multi-mono insérés 
sur des pistes comportant plus de deux canaux. 

Bouton de liaison principale : lie les commandes 
sur tous les canaux d'un plug-in multi-mono pour 
vous permettre de les ajuster par paire.

Sélecteur de canal et commandes de liaison

Sélecteur de canal

Boutons de liaison des canaux

Bouton de liaison principale
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Boutons de liaison des canaux : permettent de 
lier ou dissocier sélectivement les commandes de 
canaux spécifiques d'un plug-in multi-mono. 
Chaque carré représente un canal de haut-parleur. 
Désactivez le bouton de liaison principale avant 
d'utiliser les boutons de liaison des canaux.

Pour dissocier les commandes d'un plug-in 
multi-mono :

 Désactivez le bouton de liaison principal. Il est 
allumé lorsque la liaison est activée, éteint dans 
le cas contraire.

Pour accéder aux commandes d'un canal 
particulier :

 Sélectionnez le canal depuis le sélecteur de canal.

Pour ouvrir une fenêtre de plug-in pour tous les 
canaux d'un plug-in multi-mono :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le sélecteur 
de canal.

Pour lier les commandes de canaux spécifiques :

1 Désactivez le bouton de liaison principal, 
si ce n'est déjà fait.

2 Cliquez sur les boutons de liaison des canaux 
dont vous souhaitez lier les commandes.

Chemins pour les mixages 
surround
L'environnement de routing et de gestion des 
sous-groupes de mixage de Pro Tools étant 
particulièrement flexible, vous pouvez optimiser 
les ressources disponibles de votre système 
en commençant par identifier les éléments 
sur lesquels vous souhaitez appliquer un 
panoramique dynamique et ceux qui peuvent 
être placés uniquement sur certains canaux 
(reportez-vous à la section « Mixage avec 
chemins et sous-chemins » à la page 1167).

Une fois ces éléments identifiés dans votre 
session, vous pouvez utiliser une combinaison 
d'assignations de chemins principaux et de sous-
chemins, ainsi que de panoramiques multicanal.

Mixage avec chemins et 
sous-chemins
Il est rare que toutes les pistes utilisent un 
champ panoramique étendu et se déplacent sur 
plus d'une paire de haut-parleurs. Dans la plupart 
des cas, certains éléments sont envoyés sur 
certains haut-parleurs et y restent, constituant 
ainsi la base du mixage.

La figure suivante présente un exemple de 
combinaison de panoramiques et de routing des 
signaux pour un mixage multicanal. 

Pour en savoir plus, reportez-vous à la 
section « Extension des conventions de 
mixage stéréo au mixage surround » 
à la page 1172. 
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Quand faut-il utiliser des assignations de sortie 
multicanal ?

 Assignez des chemins 5.1 uniquement aux 
pistes sur lesquelles le panoramique doit utiliser 
les six canaux. 

Par exemple, une piste d'effets sonores du bruit 
d'un avion à réaction doit être assignée à un 
chemin 5.1 pour que le son se déplace de l'avant 
vers l'arrière. Dans un mixage musical, vous 
pouvez appliquer cet effet à un instrument en solo 
ou faire tourner une nappe de synthé, comme 
effet spécial. 

Les éléments devant être entendus simultanément 
sur tous les haut-parleurs peuvent également être 
assignés à la sortie multicanal, qu'ils nécessitent ou 
non un panoramique actif dans le champ sonore. 

Quand faut-il utiliser des sous-chemins ? 

 Pour simplifier les sessions de grande taille, 
utilisez les sous-chemins pour router des 
éléments statiques (ou stationnaires) directement 
vers un ou plusieurs canaux de sortie.

Par exemple, les dialogues d'un film sont souvent 
mixés sur le canal central afin de « fixer à l'image » 
cet élément sonore essentiel. Au lieu d'assigner un 
panoramique six canaux aux pistes de dialogue 
pour les envoyer uniquement sur le haut-parleur 
central, vous pouvez assigner directement la sortie 
principale de la piste de dialogue à un sous-chemin 
mono (centre).
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Utilisation du routing des signaux et des sous-chemins pour un mixage surround

Routing 
des bus 
d'effet

Sorties 
vers des 
sous-
chemins

Sorties vers le chemin 5.1 principal pour panoramique surround

Pistes routées vers des sous-chemins Pistes routées vers le 
chemin surround 5.1 
principal

Entrée auxiliaire 
routée vers un 
sous-chemin 5.0
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Extension des conventions de 
mixage stéréo au mixage 
surround
Le mixage stéréo a inauguré les panoramiques 
actifs et statiques, et le mixage surround peut 
bénéficier des mêmes principes de base. 

Déplacer un son entre les haut-parleurs gauche et 
droit est considéré comme un effet spécial. Dans 
un mixage musical type, les pistes essentielles sont 
fixées dans le champ sonore stéréo et ne se 
déplacent pas. 

Les mixages surround peuvent devenir incohérents 
si trop d'éléments se déplacent en permanence. 
Pour créer des effets spéciaux, vous pouvez régler 
le panoramique de certaines pistes de façon 
dynamique afin de le faire alterner ou passer 
progressivement d'un haut-parleur à l'autre.

Exemple de chemins et de 
routing des signaux pour un 
mixage surround
Le routing des signaux est un élément clé dans toutes 
les sessions Pro Tools surround. Il se configure et se 
définit dans la boîte de dialogue I/O Setup.

Les exemples suivants indiquent comment les 
entrées auxiliaires, les Master Faders et les autres 
outils de routing des signaux de Pro Tools peuvent 
être utilisés pour gérer des stems, des sous-groupes 
et d'autres configurations similaires pour vos 
projets.

Dans ces exemples, la musique et les effets sont 
mixés dans le cadre d'une bande-annonce au 
format surround 5.1. Les stems séparés (musique 
et effets) doivent être enregistrés sur un 
magnétophone numérique 8 pistes.

Exemple de chemins de sortie
L'illustration suivante présente les chemins de 
sortie définis dans la boîte de dialogue I/O Setup 
d'un exemple de session créée sur un système 
Pro Tools|HDX avec une interface audio 
HD OMNI.

Différents chemins de sortie ont été définis pour 
les stems Mix, FX, dialog et Music.

Exemple de chemins de bus
L'illustration suivante présente un exemple de 
chemins de bus.

Un chemin au format LCR (Dialog), un chemin au 
format stéréo (Music) et un chemin au format 5.1 
(FX) ont été définis, chacun avec leurs propres 
sous-chemins.

Exemple de chemins de sortie dans I/O Setup

Exemple de chemins de bus dans I/O Setup
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Exemple de sous-chemins
Les sous-chemins permettent de router des signaux 
vers les canaux de votre choix d'une sortie 
surround multicanal. Sur l'illustration suivant, 
le bus Surround possède plusieurs sous-chemins 
configurés de cette manière. 

Sous-chemin LCR : le sous-chemin des 3 canaux 
avant. Utilisez ce type de sous-chemin pour mixer 
des dialogues ou d'autres effets sonores sur l'axe 
avant. 

Sous-chemin stéréo : le sous-chemin stéréo 
avant. Utilisez ce type de sous-chemin pour 
mixer des stems de musique et des effets sur les 
haut-parleurs gauche et droit de l'axe avant. 

Sous-chemin central : le sous-chemin du canal 
central avant fournit un chemin mono séparé pour 
le canal central.

Sous-chemin Ls/Rs : le sous-chemin stéréo gauche 
et droite arrière. Utilisez ce type de sous-chemin 
pour mixer des effets surround.

Chemin LFE : le sous-chemin LFE fournit un 
chemin mono séparé pour le canal LFE. 

Sous-chemin 5.0 : le chemin 5.0 est un sous-chemin 
à 5 canaux. Utilisez ce type de sous-chemin pour 
pour conserver des ressources de mixage pour les 
pistes qui ne seront pas envoyées sur le canal LFE.

Exemple de sous-chemins dans I/O Setup
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Exemples de routing des signaux
Les exemples suivants présentent plusieurs 
possibilités d'utilisation du chemin principal et des 
sous-chemins dans une session composée d'un 
mixage principal au format 5.1 et de stems pour la 
musique et les effets. 

Exemples de mixage par stems

La figure suivante présente une configuration du 
routing pour un mixage de stems d'effets. Deux 
pistes sont routées vers des sous-chemins de bus 
stéréo, les autres sont assignées à un sous-chemin 
LCR et à un sous-chemin de bus mono. Deux 
pistes (une mono, une stéréo) sont assignées à des 
bus multicanal pour gérer le panoramique 
surround. Une entrée auxiliaire 5.1, assignée au 
chemin de bus FX principal, sert de mixeur 
auxiliaire.

Extension des conventions de mixage stéréo 
au mixage surround

Le mixage stéréo a inauguré les panoramiques 
actifs et statiques, et le mixage surround peut 
bénéficier des mêmes principes de base. 

Déplacer un son entre les haut-parleurs gauche et 
droit est considéré comme un effet spécial. Dans 
un mixage musical type, les pistes essentielles sont 
fixées dans le champ sonore stéréo et ne se 
déplacent pas. 

Les mixages surround peuvent devenir incohérents 
si trop d'éléments se déplacent en permanence. 
Pour créer des effets spéciaux, vous pouvez régler 
le panoramique de certaines pistes de façon 
dynamique afin de le faire alterner ou passer 
progressivement d'un haut-parleur à l'autre.

Stem d'effets
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L'illustration suivante présente une configuration du routing pour un morceau de musique.

Dans cet exemple, la plupart des pistes musicales 
sont routées vers les canaux avant gauche et droit 
via un sous-chemin stéréo. Une entrée 
auxiliaire 5.1 contrôle la sortie du bus et du stem. 

Assignations de sortie multiples

Les assignations de sortie multiples permettent 
de configurer un certain nombre de mixages 
multiformat. Par exemple, vous pouvez assigner 
une sortie stéréo supplémentaire aux pistes et 
créer un mixage stéréo en même temps qu'un 
mixage au format 5.1. Pour plus d'informations, 
reportez-vous à la section « Assignations de sorties 
multiples » à la page 997.

Exemples avec LFE
Les pistes LFE et d'autres contenus audio peuvent 
être envoyés sur la sortie LFE de deux manières :

• À l'aide du fader LFE dans les fenêtres Output. 
Ce signal LFE est post-fader. 

• À l'aide d'un sous-chemin personnalisé pour 
router les canaux séparément.

Stems d'un morceau de musique
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L'illustration suivante présente la fenêtre Output 
d'un canal, utilisée pour le départ vers le canal LFE 
et l'indication de son niveau. 

À l'aide du fader LFE, vous pouvez ajouter la 
quantité de signal de votre choix d'un chemin 
multicanal à la sortie LFE générale. Dans 
l'exemple ci-dessus, le pourcentage alloué au 
centre de la piste est désactivé, et le fader LFE est 
monté pour router le signal vers le canal LFE. 

L'illustration suivante indique comment router une 
piste LFE « traditionnelle » uniquement vers le 
canal LFE. Cet exemple utilise un sous-chemin 
LFE personnalisé pour le routing vers le chemin du 
bus FX principal. 

LFE et filtrage
Pro Tools n'applique aucun filtrage aux signaux 
LFE. Dans certaines cas, le format de livraison 
requiert un filtrage sur la piste LFE.

Fader LFE

Routing LFE séparé, avec sortie principale vers le 
canal LFE mono

Les faders LFE peuvent « suivre » les groupes de 
mixage et d'édition. Pour plus d’informations, 
reportez-vous à la section « Sélection des 
attributs de groupe » à la page 263.

Pour obtenir des instructions sur la création 
d'un sous-chemin, reportez-vous à la section 
« Chemins multicanal personnalisés » 
à la page 1155. 
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Chapitre 49 : Mixage et panoramique 
surround

Avant de pouvoir ajuster le panoramique d'une 
piste en surround, vous devez l'assigner à un 
chemin de sortie ou de bus multicanal approprié. 

La boîte de dialogue I/O Setup définit l'architecture 
du routing des bus et sorties du mixeur surround 
multicanal de Pro Tools. Si besoin est, nous vous 
conseillons de vous familiariser avec les chemins 
principaux, les sous-chemins et la boîte de dialogue 
I/O Setup avant de commencer des projets 
multicanal dans Pro Tools. 

Introduction au panoramique 
surround dans Pro Tools
(Pro Tools HD uniquement)

Quatre méthodes différentes de panoramique sont 
disponibles : 

• Dans la fenêtre Edit, à l'aide de la grille de 
panner de taille réduite dans la vue I/O.

• Dans la fenêtre Mix, à l'aide de la grille de 
panner de taille réduite.

• Dans la fenêtre Output, à l'aide de la grille de 
panner.

• Par édition de l'automation de panoramique.

Certaines surfaces de contrôle Pro Tools offrent 
des options supplémentaires de gestion du 
panoramique. Reportez-vous à la documentation 
de votre surface de contrôle.

Pour plus d’informations sur les configurations 
multicanal et les options de la boîte de dialogue 
I/O Setup, reportez-vous au Chapitre 47, 
« Configuration de Pro Tools pour le 
surround ». Pour le routing des signaux 
multicanal, reportez-vous au Chapitre 48, 
« Pistes multicanal et routing des signaux ».

Le mixage surround multicanal est pris en 
charge sur Pro Tools HD.



Guide de référence Pro Tools1176

Grilles du panner des fenêtres 
Mix et Edit
Dans les fenêtres Mix et Edit, des grilles de panner 
multicanal apparaissent sur les pistes comportant 
des assignations de sortie multicanal pour les 
pistes ou les départs. 

Pour effectuer un panoramique depuis la fenêtre 
Mix ou Edit :

1 Pour effectuer un panoramique dans la fenêtre 
Edit, assurez-vous que la vue I/O est activée 
(View > Edit Window > I/O). Les grilles du 
panner sont systématiquement affichées dans 
les pistes de la fenêtre Mix prenant en charge le 
panoramique.

2 Lancez la lecture. 

3 Cliquez sur la grille du panner de la piste 
multicanal appropriée dans la fenêtre Mix ou 
Edit et faites glisser le curseur. 

Le curseur de position du panoramique suit vos 
mouvements tant que vous maintenez le bouton de 
la souris enfoncé. La gestion des mouvements est 
telle qu'une fois que vous avez cliqué pour 
« saisir » le curseur de position du panoramique, 
les mouvements ne sont pas limités à la zone 
réduite allouée à la grille de la piste. 

Couleur du curseur de position du 
panoramique lors de l'automation

Le curseur de position du panoramique est vert en 
mode d'automation Read, rouge en mode Write, 
Touch, Latch ou Touch/Latch et jaune en mode 
Off (ou automation suspendue). 

En mode Trim, le fader de volume et le fader LFE 
sont en jaune.

Les fenêtres de sortie offrent d'autres fonctions et 
commandes (ainsi qu'une grille beaucoup plus 
grande). Pour plus d'informations, reportez-vous 
à la section « Fenêtres de sortie » à la page 1176. 

Fenêtres de sortie
Les fenêtres de sortie offrent des commandes de 
panoramique (appelées panners) et des 
commandes Pro Tools standard pour les pistes 
de tous les formats de mixage (du format LCR 
à 3 canaux jusqu'au format 7.1 à 8 canaux). 

Pour plus d'informations sur les commandes 
standard des fenêtres de sortie, reportez-vous à la 
section « Commandes standard » à la page 1177. 
Pour plus d'informations sur les commandes de 
panoramique des fenêtres de sortie, reportez-vous 
à la section « Commandes du panner surround » 
à la page 1178.

Faites glisser le curseur dans la grille de la piste pour 
ajuster le panoramique
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Les fenêtres de sortie fournissent notamment les 
fonctionnalités suivantes :

• Panoramique X/Y (type joystick)

• Panoramique 3-Knob (trois boutons)

• Contrôle de la divergence intégrale et du 
pourcentage de centrage

• AutoGlide

• Alimentation du canal LFE

• Indicateurs de niveau multicanal

• Prise en charge de la fenêtre cible de Pro Tools

Il est possible d'ouvrir simultanément plusieurs 
panners ou d'afficher le panner en cours dans une 
seule fenêtre.

Pour ouvrir une fenêtre de sortie:

 Cliquez sur le bouton de la fenêtre de sortie 
(petit fader situé sur le côté droit du sélecteur de 
sortie d'une piste dans la fenêtre Mix ou Edit sur 
la vue I/O).

Commandes standard
Toutes les fenêtres de sortie offrent des 
commandes Pro Tools standard pour le routing, 
l'assignation des chemins et d'autres fonctions 
applicables aux pistes. Ces commandes se 
trouvent dans la partie supérieure de toutes les 
fenêtres de sortie, de départ, d'insert et de plug-in 
(reportez-vous à la section « Commandes de 
sélecteur standard dans les fenêtres Output » 
à la page 1011).

Fader de piste, Solo, Mute et 
Auto
Toutes les fenêtres de sortie sont dotées de 
commandes de volume et de mute. Vous pouvez 
ainsi ajuster et automatiser le volume des pistes ou 
les muter directement à partir de ces commandes. 
Le fader le plus grand et le bouton Mute sont 
équivalents à ceux de la fenêtre Mix de Pro Tools. 

Ouverture d'une fenêtre de sortie multicanal

Pour obtenir des instructions sur la gestion 
de multiples fenêtres de sortie, reportez-vous 
à la section « Fenêtres Output pour les pistes 
et les départs » à la page 1008.

Section de commandes du panner

Sélecteur de piste

Sélecteur 
de sortie

Sélecteur de chemin
Icône de ciblageAffichage des indicateurs de niveau

Protection de 
l'automation
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Commandes du panner surround
Lorsque la sortie est assignée à des pistes ou à des chemins d'au moins quatre canaux, sa fenêtre offre une 
grille X/Y pour la gestion du panoramique surround. Les haut-parleurs associés au format multicanal du 
panoramique sont représentés, à leur position respective, à l'extérieur de la grille du panoramique. 
Ces haut-parleurs font également office de commandes Snap Pan to Speaker.

Cette section décrit toutes les commandes et toutes les fonctions des panners multicanal de Pro Tools. 

Fenêtre de sortie avec un panner multicanal au format 7.1

Grille X/Y

Fader LFE

Fader et indicateur de niveau de la piste

Position
(boutons de 
panoramique)

Divergence

Curseur de position 
du panoramique

Bouton du mode 
de panoramique

Automation, Solo et 

Mute de la piste

Pourcentage 
de centrage

Cliquez pour afficher les 
indicateurs de niveau

Icônes Snap Pan to Speaker
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Grille X/Y et curseur de position 
du panoramique
La grille X/Y permet de saisir et d'afficher les 
informations de panoramique multicanal. Vous 
pouvez entrer des informations de panoramique en 
mode X/Y, en mode 3-Knob ou en saisissant des 
valeurs numériques dans les champs de données 
Position. Vous pouvez également modifier 
graphiquement l'automation de panoramique dans 
la fenêtre Edit.

Par défaut, les panners multicanal sont en mode 
X/Y. Dans ce mode, la position actuelle du 
panoramique de la piste est représentée par un 
point de couleur verte. Ce point correspond au 
curseur de position du panoramique, qui indique 
l'état de l'automation des pistes à l'aide des 
couleurs Pro Tools standard : 

Vert : la piste est en mode d'automation Read.

Rouge : la piste est en mode d'automation Write, 
Touch, Latch ou Touch/Latch.

Jaune : la piste est en mode d'automation Off 
(ou automation suspendue).

Bouton du mode de 
panoramique
Ce bouton, situé sous la grille X/Y, permet 
d'accéder aux modes de panoramique surround 
(reportez-vous à la section « Modes de 
panoramique » à la page 1180). 

Commandes Position
Les commandes Position permettent de définir la 
position du panner.

Front : affiche et contrôle la position du panner sur 
l'axe X avant (gauche/droite). 

Rear : affiche et contrôle la position du panner 
sur l'axe X arrière (gauche/droite). En mode de 
panoramique X/Y par défaut, les positions avant et 
arrière sont liées et ne peuvent être contrôlées 
indépendamment. 

F/R (Front/Rear) : affiche et contrôle la position du 
panner sur l'axe Y. 

Commande Center %
Cette commande permet de contrôler le 
pourcentage du signal envoyé au haut-parleur 
central. Vous pouvez ainsi mixer une piste sur 
l'avant avec un centre fantôme (valeur Center de 
0 %) ou en ajustant sa position sur les trois canaux 
frontaux (LCR). 

Commandes Divergence
La divergence détermine la largeur du signal auquel 
le panoramique est appliqué, par rapport aux haut-
parleurs adjacents. Pour plus d'informations, 
reportez-vous au Guide Pro Tools des concepts de 
synchronisation et de son surround. Trois 
commandes de divergence sont disponibles.

Front, Rear et F/R : permettent de contrôler la 
divergence séparée et automatisable pour les haut-
parleurs avant, arrière et entre l'avant et l'arrière, 
respectivement.

Pour voir des exemples des répercussions 
des réglages de divergence sur le 
panoramique d'une sortie, reportez-vous à 
la section « Divergence et pourcentage de 
centrage » à la page 1184.
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Icônes Snap Pan to Speaker
Ces icônes permettent de forcer la position du 
panoramique sur l'emplacement d'un haut-parleur. 
Le fait de cliquer, par exemple, sur le haut-parleur 
supérieur gauche déplace le curseur de position du 
panoramique dans le coin supérieur gauche de la 
grille X/Y.

Fader LFE
Le fader LFE n'est disponible que dans les formats 
surround de type « .1 », à savoir 5.1, 6,1 et 7,1. 

Le fader LFE détermine, pour la piste actuelle, 
le niveau de signal envoyé sur le canal LFE. 
Les faders LFE des fenêtres de piste et de départ 
peuvent obéir aux groupes dont elles dépendent. 
Le canal LFE de Pro Tools fonctionne toujours 
avec une bande passante maximale. Pour plus 
d'informations sur l'utilisation du fader LFE, 
reportez-vous à la section « Faders LFE des 
panners multicanal » à la page 1187.

Liaison des panners multicanal
Les pistes stéréo avec des sorties multicanal 
fournissent des panners multicanal gauche et droit. 
La fenêtre de sortie contient des commandes 
permettant de lier les canaux gauche et droit pour 
générer un panoramique précis.

Lorsque vous créez une piste stéréo assignée à une 
sortie multicanal, les commandes de liaison du 
panoramique suivantes sont activées par défaut :

• Liaison (relie les commandes de panoramique 
gauche et droit)

• Inversion avant (inversion de la liaison des 
commandes de panoramique gauche et droit sur 
l'avant)

• Inversion arrière (inversion de la liaison des 
commandes de panoramique gauche et droit sur 
l'arrière)

Par défaut, la commande d'inversion avant/arrière 
est désactivée. 

Modes de panoramique
Le bouton du mode de panoramique propose 
quatre modes de panoramique : mode X/Y, édition 
de la divergence, mode 3 boutons et mode 
AutoGlide. Les commandes de panoramique 
peuvent être automatisées dans les quatre modes.

Pro Tools propose les modes de panoramique 
suivants :

Mode X/Y : pour effectuer un panoramique de style 
joystick, faites glisser le curseur de position du 
panoramique sur la grille X/Y des haut-parleurs. 
Pour plus d'informations, reportez-vous à la 
section « Panoramique X/Y » à la page 1181.

Mode 3 boutons : panoramique point à point, 
entre des paires de haut-parleurs. Pour plus 
d'informations, reportez-vous à la section 
« Panoramique 3 boutons » à la page 1182. 

Édition de la divergence : faites glisser les limites 
de divergence sur la grille X/Y de divergence pour 
les redimensionner. Reportez-vous à la section 
« Mode d'édition de la divergence » 
à la page 1185. 

Commandes de panner multicanal stéréo avec 
liaisons par défaut

Liaison

Inversion
avant/arrière

Inversion avant

Inversion arrière
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Mode AutoGlide (Glissement automatique) : 
panoramique point à point entre le curseur de 
position du panoramique et une nouvelle 
destination, en fonction de la durée de glissement 
automatique spécifiée. Pour plus d'informations, 
reportez-vous à la section « Mode AutoGlide : » 
à la page 1183.

Pour activer un mode de panoramique :

 Cliquez sur le bouton du mode de panoramique 
du panner surround jusqu'à ce que l'icône du 
mode souhaité s'affiche.

Panoramique X/Y

Pour effectuer un panoramique en mode X/Y :

1 Cliquez sur le bouton du mode de panoramique 
jusqu'à ce que l'icône du mode X/Y s'affiche.

2 Faites glisser le curseur de position du 
panoramique ou cliquez n'importe où sur la 
grille, puis faites glisser le curseur pour ajuster 
le panoramique de la piste. L'emplacement du 
curseur de position du panoramique détermine 
la position de panoramique du signal. Par 
exemple, pour positionner un son sur le haut-
parleur arrière gauche, déplacez le curseur de 
position du panoramique dans le coin inférieur 
gauche de la grille.

Pour positionner le curseur de position du 
panoramique à un emplacement particulier de 
la grille :

 Cliquez à l'emplacement de votre choix sur la 
grille X/Y tout en maintenant les touches 
Ctrl+Maj (Windows) ou Commande+Maj 
(Mac) enfoncées.

Options de la grille et raccourcis

Mode d'ajustement précis : maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée 
pour effectuer un ajustement précis de toutes les 
commandes de panoramique.

Restriction du déplacement à l'axe X ou Y : faites 
glisser le curseur de position du panoramique en 
maintenant la touche Maj enfoncée pour 
restreindre son déplacement à l'axe X ou Y.

Réinitialisation des paramètres par défaut : 
maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée tout en cliquant sur la grille du 
panner pour réinitialiser tous les paramètres sur 
leur valeur par défaut.

Snap Pan to Speaker : cliquez sur l'une des icônes 
Snap Pan to Speaker pour forcer le panner sur 
l'emplacement de ce haut-parleur.

Affichage de l'automation dans la fenêtre Edit : 
maintenez les touches Ctrl+Démarrer (Windows) 
ou Commande+Ctrl (Mac) enfoncées tout en 
cliquant sur une commande pour afficher la 
playlist correspondante dans la fenêtre Edit.

Il n'est pas nécessaire de cliquer exactement 
sur le curseur de position du panoramique. 
Si vous cliquez à un endroit quelconque de la 
grille, le curseur se déplace par rapport à cet 
emplacement ou au point auquel vous prenez 
le contrôle avec un panner matériel. 
Le panoramique ne vient pas se placer 
directement sur le point auquel vous 
avez cliqué.

Il est possible d'automatiser toutes les 
commandes de panoramique, y compris la 
position et la divergence. Pour plus 
d'informations, reportez-vous au 
Chapitre 45, « Automation ».



Guide de référence Pro Tools1182

Panoramique 3 boutons
Pro Tools offre également un mode 3 boutons 
permettant de spécifier des déplacements de 
panoramique. 

Le mode 3 boutons permet d'effectuer les 
opérations suivantes :

• Mouvements panoramiques en ligne droite, 
en déplaçant le curseur de position du 
panoramique avec les boutons rotatifs 
Position (axes avant, arrière et avant/arrière).

• Mouvements panoramiques séparés entre des 
paires de haut-parleurs.

Par exemple, lorsque vous effectuez un 
panoramique de l'avant gauche vers l'arrière droite 
en mode 3 boutons, le son ne sera audible que sur 
ces deux haut-parleurs (en partant du principe que 
la divergence intégrale est activée). 

En comparaison, si vous effectuez un panoramique 
en mode X/Y, le son peut être audible sur certains 
canaux ou sur tous pendant son déplacement. 

La différence provient du fait que le mode 
3 boutons effectue un panoramique distinct entre 
les positions avant et arrière de la trajectoire, 
tandis que le panoramique en mode X/Y couvre la 
totalité des 360° de la grille de panoramique. 
Les options Divergence et Center % sont variables 
dans les deux modes. 

Pour activer le mode de panoramique 3 boutons :

 Cliquez sur le bouton du mode de panoramique 
jusqu'à ce que l'icône du mode 3 boutons 
s'affiche.

La ligne de trajectoire du panner s'affiche sur la 
grille, en s'étendant de l'avant (axe X) vers l'arrière 
(axe Y).

Pour effectuer un panoramique en mode 
3 boutons :

1 Ajustez les boutons de position avant et arrière 
pour définir la trajectoire. 

2 Faites tourner le bouton de position 
avant/arrière pour effectuer le panoramique le 
long de la trajectoire. Le curseur de position du 
panoramique est contraint à suivre la ligne de 
trajectoire blanche.

Pour modifier les angles de la trajectoire 
3 boutons, effectuez l'une des opérations 
suivantes :

 Faites glisser l'un des points de fin (avant ou 
arrière) de la trajectoire. 

 Ajustez les commandes de position avant 
(Front) ou arrière (Rear). 

Panoramique et indication des niveaux en mode 
3 boutons

Trajectoire en 
mode 3 boutons

Mode 3 boutons

Bouton du mode de panoramique 3 boutons
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Pour modifier la position de la trajectoire actuelle 
(de gauche à droite) en conservant les angles 
actuels :

 Faites glisser la trajectoire (et non ses points de 
fin) vers une nouvelle position. 

Mode AutoGlide :
Le mode AutoGlide permet d'écrire rapidement 
une automation de panner surround en cliquant sur 
de nouveaux emplacements de la fenêtre du panner 
surround au lieu de déplacer manuellement ses 
commandes.

Le délai nécessaire pour passer d'un point à l'autre 
(du curseur de position du panoramique à la 
nouvelle destination) est défini par le paramètre 
AutoGlide Time de la page des préférences de 
mixage. Cette durée est comprise entre 10 et 
10 000 millisecondes (10 secondes).

Pour définir le paramètre AutoGlide Time :

1 Sélectionnez Setup > Preferences et cliquez sur 
Mixing. 

2 Définissez une durée pour le paramètre 
AutoGlide Time dans la section Automation.

Pour effectuer une passe d'automation 
AutoGlide :

1 Cliquez sur le bouton du mode de panoramique 
jusqu'à ce que l'icône du mode AutoGlide 
s'affiche.

Le bouton du mode de panoramique affiche une 
ligne inclinée en pointillés se terminant par un 
point plein (représentant un curseur) dans son 
angle supérieur droit.

2 Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste 
à automatiser, puis sélectionnez le mode de 
votre choix.

3 Appuyez sur Play pour lancer la lecture.

4 Définissez une nouvelle destination pour le 
curseur en effectuant l'une des opérations 
suivantes :

• Cliquez sur une icône Snap Pan to Speaker pour 
effectuer un glissement vers cet emplacement de 
haut-parleur.

• Cliquez sur la fenêtre de panoramique pour 
effectuer un glissement vers un emplacement 
spécifique de la grille X/Y.

La durée du déplacement du curseur sur le 
panoramique vers la nouvelle destination correspond 
à la durée définie par le paramètre AutoGlide Time. 
Dès que le point de destination est atteint, un nouveau 
point d'automation est écrit au nouvel emplacement.

5 Pour définir des déplacements panoramiques 
supplémentaires, répétez l'étape précédente.

6 Appuyez sur le bouton Stop de la fenêtre de 
transport lorsque vous avez terminé.

Lorsque vous écrivez une automation en 
mode AutoGlide, il est impossible de 
déplacer le curseur de position du 
panoramique.

Bouton du mode de panoramique AutoGlide

Bouton du mode de panoramique (mode AutoGlide)

Mode AutoGlide

Icônes Snap 
Pan to 
Speaker

Curseur de 
position du 
panoramique
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Divergence et pourcentage 
de centrage
Les valeurs des commandes de divergence et de 
pourcentage de centrage (Center %) peuvent être 
automatisées et sont comprises entre 0 et 100. Elles 
sont particulièrement utiles pour s'assurer de 
l'audibilité et de la couverture des signaux audio 
à l'intérieur de lieux de grande dimension, ainsi 
que pour augmenter la clarté des voix. 

Divergence avant (Front) : contrôle la divergence 
entre les haut-parleurs avant (axe X uniquement). 

Divergence arrière (Rear) : contrôle la divergence 
entre les haut-parleurs arrière (axe X uniquement).

Divergence avant/arrière (F/R) : contrôle la 
divergence entre l'avant et l'arrière (axe Y).

Center % : détermine s'il existe une image centrale 
discrète, une image centrale entièrement fantôme 
ou une valeur variable comprise entre les deux. 

Side % : détermine s'il existe une image latérale 
discrète, une image latérale entièrement fantôme 
ou une valeur variable comprise entre les canaux 
latéraux droit et gauche pour les formats 7.1 et 7.0. 

Divergence
Les valeurs de divergence actuelles sont 
représentées par un contour violet sur la grille 
du panner.

Par défaut, les panners surround de Pro Tools sont 
divergents à 100 %, ce qui signifie qu'un signal 
dont le panoramique est réglé sur un seul haut-
parleur ne sera audible que sur celui-ci. 

Affichage et commandes de divergence

Affichage de la 
divergence

Commandes de 
divergence
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Une divergence inférieure se traduit par un signal 
source qui s'élargit progressivement. Lorsque la 
divergence est inférieure à 100 %, les pistes sont 
assignées dans une certaine mesure aux haut-
parleurs adjacents, même lorsque le curseur de 
position du panoramique est positionné près d'un 
seul haut-parleur. 

Pour ajuster la divergence :

 Ajustez les commandes de divergence avant 
(Front), arrière (Rear) et avant/arrière (F/R). 

Mode d'édition de la divergence
En mode d'édition de la divergence, vous pouvez 
modifier les contours de la divergence en les 
faisant glisser directement sur la grille de 
divergence. 

Pour ajuster la divergence graphiquement :

1 Cliquez sur le bouton du mode de panoramique 
jusqu'à ce que l'icône du mode d'édition de la 
divergence s'affiche.

2 Faites glisser les contours de la divergence sur 
la grille pour les redimensionner. 

Divergence frontale inférieure à 100 % pour un 
panoramique plus large

Divergence
avant

Curseur de 
position du 
panoramique

Bouton du mode de panoramique d'édition de la 
divergence
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Center %
Pour les formats surround LCR, LCRS, 5.0, 5.1, 
6.0, 6.1, 7.0, 7.0 SDDS, 7.1 et 7.1 SDDS, 
la commande Center % détermine s'il existe un 
canal central séparé pour la piste ou un canal 
central fantôme.

Exemple de pourcentage de centrage

En production cinématographique et vidéo, le canal 
central contient souvent les dialogues. Pour 
améliorer la clarté des dialogues, il est recommandé 
de laisser les autres éléments (tels que la musique) 
hors du haut-parleur central. En réduisant le 
pourcentage de centrage sur les pistes musicales, 
la musique sur laquelle est réglée un panoramique 
vers l'avant dans le champ sonore peut être envoyée 
uniquement vers les haut-parleurs gauche et droit, 
afin d'obtenir une image centrale fantôme.

Pour ajuster le pourcentage de centrage :

 Ajustez le bouton Center %.

Plus vous réduisez la valeur du pourcentage, plus 
l'icône du haut-parleur central située en haut de la 
grille s'estompe. Si le bouton Center % est réglé 
sur 0, l'icône est complètement invisible, reflétant 
ainsi le réglage du centre entièrement fantôme.

Side %
Pour les formats surround 7.1 et 7.0, la commande 
Side % détermine s'il existe des canaux latéraux 
séparés pour la piste ou un canal latéral fantôme. 

Pour ajuster le pourcentage de valeur latérale :

 Ajustez le bouton Side %. 

Plus vous réduisez la valeur du pourcentage, plus 
les icônes des haut-parleurs situées sur les côtés de 
la grille s'estompent. Si le bouton Side % est réglé 
sur 0, les icônes sont complètement invisibles, 
reflétant ainsi le réglage latéral entièrement 
fantôme.

Pourcentage de centrage réglé sur 0 (aucun haut-
parleur central activé)

Valeur latérale définie sur 50 % (haut-parleurs 
latéraux estompés au centre)
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Faders LFE des panners 
multicanal
Le fader LFE contrôle le niveau du signal de la 
piste envoyé au canal LFE. Les faders LFE ne sont 
disponibles que lorsqu'une piste est assignée à un 
chemin dont le format prend en charge le LFE 
(5.1, 6.1 ou 7.1). 

Pour envoyer le signal sur le canal LFE :

 Ajustez le fader LFE dans une fenêtre de sortie 
au format surround « .1 ». 

Groupes et faders LFE
Pour suivre les groupes Mix et Edit, les faders LFE 
de piste et de départ doivent être activés dans la 
page Group Attributes de la boîte de dialogue 
Create Groups ou Modify Groups. Leur 
assignation permet de suivre les groupes en tant 
qu'attribut global ou sur une base « groupe par 
groupe ». Reportez-vous à la section « Sélection 
des attributs de groupe » à la page 263.

LFE Enable
Certains plug-ins multicanal, notamment le 
compresseur/limiteur multicanal Dynamics III, 
intègrent une fonction d'activation du LFE. Cette 
fonction vous permet d'activer ou de désactiver le 
traitement du canal LFE, le cas échéant. 

Pour traiter le canal LFE dans un plug-in 
multicanal :

 Activez la fonction LFE Enable, si le plug-in 
multicanal la prend en charge. L'option LFE 
Enable apparaît en surbrillance lorsque vous 
l'activez.

Playlists de panoramique
Les panners multicanal comportent une playlist 
d'automation pour chaque commande de position 
et de divergence.

Pour obtenir des informations générales sur 
le LFE, les sous-canaux et les sujets 
connexes, reportez-vous au Guide Pro Tools 
des concepts de synchronisation et de son 
surround.

Fonction LFE Enable du compresseur/limiteur 
multicanal Dynamics III

Si la fonction LFE Enable n'est pas 
disponible, essayez d'utiliser la version 
multi-mono du plug-in.

L'automation de panoramique peut être 
représentée, modifiée, coupée, copiée et 
collée à partir de la fenêtre Edit. Pour plus 
d'informations, voir Chapitre 45, 
« Automation ».
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Chapitre 50 : Utilisation de la synchronisation

Deux systèmes sont synchronisés lorsque l'un 
fournit un timecode et l'autre poursuit ce timecode. 
Pro Tools peut être synchronisé avec d'autres 
périphériques via un timecode SMPTE/EBU 
ou MIDI.

Options de synchronisation 
de Pro Tools
Vous disposez de plusieurs options pour 
synchroniser Pro Tools avec une source externe et 
l'utiliser en tant que périphérique maître.

Déclenchement SMPTE 
uniquement
Cette solution est très utile pour les projets courts 
si la cadence des deux systèmes est proche. 
Toutefois, même les meilleurs systèmes restent 
rarement parfaitement synchronisés plus de 
quelques minutes.

Déclenchement SMPTE 
verrouillé sur une SYNC HD
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native uniquement)

Vous pouvez utiliser une SYNC HD pour 
verrouiller les cadences d'enregistrement et de 
lecture de Pro Tools sur l'une des sources de 
référence d'horloge suivantes, Pro Tools étant 
asservi au timecode :

• LTC 

• Source vidéo

• Référence vidéo externe (SD ou HD)

• VITC

• Word Clock 1x

• Horloge AES/EBU null

• Fréquence pilote

• Biphase

Une synchronisation extrêmement précise et fiable 
est assurée lorsque tous les transports du système 
sont référencés sur cette source de synchro 
commune, ou lorsqu'ils suivent les variations du 
timecode entrant.
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Déclenchement SMPTE et 
verrouillage sur une source non 
référencée
Le déclenchement SMPTE peut être utilisé avec 
une SYNC HD pour verrouiller la cadence 
d'enregistrement et de lecture de Pro Tools, asservi 
à un timecode LTC. Une synchronisation précise 
et fiable est assurée et les systèmes suivent les 
variations du timecode entrant. La SYNC HD 
prend également en charge les références de 
positionnement VITC et Biphase/Tach.

Options de synchronisation 
avec une SYNC HD
L'ajout d'une SYNC HD à votre système 
Pro Tools|HDX ou Pro Tools|HD Native permet 
d'utiliser Pro Tools en tant que périphérique maître 
dans votre configuration de synchronisation. Tous 
les autres périphériques sont alors asservis 
à Pro Tools. 

Vous pouvez utiliser Pro Tools avec une 
SYNC HD pour générer des commandes LTC, 
MIDI Timecode ou MMC. Lorsque la SYNC HD 
lit un timecode SMPTE entrant, il le régénère via le 
connecteur de sortie LTC ou MTC. Ce signal peut 
ensuite être transmis à d'autres périphériques 
esclaves.

MachineControl
La SYNC HD prend également en charge le 
logiciel MachineControl, qui ajoute de 
nombreuses fonctionnalités spécialisées pour les 
tâches de post-production, notamment l'armement 
des pistes à distance, l'émulation de magnétoscope, 
le timecode série, etc. Pour plus d'informations, 
reportez-vous au Guide MachineControl ou 
contactez votre revendeur.

Sortie d'horloge externe
Pro Tools peut être utilisé en tant que 
périphérique maître dans votre configuration de 
synchronisation. Dans ce cas, tous les autres 
périphériques sont asservis à la sortie Word Clock 
de Pro Tools. 

Pour configurer la sortie d'horloge externe :

1 Dans Pro Tools, sélectionnez Setup > 

Hardware.

2 Cliquez sur le menu déroulant Ext. Clock Output 
et sélectionnez un signal disponible. 

3 Lorsque vous avez terminé, cliquez sur OK pour 
fermer la boîte de dialogue Hardware Setup.

Pour de plus amples informations sur la 
connexion d'une SYNC HD à votre système 
Pro Tools, reportez-vous au Guide 
SYNC HD.
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Fenêtre Session Setup
La fenêtre Session Setup permet de configurer divers paramètres système relatifs au timecode, ainsi que 
certains paramètres de format de session, tels que la résolution, la profondeur de panoramique, le format 
audio et l'option de fichier entrelacé. Elle inclut également des zones d'information qui présentent la 
fréquence d'échantillonnage de la session, le délai du système et d'autres données liées au timecode, telles 
que le timecode entrant actuel. 

La fenêtre Session Setup est organisée en trois sections. La section Format apparaît en haut de la fenêtre. 
Les sections SYNC Setup & Timecode Offsets et Timecode Settings peuvent être masquées ou affichées.

Pour afficher la fenêtre Session Setup :

 À partir d'une session Pro Tools, sélectionnez 
Setup > Session.

Pour développer la section SYNC Setup & 
Timecode Offsets :

 Cliquez sur le triangle développer/réduire 
de la section.

Les commandes de cette section configurent les 
paramètres de la SYNC HD. Les paramètres 
disponibles sont Clock Reference, Positional 
Reference, Video Ref Format, Video In Format 
et VSO (Variable Speed Override). 

Pour afficher la section Timecode Settings :

 Cliquez sur le triangle développer/réduire 
de la section.

Les commandes de cette section permettent de 
configurer les options de génération de timecode et 
d'inertie ainsi que celles de pull up et pull down 
pour les fréquences audio et vidéo.

Fenêtre Session Setup avec une SYNC HD

 

 

Section Format

Source d'horloge

Section SYNC 
Setup & Timecode 
Offsets

Paramètres SYNC 
Setup

Section Timecode 
Settings

Paramètres du 
générateur

Informations et 
paramètres de la session

Paramètres de décalage 
du timecode externe

Décalage du lecteur 
de timecode

Paramètres pull 
up/pull down

Paramètres d'inertie

Appuyez sur Ctrl+2 (Windows) ou 
Commande+2 (Mac) pour ouvrir la fenêtre 
Session Setup.
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Informations et commandes 
de la section Format de la 
fenêtre Session Setup
La fenêtre Session Setup permet de configurer 
divers paramètres système relatifs au timecode, 
ainsi que certains paramètres de format de session, 
tels que la résolution, la profondeur de 
panoramique, le format audio et l'option de fichier 
entrelacé.

Sample Rate
Ce paramètre indique la fréquence 
d'échantillonnage de la session actuelle. 

Bit Depth
Ce menu indique la résolution de la session 
actuelle. Vous pouvez modifier la résolution de 
tous les fichiers qui seront enregistrés ou importés 
(et convertis) par la suite dans la session en 
sélectionnant une option différente dans le menu 
Bit Depth. Pour plus d'informations sur chaque 
option, reportez-vous à la section « Résolutions » 
à la page 155.

Clock Source
Ce menu permet de configurer la source d'horloge 
du système. Vous avez le choix entre une 
SYNC HD, une source d'horloge interne provenant 
d'un périphérique et une source d'horloge externe 
connectée à une interface audio Avid HD.

Options de source d'horloge

SYNC : lorsque vous utilisez une SYNC HD, 
Pro Tools reçoit sa source d'horloge de la 
SYNC HD. La SYNC HD peut à son tour être 
synchronisée sur une source d'horloge externe, 
sélectionnée dans la section SYNC Setup de la 
fenêtre Session Setup. 

Internal : en mode Internal, votre système se 
synchronise sur l'horloge interne de votre 
périphérique et la lecture s'effectue à la fréquence 
d'échantillonnage de la session.

External Clock Sources : selon votre interface 
audio, les options de source d'horloge externe 
peuvent inclure AES/EBU, S/PDIF, S/PDIF 

Optical, ADAT Optical, TDIF et Word Clock 
(des fréquences de signal Word Clock optionnelles 
sont disponibles aux fréquences d'échantillonnage 
plus élevées). Les fréquences des sources externes 
peuvent être n'importe quel multiple de la 
fréquence de base. Elles sont de 88,2 et 176,4 kHz 
pour une fréquence de base de 44,1 kHz, et de 96 et 
192 kHz pour une fréquence de base de 48 kHz. 
Si une source externe est sélectionnée et qu'aucune 
horloge de synchronisation valide n'est détectée 
sur l'entrée d'horloge externe, le périphérique d'E/S 
repasse en mode Internal.

Les modifications apportées au paramètre 
Clock Source dans la boîte de dialogue 
Hardware Setup sont reflétées dans la fenêtre 
Session Setup.

Si une SYNC HD est activée dans la boîte de 
dialogue Peripherals et est correctement 
connectée dans la chaîne Loop Sync, elle 
peut être utilisée comme périphérique 
maître de la boucle. Vos interfaces audio 
seront alors asservies à cette horloge.

Pour plus d'informations sur les sources 
d'horloge externes, reportez-vous au 
Guide SYNC HD.
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System Delay
Lorsque la compensation du délai est activée 
(Options > Delay Compensation), cette zone 
d'informations indique la quantité totale de délai 
(en échantillons) appliquée par le système pour la 
compensation du délai des plug-ins et du routing 
du mixeur. 

Pan Depth
Ce menu permet de sélectionner la profondeur de 
panoramique des chemins de sortie stéréo d'une 
session Pro Tools. La profondeur de panoramique 
représente la quantité d'atténuation appliquée à un 
signal lorsqu'une piste est routée vers une sortie 
stéréo et placée au centre du champ panoramique. 
Pour plus d'informations sur chaque option, 
reportez-vous à la section « Profondeur de 
panoramique stéréo » à la page 992.

Audio Format
Ce menu indique le format de fichier actuel des 
fichiers enregistrés dans la session. Vous pouvez 
modifier le format de fichier audio de tous les 
fichiers qui seront enregistrés ou importés 
(et convertis) par la suite dans la session en 
sélectionnant une option différente dans le menu 
Audio Format. Pour plus d'informations, reportez-
vous à la section « Formats de fichiers audio 
mixtes » à la page 156.

Interleaved
Activez l'option Interleaved afin que tous les 
fichiers multicanal stéréo ou de format supérieur 
à stéréo qui seront enregistrés ou importés 
(et convertis) par la suite dans la session soient 
au format entrelacé. Pour plus d'informations, 
reportez-vous à la section « Fichiers audio multi-
mono et multicanal entrelacés » à la page 157.

Session Start
Utilisez ce champ pour spécifier l'emplacement 
SMPTE du bord de l'image de début de la session. 
Pour plus d'informations, reportez-vous à la 
section « Définition de l'heure de début SMPTE 
d'une session (image de début) » à la page 1199.

Incoming Time (heure actuelle)
Cette zone d'informations indique le timecode 
entrant provenant d'une source externe. 

Timecode Rate
Le paramètre Timecode Rate permet de définir la 
fréquence de timecode SMPTE de la session 
actuelle. 

Feet+Frame Rate 
Le paramètre Feet+Frame Rate permet de définir 
la cadence Feet+Frame des sessions. Les cadences 
prises en charge sont de 23.976, 24 et 25 i/s.

Définissez cette cadence en fonction de celle du 
projecteur cinématographique ou vidéo si la 
vitesse du projecteur est prise en compte. Ainsi, 
pour réaliser un télécinéma à partir d'un projecteur 
cinématographique 24 i/s en vidéo NTSC, 
le projecteur devrait fonctionner à 23.976 i/s, 
qu'un pull down audio soit appliqué ou non 
à la session.

Timecode 2 Rate 
Le paramètre Timecode 2 Rate permet de définir 
une cadence d'images secondaire qui peut être 
affichée sur la règle à côté de la règle de timecode 
principale. Vous pouvez ainsi vous référer dans la 
timeline à une cadence d'images différente de la 
fréquence de timecode de la session (reportez-vous 
également à la section « Règles de base de temps » 
à la page 789).
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Section SYNC Setup and 
Timecode Offsets de la 
fenêtre Session Setup
La section SYNC Setup and Timecode Offsets de 
la fenêtre Session Setup comporte des zones 
d'informations et des menus contrôlant des 
paramètres de votre système relatifs au timecode. 

Section SYNC Setup
(Systèmes Pro Tools|HDX et Pro Tools|HD 
Native avec SYNC HD uniquement)

Les commandes de la section SYNC Setup de la 
fenêtre Session Setup permettent de configurer les 
paramètres d'une SYNC HD, tels que la référence 
d'horloge, la référence de positionnement, 
le format de référence vidéo, le format d'entrée 
vidéo et le VSO (Variable Speed Override).

Clock Reference

Ce menu permet de définir la référence d'horloge 
de Pro Tools.

 Lorsque vous utilisez une SYNC HD, 
le sélecteur Clock Reference répertorie tous les 
types d'horloge pris en charge.

 Si votre système Pro Tools|HDX ou 
Pro Tools|HD Native n'inclut pas de SYNC HD, 
vous avez le choix parmi tous les formats ou 
sources numériques activés et pouvant provenir de 

votre interface audio Avid HD (tels qu'un signal 
AES, S/PDIF ou Word Clock 1x arrivant sur le 
port d'entrée Word Clock d'une interface 
Avid HD).

Positional Reference

Définit la source de timecode que Pro Tools utilise 
en tant que référence de positionnement. 

Video Ref Format

Définit le format de la référence vidéo pour la 
SYNC HD.

Video In Format

Indique le format attendu sur le connecteur 
d'entrée vidéo de la SYNC HD. Pour certaines 
cadences HD, un menu permet de sélectionner un 
format.

Variable Speed Override (VSO)

Requiert une SYNC HD. Si vous connectez une 
SYNC HD à un système Pro Tools|HDX ou 
Pro Tools|HD Native, les commandes VSO 
s'affichent dans la section SYNC Setup de la 
fenêtre Session Setup. 

Lorsque vous utilisez le varispeed avec une 
HD MADI, il est possible de dépasser la bande 
passante disponible. Lorsque le varispeed dépasse 
la fréquence maximale pour la fréquence 
d'échantillonnage nominale actuelle, un dropout 
audio se produit. La fréquence de varispeed 
maximale pour chaque fréquence d'échantillonnage 
nominale est indiquée dans le tableau suivant.

Section SYNC Setup
Reportez-vous au Guide SYNC HD pour 
obtenir des instructions d'utilisation du 
VSO pour appliquer une variation de la 
vitesse de lecture de Pro Tools.
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Témoins Ref Present, Locked et 
Speed Cal

Les témoins Ref Present, Locked et Speed Cal de 
la section SYNC Setup de la fenêtre Session Setup 
indiquent l'état de synchronisation de la 
SYNC HD. Les témoins Locked et Speed Cal 
reflètent l'état des LED correspondantes du 
panneau avant du périphérique.

Témoin Ref Present : le témoin Ref Present 

s'allume lorsque le connecteur d'entrée de 
référence vidéo reçoit un signal vidéo valide. 

Témoin Locked : ce témoin reste allumé en vert 
lorsque la SYNC HD est verrouillée sur la 
référence d'horloge sélectionnée. Le témoin 
Locked clignote en jaune si la source de référence 
d'horloge sélectionnée est absente ou hors de la 
plage de fréquences valides.

Témoin Speed Cal : ce témoin indique l'état de la 
référence d'horloge entrante :

• Allumé en jaune : la SYNC HD est verrouillée 
et la référence d'horloge se situe dans la limite de 
0,025 % de la fréquence attendue.

• Clignotement jaune rapide : la SYNC HD est 
verrouillée mais la référence d'horloge est de 
0,025 % à 4 % plus rapide que la fréquence 
attendue.

• Clignotement jaune lent : la SYNC HD est 
verrouillée mais la référence d'horloge est de 
0,025 % à 4 % plus lente que la fréquence 
attendue.

• Clignotement rouge rapide : la SYNC HD est 
verrouillée mais la référence d'horloge est au 
moins 4 % plus rapide que la fréquence attendue.

• Clignotement rouge lent : la SYNC HD est 
verrouillée mais la référence d'horloge est au 
moins 4 % plus lente que la fréquence attendue.

• Éteint : la SYNC HD n'est pas verrouillée sur la 
référence d'horloge sélectionnée.

External Timecode Offsets
La section External Time Code Offsets permet de 
compenser d'un nombre d'images fixe le décalage 
constant de certains périphériques (comme 
certains masters vidéo après correction 
colorimétrique), ou de contenus dont l'heure de 
début diffère de celle de la session. 

Pro Tools propose quatre types différents de 
paramètres de décalage de timecode externe. 
Ces décalages correspondent aux types de 
périphériques suivants :

• MMC (MIDI Machine Control)

• 9-Pin (contrôle magnétoscope)

• Périphériques de synchronisation, dont SYNC HD 
(systèmes Pro Tools|HDX ou Pro Tools|HD Native 
uniquement) ou autres (tels que des interfaces 
MIDI générant un timecode MIDI). 

• Satellite

Fréquences de varispeed maximales

Fréquence 
d'échantillonnage 
nominale

Nombre de 
canaux

Fréquence 
maximale

44,1/48 kHz 64 48,8 kHz

44,1/48 kHz 56 55,6 kHz

88,2/96 kHz 32 97,5 kHz

88,2/96 kHz 28 111,5 kHz

176,4/192 kHz 16 194,9 kHz

176,4/192 kHz 14 223,0 kHz

Témoins Ref Present, Locked et Speed Cal
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Il est possible de définir des valeurs uniques pour 
chacun de ces types de décalage ou de les lier pour 
les contrôler simultanément. 

Des valeurs de décalage positives et négatives 
peuvent être saisies pour retarder ou avancer le 
timecode affiché dans Pro Tools, respectivement. 

Si vous utilisez l'option MachineControl, 
des options supplémentaires de décalage de 
timecode externe sont disponibles. Pour en savoir 
plus, reportez-vous au Guide MachineControl.

Pour redéfinir les décalages de timecode externe :

1 Sélectionnez Setup > External Timecode Offset.

2 Dans la boîte de dialogue Redefine External 
Time Code Offset, saisissez la valeur de 
décalage souhaitée dans le champ Desired Time 
Code Position.

3 Cliquez sur OK.

Sample Offset (décalage de synchro)

Ce champ permet de définir un décalage de 
déclenchement pour le timecode MIDI entrant 
(compris entre -100 000 et +100 000 échantillons). 
Vous créez ainsi un décalage permanent pour 
définir avec précision le point auquel Pro Tools se 
synchronise sur le timecode entrant. Avec une 
valeur de -50 par exemple, un événement dans 
Pro Tools se produit 50 échantillons avant sa 
contrepartie dans le timecode MIDI. Utilisez cette 
méthode pour compenser les différences de timing 
entre divers convertisseurs de timecode SMPTE 
vers MIDI, ou convertisseurs A/N ou N/A. 

Section Timecode Settings 
de la fenêtre Session Setup

Freewheel
Les options de la section Freewheel permettent de 
configurer l'inertie de Pro Tools, ou la manière 
dont l'application réagit à une interruption ou à une 
corruption du timecode en cours de lecture. 
Utilisez ces options pour éviter les erreurs qui 
surviennent lorsque des dropouts ou des pertes 
temporaires de signal se produisent sur la source de 
timecode SMPTE.

None : aucune inertie n'est appliquée. 

Frames : définit un nombre d'images d'inertie 
(entre 1 et 120 images). La valeur par défaut est 
de 8 images, paramètre conseillé pour la plupart 
des applications.

Jam Sync : cette option permet à Pro Tools de se 
synchroniser avec un timecode entrant, puis de 
poursuivre la lecture même si l'entrée de timecode 
est totalement interrompue. Elle peut s'avérer 
utile si le timecode est altéré ou s'il a été effacé 
accidentellement de la bande source.

Pull up/Down
Lorsque Pro Tools est associé à une SYNC HD, 
cette option permet d'accélérer (pull up) ou de 
ralentir (pull down) la fréquence d'échantillonnage 
actuelle.

Pour plus d'informations sur l'application des 
facteurs de pull up/pull down dans Pro Tools, 
reportez-vous à la section « Pull up et pull down » 
à la page 1201. 

Boîte de dialogue Redefine External Time Code Offset

Les facteurs de pull up et pull down sont 
appliqués de manière différente selon les 
workflows. Renseignez-vous sur le workflow 
spécifique de chaque projet avant de 
commencer à travailler.



Chapitre 50 : Utilisation de la synchronisation 1199

Préconfiguration SMPTE
Pour travailler en SMPTE, la première étape 
consiste à sélectionner une cadence d'images 
appropriée. Pro Tools prend en charge toutes les 
cadences d'images SMPTE standard. Si vous 
travaillez avec une bande codée SMPTE, il est 
essentiel de connaître sa cadence d'images. 
Dans certains cas, une SYNC HD peut être 
utilisée pour cela.

Configuration de Pro Tools 
pour le SMPTE
Les paramètres système Synchronization et 
MachineControl sont activés dans la boîte de 
dialogue Peripherals de Pro Tools (Setup > 

Peripherals). Ces paramètres s'appliquent au 
système et sont conservés quel que soit le type de 
session sur lequel vous travaillez. Configurez ces 
paramètres avant d'ouvrir une session.

D'autres paramètres tels que la fréquence de 
timecode de la session, la cadence Feet+Frames, 
l'image de début et le format d'affichage de l'heure 
de la session peuvent être configurés dans la 
fenêtre Session Setup. Ces paramètres sont 
spécifiques à la session et ne peuvent être modifiés 
que lorsqu'une session est ouverte.

Sélection d'un format SMPTE

Pour choisir un format SMPTE :

1 Dans Pro Tools, sélectionnez Setup > Session.

2 Sélectionnez une cadence d'images (format 
SMPTE) à l'aide du sélecteur Timecode Rate. 

3 Entrez un nombre d'images d'inertie 
(si nécessaire) dans le champ prévu à cet effet 
(reportez-vous à la section « Freewheel » 
à la page 1198).

Définition de l'heure de début 
SMPTE d'une session (image de 
début)
Dans la fenêtre Session Setup, vous pouvez définir 
une image de début SMPTE pour la session. 
L'image de début d'une bande vidéo codée de 
travail se situe rarement à l'adresse d'image 
SMPTE 00:00:00:00. Vous pouvez entrer 
rapidement une heure de début pour votre session, 
en fonction du numéro d'image approprié sur la 
bande de votre projet. Les fonctions de Pro Tools 
relatives au timecode SMPTE (par exemple, 
le mode Spot) utilisent alors cette nouvelle valeur 
comme point de début de la session.

Heure de début et codage de bande

Si vous générez un timecode, il est conseillé de 
l'imprimer à partir de la valeur 01:00:00:00 
(en réservant du temps pour les signaux d'en-tête 
de bande, telles que le noir initial, les fréquences 
test et mires de barre ou logos). Vous éviterez ainsi 
les éventuels problèmes survenant avec certains 
synchroniseurs lorsque le timecode passe de la 
valeur 23:59:59:29 à 00:00:00:00 (communément 
appelé passage à minuit).

MachineControl est pris en charge 
uniquement sur les systèmes 
Pro Tools|HDX et Pro Tools|HD Native.
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Pour définir une heure de début SMPTE pour votre 
session :

1 Sélectionnez Setup > Session. 

2 Entrez un numéro d'image SMPTE dans le 
champ Session Start.

Pour capturer une adresse SMPTE entrante en tant 
qu'heure de début de la session :

1 Cliquez dans le champ Session Start.

2 Lancez la lecture de la source de timecode. 

3 Lorsque vous atteignez l'emplacement 
correspondant à la valeur à capturer, appuyez 
sur la touche Égal (=) du pavé numérique. 

4 Appuyez sur Entrée pour accepter la valeur. 
Vous pourrez modifier ultérieurement l'adresse 
capturée. La session utilisera le numéro d'image 
saisi en tant qu'image de début SMPTE en 
mode Online.

• Si les pistes contiennent des clips et si vous 
retardez l'image de départ SMPTE d'origine 
(de 00:00:00:00 à 01:00:00:00 par exemple), 
tous les clips présents sur les pistes conservent 
leur position relative, mais sont décalés de la 
valeur temporelle ajoutée à l'image de départ.

• Si vous modifiez l'heure de début d'une session 
ouverte dans laquelle des pistes existent déjà, 
une boîte de dialogue d'avertissement s'affiche 
lorsque vous appuyez sur Entrée. Sélectionnez 
l'une des deux options suivantes.

Maintain Timecode : le temps supplémentaire est 
inséré au début de la session et les clips déjà 
présents conservent leur emplacement de timecode 
d'origine.

Maintain Relative Position : le temps 
supplémentaire est inséré au début de la session 
et la position relative entre les clips déjà présents 
et la nouvelle image de début est conservée. 
Par exemple, si vous modifiez la position de 
l’image de départ de la session de 01:00:00:00 

à 00:59:00:00, Pro Tools rallonge la session d’une 
minute afin de prendre en compte la nouvelle 
position de l'image de début, puis avance tous les 
clips existants pour conserver leur position relative 
par rapport à cette nouvelle image de début. 

Redéfinition d'une position 
Feet+Frames
Utilisez la commande Current Feet+Frames pour 
redéfinir la position Feet+Frames sur le point 
d'insertion actuel. L'heure de début de la session 
est recalculé en fonction de la nouvelle position 
Feet+Frames relative. 

Cette commande est généralement utilisée pour 
intégrer des fréquence tests, une plage de pré-roll, 
une amorce film ou d'autres contenus similaires 
précédant le contenu d'une session Pro Tools. 
La redéfinition de la position Feet+Frames n'a pas 
d'incidence sur l'heure de début de la session.

Pour définir une position d'image relative pour une 
session (Feet+Frames) :

1 À l'aide du Sélecteur, cliquez sur une piste 
(ou créez une sélection) à l'endroit où vous 
souhaitez redéfinir la position.

2 Sélectionnez Setup > Current Feet+Frames 

Position.

3 Saisissez une position Feet+Frames qui 
correspond au timecode indiqué dans la boîte 
de dialogue.

4 Cliquez sur OK.

Si votre point d'insertion ou votre sélection 
n'est pas aligné(e) sur une limite de grille, 
il/elle sera décalé(e) sur la limite la plus 
proche.
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Redéfinition d'une position de 
timecode
Utilisez la commande Current Time Code Position 
pour redéfinir la position de timecode actuelle 
ainsi que l'heure de début de la session. Lorsque 
vous créez un point d'insertion (ou une sélection) 
et que vous entrez la nouvelle position de timecode 
de cet emplacement, l'heure de début de la session 
est recalculé en fonction de ce nouvel 
emplacement de timecode relatif.

Pour redéfinir une position de timecode :

1 À l'aide du Sélecteur, cliquez sur une piste 
(ou créez une sélection) à l'endroit où vous 
souhaitez redéfinir la position.

2 Sélectionnez Setup > Current Time Code 

Position.

3 Saisissez un nouveau numéro d'image SMPTE 
correspondant au timecode indiqué dans la boîte 
de dialogue.

4 Cliquez sur OK.

Affichage de l'heure en images 
SMPTE
Dans Pro Tools, vous pouvez définir le timecode 
(SMPTE) comme unité de l'échelle temporelle 
principale. Le compteur principal utilisera alors 
cette unité. Même si Pro Tools se synchronisera 
toujours sur le timecode SMPTE entrant si l'échelle 
temporelle est en Bars|Beats, Minutes:Seconds ou 
Feet+Frames, il est généralement préférable 
d'utiliser le timecode SMPTE comme référence.

Pour définir le timecode SMPTE comme unité de 
l'échelle temporelle principale, effectuez l'une des 
opérations suivantes :

 Sélectionnez View > Rulers > Timecode.

 Cliquez sur le sélecteur du compteur principal 
de la fenêtre Edit, puis sélectionnez Timecode.

Pro Tools affiche les valeurs de timecode en fonction 
de la cadence d'images SMPTE sélectionnée.

Compteur secondaire et échelle temporelle 
secondaire

Le compteur secondaire peut afficher une échelle 
temporelle secondaire. Par exemple, si le timecode 
est défini comme unité de l'échelle temporelle 
principale avec une cadence non-drop frame 
de 29.97, et que vous souhaitez comparer l'heure 
SMPTE à celle d'une horloge murale, cliquez sur le 
sélecteur du compteur secondaire et sélectionnez 
l'unité Min:Secs comme échelle temporelle 
secondaire.

Pull up et pull down
Pro Tools prend en charge un facteur de pull up ou 
pull down maximum de 4 %, avec une marge 
supplémentaire de 0,1 %. Des fréquences différentes 
peuvent être définies pour l'audio et la vidéo d'une 
session (lorsque la vidéo a été importée ou capturée). 

Si un facteur de pull up ou pull down de 4 % 
a été défini, le pourcentage réellement appliqué 
est de 4,167 %.

Même si une SYNC HD n'est pas obligatoire pour 
utiliser les nombreuses options de pull up et pull 
down disponibles dans Pro Tools, il s'agit du seul 
type de périphérique pouvant être contrôlé à partir 
de Pro Tools capable de mémoriser et de rétablir 
automatiquement des facteurs de pull à l'ouverture 
d'une session. Les autres périphériques de 
synchronisation doivent être configurés 
manuellement.

Si votre point d'insertion ou votre sélection 
n'est pas aligné(e) sur une limite de grille, 
il/elle sera décalé(e) sur la limite la 
plus proche.
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Configuration du pull up et du 
pull down

Pour appliquer un pull up ou un pull down à de 
l'audio ou de la vidéo :

1 Sélectionnez Setup > Session.

2 Dans la section Timecode Settings de la fenêtre 
Session Setup, sélectionnez une fréquence de 
pull up ou de pull down.

Audio Rate Pull Up/Down : contrôle la fréquence 
d'échantillonnage audio. Reportez-vous à la 
section « Pull up et pull down de la fréquence 
d'échantillonnage audio » à la page 1203.

Video Rate Pull Up/Down : contrôle la cadence 
vidéo. Reportez-vous à la section « Pull up et pull 
down de la cadence vidéo » à la page 1204. 

Les choix disponibles dans ces menus dépendent 
de la cadence d'images de la session. Il est possible 
de sélectionner des valeurs différentes dans ces 
deux menus.

Les choix disponibles dans ces menus dépendent 
également des préférences et de l'option Auto 

Match Pull Factors du menu Timecode Rate. 
Reportez-vous aux sections « Préférence de pull 
up et pull down et commandes Session Setup 
étendues » à la page 1202 et « Correspondance 
automatique des facteurs de pull » à la page 1203.

Préférence de pull up et pull 
down et commandes Session 
Setup étendues
Le paramètre Audio Rate Pull Up/Down permet de 
sélectionner n'importe quel facteur de pull up ou 
pull down pour la fréquence d'échantillonnage 
audio, quelle que soit la cadence d'images de 
la session. 

De plus, si une séquence QuickTime est présente 
dans la timeline, un pull up ou down de 0,1 % peut 
être appliqué à la cadence vidéo, quelle que soit la 
cadence d'images de la session. Bien que ce type 
de workflow ne soit pas recommandé, un pull 
down était également appliqué aux clips vidéo 
QuickTime en même temps qu'à l'audio dans les 
versions antérieures de Pro Tools. Cette option est 
toujours disponible dans les version de 
Pro Tools 5.3.1 et supérieures pour maintenir la 
compatibilité des sessions antérieures. 

Les paramètres de pull up et pull down 
n'affectent pas le timecode généré par une 
SYNC HD.

Appuyez sur Ctrl+2 (Windows) ou 
Commande+2 (Mac) pour ouvrir la 
fenêtre Session Setup.

Fenêtre Session Setup 

Les facteurs de pull de 4 % ne pas 
disponibles dans les sessions en 176,4 et 
192 kHz.
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Correspondance automatique 
des facteurs de pull
Le menu Timecode Rate de la fenêtre Session 
Setup propose une option Auto Match Pull Factors. 
Lorsque l'option Auto Match Pull Factors est 
activée, Pro Tools ajuste les fréquences de lecture 
audio et vidéo pour suivre les modifications de la 
fréquence de timecode de la session. 

La correspondance automatique des facteurs de 
pull est appliquée en fonction du paramètre de pull 
up actuel. Dans ce mode, si le facteur de pull vidéo 
se situe au-delà de la plage de valeurs prises en 
charge, suite à une modification trop importante de 
la cadence d'images de la session, aucune 
modification n'est alors appliquée. 

Ce paramètre reste verrouillé après avoir été 
sélectionné, n'est pas activé par défaut et son état 
est stocké avec la session.

Exemple d'utilisation de la 
correspondance automatique 
des facteurs de pull
L'option Auto Match Pull Factors lie les facteurs de 
pull audio et vidéo lorsque la cadence d'images de 
la session est modifiée. 

Prenons l'exemple d'une session Pro Tools dont la 
cadence d'images est configurée sur 25 i/s, aucun 
pull n'est appliqué à l'audio et à la vidéo, et l'option 
Auto Match Pull Factors est activée. 

Si vous modifiez la cadence d'images de la session 
en 24 i/s, les paramètres de pull audio et vidéo 
prennent alors la valeur -4,0 % (facteur de pull 
approprié suite à la modification de la cadence 
d'images). 

La correspondance automatique des facteurs de 
pull est appliquée aux paramètres Audio Rate Pull 
Up/Down et Video Rate Pull Up/Down déjà 
sélectionnés. 

Par exemple, si un pull down de -0,1 % était déjà 
appliqué à l'audio et que la cadence d'images 
de la session a été modifiée de 29.97 à 24 i/s, 
le paramètre Audio Rate Pull Up/Down prend 
alors la valeur None. 

Pull up et pull down de la 
fréquence d'échantillonnage 
audio
Le paramètre Audio Rate Pull Up/Down applique 
un facteur de pull up ou pull down en lecture ou en 
enregistrement audio. Toutes les valeurs de pull 
sont disponibles, quelle que soit la cadence 
d'images de la session. 

Reportez-vous également à la section 
« Correspondance automatique des facteurs 
de pull » à la page 1203.
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Fréquences audio et options de pull up/pull down
Le tableau suivant répertorie les fréquences d’échantillonnage obtenues avec chaque option et 
combinaison de facteurs de pull up et pull down (arrondies au Hz entier le plus proche).

Pull up et pull down de la 
cadence vidéo
Le paramètre Video Pull Up/Down permet de 
modifier la cadence d'images pour la lecture vidéo, 
indépendamment du facteur de pull up ou pull 
down audio.

Les choix disponibles dans le menu Video Rate 

Pull Up/Down dépendent du format de fichier et de 
la cadence d'images de la vidéo. Les valeurs de 
pull up/pull down vidéo sont enregistrées avec 
la session. 

Conséquences d'un pull up 
ou d'un pull down
Cette section décrit l'impact des facteurs de pull up 
et de pull down sur les éléments de Pro Tools 
concernés.

Pull up et pull down vidéo et 
règle de timecode
Un pull up ou pull down vidéo n'affecte pas la 
règle de timecode. Prenez soin de définir une 
cadence d'images pour votre session 
correspondant à celle de votre projet. Si par 
exemple vous travaillez avec de la vidéo en 24 i/s 
avec un pull up vidéo de 4 %, définissez la cadence 
d'images de la session sur 25 i/s pour que la règle 
de timecode reste alignée. De même, si vous 
travaillez avec de la vidéo en 30 i/s avec un pull 
down vidéo de 0,1 %, définissez la cadence 
d'images de la session sur 23.976 i/s.

Fréquences d'échantillonnage en fonction des paramètres de pull up/pull down

Pull up/down 
Fréquence d'échantillonnage

44 100 48 000 88 200 96 000 176 400 192 000

+4,1667 % et +0,1 % 45 983 50 050 91 967 100 100 n/d n/d

+4,1667 % 45 938 50 000 91 875 100 000 n/d n/d

+4,1667 % et -0,1 % 45 892 49 950 91 783 99 900 n/d n/d

+0,1 % 44 144 48 048 88 288 96 096 176 576 192 192

-0,1 % 44 056 47 952 88 112 95 904 176 224 191 808

-4,0 % et +0,1 % 42 378 46 126 84 757 92 252 n/d n/d

-4,0 % 42 336 46 080 84 672 92 160 n/d n/d

-4,0 % et -0,1 % 42 294 46 034 84 587 92 068 n/d n/d

Reportez-vous également à la section 
« Correspondance automatique des facteurs 
de pull » à la page 1203.
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Lorsque vous travaillez avec un média Avid en 
25 i/s avec un pull down vidéo de 4 %, définissez 
la cadence d'images de la session sur 24 i/s.

Plug-ins et pull up/pull down
Pour un fonctionnement correct avec les facteurs 
de pull les plus importants (4 %), les plug-ins 
doivent utiliser une horloge basée sur les 
échantillons et non des valeurs temporelles 
absolues. Tous les plug-ins audio Pro Tools se 
réfèrent à une horloge basée sur les échantillons. 

Fréquences d'échantillonnage 
élevées et facteurs de pull
Les facteurs de pull audio de 4 % ne sont pas 
disponibles dans les sessions en 176,4 et 192 kHz.

Activation du mode Online de 
Pro Tools
Pour déclencher la lecture ou l'enregistrement 
depuis une source externe, le transport de 
Pro Tools doit être en mode Online. Vous indiquez 
ainsi à Pro Tools qu'il doit suivre le timecode 
entrant. 

Pour passer le transport de Pro Tools en mode 
Online, effectuez l'une des opérations suivantes :

 Sélectionnez Options > Transport Online. 

 Dans la fenêtre de transport, cliquez sur le 
bouton Online. 

Le bouton Online clignote et Pro Tools attend 
une image SMPTE pour déclencher la lecture. 
Dès réception d'un timecode, la lecture se lance 
et le bouton Online s'allume. Les témoins de 
sélection d'édition de la fenêtre Edit ainsi que le 
champ Incoming Time de la fenêtre Session Setup 
affichent le timecode entrant. 

Pour passer Pro Tools en mode Offline, effectuez 
l'une des opérations suivantes :

 Désélectionnez Options > Transport Online.

 Désactivez le bouton Online de la fenêtre de 
transport.

Enregistrement online
La page des préférences de fonctionnement 
contient deux options qui déterminent la façon 
dont Pro Tools doit lancer l'enregistrement en 
mode Online.

Record Online at Time Code (or ADAT) Lock : 
l'enregistrement online débute dès que Pro Tools 
reçoit un timecode ou un signal de synchro ADAT 
et se synchronise sur celui-ci. Dans ce cas, il n'est 
pas nécessaire de placer un point d'insertion, ni 
d'effectuer une sélection sur une piste pour définir 
un point d'entrée.

Record Online at Insertion/Selection : avec cette 
option, l'enregistrement online commence 
à l'emplacement du point d'insertion sur une piste. 
L'enregistrement se poursuit jusqu'à ce que 
Pro Tools ne reçoive plus de timecode. Si vous 
effectuez une sélection de timeline, Pro Tools 
enregistre en mode Online uniquement sur la durée 
de la sélection. 

Appuyez sur Ctrl+J (Windows) ou 
Commande+J (Mac) pour passer le 
transport en mode Online. 

Activation du bouton Online de la fenêtre de transport. 
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Génération de timecode
Lorsqu'une SYNC HD est connectée, Pro Tools 
peut générer du timecode MIDI (MTC) et SMPTE. 
Sans SYNC HD, Pro Tools peut uniquement 
générer du MTC. Pro Tools peut ainsi fonctionner 
en tant que source de synchronisation maître avec 
d'autres périphériques esclaves.

Pour générer du timecode MIDI à partir de 
Pro Tools :

1 Sélectionnez Setup > Peripherals et cliquez sur 
l'onglet Synchronization.

2 À partir du paramètre MTC Generator Port, 
sélectionnez le port de sortie MIDI à utiliser 
pour la transmission du timecode MIDI (MTC).

3 À partir du menu de la fenêtre de transport 
(ou de la fenêtre Edit), sélectionnez 
Synchronization.

4 Cliquez sur le bouton Gen MTC pour le mettre 
en surbrillance.

5 Lancez la lecture.

Pour générer du timecode à l'aide d'une SYNC HD :

1 Connectez le connecteur LTC Out de la 
SYNC HD au connecteur d'entrée SMPTE des 
périphériques esclaves. Si un périphérique 
esclave reconnaît le MTC, reliez le connecteur 
MTC OUT de la SYNC HD au connecteur 
d'entrée MIDI du périphérique esclave. 

2 Assurez-vous que la SYNC HD est sous 
tension.

3 Dans Pro Tools, sélectionnez Setup > 

Peripherals et cliquez sur l'onglet 
Synchronization.

4 Dans la section Synchronization Device de la 
page Synchronization, sélectionnez Enable 

SYNC Peripheral.

5 Cliquez sur OK pour fermer la boîte de dialogue 
Peripherals.

6 Sélectionnez Setup > Session, puis 
sélectionnez la cadence d'images correspondant 
au paramètre Timecode Rate.

7 Dans la section SYNC Setup de la fenêtre Session 
Setup, sélectionnez une référence d'horloge 
à partir du sélecteur Clock Reference. Les choix 
d'horloge disponibles dépendent de la fréquence 
d'échantillonnage. Reportez-vous à la section 
« External Clock Sources : » à la page 1194.

8 À partir du menu de la fenêtre de transport 
(ou de la fenêtre Edit), sélectionnez 
Synchronization.

9 Sélectionnez l'une des commandes suivantes :

• Gen MTC pour générer un timecode 
MIDI (MTC).

Sélection d'un port pour la génération du MTC

Fenêtre de transport, Gen MTC activé
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• Gen LTC pour générer un timecode 
longitudinal (LTC).

10 Lancez la lecture.

Pro Tools génère et envoie un timecode à partir de 
la SYNC HD.

Restrictions relatives à une 
SYNC HD verrouillée sur une 
entrée ou une référence vidéo
Une SYNC HD peut générer un timecode à 
n'importe quelle cadence d'images lorsqu'elle est 
verrouillé sur une référence ou une entrée vidéo, 
quelle que soit la cadence d'images du signal de 
référence vidéo entrant. Toutefois, si vous 
choisissez de générer un timecode en utilisant une 
cadence d'images qui ne correspond pas à celle du 
signal vidéo, les bords d'images dans la session 
Pro Tools (ainsi que les bords d'images du 
timecode généré) ne seront pas alignés avec les 
bords d'images de la vidéo.

Utilisation du MIDI Machine 
Control
Pro Tools est capable de transmettre des 
informations de positionnement à des 
périphériques externes et de contrôler leur 
transport à l'aide de messages MIDI Machine 
Control (MMC). 

Contrôle de périphériques 
externes à l'aide du MMC
Tout périphérique prenant en charge le MMC peut 
être contrôlé directement à partir de Pro Tools, 
et ce quel que soit le maître, le périphérique ou 
Pro Tools.

Les périphériques externes pris en charge par 
Pro Tools implémentent uniquement les 
communications en « boucle ouverte ». De ce fait, 
lorsque Pro Tools est utilisé en tant que transport 
maître, toute opération de transport initiée 
directement à partir du périphérique externe ne 
sera pas communiquée à Pro Tools. En revanche, 
vous pouvez sélectionner le périphérique externe 
(MMC) dans le menu de la fenêtre de transport et 
utiliser les commandes de transport de Pro Tools 
pour piloter le périphérique. 

Pro Tools ne prend pas en charge l'armement 
à distance des pistes des périphériques externes 
contrôlés via MMC. Vous devez armer les pistes 
manuellement pour réaliser un enregistrement sur 
le périphérique externe. 

Fenêtre de transport avec options de synchronisation

Appuyez sur Ctrl+Démarrer+J 
(Windows) ou Commande+Ctrl+J 
(Mac) pour activer (ou désactiver) 
la génération de LTC (GEN LTC).

Si vous modifiez les fréquences de timecode 
en cours de session, la plupart des 
convertisseurs SMPTE vers MTC devront 
être éteints puis rallumés afin de reconnaître 
la nouvelle cadence d'images.

L'option MachineControl prend en charge 
l'armement à distance des pistes de 
périphériques compatibles avec les 
protocoles Sony 9 broches et V-LAN. 
Reportez-vous à la section « Armement des 
pistes à distance » à la page 1211.
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Activation du MIDI Machine 
Control dans Pro Tools

Pro Tools en tant que MMC 
maître
Lorsque Pro Tools est utilisé comme maître, 
il envoie des commandes MMC au périphérique 
esclave qui lui renvoie à son tour des informations 
MTC.

Pour asservir un périphérique externe à Pro Tools 
à l'aide du MIDI Machine Control :

1 Connectez un port de sortie MIDI de votre 
interface MIDI Pro Tools à un port approprié du 
périphérique esclave.

2 Connectez la sortie MTC du périphérique 
esclave à un port d'entrée MIDI de votre 
interface MIDI Pro Tools.

3 Dans Pro Tools, sélectionnez Setup > 

Peripherals et cliquez sur l'onglet 
Synchronization.

4 Désactivez l'option Enable SYNC HD si elle est 
sélectionnée.

5 À partir du menu MTC Reader Port, sélectionnez 
le port d'entrée MIDI auquel le périphérique 
esclave est connecté (la source d'informations 
MTC provenant du périphérique esclave). 

6 Cliquez sur l'onglet Machine Control dans la 
boîte de dialogue Peripherals.

7 Dans la section MIDI Machine Control 
(Master), sélectionnez Enable.

8 Dans la section MIDI Machine Control 
(Master), sélectionnez le port de sortie MIDI 
auquel le périphérique esclave est connecté.

9 Définissez le numéro d'ID MMC vers lequel ces 
informations seront envoyées. 

Les commandes MMC contiennent un numéro 
d'ID pour identifier le périphérique vers lequel 
elles doivent être envoyées. Il existe 128 numéros 
d'ID MMC, de 0 à 127. Le numéro d'ID par 
défaut 127 est un paramètre spécial qui transmet 
les commandes vers la totalité des 128 ID MMC. 
Lorsque vous sélectionnez le numéro 127, 
Pro Tools transmet les commandes MMC à tous 
les ID MMC. 

10 Définissez une durée de pré-roll pour le 
périphérique esclave MMC. Le pré-roll permet 
au périphérique de disposer de suffisamment 
de temps pour se verrouiller sur le timecode 
transmis par Pro Tools. Cette durée est variable 
selon le périphérique externe. Si la durée de pré-
roll est insuffisante, le périphérique peut ne pas 
avoir le temps de se synchroniser avant que la 
position de timecode souhaitée ne soit atteinte.

11 Cliquez sur OK pour fermer la boîte de dialogue 
Peripherals.

Sélection du port de sortie MIDI pour le MMC
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12 Dans la fenêtre de transport de Pro Tools, 
effectuez un clic droit sur le bouton Online et 
sélectionnez Transport > MMC.

Pro Tools peut alors contrôler le transport du 
périphérique sélectionné et agir en tant qu'horloge 
maître.

13 Afin que le transport de Pro Tools poursuive la 
position de lecture du périphérique esclave, 
cliquez sur le bouton Online de la fenêtre de 
transport (il doit être allumé en bleu).

Pro Tools en tant qu'esclave 
MMC
Lorsque Pro Tools est asservi, il reçoit des 
commandes MMC du périphérique maître et 
renvoie des informations MTC.

Pour asservir Pro Tools à un périphérique externe 
à l'aide du MIDI Machine Control :

1 Connectez un port d'entrée MIDI de votre 
interface MIDI Pro Tools à un port approprié du 
périphérique maître.

2 Connectez un port de sortie MIDI de votre 
interface MIDI Pro Tools au port d'entrée MTC 
du périphérique maître.

3 Dans Pro Tools, sélectionnez Setup > Session.

4 Dans la section Time Code Settings de la fenêtre 
Session Setup, sélectionnez Using MTC. 

5 Sélectionnez Setup > Peripherals et cliquez sur 
l'onglet Synchronization. 

6 Désactivez l'option Enable SYNC HD si elle est 
sélectionnée.

7 À partir du menu MTC Generator Port, 
sélectionnez le port de sortie MIDI auquel le 
périphérique maître est connecté (la destination 
des informations MTC provenant de Pro Tools). 

8 Cliquez sur l'onglet Machine Control dans la 
boîte de dialogue Peripherals.

9 Dans la section MIDI Machine Control (Slave), 
sélectionnez Enable.

10 Configurez dans le champ ID le numéro d'ID 
MMC (canal) sur lequel ces informations seront 
reçues. 

11 Cliquez sur OK pour fermer la boîte de dialogue 
Peripherals.

Pro Tools répond alors aux commandes MMC du 
périphérique externe.

Sélection de l'option Transport > MMC. 

Afin que Pro Tools puisse recevoir des 
commandes MMC, la source MMC doit être 
activée dans la boîte de dialogue MIDI 
Input Enable. Pour plus d'informations, 
reportez-vous à la section « Activation de 
périphériques d'entrée » à la page 482.

Page Machine Control de la boîte de dialogue 
Peripherals, option MIDI Machine Control Remote 
sélectionnée
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Contrôle des périphériques MMC 
avec la fenêtre de transport de 
Pro Tools 
Vous pouvez utiliser la fenêtre de transport de 
Pro Tools pour contrôler à distance tous les 
périphériques activés (comme par exemple, 
un magnétoscope vidéo non linéaire). Pour cela, 
vous devez configurer les périphériques activés afin 
qu'ils écoutent l'adresse saisie pour le MMC. 
La fenêtre de transport contrôle alors le transport de 
Pro Tools et celui de tous les périphériques asservis. 

Pour contrôler des périphériques externes à partir 
de la fenêtre de transport de Pro Tools :

 Effectuez un clic droit sur le bouton Online de la 
fenêtre de transport et sélectionnez Pro Tools ou 
MMC. L'élément sélectionné agira en tant que 
transport maître.

• Lorsque le transport maître est Pro Tools, 
la position de lecture est contrôlée par le curseur 
de Pro Tools. 

• Lorsque le transport maître est MMC, la position 
de lecture est contrôlée par celle du périphérique 
externe. 

Paramètres de transport 
MMC
Lorsque vous utilisez le MMC, vous pouvez 
configurer les options suivantes pour définir le 
comportement du transport d'un périphérique dans 
la page Synchronization Preferences.

Machine Chases Memory Location : lorsque cette 
option est sélectionnée, la navigation vers un 
emplacement spécifique d'une session à l'aide d'un 
emplacement mémoire entraîne le calage d'un 
transport connecté sur cet emplacement. 

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, la navigation vers un 
emplacement spécifique d'une session en 
déplaçant le point de sélection ou réalisant un 
scrubbing sur une piste entraîne le calage d'un 
transport connecté sur cet emplacement.

Passage d'un périphérique en 
mode Offline
Utilisez le menu Online du sélecteur de transport 
maître pour passer un périphérique MIDI (ou une 
machine) en mode Offline.

Pour passer un périphérique en mode Offline :

1 Cliquez sur le sélecteur de transport maître.

2 Dans la fenêtre de transport, cliquez sur le menu 
Online et désélectionnez le périphérique (MIDI 
ou machine). Les choix proposés varient en 
fonction du transport maître actuel et des 
périphériques configurés dans Pro Tools.

Sélection du transport maître

Désactivation de l'option Online > MMC
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Pour repasser un périphérique en mode Online, 
il suffit de le resélectionner dans le menu Online.

Configuration d'un délai de 
synchro minimal
Le délai de synchronisation correspond à la durée 
initiale nécessaire afin que les périphériques de votre 
système se synchronisent entre eux. Cette durée est 
différente pour chaque périphérique. Pour configurer 
le délai de synchronisation dans Pro Tools, saisissez 
une valeur dans le champ Minimum Sync Delay des 
préférences de synchronisation. La valeur minimale 
disponible est de 15 images. Déterminez la valeur 
minimale de délai de synchronisation pour votre 
système, puis saisissez cette valeur dans la zone 
Minimum Sync Delay. Sur les systèmes avec 
MachineControl, le fait d'activer le paramètre Use 
Serial Time Code dans la fenêtre Session Setup 
accélère considérablement la synchronisation. 
La SYNC HD et les périphériques externes doivent 
être verrouillés sur une référence vidéo externe pour 
utiliser le timecode série.

Pour définir un délai de synchronisation minimal :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Synchronization. 

2 Saisissez un nombre d'images dans le champ 
Minimum Sync Delay. 

3 Cliquez sur OK pour fermer la boîte de dialogue 
Preferences. 

Configuration d'un délai de synchro minimal 
pour les périphériques MMC externes 
verrouillés sur une référence externe

Lorsque vous contrôlez un périphérique verrouillé 
sur une synchro externe via MMC, le périphérique 
se verrouille tout d'abord sur l'emplacement MMC, 
puis aligne les trames couleur. Pour un code de 
synchro externe, 4 images permettent d'assurer la 
synchronisation des trames couleur. Si le temps de 
synchronisation minimal est inférieur à la durée 
requise par le périphérique MMC pour atteindre 
l'emplacement requis puis synchroniser les trames 
couleur, la lecture commencera avant que le 
périphérique n'ait aligné les trames couleur. Dans 
ce scénario, la valeur de l'option Minimum Sync 

Delay doit être supérieure à la durée requise pour la 
synchronisation des trames couleur. Le problème 
ne se pose pas avec une SYNC HD, qui ne se 
verrouillera pas tant que la synchronisation des 
trames couleur n'est pas établie. 

Armement des pistes à 
distance
L'option MachineControl pour Pro Tools permet 
d'armer des pistes à distance sur des magnétoscopes 
9 broches (ou V-LAN pour le transport uniquement) 
pris en charge. Sans MachineControl, Pro Tools ne 
prend pas en charge l'armement des pistes à distance 
sur les périphériques externes. En plus d'offrir la 
possibilité d'armer les pistes à distance à partir 
de Pro Tools, MachineControl permet d'utiliser 
Pro Tools comme maître ou esclave avec les 
périphériques externes compatibles avec le 
protocole Sony 9 broches (ou V-LAN pour le 
transport uniquement).

Le menu Online affiche uniquement les 
périphériques correctement configurés dans 
Pro Tools.

Pour configurer des périphériques MIDI, 
reportez-vous à la section « Activation du 
MIDI Machine Control dans Pro Tools » 
à la page 1208.

Pour configurer des périphériques machine, 
reportez-vous au Guide MachineControl.

Sélectionnez Setup > Machine Track Arming 
Profiles pour configurer votre système, puis 
Window > Machine Track Arming pour 
afficher la fenêtre Machine Track Arming.
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Placement de clips sur des 
emplacements SMPTE 
d'images
Le spotting (placement) consiste à assigner de la 
musique ou un son à des emplacements SMPTE 
d'images spécifiques d'un film ou d'une vidéo. 
Cette procédure permet de positionner :

• Des clips entiers sélectionnés avec l'outil de 
saisie du temps. Plusieurs clips peuvent 
également être sélectionnés ; dans ce cas, 
Pro Tools prendra en compte la position du 
premier clip de votre sélection en tant que 
référence.

• Un emplacement spécifique à l'intérieur d'un 
clip, en cliquant avec le Sélecteur sur ce point, 
puis en sélectionnant Clip > Identify Sync Point. 

• Des sessions ou des pistes, en les faisant glisser 
à partir d'un navigateur jusqu'à la timeline ou la 
liste des clips de la session. 

Mode Spot
En mode Spot, un clip d'une piste peut rapidement 
être placé en cliquant dessus avec l'outil de saisie 
du temps. 

Vous pouvez également faire glisser un clip d'un 
navigateur de l'espace de travail ou de la liste des 
clips vers une piste en mode Spot. 

Boîte de dialogue Spot
La boîte de dialogue Spot s'affiche lorsque vous 
faites glisser un clip vers une piste ou cliquez sur 
un clip avec l'outil de saisie du temps en mode 
Spot. Les champs numériques affichent les 
données correspondantes des clips actuellement 
sélectionnés. Ces valeurs peuvent être modifiées. 

Selon le format d'échelle temporelle sélectionné, 
les informations de ces champs sont exprimées 
en timecode SMPTE, Minutes:Seconds, 
Feet+Frames, échantillons ou Bars|Beats.

Le champ activé pour la saisie de données 
numériques apparaît en surbrillance. Saisir une 
valeur dans un champ déplace un élément 
sélectionné vers l'emplacement temporel spécifié. 
Les champs Start, Sync Point et End sont 
accessibles lorsque l'outil de saisie du temps est 
activé. Seuls les champs Start ou End (selon 
l'endroit où vous cliquez) et Duration sont 
accessibles lorsque l'un des outils de trim est actif 
(reportez-vous à la section « Utilisation des outils 
de trim en mode Spot » à la page 1215).

Appuyez sur Ctrl+Alt+Démarrer+J 
(Windows) ou Commande+Option+Ctrl+J 
(Mac) pour activer (ou désactiver) le mode 
distant. Si vous utilisez une surface de travail 
D-Command ou D-Control, appuyez sur le 
bouton 9-pin Remote.

Pour plus d'informations sur l'armement de 
pistes à distance avec MachineControl, 
reportez-vous au Guide MachineControl.

Boîte de dialogue Spot
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Option Use Subframes
Une sous-image (subframe) correspond à 1/100ème 
d'image. L'option Use Subframes permet d'utiliser 
ces unités plus petites pour une plus grande 
précision. Cette commande ajoute un champ 
temporel supplémentaire aux valeurs SMPTE 
en heures:minutes:secondes:images, à l'extrémité 
droite des champs temporels lorsqu'ils sont activés. 
Utilisez un point (.) pour séparer les valeurs d'image 
entière et de sous-image.

Capture du timecode
Pro Tools permet également de capturer 
facilement des emplacements d'images « à la 
volée » via la boîte de dialogue Spot en appuyant 
sur la touche Égal (=) ou en cliquant sur le bouton 
Current Timecode si Pro Tools reçoit un timecode 
valide. Avec du VITC, il est possible de capturer 
avec précision un emplacement SMPTE provenant 
d'un magnétoscope en pause ou au ralenti.

Lorsque l'échelle temporelle est définie sur 
Timecode, appuyez sur la touche Égal (=) pour 
capturer le timecode entrant. Si elle est définie sur 
Bars|Beats, appuyez sur la touche Égal (=) pour 
capturer l'emplacement aligné sur la mesure la plus 
proche.

Bien que la capture de timecode fonctionne avec 
du timecode linéaire (LTC) ou VITC en cours de 
lecture, l'emplacement d'une image en pause ne 
peut être capturé qu'avec du VITC. 

Une SYNC HD peut lire le VITC. Le timecode 
série est également pris en charge avec 
MachineControl et une SYNC HD.

Pour augmenter ou réduire les valeurs 
SMPTE d'un nombre d'images spécifique 
dans la boîte de dialogue Spot, appuyez sur 
la touche Plus (+) ou Moins (-) du pavé 
numérique, entrez un nombre, puis appuyez 
sur Entrée.

Affichage d'un champ temporel supplémentaire 
lorsque l'option Use Subframes est activée 

Les sous-images n'apparaissent pas dans le 
champ du timecode actuel.

Pour utiliser le mode distant avec 
MachineControl, vous devez disposer d'un 
port série qualifié. Pour consulter une liste 
complète des ports actuellement qualifiés, 
rendez-vous sur www.avid.com.
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Pour placer un clip sur une image SMPTE 
spécifique :

1 Activez le mode Spot.

2 Définissez l'échelle temporelle principale sur 
Timecode. Reportez-vous à la section 
« Définition de l'heure de début SMPTE d'une 
session (image de début) » à la page 1199.

3 Identifiez l'emplacement SMPTE de l'image à 
partir de laquelle vous souhaitez déclencher la 
lecture de votre clip en mettant votre 
magnétoscope vidéo en pause sur cette image. 

4 À l'aide de l'outil de saisie du temps, cliquez sur 
un clip d'une piste ou dans la liste des clips, puis 
faites-le glisser vers une piste. La boîte de 
dialogue Spot apparaît.

5 Saisissez l'emplacement SMPTE en utilisant 
l'une des méthodes suivantes : 

• Si vous utilisez du VITC, appuyez sur la touche 
Égal (=) du pavé numérique ou cliquez sur 
Current Timecode pour saisir l'emplacement 
SMPTE actuel d'un magnétoscope en pause.

• Si vous utilisez du LTC, avec l'échelle 
temporelle définie sur Timecode, appuyez sur la 
touche Égal (=) du pavé numérique pour 
capturer la valeur de timecode entrant. Lorsque 
l'échelle temporelle est définie sur Bars|Beats, 
appuyez sur la touche Égal (=) pour capturer 
l'emplacement aligné sur la mesure la plus 
proche.

6 Si le clip a été enregistré en mode Online, vous 
pouvez cliquer sur le bouton Original Time 

Stamp pour rappeler et saisir l'emplacement 
SMPTE de l'image à partir de laquelle le clip 
a été initialement enregistré. Vous pouvez 
également accéder à un marqueur temporel 
défini par l'utilisateur en cliquant sur le bouton 
User Time Stamp. Pour plus d'informations, 
reportez-vous à la section « Marquage 
temporel » à la page 1215.

7 Cliquez sur OK pour fermer la boîte de 
dialogue. Le clip est placé à l’emplacement 
SMPTE de l'image choisie. Lorsque la session 
est en mode Online, ce numéro d'image 
déclenche la lecture du clip.

Placement automatique de 
clips
L'option Auto-Spot Clips de Pro Tools simplifie 
davantage le placement des clips. Si vous utilisez 
du VITC avec cette option activée, ou le logiciel 
MachineControl, vous pouvez mettre la vidéo en 
pause à l'emplacement SMPTE de l'image de votre 
choix, puis cliquer sur un clip avec l'outil de saisie 
du temps : il sera alors automatiquement placé 
à l'emplacement de timecode actuel. 

Le placement automatique peut également être 
assuré grâce à la prise en charge du timecode série 
avec MachineControl : activez MachineControl 
ainsi que le timecode série sur le périphérique. 

Pour placer un clip automatiquement :

1 Sélectionnez Options > Auto-Spot Clips.

2 Si vous utilisez du VITC, identifiez 
l'emplacement SMPTE de l'image à laquelle 
vous souhaitez déclencher la lecture de votre 
clip en mettant la vidéo en pause sur cette 
image.

3 Cliquez sur le clip à l'aide de l'outil de saisie du 
temps. Le clip sera alors automatiquement placé 
à l'emplacement de timecode actuel (ou à celui 
de la machine).

En cliquant sur un clip avec un outil de trim, 
vous appliquez un trim jusqu'à l'emplacement 
de timecode actuel.



Chapitre 50 : Utilisation de la synchronisation 1215

Utilisation des outils de trim 
en mode Spot
Vous pouvez utiliser la boîte de dialogue Spot pour 
effectuer un trimming sur des clips et modifier 
leurs heures de début et de fin ainsi que leur durée, 
et donc les adresses de timecode entrant 
référencées. Si vous cliquez sur un clip en mode 
Spot avec l'un des outils de trim, la boîte de 
dialogue Spot apparaît. Vous pouvez alors saisir 
une valeur dans les champs Start, End et Duration 
afin de spécifier le point exact de trim du début ou 
de la fin du clip. Utilisez cette méthode pour 
modifier la durée d'un clip afin qu'il soit aligné sur 
un point de repère visuel particulier. 

Le trimming d'un clip contenant un point de 
synchronisation (reportez-vous à la section 
« Identification d’un point de synchronisation » 
à la page 1216) n'affecte pas l'emplacement 
SMPTE de ce point, sauf si le trimming s'étend au-
delà du point de synchronisation.

Marquage temporel
Pro Tools affecte un marqueur temporel à chaque 
clip enregistré en mode Online en utilisant le 
timecode SMPTE d'origine auquel l'audio a été 
enregistré. Pour rappeler ce timecode SMPTE 
d'origine pour un clip, cliquez sur le bouton 
Original Time Stamp de la boîte de dialogue Spot.

Vous pouvez également placer un clip sur un autre 
marqueur temporel SMPTE défini par l'utilisateur, 
à l'aide de la commande Time Stamp du menu de la 
liste des clips. Une fois qu'un marqueur temporel 
a été ajouté à l'aide de cette commande, vous 
pouvez cliquer sur le bouton User Time Stamp 
pour replacer un clip sur l'emplacement SMPTE 
défini par l'utilisateur.

Affichage du timecode d'origine 
des clips
Cette commande affiche l'heure SMPTE d'origine 
de tous les clips présents sur les pistes, d'après leur 
marqueur temporel. Ce numéro d'image SMPTE 
représente l'heure de l'enregistrement online 
d'origine du clip dans Pro Tools et ne reflète pas 
nécessairement l'emplacement SMPTE actuel du 
clip sur une piste.

Pour afficher (ou masquer) le marqueur temporel 
d'origine des clips :

 Sélectionnez (ou désélectionnez) View > Clip > 

Original Time Stamp.

Création d'un marqueur 
temporel utilisateur 
Pour créer un marqueur temporel SMPTE distinct 
défini par l'utilisateur, utilisez la commande Time 

Stamp du menu de la liste des clips. Cette commande 
permet de sélectionner un ou plusieurs clips 
pour redéfinir leur marqueur temporel SMPTE. Le 
marqueur temporel d'origine et le marqueur temporel 
utilisateur sont alors enregistrés avec la session.

Lorsque l'audio est enregistré, les marqueurs 
temporels d'origine et utilisateur sont insérés au 
même emplacement. Il est possible de modifier 
celui du marqueur temporel utilisateur à tout 
moment à l'aide de la commande Time Stamp. 
Cette fonctionnalité est particulièrement utile en 
post-production, lorsque le timecode SMPTE des 
copies de travail vidéo subit de nombreuses 
modifications d'une version du montage à l'autre.

Les clips sont placés automatiquement en 
fonction de leur heure de début, à moins que 
vous n’ayez inséré un point de 
synchronisation (reportez-vous à la section 
« Identification d’un point de 
synchronisation » à la page 1216). Si le clip 
contient un point de synchronisation, il est 
placé en fonction de ce point de référence. 
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Pour affecter un marqueur temporel à un ou 
plusieurs clips sur un nouveau numéro d'image 
SMPTE :

1 Sur une piste, sélectionnez le clip sur lequel 
vous souhaitez affecter le marqueur temporel.

2 Dans le menu de la liste des clips, sélectionnez 
la commande Time Stamp.

3 Entrez une nouvelle heure SMPTE en 
effectuant l'une des opérations suivantes : 

• Entrez les valeurs manuellement (à l'aide des 
flèches de direction). 

• Cliquez sur le bouton Current Time Code ou 
appuyez sur la touche Égal (=) si vous souhaitez 
capturer l'adresse du timecode entrant.

• Cliquez sur le bouton Current Selection si vous 
souhaitez saisir l'heure de début de la sélection 
actuelle.

4 Cliquez sur OK.

Cette commande peut être utilisée pour un 
traitement par lot afin de définir de nouveaux 
marqueurs temporels pour plusieurs clips 
simultanément. Pour cela, il suffit de sélectionner 
plusieurs clips et de choisir la commande Time 

Stamp. Des boîtes de dialogue s'ouvriront 
successivement pour chaque clip. Utilisez-les pour 
saisir rapidement les nouvelles valeurs.

Une fois définis, les marqueurs temporels 
utilisateur peuvent être affichés sur tous les clips 
présents sur des pistes. 

Pour afficher (ou masquer) le marqueur temporel 
utilisateur des clips :

 Sélectionnez (ou désélectionnez) View > Clip > 

User Time Stamp.

Identification d’un point de 
synchronisation
La commande Identify Sync Point de Pro Tools 
permet d'identifier un point particulier d'un clip 
pour le placement de l'audio. 

Prenez l'exemple du scénario de placement d'effets 
sonores suivant : votre seul effet sonore est 
constitué d'un grincement de porte suivi d'un 
claquement, avec quelques secondes de 
réverbération d'ambiance. La partie 
« claquement » de l'effet, qui doit être positionnée 
exactement sur l'image correspondante, ne se 
produit pas au tout début du fichier audio, ni à la 
fin. Elle se trouve vers le milieu du fichier, ce qui 
complique son positionnement. Dans ce scénario, 
utilisez la commande Identify Sync Point pour 
créer un point dans le clip, puis synchroniser ce 
point avec une image SMPTE. 

Boîte de dialogue User Time Stamp

Pour plus d'informations sur les points de 
synchronisation, reportez-vous à la section 
« Points de synchronisation » à la page 863.
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Pour créer un point de synchronisation dans un clip :

1 Effectuez l'une des opérations suivantes :

• Cliquez avec le Sélecteur sur le point du clip 
à synchroniser avec un emplacement SMPTE 
d'image spécifique. 

• Appuyez sur la touche Flèche bas en cours de 
lecture. 

2 Sélectionnez Clip > Identify Sync Point. L'heure 
SMPTE actuelle est automatiquement entrée en 
tant qu'emplacement SMPTE du point de 
synchronisation. Une petite flèche orientée vers 
le bas s'affiche en bas du clip, avec une fine 
ligne grise verticale, pour indiquer 
l'emplacement du point de synchronisation.

Résolution des problèmes de 
synchronisation SMPTE
Si vous rencontrez des difficultés pour obtenir une 
synchronisation SMPTE correcte, vous pouvez 
suivre les procédures ci-après pour résoudre 
certains problèmes. 

Impression du timecode SMPTE 
avant l'enregistrement
Un timecode SMPTE doit être imprimé sur toutes 
les bandes (audio et vidéo) utilisées avec votre 
système avant d'y enregistrer de l'audio ou 
d'enregistrer dans Pro Tools. Si les bandes ne 
contiennent pas de timecode, votre système peut 
sembler fonctionner mais la synchronisation ne 
s'effectuera pas correctement. Au contraire, 
le décalage entre les machines et Pro Tools 
deviendra de plus en plus important au fil du temps.

Ce problème se manifeste également lorsque de 
l'audio est enregistré dans Pro Tools sans source 
SMPTE synchrone (si l'audio a été enregistré avant 
la session actuelle, par exemple). Il sera alors 
impossible de synchroniser précisément l'audio 
avec un magnétophone analogique ou un 
magnétoscope, puisque l'audio enregistré dans 
Pro Tools n’a pas été synchronisé avec le timecode 
SMPTE provenant du magnétophone analogique 
ou du magnétoscope.

Verrouillage de tous les 
composants de votre système
Lors de l'impression du timecode, assurez-vous que 
le générateur de timecode et le magnétoscope sont 
référencés sur un même signal de référence quartzé. 
Par exemple, lors de l'impression d'un timecode 
drop frame 29.97 i/s sur un magnétoscope, le 
générateur SMPTE et le magnétoscope doivent être 
verrouillés sur un même générateur de signal black 
burst ou de référence externe. En cours de lecture, le 
magnétoscope maître doit également être verrouillé 
sur ce signal black burst ou de référence externe.

Cette procédure assure la compatibilité de votre 
bande entre les passes d'enregistrement et de lecture, 
et lors de la lecture sur d'autres appareils, dans 
d'autres studios. Cela signifie également que lors 
de la lecture d'une bande codée, le magnétoscope 
de lecture doit utiliser la même fréquence 
de synchronisation que celle définie lors de 
l'impression du timecode sur le magnétoscope 
d'enregistrement. Lorsque vous imprimez un 
timecode à l'aide d'un transport audio, il peut tourner 
librement et sans référence ; en revanche, lors de la 
lecture, il doit être contrôlé par un synchroniseur 
verrouillé sur un signal de référence externe.

Point de synchronisation dans un clip audio
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Connaître la cadence d'images 
réelle de vos médias
Si vous recevez des médias d'une société de 
production au lieu de les enregistrer vous-même, 
la cadence d'images SMPTE utilisée doit 
impérativement être spécifiée sur la bande. 
Plusieurs formats de timecode utilisent le même 
nombre d'images (23.976 i/s et 24 i/s par exemple) 
mais fonctionnent à des cadences d'images par 
seconde légèrement différentes.

Une SYNC HD (ainsi que certains produits tiers) 
peut permettre de déterminer une cadence 
d'images.

Cadence 29.97 i/s non-drop non 
reconnue
La cadence 29.97 i/s non-drop est une version 
légèrement plus lente du timecode en 30 i/s non-
drop. Lorsque la cadence 29.97 i/s non-drop est 
utilisée pour une vidéo en couleur, chaque image 
vidéo correspond à une image SMPTE, sans avoir 
à utiliser de codage drop frame. Aucune image 
n'étant omise, les calculs horaires et de position se 
trouvent grandement simplifiés.

Certains périphériques matériels et logiciels 
ne reconnaissent pas la cadence d'images 29.97 
non-drop en tant que telle. Par exemple, 
un convertisseur standard SMPTE vers MTC ne la 
reconnaît pas explicitement. Vous devrez alors 
indiquer au convertisseur qu'il s'agit d'une cadence 
30 i/s non-drop. En réalité, un grand nombre de 
périphériques reconnaissant le format SMPTE 
fonctionnent correctement avec une cadence 29.97 
non-drop s'ils sont configurés pour recevoir une 
cadence 30 i/s non-drop.

Tout lecteur SMPTE utilisant des valeurs de 
timecode pour effectuer des calculs en temps réel 
(à l'instar de Pro Tools lorsqu'il est déclenché et 
synchronisé sur un timecode SMPTE) doit 
également être informé que la cadence d'images est 
de 29.97 i/s et non de 30 i/s. Étant donné que 
Pro Tools permet de choisir cette cadence 
d'images, cela ne pose pas de problème particulier. 
En revanche, le problème réside dans l'incapacité 
de nombreux utilisateurs à distinguer ces deux 
cadences.

Certaines sociétés de production fournissent des 
bandes de travail vidéo imprimées avec un 
timecode en 29.97 i/s, mais écrivent sur la boîte 
« 30 i/s NTSC », ce qui équivaut en réalité à du 
29.97 i/s non-drop.

Ainsi, lorsque la bande arrive en votre possession, 
vous ne connaissez pas sa cadence d'images réelle. 
Si vous envoyez un timecode 29.97 non-drop à un 
système Pro Tools configuré pour recevoir un 
timecode en 30 i/s non-drop, il en résultera un 
décalage temporel d'environ 1,8 image par minute, 
ce qui désynchronisera la lecture audio.

Utilisation d'une source 
d'horloge stable
Les fichiers médias doivent si possible être lus en 
utilisant le même signal de référence de 
synchronisation que celui avec lequel ils ont été 
enregistrés. Cette précaution garantit la meilleure 
correspondance entre les fréquences 
d'échantillonnage d'enregistrement et de lecture. 
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Correction des cadences film, vidéo NTSC et vidéo PAL

Cadences d'images, transferts télécinéma et cadences de lecture relatives

 

 

 

plus rapide

plus lent

25 i/s

x104,1667 % plus 
rapide (pull up de 4 %)

x96,0% plus lent 
(pull down de 4 %)

24 i/s 30 i/s

x100,1 % plus rapide 
(pull up de 0,1 %)

x99,9 % plus lent 
(pull down de 0,1 %)

x100,1 % plus rapide 
(pull up de 0,1 %)

x99,9% plus lent 
(pull down de 0,1 %)

23,976 i/s 29,97 i/s

vitesse identique, moins 
d'images par seconde

vitesse identique, plus 
d'images par seconde

Télécinéma

Télécinéma
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Conversion de fréquence d'échantillonnage basée sur les fréquences d'échantillonnage sources pour chaque 
facteur de pull up et pull down

De : Vers : Pull : Fréquence d'échantillonnage source

Vidéo 
NTSC

PAL +0,1 % puis 
+4,1667 %

45 983 50 050 91 967 100 100 n/d n/d

Film PAL +4,1667 % 45 938 50 000 91 875 100 000 n/d n/d

Vidéo 
NTSC

Film +0,1 % 44 144 48 048 88 288 96 096 176 576 192 192

Film Vidéo 
NTSC

-0,1 % 44 056 47 952 88 112 95 904 176 224 191 808

PAL Film -4,0 % 42 336 46 080 84 672 92 160 n/d n/d

PAL Vidéo 
NTSC

-4,0 % puis 
0,1 %

42 294 46 034 84 587 92 068 n/d n/d

Vidéo NTSC = 23.976/29.97 i/s
Film = 24/30 i/s
PAL = 25 i/s

Fréquence d'échantillonnage cible

44 100 48 000 88 200 96 000 176 400 192 000

Conversion de fréquence d'échantillonnage basée sur les fréquences d'échantillonnage cibles pour chaque 
facteur de pull up et pull down

Vidéo NTSC = 23.976/29.97 i/s
Film = 24/30 i/s
PAL = 25 i/s

Fréquence d'échantillonnage source

44 100 48 000 88 200 96 000 176 400 192 000

De : Vers : Pull : Fréquence d'échantillonnage cible

Vidéo 
NTSC

PAL +0,1 % puis 
+4,1667 %

42 294 46 034 84 587 92 068 n/d n/d

Film PAL +4,1667 % 42 336 46 080 84 672 92 160 n/d n/d

Vidéo 
NTSC

Film +0,1 % 44 056 47 952 88 112 95 904 176 224 191 808

Film Vidéo 
NTSC

-0,1 % 44 144 48 048 88 288 96 096 176 576 192 192

PAL Film -4,0 % 45 938 50 000 91 875 100 000 n/d n/d

PAL Vidéo 
NTSC

-4,0 % puis 
0,1 %

45 983 50 050 91 967 100 100 n/d n/d
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Chapitre 51 : Utilisation d'enregistreurs 
portables avec Pro Tools

Pro Tools HD permet d'importer des fichiers audio 
multicanal et leurs métadonnées à partir d'un 
enregistreur portable. 

Terminologie relative aux 
enregistreurs portables et 
aux workflows de production
Avant de travailler avec des enregistreurs portables 
dans Pro Tools HD, vous devez connaître la 
signification des quelques termes ci-après, relatifs 
aux enregistreurs portables et au domaine de la 
production.

Terminologie relative aux 
enregistreurs portables
La terminologie suivante s'applique aux 
enregistreurs portables en général :

Métadonnées

Le terme métadonnées est utilisé pour décrire les 
éléments suivants :

• Des informations intégrées dans un fichier 
média, notamment sur les scènes, prises, 
la fréquence d'échantillonnage, la résolution, 
les noms de clips externes, le nom de la bande 
vidéo à partir de laquelle le fichier média a été 
capturé et même des valeurs de timecode.

• Des informations intégrées dans des sessions 
Pro Tools ou autres séquences, notamment le 
nom des fichiers utilisés, leur position dans la 
timeline et l'automation.

• Des informations d'automation ou de gain des 
clips pour les séquences AAF ou OMF.

Enregistreurs portables numériques

Un enregistreur portable, ou enregistreur audio 
portable sur disque dur, est un appareil utilisé par 
un chef-opérateur du son lors du tournage d'un film 
ou d'une vidéo pour réaliser un enregistrement 
multicanal de plusieurs entrées micro enregistrées 
simultanément.

Selon les fonctionnalités et les réglages de 
l'enregistreur portable, les enregistrements 
multicanal peuvent comprendre une ou plusieurs 
pistes (jusqu'à 32) et être sauvegardés en tant que 
fichiers audio monophoniques ou polyphoniques 
sur un disque dur, un DVD-ROM ou un 
périphérique USB.

Les enregistrements multicanal d'un enregistreur 
portable doivent être encodés avec un marqueur 
temporel de début et de fin représentant le 
timecode SMPTE ou linéaire (également appelé 
LTC). La plupart des enregistreurs portables 
permettent également de saisir manuellement de 
types de métadonnées supplémentaires : 
nom/numéro du canal, scène, prise, prise 
conservée pour le montage, user bits, etc.
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Pro Tools peut importer des fichiers monophoniques 
et polyphoniques, ainsi que certains types de 
métadonnées saisies sur des enregistreurs portables. 

Mixage de production

Pour chaque enregistrement multicanal 
d'enregistreur portable, le chef-opérateur du son 
peut désigner un mixage de production composé 
d'un canal représentatif ou d'un mixdown d'une 
sélection de canaux de l'enregistrement.

Le mixage de production est destiné à être utilisé 
comme référence générale pour l'ensemble de 
l'audio d'un enregistrement multicanal. Il est 
généralement utilisé sur le système de montage 
vidéo Avid pour l'assemblage d'une séquence.

Fichiers Broadcast WAV (BWF)

Un fichier WAV contenant une section BEXT 
porte le nom de fichier Broadcast WAV (ou BWF), 
tout en conservant une extension de fichier .WAV. 
Les fichiers Broadcast WAV peuvent contenir à la 
fois des sections BEXT et iXML ou une section 
BEXT unique.

Sections BEXT et iXML

Les sections BEXT et iXML sont des groupes 
de métadonnées contenus dans un fichier 
Broadcast WAV. 

Limitations

Les limitations suivantes s'appliquent lors de la 
manipulation de métadonnées importées à partir 
d'enregistreurs portables.

• La spécification BEXT, telle que décrite ici, 
ajoute certaines caractéristiques conformes aux 
normes utilisées par les applications de montage 
vidéo Avid et Pro Tools. Les métadonnées 
descriptives en particulier sont interprétées 
différemment.

• Lorsque vous importez plusieurs fichiers dans 
lesquels les mêmes métadonnées sont 
renseignées avec des valeurs différentes, 
Pro Tools importe la première valeur présente en 
se basant sur l'ordre suivant :

• médias encapsulés au format OMF ou médias 
MXF Avid

• métadonnées de section iXML d'un 
fichier BWF

• métadonnées de section BEXT d'un 
fichier BWF 

Terminologie des workflows 
de production
La terminologie suivante s'applique à tous les 
workflows de production :

Timecode

Il existe quatre types de timecode, en fonction de 
votre production :

Numéro de bord : un numéro de bord unique est 
ajouté sur chaque image d'une pellicule lors de sa 
fabrication pour identifier sa position de timecode.

Timecode SMPTE : également nommé LTC, 
ou timecode linéaire. L'horloge génératrice de ce 
timecode peut être basée sur l'heure du jour ou 
commencer à partir d'une certaine heure du jour 
spécifique.

Minutes:Secondes : timecode basé sur les 
minutes et les secondes.

Libre : aucun timecode. La plupart des 
enregistreurs vidéo numériques grand public ne 
génèrent aucun timecode.
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Chef-opérateur du son

Le chef-opérateur du son utilise un enregistreur 
portable pour enregistrer de l'audio multicanal au 
cours d'un tournage, puis livre ces fichiers source 
à un ou plusieurs intervenants :

• un opérateur de télécinéma (workflow 
film uniquement) ;

• un monteur vidéo Avid ;

• le monteur Pro Tools.

Terminologie spécifique aux 
workflows film
La terminologie suivante s'applique uniquement 
aux workflows film :

Liste de plans

La liste de plans est un document dans lequel 
l'assistant caméra répertorie chaque scène et 
chaque prise en fonction de sa valeur de numéro de 
bord sur la pellicule. Ce document est ensuite 
utilisé par l'opérateur de télécinéma pour 
synchroniser l'audio et la vidéo.

Log son

Le log son est un document dans lequel le chef-
opérateur du son enregistre toutes les scènes et les 
prises en fonction de leur timecode de début. 

Clapman et informations du clap

Le clapman est la personne chargée de porter le clap 
(également baptisé claquette) et d'y inscrire les 
informations nécessaires à chaque nouvelle scène 
ou prise. Au début de chaque prise, le clapman rabat 
la claquette sur l'ardoise devant la caméra.

• Les informations inscrites sur le clap concernant 
la scène, la prise et le timecode sont ainsi 
capturées visuellement sur le film.

• Le son du clap est capturé par l'enregistreur 
portable, qui doit utiliser le même timecode que 
celui affiché sur le clap.

L'opérateur de télécinéma utilise toutes les 
informations mentionnées ci-dessus pour 
synchroniser les pellicules utilisées avec l'audio 
enregistré afin de créer la bande vidéo du 
télécinéma.

Télécinéma et bande vidéo de télécinéma

Le télécinéma est une machine utilisée pour 
transférer des images tournées et l'audio 
synchronisé sur une bande vidéo (appelée rushes).

La bande vidéo du télécinéma contient les rushes. 
Le timecode SMPTE sur la bande vidéo du 
télécinéma est différent du timecode enregistré sur 
le tournage.

Fichier FLEx

Le fichier FLEx est un fichier texte généré au cours 
d'une session de télécinéma et qui relie le numéro de 
bord du film, le timecode de l'enregistreur portable 
et le timecode de la bande vidéo du télécinéma. 
Lorsque la bande vidéo du télécinéma est numérisée 
par lot dans l'application de montage Avid, les 
informations du fichier FLEx sont utilisées pour 
assigner le timecode (emplacement) d'origine aux 
fichiers audio et vidéo source obtenus.

Fichiers audio et 
métadonnées d'enregistreur 
portable pris en charge
Pro Tools prend en charge les fichiers audio 
d'enregistreur portable suivants :

• Médias encapsulés au format OMF

• MXF

• Fichiers Broadcast WAV (BWF) avec les 
métadonnées suivantes :

• Sections BEXT et iXML

• Métadonnées BEXT mais aucune 
métadonnée iXML
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Affichage des métadonnées 
d'enregistreur portable dans 
Pro Tools
Vous pouvez activer ou désactiver l'affichage des 
métadonnées d'enregistreur portable dans la 
timeline et la liste des clips.

Pour afficher ou masquer les métadonnées 
d'enregistreur portable dans les playlists, 
procédez comme suit :

 À partir du menu View > Clip, sélectionnez ou 
désélectionnez l'une des options suivantes :

• Channel Name

• Scene and Take

Pour afficher ou masquer les métadonnées 
d'enregistreur portable dans la liste des clips :

1 Dans le menu de la liste des clips, 
sélectionnez Show.

2 Dans le sous-menu Show, sélectionnez ou 
désélectionnez l'une des options suivantes :

• Channel Name

• Scene and Take

Lorsqu'elles sont affichées dans la liste des clips, 
les métadonnées Scene and Take sont ajoutées à tous 
les clips disponibles du fichier audio correspondant.

Prise en charge des 
métadonnées d'enregistreur 
portable dans l'espace 
de travail
Les navigateurs de l'espace de travail affichent les 
métadonnées suivantes pour les enregistrements 
multicanal réalisés avec des enregistreurs portables.

• Duration (durée)

• File Comment (commentaires du fichier)

• Date Modified (date de modification)

• Date Created (date de création)

• # Channels (numéros des canaux)

• Format

• Sample Rate (fréquence d'échantillonnage)

• Bit Depth (résolution)

• Original Time Stamp (marqueur 
temporel d'origine)

• User Time Stamp (marqueur temporel utilisateur)

• Tape (nom de bande)

• TC Rate (fréquence TC) (renommé à partir 
de FPS)

• Channel Names (noms des canaux)

• Scene (scène)

• Take (prise)

• Shoot Date (date de tournage)

• Sound Roll (bobine son)

• Sound Roll TC (TC bobine son)

• Sound Roll TC Rate (fréquence TC bobine son)

• User Bits

• Tape ID (ID bande)

• Project (projet)

• Circled (prises cerclées)

• Clip Name (noms des clips)

Pour afficher ou masquer des métadonnées 
d'enregistreur portable dans les navigateurs de 
l'espace de travail :

 Effectuez un clic-droit sur l'en-tête de colonne, 
puis sélectionnez ou désélectionnez l'un des 
types de métadonnées.
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À propos des métadonnées Tape 
et Sound Roll
Les enregistreurs portables et les applications de 
montage vidéo Avid utilisent le champ Tape pour 
représenter différents types de métadonnées : Avid 
utilise ce champ pour stocker le nom de la bande 
vidéo du télécinéma, tandis qu'un fichier BWF 
contenant une section BEXT ou iXML l'utilise 
pour stocker le nom de la bande son.

Pour éviter cette confusion, Pro Tools conserve les 
métadonnées Tape provenant de l'application de 
montage vidéo Avid et les métadonnées Sound 
Roll et Tape des fichiers audio BWF dans leurs 
champs respectifs.

À propos des métadonnées 
Shoot Date
De nombreux enregistreurs portables ne 
renseignent pas automatiquement le champ Shoot 
Date ; la date de création du fichier est alors 
utilisée comme référence pour indiquer la date de 
production. Lorsque Pro Tools importe un fichier 
issu d'un appareil d'enregistrement portable, il 
vérifie que le champ Shoot Date est bien renseigné. 
S'il est vide, Pro Tools copie la date de création du 
fichier d'origine dans le champ Shoot Date des 
nouveaux fichiers importés.

Modification du nom de canal
Dans l'espace de travail, le champ Channel Name 
affiche le nom du canal, suivi du numéro du canal 
entre parenthèses. Vous pouvez modifier le nom 
de canal des fichiers BWF. Lorsque vous modifiez 
un nom de canal, les caractères saisis entre 
parenthèses seront abandonnés. Le numéro du 
canal est cependant toujours conservé.

Workflows d'enregistreur 
portable
(Pro Tools HD uniquement)

Afin de pouvoir utiliser Pro Tools pour travailler 
avec des fichiers d'enregistreur portable provenant 
d'un tournage de film, de vidéo ou numérique, 
vous devez respecter les étapes suivantes :

1 Avant de recevoir les fichiers source, assurez-
vous que les métadonnées ont bien été 
conservées (« Vérification de la conservation 
des métadonnées des fichiers source », 
à la page 1225).

2 Réceptionnez les fichiers source (« Réception 
des fichiers source », à la page 1226).

3 Importez les fichiers source dans Pro Tools 
(« Importation des fichiers source dans 
Pro Tools », à la page 1227).

4 Remplacez les points de montage du mixage de 
production par l'audio provenant des différentes 
prises de la même scène (« Sélection d'un canal 
d'enregistreur portable correspondant pour le 
remplacement d'un clip », à la page 1230).

Vérification de la conservation 
des métadonnées des fichiers 
source
Avant de recevoir les fichiers source, vous devez 
vous assurer qu'ils ont été préparés correctement 
à chaque étape de la production afin que leurs 
métadonnées d'origine aient été préservées.

Si les métadonnées d'origine n'ont pas été 
conservées, il est possible d'utiliser d'autres types 
de données (telles que la date de création du fichier 
ou le nom du fichier) pour trouver les canaux 
correspondants. Toutefois, la procédure est plus 
simple si les métadonnées sont toujours présentes.
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Réception des fichiers 
source
Lorsqu'ils sont impliqués dans le processus 
de post-production audio de séquences vidéo 
montées, vous avez besoin des deux ensembles 
de fichiers source suivants :

• une séquence AAF ou OMF avec un mixage de 
production monté et synchronisé avec la vidéo 
(des films de référence QuickTime ou des vidéos 
Avid par exemple) ;

• des fichiers source bruts représentant des 
enregistrements multicanal d'enregistreur 
portable.

Vous recevrez ces fichiers soit séparément (de la 
part du monteur vidéo Avid et du chef-opérateur 
du son), soit ensemble dans le cadre de 
l'exportation d'une séquence AAF ou OMF 
comprenant les données audio source brutes 
(provenant du monteur Avid).

Livraison séparée des fichiers 
source
Lorsque vous recevez une séquence AAF ou OMF 
d'un monteur Avid et de l'audio source brut d'un 
chef-opérateur du son, vous importez la séquence, 
puis l'audio source brut. Vous pouvez également 
utiliser Pro Tools pour rechercher l'audio 
correspondant hors de la session. 

Une fois l'audio importé ou localisé, Pro Tools sera 
capable de mettre les données en correspondance.

Livraison unique de fichiers 
source
Le monteur Avid dispose de deux méthodes pour 
préparer les fichiers avant de les exporter :

• l'audio source a été synchronisé automatiquement 
dans le chutier Avid et placé sur la timeline ;

• l'audio source a été synchronisé automatiquement 
et se trouve uniquement dans le chutier Avid.

Audio source automatiquement synchronisé 
dans la timeline avec le mixage de production 
monté : l'audio source contenu dans le chutier 
Avid a été automatiquement synchronisé avec 
le mixage de production monté et tous les canaux 
audio se trouvent dans la timeline Avid. 

Lorsque vous importez ce type de séquence dans 
Pro Tools, la vidéo montée, le mixage de 
production monté et tout l'audio source sont 
disponibles pour être importés directement dans 
la timeline.

Audio source automatiquement synchronisé et 
présent uniquement dans le chutier Avid : dans 
une application de montage vidéo Avid, l'audio 
source brut a été automatiquement synchronisé 
avec le mixage de production monté, mais tous 
les canaux se trouvent uniquement dans le 
chutier Avid. 

Reportez-vous aux sections « Importation 
d'une séquence AAF ou OMF dans 
Pro Tools », à la page 1227 et « Importation 
d'audio source brut directement dans 
Pro Tools », à la page 1228.

Dans ce cas, les séquences AAF ou OMF ne 
contiennent pas d'audio source ni de 
références à cet audio lorsqu'elles sont 
importées dans Pro Tools. Le monteur Avid 
doit alors livrer les fichiers de production 
séparément. Il peut soit livrer les fichiers 
audio de production stockés dans le dossier 
Avid ou OMFI Media Files, soit les fichiers 
audio source bruts non importés dans 
Media Composer.
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Importation des fichiers 
source dans Pro Tools
Cette section décrit l'importation de l'audio source 
de production à partir des types de fichiers suivants :

• Séquences AAF ou OMF

• Audio source brut (si reçu séparément de la 
séquence AAF ou OMF)

Importation d'une séquence 
AAF ou OMF dans Pro Tools

Pour ouvrir une séquence AAF ou OMF en tant que 
session Pro Tools :

1 Lancez Pro Tools.

2 Sélectionnez File > Open Session.

3 Dans la boîte de dialogue Open Session, accédez 
à la séquence AAF ou OMF que vous souhaitez 
importer.

4 Cliquez sur Open.

5 Donnez un nom à votre session dans le champ 
File Name.

6 Sélectionnez WAV dans le menu déroulant 
Audio File Type.

7 Sélectionnez les paramètres d'E/S à utiliser pour 
la session. Votre système est livré avec plusieurs 
configurations d'E/S prédéfinies, mais vous 
pouvez sélectionner une configuration 
personnalisée que vous avez créée vous-même.

8 Cliquez sur Save.

La boîte de dialogue Import Session Data s'affiche.

9 Sélectionnez Link to Source Media (si disponible) 
dans le menu déroulant Audio Media Options.

10 Sélectionnez Link to Source Media dans le 
menu déroulant Video Media Options.

11 Dans la section Source Tracks, sélectionnez les 
pistes à importer en cliquant sur le menu 
déroulant à droite de chaque nom de piste et en 
choisissant Import As New Track. 

12 Configurez les autres paramètres.

13 Cliquez sur OK.

Pro Tools crée de nouveaux dossiers Audio Files 
et Video Files, un fichier cache.wfm et un fichier 
de session aux emplacements désignés. Le type de 
fichier audio, la fréquence d'échantillonnage et la 
résolution de cette session correspondent à ceux de 
la séquence AAF ou OMF sélectionnée. Toutes les 
pistes sélectionnées dans la section Source Tracks 
de la boîte de dialogue Import Session Data sont 
automatiquement placées dans la timeline. 

Pro Tools permet d'ouvrir et d'importer des 
séquences OMF ou AAF référençant des fichiers 
audio de fréquences d'échantillonnage ou de 
résolutions mixtes. Les fichiers audio seront 
convertis à la fréquence d'échantillonnage la 
plus élevée des fichiers importés (pour les 
nouvelles sessions) ou à celle de la session 
(pour les sessions existantes). Les fichiers avec 
des résolutions mixtes et déjà à la fréquence 
d'échantillonnage cible sont importés sans 
conversion.

Pour sélectionner plusieurs pistes, cliquez sur le 
menu déroulant d'une piste tout en maintenant 
la touche Alt (Windows) ou Option (Mac) 
enfoncée et sélectionnez Import As New Track.
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Importation d'audio source brut 
directement dans Pro Tools
Si la séquence AAF ou OMF importée dans 
Pro Tools ne comprend pas d'audio source brut, 
vous pouvez l'importer séparément dans la session 
en utilisant les médias fournis par le chef-opérateur 
du son. 

Vous pouvez importer des fichiers audio 
monophoniques ou polyphoniques d'enregistreurs 
portables dans Pro Tools en utilisant les méthodes 
suivantes :

• en utilisant la commande File > Import > Audio 
puis en sélectionnant les fichiers à importer ;

• en faisant glisser des fichiers vers la liste des 
clips depuis un navigateur de l'espace de travail 
ou du poste de travail.

Correction d'une erreur 
d'alignement de l'audio suite 
à l'importation d'audio non 
exporté à partir d'Avid
Lorsque vous utilisez Pro Tools pour importer 
de l'audio source brut qui n'a pas été exporté 
à partir d'une application de montage vidéo Avid, 
de l'audio livré séparément d'une séquence AAF 
ou OMF par exemple, l'audio peut être décalé 
d'une demie image par rapport à l'audio de la 
séquence AAF ou OMF.

Cette erreur d'alignement résulte de 
l'incompatibilité entre le marquage temporel précis 
à l'image près des applications de montage Avid et 
le marquage temporel précis à l'échantillon près de 
Pro Tools. La liaison des deux marquages entraîne 
une erreur d'alignement.

Afin de résoudre cette divergence, vous devez 
décaler manuellement l'audio source brut après son 
importation dans Pro Tools. Vous avez également 
la possibilité de recourir à un utilitaire tel que 
SynchroArts Titan pour traiter et aligner l'audio 
source.

Préférence Don’t Convert 
Sample Rate on Import
Dans certains workflows, l'audio de production est 
enregistré en 48,048 kHz pour compenser à un pull 
down en 48 kHz qui sera appliqué en aval. Lorsque 
de l'importation d'audio à cette fréquence 
d'échantillonnage particulière, Pro Tools peut 
convertir la fréquence d'échantillonnage du fichier 
en 48 kHz, ou lui appliquer un pull down en temps 
réel en lecture.

Pour plus d'informations sur l'importation 
de séquences AAF et OMF dans Pro Tools, 
reportez-vous à la section « Importation 
de séquences AAF et OMF », 
à la page 361.

Pour les projets contenant de grandes quantités 
d'audio de production, il est déconseillé 
d'importer la totalité de l'audio dans Pro Tools. 
Vous pouvez configurer Pro Tools afin qu'il 
recherche l'audio à des emplacements hors de 
la session, dès que des fichiers d'enregistreur 
portable sont nécessaires. Pour plus 
d'informations, reportez-vous à la section 
« Sélection d'emplacements de recherche », 
à la page 1233.
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Si vous prévoyez d'importer de l'audio en 48,048 kHz 
et souhaitez que Pro Tools applique un pull down 
en 48 kHz en temps réel, effectuez les opérations 
suivantes :

Pour configurer la préférence Don’t Convert 
Sample Rate on Import :

1 Sélectionnez File > Preferences.

2 Cliquez sur l'onglet Processing.

3 Dans la section Import, localisez le paramètre 
Don’t Convert Sample Rates on Import.

4 Activez cette préférence pour autoriser le pull 
down en temps réel des fichiers audio en 
48,048 kHz.

Désignation des pistes 
d'enregistreur portable
Lorsque vous travaillez avec des données provenant 
d'un enregistreur portable, il est fréquent que 
Pro Tools ait à effectuer des tâches supplémentaires 
pour localiser et gérer les canaux et métadonnées 
d'enregistreur portable. Ces tâches de gestion 
peuvent demander des ressources importantes si la 
quantité de données à traiter est importante.

Pro Tools permet de désigner spécifiquement les 
pistes d'enregistreur portable après leur 
importation afin de limiter les opérations de 
gestion des fichiers d'enregistreur portable aux 
canaux contenant ce type de données.

Pour désigner une piste d'enregistreur portable :

1 Effectuez un clic droit sur le nom d'une piste 
que vous souhaitez désigner en tant que piste 
d'enregistreur portable.

2 Cliquez sur Field Recorder Guide Track.

3 Répétez l'opération pour chaque piste 
d'enregistreur portable de la session.

Affichage des fichiers 
multicanal d'enregistreur 
portable dans la liste 
des clips
Lorsque Pro Tools importe des enregistrements 
multicanal d'enregistreur portable, l'audio 
multicanal est enregistré sous la forme de fichiers 
audio entrelacés, affichés en tant qu'éléments 
uniques dans la liste des clips. 

Dans les versions précédentes de Pro Tools, 
les fichiers multicanal étaient enregistrés sous la 
forme de fichiers séparés, un pour chaque canal. 
Pro Tools traite ces groupes de clips associés 
en tant qu'éléments distincts. Un triangle 
développer/réduire situé en regard d'un élément 
dans la liste des clips indique ce type de clip 
multicanal groupé. Si vous travaillez avec des 
contenus importés à partir d'une version 
précédente de Pro Tools, vous verrez ces clips 
collectifs.

Pour désigner plusieurs pistes d'enregistreur 
portable simultanément, sélectionnez les 
pistes et effectuez un clic droit sur l'une d'elles.

Chaque piste d'enregistreur portable mono 
doit être désignée afin d'activer les 
fonctionnalités de Pro Tools spécifiques 
à ce type de piste.

Pour supprimer la désignation d'une piste 
d'enregistreur portable, effectuez un clic 
droit sur son nom et désactivez l'option Field 
Recorder Guide Track. 



Guide de référence Pro Tools1230

Afin que des clips audio multicanal importés 
à partir d'un enregistreur portable soient affichés 
sous la forme de clips collectifs, les deux clips 
composants doivent avoir les propriétés suivantes :

• même durée ;

• même préfixe de nom de clip (Audio File ou 
Audio File_01, par exemple) ;

• des suffixes de nom de clip numérotés de 
manière séquentielle, de A1 à A8.

Par exemple, les clips Audio File_01.A1 et 
Audio File_01.A2 seraient groupés en clip 
multicanal dans la liste des clips.

Si un clip groupé stéréo ou multicanal existant 
a été déplacé sur plusieurs pistes mono, puis édité 
de telle sorte qu'un ou plusieurs composants n'ont 
plus la même durée, l'indicateur stéréo disparaît et 
les clips apparaissent en tant que clips individuels 
dans la liste des clips. 

Sélection d'un canal 
d'enregistreur portable 
correspondant pour le 
remplacement d'un clip
(Pro Tools HD uniquement)

Si vous avez importé une séquence AAF ou OMF 
dans la timeline, vous pouvez remplacer le mixage 
de production par un canal d'enregistreur portable 
équivalent tout en conservant les points d'édition 
d'origine.

Remplacement d'un clip par un 
segment correspondant d'un 
canal d'enregistreur portable
Vous pouvez remplacer un clip mono (ou une 
partie sélectionnée d'un clip mono) par un segment 
correspondant d'un canal d'enregistreur portable 
enregistré simultanément. Les fondus appliqués au 
clip d'origine sont automatiquement appliqués au 
clip de remplacement et les automations présentes 
sur la piste sont conservées.

Pour remplacer un clip par un canal d'enregistreur 
portable correspondant :

1 Dans la timeline, créez une sélection incluant 
ou chevauchant le clip ou la partie de clip 
à remplacer.

2 Effectuez l'une des opérations suivantes :

• Avec l'un des outils d'édition, effectuez un clic 
droit sur la sélection à remplacer, puis 
sélectionnez la commande Matching Field 
Recorder Channels dans le menu contextuel.

• Avec le Sélecteur, cliquez sur la sélection 
à remplacer en maintenant les touches Ctrl+Alt 
(Windows) ou Commande+Option (Mac) 
enfoncées.

3 Dans le menu Matching Field Recorder 

Channels, sélectionnez le nom du clip 
correspondant à utiliser pour remplacer le clip 
d'origine. 

Si le processus d'importation de données de 
session a importé tout l'audio source de 
production directement dans la timeline, 
cette procédure n'est pas nécessaire.

L'utilisation de cette fonction est 
particulièrement utile lorsque vous dupliquez 
la piste du mixage de production. Vous 
pouvez par exemple remplacer l'audio d'un 
micro perche par celui d'un micro cravate et 
conserver les points d'édition ou fondus du 
mixage de production original de la séquence 
AAF ou OMF. 



Chapitre 51 : Utilisation d'enregistreurs portables avec Pro Tools 1231

4 Répétez cette procédure pour chacun des clips 
à remplacer sur chaque piste.

Conditions applicables aux 
correspondances de canaux 
d'enregistreur portable
Par défaut, un canal d'enregistreur portable 
correspondant est disponible pour le remplacement 
du canal original (le clip ou la portion de clip 
sélectionné sur la timeline) si les conditions 
suivantes sont remplies :

• les deux canaux proviennent d'un même 
enregistrement multicanal réalisé simultanément 
sur un ou plusieurs enregistreurs portables ;

• les deux canaux se chevauchent au moins une 
fois entre leurs positions de timecode de début et 
de fin ;

• les critères définis dans la boîte de dialogue 
Match Criteria sont remplis ;

• les métadonnées intégrées lors du tournage ou 
de l'enregistrement ont été conservées avant 
l'importation dans Pro Tools.

Cependant, des enregistreurs portables différents 
peuvent se comporter de manière non identique et 
les métadonnées disponibles seront dans certains 
cas erronées, incomplètes ou manquantes. 
Pro Tools permet de contrôler les critères de 
correspondance des canaux pour favoriser la 
recherche de canaux correspondants d'enregistreur 
portable dans ces situations.

Field Recorder Channels Match Criteria

La boîte de dialogue Field Recorder Channels 
Match Criteria permet de définir les critères sur 
lesquels Pro Tools se base pour une flexibilité 
maximale de la recherche de canaux 
correspondants d'enregistreur portable. 

Vous pouvez maintenir les touches 
Commande+Option (Mac) ou Ctrl+Alt 
(Windows) enfoncées puis utiliser les touches 
flèche bas et haut pour parcourir les 
correspondances disponibles pour la 
sélection.

La première fois que vous ouvrez le menu 
Matching Field Recorder Channels pour un 
clip spécifique, Pro Tools doit rechercher 
les canaux correspondants et affiche le 
message « Searching for metadata in the 
background ». Fermez et ouvrez à nouveau le 
menu lorsque la recherche est terminée.

Si le chef-opérateur du son a saisi le 
nom du canal (ou une autre référence 
descriptive) au cours du tournage, le menu 
Matching Field Recorder Channels affiche 
ces informations.

Pour vous assurer que les métadonnées ont 
bien été conservées dans vos fichiers source, 
reportez-vous à la section « Vérification de 
la conservation des métadonnées des fichiers 
source », à la page 1225.

Fenêtre Field Recorder Channels Match Criteria
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Il est possible de trouver des correspondances 
en fonction d'un ou plusieurs types de données 
suivantes :

File Creation Date : date de création des fichiers, 
telle que spécifiée dans le système d'exploitation.

Shoot date : date de tournage du contenu, telle que 
spécifiée dans les métadonnées iXML.

Scene :  numéro de scène du contenu, tel que 
spécifié dans les métadonnées iXML.

Scene and Take : numéros de scène et de prise, 
tels que spécifiés dans les métadonnées iXML.

Tape Name : nom de la bande, tel que spécifié 
dans les métadonnées iXML ; doit correspondre au 
nom de bande du fichier d'origine.

Sound Roll Name : nom de la bande son, tel que 
spécifié dans les métadonnées iXML ; doit 
correspondre au nom de bande son du fichier 
d'origine.

Sound Roll Name to Tape Name : nom de la 
bande, tel que spécifié dans les métadonnées 
iXML, correspondant au nom de bande son du 
fichier d'origine.

Tape Name to Sound Roll Name : nom de la bande 
son, tel que spécifié dans les métadonnées iXML, 
correspondant au nom de bande du fichier d'origine.

First X Characters in File Name : détermine la 
correspondance entre des fichiers dont le nom 
contient le nombre spécifié de caractères 
identiques en début de nom.

Channel Name : nom du canal, tel que spécifié 
dans les métadonnées iXML.

Channel Number : numéro du canal, tel que 
spécifié dans les métadonnées iXML.

Section Name and Sort Tracks By

Cette option définit la méthode utilisée par 
Pro Tools pour l'attribution de noms et le tri des 
fichiers audio créés suite au développement des 
canaux correspondants d'enregistreur portable. 

Pour configurer les critères de correspondance :

1 Effectuez l'une des opérations suivantes :

• Dans la fenêtre Edit, effectuez un clic droit sur 
un clip mono, puis sélectionnez Matching Field 

Recorder Channels > Match Criteria dans le 
menu contextuel.

• Dans la fenêtre Edit, maintenez les touches 
Commande+Option (Mac) ou Ctrl+Alt 
(Windows) enfoncées et cliquez sur un clip 
mono, puis sélectionnez Field Recorder Channel 

Match Criteria dans le menu.

• Effectuez un clic droit sur la zone du nom de la 
piste pour laquelle vous souhaitez trouver des 
correspondances, puis sélectionnez Field 

Recorder Channel Match Criteria dans le 
menu contextuel.

2 Dans la fenêtre Field Recorder Channels Match 
Criteria, sélectionnez les critères de 
correspondances sur lesquels sera basée la 
recherche de Pro Tools.

3 Dans le menu Match Timecode Plus, 
sélectionnez ANY ou ALL. En sélectionnant 
ANY, la recherche de correspondances 
renverra les résultats remplissant au moins un 
des critères spécifiés. En sélectionnant ALL, 
la recherche de correspondances renverra les 
résultats remplissant tous les critères spécifiés.

La correspondance de canaux par prise est 
possible uniquement si les scènes 
correspondent également.

Pour établir une correspondance en fonction 
du critère ci-dessus, Pro Tools accepte une 
correspondance de timecode entre le 
marqueur temporel d'origine et le timecode 
de la bande son.
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4 Pro Tools reprendra les critères spécifiés pour 
vos futures recherches de canaux 
correspondants d'enregistreur portable, jusqu'à 
ce qu'ils soient modifiés.

Sélection d'emplacements 
de recherche

Par défaut, Pro Tools recherche les fichiers 
correspondants d'enregistreur portable dans le 
dossier Audio Files de la session actuelle. 
Les enregistreurs portables accumulent souvent de 
grandes quantités de données audio. L'importation 
des fichiers nécessaires dans votre session 
Pro Tools peut donc être une tâche longue et 
complexe.

L'option Select Areas to Search permet de 
désigner des emplacements de recherche 
supplémentaires (d'autres dossiers ou disques 
durs) pour Pro Tools.

Pour sélectionner des emplacements de 
recherche de pistes correspondantes 
d'enregistreur portable :

1 Effectuez un clic droit sur le nom d'une piste 
d'enregistreur portable.

2 Cliquez sur Select Areas to Search. 

3 Naviguez jusqu'à un dossier ou un disque dur 
dans lequel vous souhaitez que Pro Tools 
recherche des correspondances.

4 Cliquez sur Choose pour confirmer votre choix.

5 Pour supprimer un emplacement de recherche 
de la liste, sélectionnez-le et cliquez sur le 
bouton Moins (-).

6 Effectuez l'une des opérations suivantes :

• Cliquez sur Save pour fermer la boîte de 
dialogue Select Areas to Search et enregistrer les 
nouveaux paramètres de recherche.

• Cliquez sur Save & Index pour enregistrer les 
nouveaux paramètres de recherche et réindexer 
les dossiers sélectionnés. Pour plus 
d'informations, reportez-vous à la section 
« Réindexation », à la page 1233.

Réindexation

Lorsque de nouveaux fichiers audio sont ajoutés 
dans l'un des emplacements de recherche désignés, 
Pro Tools doit indexer son contenu afin que vous 
puissiez accéder à ces nouveaux fichiers. 

Pour obtenir le maximum de résultats 
possibles, sélectionnez ANY. Utilisez 
ensuite l'option ALL pour restreindre les 
résultats de la recherche à une date de 
tournage, un nom de canal ou un autre 
critère spécifique.

Le bouton Reset rétablit les valeurs par 
défaut de tous les critères.

Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pour activer ou 
désactiver tous les critères de la boîte 
de dialogue.

Boîte de dialogue Select Areas to Search

Pro Tools affichera un message d'erreur si 
vous tentez d'ajouter un sous-dossier d'un 
dossier parent déjà présent dans la liste des 
emplacements de recherche.
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Pour réindexer l'ensemble des emplacements 
de recherche :

1 Dans la boîte de dialogue Field Recorder 

Channels Match, cliquez sur Select Areas 

to Search.

2 Cliquez sur Save & Index pour enregistrer les 
paramètres actuels et réindexer l'ensemble des 
emplacements de recherche de la liste.

Dossiers de recherche manquants

Les dossiers sélectionnés comme emplacements de 
recherche peuvent être manquants pour diverses 
raisons (suppression ou absence d'un disque dur 
par exemple). Si un dossier est manquant, 
Pro Tools affiche un message d'erreur lorsque vous 
ouvrez la boîte de dialogue Select Areas to Search. 
Le nom du chemin manquant est affiché en 
caractères italiques grisés dans la liste.

Développement des canaux 
d'enregistreur portable 
correspondants sur de 
nouvelles pistes
(Pro Tools HD uniquement)

Lorsque vous travaillez avec un clip mono 
appartenant à un enregistrement multicanal, vous 
pouvez le développer (ou une fraction de ce clip) 
sur de nouvelles pistes contenant les canaux 
correspondants avec les mêmes points d'édition 
et fondus. 

Cette fonctionnalité permet par exemple de créer 
facilement différentes versions d'une piste montée 
correspondant à plusieurs entrées de canal 
(microphones) enregistrées simultanément.

Pour développer les canaux correspondants 
d'enregistreur portables sur de nouvelles pistes :

1 Dans la timeline, effectuez l'une des opérations 
suivantes :

• Pour développer un seul clip sur une unique 
piste, effectuez un clic droit sur le clip.

• Pour développer une portion des clips de la piste, 
créez une sélection comprenant ou chevauchant 
le nombre de clips souhaité, maintenez les 
touches Commande+Option (Mac) ou Ctrl+Alt 
(Windows) enfoncées puis cliquez sur la sélection.

Les fichiers d'enregistreur portable 
importés via une recherche dans un 
emplacement hors de la session le sont 
toujours au format .WAV. Les métadonnées 
d'enregistreur portable sont ainsi 
conservées en cas de conversion. Le type de 
fichier de session sélectionné dans la 
fenêtre Session Setup est ignoré.

Les canaux correspondants d'enregistreur 
portable sont des canaux mono 
habituellement enregistrés en même temps 
que le clip d'origine (des enregistrements 
multicanal réalisés avec un ou plusieurs 
enregistreurs portables par exemple). Pour 
obtenir des informations détaillées sur la 
configuration des critères que les canaux 
correspondants doivent remplir, reportez-
vous à la section « Conditions applicables 
aux correspondances de canaux 
d'enregistreur portable », à la page 1231.
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• Pour développer tous les clips sur une piste mono, 
effectuez un clic droit sur le nom de la piste.

2 Cliquez sur le sous-menu Expand Channels to 
New Tracks, puis sur l'une des méthodes de 
développement des canaux d'enregistreur 
portable correspondants sur de nouvelles pistes :

• By Match Criteria (selon les critères de 
correspondance)

• By Timecode Only (selon le timecode 
uniquement)

Si des canaux correspondants d'enregistreur 
portable sont disponibles, Pro Tools les développe 
sur de nouvelles pistes (en plus du canal de la piste 
d'origine) en fonction des paramètres sélectionnés.

Détermination de la méthode 
de développement des 
canaux correspondants sur 
de nouvelles pistes
Les canaux correspondants d'enregistreur portable 
peuvent être développés sur de nouvelles pistes en 
fonction de critères de correspondance spécifiés 
dans le boîte de dialogue Field Recorder Channels 
Match Criteria (reportez-vous à la section « Field 
Recorder Channels Match Criteria », à la page 1231 
pour plus d'informations), ou selon leur timecode 
uniquement.

Développement des canaux 
correspondants en fonction de 
critères de correspondance
La commande Expand Channels to New Tracks > 

By Match Criteria crée une nouvelle piste pour 
chaque canal unique trouvé dans les canaux 
correspondants à la sélection et remplissant les 
critères spécifiés.

Le canal que vous souhaitez développer doit 
être mono.

Lorsque vous développez uniquement une 
portion des clips sur des pistes, l'option By 
Match Criteria sera grisée si aucune 
correspondance valide n'est trouvée, ou si 
l'option ANY est sélectionnée dans la boîte de 
dialogue Field Recorder Channels Match 
Criteria et qu'aucun critère n'est spécifié.

Pour plus d'informations sur ces options de 
développement sur de nouvelles pistes, 
reportez-vous à la section « Détermination 
de la méthode de développement des canaux 
correspondants sur de nouvelles pistes », 
à la page 1235.

Résultat du développement d'une sélection sur de 
nouvelles pistes
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Si des canaux dont des critères de correspondances 
dupliqués (tels que le nom ou le numéro de canal) 
sont présents, des pistes supplémentaires sont créées 
pour chaque canal dupliqué. Les nouveaux canaux 
prennent le nom du canal d'origine à partir duquel ils 
ont été développés, suivi d'un point puis d'un numéro 
d'identification. Le premier canal correspondant 
portera le suffixe .2, le deuxième .3, etc.

Chaque nouvelle piste contient uniquement des 
canaux correspondant aux critères spécifiés, 
les points d'édition et fondus de la sélection 
d'origine sont conservés. Les espaces représentent 
des clips de la sélection d'origine pour lesquels 
aucun canal correspondant n'a été trouvé avec 
ce nom de canal.

Attribution de noms et tri des canaux 
développés

Pour une flexibilité maximale, Pro Tools permet 
de contrôler la méthode d'attribution des noms et 
de tri des nouveaux canaux créés par la commande 
Expand Channels to New Tracks by Match 
Criteria.

Ce paramètre peut être configuré dans la boîte de 
dialogue Field Recorder Channels Match Criteria 
(reportez-vous à la section « Field Recorder 
Channels Match Criteria », à la page 1231 pour 
plus d'informations).

Procédure d'attribution des noms de piste lors 
du développement des canaux correspondants 
par nom de canal

Les pistes développées par nom et numéro de canal 
sont dénommées comme suit :

• Pour les noms de canaux uniques qui créent une 
seule piste, chaque piste est nommée en ajoutant 
le nom du canal au nom d'origine de la piste. 
Par exemple, le développement du nom de canal 
unique Boom sur la piste Guide.A1, entraîne la 
création d'une nouvelle piste nommée 
Guide.A1.Boom.

• Pour les noms de canaux uniques qui créent 
deux pistes ou plus, chacune des nouvelles pistes 
partageant un nom de canal est nommée en 
ajoutant un point, suivi d'un numéro 
d'identifiant. Le premier canal correspondant 
portera le suffixe .2, le deuxième .3, etc. 
Par exemple, le développement des noms de 
canaux dupliqués Boom de la piste Guide.A1, 
entraîne la création de nouvelles pistes nommées 
Guide.A1.2 et Guide.A1.3.

Procédure d'attribution des noms de piste lors 
du développement des canaux correspondants 
par numéro de canal

Les pistes développées par nom et numéro de canal 
sont dénommées comme suit :

• Pour les numéros de canaux uniques qui créent 
une seule piste, chaque piste est dénommée en 
ajoutant le numéro du canal au nom d'origine de 
la piste. Par exemple, le développement du 
numéro de canal unique A1 sur la piste 
Guide.A1, entraîne la création d'une nouvelle 
piste nommée Guide.A1.A1.

• Pour les numéros de canaux uniques qui créent 
deux pistes ou plus, chacune des nouvelles pistes 
partageant un numéro de canal est nommée en 
ajoutant un point, suivi d'un numéro 
d'identifiant. Le premier canal correspondant 
portera le suffixe .2, le deuxième .3, etc. 
Par exemple, le développement des numéros de 
canaux dupliqués A1 de la piste Guide.A1, 
entraîne la création de nouvelles pistes nommées 
Guide.A1.A1.2 et Guide.A1.A1.3.
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Procédure d'attribution des noms de piste lors 
du développement des canaux correspondants 
par nom et numéro de canal

Les pistes développées par nom et numéro de canal 
sont dénommées comme suit :

• Pour les combinaisons de noms et de numéros de 
canaux uniques qui créent une seule piste, 
chaque piste est dénommée en ajoutant le nom et 
le numéro du canal au nom d'origine de la piste. 
Par exemple, le développement de la 
combinaison de nom et de numéro de canal 
unique Boom.A1 sur la piste Guide.A1 entraîne 
la création d'une nouvelle piste nommée 
Guide.A1.Boom.A1.

• Pour les noms et numéros de canaux uniques qui 
créent deux pistes ou plus, chacune des nouvelles 
pistes partageant un nom et un numéro de canal est 
nommée en ajoutant un point, suivi d'un numéro 
d'identifiant. Le premier canal correspondant 
portera le suffixe .2, le deuxième .3, etc. Par 
exemple, le développement des noms de canaux 
dupliqués Boom.A1 de la piste Guide.A1 
entraînerait la création de nouvelles pistes 
nommées Guide.A1.A1.2 et Guide.A1.A1.3.

Développement des canaux 
correspondants en fonction du 
timecode uniquement
La commande Expand Channels To New Tracks 

By Timecode Only permet de développer une piste 
entière ou uniquement les clips sélectionnés sur de 
nouvelles playlists appartenant à la même piste ou 
sur de nouvelles pistes séparées. Cela permet 
d'afficher tous les autres clips enregistrés au même 
emplacement de timecode, quel que soit le nom ou 
le numéro du canal. Cette commande est 
particulièrement utile pour développer des pistes 
témoin éditées de l'audio source d'origine 
enregistré avec synchronisation du timecode, mais 
dont les nom et numéros des canaux n'ont pas été 
enregistrés dans les fichiers audio. 

Lors de la recherche des correspondances par 
timecode uniquement, Pro Tools prend en compte 
à la fois le marqueur temporel d'origine et le 
timecode de la bande son. Si une référence croisée 
est trouvée entre les champs du nom de bande et de 
bande son (ou vice versa), Pro Tools recherchera 
également des références croisées entre le marqueur 
temporel d'origine et le timecode de la bande son.

Exemple de workflow : 
utilisation d'une piste témoin
Pour des vidéos de concert live, la vidéo est 
capturée séparément et l'audio est enregistré dans 
Pro Tools. Le monteur vidéo utilisera une piste 
audio témoin montée sur la vidéo dans son logiciel 
de montage vidéo (tel qu'Avid Media Composer). 
La piste témoin montée est ensuite renvoyée dans 
Pro Tools, mais doit être développée sur les pistes 
source d'origine conformées pour le mixage et le 
mastering.

1 La piste audio multipiste est enregistrée dans 
Pro Tools avec asservissement au timecode. 
Un mix mono ou stéréo est enregistré 
simultanément comme piste témoin pour 
le monteur vidéo.

2 Les pistes témoin vidéo et audio sont montées 
dans une application de montage vidéo (telle 
qu'Avid Media Composer). 

3 Les pistes témoin audio montées sont exportées 
à partir du monteur vidéo sous la forme d'une 
séquence AAF (ou OMF), avec des marges d'au 
moins deux images. 

4 La séquence AAF (ou OMF) est importée dans 
Pro Tools en tant que nouvelle session.

5 Les fichiers audio source d'origine et la piste 
témoin non montée sont également importés 
dans la session.



Guide de référence Pro Tools1238

6 La piste témoin non montée d'origine est reliée 
à la session (reportez-vous à la section 
« Rétablissement du lien avec la piste témoin 
non montée d'origine », à la page 1238).

7 Dans Pro Tools, le monteur sélectionne l'option 
Expand Channels to New Tracks > By 

Timecode Only en effectuant un clic droit sur le 
nom de la piste témoin. Les pistes source 
d'origine sont développées sur de nouvelles 
pistes, avec les points d'édition et fondus de la 
piste témoin.

Rétablissement du lien avec la piste témoin non 
montée d'origine

Une fois la séquence AAF (ou OMF) et les fichiers 
audio source d'origine importés dans la session, 
il est recommandé de rétablir le lien entre la piste 
témoin montée et la piste audio source non montée 
d'origine.

Pour rétablir le lien avec la piste témoin non 
montée d'origine :

1 Ouvrez un navigateur de l'espace de travail. 
Sélectionnez votre session dans la colonne 
Locations, puis ouvrez ou développez le dossier 
Audio Files de la session.

2 Dans le navigateur, effectuez un clic droit sur le 
fichier audio de la piste témoin montée, puis 
sélectionnez Relink Selected Items.

3 Dans le panneau supérieur de la fenêtre Relink, 
naviguez vers le fichier audio de la piste témoin 
non montée d'origine qui a été enregistré dans 
Pro Tools. 

4 Dans le panneau Select Files To Relink, 
sélectionnez le fichier de la piste témoin montée.

5 Faites glisser le fichier audio de la piste témoin 
non montée vers le panneau Candidates. Si une 
boîte de dialogue s'affiche et indique qu'un ou 
plusieurs fichiers sont plus courts que le fichier 
média pour lequel vous tentez de rétablir le lien, 
cliquez sur Yes pour poursuivre l'opération.

6 Dans le panneau Candidates, activez la case 
à cocher située à gauche du fichier pour afficher 
l'icône de lien. 

7 En haut de la fenêtre Relink, cliquez sur Commit 

Links, puis fermez la fenêtre.

Effectuez un clic droit sur le nom de la piste témoin 
et sélectionnez Expand To New Tracks > By Time 

Code Only. Toutes les pistes développées sont 
alors synchronisées avec la piste témoin.

Workflow film
Cette section décrit le workflow film, du tournage 
jusqu'à la préparation du montage par le monteur 
Avid. Elle est destinée aux parties suivantes :

• l'assistant caméra ;

• le cadreur ;

• le chef-opérateur du son ;

• l'opérateur de télécinéma ;

• le monteur Pro Tools.

Présentation du workflow film

La section suivante présente les étapes nécessaires 
à un workflow film :

1 préparation du tournage ;

2 tournage ;

3 transfert télécinéma ;

4 numérisation par lot dans l'application de 
montage vidéo Avid.

Si le fichier non monté d'origine n'est pas 
disponible, vous pouvez rétablir le lien avec 
l'un des fichiers audio source, à la condition 
que ses heures de début et de fin soit 
identiques à celles de la piste témoin.
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Suivez ces étapes pour vous assurer que les 
métadonnées de timecode soient conservées dès les 
premières étapes du tournage jusqu'à la livraison 
finale des fichiers source au monteur Pro Tools.

Préparation du tournage 
(workflow film)
Au début de chaque journée de tournage, le chef-
opérateur du son doit choisir un nom unique, 
de préférence avec un numéro incrémenté chaque 
jour, et saisir ce nom exact dans le champ de 
métadonnées Tape BEXT ou iXML du fichier 
Broadcast WAV. 

Par exemple, le chef-opérateur du son peut utiliser 
le nom T001 pour le premier jour de tournage, 
T002 pour le deuxième jour de tournage, etc.

Tournage (workflow film)
1 Le tournage se déroule comme suit :

• La caméra commence à tourner.

• Un ou plusieurs enregistreurs portables 
commencent à enregistrer. Le chef-opérateur du 
son a désigné un ou deux canaux comme mixage 
de production, qui correspond à une 
consolidation d'un ou plusieurs canaux de 
chaque enregistrement multicanal.

2 Au cours du tournage, les informations de 
timecode suivantes sont capturées :

• La caméra capture les images sur une pellicule, 
chacune d'elles étant repérée par un timecode 
d'identification unique baptisé numéro de bord.

• Un ou plusieurs enregistreurs portables 
enregistrent simultanément en multicanal, avec 
un timecode SMPTE basé sur l'heure du jour 
(ou un timecode longitudinal).

3 Au cours du tournage, les informations 
suivantes sont notées :

• L'assistant caméra conserve un enregistrement 
écrit (appelé liste de plans) qui répertorie chaque 
scène et chaque prise avec un numéro de bord 
correspondant.

• Le chef-opérateur du son conserve également un 
enregistrement écrit (appelé log son) qui 
répertorie chaque scène et chaque prise avec un 
timecode correspondant.

4 Le clapman rabat la claquette sur l'ardoise pour 
indiquer le début de la prise. L'enregistreur 
portable enregistre le bruit du clap et la caméra 
capture les images suivantes :

• les numéros de scène et de prise (inscrits sur 
le clap) ;

• l'instant exact de fermeture du clap ;

• la position de timecode de fermeture du clap.

5 Le tournage se termine et la prise est 
enregistrée.

Transfert télécinéma 
(workflow film)
Lorsque le tournage de la journée est terminé, 
les composants suivants sont envoyés à l'opérateur 
de télécinéma :

• la pellicule développée ;

• l'audio multicanal enregistré sur le tournage ; 

• la liste de plans et le log son manuscrits.

L'opérateur de télécinéma génère les rushes (une 
bande vidéo contenant les plans du jour) en 
transférant le film et l'audio sur une bande vidéo. 
Les listes de plans sont utilisées comme référence.
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Pour utiliser un télécinéma pour la création 
de rushes :

1 Chargez le film et l'audio dans le télécinéma.

2 Saisissez le nom de la bande ou de la bande son 
(selon ce que vous avez utilisé au cours de la 
production) au caractère près dans le 
télécinéma. 

3 Dans la liste de plans de l'assistant caméra, 
localisez l'image du film correspondant au 
premier numéro de bord de la pellicule (cette 
image doit se trouver juste avant le clap 
de début).

4 Recherchez la première image du clap et notez 
la position de timecode affichée sur l'ardoise.

5 Localisez l'audio correspondant à la position de 
timecode exacte affichée sur le clap dans 
l'image du film (pour aligner l'audio avec les 
images).

6 Lancez la lecture du film et de l'audio pour 
tester leur synchronisation. S'ils ne sont pas 
synchronisés, apportez de légers ajustements 
manuels jusqu'à une synchronisation parfaite.

7 Une fois la synchronisation établie, verrouillez 
le positionnement du film et de l'audio.

8 Insérez une bande vidéo vierge dans le 
magnétoscope connecté au télécinéma et 
assignez manuellement les informations de 
timecode LTC (longitudinal) sur la bande vidéo. 

9 Démarrez la capture du télécinéma. Au cours de 
la capture, les événements suivants se 
produisent :

• Le télécinéma commence la capture 
synchronisée du film et de l'audio en assignant 
un timecode LTC à la bande vidéo à partir de 
l'emplacement où vous avez saisi le timecode 
de début.

• Un fichier FLEx est créé, dans lequel les 
informations relatives aux scènes et aux prises 
sont automatiquement enregistrées et associées 
aux numéros de bord du film et au timecode de 
la bande vidéo du télécinéma par rapport au 
timecode de l'audio.

10 Une fois le transfert télécinéma terminé, 
envoyez les éléments suivants au 
monteur Avid :

• la bande vidéo du télécinéma ;

• le fichier FLEx ;

• Liste de plans

• le log son.

• les médias audio enregistrés sur le tournage.

Numérisation par lot de la bande 
vidéo du télécinéma en fichiers 
numériques (workflow film)
Cette phase du workflow commence une fois que 
le monteur Avid reçoit les composants suivants de 
la part de l'opérateur de télécinéma :

• la bande vidéo du télécinéma ;

• le fichier FLEx ;

• Liste de plans

• le log son.

Pour vous assurer que les métadonnées 
soient conservées pour le monteur Pro Tools, 
saisissez impérativement le nom de la bande 
ou de la bande son au caractère près. 
Par exemple, pour une métadonnée T001 
(avec deux zéros), saisissez T001 avec deux 
zéros (et non pas T01 avec un zéro ou T0001 
avec trois zéros).

Dans certains cas, vous pouvez également 
recevoir de l'audio enregistré sur le tournage 
de la part du chef-opérateur du son.



Chapitre 51 : Utilisation d'enregistreurs portables avec Pro Tools 1241

Dans un workflow film, le monteur Avid effectue 
une numérisation par lot de la bande vidéo du 
télécinéma pour créer des fichiers audio et vidéo 
numériques et les monter.

Pour numériser par lot une bande vidéo de 
télécinéma et créer des fichiers source 
numériques :

1 Dans l'application de montage Avid, importez 
tous les fichiers FLEx appropriés dans Avid Log 
Exchange.

Avid Log Exchange affiche une liste de toutes les 
combinaisons de scène et de prise, avec les 
numéros de bord de film, le timecode audio et le 
timecode de bande vidéo associés.

2 Dans Avid Log Exchange, sélectionnez les 
éléments du fichier FLEx qui correspondent aux 
scènes et prises que vous souhaitez numériser 
par lot à partir de la bande vidéo.

3 Traitez les scènes et les prises sélectionnées 
dans le fichier FLEx. Avid Log Exchange 
envoie les éléments sélectionnés vers 
l'application de montage vidéo Avid, dans 
laquelle ils sont chargés dans le chutier en tant 
que médias hors ligne.

4 Dans le chutier Avid, sélectionnez les éléments 
à capturer.

5 Chargez la bande vidéo du télécinéma dans le 
système Avid et commencez la numérisation 
par lot.

Le système Avid numérise par lot 
automatiquement les scènes et les prises 
sélectionnées dans le chutier Avid, et utilise le 
fichier FLEx pour assigner à tous les fichiers vidéo 
et audio numérisés les informations de timecode 
correspondant aux informations de numéro de 
bord et de timecode d'origine du tournage.

6 Une fois la numérisation par lot terminée, 
utilisez l'application de montage vidéo Avid 
pour monter l'audio et la vidéo.

7 Lorsque vous avez terminé le montage, 
exportez la séquence éditée au format AAF ou 
OMF pour pouvoir l'importer dans Pro Tools.

Workflows vidéo et 
entièrement non linéaires
Cette section décrit les workflows vidéo et 
entièrement non linéaires, depuis le tournage 
jusqu'à la préparation du montage par le monteur 
Avid. Elle est destinée aux intervenants suivants :

• l'assistant caméra ;

• le cadreur ;

• le chef-opérateur du son ;

• le monteur Avid ;

• le monteur Pro Tools.

Présentation des workflows vidéo et 
entièrement non linéaires

La section suivante présente les étapes nécessaires 
dans ces workflows :

1 préparation du tournage ;

2 tournage ;

3 numérisation de la vidéo dans l'application 
de montage vidéo Avid (workflow vidéo 
uniquement) ou importation des fichiers vidéo 
numériques directement dans l'application Avid 
(workflow entièrement non linéaire uniquement).

Toutes les métadonnées requises pour la 
correspondance (telles que le nom de la 
bande) doivent être visibles dans les clips non 
numérisés.
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Respectez ces étapes pour vous assurer que le 
timecode et les autres métadonnées soient 
conservés dès les premières étapes du tournage 
jusqu'à la livraison finale des fichiers source au 
monteur Pro Tools.

Préparation du tournage 
(workflows vidéo et entièrement 
non linéaires)
Avant le début du tournage, le cadreur et le chef-
opérateur du son doivent s'assurer des éléments 
suivants :

• la sortie audio de l'enregistreur portable est 
envoyée à l'entrée audio de la caméra vidéo ;

• l'enregistreur portable et la caméra vidéo 
doivent être verrouillés sur le même timecode 
de production.

Correspondance des métadonnées Tape Name 
et Sound Roll pour des tournages vidéo

Avant de charger la bande vidéo dans la caméra 
vidéo, le cadreur étiquette physiquement la bande 
vidéo avec un nom unique. Le chef-opérateur du 
son doit saisir ce nom exact dans le champ des 
métadonnées Tape BEXT ou iXML du fichier 
Broadcast WAV. 

Correspondance des métadonnées Tape Name 
et Sound Roll pour des tournages entièrement 
non linéaires

Après avoir chargé le stockage vidéo numérique 
dans la caméra, le cadreur leur donne un nom 
unique. Le chef-opérateur du son doit saisir ce nom 
exact dans le champ des métadonnées Tape BEXT 
ou iXML du fichier Broadcast WAV. 

Tournage (workflows vidéo et 
entièrement non linéaires)
1 Le tournage se déroule comme suit :

• La caméra commence à tourner.

• Un ou plusieurs enregistreurs portables 
commencent à enregistrer. Le chef-opérateur du 
son a désigné un ou deux canaux comme mixage 
de production, qui correspond à une 
consolidation d'un ou plusieurs canaux de 
chaque enregistrement multicanal.

2 Au cours du tournage, les informations de 
timecode suivantes sont capturées :

• La caméra capture les images sur une bande 
vidéo ou un fichier en incorporant un timecode 
SMPTE basé sur l'heure du jour (ou timecode 
longitudinal).

• Un ou plusieurs enregistreurs portables 
enregistrent simultanément en multicanal, avec 
un timecode SMPTE basé sur l'heure du jour 
(ou un timecode longitudinal).

Après l'importation d'un fichier contenant 
des métadonnées Tape dans Pro Tools, les 
métadonnées s'affichent dans le champ Sound 
Roll des navigateurs de l'espace de travail.

Pour vous assurer que les métadonnées sont 
conservées pour le monteur Pro Tools, 
saisissez le nom de la bande au caractère 
près. Par exemple, pour une métadonnée 
T001 (avec deux zéros), saisissez T001 avec 
deux zéros (et non pas T01 avec un zéro ou 
T0001 avec trois zéros).
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3 Le clapman rabat la claquette sur l'ardoise pour 
indiquer le début de la prise. L'enregistreur 
portable enregistre le bruit du clap et la caméra 
capture les images suivantes :

• les numéros de scène et de prise (inscrits sur 
le clap) ;

• l'instant exact de fermeture du clap ;

• la position de timecode de fermeture du clap.

4 Le tournage se termine et la prise est 
enregistrée.

Numérisation d'une bande vidéo 
dans l'application de montage 
vidéo Avid
(Workflow vidéo uniquement)

Cette phase du workflow commence une fois que 
le monteur Avid reçoit les composants suivants de 
la part du cadreur et du chef-opérateur du son :

• la bande vidéo ;

• les enregistrements multicanal.

Dans un workflow vidéo, le monteur Avid 
numérise la bande vidéo pour créer des fichiers 
audio et vidéo numériques et les monter. 
Cependant, il doit auparavant nommer la bande.

Pour numériser une bande vidéo et créer des 
fichiers source numériques :

1 Chargez la bande vidéo dans le système Avid.

2 Lorsque vous êtes invité à donner un nom à la 
bande vidéo, saisissez le nom exact de la bande 
utilisé par le cadreur et le chef-opérateur du son.

3 Numérisez la bande vidéo chargée dans le 
système Avid.

4 Une fois la numérisation par lot terminée, 
utilisez l'application de montage vidéo Avid 
pour monter l'audio et la vidéo.

Lorsque vous avez terminé le montage, exportez la 
séquence éditée au format AAF ou OMF pour 
pouvoir l'importer dans Pro Tools.

Importation d'une vidéo 
numérique directement dans 
l'application de montage 
vidéo Avid
(Workflow entièrement non linéaire 
uniquement)

Cette phase du workflow commence une fois que 
le monteur Avid reçoit les composants suivants de 
la part du cadreur et du chef-opérateur du son :

• la vidéo numérique (sur une carte mémoire 
flash, un disque dur ou un autre stockage de 
fichiers) ;

• les enregistrements multicanal.

Dans un workflow entièrement non linéaire, 
il suffit au monteur Avid d'importer les médias 
vidéo et audio dans l'application de montage vidéo 
Avid pour pouvoir les monter. 

Pour importer de la vidéo dans l'application de 
montage Avid :

1 Créez un chutier dans l'application de montage 
vidéo Avid.

2 Importez les fichiers vidéo directement dans 
le chutier.

3 Lorsque la boîte de dialogue Disk Label Import 
s'affiche, saisissez le nom de bande exact utilisé 
par le cadreur et le chef-opérateur du son.

Pour vous assurer que les métadonnées sont 
conservées pour le monteur Pro Tools, 
saisissez le nom de la bande au caractère 
près. Par exemple, pour une métadonnée 
T001 (avec deux zéros), saisissez T001 avec 
deux zéros (et non pas T01 avec un zéro ou 
T0001 avec trois zéros).
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4 Utilisez l'application de montage vidéo Avid 
pour monter l'audio et la vidéo.

5 Lorsque vous avez terminé le montage, 
exportez la séquence éditée au format AAF ou 
OMF pour pouvoir l'importer dans Pro Tools.

Pour vous assurer que les métadonnées sont 
conservées pour le monteur Pro Tools, 
saisissez le nom de la bande au caractère 
près. Par exemple, pour une métadonnée 
T001 (avec deux zéros), saisissez T001 avec 
deux zéros (et non pas T01 avec un zéro ou 
T0001 avec trois zéros).



Chapitre 52 : Utilisation de la vidéo dans Pro Tools 1245

Chapitre 52 : Utilisation de la vidéo dans 
Pro Tools

Avid Video Engine (AVE)
Pro Tools exploite le moteur Avid Video Engine 
(AVE) pour prendre en charge la lecture vidéo. 
Le moteur AVE permet de visualiser simultanément 
une vidéo stockée sur votre poste de travail (vidéo 
native) et une vidéo dont le monitoring est assuré 
par un périphérique vidéo Avid ou tiers. Le moteur 
AVE prend en charge un large panel de formats 
vidéo QuickTime et Avid MXF HD et SD sur les 
pistes vidéo de Pro Tools, sans transcodage (Avid 
DNxHD® compris).

Pour activer le moteur Avid Video Engine de 
Pro Tools :

1 Sélectionnez Setup > Playback Engine.

2 Activez l'option Video Engine pour utiliser 
Pro Tools avec le moteur Avid Video Engine.

3 Cliquez sur OK.

Prise en charge des 
périphériques vidéo Avid et des 
interfaces tierces
Les logiciels Pro Tools et Pro Tools HD prennent 
en charge le monitoring vidéo externe à l'aide de 
matériel vidéo qualifié. Grâce au nouveau moteur 
Avid Video Engine, Pro Tools prend en charge le 
monitoring des médias DNxHD et QuickTime avec 
un boîtier Avid Nitris® DX, Mojo® DX ou d'autres 
interfaces vidéo tierces qualifiées par Avid.

Pour activer ou désactiver le monitoring vidéo 
externe avec du matériel vidéo qualifié :

1 Assurez-vous que votre boîtier vidéo Avid ou 
tiers qualifié par Avid est correctement installé 
et configuré.

2 Sélectionnez ou désélectionnez Options > 

Enable Video Hardware.

Présentation de la vidéo sur 
Pro Tools et Pro Tools HD
Pro Tools permet d'effectuer les opérations 
suivantes avec de la vidéo :

• Créer une unique piste vidéo et importer de la 
vidéo Avid ou QuickTime sur la timeline à l'aide 
de commandes de menu ou par glisser-déposer.

• Organiser, grouper et éditer des clips vidéo sur la 
timeline comme s'il s'agissait de clips audio.

• Verrouiller des pistes vidéo.

• Extraire l'audio de vidéos QuickTime.

• Effectuer un scrubbing simultané sur l'audio et 
la vidéo.

• Afficher une vidéo dans la fenêtre Video ou la 
visionner sur un moniteur externe via un 
périphérique vidéo Avid pris en charge.

• Bouncer la piste vidéo au format QuickTime.
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Pro Tools HD permet également d'effectuer les 
opérations suivantes avec de la vidéo :

• Importer plusieurs fichiers vidéo dans la 
timeline.

• Créer et éditer jusqu'à 64 pistes vidéo 
comprenant de la vidéo QuickTime et Avid dans 
la timeline.

• Sélectionner des vidéos appartenant à 
différentes playlists sur chaque piste vidéo.

• Organiser, grouper et éditer des clips vidéo avec 
des clips audio.

• Gérer plusieurs clips vidéo dans le liste des clips.

• Annuler plusieurs opérations vidéo.

Prise en charge des 
séquences QuickTime dans 
Pro Tools
Pro Tools prend en charge l'importation, la lecture 
et le montage des séquences QuickTime. 

QuickTime requis
QuickTime doit être installé si vous prévoyez 
d'inclure des fichiers de séquence ou d'importer 
des fichiers MP3 ou MP4 (AAC) dans vos sessions 
Pro Tools. QuickTime pour Windows est 
disponible en téléchargement gratuit sur le site 
Web d'Apple (www.apple.com).

Séquences QuickTime prises en 
charge
Si vous travaillez avec un collaborateur qui 
prépare les séquences QuickTime destinées à être 
utilisées dans Pro Tools, communiquez-lui les 
informations suivantes :

Médias consolidés et référencés : les séquences 
QuickTime DV sont soit des fichiers QuickTime 
complets (fichiers consolidés dans lesquels les 
médias sont copiés dans les fichiers QuickTime), 
soit des fichiers de référence QuickTime (dans 
lesquels uniquement des compositions sont 
présentes dans le fichier QuickTime, pointant vers 
les fichiers média d'origine). 

Avant de commencer votre 
projet
Avant de démarrer un projet incluant de la vidéo, 
prenez en compte les points suivants :

Cadence d'images : avant de recevoir une vidéo, 
renseignez-vous sur sa cadence d'images. Utilisez 
cette valeur pour définir la cadence d'images de 
vos sessions Pro Tools et lors de la capture vidéo.

Application et codec d'origine : avant de recevoir 
une vidéo sous la forme de fichiers média, 
déterminez l'application et le codec utilisés pour sa 
création. Assurez-vous ensuite de pouvoir lire ces 
fichiers dans Pro Tools. Il est recommandé de 
demander un fichier de test au préalable.

Incrustation du timecode de la vidéo : avant de 
recevoir des fichiers vidéo, demandez à ce que le 
timecode soit incrusté (superposé), si possible. 
Cela vous aidera à placer les fichiers aux 
emplacements de timecode appropriés dans la 
timeline de Pro Tools.

Espace suffisant sur les disques vidéo : assurez-
vous de disposer de suffisamment d'espace sur les 
disques dédiés à la vidéo. Les fichiers vidéo 
occupent beaucoup plus d'espace et consomment 
plus de bande passante que les fichiers audio. Il est 
conseillé de stocker les fichiers vidéo sur des 
disques distincts des disques audio pour éviter les 
problèmes de performance.

Pour obtenir la liste des versions de 
QuickTime compatibles avec votre version de 
Pro Tools, rendez-vous sur www.avid.com.



Chapitre 52 : Utilisation de la vidéo dans Pro Tools 1247

Disques séparés dédiés à la vidéo et à l'audio : 
pour obtenir les meilleurs résultats, utilisez toujours 
des disques vidéo et audio distincts. Pour obtenir 
des informations complètes sur la configuration 
requise pour les disques dur, rendez-vous sur 
www.avid.com.

Préférences vidéo de 
Pro Tools

La section Video des préférences de 
fonctionnement de Pro Tools propose les options 
suivantes :

Enable GPU

Le traitement vidéo dans Pro Tools est pris en 
charge par le GPU (Graphics Processing Unit) afin 
de libérer les ressources du CPU pour l'audio et le 
MIDI. Si votre GPU est plus lent et que la lecture 
vidéo est de mauvaise qualité, désactivez cette 
option pour réassigner le traitement vidéo au CPU.

Prevent Tearing

Lorsque cette option est activée, Pro Tools stocke 
la vidéo dans une mémoire tampon pour empêcher 
l'apparition d'artefacts visuels avec un déplacement 
horizontal, lorsque la synchro vidéo ne correspond 
pas à la fréquence de rafraîchissement de l'écran. 
Cette option n'est pas disponible lorsque l'option 
Enable GPU est désactivée.

Enable Hardware During Scrub

Lorsque l'option Enable Hardware During Scrub 
est activée, le monitoring vidéo est pris en charge 
lors d'un scrubbing, via une interface vidéo telle 
que Mojo DX ou Nitris DX. Lorsqu'elle est 
désactivée, seul le monitoring dans la fenêtre 
Video de Pro Tools est possible en cours de 
scrubbing. Si vous rencontrez des problèmes de 
performance lors du scrubbing vidéo, alors que 
vous utilisez du matériel vidéo pour le monitoring, 
désactivez cette option.

Play Start Latency

Si vous travaillez sur un ordinateur lent, choisissez 
une valeur plus élevée pour le paramètre Play Start 

Latency. Les valeurs disponibles vont de 1-Shortest 
à 5-Longest.

Pistes vidéo
Les pistes vidéo permettent d'ajouter ou d'importer 
de la vidéo dans la timeline de la manière 
suivante :

• Pro Tools permet d'ajouter ou d'importer une 
piste vidéo par session, avec une limite d'une 
playlist vidéo et d'un fichier vidéo Avid ou 
QuickTime sur cette piste.

• Pro Tools HD permet d'ajouter plusieurs pistes 
vidéo dans la timeline, avec plusieurs playlists 
vidéo et fichiers vidéo sur chaque piste.

• Pro Tools HD offre la possibilité de mélanger 
des pistes vidéo QuickTime et Avid dans la 
timeline (mais pas sur une même piste vidéo). 

Nouvelles options vidéo des préférences de 
fonctionnement de Pro Tools
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Pour créer une piste vidéo dans Pro Tools, 
effectuez l'une des opérations suivantes :

 Utilisez la commande File > Import pour 
importer un fichier vidéo. 

 Faites glisser un fichier vidéo vers la timeline. 

 Utilisez la commande File > Import > Session 

Data pour importer une session ou une séquence 
AAF contenant une piste vidéo.

Pour plus d'informations, reportez-vous à la 
section « Importation d'une vidéo dans Pro Tools » 
à la page 1258.

Pour créer une nouvelle piste vidéo dans 
Pro Tools HD :

1 Sélectionnez Track > New.

2 Sélectionnez Video Track dans le menu 
Track Type.

3 Entrez le nombre de nouvelles pistes vidéo.

4 Cliquez sur Create.

Une nouvelle piste vidéo apparaît. Les pistes vidéo 
peuvent se présenter de manière légèrement 
différente selon la configuration de votre système 
ou le type de vidéo qu'elles contiennent.

Pistes vidéo multiples dans la 
timeline
(Pro Tools HD uniquement)

Vous pouvez ajouter plusieurs pistes vidéo à la 
timeline, mais elles ne peuvent pas être lues 
simultanément. La piste lue est considérée comme 
la piste vidéo principale.

Playlists multiples de piste 
vidéo
(Pro Tools HD uniquement)

Les playlists donnent la possibilité de basculer 
simplement d'une version d'une piste vidéo à une 
autre.

Vous pouvez réaliser les mêmes opérations avec 
les playlists vidéo qu'avec les playlists audio :

• Duplication d'une playlist

• Création d'une playlist

• Assignation d'une playlist à une autre piste vidéo

• Modification du nom d'une playlist

• Suppression d'une playlist

Codecs multiples sur une même 
piste vidéo
(Pro Tools HD uniquement)

Une piste vidéo peut contenir des clips vidéo 
compressés avec différents codecs vidéo pour un 
même type de vidéo. Vous pouvez par exemple 
ajouter des fichiers QuickTime compressés à l'aide 
de plusieurs codecs sur une même piste vidéo.

Toutefois, après avoir ajouté le premier fichier 
vidéo à une session, tous les fichiers vidéo suivants 
ajoutés à la timeline doivent avoir la même 
cadence d'images vidéo. 

Piste vidéo vide

Pour plus d'informations, reportez-vous au 
Chapitre 29, « Playlists ».
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Piste vidéo principale
La piste vidéo principale est la piste vidéo 
actuellement en ligne. Elle sera lue avec l'audio de 
la session. 

Lorsque la piste vidéo principale est hors ligne, vous 
pouvez lire l'audio de votre session sans vidéo. 
Lorsque la vidéo est hors ligne, le bouton Video 
Online de la piste devient gris. Vous pouvez ainsi 
rapidement savoir si votre vidéo est hors ligne ou si 
la tête de lecture est sur un passage de noir.

Si aucune piste vidéo n'est actuellement en ligne, 
la piste vidéo principale est la dernière piste vidéo 
à avoir été en ligne.

Pour sélectionner la piste vidéo principale :

 Cliquez sur le bouton Video Online d'une piste 
hors ligne (bouton grisé) pour la passer sur l'état 
en ligne (bleu) et la désigner comme piste vidéo 
principale. 

Commandes et indicateurs 
des pistes vidéo

Vue de piste vidéo
La piste vidéo peut être affichée en vue Frames ou 
Blocks ; les limites et métadonnées des clips vidéo 
sont affichées dans ces deux modes. Seule la vue 
Frames permet d'afficher les images vidéo.

Pour définir la vue d'une piste vidéo :

 Sur la piste vidéo, sélectionnez Frames ou 
Blocks dans le menu des vues de piste.

Vue Frames
En vue Frames, les données vidéo sont affichées 
sous la forme d'images sur la piste vidéo. 
La représentation de ces images est fonction de 
l'image vidéo, du niveau de zoom et de la hauteur 
de la piste. Vous pouvez ainsi facilement 
rechercher une scène ou une séquence spécifique.

Si vous modifiez les paramètres de zoom en 
cours de lecture, les images ne s'afficheront pas 
correctement. Des images vides apparaîtront jusqu'à 
ce que la lecture soit arrêtée. Il est conseillé d'arrêter 
la lecture avant de modifier le niveau de zoom.

Si un pull up ou pull down vidéo est actif, 
les images restent à leur emplacement d'origine.

Bouton Video Online (en ligne)

Si vous passez de la vue Blocks à la vue 
Frames en cours de lecture, la piste vidéo 
n'affiche les images qu'après arrêt de la 
lecture.

Piste vidéo en vue Frames
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Performances en vue Frames

Lorsque vous visionnez le contenu d'une piste 
vidéo en vue Frames, il est possible que les 
performances de votre ordinateur soient réduites 
ou même médiocres. Dans ce cas, masquez la piste 
vidéo ou passez en vue Blocks.

Vue Blocks
En vue Blocks, les images sont remplacées par des 
blocs de couleur. 

Icônes des types de piste vidéo
Une icône QuickTime est affichée sur les pistes 
vidéos lorsqu'elles contiennent une vidéo 
QuickTime. Aucune icône n'est affichée pour les 
vidéos Avid ou si la piste vidéo est vide.

Vous pouvez ajouter tout type de vidéo pris en 
charge sur une piste vidéo vide.

Bouton Video Online
Le bouton Video Online permet de sélectionner la 
piste vidéo principale, de la passer en mode en 
ligne ou hors ligne, et de vérifier rapidement si une 
piste est hors ligne (bouton grisé) ou en ligne 
(bouton bleu).

Pour passer une piste vidéo sur l'état en ligne ou 
hors ligne :

 Cliquez sur le bouton Video Online d'une piste 
hors ligne (bouton grisé) pour la passer sur l'état 
en ligne (bleu) et la désigner comme piste vidéo 
principale. 

 Cliquez sur le bouton Video Online de la piste 
vidéo principale pour la passer hors ligne ; 
la sortie vidéo de Pro Tools est alors inactive.

Piste vidéo affichée en vue Blocks

Icône QuickTime d'une piste vidéo

Icône 
QuickTime

Bouton Video Online (hors ligne (en haut) et en ligne 
(en bas))

Dans Pro Tools HD, appuyez sur Maj+J 
pour parcourir toutes les pistes vidéo 
affichées et déterminer celle qui est en ligne.
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Paramètres des pistes vidéo
Pro Tools fournit des paramètres pour les pistes 
vidéo qui affectent le type de projet, la sortie et la 
qualité vidéo en lecture.

Pour afficher ou masquer les commandes des 
pistes vidéo dans la fenêtre Edit :

 Sélectionnez ou désélectionnez View > Edit 

Window Views > I/O.

Type de projet
Bien que Pro Tools ne permette pas de mélanger 
des cadences d'images différentes, vous pouvez 
travailler avec des résolutions différentes. 
Le sélecteur de type de projet permet de spécifier 
le type de projet (résolution) le plus proche des 
diverses résolutions de la session. En général, 
le type de projet n'a pas à être modifié.

Pour les vidéos Avid MXF, le type de projet est 
défini automatiquement. Cependant, lorsque 
vous travaillez avec des résolutions différentes, 
Pro Tools permet de définir la résolution la plus 
proche pour la session à l'aide du sélecteur de type 

de projet.

Les résolutions vidéo suivantes sont disponibles 
pour définir le type de projet (en fonction de vos 
médias et de la configuration de la session) :

* Le format de sortie vidéo peut être affiché sur le 
moniteur externe.

Nouvelles commandes de piste vidéo

Type de projet
Qualité vidéo
Paramètres de 
sortie

Formats vidéo pris en charge

Format 
vidéo

Fréquence 
référence 
vidéo

Cadence 
d'images 
Pro Tools

Format 
de sortie 
vidéo*

30i NTSC NTSC 29.97 NTSC

25i PAL PAL 25 PAL

23.976p 
NTSC

NTSC 23.976 NTSC

24p NTSC NTSC 24 NTSC

24p PAL PAL 24 PAL

25p PAL PAL 25 PAL

720p/ 
23.976

720p/ 59.94 
ou NTSC

23.976 720p/
59.94

720p/25 720p/25 ou 
PAL

25 720p/25

720p/ 
29.97

720p/ 59.94 
ou NTSC

29.97 720p/ 
59.94

720p/50 720p/50 ou 
PAL

25 720p/50

720p/ 
59.94

720p/ 59.94 
ou NTSC

29.97 720p/ 
59.94

1080i/ 50 1080i/50 ou 
PAL

25 1080i/50

1080i/ 
59.94

1080i/ 
59.94 ou 
NTSC

29.97 1080i/ 
59.94

1080p/
23.976

1080psf/ 
23.98

23.976 1080psf/
23.98

1080p/ 24 1080psf/
24

24 1080psf/
24

1080p/25 1080psf/50 
ou PAL

25 1080psf/ 
50

1080p/ 
29.97

1080psf/ 
29.97 ou 
NTSC

29.97 1080psf/ 
29.97
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Média QuickTime

Lorsque vous importez une séquence QuickTime, 
les conditions suivantes peuvent s'appliquer :

Pro Tools sélectionne automatiquement la cadence 
d'images et le type de projet lors de l'importation, 
en se basant sur la cadence d'images et la 
résolution de la séquence QuickTime.

Si plusieurs types de projets sont possibles, 
Pro Tools vous permet de sélectionner un type de 
projet parmi ceux qui correspondent le plus.

Si la cadence d'images est proche d'une valeur 
entière, Pro Tools l'arrondit à la cadence d'images 
la plus proche (par exemple, 29.972 sera arrondi 
à 29.97).

Pour les médias QuickTime importés dont le type 
de projet est inconnu (tels que des images fixes ou 
captures d'écran), sélectionnez le type de projet le 
plus adapté aux autres vidéos de la session.

Paramètres de sortie
Pro Tools dispose d'une fenêtre de paramètres de 
sortie pour configurer votre périphérique vidéo 
Avid ou tiers qualifié par Avid. Les paramètres de 
sortie sont enregistrés sur le système. Le bouton 
des paramètres de sortie n'est pas disponible 
lorsque vous travaillez avec de la vidéo sans 
périphérique vidéo.

Pour configurer les paramètres de sortie pour 
votre périphérique vidéo :

1 Sur une piste vidéo existante ou nouvellement 
créée, cliquez sur le bouton des paramètres 
de sortie.

2 Si un boîtier Avid Mojo DX ou Avid Nitris DX 
est connecté, l'outil Video Output Tool s'ouvre. 
Si un périphérique vidéo tiers est connecté 
(un boîtier vidéo Blackmagic ou AJA pris en 
charge par Avid par exemple), son panneau de 
configuration s'ouvre.

3 Configurez les paramètres de sortie pour votre 
périphérique vidéo Avid ou ceux du panneau de 
configuration du périphérique tiers.

Options des paramètres de sortie

Dans la fenêtre de l'outil Video Output Tool, 
cliquez sur l'onglet Options pour configurer les 
options de sortie vidéo correspondant à votre 
matériel vidéo et au type de projet.

Maintenez la touche Commande (Mac) ou 
Ctrl (Windows) enfoncée et cliquez pour 
ignorer le paramètre sélectionné dans 
Pro Tools et choisir un autre type de projet.

Onglet Options de l'outil Video Output Tool (boîtier 
Nitris DX)
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Une ou plusieurs des options suivantes sont 
disponibles dans la boîte de dialogue Video Output 
Tool en fonction de votre matériel vidéo, du type 
de projet et des résolutions vidéo. L'outil Video 
Output Tool n'est pas disponible sur les systèmes 
qui n'utilisent pas de matériel vidéo Avid. Pour les 
systèmes qui utilisent du matériel tiers (un boîtier 
vidéo Blackmagic ou AJA pris en charge par Avid 
par exemple), le bouton des paramètres de sortie 
ouvre le panneau de configuration de votre 
matériel vidéo.

Sync Lock

Le paramètre Sync Lock verrouille votre périphérique 
vidéo sur une référence externe ou une horloge 
interne. Pro Tools détecte automatiquement le type 
de votre matériel vidéo Avid et affiche les options 
appropriées parmi les suivantes :

• Options pour Mojo DX :

• Internal

• Reference

• Options pour Nitris DX :

• Internal

• Loop Through

• Ref 1

• Ref 2

Si une SYNC HD est installée et activée, et si 
le paramètre Clock Reference est défini sur 
Video Reference dans la fenêtre Session Setup, 
les formats suggérés sont mis en surbrillance dans 
le sélecteur Video Ref Format de la fenêtre Session 
Setup.

HDMI Color Space

Les options HDMI Color Space sont dynamiques et 
varient selon qu'un boîtier Mojo DX ou un 
Nitris DX est connecté ou non, ainsi qu'en fonction 
d'autres paramètres. Le paramètre HDMI Color 

Space détermine le standard colorimétrique 
(YCbCr ou conversion en RVB) à utiliser pour 
votre sortie HDMI (High-Definition Multimedia 
Interface). Du matériel vidéo Avid compatible 
HDMI doit être connecté à votre système.

HDMI Format

Lorsque vous travaillez avec de la vidéo SD, 
ce paramètre propose les options suivantes :

• SD Interlaced

• SD Progressive

Formats de référence vidéo dans la fenêtre Session 
Setup
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Output PSF ou True Progressive

Lorsque vous travaillez avec de la vidéo HD, 
ce paramètre permet d'alterner entre les formats de 
sortie PSF et progressif pour votre matériel :

• PSF Output

• True Progressive

NTSC Has Setup

Cette option détermine le mappage de couleurs 
correct pour votre système, selon que vous utilisez 
la norme NTSC-EIAJ ou non. Les utilisateurs de la 
norme NTSC-EIAJ ne doivent pas sélectionner 
cette option. Tous les autres utilisateurs doivent la 
sélectionner.

Paramètres Calibration de l'outil Video 
Output Tool
(Nitris DX uniquement)

Dans la fenêtre Video Output Tool, cliquez sur 
l'onglet Calibration pour configurer les paramètres 
d'étalonnage de la sortie vidéo. Menu Output pour les vidéos non HD

Le sélecteur Output permet de choisir entre les 
formats Component, Composite ou S Video pour 
les projets non HD.

Sur certains systèmes, toutes les sorties de votre 
matériel vidéo sont actives. Sélectionnez un signal 
analogique dans le menu Output pour étalonner 
la sortie.

Hue : ajuste un attribut de perception des couleurs 
basé sur des proportions variables de rouge, vert et 
bleu dans le signal vidéo (également appelé phase 
couleur). Disponible pour une sortie S Video ou 
Composite.

Sat : ajuste la saturation, une mesure de la 
chrominance ou de l'intensité des couleurs dans le 
signal vidéo. Disponible pour les sorties S Video 
ou Composite.

Onglet Calibration de la fenêtre Video Output Tool 
(sortie Composite sélectionnée)
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SC Phase : ajuste la phase de la sous-porteuse 
(les informations de couleur d'un signal utilisé 
pour synchroniser deux signaux vidéo ou plus). 
Disponible pour les sorties S Video ou Composite.

Setup : définit la luminosité et l'obscurité relatives 
des images. Disponible pour une sortie S Video, 
Component ou Composite.

Gain : ajuste la variation des zones les plus 
lumineuses par rapport aux zones les plus sombres 
de l'image. Disponible pour les sorties S Video ou 
Composite.

Y Gain, Pr Gain, Pb Gain : disponibles 
uniquement pour une sortie Component.

Y Gain : ajuste le gain du signal Y, une mesure de 
la luminance (Y) du signal vidéo qui correspond au 
point le plus blanc de l'image visible. Utilisez les 
barres de couleurs pour régler le niveau de blanc.

Pb Gain : ajuste le gain du signal de différence de 
couleur Pb (une version dérivée du signal BY) d'un 
système composante analogique.

Pr Gain : ajuste le gain du signal de différence de 
couleur Pr (une version dérivée du signal RY) d'un 
système composante analogique.

System Phase

Certaines configurations matérielles vidéo Avid 
permettent d'ajuster le timing du signal de sortie et 
d'un signal de référence. Cette option est disponible 
pour une sortieS Video, Component ou Composite.

SubPixel HPhase

Le paramètre SubPixel HPhase permet un 
ajustement précis de la phase horizontale. 
Disponible pour une sortie S Video, Component 
ou Composite.

Menu Output pour des vidéos HD

Le menu Output permet de sélectionner une sortie 
HD Component, Convert to HD Component RGB 
ou HD Component YPbPr.

Gain : ajuste une mesure de la luminance (Y) dans 
le signal vidéo qui correspond au point le plus 
blanc de l'image visible. Utilisez les barres de 
couleurs pour régler le niveau de blanc. Disponible 
sur certains systèmes pour une sortie 
HD Component RGB ou HD Component YPbPr.

Pb Gain : sur certaines configurations matérielles 
vidéo Avid, le paramètre Pb Gain ajuste le gain du 
signal de différence de couleur Pb, version dérivée 
du signal BY, dans l'espace colorimétrique BT. 
709 sur des systèmes composante HD. 
Ce paramètre est disponible pour une sortie 
HD Component YPbPr.

Pr Gain : sur certaines configurations matérielles 
vidéo Avid, le paramètre Pr Gain ajuste le gain du 
signal de différence de couleur Pr, version dérivée 
du signal RY, d'un système composante analogique. 
Disponible uniquement pour une sortie Component.

System Phase

Le paramètre System Phase permet de moduler le 
timing du signal de sortie et d'un signal de référence. 
Cette option est disponible pour une sortie 
HD Component RGB ou HD Component YPbPr.

Sub Pixel H Phase

Le paramètre Sub Pixel H Phase permet d'ajuster 
l'intervalle d'espacement horizontal utilisé pour 
synchroniser deux ou plusieurs signaux vidéo. 
Le paramètre Sub Pixel H Phase est disponible 
pour une sortieS Video, Component ou Composite.
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Qualité vidéo
Utilisez le sélecteur de qualité vidéo pour définir 
la qualité de la vidéo de la piste en lecture. 
Les options disponibles vont de performances 
optimales (qualité vidéo la plus basse) à qualité 
optimale.

Les options suivantes sont disponibles :

Full Quality

Sélectionnez l'optionFull Quality pour traiter et lire 
des images full raster dans un projet. Le paramètre 
Full Quality utilise une résolution de 8 bits. Cette 
option fournit la meilleure qualité de lecture vidéo 
en traitant chaque pixel des images. Dans les 
projets entrelacés, la largeur totale de chaque ligne 
des deux trames est traitée. Dans les projets 
progressifs, la largeur totale de chaque ligne de 
balayage est traitée.

Full Quality 10-bit

Sélectionnez l'optionFull Quality 10-bit pour traiter 
et lire des images full raster dans un projet. Cette 
option utilise une résolution de 10 bits, qui offre 
une qualité de traitement supérieure. Elle n'est 
disponible que lorsqu'un périphérique vidéo est 
connecté.

Draft

Sélectionnez l'optionDraft pour traiter et lire des 
images full raster dans un projet, en utilisant le 
quart des informations des images. L'option Draft 
utilise une résolution de 8 bits. Un sous-
échantillonnage de 50 % de la largeur du raster est 
appliqué. Pour les projets entrelacés, une seule 
trame est exploitée. Pour les projets progressifs, 
50 % des lignes de balayage sont exploitées.

Best Performance

Sélectionnez l'option Best Performance pour traiter 
et lire des images full raster dans un projet, 
en utilisant le seizième des informations des 
images. L'option Best Performance utilise une 
résolution de 8 bits. Un sous-échantillonnage de 
25 % de la largeur du raster est appliqué. Pour les 
projets entrelacés, 50 % des lignes d'une seule trame 
sont exploitées. Pour les projets progressifs, 25 % 
des lignes de balayage sont exploitées. Cette option 
n'est pas disponible avec du matériel vidéo tiers.

Verrouillage des pistes vidéo
Vous pouvez verrouiller une ou plusieurs pistes 
vidéo pour interdire toute opération sur les clips 
vidéo qu'elles contiennent.

Lorsqu'une piste vidéo est verrouillée, Pro Tools 
restreint toutes les opérations d'édition impliquant 
la piste (sauf celles relatives au verrouillage et au 
déverrouillage des clips vidéo).

Un petit cadenas est affiché sur les pistes vidéos 
verrouillées, pour indiquer qu'elle ne peut être 
éditée. Le cadenas n'est pas affiché si la hauteur de 
piste est défini sur Mini.

Pour verrouiller une piste vidéo :

1 Sélectionnez les pistes vidéo à verrouiller.

2 Effectuez l'une des opérations suivantes :

• Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée et cliquez sur le nom 
d'une piste vidéo sélectionnée, puis sélectionnez 
Locked.

• Effectuez un clic droit sur le nom d'une piste 
vidéo sélectionnée, puis sélectionnez Locked.
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Le verrouillage ou le déverrouillage d'une piste 
vidéo n'a pas d'effet sur l'état de verrouillage des 
clips individuels. Si un clip a été verrouillé avant la 
piste, il conserve cet état lorsque la piste est 
déverrouillée. Cependant, le fait de déverrouiller 
un clip d'une piste verrouillée ne permet pas de 
l'éditer. Tant que la piste est verrouillée, le clip se 
comporte comme s'il était verrouillé.

Cadence du moteur vidéo
La cadence du moteur vidéo représente le nombre 
d'images vidéo que Pro Tools affiche par seconde. 
Elle est calculée automatiquement d'après la 
cadence d'images du premier fichier vidéo ajouté 
à une session. Les fichiers vidéo ajoutés par la 
suite à la session doivent être de la même cadence 
d'images que celle du moteur vidéo.

La cadence d'images vidéo est indiquée pour 
chaque fichier vidéo dans les navigateurs de 
l'espace de travail ; la cadence d'images actuelle du 
moteur vidéo est affichée dans la vue I/O de la 
piste vidéo principale.

La cadence d'images n'est pas liée à la fréquence de 
timecode de la session, qui détermine le nombre 
d'images affichées par seconde dans les grilles, 
les règles et les compteurs. Vous pouvez définir 
manuellement la fréquence de timecode de la 
session à l'aide du menu Timecode Rate de la 
fenêtre Session Setup. Pour aligner les grilles et 

règles sur les images des fichiers vidéo dans la 
timeline, le paramètre Timecode Rate de la session 
doit être défini de manière à correspondre à la 
cadence du moteur vidéo.

Indicateur de cadence du 
moteur vidéo
L'indicateur de cadence du moteur vidéo est 
affiché uniquement sur la piste vidéo principale 
(qu'elle soit en ligne ou hors ligne) et indique la 
cadence du moteur vidéo, égale au nombre 
d'images vidéo que Pro Tools affiche par seconde. 

L'indicateur de cadence du moteur vidéo est 
habituellement de couleur blanche, mais il devient 
rouge dans les conditions suivantes :

• La cadence du moteur vidéo ne correspond pas à la 
fréquence de timecode actuelle de la session.

• Un pull up a été appliqué à la vidéo, ce qui engendre 
une différence entre la cadence du moteur vidéo et la 
fréquence de timecode de la session.

Il est possible de verrouiller les clips vidéo 
individuels en édition ou temporellement. 
Pour plus d'informations sur le verrouillage 
des clips, reportez-vous à la section 
« Verrouillage des clips » à la page 866.

Pour plus d'informations sur l'indicateur de 
cadence du moteur vidéo de la vue I/O, 
reportez-vous à la section « Indicateur de 
cadence du moteur vidéo » à la page 1257.

Cadence d'images vidéo

La fréquence de timecode peut être 
configurée dans la fenêtre Session Setup. 
Pour plus d'informations, reportez-vous 
à la section « Fenêtre Session Setup » 
à la page 1193.

Pour plus d'informations, reportez-vous 
à la section « Pull up et pull down » 
à la page 1201 pour obtenir des informations 
détaillées sur l'utilisation des pull up et pull 
down vidéo.
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Importation d'une vidéo dans 
Pro Tools
Pro Tools propose les méthodes suivantes 
d'importation de fichiers vidéo dans la timeline, 
la liste des clips et les pistes vidéo, nouvelles ou 
existantes :

• Utilisation de la commande d'importation vidéo 
(File > Import > Video).

• Glisser-déposer depuis la liste des clips vers la 
timeline (Pro Tools HD uniquement)

• Glisser-déposer à partir d'un navigateur de 
l'espace de travail, de l'Explorateur Windows ou 
du Finder Mac.

• Utilisation de la commande Import Session Data 
(File > Import > Session Data), pour importer 
une vidéo d'une autre session Pro Tools ou d'un 
fichier AAF, mais aucun fichier vidéo 
individuel.

Importation d'une vidéo dans 
Pro Tools à l'aide de la 
commande Import Video
La commande de menu Import Video permet de 
choisir un ou plusieurs fichiers vidéo à importer 
dans Pro Tools. 

Lorsque vous utilisez cette méthode d'importation 
vidéo, la boîte de dialogue Video Import Options 
s'affiche. Cette boîte de dialogue contient plusieurs 
options visant à personnaliser le mode 
d'importation des fichiers.

Pour importer une vidéo dans Pro Tools à l'aide de 
la commande Import Video :

1 Effectuez l'une des opérations suivantes :

• Sélectionnez File > Import > Video.

• Appuyez sur Commande+Option+Maj+I (Mac) 
ou Ctrl+Alt+Maj+I (Windows).

2 Dans la boîte de dialogue Select Video File 
to Import, sélectionnez un ou plusieurs 
fichiers vidéo.

3 Cliquez sur Open.

4 Configurez les options d'importation vidéo et 
cliquez sur OK pour importer la vidéo dans 
Pro Tools.

La cadence d'images du premier fichier vidéo 
ajouté à une session détermine la cadence du 
moteur vidéo de la session. Les fichiers vidéo 
ajoutés par la suite à la session doivent être 
de la même cadence d'images que celle du 
moteur vidéo.

En général, les médias audio et vidéo doivent 
être stockés sur des disques dédiés distincts. 
Lors de l'importation simultanée d'audio et 
de vidéo avec liaison aux médias, Pro Tools 
peut cependant les copier sur le même 
disque. Pour éviter des problèmes de 
performances, déplacez la vidéo sur un 
disque de lecture vidéo avant d'importer 
l'audio et la vidéo dans votre session. 

Dans un navigateur de l'espace de travail, 
il est possible de configurer vos disques audio 
afin qu'ils puissent lire ou enregistrer de 
l'audio et uniquement transférer de la vidéo, 
ou vice versa. Utilisez ces paramètres pour 
garantir que l'audio et la vidéo sont stockés 
sur les bons volumes. Pour des informations 
détaillées, reportez-vous à la section 
« Permissions des volumes » à la page 286.

Reportez-vous à la section « Configuration des 
options d'importation vidéo » à la page 1260 
pour obtenir des instructions détaillées.
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Importation d'une vidéo dans 
Pro Tools par glisser-déposer
Vous pouvez faire glisser les fichiers vidéo à partir 
d'un navigateur de l'espace de travail ou depuis 
l'Explorateur Windows ou le Finder Mac pour les 
déposer dans la timeline, sur une piste, dans la liste 
des pistes ou la liste des clips.

Lorsque vous utilisez cette méthode d'importation 
vidéo, la boîte de dialogue Video Import Options 
s'affiche. Cette boîte de dialogue contient plusieurs 
options visant à personnaliser le mode 
d'importation des fichiers. 

Pour importer une vidéo dans Pro Tools par 
glisser-déposer :

1 Faites glisser un ou plusieurs fichiers vidéo 
à partir d'un navigateur de l'espace de travail ou 
depuis l'Explorateur Windows ou le Finder 
Mac, puis déposez-les dans la timeline, dans la 
liste des pistes ou sur une piste vidéo existante.

2 Configurez les options d'importation vidéo et 
cliquez sur OK pour importer la vidéo dans 
Pro Tools.

Importation d'une vidéo dans 
Pro Tools à l'aide de la 
commande Import Session Data
Vous pouvez utiliser la commande Import Session 
Data pour importer une vidéo provenant d'autres 
sessions Pro Tools ou d'une séquence AAF. Les 
fichiers vidéo importés doivent être à la même 
cadence d'images que celle des fichiers vidéo déjà 
présents dans la session.

Glisser-déposer de fichiers 
vidéo de la liste des clips vers la 
timeline
(Pro Tools HD uniquement)

Vous pouvez ajouter des fichiers vidéo à la 
timeline en les faisant glisser directement de la 
liste des clips vers une piste vidéo.

Pour ajouter des fichiers vidéo à une piste vidéo 
en les faisant glisser depuis la liste des clips :

1 Sélectionnez un ou plusieurs fichiers vidéo dans 
la liste des clips.

2 Dans l'un des modes d'édition, faites glisser les 
fichiers vidéo sélectionnés vers une zone vierge 
de la timeline (pour créer une nouvelle piste 
vidéo) ou sur une piste vidéo existante (pour les 
placer sur cette piste).

Reportez-vous à la section « Configuration 
des options d'importation vidéo » 
à la page 1260 pour obtenir des instructions 
détaillées.

Pour plus d'informations sur l'importation de 
données de session, reportez-vous à la 
section « Importation de données de 
session » à la page 352.
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Configuration des options 
d'importation vidéo
La boîte de dialogue Video Import Options 
s'affiche lorsque vous importez de la vidéo dans 
Pro Tools à l'aide de la commande Import Video 
ou que vous faites glisser des fichiers vidéo depuis 
un navigateur de l'espace de travail, l'Explorateur 
Windows ou le Finder Mac.

Section Destination
La section Destination de la boîte de dialogue 
Video Import Options permet de choisir la 
destination générale de la vidéo importée dans 
Pro Tools.

Main Video Track : le fichier vidéo est importé 
directement sur la piste actuellement en ligne 
(considérée comme la piste vidéo principale) 
et dans la liste des clips. Si aucune piste n'est en 
ligne, le fichier vidéo est importé sur la dernière 
piste vidéo qui était en ligne.

New Track : chaque fichier vidéo est importé sur 
sa propre piste et dans la liste des clips.

Clip List (Pro Tools HD uniquement) : chaque 
fichier vidéo est importé directement dans la liste 
des clips à partir de laquelle vous pourrez le faire 
glisser vers la timeline.

Menu déroulant Location
Si la liste des clips n'est pas sélectionnée comme 
destination dans la section Destination, le menu 
déroulant Location permet de choisir précisément 
à quel endroit de la timeline Pro Tools doit placer 
la vidéo importée.

Session Start : place le fichier vidéo au début 
de la session.

Song Start : place le fichier vidéo au niveau du 
marqueur de début de morceau.

Selection : place le fichier vidéo au niveau du 
curseur d'édition ou dans la sélection (le cas 
échéant).

Spot : affiche la boîte de dialogue Spot à partir de 
laquelle vous pouvez positionner la vidéo à des 
endroits précis en vous basant sur l'une des 
échelles temporelles.

Original Time Stamp (vidéo Avid uniquement) : 
place la vidéo Avid sur la timeline à l'emplacement 
de timecode correspondant aux marqueurs 
temporels de la bande source d'origine. Dans le cas 
de plusieurs fichiers vidéo, cette option permet de 
les placer tous dans la timeline sur leurs marqueurs 
temporels respectifs.

Boîte de dialogue Video Import Options

Pour plus d'informations, reportez-vous à la 
section « Contournement de la boîte de 
dialogue Video Import Options » 
à la page 1261 pour obtenir des détails sur le 
contournement de la boîte de dialogue Video 
Import Options lors du glisser-déposer de 
fichiers vidéo.
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Options d'importation vidéo 
supplémentaires
Gaps Between Clips (Pro Tools HD uniquement) :  
lorsque vous importez plusieurs fichiers vidéo sur 
une piste, ils sont placés par défaut les uns à la suite 
des autres. Cette option permet d'indiquer le 
nombre de secondes séparant chaque clip vidéo 
importé sur la piste vidéo.

Import Audio from File (vidéo QuickTime 
uniquement) : lorsque cette option est 
sélectionnée, l'audio du fichier vidéo QuickTime 
importé est extrait et placé sur de nouvelles pistes 
audio mono ou stéréo dans la timeline (l'audio 
mono ou stéréo dont la fréquence 
d'échantillonnage maximale est de 48 kHz est pris 
en charge). Lorsque cette option est 
désélectionnée, seules les données vidéo du fichier 
vidéo sont importées dans Pro Tools.

Remove Existing Video Tracks : lorsque cette 
option est sélectionnée, toutes les pistes vidéo 
existantes sont supprimées avant que Pro Tools 
n'importe une vidéo dans la session.

Remove Existing Video Clips : lorsque cette 
option est sélectionnée, tous les clips vidéo 
existants sont supprimés de la timeline et de la liste 
des clips avant que Pro Tools n'importe une vidéo 
dans la session (ils sont toujours présents sur le 
disque). Cette option est utile si vous souhaitez 
importer un fichier vidéo dans la session dont la 
cadence d'images ne correspond pas à celle du 
moteur vidéo actuelle. 

Clear Main Video Track Playlist : lorsque cette 
option est sélectionnée, tous les clips vidéo 
existants de la playlist actuellement sélectionnée 
sur la piste vidéo principale sont supprimés de la 
piste avant que Pro Tools n'importe une vidéo dans 

la session. Aucune autre playlist, piste vidéo ou 
clip vidéo ne sera affecté. Cette option est 
disponible seulement si la piste vidéo principale 
est sélectionnée en tant que destination.

Contournement de la boîte de 
dialogue Video Import Options
Vous pouvez contourner la boîte de dialogue 
Video Import Options lorsque vous faites glisser 
des fichiers vidéo dans Pro Tools. Les fichiers 
vidéo sont ajoutés à l'endroit précis de la timeline 
où vous les déposez en fonction du mode d'édition 
actuel de Pro Tools.

Pour contourner la boîte de dialogue Video Import 
Options lors de l'importation des données vidéo 
dans Pro Tools :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et faites glisser un ou plusieurs 
fichiers vidéo à partir d'un navigateur de 
l'espace de travail, de l'Explorateur Windows ou 
du Finder Mac vers la liste des clips ou la 
timeline.

Importation de l'audio d'un 
clip vidéo QuickTime
Dans Pro Tools, vous pouvez effectuer un clic 
droit sur des clips vidéos QuickTime pour importer 
l'audio des clips de la séquence QuickTime 
d'origine, même si vous avez importé la vidéo 
QuickTime sans l'audio associé.

Pour importer de l'audio à partir d'un clip vidéo 
QuickTime :

1 Effectuez un clic droit sur un clip vidéo 
QuickTime présent sur une piste vidéo ou dans 
la liste des clips.

2 Sélectionnez Import Audio From Movie.

Pour plus d'informations, reportez-vous à la 
section « Cadence du moteur vidéo » 
à la page 1257.
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3 Dans la boîte de dialogue qui s'affiche, spécifiez 
l'emplacement d'enregistrement du fichier 
audio et cliquez sur Open.

4 Dans la boîte de dialogue Audio Import 
Options, spécifiez la destination de l'audio 
importé : Clip List ou New Track.

5 Pour l'option New Track, sélectionnez un 
emplacement pour l'audio :

• Session Start 

• Song Start 

• Selection 

• Spot 

6 Cliquez sur OK pour importer l'audio (ou sur 
Cancel pour annuler l'importation).

Qualité de conversion de la 
fréquence d'échantillonnage 
Si vous importez de l'audio QuickTime qui n'a pas 
été enregistré à la fréquence d'échantillonnage de 
la session, la fréquence d'échantillonnage est 
convertie afin de correspondre à celle de l'audio de 
la session. Pro Tools permet de choisir la qualité 
de conversion de la fréquence d'échantillonnage 
à l'aide du paramètre Conversion Quality des 
préférences de traitement. 

Il existe cinq paramètres, classés par ordre 
croissant de qualité (de Low à Tweak-Head). Plus 
la qualité de conversion de la fréquence 
d'échantillonnage est élevée, plus la conversion du 
fichier bouncé est longue.

Pour définir la qualité de conversion de la 
fréquence d'échantillonnage :

1 Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Processing.

2 Cliquez sur le menu déroulant Conversion 

Quality et sélectionnez un paramètre de 
conversion.

Clips vidéo
Vous pouvez créer des clips vidéo qui se 
comportent de façon semblable aux clips audio. 

Un clip vidéo est un segment de données vidéo et 
peut correspondre à une portion de vidéo ou à un 
fichier vidéo entier. Dans Pro Tools, les clips 
vidéo sont créés à partir de fichiers vidéo 
QuickTime ou Avid et peuvent être organisés dans 
les playlists de piste vidéo correspondantes. Il est 
possible de grouper des clips vidéo, de créer des 
boucles et de leur appliquer un code couleur.

Lorsque vous utilisez Pro Tools HD, vous pouvez 
ajouter, éditer et modifier les options d'affichage 
des clips vidéo de la même façon que pour des 
clips audio. Toutes les opérations d'édition 
appliquées aux clips vidéo sont non destructives 
(pour plus d'informations, reportez-vous à la 
section « Édition vidéo générale » à la page 1263).

Comme pour les clips audio, Pro Tools affiche les 
clips vidéo dans la liste des clips ou dans la 
timeline (reportez-vous à la section « Clips vidéo 
dans la liste des clips » à la page 1263).

Clip vidéo en vue Frames dans la timeline
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Dans Pro Tools, les clips vidéo sont soumis aux 
limitations suivantes :

• Vous ne pouvez ajouter qu'un seul clip vidéo 
à une session. Il peut être lu, mais ne peut être 
édité. Il n'apparaît pas dans la liste des clips.

• Lorsque vous importez une vidéo ou ouvrez une 
session créée dans Pro Tools HD, seule la piste 
principale ou la première piste vidéo disponible 
contenant des clips QuickTime est importée. 
Il est possible de lire et de visionner plusieurs 
clips et de passer d'une limite de clip à une autre 
à l'aide de la touche tabulation. En revanche, 
il est impossible de les éditer.

Clips vidéo dans la liste des clips
(Pro Tools HD uniquement)

Dans la liste des clips, chaque clip vidéo est 
identifié par une petite icône vidéo en regard de 
son nom.

Affichage ou masquage des 
clips vidéo de la liste des clips
Le menu de la liste des clips contient des 
commandes permettant d'afficher ou de masquer 
les clips vidéo dans la liste des clips.

Pour afficher ou masquer des clips vidéo dans la 
liste des clips :

1 Dans la fenêtre Edit, cliquez sur le menu de la 
liste des clips et sélectionnez Show.

2 Sélectionnez l'option Video pour afficher ou 
masquer les clips vidéo.

Édition vidéo générale
(Pro Tools HD uniquement)

La plupart des opérations d'édition disponibles 
pour les clips audio s'appliquent également aux 
clips vidéo. Cette section présente toutes les 
opérations d'édition vidéo disponibles. Sauf 
indication contraire, la procédure à suivre pour 
chaque tâche d'édition vidéo est la même que pour 
la tâche d'édition audio correspondante.

Fonctions d'édition vidéo de base

• Édition non destructive

• Affichage des noms et positions temporelles des 
clips et d'autres données dans les playlists

• Plusieurs playlists vidéo

• Multiples niveaux d'annulation

• Clips vidéo et groupes de clips vidéo dans la liste 
des clips

• Tous les modes d'édition

• Tous les outils d'édition (à l'exception des outils de 
compression/extension temporelle et du Crayon)

Icône de clip vidéo dans la liste des clips

Pour plus d'informations, reportez-vous au 
Chapitre 15, « La liste des clips ».

Pour plus d'informations sur les opérations 
d'édition, reportez-vous à la section 
appropriée de ce manuel.
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Lecture et sélection du contenu des pistes 
vidéo

• Sélection à l'intérieur des limites d'image vidéo 
(reportez-vous à la section « Sélection à l'intérieur 
des limites d'images vidéo » à la page 1265)

• Sélection et édition sur plusieurs pistes (reportez-
vous à la section « Sélection et édition sur 
plusieurs pistes audio et vidéo » à la page 1265)

• Liaison ou dissociation des sélections de piste et 
d'édition

• Défilement automatique des pistes vidéo

• Lecture en boucle

• Fenêtre Video Universe (reportez-vous à la 
section « Affichage d'une vidéo dans la fenêtre 
Video Universe » à la page 1268)

Manipulation des clips et des sélections

• Capture de clips

• Séparation de clips et outil de saisie dédié

• Chevauchements avec recouvrement et 
superposition

• Toutes les commandes de trim, sauf trim TCE

• Suppression des séparations de clips

• Positionnement, alignement, glissement, 
permutation et placement de clips

• Déplacement par incrémentation (quantification 
sur les limites d'images)

• Commande Shift (déplacement du contenu de la 
piste vers l'avant ou l'arrière d'une valeur 
spécifique)

• Quantification des clips sur la grille (arrondie à 
l'image vidéo la plus proche)

• Commande Replace Clip

• Commandes Cut, Copy, Paste et Clear

• Commandes spéciales Cut, Copy, Paste et Clear

• Répétition pour remplir la sélection

• Édition sur plusieurs pistes

• Commande Duplicate

• Commande Repeat

• Groupes de clips (reportez-vous à la section 
« Groupes de clips vidéo » à la page 1266)

• Lecture en boucle des clips

Gestion des clips

• Insertion d'espace (reportez-vous à la section 
« Insertion d'un espace sur les pistes vidéo à 
l'aide de la commande Insert Silence » 
à la page 1265)

• Commande Compact Selected (sans effet sur la 
vidéo, une piste audio au moins doit être 
sélectionnée)

• Toutes les commandes d'attribution de nom et 
d'affichage des clips

Opérations d'édition générales 
non applicables aux clips vidéo
Les opérations d'édition suivantes sont applicables 
aux clips audio, mais pas aux clips vidéo :

• Fondus

• Muter/démuter les clips

• Plug-ins AudioSuite

• Réparation de la forme d'onde avec le Crayon

• Suppression du silence

• Consolidation des clips
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Sélection et édition sur 
plusieurs pistes audio et vidéo
Vous pouvez sélectionner plusieurs pistes audio et 
vidéo et couper, copier ou coller simultanément de 
l'audio et de la vidéo.

Les données audio et vidéo sélectionnées et 
coupées, copiées ou collées dépendent du mode 
d'édition utilisé.

Sélection à l'intérieur des 
limites d'images vidéo
Pro Tools ne permet pas de sélectionner, lire ou 
éditer une image vidéo partielle. Les règles 
suivantes s'appliquent à la sélection ou à l'édition 
de vidéo :

• Lorsque vous faites une sélection sur une piste 
vidéo, les limites de la sélection respectent le 
paramètre de grille actuel, mais sont arrondies à 
la limite d'image vidéo la plus proche, comme 
suit :

• Si la sélection inclut plus de la moitié d'une 
image vidéo, l'image vidéo complète est 
comprise dans la sélection.

• Si la sélection inclut moins de la moitié d'une 
image vidéo, cette image vidéo est exclue de 
la sélection vidéo.

• Lorsque vous collez une sélection contenant de 
la vidéo sur une piste vidéo, le point d'insertion 
s'aligne automatiquement sur la limite d'image 
vidéo la plus proche.

Insertion d'un espace sur les 
pistes vidéo à l'aide de la 
commande Insert Silence
La commande Insert Silence permet d'effectuer 
une sélection sur une ou plusieurs pistes et 
d'insérer précisément la quantité d'espace 
correspondante. Votre sélection peut s'appliquer 
à plusieurs pistes vidéo et audio. Il suffit alors 
d'exécuter la commande Insert Silence pour insérer 
à la fois un silence audio et un espace.

Sélection et édition sur plusieurs pistes (mode Slip)

Lorsque vous collez simultanément de l'audio 
et de la vidéo, il est possible que l'audio ne 
soit plus positionné à l'endroit exact que vous 
aviez choisi. Dans ce cas, une boîte de 
dialogue d'avertissement s'affiche.
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En mode Shuffle, toutes les données vidéo de la 
piste sont décalées plus loin sur la piste d'une durée 
égale à la sélection. En mode Slip, Grid ou Spot, 
la commande Insert Silence fonctionne comme la 
commande Edit > Clear.

Pour insérer un espace sur une piste vidéo :

1 Effectuez une sélection sur une ou plusieurs 
pistes. La longueur de la sélection détermine la 
durée de l'espace inséré.

2 Sélectionnez Edit > Insert Silence.

Modification du nom des 
fichiers vidéo sur le disque
Lorsque vous renommez des clips audio dans la 
timeline ou dans la liste des clips, vous pouvez 
également renommer les fichiers audio sur le 
disque. Toutefois, cela ne s'applique pas aux 
fichiers vidéo sur le disque.

Pour renommer des fichiers vidéo sur le disque, 
vous devez le faire à partir d'un navigateur de 
l'espace de travail, de l'Explorateur Windows ou 
du Finder Mac.

Groupes de clips vidéo
(Pro Tools HD uniquement)

Vous pouvez inclure des clips vidéo dans des groupes 
de clips pour effectuer les opérations suivantes :

• Création de groupes de clips

• Création de groupes de clips multipistes (pistes 
audio comprises)

• Édition de groupes de clips

• Création de fondus et de fondus enchaînés sur 
les fichiers audio d'un groupe de clips

• Importation et exportation de fichiers de groupe 
de clips

Utilisation de la fenêtre 
Video
Pro Tools dispose d'une fenêtre Video qui permet 
de visionner ou d'afficher une vidéo ou d'effectuer 
un scrubbing vidéo.

Pour afficher la fenêtre Video, effectuez l'une des 
opérations suivantes :

 Sélectionnez Window > Video.

 Appuyez sur Ctrl+9 (Windows) ou 
Commande+9 (Mac).

Les modifications apportées à partir du 
système d'exploitation ne sont pas 
automatiquement mises à jour dans le 
navigateur de l'espace de travail.

Pour plus d'informations sur l'utilisation des 
groupes de clips, reportez-vous à la section 
« Groupes de clips » à la page 877.

Les vidéos Avid s'affichent dans la fenêtre 
Video uniquement lors d'une opération de 
scrubbing ou de shuttle.

Fenêtre Video
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Redimensionnement de la 
fenêtre Video
Il est possible de redimensionner la fenêtre Video 
à l'aide de la souris ou du menu contextuel.

Pour redimensionner la fenêtre Video à l'aide de la 
souris :

 Positionnez le curseur sur l'un des coins de la 
fenêtre Video, puis faites glisser la fenêtre 
jusqu'à ce que vous obteniez la taille voulue.

Pour redimensionner la fenêtre Video à l'aide du 
menu contextuel :

 Effectuez un clic droit, ou maintenez la touche 
Ctrl enfoncée et cliquez sur la fenêtre Video, 
puis sélectionnez l'une des options de taille 
suivantes :

• Quarter Size (25 % de la taille réelle)

• Half Size (50 % de la taille réelle)

• Actual Size (taille réelle)

• Double Size (200 % de la taille réelle)

• Full Screen (plein écran)

• Aspect Ratio (format d'image)

Scrubbing sur la piste vidéo
Pro Tools permet d'effectuer un scrubbing vidéo 
directement sur une piste vidéo. Lors d'un 
scrubbing sur une piste vidéo, l'opération ne 
s'applique qu'à la vidéo, l'audio n'est pas lu. 
Le scrubbing vidéo s'affiche dans la fenêtre Video. 
Si du matériel vidéo est connecté, vous pouvez 
choisir d'afficher le scrubbing vidéo sur un 
moniteur externe, en même temps que dans la 
fenêtre Video.

Lors d'un scrubbing audio sur une piste vidéo en 
ligne, l'opération s'applique à l'audio et à la vidéo 
de manière synchronisée.

Pour effectuer un scrubbing sur une piste vidéo :

1 Sélectionnez l'outil de scrubbing.

2 Cliquez sur la piste vidéo et faites glisser l'outil 
de scrubbing.

Shuttle sur la piste vidéo
Le mode de shuttle verrouillé permet d'utiliser le 
pavé numérique pour effectuer un shuttle avant ou 
arrière sur une piste vidéo et une ou deux pistes 
audio, à différentes vitesses. Les touches 
numériques 0 à 9 permettent d'augmenter la vitesse 
progressivement, comme suit :

• Pour arrêter le shuttle, appuyez sur 0.

• Pour augmenter la vitesse progressivement 
jusqu'à la vitesse normale, appuyez sur les 
touches numériques 1 à 4.

• Pour effectuer un shuttle à vitesse normale, 
appuyez sur 5.

• Pour augmenter la vitesse progressivement 
au-delà de la vitesse normale, appuyez sur les 
touches numériques 6 à 9.

Le shuttle s'effectue uniquement sur la piste vidéo 
principale. Lorsque plusieurs pistes audio sont 
sélectionnées, le shuttle s'effectue uniquement sur 
les deux premières.

Pour plus d'informations sur l'activation et la 
désactivation du scrubbing vidéo avec du 
matériel vidéo, reportez-vous à la section 
« Enable Hardware During Scrub » 
à la page 1247.

Pour effectuer un scrubbing plus précis, 
maintenez la touche Commande enfoncée 
pendant l'opération.



Guide de référence Pro Tools1268

Pour lire la piste vidéo en mode de shuttle 
verrouillé : 

1 Dans Pro Tools HD, assurez-vous que l'option 
Numeric Keypad Mode des préférences de 
fonctionnement n'est pas configurée sur Shuttle 
(reportez-vous à la section « Préférences de 
fonctionnement » à la page 107).

2 Assurez-vous que le bouton Video Online de la 
piste vidéo sur laquelle vous souhaitez effectuer 
un scrubbing est de couleur bleue (en ligne).

3 À l'aide du Sélecteur, cliquez sur la piste audio 
à l'endroit où vous souhaitez lancer la lecture. 
Pour effectuer le shuttle sur deux pistes, 
maintenez la touche Maj enfoncée et cliquez sur 
une seconde piste audio. 

4 Maintenez la touche Démarrer (Windows) 
ou Ctrl (Mac) enfoncée, puis appuyez sur un 
chiffre du pavé numérique compris entre 0 et 9 
(9 étant la vitesse la plus élevée, 5 la vitesse 
normale et 0 l'arrêt du shuttle). 

Dès que le mode de shuttle verrouillé est activé, les 
boutons Fast Forward et Rewind sont mis en 
surbrillance dans la fenêtre de transport. 

5 Appuyez sur d'autres touches pour faire varier la 
vitesse de lecture, ou sur Plus (+) ou Moins (-) 
pour inverser le sens de lecture (Plus une lecture 
avant, Moins pour une lecture arrière). 

6 Pour arrêter la lecture, appuyez sur Démarrer+0 
(Windows) ou Ctrl+0 (Mac). 

Pour quitter le mode de shuttle verrouillé, 
effectuez l'une des opérations suivantes : 

 Cliquez sur le bouton Stop de la fenêtre de 
transport. 

 Appuyez sur la barre d'espace. 

Affichage d'une vidéo dans la 
fenêtre Video Universe
(Pro Tools HD uniquement)

La fenêtre Video Universe permet de visualiser, 
naviguer, zoomer et sélectionner des clips vidéo de 
la piste vidéo principale.

La fenêtre Video Universe affiche l'image vidéo 
centrale de chaque clip de la piste vidéo principale. 
Les images vidéo sont classées de façon 
séquentielle en fonction de leur ordre dans la 
timeline. La bande de couleur sous chaque image 
représente le code couleur du clip.

Pour afficher la fenêtre Video Universe :

1 Assurez-vous que le bouton Video Online de la 
piste vidéo principale est de couleur bleue (en 
ligne).

2 Sélectionnez Window > Video Universe.

Augmentation ou réduction de la 
taille des images vidéo

Pour changer la taille des images vidéo dans la 
fenêtre Video Universe :

 Effectuez un clic droit (Windows ou Mac), 
ou maintenez la touche Ctrl (Mac) enfoncée et 
cliquez sur la fenêtre Universe, puis 
sélectionnez Increase ou Decrease.

Fenêtre Video Universe avec des images vidéo 
représentant les clips de la piste vidéo principale
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Sélection de facteurs de zoom 
dans la fenêtre Video Universe 
Lorsque vous déplacez le curseur sur la partie 
supérieure d'une image vidéo dans la fenêtre Video 
Universe, il change de forme et se comporte 
comme un outil de zoom. Vous pouvez alors 
zoomer sur un ou plusieurs clips vidéo pour 
occuper l'intégralité de la fenêtre Edit.

Pour utiliser la fenêtre Video Universe et zoomer 
sur les clips vidéo dans la fenêtre Edit :

1 Déplacez le curseur sur la partie supérieure 
d'une image vidéo jusqu'à ce qu'il prenne la 
forme d'un outil de zoom.

2 Effectuez l'une des opérations suivantes :

• Pour déplacer le début d'un clip vidéo vers 
l'extrémité gauche de la timeline tout en 
conservant le facteur de zoom actuel dans la 
fenêtre Edit, cliquez une fois sur l'image vidéo 
représentant le clip.

• Pour effectuer un zoom avant sur un clip vidéo 
afin qu'il occupe toute la fenêtre Edit, double-
cliquez sur l'image vidéo représentant le clip.

• Pour appliquer le zoom à une plage de clip 
sélectionnés afin qu'ils occupent toute la fenêtre 
Edit, faites glisser la souris sur les images vidéo 
représentant les clips.

Sélection de plages dans la 
fenêtre Video Universe 
Lorsque vous déplacez le curseur sur la partie 
inférieure d'une image vidéo dans la fenêtre Video 
Universe, il change de forme et se comporte 
comme un Sélecteur. Cet outil permet alors de 
sélectionner des plages dans un ou plusieurs clips 
vidéo de la fenêtre Edit.

Pour utiliser la fenêtre Video Universe et 
sélectionner des plages dans les clips vidéo de la 
fenêtre Edit :

1 Déplacez le curseur sur la partie inférieure d'une 
image vidéo jusqu'à ce qu'il prenne la forme du 
Sélecteur.

2 Effectuez l'une des opérations suivantes :

• Pour placer le curseur au début d'un clip vidéo, 
cliquez sur l'image vidéo représentant le clip 
vidéo.

• Pour sélectionner un clip vidéo entier du début 
à la fin, double-cliquez sur l'image vidéo 
représentant le clip en question.

• Pour sélectionner un ou plusieurs clips entiers 
du début à la fin, faites glisser les images vidéo 
représentant les clips en question.

Image vidéo avec l'outil de zoom Image vidéo avec le Sélecteur

Si la fenêtre Edit n'affiche pas les clips vidéo 
sélectionnés, l'affichage défilera 
automatiquement de façon à montrer le début 
de la sélection.



Guide de référence Pro Tools1270

Sélection simultanée de 
facteurs de zoom et de plages 
dans la fenêtre Video Universe 
Lorsque vous déplacez le curseur sur une image 
vidéo dans la fenêtre Video Universe tout en 
maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée, le curseur se transforme en 
Sélecteur. Cet outil permet à la fois de sélectionner 
des plages et de leur appliquer un zoom.

Pour utiliser la fenêtre Video Universe et effectuer 
simultanément une sélection et un zoom dans la 
fenêtre Edit :

1 Déplacez le curseur sur une partie quelconque 
d'une image vidéo dans la fenêtre Video 
Universe jusqu'à ce qu'il prenne la forme de 
l'outil de zoom ou du Sélecteur.

2 Pour sélectionner une plage de clips vidéo tout 
en leur appliquant un zoom afin d'occuper 
l'intégralité de la fenêtre Edit, maintenez la 
touche Alt (Windows) ou Option (Mac) 
enfoncée pendant que vous faites glisser la 
souris sur les images vidéo correspondantes.

Lecture de vidéos haute 
définition
Pro Tools permet d'importer et de lire des fichiers 
vidéo haute définition (HD).

Configuration de la fréquence de 
timecode de la session pour 
l'importation de vidéos HD
Lors de la lecture de vidéos dont la cadence 
d'images est supérieure à 30 i/s, la synchronisation 
dans Pro Tools est assurée si la fréquence de 
timecode dans la fenêtre Session Setup correspond 
à la moitié de la cadence d'images des fichiers 
vidéo.

Par exemple, afin qu'une vidéo HD en 59.94 i/s 
soit lue correctement, sélectionnez 29.97 i/s 
comme fréquence de timecode de la session.

Pour configurer la fréquence de timecode d'une 
session :

1 Sélectionnez Setup > Session.

2 Dans la fenêtre Session Setup, sélectionnez la 
fréquence de timecode appropriée dans le menu 
déroulant Timecode Rate.

Appuyez sur Ctrl+2 (Windows) ou 
Commande+2 (Mac) pour ouvrir la fenêtre 
Session Setup.
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Lecture vidéo optimisée
Certains codecs vidéo fournissent des 
performances optimisées en lecture dans 
Pro Tools, à l'aide du mappage des échantillons 
(DNxHD, Apple Pro Res ou DV25 par exemple). 
Les clips vidéo qui utilisent ces codecs sont 
affichés avec une icône de coche dans la liste des 
clips et la timeline de Pro Tools.

Les codecs vidéo sans mappage des échantillons 
(tels que Photo JPEG) lisent les vidéos 
normalement, mais des images peuvent être 
omises en cours de lecture. Les performances en 
lecture vidéo ne sont pas garanties avec ces codecs. 
Ces codecs vidéos ne sont pas indiqués par une 
icône de clip vidéo optimisé (coche) sur les pistes 
vidéo ou dans la liste des clips.

Pour afficher ou masquer l'icône de clip vidéo 
optimisé, effectuez l'une des opérations 
suivantes :

 Sélectionnez (ou désélectionnez) View > Clip > 

Processing State.

 Dans le menu de la liste des clips, sélectionnez 
(ou désélectionnez) Show > Processing State.

Conseils d'optimisation de la 
lecture vidéo
Lorsque vous utilisez Pro Tools pour lire des 
fichiers vidéo, la qualité de la lecture dépend des 
facteurs suivants :

• La qualité du matériel vidéo (carte graphique) 
utilisé pour lire la vidéo numérisée

• La vitesse de votre ordinateur et du disque dur

• La taille (en pixels) du fichier vidéo

• Le codec et le niveau de compression utilisés

Pour une lecture vidéo plus fluide, suivez les 
conseils ci-dessous :

• Utilisez un CODEC optimisé pris en charge tel 
que DNxHD (pour consulter la liste des codecs 
vidéo pris en charge, rendez-vous sur 
www.avid.com).

• Recompressez la vidéo dans une résolution 
vidéo standard telle que 1 920 x 1 080. Assurez-
vous de sélectionner une résolution prise en 
charge par votre codec vidéo.

• Sélectionnez le type de projet le plus adapté à la 
cadence d'images et à la résolution de votre 
vidéo. 

• Utilisez l'ordinateur et la carte graphique les plus 
puissants possible.

Clip vidéo optimisé avec icône de coche

Clip vidéo optimisé avec icône de coche dans la liste 
des clips

L'activation (ou la désactivation) de l'option 
Processing State affiche (ou masque) l'icône 
de clip vidéo optimisé, ainsi que l'icône 
Elastic Audio.
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• Utilisez un périphérique vidéo Avid.

• Configurez l'option de défilement sur None 
(Options > Scrolling > None).

• Lorsque vous travaillez avec des codecs vidéo 
sans mappage des échantillons, utilisez un clip 
vidéo moins compressé (les fichiers très 
compressés nécessitent une vitesse de 
processeur supérieure pour assurer la 
décompression en lecture).

• Masquez la piste vidéo lorsqu'elle n'est pas 
utilisée (ou passez de la vue Frames à la vue 
Blocks). 

• Fermez les logiciels qui ne sont pas utilisés.

• Redimensionnez la fenêtre Video pour afficher 
la taille réelle de la vidéo.

• Si vous constatez des problèmes de 
performances ou toute autre anomalie, 
essayez de désactiver le GPU dans les 
préférences de fonctionnement de Pro Tools. 
Dans la plupart des cas, l'utilisation du GPU 
améliore les performances. Toutefois, les 
résultats peuvent être meilleurs sur certaines 
configurations lorsque le traitement vidéo est 
pris en charge par le CPU.

Compensation du délai des 
moniteurs 
Il est possible de compenser les délais de sortie 
vidéo liés aux décodeurs externes et à certains 
types de moniteurs (tels que les projecteurs ou 
écrans plasma).

Pour compenser le délai inhérent aux 
périphériques de monitoring vidéo :

1 Sélectionnez Setup > Video Sync Offset.

2 Dans la boîte de dialogue Set Video Sync 
Offset, entrez une valeur dans le champ 
QuickTime Video Offset ou Windows Media 
Video Offset, correspondant à la compensation 
de délai inhérente à votre chaîne de monitoring 
vidéo. 

Une fois cette valeur fixée, il n'est plus nécessaire 
de la modifier, sauf si vous changez des éléments 
de votre chaîne de monitoring vidéo (tels que des 
projecteurs ou des écrans plasma).

Lecture d'une vidéo sur un 
moniteur externe via un 
périphérique vidéo
Avec un périphérique vidéo qualifié, Pro Tools 
peut lire et afficher sur de nombreux moniteurs HD 
professionnels des fichiers vidéo Avid et 
QuickTime SD, ou HD avec une sortie HD avec 
alignement des bords d'images.

Sortie HD ou SD 
Pro Tools permet de sortir des vidéos Avid et 
QuickTime HD ou SD sur un moniteur externe 
HD-SDI, HDMI, NTSC ou PAL, à l'aide d'un 
périphérique vidéo qualifié par Avid.

Boîte de dialogue Video Sync Offset

Pour obtenir la liste des périphériques 
explicitement testés pour la sortie de vidéos 
Avid et QuickTime HD ou SD avec Pro Tools, 
rendez-vous sur www.avid.com.
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Référence vidéo
La sortie vidéo peut être verrouillée sur une 
référence vidéo externe, notamment un signal de 
synchronisation black burst ou tri-level.

Bounce de la piste vidéo 
dans une séquence 
QuickTime
Une fois le mixage final terminé et les événements 
audio synchronisés avec votre vidéo, vous pouvez 
bouncer la piste vidéo principale et un mixdown 
mono, stéréo ou de format supérieur à stéréo de 
votre session dans une nouvelle séquence 
QuickTime. Pro Tools HD permet également de 
bouncer plusieurs stems dans un fichier 
QuickTime.

Vous pouvez faire votre choix parmi une multitude 
de codecs QuickTime standard, entièrement 
compatibles avec les autres applications 
QuickTime.

Pour bouncer la vidéo et l'audio de la piste vidéo 
dans une séquence QuickTime :

1 Finalisez votre mixage (ou vos stems).

2 Assurez-vous que la piste vidéo à bouncer est 
bien la piste vidéo principale. Le bouton Video 
Online de la piste doit être en surbrillance 
(bleu).

3 Assurez-vous que toutes les pistes audio à 
inclure dans le bounce sont audibles (non 
mutées ou désactivées). 

4 Routez la sortie de chaque piste à inclure dans le 
bounce sur un même chemin de bus ou sortie 
stéréo.

5 Effectuez l'une des opérations suivantes :

• Pour bouncer la session entière, cliquez sur 
Return to Zero dans la fenêtre de transport pour 
atteindre le début de la session. 

• Pour bouncer une partie de la session, activez 
Options > Link Timeline and Edit Selection, puis 
créez une sélection dans la fenêtre Edit ou la 
timeline. 

6 Sélectionnez File > Bounce to > QuickTime 

Movie. La boîte de dialogue QuickTime Bounce 
s'ouvre.

Pro Tools HD doit être verrouillé sur une 
référence d'horloge appropriée, telle qu'une 
SYNC HD. Si aucune horloge audio externe 
n'est référencée, l'audio ne sera pas aligné 
sur les bords d'images et pourra être décalé. 

Boîte de dialogue QuickTime Bounce
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7 Sélectionnez le chemin de sortie ou de bus 
principal de votre mixage à l'aide du sélecteur 
Bounce Source. Si nécessaire, sélectionnez des 
sources de bounce supplémentaires (reportez-
vous à la section « Bounce simultané de 
plusieurs sources » à la page 1135). 

8 Configurez les options File Type, Format, 
Bit Depth, ainsi que les autres options de la 
boîte de dialogue (reportez-vous à la section 
« Options de bounce » à la page 1134).

9 Activez l'option Include Video pour inclure la 
piste vidéo en ligne dans le bounce.

10 Activez les options Same as Source et Use Avid 
Codecs si nécessaire (reportez-vous à la section 
« Paramètres de bounce QuickTime » 
à la page 1274).

11 Si vous effectuez un bounce Avid vers QuickTime 
et souhaitez configurer les paramètres de la vidéo 
QuickTime, cliquez sur QuickTime Settings.

12 Activez l'option Offline pour un bounce plus 
rapide qu'en temps réel.

13 Cliquez sur Bounce.

14 Sélectionnez une destination pour la nouvelle 
séquence QuickTime, attribuez-lui un nom, puis 
cliquez sur Save.

Paramètres de bounce 
QuickTime
Lors d'un bounce QuickTime, les options 
supplémentaires suivantes sont disponibles :

Include Video

Activez cette option pour inclure la piste vidéo en 
ligne dans le fichier QuickTime bouncé.

Same as Source

Activez l'option Same As Source pour effectuer un 
bounce QuickTime dans la résolution vidéo de la 
piste vidéo en ligne. L'option Same As Source n'est 
pas toujours disponible avec certains types de 
médias QuickTime LongGOP (tels que XDCAM), 
ou lorsque différents codecs sont utilisés sur 
une piste.

Use Avid Codecs

L'option Use Avid Codecs n'est disponible que 
lorsque vous utilisez des codecs installés avec 
les packs de codecs Avid LE (disponible sur 
www.avid.com) ou PE (inclus dans le programme 
d'installation de Pro Tools). Sélectionnez cette 
option si deux codecs similaires sont présents sur 
un système. Par exemple, le codec DV25 est 
généralement inclus lors d'une installation standard 
de QuickTime, mais Avid dispose également d'un 
codec DV25 optimisé pour les produits Avid, 
tels que Pro Tools et Media Composer.

Lors du bounce d'un codec Avid vers un fichier 
QuickTime, le codec Avid doit être installé pour 
lire le fichier QuickTime dans le lecteur 
QuickTime du système sur lequel il sera lu.

Toutes les sources sélectionnées pour 
l'opération de bounce QuickTime sont 
ajoutées au fichier de séquence QuickTime 
sous la forme de pistes audio, dans l'ordre et 
du haut vers le bas.

Reportez-vous à la documentation Apple 
pour obtenir des informations détaillées sur 
la configuration des paramètres des 
séquences QuickTime.

Le bounce vidéo peut prendre plus de temps 
que la durée de la vidéo elle-même, 
en fonction du format de la vidéo source, 
du format de la vidéo bouncée et de la 
vitesse de traitement.
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Paramètres QuickTime

Pro Tools permet de transcoder de la vidéo en 
QuickTime à l'aide des paramètres QuickTime 
(le plug-in d'encodage au format QuickTime doit 
être installé). Lors d'une opération de bounce 
en QuickTime, si la vidéo de la session n'est pas 
dans une résolution ou un codec valide pour du 
QuickTime, vous êtes invité à configurer les 
paramètres QuickTime pour transcoder la vidéo 
dans une résolution et un codec QuickTime valides.

Pour transcoder une vidéo dans une résolution 
QuickTime valide :

1 Sélectionnez File > Bounce To > QuickTime.

2 Dans la boîte de dialogue QuickTime Bounce, 
activez l'option Include Video.

3 Cliquez sur QuickTime Settings. Si la vidéo 
incluse dans le bounce est dans une résolution et 
un codec QuickTime valides, le bouton 
QuickTime Settings est grisé.

4 Configurez les paramètres de la boîte de 
dialogue Movie Settings.

5 Cliquez sur OK.

6 Configurez les autres paramètres de la boîte de 
dialogue QuickTime Bounce.

7 Cliquez sur Bounce.

Option Include Video activée dans la boîte de dialogue 
QuickTime Bounce

Boîte de dialogue Movie Settings

Lors d'un bounce QuickTime effectué depuis 
Pro Tools, les paramètres de la section 
Sounds de la boîte de dialogue Movie Settings 
sont ignorés.
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Chapitre 53 : Satellite Link

Avid Satellite Link permet de relier jusqu'à 
12 systèmes Pro Tools HD via un réseau Ethernet 
afin de contrôler les commandes de transport 
(lecture, arrêt et calage), de créer des sélections 
de lecture et de mettre des pistes en solo sur tous 
les systèmes, à partir de n'importe quelle station de 
travail connectée. 

Vous pouvez également relier jusqu'à 11 systèmes 
Pro Tools HD et l'un des systèmes suivants :

• Un système Pro Tools Video Satellite, qui exploite 
un système Pro Tools séparé pour la lecture vidéo.

• Un système Avid Video Satellite, qui exploite 
un système Avid Media Composer ou Avid 
Symphony pour la lecture, la capture et la 
conversion vidéo.

À partir de chaque système Pro Tools HD relié, 
Satellite Link permet d'activer et de désactiver 
la liaison des systèmes du réseau et d'afficher l'état 
de liaison des autres systèmes connectés.

En paramétrant les préférences de Satellite Link, 
vous pouvez configurer les systèmes Pro Tools HD 
liés pour des workflows à un ou plusieurs opérateurs.

Satellite Link peut être utilisé simultanément 
avec Avid MachineControl™, afin de permettre 
à un système Pro Tools HD relié et en ligne de 
contrôler un périphérique compatible 9 broches. 

Sur les systèmes comprenant une console D-Control 
ou D-Command, Satellite Link peut fonctionner 
conjointement avec le mode Multi ICON. Vous 
avez ainsi la possibilité de contrôler de manière 
sélective le transport d'un maximum de quatre 
systèmes Pro Tools HD du réseau depuis une seule 
console D-Control, ou deux systèmes Pro Tools HD 
depuis une D-Command. 

Configuration requise pour 
Satellite Link et compatibilité

Configuration requise pour les 
systèmes satellites
Les composants suivants sont requis pour chaque 
système Pro Tools HD du réseau :

• Un ordinateur qualifié par Avid avec le logiciel 
Pro Tools HD

• Du matériel Avid HDX ou HD Native

• Un périphérique Avid SYNC HD

• Une connexion Ethernet à un réseau local (LAN) 

Pour plus d'informations, reportez-vous 
aux Chapitre 54, « Pro Tools Video 
Satellite » et Chapitre 55, « Avid Video 
Satellite ».

Tous les systèmes Pro Tools d'un réseau 
Satellite Link doivent être basés sur une 
référence vidéo commune à l'aide de la 
SYNC HD.
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Configuration de Satellite Link
Pour configurer plusieurs systèmes Pro Tools HD 
sur un réseau Satellite Link, configurez les 
paramètres réseau de base et le réseau Satellite 
Link sur chaque système Pro Tools.

Configuration des paramètres 
réseau
Les systèmes Satellite Link communiquent via des 
réseaux locaux Ethernet. Vous pouvez configurer 
les paramètres réseau sur chaque système 
Pro Tools HD de manière à créer un ou plusieurs 
réseaux Satellite Link sur le même réseau LAN. 

Satellite Link requiert que tous les systèmes 
reliés soient connectés à un réseau Ethernet local. 
Tous les systèmes doivent appartenir au même 
sous-réseau. Si possible, il est préférable qu'ils 
soient également connectés au même switch 
Ethernet, afin de réduire les temps de réponse 
sur le réseau. 

Interface Ethernet

Sur les ordinateurs dotés de plusieurs interfaces 
Ethernet, vous pouvez sélectionner l'interface 
à utiliser pour les communications Satellite Link.

Pour sélectionner l'interface Ethernet pour 
Satellite Link :

1 Sélectionnez Setup > Peripherals et cliquez sur 
Satellites.

2 Sous Advanced Network Settings, sélectionnez 
l'interface Ethernet dans le menu déroulant 
Interface. 

3 Cliquez sur OK.

Port TCP/UDP

Les systèmes d'un réseau Satellite Link doivent 
utiliser le même port TCP/UDP pour communiquer. 
Les systèmes satellites disponibles ne s'affichent sur 
les autres systèmes satellites que s'ils utilisent le 
même port.

Par défaut, Satellite Link utilise le port 
TCP/UDP 28 282. 

Si le port par défaut est déjà utilisé, ou si vous 
souhaitez configurer des réseaux Satellite Link 
distincts, vous pouvez sélectionner un autre port 
TCP/UDP pour la communication Satellite Link.

Pour sélectionner le port TCP/UDP pour la 
communication Satellite Link :

1 Sélectionnez Setup > Peripherals et cliquez sur 
Satellites.

2 Sous Advanced Network Settings, saisissez 
le numéro de port TCP/UDP que le système 
doit utiliser. 

3 Cliquez sur OK.

Pour que Satellite Link fonctionne 
correctement, vous devez sélectionner un 
numéro de port TCP/UDP compris entre 
1 024 et 65 534.
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Configuration d'un réseau 
Satellite Link
Pour configurer des systèmes Pro Tools HD sur un 
réseau Satellite Link, l'un des systèmes Pro Tools 
du réseau doit être désigné en tant que système 
administrateur. 

Les autres systèmes du réseau sont configurés 
en tant que systèmes satellites et sont ajoutés 
au réseau depuis le système administrateur. 

Configuration des systèmes satellites

Pour chaque système Pro Tools à configurer en 
tant que satellite du réseau Satellite Link, effectuez 
les opérations suivantes :

1 Sélectionnez Setup > Peripherals et cliquez sur 
Satellites.

2 Dans la zone de texte System Name, saisissez 
un nom pour le système.

3 Sous Mode, sélectionnez Satellite.

4 Cliquez sur OK.

Pour configurer un système Media Composer 
en tant que satellite vidéo :

1 Dans Media Composer, sélectionnez Edit > 

Preferences.

2 Dans la fenêtre Project, cliquez sur l'onglet 
Settings, puis double-cliquez sur Video Satellite.

3 Dans la fenêtre Video Satellite Settings, 
sélectionnez Video Satellite Mode. 

4 Cliquez sur OK.

Pour configurer un système Pro Tools non HD 
en tant que satellite vidéo :

1 Sur le système Pro Tools satellite, sélectionnez 
Setup > Peripherals, puis cliquez sur Satellites.

2 Dans la zone de texte System Name, saisissez 
un nom pour le système.

3 Sous Mode, sélectionnez Enable Satellite Mode.

4 Cliquez sur OK.

Configuration d'un satellite sur la page Satellites de la 
boîte de dialogue Peripherals

Configuration d'un système satellite vidéo Pro Tools 
sur la page Satellites de la boîte de dialogue 
Peripherals
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Configuration d'un système 
administrateur

Pour configurer un système Pro Tools en tant 
qu'administrateur du réseau Satellite Link :

1 Sélectionnez Setup > Peripherals et cliquez sur 
Satellites.

2 Dans la zone de texte System Name, saisissez 
un nom pour le système.

3 Sous Mode, sélectionnez Administrator.

4 Sous Administrator, sélectionnez le système 
actuel dans le menu déroulant System 1. 

5 Cliquez sur OK.

Ajout de satellites au réseau

Lorsque des systèmes ont été configurés en tant 
que satellites, ils deviennent disponibles sur le 
système administrateur. Les systèmes satellites 
sont ensuite déclarés à partir du système 
administrateur pour créer le réseau Satellite Link.

Pour déclarer des systèmes satellites :

1 Sur le système administrateur, sélectionnez 
Setup > Peripherals, puis cliquez sur Satellites.

2 Sous Administrator, déclarez les systèmes 
à utiliser en tant que satellites à l'aide des 
menus System 2 à 12. 

3 Cliquez sur OK.

Le système administrateur et les satellites déclarés 
apparaissent dans les commandes de synchronisation 
des fenêtres de transport et Edit. La zone d'affichage 
est redimensionnée pour inclure tous les systèmes 
disponibles.

Configuration d'un système administrateur sur la page 
Satellites de la boîte de dialogue Peripherals

Satellites déclarés dans les commandes de 
synchronisation de la fenêtre de transport
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Liaison des systèmes 
satellites
Lorsqu'un système Pro Tools a été déclaré en tant 
que satellite, il peut être relié au réseau à partir de 
l'ordinateur local ou d'un autre satellite. Lorsqu'un 
système est relié, les fonctions et commandes 
suivantes peuvent être contrôlées à partir de tous 
les systèmes du réseau :

• Activation et désactivation de la liaison du 
système

• Commandes de transport (Stop, Play, FF, Rew)

• Sélections de lecture

• Scrub/Shuttle vers un emplacement

• Mise en solo des canaux (et désactivation 
des solos)

• Fermeture des erreurs système (erreurs DAE, 
par exemple)

Commandes Satellite Link
Lorsqu'un système Pro Tools est déclaré en tant que 
satellite, les commandes Satellite Link suivantes 
s'affichent dans les fenêtres de transport et Edit : 

Bouton de liaison : contrôle l'état de liaison du 
système local.

Boutons Satellite Link : contrôlent l'état de liaison 
des autres systèmes satellites. Sur chaque système, 
l'un de ces boutons correspond au bouton de 
liaison principal de ce système.

Les boutons de liaison sont mis en surbrillance 
pour indiquer la liaison d'un système.

Pour afficher les commandes Satellite Link dans la 
fenêtre de transport :

 Sélectionnez View > Transport > Synchronization 
et View > Transport > Expanded.

Pour activer ou désactiver la liaison du système 
Pro Tools local :

 Cliquez sur le bouton de liaison de la fenêtre 
de transport. 

Pour activer ou désactiver la liaison d'autres 
systèmes satellites :

 Cliquez sur le bouton Satellite Link 
correspondant de la fenêtre de transport.

Pour activer ou désactiver la liaison de tous les 
systèmes satellites déclarés :

 Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée et cliquez sur le bouton de 
liaison ou sur un bouton Satellite Link dans 
la fenêtre de transport.

Liaison de systèmes en cours de lecture

Vous pouvez activer ou désactiver la liaison d'un 
système pendant que celui-ci ou un autre système 
relié est en cours de lecture, leurs transports 
resteront synchronisés. Si les deux systèmes sont 
en cours de lecture, le dernier système relié se 
calera à l'emplacement du système sur lequel la 
liaison a été initiée.

Commandes Satellite Link dans la fenêtre de transport

Bouton de liaison

Boutons Satellite Link
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Liaison de sélections de lecture
Vous pouvez configurer des systèmes Pro Tools 
reliés de manière à transmettre et recevoir des 
sélections de lecture à partir d'autres systèmes 
satellites. Cela vous permet de configurer un 
paramétrage pour refléter certaines sélections 
de la fenêtre Edit ou pour que tous les systèmes 
reflètent les sélections de la fenêtre Edit de tous 
les autres systèmes. 

 Si vous travaillez dans un environnement de 
mixage multiutilisateur où les dialogues, les effets 
et la musique résident sur différents systèmes, 
il peut être utile de configurer ces systèmes pour 
qu'ils transmettent uniquement les sélections de 
lecture, et de configurer le système Pro Tools 
d'enregistrement/vidéo pour qu'il ne reçoive que 
ces sélections de lecture.

 Si vous travaillez dans un environnement de 
mixage pour utilisateur unique et jonglez entre 
plusieurs systèmes, il peut être utile de définir tous 
les systèmes pour qu'ils transmettent et reçoivent 
les sélections de lecture afin que vous puissiez 
travailler sur la même sélection depuis n'importe 
quel système.

Pour configurer des systèmes Pro Tools satellites 
pour qu'ils reflètent les sélections de lecture sur 
d'autres systèmes satellites :

1 Sur les systèmes où vous allez créer des 
sélections de lecture, procédez comme suit :

• Sélectionnez Setup > Preferences et cliquez sur 
Synchronization. 

• Dans la zone Satellites de la page 
Synchronization, sélectionnez l'option Transmit 

Play Selections.

2 Sur les systèmes où vous souhaitez refléter les 
sélections de lecture, procédez comme suit :

• Sélectionnez Setup > Preferences et cliquez sur 
Synchronization. 

• Dans la zone Satellites de la page 
Synchronization, sélectionnez l'option Receive 

Play Selections.

• Cliquez sur OK pour fermer la fenêtre des 
préférences.

3 Assurez-vous que les systèmes sont reliés.

Liaison des commandes solo
Vous pouvez configurer les systèmes Pro Tools 
reliés de manière à transmettre l'état solo de leurs 
pistes et recevoir les informations d'état solo 
d'autres systèmes satellites. 

 Si vous travaillez dans un environnement de 
mixage multiutilisateur où les dialogues, les effets 
et la musique résident sur différents systèmes, 
il peut s'avérer utile de définir ces systèmes pour 
qu'ils envoient et reçoivent les commande solo et 
de définir le système Pro Tools 
d'enregistrement/vidéo pour qu'il ne n'envoie ni ne 
reçoive les commandes solo. 

 Si vous travaillez dans un environnement de 
mixage pour utilisateur unique et jonglez entre 
plusieurs systèmes, il peut s'avérer utile de définir 
tous les systèmes pour qu'ils transmettent et 
reçoivent les commandes solo afin qu'elles se 
propagent sur tous les systèmes.

Solo Safe : lorsque la liaison des commandes solo 
est activée, les pistes de tous les systèmes 
conservent leur état Solo Safe.

Solo Clear : lorsque la liaison des commandes solo 
est activée, tous les solos sont supprimés des 
systèmes définis pour recevoir les solos.
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Pour configurer la transmission ou la réception de 
l'état solo des systèmes satellites :

1 Sur les systèmes où vous souhaitez mettre des 
pistes en solo, procédez comme suit :

• Sélectionnez Setup > Preferences et cliquez sur 
Synchronization. 

• Dans la zone Satellites de la page Synchronization, 
sélectionnez l'option Transmit Solos. 

2 Sur les systèmes où vous souhaitez que les 
pistes suivent un comportement de lecture en 
solo en fonction des solos d'autres systèmes, 
procédez comme suit :

• Sélectionnez Setup > Preferences et cliquez sur 
Synchronization. 

• Dans la zone Satellites de la page Synchronization, 
sélectionnez l'option Receive Solos.

• Cliquez sur OK pour fermer la fenêtre des 
préférences.

3 Assurez-vous que les systèmes sont reliés.

Utilisation de la liaison des commandes 
solo sans liaison des commandes de 
transport

Si vous synchronisez plusieurs systèmes Pro Tools 
sur un synchroniseur externe, vous pouvez 
toujours profiter de la fonctionnalité de liaison des 
commandes solo. 

Vous pouvez configurer un système Pro Tools 
satellite pour qu'il envoie toujours ses états solo, 
qu'il soit relié ou non, de manière à mettre les 
pistes en solo sur tous les systèmes, sans liaison 
des commandes de transport. 

Pour configurer un système Pro Tools satellite 
pour qu'il gère uniquement les solos, même 
lorsqu'il n'est pas relié :

1 Sélectionnez Setup > Preferences et cliquez sur 
Synchronization. 

2 Dans la zone Satellites de la page 
Synchronization, sélectionnez l'option Solo 

Independent of Linked State.

3 Cliquez sur OK pour fermer la fenêtre des 
préférences.

Comportement de liaison des 
commandes solo en modes solo

Solo in Place : avec la liaison des commandes 
solo, lorsque vous utilisez Solo In Place, le mode 
d'opération solo est déterminé par le système qui 
transmet la commande.

 Si un système relié est en mode Solo Latch, 
la mise en solo d'une piste sur ce système ajoute 
cette dernière au nombre de pistes en solo, quel que 
soit le mode solo des autres systèmes configurés 
pour recevoir des solos.

 Si un système relié est en mode Solo X-OR, 
la mise en solo d'une piste sur ce système annule 
les solos de tous les autres systèmes, quel que soit 
le mode solo des autres systèmes configurés pour 
recevoir des solos.

Modes AFL et PFL : avec la liaison des commandes 
solo, les solos AFL et PFL définis sur un système 
relié n'ont aucun effet sur les autres systèmes.

Une piste mise en solo AFL sur un système relié 
peut être mutée par un autre système défini sur 
Solo In Place. Pour éviter cela, utilisez le mode 
PFL à la place d'AFL. 
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Fonctionnement de Satellite 
Link 

Suppression des messages d'erreur sur 
les systèmes reliés

Par défaut, les systèmes reliés continuent de 
fonctionner lorsqu'un des systèmes rencontre une 
erreur provoquant l'interruption de son transport. 
Tout message d'erreur d'un système relié s'affiche 
en tant qu'info-bulle sur le bouton Satellite Link 
correspondant dans la fenêtre de transport.

Vous pouvez configurer chaque système de 
manière à ce qu'il interrompe la lecture lorsqu'il 
rencontre une erreur. 

Pour fermer une boîte de dialogue d'erreur sur un 
système relié :

 Depuis la fenêtre de transport d'un autre 
système relié, maintenez la touche Maj 
enfoncée et cliquez sur le bouton Satellite Link 
du système affecté. 

Pour configurer l'arrêt du transport de tous les 
systèmes lorsqu'une erreur se produit sur un 
système relié :

 Assurez-vous que l'option DAE Errors Stop All 

Linked Systems est sélectionnée dans les 
préférences de synchronisation.

Pour configurer l'interruption du transport de tous 
les systèmes en cas d'erreur, assurez-vous que cette 
option est sélectionnée sur tous les systèmes reliés.

Boîtes de dialogue de lecture et 
modales

Les systèmes reliés interrompent la lecture 
(ou empêchent son démarrage) si une boîte de 
dialogue modale (telle que I/O Setup, Hardware 
Setup ou Playback Engine) est ouverte sur un 
système relié. 

Utilisation de Satellite Link 
avec MachineControl
Le mode Deck Control de MachineControl peut 
être utilisé pour contrôler un appareil 9 broches 
(tel qu'un synchroniseur 9 broches CB Electronics 
ou Soundmaster ATOM) et permettre à Pro Tools 
d'agir en tant que « système principal de code 
uniquement » pour les systèmes contrôlés par le 
synchroniseur.

Satellite Link permet l'utilisation de 
MachineControl sur un seul système Pro Tools 
relié à la fois.

 Lorsqu'un système Pro Tools relié est déjà en 
ligne et que vous connectez un autre système 
Pro Tools relié, Satellite Link interrompt 
automatiquement la connexion du premier 
système.

 Tout système Pro Tools relié présentant le 
paramètre Transport=Pro Tools obéit aux 
commandes de transport Satellite Link. 

 Aucun système Pro Tools relié présentant le 
paramètre Transport=Machine ne transmet les 
commandes de transport Satellite Link, mais s'ils 
sont hors ligne, ces systèmes obéiront à ces 
commandes. 

Pour éviter cela, désactivez la liaison du 
système en question avant d'ouvrir la boîte 
de dialogue.
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Prise en charge des surfaces 
de contrôle avec Satellite 
Link

Liaison des systèmes satellites
(D-Control, D-Command et C|24)

Pour activer ou désactiver la liaison du système 
Pro Tools local :

 Maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur le 
bouton Machine Online de la zone Transport. 

Soft Keys Satellite Link
(D-Control et D-Command)

Pour activer ou désactiver la liaison d'autres 
systèmes satellites :

1 Maintenez la touche Ctrl (Mac) ou Alt 
(Windows) enfoncée et appuyez sur le bouton 
Modes de la zone Automation des Soft Keys.

2 Appuyez sur la touche programmable 
correspondant au nom du système dont vous 
souhaitez activer ou désactiver la liaison. 

La touche programmable reste allumée pour 
indiquer que le système correspondant est relié 
ou clignote pour indiquer que le système 
correspondant présente une erreur. 

Pour activer ou désactiver la liaison de tous les 
systèmes satellites déclarés :

 Maintenez les touches Alt+Ctrl (Windows) ou 
Option+Commande (Mac) enfoncées et appuyez 
sur le bouton Online de la zone Transport.

Pour changer l'état de transmission solo du 
système Pro Tools local :

1 Maintenez la touche Ctrl (Mac) ou Alt 
(Windows) enfoncée et appuyez sur le bouton 
Modes de la zone Automation des Soft Keys.

2 Appuyez sur la touche programmable 
correspondant à Transmit Solo.

La touche programmable reste allumée pour 
indiquer que la transmission solo est active.

Satellite Link et contrôle 
EUCON
Une sélection de commandes Satellite Link ont été 
intégrées au protocole EUCON. Pour plus 
d'informations sur le contrôle des fonctions 
Satellite Link depuis des périphériques EUCON, 
reportez-vous au Guide Pro Tools EUCON.
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Chapitre 54 : Pro Tools Video Satellite

Pro Tools Video Satellite est une puissante option 
de post-production qui exploite un ordinateur Mac 
distinct exécutant le logiciel Pro Tools pour 
garantir une lecture vidéo synchronisée. 

En transférant les tâches de lecture vidéo sur un 
autre ordinateur, Pro Tools Video Satellite permet 
d'obtenir de meilleures performances sur le 
système Pro Tools administrateur.

Pro Tools Video Satellite utilise un unique 
système Pro Tools non HD pour prendre en charge 
la lecture vidéo dans une configuration Satellite. 
Pro Tools Video Satellite requiert le logiciel 
Pro Tools (et non Pro Tools HD) et peut 
fonctionner avec n'importe quelle interface audio 
non HD prise en charge par Avid (telle qu'une 
Mbox Pro). Un Pro Tools Video Satellite ne peut 
pas utiliser de référence vidéo et n'est donc pas 
aussi précis qu'un système Avid Video Satellite. 

Configuration système pour 
Pro Tools Video Satellite
• Ordinateur qualifié par Avid

• Logiciel Avid Pro Tools

• Périphérique vidéo pris en charge (facultatif)

• Moniteur client (facultatif)

• Générateur de référence vidéo black burst ou 
tri-level, dans le cas de l'utilisation d'un 
périphérique vidéo 

• Connexion Ethernet à un réseau local (LAN)

Options de sortie vidéo
Pro Tools Video Satellite prend en charge la sortie 
vidéo via un périphérique vidéo Avid ou tiers.

• Lecture sur un moniteur externe avec un boîtier 
Avid Nitris DX. Les formats de sortie 
disponibles sont HD/SD-SDI, HDMI et HD/SD 
analogique.

• Lecture sur un moniteur externe avec un boîtier 
Avid Mojo DX. Les formats de sortie 
disponibles sont HD/SD-SDI et HDMI.

• Lecture plein écran sur l'écran principal ou 
secondaire de votre ordinateur sur une 
sortie DVI.

• Lecture sur un moniteur externe avec un boîtier 
vidéo tiers pris en charge.
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Connexion d'un système 
Pro Tools Video Satellite
Pour connecter le système Pro Tools Video 
Satellite au système Pro Tools administrateur, 
ce dernier doit être désigné comme étant le 
système administrateur. 

Le système Pro Tools Video Satellite est défini en 
tant que système satellite, puis déclaré à partir du 
système administrateur.

Configuration du système 
Pro Tools principal en tant 
qu'administrateur

Pour configurer le système Pro Tools principal 
en tant qu'administrateur :

 Reportez-vous à la section « Configuration d'un 
système administrateur » à la page 1282.

Configuration du système 
Pro Tools Video Satellite

Pour configurer le système Pro Tools Video 
Satellite :

 Reportez-vous à la section « Configuration des 
systèmes satellites » à la page 1281.

Déclaration du système 
Pro Tools Video Satellite
Lorsque le système Pro Tools Video Satellite a été 
configuré en tant que satellite, il devient disponible 
sur le système administrateur. Le système satellite 
est ensuite déclaré par l'administrateur.

Pour déclarer le système satellite sur le système 
administrateur :

 Reportez-vous à la section « Ajout de satellites 
au réseau » à la page 1282.

Les systèmes s'affichent dans l'ordre, de gauche 
à droite, dans la section Synchronization de la 
fenêtre de transport.

Liaison du système Pro Tools 
Video Satellite
Après avoir connecté un système Pro Tools en tant 
que satellite vidéo, il peut être placé en mode lié. 
Lorsque ce système est lié, il obéit aux commandes 
de transport du système administrateur et est 
synchronisé avec ce dernier. Si la liaison du 
système satellite est rompue, son transport agit 
comme celui d'un système Pro Tools normal.

Pour obtenir des informations complètes sur 
la configuration d'un réseau Satellite Link 
incluant un système Pro Tools Video Satellite, 
reportez-vous à la section « Configuration de 
Satellite Link » à la page 1280. Un seul système Pro Tools Video Satellite 

peut être connecté à un réseau Satellite Link.

Le système Pro Tools administrateur ne 
répond pas aux commandes de lecture 
provenant du système Pro Tools Video 
Satellite. Les commandes de transport 
doivent être émises depuis le système 
Pro Tools principal.
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Commandes de liaison
Lorsqu'un système Pro Tools est déclaré comme 
satellite, les commandes suivantes s'affichent dans 
la fenêtre de transport : 

Bouton de liaison : contrôle l'état de liaison du 
système local.

Boutons de liaison des satellites : contrôlent 
l'état de liaison des autres systèmes satellites. 
Sur chaque système, l'un de ces boutons correspond 
au bouton de liaison principal de ce système.

Les boutons de liaison sont mis en surbrillance 
pour indiquer l'état lié.

Pour afficher les commandes de liaison dans la 
fenêtre de transport :

 Sélectionnez View > Transport > Synchronization 
et View > Transport > Expanded.

Pour lier ou interrompre la liaison du système 
Pro Tools Video Satellite local :

 Cliquez sur le bouton de liaison de la fenêtre 
de transport. 

Pour activer ou désactiver la liaison du système 
Pro Tools administrateur ou d'autres systèmes 
satellites :

 Cliquez sur le bouton de liaison du satellite 
correspondant dans la fenêtre de transport.

Pour activer ou désactiver la liaison de tous les 
systèmes satellites déclarés :

 Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le bouton de 
liaison ou sur un bouton de liaison d'un satellite 
dans la barre de transport.

Liaison de systèmes en cours de lecture

Vous pouvez lier le système Pro Tools Video 
Satellite lorsque le système Pro Tools 
administrateur est en cours de lecture, leurs 
transports se synchroniseront.

Fonctionnement de Pro Tools 
Video Satellite 

Erreurs AAE

Par défaut, deux systèmes liés continuent de 
fonctionner lorsqu'un des systèmes rencontre une 
erreur provoquant l'interruption de son transport.

Le système administrateur peut être configuré pour 
interrompre la lecture si une erreur AAE se produit 
sur le système Pro Tools Video Satellite ou tout 
autre système Satellite Link.

Pour fermer un message d'erreur sur le système 
Pro Tools Video Satellite à partir du système 
Pro Tools principal :

 Depuis la fenêtre de transport d'un autre système 
lié, cliquez sur le bouton de liaison du système 
affecté, tout en maintenant la touche Maj 
enfoncée. 

Commandes de liaison de la fenêtre de transport

Bouton de liaison

Boutons de liaison des satellites

Si le système administrateur est configuré 
pour transmettre les sélections de lecture, 
ces sélections seront transmises au système 
Pro Tools Video Satellite. Cependant, 
les sélections créées sur le système Pro Tools 
Video Satellite ne seront pas transmises au 
système administrateur.
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Pour configurer le système Pro Tools Video 
Satellite afin qu'il arrête le transport sur les deux 
systèmes lorsqu'une erreur survient :

 Sur le système Pro Tools administrateur, 
assurez-vous que l'option AAE Errors Stop All 

Linked Systems est sélectionnée dans les 
préférences de synchronisation.

Boîtes de dialogue modales

La lecture est interrompue sur les systèmes liés si 
une boîte de dialogue modale (telle que I/O Setup, 
Hardware Setup ou Playback Engine) est ouverte 
sur l'un des systèmes liés. 
. 

Placement de vidéos sur la 
timeline de Pro Tools
Une fois une session créée (ou une session 
existante ouverte) sur le système Pro Tools 
satellite et la vidéo importée, cette dernière doit 
être positionnée sur l'heure de début correcte afin 
d'être synchronisée avec l'audio sur le système 
Pro Tools principal. La vidéo peut être placée sur 
l'heure de début souhaitée en faisant correspondre 
les valeurs de timecode ou feet+frames. 

Compensation d'heures de 
début différentes dans 
Pro Tools et un Pro Tools Video 
Satellite
Dans certains cas, le système Pro Tools Video 
Satellite doit être décalé par rapport au système 
administrateur afin de compenser les décalages 
d'appareils externes ou les différences d'heure de 
début de session.

Vous pouvez contrôler la quantité de décalage en 
modifiant les paramètres Timecode Offsets sur le 
système Pro Tools Video Satellite.

Pour compenser des heures de début différentes :

1 Dans Pro Tools, sélectionnez Setup > Session. 
La fenêtre Session Setup s'ouvre.

2 Dans la section Timecode Offsets, compensez 
le décalage entre Pro Tools et un système 
Pro Tools Video Satellite comme suit :

• Si l'heure de début du clip vidéo sur le satellite 
vidéo tombe avant celle de la session Pro Tools 
administrateur, saisissez une valeur de timecode 
positive dans le champ Satellite Offset.

• Si l'heure de début du clip vidéo sur le satellite 
vidéo tombe après celle de la session Pro Tools 
administrateur, saisissez une valeur de timecode 
négative dans le champ Satellite Offset.

Si une erreur AAE se produit sur l'un des 
systèmes, son bouton de liaison satellite 
s'allumera en rouge dans la fenêtre de 
transport de l'autre système. Placez le 
pointeur de la souris sur le bouton pour 
afficher l'erreur, si nécessaire.

La lecture sur un système est impossible 
lorsqu'une boîte de dialogue modale est 
ouverte.
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Compensation d'un délai de 
sortie induit par le moniteur
De nombreux moniteurs génèrent un délai d'une ou 
plusieurs images sur la sortie vidéo. Vous pouvez 
le compenser en avançant la sortie vidéo du 
nombre d'images nécessaires.

Pour définir le nombre d'images de décalage de la 
sortie vidéo :

1 Sur le système vidéo satellite, sélectionnez 
Setup > Video Sync Offset.

2 Dans le champ Video Sync Offset, saisissez une 
valeur positive qui correspond à la quantité de 
délai induite par les moniteurs. Vous aurez peut-
être à essayer plusieurs valeurs de paramètre. 
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Chapitre 55 : Avid Video Satellite

Avid Video Satellite est une puissante option 
de post-production pour Pro Tools, installée sur 
un ordinateur distinct équipé du logiciel Avid 
Media Composer ou Symphony et qui garantit la 
synchronisation de la lecture, de l'acquisition et de 
la conversion des vidéos.

Avid Video Satellite peut exploiter un unique 
système Media Composer ou Symphony au sein 
d'une configuration Satellite. Avid Video Satellite 
peut lire des séquences complètes et ne requiert pas 
de mise à plat des vidéos. Un système Pro Tools HD 
administrateur est requis dans une configuration 
Satellite.

Le logiciel Media Composer ou Symphony avec 
l'option Video Satellite peut sortir et capturer de la 
vidéo à l'aide des périphériques vidéo Avid 
suivants :

• Avid Nitris DX

• Avid Mojo DX

Éléments requis pour Avid Video 
Satellite
Avid Video Satellite requiert les composants 
système suivants :

• Un ordinateur Mac ou Windows qualifié par Avid

• Le logiciel Pro Tools HD avec du matériel Avid 
HDX ou HD Native 

• Une SYNC HD

• Un second ordinateur qualifié par Avid pour 
Media Composer ou Symphony

• Le ID et le numéro de série du système 
Media Composer ou Symphony, ou une clé 
électronique Avid (incluse avec 
Media Composer ou Symphony)

• Un périphérique vidéo Avid (facultatif, requis 
pour une sortie vidéo haute qualité)

Périphériques vidéo Avid 

Pour une lecture de haute qualité avec alignement 
à l'image des vidéos HD ou SD (ou vidéo HD 
1 080 convertie en SD), vous devez ajouter les 
capacités d'E/S d'un périphérique vidéo Avid.

Media Composer prend en charge les 
périphériques vidéo Avid suivants :

• Avid Nitris DX

• Avid Mojo DX

Avec un périphérique vidéo Avid, vous devez 
disposez des composants suivants :

• Un générateur de signal black burst NTSC/PAL

• Un générateur de synchronisation Tri-level (pour 
les périphériques vidéo Avid compatibles HD)
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Options de sortie vidéo
Avid Video Satellite permet de sortir de la vidéo 
à l'aide de l'une des configurations suivantes :

• Lecture sur un moniteur externe avec un boîtier 
Avid Nitris DX. Les formats de sortie sont les 
suivants : HD/SD-SDI, HDMI et HD/SD 
analogique.

• Lecture sur un moniteur externe avec un boîtier 
Avid Mojo DX. Les formats de sortie sont les 
suivants : HD/SD-SDI et HDMI.

• Lecture plein écran sur l'écran principal ou 
secondaire de votre ordinateur sur une sortie DVI.

• Lecture sur un moniteur externe avec un boîtier 
vidéo tiers pris en charge.

Lecture sur un moniteur vidéo 
externe NTSC ou PAL
Media Composer et Symphony nécessitent un 
périphérique vidéo Avid pour garantir une lecture 
de haute qualité, avec alignement à l'image des 
vidéos SD (ou vidéo HD 1 080 convertie en SD) 
sur un moniteur externe NTSC ou PAL.

Si vous effectuez une sortie vidéo HD en 1 080 
avec cette configuration, vous pouvez soit 
transcoder une séquence HD en vidéo SD soit 
effectuer une downconversion d'un projet HD 
entier en vidéo SD en temps réel. 

Avec un périphérique Avid Nitris DX ou 
Mojo DX, la vidéo HD 1 080 peut être convertie 
en SD en temps réel et en mode logiciel. 

La downconversion matérielle n'est pas prise 
en charge par Video Satellite.

Lecture sur un moniteur vidéo 
externe HD-SDI
(Avid Nitris DX ou Mojo DX uniquement)

Media Composer nécessite un périphérique 
vidéo compatible HD (Nitris DX ou Mojo DX) 
pour garantir une lecture de haute qualité, 
avec alignement à l'image des vidéos HD 
natives sur un moniteur externe HD-SDI. 

Lecture plein écran sur un 
moniteur d'ordinateur via une 
sortie DVI
Si votre ordinateur est équipé d'une carte vidéo 
prise en charge, Media Composer Video Satellite 
permet une lecture en plein écran du contenu vidéo 
SD ou HD sur l'écran principal ou secondaire, 
via un port DVI. 

Cadence d'images vidéo et fréquence 
de rafraîchissement du moniteur

Lorsque vous lisez une vidéo sur un moniteur 
présentant une fréquence de rafraîchissement 
différente de la cadence d'images vidéo (comme 
c'est souvent le cas lors de l'utilisation d'une sortie 
DVI), la sortie comporte des artefacts visuels et des 
décalages de synchronisation entre l'audio et la 
vidéo. Cela se produit par exemple lors de la lecture 
d'un clip vidéo en 24 i/s sur un moniteur DVI ayant 
une fréquence de rafraîchissement de 75 Hz. 

Si votre workflow requiert une lecture de haute 
qualité, vous devez sortir la vidéo sur un moniteur 
vidéo à l'aide d'un périphérique vidéo Avid.

La downconversion est impossible pour les 
projets en 720p. 

Pour obtenir des informations détaillées sur 
la qualité de la sortie DVI sur votre moniteur 
principal ou secondaire, reportez-vous à la 
section « Workflows Avid Video Satellite » à 
la page 1297.
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Les problèmes de synchronisation audio/vidéo et 
d'artefacts se présentent comme suit :

Déformation instabilité des images : la 
déformation de l'image est la distorsion 
horizontale qui se produit sur les séquences rapides 
ou très éditées. L'instabilité vidéo est une lecture 
vidéo légèrement saccadée.

Vous pouvez résoudre ces problèmes l'un après 
l'autre (mais pas simultanément) à l'aide de l'option 
Flip On Vertical Sync de la boîte de dialogue Full 
Screen Playback Settings.

Décalage de la synchronisation audio/vidéo : La 
synchronisation entre l'audio et la vidéo varie 
légèrement à chaque image. Généralement 
indétectable à l'œil nu, des outils de mesure précis 
entraînent le décalage de la synchronisation 
audio/vidéo pouvant atteindre une demi-image, 
voire plus. Ce phénomène est normal lorsque vous 
utilisez la sortie d'une carte vidéo d'un ordinateur et 
n'affecte pas l'acquisition, le montage ou le report.

Résolutions vidéo prises en 
charge
Media Composer et Symphony Video Satellite 
prennent en charge l'importation, la capture et la 
lecture d'une large gamme de résolutions et 
cadences d'images vidéo (dont les vidéos HD).

Pour de plus amples informations sur les résolutions 
et cadences d'images prises en charge, reportez-
vous à l'aide en ligne d'Avid Media Composer ou 
rendez-vous sur le site Web Avid (www.avid.com).

Pour accéder à l'aide en ligne de Media Composer :

• Sélectionnez Help > Online Help.

Workflows Avid Video 
Satellite
Les sections suivantes décrivent les workflows 
pour l'utilisation de Pro Tools avec 
Media Composer ou Symphony configuré en tant 
que système Avid Video Satellite :

• Connexion de Pro Tools à un satellite

• Liaison de Pro Tools à un satellite

• Capture d'audio et de vidéo

• Capture d'audio et de vidéo par lot

• Enregistrement d'audio et de vidéo

Utilisation d'un système 
Video Satellite dans un 
environnement Avid Interplay
Les utilisateurs de Video Satellite peuvent préférer 
utiliser le système Avid Interplay pour la gestion 
de fichiers en réseau. Pour plus d'informations sur 
la prise en charge de Pro Tools pour Interplay, 
reportez-vous au Guide Avid Interplay Pro Tools.

Connexion de Pro Tools à un 
système Video Satellite
Pour que Pro Tools et le satellite vidéo puissent 
synchroniser leur transport, ils doivent être liés. 
Toutefois, avant que la liaison soit effective, vous 
devez établir entre eux des canaux de 
communication de base. Lorsque les systèmes 
Pro Tools et Video Satellite ont établi cette 
communication, ils sont connectés.

Pour connecter les systèmes Pro Tools et Video 
Satellite, vous devez d'abord les connecter via 
Ethernet.
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De plus, l'option Video Satellite doit être activée 
sur le système Media Composer et les systèmes 
doivent être connectés.

Conditions pour la connexion de 
Pro Tools à un système Video 
Satellite
Les conditions suivantes s'appliquent aux 
connexions entre Pro Tools et des systèmes 
Video Satellite :

• Quitter une application Pro Tools agissant en tant 
qu'administrateur d'un système Video Satellite 
libère ce système Video Satellite pour qu'il puisse 
être lié à d'autres systèmes Pro Tools.

• Si vous quittez Pro Tools alors qu'un système 
satellite est connecté, à sa prochaine exécution, 
il tentera de se reconnecter au même système 
satellite.

• Lorsqu'il est lié à un système Video Satellite, 
Pro Tools ne poursuit pas de timecode MIDI 
(MTC).

Résolution des problèmes de 
connexion des satellites
Si le système satellite n'apparaît pas dans le menu 
déroulant Administrator, vérifiez les points 
suivants :

1 Assurez-vous que Media Composer ou 
Symphony est entièrement lancé.

2 Dans Media Composer, accédez à la fenêtre 
Project et sélectionnez Settings > Video 

Satellite. Assurez-vous que le mode Video 
Satellite est activé.

3 Dans la page Satellite de la boîte de dialogue 
Peripherals de Pro Tools, sélectionnez un autre 
port Ethernet dans le menu Interface. Beaucoup 
d'ordinateurs possèdent plusieurs ports ou 
« interfaces » Ethernet. L'interface sélectionnée 
ici doit être celle connectée au même réseau que 
le système satellite.

4 Dans la fenêtre Project de Media Composer 
ou Symphony, cliquez sur l'onglet Settings, puis 
double-cliquez sur Video Satellite Settings et 
vérifiez que le port TCP/UDP est le même que 
le port TCP/UDP affiché dans le volet Satellite 
de la boîte de dialogue Peripherals de Pro Tools 
(les deux ports par défaut sont 28 282).

5 Si les paramètres du port TCP/UDP sont 
identiques, vérifiez auprès de votre 
administrateur réseau que le port affiché 
n'est pas bloqué sur le réseau.

6 Vérifiez que tous les câbles Ethernet sont 
branchés et fonctionnent. Généralement, 
des témoins lumineux indiquent l'activité au 
niveau des ports Ethernet.

7 La lecture sur système Video Satellite ne 
fonctionnera pas dans les conditions suivantes :

• Certaines boîtes de dialogue sont ouvertes dans 
Pro Tools ou Media Composer.

• Media Composer n'est pas l'application active.

• Pro Tools n'a pas de session ouverte ou 
Media Composer n'a pas de séquence ouverte.

L'exécution d'autres applications en même 
temps que Media Composer est susceptible 
d'entraîner un comportement inattendu, 
comme des problèmes de synchronisation 
audio/vidéo, la perte d'images et une lecture 
audio saccadée. Il est conseillé de ne lancer 
aucune autre application pendant l'exécution 
de Media Composer, et ce, en mode Satellite 
ou non.

Pour que Video Satellite fonctionne 
correctement, le port TCP/UDP doit être 
compris entre 1 024 et 65 534.
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Correspondance des 
paramètres de Media 
Composer et Pro Tools dans 
un système Video Satellite
Pour synchroniser précisément la lecture entre 
Pro Tools et Media Composer, les paramètres 
suivants doivent correspondre :

• Le paramètre Project Type de Media Composer 
et les paramètres Timecode Rate, Clock 
Reference et Video Format de Pro Tools

• Les paramètres Audio Pull-Up de Pro Tools et 
Edit Play Rate de Media Composer

• Format de timecode (Drop Frame ou Non-Drop 
Frame)

Pour permettre la lecture de Pro Tools en 
synchronisation avec Media Composer ou 
Symphony comme système Video Satellite, tous 
ces paramètres sont interdépendants. Une non-
correspondance au niveau de l'un de ces 
paramètres entraînera l'affichage d'un message 
d'erreur dans Pro Tools. 

Le paramètre Starting TC de Media Composer et le 
paramètre Session Start de Pro Tools peuvent ne 
pas correspondre exactement, mais doivent 
généralement être proches.

Lorsque vous travaillez avec des projets 24p et 
23,976, par défaut, Media Composer affiche les 
images correspondant à un timecode de 29,97 i/s. 
Pour que les timecodes de Pro Tools et 
Media Composer ou Symphony soient 
synchronisés lorsque vous travaillez sur des 
projets 24p ou 23.976, cliquez sur le timecode 
situé au-dessus de la fenêtre Record et sélectionnez 
Sequence > Timecode > 24 > Mas.

Correspondance entre le type 
de projet Media Composer et 
la fréquence de timecode, 
la référence d'horloge et le 
format vidéo de Pro Tools
Cette section explique comment faire correspondre 
le type de projet Media Composer avec la 
fréquence de timecode, la référence d'horloge et le 
format vidéo de Pro Tools.

Pour vous assurer que votre système Video 
Satellite lira ou capturera en utilisant les 
paramètres adéquats :

1 Dans Media Composer, cliquez sur l'onglet 
Format de la fenêtre Project.

2 Sélectionnez le paramètre souhaité dans le 
menu déroulant Project Type.

3 Dans Pro Tools, sélectionnez Setup > Session.

4 Sélectionnez un paramètre de timecode dans le 
menu déroulant Timecode Rate, compatible 
avec le paramètre Project Type de 
Media Composer.

Pour éviter les problèmes de synchronisation 
à d'autres étapes de la post-production, il est 
vivement recommandé, dans la plupart des 
cas, de modifier les paramètres de Pro Tools 
afin qu'ils correspondent à ceux de la 
séquence ouverte dans Media Composer. 

Dans la plupart des cas, la modification du 
type de projet Media Composer n'est pas 
conseillée. Vous devez modifier la 
fréquence de timecode de Pro Tools, 
à moins d'effectuer une downconversion SD 
à partir d'un projet HD. Reportez-vous au 
Guide de référence Pro Tools.

Le type de projet est également défini lorsque 
vous créez un projet dans Media Composer.
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5 Assurez-vous qu'une source d'horloge 
compatible est disponible et bien connectée.

6 Sélectionnez la référence d'horloge dans le 
menu déroulant Clock Reference.

7 Sélectionnez un format vidéo compatible dans 
le menu déroulant Video Ref Format.

Correspondance entre 
fréquence de pull-up audio et 
cadence de lecture
Par défaut, Media Composer lit les séquences à la 
cadence d'images spécifiée dans le nom du type de 
projet. Par exemple, un projet 25i PAL est lu 
à 25 i/s, l'exception étant 30i NTSC, qui est en 
réalité lu à 29.97 i/s. 

Lorsque vous travaillez avec des projets 23.976, 
24p NTSC, 24p PAL et 25p PAL, vous pouvez 
modifier la cadence de lecture (avec l'option 
appelée Edit Play Rate), sans affecter d'autres 
propriétés, de manière à ralentir ou à accélérer 
légèrement la lecture. Il s'agit de l'équivalent vidéo 
du paramètre de pull up/pull down audio de 
Pro Tools.

Pour modifier la cadence de lecture :

1 Sur l'onglet Settings de la fenêtre Project, 
ouvrez les paramètres Film and 24P.

2 Sélectionnez une valeur de paramètre Edit Play 
Rate qui correspond à votre configuration, selon 
le tableau suivant.

Pour modifier les paramètres de pull up/down 
dans Pro Tools :

1 Dans Pro Tools, sélectionnez Setup > Session.

2 Sélectionnez une fréquence dans le menu 
déroulant Audio Rate Pull Up/Down de la 
section Timecode Settings de la fenêtre Session 
Setup.

3 Cliquez sur OK pour appliquer la nouvelle 
fréquence de pull up/down à la session.

Le paramètre Video Ref Format n'est pas 
modifiable pour la plupart des cadences 
d'images HD.

Les projets 24p (PAL et NTSC) utilisent un 
paramètre Edit Play Rate par défaut qui ne 
correspond pas à la cadence du projet. 
Par défaut, 24p PAL prend la valeur 25 i/s et 
24p NTSC prend la valeur 23.976 i/s.
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Tableau de compatibilité

Le tableau suivant décrit la compatibilité entre les formats de projet et le paramètre Edit Play Rate 
d'Avid et les paramètres Time Code Rate, Audio Pull Up/Down Rate, Clock Reference et Video Format 
de Pro Tools.

Compatibilité des référence de synchronisation et des cadences entre Avid et Pro Tools

Media Composer ou Symphony Pro Tools

Format de 
projet Avid

Edit 
Play 
Rate

Réf vidéo 
Mojo DX ou 

Nitris DX

Timecode 
Rate PT

Audio Pull 
Up/Down PT

Format Réf 
vidéo 

SYNC HD 

23.976p NTSC 23.976 NTSC 23.976 Aucun NTSC

24 NTSC 24 Up 0,1 % NTSC

24p NTSC 24 NTSC 24 Aucun NTSC

23.976 NTSC 23.976 Down 0,1 % NTSC

30i NTSC 29.97 NTSC 29.97 Variable NTSC

24p PAL 24 PAL 24 Aucun PAL

25 PAL 25 Up 4 % PAL

25p PAL 25 PAL 25 Aucun PAL

24 PAL 24 Down 4 % PAL

25i PAL 25 PAL 25 Aucun PAL

720p/23.976 23.976 720p/59.94* 23.976 Aucun 720p/59.94 
(ou NTSC)

720p/25 25 720p/50 25 Aucun 720p/50 
(ou PAL)

720p/29.97 29.97 720p/59.94 29.97 Aucun 720p/59.94 
(ou NTSC)

720p/50 50 720p/50* 25 Aucun 720p/50 
(ou PAL)

720p/59.94 59.94 720p/59.94* 29.97 Aucun 720p/59.94 
(ou NTSC)
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1080p/23.976 23.976 1080p/23.98sF 23.976 Aucun 1080p/23.97 
(ou NTSC)

1080p/24 24 1080p/24sF 24 Aucun 1080p/24 
(ou PAL ou 
NTSC)

1080p/25 25 1080p/25sF (ou 
1080i/50)*

25 Aucun 1080p/25 
(ou 1080i/50 ou 
PAL)

Compatibilité des référence de synchronisation et des cadences entre Avid et Pro Tools
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* Bien que Media Composer, utilisé seul, prenne en charge le verrouillage du périphérique vidéo sur un 
signal black burst ou de synchro Tri-level à ces fréquences HD, Video Satellite prend uniquement en charge 
le verrouillage du périphérique vidéo Media Composer sur un signal de synchro Tri-level avec ces 
fréquences HD.

Correspondance entre les 
formats de timecode (Drop 
Frame ou Non-Drop Frame)
Le même format de timecode (Drop Frame ou 
Non-Drop Frame) doit être configuré sur 
Pro Tools et Media Composer.

Pour s'assurer que les paramètres de format de 
timecode sont compatibles :

1 Dans Pro Tools, sélectionnez Setup > Session. 
Si le menu déroulant de fréquences de timecode 
affiche « DF » après la fréquence d'images, 
Pro Tools est défini sur Drop Frame.

2 Dans Media Composer, effectuez un clic droit 
sur la fenêtre Record, puis sélectionnez 
Sequence Report. 

Media Composer ou Symphony (suite) Pro Tools (suite)

Format de 
projet Avid

Edit 
Play 
Rate

Réf vidéo 
Mojo DX ou 

Nitris DX

Timecode 
Rate PT

Audio Pull 
Up/Down PT

Format Réf 
vidéo 

SYNC HD

1080p/29.97 29.97 1080i/59.94 29.97 Aucun 1080i/59.94, 
1080psf-29.97 
(ou NTSC)

1080i/50 50 1080i/50* 25 Aucun 1080i/50, 
1080psf-25 
(ou PAL)

1080i/59.94 59.94 1080i/59.94* 29.97 Aucun 1080i/59.94, 
1080psf-29.97 
(ou NTSC)

Compatibilité des référence de synchronisation et des cadences entre Avid et Pro Tools

Dans certains formats de projet, 
Media Composer peut être configuré en Drop 
Frame ou Non-Drop Frame, alors que la 
fréquence de timecode de Pro Tools peut 
uniquement être définie sur Non-Drop Frame. 
Dans ce cas, Media Composer envoie 
à Pro Tools des informations de timecode 
Non-Drop, même s'il est paramétré sur Drop 
Frame. Dans Media Composer, les formats de 
projet suivants présentent ce comportement : 
23.976p NTSC, 24p NTSC et 720p/23.976.
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Si les valeurs des champs TC sont séparées par un 
point-virgule au lieu de deux points, le projet est 
défini sur Drop Frame.

3 Si les deux formats de timecode ne 
correspondent pas, utilisez l'une des méthodes 
suivantes :

• Pour forcer Pro Tools à utiliser le format 
de timecode correspondant à celui de 
Media Composer, sélectionnez le format 
de timecode compatible dans le menu 
déroulant Timecode Rate.

• Pour forcer Media Composer à utiliser la 
fréquence de timecode correspondant à celle 
de Pro Tools, entrez des points-virgules (Drop 
Frame) ou deux points (:) (Non-Drop Frame) 
entre les valeurs du champ Starting TC, puis 
appuyez sur Entrée.

Correspondance entre le 
paramètre Starting TC de 
Media Composer et le paramètre 
Session Start de Pro Tools
Dans presque tous les cas de figure, la première 
image d'une vidéo se situe au début de la séquence 
Media Composer. En revanche, les sessions 
Pro Tools contiennent souvent un espace vide 
au début, pour créer un décompte ou un silence. 

Par exemple, une séquence Media Composer peut 
démarre à 01:00:00:00 alors que la session Pro Tools 
correspondante démarre à 00:59:55:00, en incluant 
cinq secondes de silence avant le début de l'audio.

Pour définir le timecode de début par défaut pour 
les nouvelles séquences de Media Composer :

1 Dans la fenêtre Project, cliquez sur l'onglet 
Settings, puis double-cliquez sur le paramètre 
General.

2 Saisissez le timecode de début de votre choix 
dans le champ Default Starting TC.

Pour modifier le timecode de début d'une 
séquence existante dans Media Composer :

1 Dans Media Composer, ouvrez le chutier 
contenant la séquence.

2 Au besoin, agrandissez la fenêtre du chutier 
pour visualiser la colonne Start.

3 Dans la colonne Start, pour la séquence dont 
vous souhaitez définir un nouveau timecode 
de début, saisissez ce temps en utilisant le 
caractère point-virgule (pour Drop Frame) 
ou deux points (pour Non-Drop Frame), 
puis appuyez sur Entrée.

4 Cliquez sur OK pour confirmer.

Boîte de dialogue Clip Info (Media Composer, en haut) 
et une partie de la fenêtre Session Setup (Pro Tools, 
en bas)

Champ 
Starting TC

Champ Session 
Start

Timecode 
Rate

Parfois, une lecture depuis Media Composer 
démarrant plus d'une minute avant la session 
Pro Tools peut aboutir à un échec. Dans ce 
cas, avancez le début de la session Pro Tools.
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Compensation d'heures de début 
différentes dans Pro Tools et un 
système Video Satellite

Vous pouvez compenser tout décalage apparaissant 
si les timecodes de début d'une séquence Avid 
différent de Media Composer à Pro Tools.

Pour compenser des timecodes de début de 
séquence différents :

1 Dans Pro Tools, sélectionnez Setup > Session. 
La fenêtre Session Setup s'affiche.

2 Dans la section External Timecode Offset, 
compensez le décalage entre Pro Tools et Video 
Satellite comme suit :

• Si l'heure de début de la séquence du système 
Video Satellite est antérieure à celle de la 
séquence Pro Tools, saisissez une valeur de 
timecode positive dans le champ Satellite Offset.

• Si l'heure de début de la séquence du système 
Video Satellite est postérieure à celle de la 
séquence Pro Tools, saisissez une valeur de 
timecode négative dans le champ Satellite Offset.

Compensation d'un délai de 
sortie induit par le moniteur
De nombreux moniteurs génèrent un délai d'une ou 
plusieurs images sur la sortie vidéo. Vous pouvez 
le compenser en avançant la sortie vidéo du 
nombre d'images nécessaires.

Pour définir le nombre d'images de décalage de la 
sortie vidéo :

1 Dans Media Composer, sélectionnez Settings > 

Video Satellite Settings.

2 Dans le champ Video Satellite Offset, saisissez 
une valeur positive qui correspond à la quantité 
de délai induite par les moniteurs. Vous aurez 
peut-être à essayer plusieurs valeurs de 
paramètre.

Liaison ou dissociation de 
Pro Tools et d'un système 
Video Satellite
Après avoir connecté et configuré un unique 
système Pro Tools HD et un système Avid Video 
Satellite au sein d'un réseau Satellite Link, vous 
pouvez les contrôler avec les commandes de 
transport de Pro Tools et de Media Composer. 
Toutefois, si plus d'un système Pro Tools HD est 
connecté et configuré au sein d'un réseau Satellite 
Link incluant un système Avid Video Satellite, 
la lecture ne peut être lancée qu'à partir d'un 
système Pro Tools HD du réseau.

Une fois liés, Pro Tools et Media Composer prennent 
en charge les opérations de transport suivantes :

• Avec lecture audio :

• Lecture

• Lecture à mi-vitesse

• Lecture en boucle

• Shuttle

• Scrubbing

• Enregistrement

• Enregistrement en boucle

• FF/REW (avec l'option Audio During FF/RW 
activée dans Pro Tools)

• Sans lecture audio :

• Calage

• Déplacement par incrément

• Sélection

Les fonctionnalités standard de l'option 
MachineControl de Pro Tools sont 
indépendantes et non affectées par les 
commandes de transport du système Video 
Satellite. Toutefois, la poursuite d'un 
timecode MIDI Machine Control ou MIDI 
n'est pas prise en charge lorsque Pro Tools 
est lié à un système Video Satellite.
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Lorsque vous utilisez les touches J, K et L pour 
effectuer un shuttle dans Media Composer, 
Pro Tools lit les données audio à la vitesse avant de 
1x, mais pas en retour arrière, ni aucune autre 
vitesse de lecture possible.

Commandes de liaison
Lorsqu'un système Pro Tools HD est configuré en 
tant qu'administrateur, les commandes suivantes 
sont affichées dans la fenêtre de transport : 

Bouton de liaison : contrôle l'état de liaison du 
système local.

Boutons Satellite Link : contrôlent l'état de liaison 
des autres systèmes satellites. Sur chaque système, 
l'un de ces boutons correspond au bouton Link 
principal de ce système.

Les boutons Link sont mis en surbrillance pour 
indiquer l'état lié.

Pour afficher les commandes de liaison dans la 
fenêtre de transport :

 Sélectionnez View > Transport > 

Synchronization et View > Transport > 

Expanded.

Pour lier ou dissocier le système Pro Tools local :

 Cliquez sur le bouton de liaison de la fenêtre 
de transport. 

Pour activer ou désactiver la liaison d'autres 
systèmes Video Satellite :

 Cliquez sur le bouton Satellite Link 
correspondant de la fenêtre de transport.

Pour activer ou désactiver la liaison du système 
Video Satellite à partir de Media Composer, 
effectuez l'une des opérations suivantes :

 Cliquez sur le bouton Satellite Link pour définir 
l'état lié (vert) ou non (gris).

 Appuyez sur les touches Maj+Alt+L (Windows) 
pour passer de l'état lié à non lié, et vice versa.

Les modes Trim, Color Correction et Effects 
de Media Composer et Symphony ne sont pas 
pris en charge avec Avid Video Satellite.

Dans Media Composer, activez l'option Play 
Preparation Delay (Settings > Video Satellite) 
pour éviter toute erreur possible en début de 
lecture des séquences comprenant des vidéos 
nécessitant une bande passante élevée ou des 
effets non rendus. De même, activez l'option 
Loop Preparation Delay pour éviter tout 
problème de lecture en boucle.

Commandes de liaison de la fenêtre de transport 
Pro Tools

Les boutons de liaison clignotent brièvement 
lorsque l'horloge du réseau est en cours 
d'acquisition.

Si Media Composer affiche un message 
d'erreur, le bouton Satellite Link du Video 
Satellite dans Pro Tools devient rouge. 
Maintenez le curseur au-dessus du bouton de 
liaison pour afficher la boîte de dialogue. 
Pour fermer cette boîte de dialogue, 
maintenez la touche Maj enfoncée tout en 
cliquant sur le bouton Satellite Link du 
système Video Satellite.

Bouton de liaison

Boutons Satellite Link
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Contrôle de la liaison avec une 
surface de contrôle

Pour commuter l'état du bouton Link sur le 
système Pro Tools (ICON et C|24) :

 Maintenez la touche Ctrl (Mac) ou Alt 
(Windows) enfoncée et appuyez sur le bouton 
Online de la surface de contrôle.

Pour commuter l'état du bouton Satellite Link 
(D-Control ou D-Command uniquement) :

1 Maintenez la touche Commande (Mac) ou Ctrl 
(Windows) enfoncée et appuyez sur le bouton 
Modes de la surface de contrôle pour afficher 
tous les systèmes liés dans l'affichage des 
touches programmables.

2 Le bouton Modes s'allume. Si vous appuyez 
à nouveau sur le bouton Modes, vous quitterez 
le mode Satellite Link.

3 Vous pouvez alors appuyez sur les touches 
programmables correspondant à chaque 
équipement pour activer/désactiver la liaison 
de cet équipement.

Video Satellite et surfaces de contrôle 
et de travail EUCON

Une sélection de commandes de liaison de systèmes 
ont été intégrées au protocole EUCON. Pour plus 
d'informations sur le contrôle de fonctions Video 
Satellite depuis des périphériques EUCON, 
reportez-vous au Guide Pro Tools EUCON.

Capture d'audio et de vidéo 
avec un système Video 
Satellite
Vous pouvez utiliser un système Video Satellite 
pour capturer de l'audio dans Pro Tools et de la 
vidéo dans Media Composer en une seule passe.

Avant la capture d'audio et de 
vidéo
Avant de capturer de l'audio ou de la vidéo à partir 
d'une bande, assurez-vous d'avoir établi les 
connexions suivantes.

Pour des connexions avec un périphérique vidéo 
Avid, procédez comme suit :

1 Connectez les sorties souhaitées du 
magnétoscope aux entrées correspondantes 
du périphérique vidéo.

2 Connectez la source audio aux entrées de votre 
interface audio Pro Tools HD principale.

Pour des connexions sans périphérique vidéo 
Avid, procédez comme suit :

 Pour les connexions basées sur FireWire, 
connectez directement le câble FireWire au port 
FireWire du système Media Composer. 

Étant donné que la vidéo et l'audio sont acheminés 
par un seul signal via FireWire, il n'est pas 
nécessaire de connecter des entrées audio.

Si vous capturez de la vidéo via FireWire, vous 
devez capturer l'audio et la vidéo dans 
Media Composer, car un unique câble FireWire 
achemine à la fois la vidéo et l'audio. Les données 
audio peuvent ensuite être exportées vers 
Pro Tools.

Pour plus d'informations, reportez-vous au 
guide de votre interface Pro Tools HD.
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Conditions pour la capture 
d'audio et de vidéo
Les conditions suivantes s'appliquent à la capture 
audio et vidéo avec un système Video Satellite :

• En raison de limitations techniques, lors de la 
capture de vidéo à partir d'un périphérique 
contrôlé à l'aide d'une connexion 1394, l'audio 
peut subir une désynchronisation allant jusqu'à 
3/4 d'une image.

• Si vous souhaitez capturer une bande vidéo de 
télécinéma à 29,97 pour un projet à 24 i/s, 
vous devez d'abord capturer l'audio et la vidéo 
dans Media Composer, puis exporter à nouveau 
l'audio vers Pro Tools. Pour l'exportation 
manuelle d'une séquence AAF, reportez-vous au 
Guide Avid Media Composer.

Configuration de Pro Tools et 
d'un système Video Satellite 
Media Composer pour la capture
Avant de configurer Pro Tools et Media Composer 
pour une capture synchronisée, vérifiez que les 
paramètres des deux applications correspondent. 
Pour plus d’informations, reportez-vous à la 
section « Correspondance des paramètres de 
Media Composer et Pro Tools dans un système 
Video Satellite » à la page 1299.

Configuration de Pro Tools pour la 
capture au sein d'un système Video 
Satellite

Pour configurer Pro Tools pour la capture audio :

1 Dans Pro Tools, sélectionnez Setup > Session 
et vérifiez ce qui suit :

• Le menu déroulant Clock Source est défini sur 
SYNC.

• Le menu déroulant Clock Reference est défini 
sur Video Reference.

• Si le menu déroulant Clock Reference est défini 
sur une autre source, comme Word Clock, 
assurez-vous que le témoin Ref Present est 
allumé et que la référence d'horloge sur laquelle 
est verrouillée l'option SYNC correspond à celle 
du magnétoscope.

2 Routez les entrées audio vers les pistes de votre 
choix.

3 Activez pour l'enregistrement les pistes audio 
sur lesquelles vous souhaitez capturer l'audio.

4 Cliquez sur le bouton Record Enable de la 
fenêtre de transport.

Configuration de Media Composer pour 
la capture vidéo

Avid Video Satellite prend en charge la capture 
vidéo dans une séquence nouvelle ou existante 
à l'aide des outils de capture de Media Composer 
ou Symphony. Reportez-vous à la documentation 
de Media Composer ou Symphony pour les détails 
de configuration.

Lecture de pistes audio et vidéo 
capturées avec un système Video 
Satellite

Lorsque vous avez terminé une capture avec un 
système Video Satellite, le clip capturé s'affiche 
dans la fenêtre Record et sur la timeline. L'audio 
apparaît sur la timeline de Pro Tools.

Pour visionner le clip capturé, procédez comme 
suit :

 Cliquez sur Play (ou appuyez sur la barre 
d'espace) dans Pro Tools ou Media Composer.
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Nouvelle numérisation d'une 
séquence existante
Media Composer peut ouvrir des séquences créées 
sur d'autres systèmes de montage Avid. Toutefois, 
il se peut que vous souhaitiez numériser à nouveau 
certains ou tous les fichiers média en raison d'une 
mauvaise résolution, ou parce qu'ils sont 
manquants.

Lorsque vous utilisez cette procédure avec un 
système Video Satellite, vous devez capturer les 
données audio dans Media Composer, puis 
exporter une séquence AAF référençant ou 
contenant les données audio intégrées dans 
Pro Tools. 

Numérisation à partir d'une 
EDL
Media Composer inclut le logiciel Avid EDL 
Manager, qui vous permet d'ouvrir une liste de 
points de montage (EDL) provenant d'une autre 
application de montage, de créer une séquence 
Media Composer à partir de cette EDL, puis de 
renumériser la séquence.

Lorsque vous utilisez cette procédure avec un 
système Video Satellite, vous devez capturer les 
données audio dans Media Composer, puis 
exporter une séquence AAF référençant ou 
contenant les données audio intégrées dans 
Pro Tools. 

Report sur bande d'audio et 
de vidéo
Vous pouvez reporter sur bande de l'audio de 
Pro Tools et de la vidéo de Media Composer 
à l'aide de l'outil Digital Cut de Media Composer. 
Reportez-vous à la documentation de 
Media Composer pour les détails de configuration. 
Notez que la connexion 9 broches doit être reliée 
au système Media Composer.

Pour enregistrer les données audio et vidéo sur 
bande simultanément depuis Media Composer et 
Pro Tools :

1 Assurez-vous que le système est configuré 
comme suit : 

• Pro Tools et les ordinateurs Media Composer 
Video Satellite sont liés.

• Les sorties audio de l'interface audio 
Pro Tools HD sont connectées aux entrées audio 
appropriées du magnétoscope.

La fonction Universal Mastering de 
Symphony n'est pas prise en charge avec 
Video Satellite.

Pour réduire le risque d'omission d'images, 
il est conseillé de rendre tous les effets avant 
d'effectuer un report.

Lorsque vous effectuez un report sur un 
magnétoscope SDI ou un périphérique 1394 
requérant que les données audio et vidéo 
soient combinées en un seul flux, vous devez 
exporter l'audio vers Media Composer 
depuis Pro Tools ou combiner les signaux 
audio et vidéo à l'aide d'un périphérique de 
sommation tiers, puis effectuer le report de la 
séquence finale sur bande.



Guide de référence Pro Tools1310

• Les sorties vidéo du système Media Composer 
sont connectées au magnétoscope.

• Si vous utilisez un contrôle d'appareil, son câble 
sortant de Media Composer est connecté au 
magnétoscope, ce dernier étant configuré en 
mode Remote.

2 Insérez la bande vidéo dans le magnétoscope. 

3 Pour vérifier que le magnétoscope est bien 
configuré, reportez-vous à la section suivante 
de l'aide de Media Composer (Help > Avid 

Media Composer Help) : Configuring a Deck or 
Multiple Decks.

4 Effectuez l'une des opérations suivantes :

• Sélectionnez l'un des noms de bande affichés et 
cliquez sur OK.

• Cliquez sur New pour ajouter une nouvelle 
bande à la liste.

5 Faites glisser la séquence à enregistrer sur 
bande du chutier vers la fenêtre 
d'enregistrement.

6 Sélectionnez Output > Digital Cut. L'outil 
Digital Cut s'affiche.

7 Si vous souhaitez définir les points d'entrée et 
de sortie pour un report sur bande. 

8 Effectuez l'une des opérations suivantes :

• Sélectionnez l'option Entire Sequence pour 
enregistrer l'intégralité de la séquence.

• Désélectionnez l'option Entire Sequence et 
définissez les points d'entrée et de sortie sur la 
timeline.

9 Si vous effectuez un report via une connexion 
FireWire (1394) (Special > Device > IEEE 

1394), sélectionnez le mode de sortie approprié 
à partir du menu déroulant Output Mode, 
comme suit :

• Si tous les médias de la timeline sont DV25, 
ou DV50, et si tous les effets sont calculés, vous 
pouvez obtenir une qualité de sortie légèrement 
meilleure en sélectionnant DV25 ou DV50, 
selon le cas.

• Sinon, vous devez sélectionner les options 
RT DV25 ou RT DV50 pour effectuer le calcul 
et le transcodage de toutes vos données vidéo au 
format approprié.

Lorsque vous utilisez Media Composer en 
mode Satellite pour des projets 24p et 23.976, 
seuls les formats de sortie 24 et 23.976 sont 
pris en charge. Le format de sortie 29.97 
(vitesse de lecture de +25 % sans 
compensation) n'est pas pris en charge en 
mode Satellite pour les projets 24p et 23.976p.

Outil Digital Cut
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10 Sélectionnez l'option Stop on Dropped Frames 
si vous souhaitez que Media Composer arrête 
automatiquement la vidéo si l'enregistrement 
des données audio et vidéo ne s'effectue pas 
correctement.

11 Sélectionnez l'option Add Black At Tail et 
saisissez la quantité de noir à ajouter à la fin 
de la séquence.

12 Sélectionnez l'une des options de commande 
d'appareil suivantes :

Mode Local : vous lancez l'enregistrement 
manuellement. 

Mode Remote : Media Composer démarrera le 
magnétoscope et déclenchera l'enregistrement 
au timecode spécifié.

13 Si vous choisissez le mode Remote, 
sélectionnez l'une des options suivantes :

Sequence Time : démarre l'enregistrement en se 
basant sur le timecode de la séquence. Par exemple, 
si la séquence démarre à 01:00:00:00 sur la timeline, 
Media Composer commence l'enregistrement 
lorsque la bande atteint 01:00:00:00.

Record Deck Time : démarre l'enregistrement 
à la position actuelle du magnétoscope.

Mark In Time : démarre l'enregistrement à l'adresse 
saisie dans la fenêtre située en haut à droite des 
commandes de la barre de transport.

14 À l'aide des boutons Source Track, sélectionnez 
la piste vidéo supérieure. Seules les pistes vidéo 
sélectionnées et les pistes vidéo situées en 
dessous seront enregistrées.

15 Si vous sélectionnez le mode Remote, utilisez 
les boutons Record Track sur la droite pour 
sélectionner les pistes audio et vidéo à activer 
pour l'enregistrement sur bande.

16 Cliquez sur le bouton jaune Preview pour 
vérifier que toutes les pistes sélectionnées sont 
lues et que les points d'insertion sur la bande 
sont corrects.

17 Effectuez l'une des opérations suivantes :

• Pour enregistrer en mode Local, cliquez sur le 
bouton de lecture et procédez à l'enregistrement sur 
le magnétoscope. Lorsque vous êtes prêt, cliquez 
sur le bouton Record dans la fenêtre Digital Cut.

• Pour enregistrer en mode Remote, cliquez 
sur Record dans la fenêtre Digital Cut. 
Media Composer placera la bande en attente, 
la lira, puis lancera l'enregistrement 
à l'emplacement approprié.

Pistes source sélectionnées

Lorsque vous effectuez un report sur bande 
avec un périphérique vidéo Avid Mojo DX ou 
Nitris DX, le mode de sortie doit être défini 
sur Real Time si vous utilisez des sorties 
vidéo autres que FireWire, afin d'obtenir une 
synchronisation audio/vidéo optimale.

Veillez à enregistrer au moins quelques 
secondes de noir sur la bande avant de 
procéder à un report sur bande. Ainsi, vous 
avez l'assurance que la bande vidéo est 
formatée correctement lorsque le report sur 
bande commence.

Bouton 
de piste 
source

Bouton Piste 
d'enregistrement

Activation pour 
l'enregistrement Aperçu
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importation 339
activation

Auto Backup, option 109
automation 1089
automation de plug-in 1046
groupe 264
insert 1037
périphérique d'entrée MIDI 482
piste 248

activation de la règle de tempo, bouton 184
activation pour l'enregistrement, bouton 447, 507
activé(e) 17
Add Key Change, commande 831
Add Marker/Memory Location, bouton 838
Adjust Session Start Time to Match Source Start 

Time 356
Advanced Meter Type Settings 121
affichage

de l'ensemble des règles 791
informations sur les fichiers de clips audio 268

informations temporelles des clips 533
marqueurs temporels d'origine 1215
marqueurs temporels utilisateur 1216
noms des clips 533
règle de métrique 821
règle de tempo 797

affichage des bus actifs 100
affichage du timecode actuel 1195
affichage du timecode entrant 1195
affichage sous forme de blocs sur la piste 

vidéo 1250
Afficher/Masquer la liste des pistes/groupes, 

bouton 230
Afficher/Masquer la liste des pistes/groupes, 

bouton 255
affinage de l'automation 1074, 1092
AFL (After Fader Listen) 245
AFL/PFL Mutes (chemin de sortie) 79
AFL/PFL, chemin 78
After Fader Listen (AFL), mode 245
After Playback, option de défilement 420
After Write Pass, Switch To, option 118, 1068
aide 197

info-bulles 105, 198
aide en ligne 1297
AIFC, format de fichier 372
ajout d'un changement de tempo, bouton 818
ajout de changement de métrique, bouton 821
ajout de déclencheurs uniques 688
alignement sur la grille 546
alignement sur le clip suivant ou précédent 856
All MIDI Notes Off, commande 724
aller à la fin, bouton 180
allocation des disques 450

et sessions multi-plateformes 451
et volume système 452
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allocation Round Robin 451
Allow Latch Prime in Stop, option 117
Allow Track Arm Commands in Local Mode, 

option 130
Always Display Marker Colors, option 106
Always Fill Channel Strips When Banking, 

option 116
Analysis, vue 912, 927
annulation d'une prise d'enregistrement 461, 490
aperçu

audio dans les navigateurs 306
de clips dans la liste des clips 274
en contexte 311
nombre de voix nécessaires 311
réservation de voix 311
traitement AudioSuite 894

Apply Real-Time Properties, option 350
archivage de sessions (avec la commande 

Compact) 621
arrêt, bouton 181
ASIO 6
Assignments, vue (option de la vue 

des départs) 1002
attribut (groupe) 262
Attributes (liste des groupes), commande 256
attribution automatique des noms

clips QuickPunch 502
clips séparés 601
et commande Strip Silence 868

attribution de nom automatique
fichiers et clips audio 445
playlists 645
prises 445

attribution de nom et saisie de commentaires pour 
une piste, boîte de dialogue 219

aucun défilement pendant la lecture 420
Audio During Fast Forward/Rewind, option 108, 418
Audio Files, dossier 158
Audio MIDI Setup (AMS) (Mac) 58
Audio Pull Up/Down, paramètre 1300
Audio Pull-Up et Edit Play Rate 1300
Audio Track Record Lock, option 504
Audio Track RecordLock, option 110
audio, pull up et pull down 1202
AudioSuite, fenêtre 889
AudioSuite, menu 197
AudioSuite, plug-in 889, 890, 896, 897, 1035

aperçu 894
bouton de ciblage 893
Bypass, bouton 895

Clip by Clip, mode 892
Clip List, commande 890
Create Continuous File, commande 892
Create Individual Files, commande 892
Entire Selection, mode 892
Overwrite File, commande 892
Playlist, commande 890
Render bouton 895
Reverse, bouton 895
sélecteur de mode de fichier 891
sélecteur de référence de sélection 890
traitement multicanal 896
Use in Playlist, bouton 891
utilisation 896
volume d'aperçu 894
Whole File, bouton 895

AudioSuite, plug-ins
Default Handle Length, préférences 124
Handle Length, paramètre 895

Audition Paths, sélecteur 78
Auto Backup, option 109
Auto Input Monitoring, mode 452, 453
Auto Rename, commande de la liste des clips 276
Auto, bouton de plug-in 1043
AutoGlide Time, préférence 118, 1183
AutoJoin

commande 1069
indicateur 1070

AutoMatch
bouton 1084
commandes individuelles 1085
indicateurs 1078
sur toutes les commandes 1085
types d'automation individuels 1085

AutoMatch Time, préférence 118, 1074
Automatically Copy Files on Import, 

option 124, 342, 354
Automatically Create Click Track in New Sessions, 

option 127
Automatically Find and Relink 395
automation 1065

activation 1089
affichage des limites et formes de fondu 644
affinage 1074, 1092
capture et application à un autre 

emplacement 1118, 1121
clip 529
collage 1099
commandes commutées 1080
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conversion de l'automation de volume en gain 
du clip 619

conversion du gain du clip en automation de 
volume 619

copie 1099
Coupage 1099
création 1083
départs 1081
dessin avec le Crayon 1093
écriture 1079
écriture à l'arrêt 1108
écriture jusqu'au point d'automation suivant 1109
écriture sur une sélection, au début ou à la fin 

d'une sélection 1106
édition 568, 1095
en paliers 1097
et assignations de sortie multiples 1163
et panoramique multicanal 1187
fusion de l'automation de trim 1105
fusion de l'automation de VCA 1126
fusion de l'automation de volume sur le gain du 

clip 619
fusion du gain du clip sur l'automation de 

volume 619
lissage 1073
Master VCA 1124
modes 1068
pistes groupées 1099
pistes masquées 232
playlist 645
playlists 1066, 1075
plug-ins 1082, 1083, 1084
point d'intersection 1068
points d'automation 1097
protection 1075
relative et absolue 1071
Safe, bouton 1043
snapshot 1116
Special Paste, mode 1102
suppression 1091
sur des pistes multicanal 1098
suspension 1089
trimming 1104
valeurs delta 1071
vue de piste 537

automation de commande en paliers 1097
automation de mute 1096
automation de panoramique 1096
automation de trim

fusion 1105

automation de volume 1096
Automation Enable, fenêtre 1079
Automation Follows Edit, option 1074
automation par snapshot 1116

ajout à des playlists d'automation vides 1117
écriture sur une automation existante 1117
et valeurs de trim 1118

Automation Preview, mode 1119
Punch Preview, bouton 1120
suspension 1120
Write Automation To, commandes 1121

automation, modes
Latch 1069
Latch Trim 1072
Off 1068
Read 1068
Read Trim 1071
Touch 1068
Touch Trim 1072
Touch/Latch 1070
Touch/Latch Trim 1072
Trim Off 1071
Write 1068
Write Trim 1072

automation, sélecteur de mode 1068
Auto-Name Memory Locations While Playing, 

option 114, 839
Auto-Name Separated Clips, option 113, 601
Auto-Spot Clips, commande 1214
avance rapide 418
avance rapide, bouton 180
avancée, mesure des niveaux 214
Avid Audio Engine (AAE) 6
Avid Audio Forums, commande 188
Avid Video Engine (AVE) 57, 1245
Avid Video Satellite 1295

B
Back and Play, commande 418
Back, commande 418
Back/Forward Amount 108, 419
Back/Forward, commandes 418
bande passante de traitement 66
Bar|Beat, marqueur

audio avec tempos variables 820
création avec la commande Identify Beat 818
déplacement 819
édition 820
et événements de tempo 819
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Bars|Beats, échelle temporelle 789
basculement

hauteur de piste 228
vue de piste 227

base de connaissances 197
Batch Fades, boîte de dialogue 638
Beat Detective 665, 666, 667

avec plusieurs pistes 681
Collection, mode 687
configuration requise 666
conformation de clips 682
déclencheur rythmique

déplacement 675
génération 671
insertion 675
promotion 675
suppression 674

définition d'une sélection 668
détection des transitoires 671
extrapolation 680
fenêtre 667
génération de marqueurs Bar|Beat 676
lissage des points d'édition 685
modèle DigiGroove 677
modèles 677
modèles de groove 678
Scroll Next 676
séparation de clips 680
Trigger Pad 680

Bi-Phase/Tach
impulsions par image, paramètre 135
Wiring paramètre 134

Blocks, vue
piste audio 224
piste vidéo 1250

New Memory Location, boîte de dialogue 465
New Paths, boîte de dialogue 88
Video Import Options, boîte de dialogue 1260
boucle

création avec l'outil de trim de boucle 562
enregistrement avec une reverb ou un 

delay 1132
outil de trim de boucle 562

boucle, outil de trim 562
bounce hors ligne (plus rapide qu'en 

temps réel) 1144
Bounce to Disk, commande 1129, 1133, 1134, 1147

chemin source 1134
choix du répertoire 1144

conversion de la fréquence 
d'échantillonnage 1140

conversion de la fréquence d'échantillonnage, 
options 1139

depuis un sélecteur de chemin de départ 1134
depuis un sélecteur de chemin de sortie 1134
dithering 1130
enregistrement d'un sous-groupe de 

mixage 1146
File Type 1136
Format 1138
format de canal, options 1138
marqueurs temporels 1133
Offline, option 1144
résolutions 1139
Share With SoundCloud, option 1141

Bounce to QuickTime Movie, commande 1273
ajout d'un changement de tempo, bouton 798
conformation des fichiers audio au tempo de la 

session, bouton 308
Bring to Front, commande 603
bus de mixage 401, 1002
Bypass Clip Gain, paramètre 619
bypass d'effet, bouton 1044
Bypass, bouton de plug-in 1044

C
C|24 49
cadence d'images

et fréquence de rafraîchissement 1296
pull up et pull down 1202

cadence du moteur vidéo 1257
Calibration Mode, commande 436
Calibration Reference Level, préférence 112
canal 12
Capture Clip, commande 599
capture de timecode 1213
capture de valeurs d'automation 1121
caractères interdits 160, 395
caractéristiques du logiciel ProTools 39
carte d'assignation de plug-in 1053

Learn, mode 1053
catalogue (espace de travail) 287
Center Playhead Scrolling, option 422
Change Duration, commande 937, 957
Change Edit to Match Timeline, commande 590
Change Meter, commande 772, 821, 823, 824
Change Tempo, commande 798
Change Timeline to Match Edit, commande 589
Change Velocity, commande 937, 954
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changement de programme 715
déplacement 719
écoute 719
édition 719
et sélection de banque 715
insertion 718
par défaut, pour une piste MIDI 716
suppression 719

changement de programme MIDI
poursuite 722

changement de zoom 554
Check for Updates, commande 50
chef d'orchestre, bouton 184
chemin 70

activation et désactivation 93
création 87
création de chemins multicanal 1155
de sortie par défaut 78
derniers paramètres utilisés 102
exemple multicanal 95
exemples de sous-chemins surround 1171
mappage 94
modification 90
mono et stéréo par défaut 91
personnalisation 90
pour le surround 1167
principal 70
réorganisation 93
sélection 92
sous-chemins 70
superposition 95
suppression 93

chemin de signal audio 70
chemin de sortie, sélecteur 236
chemin des indicateurs, sélecteur 77
chemin principal 70
chemin source 1134
chemins

d'écoute 78
chemins superposés 95
Chord Change, boîte de dialogue 835
cible, bouton de plug-in 1044
Classic, mode du pavé numérique 28, 109
Clear All Clip Indicators, commande 211, 212, 1005
Clear Clip Gain, commande 617
Clear Special, commandes (automation) 1102
Clear Trim Automation, commande 233, 1092
Clear, commande (menu Edit) 539

Clear, commande de la liste des clips 277, 278
clic 437, 438
clic du métronome, bouton 183
Click, plug-in 436
clics et pops, éviter 528
clip 11, 224, 526

adaptation de la durée à une sélection 
d'édition 622

affichage des informations temporelles 533
affichage du nom 533
alignement sur 856
alignement sur le clip suivant 856
alignement sur les points de départ des 

clips 852
attribution automatique des noms 276
automation 529
capture 599
collage 539
conformation au tempo 803
conformé avec Beat Detective 682
consolidation 621
copie 538
coupe 538
création 599
créé automatiquement 525
de fichier entier 525
décalage 865
défini par l'utilisateur 275, 277, 525
déformé (Elastic Audio) 525, 925
déplacement de clips avec fondus 639
déplacement en mode Grid 860
déplacement en mode shuffle 854, 855
déplacement en mode Slip 857
déplacement par incrément 607
déplacement par incrément de clips avec 

fondus 639
déplacement sur une piste multicanal 610
déverrouillage 866
duplication 871
effacement 539
exclusion de données par trimming 604
exportation en tant que fichier audio 345
extension de sélections pour inclure 582
fondu enchaîné 635
gain 611
gestion 275
glissement 853
glisser-déposer depuis la liste des clips 849
hors ligne 525
marquage temporel 1215
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marqueur temporel d'origine 858
marqueur temporel utilisateur 858
masquage des clips créés automatiquement 277
MIDI 489
mise en boucle 873
modification du nom dans la liste des clips 276
modification du nom sur une piste 533
multicanal 525
mute 867
nom par défaut 445
placement 1214
placement automatique 1214
placement en mode Spot 857
placement sur le point d'insertion d'édition 851
placement sur une piste 849
point de synchro 1216
point de synchronisation 863
quantification 609, 951
recherche 270
remplacement 861
répétition 872
Select, options 273
sélection 564, 578
sélection de tout le contenu d'une piste 578
séparation 600
séparation avec Beat Detective 680
séparation avec l'outil de séparation 602
suppression d'une séparation 604
suppression de la déformation 

(Elastic Audio) 926
suppression de propriétés en temps réel 731
suppression des clips inutilisés 277
suppression du pitch shifting 

(Elastic Audio) 934
suppression du silence 867, 868
transfert à l'arrière-plan 603
transfert au premier plan 603
tri 269
trimming des points de début/fin 558
trimming jusqu'au point d'insertion 

d'édition 604
trimming selon la valeur d'incrément 606, 705
verrouillage 866
verrouillage pour l'édition 866
verrouillage temporel 867
vidéo 1262

Clip Auto Fade In/Out Length, préférence 637
clip avec déformation (Elastic Audio) 525

clip créé automatiquement 525
masquage 277

clip de fichier entier 525
clip défini par l'utilisateur 275, 277, 525
Clip Gain Info, vue 611
Clip Groups, dossier 158
Clip Hold, options 122, 212
Clip Info, boîte de dialogue 1304
Clip List Selection Follows Edit Selection, 

option 113, 268, 578
clip MIDI 529

créé sur les barres de mesure 489
directives pour l'édition 530
et enregistrement en punch-in 492
et événements de contrôleur 531
et liste des clips 267

clip mis en boucle 873
copie et collage d'automation 877
édition 875
sélection 875
trimming avec l'outil de trim de boucle 563

clip multicanal 525
Clip Name

option d'affichage 533
Clip Time, options d'affichage 533
clip vidéo 1262
Clip, menu 197

Bring to Front, commande 603
Capture, commande 599
Identify Sync Point, commande 1216
Lock, commande 866
Mute/Unmute, commande 867
Quantize to Grid, commande 609
Remove Sync Point, commande 864
Send to Back, commande 603
Ungroup All Clips, commande 879
Ungroup Clips, commande 879
Unlock, commande 866
Unloop Clips, commande 875

clips
insertion de silence 870

clips créé automatiquement
modification du nom 275

clips mis en boucle
annulation 875
création 874

clips mutés et traitement AudioSuite 896
Clips, vue 224, 225, 529
Clock Reference, paramètre 1299
Clock Source 1194
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Close Session, commande 170
Coalesce Clip Gain to Volume Automation, 

commande 619
Coalesce Trim Automation, commande 233
Coalesce Trim Automation, options 118
Coalesce VCA Master Automation, commande 233
Coalesce Volume to Clip Gain, commande 619
Coalesce when Removing Slaves from VCA Group, 

option 117
codage couleur

application aux tranches 252
options 248

collage
automation 1102
avec la commande Repeat to Fill Selection 540
paramètres de plug-in 1050
sélections et clips 539
sur plusieurs pistes 541
types de données multiples 541

Collection, mode (Beat Detective) 687
codage couleur

options 106
Color, paramètre (fenêtre d'incrustation) 135
Command|8 49, 1030
commande de piste

fenêtre Edit 205, 206, 207
piste audio 205
piste d'entrée auxiliaire 205
piste d'instrument 207
piste Master Fader 205
piste Master VCA 206
piste MIDI 206
piste vidéo 207

commandes d'édition 537, 538, 539
commandes de liaison 1306

accès aux boutons de liaison depuis une 
surface de contrôle 1307

affichage 1306
bouton de liaison 1306
liaison de systèmes à une surface de 

contrôle 1307
Satellite Link, boutons 1306

commandes de piste
Elastic Audio 912

commandes, focus clavier 26
Comments, vue 220, 994
Compact Selected, commande 278
Compact, commande 621
compactage de fichiers audio 621
Compare, bouton de plug-in 1043

compatibilité 3, 1301
compensation

décalages du satellite vidéo 1293
délai de moniteur 1293
délai du moniteur 1305

compensation de piste, indicateur (cmp) 1024
compensation du délai 1021

activation 1021
affichage 217, 995
application aux pistes bypassées 

automatiquement 501, 1025
bypass 1024
champ de décalage utilisateur (+/-) 1023
délais des inserts matériels 75, 1028
indicateur du délai (dly) 1023
insert matériel 75
MIDI Beat Clock 128
MIDI Timecode 128
mode 1022
modification du délai des pistes 1023
supérieur à la limite de compensation 1024

compensation du délai d'un insert matériel 1028
compensation du délai, option d'affichage 1023
compensation du retard

Time Mode, option 113
compensation du délai d'insert matériel 75
Compensation for Input Delays After Record Pass, 

option 77
Compensation for Output Delays After Record 

Pass, option 77
compositing 648
compression/expansion temporelle, outil de 

trim 559
trimming MIDI 710

compteur secondaire, sélecteur 793
compteurs principaux 792
configuration

décalage de l'heure de début du satellite 1293
MMC 1208, 1209
SMPTE 1199

Configuration audio et MIDI (Mac) 143
configuration de fenêtres 189
configuration matérielle

taille de la mémoire tampon 456
configurations de fenêtres

importation 360
Conform to Tempo, commande 803
connexion

périphériques audio externes 1062
connexion d'entrée 12, 434
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Consolidate, commande
audio 621
notes MIDI 706

consolidation de médias 321
consolidation de médias audio source 367
consolidation des médias source 383
Constant, commande (Tempo Operations) 812
continu, zoom 548
Continuous Scroll with Playhead, option 422
Continuous Scrolling During Playback, 

option 421, 422
contrôle (panoramique surround) 1181
contrôle local 483
contrôle séparé des signaux 1162
contrôleur MIDI 481

contrôle local 483
Controller Meter Path, sélecteur 77
Controllers, dossier (personnalités de 

contrôleur) 1031
conversion de la fréquence d'échantillonnage 

audio 369
conversion de la fréquence d'échantillonnage, 

options 357, 369, 381
conversion de sessions 163
conversion forcée de médias audio au format de la 

session cible 367
Conversion Quality, option 1262, 1140
Convert Clip Gain to Volume Automation, 

commande 619
Convert Imported WAV files to 

AES31/BroadcastWave, option 124, 342, 396
Convert Volume to Clip Gain, commande 619
copie

de l'automation de piste sur les départs 1082
de notes MIDI avec la commande Split 960
des paramètres des commandes de piste sur 

les départs 1006
paramètres de plug-in 1050
sélections et clips 538

copie à partir de médias source (vidéo) 367
copie de médias audio source 366
copie des médias source 382
Copy Clip Gain, commande 618
Copy from Source Media (vidéo) 356
Copy Settings, commande 1048
Copy Special, commandes 1102
Copy To Send, commande 1082
Copy, commande 538
Core Audio 6
correspondance 659

correspondance automatique des facteurs de pull 
up/down 1203

correspondances (prises alternatives) 474, 659
coupe

automation 1099
coupe

de notes MIDI avec la commande Split 960
sélections et clips 538

courbe de gain du clip 612
Crayon 547, 572, 696

dessin d'automation 1093
édition de points d'automation 1095
édition du gain du clip 615
édition du tempo 805
formes 696, 1093
Free Hand 697
insertion de notes MIDI 698
ligne 805
Line 697
Random 698
réparation d'une forme d'onde 572
résolution des événements de contrôleur 

insérés 713
sélection d'une forme 696
Square 697
Triangle 697
utilisation en mode Gomme 710

Create Click Track, commande 437
Create Fades, commande 635, 636
création

clip 599
fondu enchaîné 635
fondus d'entrée/sortie 633
groupe de clips 878
marqueurs et emplacements mémoire 837
session 154
sessions compatibles Mac et PC 399
sous-dossier de paramètres 1049

création automatique de copies de sauvegarde des 
sessions 109, 158

création de pistes composites 648
Crossfade Preference for Pre/Post-Roll, 

option 114, 632
Current Feet+Frames, commande 1200
Current Timecode Position, commande 1201
curseur d'édition 416

déplacement sur les limites d'un clip 585
et scrubbing 568
positionnement avec le Sélecteur 564
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curseur de lecture 416
curseur de panoramique 209
Custom FF/REW Speed, préférence 108
Custom Shuttle Lock Speed, préférence 108, 571
Cut Clip Gain, commande 617
Cut Special, commandes 1101

All Automation 1101
Pan Automation 1101
Plug-In Automation 1101

Cut Time, commande 823, 827
Cut, commande 538

D
D-Command 49, 1030
D-Control 49, 1030
décalage

configuration pour l'heure de début du satellite 
vidéo 1293

décalage de synchro 1198
décalage des pistes, options 357, 368
décalage global de vélocités de note 708
décalage utilisateur, champ (+/-) 1023
déclencheur 1047
déclencheur externe 1042
déclencheur, sélecteur 893
décompte 438
décompte, bouton 183
Default Automatic Naming to English, option 106
Default Clip Color Coding, options 107
Default Dynamics, préférence 116, 1040
Default EQ, préférence 116, 1040
Default Handle Length, options 124
Default Input Gain, préférence 126
Default Monitor Format, sélecteur 80
Default Note Duration 693
Default Note On Velocity, paramètre 694
Default Plug-In, préférence 126
Default Thru Instrument, préférence 127
défilement

de l'affichage des notes MIDI 532
de la vue Notes vers le haut ou le bas 557
des fenêtres Mix et Edit jusqu'à des pistes 591
jusqu'à une piste 222
sur la règle 590
vertical ou horizontal d'une fenêtre 

ProTools 591
définition

de points de punch/boucle 463
définition de clip 347
déformation audio (Elastic Audio) 922

déformation des images 1297
Degree of Thinning, préférence 117
délai

décalage de pistes MIDI 723
délai d'insert matériel 75
délai, indicateur (dly) 1023
Delay After Play Command, préférence 130
Delay Before Locking to LTC, option 129
Delay Before Locking to Timecode, option 129
Delay Compensation Time Mode, option 113, 1022
Delay Compensation, vue 217, 995, 1023
Delay for External Devices, options 128
Delay, paramètre (propriétés en temps réel) 729
Delay, plug-ins 1033
Delete Active Groups (liste des groupes), 

commande 256, 261
Delete Current Settings File, commande 1048
Delete Fades, commande 635
Delete Track, commande 222, 233
Delete, commande de groupe 256, 261
demi-page 422
densité d'édition du tempo, menu déroulant 806
départ 998

affichage des commandes 1004
ajout 999
Assignments, vue 1002
automation 1081
copie de l'automation de piste 1082
et mixage multicanal 1165
modification de la configuration par défau 1000
mono ou stéréo 1002
multicanal 1165
niveau par défaut 999
options d'affichage 1002
pour les bus de mixage 1002
suppression 1000
vers une E/S matérielle 1002

départ vers une E/S matérielle 1002
départ, mute 998
départ, niveau 998
départ, panoramique 998
départs

désignation 1061
déplacement

Bar|Beat, marqueur 819
changement de programme 719
de clips avec fondus 639
événement Sysex 720
fondu 639
inserts 1041
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marqueur 844
notes MIDI 703

déplacement par incrément 606
clips multiples 608
de clips avec fondus 639
de la valeur de déplacement par incrément 

suivante 608
définition de la valeur d'incrément 607
du contenu d'un clip 609
fondu 639
plage de la sélection 581
points de début/fin de sélection 582
sélections et clips 607

derniers paramètres utilisés 102
désactivation

assignations des pistes 238
chemins 93
chemins, globalement 94
départ 1005
entrées 238
insert 1037
Master Faders et assignations 985
piste 248
sorties 238

désactivé(e) 17
Destination Audio Sample Rate 382
DestructivePunch 511

fondus enchaînés 503
préparation 512
Prepare DPE Tracks, commande 513

DestructivePunch File Length, préférence 112, 512
détermination manuelle du tempo 441
diagramme d'accord 835
Digital Cut, outil (MediaComposer) 1310
DigiTest 52
Disable “Input” When Disarming Track (In “Stop”), 

option 111
Display (liste des groupes), commande 256
Display Events as Modified by Real-Time 

Properties, option 127, 731
disque dur

allocation Round Robin 451
enregistrement sur le volume système 452
et compactage audio 621

dissociation de commandes de plug-in 1166, 1060
dithering

et bounce sur disque 1130
résolution et bounce sur disque 1139
sur les Master Faders 1130

divergence
ajustement graphique 1185
utilisation 1184

divergence arrière 1184
divergence avant 1184
divergence avant/arrière 1184
division (MIDI) 960
division de notes, action 961
division de pistes stéréo et multicanal 610
données de piste 524
données de session

importation 352
données média 19
données System Exclusive 720

déplacement 720
enregistrement 496
suppression 721

dossier de destination des paramètres de 
plug-in 1049

Double-Clicking a MIDI Clip Opens, option 127
Drag and Drop From Desktop Conforms to Session 

Tempo, options 125, 343
drapeaux de pré/post-roll 576
Draw Grids in Edit Window, option 545
DSP

éléments activés et désactivés 17
et départs désactivés 1005
et entrées et sorties désactivées 238
et indicateurs de niveau des départs 1004
et pistes sans sortie assignée 998
et ressources globales 16
et sorties désactivées 998

DSP, jauges d'utilisation 67
Duplicate Track, commande 222, 233, 1067
Duplicate, commande 871
Duplicate, commande de groupe 256
duplication

départ 1006
inserts 1041
playlist 646
sélections de notes MIDI 872
sélections et clips 871

Duration
propriétés en temps réel 728

durée de note personnalisée
Follow Grid 694

durée des poignées de consolidation 383
durée des poignées lors d'une consolidation 367
durée, d'une note MIDI
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édition avec la commande Change 
Duration 957

modification pour un jeu plus legato 958
modification pour un jeu plus staccato 958
randomisation 958

Dynamic Plug-In Processing, option 56
Dynamics, plug-ins 1033

E
E/S non disponible 104
échelle temporelle 792

Bars|Beats 789
Feet+Frames 790
Minutes:Seconds 790
principale 792, 1201
Samples 790
secondaire 793, 1201
Timecode 790

échelle temporelle principale 792
écoute

dans les navigateurs 306
de clips dans la liste des clips 78, 274
fondus 627
notes MIDI 701
points de début et de fin d'une sélection 423
pré/post-roll 423
prises 474
programmes 719

écoute en contexte 274
écrêtage 434
écriture

automation 1079
automation par snapshot 1116
d'automation à l'arrêt 1108
d'automation jusqu'au point d'automation 

suivant 1109
d'automation sur une sélection, au début 

ou à la fin d'une sélection 1106
Edit Insertion Follows Scrub/Shuttle, 

option 108, 568
Edit Play Rate, paramètre 1299, 1300
Edit Selection Follows Clip List Selection, 

option 113, 578
Edit Window Default Length, préférence 105, 179
Edit Window Follows Bank Selection, option 116

Edit, fenêtre
défilement à partir de la règle 591
vue Universe 593

Edit, menu 197
Change Edit to Match Timeline, 

commande 590
Change Timeline to Match Edit, 

commande 589
Clear Special, commandes 1102
Clear, commande 539
Consolidate, commande 621
Copy Special, commandes (automation) 1102
Copy to Send, commande 1082
Copy, commande 538
Create Fades, commande 635, 636
Cut Special, commandes 1101
Cut, commande 538
Delete Fades, commande 635
Duplicate, commande 871
Fade To End, commande 634
Fade to Start, commande 634
Fades, commande 627
Heal Separation, commande 604
Identify Sync Point, commande 863
Insert Silence, commande 870
Paste, commande 539
Play Edit Selection, commande 425
Play Timeline Selection, commande 425
Redo, commande 535
Repeat to Fill Selection, commande 540
Repeat, commande 872
Select All, commande 578
Separate Clip, commandes 600
Shift, commande 865
Strip Silence, commande 867, 868
TCE Edit to Timeline Selection, 

commande 622
Thin All Automation, commande 1093
Thin Automation, commande 1093
Trim Automation to All Enabled, commande 1119
Trim Automation to Current, commande 1119
Trim Clip End to Fill Selection, commande 605
Trim Clip End to Insertion, commande 605
Trim Clip Start to Fill Selection, commande 605
Trim Clip Start to Insertion, commande 604
Trim Clip to Fill Selection, commande 606
Trim Clip To Selection, commande 604
Undo, commande 535
Write Automation, commandes 1116, 1118
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Edit/Tool Mode Keyboard Lock 573
éditeur de partition

commandes de page 762
commandes de zoom 763
édition de données 767
exportation d'une partition 774
impression 775
ouverture 754
silences 770
symboles et diagrammes d'accord 773

éditeur de tempo 804
éditeur MIDI

édition des notes MIDI 746
ligne de vélocité 751
lignes d'automation 751
lignes de contrôleur 751
Notation, vue 749
vue superposée des notes 744

édition
attributs de note 709
automation 1095
Bar|Beat, marqueur 820
changement de programme 719
clip MIDI 530
durée de note 957
emplacement mémoire 843
en cours de lecture 524
et modes d'édition 543
événement de contrôleur 713
événement de métrique 822
événements de tempo 799
forme d'onde 528
liste des événements MIDI 783
marqueur 843
mode Grid 545, 546, 547
mode Shuffle 543
mode Slip 544
mode Spot 544
modes d'édition 543
modes Grid 860
non destructive 523
non destructive (audio) 529
non destructive (MIDI) 532
notes MIDI 700
pistes masquées 232
points d'automation 1097
simultanée de plusieurs pistes 541
vélocité de note 707, 954
verrouillage du mode Shuffle 544
vue de piste 537

édition destructive 621
édition MIDI en miroir 695
édition non destructive (audio) 529
édition non destructive (MIDI) 532
édition, modes 543
édition, playlist 645
Elastic Audio

activation sur les pistes 910
ajout de marqueurs d'événements 927
algorithmes TCE 916
analyse 913
analyse dans l'espace de travail 304, 305
analyse par lot 304
Analysis, vue 912, 927
aperçu au tempo de la session 310
clips déformés 925
commandes de piste 912
Conform to Tempo 803
création de pistes 911
déformation basée sur le tempo 802
déformation de plage 924
déformation de plage individuelle 925
déformation en accordéon 923
déformation télescopique 922
déplacement de clips entre des pistes 935
déplacement de marqueurs d'événements 928
désactivation 911
détection du tempo 913
fichiers rendus 915

régénération 315, 395
groupes d'édition 927
indicateur d'écrêtage 915
indicateur de déformation 925
indice de confiance des événements 913
marqueur de déformation généré par un 

événement de tempo 922
marqueurs d'événements 920
marqueurs de déformation 920
mise à plat du traitement 911
Monophonic, plug-in 918
pistes 910
pitch shifting 933
plug-ins 916
Polyphonic, plug-in 917
promotion de marqueurs d'événements 928
propriétés 929
quantification 950
Rhythmic, plug-in 918
sélecteur de plug-in des navigateurs 309
suppression de la déformation 926
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suppression de marqueurs d'événements 929
suppression du pitch shifting 934
traitement AudioSuite 934
traitement hors plage 926
transposition 933
types de traitement 914
Varispeed, plug-in 919
vues de piste 912
Warp, vue 912, 920
workflows 903, 904
X-Form, plug-in 919

Elastic Audio, préférences 126
Elastic Properties, fenêtre 929
Eleven Rack 40
Embed Eleven Settings From, sélecteur 80
emplacement

déplacement de notes MIDI par 
glisser-déposer 703

emplacement mémoire 837, 841
création 837, 839
édition 843
emplacement mémoire de sélection 841
extension de sélections 582
importation 360
marqueur 841
mémorisation de sélections d'édition 465
modification du nom 843
rappel 843
rappel de sélections d'édition 466
suppression 845

emplacement mémoire de sélection 841
déplacement de la sélection mémorisée 844

emplacements
quantification des notes MIDI 942
randomisation des notes MIDI 941, 944

émulation d'enregistreur multipiste 111, 503
en boucle

lecture 426
sélection 426

Enable Dub Window, option 135
Enable Elastic Audio on New Tracks, 

préférence 126
Enable GPU, option 110
Enable Hardware During Scrub, option 110
Enable Session File Auto Backup, option 109
Enable SYNC Peripheral, option 134
End To Insertion, commande 605
Enforce Avid Compatibility, option 379
Enforce Mac/PC Compatibility, option 166, 399

enregistrement 459
à mi-vitesse 480
activation de pistes pour l'enregistrement 447
allocation Round Robin 451
annulation d'une prise 461
avec un clic 436
avec un décompte 438
bounce sur disque 1133
clip MIDI 489
d'un sous-groupe de mixage sur disque 1131
d'une piste audio mono 459
d'une piste audio stéréo 459
d'une piste multicanal 459
de plusieurs pistes audio 461
de prises supplémentaires 470
depuis une source numérique 478
destructif 470
données System Exclusive 496
en boucle 472
en mode Record Pause 462
LED d'état 507
non destructif 470
online 1205
piste d'instrument 486
piste MIDI 486
QuickPunch, mode 505
raccourcis clavier 462
sur le volume système 452
sur une nouvelle playlist 471

enregistrement à la volée en punch-in
QuickPunch 443, 505

enregistrement à mi-vitesse 480
enregistrement d'une copie d'une session 163
enregistrement d'une session 162
enregistrement d'une session sous un nouveau 

nom 162
enregistrement de paramètres de plug-in 1050

Save Plug-In Settings To, commande 1049
enregistrement des paramètres de plug-in

Save Settings As, commande 1048
Save Settings, commande 1048

enregistrement destructif 470
enregistrement en boucle

audio 472
et pré/post-roll 472
MIDI 493
prises multiples (MIDI) 494

enregistrement en punch-in
MIDI 490
piste MIDI 491
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enregistrement en punch-in/out
audio 468
et monitoring 469
et pré/post-roll 468

enregistrement MIDI 481
activation de périphériques d'entrée 482
annulation d'une prise 490
données System Exclusive 496
filtre d'entrée 484
mode fusion/remplacement 485
monitoring avec MIDI Thru 483
quantification en entrée 484, 963
Wait for Note 484

enregistrement non destructif 470
en mode QuickPunch 502
enregistrement sur une nouvelle playlist 471

enregistrement, bouton (fenêtre de transport) 181
enregistreur DAT, enregistrement à partir de 479
enregistreur portable

développement des canaux alternatifs sur de 
nouvelles playlists ou pistes 662

importation de fichiers audio monophoniques 341
importation de fichiers audio polyphoniques 341

entrée auxiliaire 14, 199
commandes de piste 205
flux du signal 983
monitoring et mixage 1014
tranches 202

entrée MIDI, sélecteur 242
entrelacé, fichier audio 157
EQ, plug-ins 1033
espace de travail 279

affichage des formes d'onde 303
analyse Elastic Audio 304
aperçu audio 306, 307, 310
Automatically Find and Relink 314
base de données 281
calcul des formes d'onde 303
catalogues 280, 320, 321
commandes 292
commentaires 296
copie d'éléments de la base de données 297
Copy and Relink 313
déplacement d'éléments de la base de 

données 297
écoute 306
éléments de base de données 293, 294, 295
enregistrement d'une recherche dans un 

catalogue 303
fenêtre Relink 316

fichiers de transfert 312, 313
fichiers manquants 312, 314
fichiers candidats pour le rétablissement des 

liens 316
indexation 288
liens 312
Manually Find and Relink 314
menu des navigateurs 289
mode d'aperçu automatique 310
mode d'écoute en boucle 309
navigation 284
options d'affichage des navigateurs 292
options de liaison 318
permissions des volumes 286
préférences 327
recherche 298
recherche de liens 318
recherche rapide 298
Regenerate Missing Rendered Files 315
Relink, fenêtre 281
rétablissement des liens 312
sélecteur de plug-in Elastic Audio 309
session 280
Skip All 314
suppression d'éléments de la base de 

données 297
tâche échouée 326
tâches 325
tâches suspendues 325
Task Manager, fenêtre 280
tri des colonnes 293
volume de transfert 281
volumes 280
volumes adaptés (voir fichier de transfert) 313
WaveCache 282, 304

Ethernet Controllers 138
EUCON 139, 1030, 1065
événement de contrôleur 712

édition 713
édition avec l'outil Smart 568
et clip MIDI 531
insertion 713

événement de contrôleur MIDI
poursuite 721

événement de métrique 821
édition 822
insertion 821
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événement de tempo 798
édition 799
et marqueurs Bar|Beat 819
extension d'une sélection à 808
insertion 798

Event Operations, commandes 937
Change Duration, commande 957
Change Velocity, commande 954
Flatten Performance, commande 954
Input Quantize, commande 963
Quantize, commande 938
Restore Performance, commande 952
Select/Split Notes, commande 962
Step Input, commande 964
Transpose, commande 958

Event Operations, fenêtre 937, 938
Event, menu 197

All MIDI Notes Off, commande 724
Beat Detective, commande 667
Change Meter, commande 821
Event, commandes 937
Identify Beat, commande 817
MIDI Track Offsets, commande 723
MIDI Event List 777
MIDI, commandes 937
Remove Duplicate Notes, commande 724
Renumber Bars, commande 830
Tempo, commandes 811
Time, commandes 823

exemples de chemins LCRS 1156
Exit, commande (Windows) 170
Expand Channels to New Playlists 662
Expand to New Tracks, commande 234
Export Clip Definitions, commande 278, 347
Export Clip Groups, commande 390
Export Clips as Files, commande 278, 345
Export MIDI Settings, boîte de dialogue

Apply Real-Time Properties, option 350
MIDI File Format, menu déroulant 350

Export MIDI, commande 350
Export Selected as Files, commande 379
Export Selected Tracks as OMF/AAF, 

commande 373, 376
Export Session Info as Text, commande 386
Export Settings, bouton (I/OSetup) 102
exportation 330

audio 345
conversion de la fréquence d'échantillonnage, 

options 381
d'une partition vers Sibelius 774

d'une session sous forme de texte 386
définition de clip 347
fichier AAF 373, 382, 383
fichier OMF 382, 383
fichier OMFI 373
fichier stéréo entrelacé 346
fichiers Sibelius (.sib) 774
groupe de clips 390
marqueur 350
médias audio, options 382
OMF/AAF, options 379
piste MIDI 349

Ext. Clock Output 62
extension d'une sélection 582, 808

à l'événement de tempo suivant 808
extension de sélections

à des pistes adjacentes 584, 585
jusqu'à des limites de clip 582
jusqu'à un marqueur ou un emplacement 

mémoire 582
pour inclure des clips adjacents 582

External Timecode Offsets 1197
extrapolation 680

F
Fade Files, dossier 158
Fade To End, commande 634
Fade to Start, commande 634
fader de gain du clip 613
fader de gain du clip, icône 611
fader de volume 209
fader de volume MIDI 210
Fades, boîte de dialogue 627

In Shape 630
Link, option 630
Out Shape 628

Fades, commande 627
famille 003 40
famille Mbox 40
Feet+Frame Rate, paramètre 1195
Feet+Frames

redéfinition de la position 1200
Feet+Frames, échelle temporelle 790
fenêtre

cascade 192
fenêtre d'incrustation

couleur 135
position horizontale 135
position verticale 135
taille 135
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fenêtre de l'éditeur MIDI 733
palette de couleurs, fenêtre 250
fenêtre de sortie, bouton 1177
fenêtre de transport 180

affichage de l'état d'enregistrement 507
champs de début, de fin et de durée 464
champs Start, End et Length 182
commandes de transport 180
commandes MIDI 183
pré/post-roll 182, 466

fenêtre de transport étendue 195, 464
Disk Space, fenêtre 449
fenêtre Edit 173, 174, 175

All View, option 993
demi-page 422
None, option d'affichage des vues 993
options d'affichage 175

fenêtre Edit, options d'affichage 993
Matching Criteria, fenêtre 476, 657
Memory Locations, fenêtre 840
fenêtre Mix 172, 173

All View, option 993
All, option d'affichage 172
commandes de piste 172
largeur des pistes 216
None, option d'affichage des vues 993

fenêtre Mix, options d'affichage 993
Undo History, fenêtre 535
fenêtres

fermeture 193
masquage de toutes les fenêtres flottantes 192
mosaïque 192
mosaïque horizontale 192
mosaïque verticale 192
organisation 192

fermeture des fenêtres de plug-in 1045
fichier audio 10

compactage 621
importation 331
nom par défaut 445
types de fichier mixtes 165

fichier de résolution multicaméra 363
fichier de session 157
fichier de transfert 394
fichier manquant 395

ignorer 314
fichier MIDI (voir fichier MIDI standard)
fichier MIDI standard 347, 348

exportation 349
importation 347

fichier Sibelius (.sib) 774
fichier stéréo entrelacé, exportation 346
File, menu 197

Bounce to Disk, commande 1133
Close Session, commande 170
Exit, commande (Windows) 170
Export MIDI, commande 350
Export Selected Tracks as OMF/AAF, 

commande 373
Export Session Info as Text, commande 386
Import Audio to Track, commande 337
Import Clip Groups, commande 389
Open Session, commande 159
Revert to Saved, commande 162
Save As, commande 162
Save Copy In, commande 163, 400
Save, commande 162
Send To Gobbler, commande 391

filtre d'affichage (fenêtre Memory Locations) 848
filtre d'affichage (liste des événements MIDI) 779
Find All Candidates, commande 317
Find Matching Tracks, option 358
Find, commande de la liste des clips 270
First Selected MIDI Track, option 127
Flatten Performance, commande 937, 954
flux du signal

entrée auxiliaire 983
Master Fader 984
piste audio 983
piste d'instrument 986

focus clavier 25
commandes 26
liste des clips 27, 273
liste des groupes 27

focus sur la barre d'outils 27
fondu 633

création 633
création avec l'outil Smart 566
création par lot 638
déplacement 639
déplacement par incrément 639
fondus automatiques 637

fondu enchaîné
création avec l'outil Smart 566
création par lot 638
DestructivePunch 503
Fades, boîte de dialogue 627
gain constant 630
linéaire 632
Overlapping Waveforms, vue 626
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pré/post 636
puissance constante 630, 632
recouvrement 632
suppression 635
TrackPunch 503
trimming 636

fondu enchaîné centré 625
fondu enchaîné de gain constant 630
fondu enchaîné de puissance constante 630
fondus automatiques 637
format audio 382, 1195
format de fichier (audio)

AIFF 1136
BWF (.WAV) 1136
MP3 1136
MXF 1138
QuickTime 1137

format de fichier AIFF 1136
format de fichier audio 156
format de fichier BWF (.WAV) 1136
format de fichier de groupe de clips (.cgrp) 885
format de fichier de groupe de clips (.rgrp) 388
format de fichier MP3 1136
format de fichier WAV 396, 1136
format de timecode 1299
format MXF 1138
formats de fichier QuickTime 1137
formats surround 5.1 1157
formats surround 7.1 et 7.0 1152
formats surround SDDS 1152
forme d'onde 526

directives pour l'édition 528
et passage par zéro 528
espace de travail 303
éviter les clics et les pops 528
réparation avec le Crayon 572

forme d'onde, options d'affichage 526
contours 527
Peak 526
Power 526
Rectified 527

forme de fondu d'entrée 630
forme de fondu de sortie 628
Forward and Play, commande 418
Forward, commande 418
Frames, vue (piste vidéo) 1249
fréquence d'échantillonnage audio de 

destination 369
fréquence d'échantillonnage audio source 369
fréquence de rafraîchissement 1296

fusion
automation de trim 1105
automation de VCA 1126

fusion MIDI, mode 184, 444, 485

G
gain basé sur les clips 370, 611
gain du clip 611

affichage de la valeur statique de gain 
du clip 611

ajustement avec le fader de gain du clip 613
bypass 619
Clip Gain Info, vue 611
collage 618
conversion de l'automation de volume en gain 

du clip 619
conversion du gain du clip en automation de 

volume 619
copie 618
coupe 617
courbe de gain du clip 612
Default Handle Length, préférences 124
dynamique 611
édition 613
édition avec la Main 614
édition avec le Crayon 615
édition des points d'automation 614
fusion de l'automation de volume sur le gain du 

clip 619
fusion du gain de clip sur l'automation de 

volume 619
groupes de clips 884
réinitialisation 617
rendu 620
statique 611

génération de timecode 1206
gestion des clips 275
gestion des fichiers 393
gestionnaire de tâches 324, 339
Glide Automation, commandes 1103
glissement de clips 853
glisser-déposer

depuis la liste des clips sur des pistes 850, 851
importation de fichiers audio 333
importation de fichiers MIDI 349
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Global MIDI Playback Offset, préférence 127, 722
Gobbler 391, 1143
grand compteur, fenêtre 415
Grid absolu, mode 545
Grid relatif, mode 545
Grid, mode 545, 860

absolu 545
Clips/Markers, option 547
configuration 546
Draw Grids in Edit Window, option 545
en mode Slip, Shuffle ou Spot 546
relatif 545

Group, commande 258, 259
groupe

activation 264
attributs 262
création 258
décalage des commandes 266
désactivation de la liaison des groupes de 

mixage et d'édition 254
duplication 261
édition de l'automation 1099
groupe d'édition 258
groupe de mixage 258
liaison des groupes de mixage et d'édition 254
modification 259
modification du nom 260
pistes masquées 232
sélection au clavier 265
suppression 261

groupe d'édition 258
et sélections 577

groupe de clips 525, 877
basé sur des références de tempo 881
création 878
dégroupement 879
divisé 881
édition 882
exportation vers d'autres disques durs 390
fondus et fondus enchaînés 884
format de base de temps 878
importation 389
importation et exportation 388
mixte 880
modification du format de la base 

de temps 882
multipiste 880
regroupement 879
trimming 883
vidéo 1266

groupe de mixage 258
groupes de clips vidéo 1266
Groups, boîte de dialogue 257

H
Hardware Setup

Ext. Clock Output 62
Launch Setup App 59

hauteur (notes MIDI)
transposition 703

hauteur de piste 228
redimensionnement 229

hauteur, d'une note MIDI
transposition avec la commande 

Transpose 958
HDI/O 47
HDMADI 48
HDOMNI 46, 63
Heal Separation, commande 604
HEAT 49, 969

importation des paramètres principaux 360
Help, menu 25, 197
heure de début pour les séquences 

MediaComposer 1304
HFS+, disques

et systèmes Windows 397
Hide All Floating Windows, commande 192
Hide and Make Inactive, commande 233
Hide/Show, commande 233
historique d'annulation 536
historique de recherche 271
Horizontal Position, paramètre 135
hors ligne

clip 525
fichiers, sélection dans l'espace de travail 290

Host Engine 55

I
I/O Setup 69

boîte de dialogue 70
chemins 87
commandes 75
derniers paramètres utilisés 102
E/S non disponible 104
fichier de paramètres Surround Mix 101
fichiers de paramètres 100
fichiers de paramètres d'usine 100
formats surround 1153
importation pour le surround 1155
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Low Latency Monitoring 79
options 77
page Bus 73
page H/W Insert Delay 75
page Input 72
page Insert 74
page Output 73
personnalisation 82
préampli micro 74
routing des E/S 83
sous-chemin 90
surround 1170

I/O, vue 208, 995
ID de groupe, indicateur 256
Identify Beat, commande 817, 818
Identify Sync Point, commande 863, 1216
Idle MTC Enabled, option 134
Ignore Errors During Playback/Record, option 55
Ignore Track Arming, option 130
image de début (session) 1195
Import as Offline Satellite Media 356
Import Audio to Track, commande 337
Import Audio, boîte de dialogue 337
Import Clip Groups, commande 389
Import Key Signature Map, option 360
Import Markers 360
Import Memory Locations 360
Import Rendered Audio Effects 370
Import REX Files as Clip Groups, option 125, 342
Import Session Data, commande 352
Import Settings, bouton (I/OSetup) 102
Import Settings, commande 1048
Import Video, commande 1258
Import Volume Automation 370
Import Window Configurations 360
importation 329

audio 331
configurations de fenêtres 360
conversion de la fréquence d'échantillonnage, 

options 369
copie des fichiers importés 354
copie durant 354
d'éléments hors ligne depuis des 

catalogues 322
de données de session 354
emplacement mémoire 360
fichiers audio multicanal d'enregistreur 

portable 341
groupe de clips 389
mappage du timecode, options 368

marqueur 349, 360
médias audio, options 366
par glisser-déposer 333
paramètres d'E/S multicanal 1155
paramètres de plug-in 1050
paramètres HEAT principaux 360
piste d'une autre session 352
piste MIDI 347
PRE, paramètres 360
référence aux fichiers importés 354
table d'armures 360
table des tempos et métriques 360

importation de l'audio de séquences 
QuickTime 1261

importation des paramètres HEAT principaux 360
importation en tant que médias satellites 

hors ligne 367
importation MIDI 348
importation vidéo 1258
impression d'une partition 775
impulsions par image

Bi-phase/Tach 135
Include Control Changes in Undo Queue, 

option 118
Include Sends in Trim Mode, option 118
incrément, valeur

trimming de notes MIDI 705
indicateur

pour les pistes MIDI 210
indicateur d'activation pour l'enregistrement 182
indicateur d'emplacement 590
indicateur d'état de la compensation du délai 176
indicateur d'état en ligne des données de la 

session 176
indicateur d'état en ligne des données de la 

timeline 176
indicateur de cadence du moteur vidéo 1257
indicateur de crête 209
indicateur de déformation 925
indicateur de la métrique actuelle 184, 821
indicateur de monitoring TrackInput 182
indicateur de niveau

et surface de contrôle 77
niveaux pré/post-fader 211
pour les pistes audio 210
pour les pistes d'entrée auxiliaire, Master 

Fader et d'instrument 210
Sends, vue 1004

indicateur de niveau de piste 210
indicateur de panoramique 209
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indicateur de volume 209
indicateur MIDI 210
indicateurs de début, fin et durée 464
indicateurs de sélection d'édition 583
inertie de timecode 1198
info-bulles 105, 198
Input Devices, commande 482
Input Filter, commande 484

MIDI Event List View Filter, boîte de 
dialogue 779

MIDI Input Filter, boîte de dialogue 484
Input Only Monitoring, mode 453
Input Quantize, commande 937, 963
insert 990, 1033

d'E/S matériel 1034
délais des inserts matériels 75
déplacement 1041
désactivation (et activation) 1037
désignation 1061
duplication 1041
mono 1034
mono vers stéréo 1034
partagé pour un sous-groupe de mixage 1017
plug-in 1033
post-fader sur les Master Faders 984, 1033
stéréo 1034
traitement d'une seule piste 1034
traitement par boucle d'effet 1034

insert d'E/S matériel 1034
délai 75

insert de plug-in 1033
insert pré/post-fader 1033
Insert Silence, commande 870
Insert Time, commande 823, 826
insertion

changement de programme 718
de plug-ins sur les pistes 1038
événement de contrôleur 713
événement de métrique 821
événements dans la liste des événements 

MIDI 781
événements de tempo 798
notes MIDI 698

Insertion Follows Playback, option 108, 428
Inserts, options des vues 991
Inserts, vue 994
instabilité vidéo 1297

instrument MIDI externe 498
instrument Thru par défaut 483
instrument, plug-in 497
Instruments, vue 994
interfaces audio HD 43
Internal, mode (option de source d'horloge) 1194
interrogation de bus 1007
Items to Copy 166

Preserve Folder Hierarchy, commande 167

J
Jam Sync 1198
Join, commande 1069

L
Language, options 106
largeur de piste 216
Latch Record Enable Buttons, option 110
Latch Trim, mode d'automation 1072
Latch, mode d'automation 1069

AutoJoin 1069
Join 1069

Latch, option 247
Latching Behavior for Switch Controls in “Touch”, 

option 117
latence 54
Launch Setup App, bouton 59
lecture

à mi-vitesse 425
arrêt 413
audio 413
d'une sélection d'édition avec la tête de lecture 

activée 424
d'une sélection de timeline avec la tête de 

lecture activée 425
depuis un point spécifique d'une piste 417
des pistes 460
et création de sélections 579
lancement 413
MIDI 414
pistes 413
sans défilement de la fenêtre 420
sélection 423

lecture, bouton 181
Levels of Undo, préférence 115
LFE

activation dans les plug-ins 1187
exemples de routing 1173
faders 1187
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liaison
commandes de plug-in 1060
panners stéréo 1180
panoramique inversé 1011
panoramique stéréo 1010
plug-in multi-mono 1166

liaison aux médias source (vidéo) 367
liaison des canaux, bouton 1044

pour des plug-ins multi-mono 1167
liaison des sélections, bouton 575, 577
liaison principale, bouton 1044

pour des plug-ins multi-mono 1166
ligne d'automation 1076

dans la fenêtre Edit 1076
dans les fenêtres de l'éditeur MIDI 751

ligne de contrôleur 712, 1076
dans la fenêtre Edit 1076
dans les fenêtres de l'éditeur MIDI 751

ligne de playlist 651
Limit Character Set, option 166
limite de clip

déplacement de la tête de lecture vers 425
déplacement du curseur d'édition 585
extension de sélections 582

linéaire, fondu enchaîné 632
Linear Sample Display 810
Linear Tick Display 810
Linear, commande (Tempo Operations) 812
Linearity Display, mode 810
Link Mix and Edit Group Enables, option 115
Link Record and Play Faders, option 110, 455
Link Timeline and Edit Selection, option 575
Link to Source Media (vidéo) 356
Link Track and Edit Selection, option 221, 576
lissage de l'automation 1073
lissage des points d'édition (Beat Detective) 685
liste des clips 267

affichage d'informations sur les fichiers de 
clips audio 268

aperçu de clips 274
écoute de clips 274
et clips MIDI 267
Export Clips as Files, commande 345
focus clavier 27
glisser-déposer depuis 849
historique de recherche 271
menu déroulant 267
recherche de clips 270
relancer une recherche 271

sélection de clips 272
tri 269

liste des clips, menu 1215
Auto Rename, commande 276
Clear, commande 277
Compact, commande 621
Export Clip Definitions, commande 347
Export Selected as Files, commande 379
Find, commande 270
Rename, commande 276
Select, options 273
Select Unused, commande 277
Show Auto-Created, option 277
Sort By, options 269
Time Stamp Selected, commande 858
Timeline Drop Order, option 850

liste des configurations de fenêtres 193
liste des événements MIDI

édition d'événements 783
filtre d'affichage 779
insertion d'événements 781
menu d'options 785
navigation 780
sélection d'événements 784
suppression d'événements 784

liste des groupes 255
focus clavier 27
menu 256

liste des périphériques 61, 62
liste des pistes 230

affichage 230
masquage 230
menu déroulant 230

localisation
avec les boutons d'avance/retour rapide 418
avec les indicateurs d'emplacement 590
du curseur de lecture 416

Lock Clip, commande 866
rendu AudioSuite 896

Lock Settings File, commande 1048
Locked, commande 233
Locked, témoin 1197
Loop Playback, option 426

et mode Touch 1080
Low Latency Monitoring, chemin 79
Low Latency Monitoring, option 456
LTC Output Level, paramètre 134
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M
Machine Chases Memory Location, 

option 128, 1210
Machine Control (boîte de dialogue 

Peripherals) 135
Machine Cues Intelligently, option 129
Machine Follows Edit Insertion/Scrub, 

option 128, 1210
Machine Track Arming, fenêtre 1211
MachineControl, option 49
Make Inactive, commande de piste 233, 248
Manually Find and Relink 395
mappage des canaux

modification 94
re-mappage 95

mappage des chemins dans I/O Setup 94
mappage du timecode, options 356

lors d'une importation 368
Markers, règle 791
Marketplace, menu 187
marqueur 370, 841

affichage des options 846
basé sur des références de tempo ou les 

échantillons 841
création 837, 839
déplacement 844
édition 843
exportation 350
extension de sélections 582
importation 349, 360
suppression 845
tri 847

marqueur Bar|Beat
généré avec Beat Detective 676

marqueur de début de morceau 797
déplacement 797
modification du tempo 797

marqueur de déformation 920
ajout 921
repositionnement (sans appliquer de 

déformation) 921
suppression 921

marqueur de déformation généré par un 
événement de tempo 922

marqueur de sélection de timeline 464
marqueur temporel 383, 1215

bounce sur disque 1133
marqueur temporel d'origine 858, 1215
marqueur temporel utilisateur 858, 1216

marqueurs d'édition 576
et durée de la sélection 581

marqueurs de déformation générés par des 
événements de tempo 803

marqueurs de sélection de timeline 576
durée de la sélection 581
et sélections d'édition 577
sélections de timeline 589

masquage
clips créés automatiquement 277

Master Fader 984
ajustement du niveau d'entrée d'un 

sous-groupe de mixage 986
commandes de piste 205
désactivé 985
en tant que commande master de niveau de 

départ 1020
flux du signal 984
indicateur de niveau pré/post fader 985
inserts 1033
inserts post-fader 984
multicanal 1165
tranches 202
utilisation en tant que commande de volume 

stéréo principale 986
Master VCA

affichage de l'automation 1124
assignation de groupes 990
commandes 988
commandes de piste 206
mixage 987
suppression 1126
tranches 203
transfert de l'automation 1126
type de piste 199, 987

mastering 1148
Media Composer

Project Type, paramètre 1299
média intégré 22
média lié 23
média source 366, 382
Media Composer

activation et désactivation de la liaison 1306
Edit Play Rate 1299
format de timecode 1299
liaison avec ProTools 1305
résolution des problèmes de connexion des 

satellites 1298
Starting TC, paramètre 1299
Video Satellite 140, 1295
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médias audio, options 355
lors d'une exportation 382
lors d'une importation 366

médias vidéo, options 356
Memory Locations, fenêtre 843

affichage des options pour les marqueurs 846
filtre d'affichage 848

menu de bibliothèque 1042
menu des paramètres de plug-in 1042, 1048
menu des prises alternatives 475
Merge, mode (voir fusion MIDI, mode)
mesure des niveaux avancée 214

Advanced Meter Type Settings 121
Digital VU, option 120
échelles du fader et de mesure 214
indicateur de réduction de gain 214
K, options 121
Linear (Extended), option 120
Linear, option 120
Meter Type, paramètre 214
PPM, options 120
ProTools Classic, option 120
RMS, option 120
Sample Peak, option 119
VENUE, options 121
VU, option 120

mesures
renumérotation 830

métadonnées 19, 1221
Meter Type 214
Meters and Faders, vue 995
métrique

actuelle 821
affichage 184
par défaut 439

métronome, bouton 438
Mic Preamps, vue 994
MIDI 7

assignation des canaux 242
configuration 58
configuration (Mac) 143
configuration (Windows) 145
consolidation de notes 706
décalage 722
définition de la valeur de grille pour 

l'édition 695
édition dans une fenêtre de l'éditeur MIDI 746
enregistrement en boucle 493
événements de contrôleur 712
fichier de noms de patch (.midnam) 716

importation 348
importation par glisser-déposer 349
instrument Thru par défaut 483
lecture 414
mute des notes 707
noms de patch 716
sélection et division de notes 960
séparation de notes 705

MIDI Beat Clock 430
décalages 431
transmission 430
transmission via IAC 431

MIDI Controllers 138
MIDI File Format, menu déroulant 350
MIDI Machine Control (MMC) 1207

configuration dans ProTools 1208, 1209
contrôle de périphériques externes 1207
périphérique esclave, paramètres 136
périphérique maître, paramètres 136

MIDI Note Color Shows Velocity, option 107
MIDI Note Display, options 128
MIDI Operations, fenêtre 937
MIDI Setup, commandes

MIDI Beat Clock, commande 430
MIDI Studio Setup (MSS) (Windows) 58, 145, 717
MIDI Thru, commande 483
MIDI Timecode (MTC)

sortie MTC inactive 134
MIDI Track Offsets, commande 723
MIDI, commandes de configuration

Input Devices, commande 482
Input Filter, commande 484

mini-clavier 531, 701
Minimize Additional I/O Latency, option 55
Minimum Sync Delay, option 129, 1211
Minutes:Seconds, échelle temporelle 790
mise à jour logicielle 50
mise à plat du traitement Elastic Audio 911
mise en boucle

clips 873
mise en solo

pistes d'un sous-groupe 1021
mi-vitesse, lecture 425
Mix Window Follows Bank Selection, option 116
mixdown final 1147
mixdown stéréo 1147
MMC (voir MIDI Machine Control)
mode AutoGlide 1183
mode calculatrice (pour la saisie de valeurs) 583
mode d'édition, boutons 175, 543
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mode d'enregistrement destructif 442, 470
mode d'enregistrement en boucle 443, 472
mode d’enregistrement non destructif 442
mode Grid

absolu 860
définition de la valeur de la grille 859
relatif 860
suspension 860

mode Grid absolu 860
mode Grid relatif 860
mode Shuffle

et clips verrouillés 866, 867
et déplacement de clips 854

mode Slip
et déplacement de clips 857

mode Spot
et déplacement de clips 857

modèle
Beat Detective 677
DigiGroove 677
session ProTools 168

modèle de groove 677, 678, 945
application 948
mappage 949

modèle de session personnalisé 168
modèle DigiGroove 677
modes d'édition 543

et placement des clips 849
Grid 545
Grid relatif 545
Shuffle 543
Slip 544
Spot 544, 1212
verrouillage du mode Shuffle 544

modes d'enregistrement
et MIDI 444
mode d’enregistrement destructif 442
mode d’enregistrement en boucle 443
mode d’enregistrement non destructif 442
QuickPunch 443

modes d’enregistrement 441
modes de monitoring 452

Auto Input 452
Input Only 453

modification du nom
clip créé automatiquement 275
d'un clip sur une piste 533
de clips dans la liste des clips 276
emplacement mémoire 843
playlist 647

modification proportionnelle des vélocités 
de note 955

Modify Groups, commande 256
Modify, commande groupe 256
Mojo DX 1245, 1295
molette de défilement

défilement d'une fenêtre ProTools 591
et affichage des notes d'une piste MIDI 532
et pistes MIDI en vue Notes 557
zoom dans la fenêtre Edit 557

Momentary, option de verrouillage solo 247
monitoring

durant un enregistrement en punch-in/out 469
enregistrement MIDI avec MIDI Thru 483

monitoring à faible latence
bounce sur disque 457

mono divisé, fichier audio 157
Move Song Start, commande 823, 829
MP3, format de fichier

importation 331
MTC (MIDI Timecode) 1198
MTC Generator Port, paramètre 133
MTC Reader Port, paramètre 133
multi-mono

plug-in 1166
sélecteur de canal de plug-in 1166

multi-mono, fichier audio 157
mute

de clips 867
départ 1000
notes MIDI 707
piste 247

Mute Audio Inputs in Auto Input, option 518
Mute Record-Armed Tracks While Stopped, 

option 111, 518
Mute, bouton 247
mute, écrasement/extension 1113
Mute/Unmute Clip, commande 867
MXF, format 331

N
Narrow Mix, option d'affichage 216
Native, plug-ins

latence 1035
utilisation des voix 1035

navigateur 283
options d'affichage 292
ouverture 284
tri 293

navigateur de l'espace de travail 185, 451, 452
navigateurs de l'espace de travail 279
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navigation dans l'espace de travail 284
New Group (liste des groupes), commande 256
New Session, commande 102, 154
New Track Default Output, sélecteur 78
New Track, commande 217, 233
New Tracks Default To Tick Timebase, 

option 114, 344
Nitris DX 1245, 1295
niveaux d'annulation 536
niveaux d'entrée 434
No Output, option 998
nom de clip

menu contextuel 198, 278
nom de groupe 256
Non-Linear Transport Error Suppression, 

option 129
Notation Display Track settings 764
Notation, vue 749
note (voir notes MIDI)
note bloquée 724
Note Chasing, option 721
note MIDI

duplication d'une sélection 872
durée en ticks 794

notes MIDI 701
attributs 709
défilement 532
déplacement 703
division 960
édition 700

durée 957
hauteur 703
vélocité 707, 954

insertion 698
mini-clavier 701
poursuite 721
quantification 945
sélection 700
suppression 709
transposition 703, 958
trimming des points de début et fin 704

Notes, vue 224, 225, 531, 532
Number of Voices, paramètre 56

O
Object Select in Edit Window, commande 278
OMF 373

données média 19
exportation 379
importation 361

médias intégrés 22
médias liés 23
métadonnées 19, 1221
options de publication 383
ouverture dans ProTools 362
paramètres de conversion lors d'une 

importation 370
Online, bouton 180
online, enregistrement 1205
Online, options 112
Open Session, commande 159
Open Unresourced DSP Plug-Ins as Native, 

préférence 126
Operation/Destination, menus déroulants 357
Operations, menu

Calibration Mode, commande 436
Link Timeline and Edit Selection, option 575
Link Track and Edit Selection 221, 576
Low Latency Monitoring, option 456

option de format entrelacé (session) 157, 1195
options de défilement 420
options de sélection de la liste des clips 273
Options Default Track Color Coding 107
Options, menu 197

Auto-Spot Clips, commande 1214
Delay Compensation, option 1022
Destructive Record, mode 470
Link Track and Edit Selection, option 221, 576
Loop Playback, option 426
Loop Record, mode 472
MIDI Thru, commande 483
Mirror MIDI Editing, commande 695
Pre/Post Roll, option 467
Pre-Fader Metering, option 211
Scrolling, options 420
Solo Latch, options 246
Transport Online, commande 1205

Organize Plug-In Menus By, option 106, 1039
Other Playlists, menu 646
outil de saisie d'objet 565, 579, 580
outil de saisie du temps 565, 580
outil de scrubbing 547, 568

création d'une sélection 586
en mode Shuttle 570

outil de séparation 565, 602
Outil de trim de boucle 562
outil de trim de vélocité 708
outil de trim par scrubbing 561
outil de trim TCE 125
outil de zoom 547, 548, 551
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outil Smart 566
création de fondus 566
création de fondus enchaînés 566
édition d'événements de contrôleur 568
édition de l'automation 568
pistes Elastic Audio 567
pistes MIDI 567
pistes multicanal 568

outils d'édition 547
Crayon 547, 572
Main 547, 579
outil de scrubbing 547, 568
outil de trim 547
outil Smart 547
Sélecteur 417, 547
trim 558
zoom 547, 548

outils de saisie 547, 565, 579, 703
édition de points d'automation 807, 1095
édition de points d'automation de gain 

du clip 614
outil de saisie d'objet 565, 579
outil de saisie du temps 565
outil de séparation 565, 602
sélection de notes MIDI 700

outils de trim 547, 558
outil de trim de boucle 562
outil de trim par scrubbing 561
outil de trim TCE 125, 559, 710
trimming de l'automation 808, 1096
trimming du gain du clip 616

Output Meter Path, sélecteur 77
Output, fenêtre 997
ouverture de fenêtres de plug-in 1044

P
P (volumes en lecture seule) 286
Page, option de défilement 421, 740, 760
Pan Odd Tracks Left/Even Tracks Right 370
panoramique

3boutons 1182
automation et groupes 1099
contrôle sur la grille 1181
directives 1170, 1172
grilles 1176
mode d'ajustement précis 1181
mode X/Y 1181
playlists d'automation multicanal 1187
stéréo lié 1010, 1180
trajectoire 1183

Use Absolute Pan Linking, option 116
panoramique 3-Boutons 1182
panoramique lié inversé 1011
panoramique sur une trajectoire 1183
par défaut

changement de programme 716
chemin d'écoute 78
chemin de sortie 78
chemin des indicateurs de niveau 77
chemins 91
heure de début pour les séquences 

MediaComposer 1304
métrique 439
tempo 440

par défaut (chemin) 91
Parabolic, commande (Tempo Operations) 813
paramètre précédent, bouton de plug-in 1042
paramètre suivant, bouton de plug-in 1042
paramètres

collage 1050
copie 1050
création 1050
création de sous-dossiers 1049
enregistrement 1050
sélection d'une destination 1049
Settings Preferences, commande 1049

paramètres d’E/S 100
paramètres d’E/S d’usine 100
paramètres de fondu par défaut 114
paramètres de plug-in 1049
paramètres de session 165
paramètres par défaut, pour plug-in TC/E 126
paramètres système

fréquence d'échantillonnage 57
Hardware Setup 60
Host Engine 55
nombre de voix 56
Playback Engine 53
source d'horloge 60
taille de la mémoire tampon matérielle 52, 54
taille du cache 57
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passage par zéro 528
Paste Settings, commande 1048
Paste Special, commandes (automation) 1102
Paste, commande 539
pavé numérique, mode 28
pavé numérique, modes 109

Classic 28, 109
Shuttle 29, 109, 571
Transport 29, 109
Use Separate Play and Stop Keys 109

Peak Hold, options 122, 211
Peak, vue 526
PEC/Direct Style Input Monitoring, option 112
pédale 61
Pencil Tool Resolution When Drawing Controller 

Data, option 127, 713, 1094
Peripherals, boîte de dialogue 133, 481
périphérique

contrôleur Ethernet 138
contrôleur MIDI 138
de synchronisation 133
Machine Control 135
PRE 139
satellites 140
VENUE 141

périphériques de synchronisation 49
permissions des volumes 286
personnalités 1031
PFL (Pre Fader Listen) 245
piste 9

activation pour l'enregistrement 447
activation/désactivation 248
ajout à la sélection 584, 585
ajout de commentaires 220
ajout de nouvelles données à la fin 471
codage couler, options 248
conversion de pistes multicanal en pistes 

mono 1162
création d'une piste de clic 437
création de pistes Elastic Audio 911
déplacement de sélections entre 584
disposition des pistes pour le format 5.1 1161
duplication 222, 1067
Elastic Audio 910
exclusion de données par trimming 604
formats 200
groupement 253
hauteur de piste 228
lecture 413, 460

localisation avec les boutons d'avance/retour 
rapide 418

masquage 231, 232
mesure du niveau 211
mute 247
nom 217, 219
placement de clips sur 849
priorité de lecture 240
raccourci de défilement 591
sélection de clips 578
sélection de contenu 577
sélection multiple 584
sélection sur les règles de base de temps 584
solo 244
suppression 222
suppression d'une sélection 585
surround 1161
transposition 958
types 199
vidéo 1247
vue de piste 223, 227
vue principale 228, 1100

piste audio 9
activation du traitement Elastic Audio 910
bounce sur disque 1133
commandes de piste 205
création d'une table de tempos 817
désactivation du traitement Elastic Audio 911
enregistrement en boucle 472
enregistrement en punch-in/out 468
enregistrement multiple 461
et format de sortie 1163
et sessions surround 1161
flux du signal 982
format 5.1 1151
placement d'audio sur des pistes 

multicana 1162
tranche 201
Waveform, vue 526

piste d'instrument 200
Clips, vue 224
commandes de piste 207
enregistrement 486
flux du signal 986
mixage surround 1165
monitoring et mixage 1014
Notes, vue 224
sélecteur d'entrée MIDI 244
sélecteur de sortie MIDI 244
tranches 204
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piste de clic 437
piste Elastic Audio 910
piste masquée

et sélections 577
groupes 232
opérations d'édition sur les groupes 232

piste MIDI
assignation à plusieurs canaux 486
changement de programme par défaut 716
Clips, vue 224, 225, 529
commandes de piste 206
enregistrement 481, 486
enregistrement en boucle 493
enregistrement en punch-in 490, 491
entrée 242
et décalage MIDI 722
Note Chasing 721
Note, vue 531
Notes, vue 224, 225
sélection d'une hauteur de note 962
sortie 242
Sysex, vue 720
tranches 203
Velocity, vue 707

piste multicanal 459
déplacement d'un clip sur 610
division 610
et automation 1098
noms 445
remplacement de clips sur 862

piste stéréo
déplacement d'un clip sur 610
division 610
noms 445
remplacement de clips sur 862

piste vidéo 200, 1247
affichage en blocs 1250
commandes de piste 207
paramètres 1251
paramètres de sortie 1252
piste vidéo principale 1249
qualité vidéo 1256
scrubbing 1267
shuttle 1267
type de projet 1251
verrouillage 1256

pistes multiples
adaptation de la durée des clips audio à une 

sélection d'édition 623
collage sur 541

déplacement des clips en mode shuffle 855
déplacement par incrément de clips 608
écoute des prises 475, 660
édition simultanée 541
et Beat Detective 681
extension de sélections 584, 585
sélection 584
séparation de clips 602

Pitch Memory Enabled, option 134
pitch shifting 933
placement

automatique 1214
clips 1212, 1214

placement en mode Spot
clips 857

Play Edit Selection, commande 423, 425
Play MIDI Notes When Editing, option 693
Play Start Follows Timeline Selection, option 108
Play Start Latency, paramètre 110
Play Start Marker Follows Timeline Selection, 

option 428
Play Timeline Selection, commande 423, 425
Playback Engine 52

Cache Size 57
Hardware Buffer Size 54
Host Engine 55
Number of Voices 56
Sample Rate 57

Playback Engine, paramètre 53
playlist 11, 645

assignation 646
attribution de nom automatique 645
configuration du pré/post-roll 467
création 646
d'automation 645, 1066, 1075
d'édition 645
duplication 646
enregistrement sur une nouvelle playlist 471
et édition MIDI non destructive 532
et groupes 647
et pistes multicanal 1098
modification de la base de temps 796
modification du nom 647
rappel 646
sélecteur de playlist 645
suppression 647

Playlists, vue 651
plug-in

activation de l'automation 1083, 1084
activation pour l'automation 1046
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automation 1082
bypass à partir de la fenêtre de plug-in 1059
Category 1039
Category and Manufacturer 1040
création d'un preset par défaut 1050
et facteurs de pull 1205
et mixage surround 1166
favori 1040
Flat List 1039
insertion sur une piste 1038
liaison et dissociation 1060, 1166
Manufacturer 1039
menu de bibliothèque 1042
menu des paramètres 1042
mono vers stéréo 1034
multicanal 1034
multi-mono 1034, 1166
Organize Plug-In Menus By, commande 1039
paramètre précédent, bouton 1042
paramètre suivant, bouton 1042
pour le surround 1166
presets 1048
sélecteur de canal pour un format 

multi-mono 1166
sélection de paramètres, bouton 1043
suppression depuis une piste 1038

Plug-In Controls Default to Auto-Enabled, 
option 117

plug-in en temps réel 1033
plug-in multicanal 1166
plug-in non temps réel 889
plug-in, carte d'assignation

création 1055
définition d'une carte par défaut 1057
gestion 1056
importation et exportation 1058
suppression 1057

plug-in, commandes
ajustement 1045
liaison 1060

plug-in, fenêtre
ouverture et fermeture 1044

plug-in, sélecteur
pour des plug-ins AudioSuite 890

point d'automation
gain du clip 614
keyframes Avid 1095

point d'insertion d'édition
placement de clips sur 851
trimming de clips 604

point d'intersection 1068
point d’automation 1097
point de synchro 1216

identification 1216
point de synchronisation

d'un clip 863
depuis Beat Detective 686
identification 863

points de boucle 463
marqueurs de sélection de timeline 464

points de punch 463
marqueurs de sélection de timeline 464

post-fondu enchaîné 626, 636
post-roll, bouton 182
pourcentage de centrage 1184
pourcentage de centrage, dans la fenêtre de 

sortie 1186
pourcentage de valeur latérale 1184
poursuite

changement de programme MIDI 722
événements de contrôleur MIDI 721
notes MIDI 721

Power, vue 526
PRE 49

configuration 139
I/O Setup 74

Pre Fader Listen (PFL), mode 245
PRE, paramètres 360
pré/post-fader, bouton 1011
pré/post-roll

configuration 466
écoute 423
et enregistrement en punch-in/out 468
et enregistrement en boucle 472

pré/post-roll, drapeaux 468
Pre/Post-Roll, option 467
préampli micro

configuration 139
I/O Setup 74

Pre-Fader Metering, option 211
préférences

affichage des info-bulles 198
Automatically Copy Files on Import, option 354
changement de zoom 114
DestructivePunch 503
durée de fichier DestructivePunch 512
globales 131
locales 131
modification 105
Mute Audio Inputs in Auto Input 518
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Mute Record-Armed Tracks While 
Stopped 518

Pause during Playback 327
TrackInput 454
TrackPunch 503

préférences d'affichage 105
Clip Hold, options 122
Draw Grids in Edit Window, option 545
options de langue 106
Peak Hold, options 122

préférences d'automation
AutoMatch Time, préférence 1074
Smooth and Thin Data After Pass, option 1092

préférences d'édition 113
Auto-Name Memory Locations While Playing, 

option 839
Auto-Name Separated Clips, option 601
Clip List Selection Follows Edit Selection, 

option 268, 578
Crossfade Preference for Pre/Post-Roll, 

option 114, 632
Edit Selection Follows Clip List Selection, 

option 578
qualité de conversion, option 332
QuickPunch Crossfade Length, 

préférence 503
Separate Clip Operates On All Related Takes, 

option 601
préférences de changement de zoom 114, 554
préférences de fonctionnement 107

Audio During Fast Forward/Rewind, option 418
Clip Auto Fade In/Out Length, préférence 637
Edit Insertion Follows Scrub/Shuttle, 

option 568
Link Record and Play Faders, option 455
Machine Chases Memory Location, 

option 1210
Machine Follows Edit Insertion/Scrub, 

option 1210
Record Online, option 1205
Use F11 for Wait for Note 485

préférences de mesure des niveaux 119
préférences de mixage 115
préférences de synchronisation 128
préférences de traitement 124
préférences globales (s'appliquent au système 

complet) 131
préférences locales (s'appliquent à la session 

ouverte) 131

préférences MIDI 126
Global MIDI Playback Offset, préférence 722
Pencil Tool Resolution When Drawing 

Controller Data, option 127, 713, 
1094

préférences MIDI, page 126
Preferences, boîte de dialogue 105
pré-fondu enchaîné 626, 636
Prepare DPE Tracks, commande 513
Pre-Process using Standard Conform 685
pré-roll, bouton 182
Preserve Fades when Editing, option 114
Preserve Folder Hierarchy, commande 167
preset

carte d'assignation de plug-in 1053
plug-in 1048

preset utilisateur par défaut 1050
presets de zoom 553
Prevent Tearing, option 110
Prime for Playback, mode (Play Pause) 426
Prime for Record, mode (Record Pause) 462
principale, échelle temporelle 1201
prise

MIDI 495
prise en charge des applications multilingues 409
prises

alternatives correspondantes 474, 659
de pistes multiples 475, 660
écoute 474
enregistrement de prises supplémentaires 470
nom par défaut 445
numérotation en mode QuickPunch 502
sélection d'une prise alternative 474, 659

prises alternatives correspondantes 474, 659
prises alternatives, menu 659
prises associées

et commande Separate Clip 601
Pro Tools

Video Satellite, paramètres 1299
Pro Tools Help, commande 188
Pro Tools Knowledge Base, commande 188
profondeur de panoramique 992
Program Change, boîte de dialogue 716, 717
Project Type, paramètre de MediaComposer 1299
propriétés en temps réel

activation 726
affichage 725
basées sur des clips 730
basées sur des pistes 730
dans la fenêtre Edit 732
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dans la liste des événements MIDI 731
Delay 729
Display Events as Modified by Real-Time 

Properties, option 127
Duration 728
écriture sur des clips 731
écriture sur des pistes 730
paramètres 727
Quantize 727
suppression 731
sur les pistes et les clips 730
Transpose 729
Velocity 729

propriétés MIDI en temps réel 725
paramètres 727
sur les pistes et les clips 730

protection contre l'enregistrement, mode 449
protection de l'automation 1075
Pro Tools

aide 197
base de connaissances 197
Check For Updates 197
Clock Reference, paramètre 1299
commandes de liaison 1306

affichage 1306
liaison et dissociation des systèmes 1306

Drop Frame, paramètre 1299
fichier de session 157
fichier de session, icône 8
gestion des fichiers 393
menus principaux 197
navigateurs Web 186
Non-Drop Frame, paramètre 1299
piste vidéo 1249
pull up et pull down audio 1299
Session Start, paramètre 1299
systèmes 39
Timecode Rate, paramètre 1299
Video Format, paramètre 1299
Video Satellite 1297

Pro Tools HD
capacités avec du matériel HD Native 43
capacités avec du matériel HDX 41

Pro Tools Online, navigateur 188
Pro Tools, menu

Quit, commande (Mac) 170
puissance constante, fondu enchaîné 632
pull up et pull down 1202, 1204, 1205
pull up et pull down audio 1299
Punch Capture, bouton 1122

Punch In Frame Offset, préférence 130
Punch Out Frame Offset, préférence 130
Punch Preview, bouton 1120

Q
qualité de conversion de la fréquence 

d'échantillonnage 369, 1139, 1262
qualité de conversion, option 332
quantification

MIDI en entrée 484, 963
notes MIDI 940, 945

quantification sur un groove 945
Quantize

clips audio 940, 951
événements Elastic Audio 941, 950
propriétés en temps réel 727
quantification de clips sur la grille 609

Quantize Clips to Grid, commande 859
Quantize Edits to Frame Boundaries, option 380
Quantize to Grid, commande 609
Quantize, commande 937, 938
Quantize, fenêtre 941
QuickPunch 443, 500, 505

fondus enchaînés 503
numérotation des clips/prises 502
systèmes ProTools HD 500

QuickPunch Crossfade Length, préférence 114, 503
QuickStart, boîte de dialogue 151
QuickTime, séquence

conditions requises 1246
importation de l'audio 1261
optimisation pour la lecture 1271
synchronisation 1272

Quit, commande (Mac) 170

R
R (volumes d'enregistrement et lecture) 286
raccourcis clavier 1045

commandes clavier générales 25
enregistrement 462
saisie numérique 583

raccourcis de saisie au clavier 1045
randomisation

durée des notes 958
emplacements des notes 941

Read Trim, mode d'automation 1071
Read, mode d'automation 1068
Real-Time Properties

vue 725
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Real-Time Properties, fenêtre 726
Real-Time Properties, vue 725, 995
Recalculate Waveform Overviews, commande 278
Recall Memory Location Selection at Original 

Track, option 114
recherche de clips 270

Include Subsequently Added Clips 270
par nom 270

Record Online at Insertion/Selection, option 112
Record Online at Timecode (or ADAT) Lock, 

option 112
Record Online, option 1205
recouvrement, fondu enchaîné 632
Rectified, vue 527
ReCycle 331
redéfinition

position de timecode 1201
position Feet+Frames 1200

Redo, commande 535
réduction de gain, indicateur 214
Ref Present, témoin 1197
référence à des médias audio source 366
référence aux médias source 382
régénération des fichiers rendus manquants 395
règle

défilement sur 590
pull up et pull down 1204
zoom sur 552

règle de base de temps principale 792
règle de métrique

affichage 821
extension d'une sélection d'édition à 822

règle de tempo
affichage 797
extension d'une sélection d'édition à 799

règle de timecode secondaire 790
règle des marqueurs 841

extension d'une sélection d'édition à 845
règle, options d'affichage 791

Bars|Beats, échelle temporelle 789
Feet+Frames, échelle temporelle 790
Minutes:Seconds, échelle temporelle 790
Samples, échelle temporelle 790
Timecode, échelle temporelle 790

règle, sélecteur de vue 791
règles

affichage de l'ensemble des règles 791
de base de temps 789
de chef d'orchestre 791
modification de l'ordre d'affichage 791

règles de base de temps 789
drapeaux de pré/post-roll 576
et sélections de timeline 588
glissement de sélections d'édition 586
glissement de sélections de timeline 589
marqueurs d'édition 576
marqueurs de sélection de timeline 576
Timecode2 790

règles de chef d'orchestre 791
inclure dans les sélections 584

Regroup Clip, commande 879
Remote Mode, options 130
Remove Duplicate Notes, commande 724
Remove Sync Point, commande 864
remplacement MIDI, mode 184, 444, 485
remplacement, mode (voir remplacement 

MIDI, mode)
Rename, commande 233
Rename, commande de la liste des clips 276, 278
Renamed Audio Files, dossier

enregistrement d'une copie dans 396
Render Clip Gain, commande 620
Rendered Files, dossier 158, 915
Renumber Bars, commande 830
Repeat to Fill Selection, commande 540
Repeat, commande 872
repère du curseur de lecture 416
repères à importer 370
répétition de sélections et clips 872
Replace Clip, commande 278, 861

et pistes multicanal 862
Replace Clip, boîte de dialogue 862

Reserve Voices For Preview In Context, 
option 108, 311

Reset Bi-Phase, bouton 135
résolution 155, 382, 1194
résolution du tempo, sélecteur 805
résolutions mixtes 165
ressources non disponibles 159
ressources système 16
Restore Performance, commande 937, 952
rétablissement des liens

options de liaison 318
recherche de liens 318

retour à zéro, bouton 180
retour rapide 418
retour rapide, bouton 180
Reveal in Explorer, commande (Windows) 278
Reveal in Finder, commande (Mac) 278
Revert to Saved, commande 162
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REX, fichier 331
importation 339

Root Settings, dossier 1048, 1049
routing

chemin de signal 69
départs 998
départs multicanal 1165
exemples surround 1170
sous-groupe de mixage et effets 1013

routing du signal
bases pour le surround 1164
et ordre des chemins par défaut 82
exemple 13
exemples surround 1172

S
saisie numérique

raccourcis 583
Sample Offset (décalage de synchro) 1198
Sample Rate Conversion Quality 125, 332, 343, 382
Sample Rate, paramètre 1139

Hardware Setup, boîte de dialogue 60
Playback Engine, boîte de dialogue 57

Samples, échelle temporelle 790
Satellite Link

option 140
préférences 130

Satellites 140
Save As, commande 162
Save Copy In, commande 163, 400
Save, commande 162
Scale, commande (opérations de tempo) 815
Score Setup, fenêtre 766
Scroll into View, commande 222, 233
Scroll to Track Banks Controllers, option 116
Scroll To Track, commande 220, 592
Scrolling, options

After Playback 420
Center Playhead 422
Continuous Scrolling During Playback 421
None 420
Page 421, 740, 760

scrubbing 568
avec l'outil de trim par scrubbing 561
avec le Sélecteur 569
et curseur d'édition 568

piste vidéo 1267
résolution 569
sur deux pistes audio 569
sur une piste audio 569
vitesse et sens de lecture 569

S-Curve, commande (Tempo Operations) 814
secondaire, échelle temporelle 793, 1201
Select All, commande 578
Select Parent in Workspace, commande 278
Select Tracks in Group, commande 256
Select Unused Clips, commande 277
Select/Split Notes, commande 937, 960, 962

division de notes, action 961
Sélecteur 417, 547, 564

création d'une sélection d'édition 564
création d'une sélection de timeline 565
positionnement du curseur d'édition 564
scrubbing 569
sélection d'un clip entier 564
sélection d'une piste entière 564
sélection de notes MIDI 701

sélecteur d'assignation de groupe 987
sélecteur d'entrée MIDI 208
sélecteur d'entrée MIDI

piste d'instrument 244
sélecteur de canal 1044

pour des plug-ins multi-mono 1166
sélecteur de chemin d'entrée 208, 235
sélecteur de chemin de sortie 208
sélecteur de conversion de plug-in 1044
sélecteur de déclencheur 1042
sélecteur de mode de traitement 892
sélecteur de notes 702
sélecteur de piste 1042
sélecteur de playlist 645
sélecteur de playlist 11
sélecteur de plug-in

pour les plug-ins en temps réel 1042
sélecteur de plug-in Elastic Audio 912
sélecteur de position d'insert 1042
Sélecteur de sortie MIDI 208
sélecteur de sortie MIDI

piste d'instrument 244
sélecteur de voix 241
sélecteur de vue de la fenêtre Edit 992
sélecteur de vue de la fenêtre Mix 992
sélecteur de vue de piste 226
sélection

avec l'outil de scrubbing 586
avec les indicateurs de sélection d'édition 583
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clips 578
clips non contigus 579
collage 539
consolidation 621
contenu des pistes 577
copie 538
coupe 538
d'une plage de hauteurs de notes 962
dans la liste des événements MIDI 784
de notes d'un accord 963
décalage 865
déplacement par incrément 581, 607
déplacement par incrément des points de 

début/fin 582
déplacement sur le clip suivant/précédent 586
déplacement vers des pistes adjacentes 584
duplication 871
écoute des points de début et de fin 423
effacement 539
éléments des navigateurs 297
en cours de lecture 579
et bounce sur disque 1133
et groupes d'édition 577
et marqueurs de sélection de timeline 577
et pistes masquées 577
extension 582, 808
extension à la règle de métrique 822
extension à la règle de tempo 799, 845
incluant les règles du chef d'orchestre 584
lecture 423
lecture en boucle 426
mémorisation avec les emplacements 

mémoire 841
modification de la durée 581
non contiguë 579
notes MIDI 700, 701
objet 579
répétition 872
suppression d'une piste 585
sur plusieurs pistes 577, 584
sur toutes les pistes 584

Selection Changes Alternate Playlists, option 796
sélection d'édition

copie depuis la sélection de timeline 589
copie sur la sélection de timeline 590
création avec le Sélecteur 564
écoute avec la tête de lecture activée 424
glissement sur la règle 586

sélection d'objets 579
sélection de banque 715

sélection de paramètres de plug-in, bouton 1043
sélection de patch, bouton 716
sélection de pistes pour un traitement 

AudioSuite 897
sélection de timeline 588

champs Start, End et Length 182
copie depuis la sélection d'édition 590
copie sur la sélection d'édition 589
création avec le Sélecteur 565
écoute avec la tête de lecture activée 425
glissement sur la règle 589
marqueurs de sélection de timeline 589
sur les règles de base de temps 588

sélection non contiguë 579
Selection, commandes

Play Edit Selection 423
Play Timeline 423

sélections d'édition et de timeline, dissociées 575
sélections dissociées d'édition et de timeline 575
Send Pans Default to Follow Main Pan, option 115
Send to Back, commande (menu Clip) 603
Send To Gobbler, commande 391
Send To Sibelius, commande 774
Sends Default to -INF, option 115
Sends, vue 994
Separate Clip Operates On All Related Takes, 

option 113, 601
Separate Clip, commandes 600

At Selection 600
At Transients 600
et pistes multiples 602
et prises associées 601
On Grid 600

séparation de notes MIDI 705
séquence AAF, ouverture dans ProTools 362
séquence OMF, ouverture dans ProTools 362
session 8

cadence d'images 1195
création 154
création pour le mixage surround 1152
enregistrement 162
fermeture 170
fichiers 8
fichiers audio multicanal entrelacés 157
fichiers audio multi-mono 157
format audio 1195
format entrelacé 157, 1195
formats audio mixtes 156, 165
fréquence d'échantillonnage 155, 1194
image de début 1195
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modèles 168
ouverture 159
ouverture depuis un volume de transfert 159
résolution 155, 1194
résolutions mixtes 165
sauvegarde 109, 158

Session Data to Import, menu 358
Session File Backups, dossier 158
session Mac

compatibilité avec Windows 399
Session Setup, fenêtre 1193
Session Start, paramètre 1299
session Windows

compatibilité avec Mac 399
Sessions Overwrite Current I/OSetup When 

Opened, option 81
Set As User Default, commande 1048
Set Plug-In Default To, commande 1049
Set Record Tracks to Auto Input, commande 454
Set Record Tracks to Input Only, commande 454
Set Servo Lock Bit at Play, option 130
Setup, menu 197

Click/Countoff Options, boîte de dialogue 438
Disk Allocation 450
I/O Setup 70
MIDI Studio 717
Preferences, commande 105
Session Setup 1193
Video Sync Offset, commande 1272

Share With SoundCloud, option 1141
Shift, commande 865
Show All Tracks, commande de groupe 256
Show Auto-Created, option 277
Show Only Tracks in Group, commande 256
Show/Hide Clip List, bouton 267
Show/Hide Tracks in Group, commande 256
Shuffle, mode 543
Shuffle, verrouillage du mode 544
shuttle

fixe, option de mode 571
Shuttle, mode du pavé numérique 29, 109, 571
side-chain 1047

filtres 1047
traitement 1042

silences (éditeur de partition) 770
SIP (Solo In Place) 245
Size, paramètre (fenêtre d'incrustation) 135
Skip All 395
Slip, mode 544
Smooth and Thin Data After Pass, option 117, 1092

SMPTE
configuration 1199
image de début (session) 1195

Snap Pan to Speaker, icônes 1180
Snap To Bar, option 821
Snap To, commandes 856
solo

piste 244
Solo in Place (SIP), mode 245
Solo Latch, options 246
Solo Safe, mode 247
Solo, bouton 245
Solo, modes 245
Sony Dynamic Digital Sound (SDDS) 1152
Sort By, options 269
sortie

assignation de sorties multiples 997
chemins et sous-chemins 5.1 par défaut 1154
format et pistes 1163
vers des chemins multicanal 1164

Sortie d'horloge externe 1192
sortie MIDI, sélecteur 243
sortie, options

Conversion Quality, option 1140
fréquence d'échantillonnage 1139

SoundCloud 1141
Source Audio Sample Rate 382
source d'horloge 60, 1063
source d'horloge externe 1063
sous-chemin 70, 90

exemples pour le surround 1168
sous-dossiers, création pour les paramètres 1049
sous-groupe

mise en solo de pistes 1021
sous-groupe de mixage

application d'un insert à 1017
bounce sur disque 1131

sous-image 1213
Special Paste 1102
Speed Cal, témoin 1197
Split Into Mono Track, commande 233, 610, 1162
Spot, boîte de dialogue 857, 1212

Use Subframes, option 1213
User Time Stamp, bouton 1215

Spot, mode 544, 1212
trimming de clips 1215

SRC (conversion de la fréquence 
d'échantillonnage), options 357

Standard VCA Logic for Group Attributes, 
option 117
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Start To Insertion, commande 604
Starting TC, paramètre

correspondance avec le paramètre Session 
Start 1299

Step Input, commande 937, 964
Stop at Shuttle Speed Zero, option 129
Stretch, commande (opérations de tempo) 816
Strip Silence, commande 867, 868, 869
Suppress Automation “Write To” Warnings, 

option 117
suppression

automation 1091, 1099
changement de programme 719
chemins dans I/O Setup 93
clips inutilisés 277
de plug-ins sur des pistes 1038
départ 1000
éléments de la liste des événements MIDI 784
emplacement mémoire 845
événement Sysex 721
fondu enchaîné 635
groupe 261
notes MIDI 709
piste 222
playlist 647

suppression d'erreurs 55
surface de contrôle

C|24 1030
Command|8 1030
D-Command 1030
D-Control 1030

surround
bases pour le routing des signaux 1164
chemins au format 5.1 1157
configuration de ProTools 1152, 1161
et départs 1165
fichiers de paramètres 1153
grilles de panoramique 1176
importation de paramètres d'E/S 1155
niveau, solo, mute séparés 1162
playlists de panoramique et automation 1187
pourcentage de centrage 1186
pourcentage de centrage latéral 1186
utilisation de sous-chemins, exemples 1168
utilisation des chemins 1167

Suspend All Groups (liste des groupes), 
commande 256

suspension
automation 1089
écriture d'automation 1089

swing 941, 943
symbole d'accord 773, 835
Sync Point, option d'affichage 864
SYNC, périphérique

génération de timecode avec 1206
options de synchronisation 1192
verrouillage sur 1191

synchronisation 133
black burst 1217
MIDI Beat Clock 430
MMC 1207
options 1191
résolution des problèmes 1217, 1297, 

1298, 1299
verrouillage 1217

Synchronization Device, paramètres 134
Sysex, vue 720
syst 40
System Usage, fenêtre 66, 67
systèmes HD Native 42
systèmes HDX 41
systèmes ProTools

QuickPunch 500

T
T (volumes de transfert) 286
Tab to Transients, bouton 587
tablature guitare 835
table d'armures 360
table de métriques 360
table de tempo

Identify Beat, commande 817
table de tempos 360
tabulations vers les transitoires, bouton 420
tâche

échouée 326
en attente 326
groupée 327
suspendue 325
suspension en cours de lecture 327

taille de la mémoire tampon matérielle 52, 54, 456
taille des marges de consolidation 383
taille du cache 57
Target Project Timecode Format 380
TC/E Plug-in, préférence 125, 560
TCE Edit to Timeline, commande 622
TCE, outil de trim 559, 560, 561
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tempo
actuel 798
affichage 184
détermination manuelle 441
effets sur les marqueurs et emplacements 

mémoire 841
par défaut 440
tempo manuel, mode 440

tempo actuel 184, 798
tempo manuel, mode 184, 440
Tempo Operations, commandes

Constant, commande 812
Linear, commande 812
Parabolic, commande 813
Scale, commande 815
S-Curve, commande 814
Stretch, commande 816

Tempo Operations, fenêtre 811
terminologie ProTools et Avid 21
tête de lecture 422, 740

déplacement vers les limites d'un clip 425
et sélections d'édition 424
et sélections de timeline 425

Thin All Automation, commande 1093
Thin Automation, commande 1093
Time Compression/Expansion, plug-in 622
Time Operations, commandes 823

Change Meter, commande 824
Cut Time, commande 827
Insert Time, commande 826
Move Song Start, commande 829

Time Operations, fenêtre 821, 823
Time Slots, jauge 67
Time Stamp Selected, commande 858
Time Stamp, commande 278, 475, 659, 1215
timecode 1299

capture 1213
compensation du décalage entre les heures de 

début 1292, 1305
correspondance entre les formats 1303
correspondance entre ProTools/Satellite 1304
correspondance forcée sur un système 

Satellite 1304
et Jam Sync 1198
et limitations relatives aux formats Drop Frame 

de ProTools 1303
génération 1206
inertie 1198
redéfinition de la position 1201

Timecode 2 Rate, paramètre 1195
Timecode Rate, paramètre 1195, 1299
Timecode, échelle temporelle 790
Timecode2, règle 790
timecodes 1299
Timeline Drop Order, option 850
Timeline Insertion/Play Start Marker Follows 

Playback, option 108, 421, 428
timing basé sur les échantillons 793, 841
timing basé sur les références de tempo 793, 841
Touch Timeout, option 116
Touch Trim, mode d'automation 1072
Touch, mode d'automation 1068
Touch/Latch, mode d'automation 1070
Track and Master Meter Types Linked, option 119
Track Color, vue 996
Track Name, commandes 233
Track Number, commande 220, 592
Track Position Numbers Stay with Hidden Tracks, 

option 105
Track, menu 197

Auto Input Monitoring, mode 453
Clear All Clip Indicators, commande 211, 

212, 1005
Delete, commande 222
Duplicate, commande 222, 1067
Group, commande 258, 259
Input Only Monitoring, mode 453
Make Inactive, commande 248
New Track, commande 217
Scroll To Track 220
Scroll to Track, commande 592
Set Record Tracks to Auto Input 454
Set Record Tracks to Input Only 454
Split Into Mono, commande 610
Split into Mono, commande 1162
Write MIDI Real-Time Properties, 

commande 731
TrackInput, bouton de monitoring 453
TrackPunch

fondus enchaînés 503
préférences 503

Tracks (liste des groupes), commande 256
traitement

AudioSuite 895
multicanal pour AudioSuite 896
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Traitement Elastic Audio 903
traitement side-chain externe 1047
traitement side-chain interne 1047
tranche 12

entrée auxiliaire 202
piste d'instrument 204
piste Master Fader 202
piste Master VCA 203
piste MIDI 203
pistes audio 201

tranches 666
transfert, fichiers

sélection dans l'espace de travail 290
transitoire 526

détection avec Beat Detective 671
tabulation vers 420, 587

transport 180
décompte 438
métrique 439
métronome 438

transport dynamique, mode 427
transport maître 1210
Transport Online, option 1205
Transport Record Lock, option 503, 517
Transport RecordLock, option 111
Transport View, options 464
Transport, mode du pavé numérique 29, 109
Transport, options d'affichage 183, 415, 466
Transpose

notes MIDI 958
propriétés en temps réel 729

Transpose, commande 937, 958
transposition 958

Elastic Audio 933
notes MIDI 703
par octave 960
piste 958
tonalité 959

tri
clips 269
données des navigateurs 293
marqueurs 847

Trim Automation, commandes 1119
Trim to All Enabled 1119
Trim to Current 1119

Trim Clip, commandes
End to Fill Selection 605
End to Insertion 605
Start to Fill Selection 605
Start to Insertion 604

To Fill Selection 606
To Selection 604

Trim to All Enabled Automation, commande 1119
Trim to Current Automation, commande 1119
trimming

de clips avec l'outil de trim par scrubbing 561
de clips jusqu'au point d'insertion d'édition 604
de clips selon la valeur d'incrément 606, 705
exclusion de données de clip et de piste 604
fondu enchaîné 636
points d'automation 808, 1096, 1104
points d'automation de gain du clip 616
points de début et fin de notes 704
points de début/fin d'un clip 558

Tweak Head, paramètre (qualité de 
conversion) 1140, 1262

types de fichier mixtes 165

U
Undo, commande 461, 535
Ungroup All Clips, commande 879
Ungroup Clips, commande 879
Universe, vue 593
Unlock Clip, commande 866
Unloop Clips, commande 875
Use Absolute Pan Linking, option 116
Use F11 for Wait for Note, option 127, 485
Use MIDI to Tap Tempo, option 127
Use Separate Play and Stop Keys, option 109
Use Subframes, option 1213

V
valeur d'incrément 607

pour le trimming de clips 606
valeur de grille 695, 859

définition pour l'édition MIDI 695
valeur de grille, sélecteur 546
vélocité (MIDI)

décalage global 708
dessin avec le Crayon 707
édition 707, 954
fondu 954
modification proportionnelle 955
propriétés en temps réel 729

Velocity, vue 707
VENUE 141
VENUE Link 49, 141
verrouillage pour l'édition d'un clip 866
verrouillage temporel d'un clip 867



Index 1351

Vertical Position, paramètre 135
vidéo

importation 1258
lecture 1296

Video Engine, option 57
Video Format, paramètre 1299
vidéo haute définition

lecture 1270, 1296
Video Online, bouton 1249, 1250
Video Satellite

connexion 1297
décalage du satellite vidéo 1293
éviter les problèmes de synchronisation 1299
MediaComposer 140, 1295
paramètres 1299
quitter ProTools 1298
résolution des problèmes de connexion des 

satellites 1298
Video Sync Offset, commande 1272
Video Universe, fenêtre 1268
Video Window, commande 1266
Video, fenêtre 1266
vidéo, pull up et pull down 1202
View, menu 197

Clip Name, option d'affichage 533
Clip Sync Point, option d'affichage 864
Clip Time, options d'affichage 533
fenêtre Edit, options d'affichage 175
fenêtre Mix, options d'affichage 172
Narrow Mix, option d'affichage 216
options d'affichage de la fenêtre Edit 993
options d'affichage de la fenêtre Mix 993
Track Number, commande 220, 592
Transport View, options 464
Transport, options d'affichage 183, 415, 466

VITC
Generate Lines, paramètre 134
Read Lines, par défaut 134
Read Lines, paramètre 134

VITC Insertion Enabled, option 134
Voices, jauge 67
voix 500

et plug-ins Native 1035
et priorité des pistes 240

volume
transfert 281

volume d'aperçu
AudioSuite 894

Volumes de performance 281
volume de transfert 281
volume, fader 209
vue

Inserts, vue 994
Sends, vue 994

vue de l'éditeur MIDI (dans la fenêtre Edit) 185
vue de piste 223

basculement 227
Blocks 224
changement 227
Clips 224, 225, 529
édition des contenus 537
Notes 224, 225, 531
Playlists 651
Sysex 720
Velocity 707
vue principale 1100
Waveform 526

vue large des indicateurs de niveau 213
vue principale de piste 228, 1100
vues

Delay Compensation 217
I/O 208
vue large des indicateurs de niveau 213

W
Wait for Note 183, 484
Warp, vue 912, 920
WAV, format de fichier

compatible AES31/Broadcast 396
WaveCache 304
WaveCache.wfm, fichier 158, 282
Waveform, vue 526
Whole File, bouton (AudioSuite) 895
Window, menu 197

Automation Enable, commande 1079
Big Counter, commande 415
Color Palette 250
Disk Space, commande 449
Edit, commande 175
Machine Track Arming, commande 1211
Memory Locations, commande 843
Mix, commande 172
System Usage, commande 67
Task Manager, commande 339
Transport, commande 180
Undo History, commande 535
Workspace, commande 451
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Word Clock 62, 1308
workflow d'échange

médias intégrés 22
médias liés 23

workflows 516
Workspace.wksp, fichier 282
Write 1118
Write Automation to Next Breakpoint on Stop, 

commande 1111
Write Automation to Next Breakpoint, 

commande 1109
Write Automation to Selection/Selection 

Start/Selection End, boutons 1107
Write Automation To, commandes 1121
Write Automation, commandes 1116, 1118
Write MIDI Real-Time Properties, commande 731
Write Trim, mode d'automation 1072
Write, mode d'automation 1068

X
XML (noms de patch MIDI) 716
X–OR (annulation des solos précédents), option de 

verrouillage solo 247

Z
zone d'édition des événements 709
Meter, zone 439
zoom 548

avec la molette de défilement 557
changement de zoom 554
continu 548
dans l'éditeur de tempo 804
horizontal sur l'ensemble des pistes 548
mémorisation de niveaux de zoom 553
pour visualiser tous les clips 550
rappel de niveaux de zoom 553
rétablissement du niveau de zoom 

précédent 550
sur la règle 552
sur la session entière 550
sur un point spécifique d'une piste 551, 754
sur une sélection 550
sur une zone d'une piste 551, 755
vertical 549

zoom arrière audio, bouton 549
zoom arrière horizontal, bouton 548
zoom arrière MIDI, bouton 549
zoom avant audio, bouton 549
zoom avant horizontal, bouton 548
zoom avant MIDI, bouton 549
zoom normal, mode 551, 754
zoom unique, mode 551, 755
zoom, boutons 548
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